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8 ContentsCompressor is an essential part of the video compression process. It makes compression
fast, efficient, and convenient, giving you more options in your choices of compression
settings and output formats.
This preface covers the following:
• About Compressor (p. 9)
• About the Compressor Documentation (p. 10)
• Additional Resources (p. 10)
About Compressor
Compressor is targeted at video postproduction professionals and compressionists who
require high performance and maximum control over the final digital content for DVD
authoring, streaming media servers, and wireless devices.
Compressor gives you resizing, cropping, image processing, encoding, and delivery
options, and offers batch processing, VBR options, and H.264 encoding. You can also use
Droplets and AppleScript, specify and save transcode settings, use filters, specify
destinations, and more. Compressor also provides a variety of output formats for Apple
devices, DVD, web, CD, and kiosk.
Important: Compressor 4 is designed to work closely with Final Cut Pro X and later and
Motion 5 and later and is required for the Send to Compressor feature. All mentions of
Final Cut Pro and Motion in this document refer to these versions.
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PrefaceAbout the Compressor Documentation
Compressor comes with various documents that will help you get started as well as
provide detailed information about the application. (To access onscreen help for
Compressor, open Compressor and choose Help > Compressor Help.)
• Compressor User Manual: This comprehensive document describes the Compressor
interface, commands, and menus and gives step-by-step instructions for using
Compressor and accomplishing specific tasks. It also contains information for configuring
an Apple Qmaster distributed processing system for more efficient transcoding and
rendering. It is written for users of all levels of experience.
• Apple Qadministrator User Manual: This document explains how to manually set up
and manage clusters for use in an Apple Qmaster distributed processing system.
• Apple Qmaster User Manual: This document explains how to use Apple Qmaster as a
client for submitting rendering jobs from Shake, Maya, and other applications, to a
distributed processing system.
• Share Monitor User Manual: This brief document describes how to use Share Monitor
to monitor the transcoding progress of batches and jobs.
Additional Resources
Along with the documentation that comes with Compressor, there are a variety of other
resources you can use to find out more about Compressor.
Compressor Website
For general information and updates, as well as the latest news on Compressor, go to:
• http://www.apple.com/finalcutpro/compressor
Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support web page. You’ll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.
• http://www.apple.com/support
For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for Compressor, go to:
• http://www.apple.com/support/compressor
10 Preface Welcome to CompressorCompressor contains a number of predefined settings that allow you to start transcoding
immediately. You can begin transcoding media files as soon as you install Compressor if
you have one or more source media files and the preexisting Compressor batch templates
or settings and destinations suit your transcoding needs.
This chapter covers the following:
• Terms Used by Compressor (p. 11)
• Quick and Easy Compressor Workflow: Batch Template Method (p. 12)
• Quick and Easy Compressor Workflow: Manual Method (p. 17)
• Optional Tasks You Can Perform Before Submitting a Batch (p. 24)
Terms Used by Compressor
There are a few terms used by Compressor that you should feel comfortable with before
you begin using it.
A batch is the heart of the transcode process. It contains one or more source media files,
which are the files you want to convert, or transcode, to another format. Each source
media file creates its own job. This means that a batch can contain multiple jobs, with
each job based on its own source media file.
Each job also has at least one target. The targets define what sort of output file should
be created by the transcoding process and where it should be placed. You can have
multiple targets assigned to a job, which means that you can easily create multiple output
files, each with a different format.
Each target has three parts.
• The setting: The setting part of a target defines the transcoding process, including the
encoder format that is used as well as a variety of filters and geometry attributes.
• The destination: The destination part of a target defines where the output file is saved.
It also defines the rules that are used to create the output filename. Compressor includes
a preference setting that allows you to specify a default destination.
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1• The output filename: You can edit the output filename part of the target if for some
reason you do not want to use the name generated based on the destination.
Note: You can transcode a job only after it has at least one setting assigned to it.
If you need to create your own settings, or modify those that come with Compressor, see
The Basic Transcoding Workflow and Creating, Previewing, and Modifying Settings.
Quick and Easy Compressor Workflow: Batch Template Method
Batch templates simplify and accelerate your transcoding workflow. The following workflow
shows you a quick and easy way to use Compressor with batch templates.
• Stage 1: Choosing a Batch Template
• Stage 2: Adding a Source Media File
• Stage 3: Submitting the Batch
• Stage 4: Using Post-Transcoding Actions
• Stage 5: Saving Custom Batch Templates—Optional
Stage 1: Choosing a Batch Template
To use Compressor with this workflow, you must choose a batch template.
To open Compressor and choose a batch template
1 Double-click the Compressor icon in the Applications folder.
Compressor opens with the Batch Template Chooser and an empty untitled batch with
a placeholder job.
12 Chapter 1 Getting Started QuicklyNote: The Batch Template Chooser does not appear if you have previously selected the
“Don’t show this dialog again” checkbox, or, in Compressor preferences, selected Use
Blank Template. Select Show Template Chooser in Compressor preferences to have the
Batch Template Chooser appear when you are creating new batches. Alternatively, you
can choose File > New Batch From Template to create a new batch and have the Batch
Template Chooser appear.
The Batch Template Chooser contains options for the standard Apple batch templates
(described in step 2).
You can also add custom batch templates. For more information, see Creating a Custom
Batch Template.
Note: To see the Compressor interface configured similarly to what is shown in this
document, choose a Standard layout from the Layouts submenu of the Window menu.
Chapter 1 Getting Started Quickly 132 Click one of the options in the Batch Template Chooser to select it.
The standard Apple batch templates are listed below.
• Create Audio Podcast: Use this template to create an AAC audio file suitable for
podcasting and add it to the iTunes library.
• Create Blu-ray disc: Use this template to create BD H.264 video and Dolby Digital
Professional (.ac3) audio files and automatically burn them to a Blu-ray disc or an AVCHD
disc (AVCHD discs can be played in Blu-ray Disc players that are compatible with the
AVCHD format).
• Create DVD: Use this template to create a standard definition DVD using MPEG-2 (.m2v)
video and Dolby Digital Professional (.ac3) audio and automatically burn it to a disc.
• HTTP Live Streaming: Use this template to create a set of files you can use to stream a
movie to iPhone, iPad, iPod touch, and Mac, using an ordinary server.
• Publish to Apple TV: Use this template to create a video file suitable for viewing on
Apple TV and add it to the iTunes library.
• Publish to YouTube: Use this template to create a video file suitable for viewing on
YouTube and upload it to a YouTube account.
Note: Your choice of a template should be based on the intended use of the output
media file you are creating. If there is no obvious template for your intended workflow,
you may want to try the manual method. For more information, see Quick and Easy
Compressor Workflow: Manual Method. For information about creating custom templates,
see Creating a Custom Batch Template.
3 Click Choose.
14 Chapter 1 Getting Started QuicklyCompressor applies a target to the placeholder job. The target contains the appropriate
transcoding setting (based on the template you chose), the default destination (Source),
and a suggested output filename, based on the source filename and the name of the
applied setting.
By default, the batch templates use Source (the same folder as the source media files
originated from) as the destination for the encoded files. For information about choosing
other destinations, see Creating and Changing Destinations.
Stage 2: Adding a Source Media File
Drag a source file from the Finder or the desktop to the placeholder job in the Batch
window.
Note: You can drag in only one source file because batch templates contain only one
job. If you drag multiple files to the job, only the last file is added to this job and all other
files are ignored.
Stage 3: Submitting the Batch
Once the job includes a source media file, a setting, a destination, and an output filename,
it is ready for processing.
To submit the batch for processing
µ Click the Submit button to submit the batch containing your job.
Chapter 1 Getting Started Quickly 15A dialog appears where you can name this submission, choose whether to use distributed
processing, and set the priority of this submission. In most cases you can leave the settings
as they are and just click Submit.
For more details about this Submit dialog, see Submitting a Batch.
After you submit a batch, you can open the Compressor History window or the Share
Monitor application so you can monitor the transcoding progress of your batch. You can
also set Compressor preferences to open Share Monitor automatically.
Stage 4: Using Post-Transcoding Actions
Almost every batch template includes an automatic post-transcoding action. When
Compressor has completed transcoding one of these batch template jobs to an output
media file, it will execute a corresponding automatic action, such as uploading the file
to a YouTube account, running an Automator workflow, or burning a DVD.
For more information about job actions such as these, see Job Action Tab and Adding
Actions.
The following list indicates the default post-transcoding job action for each Compressor
batch template.
• Create Audio Podcast: Add to iTunes Library.
• Create Blu-ray disc: Create Blu-ray disc.
• Create DVD: Create DVD.
• HTTP Live Streaming: Prepare for HTTP Live Streaming.
• Publish to Apple TV: Add to iTunes Library.
• Publish to YouTube: Publish to YouTube.
Stage 5: Saving Custom Batch Templates—Optional
For information about the optional step of creating custom templates, see Creating a
Custom Batch Template.
16 Chapter 1 Getting Started QuicklyQuick and Easy Compressor Workflow: Manual Method
The following workflow shows you an easy way to manually build and process a batch
in Compressor.
• Stage 1: Adding Source Media Files
• Stage 2: Assigning Settings and Destinations
• Stage 3: Submitting the Batch
Stage 1: Adding Source Media Files
To use Compressor, you must first add source media files to the Batch window.
To open Compressor and add source media files to the Batch window
1 Double-click the Compressor icon in the Applications folder.
Compressor opens with the Batch Template Chooser and an empty untitled batch with
a placeholder job.
2 Since this workflow is focused on the manual method rather than the batch template
method, click Cancel in the Batch Template Chooser to close it.
To prevent the Batch Template Chooser from opening in the future, select “Don’t show
this dialog again,” or, in Compressor preferences, select Use Blank Template.
For information about the batch template method, see Quick and Easy Compressor
Workflow: Batch Template Method.
Chapter 1 Getting Started Quickly 17The figure below shows the remaining windows in the Compressor interface.
Note: To see the Compressor interface configured similarly to what is shown above,
choose a Standard layout from the Layouts submenu of the Window menu.
3 Drag one or more source files from the Finder or the desktop to an empty area in the
Batch window (in this example, just below the empty job).
Note: If you drag multiple files to the empty job, only the last file is added to this job and
all other files are ignored.
18 Chapter 1 Getting Started QuicklyNew jobs are created for each source file you dragged to the batch.
Each source file creates 
a job in the batch.
Target area (empty in
this case) of a job
See About the Batch Window for more information about the controls in the Batch
window.
Stage 2: Assigning Settings and Destinations
You need to assign at least one setting to each source media file job before you can
submit the batch for processing, but you can also add multiple settings to the same job
to transcode multiple versions of the media file. Each setting-destination pair is known
in Compressor as a target.
Chapter 1 Getting Started Quickly 19To assign a setting and a destination to a job
1 Choose a setting for your source media file jobs in any of the following ways.
• To assign different settings to different jobs: Drag settings from the Settings tab to
individual jobs in the Batch window.
Select one or more 
(two in this case) settings 
to apply to the job.
A job with a source 
media file in the
Batch window
• To assign a single setting to multiple selected jobs: Select the jobs (source media files) in
the Batch window and choose Target > New Target With Setting. This opens a settings
selection dialog over the Batch window.
20 Chapter 1 Getting Started QuicklyClick Add to assign 
the settings to the 
selected jobs.
Select the settings 
to apply to the 
selected jobs.
Select the jobs in 
the Batch window.
Choose one or more settings, using the disclosure triangles to reveal individual settings,
and click Add. The chosen settings are assigned to all the selected jobs.
New targets are added 
for each setting you 
drag to the job.
You can also choose Edit > Select All to select all the jobs before applying the settings.
See Creating, Previewing, and Modifying Settings for more information on settings,
and Finalizing Jobs and Submitting Batches for more information about working with
jobs and targets.
The next step is to set the destination. By default, the destination is set to Source, which
writes the output files to the same folder as the source files originated from. You can
change the destination for organization purposes or to take advantage of larger and
faster hard disks.
Note: You can choose a default destination from the Compressor Preferences window.
See Setting Compressor Preferences for more information.
You can set the destination for each individual target or for a selected group of targets.
Chapter 1 Getting Started Quickly 212 Choose a destination for your job’s targets in one of the following ways.
• Do nothing: Accept the default destination Source (the same folder as the source media
files originated from) specified in the Destination column.
• Use the target’s shortcut menu to change one setting at a time: Control-click the target
you want to change and then choose any of the preexisting destinations available to
you from the Destination submenu.
Use the target’s shortcut 
menu to change the 
destination for the 
selected targets.
You can also choose Other from the shortcut menu to open a dialog to choose any
location available to your computer as the destination.
Note: Choosing Other allows you to choose any location currently accessible from your
desktop, including a mounted open volume. However, this volume must remain open
until the batch has been transcoded.
You can select multiple targets and change all their destinations at once using the same
method. You can also use the Destination submenu of the target’s shortcut menu to
choose a destination, or drag a destination from the Destinations tab to the target.
See Creating and Changing Destinations for more information on destinations.
3 You can name the batch, and save it, by choosing File > Save.
Stage 3: Submitting the Batch
Once each media file has at least one setting and destination associated with it, it becomes
a job, and your batch is ready to be submitted.
To submit a batch for processing
µ Click Submit.
22 Chapter 1 Getting Started QuicklyA dialog appears where you can name this submission, choose whether to use distributed
processing, and set the priority of this submission. In most cases you can leave the settings
as they are and just click Submit.
For more details about this Submit dialog, see Submitting a Batch.
After you submit a batch, you can open Share Monitor so you can monitor the transcoding
progress of your batch. You can also set Share Monitor to automatically open in the
Compressor Preferences window.
Note: You can always open Share Monitor by double-clicking the Share Monitor icon in
the Dock or by clicking its icon in the Batch window.
Chapter 1 Getting Started Quickly 23You can also monitor the encoding progress in the History window.
See Finalizing Jobs and Submitting Batches for more information on jobs and batches.
Optional Tasks You Can Perform Before Submitting a Batch
The three stages described in the previous section show you the fastest way to transcode
media files. Although you can modify your preexisting settings using this method, you
can’t preview your files or fine-tune any settings.
The following chapters describe additional steps that can be performed on the setting
of any job before it is submitted:
• Creating, Previewing, and Modifying Settings
• Finalizing Jobs and Submitting Batches
• Adding Filters to a Setting
• Working with Frame Controls
• Adding Geometry Settings
• Adding Actions
• Using the Preview Window
• Creating and Changing Destinations
The following chapters give a more detailed look at output format settings and various
transcoding options:
• Creating AIFF Files
• Creating Common Audio Format Files
• Creating DV Stream Output Files
• Creating Dolby Digital Professional Output Files
• Creating H.264 for Apple Devices Output Files
• Creating H.264 for Blu-ray Disc
• Creating Image Sequence Files
• Creating MP3 Output Files
• Creating MPEG-1 Output Files
24 Chapter 1 Getting Started Quickly• Creating MPEG-2 Output Files
• Creating MPEG-4 Output Files
• Creating QuickTime Export Component Files
• Creating QuickTime Movie Output Files
Chapter 1 Getting Started Quickly 25Compressor is a powerful and flexible tool that can be used in many different ways to
achieve the results you want.
This chapter covers the following:
• Typical Compressor Scenarios (p. 28)
• Compressor Features (p. 29)
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2Typical Compressor Scenarios
The following are typical Compressor scenarios.
• Converting source media to one or more different output formats: You can use Compressor
to convert one or more media files to one or more different media file output formats.
See Quick and Easy Compressor Workflow: Manual Method for more information.
Apple TV DVD video CD-ROM
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iPad
iPod
iTunes
H.264
MP3
AC-3
MP3
MPEG-1
MPEG-4
QuickTime
AC-3
AIFF
H.264
MPEG-1
MPEG-2
AIFF
MP3
QuickTime
Blu-ray Disc
H.264
AC-3
Source media or
Final Cut Pro project
To web
QuickTime
movie
(for broadband
and lowband)
• Exporting sequences or clips to one or more formats directly from other applications: You
can use Compressor to convert sequences or clips to one or more file formats from
within other applications, such as Final Cut Pro. This workflow is the same as described
in detail in Submitting a Project for Transcoding.
This integration with Final Cut Pro and Motion makes transcoding (the process of
converting files from their original format into output files ready for distribution in
another format) faster and more convenient. Integration also saves hard disk space by
eliminating the need to export intermediate media files before processing them. It also
leverages the video processing technology of the other applications to do much of the
work (therefore maximizing the quality of images that are encoded), and avoids
degradation that can occur from multiple compression and decompression steps.
28 Chapter 2 Ways to Use Compressor• Creating DVD compliant files: Before you can convert your existing media files into a
DVD project, you must convert the video into MPEG-1 (SD projects only), MPEG-2 (SD
and HD projects), or H.264 (HD projects only) files. Compressor can encode audio in
the Dolby Digital Professional format (also known as AC-3). Dolby Digital Professional
is a very common compressed audio format for DVD-Video discs. Compressor also
supports two specialized situations:
• For those situations in which you are editing high definition (HD) sources in
Final Cut Pro and want to create a standard definition (SD) DVD from them,
Compressor includes a high-quality down conversion capability. HD sources using
1080i or 720p resolutions use a high-quality transcoding process to create SD MPEG-2
video output files.
• For those situations in which you must fit the maximum video onto a DVD and do
not require broadcast quality, Compressor includes the ability to export
DVD-Video-compatible MPEG-1 format files.
Compressor Features
Compressor can work as a standalone application or be integrated into the workflow of
other applications, such as Final Cut Pro. To this end, Compressor accepts the same full
range of source media file types that Final Cut Pro accepts. Compressor offers the following
features.
• Batch processing: This streamlined process allows you to create multiple output files
from single source media files.
• VBR options: Using the MPEG-2 encoder, you can set either a single- or dual-pass variable
bit rate (VBR) for your output files, a setting that affects the video file image quality.
• H.264 encoding: H.264 produces higher quality video at lower data rates for everything
from mobile phones to High Definition (HD). H.264 works especially well with the Apple
QuickTime media player. Compressor includes H.264 formats that specifically target
Blu-ray discs, iTunes, iPhone, iPad, iPod, and Apple TV.
• Droplets: These standalone applications can be used for drag-and-drop transcoding
operations straight from your desktop. Once created, Droplets simplify and automate
the transcoding process and can be used even without opening Compressor.
• Settings: Settings contain all necessary file format, filter, and geometry settings needed
for transcoding. You can customize and modify the Apple-supplied settings or create
new ones, making it possible to create a library of specialized settings that can be
reused.
Chapter 2 Ways to Use Compressor 29• Filters: The selection of available Compressor filters gives you dynamic artistic control
while you convert your source media to other formats and allows you to create a final
product to your precise specifications. A selection of the available filters includes fade
in/fade out, timecode overlays, gamma correction, noise removal, letterbox, watermark,
color adjustment, and others. Additionally, there are audio filters for controlling dynamic
range, peak levels, equalization, and fade in/fade out.
• Previewing: You can preview your filter settings in real time using the Preview window
as you adjust them in the Inspector window. This lets you tweak the settings to your
satisfaction, before transcoding the source media file.
• Destinations: You can create and save destinations for your output files, which can then
be assigned to each output file’s target. You can even include FTP and iDisk locations.
A destination can also specify the filenaming convention to use.
• Geometry: You can adjust your frame size using the geometry Inspector window controls
and graphical controls in the Preview window. These features allow you to crop
unwanted image areas of your source media file and reduce file size. Compressor also
allows you to resize your image to other aspect ratios such as 4:3, 16:9, and 2.35:1 for
delivery onto other platforms, such as DVD or iPod.
• Publishing: You can use Compressor to upload output files to a QuickTime Streaming
Server or other locations for DVD authoring.
• AppleScript usage: You can add specialized AppleScript information to any output file,
which gives you the flexibility to automate and customize any post-encoding operations.
• Interoperability: Compressor is an integral component of other Apple professional video
applications such as Final Cut Pro and Motion. For example, you can export sequences
directly from Final Cut Pro into Compressor for transcoding.
• Transcoding activity in the background: Compressor lets you begin transcoding a batch
and then continues processing in the background, allowing you to perform other tasks
at the same time.
• Email notification: You can set up Compressor to send an email notification to any
location to notify you when the batch transcode is complete.
• Distributed processing: Compressor offers distributed processing, distributing the work
to multiple computers that have been chosen to provide more processing power. The
distributed processing feature is limited to computers that have Compressor installed.
For more details, see Apple Qmaster and Distributed Processing.
• Command-Line Features: Compressor has a number of command-line options for
submitting jobs, enabling and disabling service node and cluster-controlling services,
and monitoring batches. For more information, see Using the Command Line.
30 Chapter 2 Ways to Use CompressorCompressor makes it easy to transcode media into multiple formats. In addition,
Compressor is integrated into Final Cut Pro and Motion.
For simple or repetitive workflows, you can also use the Share feature in Final Cut Pro
and Motion. The Share feature is an easy “one-click” way to send your work to clients,
friends, and other audiences without any advanced knowledge of transcoding, delivery
file formats, or FTP protocols. From the Share window in Final Cut Pro and Motion, you
can quickly create and deliver output media files in iPhone, iPad, iPod, Apple TV, DVD,
Blu-ray Disc, and YouTube formats without having to open any additional applications.
For more information about the Share feature, see the Final Cut Pro User Manual and the
Motion User Manual.
This chapter covers the following:
• Compressor Concepts and Terms (p. 31)
• Preparing Compressor for Transcoding with Custom Settings (p. 34)
• Choosing an Output Format (p. 36)
• Creating a Compressor Batch (p. 37)
• Viewing Transcoding Status (p. 39)
• Optional Compressor Shortcuts (p. 39)
Compressor Concepts and Terms
This section covers some common terms that you may encounter as you use Compressor.
The following diagram illustrates how the standard Compressor transcoding process
works. The largest transcoding component is a batch. The batch represents all the
components needed to transcode your current media. It must contain one or more jobs.
A job consists of at least one source media file with one or more targets, each with a
setting and a destination associated with it. After the transcoding process, the resulting
file is known as the output media file. One output media file is created for each setting
assigned to a source media file.
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3In the illustration below, the batch contains two source media files, each of which is a
job containing two targets (sets of a setting and destination). The total number of output
files created by transcoding this batch will be four: Job 1 will create two output media
files, as will Job 2.
Job 2
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Output media file
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Output media file
(Job 2, Target 1)
Output media file
(Job 2, Target 2)
Source 
media file 
1
Source 
media file 
2
Target 1
Setting Destination
Target 2
Setting Destination
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You should familiarize yourself with the following common terms:
• Codec: Short for COmpression/DECompression. A mathematical model for reducing the
data of a source media file.
• File Format: The output format you use to transcode your source media file.
• Group: Contains designated settings placed into a folder in the Settings tab. Groups
help you organize your settings and can simplify the job creation process.
• Transcoding: The process of converting files from their original format into output files
ready for distribution in another format. Closely related terms include compression,
which specifically refers to data reduction, and encoding, a term that is essentially
synonymous with transcoding, but does not emphasize the conversion aspect.
• Source media file: The transcoding process always starts with a source media file, which
is the file intended for transcoding in its original form. Source media files are always
one of the following.
• Movies: Containing video, audio, and other data (such as markers)
• Stills: Used as part of a sequence of still images for certain video productions
32 Chapter 3 The Basic Transcoding Workflow• QuickTime: QuickTime is cross-platform multimedia technology which allows Mac OS
and Windows applications to capture and play back video, audio, and still-image files.
QuickTime files can contain many different kinds of media and codecs. Codecs give
instructions to QuickTime on how to play back the media.
A typical Compressor transcoding process consists of the following components.
• Setting: Once you have imported your source media file, you must assign one or more
settings to it. A setting is a combination of transcode attributes, such as output format,
filter, and geometry settings, that are applied to the source media file during the
transcoding process.
• Output (file) format: The encoder you choose to convert your source media file.
Choose one of the following output formats based on the intended playback method
and environment of your transcoded media files: AIFF, Dolby Digital Professional, DV
Stream, H.264 for Apple Devices (which contains settings for use with an iPhone,
iPad, iPod, or Apple TV), Image Sequence (which supports TIFF and TARGA images),
MPEG-1, MPEG-2, MPEG-4, QuickTime Movie, or QuickTime Export Components.
• Filters: Allow you to adjust different characteristics of your video such as color,
brightness, and sharpness, to maximize your video quality as the file is compressed.
• Geometry settings: Allow you to crop the image and adjust its frame size.
• Actions settings: Allow you to create automatic post-transcoding actions and apply
them to jobs and settings. Easily create and deliver output media files, send email
notifications, and execute post-transcoding tasks using Automator.
Chapter 3 The Basic Transcoding Workflow 33• Destination: A destination also needs to be assigned to the source media file. This is
the location where your transcoded media file is stored. You can either use the default
destination called Source (the same folder the source media file is in), or you can
designate any location to which you have full access. You can also change the default
destination in Compressor preferences. The destination also controls how the transcoded
media file is named.
• Target: A blueprint for creating an output media file containing a setting, a destination,
and an output filename.
• Job: Once you assign one or more targets to the source media file, it becomes a job,
and is ready to be transcoded.
• Batch: A batch consists of one or more jobs that are processed at one time. All jobs
contained within the batch are submitted collectively when you click the Submit button.
• Output media file: The transcoded media files created after the batch is submitted and
processed are called output media files. An output media file is the result of a
successfully transcoded source media file (containing one setting and destination). You
can create as many output media files as there are different settings applied to the
various source media files in the batch.
Preparing Compressor for Transcoding with Custom Settings
Compressor contains a number of preconfigured settings that allow you to start
transcoding immediately. If you want to transcode your source media files immediately
and don’t need to create your own settings, you can follow the steps described in Quick
and Easy Compressor Workflow: Batch Template Method instead. Or if your workflow is
not covered by any of the batch templates and you want to start transcoding immediately,
you can also try the steps in Quick and Easy Compressor Workflow: Manual Method.
However, if you want to create your own settings and destinations, and customize other
attributes such as filters, cropping, frame resizing, and actions settings, you need to follow
the steps outlined below. If the custom settings you create here can be used for all your
transcoding needs, you won’t need to go through these steps again. However, if you
need to create new settings and destinations for each transcoding project, you’ll need
to repeat these steps each time.
Stage 1: Creating a Setting
Unless you are using a preexisting setting or a batch template supplied with Compressor,
you will need to create your own settings. This is done using the Settings tab and begins
with choosing an output format from the File Format menu that opens when you click
the Add (+) button. See Choosing an Output Format for more information. In addition,
you also have the option of adding filters, geometry settings, and post-transcoding actions
and then previewing your setting to ensure satisfaction. See Creating a Setting from
Scratch for more information.
34 Chapter 3 The Basic Transcoding WorkflowYou can also streamline your workflow by putting your settings into groups. See Creating
Groups of Settings for more information.
After you have created a setting, you can further customize it with additional adjustments
such as filters (to adjust image quality or add effects such as letterboxing), pixel size
(geometry values), and post-transcoding actions. These additional adjustments are all
managed in the Inspector window. See Adding Filters to a Setting, Working with Frame
Controls, Adding Geometry Settings, and Adding Actions for more information.
Stage 2: Previewing the Setting
It’s a good time-saving measure to preview your setting before submitting the batch.
This can be done using the Preview window and ensures that the quality of the output
media file is acceptable. The Preview window consists of a split screen displaying the
content of your source media file in its original form in one half, and the content of your
output media file in the other half.
From the Preview window, you can do any of the following:
• Play the media file.
• Dynamically preview effects (in real time).
• Modify the effects of the filters and geometry settings of your setting.
• Compare source or output versions.
• Crop the output file frame size.
• Change the aspect ratio.
• Add various markers (compression, chapter, or podcast).
Note: Frame Controls settings cannot be previewed in the Preview window. To preview
Frame Controls settings, do a test transcode of a small section of your source media file.
(See Transcoding a Portion of the Clip with the Preview Window for more information.)
See Previewing a Setting or Using the Preview Window for more information.
Stage 3: Creating a Destination
By default, your transcoded file is saved in the same folder as your source media file
(Source). However, if you want to store your transcoded files in a different location, you
can create a new destination in the Destinations tab. Using this tab, you can choose any
folder, volume, or remote server for which you have permissions and access to be a
destination, and add useful file identifiers for your transcoded output file. Once you have
created sufficient destinations, you won’t need to open the Destinations tab again.
See Creating and Changing Destinations for more information.
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Selecting the relevant playback platform (Apple devices, DVD, web, CD, and kiosk) is the
first choice you need to make before you compress a source media file into a different
output format. Once you have decided on the platform, you can choose the appropriate
output format for that platform.
Whatever the digital video format of your source media file, you can transcode it using
one of the many encoders supplied with Compressor, including the following
industry-standard formats, all of which have their own particular attributes:
• AIFF: Intended for audio use (including DVD or CD authoring) where you need
customized settings. For more details on the AIFF format, see Creating AIFF Files.
• Common Audio Formats: Intended to provide easy access to the most common audio
formats, including AIFF, Apple CAF files, and WAVE. For more details, see Creating
Common Audio Format Files.
• DV Stream: Common format used for SD projects. See Creating DV Stream Output Files
for more information.
• Dolby Digital Professional: Also known as AC-3. Usually intended for DVD authoring.
For more details on the AC-3 format, see Creating Dolby Digital Professional Output
Files.
• H.264 for Apple Devices: Intended for creating video files suitable for playback using
iTunes, an iPhone, an iPad, an iPod, and Apple TV. For more details on the H.264 for
Apple Devices format, see Creating H.264 for Apple Devices Output Files.
• H.264 for Blu-ray: Intended for creating H.264 settings specifically configured for Blu-ray
Disc. For more details on the H.264 for Blu-ray Disc format, see Creating H.264 for Blu-ray
Disc.
• Image Sequence: Compatible with a wide range of compositing and image processing
applications. For more details see Creating Image Sequence Files.
• MP3: Intended for audio compression. The MP3 format creates audio files that are
compatible with a wide variety of playback devices. For more details on the MP3 format,
see Creating MP3 Output Files.
• MPEG-1: Intended for Internet, CD-ROM, and specialized DVD use. For more details on
the MPEG-1 format, see Creating MPEG-1 Output Files.
• MPEG-2: Intended for standard and high definition DVD use. For more details on the
MPEG-2 format, see Creating MPEG-2 Output Files.
• MPEG-4, Part-2: Intended for a variety of uses including the web or wireless devices.
For more details on the MPEG-4 format, see Creating MPEG-4 Output Files.
36 Chapter 3 The Basic Transcoding Workflow• QuickTime Export Components: Leveraging the component plug-in architecture of
QuickTime, Compressor can output a variety of additional codec options and third-party
formats such as Windows Media, RealPlayer, 3G, and AVI. The QuickTime Export
Components feature allows you to control the third-party encoding engine without
having to open another application. For more details on QuickTime Export Components,
see Creating QuickTime Export Component Output Files.
• QuickTime Movie: Intended for use with QuickTime in a variety of playback environments.
Because QuickTime is cross-platform multimedia technology, it allows Mac OS and
Windows applications to capture and play back video, audio, and still-image files. For
more details on the QuickTime format, see Creating QuickTime Movie Output Files.
Creating a Compressor Batch
This section describes the steps in manually creating and submitting a complete
Compressor batch. For a quicker and easier but more limited method, see Quick and Easy
Compressor Workflow: Batch Template Method.
Once you have the necessary settings and destinations available, you can begin to create
your batch for transcoding. A batch contains one or more jobs. A job consists of one
source media file with one or more targets, which contain the settings and destinations.
You can submit a batch for transcoding only after you have assigned at least one target
(setting and destination) to each job (source media file) in the batch. All jobs in the batch
are submitted together. Think of batches as documents that can be saved, closed, and
opened again. And much like a Final Cut Pro project, a separate tab (that can be torn off)
contains each Compressor batch.
Stage 1: Importing Source Media Files into Compressor
You import source media files into a batch either by using the File Selection dialog or by
dragging the files from the Finder to the Compressor Batch window. You can import
source media files from any folder that you have access to.
See Importing Source Media Files for more information.
Stage 2: Assigning a Setting
Once you have imported your source media file into the Batch window, you need to
assign one or more settings to it. This makes it a job. A source media file can be transcoded
only after it has at least one setting assigned to it, and you can add a setting to a source
media file only after you have either selected a preexisting setting or created one. Your
setting must have an output file format associated with it.
• If you choose a preexisting setting: The output file format has already been assigned.
• If you create your own setting: You must choose an output file format from the file format
menu that opens when you click the Add (+) button in the Settings tab.
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window and choosing a setting from the dialog that appears when you choose Target >
New Target With Setting, or by Control-clicking one of the selected jobs and choosing a
setting from the New Target With Setting submenu of the shortcut menu that appears.
If you have a favorite setting (preexisting or customized), you can streamline your workflow
by creating a standalone application called a Droplet containing multiple settings, and
use the Droplet to submit batches without opening Compressor. See Creating a Droplet
from the Settings Tab for more information.
Note: You can also create groups of settings, which is a quick and convenient way to
assign multiple settings to a source media file. See Creating Groups of Settings for more
information.
Stage 3: Previewing the Setting Using the Preview Window
You can either preview a source media file or the source media file with its assigned
setting. From the Preview window, you can dynamically preview (in real time) and modify
the effects of the filters and geometry adjustments of your setting, play back the media
file, view source or output views, crop the output file frame size, change the aspect ratio,
and add various markers relevant to the MPEG-1, MPEG-2, and H.264 for Apple Devices
formats.
See Previewing a Setting or Previewing a Clip for more information.
Stage 4: Assigning a Destination
You can choose the location to place your output media files by assigning a destination
to each target. The destination also defines various aspects of how the output media file
is named. There are several supplied destinations in the Destinations tab you can choose
from, or you can create your own custom destinations. In addition to assigning a
destination by dragging one from the Destinations tab to a job’s target, you can also use
the Target > Destination menu or the shortcut menu that appears when you Control-click
a target to assign an existing destination to a job. You also have the option of choosing
a location that has not been defined as a destination by choosing Other in the above two
menus.
See Assigning Destinations to Source Media Files for more information.
Stage 5: Submitting the Batch for Transcoding
Once you have created all the jobs you want in the batch and are satisfied with the
settings and quality of your output files (having previewed them), you are ready to submit
the batch. You do this by clicking the Submit button in the Batch window.
Note: If you are transcoding a large batch, you should turn off the screen saver application
on your computer. This will improve the speed of your transcode because resources are
not being diverted to the screen saver.
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Viewing Transcoding Status
You use Share Monitor and the History window to see the current status of a submitted
batch and all the jobs contained within it. Share Monitor is a standalone application, so
that it can work with both Compressor and Droplets, whether or not Compressor is open,
and regardless of whether you have submitted anything. See Creating a Droplet from
the Settings Tab for more information about Droplets.
Stage 1: Viewing the Batch Transcoding Status
After you submit a batch, then you can open Share Monitor so you can view the
transcoding status of your batch. This is a good way to monitor when your batch has
finished transcoding and if any problems occurred during the transcode process. You
can set Compressor Preferences to open Share Monitor automatically.
See Setting Compressor Preferences and the Share Monitor User Manual for more details.
Alternatively, you can look at the History window in Compressor. It contains a progress
bar and, like Share Monitor, it can tell you if a submission was successfully transcoded.
Stage 2: Confirming Transcode Completion
It’s a good idea to open the transcoded media file’s destination folder to ensure that the
media file was transcoded successfully and saved to that location.
Optional Compressor Shortcuts
Compressor was designed with workflow in mind. Depending on your needs, there are
a number of ways to speed up the Compressor transcoding workflow.
Using Preexisting Settings
Compressor contains a number of preexisting settings that allow you to start transcoding
immediately. If these preexisting settings suit your needs, you can transcode your source
media files immediately.
See Quick and Easy Compressor Workflow: Manual Method for more information.
Even if you need to create custom settings, you can group them so that they can be easily
applied to targets. See Creating, Previewing, and Modifying Settingsfor more information.
Using Default Settings and Destinations
If you find that you are applying the same settings and destinations to each source media
file, you can configure Compressor preferences to automatically apply those settings and
destinations. See Setting Compressor Preferences for more information.
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Droplets provide a fast and convenient way to transcode material without even opening
Compressor. You create a Droplet by saving a setting or a group of settings and
destinations as an active icon. When you drag one or more source media files to it, the
Droplet begins the transcoding process automatically.
See Creating a Droplet from the Settings Tab for more information.
40 Chapter 3 The Basic Transcoding WorkflowThe Compressor interface consists of a number of core windows in which you do most
of your transcoding preparation work.
This chapter covers the following:
• Compressor Windows and the Transcoding Workflow (p. 42)
• Creating and Managing Compressor Layouts (p. 43)
• Working with the Compressor Windows (p. 46)
• Batch Window (p. 49)
• Settings Tab (p. 52)
• Destinations Tab (p. 53)
• Inspector Window (p. 53)
• History Window (p. 62)
• Preview Window (p. 63)
• Apple Qmaster Sharing Window (p. 65)
• Share Monitor (p. 66)
• Droplet Windows (p. 67)
• About Changing Values and Timecode Entries (p. 67)
• Keyboard Shortcuts (p. 69)
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4Compressor Windows and the Transcoding Workflow
Each Compressor window represents a part of the transcoding workflow.
Settings and 
Destinations tabs
Batch window
Preview 
window
History 
window
Inspector window
• Batch window: Allows you to import source media files, add settings and destinations,
and name the batch.
• Settings and Destinations tabs: The Settings tab allows you to centrally manage Apple
and custom settings. The Destinations tab allows you to create, modify, or remove
destination settings, set a default destination, and add file identifiers to your output
media filename.
• Inspector window: Allows you easy access to common transcoding controls, and a full
summary table containing all the details of each setting. You can also use the Inspector
window to gather information on source clips, and to make dynamic changes
interactively with the Preview window.
• Preview window: Allows you to play your source media file in its original format, or
preview your source media file with settings that have been assigned to it. You can
see the effects of settings—such as filters and frame resizing—and make adjustments
to these attributes while previewing the media file in real time. You can also use the
Preview window to add and view various kinds of markers.
• History window: The History window allows you to view a full log of all batches submitted
from your computer, including progress bars of those still being transcoded, and pause
or resubmit any batches listed in the log.
• Droplet window (not pictured): Allows you to save one or more settings or groups of
settings into a Droplet, a standalone preset, packaged into a drag-and-drop application
and saved as an icon.
42 Chapter 4 The Compressor Interface• Share Monitor (not pictured): Allows you to view the status of all batches being processed.
(See the Share Monitor User Manual for more information.)
Creating and Managing Compressor Layouts
As you use Compressor you will find that, depending on the particular encoding task you
are configuring, how the various Compressor windows are laid out can affect how easy
Compressor is to use. To help with this, Compressor includes the ability to configure and
save layouts. Layouts define which windows are visible, their size, their position, and
which icons are in the Batch window’s toolbar.
Compressor includes two layouts that you can use to get a starting point for creating
your own custom layouts.
Note: Each layout is available in several sizes, allowing you to choose the size that best
fits your monitor. You can modify any of these layouts and save them as your own custom
layouts.
Standard Layout
The standard layout shows all the Compressor windows, with the Settings and Destinations
tabs sharing a window. This layout is optimized for those times when you are transcoding
a single source media file.
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The batch layout places the emphasis on the Batch window. This layout is optimized for
those times when you are transcoding a number of similar source media files.
Choosing, Saving, and Managing Layouts
Compressor makes it easy to choose a layout.
To choose a layout
µ Choose Window > Layouts, and choose a layout from the list that appears.
Once you choose a layout, the Compressor interface changes to match it.
You can also create and save your own custom layouts.
To save a layout
1 Configure the Compressor interface the way you want it to be saved.
See Working with the Compressor Windows for information on the ways you can work
with the various windows.
2 Choose Window > Save Layout.
3 In the dialog that appears, enter a name for the layout and click Save.
The layout is saved and appears in the Window > Layouts list.
You can manage the layouts list by removing or renaming existing layouts.
To manage your layouts
1 Choose Window > Manage Layouts.
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2 Do any of the following:
• To rename a layout: Double-click it and type the new name.
• To remove a layout: Select it and click the Delete (–) button.
• To save the current interface configuration as a new layout: Click the Add (+) button and
enter a name for the layout.
• To choose a layout and apply it to the current Compressor interface: Choose the layout
and click the Apply button.
3 Click Done when you have finished managing your layouts.
The layout manager closes and the Compressor interface changes to match the chosen
layout setting.
Note: The layouts list is actually divided into two sections—the ones supplied by Apple
and the ones that you create. You cannot rename or delete the Apple-supplied layouts.
The ones that you create are listed in alphabetical order. Use care when naming your
layouts to ensure you can easily locate them in the list.
About the Layout Files
If you have several workstations using Compressor, you might find that you want to be
able to have the same layouts available on all of them.
You can accomplish this by copying the layout files from one system to another, ensuring
you put them in the correct location. The layouts are stored in the following path:
Users/username/Library/Application Support/Compressor/Layouts. The layouts all have
a .moduleLayout extension.
Important: Do not manually add or remove the layout files while Compressor is open.
Compressor checks this location for available layouts as part of its startup process. You
must restart Compressor to have it recognize any changes you have made to these files.
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While the standard and batch workflow layouts present the Compressor interface as a
single large element, it is actually composed of a number of individual windows that can
be positioned and sized to best suit your needs.
Why Are Some Windows Covered Up?
Because the Compressor interface is made up of individual windows, you may find that
when you switch from Compressor to another application and then switch back to
Compressor by clicking one of its windows, only that window appears, with the others
remaining covered by other windows you might have open.
To bring all Compressor windows to the front
Do one of the following:
µ When switching between applications, take advantage of the built-in application switching
feature of Mac OS X. Press Command-Tab to have an application selection dialog appear.
As you hold down the Command key, you can press the Tab key to cycle through the
currently running applications, releasing the Command key once the Compressor icon is
selected. This ensures that all the Compressor windows are visible.
µ Choose Window > Bring All to Front.
µ Click the Compressor application icon in the Dock.
Note: The Compressor toolbar, located along the top of the Batch window, makes it easy
to navigate to the main Compressor windows and to Share Monitor.
Resizing the Compressor Windows
All the Compressor windows can be resized with the exception of the Inspector window,
which has a fixed size.
Each window has a minimum size limit, both horizontally and vertically, that affects how
small you can make the window.
To resize a window
µ Drag the window’s lower-right corner to stretch or compress the window horizontally or
vertically.
Drag this corner to resize 
the window. Note: As you reposition or resize a window, it will snap to a nearby window once you
get close to it. This makes it easy to create a neat layout without gaps or overlaps.
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The Batch window and the Settings and Destinations window can have multiple tabs.
• The Batch window: When you are working with a large monitor and have several batches
open, you might want to be able to see each of them in its own window.
• The Settings and Destinations tabs: By default, the Settings tab and the Destinations tab
are located in the same window. You can choose to have each in its own window or
to close one of the tabs. You can even choose to add any of the other windows (except
the Batch window) as an additional tab to the window.
In both cases, you can also control the order of the tabs.
To move a tab to its own window by dragging
1 Drag the tab out of its current location.
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To move a tab to its own window using a shortcut menu
µ Control-click the tab and choose Tear Off Tab from the shortcut menu.
The tab opens in its own window.
To add a tab from one window to another window by dragging
1 Drag the tab to the tab area of the window you want to add it to.
A highlight appears around the tab area.
2 Release the tab.
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To add a tab from one window to another window by using a shortcut menu
µ Control-click the tab area where you want the window to appear, and choose the tab
from the list that appears in the shortcut menu.
Note: This is the only method that allows you to add the History, Preview, or Inspector
tabs to the window.
To change the order of the tabs in their current window
µ Drag the tab left or right to its new position.
The other tabs move to make room for it.
Once you have the Compressor interface configured as you like it, you can save it as a
layout. That makes it easy to restore the layout or to switch between it and other layouts.
See Creating and Managing Compressor Layouts for more information.
Batch Window
When you first open Compressor, the Batch window appears. The Batch window allows
you to import source media files for compressing, add settings and destinations, name
the batch, and choose where you want to save it. The Batch window is where you place
all source media files in preparation for transcoding.
Note: Generally the Batch window is always showing. If you close it, it will reopen when
you create a new batch (File > New Batch) or open an existing batch (File > Open).
You can use the Compressor menu bar or the toolbar at the top of the Batch window to
open all other windows. (If the toolbar isn’t visible when you open Compressor, click the
button in the upper-right corner of the Batch window to open it.)
Job area
Toolbar
Batch tabs
Batch status
Show/hide
 toolbar button
Batch submission button
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the tabs for the open batches and an area for showing and configuring a batch’s jobs.
For information about adding source media files to a batch, see Adding Source Media
Files to a Batch to Create Jobs. For information on working with jobs and targets, see
Finalizing Jobs and Submitting Batches.
Customizing the Toolbar
The Batch window contains a toolbar that you can customize to better fit your needs.
Note: If the toolbar isn’t visible when you open Compressor, click the button in the
upper-right corner of the Batch window to open it.
To customize the Batch window toolbar
1 Do one of the following to open the toolbar customization palette:
• Choose View > Customize Toolbar.
• Control-click in the toolbar and choose Customize Toolbar from the shortcut menu.
• Click the Customize icon in the toolbar (if present).
The toolbar palette opens.
2 To customize the toolbar, do any of the following:
• To remove items currently in the toolbar: Drag them off.
• To add items to the toolbar: Drag them from the toolbar palette to the toolbar, placing
them where you want them to appear.
• To rearrange items in the toolbar: Drag them from their current location to a new location.
• To restore the toolbar to its default configuration: Drag the default set (located on the
bottom of the palette) to the toolbar.
• To configure how items show in the toolbar: Choose a setting from the Show pop-up
menu.
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3 Click Done when you have finished.
Note: The toolbar configuration is saved as part of a layout. See Creating and Managing
Compressor Layouts for more information about layouts.
It is possible to add more items to the toolbar than there is room for. When that happens,
the right edge of the toolbar shows a double arrow that you can click to get access to
the icons that do not fit.
Click these arrows
to see items that did 
not fit in the toolbar.
About the Toolbar Items
Most of the items you can add to the toolbar can be added only once. There are a few
that can be added multiple times, such as the separator, the space, and the flexible space.
• New Batch: Creates a new untitled batch.
• Open Batch: Opens a dialog for you to locate and select a saved batch to open.
• Close: Closes the currently selected batch.
Note: You cannot close a batch if it is the only one open.
• Add File: Opens a dialog for you to locate and select one or more source media files to
import into the current batch.
• Add Surround Sound: Opens the audio file assignment dialog that you can use to
manually assign files to each audio channel in a surround sound configuration.
• Add Image Sequence: Opens a dialog for you to locate and select the folder containing
the source media image sequence files.
• Submit with Previous Settings: Submitsthe batch by using the settings used by previous
batch submissions, bypassing the submission dialog.
• History: Opens the History window.
• Inspector: Opens the Inspector window.
• Settings: Opens the Settings tab.
• Destinations: Opens the Destinations tab.
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• Share Monitor: Opens the Share Monitor application.
• Create Droplet: Opens a settings selection dialog for you to select the settings for this
Droplet.
• Separator: Adds a vertical line to the toolbar, allowing you to group items together.
• Space: Adds a fixed-width space to the toolbar.
• Flexible Space: Adds a flexible-width space to the toolbar. The space makes it possible
to force items to the left and right edges of the toolbar, with it expanding to fill any
unused area.
• Customize: Opens the toolbar customization palette.
Settings Tab
The Settings tab allows you to centrally manage Apple and custom settings. You use the
Settings tab together with the Inspector window to create and modify settings, decide
exactly which settings you want to use to transcode your source media file, and choose
which output format you want the transcoded file converted to.
To open the Settings tab
Do one of the following:
µ Choose Window > Settings (or press Command-3).
µ Click the Settings icon in the Batch window toolbar (if present).
µ Click the Settings tab (if present).
The Settings tab contains a list of the existing settings and the necessary buttons to add,
remove, or duplicate a setting and to create groups and Droplets.
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create, manage, and choose settings.
Destinations Tab
The Destinations tab allows you to create, modify, or remove destination settings, set a
default destination, and add file identifiers to your output media filename.
To open the Destinations tab
Do one of the following:
µ Choose Window > Destinations (or press Command-4).
µ Click the Destinations icon in the Batch window toolbar (if present).
µ Click the Destinations tab (if present).
See Creating and Changing Destinations for details on how to configure destinations to
simplify your Compressor workflow.
Inspector Window
The Inspector window has easy access to common transcoding controls (for creating and
modifying settings and destinations); a full summary table containing all the details of
each setting; and information about source media files, including A/V attributes, closed
caption data, annotations, and job actions.
To open the Inspector window
Do one of the following:
µ Choose Window > Show Inspector.
µ Click the Inspector icon in the Batch window toolbar.
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About the Automatic Settings
Several items in the settings panes have an optional automatic mode. When the automatic
mode is enabled, Compressor determines the optimal value for the setting.
The Automatic button is 
dark when active, and its 
item is dimmed.
The Automatic button is 
dimmed when inactive, 
and its item is selectable.
In general, when the automatic mode is active, its item is dimmed and cannot be changed.
• If the setting has not been assigned to a source media file: The item says “Automatic.” An
exception is in the Frame Controls pane of the Inspector window, whose state is
undetermined until you have applied the setting to a source media file.
• If the setting has been assigned to a source media file: The item remains dimmed but
shows the value that will be used.
When the automatic mode is inactive, its button is dimmed and you can choose values
for an item as usual.
You can turn the Automatic button on or off to change from on (the button darkens) to
off (the button lightens).
Tip: It is a good idea to verify the values in the Inspectors for those settings that are set
to automatic. Compressor can usually correctly determine the appropriate values; however,
there may be instances where there is not enough information in the source media file
to determine the correct value. For example, some QuickTime clips might not have proper
metadata or the metadata might be incorrect. Additionally, if the source media file uses
nonstandard settings (such as the video frame size or frame rate), Compressor chooses
the nearest standard value to use.
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When you select a job in the Batch window, the Inspector window shows you information
about the job’s source media file and allows you to add annotations, closed caption files,
and job actions.
The Inspector window contains three tabs: A/V Attributes, Additional Information, and
Job Action.
A/V Attributes Tab
The A/V Attributes tab contains general information about the source media file and is
divided into three sections.
• File information: This section shows the filename, location, and type of file.
• Video information: This section, when applicable, shows all video-related information
about the file. This includes its frame size, frame rate, and timecode information.
• Audio information: This section, when applicable, shows all audio-related information
about the file. This includes its sample size and sample rate.
Additional Information Tab
The Additional Information tab allows you to see and modify a variety of metadata items
that might have been added in other applications such as Final Cut Pro or QuickTime.
You can also add metadata items to the output media file. It also includes the ability to
associate a closed caption file with the file.
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files and annotations.
• Closed Caption file field: Displays the name of the closed caption file currently associated
with the source media file.
• Choose (closed caption) button: Use this button to open a dialog and navigate to the
the closed caption file you want to associate with the source media file.
• Clear button: Use this button to remove the associated closed caption file.
• Annotations table: Displays the current annotation types and the corresponding
annotation text.
• Add Annotation pop-up menu: Use this menu to choose the type of annotation you
want to add to the source media file.
• Remove (annotation) button: Use this button to remove the selected annotation.
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The Job Action tab allows you to apply and adjust post-transcoding actions to entire jobs.
See Adding Actions for more information.
• When job completes pop-up menu: Use this pop-up menu to select and apply a
post-transcoding action for a job selected in the Batch window.
About the Settings Panes
When you select a setting in the Settings tab or a target in a batch’s job, the Inspector
shows one of six panes.
Summary Pane
The Summary pane contains the Summary table, which describes all the settings (video
and audio settings, geometry, and filter settings) associated with the setting selected in
the Settings tab. Information in the Summary table is updated automatically whenever
any setting is modified.
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• Name: The name of the setting selected in the Settings tab.
• Description: A description of the setting selected in the Settings tab.
• File Extension: The extension assigned to the transcoded media file. This identifies which
format your source media file is being converted to.
• Estimated file size: When assigned to a source media file, this shows the estimated total
file size. When not assigned to a source media file, this shows an estimated size per
hour of source media.
Note: The estimated total file size is not available for all output formats.
• Audio Encoder: Details of the audio output file format and other transcoding settings,
such as sample rate, channels, bits per sample, and codec type.
• Video Encoder: Details of the video output file format and other transcoding settings
such as frame width and height, crop amount (in pixels), frame rate, aspect ratio, codec
type, pixel depth, spatial quality, minimum spatial quality, key frame interval, temporal
quality, minimum temporal quality, and data rate (in bits per second).
• Filter: Details of all, some, or none (depending on how many filters you selected in the
Filters pane) of the available Compressor filters.
Encoder Pane
You use the Encoder pane to select and configure the output file format and other settings.
The file format options and attributes are different for each format.
• File Format: Use this pop-up menu to choose an output file format. See Choosing an
Output Format for more information on the available output formats.
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on the format you choose from the File Format pop-up menu, and if video and audio
tracks are enabled. Don’t alter this field without good reason, because your file may
not be recognized if you do.
• aiff: Represents AIFF.
• ac3: Represents Dolby Digital Professional.
• caf: Represents Apple CAF files.
• dv: Represents Digital Video (DV) format video.
• mpg: Represents MPEG-1 multiplexed (video and audio) stream.
• m1v: Represents MPEG-1 video elementary stream.
• m1a: Represents MPEG-1 audio elementary stream.
• m2v: Represents MPEG-2 video elementary stream.
• m2t: Represents MPEG-2 transport stream.
• mpeg: Represents MPEG-2 program stream.
• m4v: Represents H.264 for Apple Devices.
• mp4: Represents MPEG-4.
• mov: Represents QuickTime.
• tga: Represents TARGA.
• tiff: Represents TIFF.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with two–pass or
multi-pass encoding. For more information, see Job Segmenting and Two-Pass or
Multi-Pass Encoding.
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This pane of the Inspector offers automatic and customized settings for advanced image
analysis in frame resizing and frame retiming.
Frame resizing would be necessary when transcoding between a high definition format
such as 1080i and a standard definition format such as DV-NTSC. An example of frame
retiming would be when transcoding between video formats with different frame rates
such as NTSC (29.97 frames per second) and PAL (25 frames per second). For more
information about the Frame Controls pane, see About the Frame Controls Pane.
Filters Pane
You use the Filters pane to add filters to your setting. You can perform tasks such as
gamma correction and noise removal from here.
60 Chapter 4 The Compressor InterfaceSelect the checkbox next to any of the filters you want to include in a particular setting.
Use each filter’s sliders or arrow controls to adjust your filter settings as necessary.
Filters are applied to the source media file in the order you organize them in the Filters
list. You can reorder filters by dragging them up or down in this list.
For more information about the Filters pane, see About the Filters Pane.
Geometry Pane
You use the options in the Geometry pane to crop and size the media file being
compressed and set its aspect ratio.
The Geometry pane has three sections:
• Source inset (Cropping): Use any of the four fields to enter the number of pixels by which
you want to reduce the source media file size, or choose a setting from the “Crop to”
pop-up menu to have Compressor enter crop values based on the source media file
video content.
• Dimensions (encoded pixels): Use the Frame Size pop-up menu or these fields to create
an appropriate output frame size and aspect ratio for your output media file. Use the
Pixel Aspect pop-up menu to set width and height values to conform to a designated
pixel aspect ratio.
• Output image inset (Padding): Use the Padding pop-up menu to calculate the output
height or width values. With Custom selected, you can enter values in the fields.
For more information about the Geometry pane, see Adding Geometry Settings.
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You use the Actions pane to activate transcode-completion notification emails and assign
a default destination to this setting.
• Email Notification to checkbox and field: Use to enter the address to which you want an
email notification sent after the media file has been transcoded, or in the event of an
error.
• Default Destination: Choose a destination from the pop-up menu that you want this
setting to use as its default.
For more information about the Actions pane, see Adding Actions.
History Window
The History window gives you quick access to and some information about previously
submitted batches. You can use this window to pause a transcoding operation, resubmit
batches by dragging them to the Batch window, or view submission details about
particular batches. You can also use it to locate the output media files from previously
submitted batches.
The History window also contains a progress bar that you can use to monitor the status
of previously submitted batches.
To open and close the History window
Do one of the following:
µ Choose Window > History (or press Command-1).
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Note: The History window automatically opens if it is closed when you submit a batch
for transcoding.
The History window contains entries that display information about the batch name and
the date and time it was originally transcoded. The entries are ordered by date, with the
oldest first. When you drag a batch into the Batch window for resubmission, a new untitled
batch is created for it (any existing batches are unaffected).
For more information about the controls and settings in the History window, see About
the History Window.
Preview Window
The Preview window consists of a split screen that displays your selected source media
file in its original form on the left side, and what your output media file will look like on
the right side. This allows you to make a comparison between the original and transcoded
versions and adjust your settings as necessary. Using the options in this window, you can
crop the frame, add key frames, and change the aspect ratio.
To open the Preview window
Do one of the following:
µ Choose Window > Preview (or press Command-2).
Chapter 4 The Compressor Interface 63µ Click the Preview button in the Batch window toolbar.
Marker pop-up menu 
button
The Preview window has additional features, including a Marker pop-up menu. The Marker
pop-up menu allows you to import chapter lists or manually add chapter (and podcast)
markers and compression markers (to improve the compression quality of your media
file).
For more information about the controls and settings in the Preview window, see About
the Preview Window.
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Compressor includes a distributed processing feature that you can use to speed up your
transcoding jobs. It allows you to harness the power of multiple computers on your local
network to spread out the work. The Apple Qmaster Sharing window, opened by choosing
Apple Qmaster > Share This Computer, provides most of the controls needed to configure
a distributed processing system. For details on setting it up, see Apple Qmaster and
Distributed Processing.
Chapter 4 The Compressor Interface 65Share Monitor
You use Share Monitor to monitor the progress of all transcoding batch activity, including
estimates for the transcoding time remaining for all jobs. Share Monitor is a separate
application that can be opened without opening Compressor. For more details on Share
Monitor, see the Share Monitor User Manual.
To open Share Monitor
µ Click the Share Monitor button in the Batch window toolbar.
You can also set Compressor preferences so that Share Monitor opens automatically when
you submit a batch. See Setting Compressor Preferences for more information.
Share Monitor displays the status of all your submitted batches, including each batch’s
name and other details. You can view reports for both successful and failed jobs in Share
Monitor as well as the History window.
For more information about the controls and settings in Share Monitor, see the Share
Monitor User Manual.
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You can save one or more settings or groups of settings into a Droplet, a standalone
preset, packaged into a drag-and-drop application and saved as an icon. Then you can
transcode source media files (without even opening Compressor) by simply dragging
them to a Droplet icon. See Using Dropletsfor information on creating and using Droplets.
Drag selected source 
media files to a Droplet 
to transcode them.
You can open any Droplet and view its window for full details about the Droplet.
To open a Droplet window
µ Double-click a Droplet icon.
For more information about the controls and settings in the Droplet window, see About
the Droplet Window.
About Changing Values and Timecode Entries
Compressor includes several types of value entry methods. Most of them have features
that can make changing the values or timecode fields much easier.
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There are two methods used to enter general numeric values: traditional sliders with
separate numeric entry fields and value sliders that combine the slider with the numeric
entry field.
Value slider with 
combined slider and 
numeric entry field
Separate slider and 
numeric entry field
Value sliders allow you to enter a specific number in the value field or to drag in the value
field to set a value. When using the value sliders, you can use a modifier key to make
normal, small, or large value adjustments. Dragging in the middle area (where the number
is) works the same as an ordinary slider; dragging to the right increases the value and
dragging to the left decreases the value. Additionally, you can click the right or left arrow
to change the value one step at a time. You can also double-click the number itself and
type a new number to enter a specific number in the value field.
To change values in normal increments
Do one of the following:
µ Drag left or right in the value field.
µ Click the left arrow to decrease a value, or click the right arrow to increase a value.
µ If you have a three-button mouse with a scroll wheel, click in the value field and use the
scroll wheel on the mouse.
To change values in fine increments
Do one of the following:
µ Option-drag in the value field.
µ Option-click the left arrow to decrease a value, or Option-click the right arrow to increase
a value.
µ If you have a mouse with a scroll wheel, Option-scroll in the value field.
To change values in coarse increments
Do one of the following:
µ Shift-drag in the value field.
µ Shift-click the left arrow to decrease a value, or Shift-click the right arrow to increase a
value.
µ If you have a mouse with a scroll wheel, Shift-scroll in the value field.
When a value slider or value field is active (highlighted), press Tab to move to the next
field.
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Compressor uses timecode value sliders for all timecode entry fields. In addition to being
able to enter timecode values directly, you can “scrub” the timecode value by dragging.
If you place the pointer over a segment of the timecode, small arrows appear above and
below that segment.
You can drag up or to the right to increase the value in that segment (values in segments
to the left will also increment if your dragging causes the selected segment to roll over).
Dragging to the left or down decreases the value. You can hold down the Option key to
make the value changes slower, or the Shift key to make them faster.
Alternatively, you can click the up and down arrows on each side of the timecode value
or press the keyboard’s Up Arrow and Down Arrow keys to increase or decrease the
timecode value.
You can control which segment is affected by the up and down arrows by selecting a
segment so that a caret appears below the segment. You can also use the keyboard’s
Left Arrow and Right Arrow keys to select other segments.
Keyboard Shortcuts
For complete lists of Compressor keyboard shortcuts, see General Compressor
Keyboard Shortcuts and Preview Window Keyboard Shortcuts.
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This chapter covers the following:
• About Compressor Preferences (p. 71)
• Using Compressor Preferences (p. 74)
About Compressor Preferences
Use the Compressor Preferences window to configure a variety of Compressor controls.
The Compressor Preferences window contains the following controls.
Compressor Preferences Details
• Email Address: Use this field to enter the default email address for email notification.
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5• Outgoing Mail Server: For more information about email notification, see Working with
Post-Transcoding Actions.
• Automatically launch Share Monitor: Use this checkbox to control whether Share Monitor
automatically opens when you submit a batch.
• Display job thumbnails: Use this checkbox to control whether thumbnail images are
displayed for jobs in a batch.
• Cluster Options: Choose one of the following to control cluster options (for distributed
processing scratch storage settings).
• Copy source to cluster as needed: Instructs Compressor to copy source files to a
cluster’s scratch storage location as needed.
• Always copy source to cluster: Requires Compressor to always copy source files to a
cluster’s scratch storage location.
• Never copy source to cluster: Prevents Compressor from copying source files.
• Never copy files to/from cluster: Prevents Compressor from copying any files. Either
all the files are in the correct locations, or the batch fails.
• Copy at submission (high priority): Use this checkbox to control whether Compressor
transfers Source files to the processing cluster immediately.
• Default Setting: Use the Default Setting pop-up menu to choose from the list of existing
settings.
• Default Destination: Use the Default Destination pop-up menu to choose from the list
of existing destinations.
• For New Batches: Choose one of the following options for setting the Compressor
startup screen.
• Show Template Chooser: Compressor opens with the Batch Template Chooser on
startup.
• Use Blank Template: Compressor opens with an empty untitled batch with a
placeholder job.
• Allow connections from other computers: Use this checkbox to control whether remote
computers running Share Monitor can view this computer’s job status. Share Monitor
on the remote computer only needs to know the IP address or hostname. (There is no
password to enter.)
• Enter IP addresses or ranges for manually selected computers: This table displays
information about remote host computers.
• Add/Remove button: Use this button to add or remove information about remote host
computers.
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The remote computer address dialog is displayed when you click the Add/Remove button
in the main Compressor Preferences window. Use this window to enter IP addresses or
ranges for manually selected computers.
This dialog contains the following controls:
• Host/Host IP address range buttons: These buttons control whether this dialog is in IP
Address mode (in which you enter a specific address) or IP Address Range mode (in
which you enter a range of addresses).
• Host: Use this mode to enter a host name and IP address for a specific remote
computer.
• Host IP address range: Use this mode to enter a name and set of range numbers
(Range From, Range To) for a range of remote IP addresses.
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Follow the instructions below to set Compressor preferences.
To open Compressor preferences
µ Choose Compressor > Preferences, or press Command-Comma (,).
The Preferences window appears.
To configure the email notification preference
1 Enter the default email address to use when email notification is activated.
You can change this address in the Actions pane of the Inspector window.
2 Enter the mail server used by this computer for outgoing email.
For more information about email notification, see Working with Post-Transcoding Actions.
To set whether or not Share Monitor automatically opens
Do one of the following:
µ Select the “Automatically launch Share Monitor” checkbox to have Share Monitor
automatically open when you submit a batch.
µ Deselect the “Automatically launch Share Monitor” checkbox to prevent Share Monitor
from automatically opening. You can still manually open Share Monitor from the Batch
window.
To control whether thumbnail images are displayed for each job in a batch
µ Select “Display job thumbnails” to have Compressor display the images.
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To control cluster options (for distributed processing scratch storage settings)
µ Choose an option from the Cluster Options pop-up menu:
• Copy source to cluster as needed: Instructs Compressor to copy source files to a cluster’s
scratch storage location as needed.
• Always copy source to cluster: Requires Compressor to always copy source files to a
cluster’s scratch storage location.
• Never copy source to cluster: Prevents Compressor from copying source files.
• Never copy files to/from cluster: Prevents Compressor from copying any files. Either all
the files are in the correct locations, or the batch fails.
To control whether Compressor transfers Source files to the processing cluster
immediately
Do one of the following:
µ Select “Copy at submission (high priority)” to have Compressor transfer source files
immediately.
µ Deselect “Copy at submission (high priority)” to prevent Compressor from transferring
source files immediately.
To control the default setting
µ Use the Default Setting pop-up menu to choose from the list of existing settings.
The setting you choose appears as the default setting when you import a new source file
in the Batch window.
To change the default destination
µ Use the Default Destination pop-up menu to choose from the list of existing destinations.
The destination you choose appears as the default destination when you import a new
source file in the Batch window.
To control whether Compressor displays the Batch Template Chooser on startup
µ Select Show Template Chooser to display the Batch Template Chooser on startup.
µ Select Use Blank Template to not display the Batch Template Chooser on startup.
To control whether other computers with Share Monitor can view this computer’s job
status
µ Select “Allow connections from other computers” to allow remote computers running
Share Monitor to monitor this computer’s job status.
The remote computer needs to know this computer’s IP address or hostname. (There is
no password.)
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1 Click Add (+) at the bottom of the Compressor Preferences window.
The host address dialog appears.
2 In the host address dialog, do one of the following:
• Select Host, complete the Host Name and IP Address fields, and click Add Host.
Note: You can also enter only the host name or the IP address and press the Tab key.
If a corresponding host name or IP address is found, the match is entered in the field
automatically.
• Select “Host IP address range,” complete the Range fields, and click Add Range.
The hosts or host ranges appear in the Host table in the main Preferences dialog.
Important: Any changes you make to the Compressor preference settings take effect
only when you click OK. If you make changes but decide not to use them, click Cancel.
76 Chapter 5 Setting Compressor PreferencesThe first step in the traditional Compressor transcoding process is to import at least one
source media file into the Batch window.
Note: If you are using the batch template workflow, the first step would be to choose a
batch template. For more information about the simple batch template workflow, see
Quick and Easy Compressor Workflow: Batch Template Method.
This chapter covers the following:
• About the Batch Window (p. 77)
• Adding Source Media Files to a Batch to Create Jobs (p. 81)
• Using the Inspector with Source Media Files (p. 89)
• Tips on Importing Source Media Files (p. 92)
About the Batch Window
The Batch window provides a central location for organizing your transcoding tasks and
quickly assigning settings. When you first open Compressor, an untitled Batch window
appears. Think of batches as documents that can be saved, closed, and opened again.
You use the toolbar at the top of the Batch window to open all other task windows.
Job area
Toolbar
Batch tabs
Batch status
Show/hide
 toolbar button
Batch submission button
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6General Batch Window Information
Batches are the heart of your Compressor workflow, and the Batch window is where you
work with the batches. The Batch window supports having multiple batches open at
once, showing them as separate tabs.
To create a new batch
µ Choose File > New Batch (or press Command-N).
A new untitled batch is added to the Batch window. Depending on how For New Batches
is configured in Compressor preferences, the Batch Template Chooser may appear.
Note: To create a new batch and make sure the Batch Template Chooser appears, choose
File > New Batch from Template (or press Command-Shift-N).
Each tab is for 
a different batch.
The new batch’s tab 
See Saving and Opening a Batch File for more information about batch files. See About
the Batch Template Chooser for more information about the Batch Template Chooser.
You can even have multiple Batch windows open, with each containing a different batch,
by dragging a batch’s tab to a new location. See About the Tabs for information on
dragging tabs to open or close additional Batch windows.
The Batch window has a Submit button, located in the lower-right corner, that you can
use to begin transcoding the currently selected batch. The lower-left corner shows the
status of the current batch (how many jobs it contains and whether it has been submitted).
About the Batch Template Chooser
To simplify common workflows, Compressor includes a Batch Template Chooser that can
appear anytime you create a new batch. The For New Batches setting in Compressor
Preferences controls whether the Batch Template Chooser appears. See About Compressor
Preferences for details on this setting.
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configure a new batch.
Choosing a template adds one or more settings to the batch, as well as a job action to
be executed once the batch output is finished.
The standard Apple batch templates are listed below.
• Create Audio Podcast: Use this template to create an AAC audio file suitable for
podcasting and add it to the iTunes library.
• Create Blu-ray disc: Use this template to create BD H.264 video and Dolby Digital
Professional (.ac3) audio files and automatically burn them to a Blu-ray disc or an AVCHD
disc (AVCHD discs can be played in Blu-ray Disc players that are compatible with the
AVCHD format).
• Create DVD: Use this template to create a standard definition DVD using MPEG-2 (.m2v)
video and Dolby Digital Professional (.ac3) audio and automatically burn it to a disc.
• HTTP Live Streaming: Use this template to create a set of files you can use to stream a
movie to iPhone, iPad, iPod touch, and Mac, using an ordinary server.
• Publish to Apple TV: Use this template to create a video file suitable for viewing on
Apple TV and add it to the iTunes library.
• Publish to YouTube: Use this template to create a video file suitable for viewing on
YouTube and upload it to a YouTube account.
Note: Your choice of a template should be based on the intended use of the output
media file you are creating. If there is no obvious template for your intended workflow,
you may want to try the manual method. For more information, see Quick and Easy
Compressor Workflow: Manual Method. For information about creating custom templates,
see Creating a Custom Batch Template.
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You can save any batch as a custom batch template. Custom batch templates appear as
options in the Batch Template Chooser, alongside the default Apple batch templates.
Custom batch templates can save you time, particularly with workflows that you repeat
often.
To create a custom batch template
1 In the Batch window, do one of the following to open a batch with the characteristics
(jobs, settings, destinations, job actions, and so on) that you want in the batch template:
• Create a new batch and make the needed adjustments.
For more information, see The Basic Transcoding Workflow, Assigning Settings, Assigning
Destinations, and Adding Actions.
• Open a saved batch with the characteristics that you want in the batch template.
For more information, see Saving and Opening a Batch File.
2 Choose File > Save as Template.
3 In the dialog that appears, enter a name and description, then click OK.
The custom batch template is saved.
Optionally, choose File > New Batch from Template to open the Batch Template Chooser
and confirm or use your new custom batch template.
About the Batch Window Toolbar
The Batch window has a customizable toolbar along its top. You can choose whether to
show or hide the toolbar by clicking the button in the window’s upper-right corner.
Show/hide toolbar 
button (with the toolbar 
hidden in this example)
You can choose to have a variety of items in the toolbar, such as items to open, save, or
close a batch. See Customizing the Toolbar for details on the items you can add and how
to add them.
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You need to import the source media files into the batch in the Batch window before
you can add any transcoding settings to them. Once they are imported into the batch,
the source media files create a job, which is the first step to getting the files transcoded.
There are special methods to use when importing surround sound source media files.
Adding Standard Source Media Files to Batches
Following are the details for adding standard (non–surround sound or image sequence)
source media files to a batch.
To add source media files to a batch
1 Open Compressor.
The Batch window opens with an empty batch tab named Untitled.
Untitled batch tab
Empty batch area with 
a placeholder job
Note: If the Batch Template Chooser opens automatically, click Cancel to close the Batch
Template Chooser. To prevent the Batch Template Chooser from opening when you open
Compressor, select the “Don’t show this dialog again” checkbox, or, in Compressor
preferences, select For New Batches: Use Blank Template.
2 Do one of the following:
• Choose Job > New Job With File (or press Command-I), navigate to the relevant media
file folder, select one or more source media files, and then click Open.
• Click the Add File button (in the Batch window toolbar, if visible), navigate to the
relevant media file folder, select one or more source media files, and then click Open.
• Control-click a job and choose Source > File from the shortcut menu.
• Control-click an empty area of the batch and choose New Job With File from the shortcut
menu. You can then navigate to the relevant media file folder, select one or more
source media files, and then click Open.
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batch.
Note: You can combine the above steps by selecting all the source media files you want
to transcode before opening Compressor and then dragging them to the Compressor
application icon. This opens Compressor and adds the media files to the default untitled
batch at the same time.
3 Save the batch by choosing File > Save As (or pressing Command-Shift-S).
4 Enter a name for the batch and choose the location where you want to save it in the
dialog that appears.
5 Click Save when done.
The tab in the Batch window changes to match the name of the file.
Note: If your Finder preferences are set to show the extensions, the extension .compressor
appears in the tab along with the name.
You are not actually required to name and save your batches, and for quick jobs you
might decide not to. However, naming and saving a batch makes it easy to go back and
resubmit it later if you find that the output files were not as expected or if your needs
change. It also makes it easier to figure out what is in the History window and in Share
Monitor if you submit multiple batches in a short period of time.
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with video content also include a thumbnail image and a scroller that you can use to
scroll through the video.
Drag the slider to scroll 
through video files.
Click anywhere in the job 
to see this file’s attributes 
in the Inspector window.
Each source media
file creates a job.
The targets for this job 
will appear in this area.
You can change the source media file assigned to a job.
To change the source media file assigned to a job
1 Select the job for which you want to change the source media file.
2 Do one of the following:
• Choose Job > Source > File, navigate to the relevant media file folder, select one or
more source media files, and then click Open.
• Control-click the job and choose Source from the shortcut menu. You can then navigate
to the relevant media file folder, select one or more source media files, and then click
Open.
• Drag a new source media file to the job.
Any targets you had already configured remain and are now applied to the new source
media file. You can also remove a source media file from a job if needed.
To remove a source media file from a job
µ Control-click the job and choose Clear Source from the shortcut menu.
To remove a job from a batch
Do one of the following:
µ Select the job and press Delete.
µ Control-click in an empty part of the batch and choose Remove All Jobs from the shortcut
menu.
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Adding Surround Sound Source Media Files to Batches
There are two methods you can use to add audio files to a batch to create a surround
sound job: an automatic method that relies on file naming to map the audio files to the
proper channels and a manual method that allows you to manually assign the audio files
to the channels.
Each method results in a job to which you can add a setting that supports surround sound
audio outputs, such as Dolby Digital Professional, AIFF, and several audio codecs in the
QuickTime Movie output format.
Important: Some of the output formats have multiple configurations for the surround
sound audio channels. Be sure you know which configuration your intended playback
device requires. For example, the AIFF output format provides four different configurations
for 5.1 (six-channel) audio outputs, with the difference being the order of the channels.
Assigning Files to Surround Sound Channels (Automatic Method)
Compressor offers some streamlined channel assignment techniques that can save you
time.
To assign files to surround channels with channel identifier codes
1 Append the channel identifier code of the target surround channel to the filename of
each source audio file. (See the list below for the appropriate channel identifier codes.)
• -L: Left front channel
• -R: Right front channel
• -C: Center front channel
• -Ls: Left surround channel
• -Rs: Right surround channel
• -S: Center surround channel
• -LFE: Low frequency channel (Subwoofer, LFE)
For example, to assign an AIFF file to the left surround channel, rename the file as
filename-Ls.aiff (where filename is the name of your file). (The channel identifier codes
must include the hyphen, as shown.)
Note: Mac OS X may add a file extension like .aiff. This will not interfere with this channel
assignment method.
This procedure works only when you drag and drop files into the Batch window. If you
drag the files onto the Compressor application icon, they will appear as separate source
files, each in its own job.
84 Chapter 6 Importing Source Media FilesNote: If you are creating Dolby Digital Professional (AC-3) surround sound streams, you
will not use all the channels listed in the table at once. See Audio Tab Settings for a
diagram of the Dolby audio coding modes.
2 Drag the renamed source audio files to the Batch window.
If the following conditions are met, Compressor automatically collapses the entire group
of files into what appears as a single surround source media file in the Batch window:
• The files in the group must be named correctly. (See the list in the previous step.)
• The total number of files in the group must be fewer than seven.
Assigning Files to Surround Sound Channels (Manual Method)
Follow these steps to use the manual method for assigning individual audio files to
surround sound channels. Additionally, you can add a video file to the surround sound
job.
To manually assign source audio files to channels of a surround sound stream
1 Do one of the following to import the source audio files:
• Choose Job > New Job With Surround Sound Group (or press Command-Control-I).
• Click the Add Surround Sound button in the Batch window.
• Control-click in the batch and choose New Job With Surround Sound Group from the
shortcut menu.
The channel assignment interface opens.
2 Do one of the following to assign a source audio file to a particular channel:
• Drag the source audio file from the Finder to the icon for a specific channel (for example,
“L”).
• Click the icon for a specific channel (for example, “L”) and use the Open dialog to locate
the source audio file intended for that channel.
The file is now assigned to the “L” (Left Front) channel.
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stream.
Note: If you are creating Dolby Digital Professional (AC-3) surround sound streams, you
will not use all the channels listed in the table at once. See Audio Tab Settings for a
diagram of the Dolby audio coding modes.
4 Optionally, click the Add Video button to select a video file to include with the surround
sound job.
5 When you have finished adding source audio and video files to the channel assignment
interface, click OK.
The group of surround files appears as a single surround source media file job in the
Batch window.
About Surround Sound Jobs
Once you have created a surround sound job, the Batch window shows the surround
sound icon in the source media file thumbnail (unless a video file was added to the job)
and the Inspector window shows the channels and their assigned files.
Click a channel’s icon to 
change the file assigned 
to that channel.
You can change any of the file assignments in the Inspector window.
To change a surround sound file assignment
1 Click the speaker icon of the channel you want to change.
A file selection dialog opens.
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3 Optionally, you can either click Add Video to add a video file to the job, or delete the
video file already assigned and then click Add Video to choose a different video file.
See Creating Dolby Digital Professional Output Files for information on creating Dolby
Digital Professional output files.
Adding Image Sequences to Batches
You can import a sequence of still images into Compressor as a single image sequence
job and then apply an output frame rate and an audio file to the job. From that point,
you treat the job as you do any other Compressor source media file, adding settings,
destinations, filters, and post-transcoding actions to create an output media file with the
desired video and audio formats and characteristics.
To add a still image sequence job to a batch
1 Open Compressor.
The Batch window opens with an empty batch tab named Untitled.
Untitled batch tab
Empty batch area with 
a placeholder job
Note: If the Batch Template Chooser opens automatically, click Cancel to close the Batch
Template Chooser. To prevent the Batch Template Chooser from opening when you open
Compressor, select the “Don’t show this dialog again” checkbox, or, in Compressor
preferences, select For New Batches: Use Blank Template.
2 Do one the following:
• Click the Add Image Sequence button and navigate to the folder containing the image
sequence files you want to import.
• Choose Job > New Job With Image Sequence (or press Command-Option-I) and navigate
to the folder containing the image sequence files you want to import.
3 Select the folder containing the image sequence files you want to import.
4 Click Open.
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5 Select the job in the Batch window.
The Inspector window displays the A/V Attributes tab containing information and controls
for the new image sequence job.
6 Do any of the following:
• Confirm the selected image sequence files. (Click the Info (i) button for the complete
list of files.)
• Confirm the video format information in the Video section.
• Use the Native Field Dominance pop-up menu to adjust the field dominance for the
source files. (The choices are Progressive, Top First, and Bottom First.)
• Use the Frame Rate pop-up menu to adjust the frame rate for the source files by
choosing from a list of standard frame rates.
• Click Choose Audio to locate, select, and add an audio file to the image sequence job.
Note: Compressor supports the following audio file types for image sequences: AIFF,
MP3,  MPEG-4 audio-only (.m4a), and QuickTime movie (.mov).
88 Chapter 6 Importing Source Media FilesNote: You can also use Compressor to output an image sequence. For more information,
see Creating Image Sequence Output Files.
Using the Inspector with Source Media Files
When you select a batch’s job, the Inspector window shows you information about the
job’s source media file.
The Inspector window contains three tabs: A/V Attributes, Additional Information, and
Job Action.
A/V Attributes Tab
The A/V Attributes tab contains general information about the source media file and is
divided into three sections.
• File information: This section shows the filename, location, and type of file.
• Video information: This section, when applicable, shows all video-related information
about the file. This includes its frame size, frame rate, and timecode information.
• Audio information: This section, when applicable, shows all audio-related information
about the file. This includes its sample size and sample rate.
Chapter 6 Importing Source Media Files 89Additional Information Tab
The Additional Information tab allows you to see and modify a variety of metadata items
that might have been added in other applications such as Final Cut Pro or QuickTime. It
also includes the ability to associate a closed caption file with the file.
To associate a closed caption file with a job’s source media file
1 Click the job to show the source media file’s attributes in the Inspector window.
2 Click the Additional Information tab.
3 Click Choose, locate the closed caption file (must be a Scenarist closed caption format
file, usually with an .scc file extension), and click Open.
Note: Closed caption data is supported by the H.264 for Apple Devices, MPEG-2, and
QuickTime Movie output formats.
Depending on the output format of the job’s target, Compressor applies the closed
caption file to the output media files.
• For QuickTime outputs: Compressor adds the closed caption file as a closed caption
track to the QuickTime output file. You can view the closed captions using
QuickTime Player (version 7.2 or later).
• For MPEG-2 elementary stream outputs: Compressor embeds the closed caption data in
an elementary MPEG-2 video stream so that it can be used for DVD authoring.
• For MPEG-2 program and transport stream outputs: Compressor embeds the closed
caption data in program and transport MPEG-2 streams using the EIA-708 ATSC protocol.
Important: The timecode values in the closed caption file must directly relate to the
timecode of the source media file. You can open a closed caption file in TextEdit to see
the timecode values it contains (the actual text is encoded and cannot be read this way).
90 Chapter 6 Importing Source Media FilesTo add an annotation
1 Click the job to show the source media file’s attributes in the Inspector window.
2 Click the Additional Information tab.
3 Use the Add Annotation pop-up menu to choose the type of annotation.
4 Double-click the corresponding Value field and enter the annotation text.
5 Click Save.
Note: This Add Annotation feature is supported by the H.264 for Apple Devices, MP3,
and QuickTime Movie output formats.
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The Job Action tab allows you to apply and adjust post-transcoding actions to entire jobs.
For complete details on using the Job Action tab, see Adding Job Actions.
Tips on Importing Source Media Files
Here are some additional tips on importing source media files.
Highly Compressed Source Files
It is strongly recommended that you do not use highly compressed source files, such as
MPEG files, as your source files, because they can cause undesirable artifacts in the encoded
video.
QuickTime Reference Movies
If you submit a reference movie for distributed processing, the Apple Qmaster distributed
processing system will automatically copy the appropriate media files to the processing
cluster. For the best performance, you can avoid this file transfer step by making sure
that the media files specified in the reference movie are available to each node of the
Apple Qmaster cluster. For more information, see How the Apple Qmaster System
Distributes Batches.
Importing MPEG-2 Files
When you import an MPEG-2 file, Compressor must parse the file before you can play it
in the Preview window. Parsing the file involves determining its frame structure and other
necessary information about the file. Since the frame structure can change throughout
the file, Compressor must scan through the entire file, which can take several minutes
for longer files.
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the “Add DVD Studio Pro metadata” checkbox selected. See Extras Tab for more
information.
About Dolby Digital Professional Source Media Files
You can use Dolby Digital Professional AC-3 audio files as source media files for your jobs.
There are two common reasons to want to do this.
• To test a file you just encoded: Since you cannot preview the Dolby Digital Professional
output settings, importing an encoded file into a job allows you to play it and verify
the settings.
• To convert a Dolby Digital audio file to another format: Since not all media players include
Dolby Digital decoders, you may find that you need to transcode the file into another
format.
Compressor includes a Dolby Digital decoder that it uses whenever you play or transcode
Dolby Digital audio files. This makes it possible to verify the Dolby Digital Professional
output settings of a previously encoded file on your system without requiring you to
have an external Dolby Digital decoder. To hear surround sound you must have an external
surround sound device connected to your computer’s USB or FireWire output. The audio
is mixed down to two channels if you play the audio using your system’s stereo speakers.
Important: Since the audio output is already decoded and not in the Dolby Digital format,
the optical output cannot be used when playing Dolby Digital files from Compressor.
Tip: Add an .ac3 extension to the filename if Compressor does not allow you to add it to
a job.
Automatic Values and Nonstandard QuickTime Files
Compressor uses a variety of tactics to determine the proper values for any settings that
are set to Automatic. In most cases, QuickTime files contain metadata that specify the
various attributes of the file, such as frame rate and frame size. In some cases, this metadata
is not present, forcing Compressor to try to determine this information, or it is incorrect,
causing Compressor to generate incorrect values for the Automatic settings.
Additionally, some QuickTime files use nonstandard settings that require Compressor to
choose an automatic value that may not be suitable.
For these reasons, it is a good idea to verify the values in the Inspectors for those settings
that are set to automatic. See About the Automatic Settings for more information.
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geometry settings, that you apply to the source media file as a part of the transcoding
process.
You need to assign at least one setting to a source media file before you can transcode
it. Once you have a source media file in the current batch in the Batch window, you can
either select a preexisting setting or create a customized one using the Settings tab.
Once you have all the settings that you think you need, you won’t have to open the
Settings tab again because you can select the settings directly from the Batch window.
Note: A setting is just one kind of Compressor preset. You can also create, modify, save,
or remove Destination presets. For more information on destinations, see Creating and
Changing Destinations.
This chapter covers the following:
• About the Settings Tab (p. 96)
• Using the Inspector with Settings (p. 99)
• Duplicating Settings (p. 100)
• Creating a Setting from Scratch (p. 102)
• Searching for a Setting (p. 103)
• Previewing a Setting (p. 103)
• Deleting Settings (p. 105)
• Creating Groups of Settings (p. 106)
• Distributing and Sharing Settings (p. 107)
• Example: Creating Custom Groups and Settings for DVD (p. 108)
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Modifying Settings 7About the Settings Tab
The Settings tab allows you to manage your settings. In conjunction with the Inspector
window, the Settings tab also provides details of all the settings and provides easy access
to common transcoding controls.
You use the Settings tab (together with the Inspector window) to create, modify, or delete
settings, as well as create group folders for multiple settings. You can also create Droplets
from the Settings tab.
The Settings tab contains a list of the existing settings and the necessary buttons to add,
remove, or duplicate a setting and create groups and Droplets.
Duplicate Selected 
Setting button
Settings list
“Create a New
Setting Group” button
An example setting
Click the disclosure 
triangles to show
or hide a setting
group’s contents.
“Save Selection
as Droplet” button
Delete Selected
Settings button
“Create a New
Setting” button
Settings Tab Buttons
The following buttons are located along the top of the Settings tab.
• Create a New Setting Group: Click to create a folder where you can group existing
settings. Use this button as a way to organize your settings into some sort of logical
order, keeping the Settings tab easy to navigate. Once settings have been created, you
can assign a whole group of settings to a source media file (by dragging it onto the
source file in the Batch window) or you can create a Droplet containing multiple settings.
See Creating Groups of Settings for more information.
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settings. Droplets allow you to transcode a media file by simply dragging one or more
source media files over the Droplet icon. Once you have selected your setting or group
and clicked the “Save Selection as Droplet” button, the Save dialog asks you to name
your Droplet, choose a location for it, and choose a destination folder for the relevant
output media files. Once you complete this dialog, your Droplet is ready and you can
drag as many files as you want to its icon. See Using Droplets for more information
about Droplets.
• Duplicate Selected Setting: Click to duplicate a selected setting in the Settings tab. The
Duplicate button copies the exact settings of the setting currently selected in the
Settings tab. Using the Duplicate button allows you to create a new setting from a
preexisting one; you can then adjust that setting according to your needs, rather than
creating a new setting from scratch.
• Search field: Enter text to search the settings for specific attributes. For example, you
can type “iPod” to see a list of settings specifically designed for an iPod.
• Create a New Setting (+): Click to add a new setting to the Settings tab. A dialog appears
for you to choose an output file format (H.264 for Apple Devices, MPEG-2, MPEG-4, and
so on) when you click this button.
• Delete Selected Settings (-): Click to remove a setting from the Settings tab. You are not
asked for a confirmation, so be sure you want to remove the setting before clicking
this button.
Note: You cannot delete the Apple settings.
Settings List
When you first open the Settings tab it contains a set of preexisting (Apple) settings
supplied with Compressor. The Settings tab displays name and description details of all
existing settings and groups stored on your computer.
The Apple setting group 
with subgroups
New “Untitled” setting
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Format]” with “[File Format]” being the file format you chose from the (+) pop-up menu.
It’s a good idea to change the setting name to something meaningful, such as details of
the settings or distribution method associated with the setting. Click the setting in the
Settings tab to open it in the Inspector window.
Click a setting to see it in 
the Inspector window.
Enter the selected 
setting’s name and 
description in the 
Inspector window.
Use the Name field in the Inspector window to enter a name. Use the Description field
to enter more information about each setting. This information only appears within the
Settings tab and can help you keep track of your files when you have many settings.
You can also organize your settings by putting them in group folders. Once you have
created and named a group folder, you can drag any existing custom setting into it. When
you drag a setting to a group, you remove it from its current location. You can also drag
individual settings from a group to a source media file. See Creating Groups of Settings
for more information.
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Whenever you select a batch’s target, its setting immediately appears in the Inspector
window with Selected Target in the Name field. This is a temporary copy of the setting
and not the setting itself, so you can make temporary modifications to the setting for
just that one batch submission.
Select a target in the
Batch window to see 
its settings in the
Inspector window.
The setting’s name
shows as “Selected
Target.”
Click the Save As button
to save this as a new
setting with any 
changes you make. When you modify the target’s setting, the Save As button at the bottom of the Inspector
window becomes active. Click Save As to save the modified setting with a new name.
The saved copy appears in the Settings tab as Setting Name-Copy, and immediately
becomes the selected setting in the Settings tab.
Using the Inspector with Settings
The Inspector window contains the panes that let you create and modify all the settings
related to your output media file, such as filters, geometry, and output format. The
Inspector window is also where you name your settings, as well as add descriptions to
make it easier to remember later what you customized.
• Summary pane: Provides a detailed summary of a selected setting. See Summary Pane
for more information about this pane.
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audio settings. See the following specific sections for more information about the
different encoder panes.
• About the AIFF Encoder Pane
• Creating Common Audio Format Files
• About the DV Stream Encoder Pane
• About the Dolby Digital Professional Encoder Pane
• About the H.264 for Apple Devices Encoder Pane
• Creating H.264 for Blu-ray Disc
• About the Image Sequence Encoder Pane
• Creating MP3 Output Files
• About the MPEG-1 Encoder Pane
• About the MPEG-2 Encoder Pane
• About the MPEG-4 Part 2 Encoder Pane
• About the QuickTime Export Components Encoder Pane
• About the QuickTime Movie Encoder Pane
• Frame Controls pane: Allows you to customize changes to the frame size, frame rate,
or field dominance. (See Working with Frame Controls for more information.)
• Filters pane: Allows you to add filters to your setting to enhance the quality of the
output files. (See About the Filters Pane for more information.)
• Geometry pane: Allows you to crop and set the frame size for your output media file.
(See Adding Geometry Settings for more information.)
• Actions pane: Allows you to send email notifications and assign a default destination
to the setting. (See Adding Actions for more information.)
Duplicating Settings
If there is a setting that contains some attributes that you want to use in another setting,
you can duplicate the existing setting and make the necessary modifications to the
duplicated one, rather than creating a new setting from scratch. Duplicating a stock Apple
setting and then adjusting the duplicate to suit your needs is the most convenient way
to create custom settings.
To duplicate a setting
1 Select the setting that you want to duplicate in the Settings tab.
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Select the setting
to be duplicated.
Click the Duplicate 
Selected Setting
button to duplicate
the selected setting.
A new setting appears in the Custom folder with the word Untitled appended before the
original name.
3 Select the new setting in the Custom folder.
4 Open the following Inspector panes to modify the following items:
• The setting name and description: Change the name and description to make it easy to
remember why you created this custom setting.
• Encoder pane: Change the output format and video and audio codecs and their
associated attributes here.
• Frame Controls pane: Change any attribute in the Frame Controls pane.
• Filters pane: Change any filter attributes here. Click the checkbox next to a filter to add
it to the setting, or deselect it to remove it from the setting.
• Geometry pane: Change any attribute in the Geometry pane.
• Actions pane: Change any attribute in the Actions pane.
5 If you have modified the setting in any way, you can do either of the following to save
the changes:
• Click the Save button at the bottom of the Inspector window to save the changes.
• Attempt to select any other setting.
A dialog asks if you want to save the changed attributes.
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Inspector.
See Assigning Settings to Source Media Files for information about assigning settings.
Creating a Setting from Scratch
If the preexisting settings are not sufficient for your transcoding needs or if you simply
want additional settings, you can create your own.
Note: The recommended procedure for creating custom settings is to duplicate a stock
Apple setting and then adjust the copy to suit your needs. For information on duplicating
settings, see Duplicating Settings.
To create a setting
1 Click the Add (+) button in the Settings tab and choose an output format from the pop-up
menu.
Choose an output format 
for the new setting
A new setting called Untitled appears in the Custom folder of the Settings tab, appended
with the selected output file format (for example, Untitled MPEG-2).
The new Untitled setting
The Inspector window also changes to show this setting’s parameters.
Note: You can always change the output file format for that setting in the Encoder pane
of the Inspector, but be sure to change the setting name to reflect its output file format.
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• The setting name and description: Change the name and description to make it easy to
remember why you created this custom setting.
• Encoder pane: Change the output format and video and audio codecs and their
associated attributes here.
• Frame Controls pane: Change any attribute in the Frame Controls pane.
• Filters pane: Change any filter attributes here. Click the checkbox next to a filter to add
it to the setting, or deselect it to remove it from the setting.
• Geometry pane: Change any attribute in the Geometry pane.
• Actions pane: Change any attribute in the Actions pane.
3 Click Save to Save the setting.
See Assigning Settings to Source Media Files for information about assigning settings.
Note: You can create groups of settings that can then be applied to a media file in one
step. See Creating Groups of Settings for more information.
Searching for a Setting
The Settings tab includes a search field that you can use to quickly locate the setting you
need. For example, you can type “iPhone” to see a list of settings that mention iPhone.
To search for a setting
µ Click the search field and enter the text to search for.
Both the name and descriptions of the settings are searched to determine if any contain
the text you entered. Click the “X” at the right of the search field to clear the text entry
and return to a normal settings display.
Previewing a Setting
The Compressor Preview window lets you see the effects of your setting—such as filters
and frame resizing—and make adjustments to these attributes while previewing the
media file in real time.
Note: You cannot preview a setting on its own—it must be assigned to a job with a
source media file first. In addition, Encoder and Frame Controls pane settings cannot be
previewed. If you want to see the effects of settings you make in these two panes, you
can use the Preview window to select a small portion of the source media file to transcode
and then view the output file to see the results. See Test Transcode Tip for more
information.
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1 Apply the setting to a job in a batch.
See Assigning Settings to Source Media Files for more information.
2 Select the target with the setting that you want to preview in the Batch window.
Note: You may have to click the Batch window’s Preview button (or press Command-2)
for the Preview window to appear.
The opening frame of the selected source media file appears in the Preview window, and
the title of the selected setting appears in the Batch Item pop-up menu. The left half of
the screen displays the source media file in its original form (Source view) and the right
half displays what the output image will look like with selected filters and other setting
attributes applied to it (Output view).
Output view
Batch Item
selection buttons
Source view
Batch Item pop-up menu
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Preview window.
This half of the 
Preview window 
shows the effects
of the Inspector 
window changes.
Make adjustments while 
previewing the media 
file in the Preview 
window.
Select the item you 
want to change.
Note: To preview the effect of the filters on your media file, you need to make sure that
the checkbox for that particular filter is selected in the Filters list. Otherwise, the Preview
window won’t recognize that filter, and it will not be part of the transcoding settings for
that job. See Using the Preview Window for more information about previewing your
settings and About the Filters Pane for more information on filters.
Deleting Settings
Use the Delete Selected Settings button to delete custom settings.
Note: You cannot delete Apple settings.
To delete a setting
1 Select the setting that you want to delete.
2 Click the Delete Selected Settings (–) button, or press the Delete key on your keyboard.
Warning: There is no warning when you delete a setting, and you cannot undo the
deletion to restore the setting.
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Creating a group of settings allows you to quickly assign multiple settings to a source
media file.
To create a group of settings
1 Click the Group button in the Settings tab.
A folder called Untitled appears in the Settings tab with 0 Settings in the Description
column. You cannot modify this field. It displays the number of settings the group contains.
A new untitled group 
with 0 settings is created.
Enter a name for
the new group.
Click the Group button.
2 Enter a suitable group name in the Inspector Name field.
3 In the Settings tab, drag the relevant settings into the group folder.
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folder into another group folder.
This custom group 
contains three other 
custom groups, each 
with its own settings.
The Description field displays the number of settings your group contains. Once you have
at least one setting inside the group folder, you can click the disclosure triangle next to
the group folder to show or hide the setting group details. You can also see full details
of the settings in any group by selecting the group and then looking at the Summary
pane in the Inspector window.
Note: You can also drag settings from one group to another group.
To add the same setting to more than one group
1 Select the setting.
2 Click the Duplicate button to create a copy.
3 Drag the duplicated setting to another group folder.
You can choose to rename the setting, for example, removing the word “copy” from it.
Distributing and Sharing Settings
Newly created settings are stored in the home folder at
/Users/username/Library/Application Support/Compressor/Settings as XML files, with the
file extension .setting. You can distribute and share any of your custom settings by placing
them into the same location within the home folder of whatever computer you distributed
the settings to. You can also transfer these files the same way that you would distribute
any other file, by emailing them as an attachment or placing them on a server.
Note: Settings created using Compressor 4 or later are not compatible with earlier versions
of Compressor.
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tab to your desktop or a Finder window. From there, you can attach it to an email or copy
it to another folder or volume.
To copy a setting directly from Compressor
µ Drag one or more settings from the Settings tab to the Finder (to the desktop, for example).
Conversely, you can add a setting to Compressor by simply dragging its file from the
Finder.
To apply or add a setting to Compressor from the Finder
Do one of the following:
µ Drag one or more settings from the Finder to the Custom group in the Settings tab.
The settings appear in the Custom group in the Settings tab.
µ Drag one or more settings from the Finder to an empty space in the Batch window.
A new job appears with one or more target rows populated with the settings.
µ Drag one or more settings from the Finder to an empty space on a job tile in the Batch
window.
One or more new target rows appear on the job, populated with the settings.
You can also add settings to Compressor using Droplets. For more information, see Using
Droplets to Create Jobs and Settings in Compressor.
Example: Creating Custom Groups and Settings for DVD
For this example, you are working on an HD project that will eventually end up on both
an HD and an SD DVD. Before that happens, though, you also need to supply SD DVDs
of the dailies.
An easy way to handle this is to create two groups of settings.
• Settings for the dailies: These settings would include an AIFF audio encoder (since you
want it done fast and disc space will not likely be an issue) and an MPEG-2 encoder
with an SD frame size using the fastest settings (since quality is not the highest concern).
This could also be an HD encoder if you have an easy way to play an HD DVD.
• Settings for the final disc: These settings would include an AC-3 audio encode, an H.264
HD for DVD video encode, and an MPEG-2 encode using the Frame Controls to ensure
a high-quality SD output video.
You would most likely create a third settings group that would be named after this project
and would contain the above two groups.
To create the groups for dailies and final outputs
1 In the Settings tab, click the Group button three times to create three new untitled groups.
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project.
3 Select the second of the new groups and name it Dailies.
4 Select the third of the new groups and name it Final Discs.
5 In the Settings tab, drag the Dailies and Final Discs groups up until a black box surrounds
the group named after the project, and then release them.
Note: You can select multiple groups or settings by holding down Shift while selecting
them.
6 Locate settings in the Apple settings that come closest to matching what you need each
setting to do in these new groups.
7 Make a copy of each setting by clicking the Duplicate Selected Setting button.
8 Select each copied setting, rename it, and then drag it to the proper folder.
This custom group 
contains the settings 
used to create the dailies.
This custom group 
contains the settings 
used to create the
final disc.
This custom group 
contains the other 
custom groups, each 
with its own settings.
You can then select each setting and make any necessary changes to it.
When you have imported the source media files and created their jobs, you can just assign
the appropriate group (Dailies or Final Disc) and all the proper settings are applied to the
targets.
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a destination, assigned to it. You created the jobs by importing the source media files.
For a job to be complete, and thus ready to be submitted for transcoding, you need to
add one or more targets to it. Each target contains a setting, which defines everything
about what the file is to be transcoded into, and a destination, which defines where the
transcoded file is saved and how its name is generated. Each target also allows you to
manually enter the name for the output file.
Compressor gives you a number of different options for assigning settings and destinations
to your targets and submitting and resubmitting batches.
Note: See About the Settings Tab and About the Destinations Tab for more information
about creating presets in these windows.
This chapter covers the following:
• Assigning Settings (p. 111)
• Assigning Destinations (p. 116)
• General Job and Target Information (p. 118)
• General Batch Information (p. 120)
• Using Final Cut Pro and Motion with Compressor (p. 127)
• Using Distributed Processing with Compressor (p. 129)
Assigning Settings
This section describes how you can assign settings to source media files and replace or
modify assigned settings.
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Batches 8Assigning Settings to Source Media Files
You can use a variety of methods to assign settings to a job. Some methods, such as
dragging the setting from the Settings tab, are better suited to working with one job.
Other methods, such as using the shortcut menu, are better for assigning the same
settings to a group of jobs. You can even assign settings by dragging (settings or Droplets)
from the Finder.
Note: The following steps assume you have already added source media files to a batch,
creating the jobs to which you are adding the settings. See Importing Source Media Files
for details on importing source media files.
Tip: You can Option-click a setting group’s disclosure triangle to expand that group (and
all subgroups) and show all the settings it contains.
To assign a setting to a job by dragging
1 Select one or more settings or groups of settings in the Settings tab.
2 Drag the settings to the job in the Batch window.
Select one or more 
(two in this case) settings 
to apply to the job.
A job with a source 
media file in the
Batch window
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New targets are added 
for each setting you 
drag to the job.
Note: You can only apply the settings to a single job when you assign them by dragging.
To assign a setting to a job using the Target menu
1 Select one or more jobs in the Batch window’s current batch.
2 Choose Target > Add Target With Setting.
The settings selection dialog appears over the Batch window.
Click Add to assign 
the settings to the 
selected jobs.
Select the settings 
to apply to the 
selected jobs.
Select the jobs in 
the Batch window.
3 Choose one or more settings or groups of settings to assign to the jobs, and click Add.
The settings are assigned to each selected job.
To assign a setting to a job using the shortcut menu
1 Select one or more jobs in the Batch window’s current batch.
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shortcut menu.
The shortcut menu lists the settings based on their groups. You cannot directly choose
a group to be assigned, but each group contains an “All” item that selects all the group’s
settings.
Note: You cannot select multiple individual settings with this method.
3 Choose a setting or All to choose all settings in a group.
The settings are applied to all selected jobs.
To assign a setting from the Finder
Do one of the following:
µ Drag one or more settings from the Finder to an empty space in the Batch window.
A new job appears with one or more target rows populated with the settings.
µ Drag one or more settings from the Finder to an empty space on a job tile in the Batch
window.
One or more new target rows appear on the job, populated with the settings.
For more information, see Distributing and Sharing Settings
You can also add settings to Compressor using Droplets. For more information, see Using
Droplets to Create Jobs and Settings in Compressor.
Replacing an Assigned Setting with a Different Setting
After you have assigned a setting to a job, you might find a more suitable setting and
decide to change the target’s setting to the new one. You can use several methods to
change a target’s setting. All of these methods leave the destination and output filename
settings as they are.
To replace a setting already assigned to a target with a different setting
Do one of the following:
µ Choose Target > Change Setting. This opens the setting selection dialog where you can
choose a new setting and click Add to assign it to the selected target.
µ Control-click the target and choose Change Setting from the shortcut menu. This opens
the setting selection dialog where you can choose a new setting and click Add to assign
it to the selected target.
µ Select the new setting in the Settings tab and drag it to the target.
Note: With all the above methods, if you select multiple settings, only the top one is
assigned to the target.
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You can edit or change any component of a setting that has already been assigned to a
source media file in the Batch window (identified as Selected Target in the Inspector
window).
To modify a setting already assigned to a source media file in the Batch window
1 Select the target in the batch with the setting that you want to change.
The setting appears in the Inspector window with Selected Target in the Name field. This
is a temporary copy of the setting and not the setting itself, so you can make temporary
modifications to the setting for just that one batch submission.
Select a target in the
Batch window to see 
its settings in the
Inspector window.
The setting’s name
shows as “Selected
Target.”
Click the Save As button
to save this as a new
setting with any 
changes you make.
2 Make the changes to the setting.
When you modify the setting, the Save As button at the bottom of the Inspector window
becomes active.
3 Click Save As to save the modified setting with a new name.
The saved copy appears in the Settings tab as Setting Name-Copy and immediately
becomes the selected setting in the Settings tab.
Note: You do not have to save the modified setting, but it is a good idea to save it in
case you need to use it again later.
Chapter 8 Finalizing Jobs and Submitting Batches 115Assigning Destinations
This section describes how you can set output destinations and output filenames.
Assigning Destinations to Source Media Files
When you assign settings to your targets, the default destination is automatically also
assigned. You can set the default destination with Compressor preferences. (Choose
Compressor > Preferences.) This can be one of those supplied with Compressor or a
custom destination you have created. See Creating a Destination for details on working
with destinations.
You can replace the default destination with any other destination, or even manually
choose a location to save the output file to. There are a number of different ways to assign
a destination to a source file. As with assigning settings, different methods have different
advantages.
To assign a destination by dragging
1 Select a destination in the Destinations tab.
2 Drag the destination to the target in the Batch window.
Drag the destination 
to a job with a target 
in the Batch window.
Select a destination 
to apply to the target.
The destination part of the target updates to the new destination.
Note: You can only apply the destination to a single job when you assign it by dragging.
Additionally, you cannot create a temporary destination using this method.
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by dragging the destination to an empty part of the job.
To assign a destination using the Target or shortcut menu
1 Select all targets that you want to set the destination on.
2 Do one of the following:
• Choose Target > Destination > [Destination].
• Control-click one of the targets and choose Destination > [Destination] from the shortcut
menu.
Use the target’s shortcut 
menu to change the 
destination for the 
selected targets.
Once you have selected a destination, it appears in each target’s destination section.
Note: You can also assign a temporary destination by choosing Other. This opens the
File Selection dialog and allows you to create a new destination for just that batch
submission. This destination is not saved and applies only to the submitted batch.
Setting the Output Filename
In addition to defining where to save the output file, destinations also define how the
output filename is created. Once you have assigned a destination, the output filename
is complete. You can choose to use it as is or you can manually modify it or enter a new
name.
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µ Click in the output filename area and edit the existing name, or triple-click the existing
name to enter a new name.
The output filename
General Job and Target Information
This section provides general information about jobs and targets.
About Targets
Targets contain three items:
• The setting
• The destination
• The output filename
The setting The destination
The output filename
Drag the dividers 
to expand a target’s 
section and make it 
easier to see the entry.
The target Add 
and Delete buttons
You can use a variety of methods to add targets to a job. The most common is to add a
setting or destination to the job. You can also use any of the following methods.
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Do one of the following:
µ Select one or more jobs and choose Target > Add Target. This adds an empty target to
the jobs.
µ Select one or more jobs and Control-click in an empty area of one of them, then choose
Target > Add Target. This adds an empty target to the jobs.
µ Click the Add (+) button of an existing target.
You can also copy one or more targets from one job to another.
To copy targets to another job by dragging
1 Select the targets to copy.
2 Press the Option key and then drag the targets to the new job.
To delete targets
Do one of the following:
µ Select one or more targets and press Delete.
µ Click the Delete (–) button in a target.
About Adding and Copying Jobs
Jobs are most often created by adding source media files to a batch. You can use several
other methods to add jobs to a batch. Additionally, you can chain jobs in a batch to set
the order in which the files are transcoded once they are submitted.
To add an empty job to a batch
µ Choose Jobs > New Job.
To delete a job from a batch
µ Select the job and press the Delete key.
To copy jobs from one batch to another
Do one of the following:
µ Open each batch in its own window and drag the jobs from one window to the other.
µ Select the jobs to be copied, press Command-C, select the batch to copy them to, and
then press Command-V.
About Chaining Jobs
Chaining jobs is useful when you need to apply multiple settings to a source media file,
but need to have each setting applied after the previous one has finished. This makes it
possible to control the order in which the settings are able to modify the source media
file.
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1 Select the targets whose outputs you want to chain to new jobs.
2 Do one of the following:
• Choose Jobs > New Job With Target Output.
• Control-click one of the targets and choose New Job With Target Output from the
shortcut menu.
New jobs are added to the batch with the chain thumbnail and the name of the output
file of the targets they are chained to.
The chained job’s source 
name is the output 
filename of the target it 
is chained to.
The chained job’s 
thumbnail is this chain 
link logo.
You can chain multiple jobs if needed. See Other Reverse Telecine Issues for an example
of chaining two jobs together.
General Batch Information
This section provides general information about submitting, saving, and opening batches.
Submitting a Batch
Once you have configured the jobs and their targets within a batch, you are ready to
submit the batch for processing.
To submit a batch
1 Make sure the batch to be submitted is selected in the Batch window.
2 Do one of the following:
• Choose File > Submit.
• Click the Batch window’s Submit button.
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3 Check the Name field to confirm the batch name.
You can change this name to something more meaningful about this batch. This is the
name that is used for this submission in both Share Monitor and the History window.
4 Use the Cluster pop-up menu to do one of the following: Use the Cluster pop-up menu
to choose which computer or cluster will process the batch.
• Choose This Computer: Compressor will not involve any other computers in completing
the batch unless you select This Computer Plus, which creates an ad hoc cluster
including This Computer and any available service nodes.
See About This Computer Plus and Unmanaged Services for more information.
• Choose a cluster: Compressor submits the batch to the cluster for processing (This
Computer Plus is not available).
You may need to authenticate yourself depending on the choice you make. See
Apple Qmaster and Distributed Processing for more details.
5 Use the Priority pop-up menu to choose priority level for the batch.
6 Click Submit or press Enter to submit the batch for processing.
The History window shows the batch progress. See About the History Window for more
information.
Note: The History window automatically opens if it is not already open.
You can also monitor the transcoding progress with Share Monitor by clicking its icon in
the Batch window. For more information on Share Monitor, see the Share Monitor
User Manual, available from the Share Monitor Help menu.
You can set Compressor preferences to automatically open Share Monitor. See Setting
Compressor Preferences for more details.
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settings assigned to each), there is about a 10-second delay after submitting the batch
when nothing happens. Be patient. Compressor is preparing the large batch before it
can be properly submitted for processing. If you are transcoding a large batch, you should
turn off the screen saver application on your computer. This will improve the speed of
your transcode because resources are not being diverted to the screen saver.
Once the batch has been submitted, a yellow triangle with an exclamation point appears
in the batch.
Click the warning 
symbol to see an 
explanation about 
why it is there.
These warning symbols are used by Compressor whenever an issue exists with a batch.
You can place the pointer over the symbol to see a tooltip defining why it is there, or you
can click the symbol to open a dialog about it.
In the above case, since the batch has been submitted, this warning is to let you know
that a file with that name now exists at that destination, and that if you submit again,
that file will be overwritten.
You can bypass the submit dialog when submitting a batch. The submitted batch
automatically uses the settings from the previously submitted batch.
To submit a batch using previous settings
Do one of the following:
µ Choose File > Submit with Previous Settings.
µ Click the “Submit with Previous Settings” item in the Batch window toolbar (if present).
See About the Batch Window for more information about using the Batch window.
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Before committing to a long transcoding session, do a quick test with a small section of
the source media file. If there is a problem (such as an incorrect setting or a reference file
that can’t find the files it is referencing), you can make the correction without losing a
lot of time. Such tests also allow you to preview Encoder pane and Frame Controls results
that are not visible in the Preview window. For a quick way to select a small section of
the source media file, see Transcoding a Portion of the Clip with the Preview Window.
Make sure the test section is specific to the type of settings you applied. For example,
pick a high motion section if you’re doing frame rate or field order conversions with Frame
Controls.
About the History Window
The History window provides quick access to all previously submitted batches, allowing
you to conveniently resubmit batches by dragging them to the Batch window and view
submission details about when particular job batches were submitted from your computer.
Click the disclosure 
triangle to see the details 
of that day’s submissions.
The History window organizes its contents by the submission date. You can change the
order in which the contents are sorted by clicking the Reverse Sort Order button along
the bottom of the History window. You can also clear the contents of the History window
by clicking the Clear button or remove selected items by selecting them and pressing
the Delete key.
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Click the disclosure 
triangle to see the 
details of each target 
of this submission.
Click the Pause button
to temporarily pause
the transcode process. 
Click it again to resume 
transcoding.
The name of
this submission
Click the Cancel
button to end the 
transcode process. Note: If it is closed, the History window automatically opens when you submit a batch.
Once the transcode finishes, the History window adds a button to make finding the
encoded files easy.
A target from the 
submitted batch
Click the “Reveal in 
Finder” button to show 
the encoded file in a 
Finder window.
Clicking this disclosure 
triangle shows the 
submission details.
Resubmitting a Batch
All batch submission information is stored in the History window. This information includes
the details about all of the batch’s jobs and targets, including which source media files
were assigned to them. You can use this information to resubmit a batch simply by
dragging a particular entry from the History window back to the Batch window.
To resubmit a batch submission from the History window
1 Use the disclosure triangles to locate the batch submission to resubmit.
Note: This is where giving the submission a recognizable name can help.
2 Drag the submission from the History window to the Batch window.
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creates a new untitled tab in the Batch window for that batch. The batch appears in the
new tab with all its original details (source media files, targets, assigned settings,
destinations, output format, and batch name). You can now make any changes to the
batch and resubmit it.
Saving and Opening a Batch File
There may be times when you configure a batch but are not able to submit it right away.
In those cases, you may find it useful to save the batch settings for later reference.
To save a batch file
1 Choose File > Save As (or press Command-Shift-S).
A dialog opens to name the file and choose its destination.
2 Enter a name for the file if you do not want to use the default name.
3 Choose the destination for the file.
4 Click Save.
Batch filenames have a .compressor extension added to them.
Note: The .compressor extension appears in the Batch window tabs if Finder preferences
are set to show all file extensions.
To open a batch file within Compressor
1 Choose File > Open (or press Command-O).
A dialog opens to select the batch file to open.
2 Locate and select the batch file to open.
3 Click Open.
You can also open a batch file by double-clicking it in the Finder, or by dragging the
batch file to the Compressor application icon.
Note: An error message appears if Compressor cannot locate any of the source files listed
in the batch file, and only those sources it finds will appear.
Transcoding Different Clips from One Source Media File
If you have a large source media file and you want to transcode only a few different
sections of it, you can do this in one batch submission.
To transcode different clips from one source media file
1 Open the Batch window.
2 Import the source media file into a batch as many times as the number of clips you want
to make.
A new job is created each time you import the source media file.
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A unique identifier is applied to the output filename, so that you can easily identify each
clip after it is transcoded.
Unique file identifiers 
are automatically 
applied to each job.
4 Do one of the following to open the Preview window:
• Choose Window > Preview (or press Command-2).
• Click the Preview button in the Batch window.
The Preview window opens.
5 Use the Batch Item selection buttons or pop-up menu to navigate to each media file you
want to transcode.
6 Drag the In and Out points to the first relevant section of the media file, and repeat for
the next media file by dragging its In and Out points to the next relevant section of the
media file.
You can also use the I (In) and O (Out) keys to move the markers to the current location
of the playhead.
The In point The Out point
7 Return to the Batch window and click Submit.
126 Chapter 8 Finalizing Jobs and Submitting BatchesSee About the Preview Window for more information.
Using Final Cut Pro and Motion with Compressor
Final Cut Pro and Motion contain a Share menu with many commonly used transcoding
options already configured. However, if you need a transcoding option not covered by
the preconfigured Share items, or you need to customize one of the options, you can use
the Send to Compressor options to open the project in Compressor where you can
configure it as needed.
Important: Compressor 4 must be installed on the same computer as Final Cut Pro X and
Motion 5 for these options to work.
Submitting a Project for Transcoding
You can send a Final Cut Pro or Motion project to Compressor either with a setting already
in place or with no setting applied. In either case, the project appears in a batch that you
can configure as you would any other batch.
To transcode a Final Cut Pro or Motion project
1 Open and select the project you want to transcode in Final Cut Pro or Motion.
2 In the Final Cut Pro or Motion Share menu, choose and configure an output option.
See Final Cut Pro Help or Motion Help for information on the available options and their
configurations.
3 Do one of the following:
• If you chose the Send to Compressor Share menu option, Compressor opens and the
project appears as a job in a new batch with no settings.
• If you chose any of the other options, click Advanced and choose Send to Compressor.
Compressor opens and the project appears as a job in a new batch configured with
the Share menu option you chose.
The Final Cut Pro project 
name is used as the new
job’s name.
4 Assign settings and destinations to the job as necessary.
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• Assigning Settings to Source Media Files
• Assigning Destinations to Source Media Files
5 Click the Submit button in the Batch window.
Compressor begins transcoding the Final Cut Pro project.
Note: Once the Final Cut Pro or Motion project opens in Compressor, you can continue
working in Final Cut Pro or Motion on that project or a different project.
Resubmitting a Project
You can use the History window to resubmit a Final Cut Pro or Motion project, the same
way as you resubmit any other batch. Compressor resubmits the project as it was when
originally submitted; any changes that have been made to the project since the original
submission are ignored.
See Resubmitting a Batch for details about the steps in this process.
Optimizing Distributed Processing for Final Cut Pro and Motion
There are two common situations that affect how distributed processing works with your
Final Cut Pro and Motion media:
• Media is on the Final Cut Pro or Motion boot disk: This is the default way the media is
handled. In this case, the only distributed processing option you have is This Computer
Plus, and Apple Qmaster has to first copy the source media to the distributed processing
service computers, slowing down the distributed processing process.
• Media is on a mountable non-boot disk: Storing your Final Cut Pro and Motion media
on a disk other than the computer’s boot disk means that all the distributed processing
service computers can directly access the source media, saving Apple Qmaster from
having to copy it to the service computers, and allowing you to choose to submit the
project to any clusters that are available. This disk can be a second internal disk in the
computer, an external disk, or a disk on a local network computer.
To optimize distributed processing for Final Cut Pro and Motion
1 Make sure all Events used in your Final Cut Pro project are stored on a mountable disk
that is configured for file sharing. For details on storing your Final Cut Pro and Motion
media on non-default disks, see Final Cut Pro Help and Motion Help.
2 On each of the Apple Qmaster cluster’s computers, mount the hard disk where the
Final Cut Pro events and other media files are located.
3 In Compressor preferences, choose “Never Copy Source to Cluster” from the Cluster
Options pop-up menu.
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Send to Compressor and choose a cluster there will no longer need to spend time copying
the source files to the cluster’s computers, providing a more efficient transcoding process.
Using Distributed Processing with Compressor
You can increase speed and productivity by distributing processing across multiple
computers. The Apple Qmaster features of Compressor subdivide the work for speed,
route the work to the computers with the most available computing power, and direct
the processing across designated computers.
For complete instructions on setting up and managing an Apple Qmaster distributed
processing network, see Apple Qmaster and Distributed Processing.
This section covers two specific topics that you should be aware of when you are using
the Apple Qmaster distributed processing system with Compressor.
Job Segmenting and Two-Pass or Multi-Pass Encoding
If you choose the two-pass or the multi-pass mode, and you have distributed processing
enabled, you may have to make a choice between speedier processing and ensuring the
highest possible quality.
The Apple Qmaster distributed processing system speeds up processing by distributing
work to multiple processing nodes (computers). One way it does this is by dividing up
the total number of frames in a job into smaller segments. Each of the processing
computers then works on a different segment. Since the nodes are working in parallel,
the job is finished sooner than it would have been on a single computer. But with two-pass
VBR and multi-pass encoding, each segment is treated individually so the bit-rate allocation
generated in the first pass for any one segment does not include information from the
segments processed on other computers.
First, evaluate the encoding difficulty (complexity) of your source media. Then, decide
whether or not to allow job segmenting (with the Allow Job Segmenting checkbox at
the top of the Encoder pane). If the distribution of simple and complex areas of the media
is similar throughout the whole source media file, then you can get the same quality
whether segmenting is turned on or not. In that case, it makes sense to allow segmenting
to speed up the processing time.
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scenes. For example, suppose you have a 2-hour sports program in which the first hour
is the pregame show with relatively static talking heads, and the second hour is high-action
sports footage. If this source media were evenly split into two segments, the bit-rate
allocation plan for the first segment would not be able to “donate” some of its bits to the
second segment because the segments would be processed on separate computers. The
quality of the more complex action footage in the second segment would suffer. In this
case, if your goal were ensuring the highest possible quality over the entire 2-hour
program, it would make sense to not allow job segmenting by deselecting the checkbox
at the top of the Encoder pane. This forces the job (and, therefore, the bit-rate allocation)
to be processed on a single computer.
Note: The Allow Job Segmenting checkbox affects only the segmenting of individual
jobs (source files). If you are submitting batches with multiple jobs, the distributed
processing system will continue to speed up processing by distributing (unsegmented)
jobs, even with job segmenting turned off.
For more information on variable bit-rate encoding (VBR), see Quality Tab. For more
information on the Apple Qmaster distributed processing system, see Apple Qmaster and
Distributed Processing.
About This Computer Plus and Unmanaged Services
Compressor includes a This Computer Plus feature that makes it easy to take advantage
of the distributed processing capabilities offered by Apple Qmaster, without requiring a
lot of knowledge about how clusters are configured, setting up file sharing, and so on.
Using This Computer Plus is a two-step process:
• Installing Compressor, configured to provide distributed processing services, on each
computer to be included in the This Computer Plus cluster.
• Selecting the This Computer Plus checkbox when you submit a Compressor batch for
processing.
Note: You may need to authenticate yourself. See Apple Qmaster and Distributed
Processing for more details.
These two steps let you harness the processing power of any number of computers on
your network without any additional effort or knowledge on your part.
For additional information, see Getting Started Quickly Using This Computer Plus.
130 Chapter 8 Finalizing Jobs and Submitting BatchesYou can use Compressor to output audio in the AIFF format.
This chapter covers the following:
• Creating AIFF Output Files (p. 131)
• About the AIFF Encoder Pane (p. 132)
• About the Sound Settings Dialog (p. 132)
• QuickTime Audio Sample Sizes and Rates (p. 133)
• Choosing an Audio Codec for Distribution (p. 134)
• Configuring AIFF Settings (p. 134)
Creating AIFF Output Files
The AIFF (Audio Interchange File Format) file format was developed by Apple for storing
high-quality audio. The format was intended for DVD or CD authoring and is now one of
the most commonly used audio file formats for the Mac OS.
Note: Choose the AIFF option from the File Format pop-up menu only if you need to
create a specialized AIFF file. If you are creating a standard AIFF file, choose the Common
Audio Formats option.
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9About the AIFF Encoder Pane
The following options appear when you choose the AIFF output format from the File
Format pop-up menu in the Encoder pane of the Inspector window.
File Extension field
QuickTime AIFF 
Summary table
Click to open the Sound 
Settings dialog.
Choose AIFF.
• File Extension: This field displays the AIFF file extension (.aiff) automatically after the
AIFF output format is chosen from the File Format pop-up menu or the (+) pop-up
menu in the Settings tab. Don’t alter this field.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. Since job
segmenting is not used for audio-only encodes, this checkbox is not active with the
AIFF file format. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Settings: This button opens the QuickTime Sound Settings dialog. Use this dialog to
select suitable audio codecs and change other audio compression settings. See About
the Sound Settings Dialog for more information.
• QuickTime AIFF Summary: This table displays full details for this setting.
About the Sound Settings Dialog
You use the Sound Settings dialog to change your audio compression settings for both
the QuickTime and AIFF output formats. To open this dialog, click the Audio Settings
button in the AIFF or QuickTime Movie Encoder pane.
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allow you to configure additional settings, which appear in the lower half of the Sound
Settings dialog. In some cases, an Options button becomes available. Click it to configure
additional settings.
Choose the number 
of channels (the 
selection varies based 
on the codec).
Choose a rate that 
provides the quality 
and file size required.
Choose an audio codec.
Format-specific settings 
based on the codec
The Sound Settings dialog contains the following items, with various choices for each,
depending on the audio codec you choose in the Format pop-up menu.
• Format: Choose the audio codec you want to add to your setting.
• Channels: Choose the type of channel output, such as mono, stereo, or some type of
multichannel output, depending on the codec.
• Rate: Choose the sample rate you want to use for your media file. The higher the sample
rate, the higher the audio quality, but the larger the file. Downloading a larger file takes
longer and requires more bandwidth.
• Show Advanced Settings: This button remains dimmed unless the codec you selected
from the Format pop-up menu offers options. Contact the manufacturers of these
codecs directly for more information about the additional options they offer.
QuickTime Audio Sample Sizes and Rates
If you have the disk space and bandwidth, it is best to leave your audio uncompressed.
Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD quality) samples.
Compressor supports up to 64 bits per sample floating point and a maximum sample
rate of 192 kHz.
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MPEG-4 Audio (AAC) is a good general-purpose audio delivery codec and is compatible
with a wide variety of playback devices. For slower computers, less-compressed formats,
such as IMA, or completely uncompressed formats, such as AIFF, may be better choices,
because they are less processor intensive, thus allowing the computer to focus on the
more challenging video stream.
Configuring AIFF Settings
When you choose the AIFF output file format as your output format, you can only create
audio settings (because it is an audio-only format). If you want to add an audio codec to
your AIFF preset, you need to open the Sound Settings dialog and choose your audio
codec settings from there.
To create an AIFF audio codec setting
1 In the Settings tab, do one of the following:
• Make sure that the correct setting is selected.
• Create a new setting by choosing AIFF from the “Create a new setting” (+) pop-up
menu.
2 Click the Settings button in the AIFF Encoder pane.
The Sound Settings dialog opens.
Choose an audio codec 
from the Format 
pop-up menu.
3 Choose an audio codec from the Format pop-up menu and either accept its defaults or
customize the other audio codec settings (Format, Channels, Rate, and Options, if
available). See About the Sound Settings Dialog for more details.
Note: You can see full details of the current contents of your preset by viewing the
QuickTime AIFF Summary table in the Encoder pane.
4 Click OK to save your settings and close this dialog.
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This chapter covers the following:
• Creating Common Audio Format Files (p. 135)
• About the Common Audio Formats Pane (p. 136)
• Configuring Common Audio Formats Settings (p. 136)
Creating Common Audio Format Files
The Common Audio Format setting makes it easy to create audio files in the following
formats:
• AIFF: The AIFF (Audio Interchange File Format) file format was developed by Apple for
storing high-quality audio. The format was intended for DVD or CD authoring and is
now one of the most commonly used audio file formats for the Mac OS.
Note: Use this to create standard AIFF format files. Choose the AIFF option from the
File Format pop-up menu if you need to create specialized AIFF format files.
• Apple CAF File: The Apple CAF (Core Audio Format), developed by Apple, provides high
performance and flexibility and is scalable to future ultra-high resolution audio recording,
editing, and playback. It has an unrestricted file size and supports a wide variety of
metadata.
• WAVE: The WAVE (WAVEform audio file format) is primarily used on Windows computers.
135
Creating Common Audio Format
Files 10About the Common Audio Formats Pane
The following options appear when you choose the Common Audio Formats output
format from the File Format pop-up menu in the Encoder pane of the Inspector window.
The Automatic button
• Extension: This field displays the file extension after you select an audio format from
the “File type” pop-up menu.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. Since job
segmenting is not used for audio-only encodes, this checkbox is not active with the
Common Audio Formats file format. For more information, see Job Segmenting and
Two-Pass or Multi-Pass Encoding.
• File type: Choose the type of audio file to create.
• Automatic: When Automatic is on, Compressor determines the number of channels,
the sample rate, and sample size based on the source file, and the “Channel layout,”
“Sample rate,” and “Sample size” pop-up menus are disabled. When the Automatic
button is off, you manually configure these settings.
• Channel layout: Choose the number of channels (Mono, Stereo, or 5.1).
• Sample rate: Choose from the available sample rates (32000, 44100, 48000, or 96000).
• Sample size: Choose from the available sample sizes (16, 24, or 32).
Configuring Common Audio Formats Settings
When you choose the Common Audio Formats output file format as your output format,
you can only create audio settings (because it is an audio-only format).
To create a Common Audio Formats setting
1 In the Settings tab, do one of the following:
• Make sure that the correct setting is selected.
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setting” (+) pop-up menu.
2 Choose an audio format from the “File type” pop-up menu in the Common Audio Formats
Encoder pane.
3 Do one of the following:
• Click to turn on the Automatic button and let Compressor configure the “Channel
layout,” “Sample rate,” and “Sample size” pop-up menu settings.
• Click to turn off the Automatic button and manually configure the “Channel layout,”
“Sample rate,” and “Sample size” pop-up menu settings.
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Due to its low cost and wide availability, the DV video format is extremely popular for
standard definition (SD) video capture and delivery.
This chapter covers the following:
• About the DV Stream Encoder Pane (p. 139)
• DV Transcoding Workflow (p. 140)
About the DV Stream Encoder Pane
This section contains detailed information about the various settings within the DV Stream
Encoder pane of the Inspector window. You make your DV settings by either modifying
an existing setting or creating a new setting in the Settings tab.
The Automatic buttons 
for the Format, Aspect 
Ratio, and Field 
Order values
The DV Stream Encoder pane contains the following settings.
• Extension: This field displays the DV file extension (.dv) automatically after the DV Stream
output format is chosen from the File Format pop-up menu or the (+) pop-up menu
in the Settings tab.
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11• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. For more
information, see Job Segmenting and Two-Pass or Multi-Pass Encoding.
• Format: Choose either NTSC or PAL as the output video format.
• Aspect Ratio: Choose either 16:9 or 4:3 as the output video aspect ratio.
Note: The 16:9 aspect ratio uses anamorphic video.
• Field Order: Choose Bottom field first (required for interlaced DV video) with interlaced
sources or Progressive with progressive sources.
DV Transcoding Workflow
How you use Compressor to transcode your video into DV Stream format files depends
on how you intend them to be used. The basic steps are listed below.
Stage 1: Creating a Batch
As with any transcode, you need to start by creating a batch. See Preparing Compressor
for Transcoding with Custom Settings for more information.
Stage 2: Creating Jobs with the Source Video Files
Import the source video files either by dragging them from the Finder to the batch or by
choosing Job > New Job With File.
Stage 3: Adding Targets with a DV Setting to Each Job
Each of the jobs requires at least one target—in this case the jobs need targets with a
DV Stream setting. If there is more than one job, it is easiest to select all the jobs by
choosing Edit > Select All and then choose Target > New Target With Setting to apply
the same setting to all the jobs.
Stage 4: Submitting the Batch for Transcoding
Click the Submit button to start the transcode process. See Submitting a Batch for more
information.
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Professional (AC-3) audio files.
Dolby Digital Professional format (also known as AC-3) is a very common compressed
audio format for DVD-Video discs. Compressor accepts multichannel sound files in a
variety of formats and gives you complete control over the AC-3 encoding process. Dolby
Digital programs can deliver 5.1-channel surround sound with five discrete full-range
channels (left, center, right, left surround, and right surround) plus a sixth channel for
low-frequency effects (LFE), sometimes known as “the subwoofer.” Another surround
option is Dolby Surround, with four channels (left, center, right, surround). But not all
AC-3 audio is 5.1 surround sound. Dolby Digital Professional is commonly used to encode
stereo files to greatly reduce their file size.
See Adding Surround Sound Source Media Files to Batches for more information about
creating surround sound audio files using other output formats.
Note: It’s important to understand that Compressor cannot take stereo audio files and
create 5.1 surround sound from them. If you want to create a 5.1 surround sound AC-3
audio file, you must first create the six channels of audio it requires. This must be done
using other applications outside Compressor.
This chapter covers the following:
• About the Dolby Digital Professional Encoder Pane (p. 142)
• General Information About Creating Dolby Digital Professional Files (p. 148)
• Converting Stereo Audio Files to Dolby Digital Professional Format (p. 149)
• Assigning Files to Surround Sound Channels (Manual Method) (p. 150)
• Assigning Files to Surround Sound Channels (Automatic Methods) (p. 153)
• Assigning Files to Surround Sound Channels with Droplets (p. 155)
• Options for Spatial Mixing (p. 155)
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Output Files 12About the Dolby Digital Professional Encoder Pane
This section contains detailed information about the various tabs within the Dolby Digital
Professional (AC-3) Encoder pane of the Inspector window.
You make your Dolby Digital Professional settings using the tabs described below, by
either modifying an existing setting or creating a new setting in the Settings tab. The
Dolby Digital Professional pane opens with the default Audio tab on top. The Dolby Digital
Professional pane contains the following items: basic settings, Audio tab settings, Bitstream
tab settings, and Preprocessing tab settings.
Basic Settings
Use the following basic settings to set up a Dolby Digital Professional (AC-3) job or batch.
• File Extension: This field displays the Dolby Digital Professional file extension (.ac3)
automatically after the Dolby Digital Professional output format is chosen from the File
Format pop-up menu or the (+) pop-up menu in the Settings tab.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. Since job
segmenting is not used for audio-only encodes, this checkbox is not active with the
Dolby Digital Professional file format. For more information, see Job Segmenting and
Two-Pass or Multi-Pass Encoding.
• Audio, Bitstream, and Preprocessing: These buttons open the Audio, Bitstream, and
Preprocessing tabs described next.
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All the most important Dolby Digital Professional settings are accessible in the Audio tab.
• Target System: Compressor limits available settings to those appropriate for the target
system. If you’re encoding for use with DVD Studio Pro, choose DVD Video. Choose
DVD Audio only if you are encoding for use in a DVD Audio authoring application.
Choose Generic AC-3 to remove the setting limits.
• Audio Coding Mode: Specifies the audio channels of the encoded stream. This setting
also has an Automatic button.
The Audio Coding Mode
Automatic button
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two rear channels (surround). “2/0 (L, R)” is essentially a standard stereo file. The audio
coding mode affects settings such as the available bandwidth and surround channel
preprocessing. If you click the Automatic button (next to the Audio Coding Mode
pop-up menu), Compressor makes its best guess at the intended audio coding mode,
based on available source audio files.
3/1 channels 3/0 channels
2/2 channels 2/1 channels 2/0 channels 1/0 channels
(LFE option not available) (LFE option not available)
3/2 channels
L C
LFE
LFE LFE
LFE LFE
LFE LFE
R
Ls Rs
L R
Ls Rs
L R L R
S
L C R
S
L C
C
R
Note: In the Audio Coding Mode pop-up menu, “S” stands for a single rear “Surround”
channel, and in this illustration, “LFE” stands for Low Frequency Effects (also known as
“subwoofer”). For more information, see Assigning Files to Surround Sound Channels
(Manual Method) and Assigning Files to Surround Sound Channels (Automatic Methods).
• Enable Low Frequency Effects: Select this checkbox to include the LFE channel in the
encoded stream (not available for 1/0 mono or 2/0 stereo).
• Sample Rate: Specifies the sample rate. All files intended for video and audio DVD
authoring must have a 48 kHz sample rate as per the DVD specification. The 32 kHz
and 44.1 kHz sample rates are available only when Generic AC-3 is the target system.
• Data Rate: The choices depend on the coding mode and target system. The higher the
rate, the better the quality. AC-3 streams have a constant data rate. At 448 kbps, which
is the default for 5.1 encoding, one minute of AC-3 audio takes about 3.3 MB of storage
space. For stereo encoding, rates of 192 kbps and 224 kbps are typical and will produce
good results.
• Bit Stream Mode: Defines the purpose of the encoded audio material. The information
is included in the finished stream and can be read by some decoding systems.
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full scale (dBFS), in your sound files relative to full modulation. The playback device
uses this information to maintain similar volume among different AC-3 streams. The
goal is to make all AC-3 encoded audio files have the same listening level, regardless
of the source file.
It is especially important to properly use the Dialog Normalization feature if you have
different audio files (with different volume levels) going on to a DVD. If you know the
average level for each file, enter that number in the Dialog Normalization field for each
file. For example, if the dialogue in your Final Cut Pro sequence averages around –12 dB
on the audio meter, enter –12 in the Dialog Normalization field.
Note: This normalization is between the audio streams on the DVD, not within an
individual audio stream itself. For that type of normalization, use an audio editing tool.
You can enter values from –1 dBFS to –31 dBFS. The difference between the value you
enter and 31 dBFS (which represents the normal dialogue listening level) is the amount
that the source audio will be attenuated.
• If you enter –31 dBFS: The attenuation is 0 dB (31 dBFS–31 dBFS), and the source
audio levels are not affected at all.
• If you enter –27 dBFS: The attenuation will be 4 dB (31 dBFS–27 dBFS).
• If you enter –12 dBFS: The attenuation is 19 dB (31 dBFS–12 dBFS).
The louder the source file, the smaller the value you enter, and the more the audio in
the encoded file is attenuated during playback.
If you do not know the sound level of the source file or for some other reason want to
ensure the Dolby Digital Professional encoder does not affect your sound levels, enter
–31 for the Dialog Normalization and choose None in the Compression Preset pop-up
menu (located in the Preprocessing tab).
Important: It is critical that you set Dialog Normalization correctly if you intend to use
any of the Compression Preset settings. The Compression Preset settings assume that
the audio, after the dialogue has been normalized, is at the normal listening level of
31 dBFS. Levels that are consistently louder than that result in distorted sound and
erratic levels.
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These settings are stored in the finished stream for use by the playback device. Leave
them at their default values unless you have a specific technical reason for changing
them.
• Center Downmix, Surround Downmix: If your encoded audio has these channels, but
the player does not, the channels are mixed into the stereo output at the specified
level.
• Dolby Surround Mode: When encoding in 2/0 (stereo) mode, specifies whether the
signal uses Dolby Surround (Pro Logic).
• Copyright Exists: Select this checkbox to specify that a copyright exists for this audio.
• Content is Original: Select this checkbox to specify that this audio is from the original
source and not a copy.
• Audio Production Information: Select this checkbox and fill in the fields below to specify
how the encoded audio content was mixed. Playback devices may use this information
to adjust output settings.
• Peak Mixing Level: Specifies peak sound pressure level (SPL) (between 80 dB and
111 dB) in the production environment when this mix was mastered.
• Room Type: Specifies information about the mixing studio.
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Preprocessing options are applied to the audio data before encoding. With the exception
of the Compression Preset setting, leave these settings at their default values unless you
have a specific technical reason for changing them.
Compression Preset
• Compression Preset: Specifies one of the dynamic range processing modes built in to
the AC-3 format. The default of Film Standard Compression should only be used when
you are encoding an original mix intended for cinema. In almost all cases, you should
choose None.
Important: It is critical that you set the Audio tab’s Dialog Normalization correctly if
you intend to use any of these Compression Preset settings. The Compression Preset
settings assume that the audio, after the dialogue has been normalized, is at the normal
listening level of 31 dBFS. Levels that are consistently louder than that result in distorted
sound and erratic levels.
Note: If you are building a Dolby Digital Professional 5.1-channel surround sound DVD,
you will use Film Standard Compression.
General
• Digital Deemphasis: Specifies whether input audio data is preemphasized and needs
to be deemphasized before encoding.
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• Low-Pass Filter: Select this checkbox to apply a 120 Hz low-pass filter to the Low
Frequency Effects (LFE) channel. Turn off this filter if the digital signal fed to the LFE’s
input does not contain information above 120 Hz.
Full Bandwidth Chan.
• Low-Pass Filter: Select this checkbox to turn on a low-pass filter with a cutoff near the
available audio bandwidth that is applied to the main input channels. If the digital
signal fed to the main input channels does not contain information above the available
audio bandwidth, you can turn off this filter. Compressor will automatically determine
the available bandwidth.
• DC Filter: Select this checkbox to turn on a DC high-pass filter for all input channels as
a simple way to remove DC offsets. Most mixed audio material is already free of DC
offsets.
Surround Channels
• 90º Phase Shift: Select this checkbox to generate multichannel AC-3 streams that can
be downmixed in an external two–channel decoder to create true Dolby
Surround-compatible output.
• 3 dB Attenuation: Select this checkbox to apply a 3 dB cut to the surround channels of
a multichannel film soundtrack being transferred to a consumer home theater format.
Cinema surround channels are mixed 3 dB “hot” (higher) relative to the front channels
to account for cinema amplifier gains.
General Information About Creating Dolby Digital Professional
Files
Following are some things to keep in mind as you configure and encode Dolby Digital
Professional AC-3 files.
About the Source Media Files
There are a few guidelines to be aware of when encoding Dolby Digital Professional
output files from your source media files.
Depending on the format, a file can contain a single channel (mono), dual channels
(stereo), or multiple channels. Compressor supports Dolby Digital Professional in all these
configurations.
Sound files intended for Dolby Digital Professional encoding must conform to the following
rules:
• All source files should be the same length. (If they are not, Compressor sets the length
of the AC-3 stream to match the length of the longest file.)
• All files must have a 48 kHz sample rate (as required for DVD).
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Compressor adds digital silence to the end of the files.
Note: Compressor can support any kind of source files that contain surround sound and
high resolution audio up to 64 bits per sample (floating point) and sample rates up to
192 kHz.
About Previewing the Encoder Settings
The settings made in the Dolby Digital Professional encoder pane cannot be previewed.
If you have an external surround sound device connected to the USB, FireWire, or other
output from the computer, you will be able to hear the audio assigned to the different
channels, but it will not include any settings, such as the Dialog Normalization or
Compression Preset settings.
Important: Since the audio output is not Dolby Digital, the optical output cannot be used
to verify the audio assigned to each channel.
The only way to verify the settings is to submit the batch and listen to the results. If you
are unsure of the settings, use the Preview window to encode a short portion of the
source as a test.
You can import an AC-3 file as a source media file into a Compressor batch. Compressor
includes a built-in Dolby Digital decoder that it uses to decode the AC-3 files. This decoder
will properly apply any settings you made in the Dolby Digital Professional Encoder pane,
allowing you to hear their effects without requiring you to have an external Dolby Digital
decoder. You can also transcode the AC-3 files to a different format.
Note: Surround sound AC-3 files are downmixed to stereo if you do not have an external
surround sound system connected to the computer.
Converting Stereo Audio Files to Dolby Digital Professional
Format
Follow these steps to encode a stereo (2/0 L,R) Dolby Digital Professional (AC-3) stream
from a stereo source media file.
To encode an AC-3 stream
1 Add source audio files to the Batch window (see Importing Source Media Filesfor details).
2 Save the batch by choosing File > Save As (or pressing Command-Shift-S), then entering
a name for the batch, selecting a location, and clicking Save.
3 Do one of the following to apply the appropriate Apple setting from the Dolby Digital
Professional category to the source audio file:
• Choose Target > New Target With Setting, choose a setting, and click Add.
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Setting from the shortcut menu, choose a setting, and click Add.
• Drag a setting from the Settings tab to the source audio file’s job in the Batch window.
4 If you want, make any adjustments to the setting in the Encoder pane of the Inspector
window (see About the Dolby Digital Professional Encoder Pane for more information).
Note: Compressor will map channels intelligently. Here are some examples:
• If you import a stereo source file and apply a mono 1/0 (C) audio coding mode to it: The
file will be downmixed.
• If you apply a surround audio coding mode to the stereo file: The left and right channels
will be mapped to the left front (L) and right front (R) channels, leaving the other
channels of the coding mode silent.
• If you assign a stereo file to the left front or left (rear) surround channel: Compressor will
pick the left channel and ignore the right channel.
5 Click Submit.
For information about encoding surround sound files, see Assigning Files to Surround
Sound Channels (Manual Method) and Assigning Files to Surround Sound Channels
(Automatic Methods). Also see About Previewing the Encoder Settings for information
on playing your AC-3 audio files with Compressor.
Assigning Files to Surround Sound Channels (Manual Method)
Follow these steps to use the manual method for assigning individual audio files to
surround sound channels.
To manually assign source audio files to channels of a surround sound stream
1 Do one of the following to import the source audio files:
• Choose Job > New Job With Surround Group (or press Command-Control-I).
• Click the Add Surround Sound button in the Batch window.
• Control-click in the batch and choose New Job With Surround Group from the shortcut
menu.
The channel assignment interface opens.
2 Do one of the following to assign a source audio file to a particular channel.
• Drag the source audio file from the Finder to the icon for a specific channel (for example,
“L”).
• Click the icon for a specific channel (for example, “L”) and use the Open dialog to locate
the source audio file intended for that channel.
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3 Repeat step 2 for each of the source audio files that you intend to include in the surround
stream.
Note: If you are creating Dolby Digital Professional (AC-3) surround sound streams, you
will not use all the channels listed in the table at once. See Audio Tab Settings for a
diagram of the Dolby audio coding modes.
4 When you have finished adding source audio files to the channel assignment interface,
click OK.
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Batch window and the icons are also shown in the Inspector window.
Click a channel’s icon to 
change the file assigned 
to that channel.
Note: You can click a channel icon in the Inspector window to change the file assigned
to it.
5 Do one of the following to apply the appropriate Apple setting from the Dolby Digital
Professional category to the source audio file:
• Choose Target > New Target With Setting, choose a setting, and click Add.
• In the Batch window, Control-click in an empty part of the job, choose New Target With
Setting from the pop-up menu, choose a setting, and click Add.
• Drag a setting from the Settings tab to the source audio file’s job in the Batch window.
6 Make any necessary adjustments in the Inspector window and click Submit.
Compressor creates an AC-3 surround audio stream. See About Previewing the Encoder
Settings for information on playing your AC-3 audio files with Compressor.
You can also combine surround audio source files with a video file to make a single
Compressor job. This is useful in audio post-production workflows in which surround
audio stems (submixes) are created separately from the final picture edit. Compressor
will treat the video and up to six audio files as a virtual single asset. For example, this
would allow you to apply the Create DVD job action to make a DVD with 5.1-channel
surround sound.
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1 Follow steps 1-5 above to manually assign source audio files to channels of a surround
sound stream.
2 Click the Add Video button and use the resulting Open window to choose the video file.
Note: This feature supports QuickTime source media files only. Image sequences are not
supported.
3 Make any necessary adjustments in the Inspector window and click Submit.
Assigning Files to Surround Sound Channels (Automatic
Methods)
Compressor offers some streamlined channel assignment techniques that can save you
time.
To assign files to surround channels with channel identifier codes
1 Append the channel identifier code of the target surround channel to the filename of
each source audio file. (See the list below for a list of the appropriate channel identifier
codes.)
• -L: Left front channel
• -R: Right front channel
• -C: Center front channel
• -Ls: Left surround channel
• -Rs: Right surround channel
• -S: Center surround channel
• -LFE: Low frequency channel (Subwoofer, LFE)
For example, to assign an AIFF file to the left surround channel, rename the file as
filename-Ls.aiff (where filename is the name of your file).
Note: Mac OS X may add a file extension like .aiff. This will not interfere with this channel
assignment method.
This procedure only works when you drag and drop files into the Batch window. If you
drag the files onto the Compressor application icon, they will appear as separate source
files, each in its own job.
Note: If you are creating Dolby Digital Professional (AC-3) surround sound streams, you
will not use all the channels listed in the table at once. See Audio Tab Settings for a
diagram of the Dolby audio coding modes.
2 Drag the renamed source audio files to the Batch window.
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of files into what appears as a single surround source media file in the Batch window:
• The files in the group must be named correctly. (See the channel identifier codes listed
above.)
• The total number of files in the group must be fewer than seven.
The Inspector window shows the audio files assigned to each channel.
Click a channel’s icon to 
change the file assigned 
to that channel.
Note: You can click a channel icon in the Inspector window to change the file assigned
to it.
3 Do one of the following to apply the appropriate Apple setting from the Dolby Digital
Professional category to the source audio file’s job:
• Choose Target > New Target With Setting, choose a setting, and click Add.
• In the Batch window, Control-click in an empty part of the job, choose New Target With
Setting from the shortcut menu, choose a setting, and click Add.
• Drag a setting from the Settings tab to the source audio file’s job in the Batch window.
4 Make any necessary adjustments in the Inspector window and click Submit.
Compressor creates an AC-3 surround audio stream. See About Previewing the Encoder
Settings for information on playing your AC-3 audio files with Compressor.
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You can further streamline the channel assignment process by encapsulating the
“automatic” method described above in a Droplet.
For more information about Droplets, see Using Droplets.
Options for Spatial Mixing
This section offers additional insights and suggestions for using the channels in a Dolby
Digital Professional program.
Using the Center Channel
In a multichannel system, there are three ways to achieve a centrally placed sound image.
• Create a “phantom center” (mix sound to the left and right equally, as with
stereo): Commonly used, but assumes the listener is seated exactly between the speakers
(which is not possible in automobiles and not always the case in homes). The timbre
of sound is not the same as from a direct speaker because of cross-cancelation effects.
• Use the center channel alone: This creates a stable center image for listeners in any
location. (To prevent the audio from sounding too focused or narrow, its reverb can
be spread to the left and right channels.)
• Use all three front channels equally or in various proportions: This method allows for
greater control of the range of spatial depth and width. The phantom center can be
reinforced by additional signals in the center channel, which can be enhanced by signals
spread into the left/right pair. The disadvantage is that sound from all three speakers
may not blend well or may not arrive at the listener at the same time, causing side
effects such as comb filtering, shifts in tone color, or smearing. To counteract these
side effects, you can first process the additional signals to change their spatial character,
timbre, or prominence relative to the main center signal.
Using Surround Channels
Subtle surround effects can greatly enhance the listener’s sense of depth compared to
conventional stereo. Popular music often benefits from creative use of surround. But
don’t overdo it. The film industry guideline—don’t use surround effects to distract the
listeners from the story—also works well for music.
Limitations of the LFE Channel
The Low Frequency Effects (LFE) channel is a separate signal with a limited frequency
range and is created by the mixing engineer and delivered alongside the main channels
in the mix. A “brick wall” filter at 120 Hz in the Dolby Digital Professional encoder limits
use of the LFE channel to the bottom two audible octaves. Dolby recommends limiting
the signal to 80 Hz when mixing your sound.
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Tchaikovsky’s “1812 Overture”), the LFE channel is not necessary. The LFE signal is also
discarded in the Dolby Digital Professional downmix process, so intense bass signals do
not stress small stereo systems. Be sure not to include vital information in the LFE channel
that would be missed in mono, stereo, or Pro Logic playback.
Because LFE is separate from other channels, its ability to blend with higher frequencies
can be affected by filters used to generate the LFE signal. To ensure a cohesive audio
signal, keep the entire signal together in the main channel or channels.
Avoid creating an LFE channel for material originally produced without one. Dolby Digital
Professional’s five main channels are all full-range, and the LFE channel does not increase
the frequency response. Dolby Digital Professional decoders offer bass management,
directing low frequencies to a subwoofer or other suitable speakers. An LFE track may
interfere with bass management.
Accommodating Stereo Playback
Even with the popularity of 5.1 systems, you should always address stereo reproduction.
There are three basic ways to do this:
• Prepare a new stereo mix from the original multitrack elements (using conventional
stereo-mixing sessions).
• Prepare a studio-adjusted downmix from the multichannel mix. This method takes
advantage of the work that has gone into mixing the 5.1 version. It retains flexibility in
the exact proportions of each channel represented in the final stereo mix.
• Let the decoder derive a stereo downmix, based on preset formulas in the decoder.
Downmix options and dynamic range control effects can be previewed and adjusted
in the production studio, and a range of adjustments is possible.
Always check the mix on an inexpensive surround system to evaluate how well it sounds
on modest playback systems.
Note: For more information about Dolby Digital Professional, see “Frequently Asked
Questions about Dolby Digital Professional,” available at the Dolby Laboratories Inc.
website at http://www.dolby.com.
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iTunes, on an iPhone, iPad, or iPod, or with Apple TV.
The efficiency of the H.264 encoder makes it well suited to create media to use with
iTunes and its related Apple devices. Compressor includes preconfigured settings that
use the H.264 for Apple Devices Encoder pane to make it easy for you to create suitable
media files.
For information on creating H.264 files for other uses (such as web video), see Creating
QuickTime Movie Output Files.
This chapter covers the following:
• About the H.264 for Apple Devices Encoder Pane (p. 158)
• Chapter and Podcast Markers for Apple Devices (p. 161)
• Aspect Ratios for Apple Devices (p. 162)
• H.264 Workflows for Apple Devices (p. 162)
• Configuring Settings for H.264 for Apple Devices Output Files (p. 163)
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This section contains detailed information about the elements of the H.264 for Apple
Devices Encoder pane in the Inspector window. You make your H.264 settings using this
pane, by either modifying an existing setting or creating a new setting in the Settings
tab.
You make your H.264 for Apple Devices settings using the controls described below,
either by duplicating an existing setting and modifying it or by creating a new setting in
the Settings tab of the Settings window. The H.264 for Apple Devices Encoder pane
contains the following items.
• Extension: This field displays the H.264 for Apple Devices file extension (.m4v)
automatically after the H.264 for Apple Devices output format is chosen from the File
Format pop-up menu or the (+) pop-up menu in the Settings tab of the Settings window.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Device: Select one of the following device options from the pop-up menu:
• iPod/iPhone (VGA): This option creates video output files with a frame width of 640
pixels.
• iPod/iPhone (Anamorphic): This option creates video output files with a frame width
of 640 (anamorphic) pixels.
• iPod/iPhone (QVGA): This option creates video output files with a frame width of 320
pixels.
• Apple TV SD: This option creates video output files with a frame width of 640 pixels
with a higher bit rate range than the iPod/iPhone 640 (VGA) option.
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of 720 (anamorphic) pixels.
• Apple TV HD: This option creates video output files with a frame width of 1280 pixels,
except when the aspect ratio is set to 4:3. In that case, the video output files have
frame dimensions of 960 x 720 (anamorphic) pixels for frame rates above 24 fps and
1280 x 720 (square) pixels for lower frame rates.
• Apple TV 3rd Generation: This option, intended for the third-generation Apple TV and
iPad models, creates video output files with a frame width of 1080 pixels.
• iPhone (Local/WiFi): This option creates video output files with a frame width of 480
pixels.
• iPhone (Cellular): This option creates video output files with a frame width of 176
pixels.
• iPad/iPhone with Retina display: This option creates video output files with a frame
width of 1280 pixels.
• Aspect Ratio: Use the Aspect Ratio pop-up menu to choose the exact pixel dimensions
of the output media file. The available options depend on which device option you
selected. See Aspect Ratios for Apple Devices for more information.
The Aspect Ratio setting also has an Automatic button. Clicking the Automatic button
causes the encoder to choose the aspect ratio that matches the source video file.
Important: The automatic mode for the Aspect Ratio setting is able to choose from a
wider variety of values to better match the source video (with the values determined
and displayed when this output format is applied to a source media file). For the best
results, it is recommended that you use the automatic mode for the Aspect Ratio setting.
The Aspect Ratio
Automatic button
Note: By default, the Frame Controls feature is set to Automatic. The Frame Controls
Retiming Control will be engaged only if the source file is interlaced.
• Frame Rate: Use this pop-up menu to choose from the options listed below.
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causes the encoder to choose the frame rate that matches the source video file.
The Frame Rate
Automatic button
• 29.97: Used for NTSC-based video
• 25: Used for PAL-based video
• 24: Used for PAL-based video
• 23.98: Used for NTSC-based video
• 15: Used for web-based video
• Bit Rate: Use this slider to choose the bit rate to use for the output video, or enter a
number in the text field. The available ranges depend on the Device setting. The setting
you should choose depends on how the output is to be used. Higher bit rates produce
better picture quality, but they also produce larger output files.
• Audio: Use this pop-up menu to choose from the four audio bit-rate options listed
below.
• None: Use this option to exclude audio from the output media file.
• 24 Kbps: Creates an audio bitstream at 24 Kbps for the iPhone (Cellular) device option.
• 128 Kbps: Creates an audio bitstream at 128 Kbps.
• 256 Kbps: Creates an audio bitstream at 256 Kbps.
• Frame Sync: Also known as the key frame interval, the Frame Sync value represents how
often a key frame is inserted in the H.264 stream. The lower the number, the more
smoothly the video can be manipulated (scrubbed) during playback (more frequent
key frames). The higher the number, the more efficient the compression (less frequent
key frames). The available range is from 2 to 10 seconds; the default is 5 seconds.
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checkbox causes the encoder to choose a frame sync rate that matches the source
video file.
• Multi-pass: Similar to two-pass MPEG-2 encoding, multi-pass offers the best possible
quality. For faster (single-pass) encoding, turn this feature off by deselecting the
checkbox.
Note: If you are also using distributed processing, you may want to turn off job
segmenting. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Include Dolby 5.1: Use this checkbox to add a Dolby Digital Professional 5.1 surround
sound audio track, in addition to the standard AAC audio track, to the output movie.
This feature is intended to be used when creating output files from source files that
include surround sound audio. The Dolby Digital Professional audio track is played by
Apple TV only when connected to a system with a suitable Dolby Digital decoder. The
AAC audio track plays in all other cases.
Note: Selecting the Include Dolby 5.1 checkbox creates a true Dolby Digital Professional
5.1 surround sound audio track only if your source audio includes 5.1 surround sound
audio. If your source audio includes only stereo audio, the Dolby Digital Professional
5.1 surround sound audio track has only two channels of actual audio.
Chapter and Podcast Markers for Apple Devices
Chapter markers created in Final Cut Pro are passed through (transferred) to other output
files that can be recognized by QuickTime Player, iTunes (.m4v files), and Final Cut Pro.
You can also add podcast markers to the output file. Podcast markers are similar to chapter
markers (they can have a URL and artwork assigned to them); however, they cannot be
navigated to directly by the viewer. They are intended to provide a slideshow function
to audio podcasts. For information about adding chapter and podcast markers, see
Working with Markers and Poster Frames.
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The choice you make with the Device pop-up menu defines the width of the encoded
file. The choice you make in the Aspect Ratio pop-up menu defines the height of the
encoded file. Compressor scales the source video vertically to make it fit the height. This
means that the source video must be anamorphic (things look tall and skinny) in
anticipation of being scaled to fit the intended aspect ratio. Non-anamorphic video set
to an aspect ratio other than its native aspect ratio will appear distorted in the encoded
file.
Important: If your source video is letterboxed, use the aspect ratio that matches the
whole video frame, including the black bars, or else you will end up with distorted output
files. You can use the automatic crop feature to crop off the letterbox bars. See Adding
Geometry Settings for more information.
The following choices are available in the Aspect Ratio pop-up menu for each Device
option:
• 4:3
• 16:9
• 1.85:1
• 2.35:1
Each choice will result in a different height for the output media file. For example, with
the iPod/iPhone (VGA) setting, the 4:3 option results in a 640 x 480 file, whereas the 16:9
option results in a 640 x 360 file.
If the source media file is either DV NTSC or HDV, but you are unsure of your source media
file’s aspect ratio, click the Automatic button. This option analyzes the source media file’s
aspect ratio to determine the appropriate pixel dimensions.
H.264 Workflows for Apple Devices
The efficiency and quality of H.264 creates a number of options for iPhone, iPad, iPod,
and Apple TV video producers. When choosing a Device option, you can choose to create
a file that plays on a wide variety of devices or to create a file targeted to a specific device,
such as an iPhone 4.
• Options that are compatible with all devices do not produce optimal results when
played on higher resolution devices, such as an Apple TV. However, these options
produce smaller files, which can be an advantage.
• Options that are targeted at higher resolution devices produce great results on those
devices; however, they result in larger files.
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play the video, the video content, and how you intend to deliver the file.
Additionally, you can assign a clip’s poster frame using the Preview window. See Setting
the Poster Frame for more information. You can change the poster frame in iTunes if
necessary. See iTunes help for more information.
Configuring Settings for H.264 for Apple Devices Output Files
To ensure that your output media files are iPhone, iPad, iPod, and Apple TV compatible,
it is recommended that you use the standard settings provided in the Apple Devices
group in the Settings tab. For more information on applying settings, see Assigning
Settings to Source Media Files.
You can also create iPhone, iPad, iPod, and Apple TV compatible media files with batch
templates. For more information, see Quick and Easy Compressor Workflow: Batch
Template Method.
Note: Files created using iPhone and iPod settings can also play on Apple TV.
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Blu-ray and AVCHD discs.
Blu-ray, also known as Blu-ray Disc (BD), is a format that was developed to enable recording,
rewriting, and playback of high definition (HD) video. The format offers more than five
times the storage capacity of traditional DVDs and can hold up to 25 GB on a single-layer
disc and 50 GB on a dual-layer disc.
An AVCHD disc can be thought of as a simpler HD disc that is burned to red laser media.
The resulting disc plays in Blu-ray Disc players that are compatible with the AVCHD format.
This chapter covers the following:
• About the H.264 for Blu-ray Disc Encoder Pane (p. 166)
• H.264 Workflows for Optical Disc (p. 168)
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This section contains detailed information about the elements of the H.264 for Blu-ray
Disc Encoder pane in the Inspector window. You make your H.264 for Blu-ray Disc settings
using this pane, by either modifying an existing setting or creating a new setting in the
Settings tab.
The H.264 for Blu-ray Disc pane contains the following items.
• File Extension field: Displays the H.264 for Blu-ray file extension (.264) automatically
after the H.264 for Blu-ray output format is chosen from the File Format pop-up menu
or the (+) pop-up menu in the Settings tab.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Stream Usage: Use the Stream Usage pop-up menu to choose how you intend to use
the H.264 stream. Compressor modifies the bit-rate range settings based on the usage
you choose with this pop-up menu.
• Blu-ray: Choose this if you intend to use the stream to create a standard Blu-ray disc.
• AVCHD: Choose this if you intend to use the stream and the Create Blu-ray Disc job
action to burn an AVCHD disc using a standard DVD burner. This disc can be played
in Blu-ray Disc players that are compatible with the AVCHD format. AVCHD discs can
have up to a maximum of 50 chapter markers.
• Video Format: Use the Video Format pop-up menu to choose from the four options
listed below. All of them are HD progressive formats.
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causes the encoder to choose the video format that matches the source video file.
The Video Format 
Automatic button
• NTSC: This format is referred to as 480p. It uses a 720 x 480 frame size with an
anamorphic 16 x 9 format at 59.94 fps.
• PAL: This format is referred to as 576p. It uses a 720 x 576 frame size with an
anamorphic 16 x 9 format at 50 fps.
• 720p: This format uses a 1280 x 720 frame size with a 16 x 9 format at either 59.94 fps
for NTSC or 50 fps for PAL.
• 1920x1080: This format is referred to as 1080p. It uses a 1920 x 1080 frame size with
a 16 x 9 format at either 59.94 fps for NTSC or 50 fps for PAL.
• Frame Rate: Use this pop-up menu to choose a frame rate for the output media file.
The Frame Rate setting also has an Automatic button. Clicking the Automatic button
causes the encoder to choose the frame rate that matches the source video file.
The Frame Rate
Automatic button
Note: If you choose a format in the Video Format menu, the Frame Rate menu will be
filled in automatically.
Use the Frame Rate pop-up menu to choose from the following options:
• 23.98: Used for NTSC-based video
• 25: Used for PAL-based video
• 29.97: Used for NTSC-based video
• 50: Used for PAL-based video
• 59.94: Used for NTSC-based video
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with the slider, or enter a value directly. While the available range for a Blu-ray disc is
between 5 Mbps and 30 Mbps, typical video bit rates with H.264 might range from
7 Mbps to 15 Mbps, depending on your DVD bit budget and the nature of your source
media files. The available range for AVCHD discs is 5 Mbps to 15 Mbps.
• Maximum Bit Rate slider and field: Choose a maximum bit rate between 6 Mbps and
35 Mbps for a Blu-ray disc, or between 6 Mbps and 17 Mbps for an AVCHD disc. You
can also enter any number within these ranges into the accompanying field. The
Maximum Bit Rate setting cannot be lower than the Average Bit Rate setting. As a
general rule, set your maximum bit rate at least 1 Mbps higher than your average bit
rate, to allow for bit-rate variability in achieving the goal of constant quality.
• Multi-pass: Use this checkbox to turn on multi-pass encoding. Similar to two-pass
MPEG-2 encoding, multi-pass offers the best possible quality. For faster (single-pass)
encodes, turn this feature off by deselecting the checkbox. See Job Segmenting and
Two-Pass or Multi-Pass Encoding for more information.
H.264 Workflows for Optical Disc
The efficiency and quality of H.264 creates a number of options for optical disc producers:
• Video resolutions supported by SD DVDs are also supported by Blu-ray Disc. This means
that a Blu-ray disc can use an HD video resolution file for its main content, such as a
feature film, and then use SD video resolution files for additional features like trailers
and a “making of” documentary.
• The Create Blu-ray Disc job action includes the ability to burn an AVCHD disc using red
laser media. An AVCHD disc provides a way to play H.264 video in Blu-ray Disc players
that are compatible with the AVCHD format. See Create Blu-ray Disc for more
information.
• Because H.264 can deliver high definition (HD) video at standard definition (SD) bit
rates, you can get more HD content on a regular DVD-5 disc than you might expect
for an AVCHD disc.
168 Chapter 14 Creating H.264 for Blu-ray DiscYou can use Compressor to output an image sequence for use by compositing applications.
This chapter discusses the image sequences that Compressor can output from your source
media files.
This chapter covers the following:
• Creating Image Sequence Output Files (p. 169)
• About the Image Sequence Encoder Pane (p. 170)
• Configuring Image Sequence Settings (p. 171)
Creating Image Sequence Output Files
The Image Sequence output format creates a set of still-image files representing the
source video frames. Use this encoder to convert a video clip to an image sequence for
use with compositing applications that aren’t compatible with QuickTime.
Note: You can also use Compressor to import an image sequence. For more information,
see Adding Image Sequences to Batches.
The Image Sequence output format supports the following still image formats.
• TIFF (Tagged Image File Format): TIFF is one of the most common and flexible still-image
formats and was developed to create a standard file format for storing and exchanging
digital graphics used in desktop publishing. It is compatible with a wide range of
compositing and image processing applications.
• TARGA (Truevision Advanced Raster Graphics Adapter): TARGA, also commonly referred
to as TGA, is a raster graphics format commonly used by animation and video
applications.
• DPX: DPX is a common file format for digital intermediate and visual effects work and
is an ANSI/SMPTE standard (268M-2003).
• IFF (Interchange File Format): IFF is a generic file format originally introduced by the
Electronic Arts company in 1985 (in cooperation with Commodore-Amiga) in order to
ease transfer of data between software products produced by different companies.
• JPEG (Joint Photographic Experts Group): JPEG is a common still-image format.
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Industrial Light & Magic for use in computer imaging applications.
About the Image Sequence Encoder Pane
This section contains detailed information about the elements of the Image Sequence
Encoder pane in the Inspector window. You make your image sequence settings using
this pane, by either modifying an existing setting or creating a new setting in the Settings
tab.
Choose Image Sequence.
Choose an image type.
Choose a frame rate
from the Frame Rate 
pop-up menu or click 
the Automatic button.
The Image Sequence Encoder pane contains the following items to help you create your
image sequence output files:
• File Extension: This field displays the TIFF file extension (.tiff) automatically after the
Image Sequence output format is chosen from the File Format pop-up menu or the
(+) pop-up menu in the Settings tab. Don’t alter this field. You can change the output
format with the Image Type pop-up menu. This field will update automatically with
your choice of output format.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Image Type: Use this pop-up menu to choose one of the six image sequence types for
the output media. For descriptions of these output types, see Creating Image Sequence
Output Files.
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want the still images to be created. The higher the frame rate, the greater the number
of still images created and the larger the output file. For example, if you choose 30 fps,
Compressor creates 30 still images for every second of the video clip you are transcoding.
If you choose 8 fps, Compressor creates only 8 still images per second.
• Create unique output directory: Select this checkbox to create a folder for the resulting
output files. The folder is given the same name as that of the media file, and the files
are stored inside the folder and named frame-nnn. For example, if the output filename
is test, the directory path is destination/test/frame-nnn.
If you don’t select this box, the output files are stored at the top level of your destination
folder and named filename-nnn rather than frame-nnn. Be aware that even at the slow
rate of 8 fps, a large number of files are created when you transcode to this output
format, so creating an output directory is a good way to keep your files organized.
• Add leading zeros to frame numbers: Select this checkbox to add leading zeros to the
frame number. When choosing this method, all the output files consist of multidigit
filenames, such as frame-000001 (or filename-000001 if these files aren’t being saved in
a unique output directory). If you don’t select this checkbox, each file uses a regular
filename, such as frame-1 (or filename-1 if these files aren’t being saved in a unique
output directory).
• Scale image to preserve aspect ratio: Affects only video media using non-square pixels,
such as NTSC and PAL formats, and only when you are not intentionally changing the
video frame size. Select this checkbox to scale the output files to use square pixels and
maintain the original aspect ratio (which results in an increase or decrease in the number
of horizontal and vertical pixels). If the checkbox is not selected (the default setting),
the output files use the same pixel aspect ratio and have the same number of horizontal
and vertical pixels as the original video.
Configuring Image Sequence Settings
You use the Image Sequence output format if you want to transcode a video clip into a
series of still images.
To create an Image Sequence setting
1 In the Settings tab, do one of the following:
• Make sure that the correct setting is selected.
• Create a new setting by choosing Image Sequence from the “Create a new setting” (+)
pop-up menu.
2 Apply the setting to a job in the Batch window.
3 Make sure the resulting image sequence target is selected.
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pop-up menu.
The Image Sequence Encoder pane appears.
5 Use the Image Type pop-up menu to choose one of the following image sequence types
for the output media. For descriptions of these output types, see Creating Image Sequence
Output Files.
• TIFF
• TARGA
• DPX
• IFF
• JPEG
• openEXR
6 Enter a number in the Frame Rate (fps) field, choose a frame rate from the pop-up menu,
or click the Automatic button.
7 Select the “Create unique output directory” checkbox if you want your image sequence
files stored in their own folder in the destination folder.
8 Select the “Add leading zeros to frame numbers” checkbox if you want your output image
sequence files numbered with the format 0000nn.
Important: Use FTP software to upload the image sequence to remote servers.
Since all still image types require square pixels (a pixel aspect of 1.0), Compressor may
have to alter the pixel dimensions of an image sequence job. To view or adjust these
parameters, select the target in the Batch window and click the Geometry tab in the
Inspector. If you will be using the image sequence in an application that can be set to a
specific size and pixel aspect ratio (such as Motion), make the appropriate changes in the
Geometry pane before encoding.
To adjust the pixel aspect ratio of an image sequence job before transcoding
1 In the Batch window, select the image sequence target.
2 In the Geometry pane in the Inspector window, use the Frame Size pop-up menu to
choose the appropriate output dimensions (such as 720x480, 1920x1080, and so on) for
the image sequence.
The Pixel Aspect pop-up menu becomes active.
3 In the Pixel Aspect pop-up menu in the Geometry pane, choose the appropriate pixel
aspect ratio for your image sequence.
See About the Image Sequence Encoder Pane for more information about the Image
Sequence Encoder pane. See About the Geometry Pane for more information about the
Geometry pane.
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the Inspector window.
Chapter 15 Creating Image Sequence Files 173Compressor provides the tools you need to create exceptional MP3 files.
MP3 is a specific type of MPEG encoding known formally as MPEG audio layer 3. MP3 uses
perceptual audio coding and psychoacoustic compression to remove all superfluous
information (specifically the redundant and irrelevant parts of a sound signal that the
human ear doesn’t hear anyway). The result is that MP3 encoding shrinks the original
sound data from a CD (with a data rate of 1411.2 kilobits per one second of stereo music)
by a factor of 12 (down to 112–128 kbps) without sacrificing very much sound quality.
Proponents of MP3 actually claim there is no sacrifice in sound quality, but audio
professionals can usually hear the difference on good equipment.
This chapter covers the following:
• Common Uses for MP3 (p. 175)
• About the MP3 Encoder Pane (p. 176)
• MP3 Transcoding Workflow (p. 177)
Common Uses for MP3
MP3 is a widely adopted standard for compressed audio files, so it can be used in many
different ways, including music and podcasts.
Music
Almost every portable digital music player supports the MP3 audio format. By using the
higher bit rates, for example 256 kbps, you can create an excellent quality audio file using
a much smaller file size than with uncompressed audio.
You can also add metadata to the file so that when the output media file opens in many
players (including iTunes) the common information, such as artist, album, and so on,
appears.
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The MP3 format’s wide range of supported bit rates makes it ideal for delivering podcasts
at a variety of quality levels, making it possible for users to choose a file size and quality
level they are comfortable with.
Note: For the most options when creating enhanced audio podcasts, use the MPEG-4
output format. You are able to add chapter and podcast markers with URLs and artwork
to the output file. See Creating MPEG-4 Output Files for more information.
About the MP3 Encoder Pane
This section contains detailed information about the various settings within the MP3
Encoder pane of the Inspector window. You make your MP3 settings by either modifying
an existing setting or creating a new setting in the Settings tab.
The MP3 Encoder pane contains the following settings.
• Extension: This field displays the MP3 file extension (.mp3) automatically after the MP3
output format is chosen from the File Format pop-up menu or the (+) pop-up menu
in the Settings tab.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Stereo Bit Rate pop-up menu: The higher the Mono or Stereo kilobits per second (kbps),
the higher the audio quality and the larger the file size. The most common bit rate for
stereo MP3 files is between 128 kbps and 192 kbps. Lower bit rates are more appropriate
for sound files containing voice recordings (as opposed to music).
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• 32 kbps: AM radio quality, suitable for medium-quality speech
• 96 kbps: FM radio quality, suitable for high-quality speech or medium-quality music
• 128 kbps: Suitable for good-quality music
• 256 kbps and 320 kbps: Suitable for music that is near CD quality
• Use Variable Bit Rate Encoding (VBR): This setting varies the number of bits used to store
the music depending on the complexity of the music. This can help keep file size to a
minimum.
• Sample Rate pop-up menu: The number of times per second that the music waveforms
are captured digitally. The higher the sample rate, the higher the quality and the larger
the file size. Don’t choose a sample rate higher than the rate used originally to store
the music or you’ll waste space. CD quality, for example, is 44.100 kHz, so choosing a
higher rate when you’re encoding from a CD is unnecessary.
• Channels pop-up menu: If you don’t have stereo speakers or if your audio files are
monaural, choose Mono (mono files are about half the size of stereo files). If you’ll be
listening to your MP3 files using your stereo system, choose Stereo.
• Joint Stereo: When this checkbox is deselected, your MP3 files contain one track for the
right stereo channel and one track for the left. In many cases, the two channels contain
related information. When the Joint Stereo checkbox is selected, one channel carries
the information that’s identical on both channels, and the other channel carries the
unique information. At bit rates of 160 Kbps and below, this can improve the sound
quality of your converted audio.
• Smart Encoding Adjustments: Select this to have Compressor analyze your encoding
settings and music source, and then adjust settings to maximize quality.
• Filter Frequencies Below 10 Hz: Filtering inaudible frequencies results in smaller, more
efficient files without perceptible loss of quality.
MP3 Transcoding Workflow
How you use Compressor to transcode your audio into MP3 format files depends on how
you intend them to be used. The basic steps are described below.
Stage 1: Creating a Batch
As with any transcode, you need to start by creating a batch. See Preparing Compressor
for Transcoding with Custom Settings for more information.
Stage 2: Creating Jobs with the Source Audio Files
Import the source audio files either by dragging them from Finder to the batch or by
choosing Job > New Job With File.
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If you intend to play the MP3 files with a device or application, such as iTunes, you can
add a variety of annotations, such as artist, album, title, and so on, that can be read and
displayed. See Additional Information Tab for more information.
Stage 4: Adding Targets with an MP3 Setting to Each of the Jobs
Each of the jobs requires at least one target—in this case the jobs need targets with an
MP3 setting. If there is more than one job, it is easiest to select all the jobs by choosing
Edit > Select All and then choose Target > New Target With Setting to apply the same
setting to all the jobs.
Stage 5: Submitting the Batch for Transcoding
Click the Submit button to start the transcode process. See Submitting a Batch for more
information.
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MPEG-1 is an internationally accepted compression standard developed by the Motion
Picture Experts Group (MPEG). MPEG-1 allows you to create VHS-quality video files and
was designed to support SIF (Standard Interface Format) resolution noninterlaced
(progressive) video using relatively low bit rates (Compressor supports 0.5 Mbps to 2 Mbps).
It also allows you to create compressed one-channel and two-channel audio.
This chapter covers the following:
• Common Uses for MPEG-1 (p. 179)
• MPEG-1 Specifications (p. 180)
• About the MPEG-1 Encoder Pane (p. 181)
• About the MPEG-1 Video Tab (p. 182)
• About the MPEG-1 Audio Tab (p. 183)
• About System and Elementary Streams (p. 184)
• MPEG-1 Transcoding Workflow (p. 184)
• Configuring the MPEG-1 File Format for Web Use (p. 185)
• Configuring the MPEG-1 File Format for DVD Use (p. 187)
• Creating the MPEG-1 Video for DVD Setting (p. 187)
• Creating the MPEG-1 Audio for DVD Setting (p. 189)
• Optional—Creating an MPEG-1 for DVD Group and Destination (p. 191)
Common Uses for MPEG-1
MPEG-1 is a widely adopted standard, so it can be used in many distribution methods
including optical discs, the web, and audio-only files.
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MPEG-1 is the video compression format used for video CD (VCD) titles and is compatible
for use on DVD titles since all DVD players contain the hardware required for MPEG-1
playback. MPEG-1 is commonly used in videos distributed on CD-ROM. Its low bit rate
and small file sizes are useful when you must fit multiple hours of video onto a DVD and
do not require the broadcast quality of MPEG-2 encoding. A DVD can contain a mix of
MPEG-2 and MPEG-1 video.
On the Web
Since MPEG-1 was one of the first widely adopted compression standards, it has an
advantage of being compatible with most media players. This makes MPEG-1 attractive
for use on the web when you need maximum compatibility with relatively high quality.
Audio-Only
You can use MPEG-1 Layer 2 audio compression as an alternative to Dolby Digital
Professional or DTS compression. While there is no Apple setting for MPEG-1 audio-only
files in this release of Compressor, you can easily create a setting yourself. See Configuring
the MPEG-1 File Format for DVD Use for details.
MPEG-1 Specifications
Compressor supports all the MPEG-1 specifications for frame sizes, frame rates, video
encoding, and audio encoding.
MPEG-1 Frame Sizes and Frame Rates
Compressor can produce full frame rate video (25 fps and 29.97 fps for DVD and 23.976 fps,
25 fps, and 29.97 fps for the web) with SIF resolutions dependent on the use.
• Web: 320 x 240
• NTSC: 352 x 240
• PAL: 352 x 288
While the NTSC and PAL resolutions are roughly half the full resolution of MPEG-2 video,
when played on a DVD player they automatically expand to fill the entire screen.
MPEG-1 File Format Specifications
MPEG-1 video encoding uses a process very similar to that used in MPEG2
encoding—many of the same terms and settings apply. In Compressor, the encoding
settings are set as follows.
• Encoding mode: One pass
• GOP structure: Open
• GOP pattern: BBIBBP
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These settings are fixed and apply to all Compressor MPEG-1 video output files. See GOP
Tab for information about Group of Pictures (GOP) settings. See Quality Tab for information
on the encoding mode.
The MPEG-1 output files can have I-frames forced on specific frames by placing
compression markers on them. These markers can be added to the source media file
using Final Cut Pro or can be added manually in the Preview window. See Working with
Markers and Poster Frames for more information.
The MPEG-1 format does not support named chapter markers.
About the MPEG-1 Encoder Pane
This section contains detailed information about the various tabs within the MPEG-1
Encoder pane of the Inspector window. You make your MPEG-1 settings using these tabs,
by either modifying an existing setting or creating a new setting in the Settings tab.
The MPEG-1 Encoder pane opens with the default Video tab on top and contains the
following items.
• Extension: This field displays the MPEG-1 file extension (.mpg) automatically after the
MPEG-1 output format is chosen from the File Format pop-up menu or the (+) pop-up
menu in the Settings tab. The extension changes to the video-only extension (.m1v) if
the Audio tab is disabled or the audio-only extension (.m1a) if the Video tab is disabled.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
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About the MPEG-1 Video Tab
You use the Video tab to make settings related to the video format.
The Automatic button
• Enabled checkbox: Make sure this checkbox is selected if you want the MPEG-1 output
format to include the Video tab settings.
• Frame Rate pop-up menu: Choose the frame rate of the video you are encoding.
• With Purpose set to Web: The choices are 23.976, 25 (PAL frame rate), 29.97 (NTSC
frame rate), and Automatic.
• With Purpose set to DVD: The choices are 25 (PAL frame rate), 29.97 (NTSC frame rate),
and Automatic.
• Automatic button: Clicking the Automatic button forces the encoder to determine the
proper frame rate by choosing the rate that most closely matches the source frame
rate.
Note: Using the Automatic setting with nonstandard source frame rates may result in
output frame rates that do not match the intended video frame rate. For example, a
source frame rate of 15 fps with the Purpose set to DVD results in an automatic selection
of 25 (PAL). If you are intending to use the output on an NTSC DVD, you must choose
29.97 as the frame rate.
• Purpose buttons: Choose the intended purpose for the output files.
• Web: Forces the resolution to 320 x 240 regardless of the Frame Rate selection.
• DVD: Allows the Frame Rate selection to set the resolution. With the 29.97 frame
rate, the resolution is 352 x 240. With the 25 frame rate, the resolution is 352 x 288.
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number directly in the text field. While the available range is from 0.5 Mbps to 2.0 Mbps,
the actual setting you should use depends on how the output is to be used. Higher bit
rates produce better picture quality, but they also produce larger output files.
• For web projects: Choose a bit rate that best balances the picture quality with file size
and download expectations.
• For VCD projects: The recommended video bit rate is 1.15 Mbps, with a system stream
(multiplexed video and audio in the same file) bit rate of under 1.3944 Mbps.
• For DVD projects: The typical video bit rate is 1.15 Mbps, with 1.856 Mbps being the
maximum allowed.
About the MPEG-1 Audio Tab
You use the Audio tab to make settings related to the audio format.
• Enabled checkbox: Make sure this checkbox is selected if you want the MPEG-1 output
format to include the Audio tab settings.
• Sample Rate pop-up menu: Choose the sample rate of the output audio.
• 48 kHz: Required for use on DVDs.
• 44.1 kHz: Used on audio CDs. This is the most commonly supported sample rate.
• Channels buttons: Select the channel valence (stereo or mono) for the output media
file.
• Stereo: Select this button to create a stereo output audio file.
• Mono: Select this button to create a mono output audio file.
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64 kbps, 128 kbps, 192 kbps, 224 kbps, and 384 kbps. Higher bit rates produce higher
quality audio, but they also produce larger output files.
Note: The 224 kbps and 384 kbps settings are not available when Channels is set to
Mono.
About System and Elementary Streams
You can use Compressor to create system or elementary MPEG-1 streams.
System Streams
System streams, also known as multiplexed streams, combine the video and audio
components into the same file. This type of stream is most often used in web applications.
Compressor automatically creates a system stream when you enable both the Video and
Audio tabs in the same setting.
Elementary Streams
With elementary streams, there are separate files for the video and audio components.
Elementary streams are required by some applications.
Compressor automatically creates an elementary stream when only the Video or Audio
tab is enabled, but not both. To create elementary streams of both the video and the
audio, you must use two settings—one with the Video tab enabled using the file extension
of .m1v and a second with the Audio tab enabled using the file extension of .m1a.
MPEG-1 Transcoding Workflow
This section gives step-by-step instructions for setting your MPEG-1 attributes prior to
creating MPEG-1 output files with Compressor. Make your MPEG-1 settings from the
MPEG1 Encoder pane by either modifying an existing setting or creating a new setting.
See the following for common settings with the MPEG-1 output file format.
Encoding for the Web
Use the following settings when encoding MPEG-1 system streams for the web.
Video tab:
• Frame rate: Automatic
• Purpose: Web
• Bit rate: As low as you can set it and get acceptable picture quality
Audio tab:
• Sample rate: 44.1 kHz
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• Bit rate: As low as you can set it and get acceptable audio quality; use higher bit rates
when encoding stereo audio
Encoding for DVD
Use the following settings to configure two settings when encoding MPEG-1 elementary
streams for DVD authoring.
Video elementary stream setting (Video tab):
• Frame rate: 29.97 for NTSC or 25 for PAL
• Purpose: DVD
• Bit rate: 1.15 Mbps
Video elementary stream setting (Audio tab):
• Enabled checkbox: Deselected
Audio elementary stream setting (Video tab):
• Enabled checkbox: Deselected
Audio elementary stream setting (Audio tab):
• Sample rate: 48 kHz
• Channels: Stereo with two-channel sources; Mono with one-channel sources
• Bit rate: 192 kbps or 224 kbps
Configuring the MPEG-1 File Format for Web Use
The following sections guide you through configuring the MPEG-1 output file format for
web use. This process creates a single MPEG-1 system stream.
• Stage 1: Choosing Video Settings
• Stage 2: Choosing Audio Settings
Stage 1: Choosing Video Settings
This section describes creating MPEG-1 video settings for web use.
To open the MPEG-1 Encoder pane and choose video settings
1 Open the Settings tab, then choose MPEG-1 from the “Create a New Setting” (+) pop-up
menu.
The MPEG-1 Encoder pane opens in the Inspector with the default Video tab displayed.
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Click the Automatic 
button or choose 
a frame rate.
Select Web to set the 
resolution to 320 x 240.
Choose the bit rate.
Select to enable 
the Video tab.
3 Select the Enabled checkbox.
4 Click the Automatic button next to the Frame Rate pop-up menu.
You can also choose 23.976, 29.97, or 25 from the Frame Rate pop-up menu if you know
the frame rate of the source video.
5 Select the Web button.
This sets the resolution of the output to 320 x 240.
6 Choose the bit rate to use from the Bit Rate slider, or enter a value directly.
Stage 2: Choosing Audio Settings
This section describes creating MPEG-1 audio settings for web use.
To open the Audio tab and choose audio settings
1 Click the Audio button in the MPEG-1 Encoder pane to open the Audio tab.
Select to enable 
the Audio tab.
Choose the sample rate.
Select the number 
of audio channels.
Choose the bit rate.
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3 Choose 44.1 kHz from the Sample Rate pop-up menu.
4 Select Stereo when using two-channel audio sources, or Mono when using one-channel
audio sources.
5 Choose the bit rate to use from the Bit Rate pop-up menu.
6 Click the Save button (in the lower-right corner of the Inspector) to save this setting.
Configuring the MPEG-1 File Format for DVD Use
The following sections guide you through configuring the MPEG-1 output file format for
DVD use. This process creates two settings, one for video and another for audio, creating
elementary streams.
Stage 1: Creating the MPEG-1 Video for DVD Setting
Create the setting for an MPEG-1 elementary video output file suitable for DVD. See
Creating the MPEG-1 Video for DVD Setting for more information.
Stage 2: Creating the MPEG-1 Audio for DVD Setting
Create the setting for an MPEG-1 elementary audio output file suitable for DVD. See
Creating the MPEG-1 Audio for DVD Setting for more information.
Stage 3: (Optional) Creating an “MPEG-1 for DVD” Group and Destination
Optionally, you can “package” your newly-made settings in a custom “MPEG-1 for DVD”
group and destination. See Optional—Creating an MPEG-1 for DVD Group and Destination
for more information.
Creating the MPEG-1 Video for DVD Setting
The following sections create the setting for an MPEG-1 elementary video output file
suitable for DVD.
• Stage 1: Creating the MPEG-1 Video for DVD Setting
• Stage 2: Configuring the Video Settings
• Stage 3: Making an Elementary Video Stream
Stage 1: Creating the MPEG-1 Video for DVD Setting
This section describes creating MPEG-1 video settings for DVD use.
To open the Settings tab and create a new setting
1 Open the Settings tab, and choose MPEG-1 from the “Create a New Setting” (+) pop-up
menu.
This adds a new setting to the existing list.
Chapter 17 Creating MPEG-1 Output Files 1872 Name the new setting “MPEG-1 Video for DVD.”
See Creating a Setting from Scratch for more information.
Stage 2: Configuring the Video Settings
This section describes configuring MPEG-1 video settings for DVD use.
To open the MPEG-1 Encoder pane and configure the Video settings for DVD
1 Click the Encoder tab and choose MPEG-1 from the File Format pop-up menu.
2 Click the Video button in the MPEG-1 Encoder pane to open the Video tab.
Select to enable
the Video tab.
Choose the frame rate.
The file extension 
changes to .m1v once
the Audio tab is disabled.
Choose the bit rate.
Select DVD to set the 
resolution to match
the frame rate.
3 Select the Enabled checkbox.
4 Choose the frame rate that matches your source video, either 29.97 or 25, from the Frame
Rate pop-up menu.
5 Select the DVD button.
This sets the resolution of the output to match the selected frame rate.
6 Choose the bit rate to use with the Bit Rate slider, or enter a value directly.
The typical value used for DVD projects is 1.15 Mbps, with 1.856 Mbps being the maximum
allowed.
Stage 3: Making an Elementary Video Stream
In order for the output media file to be an elementary video stream, you must turn off
the audio setting.
To turn off the audio for the video setting
1 Click the Audio button in the MPEG-1 Encoder pane to open the Audio tab.
2 Deselect the Enabled checkbox.
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sets the file extension to .m1v.
Deselect to disable
the Audio tab.
3 Click the Save button (in the lower-right corner of the Inspector) to save this setting.
This saves the “MPEG-1 Video for DVD” setting.
Creating the MPEG-1 Audio for DVD Setting
The following sections create the setting for an MPEG-1 elementary audio output file
suitable for DVD.
• Stage 1: Creating the MPEG-1 Audio for DVD Setting
• Stage 2: Making an Elementary Audio Stream
• Stage 3: Configuring the Audio Settings
Stage 1: Creating the MPEG-1 Audio for DVD Setting
This section describes creating MPEG-1 audio settings for DVD use.
To open the Settings tab and create a new setting
1 Open the Settings tab and click the Add (+) button.
This adds a new setting to the existing list.
2 Name the new setting “MPEG-1 Audio for DVD.”
See Creating a Setting from Scratch for more information.
Stage 2: Making an Elementary Audio Stream
In order for the output media file to be an elementary audio stream, you must turn off
the video setting.
To turn off the video setting
1 Click the Encoder tab and choose MPEG-1 from the File Format pop-up menu.
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Deselect to disable
the Video tab.
The file extension 
changes to .m1a once
the Video tab is disabled.
3 Deselect the Enabled checkbox.
This ensures that this preset will only create an elementary audio stream and sets the file
extension to .m1a.
Stage 3: Configuring the Audio Settings
Use the following settings to create an MPEG-1 audio file for DVD.
To open the Audio tab and configure the Audio settings for DVD
1 Click the Audio button in the MPEG-1 Encoder pane to open the Audio tab.
2 Select the Enabled checkbox.
Choose the 48 kHz 
sample rate.
Choose the bit rate.
Select to enable 
the Audio tab.
Select either Stereo 
or Mono.
3 Choose 48 kHz from the Sample Rate pop-up menu.
4 Select Stereo when using two-channel audio sources or Mono when using one-channel
audio sources.
5 Choose the bit rate to use from the Bit Rate pop-up menu.
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6 Click the Save button (in the lower-right corner of the Inspector) to save this setting.
This saves the “MPEG-1 Audio for DVD” preset.
Optional—Creating an MPEG-1 for DVD Group and Destination
To make it easy to use these two MPEG-1 presets with a source, you can create an “MPEG-1
for DVD” preset group using them. See Creating Groups of Settings for more information.
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MPEG-2 is an internationally accepted compression standard developed by the Motion
Picture Experts Group (MPEG). MPEG-2 allows you to create broadcast-quality video files
and was designed to support high-resolution, high bit-rate video. It is the video
compression format used for high-quality video titles on DVD, HD broadcast, and home
satellite dish systems. All DVD players contain the hardware required for MPEG-2 playback.
This chapter covers the following:
• About Standard Definition MPEG-2 (p. 193)
• About High Definition Sources and MPEG-2 (p. 194)
• About Elementary, Transport, and Program Streams (p. 194)
• About the MPEG-2 Encoder Pane (p. 195)
• MPEG-2 Reference Information (p. 206)
• MPEG-2 Transcoding Workflow (p. 210)
• Example MPEG-2 Settings (p. 216)
About Standard Definition MPEG-2
Standard MPEG-2 is full frame rate (23.98–29.97 fps) and full-screen resolution (720 x 480
for NTSC and 720 x 576 for PAL). MPEG-2 has the following characteristics.
• Support for interlaced video: MPEG-2 can support either interlaced or progressive video.
Because MPEG-2 streams are generally played from a local DVD drive, rather than over
a network with variable bandwidth, video frame rate usually stays constant, and the
video normally looks completely smooth.
• No streaming support: MPEG-2 is not suitable for streaming video files over the web
because it requires a high bit rate (2 to 9 Mbps) to maintain acceptable image quality.
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format. To create DVD-Video discs, you can use a DVD authoring application in conjunction
with Compressor, or you can use the Create DVD job action, which is part of the Create
DVD template. See About Job Actions and About the Batch Template Chooser for more
information.
About High Definition Sources and MPEG-2
Compressor has several different options and workflows for transcoding high definition
(HD) video source files into MPEG-2 files.
HD on Blu-ray
Compressor can output MPEG-2 files for creating HD-resolution Blu-ray discs from either
HD or standard definition (SD) source media. Compressor can retain the various frame
sizes and frame rates of high definition video when transcoding to MPEG-2. And
Compressor supports the higher bit rates required by the Blu-ray format. For more
information on creating output for Blu-ray discs, see Stream Usage. Also see About Job
Actions for information on adding the Blu-ray job action to a job.
Note: The other output file format option for Blu-ray discs is H.264, also known as MPEG-4
Part 10.
HD to SD Downconversion
For those situations in which you are editing high definition (HD) sources in Final Cut Pro
and want to create a standard definition (SD) DVD from them, Compressor provides
high-quality downconversion. Compressor retains as much detail as possible during
scaling and correctly preserves progressive or interlaced formats when encoding to
MPEG-2 for DVD.
To see the source media resolution and frame rate
1 Import the source media file into the Batch window.
2 Click the source’s name in the Batch window.
The source media file’s resolution and frame rate, along with its duration, appear in the
lower-left corner of the Preview window.
About Elementary, Transport, and Program Streams
There are three common MPEG-2 stream types that are used to deliver MPEG-2 encoded
video.
• Elementary streams: These streams contain only one MPEG-2 content channel and no
audio.
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associated audio. All the channels are multiplexed together, allowing the receiver to
choose which to play back. Compressor supports creating single-channel transport
streams that can optionally include associated audio.
Transport streams can also recover from interruptions during playback, making them
ideally suited for broadcast and streaming applications where noise or network
congestion can lead to interruptions.
• Program streams: These streams contain only one MPEG-2 content channel and its
associated audio. Program streams require an error-free delivery method and are
primarily used for storage or processing within a computer.
By default, the Compressor MPEG-2 encoder creates elementary MPEG-2 steams. You can
configure the MPEG-2 encoder to create transport or program streams and choose whether
they should include audio in the Extras tab. See Extras Tab for more information.
Note: The SD DVD and Blu-ray options from the Stream Usage pop-up menu output only
elementary streams. If you select either of these and then configure the output to be
either a transport or program stream, the Stream Usage changes to Generic. See Stream
Usage for more information.
About the MPEG-2 Encoder Pane
This section contains detailed information about the various tabs within the MPEG-2
Encoder pane in the Inspector window. You make your MPEG-2 settings using these tabs,
by either modifying an existing setting or creating a new setting in the Settings tab.
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The MPEG-2 pane opens with the default Video Format tab on top and contains the
following items.
• Extension field: Displays the MPEG-2 file extension (.m2v) automatically after the MPEG-2
output format is chosen from the File Format pop-up menu.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Stream Usage: This pop-up menu allows you to choose how you intend to use the
MPEG-2 stream. Compressor modifies the options available and bit rate ranges based
on the usage you choose with this pop-up menu. See Stream Usage for more
information.
• Video Format, Quality, GOP, and Extras: These buttons open the Video Format, Quality,
GOP, and Extras tabs. Their settings are explained in the following sections.
Stream Usage
Choosing a setting from the Stream Usage pop-up menu ensures the encoded MPEG-2
stream will be suitable for how you intend to use it.
The options in the Stream Usage pop-up menu include the following:
• Generic: The Generic option allows you complete access to all the MPEG-2 settings.
This is the only option that supports the MPEG-2 640 x 480 video format in addition to
the SD and HD video formats. It is also the only option that supports creating transport
and program streams. It supports the complete bit-rate range of 2.0 Mbps to 40.0 Mbps.
• SD DVD: The SD DVD option restricts the encoding options to those allowed by the SD
DVD specification. These include the NTSC and PAL video formats and a bit-rate range
of 2.0 Mbps to 9.0 Mbps.
• Blu-ray: The Blu-ray option restricts the encoding options to those allowed by Blu-ray
video discs. These include the SD and HD video formats and a bit-rate range of
10.0 Mbps to 40.0 Mbps.
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You use the Video Format tab to make settings related to video formats, frame rates,
aspect ratio, field dominance, and timecode. All of these, except the timecode setting,
can be set to automatically configure themselves based on the video being encoded.
The Video Format tab contains the following controls.
• Video Format pop-up menu: Choose your output video file format as NTSC, PAL, 720p,
HD 1440x1080, HD 1920x1080, or a variety of versions of 640 width formats. The Stream
Usage setting determines which of these formats are actually available. When you
choose a Video Format setting, the other settings in this tab will be filled in with default
values, or they will be dimmed, indicating that there are no options for that setting.
The NTSC and PAL items refer to standard definition settings for the NTSC and PAL TV
standards. Of the major-market DVD regions, NTSC is used in North America and Japan,
and PAL is used throughout Europe.
Generally, the output video format should match the source video format. For interlaced
video originating from traditional NTSC or PAL camcorders, choose NTSC or PAL from
this pop-up menu. If you are unsure of what your source media file’s video format is,
you can choose Automatic. This setting analyzes your source media clip’s frame rate
to determine the correct video format.
If you click the video format Automatic button, the GOP size is limited to 12 or 15 (based
on whether the video is PAL or NTSC), with a closed IBBP pattern. With Automatic
selected, you cannot change the frame rate setting in this tab, or the GOP settings in
the GOP tab. See Understanding GOPs and Frame Types for more information about
GOPs.
Video Format Automatic 
button
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Formats), Compressor enters the output frame size in the fields in the Geometry pane
based on your video format selection.
The video format you choose determines the options for the associated characteristics
such as frame size and rate, aspect ratio, and field dominance.
Note: The normal frame dimensions of standard definition (SD) NTSC digital video are
720 x 486. If you want to transcode a source file using the NTSC setting, Compressor
crops the file to achieve the required MPEG-2 frame size of 720 x 480, unless you have
already specified cropping attributes for your setting. If not, Compressor crops two
rows of pixels from the top and four from the bottom. This crop attribute is only
temporary and is not saved in the setting. You can see the effects of the crop by
double-clicking the setting in the job to open the Preview window.
• Frame Rate pop-up menu: Choose the intended frame rate for the MPEG-2 output file.
Film and some video camcorders create progressive material at 24 fps (or the NTSC
variant 23.98 fps). Although the term “24p” implies video with a frame rate of 24 fps,
the frame rate is usually 23.976 fps (rounded to 23.98) fps. To transcode these sources
for DVD playback on NTSC-related TVs, choose the 23.98 setting. See About 24p (23.98p)
for more information.
Note: The NTSC frame rate is frequently mentioned as 29.97 fps. Similarly, the “NTSC
version” of 24 fps is mentioned as 23.98 fps. Both these numbers are actually
approximations to the true values 30/1.001 and 24/1.001, or 29.97003 and 23.97602
shown to more decimal places. These numbers show that 29.97 is a pretty good
approximation to 30/1.001 (only 3 frames drift in 100,000 seconds), but that 23.976
would be much better than 23.98. In fact, even though 23.98 is used as shorthand in
the Compressor Help and in the Compressor user interface, accuracy of 23.976 or better
is maintained internally in Compressor, and generally within QuickTime as well. See
About 24p (23.98p) for more information on this topic.
• Aspect Ratio pop-up menu: Choose the aspect ratio of your video file. The default is 4:3.
The other option of 16:9 is used for anamorphic DVD. The aspect ratio determines how
the picture fills the television screen. A 16:9 (widescreen) DVD viewed on a typical 4:3
television displays in letterbox format (black bars at the top and bottom of the screen).
However, a widescreen DVD displayed on a 16:9 (widescreen) TV fills the screen.
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your interlaced source media file will be the dominant (first) field in the output MPEG-2
video file. If you choose Automatic (the default), Compressor analyzes the source video
and attempts to determine field dominance automatically. The bottom field is dominant
for DV source video. This setting does not pertain to the 720p video format, since that
format must be progressive.
Note: For interlaced video, the top field is also known as the upper or odd field, and
the bottom field is also known as the lower or even field.
• Choose start timecode checkbox and field: If you leave the checkbox deselected (the
default), Compressor embeds the source media file’s existing timecode into the output
media file. Selecting this checkbox allows you to override the source media file’s existing
timecode and enter a new timecode in the timecode field. This field remains dimmed
unless the checkbox is selected, and if it is left blank, the output media file uses the
default timecode of 00:00:00:00.
• Drop frame checkbox: If you have already selected the “Choose start timecode” checkbox,
and you want your timecode to be drop frame (rather than non-drop frame), you must
also select this checkbox.
Timecode is a numbering system for labeling the frames in a video sequence. The type
of timecode designed for 30 fps video has a frame counter that counts from 0 to 29
and then increments the seconds counter and returns to 0. This type of timecode, also
known as non-drop frame timecode, maintains an accurate measure of elapsed time
for true 30 fps video. However, the NTSC frame rate is 29.97 fps, and so drop frame
timecode was defined to provide a more accurate measure of elapsed time for NTSC.
Drop frame timecode skips frame numbers 0 and 1 once a minute on the minute,
except for every 10 minutes. For example, drop frame timecode 01:08:59;29 is followed
by 01:09:00;02, skipping timecodes 01:09:00;00 and 01:09:00;01.
Note: Drop frame timecode applies only if you are using interlaced NTSC video.
Quality Tab
The Quality tab allows you to set the bit rate for your video so that it can be transcoded
to a suitable data size and quality.
In addition to the controls, the lower-right corner shows an estimate of how many minutes
of video would fit on a 4.7 GB DVD using the current settings. This time assumes a single
AIFF audio stream to be used with the MPEG-2 stream.
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Mode pop-up menu
Time estimate for a 4.7 
GB disc with a stereo 
AIFF audio stream
Motion Estimation 
pop-up menu
• Mode pop-up menu: Allows you to choose one of the following MPEG-2 encoding
modes. High Definition (HD) quality modes will be “One pass VBR Best” or “Two pass
VBR Best.”
• One pass CBR: Using this mode, the output MPEG-2 video stream’s bit rate is held
approximately constant from one GOP to the next. This is the fastest Compressor
MPEG-2 encoding mode, and it provides good to very good quality, especially at bit
rates between 5 and 9 Mbps.
• One pass VBR: This VBR (variable bit rate) encoding mode aims to maintain constant
quality (at the expense of constant bit rate) for the transcoded video file. This means
that in scenes with much detail or fast motion, Compressor allows a higher bit rate
than it allows in less detailed or still parts of the stream. In spite of this bit-rate
variability, Compressor ensures your specified average bit rate is achieved accurately
and that the maximum bit rate is not exceeded. Unlike the two-pass modes, one-pass
VBR doesn’t have a “bird’s eye” view of the source media prior to encoding, so its bit
allocation is less optimized than two-pass VBR. Nonetheless, for most standard
definition (SD) media files at bit rates of 3.5 Mbps and above, this mode provides
good to excellent quality and transcodes quickly.
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applies greater effort to its internal decision-making processes. Although one-pass
VBR Best transcodes slower than one-pass VBR, it provides excellent to outstanding
SD video quality at bit rates of 3 to 3.5 Mbps and above. Bit rates for HD MPEG-2 can
range from 10–29 Mbps average, 12–29 Mbps maximum. Compared to one-pass
VBR, one-pass VBR Best provides higher quality, especially for difficult material at low
bit rates. For short streams of 1 to 2 minutes or less, if you are using one-pass VBR
or one-pass VBR Best, the average bit-rate accuracy may be compromised by as much
as 10 to 30 percent.
• Two pass VBR: In this mode, Compressor reads through the entire source video file
twice. In the first of these passes, Compressor analyzes the entire source video stream
prior to transcoding it to determine the degree of encoding difficulty of each scene.
It then creates a bit-rate allocation plan that gives the higher bit rate to complex
scenes and a lower bit rate to easy scenes, so as to average out to the specified
average bit rate while ensuring that the specified maximum bit rate is not exceeded.
In the second pass, Compressor does the actual compression, creating the MPEG-2
output video file according to its bit-rate allocation plan. As with one-pass VBR, the
goal of two-pass VBR is constant quality rather than constant bit rate. Unlike one-pass
VBR, two-pass VBR is able to establish an overview of where best to spend its bits
across the entire source media file, before beginning the actual encoding. The result
of this process is that transcoding time is almost twice that of one-pass VBR. Although
the benefit is not twice the quality, two-pass VBR provides more consistent overall
quality than one-pass VBR, especially in source media files where the difference
between the most and the least complex scenes is substantial.
• Two pass VBR Best: This mode devotes more effort to its internal decision-making
process than does two-pass VBR. Encoding time for “Two pass VBR Best” is slower
than it is for “Two pass VBR,” but it provides the best possible quality that the
Compressor MPEG-2 encoder has to offer. This mode provides outstanding quality
at bit rates of 3–3.5 Mbps and above for standard definition (SD) video. See Job
Segmenting and Two-Pass or Multi-Pass Encoding for information about using the
two-pass modes with job segmenting.
• Average Bit Rate slider and field: Choose the average bit rate by dragging the slider or
entering a number into the accompanying field. The range available to you depends
on the Stream Usage setting. See Stream Usage for more information. There is also an
Automatic button you can use to have Compressor determine the appropriate average
and maximum bit rates.
Note: The average bit-rate setting directly controls the size of the encoded file. The
maximum bit-rate setting does not affect the encoded file’s size.
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or entering a number into the accompanying field. See About Choosing the Bit Rates
for more information. The range available to you depends on the Stream Usage setting.
See Stream Usage for more information.
Note: This slider is only available with the VBR modes and cannot be set lower than
the average bit rate. It is also not available if the Automatic button is active.
• Motion Estimation pop-up menu: This menu is another trade-off between image quality
and processing time, especially if there is a lot of motion in the source file. The three
options in this menu are described below.
• Good: The fastest motion estimation setting. This mode does well even with significant
amounts of motion between frames, if the motion has minimal interfield motion
within frames. For example, footage that has been exposed to frame-rate conversion
or other effects processes tends to have little interfield motion. In general, use Good
with the one-pass encoding mode.
• Better: A good general-purpose motion estimation setting. The Better mode provides
good results even with complex interlaced motion. Better works well for almost all
types of interlaced video sources, even shaky footage from hand-held consumer
camcorders. In general, use Better with “One pass VBR” and “Two pass VBR.” If you
are using a progressive video format, the Better mode will do only frame-based
motion estimation, and not field-based motion-vector searching, which is not relevant
for progressive source. In this case the Better mode will run somewhat faster.
• Best: This is the highest-quality motion estimation setting and should be used for
the most demanding and complex motion for interlaced sources. It is slower than
the Better mode. In general, use the Best mode to maximize quality when using “One
pass VBR Best” or “Two pass VBR Best.”
GOP Tab
You use the GOP (group of pictures) tab to select a GOP format, structure, and size. It
contains the following controls. See Understanding GOPs and Frame Types for more
information.
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the GOP tab cannot be changed and default to a closed IBBP GOP structure with a size
of 12 (for PAL) or 15 (for NTSC).
• GOP Structure pop-up menu: Choose an option from this pop-up menu to specify
whether there will be two, one, or no B-frames between the reference frames within
a GOP. GOP structure, along with GOP size, determines the number of I-frames, P-frames,
and B-frames that are used within a GOP during encoding. Choose from one of the
following:
Note: For most MPEG-2 encoding situations intended for use on a DVD, choose IBBP
as the GOP structure setting, and GOP size 15 for NTSC, or GOP size 12 for PAL. These
selections will give the best results in most situations. See GOP Structure for more
information.
• IP: No B-frames are used with this setting. Choose IP only if your media contains fast
motion that does not encode with sufficient quality using an IBBP or IBP structure.
• IBP: One B-frame is used between reference frames (I-frames and P-frames) with IBP.
Choose this setting only if your media contains fast motion that does not encode
with sufficient quality using an IBBP structure.
• IBBP: Use IBBP for the majority of MPEG-2 encoding situations, along with a GOP size
of 15 for NTSC, or 12 for PAL. Two B-frames are used between reference frames with
this setting.
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in the previous or next GOP, while open GOPs begin with one or more B-frames that
reference the last P-frame of the previous GOP. Closed GOPs created by the Compressor
MPEG-2 encoder begin with an I-frame. Select your GOP type (open or closed) based
on whether and how you create chapter markers for DVD authoring and whether you
intend to use multiple video angles in your title. See Open and Closed GOPs for more
information.
• Open: Select this button to create open GOPs.
• Closed: Select this button to create closed GOPs.
• GOP Size pop-up menu: Choose how many frames are contained within your GOP,
following the format of the chosen GOP structure. The maximum GOP size you can
choose within Compressor is 15 frames (NTSC) or 12 frames (PAL and 720p). The
minimum GOP size for all video formats is 6 frames (closed GOP) or 7 frames (open
GOP). The relationship between GOP structure and GOP size gives you GOP patterns.
See Understanding GOPs and Frame Types and GOP Size for more information.
• Pattern field: This field cannot be edited but displays the actual GOP pattern based on
your chosen GOP structure and size.
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You use the Extras tab to control the inclusion or exclusion of specific MPEG-2 authoring
information. The Extras tab contains the following controls.
• Add DVD Studio Pro metadata: Selecting this checkbox allows Compressor to parse
specific MPEG-2 authoring information during the transcoding process to accelerate
the import process into DVD Studio Pro. However, these MPEG-2 files will be
incompatible with versions of DVD Studio Pro 1.5 or earlier. Leaving the checkbox
unselected means the information will be parsed later in DVD Studio Pro.
Note: MPEG-2 streams with additional DVD Studio Pro metadata are only compatible
with DVD Studio Pro 2 (or later) versions. MPEG-2 streams with this checkbox selected
will not be compatible with versions prior to DVD Studio Pro 2 or with other DVD
authoring tools. All Apple settings have this box checked by default. To make your
MPEG-2 files compatible with other DVD authoring tools, deselect this checkbox, and
then save the setting.
• Include Chapter Markers only: Selecting this checkbox excludes unnamed compression
markers from the stream but still retains the chapter markers. Leaving the checkbox
unselected allows all markers to be recognized in the output media file. See Adding
Compression or Podcast Markers to a Clip for more information about chapter markers.
• YUV 4:2:2 Color encoding (Not for DVD use): Select this checkbox to enable 4:2:2 color
encoding. This option is supported in the creation of MPEG-2 elementary, program,
and transport streams, but it is only available when the Stream Usage pop-up menu is
set to Generic.
• Multiplexed MPEG-1/Layer 2 Audio: Use this checkbox to create a multiplexed stream
(rather than an elementary stream). You can make the output file either a transport
stream or a program stream. See About Elementary, Transport, and Program Streams
for information on the differences between the different stream types.
The audio in this stream is MPEG-1 Layer 2, with a sample rate of 44.1 kHz or 48 kHz
(depending on the source) and a bit rate of 384 kbps. To create an audio-only
(MPEG-1/Layer 2 Audio) elementary stream, see Creating the MPEG-1 Audio for DVD
Setting.
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program streams. Selecting the Multiplexed MPEG-1/Layer 2 Audio checkbox sets your
stream usage to Generic if it is currently anything else.
MPEG-2 Reference Information
The following sections contain useful information for creating MPEG-2 output media files.
About Choosing the Bit Rates
When determining average and maximum bit rates for standard DVD playback, remember
to consider the bit rate of your audio track as well as the MPEG-2 bit rate.
You must keep the total of both average and maximum audio and video bit rates under
10.08 Mbps, the maximum guaranteed transfer rate from standard DVD players. Because
DVD-compatible audio formats are constant bit rate (CBR), there is no maximum audio
bit rate to worry about.
For example, if you are using AIFF audio at 1.5 Mbps, you should keep both the average
and maximum video bit rates under 8.5 Mbps. Typically, your average bit rate will be
lower than this (for example, 3.5 Mbps for 2 hours of footage on your DVD). However,
your maximum bit rate must also stay below this number. A maximum bit rate of 8.0 Mbps
is recommended to provide an extra margin for error (for example, to accommodate
subtitle streams). If you are using one of the DVD-compatible compressed audio formats
such as Dolby Digital or MPEG-1/Layer-2, your audio bit rate may be as low as 0.2 to
0.4 Mbps, in which case you can set your maximum bit rate about 1 Mbps higher.
Also, as a general rule, set your maximum bit rate at least 1 Mbps higher than your average
bit rate, to allow for bit-rate variability in achieving the goal of constant quality.
MPEG-2 Video Frame Sizes and Formats
Since MPEG-2 uses fixed video frame sizes, Compressor enters the output frame size in
the fields in the Geometry pane based on your video format selection.
The video format you choose in the Video Format pop-up menu determines the options
for the associated characteristics such as frame size and rate, aspect ratio, and field
dominance. For more information, see Video Format Tab.
Frame rate (fps) Aspect ratio Scanning method
Frame size
Video format (pixels)
Interlaced,
progressive
23.98 (progressive 4:3 or 16:9
only), 29.97
NTSC 720 x 480
Interlaced,
progressive
PAL 720 x 576 25 4:3 or 16:9
23.98, 25, 29.97, 16:9 Progressive
50, 59.94
720p 1280 x 720
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Frame size
Video format (pixels)
Interlaced,
progressive
23.98 (progressive 16:9
only), 25, 29.97
HD 1440 x 1080 1440 x 1080
Interlaced,
progressive
23.98 (progressive 16:9
only), 25, 29.97
HD 1920 x 1080 1920 x 1080
Interlaced,
progressive
640 x 480 (1.33) 640 x 480 23.98, 25, 29.97 4:3 or 16:9
Interlaced,
progressive
640 x 360 (1.78) 640 x 360 23.98, 25, 29.97 4:3 or 16:9
Interlaced,
progressive
640 x 352 (1.82) 640 x 352 23.98, 25, 29.97 4:3 or 16:9
Interlaced,
progressive
640 x 384 (1.67) 640 x 384 23.98, 25, 29.97 4:3 or 16:9
Interlaced,
progressive
640 x 320 (2.00) 640 x 320 23.98, 25, 29.97 4:3 or 16:9
Understanding GOPs and Frame Types
A major feature of MPEG-2 encoding is its ability to remove redundancy, not only within
a frame, but also among a group of frames. MPEG-2 uses three frame types (I, P, and B)
to represent the video. A group of pictures (GOP) setting defines the pattern of the three
frame types used. These three picture types are defined in the following ways.
• Intra (I): Also known as the key frame. Every GOP contains one I-frame. The I-frame is
the only MPEG-2 frame type which can be fully decompressed without any reference
to frames that precede or follow it. It is also the most data-heavy, requiring the most
disk space. If you want to place an I-frame at a scene change or some other specific
frame location, you need to manually set it using the Preview window. This is known
as a forced I-frame. See Working with Markers and Poster Frames for more information.
• Predicted (P): Encoded from a “predicted” picture based on the closest preceding I- or
P-frame. P-frames typically require much less disk space than do I-frames because they
reference a preceding I- or P-frame in the GOP.
Note: Both I-frames and P-frames are also known asreference frames, because a B-frame
may refer to either one or both frame types.
• Bi-directional (B): Encoded from an interpolation of succeeding and preceding reference
frames, either I-frame or P-frame. B-frames are the most storage-efficient MPEG-2 frame
type, requiring the least amount of disk space.
The use of B- and P-frames is what allows MPEG-2 to remove temporal redundancy,
contributing to its ability to compress video efficiently.
Things to Consider When Choosing a GOP Setting
You need to consider the following factors when choosing a GOP setting.
Chapter 18 Creating MPEG-2 Output Files 207GOP Structure
This setting specifies whether there will be two, one, or no B-frames between the reference
frames within a GOP. GOP structure, along with GOP size, determines the number of I-,
P-, and B-frames that will be used during transcoding.
The GOP structure you choose depends on how far apart P-frames should be spaced.
Since a P-frame is predicted from the previous reference frame (either an I-frame or a
P-frame), if there are one or two B-frames in between, the prediction must cover the
distance objects can move over the duration of two to three frames.
In principle, the less average motion there is from one frame to the next, the farther apart
P-frames can be spaced, and the greater the compression can be. For most video material,
the IBBP structure is a good choice. Material with unusually fast motion throughout the
entire sequence may benefit from an IBP or IP structure, but in such cases a relatively
high bit rate (6 to 8 Mbps for SD video) may be required for good quality.
GOP Size
This setting specifies the number of frames within a GOP. Because exactly one I-frame
exists per GOP, longer GOP sizes generally provide greater compression, because B- and
P-frames are smaller than I-frames.
For most media, spacing I-frames about 1/2 second apart gives good results. This equates
to a GOP size of 15 frames for NTSC and 12 frames for PAL. The DVD-Video specification
prohibits GOP lengths from being much longer than this. Generally, only material with
scene changes occurring less than 1/2 second apart frequently throughout the video will
benefit from shorter GOP sizes.
Open and Closed GOPs
Open GOPs are most efficient because they allow an extra B-frame in the GOP pattern.
Open GOPs start with a B-frame that is able to look at the last P-frame from the preceding
GOP as well as the first I-frame of its own GOP.
:06 :07 :08 :09
:09
:04 :05 :10 :11 :12 :13 :14 :15 :16 :17 :18 :19 :20 :21
Open GOP
(IBBP, 15 frames)
P B B I B B P B B P B B P B B P B B I
:03
:04 :05 :06 :07 :08 :10 :11 :12 :13 :14 :15 :16 :17 :18
Closed GOP
(IBBP, 15 frames)
I B B P B B P B B P B B P B P
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or next GOP. In contrast, open GOPs begin with one or more B-frames that reference the
last P-frame of the previous GOP. Closed GOPs created by Compressor always begin with
an I-frame.
Open GOPs generally provide slightly better compression than do closed GOPs of the
same structure and size. The illustration above shows that a closed GOP contains one
more P-frame than does an open GOP of the same length. Since P-frames generally require
more bits than do B-frames, the open GOP achieves slightly better compression.
There are limitations to using open GOPs for DVD-Video discs that are created using a
DVD authoring application. One limitation is that only closed GOPs are permitted within
MPEG-2 streams that will be used for mixed-angle or multi-angle DVDs.
The other limitation is that DVD chapter markers can only be set at the beginning of a
closed GOP. The best time to define chapter markers is before doing MPEG-2 transcoding.
For example, if you specify your chapter markers in Final Cut Pro, you can set Compressor
to do MPEG-2 transcoding with open GOPs. Compressor will then force a closed GOP to
begin only at the specified chapter markers and will make all other GOPs open. You can
also accomplish this by specifying “forced I-frames” in the Compressor Preview window
and giving them a chapter name to be used by a DVD authoring application.
However, if you want to specify chapter markers at any GOP boundary after your video
has been transcoded in the MPEG-2 format, you should use only closed GOPs. This freedom
is limited, as it allows you to set chapter markers only at GOP boundaries, rather than at
any video frame.
About 24p (23.98p)
For DVD authoring and encoding, 24p refers to a video sequence that contains 24
progressive (non-interlaced) frames per second, with NTSC-related standard definition
frame dimensions (720 x 480 for MPEG-2). Film-based movies have a native frame rate of
24 fps, and because the MPEG-2 format is able to represent 24 fps video internally, many
commercial movie DVDs are encoded in this way. But any time you use NTSC video in
your project, the frame rate of film-transferred material will be slowed down from 24 fps
to 23.976 fps (rounded to 23.98) and a 2:3:2:3 pull-down is added. So, the more accurate
term is actually 23.98p.
Compressor can also do this for 24p source video files. For such material, the 23.98 frame
rate option (in the Video Format tab) compresses each source frame one-for-one, without
compressing repeated frames or fields in order to achieve a 29.97 fps display rate. This
results in higher quality at a lower compressed bit rate than would be possible if the 24p
material were converted to 29.97 fps prior to transcoding. Compressor also sets internal
MPEG-2 frame flags correctly, so DVD players will properly apply the 3:2 pull-down process
for display on 29.97 fps interlaced NTSC TV sets.
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skips one out of every 1000 source frames. If the 24p source video is 23.98 fps, Compressor
transcodes all source frames, without skipping (or repeating) any of them.
MPEG-2 Transcoding Workflow
This section includes step-by-step instructions for setting your MPEG-2 attributes prior
to creating MPEG-2 output files with Compressor. Make your MPEG-2 settings from the
MPEG-2 Encoder pane by either modifying an existing setting or creating a new one in
the Settings tab.
See the following steps for working with the MPEG-2 output file format. For example
values for each of these settings, see Example MPEG-2 Settings.
• Stage 1: Choosing Video Format Settings
• Stage 2: Choosing Quality Settings
• Stage 3: Choosing GOP Settings
• Stage 4: Choosing Extras Settings
Stage 1: Choosing Video Format Settings
It’s important to match the video format, aspect ratio, and field dominance to those of
your source media file. See Video Format Tab for a more detailed description of each of
these settings.
Note: The easiest way to make sure you are matching the source media file is to activate
the Automatic buttons. See About the Automatic Settings for more information.
To open the MPEG-2 Encoder pane and choose Video Format settings
1 Open the Settings tab, then choose MPEG-2 from the Add Preset (+) pop-up menu button.
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tab displayed.
Manually configure these 
settings if you do not 
intend to match the 
source media file.
Select the Automatic 
buttons to have the 
encoder match the 
source media file.
Choose the type 
of MPEG-2 stream 
to create.
2 Choose the setting from the Stream Usage pop-up menu that matches how you intend
to use the encoded video. This ensures that the MPEG-2 encoding options are restricted
to those that are supported by your intended usage. The options include:
• Generic
• SD DVD
• Blu-ray
3 Choose a format from the Video Format pop-up menu or select its Automatic button:
• NTSC (default)
• PAL
• 720p
• HD 1440x1080
• HD 1920x1080
• 640x480
• 640x360
• 640x352
• 640x384
• 640x320
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You must determine whether the intended shape of your source video is 4:3 (normal) or
16:9 (widescreen) before you can choose your aspect ratio.
5 Choose a field dominance setting based on your source media type from the Field
Dominance pop-up menu. For example, for DV choose Bottom First. Or choose the Field
Dominance Automatic button to let Compressor determine the correct setting.
6 If you want to use the timecode from your source video, leave the “Choose start timecode”
checkbox unselected. Otherwise, select this checkbox and enter a new timecode.
7 If you have selected the “Choose start timecode” checkbox, and if your video format is
NTSC, select the “drop frame” checkbox if you want to use drop frame (rather than
non-drop frame) timecode.
See Video Format Tab for more information.
Stage 2: Choosing Quality Settings
In the Quality tab, you set the MPEG-2 encoding attributes that have the greatest influence
on the resulting quality of your MPEG-2 video output file: encoding mode, average and
maximum bit rate, and type of motion estimation.
To open the Quality tab and choose the Quality settings
1 Click the Quality button in the MPEG-2 Encoder pane to open the Quality tab.
Choose a Motion 
Estimation setting.
Choose a mode that 
fits your time and 
quality requirements.
Choose bit rates that 
fit your file size and 
quality requirements.
2 Make a selection from the Mode pop-up menu.
For best image quality, choose “One pass VBR Best” or “Two pass VBR Best.” For faster
encoding, with excellent image quality, choose “One pass VBR” or “Two pass VBR.” For
HD sources, choose either “One pass VBR Best” or “Two pass VBR Best.”
With two-pass modes, the source media file is examined on the first pass and transcoded
on the second pass, with bit rates tailored to the video content. Alternatively, one-pass
modes transcode the material more quickly, but allocate bits less optimally than do the
corresponding two-pass modes.
Note: If you are using two-pass VBR with distributed processing enabled, you may want
to deselect the Allow Job Segmenting checkbox in the Encoder pane. See Job Segmenting
and Two-Pass or Multi-Pass Encoding for more information.
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button.
Choose an appropriate bit rate based on the content and length of your source video
and the intended size (in bytes) of your output file. In DVD authoring, the entire video
must fit on the DVD disc—the lower the bit rate, the more data you can store. However,
the higher the bit rate, the better the image quality will be.
As you change the Average Bit Rate value (with the slider or the field), the bit-rate
calculator at the bottom of the Quality tab dynamically shows the maximum number of
minutes of video on a DVD-5. The calculator assumes 1.5 Mbps for audio (two-channel
AIFF).
See the table below for some average bit rates and corresponding footage times for a
4.7 GB DVD.
4 If available, use the Maximum Bit Rate slider or field to set a maximum bit rate.
Because SD DVD players support peak bit rates of up to 10.08 Mbps for video plus audio,
you should set the maximum video bit rate between 8.0 and 8.5 Mbps if you are using a
1.5 Mbps (two-channel AIFF) audio track.
Note: For best results, make sure the maximum bit rate is at least 1 Mbps higher than
the average setting. Larger differences can produce better results.
5 Choose one of the following settings from the Motion Estimation pop-up menu:
• Good: The fastest motion estimation setting—sufficient when there is relatively low
motion between frames
• Better: A good general-purpose motion estimation setting—provides very good results
even in the presence of complex interlaced motion
• Best: The highest quality setting to handle the most demanding and complex motion
for interlaced sources—somewhat slower than the Better mode
See Quality Tab for more information.
The following table shows some average bit rates and corresponding footage times for
a 4.7 GB DVD:
Average bit rate Approximate duration for 4.7 GB DVD
1
3.5 Mbps 121 minutes
5.0 Mbps 94 minutes
6.0 Mbps 82 minutes
7.5 Mbps 68 minutes
8.0 Mbps 65 minutes
1 For a DVD clip with video, audio, and subpictures: assumes 1.5 Mbps for audio (two-channel AIFF).
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a minute or two in length), the resulting MPEG-2 output file size may not accurately reflect
the average bit rate you specified. If the MPEG-2 output media file is larger than you want,
you can try transcoding it again at a lower average bit rate.
Stage 3: Choosing GOP Settings
Select a suitable GOP structure and size and decide whether you want the GOPs to be
open or closed.
Note: These settings are not adjustable if you chose an HD video format in the Video
Format tab.
To open the GOP tab and choose GOP settings
1 Click the GOP button in the MPEG-2 Encoder pane to open the GOP tab.
Choose a GOP structure 
to control how many 
B-frames are used.
Choose open or 
closed GOPs.
Choose a GOP size.
2 Choose a GOP structure from the GOP Structure pop-up menu.
For the majority of MPEG-2 encoding jobs for DVD authoring, choose the IBBP GOP
structure.
3 Choose a GOP size from the GOP Size pop-up menu.
For the majority of MPEG-2 encoding jobs for DVD authoring, choose GOP size 15 for
NTSC and GOP size 12 for PAL and 24p.
The options available in this menu are determined by the GOP structure you choose and
by whether or not the GOP is open or closed.
4 Decide whether you want the GOP pattern to be open or closed and click the appropriate
button.
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The Compressor Preview window offers additional MPEG-2 transcoding flexibility by
allowing you to manually insert I-frames into your output MPEG-2 file at any frame
location, regardless of your chosen GOP pattern and size. These are known as forced
I-frames, and may be useful for improving the quality of the MPEG-2 file in the vicinity
of the scene change. See Understanding GOPs and Frame Types for more information
on I-frames.
In addition, adding I-frames to your clip allows you to create chapter markers that DVD
authoring applications can understand and use. See Working with Markers and Poster
Frames and Adding Compression or Podcast Markers to a Clip for more information.
See Understanding GOPs and Frame Types, Things to Consider When Choosing a GOP
Setting, and GOP Tab for more information about GOPs.
Stage 4: Choosing Extras Settings
You can control the inclusion or exclusion of specific MPEG-2 authoring information in
the Extras tab.
To open the Extras tab and choose Extras settings
1 Click the Extras button in the MPEG-2 Encoder pane to open the Extras tab.
2 Select the “Add DVD Studio Pro metadata” checkbox if you want Compressor to parse
specific MPEG-2 authoring information rather than parse the information later in
DVD Studio Pro.
Important: Selecting this checkbox may make your MPEG-2 files incompatible with any
DVD authoring tools other than DVD Studio Pro 2 (or later).
3 Select the “Include chapter markers only” checkbox if you want to exclude automatic
compression markers from the stream but still retain the chapter markers.
4 Select the Multiplexed MPEG-1/layer 2 Audio checkbox only if you need to create transport
or program streams. See About Elementary, Transport, and Program Streams for more
information.
See Extras Tab for more information about settings in the Extras tab.
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The following MPEG-2 settings can be used for most general MPEG-2 encoding situations.
Open the MPEG-2 Encoder pane and click the appropriate buttons to access these tabs.
Note: Be aware that many of the settings shown in this example are not suitable for all
video input formats, nor for all encoding situations. Some alternative settings are shown
in parentheses where appropriate. See the sections at the beginning of this chapter for
details on how and when to use other settings.
Video Format Tab
• Video Format: NTSC (PAL, 720p, HD 1440x1080, HD 1920x1080, or one of the 640 width
options)
• Aspect Ratio: 4:3 (16:9 for anamorphic or HD widescreen)
• Field Dominance: Automatic (not available for 720p)
Quality Tab
• Mode: “One pass VBR Best” (other one-pass and two-pass settings)
• Average Bit Rate: 5 Mbps (2 to 9 Mbps) for standard DVD or 18 Mbps for HD video
formats (range varies)
Note: Your choice of bit rate may be influenced by several factors, including the
complexity of your source video, the format and number of your audio streams, and
the total duration of all video clips to fit on your DVD.
• Maximum Bit Rate: 8.0 Mbps for standard DVD or 27 Mbps for HD video formats
• Motion Estimation: Best
GOP Tab
• GOP Structure: IBBP
• GOP Size: 15 (12 for PAL and 50i, 50p, and 24p HD formats)
• GOP Type: Open (Closed)
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MPEG-4 Part 2 (known as MPEG-4 video in QuickTime 6) plays an important role in the
evolution of standards for the Internet and wireless multimedia industries, where it has
been widely adopted.
Use MPEG-4 Part 2 anywhere you want to be compatible with MPEG-4 Part 2 devices or
players, such as the millions of smartphones and digital still cameras that capture and
play back MPEG-4 Part 2 video.
H.264, also known as MPEG-4 Part 10, is a newer technology than MPEG-4 Part 2, providing
up to four times the frame size of video encoded with the MPEG-4 Part 2 codec at a given
data rate. But, just as MPEG-1 and MPEG-2 are still used in the industry today, MPEG-4
Part 2 will continue to be used.
Note: MPEG-4 Part 2 is both a QuickTime codec (MPEG-4 Video) and an output format.
This chapter discusses MPEG-4 Part 2 as an output format.
This chapter covers the following:
• About MPEG-4 Part 2 (p. 217)
• About the MPEG-4 Part 2 Encoder Pane (p. 218)
• Using Default MPEG-4 Part 2 Settings (p. 222)
• Customizing MPEG-4 Part 2 Settings (p. 223)
• Audio Podcasting Workflow (p. 225)
• Adding Additional Settings and Presets (p. 228)
About MPEG-4 Part 2
MPEG-4 Part 2 offers the following advantages.
• Standards compliance: Output is with MPEG-4 Part 2 devices and other standards-based
(ISMA) players, such as mobile phones.
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19• High-quality video: A versatile transcoder that can be set to a target data rate and—using
one-pass variable bit rate (VBR)—can maximize the highest-quality output or speed
for the fastest possible transcode.
• Advanced Audio Coding (AAC): MPEG-4 audio accommodates a wide variety of source
audio, and brings true variable bit rate (VBR) audio transcoding to QuickTime. It uses
the Advanced Audio Coding (AAC) codec, which provides more clarity than MP3 audio
at the same bit rate with smaller file sizes, or files of the same size at higher quality.
You can also include podcasting information, such as chapter and podcast markers
with artwork and URLs, as well as a variety of text annotations.
• Hinting for streaming: Hinting refers to how a video stream is divided into streamable
pieces. To create streaming video, the streaming server needs some hints about what
data to send out and when. These hints consist of defining a maximum packet size and
maximum packet duration. A hint track contains information needed to stream your
output file. A hint track is created for every streamable media track in the output file
(video and audio), and the streaming server uses the hint track to turn the media into
real-time streams.
About the MPEG-4 Part 2 Encoder Pane
The MPEG-4 Part 2 Encoder pane allows you to select a variety of streaming types and
options.
MPEG-4 Encoder Pane General Settings
The MPEG-4 Part 2 pane contains the following items:
• File Extension field: Displays the MPEG-4 Part 2 file extension (.mp4) as soon as the
MPEG-4 output format is selected from the File Format pop-up menu or the (+) pop-up
menu in the Settings tab.
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only if you are using Compressor with distributed processing and with multi-pass
encoding. Since the MPEG-4 Part 2 format uses single-pass VBR, you can leave this
checkbox selected in all cases for added speed gains with distributed processing. For
more information, see Job Segmenting and Two-Pass or Multi-Pass Encoding.
• Video, Audio, and Streaming buttons: These buttons open the Video, Audio, and
Streaming panes, described next.
• Enhanced Podcast (m4a file): Select this checkbox to ensure that podcasting annotations
and metadata are written to the output media file. This is available for audio files only.
To make this option available, deselect the Video Enabled checkbox at the top of the
Video pane.
• Fit marker images within: Use this to specify the width and height of the podcast marker
images when creating an audio podcast. You can also click the Automatic button to
have Compressor enter the values. This option is only available when the Video Enabled
checkbox at the top of the Video pane is deselected. See Stage 5: Creating and
Configuring Markers for the Output Media File for more information.
Video Pane
The Video pane allows you to make settings for the quality (ISMA profile), frames per
second (fps) rate, key frame interval, and bit rate of your MPEG-4 Part 2 output file.
Either enter a number in 
the Bit Rate field or use 
the slider to set the bit 
rate.
The pane contains the following controls.
• Video Enabled checkbox: Make sure that this checkbox is selected if you want the MPEG-4
Part 2 output format video settings to be applied.
• Video compression: Choose the MPEG-4 compression format to use.
• MPEG-4 basic: Ensures playback on all MPEG-4 Part 2 devices.
• MPEG-4 improved: Gives better output quality, but this setting is not compatible with
older MPEG-4 Part 2 devices.
• H.264 main profile: Similar to the H.264 baseline profile but with support for
standard-definition video requirements.
• H.264 baseline profile: Primarily for videoconferencing and mobile applications.
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frame rate of your output media file, or click the Automatic button to have Compressor
choose the frame rate.
• Key Frame Interval field: Enter a value to designate how often (number of frames) you
want key frames created in your output media file, or click the Automatic button to
have Compressor choose the key frame interval rate (the displayed value is 0 with
Automatic on; the actual value is determined during the encoding process).
• Multi-pass: Select this for higher-quality results but at the expense of longer encoding
times. This is only available when you choose an H.264 option from the “Video
compression” pop-up menu.
• Bit Rate slider and field: Move the slider to set the overall video bit rate for your output
media file, or enter a specific number in the accompanying field.
Audio Pane
You use the Audio pane to set the audio track quality, sample rate, quality, and bit rate
of the MPEG-4 output file.
Sample Rate pop-up 
menu
Bit Rate slider
Use the following buttons and slider to make more detailed adjustments.
• Audio Enabled checkbox: Make sure that this checkbox is selected if you want the MPEG-4
Part 2 output format audio settings to be applied.
• Channels buttons: Choose the audio channel for your output media file to be either
mono or stereo.
• Mono: Choose this button for mono output.
• Stereo: Choose this button for stereo output.
• Sample Rate pop-up menu: Choose from one of the following sample rates: 8, 11.025,
12, 16, 22.05, 24, 32, 44.1, or 48 kHz. You can also choose Recommended to have
Compressor choose a sample rate that is suitable for the Channels and Bit Rate settings.
Note: If you choose Recommended, the sample rate is not determined until the
transcode actually starts.
• Quality pop-up menu: Choose one of the following for the audio quality of your output
media file:
• Low: This allows for fast transcoding, but it is at the expense of output file quality.
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• High: This is the best audio quality setting available. Use this setting when the audio
quality is important for the output media file and you don’t mind how long it takes
to transcode.
• Bit Rate slider and field: Move the slider to set the overall audio bit rate for your output
media file between the range of 16 kbps (2 KB/sec.) and 320 kbps (40 KB/sec.), or enter
a specific number in the accompanying field.
Streaming Pane
You use the Streaming pane to set hints for your output file, as well as set the maximum
packet size and packet duration limits of the MPEG-4 Part 2 output file. You can also set
your output media file to work with an older version of QuickTime Streaming Server
(version 4.1 or earlier).
The Streaming pane contains the following controls.
• Streaming hints enabled checkbox: Make sure that this checkbox is selected if you want
the MPEG-4 Part 2 output format streaming settings to be applied.
• QuickTime Streaming Server Compatibility (pre 4.1) checkbox: Select this checkbox if you
want your output media file to work with an older QuickTime Streaming Server (version
4.1 or earlier). You don’t need to select this checkbox if you are using a newer version
of QuickTime, because any streaming compatibility issues are automatically resolved.
• Packet Maximum Size field: Enter a number to specify the largest file size allowable (in
bytes) for a streaming packet in your output media file. The packet size you choose
should be no larger than the largest packet used on any network between the streaming
server and the viewer.
• Packet Maximum Duration field: Enter a number to specify the longest duration allowable
(in milliseconds) for a streaming packet in your output media file. The duration affects
MPEG-4 Part 2 audio only. It limits the maximum amount of audio (in milliseconds) in
any packet, which limits the audio dropout created by the loss of a packet.
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If you don’t need to customize the video and audio settings of your MPEG-4 Part 2 file,
you can use the “quick-and-easy” method to transcode your source media files. This
consists of accepting the default MPEG-4 Part 2 output format settings.
Default Video Pane Settings
These are the default video settings for MPEG-4 Part 2 output media files.
• Video Enabled: Selected
• Video compression: H.264 baseline profile
• Frame Rate: 29.97 fps
• Key Frame Interval: 30 frames
• Bit Rate: 1000 kbps
Either enter a number in 
the Bit Rate field or use 
the slider to set the bit 
rate.
See Video Pane for more information.
Default Audio Pane Settings
These are the default audio settings for MPEG-4 Part 2 output media files.
• Audio Enabled: Selected
• Channels: Stereo
• Sample Rate: 44.100 kHz
• Quality: High
• Bit Rate: 128 kbps
Sample Rate pop-up 
menu
Bit Rate slider
See Audio Pane for more information.
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These are the default streaming settings for MPEG-4 Part 2 output media files.
• Streaming hints enabled: Selected
• Packet Maximum Size: 1,450 bytes
• Packet Maximum Duration: 100 milliseconds
See Streaming Pane for more information.
If these settings are acceptable to you, there is nothing further that you need to do, and
you can begin transcoding source media files immediately.
Customizing MPEG-4 Part 2 Settings
If you want to customize your MPEG-4 Part 2 file format settings, you need to perform a
more detailed transcoding workflow than the one described above.
• Stage 1: Customizing MPEG-4 Video Settings
• Stage 2: Customizing MPEG-4 Audio Settings
• Stage 3: Editing MPEG-4 Streaming Settings
Stage 1: Customizing MPEG-4 Video Settings
You adjust MPEG-4 video settings in the MPEG-4 Encoder pane.
To open the MPEG-4 Encoder pane and adjust the MPEG-4 video settings
1 In the Inspector window, click the Encoder pane and choose MPEG-4 from the File Format
pop-up menu.
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default Video pane.
2 Adjust the MPEG-4 video settings using the available controls.
Note: Make sure the Video Enabled checkbox is selected.
See Video Pane for details about MPEG-4 Part 2 video settings.
If you don’t want to edit any other attributes, your MPEG-4 setting can be assigned to
any source media file in the usual way. See Preparing Compressor for Transcoding with
Custom Settings for more information. Otherwise, go to the next stage to edit MPEG-4
audio settings.
Stage 2: Customizing MPEG-4 Audio Settings
You adjust the MPEG-4 audio settings in the Audio pane.
To open the Audio pane and adjust the MPEG-4 audio settings
1 Click the Audio button to open the Audio pane.
Sample Rate pop-up 
menu
Bit Rate slider
2 Adjust the MPEG-4 audio settings using the available controls.
Note: Make sure that the Audio Enabled checkbox is selected.
See Audio Pane for details about MPEG-4 Part 2 audio settings.
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any source media file in the usual way. See Preparing Compressor for Transcoding with
Custom Settings for more information. Otherwise, go to the next stage to edit streaming
settings.
Stage 3: Editing MPEG-4 Streaming Settings
You edit MPEG-4 streaming settings in the Streaming pane.
To open the Streaming pane and edit the streaming settings
1 Click the Streaming button to open the Streaming pane.
2 Select the “QuickTime Streaming Server Compatibility (pre v4.1)” checkbox if your intended
distribution method is via a QuickTime Streaming Server earlier than version 4.1.
3 Enter new numbers into the Size and Duration fields for Packet Maximum, and make sure
that the “Streaming hints enabled” checkbox is selected.
4 See Streaming Pane for details about MPEG-4 Part 2 streaming settings.
Audio Podcasting Workflow
Compressor makes it easy to create an enhanced audio podcast based on the MPEG-4
output format. An enhanced audio podcast includes podcasting information such as
chapter and podcast markers with artwork and URLs, as well as a variety of text
annotations. Follow the instructions below to create an audio podcast.
• Stage 1: Configuring the MPEG-4 Output for Audio-Only Output
• Stage 2: Including Podcasting Information
• Stage 3: Applying the Setting to a Source Media File’s Target
• Stage 4: Entering Annotations for the Output Media File
• Stage 5: Creating and Configuring Markers for the Output Media File
• Stage 6: Submitting the Job and Verifying the Output Media File
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Follow the steps below to configure MPEG-4 settings for audio-only output (such as
podcasts).
To open the MPEG-4 Encoder pane and configure it for audio-only output media files
1 In the Inspector window, click the Encoder pane and choose MPEG-4 from the File Format
pop-up menu.
2 Click the Video button to open the Video pane.
3 Deselect the Video Enabled checkbox.
4 Click the Audio button to open the Audio pane.
5 Select the Audio Enabled checkbox.
This configures the MPEG-4 output to be an audio-only (.m4a) file. You can also configure
the other settings in the Audio pane as needed.
Stage 2: Including Podcasting Information
Follow the steps below to include podcasting information.
To configure the MPEG-4 output to include podcasting information
1 Select the “Enhanced Podcast (m4a file)” checkbox near the bottom of the Inspector
window.
Deselect this checkbox
to activate the “Allow 
Podcasting information” 
checkbox.
Select this checkbox 
to include podcasting 
information in the 
output media file.
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pane. Selecting this checkbox ensures that any annotations you add, as well as any chapter
and podcast markers with their artwork and URLs, are embedded with the output media
file.
2 Save the setting so that you can apply it to a source media file’s target.
Stage 3: Applying the Setting to a Source Media File’s Target
You must apply the setting to a source media file’s target to be able to configure the
podcasting information that this setting allows you to add to the output media file. See
Assigning Settings to Source Media Files for more information.
Stage 4: Entering Annotations for the Output Media File
You have the option of adding annotations (such as producer credits, keywords, and
copyright information).
To open the Additional Information tab and enter annotations
1 Click a non-target area of the job created by the source media file.
The Inspector window shows the A/V Attributes, Additional Information, and Job Action
tabs.
2 Click the Additional Information tab.
3 The Additional Information tab is where you can add annotations, such as a title and
artist, to the output media file.
Choose items from this 
pop-up menu to include 
them as annotations in 
the output media file.
4 Choose an item from the Add Annotation pop-up menu to add it to the output media
file.
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5 Double-click the item’s Value column to type in the text annotation.
6 Repeat this for each annotation item you want to add to the output media file.
See Using the Inspector with Source Media Files for more information.
While you have the job selected, you can optionally use the Job Action tab to have the
output media file automatically added to a playlist in the iTunes library. For more
information, see Adding Actions and About Job Actions.
Stage 5: Creating and Configuring Markers for the Output Media File
You can use the Preview window to add and configure chapter and podcast markers for
the output media file. You can manually add the markers or import a chapter marker list.
Each chapter and podcast marker can be named, have a URL added to it, and have a still
image added as its artwork.
To control the size of the marker images, you can also enter values in the “Fit marker
images within” setting near the bottom of the MPEG-4 Inspector window.
When played, the artwork displays along with the URL (which the viewer can click to
open a web browser to show).
See Working with Markers and Poster Frames for details on adding and configuring
markers in the Preview window.
Stage 6: Submitting the Job and Verifying the Output Media File
Once you have added the annotations and markers to the job, you can submit it to create
the output media file.
After the encoding process finishes, you can open the output media file in
QuickTime Player to verify that the markers, URLs, and artwork appear as intended.
Adding Additional Settings and Presets
Although the output format setting is the most important component of the Compressor
workflow, you can also add other settings and presets, such as filters, cropping, frame
sizing, actions, and destinations. For further instructions on how to add these settings,
see the following:
• Adding Filters to a Setting
• Working with Frame Controls
• Adding Geometry Settings
• Adding Actions
• Creating and Changing Destinations
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component plug-in feature.
This chapter discusses how to take advantage of the QuickTime component plug-in
feature, which opens up a wide variety of additional file formats that Compressor can
output from your source media files.
This chapter covers the following:
• Creating QuickTime Export Component Output Files (p. 229)
• Installing QuickTime Export Component Plug-ins (p. 230)
• About the iPod Plug-in (p. 230)
• About the QuickTime Export Components Encoder Pane (p. 231)
• Configuring Export Components Settings (p. 231)
Creating QuickTime Export Component Output Files
Compressor and QuickTime can be extended to support additional codec options and
third-party formats. This section focuses on the QuickTime component plug-in feature,
which allows you to export exotic file formats that can play on third-party devices and
operating systems, such as mobile phones. Unlike standard QuickTime movies, these
exported files cannot be played back with QuickTime Player or other QuickTime-based
applications. (For information on the native QuickTime movie file format, see Creating
QuickTime Movie Output Files.)
In the past, creating these kinds of files required multiple steps and multiple operating
systems: exporting the file, moving it to a computer on another platform, and then
encoding using another software application. The QuickTime Export Components feature
allows you to control the third-party encoding engine without having to open another
application. This streamlines your workflow and saves you the time and hassle of working
with multiple operating systems and software packages.
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Component Files 20Installing QuickTime Export Component Plug-ins
With no additional third-party software, Compressor currently supports transcoding to
3G, AVI, and iPod. The export component feature in Compressor was developed to make
it possible to add additional export plug-ins in the future. You would simply install the
third-party software and then choose the corresponding output file format from the
Encoder Type pop-up menu in the QuickTime Export Components Encoder pane of the
Inspector window.
To find out more about the currently available plug-ins and updates
µ Go to the Compressor support website at http://www.apple.com/support/compressor.
About the iPod Plug-in
The QuickTime Export Components output format includes an iPod encoder type. This
encoder creates an output file suitable for playing on an iPod, using an H.264 encoder
for the video and an AAC encoder for the audio. All settings (frame size, frame rate, and
so on) are automatically set.
Drawbacks of using this plug-in (as opposed to using the H.264 for Apple Devices output
format) include not being able to take advantage of distributed processing, include
chapter markers, or use the Frame Controls pane.
See Creating H.264 for Apple Devices Output Files for more information on creating iPod
output media files.
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The following options appear when you choose the QuickTime Export Components
output format from the File Format pop-up menu in the Encoder pane of the Inspector
window:
File Extension field
Choose QuickTime 
Export Components.
Click to see the options 
for the encoder plug-in.
Choose an encoder 
plug-in.
• File Extension: This field indicates the file extension for the output format selected from
the Encoder Type menu.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
• Encoder Type: Use this pop-up menu to choose from the available export component
output formats (plug-ins).
• Options: Click this button (if active) to open the Settings window for the output file
format selected in the Encoder Type pop-up menu.
Configuring Export Components Settings
When you choose QuickTime Export Components as your output format, you can only
create settings for export plug-ins that are already installed.
To create QuickTime Export Components settings
1 In the Settings tab, do one of the following:
• Make sure that the correct setting is selected.
• Create a new setting by choosing QuickTime Export Components from the “Create a
new setting” (+) pop-up menu.
2 Choose an output file format from the Encoder Type pop-up menu.
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The Settings window for that particular output file format opens.
Configure settings 
for the QuickTime export 
component.
Important: Use the third-party export module user interface to explicitly enter the width,
height, and frame rate for the output file. Do not leave the width, height, and frame rate
fields in the third-party user interface at their default (“current”) values.
4 Click OK to save your settings and close this dialog.
Note: The Compressor Frame Controls feature is not available when using the QuickTime
Export Component Output feature.
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QuickTime is cross-platform multimedia technology and allows Mac OS applications to
capture and play back video, audio, and still-image files. QuickTime supports a wide
variety of codecs and can also be extended to accommodate additional codec options
and third-party codecs. See Creating QuickTime Export Component Output Filesfor more
information about additional QuickTime export options.
This chapter covers the following:
• Creating QuickTime Output Files (p. 233)
• About the QuickTime Movie Encoder Pane (p. 234)
• QuickTime Transcoding Workflow (p. 240)
• Understanding Codecs (p. 244)
• QuickTime Video Codecs (p. 244)
• QuickTime Audio Codecs (p. 245)
Creating QuickTime Output Files
QuickTime is an open standard with many built-in codecs and is both a multimedia and
streaming media architecture. It is widely used for both authoring and delivery. For
example, many video editing and compositing applications use QuickTime as their base
format. QuickTime contains a wide range of video and audio codecs suitable for everything
from streaming video to DVD. The QuickTime architecture can also handle file formats
other than QuickTime movies, such as AVI files and 3G streams. For more information on
creating those kinds of formats, see Creating QuickTime Export Component Files.
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Files 21QuickTime Media Files for the Web
You can play your output media files over the web with QuickTime, once they are
compressed to a data rate appropriate for the bandwidth you expect the users to have.
You can do this by making your output media files either QuickTime Fast Start movies
(pre-buffered download) or QuickTime Streaming movies.
Compressor allows you to choose different streaming options via the Streaming pop-up
menu in the QuickTime Encoder pane. See the Streaming pop-up menu item for more
information about streaming QuickTime media files over the web.
About the QuickTime Movie Encoder Pane
The following options appear when you choose QuickTime Movie from the File Format
pop-up menu:
Summary table
File Extension field
Options button (dimmed 
unless Hinted Streaming 
is selected)
Streaming pop-up 
menu
Clean aperture selection
QuickTime Movie Encoder Pane Basic Settings
Use these basic options to control the more specific QuickTime movie settings, below.
• File Extension field: This field displays the QuickTime file extension (.mov) automatically
after the QuickTime output format is chosen from the File Format pop-up menu or the
(+) pop-up menu in the Settings tab.
• Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It is relevant
only if you are using Compressor with distributed processing and with multi-pass
encoding. For more information, see Job Segmenting and Two-Pass or Multi-Pass
Encoding.
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Settings and Sound Settings dialogs. Use these dialogs to select suitable codecs and
change other video or audio compression settings. See About the Sound Settings Dialog
and About the Compression Settings Dialog for more information on these dialogs.
• Enabled/Disabled/Pass-through: Use these pop-up menus to enable or disable Video
and Audio settings. Enabled means the video or audio track will be included in the
output movie. Disabled means the video or audio track will be excluded from the output
movie. Pass-through (audio only) means Compressor will copy the audio into the output
movie without modifying it. An example of this might involve HD (high definition) files
with multitrack audio that you want to convert to SD (standard definition) files without
disturbing the audio tracks.
Note: If you export a sequence from Final Cut Pro to Compressor (File > Export > Using
Compressor) and apply a setting with “Pass-through” selected, the audio portion of
the setting will change to a PCM setting with the sequence’s setting and channel count,
but with only a single track created on output. If you require audio passthrough for a
Final Cut Pro sequence, export a QuickTime movie (File > Export > QuickTime Movie)
and then import the movie into Compressor.
Important: If a setting has “Pass-through” selected, the Filter pane audio filters are not
available. Additionally, the Frame Controls pane retiming controls will not correct the
audio, potentially causing synchronization errors with the video.
• Streaming: Choose a QuickTime streaming option from this pop-up menu.
• None: If you choose this setting (the default), your output media file will not stream
over the Internet.
• Fast Start: This option allows your output media file to be viewed even before it is
fully downloaded from its server.
• Fast Start-Compressed Header: This setting achieves the same results as Fast Start
(allowing your output media file to be viewed before it is fully downloaded from the
server), but the output media files are smaller.
• Hinted Streaming: This setting allows hint tracks to be added to the output media
file so that it can be used with a QuickTime Streaming Server.
• Options button: This button remains dimmed unless Hinted Streaming is chosen from
the Streaming pop-up menu. Clicking this button opens the QuickTime Hint Exporter
Settings dialog, which allows you to choose extra hinting settings for your stream.
• Add clean aperture information checkbox: This checkbox (selected by default) allows
you to choose whether to add information that defines clean picture edges to the
output file.
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whether information is added to the file that a player can use to hide the edges of the
picture.
• If the checkbox is selected: Information is added to the output file that defines how
many pixels to hide to ensure that no undesirable artifacts appear along the edges.
When the output file is played using QuickTime Player, this setting can result in the
pixel aspect ratio being slightly altered.
• If the checkbox is not selected: No clean aperture information is added to the output
file. This was the standard behavior in Compressor 3.0.5 and earlier.
• Summary table: Displays full details for this setting.
QuickTime Video and Audio Settings
The QuickTime Video and Audio Settings buttons appear in the Encoder pane if you
selected QuickTime Movie as the output file format. (The Audio Settings button also
appears if you choose AIFF from the File Format pop-up menu.) You use these buttons
to open the Compression Settings and Sound Settings dialogs, where you can modify
whichever video or audio codec you want to add to the selected setting in the Settings
tab.
By default, both the Video and Audio Settings buttons are enabled, but you can disable
one or the other by deselecting the appropriate checkbox.
Video Codec Settings
The QuickTime Video Settings button provides access to the currently installed QuickTime
video codecs.
For information on how to customize video codec settings, see Stage 2: Adding a
QuickTime Video Codec.
All codecs are compatible with QuickTime, but if you intend to play back the output file
using QuickTime Player, the following delivery codecs are recommended:
• H.264
• Photo-JPEG
Audio Codec Settings
The QuickTime Audio Settings button provides access to the currently installed QuickTime
audio codecs.
For information on how to customize audio codec settings, see Stage 3: Adding a
QuickTime Audio Codec.
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media file using QuickTime Player, the following delivery codecs are recommended:
• AAC
• IMA 4:1
See QuickTime Audio Codecs for more information about audio codecs.
Chapter and Podcast Markers for QuickTime Output
Chapter markers created in Final Cut Pro are passed through (transferred) to other output
files that can be recognized by QuickTime Player, iTunes (.m4v files), and Final Cut Pro.
For information about adding chapter and podcast markers, see Working with Markers
and Poster Frames.
About the Compression Settings Dialog
You use the Compression Settings dialog to change your video codec settings for the
QuickTime output format. To open the Compression Settings dialog, click the Video
Settings button in the QuickTime Encoder pane.
If a particular setting can’t be changed, it remains dimmed. Some video codecs—such
as Photo-JPEG—allow you to make additional settings. If this is the case, the Options
button becomes available. Click it to make additional settings.
Choose a frame rate 
from this pop-up menu.
Click the Options button for 
more configuration settings.
Select a compression 
type from this pop-up 
menu.
The Compression Settings dialog contains the following items, depending on which codec
you choose in the Compression Type pop-up menu.
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The compression selection, located at the top of the window, defines which settings are
active in the rest of the window.
• Compression Type: Use this pop-up menu to choose the video codec you want to add
to your preset.
Motion Area
The Motion area settings are only active for some codecs.
• Frame Rate: With this pop-up menu, you can reduce the frame rate of your original file
to reduce the size of the compressed file. Higher frame rates make for smoother motion
but require more bandwidth. You use the Frame Rate pop-up menu to choose a different
frame rate, but for best results you should change it to a number that the original file
can be easily divided by. For example, if your original file had a frame rate of 30 fps,
you should use a frame rate of 10 fps or 15 fps. Choosing a frame rate of something
like 24 fps would result in uneven motion and even dropped frames, because 30 is not
evenly divisible by 24. Choose from the following settings: 8, 10, 12, 15, 23.98, 24, 25,
29.97, 30, 59.94, 60 fps, or choose Custom to enter a number manually.
• Key Frames: If your selected codec allows it, use the Key Frames Every field to enter the
number of frames you want between your key frames. Codecs based on the temporal
compression method use key frames. These act as a reference frame for the next
sequence of frames, so that any data redundancy between the key frame and the
ensuing frames can be removed. In between key frames are the less detailed delta
frames. You need to insert key frames throughout your media file because content
changes. Some video codecs allow you to insert a key frame every certain number of
frames, while other video codecs use natural key frames by scanning the whole file to
detect where the major similarities and differences occur and inserting the key frames
accordingly.
If there’s a lot of motion in your media file, you need key frames more often than you
do with something more static, such as a talking head sequence.
Data Rate Area
The Data Rate area is only active for some codecs.
• Data Rate: Use this field to set the number of kilobytes per second (KB/sec.) required
to deliver your media file. This setting is useful if you have a specific bit rate (such as a
DSL connection) or amount of space (on a DVD or CD-ROM). You should choose a data
rate that is appropriate for your delivery medium and set it as high as possible within
your data limitations. When you set a data rate, you override other codec quality settings
because the codec compresses the file as much as it needs to based on its data rate
limit.
Remember that the data rate is only for the video track of a media file. If your media
file also contains audio, you must allow some space for that too.
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The Compressor area changes based on the codec chosen with the Compression Type
pop-up menu.
• Options button: This button remains dimmed unless the codec you selected from the
Compression type pop-up menu offers options. It is recommended that you contact
the manufacturers of these codecs directly for more information about the additional
options they offer.
Preview Area
The Preview area is not used.
About the Sound Settings Dialog
You use the Sound Settings dialog to change your audio compression settings for either
the QuickTime or AIFF output format. To open this dialog, click the Audio Settings button
in the QuickTime Movie or AIFF Encoder pane.
If a particular audio setting cannot be changed, it remains dimmed. Most audio codecs
allow you to make additional settings. If this is the case, various buttons and controls
become available. Click them to make additional settings.
Format pop-up menu
Rate field and pop-up 
menu
Show Advanced Settings 
checkbox
The Sound Settings dialog contains the following items, with various choices for each,
depending on the audio codec you choose in the Format pop-up menu.
• Format: Choose the audio codec you want to add to your setting.
• Channels: Choose the type of channel output, such as mono, stereo, or some type of
multichannel output, depending on the codec.
• Rate: Choose the sample rate you want to use for your media file. The higher the sample
rate, the higher the audio quality, but the larger the file. Downloading a larger file takes
longer and requires more bandwidth.
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from the Format pop-up menu offers options. It is recommended that you contact the
manufacturers of these codecs directly for more information about the additional
options they offer.
QuickTime Audio Sample Sizes and Rates
If you have the disk space and bandwidth, it is best to leave your audio uncompressed.
Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD quality) samples.
Compressor supports up to 64 bits per sample floating point and a maximum sample
rate of 192 kHz.
Choosing an Audio Codec
AAC is a good general-purpose audio delivery codec and it is compatible with a wide
variety of playback devices. For QuickTime movies playing on slower computers, IMA 4:1
is a better choice because it is less computer intensive, thus allowing the computer to
focus on the more challenging video stream. See QuickTime Audio Codecs for more
information about audio codecs.
QuickTime Transcoding Workflow
The following sections outline the transcoding process required to create QuickTime
output media files.
• Stage 1: Opening the QuickTime Encoder Pane
• Stage 2: Adding a QuickTime Video Codec
• Stage 3: Adding a QuickTime Audio Codec
Stage 1: Opening the QuickTime Encoder Pane
There are many QuickTime video and audio codecs that you can choose from in
Compressor. You access all codecs via the Compression Settings and Sound Settings
dialogs, opened from the QuickTime Encoder pane by clicking the Video Settings and
Audio Settings buttons.
To confirm or create a QuickTime Movie setting
1 In the Settings tab, do one of the following:
• Make sure that the correct setting is selected.
• Create a new setting by choosing QuickTime Movie from the “Create a new setting”
(+) pop-up menu.
2 Open the Encoder pane in the Inspector window.
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buttons, Enable pop-up menus, the Streaming pop-up menu, the Options button
(dimmed), and the Summary table. See About the QuickTime Movie Encoder Pane for
more information.
Note: Make sure that the Enable pop-up menus next to the Settings buttons are set to
Enabled if you want those settings included in the transcoding.
Stage 2: Adding a QuickTime Video Codec
To add a QuickTime video codec to your setting, you need to open the Compression
Settings dialog and choose a video codec from the Compression Type pop-up menu.
Note: If you don’t intend to use any video settings, choose Disabled from the pop-up
menu.
To open the QuickTime Encoder pane and apply a video codec
1 Click the Video Settings button in the QuickTime Encoder pane.
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Choose a video codec 
from the Compression 
Type pop-up menu.
2 Choose a video codec from the Compression Type pop-up menu and either accept its
defaults or customize the other settings (in the Motion, Data Rate, and Compressor areas).
See any of the following for more information about video codecs:
• Video Codec Settings
• About the Compression Settings Dialog
• QuickTime Video Codecs
Note: You can see the current contents of your setting by viewing the Summary table.
3 Click OK to save changes and close this dialog.
Stage 3: Adding a QuickTime Audio Codec
If you want to add an audio codec to your setting, you need to open the Sound Settings
dialog and choose your audio codec settings from there.
Note: If you don’t intend to use any audio settings, choose Disabled from the pop-up
menu.
To open the QuickTime Encoder pane and apply an audio codec
1 Click the Audio Settings button in the QuickTime Encoder pane.
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Choose an audio codec 
from the Format
pop-up menu.
2 Choose an audio codec from the Format pop-up menu and either accept its defaults or
customize the other audio codec settings (Format, Channels, Rate, and Options, if
available).
See any of the following for more information about audio codecs:
• Audio Codec Settings
• About the Sound Settings Dialog
• QuickTime Audio Codecs
Note: You can see full details of the current contents of your setting by viewing the
Summary table.
3 Click OK to save your settings and close this dialog.
Adding Additional Settings and Presets
Although the output format setting is the most important component of the Compressor
workflow, you can also add other settings and presets, such as filters, cropping, frame
sizing, actions, and destinations. For further instructions on how to add these settings,
see the following:
• Adding Filters to a Setting
• Working with Frame Controls
• Adding Geometry Settings
• Adding Actions
• Creating and Changing Destinations
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Codec stands for compressor (CO)/decompressor (DEC) pairs. You use different codecs for
different playback methods (such as the web or DVD). Once you know the playback
method of your target audience, you can pick a suitable codec. To decide which codec
is right for your needs, you must choose the necessary level of compression to meet your
data rate limits and the level of quality you want.
The following sections discuss issues to be aware of when selecting a video or audio
codec.
QuickTime Video Codecs
Each codec offers advantages and disadvantages. Some are more appropriate for storing
certain types of media; others introduce more artifacts. Some compress slowly and
decompress quickly, while others compress and decompress at the same speed. Some
codecs can compress a file to 1/100 of its original size, while others decrease the file size
very little. Some codecs are available only on specific operating system platforms, some
require a particular processor, and some require a minimum version of QuickTime for
playback.
When choosing a codec you should consider the following:
• Minimum system requirements of your target audience
• Source material
• Quality of the compressed media file
• Size of the compressed media file
• Compression/decompression time for the media file
• If the media file will be streamed
Compressor comes equipped with the standard video codecs that QuickTime offers and
the additional codec options that come with QuickTime Pro. Unless you know that people
in your target audience have a particular codec installed on their computers, you should
use one of the standard QuickTime codecs to ensure universal conformity.
Note: See the relevant QuickTime documentation for more information about choosing
video codecs and how to get the best out of the video codec settings.
Video codecs can be divided into the following two types:
• Lossless codecs: Lossless codecs completely preserve the data they compress and are
usually used to transfer footage from one editing suite to another. Lossless codecs can
require high data rates and high-end computers with specialized hardware. Examples
of lossless codecs are the Animation, 8-bit, and 10-bit uncompressed 4:2:2 codecs.
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of the data and are usually used to deliver finalized video to an end user. The level of
approximation is determined by the quality of the codec. Typically there is a tradeoff
between the output quality of the codec and its achievable level of compression. With
some codecs, a compression ratio of at least 5:1 can be reached without visible
degradation. An example of a lossy codec is the Photo-JPEG codec.
Low-quality lossy compression introduces unnatural visual artifacts that may become
noticeable to the human eye. Using a lossy codec, you should compress your media
file only once, because compressing a file multiple times adds more artifacts.
QuickTime Audio Codecs
If you have the disk space and bandwidth, the best thing you can do is leave your audio
uncompressed. Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD
quality) samples. (Compressor supports up to 64 bits per sample floating point and a
maximum sample rate of 192 kHz.) If you have disk space and bandwidth limitations, you
must compress your audio. However, audio takes up less disk space than video, so it
doesn’t need to be compressed as much as video.
The two most important components of audio codecs are sample rates and size. The
sample rate sets the sound quality, and sample size sets the dynamic range of the sound.
QuickTime audio codecs allow you to set both the sample rate and size of your source
media file.
Sound Sample Rates
Digitized sound consists of sound samples captured at different frequency rates. The
more sound samples per second, the higher the sound quality. For example, audio CDs
use a 44.1 kHz sample rate, DVDs sample at 48 kHz, and telephone networks sample
voices at 8 kHz. The sample rate you choose depends on the nature of the sound. Music
requires a higher sample rate than voice, because music contains a wider range of
frequencies. Spoken voice has a more limited range of frequencies, so you can choose a
lower sample rate and still maintain acceptable audio quality. In most cases, you should
choose the highest sample rate available.
Reducing the sample rate can shrink a media file by as much as 5:1. The audio quality
will be affected, but not as much as it would be if you used 8-bit sampling. The following
table shows common sample rates and the audio device quality to expect at each rate:
Sample rate Audio device quality
48 kHz DAT/DV/DVD
44 kHz CD
22 kHz FM radio
8 kHz Telephone
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The sound sample size determines the dynamic range of the sound. 8-bit sound provides
for 256 possible values, whereas 16-bit sound allows for more than 65,000 possible values.
Choose 16-bit sound for music that has both soft and loud sections, such as orchestral
music. For spoken voice or music that has a more or less constant volume level, choosing
8-bit sound can still yield good results.
If you need to shrink your media file, you can reduce the sample size from 16 bits to 8 bits.
This cuts the file size in half but also degrades the audio quality.
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filters) that you can use to adjust the details of your transcoding projects.
This chapter covers the following:
• Working with Filters (p. 247)
• About the Filters Pane (p. 249)
• Video Filters Tab (p. 250)
• Audio Filters Tab (p. 257)
• Color Tab (p. 259)
• Adding Filters to a Setting (p. 260)
Working with Filters
You can treat your source media file with a variety of filters before you transcode it to
help improve the output quality of your video and audio. The best way to assign these
filter settings is to look at, and listen to, your source media file and choose the most
suitable one based on its content.
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Adding Filters to a Setting
22Previewing Filters
You can preview a clip containing your current filter settings by clicking the target in the
Batch window to open it in the Preview window. The Preview screen is split into original
and transcoded versions of your media file so that you can see or hear the effects of your
filter settings before processing the batch (as long as the checkbox for that particular
filter is selected).
Adjustments you make 
can be viewed in the 
Preview window.
This can be helpful when you are applying multiple filters since it can be difficult to
anticipate how the filters will interact with each other.
Important: The order of the filters in the filter list defines the order in which they are
applied to the video or audio. Try changing the order of the filters if you are seeing
unexpected results in the Preview window.
Once you are reasonably happy with your settings, it’s a good idea to scan through the
whole movie to ensure that your changes are not too extreme for some scenes.
Note: Depending on your system, the source media file type, and the number of filters
applied, the Preview window showing the filter settings may update at a lower frame
rate than the source frame rate.
See Using the Preview Window for more information.
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Compressor supports the following color spaces: YUV (R408), 2VUY, RGBA, ARGB, and
YUV (v210). Some filters require a color space conversion and some filters can handle
various color spaces. For each media file, Compressor chooses the most suitable color
space to provide the best output and performance results based on the color space of
three attributes: the source media format, the output file format, and chosen filters.
Optionally, you can use the Output Color Space pop-up menu (in the Color tab) to
manually adjust the color space for the output media file.
For more information about how you can adjust color spaces, see Color Tab.
About the Filters Pane
The Filters pane contains three tabs: one for video filters, one for audio filters, and one
for color space adjustment of output media files. The Filters pane contains all the filters
available in Compressor.
Filter controls
Choose video, audio, 
or color filters
Filters list
Use the following features in the Filters pane of the Inspector to select and adjust filters
that you want to assign to your settings.
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If you decide that you no longer want to use that filter, be sure to deselect that particular
filter’s checkbox before transcoding.
• Filters list: Select the checkbox next to the filters you want to add to your presets. Filter
settings you select appear in the Summary table in the Summary pane. You can reorder
filters by dragging them up or down in the Filters list. Because these filters are processed
one by one during transcoding—starting with the first entry in the list—it is important
that your filters are organized correctly. For example, it is sensible to place your text
overlay filter last, so that the text color you selected doesn’t get modified by some
other filter.
• Filter controls: The controls available depend on the filter selected in the Filters list. The
slider allows you to make large numerical changes to your setting, while the arrow
control lets you make single incremental number changes. The setting number appears
in the field located between the slider and arrow control.
Video Filters Tab
Compressor includes the following video filters.
BlackWhite Restore
Restores nearly black colors to pure black and nearly white colors to pure white without
affecting colors in the rest of the image. Use this filter to better compress the solid black
and white areas (the luminance) in the image, such as backgrounds. The two sliders allow
you to separately set values between 0 and 100 for black and white. See Color Spaces for
information on how color spaces relate to this filter.
• Black: Sets values between 0 and 100 for black.
• White: Sets values between 0 and 100 for white.
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Alters the overall color and luminance values of your output media file to a brighter or
darker level. Some QuickTime codecs darken your video file, so you can use this filter to
compensate for that. Choose any number between –100 and 100, but avoid the extreme
settings as they give a very washed-out quality.
• Brightness: Adjusts brightness to any number between –100 and 100.
• Contrast: Adjusts contrast to any number between –100 and 100.
Color Correct Highlights, Midtones, or Shadows
Depending on which of these you choose, this corrects white balance inaccuracies and
creates color effects on the bright, midtone, or dark areas of your clip. Adjust red, green,
and blue values independently between –100 and 100.
• Red: Adjusts red value between –100 and 100.
• Green: Adjusts green value between –100 and 100.
• Blue: Adjusts blue value between –100 and 100.
Deinterlacing
Removes the effects of interlacing.
For deinterlacing, the Frame Controls feature is recommended over this Deinterlacing
filter (a legacy filter) as it will always provide much higher quality. See Working with Frame
Controls for more information.
For general information about deinterlacing, see About Deinterlacing.
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• Algorithm: Choose from one of four deinterlacing methods.
• Blur: Blends the odd and even fields together. This setting gives more importance
to temporal data and preserves motion better, but because individual frames consist
of a composite of both frames, they don’t look good when you pause playback.
• Even: Keeps the even fields and ignores the odd fields, avoiding motion blur.
• Odd: Keeps the odd fields and ignores the even fields, avoiding motion blur.
• Sharp: Looks at both fields to make all edges sharper. This setting gives more
importance to spatial data.
Fade In/Out
Adds a dissolve from and to a matte color at the beginning and end of the clip.
• Fade In Duration: Sets the duration of the fade.
• Fade Out Duration: Sets the duration of the fade.
• Fade In Opacity: Sets the opacity of the clip’s video at the first frame. A value of 0.0 sets
the clip video to be completely covered by the matte color. A value of 0.5 sets the clip
to be 50 percent covered by the matte color.
• Fade Out Opacity: Sets the opacity of the clip’s video at the last frame. A value of 0.0
sets the clip video to be completely covered by the matte color. A value of 0.5 sets the
clip to be 50 percent covered by the matte color.
• Fade Color: Sets the matte color. When clicked, the color picker appears where you can
choose the color to fade to and from. (The Fade In and Fade Out colors must be the
same.)
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Controls the overall brightness of an image as displayed on a monitor by changing the
gamma amount of the media file. This filter can be used to remove detail from an
underexposed clip or reduce an overexposed clip’s saturation to an acceptable level
without washing out the image too much. Computers using different operating systems
have different monitor settings. For cross-platform viewing, correcting the gamma will
improve the image for all platforms.
• Gamma: Sets a gamma setting between 0.1 and 4.0.
Letterbox
Scales and positions the image in the frame within horizontal letterbox bars.
• Type: This pop-up menu allows you to choose the type of letterboxing to use. Scale
vertically compresses the video to fit within the letterbox bars. Matte crops off the
video where the letterbox bars are placed.
• Position: This pop-up menu allows you to choose the position of the video. Center
places letterbox bars above and below the video, keeping the video centered. Bottom
positions the video at the bottom of the screen with a single letterbox bar above it.
Top positions the video at the top of the screen with a single letterbox bar below it.
• Output: This pop-up menu allows you to choose the specific aspect ratio to use for the
letterbox. Each setting is followed by a value that shows the ratio of the width to the
height for that setting. For example, the Academy setting shows its aspect ratio as
1.85:1, indicating that the image’s width is 1.85 times the size of its height. The Manual
setting enables the Manual slider, which you can use to manually set the letterbox
aspect ratio.
• Manual slider: Used when Manual is selected in the Output pop-up menu. Allows you
to manually set the letterbox aspect ratio. The Manual slider has no effect when Manual
is not selected in the Output pop-up menu.
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color from the color picker.
Noise Removal
Reduces random flecks of noise from the image. Some codecs introduce noise into the
video file, which can be softened with the Noise Removal filter. You can improve image
quality and spatially compress your material more efficiently by reducing its fine detail.
The noise reduction filter allows you to blur areas of low contrast while leaving
high-contrast edges sharp. This is known as adaptive noise reduction. The results are
imperceptible to the human eye but improve the final compression of the source media.
It is especially important to use this filter with live video.
• Apply To: This pop-up menu allows you to choose which channels you want to filter
the noise from. The default is All Channels, which filters out noise from all channels
including the alpha channel. The other option is Chroma Channels, which filters out
noise only from the two chroma channels—U and V—in the AYUV color space (or R408
in Final Cut Pro terminology).
• Iterations: This pop-up menu smooths out image noise. Choose how many times
(between 1 and 4) you want the selected algorithm applied to the source media file.
The modified image is used each time as a starting point for the algorithm. The more
iterations used, the fuzzier the image becomes.
• Algorithm: Select one of the following algorithms from the Algorithm pop-up menu:
Average (each pixel’s color is modified by taking an average color of pixels around it,
including its own color value); Replace (each pixel’s color is modified by taking an
average of pixels around it, while ignoring its own color value); and Merge (each pixel’s
color is modified by taking a weighted average of surrounding pixels and itself; the
pixel’s own color value is given greater weight).
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Enhances the image contrast around object edges. Some codecs blur the video image,
so this filter can counteract the softening effect of noise removal or blurred source material
and increase the perception of sharpness in the image. When used to an extreme, the
output media file can look grainy. Choose any number between 0 and 100.
• Amount: Sets a sharpen setting between 0.0 and 100.0.
Text Overlay
Superimposes text onto the image. This is a useful tool for stamping other relevant text
information onto your output media file.
Use the following controls to position text, select color and font, and set its opacity.
• Position: Positions text in the image clip. Choose from 1 of 13 positions such as Center,
Lower Left, Lower Left - Title Safe, and so on.
• Alpha: This slider sets the text opacity. Choose between 0 and 1. A value of 0 makes
the text completely transparent, while a value of 1 makes it completely opaque.
• Overlay Text: Type your text here.
• Text Color: Click this box to choose a text color from the color picker.
• Select Font: Click this button to open a font palette for selecting font, style, and size.
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Superimposes the clip’s timecode text onto the image. You can also add a label to the
timecode text.
• Position: Positions timecode text in the image clip. Choose from 1 of 13 positions such
as Center, Lower Left, Lower Left - Title Safe, and so on.
• Alpha: This slider sets the timecode text opacity. Choose between 0 and 1. A value of
0 makes the text completely transparent, while a value of 1 makes it completely opaque.
• Label: Type any text that you want to appear to the left of the timecode number here.
• Start Timecode at 00:00:00:00 checkbox: Select this checkbox to have the timecode start
at 00:00:00:00. When this is not selected, the clip’s timecode is used.
• Text Color: Click this box to choose a timecode text color from the color picker.
• Select Font: Click this button to open a font palette for selecting font, style, and size.
Watermark
Superimposes a watermark onto the image. This is a useful tool for stamping a suitable
logo onto your output media file. The watermark filter can apply either still images or
movies as watermarks on your output media file.
Use the following pop-up menus, fields, and sliders to position and size the watermark
and set its opacity.
• Position pop-up menu: This pop-up menu positions the watermark image in the image
clip. Choose from one of 13 positions such as Center, Lower Left, Lower Left - Title Safe,
and so on.
• Scale By: This slider sets the size of the watermark image size.
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of 0 makes the watermark image completely transparent, while a value of 1 makes it
completely opaque.
• Repeat checkbox: Used when you choose a clip as the watermark, this checkbox allows
you to have the watermark clip loop its playback. If you don’t select this checkbox, the
watermark clip plays until its end and then disappears.
• Choose button: Click this button to open the file selection dialog and select a stored
watermark movie or still image.
Audio Filters Tab
Compressor includes the following audio filters.
Important: The audio filters are not available when audio is set to “Pass-through” in
QuickTime settings. See About the QuickTime Movie Encoder Pane for more information.
Dynamic Range
Allows you to dynamically control a clip’s audio levels by enhancing the quieter parts
and lowering the louder parts. This is also referred to as audio level compression.
• Soften Above: Audio above this level is reduced to the level set by the Master Gain.
• Noise Threshold: Sets the level of what is considered noise. Audio at this level and above
is dynamically boosted to the level set by the Master Gain. Audio below this level is left
as is.
• Master Gain: Sets the average level of the dynamically compressed audio.
Peak Limiter
Sets the level of the loudest audio allowed in the clip.
• Gain (dB): Sets the level above which louder peaks are reduced.
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Allows you to use the Apple AUGraphicEQ to shape a wide variety of frequencies
throughout the audible frequency range. You have the choice of a 31-band or a 10-band
version.
• Options button: Opens the Apple: AUGraphicEQ interface.
• Apple: AUGraphicEQ: You can use a pop-up menu in the equalizer’s interface to choose
to use the 31-band or 10-band version of the equalizer. You can use the slider to adjust
the level for each band to any number between –20 dB and 20 dB, or select a band
and enter a number in the dB field. You can drag the pointer to select multiple bands.
You can also hold down the Control key and drag across the bands, effectively “drawing”
an equalization curve. Click the Flatten EQ button to set all bands to a 0.0 dB value.
Fade In/Out
Adds a mix from and to a silence (or a gain level you set) at the beginning and end of
the clip.
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to have the Dynamic Range filter ahead of the Fade In/Out filter in the filter list.
• Fade In Duration: Sets the duration of the mix from the gain value to the clip’s normal
audio level at the start of the clip.
• Fade Out Duration: Sets the duration of the mix from the clip’s normal audio level to
the gain value at the end of the clip.
• Fade In Gain: Sets the level that the mix starts with. A value of –100.0 is silence while
0.0 leaves the audio as it is.
• Fade Out Gain: Sets the level that the mix ends with. A value of –100.0 is silence while
0.0 leaves the audio as it is.
Color Tab
You can use the Output Color Space pop-up menu to manually adjust the color space
for the output media file.
The Color tab includes the following controls.
• Output Color Space pop-up menu: Choose from the following options to affect the color
space in the output media file.
• Default for Encoder: Uses the standard color space for the target format.
• Preserve source: Maintains the color space of the source media file.
• SD (601): Uses the standard color space for SD media files.
• HD (709): Uses the standard color space for HD media files.
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You use the Filters pane in the Inspector window to add filters to your settings.
To add filters to a setting
1 Open the Settings tab.
2 Select the setting in the Settings tab that you want to modify. (Or select a setting already
applied to a source media file in the Batch window. This way, you can open the Preview
window and see the effects of your filter adjustments.)
3 Click the Filters pane in the Inspector.
4 Make adjustments to any filters that you want added to the setting.
Note: A checkmark appears automatically as soon as you make adjustments to any filter.
Any changes you make 
to a filter’s settings
apply to the currently 
selected filter.
The filter is automatically 
selected if you make any 
adjustments to it.
5 Drag the filters up or down within the Filters list to set the order in which you want them
applied to the source media file during transcoding.
Drag filters up or down 
to set the order in which 
you want them to be 
applied to the source 
media file.
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first item in the list—it is important that your filters be organized in the order you want
them. For example, it is sensible to place your text overlay filter last, so that the text color
you selected doesn’t get modified by some other filter.
If you move a filter, be sure to select the checkbox so that Compressor knows to apply
the filter to that setting. As an additional reminder, once you select the moved filter and
then try to select another setting, the Save dialog appears, requiring you to save or revert
the changes to that setting. By default, all selected filters are displayed first in the list.
Note: You can see setting details in the Summary pane of the Inspector window.
See About the Filters Pane for more details.
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video effects.
Through frame controls, Compressor offers high-quality transcoding from many different
source formats to many different target formats using advanced image analysis.
This chapter covers the following:
• About the Frame Controls Pane (p. 263)
• Adding Frame Controls to a Setting (p. 268)
• About Deinterlacing (p. 269)
• About Reverse Telecine (p. 270)
• Using the Retiming Controls (p. 273)
About the Frame Controls Pane
Using frame controls, you can do any of the following at levels of quality that were
previously available only through expensive hardware solutions:
• Convert video files between international television standards such as PAL to NTSC, or
NTSC to PAL.
• Downconvert high definition (HD) video sources to standard definition (SD), or upconvert
SD to HD.
• Convert a progressive stream to an interlaced one, or interlaced to progressive.
• Make high-quality frame rate adjustments, including high-quality slow-motion effects.
• Automatically remove telecine pull-down (reverse telecine).
The Advanced Format Conversions settings group in the Settings tab has particular
relevance to working with frame controls.
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23Important: Frame Controls settings cannot be previewed in the Preview window. To
preview Frame Controls settings, do a test transcode of a small section of your source
media file. (See Transcoding a Portion of the Clip with the Preview Window for more
information.)
Use the following features in the Frame Controls pane of the Inspector to select and
adjust frame controls attributes that you want to assign to your settings.
Resizing controls
Retiming controls
Frame Controls pop-up 
menu
Automatic button
Frame Controls Area
Use this pop-up menu to enable or disable the Frame Controls feature. Use the
corresponding Automatic button to enable or disable automatic mode.
Frame Controls 
Automatic button
• Frame Controls pop-up menu: Use this pop-up menu to enable or disable the Frame
Controls pane.
• Off: The default setting for most Apple presets. Choose Off if your Compressor project
does not involve changes to the frame size, frame rate, or field dominance.
• On: Allows you to manually adjust all the attributes in the Frame Controls pane.
• Automatic button: When this button is selected, Compressor analyzes the transcoding
job (the source media file and the applied setting), and then automatically determines
the appropriate Frame Controls attributes. For more information, see About the
Automatic Settings.
In Automatic mode, Frame Controls technology is engaged in the following two types
of transcodes only:
• Transcoding from high definition (HD) sources to standard definition (SD) MPEG-2
output files
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Resizing Controls Area
Use the controls in this area to choose the algorithm with which frames are resized.
• Resize Filter: Use this pop-up menu to choose from the following resizing options. This
decision is a trade-off between faster processing time and higher output quality in
projects that involve a change in resolution.
• Fast (Nearest pixel): This option provides the fastest processing time.
• Better (Linear filter): This option provides a medium trade-off between processing
time and output quality.
• Best (Statistical prediction): This option provides highest output quality, but takes
longer.
• Output Fields: Use this pop-up menu to choose the output scanning method (either
the field dominance or a conversion to progressive scanning).
• Same as source: No change to the scanning method.
• Progressive: Scanning method where each frame is complete (not divided into fields).
Use this setting in place of the Compressor Deinterlacing filter (a legacy filter in the
Filters pane) as it will always provide much higher quality.
• Top first: Interlaced field dominance (field order), also known as field two, the upper
field, or the odd field.
• Bottom first: Interlaced field dominance (field order), also known asfield one, the lower
field, or the even field.
• Deinterlace: Use this pop-up menu to choose from different techniques for deinterlacing.
This decision is a trade-off between faster processing and higher-quality deinterlacing
of motion areas within the frame. In all cases, each higher-quality deinterlacing option
yields the same or better results than the next lower quality option. However, if
downward resizing is also applied to the frame, improvements in quality may not be
noticeable. Under these circumstances, Fast or Better will likely provide sufficiently high
quality, depending on the amount of downward resizing.
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Important: Using all Best settings may result in unexpectedly long processing times.
If you are reducing the frame size in addition to deinterlacing the frame, Fast or Better
will likely provide sufficiently high quality, depending on the amount of downward
resizing.
Note: While the Deinterlace pop-up menu is always active, Compressor only deinterlaces
jobs that need it. (For example, if the source is interlaced and the Output Fields pop-up
menu is set to Progressive, Compressor will deinterlace. If the source media file is
progressive, Compressor will not deinterlace.)
• Fast (Line averaging): This option averages adjacent lines in a frame.
• Better (Motion adaptive): This option offers good-quality deinterlacing for areas of
the image that are in motion.
• Best (Motion compensated): This option offers higher-quality deinterlacing for areas
of the image that are in motion.
• Reverse Telecine: This option removes the extra fields added during the telecine
process to convert the film’s 24 fps to NTSC’s 29.97 fps. Selecting this item disables
all other items in the Frame Controls pane. See About Reverse Telecine for more
information on 3:2 pull-down and using the Reverse Telecine feature.
• Adaptive Details: Select this checkbox to use advanced image analysis to distinguish
between noise and edge areas.
• Anti-alias: Use this slider to set a softness level from 0 to 100. This parameter improves
the quality of conversions when you’re scaling media up. For example, when transcoding
standard definition video to high definition, Anti-alias smooths out jagged edges that
might appear in the image.
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is a sharpening control that lets you add detail back to an image being enlarged. Unlike
other sharpening operations, the Details Level setting is able to distinguish between
noise and feature details, and generally doesn’t increase unwanted grain. Increasing
this parameter may introduce jagged edges, however, which can be eliminated by
increasing the Anti-alias level.
Note: Adaptive Details, “Anti-alias,” and Details Level pertain only to frame resizing
(scaling), not deinterlacing.
Retiming Controls Area
Use the controls in this area to choose the algorithm with which frame rates are adjusted.
Note: When you use the retiming controls to change the video speed, Compressor will
also adjust the audio portion of the output media file so that it stays in sync with the
video. The retiming controls will not affect the audio pitch. See Using the Retiming Controls
for more information about using these options.
• Rate Conversion: Use this pop-up menu to choose from the following techniques for
retiming frames (changing the frame rate). This decision is a trade-off between faster
processing time and higher output quality. In many cases, the Better setting will provide
sufficiently high-quality conversion at a substantial savings in processing time over the
Best setting.
Important: Using all Best settings may result in unexpectedly long processing times.
The Better setting for rate conversion will provide sufficiently high-quality conversion
at a substantial savings in processing time over the Best setting.
• Fast (Nearest frame): No frame blending is applied; Compressor simply uses a copy
of the nearest available frame to fill the new in-between frames.
• Good (Frame blending): Averages neighboring frames together to create new
in-between frames.
• Better (Motion compensated): Uses optical flow to interpolate frames, with good-quality
results.
• Best (High quality motion compensated): Uses optical flow to interpolate frames, with
higher-quality results; this option is particularly useful for transcodes that involve
increases in frame rates (for example, 23.98 fps to 59.94 fps).
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to a new duration.
Selection pop-up menu
• Percent of source: Use this to enter a percentage value to modify the clip’s speed or
choose a specific situation from the pop-up menu. For more information about the
options in this radio button, see Entering a Percentage.
• Total duration: Use this to choose a duration for the clip. For more information about
the options in this radio button, see Entering a Duration.
• So source frames play at [frame rate] fps: Use this when the source media file’s frame
rate does not match the Encoder pane frame rate (shown as the frame rate for this
item). For more information about the options in this radio button, see Forcing Frames
to Play at the Encoder Pane’s Frame Rate Setting.
Adding Frame Controls to a Setting
You use the Frame Controls pane in the Inspector window to add frame resizing and
retiming adjustments to your settings.
To add automatic Frame Controls adjustments to a setting
1 Open the Settings tab.
2 Select the setting in the Settings tab that you want to modify. (Or select a setting already
applied to a source media file in the Batch window.)
3 Click the Frame Controls tab in the Inspector window.
4 Click the Automatic button next to the Frame Controls pop-up menu.
Compressor analyzes the transcoding job (the source media file and the applied setting)
and then automatically determines the appropriate Frame Controls attributes.
In Automatic mode, Frame Controls technology is engaged in the following two types
of transcodes only:
• Transcoding from high definition (HD) sources to standard definition (SD) MPEG-2
output files
• Transcoding from interlaced sources to H.264 for Apple Devices (progressive) output
files
To add custom Frame Controls adjustments to a setting
1 Open the Settings tab.
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applied to a source media file in the Batch window.)
3 Click the Frame Controls tab in the Inspector window.
4 Choose On from the Frame Controls pop-up menu.
Choosing On allows you to manually adjust all the attributes in the Frame Controls pane.
Note: If the Automatic button is active, you will first need to click it to turn it off.
5 Make changes to any of the controls in the Frame Controls pane. (See About the Frame
Controls Pane for details on each of the controls.)
6 Click Save to save the changes.
About Deinterlacing
You can use the Frame Controls feature in Compressor to deinterlace your video media.
NTSC and PAL video is interlaced. This means that each frame of video consists of two
fields (1/60 of a second apart), one with the odd broadcast lines and one with the even
lines of the image. The differences between these two fields create the impression of
motion. Our eyes combine these two images into one whole frame of smooth, realistic
motion at 30 fps in standard definition television, and because of the high field-refresh
speeds (1/60 of a second), the interlacing is invisible.
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the field become separated into alternating jagged lines. You can view your source media
one frame at a time and check for horizontal stripes along the leading and trailing edges
of moving objects. If you find these, you need to deinterlace your source media to convert
it to a frame-based format.
Interlacing creates 
a “comb” effect that 
should be removed.
If your source media file needs to be converted to a frame-based format, you must
deinterlace it to remove the effects of interlacing. Interlacing on computer displays can
cause high-motion parts of your video to look fuzzy, so this is especially important if
you’re outputting a QuickTime movie for desktop or web playback. You can remove the
upper (odd) or lower (even) field from an interlaced video file, although smooth motion
may be compromised within the clip. This filter can also be used to eliminate flickering
caused by interlacing in still frames that have thin vertical lines, such as title pages with
small text. The remaining fields are interpolated to create a whole image, resulting in an
overall softening of the image.
About Reverse Telecine
The Deinterlace pop-up menu includes a setting for reversing the telecine.
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The most common approach to distributing film’s 24 fps among NTSC video’s 29.97 fps
is to perform a 3:2 pull-down (also known as a 2:3:2:3 pull-down). If you alternate recording
two fields of one film frame and then three fields of the next, the 24 frames in 1 second
of film end up filling the 30 frames in 1 second of video.
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As shown above, the 3:2 pattern (actually a 2:3:2:3 pattern since frame A is recorded to
two fields followed by frame B recorded to three fields) repeats after four film frames.
Virtually all high-end commercials, movies, and non-live television shows use this process
prior to being broadcast.
For editing and effects purposes, it is often desirable to remove the extra fields and restore
the video to its original 23.98 fps rate. An additional benefit of restoring the original
23.98 fps rate is that it is easier to convert this to the PAL 25 fps rate.
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video, leading to smaller file sizes. The reverse telecine feature makes it easy to do this.
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About the Cadence
When film is telecined to NTSC video, it has a constant cadence. This means that the 3:2
pattern is consistent and uninterrupted. It is relatively easy to remove the telecine from
a constant cadence clip since you only have to determine the pattern once.
If you take these telecined clips and edit them as NTSC video, the result will be a final
video file that has a broken cadence with an inconsistent 3:2 pattern. It is much more
difficult to remove the telecine from this clip since you have to constantly verify the
cadence to make sure you don’t inadvertently choose incorrect fields when creating the
23.98 fps video.
The Reverse Telecine feature included with Compressor automatically detects broken
cadences and adjusts its processing as needed.
Other Reverse Telecine Issues
There are a few other issues to be aware of when you use the Reverse Telecine feature.
All Other Frame Controls Settings Are Disabled
Since the goal of the Reverse Telecine feature is progressive 23.98 fps video, all the other
options of the Frame Controls pane are disabled when Reverse Telecine is selected.
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Because of the unpredictable nature of the processing when reversing the telecine,
segmented encoding does not work as efficiently as it does when reverse telecine is not
being used.
About Pausing the Transcode Process
If you pause the transcode process, the transcode must start from the beginning when
you restart it.
Creating PAL Video During the Reverse Telecine Process
It is a common practice to convert 23.98 fps or 24 fps video to PAL’s 25 fps rate by speeding
up the playback by 4 percent. If you are starting with NTSC 29.97 fps video from a telecine,
you can convert it to PAL video using two jobs.
• First job: Apply a setting to the job that performs the reverse telecine process and
results in an NTSC frame size at 23.98 fps.
Note: You could apply a setting that also converts the video to PAL; however, the
format conversion will not be done using Frame Controls and may not be of suitable
quality.
• Second job: Create the second job by having the first job selected and choosing Job >
New Job With Target Output. This creates a job that is chained to the output of the
first job. You can now apply a setting that sets the output format to PAL and use the
Frame Controls feature to ensure a high-quality output file.
See About Adding and Copying Jobs for more information about chaining jobs.
Using the Retiming Controls
The retiming controls have two common uses.
• Converting video from one frame rate to another: This typically involves converting NTSC
to PAL frame rates or PAL to NTSC frame rates. This function uses only the setting of
the Rate Conversion pop-up menu and is automatically configured when necessary.
• Converting video to a new speed: This can be a matter of playing the existing frames at
a different rate or, in the case of slow-motion effects, it can require generating
intermediate frames.
In all cases, if the source media file contains audio, the audio also has its speed changed,
with the audio pitch corrected so that it sounds the same as the original, just at a different
speed. This ensures that you will maintain sync between the video and audio.
If you preview a setting that uses retiming controls, the video will play at its new frame
rate or speed, but it will not have been processed by Frame Controls and will be of a
lower quality than the actual transcoded output file will be. The audio is pitch corrected
when the setting is previewed.
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output format and choose “Pass-through” for the audio setting, the audio does not have
its speed changed and will not maintain sync with the video. See About the QuickTime
Movie Encoder Pane for more information.
Converting Video to a New Speed
The retiming controls give you three options for determining the playback speed.
You can determine the playback speed of the output media file by:
• Entering a percentage
• Entering a duration
• Forcing the frames to play at the Encoder pane’s Frame Rate setting
Entering a Percentage
You have two options when using the percentage method to determine the clip’s duration:
• Entering a percentage value
• Choosing a preset value
The presets that you choose from are intended to be used for specific situations.
• 24 @ 25: Use this setting when you have 24 fps video that you want to convert to 25 fps
for PAL distribution.
• 23.98 @ 24: Use this setting when you have 23.98 fps video and want to convert it to
24 fps.
• 23.98 @ 25: Use this setting when you have 23.98 fps video and want to convert it to
25 fps for PAL distribution.
• 30 @ 29.97: Use this setting when you have 30 fps video and want to convert it to
29.97 fps.
• 29.97 @ 30: Use this setting when you have 29.97 fps video and want to convert it to
30 fps.
274 Chapter 23 Working with Frame Controls• 24 @ 23.98: Use this setting when you have 24 fps video and want to convert it to
23.98 fps for NTSC DVD distribution.
With all these options, no intermediate video frames are required—the existing frames
are just set to play back faster or slower.
Entering a Duration
The duration field shows the clip’s current duration. As you change the duration, the
percentage value changes to reflect that change.
This option is most useful when you have a source media file whose duration is a bit
longer or shorter than it needs to be, and you’d rather change its playback speed than
add or remove video frames.
With this method, intermediate video frames are created as needed.
Forcing Frames to Play at the Encoder Pane’s Frame Rate Setting
This option is used when your source media file uses a frame rate different from the
Encoder pane’s Frame Rate setting.
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Inspector window.
This chapter covers the following:
• Working with Cropping, Scaling, and Padding (p. 277)
• About the Geometry Pane (p. 279)
• Making Geometry Adjustments to a Setting (p. 283)
Working with Cropping, Scaling, and Padding
The Geometry pane provides three different methods you can use to affect the output
image.
Cropping
When you crop an image, you are removing video content. Often that content is
unnecessary image area (such as the overscan area, which is necessary for television, but
not for computers) to make what’s left seem bigger in the same frame size.
Cropping also includes a “Letterbox area of source” setting that detects image edges and
automatically enters crop values to match them. This is especially useful if you want to
crop out the letterbox area of a source media file.
When you adjust the crop settings, one of two things happens to the output video file’s
frame size:
• The frame size remains the same if you have chosen anything other than the 100% of
source, 50% of source, and 25% of source settings in the Frame Size pop-up menu of
the “Dimensions (encoded pixels)” section of the Geometry pane. This means that the
source video image is scaled larger to fill the output video file’s frame size, which results
in larger pixels and overall image degradation.
• The frame size reduces by the crop amounts if you have chosen the 100% of source,
50% of source, or 25% of source settings in the Frame Size pop-up menu of the
“Dimensions (encoded pixels)” section of the Geometry pane. This can result in
nonstandard frame sizes.
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Scaling
Scaling provides a way to alter the output video file’s frame size without removing any
of the source image. Most often, scaling involves shrinking your output media image size
to save storage space or reduce the bit rate.
Compressor offers four basic methods for scaling the image size of an output media file.
• Choose a percentage of the source size: Three settings scale the source image based on
a percentage (100% of source, 50% of source, and 25% of source). In addition to the
source image frame size, crop values will affect the actual frame size of the output
video.
• Choose a maximum frame size: Six settings scale the source image to maintain the
original aspect ratio and to be as large as possible without going over the selected
frame size.
• Choose a specific frame size: There are several standard frame size settings you can
choose from, such as 720x486, 720x576, and so on. When you choose any of these, the
output video file’s frame size will match this setting.
• Enter a custom value: You can enter a custom frame size. Additionally, you can have
the custom frame size constrained to a common aspect ratio such as 4:3 or 16:9. When
you enter a custom frame size, the output video file’s frame size will match this setting.
You are also able to define the output image’s pixel aspect ratio by choosing from a
pop-up menu with the common settings.
Note: The scaling settings are only active when using the MPEG-4, QuickTime Movie, and
Image Sequence output encoding formats.
The scaling settings are in the “Dimensions (encoded pixels)” section of the Geometry
pane.
Padding
Padding provides a method to scale the image to a smaller size while retaining the output
image’s frame size by filling the padded areas with black. Unlike cropping, padding does
not remove any of the source image—the image is reduced by scaling by the padding
amounts.
Padding is useful when the source image frame size is smaller than the output image
frame size and you want to prevent the source image from being scaled to the output
image size. By adding the correct amount of padding, the source image will remain the
same size in the output image, with black filling the rest of the image frame.
Padding is automatically applied when the source video image is uncompressed NTSC
720 x 486 and the output image is 720 x 480.
278 Chapter 24 Adding Geometry SettingsThere are also several common padding settings you can choose from, such as 16 x 9 and
Panavision. These make it easy to have Compressor automatically enter padding values
to ensure the source image retains its original aspect ratio.
The padding settings are in the Output Image Inset (Padding) section of the Geometry
pane.
About the Geometry Pane
You use the Geometry pane to choose cropping and sizing settings, output media file
sizes, and the aspect ratio (the ratio between image frame width and height).
Cropping
Scaling
Padding
Source Inset (Cropping) Settings
You can use the “Crop to” pop-up menu to apply a center crop or enter cropping settings
in the fields described below.
• “Crop to” pop-up menu: Choose from the following options for manual cropping or
automatic center cropping.
The actual numeric crop values are determined once a target setting is applied to a
job.
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(720 x 486) using an MPEG-2 NTSC setting, your output media file will be automatically
cropped (two pixels from the top and four from the bottom) to achieve the MPEG-2
required dimensions of 720 x 480, unless you already specified cropping attributes. This
crop attribute is only temporary and is not saved in the setting. You can see the
automatic crop in the usual way, by double-clicking the setting in the job to open the
Preview window. See About the MPEG-2 Encoder Pane for more information about the
Video Format pop-up menu.
• Custom: Choose this option to manually enter values in the Left, Right, Top, and
Bottom cropping fields, or to adjust these values by dragging the red frame bars in
the Preview window. For more information, see Making Geometry Adjustments to a
Setting.
• 4:3 (1.33:1): Applies an automatic center crop with an aspect ratio of 4:3.
• 16:9 (1.78:1): Applies an automatic center crop with an aspect ratio of 16:9.
• Panavision (2.35:1): Applies an automatic center crop with an aspect ratio of 2.35:1.
• Europe Standard (1.66:1): Applies an automatic center crop with an aspect ratio of
1.66:1.
• UK Standard (1.75:1): Applies an automatic center crop with an aspect ratio of 1.75:1.
• Academy (1.85:1): Applies an automatic center crop with an aspect ratio of 1.85:1.
• Letterbox area of source: This option allows Compressor to detect whether the source
media file has been letterboxed, and if it has, to enter crop values to remove the
letterbox.
• Left, Right, Top, and Bottom: The four cropping fields (Left, Top, Right, and Bottom)
allow you to crop the frame of your source media file in pixel increments. Most broadcast
video files have overscan areas. If the output file will be shown exclusively on a computer
screen rather than on a television screen, you can safely remove some edging from
your file without affecting the picture area. The numbers give the distance (in pixels)
between the edge of the original frame and the resulting cropped frame. All fields
default to 0.
Note: The regular (action safe) overscan area is the outer 5 percent of the image on all
four sides. Cut in an additional 5 percent and you have the more conservative title safe
area. So you can safely crop anywhere between 5 and 10 percent of your outer frame
area and still preserve the essential material.
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The settings in the Dimensions section are only active when using the MPEG- 4, QuickTime
Movie, and Image Sequence output encoding formats. For other formats, the settings
are dimmed but show the settings that will be used when the batch is submitted.
• Frame Size Width and Height fields: These text fields and associated pop-up menus allow
you to customize the frame size and aspect ratio of your output media file. Enter a
value in either the Width or the Height field or choose an option from the associated
pop-up menu.
• Frame Size pop-up menu: The relevant output size dimensions are automatically entered
in the Width and Height fields based on the choices you make in the pop-up menus.
• 100% of source: Defines an output dimension identical to the dimension of the source
media. (This option makes leaves the dimension unchanged.)
• 50% of source: Scales the output dimension to exactly 50% of the source media
dimension.
• 25% of source: Scales the output dimension to exactly 25% of the source media
dimension.
• Up to 1920x1080: Scales the output dimensions to not exceed a 1920 x 1080 frame
size while maintaining the original aspect ratio.
• Up to 1280x720: Scales the output dimensions to not exceed a 1280 x 720 frame size
while maintaining the original aspect ratio.
• Up to 960x540: Scales the output dimensions to not exceed a 960 x 540 frame size
while maintaining the original aspect ratio.
• Up to 854x480: Scales the output dimensions to not exceed a 854 x 480 frame size
while maintaining the original aspect ratio.
• Up to 428x240: Scales the output dimensions to not exceed a 428 x 240 frame size
while maintaining the original aspect ratio.
• Up to 214x120: Scales the output dimensions to not exceed a 214 x 120 frame size
while maintaining the original aspect ratio.
• 320x240: Defines an output dimension of exactly 320 x 240.
• 640x480: Defines an output dimension of exactly 640 x 480.
• 720x480: Defines an output dimension of exactly 720 x 480.
• 720x486: Defines an output dimension of exactly 720 x 486.
• 720x576: Defines an output dimension of exactly 720 x 576.
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• 1920x1080: Defines an output dimension of exactly 1920 x 1080.
• Custom: This is a manually created setting. Enter whichever dimensions suit your
needs in the Width and Height fields. This setting has no constraint on the aspect
ratio.
• Custom (4:3): This manual setting is constrained to the 4:3 aspect ratio. Enter a value
in either the Width or the Height field, and the other value is entered automatically.
• Custom (16:9): This manual setting is constrained to the 16:9 aspect ratio. Enter a
value in either the Width or the Height field, and the other value is entered
automatically.
• Custom (1.85:1): This manual setting is constrained to the 1.85:1 aspect ratio. Enter
a value in either the Width or the Height field, and the other value is entered
automatically.
• Custom (2.35:1): This manual setting is constrained to the 2.35:1 aspect ratio. Enter
a value in either the Width or the Height field, and the other value is entered
automatically.
• Pixel Aspect field: You can choose Custom from the Pixel Aspect pop-up menu and
enter any value in this field. The pixel aspect ratio refers to the shape of the pixels in a
digital image. This is especially important when using some filters. For example, if the
graphic you use for the Watermark filter uses a circle and you want to be sure it still
looks like a circle when finished (as opposed to an oval), you must choose the pixel
aspect setting that matches your output format.
• Pixel Aspect pop-up menu: Use this pop-up menu to set the pixel aspect ratio of the
output media file. This forces the pixel aspect ratios to conform to specific formats.
Options include the following.
• Custom: Choose this option to manually enter values in the Pixel Aspect field.
• Default for size: The pixel aspect ratio is set to the commonly assumed value for the
setting’s width and height. For example, the default for 720 x 480 or 720 x 486 is
NTSC CCIR 601/DV NTSC.
• Square: Use this when the output is to be displayed on computers.
• NTSC CCIR 601/DV: Forces the pixel aspect ratio to 4:3 using 720 x 480 pixels.
• NTSC CCIR 601/DV (16:9): Forces the pixel aspect ratio to 16:9 using 720 x 480 pixels.
• PAL CCIR 601: Forces the pixel aspect ratio to 4:3 using 720 x 576 pixels.
• PAL CCIR 601 (16:9): Forces the pixel aspect ratio to 16:9 using 720 x 576 pixels.
• HD (960x720): Forces the pixel aspect ratio to 16:9 using 1280 x 720 pixels.
• HD (1280x1080): Forces the pixel aspect ratio to 16:9 using 1920 x 1080 pixels.
• HD (1440x1080): Forces the pixel aspect ratio to 16:9 using 1440 x 1080 pixels.
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Use the following settings to apply and adjust padding.
• Padding pop-up menu: Use this pop-up menu to choose one of the following options.
• Custom: Allows you to manually enter values in the Left, Right, Top, and Bottom
fields.
• Preserve source aspect ratio: Pads the image so that the original aspect ratio is
maintained.
• 4x3 1.33:1: Uses a 4 x 3 aspect ratio.
• 16x9 1.78:1: Uses a 16 x 9 aspect ratio.
• 4x3 1.33:1: Uses a 4 x 3 aspect ratio.
• Panavision 2.35:1: Uses a 2.35:1 aspect ratio.
• Europe Standard 1.66:1: Uses a 1.66:1 aspect ratio.
• UK Standard 1.75:1: Uses a 1.75:1 aspect ratio.
• Academy 1.85:1: Uses a 1.85:1 aspect ratio.
• Left, Right, Top, and Bottom fields: Use these fields to add pixels of image “padding”
around the sides of a frame. This is the opposite of cropping. In cases where the frame
size of the output media file differs from that of the source media file, you may wish
to pad an image rather than scale it.
Making Geometry Adjustments to a Setting
You use the Geometry pane in the Inspector window to crop, scale, and change the frame
aspect ratio in a setting.
To add cropping, frame sizing, and aspect ratio settings to your setting
1 Open the Settings tab.
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applied to a source media file in the Batch window.)
3 Click the Geometry tab in the Inspector.
4 Enter your source inset (cropping) settings, choose output size dimensions from the
Frame Size pop-up menu, and choose padding settings from the output image inset
section.
You can see all changes you make to your setting by viewing the Summary table in the
Summary pane.
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cropping fields or drag the red frame bars in the Preview window. Using the latter method,
the resulting numbers dynamically appear in the cropping fields so that you can see a
numerical representation of your frame cropping. Hold down the Shift key to constrain
the crop to either the source aspect ratio, the source height, or the source width.
Drag the red frame
bars (by the handles)
to adjust the output
file frame size.
If you select a batch’s target, 
any resizing in the Preview 
window is reflected in the 
Geometry pane. You can also 
directly enter numbers into 
these cropping fields.
See About the Geometry Pane or Previewing a Clip for more details.
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(and thereby also individual targets). Post-transcoding actions simplify and accelerate
your day-to-day workflow and make it easy to share your work with others. You can
quickly create and deliver output media files for the iPhone, iPad, iPod, Apple TV, DVD,
Blu-ray Disc, the web, and YouTube without having to open any additional applications.
You can also automatically send emails giving notice of when individual output media
files are completed. And you can trigger Automator workflows for individual jobs and
trigger AppleScript documents for individual targets.
This chapter covers the following:
• Working with Post-Transcoding Actions (p. 287)
• Adding Setting Actions (p. 287)
• Adding Job Actions (p. 289)
Working with Post-Transcoding Actions
Compressor supports both job actions and setting actions. Job actions apply to entire jobs.
Job actions are often associated with batch templates. (For more information about batch
templates, see Quick and Easy Compressor Workflow: Batch Template Method.) Setting
actions apply to individual settings (and thereby, also individual targets). You can save
settings that have setting actions applied as custom settings for future use.
Adding Setting Actions
Compressor can send an email to one recipient per applied preset setting, giving notice
of when a transcode is complete. You can also choose a default destination for this setting.
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You can use the Actions pane in the Inspector to set options related to transcode
completion notification emails and default destinations.
The Actions pane contains the following items.
• Email Notification to: If you want to be notified when a particular transcoding job has
been completed, select this checkbox and enter the appropriate email address in the
text field. (You can enter only one email address.) This is useful if you are transcoding
an especially large source media file that may take many hours to complete. Rather
than continuously checking to see if the transcoding is finished, you just wait until you
receive an email.
Note: To enable this email feature, you must first enter an email address and outgoing
mail server in Compressor preferences. (Choose Compressor > Preferences.)
• Default Destination pop-up menu: Use this pop-up menu to assign a destination to the
particular setting. (This is in contrast to setting a default destination for all settings in
Compressor preferences.) For information about setting a default destination for all
settings in Compressor preferences, see Setting Compressor Preferences.
How to Add Setting Actions
You use the Actions pane in the Inspector window to set post-transcoding options for
your output media file, such as sending an email.
To add an email notification to your setting
1 Select a custom setting in the Settings tab, or open a batch with a job that has a setting
applied to it.
Apple settings cannot be modified. You can copy an Apple setting and modify the copy,
however.
2 Click the Actions tab in the Inspector.
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accompanying field.
Note: To enable this email feature, you must first enter an email address and outgoing
mail server in Compressor preferences. (Choose Compressor > Preferences. You may need
to close and reopen Compressor for any email preference changes to function.)
4 Optionally, you can click Save or Save As to save this email configuration to this setting.
To choose a default destination for this setting
1 Select a custom setting in the Settings tab, or open a batch with a job that has a setting
applied to it.
Apple settings cannot be modified. You can copy an Apple setting and modify the copy,
however.
2 Click the Actions tab in the Inspector.
3 Choose a destination from the Default Destination pop-up menu.
The pop-up menu lists the Apple destinations and any custom destinations you have
created.
4 Optionally, you can click Save or Save As to save this default destination to this setting.
See About the Actions Pane for more details.
Adding Job Actions
You can use job actions to automate your transcoding workflow. For example, you can
automatically upload output media files to web streaming sites such as YouTube, burn
DVDs and Blu-ray discs, trigger Automator workflows, transfer output media files to iTunes,
open output media files in other applications, and create web reference movies. Job
actions are integral to the functioning of batch templates.
For more information about batch templates, see Quick and Easy Compressor Workflow:
Batch Template Method.
About the Job Actions Tab
You apply and adjust job actions with the Job Action tab in the Inspector window. To
use the Job Action tab, you must first select a job in the Batch window.
To open the Job Action tab
1 Add a source media file to the Batch window so that there is at least one job present in
the Batch window.
2 Select a job in the Batch window.
The Inspector window opens with the A/V Attributes tab selected. If the Inspector window
is not open, click the Inspector button or choose Window > Show Inspector to open it.
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The Job Action tab consists of a single “When job completes” pop-up menu. The list below
details the purpose of each option in this pop-up menu. For a detailed description of the
user interface for each option, see About Job Actions.
• “When job completes” pop-up menu: Use this pop-up menu to select and apply a
post-transcoding action for a job selected in the Batch window.
• Do Nothing: Choose this option to disable the Job Action tab.
• Add to iTunes Library: Compressor will add the output media file to an iTunes playlist.
• Create DVD: Compressor will create a standard definition DVD using MPEG-2 (.m2v)
video and Dolby Digital Professional (.ac3) audio and automatically burn it to a disc.
• Create Blu-ray Disc: Compressor will create and automatically burn a Blu-ray disc or
an AVCHD disc using video and audio that is compatible with Blu-ray.
• Create Web Reference Movie: Compressor will create a reference movie that enables
a web browser and a server to automatically select the right movie for any device or
connection speed, without requiring the viewer to make a choice.
• Open with Application: Compressor will open the output media file with a specific
application.
• Prepare for HTTP Live streaming: Compressor will create a set of video files suitable
for use on an HTTP live streaming server.
• Run Automator Workflow: This option opens a dialog for you to locate and select an
Automator script that Compressor will execute automatically on completion of the
transcoding job.
• Publish to YouTube: Compressor will create a video file suitable for viewing on YouTube
and upload it to a YouTube account.
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Facebook and upload it to a Facebook account.
• Publish to Vimeo: Compressor will create a video file suitable for viewing on Vimeo
and upload it to a Vimeo account.
• Publish to CNN iReport: Compressor will create a video file suitable for viewing on
CNN iReport and upload it to a CNN iReport account.
• Send Email: Compressor will send an email using the information you enter.
About Job Actions
This section describes the user interface for each job action.
Add to iTunes Library
Use this form to automatically add output media files to iTunes.
• Playlist pop-up menu: Use the Playlist pop-up menu to add the output media file to a
particular playlist in your iTunes library.
Note: The first time you use this feature, this pop-up menu will be empty. To populate
this menu with playlists from your iTunes library, choose Refresh from the Playlist
pop-up menu.
• Title: Enter the text you want to appear as the title of the file in your iTunes library.
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• Output Device pop-up menu: Use this pop-up menu to choose the device to format to.
The pop-up menu displays a list of your system’s suitable output devices, including
optical drives and the computer’s hard disk. Choose Hard Drive to create a disk image
(.img) file that you can burn to DVD media at a later time using the Disk Utility
application (available in the Utilities folder). Other settings may change depending on
the device you choose.
Important: If a progress indicator appears next to the output device you selected, wait
a moment for the list of available devices to update. This can happen when you eject
or insert a disc or when you turn an optical drive on or off.
• Eject button: Depending on your optical media drive type, click this button to eject
optical media from the drive or open the drive’s media tray.
• Layers pop-up menu: Use this pop-up menu to specify the type of disc you are making.
• Automatic: Use this to have the type of disc you insert to be automatically detected.
You must insert the disc before clicking Burn for Automatic to work. Additionally,
Automatic always creates a single-layer disk image when Hard Drive is selected as
the output device.
• Single-layer: Use this to identify the disc as a single-layer disc. You can use this to
force a dual-layer disc to be treated as a single-layer disc.
• Dual-layer: Use this to identify the disc as a dual-layer disc. You can use this to force
the disk image to be formatted for a dual-layer disc when you choose Hard Drive as
your output device. Selecting “Dual-layer” when using a single-layer disc may result
in an error while burning the disc, depending on the project’s length.
• Disc Template pop-up menu: Use this pop-up menu to choose a menu template for the
DVD.
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• When Disc Loads pop-up menu: Use this pop-up menu to choose what happens when
the disc loads in the player.
• Show Menu: Choose this option to show the menu.
• Play Movie: Choose this option to play the movie.
• Use Chapter Marker Text as Subtitles checkbox: Select this checkbox to have marker text
appear as subtitles. This is particularly useful for creating DVD dailies. This allows you
to line up a series of clips or scenes and identify each item with a marker text-subtitle.
• Background pop-up menu: Opens a dialog for you to locate and select a still image to
use as the menu’s background.
• Main Menu and Chapter Menu preview: Use the Main Menu and Chapter Menu buttons
to display previews of the menus included with the selected template.
Create Blu-ray Disc
Use this form to enter information and settings for the Blu-ray disc you want to burn.
Additionally, you can burn an AVCHD disc based on settings in this form.
An AVCHD disc can be thought of as a simpler HD disc that is burned to red laser media.
The resulting disc plays in Blu-ray Disc players that are compatible with the AVCHD format.
This means that you can burn a disc that contains HD video content and some basic
menu features using a standard DVD burner and play that disc in compatible Blu-ray Disc
players. See About the H.264 for Blu-ray Disc Encoder Pane for information on creating
H.264 streams suitable for Blu-ray discs and AVCHD discs.
Important: You cannot play any disc containing Blu-ray content on a Mac computer.
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Device pop-up menu. The setting descriptions below identify which items do not apply
to AVCHD discs.
• Output Device pop-up menu: Use this pop-up menu to choose the device to format to.
The pop-up menu displays a list of your system’s suitable output devices, including
optical drives and the computer’s hard disk. Each device also includes the words Blu-ray
or AVCHD to indicate which type of disc it creates. Choose Hard Drive to create a disk
image (.img) file that you can burn to Blu-ray disc media at a later time using the Disk
Utility application (available in the Utilities folder). Other settings may change depending
on the device you choose.
Important: If a progress indicator appears next to the output device you selected, wait
a moment for the list of available devices to update. This can happen when you eject
or insert a disc or when you turn an optical drive on or off.
Note: If you choose a standard DVD burner, the disc is formatted as an AVCHD disc.
All other devices format the disc as a Blu-ray disc.
• Eject button: Depending on your optical media drive type, click this button to eject
optical media from the drive or open the drive’s media tray.
• Layers pop-up menu: Use this pop-up menu to specify the type of disc you are making.
• Automatic: Use this to have the type of disc you insert to be automatically detected.
You must insert the disc before clicking Burn for Automatic to work. Additionally,
Automatic always creates a single-layer disk image when Hard Drive is selected as
the output device.
• Single-layer: Use this to identify the disc as a single-layer disc. You can use this to
force a dual-layer disc to be treated as a single-layer disc.
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the disk image to be formatted for a dual-layer disc when you choose Hard Drive as
your output device. Selecting “Dual-layer” when using a single-layer disc may result
in an error while burning the disc, depending on the project’s length.
• Disc Template pop-up menu: Use this pop-up menu to choose a menu template for the
Blu-ray disc.
• Title field: Use this field to enter a name for the program on the Blu-ray disc.
• When Disc Loads pop-up menu: Use this pop-up menu to choose what happens when
the disc loads in the player.
• Show Menu: Choose this option to show the menu.
• Play Movie: Choose this option to play the movie.
• Use Chapter Marker Text as Subtitles checkbox: Select this checkbox to have marker text
appear as subtitles. This is particularly useful for creating Blu-ray disc dailies. This allows
you to line up a series of clips or scenes and identify each item with a marker
text-subtitle.
Note: Subtitles are not supported on AVCHD discs.
• Include Loop Movie Button checkbox: Select this checkbox to add a Loop Movie button
to the menu. This option is not available on all disc templates.
• Background button: Opens a dialog for you to locate and select a background graphic.
• Logo Graphic button: Opens a dialog for you to locate and select a logo graphic.
• Title Graphic button: Opens a dialog for you to locate and select a title graphic.
• Main Menu and Chapter Menu preview: Use the Main Menu and Chapter Menu buttons
to display previews of the menus included with the selected template.
Note: Blu-ray and AVCHD menus are best suited for display at 1080i or 1080p
resolutions. Users should ensure that their player and display are set accordingly.
Chapter 25 Adding Actions 295Create Web Reference Movie
Use this form to create a reference movie that enables a web browser and a server to
automatically select the right movie for any device or connection speed, without requiring
the viewer to make a choice.
• Web reference movie destination field and button: Use this field and the associated Choose
button to define a destination folder for the output web reference movie. Click the
button to open a dialog for locating and selecting the folder.
• Create Read Me file with sample HTML checkbox: Use this checkbox to control whether
Compressor creates a text document containing complete instructions and sample
HTML for embedding the web reference movie in a web site.
• Create Poster Image checkbox: Use this checkbox to control whether Compressor creates
a thumbnail image for embedding the web reference movie in a web site.
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Use this form to specify an application to open the output media file.
• Open With pop-up menu: Use this menu to either confirm or select the application that
will open the output media file.
Prepare for HTTP Live streaming
Use this form to create a set of files you can use to stream audio and video to iPad, iPhone,
iPod touch, and Mac, using an ordinary web server. Designed for mobility, HTTP live
streaming can dynamically adjust movie playback quality to match the available speed
of wired or wireless networks. HTTP live streaming is great for delivering streaming media
to your iOS-based application or HTML5-based website. For detailed information on
implementing HTTP live streaming, see the Apple Developer HTTP live streaming website.
• Choose button: Click Choose to open a dialog for locating a destination for the HTTP
live streaming assets.
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for the media. This value defines how the video streams are split into chunks. This
segmentation defines when the web server can switch between the various video
formats while streaming to a device with varying network connection speeds. A smaller
value allows the server to respond more quickly to changing connection speeds.
• Create Read Me file with sample HTML checkbox: Select this to include a file with basic
HTTP live streaming usage information.
Run Automator Workflow
Use this form to choose an Automator script to run.
• Choose Automator Workflow: Click Choose to open a dialog for locating and selecting
an Automator script that Compressor will execute automatically on completion of the
transcoding job.
Publish to YouTube
Use this form to enter information about movies you want to publish to a YouTube
account on the web.
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for each output media file.
Important: You must complete all fields for successful uploading.
• Username: Use this field to enter a YouTube username.
• Password: Use this field to enter a YouTube password.
• Title: Use this field to enter the name of the movie you are publishing.
• Description: Use this field to enter a description of the movie you are publishing.
• Tags: Use this field to enter keywords that describe your movie. These are search terms
that your intended audience might use to find your movie on YouTube. For more
information, see YouTube help.
• Category pop-up menu: Use this pop-up menu to select a YouTube category for your
movie. On YouTube, a movie can belong to one of several categories (topic areas).
• Make this movie private checkbox: Select this checkbox to control viewing access to the
movie you are publishing. When you make a video private on YouTube, you have the
option of sharing it with a select number of people from any of the contact lists you
create for your account. See YouTube help for more information.
Publish to Facebook
Use this form to enter information about movies you want to publish to a Facebook
account on the web.
Chapter 25 Adding Actions 299Note: To upload multiple Facebook output media files in one batch, create a separate
job for each output media file.
Important: You must complete all fields for successful uploading.
• Email: Use this field to enter the email address for a Facebook account.
• Password: Use this field to enter a Facebook password.
• Title: Use this field to enter the name of the movie you are publishing.
• Description: Use this field to enter a description of the movie you are publishing.
• Privacy pop-up menu: Use this pop-up menu to choose who can view the movie. The
choices are Only Me, Friends, Friends of Friends, and Public.
Publish to Vimeo
Use this form to enter information about movies you want to publish to a Vimeo account
on the web.
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for each output media file.
Important: You must complete all fields for successful uploading.
• Email: Use this field to enter the email address for a Vimeo account.
• Password: Use this field to enter a Vimeo password.
• Title: Use this field to enter the name of the movie you are publishing.
• Description: Use this field to enter a description of the movie you are publishing.
• Tags: Use this field to enter keywords that describe your movie. These are search terms
that your intended audience might use to find your movie on Vimeo. For more
information, see Vimeo help.
• Viewable by pop-up menu: Use this pop-up menu to choose who can view the movie.
The choices are Anyone, My contacts, and Nobody else.
Publish to CNN iReport
Use this form to enter information about movies you want to publish to a CNN iReport
account on the web.
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job for each output media file.
Important: You must complete all fields for successful uploading.
• Email: Use this field to enter the email address for a CNN iReport account.
• Password: Use this field to enter a CNN iReport password.
• Subject: Use this field to enter the name of the movie you are publishing.
• Body: Use this field to enter a description of the movie you are publishing.
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Use this form to enter information for an email that is composed when the job completes.
This email contains the actual output file and opens in Mail so that you can further edit
the email’s contents and other settings. Once you are done editing the email, you can
click Send.
• Send To: Enter the email address to where you want the email to be sent. You can enter
multiple email addresses, separated by a comma.
• Send From: Enter the email address you want the email to be sent from.
• Subject: Use this field to enter the email’s subject.
• Body: Use this field to enter the email’s text.
Chapter 25 Adding Actions 303The Preview window has two main roles. You can use it to play your source media file in
its original format, or you can preview your source media file with whichever settings
have been assigned to it.
This chapter covers the following:
• About the Preview Window (p. 305)
• Previewing a Clip (p. 311)
• Transcoding a Portion of the Clip with the Preview Window (p. 316)
• Working with Markers and Poster Frames (p. 317)
• About the Preview Window Keyboard Shortcuts (p. 324)
About the Preview Window
When you use the Preview window to compare the original version of the clip with the
version that will be output, you can make and view real-time changes. This comparison
lets you check the effects of settings on your file before spending time and resources
transcoding it. Do this to check the quality of the output media file.
Scaled, cropped, and 
filtered version of the clip
Original version 
of the clip
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26You can also use the Preview window to enlarge the Preview screen size, manually add
I-frames (MPEG-1 and MPEG-2 only), and designate a portion of your media file for
transcoding using the In and Out markers.
The Preview window allows you to play batch items before submitting them for
transcoding and allows you to compare versions of your clip to ensure that the quality
of the output media file is acceptable.
In and Out controls
Preview scale selection
Source/Setting selection
Preview screen area
Batch Item selection 
controls
Timeline controls
Marker pop-up menu
Source/Output 
information
Transport controls
The Preview window contains the following items.
• Preview scale selection: Adjusts the Preview screen size. The three settings are 100%,
75%, and 50%, but you can also drag the Preview window handle to any size you like.
• Source/Setting selection: Use these buttons to preview the selected batch item using
either the source’s aspect and size or the setting’s aspect and size. The Source View
button also provides a cropping boundary that you can use to define one or more
edges to be cropped. The Setting View button shows the cropped version of the media
scaled to its aspect and size setting.
• Source/Output information: The clip’s frame size and frame rate are shown in the
lower-left corner of the Preview window. The clip’s duration (from the In point to the
Out point) is shown in the lower-right corner. With the Source View button selected,
the frame size and frame rate represent the source media clip. With the Output View
button selected, the frame size and frame rate represent the setting for this batch item.
Note: To see the total duration of the clip (without In and Out points), select the source
file in the Batch window and open the Inspector window (choose Window > Show
Inspector).
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You can use the batch item selection area to choose specific items from the Batch window
to show in the Preview window.
Batch Item selection 
buttons
Batch Item pop-up menu
• Batch Item selection buttons: Use these buttons to click backward or forward through
the list of source media files and clips with settings available for previewing. As you
click through the list, the selected batch item appears in the Batch Item pop-up menu.
• Batch Item pop-up menu: Choose the source media file you want to preview from this
pop-up menu, with or without its assigned settings.
In and Out Controls
Once you have selected the batch item, the In and Out controls can be used to see and
adjust the In and Out point timecode information.
Sets In point to current 
playhead position.
Sets Out point to current 
playhead position.
In point timecode Out point timecode
• In and Out timecode fields: The exact locations of the In and Out points are displayed
here using the standard timecode format of hh:mm:ss:ff. You can manually edit these
fields by selecting the field and entering new values. If a new value is entered, the
timeline’s relevant In or Out point moves to the specified point in the current batch
item.
Note: If your source media file has a timecode track with a specific timecode, the Start
and End timecode of the clip will appear in both the In and Out timecode fields. For
everything else, the timecode will start with 00:00:00:00.
• In and Out Point buttons: Drag the In point (right-pointing arrow) or Out point
(left-pointing arrow) buttons in the timeline to set a new In or Out point. You can also
use the Set In and Set Out buttons (next to the timecode fields) to set In and Out points.
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The Preview screen area displays the currently selected batch item.
Cropping boundary
Cropping handle for 
the lower-right corner
Split screen slider
Cropping dimensions 
(also seen in Source 
Inset fields in the 
Geometry pane)
The Preview screen also contains the following items.
• Split screen slider: Drag the split screen slider any distance across the top of the Preview
screen to get a comparison view between the source media file (left side) and output
media file (right side). In addition to the location of the slider at the top, the screen
division is indicated by a vertical white line bisecting the image.
• Cropping boundary: The cropping boundary is only available in Source view. Use the
handles to drag the red boundary edges and corners in the direction you want to crop
your output media file. Use the center handle to drag the entire frame in any direction
while still maintaining its dimensions. The new values (for left, top, right, and bottom)
appear dynamically in the Preview screen as you crop the frame. If you also have the
Inspector window open with the batch’s target selected, you can see the same values
changing in the cropping fields of the Geometry pane. Select the Output view to show
the results of the crop boundary settings.
Timeline Controls
The timeline controls provide information about the clip, including any markers it has
and the current In and Out point settings. You can also use the timeline to position the
playhead to a specific frame and set the In and Out points.
Playhead timecode 
Playhead
Marker
In point Out point
• Playhead timecode: Shows the timecode of the playhead’s position in the timeline using
the standard timecode format of hh:mm:ss:ff. You can enter a new value to precisely
position the playhead along the timeline.
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timecode of the clip will appear in the playback timecode field. For everything else,
the timecode will start with 00:00:00:00.
• In and Out points: Use these if you want to transcode only a section of your source
media file, rather than the whole thing. Drag the points to indicate the Start and End
points within the source media file that you want to transcode. The In and Out timecode
fields at the bottom of the Preview window update as you drag these points. (You can
also click the Set In Point or Set Out Point buttons to set the points to wherever the
playhead is currently positioned.)
Important: In and Out points are not preserved after a transcode has been completed,
so if you want to resubmit a batch from the History table, you need to reapply these
points to your clip. In and Out points are assigned to the source media file rather than
the setting, so whatever In and Out points you create will be the same for all other
settings related to that source media file in the current batch.
• Playhead: Gives you a visual indication of where the displayed frame is located within
the clip. You can drag the playhead to navigate quickly to a specific location within
the clip.
• Marker: Gives you a visual indication of where a marker has been placed in the clip.
The color of the marker indicates its type:
• Blue: Compression markers (These are compression markers that you add manually.)
• Purple: Chapter markers (These are named markers that are intended to be
navigational chapter stops or visual artwork in the output media file.)
• Red: Podcast markers (These are named markers that are intended to be navigational
chapter stops or visual artwork in the output media file.)
• Green: Edit/cut markers (These are compression markers that are added automatically
at edit points in the Final Cut Pro sequence.)
• Gray bar with center dot: Poster frame (This bar indicates the frame chosen as the
poster frame for this file.)
See Working with Markers and Poster Frames for more information.
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These move the playhead backward or forward to the exact position of the next marker
or In and Out point, making it easy to navigate quickly between existing markers. You
can also use these buttons to quickly move the playhead to the start or end of the clip.
Move to previous marker
Play/Pause
Fast Backward
Move to next marker
Fast Forward
Playback Loop button
• Play/Pause button: Starts or stops playback of the clip. If you stop playback, the playhead
remains at its current position. To return to the start of the clip, you need to drag the
playhead back to the beginning or click the “move to previous marker” control.
• Move to previous marker and Move to next marker buttons: Moves the playhead to the
previous or next marker, the In or Out points, or to the start or end of the clip if no
more markers are present.
• Fast Backward and Fast Forward buttons: Allow you to play your clip in either direction
at twice the normal speed. If clicked while playing, clicking one of these buttons a
second time returns playback to normal speed.
• Playback Loop button: Click to play the media in a continuous loop.
Marker Pop-Up Menu
Use the Marker pop-up menu to manage the clip’s markers. While you can use markers
with all settings, they actually affect only the output file when the setting uses the MPEG-1,
MPEG-2, MPEG-4 when configured for podcasting, H.264 for Apple Devices, or QuickTime
Movie output file format. See Working with Markers and Poster Frames for more
information.
Choose items from the Marker pop-up menu to add, remove, show, hide, and edit markers
and poster frames.
• Import Chapter List: Opens a file import dialog that allows you to import a file containing
a list of chapter marker times for the source media file. See Adding Compression or
Podcast Markers to a Clip for more information.
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on a marker.
• When the playhead is not positioned on a marker: Choosing “Add marker” places a
new marker on the timeline at the playhead’s current position.
• When the playhead is positioned on a marker: Choosing “Remove marker” deletes the
current marker.
• Edit: Available only when the playhead is positioned on a marker. Choosing Edit opens
a dialog for configuring the marker. The dialog allows you to set the marker type and
assign a URL and an image to it. See Adding Compression or Podcast Markers to a Clip
for more information.
• Show Chapter/Podcast Markers: Controls whether chapter and podcast markers (those
with names) are shown in the timeline. A checkmark indicates they are shown.
• Show Compression Markers: Controls whether compression markers (those without
names) are shown in the timeline. A checkmark indicates they are shown.
• Show Edit/Cut Markers: Controls whether markers automatically placed at each edit
point by another application, such as Final Cut Pro, are shown in the timeline. A
checkmark indicates they are shown.
• Set poster frame: Choose this item to make the current frame the poster frame. A poster
frame is a still image that represents a video or audio media file or a podcast chapter
in applications such as iTunes and the Finder. By default, the first frame in a video file
is the poster frame.
• Clear poster frame: Deletes the poster frame marker.
• Go to poster frame: Moves the playhead to the poster frame.
Previewing a Clip
You can preview either the original source media file or the file with a setting applied to
it. Source media files appear in the list as their filenames. Any settings that have been
applied to the source media file are listed immediately below the file’s name and are
indented to make it easier to identify them. Whether you choose to view the original
source media file or the source media file with a setting determines which options you
see in the Preview window.
Important: Settings you make in the Encoder pane and the Frame Controls pane cannot
be previewed. Only the settings made in the Filters pane and Geometry pane can be
previewed. See Transcoding a Portion of the Clip with the Preview Window for an
alternative method of previewing Encoder pane and Frame Controls pane settings.
To preview a source media file
1 Open the Preview window.
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the source media file in its job in the Batch window.
2 Do one of the following:
• Choose a source media file from the Batch Item pop-up menu (identified by its filename).
A setting applied to the
source media file “Nancy
at table CU 5.” The
checkmark indicates
that this is currently
being viewed in the
Preview window.
The original source
media file “Nancy
at table CU 5.”
Selects the default
color bars image.
• Click the Batch Item selection buttons until the source media file appears in the pop-up
menu.
• Select the source media file in its job in the Batch window.
Only the Source View button is active (and the Output View button is dimmed). This
is because you selected a regular source media file, so you can only see the
unadulterated clip—without the split screen divider or cropping bars.
3 Choose a Preview screen size from the Preview Scale pop-up menu, or drag the Preview
window handle to a size you like.
This does not affect the display frame size of the actual output media file. That can only
be set from the Geometry pane in the Inspector window.
4 Click the Play button to preview the selected source media file.
Source media files with markers already added, such as files from Final Cut Pro, will show
the markers in the timeline. You can manage the markers if needed. See Working with
Markers and Poster Frames for more information.
To preview a clip with an assigned setting
1 Open the Preview window.
Note: You can open the clip into the Preview window in one step, by double-clicking the
target (that contains the setting) of a job in Batch window.
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• Choose a setting from the Batch Item pop-up menu (the indented setting names, not
the source filenames).
• Click the Batch Item selection buttons until the clip with a setting appears in the pop-up
menu.
• Select the clip’s setting in its job in the Batch window.
Both Source and Setting (Output) View buttons are active so you can switch between
these two views. Because you selected a setting, you can use the split screen slider and
cropping boundary in the Preview window.
3 Click the Setting view button in the upper-right corner of the Preview window.
4 Choose a Preview screen size from the Preview Scale pop-up menu, or drag the Preview
window handle to a size you like.
This does not affect the display frame size of the actual output media file. That can only
be set from the Geometry pane in the Inspector window.
Note: When you adjust the frame size of a setting (in the Geometry pane) while you are
viewing it in the Preview window, the frame size may not resize accordingly. If this occurs,
select Sample Movie or a different target from the Batch Item pop-up menu and then
select this target again. It will display the correct frame size.
5 Drag the split screen slider left or right across the top of the screen to move the split
screen divider over more or less of the transcoded portion of the clip.
6 Use the cropping boundary to adjust the display frame size of your output media file.
Cropping boundary 
and handles
Split screen slider
Split screen divider
Cropping dimensions 
(also seen in Source 
Inset fields in the 
Geometry pane)
Source and Setting 
View buttons
Batch Item 
pop-up menu
7 Check the results of your cropping by clicking the Source and Setting View buttons.
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the output image will be (as the framing geometry conforms to the settings of the output
size ratio rather than to the source file settings). This effect is similar to zooming in on an
image, which results in larger pixels and overall image degradation. So make sure that
you don’t crop in so far that the image is enlarged past its original size relative to the
original size of the frame.
Source and Setting
View buttons
8 Select the filter that you want to adjust and make changes as necessary.
Note: The filter you select must have a checkmark next to it in the Filters list. Otherwise,
the filter won’t be applied to the setting.
Selected filter settings 
are displayed in the 
Preview window.
Setting selection
314 Chapter 26 Using the Preview Window9 If you want to make the display frame size of your output media file different from that
of your source media file, open the Geometry pane in the Inspector window and choose
a preexisting value from the Frame Size pop-up menu or enter different output size values
in the relevant fields.
Note: MPEG-2 is limited to preestablished display frame sizes based on MPEG-2
specifications. In this instance, all output size items are unavailable.
Cropping dimensions 
(also displayed in the 
Inspector window when 
you drag cropping bars)
10 Click the Play button in the Preview window to view the clip.
See About the Preview Window for more information about these settings.
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You can use the Preview window to play back Dolby Digital Professional (AC-3) files.
Compressor includes a Dolby Digital decoder so that when you add an AC-3 source
media file to a batch and play it, you are able to hear it using your computer’s current
speakers. This includes everything from the built-in stereo speakers, which play a
mixed-down version of the AC-3 file if it contains more than two channels, to a set of
external surround speakers connected to a USB or FireWire output.
Important: Since Compressor is decoding the Dolby Digital audio file, you cannot use
your computer’s optical output to preview Dolby Digital audio.
This feature is important if you are using the Dolby Digital Professional encoder since
you cannot preview the encoder’s settings in real time in the Preview window. Instead,
you can add the encoded AC-3 files to a batch and play them to verify that the encoder’s
settings produced good results. See Transcoding a Portion of the Clip with the Preview
Window for information on creating a short test clip for this purpose.
Transcoding a Portion of the Clip with the Preview Window
Although Geometry (cropping and scaling) and Filters adjustments are displayed instantly
in the Preview window, Encoding pane and Frame Controls pane settings are not. To
preview Encoder pane and Frame Controls pane settings, do a test transcode of a small
section of your source media file.
You can use the Preview window to set In and Out points to transcode only a portion of
your media file rather than transcoding the whole thing.
To designate a portion of your media file for transcoding
1 Open the Preview window.
2 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection buttons
until the clip appears in the pop-up menu.
3 Do one of the following:
• Drag the In point to the appropriate location.
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button.
Playhead 
Out point
In point
Set In Point button Set Out Point button 4 Do one of the following:
• Drag the Out point to the appropriate location.
• Drag the playhead to where you want transcoding to end and click the Set Out Point
button.
The only segment of the media file that will be transcoded is between the two points
that you set. The rest of the clip will not be transcoded.
Important: When you use the In and Out points to specify a segment of the source media
file to transcode, they apply to all targets assigned to the file’s job. You can add a source
media file multiple times to a batch, creating multiple jobs, and set the In and Out points
differently in each job.
Working with Markers and Poster Frames
Compressor can import and create several different kinds of markers. In addition,
Compressor can import entire lists of chapter markers. Compressor also supports setting
a poster frame for a clip.
Output File Formats That Support Markers
Not all output file formats support markers. Following is a list of those that do support
them.
• MPEG-2
• MPEG-4 when configured for podcasting (audio-only with the Enhanced Podcast
checkbox selected)
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• H.264 for Apple Devices
You can set and configure markers for other output file formats, but they will not be
included in the encoded output file.
Types of Markers
Compressor can import and create the following types of markers.
• Chapter markers: Chapter markers allow easy access to index points throughout a DVD,
QuickTime movie, or video podcast. QuickTime Player can interpret any text track
containing time stamps as a chapter track. Chapter markers can also have artwork and
a URL assigned to them that appear when playing a podcast.
These markers appear as purple in the Preview window timeline and are the type
created when you manually add markers using Compressor.
• Podcast markers: Like chapter markers, podcast markers can have artwork and a URL
assigned to them. Podcast markers cannot be used to access frames within the clip,
though, and they do not appear as chapter markers in QuickTime.
You can use podcast markers to provide a slideshow (with URLs) for users to view when
playing audio podcasts.
These markers appear as red in the Preview window timeline.
• Compression markers: Compression markers are also known as manual compression
markers. These are markers you can add in the Compressor Preview window to indicate
when Compressor should generate an MPEG I-frame during compression. See
Understanding GOPs and Frame Types for more information on I-frames.
These markers appear as blue in the Preview window timeline.
• Edit/Cut markers: Edit/Cut markers are also known as automatic compression markers.
These markers are intended to be at each cut or transition point in a sequence. During
transcoding, Compressor uses Edit/Cut markers to generate MPEG I-frames at these
points, improving compression quality.
These markers appear as green in the Preview window timeline.
Manually Adding and Removing Markers
The Preview window includes comprehensive marker support, including the ability to
manage markers already added to the source media file, manually add or remove markers,
and import chapter marker lists. When you add a marker to a clip, it appears as a chapter
marker by default. You can then change the marker to a compression or podcast marker
if you wish (see Adding Compression or Podcast Markers to a Clip).
To add a chapter marker to your clip
1 Open the Preview window.
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there is a checkmark by it.
3 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection button
until the clip you want appears in the pop-up menu.
4 Do one of the following to determine where the marker is to be placed:
• Drag the playhead where you want to add a marker.
• Enter a timecode value in the playhead timecode field.
5 Do one of the following to add a marker:
• Click the Marker button and choose “Add marker” from the pop-up menu.
• Press M.
A purple chapter marker appears in the timeline.
A purple marker appears 
under the playhead after 
the marker is added.
6 Choose Edit from the Marker pop-up menu (or press Command-E).
A dialog for editing the marker appears.
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For chapter markers, this name appears in the output media file where it can be seen
with QuickTime Player and in playback devices.
8 If you want to assign an image to the chapter marker, choose one of the following from
the Image pop-up menu:
• None: No image is associated with the marker.
• Frame in source: By default, the frame displayed is the frame on which the marker is
placed. To use a different frame as the image, enter a different timecode value.
• From File: Drag an image to the image well. You can also click Choose to open a
file-selection dialog and select a still-image file to assign to the marker.
9 Click OK to close the dialog.
You can convert a chapter marker to a compression or podcast marker by choosing Edit
from the Marker pop-up menu.
To remove a marker from your clip
1 Click either the “Move to Previous Marker” or “Move to Next Marker” control to move the
playhead to the marker you want to remove.
2 Do one of the following to remove the marker:
• Click the Marker button and choose “Remove marker” from the pop-up menu.
• Press M.
The marker disappears.
To import a chapter marker list
1 Open the Preview window.
2 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection button
until the clip you want appears in the pop-up menu.
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A file selection dialog opens so that you can locate and select the chapter marker file for
that source media file.
4 Select the chapter marker file and click Open.
The markers are imported and added to the Preview window timeline.
Note: While all markers imported by using a chapter marker list are configured as chapter
markers, you can use the marker edit dialog to change them to podcast or compression
markers. Additionally, you can add URLs and artwork to them as needed.
Important: The timecode values in the list must be based on the source media file’s
timecode.
Adding Compression or Podcast Markers to a Clip
To manually add a compression or podcast marker to a clip, you first add a chapter marker
(as described in the previous section) and then you edit the marker.
Note: A podcast can have both chapter and podcast markers. The only difference is that
the viewer can navigate directly to a chapter marker but cannot navigate to a podcast
marker. For more information, see Types of Markers.
To manually add a compression or podcast marker to a clip
1 Choose the Show Chapter/Podcast Markers and Show Compression Markers items from
the Marker pop-up menu, so that there is a checkmark by them.
2 Do one of the following to determine where the marker is to be placed:
• Drag the playhead where you want to add a marker.
• Enter a timecode value in the playhead timecode field.
3 Do one of the following to add a marker:
• Click the Marker button and choose “Add marker” from the pop-up menu.
• Press M.
A purple chapter marker appears in the timeline.
4 Choose Edit from the Marker pop-up menu (or press Command-E).
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5 Choose Compression or Podcast from the Type pop-up menu.
6 Enter a name for the marker in the Name field.
For podcast markers, this name does not appear to the viewer.
7 Optionally, enter a URL in the URL field.
This URL applies only to podcasts. The marker’s name appears over the artwork where
the viewer can click it to open a web browser to the URL’s website.
8 If you want to assign an image to the chapter marker, choose one of the following from
the Image pop-up menu:
• None: No image is associated with the marker.
• Frame in source: By default, the frame displayed is the frame on which the marker is
placed. To use a different frame as the image, enter a different timecode value.
• From File: Drag an image to the image well. You can also click Choose to open a
file-selection dialog and select a still-image file to assign to the marker.
9 Click OK to close the dialog.
The marker in the timeline changes to blue if it’s a compression marker, or red if it’s a
podcast marker. You can use the Previous Marker and Next Marker buttons to select other
markers in the timeline to edit.
You also have the option of importing a chapter marker list. These lists can use either the
QuickTime TeXML format (an XML-based format for constructing 3GPP-compliant timed
text tracks in a QuickTime movie file) or a plain text chapter list file. See Creating Plain
Text Chapter Marker Lists for information.
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You can create a list of timecode points that Compressor can import to create markers.
The timecode values need to match the timecode of the track’s video clip. The list of
timecode values must be a plain text file; you can create it with TextEdit (as long as you
save the file as plain text). If you create the list with a more advanced word-processing
application, be sure to save the file as a plain ASCII text file with no formatting.
The file must follow these rules.
• Each marker must be on a new line that starts with a timecode value in the 00:00:00:00
format. These values identify the marker positions.
• After the timecode value, you can include a name for the marker. You can use a comma,
space, or tab character to separate the timecode value from the marker name.
• Any lines that do not begin with a timecode value are ignored. This makes it easy for
you to add comments to the list.
• The timecode values do not have to be listed in chronological order.
Setting the Poster Frame
You can use Compressor to set the poster frame for a movie. This is the frame that appears
in iTunes to represent the movie. If you do not set the poster frame, iTunes uses the frame
ten seconds from the movie’s first frame.
To set the poster frame
1 Position the Preview window’s timeline to the frame you want to be the poster frame.
2 Choose “Set poster frame” from the Marker pop-up menu.
A vertical line with a center dot appears in the timeline.
To move the playhead to the poster frame
µ Choose “Go to poster frame” from the Marker pop-up menu.
Note: This setting is not available if the poster frame has not been set.
To remove the poster frame setting
µ Choose “Clear poster frame” from the Marker pop-up menu.
Note: This setting is not available if the poster frame has not been set.
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For a complete list of Preview window keyboard shortcuts, see Preview Window
Keyboard Shortcuts in the Keyboard Shortcuts chapter.
324 Chapter 26 Using the Preview WindowCompressor allows you to choose where to save your transcoded files.
Without a selected destination, the output file is saved to the same folder as the source
media file. This may be satisfactory for your needs, but if there are various remote
uploading servers, or if you just want a specific type of output file to end up in a specific
location, you must assign that destination.
If you have a volume open on your desktop, it is treated the same as a local destination
and allows you to save output media files directly, without the extra steps needed for
remote destinations, such as specifying the host name and entering the user name and
password. When you use the remote option for your destination, you can save to any
folder under the User directory of that remote computer.
Once you have created all your necessary destinations, you won’t have to open the
Destinations tab again because you can select all destinations directly from the Batch
window once they have been created. Additionally, when creating custom settings, you
can assign a default destination that’s automatically used. For details, see Adding Setting
Actions.
This chapter covers the following:
• About the Destinations Tab (p. 326)
• Using the Inspector with Destinations (p. 327)
• Creating a Destination (p. 327)
• Warning Triangles (p. 329)
• Deleting and Duplicating a Destination (p. 330)
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Destinations 27About the Destinations Tab
You use the Destinations tab together with the Inspector window to create, modify, or
remove your destination settings and add file identifiers to your output media filename.
Custom destinations
Default 
destinations
Duplicate 
button Add and Remove buttons
Default filename 
identifiers
Filename Template 
pop-up menu
Sample filename line
The Destinations tab contains the following items.
• Destinations list: This lists destination names and pathnames.
There are four default destinations in the Apple folder: Cluster Storage is a cluster’s
scratch storage location; Desktop is the user’s Desktop folder; Source is the same folder
from which the source media file originated; and User's Movies Folder is the Movies
folder in the user's home folder.
Note: Cluster Storage applies only to installations of Compressor that have distributed
processing enabled.
• Add (+): To create a destination, click this button. A file selection dialog appears in
which you can select a destination folder.
• Duplicate button: Makes a copy of the selected destination, placing it in the Custom
folder. Using this option allows you to create a new destination from a preexisting
destination, which you can then adjust according to your needs, rather than creating
a new destination from scratch.
• Delete (–): Removes a selected custom destination from the Destinations tab
immediately. You are not asked for confirmation, so be sure you want to remove the
destination before clicking this button.
Note: You cannot remove the destinations from the Apple folder.
326 Chapter 27 Creating and Changing DestinationsUsing the Inspector with Destinations
When you double-click or select a destination in the Destinations tab, the Inspector
window opens. It contains the following items:
• Name: Use this field to modify the name of the destination preset.
• Output Filename Template: Use this pop-up menu to add file identifiers to your output
media file. You can manually edit this field. Selecting any of the following file identifiers
adds it to your output media filename.
• Date: Date the file was transcoded in the YYYY-MM-DD format
• Setting Name: Name of the setting used for the transcoding job
• Source Media Name: Source media filename without its extension
• Source Media Extension: Extension of the source media file
• Sample From Defined Template: Displays a sample of what the output filename will
look like with any file identifiers you have added. You cannot edit the Sample line,
but it changes dynamically based on the file identifiers you add or delete.
• Path: Displays the path to the destination folder.
Creating a Destination
You use the Destinations tab with the Inspector window to create and assign a destination
and to add file identifiers to your output file.
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• Local: Any directory on your own computer
• Open Volume: Any shared volume open on your desktop
Note: By default, the output media file destination is the same folder from which the
source media files originated. You can change the default destination to any other
Destination preset. Choose Compressor > Preferences and use the Default Destination
pop-menu to choose from the list of Destination presets.
To create a destination
1 Open the Destinations tab.
2 Click the Add (+) button.
The Destination Selection dialog appears.
3 Navigate to your chosen destination folder or open mounted volume, then click Open.
A new destination with the folder’s name appears in the Custom folder of the Destinations
tab along with the path to the folder you just assigned.
4 Double-click the new destination in the Destinations tab.
The Inspector window opens, showing relevant information for the new destination.
5 Do either of the following in the Inspector:
• Modify the name of the new destination in the Name field.
• Modify the pathname of the new destination by clicking Choose to open the destination
selection dialog and navigating to a new folder.
6 Add file identifiers to your output filename using the pop-up menu in the Output Filename
Template field.
Filename Template 
pop-up menu
You can also manually edit this field by doing any of the following:
• Drag the file identifiers to rearrange their order.
• Click on either side of the file identifiers to type additional text.
• Use the Delete key on your keyboard to remove any of the file identifiers.
328 Chapter 27 Creating and Changing DestinationsThe Sample From Defined Template field in the Inspector window shows a sample of the
output filename with its chosen file identifiers. The default file identifier combination is
Source Media Name-Setting Name.
Note: Avoid customizing your filename templates with anything beginning with a period
(.). The resulting file will only be visible via the command line and not visible using the
Mac OS X Finder.
See About the Destinations Tab for more details about these settings.
To change the default destination
1 Choose Compressor > Preferences.
2 Use the Default Destination pop-up menu to choose from the list of existing destination
presets.
The destination you choose appears as the default destination when you import a new
source file in the Batch window.
Warning Triangles
When there is a problem with your destination, a yellow warning triangle appears. You
must resolve this problem before you can successfully transcode. Warning triangles appear
in the Destinations tab if the destination isn’t reachable or writable, and in the Batch
window if:
• There is already an identical file at that destination.
• You have two destinations with the same name.
• The destination isn’t reachable or writable.
The warning appears at whatever level the problem originated (preset, job, or batch) and
propagates upward, so that if the problem occurs at the preset level, you see warning
triangles next to the preset and job.
Chapter 27 Creating and Changing Destinations 329If you hold the pointer over the warning triangle for a few seconds, a tooltip displays
information about the nature of the problem. As soon as you resolve the problem, the
warning triangle disappears and you can continue to transcode.
Click the warning 
symbol to see an 
explanation about 
why it is there.
Deleting and Duplicating a Destination
You can manage destinations by deleting those you no longer need and creating new
ones based on existing destinations.
To delete a destination
1 Open the Destinations tab.
2 In the Destinations tab, select the destination you want to remove, then click the Remove
(–) button, or press Delete.
Important: There is no confirmation step in this process, so you need to be sure you want
to remove the destination before clicking the button.
Remove button
To duplicate a destination
1 Open the Destinations tab.
330 Chapter 27 Creating and Changing Destinations2 In the Destinations tab, select the destination you want to copy, then click the Duplicate
button.
Duplicate button
A new entry appears in the Destinations tab with _copy appended to its name. This
destination is identical in all other ways. Rename the duplicate destination as appropriate.
The duplicated 
destination
Chapter 27 Creating and Changing Destinations 331Compressor allows you to save one or more settings or groups of settings into a Droplet.
A Droplet is a standalone preset created by Compressor, packaged into a drag-and-drop
application and saved as an icon.
When you drag source media files to a Droplet icon, they are automatically submitted
for transcoding using the specified embedded settings. The transcoding process begins,
whether or not Compressor is open.
Drag selected source 
media files to a Droplet 
to transcode them.
You can drag any number of media files onto a Droplet. You can double-click a Droplet
to open it and see the settings it contains.
Note: Compressor must already be installed on any computer on which you intend to
use Droplets.
This chapter covers the following:
• Creating Droplets (p. 334)
• About the Droplet Window (p. 336)
• Checking Droplet Settings (p. 338)
• Using a Droplet to Transcode Source Media Files (p. 340)
• Using Droplets to Create Jobs and Settings in Compressor (p. 342)
• Droplet Tips (p. 343)
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28Creating Droplets
Droplets are easy to create, and once created, allow you to quickly and easily submit
source media files for transcoding. Compressor offers two methods for creating Droplets,
each with its own advantages. In the Settings tab, you can use the “Save Selection as
Droplet” button. And, in the File menu, you can choose the Create Droplet item.
Creating a Droplet from the Settings Tab
If you are already working in the Settings tab and you have identified an existing setting
from which you want to create a Droplet, the “Save Selection as Droplet” button is a
handy tool for creating the Droplet.
To create a Droplet using the “Save Selection as Droplet” button in the Settings tab
1 Open the Settings tab.
2 Select one or more settings or setting groups that you want to save as a Droplet.
• Click the “Save Selection as Droplet” button.
“Save Selection as 
Droplet” button
• Control-click the settings you selected and choose Save as Droplet from the shortcut
menu.
The Save dialog appears.
Note: You can Shift-click or Command-click to add multiple settings and/or setting groups
to a Droplet. In this situation, every source media file is transcoded by every setting in
the Droplet. For example, if you submitted two source media files to a Droplet containing
three settings, Compressor creates six different output media files.
3 In the Save dialog, enter a name for the Droplet in the Save As field and use the Where
pop-up menu to navigate to the Droplet location.
You can save your Droplet anywhere on your computer, but it’s most convenient to save
it on your desktop, so you can conveniently drag source media files to it.
4 Use the “Choose Destination for Droplet results” pop-up menu to choose a destination
folder for the output media files that the Droplet will create.
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tab. If no custom destinations have been created, only four default Apple destinations
appear in the Choose Destination pop-up menu. See Creating a Destination for more
information about destinations.
5 Click Save.
Your newly created Droplet appears as an icon at whatever location you selected. You
are now ready to use it for transcoding.
Creating a Droplet from the File Menu
No matter where you are working in the Compressor application, you can always use the
Create Droplet item in the File menu.
To create a Droplet using the Create Droplet command in the File menu
1 Choose File > Create Droplet.
The Droplet Settings Selection and Save dialog appears.
2 Select one or more settings or setting groups that you want to save as a Droplet.
You can Shift-click or Command-click to add multiple settings and/or setting groups to
a Droplet. In this situation, every source media file is transcoded by every setting in the
Droplet. For example, if you submitted two source media files to a Droplet containing
three settings, Compressor creates six different output media files.
3 Enter a name for the Droplet in the Save As field and use the Where pop-up menu to
navigate to the Droplet location.
You can save your Droplet anywhere on your computer, but it’s most convenient to save
it on your desktop, so you can conveniently drag source media files to it.
4 Use the “Destination for files created by the droplet” pop-up menu to choose a destination
folder for the output media files that the Droplet will create.
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tab. If no custom destinations have been created, only four default Apple destinations
appear in the Choose Destination pop-up menu. See Creating a Destination for more
information about destinations.
5 Click Save.
Your newly created Droplet appears as an icon at whatever location you selected. You
are now ready to use it for transcoding.
Drag selected source 
media files to a Droplet 
to transcode them.
About the Droplet Window
You can open any Droplet to view its full details as well as add, remove, and modify
settings and source media files. You can also modify the filenames for the output media
files using the Filename Template and change the destination folder for the output media
files that the Droplet will create.
336 Chapter 28 Using DropletsSee About the Destinations Tab for more information on using file identifiers.
Destination 
pop-up field
“Show window on 
startup” checkbox
Submit button
Source files table
Individual jobs
Jobs table
Job Type  Filename Template
Action checkbox 
(only present for some 
job types)
Job type identifier
Show Info button
Add Output and Remove 
Output buttons
The Droplet window contains the following items.
• Destination: This field displays the destination for the output media file. You can modify
this by clicking it and choosing a destination defined in Compressor, or by clicking the
Choose button to open the Destination Location dialog and choosing a folder.
• Source Files: Contains a list of all the jobs in the batch about to be submitted. If the
“Show window on startup” checkbox is selected, the Droplet window opens after you
drag your source media files to the Droplet icon, and all the source media files appear
in the Source Files table. You can drag one or more source media files into this table,
and they will all be transcoded together when you submit the batch, just like a normal
batch submission from the Batch window.
• Job Type pop-up menu: Use this pop-up menu to select the type of output media file.
The choices are: Apple TV, Blu-ray, DVD, iPhone, iPod, YouTube, and Other. The Other
option opens a dialog in which you can choose from a list of existing Compressor
settings. For a complete description of each these job types, see Quick and Easy
Compressor Workflow: Batch Template Method and About Job Actions.
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from each item in the Source files list.
• Filename Template: Compressor automatically enters a filename in this field for the
output media file. The first part of the filename is based on the source file name.
Compressor also automatically appends an output type identifier (such as “iPod” or
“YouTube”) at the end of the filename. You can manually edit any portion of the filename
by double-clicking it.
• Job type identifier: Compressor automatically appends an output type identifier (such
as “iPod” or “YouTube”) at the end of each filename. You can manually edit any output
type identifier by double-clicking it.
• Add/Remove Output buttons: Click Add Output to create additional outputs. To remove
a particular output, click its Remove Output button.
• Show Info button: Click this button to display extensive details about the current setting
and the output media file. If you are transcoding multiple source files, you can view
information about each individual media file.
• Action checkbox: Select this checkbox to activate any post-transcoding actions (beyond
simply creating the output media file). For more information, see Adding Job Actions.
• Show window on startup checkbox: When this checkbox is selected, the Droplet window
opens when you drag source media files to the Droplet icon, before the batch is
submitted. This allows you to verify the settings contained within the Droplet. If the
checkbox is not selected, the batch is submitted as soon as the batch is dragged to
the Droplet icon (as long as there are no errors), and the Droplet window doesn’t open.
• Submit: Click this button to open the submit dialog and submit the batch. For more
information about submitting, see Using a Droplet to Transcode Source Media Files
and Submitting a Batch. You only need to do this if the “Show window on startup”
checkbox is selected; if this checkbox is not selected, the batch is submitted
automatically.
Checking Droplet Settings
This section describes several ways to check and adjust Droplet settings.
“Show window on startup” Checkbox
The “Show window on startup” checkbox at the bottom of the Droplet window determines
whether or not a Droplet window opens when a batch is dragged to a Droplet icon. If it
is selected, the Droplet window opens when you drag a batch to the Droplet icon, and
you can view the Droplet settings.
338 Chapter 28 Using DropletsIf this checkbox is not selected, double-click the Droplet icon to open its window and see
the settings.
“Show window 
on startup” button
Show Details button
See About the Droplet Window for more information about Droplet settings.
Show/Hide Details Button
Use this button to open or close the action drawer for any particular job. You can use the
action drawer to apply and adjust job actions. For more information about
post-transcoding actions, see Adding Job Actions.
Show/Hide Details button DVD Action drawer
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Click the Info button on any job to get detailed information about the resulting output
media file.
“Show info for” 
pop-up menu
Note: If you are transcoding multiple source files, you can use the “Show info for” pop-up
menu in the Info dialog to choose which particular source media file will have its details
displayed.
Using a Droplet to Transcode Source Media Files
Once you have created a Droplet, you can transcode source media files by dragging them
to the Droplet icon.
To transcode source media files using a Droplet
1 Drag your selected source media files over the Droplet icon.
The “Show window on startup” checkbox at the bottom of the Droplet window determines
what happens next.
• If the “Show window on startup” checkbox is not selected: The Droplet begins transcoding
the source media files immediately.
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the source media files displayed in the Droplet Source Files table. Proceed to step 2 to
submit your batch.
If the Droplet window opens, you can view its full details as well as add, remove, and
modify settings and source media files. You can also modify the filenames for the output
media files using the Filename field and change the destination folder for the output
media files that the Droplet will create.
2 When you’re satisfied with the settings, click Submit.
The submit dialog appears. For detailed information about the submit dialog, see
Submitting a Batch.
3 Enter a name for the batch in the Name field.
This is useful for identifying the batch in Share Monitor.
4 Use the Cluster pop-up menu to choose which computer or cluster will process the batch.
The default Cluster setting is This Computer, which means Compressor will not involve
any other computers in completing the batch. You can choose from any other available
clusters that appear in this list. See Apple Qmaster and Distributed Processing for more
details on setting up an Apple Qmaster distributed processing network.
5 Select the This Computer Plus checkbox to create an ad hoc cluster including This
Computer and any available service nodes.
See About This Computer Plus and Unmanaged Services for more information.
6 Use the Priority pop-up menu to choose a priority level for the batch.
7 Click Submit or press Enter to submit the batch for processing.
Each source media file is processed according to the existing setting or group of settings
contained within the Droplet.
8 Open Share Monitor if you want to view the processing status of your source media files.
See the Share Monitor User Manual for more information.
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Files table and submit them for transcoding.
To transcode source media files using an open Droplet
1 Double-click the Droplet icon to open it.
2 Using the Finder, locate the source media files and drag them into the Droplet’s Source
Files table.
3 Modify your Droplet settings as necessary, then click Submit.
Each source media file is processed according to the existing setting or group of settings
contained within the Droplet. For example, if you submitted two source media files to a
Droplet containing three settings, Compressor would create six different output media
files.
4 Open Share Monitor if you want to view the processing status of your source media files.
Using Droplets to Create Jobs and Settings in Compressor
You can drag Droplets from the Finder to the Batch window in Compressor to either
create a complete job/target based on the Droplet or apply targets (settings and
destinations) to existing jobs in the Batch window.
To create new jobs using Droplets
µ Drag a Droplet to an empty space in the Batch window.
A new job appears with one or more target rows populated from the Droplet’s properties,
including settings and destinations.
To create new targets using Droplets
µ Drag a Droplet to an empty space on a job tile in the Batch window.
One or more new target rows appear on the job, populated from the Droplet’s properties,
including settings and destinations.
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Here are some additional tips on using Droplets to transcode source media files.
Droplets and Compressor Processing Services
If you drag files to a Droplet icon without first opening the application or opening a
Droplet, Compressor may display an alert message (“This computer is unavailable”),
indicating that Compressor processing services have not yet started up in the background.
Click Submit at the bottom of the Droplet window. Compressor processing services will
start up and transcode the files.
Droplets and Large Numbers of Source Media Files
If you submit a large number of source media files (such as 200 or more) using a Droplet,
there may be a delay of about 1 minute between the “Getting ready for processing” alert
message and the dialog reporting that the job is being submitted. You can avoid this
reporting delay by reducing the number of source files you submit at one time with a
Droplet.
Chapter 28 Using Droplets 343Transcoding or processing a series of large files on one desktop computer is processor
intensive and time-consuming. You can increase speed and productivity by distributing
processing across multiple computers.
This chapter covers the following:
• Distributed Processing Basics (p. 345)
• Basic Components of the Apple Qmaster Distributed Processing System (p. 347)
• Getting Started Quickly Using This Computer Plus (p. 354)
• Getting Started Quickly Using QuickClusters (p. 356)
• The Interfaces in the Apple Qmaster Distributed Processing System (p. 359)
• Apple Qmaster Sharing Window of Compressor (p. 366)
• General Information About Clusters (p. 370)
• Creating Clusters with Apple Qadministrator (p. 381)
• Setting Up for Part-Time Distributed Processing with Shake (p. 384)
Distributed Processing Basics
Distributed processing accelerates processing by distributing the work to multiple
computers that have been chosen to provide more processing power. You can submit
batches of processing jobs to the Apple Qmaster distributed processing system, which
allocates those jobs to other computers in the most efficient way (described in more
detail in How the Apple Qmaster System Distributes Batches).
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Processing 29Computers that submit batches to the Apple Qmaster distributed processing system are
called clients. A job is a processing task such as a Compressor preset-source pair, or a
Shake file, or other files or commands that use UNIX commands to specify settings such
as rendering instructions and file locations and destinations.
Batch of
processing jobs
Client computer
Jobs are submitted.
Destination folder
Files are placed at
specified destination.
Processed
files
Apple Qmaster cluster
Processing is
performed by cluster.
Network
A batch is one or more jobs submitted for processing at one time. The procedure is
analogous to printing multipage documents from a word processing program; the files
are spooled and processed in the background. Although a batch can include just one
job, you will typically want to submit several jobs at once for processing. Similarly, several
people can use the same Apple Qmaster system at the same time, with several client
computers sending batches in the same time frame. Batches are managed and distributed
by the computer that is designated as the Apple Qmaster cluster controller, which is
described in the next section.
There are three approaches you can take toward setting up a distributed processing
system:
• Use This Computer Plus: Using This Computer Plus is the easiest approach you can take
to create a distributed processing system. You simply install Compressor, configured
as a service node, on any computers you want to perform processing duties. For more
information, see Getting Started Quickly Using This Computer Plus.
• Create a QuickCluster: Creating a QuickCluster allows you to configure a single computer
to be a cluster by choosing the number of instances it supports, based on the number
of cores available. For more information, see Getting Started Quickly Using QuickClusters.
• Manually create a cluster: Large installations can manually create managed clusters for
use by their clients. For more information, see Creating Clusters with
Apple Qadministrator.
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managed clusters), you may be asked to authenticate yourself. This is because
Apple Qmaster must share a folder, using NFS sharing, with links to the media files so
that the processing computers can access the media files. This makes this folder available
to any computer that knows its IP address. When using distributed processing with
confidential media, make sure the computers are protected by a firewall.
For more information about the various components that make up a distributed processing
system, see Basic Components of the Apple Qmaster Distributed Processing System.
Basic Components of the Apple Qmaster Distributed Processing
System
Although the Apple Qmaster software includes a few different applications (see The
Interfaces in the Apple Qmaster Distributed Processing System), as a whole it is part of a
networked system that includes the following basic components.
Note: Within a distributed processing system, the Compressor, QuickTime, and Mac OS
versions must all be identical.
• Client(s): The computer or computers that use Compressor or Apple Qmaster to submit
jobs for distributed processing. Applications that can use Apple Qmaster services for
processing include Compressor, Shake, Autodesk Maya, and many UNIX command-line
programs. Computers with Final Cut Pro and Motion can also be clients.
• An Apple Qmaster cluster: An Apple Qmaster cluster contains:
• Service nodes: The computers that perform the processing of batches submitted via
Compressor or Apple Qmaster. A batch can include one or more jobs.
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Apple Qmaster Sharing window of Compressor, that divides up batches, determines
which service nodes to send work to, and generally tracks and directs the processes.
Cluster controller manages the
distribution of client’s jobs across the cluster
Service node
processes jobs
Cluster
(can contain multiple service nodes, but only one cluster controller)
Client computer from
which users send jobs to the cluster
Service node
processes jobs
Service node
processes jobs
Service node
processes jobs
The client computer, the service nodes, and the cluster controller are often on separate
(but network-connected) computers, for the most rapid processing potential. However,
the cluster controller could be on a client computer or a service node. See Using One
Computer to Serve Two Distributed Processing Rolesfor more information on this scenario.
Following is a closer look at the part each component plays in the Apple Qmaster system.
Clients
Batches are submitted for distributed processing from the client computers. A client
computer can be any computer that has Compressor installed and is on the same network
(subnet) as the cluster controller. Multiple client computers can be on the same subnet,
using the same cluster to do the processing for various applications.
You use Compressor or the Apple Qmaster application to submit batches to be processed
for a client. See The Basic Transcoding Workflow and the Apple Qmaster User Manual for
details on using these applications.
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When a client sends batches to the Apple Qmaster distributed processing system, all the
processing and subsequent moving of any output files is performed by a group of
Apple Qmaster–configured computers called a cluster. You can create one or more clusters
of service nodes, with one cluster controller included in each cluster. Each computer in
the cluster is connected to the other computers in the cluster through a network
connection.
Cluster
controller
Service
node
Service
node
Service
node
Example of a cluster
Note: This illustration provides only one simple example of a cluster. Other possibilities
are described in Examples of a Distributed Processing Network.
Service Nodes
The service nodes are where the processing work is done. When you assign a group of
service nodes to a cluster, they function as one very powerful computer because all their
resources are shared. If one service node is overloaded or otherwise inaccessible, another
service node is used.
You make a computer available as a service node by configuring it in the Apple Qmaster
Sharing window, accessible from Compressor by choosing Share This Computer from the
Apple Qmaster menu.
The Minimum You Need to Know
The following are the basic rules for setting up a distributed processing network:
• A cluster must contain one (and only one) computer acting as the cluster controller,
and at least one computer acting as the service node. (These two can be the same
computer, as shown in Using One Computer to Serve Two Distributed Processing Roles.)
• The client computers and the computers in any cluster that supports them must be
on the same network.
• The network must support the Apple networking technology built in to Mac OS X.
• All the computers in a cluster need read-and-write access to any computers (or storage
devices) that will be specified as output destinations for files.
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A very small distributed processing setup could include as few as two computers:
• One computer connected to the client and configured to act as both the service node
and the cluster controller
• One client computer
Client Service node with
cluster controller enabled
Minimum setup for distributed processing
Though simple, this setup is useful in a small-scale environment because it allows the
client computer to offload a lot of processing work.
Using One Computer to Serve Two Distributed Processing Roles
To maximize your resources, you may want to consider using some computers for more
than one distributed processing function.
• Service node and cluster controller: In a small setup, one of the service nodes in a cluster
can also act as the cluster controller so that it performs both functions. However, in
a cluster of many service nodes, the processing load required for the cluster controller
could be so high that it would not be efficient to use one computer as both a service
node and a cluster controller.
• Client computer and cluster controller or service node: You could also set up a client
computer to act as a cluster controller or service node in a cluster, but again, keep in
mind that the more available processing power a computer has, the faster it can
manage or process jobs.
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“part-time” processing because each computer acts as someone’s workstation, but at the
same time is also part of the distributed processing cluster. The bulk of the processing
jobs can be submitted with Compressor or Apple Qmaster at the end of the day, so that
the computers are busy processing a large queue of distributed processing batches after
everyone has gone home. (See About Advanced Settings in the Apple Qmaster Sharing
Window and Scheduling Service Availability in the Work Schedule Dialog for information
on scheduling service node availability.)
Network
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Each computer acts as both
a client that submits jobs for processing and
a service node that performs the processing.
All source and output files are stored on the FireWire drives.
In the sample setup shown above, five computers act as both the clients (user workstations
from which users submit jobs for distributed processing) and cluster computers (which
do the processing). Each computer has an additional volume, such as a FireWire drive,
that is used for media before and after it is rendered, and for the associated files.
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a LAN, connected to a cluster using a high-speed switch. A rack of servers plus a shared
storage device, acting as the cluster, would be an extremely strong rendering engine.
The service nodes would each have a local copy of the relevant client application software
so that they could process the rendering jobs.
Client Client Client Client
Example of a network setup for distributed rendering
High-speed switches (chained together)
Rack of servers containing
cluster controller and service nodes,
plus rack-mounted shared storage device
LAN
How the Apple Qmaster System Distributes Batches
The Apple Qmaster cluster controller determines the most efficient use of the cluster
resources. It makes this determination based on the availability of each service node and
the number of separable parts (described next) of the batch.
Because Apple Qmaster subdivides individual batches across different service nodes, the
work is shared and completed more quickly. And, because this method uses all the service
nodes as much as possible, you avoid under-utilizing your resources.
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following ways. (Apple Qmaster determines which way is the most efficient for specific
batches, depending on the circumstances.)
• The batch is subdivided into data segments: For example, for a render batch, the cluster
controller could divide the frames into groups (segments). Each segment would be
processed in parallel on the service nodes in the cluster.
• The batch is subdivided into tasks: For example, for a render batch, the cluster controller
could subdivide the rendering work into different processing tasks. Different tasks
would be run on different service nodes.
Rather than actually moving segments, Apple Qmaster tells the service nodes which
segments to read via the network, where to find them, and what to do with them. Below
is an example of how one batch could be processed in an Apple Qmaster system.
Batch submitted by
Compressor or
Apple Qmaster (job request
for frames 1–30)
Cluster controller
divides and distributes
job to available
service nodes
Service node 1 Service node 2 Service node 3
Instructions specifying
locations of source files
and frames 11–20
Instructions specifying
locations of source files
and frames 21–30
Instructions specifying
locations of source files
and frames 01–10
Processed file (frames 1-30)
placed in specified
destination
In distributing batches, Apple Qmaster uses the technology built in to Mac OS X to locate
services in a cluster on the same IP subnet and to dynamically share and receive
information. Because the computers can continually transmit their current processing
availability status, Apple Qmaster can distribute (load-balance) the workload evenly across
the cluster.
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A distributed processing network can consist of as few as one or two computers, whereas
a high-volume network may include many computers, an Xserve system and Xserve
cluster nodes in a rack, and high-speed networking infrastructures. You can scale up a
distributed processing system as your workload demands by adding features and devices
to the network that supports it.
There are many ways to expand the capacity of a distributed processing network. You
could include any of the following.
• High-speed switch and cables: A 100Base-T or Gigabit Ethernet switch and compatible
cables to allow your data to move over the LAN at maximum speed.
• Multiple clients: Multiple client computers can use the services of the same cluster. And,
you can have multiple client applications on the same client computer, using the same
cluster.
• Multiple clusters: Depending on how extensive your network is and how many clients
it needs to serve, you may want to divide up available computers and create more than
one cluster to serve various clients. (Users select the cluster they want to send a batch
to when they submit the batch.)
• Multiple service nodes: In general, more service nodes mean more processing power.
In deciding how many service nodes to have in a cluster, consider the ratio of data
movement time to computing time. If the processing demand is greater than the
network demand required to move job segments throughout the cluster, as is the case
with rendering, more service nodes are a good idea. If the computing load, per job, is
closer to the network load, having a smaller number of service nodes per cluster may
be more efficient. If you are using the Apple Qmaster distributed processing system
with applications other than Shake or Compressor, consult the application’s user manual
on how to optimize the number of service nodes.
• Storage device: A storage device, such as a remote disk or group of disk arrays, can be
used as cluster scratch storage, which is a place for short-term storage of temporary
data generated by the cluster controller, clients, and service nodes. (You set the scratch
storage location in the Apple Qmaster Sharing window of Compressor. See About
Advanced Settings in the Apple Qmaster Sharing Window and Using Cluster Storage
for more information.) Alternatively, a storage device can be used as a final destination
for the files after they are processed.
For more information, see Examples of a Distributed Processing Network.
Getting Started Quickly Using This Computer Plus
Using This Computer Plus in Compressor gives you an easy way to take advantage of the
distributed processing capabilities offered by Apple Qmaster without requiring a lot of
knowledge about how clusters are configured, how to set up file sharing, and so on.
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• Creating Apple Qmaster service nodes in Compressor on your networked computers
• Selecting This Computer Plus when you submit a Compressor batch for processing
These two steps let you harness the processing power of any number of computers on
your network without any additional effort or knowledge on your part.
Note: Within a distributed processing system, the Compressor, QuickTime, and Mac OS
versions must all be identical.
• Stage 1: Creating Service Nodes
• Stage 2: Submitting Compressor Batches for Processing
Stage 1: Creating Service Nodes
Once you have installed Compressor on a computer you want to use as a service node,
you need to configure its Apple Qmaster Sharing window.
To configure a computer as a service node
1 In Compressor, choose Apple Qmaster > Share This Computer.
The Apple Qmaster Sharing pane appears.
2 Select “Share this computer” and “as Services only.”
3 Select Compressor in the Services area. Make sure “Require these services to only be used
in managed clusters” is not selected.
4 Click OK.
This computer is now available for Compressor to use as an unmanaged service node.
Additionally, Final Cut Pro and Motion can use it when you select This Computer Plus in
any of their Share menu options.
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When you submit a Compressor batch for processing, a dialog appears that allows you
to name the batch and select the computers to process the batch. At this point, you can
harness the processing power of all the computers you set up as service nodes in stage
1 to complete the batch.
To process the batch using This Computer Plus
1 Leave the Cluster pop-up menu set to the default selection (This Computer).
2 Select the This Computer Plus checkbox.
Compressor and Apple Qmaster coordinate the distribution of the processing tasks
between the available computers and deposit the resulting output files at the location(s)
you designated in Compressor.
Getting Started Quickly Using QuickClusters
QuickClusters offer a simple and automated way to create and configure clusters, as well
as an alternative to creating and configuring clusters manually with Apple Qadministrator.
QuickClusters with enabled unmanaged support automatically configure themselves and
use any available unmanaged services on the same local network (subnet). QuickClusters
listen for unmanaged service advertisements and may mark or remember any of them
for later use.
The Apple Qmaster distributed processing system has default settings that allow you to
use distributed processing immediately.
• Stage 1: Installing the Software
• Stage 2: Configuring a QuickCluster
• Stage 3: Adding Service Nodes to a Cluster
• Stage 4: Creating and Submitting a Batch
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Install Compressor on the computers you want to include in your distributed processing
network.
To install the software
1 Install Compressor for use as a client on at least one computer in your network.
In order to submit jobs and batches to the distributed processing system, you need to
use client (submission) software (Compressor or Apple Qmaster).
2 Install Compressor on each computer you want to use for distributed processing. (All
computers must be on the same subnet.)
Note: Within a distributed processing system, the Compressor, QuickTime, and Mac OS
versions must all be identical.
Stage 2: Configuring a QuickCluster
Use the Apple Qmaster Sharing window to configure the cluster controller and service
node computers.
To configure the cluster controller and service node computers
1 In Compressor, choose Apple Qmaster > Share This Computer.
The Apple Qmaster Sharing pane appears.
2 Select the “Share this computer” checkbox.
All other settings in this window should be correct by default:
• The “as QuickCluster with services” option should be selected.
• Rendering should not be selected.
• Compressor should be selected.
• “Require these services to only be used in managed clusters” should not be selected.
• A default name for this QuickCluster appears in the “Identify this QuickCluster as” text
area.
• “Include unmanaged services from other computers” should be selected.
• “Require password” should not be selected.
For more information about these settings, see About Basic Settings in the Apple Qmaster
Sharing Window.
3 Click OK.
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processing services. For information about multiple service instances, see Using Virtual
Clusters to Make the Most of Multicore Computers.
Stage 3: Adding Service Nodes to a Cluster
Do the following on each computer that you would like to make an unmanaged service
node on your cluster.
To add a service node to a cluster
1 In Compressor, choose Apple Qmaster > Share This Computer.
The Apple Qmaster Sharing pane appears.
2 Select “Share this computer” and “as Services only.”
All other settings in this window should be correct by default:
• Rendering and Compressor should both be selected.
• “Require these services to only be used in managed clusters” should not be selected.
• All other settings are disabled.
For more information about these settings, see About Basic Settings in the Apple Qmaster
Sharing Window.
3 Click OK.
This creates a service node that will automatically process jobs submitted to the
QuickCluster you set up in Stage 2: Configuring a QuickCluster.
Stage 4: Creating and Submitting a Batch
In the Compressor Batch window or in the Apple Qmaster window, create a batch with
one or more jobs. See Finalizing Jobs and Submitting Batches or the Apple Qmaster
User Manual for details.
To submit the batch
1 Do one of the following:
• If you are using Compressor: In the Compressor Batch window, click Submit, and in the
resulting dialog, use the Cluster pop-up menu to choose the cluster you created in
stage 2.
• If you are using Apple Qmaster: In the Apple Qmaster window, choose the cluster you
created in stage 2 from the Submit To pop-up menu.
2 Click Submit.
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The Interfaces in the Apple Qmaster Distributed Processing
System
The Apple Qmaster system is a suite of applications that work together to provide
maximum power and flexibility for distributed processing. The elements of the system
can be combined in a variety of ways to suit your needs.
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nodes and cluster controllers and to create service nodes for This Computer Plus clusters
and QuickClusters, which provide what most users need. System administrators use
Apple Qadministrator for advanced cluster creation and control. Client users use
Compressor or Apple Qmaster to submit batches of jobs for processing. Finally, Share
Monitor can be used by both administrators and client users to monitor and manage
batches.
Apple Qadministrator
Share Monitor
QuickCluster
Users:  Administrators and client users
Use to:  Monitor batches that have
been sent to clusters
Compressor
Users:  Administrators
Use to:  Create service nodes and
cluster controllers
Users:  Administrators
Use to:  Assemble clusters of service nodes
and cluster controllers
Compressor or Apple Qmaster
Users:  Client users
Use to:  Submit jobs to clusters
for processing
Note: It is possible to create a simple (personal) distributed processing system and skip
Apple Qadministrator altogether. See Getting Started Quickly Using This Computer Plus
and Getting Started Quickly Using QuickClustersfor more information. See Apple Qmaster
Sharing Window of Compressor for information on all of its settings.
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Use the Apple Qadministrator application to manually create and modify Apple Qmaster
clusters. Apple Qadministrator can be used on any computer that is on the same network
as the cluster you want to administer. With the administrator password (if one was created),
you can also use Apple Qadministrator to see and modify existing clusters on the network.
Note: Most users will not need to use Apple Qadministrator to create or manage their
clusters, instead using This Computer Plus and QuickClusters.
Use Apple Qadministrator to assemble clusters:
Drag available service
nodes to assign them
to a cluster.
For details about using Apple Qadministrator, see the Apple Qadministrator User Manual.
To open Apple Qadministrator
µ In Compressor, choose Apple Qmaster > Administer Clusters.
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selected cluster, you will not be able to see or modify the cluster until you click the Lock
button and then enter the password in the dialog that appears.
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Client computer users use either Compressor or Apple Qmaster to submit batches for
processing.
Batch Batch
Batch Batch
Use Apple Qmaster to submit
a batch to a cluster:
Cluster A
Cluster B
Network
Use Compressor to submit
a batch to a cluster:
Using Compressor
Use the Cluster pop-up menu in the Compressor Batch window to choose a cluster for
any given batch. For more information on submitting batches with Compressor, see
Submitting a Batch.
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The Apple Qmaster application is the application that you use to submit distributed
processing jobs from digital visual effects software packages such as Shake, Autodesk
Maya, and any UNIX command-line program.
You can use any of the following workflows in Apple Qmaster:
• For Shake processing batches, you can drag Shake files into the Apple Qmaster window.
A default script for submitting the jobs is automatically created. In Apple Qmaster, you
can then specify certain details, such as which cluster to use, and make adjustments
to certain settings.
• For Maya batches, there is also a special interface within Apple Qmaster for submitting
and customizing Maya jobs.
• You can use the Generic Render command in Apple Qmaster for the distributed
processing of projects from other frame-based rendering applications (such as After
Effects and LightWave).
For complete information about the Apple Qmaster application, see the Apple Qmaster
User Manual.
To open Apple Qmaster
µ In Compressor, choose Apple Qmaster > Create Rendering Jobs.
The Apple Qmaster window appears.
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As an administrator, you can use Share Monitor to track the progress of all the batch
activity for all the clusters on your network. You can see how close to completion each
job is, along with other details, and you can cancel, pause, and resume batches as well.
If you are a client user, you can use Share Monitor to view and manage your own batches.
Cluster
Use Share Monitor to see information about batches
that have been sent to specified clusters:
Status of
batches
Status of
batches
Cluster
Network
For complete information about Share Monitor, see the Share Monitor User Manual.
To open Share Monitor
Do one of the following:
µ Submit a batch with Compressor or Apple Qmaster. The Share Monitor window opens
automatically depending on your preference setting.
µ Configure and submit a Share menu option from Final Cut Pro or Motion. Share Monitor
opens in the Dock where you can select it to open it.
µ Click the Share Monitor button in the Apple Qmaster window or in the Compressor Batch
window.
µ In Apple Qadministrator, choose Cluster > Show Share Monitor.
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Apple Qmaster Sharing Window of Compressor
Use the Apple Qmaster Sharing window of Compressor to activate, create, or make
changes to Apple Qmaster cluster-controlling and processing services (including passwords
and scratch storage locations).
Use the Apple Qmaster Sharing window of Compressor 
to configure service nodes and cluster controllers:
Service
node
Cluster
controller
For details about using the Apple Qmaster Sharing window of Compressor, see Options
in the Apple Qmaster Sharing Window of Compressor.
Also see the Apple Qmaster User Manual for more information, including information
about creating an extended node cluster that uses nodes without Apple Qmaster installed.
To open the Apple Qmaster Sharing window of Compressor
1 Open Compressor.
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The Apple Qmaster Sharing window appears.
After you configure the Setup and Advanced panes, click OK to apply the settings.
Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
About Basic Settings in the Apple Qmaster Sharing Window
You can use the Setup pane within the Apple Qmaster Sharing window to configure your
distributed processing system.
Sharing Settings
• Share this computer: Select this checkbox to share this computer using one of the three
options below. Deselect this option to not share this computer.
• as QuickCluster with services: Select this option to create an “instant” cluster with
unmanaged services. See Getting Started Quickly Using QuickClusters for more
information.
• as Services and cluster controller: Select this option to define this computer as a cluster
controller when building a cluster in Apple Qadministrator. See Creating Clusters
with Apple Qadministrator for more information.
• as Services only: Select this option to make this computer a service node only. Service
nodes perform the processing of batches. They can be included in This Computer
Plus clusters, QuickClusters, or in managed clusters. See Managed vs. Unmanaged
Services for more information.
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• Rendering: Use this checkbox to enable or disable the Rendering service. Click its Options
button to open a dialog in which you can adjust the number of instances of a processing
service. For more information, see Using Virtual Clusters to Make the Most of Multicore
Computers.
• Compressor: Use this checkbox to enable or disable the Compressor service. Click its
Options button to open a dialog in which you can adjust the number of instances of
a processing service. For more information, see Using Virtual Clusters to Make the Most
of Multicore Computers.
• Require these services to only be used in managed clusters: Use this checkbox to make
the shared service unmanaged (the default) or managed. For more information, see
Managed vs. Unmanaged Services.
QuickCluster Settings
• Identify this QuickCluster as: Use this field to change the name of a QuickCluster. For
more information about QuickClusters, see Getting Started Quickly Using QuickClusters.
• Include unmanaged services from other computers: Select this checkbox to have this
QuickCluster automatically use the available unmanaged computers on your network
for distributed processing. For more information on this option, see Managed vs.
Unmanaged Services.
Security Settings
• Require password: If you want to control who is able to include a specific service node
or cluster controller in a cluster, select this checkbox and enter a password in the dialog
that opens. For more information, see Setting a Service Password for Including a
Computer in a Cluster.
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You can use the Advanced pane within the Apple Qmaster Sharing window to further
configure your distributed processing system.
Advanced Service Settings
Use these features to schedule service restarts and service availability.
• Restart all services every 24 hours: Selecting the “Restart all services every 24 hours”
checkbox ensures a robust distributed processing system. Refreshing the services
periodically prevents increased virtual memory sizes and memory leaks in third-party
software.
• Set schedule for unmanaged services: If you enabled unmanaged services, you can open
a calendar interface and schedule the availability of these services to the distributed
processing system. For information on using the calendar interface, see Scheduling
Service Availability.
Shared Cluster Storage
Use these features to configure scratch storage for this computer’s cluster controller. For
more information on cluster storage, see Using Cluster Storage.
• Delete files older than N days: Enter the number of days temporary process files may
remain on the cluster’s scratch location before they are automatically deleted. If you
anticipate a transcoding session that will last up to seven days or longer, you must
adjust this value.
• Storage location: Shows the temporary cluster storage location. Click Set to choose a
local folder directory to change the scratch location for the cluster’s temporary process
files. See Using Cluster Storage for more information.
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Use these features to configure network settings.
• Allow discovery via Bonjour: By default, this checkbox is selected to have the
Apple Qmaster distributed processing system use the Bonjour networking technology.
You can deselect the “Allow discovery via Bonjour” checkbox for enhanced security.
This will prevent detection of your computer over a Bonjour network. This feature
requires Mac OS X v10.4 or later.
• Use network interfaces: Restrict distributed processing activity to a particular network
interface card by choosing it from this pop-up menu. If you do this on a service node
computer, use a different computer to submit Compressor jobs and batches.
• Enable Port Range: You can define which ports Apple Qmaster uses for service
advertisements with the Enable Port Range checkbox and text fields. For more
information, see Defining Ports for Service Advertisements.
Extras
Use these features to configure additional settings.
• Log service activity to file: If this checkbox is selected, an activity log is created and
updated regularly with information about the Apple Qmaster actions on this computer.
Logs are stored in /Library/Application Support/Apple Qmaster/Logs. To turn this feature
off, deselect the checkbox.
Note: You can also access this log information using the Log button in
Apple Qadministrator or by clicking Show Log in the Share Monitor Show Info window.
• Maximum Active Targets: By default, a cluster can process up to 40 targets at one time.
To change the maximum number of targets processed at the same time between two
or more jobs, enter a number from 1 to 999.
• Identify this computer to Qadministrator as: By default, a computer is identified on the
network by its computer name (as it is entered in the Sharing pane of System
Preferences). You can change this name to something more meaningful if you like,
since it is the name used to identify this computer in the Apple Qadministrator
application. If you are setting up a managed cluster controller, this is the name that
will appear in the Apple Qadministrator Controller pop-up menu.
General Information About Clusters
Once your network is set up and you have installed the necessary components, you are
ready to create distributed processing clusters.
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• Use This Computer Plus: Using This Computer Plus to create a cluster is the easiest
approach you can take to create a distributed processing system. You simply install
Compressor, configured as a service node, on any computers you want to perform
processing duties. For more information, see Getting Started Quickly Using This
Computer Plus.
• Create a QuickCluster: Creating a QuickCluster allows you to quickly configure a
distributed processing system with a separate computer as the cluster controller (This
Computer Plus clusters use the same computer you submit the batch from as the cluster
controller). This is particularly useful when you have multiple clients submitting to the
cluster. For more information, see Getting Started Quickly Using QuickClusters.
• Manually create a cluster: Large installations can manually create clusters for use by
their clients. For more information, see Creating Clusters with Apple Qadministrator.
If you have questions about any concepts and terms used here, see Distributed Processing
Basics.
Note: If you are an Apple Qmaster user and you want to create a cluster that includes
computers that do not have Apple Qmaster installed, see the Apple Qmaster User Manual
for instructions.
Options in the Apple Qmaster Sharing Window of Compressor
Following are optional settings you may want to use.
Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
For a complete list of the options and settings in the Apple Qmaster Sharing window of
Compressor, see About Basic Settings in the Apple Qmaster Sharing Window and About
Advanced Settings in the Apple Qmaster Sharing Window.
Setting the Name
By default, a computer is identified on the network by its computer name (as it is entered
in the Sharing pane in System Preferences). You can change this name to something
more meaningful if you like, since it is the name used to identify this computer in the
Apple Qmaster distributed processing system. If you are setting up a QuickCluster, this
is the name that will appear in the Compressor Cluster pop-up menu or the Apple Qmaster
Submit To pop-up menu. If you are setting up a managed cluster controller, this is the
name that will appear in the Apple Qadministrator Controller pop-up menu.
To enter a name for a QuickCluster
µ Enter the new name for the cluster in the “Identify this QuickCluster as” field.
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1 Click Advanced to open the Advanced pane.
2 Enter the new name in the “Identify this computer to Apple Qadministrator as” field.
Unmanaged Services
You can enable unmanaged services for a QuickCluster. For more information, see
Managed vs. Unmanaged Services.
Setting the Password
To add a password requirement, select the “Require password” checkbox.
• If you are setting up a QuickCluster: Other users will be required to enter this password
before being allowed to submit requests to this computer.
• If you are setting up a cluster to use with Apple Qadministrator: An administrator will be
required to enter this password before being allowed to add this computer to a cluster.
For more information, see Setting a Service Password for Including a Computer in a Cluster.
(If you configure the computer as both a cluster controller and a service node, this
password is used for both.)
Setting Cluster Storage
You can change the default scratch storage location for processing that occurs on this
computer in the Advanced pane. For more information, see Using Cluster Storage.
Managed vs. Unmanaged Services
You have flexibility in how you build clusters for distributed processing with Compressor
or Apple Qmaster. When you configure processing services, you can choose to make
them either managed services or unmanaged services (the default).
Managed Services
Managed services can be assigned to serve one particular cluster controller. Once assigned,
managed services remain exclusively dedicated to that cluster until they are removed
with the Apple Qadministrator application. QuickClusters cannot use managed services
from other nodes, except in the case of extended node clusters. For more information,
see the Apple Qadministrator User Manual. See the Apple Qmaster User Manual for more
information on extended node clusters.
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Unmanaged services automatically assign themselves to the first available This Computer
Plus cluster or QuickCluster with enabled unmanaged service support. QuickClusters
listen for unmanaged service advertisements and may mark or remember any of them
for later use. An unmanaged service remains dedicated to its This Computer Plus cluster
or QuickCluster only long enough to finish the current job. Once the current job is
complete, an unmanaged service is once again a “free agent” and advertises its availability
to all This Computer Plus clusters and QuickClusters.
Note: Managed clusters (those created with Apple Qadministrator) can also use
unmanaged services. When unmanaged service support is enabled on a managed cluster,
the cluster automatically adds any available unmanaged services in addition to its managed
services (that were explicitly added using Apple Qadministrator).
Enabling Unmanaged Services on QuickClusters
Follow these steps to enable unmanaged services on QuickClusters.
To enable unmanaged services on QuickClusters
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Select the “Share this computer” checkbox and the “as QuickCluster with services” button
to create a QuickCluster.
3 Select “Include unmanaged services from other computers.”
4 Click OK.
For more information on creating QuickClusters, see Getting Started Quickly Using
QuickClusters.
Enabling Unmanaged Services on Managed Clusters
Follow these steps to enable unmanaged services on managed clusters.
To enable unmanaged services on managed clusters
1 In Apple Qadministrator, select a cluster in the Cluster list, or click the Add (+) button to
add a new cluster.
2 Select “Allow use of unmanaged services.”
For more information on creating managed clusters, see Creating Clusters with
Apple Qadministrator.
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Follow the instructions below to manage the processing services on a computer in a
cluster.
Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
To set managed processing services
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Do one of the following:
• Select the “Require these services to only be used in managed clusters” checkbox to
use this computer only in managed clusters.
• Deselect the “Require these services to only be used in managed clusters” checkbox
to use this computer in unmanaged as well as managed clusters.
3 Click OK.
To turn off processing services
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 In the Services section, do one of the following:
• To turn off Compressor services: Deselect the Compressor checkbox.
• To turn off Apple Qmaster services: Deselect the Rendering checkbox.
3 Click OK.
Turning Cluster Controller Services On or Off
Use the Services area in the Apple Qmaster Sharing window of Compressor to turn the
cluster controller on or off on a specific computer.
To turn on cluster controller services
1 In Compressor, choose Apple Qmaster > Share This Computer to open the Apple Qmaster
Sharing window.
2 Select the “Share this computer” checkbox, then select one of the following buttons:
• as QuickCluster with services: Select this option to create an “instant” cluster with
unmanaged services.
• as Services and cluster controller: Select this option to build a cluster in
Apple Qadministrator. (See Creating Clusters with Apple Qadministrator for more
information.)
Also see Managed vs. Unmanaged Services for more information.
3 In the Services area, select the Rendering and/or Compressor checkbox.
4 Click OK.
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To turn off cluster controller services
1 In Compressor, choose Apple Qmaster > Share This Computer to open the Apple Qmaster
Sharing window.
2 Deselect the “Share this computer” checkbox and click OK.
Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
Optionally, you can turn off the controller and just make the node a service node. To do
this, select “as Services only” in the “Share this computer” section.
Using Virtual Clusters to Make the Most of Multicore Computers
You can adjust the number of instances of a processing service, essentially creating virtual
clusters on individual computers. For processor-intensive work, having multiple instances
may increase speed and efficiency, depending on the processing application. Too many
instances, however, may actually decrease speed and efficiency.
A general rule you can use when choosing the number of instances is to allow two GB
of memory for each instance. If you have a computer with eight GB of memory that offers
eight instances in the pop-up menu, choosing four instances should provide good results.
This number can vary widely though, depending on whether this computer is also being
used for other duties.
Note: By default, the Apple Qmaster system creates one Rendering service instance for
each processor. Rendering services are for Shake (with Apple Qmaster), Autodesk Maya,
and other UNIX command-line programs, as opposed to Compressor services, which are
solely for Compressor distributed processing. Consult the documentation that came with
the application to see if using each processor individually is ideal.
To change the number of instances of processing services on a computer
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Select Compressor or Rendering in the Services section, then click its Options button.
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click OK.
Choose the number
of instances from
the pop-up menu.
4 Click OK in the Apple Qmaster Sharing window.
Note: The Service Options dialog is also used to add extended nodes to a cluster, as
described in the Apple Qmaster User Manual.
Setting a Service Password for Including a Computer in a Cluster
If you want to control who is able to include a specific service node or cluster controller
in a cluster, you can create a password called a service password for the computer.
Note: A service password can be stored in a user’s keychain.
To set or change a service password
1 On the computer designated as the service node or cluster controller, open Compressor
and choose Apple Qmaster > Share This Computer.
2 Do one of the following:
• To require a password: Select Require Password.
• To change an existing password: Click Change Password.
The password dialog opens.
3 Enter and verify a password, then click OK.
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Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
Scheduling Service Availability
If you enabled unmanaged services, you can open a calendar interface and schedule the
availability of these services to the distributed processing system.
The calendar interface of the work schedule dialog contains several useful features.
You can use the following controls to constrain the availability of unmanaged services
for each day of the week:
• On/Off pop-up menu: Use this pop-up menu to turn services on or off for a particular
day of the week.
• On: This setting indicates that the services are available for all 24 hours of that
particular day. (This is the default setting for all seven days of the week.)
• Off: Makes the service unavailable on that day of the week.
• On Between: Allows you to enter the period of time the service will be available.
• Off Between: Allows you to enter the period of time the service will not be available.
• Start time field: Enter a start time.
• End time field: Enter an end time.
Scheduling Service Availability in the Work Schedule Dialog
Follow the steps below to schedule the availability of unmanaged services.
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1 In the Advanced Service Settings area of the Advanced pane within the Apple Qmaster
preferences pane, click Set.
The work schedule dialog appears.
2 To constrain the availability of the services, choose one of the options from the pop-up
menu next to a particular day of the week. See Scheduling Service Availability for details.
3 Enter any constraining time periods in the appropriate start time and end time fields.
Note: You must enter valid days and times. The time cannot overlap into the next day in
one entry. There must be two entries when the range ends after 12 a.m. For more
information, see Setting Availability from Sunday Night to Monday Morning.
4 Click OK to save the settings and close the dialog.
5 Click OK to apply the changes to this computer.
Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
Setting Availability from Sunday Night to Monday Morning
You must enter valid days and times. The time cannot overlap into the next day in one
entry. There must be two entries when the range ends after 12 a.m.
For example, to set the service availability from 6 p.m. on Sunday to 8 a.m. on Monday,
follow the steps below.
To provide service availability from Sunday night to Monday morning
µ Make both of the following entries:
• Sunday: On between 6:00 PM and 12:00 AM
• Monday: On between 12:00 AM and 8:00 AM
Using Cluster Storage
By default, the Apple Qmaster distributed processing system saves temporary process
files in the /Library/Application Support/Apple Qmaster/Storage directory on the cluster
controller. You can also choose any other location on a local disk for this scratch storage.
Computers in the cluster will access this location as needed.
Adjusting Cluster Storage Settings
Follow the steps below to change scratch storage settings for a cluster.
To change cluster storage settings
1 On the cluster controller, open Compressor and choose Apple Qmaster > Share This
Computer.
2 Click Advanced to open the Advanced pane.
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• To change the cluster storage location: Click the “Storage location” Set button, then
navigate to the folder in the dialog and click Choose.
Note: If you are using the default This Computer setting in the Cluster pop-up menu
in the Compressor Batch window and you choose Cluster Storage as the destination,
the output file will be copied to the Source location.
• To change how often cluster storage files are deleted: Enter a new number in the “Delete
files older than N Days” field.
Click Set to open a
dialog for choosing
a new storage folder.
Enter a new number to 
change how often cluster 
storage files are deleted.
4 Click OK to apply the changes.
Important: If you are making changes to existing settings and this computer is already
providing processing services, clicking OK immediately resets this computer’s services. If
this computer is also the cluster controller, any current jobs are terminated.
Cluster Storage Capacity
If you are processing large source media files that exceed the available storage space on
the startup disk, you may run out of storage space on that disk. There are a number of
things you can do to address this.
• Change the cluster storage location to a disk with more free space. For more information,
see Adjusting Cluster Storage Settings.
• Configure cluster storage settings to delete files more frequently. For more information,
see Adjusting Cluster Storage Settings.
• Compressor users can set Cluster Options preferences (choose Compressor >
Preferences) to “Never copy source to cluster.” For more information, see Setting
Compressor Preferences.
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If you are using cluster storage and an error occurs, partial files may be left on the
designated cluster storage location. Check the designated cluster storage location to
make sure no partial media files are left there. If you find partial media files, delete them
and submit the job again.
QuickTime Reference Movies
If you submit a reference movie for distributed processing, the Apple Qmaster distributed
processing system will automatically copy the appropriate media files to the processing
cluster. For the best performance, you can avoid this file transfer step by making sure
that the media files specified in the reference movie are available to each node of the
Apple Qmaster cluster.
Defining Ports for Service Advertisements
You can define which ports Apple Qmaster uses for service advertisements with the
Enable Port Range checkbox and text fields in the Network section of the Advanced pane
within the Apple Qmaster Sharing window of Compressor.
To define ports for Apple Qmaster service advertisements
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Click Advanced to open the Advanced pane.
3 Select Enable Port Range.
4 In the From field, enter any integer value between 50,000 and 65,535 to set the start of
the range.
5 In the “Number of ports” field, enter the size of the range, such as 1000.
Recovery and Failure Notification Features
The Apple Qmaster distributed processing system has a number of built-in features
designed to attempt recovery if there is a problem, and to notify you when the system
attempts a recovery.
Recovery Features
The recovery actions described next occur automatically if failures occur in the
Apple Qmaster distributed processing system. There is no need for you, as the
administrator, to enable or configure these features.
If a Service Stops Unexpectedly
If either the cluster controller service or the processing enabled on a service node stops
unexpectedly, the Apple Qmaster distributed processing system restarts the service. To
avoid the risk of endless stopping and restarting, the system restarts the failed service a
maximum of four times. The first two times, it restarts the service right away. If the service
stops abruptly a third or fourth time, the system restarts the service only if it had been
running for at least 10 seconds before it stopped.
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When a service stops suddenly while in the middle of processing an Apple Qmaster batch,
the cluster controller resubmits the interrupted batch in a way that prevents the
reprocessing of any batch segments that were complete before the service stopped. The
cluster controller delays resuming the batch for about a minute from the time it loses
contact with the service.
If a Batch Fails
When the service is running, but one batch fails to process, a service exception occurs.
When this happens, the cluster controller resubmits the batch immediately. The cluster
controller resubmits the batch a maximum of two times. If the job fails on the third
submission, the distributed processing system stops resubmitting the job. In Share Monitor,
the job’s status is set to Failed.
Failure Notification
There are two different ways that the Apple Qmaster distributed processing system can
provide information about a problem.
Email Notification
When a processing service stops unexpectedly, Apple Qmaster sends a notification email
to the address that was entered in the Apple Qadministrator Cluster Preferences dialog
for that cluster. If no address was entered there, the email is sent to the address in the
Internet settings of the computer on which the cluster controller is enabled.
Note: Apple Qmaster does not currently support SMTP servers that require authentication.
Log Files for Individual Jobs or Batches
If a particular job or batch fails, a log file is generated that describes this failure. You can
find the name and location of this log file through Share Monitor by selecting the batch
or job, clicking the Show Info icon, then clicking the Show Log button.
Notification and Log Labels
The following table lists the service labels used in the email notifications and logs.
Processing service type Notification label
Local Compressor service servicecontroller:com.apple.stomp.transcoder
Distributed Compressor service servicecontroller:com.apple.stomp.transcoderx
Distributed Apple Qmaster servicecontroller:com.apple.qmaster.executor
service
Creating Clusters with Apple Qadministrator
Once you configure managed service nodes or cluster controllers, they are visible in
Apple Qadministrator, which you use to create and modify Apple Qmaster clusters.
Chapter 29 Apple Qmaster and Distributed Processing 381There are two basic steps to creating a managed cluster with Apple Qadministrator. First,
you create a new cluster and choose the cluster controller. Then, you add service nodes
to the cluster.
• Stage 1: Creating a New Cluster
• Stage 2: Assigning Service Nodes
Stage 1: Creating a New Cluster
Use the following steps to create a cluster with Apple Qadministrator. For more
information, see the Apple Qadministrator User Manual.
To create a new cluster
1 In Compressor, choose Apple Qmaster > Administer Clusters to open Apple Qadministrator,
then do the following:
a Click the Add (+) button.
b Select Untitled Cluster and rename it.
... then rename the 
Untitled Cluster.
Click the Add button... 2 From the Controller pop-up menu, choose a cluster controller from those available on
the network.
Use this pop-up
menu to choose
a cluster controller.
Note: If a password was created for the cluster controller in the Apple Qmaster Sharing
window, a password authentication dialog appears.
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the passwords you want.
• Administrator Password: If you create this password, administrators will need to know
it in order to modify this cluster and to view this cluster’s batches in Share Monitor.
• User Password: If you create this password, users will need to know it in order to submit
batches to this cluster and to view those batches in Share Monitor.
Stage 2: Assigning Service Nodes
Use the following steps to assign service nodes to a cluster.
To add a service node to a cluster
1 If the Qmaster Service Browser is not already displayed, click the disclosure triangle to
see it.
Click this disclosure 
triangle to see
available nodes.
2 Add service nodes to the new cluster by dragging them from the Qmaster Service Browser
list at the bottom of the window to the cluster’s service nodes list.
If there is a closed lock icon next to a computer name, click the lock and enter the
password that was assigned to it in the Apple Qmaster Sharing window of Compressor.
Otherwise, you won’t be able to drag that service node to the cluster.
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Drag nodes to this
list from the Service
Browser list.
Clicking this disclosure triangle 
displays each instance of the 
services set in the Apple Qmaster 
Sharing window for this node.
Note: The computer names you see at the top level of the Name columns may appear
in one of three formats, depending on your configuration: the computer name (for
example, Lemur node), the Apple networking name (for example, Lemur-node.local), or
the network address for the computer (for example, 02030b-dhcp45.company.com).
3 When you have finished adding service nodes, click Apply.
Your cluster is now ready to process batches.
Note: Although Apple Qadministrator currently allows you to create a cluster with
unmanaged services, valid clusters require at least one managed service for the cluster
to be viewable in Apple Qmaster, Compressor, and Share Monitor.
Setting Up for Part-Time Distributed Processing with Shake
If you cannot consolidate all of the necessary source files (Shake scripts, media files, and
so on) on a single-cluster storage volume, follow the instructions below.
• Stage 1: Turning Off the Shake UNC Setting
• Stage 2: Turning On Personal File Sharing
• Stage 3: Mounting the Media Storage Volumes
• Stage 4: Submitting Processing Jobs in the Sample Part-Time Distributed Processing
Setup
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Stage 1: Turning Off the Shake UNC Setting
To make sharing and volume mounting work smoothly in this setup, you need to turn
off the Shake UNC setting on each computer. The UNC setting uses the entire file
pathname, with the network address, in a convention that starts with
//ComputerName/DriveName/path. You don’t want Shake to use this filenaming convention
because it conflicts with the file sharing and volume mounting used in this setup.
Note: All the media volumes should have the same name.
In the three steps below, you make this change in a Shake startup .h file. As described in
the Shake documentation, the startup .h files, located in the startup directory, are used
to customize Shake settings (similar to setting preferences).
To turn off the UNC setting, do the following on each of the computers
1 Log in as the user who will use Shake on the computer.
2 Double-click the Terminal icon in /Applications/Utilities/ to open a Terminal window.
3 Enter these two command lines in the Terminal window, pressing Return after each
command line:
mkdir -p ~/nreal/include/startup/
echo 'script.uncFileNames = 0;' > ~/nreal/include/startup/UNC_off.h
Stage 2: Turning On Personal File Sharing
On each computer, turn on Personal File Sharing. This allows the computers to share the
media volumes.
To turn on Personal File Sharing
1 Open System Preferences.
2 Click Sharing.
3 Select the File Sharing checkbox.
Stage 3: Mounting the Media Storage Volumes
Follow the instructions below so that all the computers in the cluster are mounting all
the media volumes in the cluster.
To mount the media storage volumes
1 On each computer, log in as the administrator. (The first user account you create when
you set up Mac OS X is an administrator account.)
2 On each computer in the group, use the Connect to Server command in the Finder’s Go
menu to mount each media volume.
3 Enter another computer’s name in the Connect to Server dialog.
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5 Repeat steps 1 through 4 until all the computers are mounting all the media volumes in
the cluster.
Stage 4: Submitting Processing Jobs in the Sample Part-Time Distributed
Processing Setup
After you finish Stage 3: Mounting the Media Storage Volumes, each one of these
computers can be used to submit jobs for distributed processing.
Because of the way access has been configured in Setting Up for Part-Time Distributed
Processing with Shake, all file pathnames are conveniently consistent and simple for the
purposes of specifying them in Compressor, in Shake scripts, and in Apple Qmaster,
assuming that:
• Users place the source media on a mounted media volume (one of the FireWire drives).
• Users place the Shake scripts on a mounted media volume.
• All folders and files on the shared media volumes have read-and-write access enabled
for everyone (for Owner, Group, and Others). You can configure this access setting by
selecting the folder or file and choosing File > Get Info.
These three assumptions are important because they ensure that all the computers have
read-and-write access to all the source files and output destinations.
Stage 5: Specifying Media File and Script Locations
The following additional configuration guidelines apply to anyone using Shake (or any
other UNIX-based rendering applications):
• Specifying the Media File Locations in Shake Scripts: As you follow the steps in Setting
Up for Part-Time Distributed Processing with Shake, all the Shake render scripts should
specify their source media (File In) locations and output (File Out) destinations as
/Volumes/MediaDiskName/ (for example, /Volumes/Media3/).
• Specifying Shake Script Locations in Apple Qmaster: As you follow the steps in Setting
Up for Part-Time Distributed Processing with Shake, all the Shake script locations should
be specified in Apple Qmaster as /Volumes/MediaDiskName/ScriptFilename (for example,
/Volumes/Media3/Script.shk).
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This appendix covers the following:
• General Compressor Keyboard Shortcuts (p. 387)
• Preview Window Keyboard Shortcuts (p. 388)
General Compressor Keyboard Shortcuts
Keyboard shortcut Function
Brings the History window to the front.
1
Brings the Preview window to the front.
2
Brings the Settings tab to the front.
3
Brings the Destinations tab to the front.
4
Closes the current window.
shift W
Show/hide the Batch window’s toolbar.
option T
Revert to the original window layout.
shift control U Opens the Preferences window.
,
Creates a new batch. The Batch Template Chooser appears unless
it has been disabled.
N
Creates a new batch with the Batch Template Chooser appearing,
even if it has been disabled.
shift N
Saves the current batch.
S
Saves the current batch as a new batch.
shift S
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Opens a saved batch.
O
Closes the current batch tab.
W
Saves the current batch as a new template.
option S
Imports a source asset to create a new job in the batch.
I Opens dialog to replace the source of the current job.
shift I
Creates a new surround sound group job in the batch.
control I
Creates a new image sequence job in the batch.
option I
Submits a batch from an open Droplet.
return
Removes a selected item from the Batch, Preview, or Destinations
window.
delete
Navigates up list items in the Batch, Destinations, Settings, and
Filters lists.
Navigates down list items in the Batch, Destinations, Settings, and
Filters lists.
Navigates through text fields in all panes.
tab
Opens the Mount Cluster Storage dialog.
shift M Opens Compressor Help.
shift
?
Preview Window Keyboard Shortcuts
Keyboard shortcut Function
Starts fast reverse motion.
J
Starts fast forward motion.
L Moves the clip backward frame by frame.
Moves the clip forward frame by frame.
Starts or stops clip playback.
space
Adds or removes a marker.
M
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When the playhead is positioned on a marker, opens the Edit Marker
dialog.
E
Sets an In point for the clip.
I
Sets an Out point for the clip.
O
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questions.
This appendix covers the following:
• Resources for Solving Problems (p. 391)
• Solutions to Common Problems (p. 391)
• Contacting AppleCare Support (p. 393)
Resources for Solving Problems
If you run into problems while working with Compressor, there are several resources you
can use to find a solution.
• This appendix: This appendix includes information about some of the most frequent
issues users encounter.
• Release Notes: The Release Notes document, available from the Help menu, provides
up-to-date information that didn’t make it into the manual. Be sure to consult this
document as soon as you install or upgrade Compressor.
• AppleCare Knowledge Base: AppleCare Support maintains a database of common support
issues that is updated and expanded to include new issues as they arise. This is an
excellent, free resource for Compressor users. To access the AppleCare Knowledge Base,
go to the AppleCare support page at http://www.apple.com/support.
• AppleCare Support: There are a variety of support options available to Compressor
customers. For more information, see the Apple service and support guide that was
included with your Compressor package.
Solutions to Common Problems
The following tips address some common issues.
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If you submit a reference movie for distributed processing, the Apple Qmaster distributed
processing system will automatically copy the appropriate media files to the processing
cluster. For the best performance, you can avoid this file transfer step by making sure
that the media files specified in the reference movie are available to each node of the
Apple Qmaster cluster. For more information, see How the Apple Qmaster System
Distributes Batches.
Cluster Settings for Extended Transcoding Sessions
If you anticipate a transcoding session that will last up to seven days or longer, you must
make an adjustment in the Advanced section of the Apple Qmaster preferences pane.
By default, temporary process files may remain on a cluster’s scratch location for seven
days before they are automatically deleted. You can increase this value (the number of
days) in the Apple Qmaster Sharing window of Compressor.
Cleaning Up Cluster Storage
If you are using cluster storage and an error occurs, partial files may be left on the
designated cluster storage location. Check the designated cluster storage location to
make sure no partial media files are left there. If you find partial media files, delete them
and submit the job again.
Using Apple Qmaster with an NFS Server
By default, Apple Qmaster uses /etc/exports to define its Cluster Storage export. This can
cause a conflict if you defined an NFS export in your local NetInfo database. When you
enable a controller using Apple Qmaster 2 or later, Apple Qmaster uses /etc/exports, not
entries defined in your NetInfo database. To work around this issue, either move the
exports to /etc/exports, or move the controller to a computer that doesn’t export anything.
Apple Qmaster Distributed Processing and Xsan
Here are some tips on using the Apple Qmaster distributed processing system with Xsan.
Restarting Apple Qmaster and Xsan
Using previous versions of Apple Qmaster distributed processing on an Xsan may cause
mounting problems when restarting an Apple Qmaster distributed processing cluster
controller.
Restart Apple Qmaster and Xsan computers in the following order
1 Turn off the cluster controller by deselecting “Share this computer” and clicking OK in
the Apple Qmaster Sharing window, opened by choosing Share This Computer from the
Apple Qmaster menu in Compressor.
2 Restart the Apple Qmaster cluster controller computer.
3 Wait for the Xsan volume to mount on the desktop.
392 Appendix B Solving Problems4 Select “Share this computer,” select either “as QuickCluster with services” or “as Services
and cluster controller,” then click OK in the Apple Qmaster Sharing window to restart the
controller.
Xsan Compatibility
Xsan 1.3 is not compatible with Compressor and the Apple Qmaster distributed processing
system when Xsan media drives are used for cluster (scratch) storage. To use Xsan with
Apple Qmaster 2.3, update to Xsan 1.4.
To download and install Xsan 1.4
µ Go to http://www.apple.com/support/xsan.
Compressor Command-Line Usage Requires Login
Although it is possible to use the command line to run an Apple Qmaster distributed
processing network, each Compressor service node (each computer providing Compressor
distributed processing services) must be logged in (with a Mac OS X user name and
password) for full functionality.
Contacting AppleCare Support
Information about the support options available from Apple can be found at the AppleCare
Support site at http://www.apple.com/support/compressor.
Whatever your issue, it’s a good idea to have the following information immediately
available when you contact Apple for support. The more of this information you have to
give to the support agents, the faster they will be able to address your issue.
• Detailed notes of the exact steps taken up to the point where the issue occurred. It’s
important to provide step-by-step instructions to support advisors so they can
understand and reproduce what you’re experiencing. Be sure to include the exact text
of any alert messages you see.
• The version of Mac OS X you have installed. This information can be viewed by choosing
About This Mac from the Apple menu.
• The version of Compressor you have installed, including updates if applicable. The
version number can be viewed by choosing Compressor > About Compressor.
• The model of computer you are using.
• The amount of RAM installed in your computer, and how much is available to
Compressor. You can find out how much RAM is installed by choosing About This Mac
from the Apple menu.
• The format and specifications of any media files (video, audio, or photo) that you are
working with, if applicable.
• What other third-party hardware is connected to or installed in the computer, and who
the manufacturers are. Include hard disks, graphics cards, and so on.
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• Have your computer serial number available when contacting support; the support
advisor will need your computer serial number to view your system profile. This
information can be viewed by choosing About This Mac from the Apple menu and
clicking More Info. Choose Send to Apple from the File menu in System Profiler to make
this information available to Apple.
AppleCare Support can be reached online at http://www.apple.com/support/compressor.
There is also an item in the Help menu that will take you directly to the AppleCare website.
To go to the AppleCare website from within Compressor
µ Choose Help > Service and Support.
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to run Compressor from the command line with minimal use of application interfaces,
this appendix is for you.
This appendix covers the following:
• Shell Commands for Submitting Compressor Jobs (p. 395)
Shell Commands for Submitting Compressor Jobs
You can run the Compressor application from the command line using the Compressor
command, with a number of command-line options for submitting jobs.
In the command-line descriptions below, angle brackets < > indicate a mandatory
argument in a command, and brackets [ ] indicate an optional argument.
Synopsis
Below is a synopsis of the command for submitting a job to a cluster. The Compressor
command is located in /Applications/Compressor.app/Contents/MacOS/.
Compressor [-clustername ][-clusterid 
] [-batchfilepath ] [-batchname
 ] [-priority ] [-jobpath ] [-settingpath ] 
[-destinationpath ] [-info ] [-timeout ] [-help] [-show]
In this example, -jobpath, -settingpath, and -destinationpath, in that order, can be
repeated as many times as the number of jobs you want to submit.
Note: Not all the options are necessary. For example, you can specify the cluster either
by its -clustername or by its -clusterid. You do not need to specify both. If both are
specified, only -clusterid is used.
Additionally, if you specify -batchfilepath, then -jobpath, -settingpath, and
-destinationpath are not necessary because the previously saved batch file already
contains information about the job, settings, and destination.
Example of -batchfilepath:
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"/Volumes/Hermione/SavedCompressorBatches/FreeChampagne.compressor"
Once the job is submitted successfully, this command displays the batch ID (identifier)
and job ID (identifier) in the shell, and you can monitor the progress of a batch in Share
Monitor.
Command Options
This table provides information about each of the command options for submitting jobs.
Submission command option Description
Use to specify the name of the cluster to which you want to send
the job. Using the cluster name, Compressor looks for the cluster
on the network in order to use it.
-clustername 
User password for the cluster specified by -clusterid or
-clustername.
-password 
Use to specify a name for the batch so that you can easily recognize
it in Share Monitor.
-batchname 
Optionally, you can use -clusterid to enter the cluster ID (IP
address) and port number instead of using -clustername. (When
you enter the cluster ID and port number, less time is required to
find the cluster on the network.) Enclose the IP address and port as
follows:
"tcp://:"
Also, if your cluster requires a password, you must supply a password
that is set for QuickClusters in the Apple Qmaster Sharing window
in Compressor, or for manually created clusters, in
Apple Qadministrator. The format is -clusterid
[username:password]@:. The
username is not checked, so it can be any username, but the
password must be valid. You can also use -password with
-clusterid as follows:
-clusterid @: -password
 Use Compressor -show to see a cluster’s ip address
and port number (clusterid).
-clusterid 
-priority  Specifies the priority level for a job.
-jobpath  Specifies the location of the source file.
-settingpath  Specifies the location of the settings for the job.
-destinationpath  Specifies the destination file URL for the job.
-info  Gives detailed information for a batch or a job.
Use to specify the number of seconds before Compressor can quit
when looking for a cluster. The default value is 30. A value of 0 puts
no limit on the time out and allows Compressor to browse the
network for as long as it needs to find the cluster.
-timeout 
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Shows the ID information for the cluster specified with
-clustername or -clusterid, or for all clusters if no cluster is
specified.
-show
Displays information regarding the required parameters for the
Compressor command.
-help
Example of Compressor Commands
Following are examples of code for submitting common Compressor commands.
Cluster Names and IDs on a Local Network
The following command lists all of the cluster names and IDs on the local network.
/Applications/Compressor.app/Contents/MacOS/Compressor -show -timeout 10
This command has the following elements:
• Identifies where Compressor is located (the quotation marks are used because of the
space in “Final Cut Pro”).
• Shows all cluster names and IDs found.
• Sets the command to time out after ten seconds.
Submit a Job with No Password
The following submits a job to a cluster identified by a name that does not have a
password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clustername MyCluster
 -batchname "My First Batch" -jobpath ~/Movies/MySource.mov -settingpath 
~/Library/Application\ Support/Compressor/Settings/MPEG-4.setting 
-destinationpath ~/Movies/MyOutput.mp4 -timeout 5
This command has the following elements:
• Identifies where Compressor is located.
• Sends this job to the cluster named MyCluster.
• Assigns the batch name My First Batch (the quotation marks are used because of the
spaces).
• Finds the MySource.mov file for the job at ~/Movies/MySource.mov.
• Uses the MPEG-4 setting at ~/Library/Application\
Support/Compressor/Settings/MPEG-4.setting (the “\” character is used in this case to
retain the space in “Application Support”).
• Writes the output file, named MyOutput.mp4, to the ~/Movies folder.
• Sets the command to time out after five seconds of looking for the cluster.
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The following submits a job to a cluster identified by a name that does have a password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clustername MyCluster
 -password testpassword -batchname "My First Batch" -jobpath 
~/Movies/MySource.mov -settingpath ~/Library/Application\ 
Support/Compressor/Settings/MPEG-4.setting -destinationpath 
~/Movies/MyOutput.mp4 -timeout 5
This command has the following elements:
• Identifies where Compressor is located.
• Sends this job to the cluster named MyCluster.
• Submits the password “testpassword.”
• Assigns the batch name My First Batch.
• Finds the MySource.mov file for the job at ~/Movies/MySource.mov.
• Uses the MPEG-4 setting at ~/Library/Application\
Support/Compressor/Settings/MPEG-4.setting.
• Writes the output file, named MyOutput.mp4, to the ~/Movies folder.
• Sets the command to time out after five seconds of looking for the cluster.
Submit a Job Using a Cluster ID and No Password
The following submits a job to a cluster identified by an IP address that does not have a
password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clusterid 
"tcp://192.168.1.148:62995" -batchname "My First Batch" -jobpath 
~/Movies/MySource.mov -settingpath ~/Library/Application\ 
Support/Compressor/Settings/MPEG-4.setting -destinationpath 
~/Movies/MyOutput.mp4 -timeout 5
This command has the following elements:
• Identifies where Compressor is located.
• Sends this job to the cluster with the IP address of tcp://192.168.1.148 at port 62995.
• Assigns the batch name My First Batch.
• Finds the MySource.mov file for the job at ~/Movies/MySource.mov.
• Uses the MPEG-4 setting at ~/Library/Application\
Support/Compressor/Settings/MPEG-4.setting.
• Writes the output file, named MyOutput.mp4, to the ~/Movies folder.
• Sets the command to time out after five seconds of looking for the cluster.
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The following submits a job to a cluster identified by an IP address, with a user name and
an inline password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clusterid 
"tcp://username:testpassword@192.168.1.148:62995" -batchname "My First Batch"
 -jobpath ~/Movies/MySource.mov -settingpath ~/Library/Application\ 
Support/Compressor/Settings/MPEG-4.setting -destinationpath 
~/Movies/MyOutput.mp4 -timeout 5
This command has the following elements:
• Identifies where Compressor is located.
• Sends this job as “username” with the pasword “testpassword” to the cluster with the
IP address of tcp://192.168.1.148 at port 62995.
• Assigns the batch name My First Batch.
• Finds the MySource.mov file for the job at ~/Movies/MySource.mov.
• Uses the MPEG-4 setting at ~/Library/Application\
Support/Compressor/Settings/MPEG-4.setting.
• Writes the output file, named MyOutput.mp4, to the ~/Movies folder.
• Sets the command to time out after five seconds of looking for the cluster.
Submit a Job Using a Cluster ID and a Password
The following submits a job to a cluster identified by an IP address using a password, but
does not specify a user name.
/Applications/Compressor.app/Contents/MacOS/Compressor -clusterid 
"tcp://192.168.1.148:62995" -password testpassword -batchname "My First 
Batch" -jobpath ~/Movies/MySource.mov -settingpath ~/Library/Application\ 
Support/Compressor/Settings/MPEG-4.setting -destinationpath 
~/Movies/MyOutput.mp4 -timeout 5
This command has the following elements:
• Identifies where Compressor is located.
• Sends this job to the cluster with the IP address of tcp://192.168.1.148 at port 62995
with the pasword “testpassword.”
• Assigns the batch name My First Batch.
• Finds the MySource.mov file for the job at ~/Movies/MySource.mov.
• Uses the MPEG-4 setting at ~/Library/Application\
Support/Compressor/Settings/MPEG-4.setting.
• Writes the output file, named MyOutput.mp4, to the ~/Movies folder.
• Sets the command to time out after five seconds of looking for the cluster.
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3
ContentsShare Monitor is an easy-to-use application for viewing or adjusting the status of batches
and jobs processed by Compressor, Apple Qmaster, Final Cut Pro, and Motion.
This preface covers the following:
• About Share Monitor (p. 5)
• About the Share Monitor Documentation (p. 5)
• Additional Resources (p. 6)
About Share Monitor
You use Share Monitor to monitor the transcoding progress of batches and jobs. You can
pause, resume, cancel, and get the status for any submitted batch or any individual job,
target, or target segment. You can also use Share Monitor to view detailed history for
recently completed batches and jobs.
Important: Share Monitor 4 is designed to work closely with Final Cut Pro X and later and
Motion 5 and later. All mentions of Final Cut Pro and Motion in this document refer to
these versions.
About the Share Monitor Documentation
The Share Monitor User Manual (this document) describes the Share Monitor application
only. For information about Compressor and how to create a complete network for
Apple Qmaster processing, see the Compressor User Manual, available in Compressor Help.
• Share Monitor User Manual: This brief document describes how to use Share Monitor
to monitor the transcoding progress of batches and jobs.
• Compressor User Manual: This is a comprehensive document that describes the
Compressor interface, commands, and menus and gives step-by-step instructions for
using Compressor and accomplishing specific tasks. It also explains how to set up and
maintain a distributed processing network for use with Compressor or digital visual
effects software packages. It is written for users of all levels of experience.
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Preface• Final Cut Pro Help: This document describes how to share your projects and use Share
Monitor to view the progress.
• Motion Help: This document describes how to share your projects and use Share Monitor
to view the progress.
Additional Resources
There are a variety of Apple websites that you can visit to find additional information.
Compressor Website
For general information and updates, as well as the latest news on Compressor, go to:
• http://www.apple.com/finalcutpro/compressor
Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage. You’ll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.
• http://www.apple.com/support
For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for Compressor, go to:
• http://www.apple.com/support/compressor
6 Preface Welcome to Share MonitorJust as Printer Setup Utility allows you to view print jobs submitted to a printer, Share
Monitor lets you view the status of batches submitted for processing. For example, Share
Monitor displays each batch’s name, details of where it originated, the percentage of
completion, and the estimated time before completion. Batches not yet running appear
as pending. Each batch, job, target, and target segment includes status information and
a progress bar, as well as buttons you can use to pause, resume, cancel, and get the status
of a transcode that is currently in progress.
Note: The most popular use of Share Monitor is viewing the progress of the Compressor
transcoding batches and Final Cut Pro or Motion sharing operations. By default, Share
Monitor does not automatically open when you submit a Compressor batch. To have
Share Monitor open automatically, in Compressor preferences, select “Automatically
launch Share Monitor.” See the Compressor User Manual for more information. Share
Monitor appears in the Dock when you start a share operation from either Final Cut Pro
or Motion.
This chapter covers the following:
• About the Share Monitor Main Window (p. 8)
• About the Info Window (p. 11)
• Viewing or Changing the Status of a Submitted Batch (p. 11)
• Share Monitor and Distributed Processing (p. 13)
• Share Monitor Preferences (p. 14)
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Using Share Monitor
1About the Share Monitor Main Window
Most of the Share Monitor controls are available in the Share Monitor main window.
Toolbar buttons User buttons Status buttons
Batch display
Cluster list
The Share Monitor main window includes the following sections:
General Interface
For details about the toolbar buttons and the batch display, see the next sections.
• Batch display: Provides a hierarchical display of batch, job, target, and segment
information for current and completed batches. Also includes controls to pause, resume,
cancel, and get status for any individual batch, job, target, or segment.
• Toolbar: Use the toolbar to adjust the display of items you are monitoring. See Toolbar
Buttons for details.
• Cluster list: Displays a list of computers available for processing batches, including “This
Computer” (the one using Share Monitor) and all enabled Apple Qmaster processing
clusters on your network. Select any cluster in the list to monitor its activity.
• User buttons: Click the Me button to display batches you submitted. Click All to display
all batches for the selected cluster. (For information about permissions and password
protection, see the “Apple Qmaster and Distributed Processing” chapter in the
Compressor User Manual.
• Status buttons: Click the Active button to display batches that the selected cluster is
currently processing. Click Completed to display batches that the selected cluster has
already completed. Click All to display all batches for the selected cluster.
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Share Monitor contains a toolbar with the following buttons that let you adjust the display
of batch status information.
Note: If the toolbar isn’t visible when you open Share Monitor, click the button in the
upper-right corner of the Batch window to open it.
• Refresh: Click Refresh to update the status of a selected cluster immediately, rather
than wait for the next update event.
• Expand All: Reveals all job, target, and segment information for every batch.
• Collapse All: Displays batch-level information only.
• Sort Order: Switches the batch list between descending and ascending order.
Batch Display
Batches, jobs, targets, and segments are displayed in hierarchical (nested) views. Each
view in the batch view hierarchy contains a disclosure triangle. Click the disclosure triangles
to reveal the next level of the hierarchy. For example, click the disclosure triangle in a
batch view to reveal the jobs contained within the batch, and click the disclosure triangle
in a job view to reveal the targets contained within the job.
Chapter 1 Using Share Monitor 9Note: Completed tasks appear in the same view area.
Job view
Batch view
Target view
Segment views
• Batch view: Displays the batch name, the number of jobs and targets contained within
the batch, the date and time on which the batch was submitted, the name of the user
who submitted the batch, and the status.
• Job view: Displays the name, the number of targets and segments contained within
the job, the input file type (displayed as an icon), and the status.
• Target view: Displays the type (displayed as an icon), the name, the number of segments
that the target has been broken down into, and the status.
• Segment view: When a batch is being processed using a cluster, this displays a
description (a time-based or frame-based description of the portion of the target being
processed), the machine name (service node that the segment is being processed on),
the status, and the machine type (displayed as an icon). Segment information is available
only while a batch is being processed.
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To get detailed information about any submitted batch, job, target, or segment, click its
Show Info button to open a window showing information for that item.
The window displays the full text of status messages on any batch, job, target, or segment,
such as Name, Submission Time, Owner, Time Elapsed, Time Remaining, Percent Complete,
and Status. Click the Show Log button to display text information on any batch, job,
target, or segment in a Console window. This information is useful for troubleshooting
distributed processing issues, and it can be saved to a file and processed with XML tools
and UNIX scripts.
The following table lists the service labels used in logs and email notifications.
Processing Notification
Local Compressor service servicecontroller:com.apple.stomp.transcoder
Distributed Compressor service servicecontroller:com.apple.stomp.transcoderx
Distributed Apple Qmaster servicecontroller:com.apple.qmaster.executor
service
Viewing or Changing the Status of a Submitted Batch
You open Share Monitor to see the status of a submitted batch and all the jobs contained
within it.
To open Share Monitor from Compressor
Do one of the following:
µ Click Share Monitor in the Batch window.
µ Select the “Automatically launch Share Monitor” preference to have Share Monitor open
each time you submit a batch.
To open Share Monitor from Apple Qmaster
µ Click Share Monitor in the toolbar.
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To open Share Monitor from Apple Qadministrator
µ Choose Cluster > Show Share Monitor.
To open Share Monitor from Final Cut Pro
Do one of the following:
µ Double-click Share Monitor in the Dock. Share Monitor appears in the Dock when you
submit a Share menu option, such as sharing a project to Apple Devices.
µ Open the Background Tasks window (choose Window > Background Tasks or press
Command-9) and click the Open button next to the Sharing item.
To open Share Monitor from Motion
Do one of the following:
µ Choose Share > Show Share Monitor.
µ Double-click Share Monitor in the Dock. Share Monitor appears in the Dock when you
submit a Share menu option, such as sharing a project to Apple Devices.
To use Share Monitor to view the status of your batch
1 Open Share Monitor.
2 Do any of the following to view the batch processing details and take any necessary
action.
• To reveal information about the component parts of a batch, job, or target: Click the
disclosure triangle next to the item name.
• To pause a job, batch, or target: Click the corresponding Pause/Resume button.
• To restart the processing for an item: Click the corresponding Pause/Resume button.
• To cancel a job, batch, or target: Click its Cancel button.
Click the disclosure triangle 
next to an item to reveal 
more information.
Pause/Resume
Show Info
Cancel
When the progress bar reaches 100 percent, your media file has been successfully
transcoded and saved in the designated destination folder. Completed batch and job
items are marked “Successful” and remain in the batch display. Unsuccessful batch and
job items are marked “Failed” and remain in the batch display.
12 Chapter 1 Using Share Monitor3 Click the Show Info button for any item in the batch display to view information about
that item.
4 Open the destination folder to view the newly transcoded output media file.
Share Monitor and Distributed Processing
If you have set up an Apple Qmaster distributed processing system to process Compressor,
Apple Qmaster, Final Cut Pro, and Motion jobs, Share Monitor will offer some additional
features. For example, both administrators and client users can use Share Monitor to
monitor the processing of submitted jobs. Administrators can stop or cancel any batch,
as long as they have the administrator password for the cluster that is processing the
batch, and users can stop or cancel their own batches.
Share Monitor and Passwords
There are different kinds of passwords that may affect how you use Share Monitor. For
more information, see the “Apple Qmaster and Distributed Processing” chapter in the
Compressor User Manual.
Administrator Password
If you create this password, administrators will need to know it in order to modify the
selected cluster and to view the selected cluster’s batches in Share Monitor. To create an
administrator password, click the Security tab in Apple Qadministrator.
User Password
If you create this password, users will need to know it in order to submit batches to the
selected cluster and to view those batches in Share Monitor. To create a user password,
click the Security tab in Apple Qadministrator.
Service Node Password
If you are setting up a QuickCluster, other users will be required to enter this password
before being allowed to submit remote requests to the computer.
If you are setting up a cluster to use with Apple Qadministrator, an administrator will be
required to enter this password before being allowed to add the computer to a cluster.
To create a service node password, select the “Require password” checkbox in the
Apple Qmaster Sharing window of Compressor.
Viewing or Changing Batch Status for Distributed Processing
Depending on how you open Share Monitor, the application may have slightly different
views, with different levels of control.
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1 Open Share Monitor in one of the following ways.
• Administrators who want to see or modify the status of batches: Choose Cluster > Show
Share Monitor when Apple Qadministrator is open.
• Users who want to see the status of batches and modify the status of their own batches: Use
the Share Monitor window that opens when you open it from Compressor,
Apple Qmaster, Final Cut Pro, or Motion. For more information, see Viewing or Changing
the Status of a Submitted Batch.
2 Choose the cluster whose activity you want to view from the Cluster list.
3 View the batch processing details and take any necessary action.
Note: Client users cannot modify other users’ batches. When they select a batch or job
submitted by another user, the Cancel and Pause/Resume buttons are not available.
For more details, see Setting Share Monitor Preferences and Viewing or Changing the
Status of a Submitted Batch.
Share Monitor Preferences
You can use the Share Monitor Preferences window to configure several aspects of Share
Monitor. Most of the information displayed in Share Monitor can be shown or hidden
using settings in Share Monitor preferences.
About the Share Monitor Preferences Window
The Share Monitor Preferences window includes the following view options and network
options:
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• Show Jobs: Select this checkbox to show job views (and target and segment views) in
the Share Monitor batch display.
• Show Targets: Select this checkbox to show target views (and segment views) in the
Share Monitor batch display.
• Show Segments: Select this checkbox to show segment views in the Share Monitor
batch display.
• Update status every # seconds field: Enter the number of seconds between updates
from processing computers to control how often Share Monitor information is updated.
The Status Interval setting in Apple Qadministrator cluster preferences takes precedence
over the update frequency setting in Share Monitor preferences. Share Monitor can
provide new status information only as often as it receives it from the cluster controller,
as set in the Status Interval field of the Apple Qadministrator Cluster Preferences window.
For more information, see “Setting Preferences” in the Apple Qadministrator User Manual.
Network Options
• Monitor non-Bonjour hosts table: This table displays information about remote host
computers.
• Add/Remove button: Use the button to add or remove information about remote host
computers.
Remote Computer Address Dialog
This dialog is displayed when you click the Add/Remove button in the main Preferences
window. Use this dialog to enter IP addresses or ranges for manually selected computers.
• Host/Host IP address range buttons: These buttons control whether this dialog is in IP
address mode (in which you enter a specific address) or IP address range mode (in
which you enter a range of addresses).
• Host: Use this mode to enter a host name and IP address for a specific remote
computer.
• Host IP address range: Use this mode to enter a name and set of range numbers
(Range From, Range To) for a range of remote IP addresses.
Setting Share Monitor Preferences
Use the Share Monitor Preferences window to configure several aspects of Share Monitor.
To set Share Monitor preferences
µ Choose Share Monitor > Preferences, or press Command-Comma (,).
The Share Monitor Preferences window opens.
Any changes you make to the Share Monitor preference settings take effect only when
you click OK. If you make changes but decide not to use them, click Cancel.
Chapter 1 Using Share Monitor 15
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Let’s get started
When you start your MacBook Pro for the first time, Setup Assistant launches 
to get you going. Follow a few simple steps to connect to your Wi-Fi network, 
transfer your stuff from another Mac or a PC, create a user account for your 
Mac, and log in with your Apple ID.
Your Apple ID lets you download apps from the App Store, shop the iTunes 
Store and the Apple Online Store, access iCloud, and communicate using 
FaceTime. If you don’t have an Apple ID, creating one is easy and free. 
Multi-Touch gestures
Many functions on your MacBook Pro can be performed using simple 
gestures on the trackpad. Here are some of the most popular Multi-Touch 
gestures for the Mac.
Get to know your desktop
Welcome to your new home base. The desktop contains the Dock, where 
icons of your frequently used apps appear. To customize your desktop and 
other settings on your Mac, click the System Preferences icon in the Dock. 
To access your files and folders, click the Finder icon. To check the status of 
your wireless Internet connection, click the Wi-Fi status icon in the menu bar. 
Your Mac automatically connects to the network you chose during setup. 
Hello.
Multi-Touch 
trackpad
MagSafe power 
connector
Power 
adapter
AC power 
cord
Power 
button
Click
Press down anywhere on the trackpad 
to click. Or, with Tap to Click enabled, 
simply tap the surface.
Secondary click (right click)
Click with two fingers to open shortcut 
menus. Or, with Tap to Click enabled, tap 
two fingers anywhere.
Swipe to navigate
Swipe with two fingers to flip through 
web pages, documents, and more. 
Double click
Press down two times anywhere on the 
trackpad. Or, with Tap to Click enabled, 
double-tap the surface.
Two-finger scroll
Brush two fingers along the trackpad 
to scroll in any direction—up, down, 
or sideways.
Smart zoom
Double-tap the trackpad with two 
fingers to quickly magnify a web page.
Pinch to zoom
Zoom in and out of photos and web 
pages more precisely by pinching your 
thumb and finger. 
Switch between full-screen apps
Swipe with three fingers to move 
from one full-screen app to another.
View Launchpad
Pinch with four fingers to view 
all your apps in Launchpad.
Rotate
Turn your thumb and finger clockwise 
or counterclockwise to rotate an image.
View Mission Control
Swipe up with three fingers to see 
every open window on your Mac.
Learn more
Choose System Preferences from the 
Apple menu and click Trackpad to learn 
more about gestures. 
iCloud
iCloud stores your music, photos, mail, and more and wirelessly pushes 
them to your Mac, iPhone, iPad, iPod touch, and even your PC. All without 
docking or syncing. So when you buy a song on one device, it’s automatically 
downloaded to all your others. And with Photo Stream, your latest photos 
appear everywhere you want to see them. To customize your iCloud settings, 
open the Apple menu, select System Preferences, then click iCloud. Sign 
in with your Apple ID and choose the iCloud features you want to enable 
or disable.
Important
Read this document and the safety information in the Important Product 
Information Guide carefully before you first use your computer.
Learn more
You can find more information, watch demos, and learn even more about 
MacBook Pro features at www.apple.com/macbookpro.
Help
You can often find answers to your questions, as well as instructions 
and troubleshooting information, in Help Center. Click the Finder icon, 
click Help in the menu bar, and choose Help Center. 
Mac OS X Utilities
If you have a problem with your Mac, Mac OS X Utilities can help you 
repair your computer’s drive, restore your software and data from a
 Time Machine backup, or erase your hard drive and reinstall OS X Lion 
and Apple applications. You can also use Safari to get online help. If your 
Mac detects a problem, it opens Mac OS X Utilities automatically. Or you 
can open it manually by restarting your computer while holding down 
the Command and R keys. 
Support
Your MacBook Pro comes with 90 days of technical support and one year 
of hardware repair warranty coverage at an Apple Retail Store or an Apple 
Authorized Service Provider. Visit www.apple.com/support/macbookpro
for technical support on MacBook Pro. Or call 1-800-275-2273. In Canada, 
call 1-800-263-3394.
Not all features are available in all areas.
TM and © 2012 Apple Inc. All rights reserved. Designed by Apple in California. Printed in XXXX.  
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Help 
menu
Menu bar
Finder Dock
System 
Preferences
Quick Start Guide
Let’s get moving
It’s easy to move files like documents, email, photos, music, and movies 
to your new Mac from another Mac or a PC. The first time you start your 
new Mac, it will walk you through the transfer process. All you have to do 
is follow the onscreen instructions.
Welcome to your new MacBook Pro. We’d like to show you around.
Battery indicator 
lights
Audio in/out
FireWire 800 Thunderbolt SDXC slot
MagSafe 
power
FaceTime HD camera
Security 
slot
Gigabit USB 3 SuperDrive
Ethernet
Wi-Fi 
status Click the icon in the Dock to open 
Safari, and surf the web using 
Multi-Touch gestures. Scroll up 
or down with two fingers on the 
trackpad. Swipe with two fingers 
on the trackpad to go back and 
Safari web browser Mail
Top Sites
Get a quick overview 
of the sites you visit 
most often.
One-stop email
View all your accounts in 
Mail for one-click access.
Conversation view
See all the email 
messages from a 
conversation thread.
Search
Quickly narrow search 
results to find exactly 
what you want.
Mail lets you manage all your 
email accounts from a single, 
ad-free inbox, even when you’re 
not connected to the Internet. It 
works with most email standards—
including POP3 and IMAP—and
forth between pages. Double-tap 
with two fingers to magnify a page, 
then double-tap again to return 
to the original size. Or pinch to 
zoom in and out.  
popular email services such as 
Gmail, Yahoo! Mail, and AOL Mail. 
The first time you open Mail, Setup 
Assistant will help you get started. 
You can also manage your mail 
from iCloud.
Launchpad
Open Launchpad
Click the Launchpad 
icon in the Dock.
Folders
Group apps in folders 
by dragging one app 
on top of another.
Launchpad is the home for all the 
apps on your Mac. Just click the 
Launchpad icon in the Dock. Your 
open windows are replaced by a 
full-screen display of all your apps. 
Arrange apps any way you want, 
group them together in folders, 
or delete them from your Mac. 
When you download an app from 
the Mac App Store, it automatically 
appears in Launchpad.
Mission Control
Mission Control gives you a 
bird’s-eye view of everything 
running on your Mac. Click the 
Mission Control icon in the Dock, 
and your desktop zooms out 
to display all the open windows 
in every application, all your 
full-screen apps, and Dashboard, 
the home of mini-apps called 
widgets. Click anything to zoom 
in on it. Think of Mission Control 
as the hub of your system—view 
everything and go anywhere with 
just a click.
Open Mission Control
Click the Mission Control 
icon in the Dock.
Add desktop spaces
Click the + button 
to the right of the top 
row to add a new space.
Dashboard
Located at 
the top left for 
easy access.
Reading List
Click the glasses icon to 
save pages to read later.
Mac App Store
The Mac App Store is the best way 
to find and download thousands of 
apps for your Mac, from games and 
social networking to productivity 
apps and more. New apps install 
in one step to Launchpad. You 
can install apps on every Mac 
authorized for your personal use 
and even download them again. 
The Mac App Store lets you know 
when app updates are available, 
so you always have the latest 
versions. Open the Mac App Store 
by clicking its icon in the Dock.
iTunes
iTunes organizes and plays your 
digital music and video on your Mac. 
The iTunes Store lets you buy new 
music, movies, TV shows, books, and 
more. iTunes is also where you’ll find 
the App Store for iPad, iPhone, and 
iPod touch. 
iTunes Store
Discover and buy new music, 
movies, and more.
Genius Mixes
Let iTunes search your music 
library and group songs that 
go great together.
iCal
Multiple calendars
Access all your calendars 
from one place.
Keep track of your busy schedule 
with iCal. You can create separate 
calendars—one for home, another 
for school, a third for work. See 
all your calendars in a single 
window or choose to see only 
the calendars you want. Create 
and send invitations using contact 
information from your Address Book, 
then see who has responded. Use 
iCloud to update calendars on all 
your devices automatically or share 
calendars with other iCloud users. 
iPhoto
Create
Create books, 
cards, and calendars.
Faces
iPhoto can even organize 
your photos based on 
who’s in them.
Events
Double-click any Event 
to browse photos.
iPhoto is the best way to organize, 
browse, edit, and share your photos 
on your Mac. You can organize your 
photo library by Faces, Places, and 
Events. To send photos by email 
or publish them to Facebook, just 
select the photo and click Share 
in the bottom right of your screen. 
Or click Create to turn your favorite 
shots into photo books, calendars, 
and cards.
iMovie
Event browser
Your imported videos 
appear here so you 
can access all your clips.
Project browser
Simply drop your 
selection in a project 
to create a great movie.
iMovie puts all your video clips 
in one place so you can quickly 
turn them into great-looking 
movies or even Hollywood-style 
movie trailers in just a few clicks. 
It has all the editing tools, themes, 
and special effects you need to 
turn your photos and videos into 
something amazing. And iMovie 
lets you import video from most 
popular digital video cameras, your 
iPhone, iPad, or iPod touch, or the 
FaceTime camera on your Mac.
FaceTime
FaceTime for Mac lets you talk face 
to face with anyone on an iPad, 
iPhone, iPod touch, or Mac—from 
your Mac.* To set up FaceTime on 
your Mac, all you need is your Apple 
ID and email address. To start a video 
call, click an entry in your Address 
Book contacts list. 
Favorites
Add your frequent contacts 
to Favorites for easy access.
*Requires FaceTime-enabled device for both caller and recipient. Not available in all areas.
Calendar view
Select the view you 
prefer—day, week, 
month, or year.
Full-screen view
Click the full-screen button 
to go full screen.
Always up to date
Updates to your purchased apps 
appear automatically.
Add an event
Double-click to 
create a new event.
Discover new apps
Browse thousands of 
apps and download them 
straight to Launchpad.
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iWork comporte plus de 250 fonctions permettant de 
simplifier les calculs statistiques, financiers, d’ingénierie et 
autres. Le navigateur des fonctions intégré permet de vous 
familiariser rapidement avec les fonctions et d’apprendre 
comment les ajouter à une formule.
Pour commencer, tapez simplement le signe égal dans une cellule de tableau vide 
pour ouvrir l’éditeur de formules. Choisissez ensuite Insérer > Fonction > Afficher le 
navigateur des fonctions.
Le présent guide de l’utilisateur contient des instructions détaillées destinées à vous 
aider à écrire des formules et à utiliser des fonctions. D’autres ressources viennent en 
outre compléter ce manuel.
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Aide à l’écran
L’aide à l’écran contient toutes les informations qui figurent dans ce manuel dans un 
format facilitant la recherche, toujours disponible sur votre ordinateur. Vous pouvez 
ouvrir l’aide sur les formules et fonctions d’iWork à partir du menu Aide de toute 
application iWork. Lorsque Numbers, Pages ou Keynote est ouvert, choisissez Aide > 
Aide sur les formules et fonctions d’iWork.
Site web d’iWork
Consultez les dernières actualités et informations concernant iWork à l’adresse 
www.apple.com/fr/iwork.
Site web d’assistance
Vous trouverez des informations détaillées sur la résolution de problèmes à l’adresse 
www.apple.com/fr/support/iwork.
Bulles d’aide
Les applications iWork disposent de bulles d’aide, de courtes descriptions, pour 
la plupart des éléments qui apparaissent à l’écran. Pour afficher une bulle d’aide, 
maintenez le pointeur sur un élément pendant quelques secondes.
Guides d’initiation vidéo en ligne
Les guides d’initiation vidéo en ligne que vous pouvez visionner à l’adresse 
www.apple.com/fr/iwork/tutorials expliquent comment réaliser certaines tâches dans 
Keynote, Numbers et Pages. La première fois que vous ouvrez une application iWork, 
un message reprenant un lien vers ces guides d’initiation sur le web apparaît. Vous 
pouvez visionner ces guides d’initiation vidéo à tout moment en choisissant, dans 
Keynote, Numbers et Pages, les menus Aide > Guides d’initiation vidéo.15
Le présent chapitre explique comment réaliser des calculs 
dans des cellules de tableau à l’aide de formules. 
Éléments des formules
Une formule réalise un calcul et affiche le résultat dans la cellule où vous avez placé la 
formule. Les cellules contenant des formules sont appelées cellules de formule. 
Par exemple, dans la dernière cellule d’une colonne, vous pouvez insérer une formule 
qui additionne les nombres des cellules situées au-dessus. En cas de modification de 
l’une des valeurs des cellules situées au-dessus de la cellule de formule, la somme 
affichée dans cette dernière est automatiquement actualisée. 
Une formule réalise des calculs d’après les valeurs que vous indiquez. Ces valeurs 
peuvent correspondre à des nombres ou du texte (des constantes) que vous tapez 
dans la formule. Il peut aussi s’agir de valeurs qui figurent dans des cellules de tableau 
que vous identifiez dans la formule à l’aide de références à des cellules. Les formules 
utilisent des opérateurs et des fonctions pour réaliser les calculs sur les valeurs que 
vous indiquez : 
Â Les opérateurs sont des symboles qui permettent de réaliser des opérations 
arithmétiques, de comparaison ou sur des chaînes. Dans les formules, les symboles 
servent à indiquer l’opération à réaliser. Par exemple, le symbole + additionne des 
valeurs, tandis que le symbole = compare deux valeurs pour déterminer si elles sont 
égales.
=A2 + 16 :  formule qui utilise un opérateur pour additionner deux valeurs.
= :  précède toujours une formule.
A2 :  référence à une cellule. A2 fait référence à la seconde cellule de la première 
colonne.
+ :  opérateur arithmétique qui additionne la valeur qui le précède et celle qui le 
suit.
16 :  constante numérique.
1
Utilisation de formules dans des 
tableauxÂ Tandis que les fonctions sont des opérations nommées et prédéfinies, telles que 
SOMME et MOYENNE. Pour utiliser une fonction, vous devez taper son nom puis les 
arguments dont la fonction a besoin entre parenthèses. Les arguments indiquent les 
valeurs que la fonction doit utiliser pour réaliser l’opération.
=SOMME(A2:A10) :  formule qui utilise la fonction SOMME pour additionner les 
valeurs d’une plage de cellules (neuf cellules de la première colonne).
A2:A10 :  référence aux valeurs des cellules A2 à A10.
Pour savoir comment  Aller à
Afficher instantanément la somme, la moyenne, la 
valeur minimale, la valeur maximale et le compte 
des valeurs appartenant à une sélection de 
cellules et, facultativement, enregistrer la formule 
utilisée pour obtenir ces valeurs dans Numbers
« Calculs instantanés dans Numbers » (page 17)
Ajouter rapidement une formule permettant 
d’afficher la somme, la moyenne, la valeur 
minimale, la valeur maximale, le compte ou le 
produit des valeurs d’une sélection de cellules
« Utilisation de formules rapides 
prédéfinies » (page 18)
Utiliser des outils et des techniques pour créer et 
modifier des formules dans Numbers
« Ajouter et modifier des formules à l’aide de 
l’éditeur de formules » (page 20)
« Ajouter et modifier des formules à l’aide de la 
barre des formules » (page 21)
« Ajout de fonctions à des formules » (page 22)
« Suppression de formules » (page 25)
Utiliser des outils et des techniques pour créer et 
modifier des formules dans Pages et Keynote
« Ajouter et modifier des formules à l’aide de 
l’éditeur de formules » (page 20)
Utiliser des centaines de fonctions iWork et 
consulter les exemples illustrant l’usage des 
fonctions dans le domaine financier, l’ingénierie, 
les statistiques et dans d’autres domaines
Aide > Aide sur les formules et fonctions d’iWork 
Aide > Guide de l’utilisateur des formules et 
fonctions d’iWork
Ajouter des références de cellules de différents 
types à une formule dans Numbers
« Référencement de cellules dans des 
formules » (page 26)
« Utilisation du clavier et de la souris pour créer 
et modifier des formules » (page 28)
« Distinction entre références absolues et 
relatives à des cellules » (page 29)
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Pour savoir comment  Aller à
Utiliser des opérateurs dans des formules « Opérateurs arithmétiques » (page 30)
« Opérateurs de comparaison » (page 31)
« Opérateur de chaîne et jokers » (page 32)
Copier ou déplacer des formules ou la valeur 
qu’elles calculent entre les cellules d’un tableau
« Copie ou déplacement de formules et de leurs 
valeurs calculées » (page 32)
Rechercher des formules et des éléments de 
formule dans Numbers
« Affichage de toute les formules d’une feuille de 
calcul » (page 33)
« Recherche et remplacement d’éléments de 
formule » (page 34)
Calculs instantanés dans Numbers
Les résultats des calculs les plus courants utilisant la valeur d’au moins deux cellules 
sélectionnées s’affichent dans la partie inférieure gauche de la fenêtre de Numbers.
Pour réaliser des calculs instantanés :
1 Sélectionnez au moins deux cellules du tableau. Elles ne doivent pas nécessairement 
être adjacentes.
Le résultat des calculs des valeurs de ces cellules s’affiche instantanément dans le coin 
inférieur gauche de la fenêtre.
Les résultats apparaissant en 
bas à gauche s’appuient sur 
les valeurs des deux cellules 
sélectionnées.
Somme :  affiche la somme des valeurs numériques d’une sélection de cellules.
moy :  affiche la moyenne des valeurs numériques d’une sélection de cellules.
min :  affiche la plus petite valeur numérique d’une sélection de cellules.
max :  affiche la plus grande valeur numérique d’une sélection de cellules.
Compte :  affiche le nombre de valeurs numériques ou de valeurs temporelles (date/
heure) d’une sélection de cellules.
Les cellules vides et celles qui contiennent des valeurs de types non répertoriés cidessus ne sont pas utilisées pour les calculs.
2 Pour réaliser une autre série de calculs instantanés, sélectionnez d’autres cellules.Si un calcul particulier s’avère très utile et que vous souhaitez l’intégrer dans un 
tableau, vous pouvez l’ajouter comme formule dans une cellule vide du tableau. 
Il suffit de faire glisser vers une cellule vide la somme, la moyenne ou tout autre 
élément se trouvant dans la partie inférieure gauche de la fenêtre. La cellule ne doit 
pas nécessairement se trouver dans le même tableau que les cellules utilisées dans les 
calculs.
Utilisation de formules rapides prédéfinies
Un moyen simple de réaliser un calcul de base de valeurs, situées dans un intervalle 
de cellules adjacentes dans un tableau, consiste à sélectionner les cellules puis à créer 
une formule rapide. Vous pouvez procéder simplement dans Numbers par le biais du 
menu local Fonction accessible dans la barre d’outils. Dans Keynote et Pages, ouvrez 
l’inspecteur Tableau, cliquez sur la sous-fenêtre Format, puis choisissez une formule 
dans le menu local Fonction.
Somme :  calcule la somme des valeurs numériques des cellules sélectionnées.
Moyenne :  calcule la moyenne des valeurs numériques des cellules sélectionnées.
Minimum :  détermine la plus petite valeur numérique des cellules sélectionnées.
Maximum :  détermine la plus grande valeur numérique des cellules sélectionnées.
Compte :  détermine le nombre de valeurs numériques ou de valeurs temporelles 
(date/heure) d’une sélection de cellules.
Produit :  multiplie toutes les valeurs numériques des cellules sélectionnées.
Vous pouvez également choisir Insertion > Fonction et utiliser le sous-menu qui 
apparaît.
Les cellules vides et celles qui contiennent des types de valeurs non répertoriés sont 
ignorées.
Voici quelques méthodes permettant d’ajouter une formule rapide :
m Utilisation de valeurs sélectionnées dans une colonne ou une rangée et sélection des 
cellules Dans Numbers, cliquez sur Fonction dans la barre d’outils et choisissez un 
calcul dans le menu local. Dans Keynote ou Pages, choisissez Insertion > Fonction et 
utilisez le sous-menu qui apparaît.
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Si les cellules se trouvent dans la même colonne, le résultat se voit placé dans la 
première cellule vide située sous les cellules sélectionnées. Si aucune cellule n’est vide, 
un rang où le résultat doit apparaître est ajouté. Vous pouvez cliquer sur la cellule pour 
afficher la formule.
Si les cellules se trouvent dans la même rangée, le résultat se voit placé dans la 
première cellule vide située à droite des cellules sélectionnées. Si aucune cellule n’est 
vide, une colonne où le résultat doit apparaître est ajoutée. Vous pouvez cliquer sur la 
cellule pour afficher la formule.
m Pour utiliser toutes les valeurs issues des cellules du corps d’une colonne, cliquez 
tout d’abord sur la cellule d’en-tête ou sur l’onglet de référence de la colonne. Dans 
Numbers, cliquez ensuite sur Fonction dans la barre d’outils et choisissez un calcul 
dans le menu local. Dans Keynote ou Pages, choisissez Insertion > Fonction et utilisez 
le sous-menu qui apparaît.
Le résultat se voit alors placé dans un rang de bas de tableau. Si le rang de bas de 
tableau n’existe pas, un est alors ajouté. Vous pouvez cliquer sur la cellule pour afficher 
la formule.
m Pour utiliser toutes  les valeurs d’un rang, cliquez tout d’abord sur la cellule d’en-tête 
ou sur l’onglet de référence de ce rang. Dans Numbers, cliquez ensuite sur Fonction 
dans la barre d’outils et choisissez un calcul dans le menu local. Dans Keynote ou 
Pages, choisissez Insertion > Fonction et utilisez le sous-menu qui apparaît.
Le résultat se voit alors placé dans une nouvelle colonne. Vous pouvez cliquer sur la 
cellule pour afficher la formule.
Création de formules personnalisées
Bien qu’il soit possible d’utiliser plusieurs techniques rapides pour ajouter des formules 
permettant d’effectuer des calculs simples (voir « Calculs instantanés dans Numbers » à 
la page 17 et « Utilisation de formules rapides prédéfinies » à la page 18), les outils 
consacrés aux formules vous procurent plus de contrôle pour insérer vos formules. 
Pour savoir comment  Aller à
Utiliser l’éditeur de formules pour manipuler une 
formule
« Ajouter et modifier des formules à l’aide de 
l’éditeur de formules » (page 20)
Utiliser la barre de formules redimensionnable 
pour manipuler des formules dans Numbers
« Ajouter et modifier des formules à l’aide de la 
barre des formules » (page 21)
Utiliser le navigateur des fonctions pour ajouter 
rapidement des fonctions à des formules lors de 
l’utilisation de l’éditeur de formules ou de la barre 
des formules
« Ajout de fonctions à des formules » (page 22)
Détecter une formule erronée « Gestion des erreurs et des avertissements dans 
les formules » (page 25)Ajouter et modifier des formules à l’aide de l’éditeur de formules
Vous pouvez également faire appel à l’éditeur de formules pour modifier une formule 
directement depuis la barre des formules (reportez-vous à la rubrique « Ajouter et 
modifier des formules à l’aide de la barre des formules » à la page 21). L’éditeur de 
formules possède un champ de texte contenant votre formule. Au fur et à mesure 
que vous ajoutez des références à des cellules, des opérateurs, des fonctions ou des 
constantes à une formule, ces éléments apparaissent de la manière suivante dans 
l’éditeur de formules.
Toutes les formules 
doivent commencer par 
le signe égal. Fonction Somme.
Références aux cellules 
d’après leur nom.
Référence à une plage de 
trois cellules.
Opérateur de 
soustraction.
Voici plusieurs manières d’utiliser l’éditeur de formules :
m Pour ouvrir l’éditeur de formules, effectuez l’une des opérations suivantes : 
Â Sélectionnez une cellule du tableau, puis saisissez le signe égal (=). 
Â Dans Numbers, double-cliquez sur une cellule contenant une formule. Dans Keynote 
et Pages, sélectionnez le tableau, puis double-cliquez sur une cellule contenant une 
formule.
Â Dans Numbers uniquement, sélectionnez une cellule d’un tableau, cliquez sur 
Fonction dans la barre d’outils, puis choisissez Éditeur de formules dans le menu 
local.
Â Uniquement proposé dans Numbers, sélectionnez une cellule, puis choisissez Insérer 
> Fonction > Éditeur de formules. Dans Keynote et Pages, activez l’inspecteur des 
tableaux, choisissez la sous-fenêtre Format, puis sélectionnez Éditeur de formules 
dans le menu local Fonction.
Â Sélectionnez une cellule contenant une formule et appuyez sur Option + Retour.
L’éditeur de formules s’ouvre en avant-plan de la cellule sélectionnée, mais vous 
pouvez le déplacer.
m Pour déplacer l’éditeur de formules, maintenez le pointeur au-dessus du côté gauche 
de l’éditeur de formules jusqu’à ce qu’une main soit représentée, puis faites-le glisser 
l’éditeur.
m Pour élaborer votre formule, procédez comme suit :
Â Pour ajouter un opérateur ou une constante au champ, placez le point d’insertion 
et tapez. Vous pouvez utiliser les touches fléchées pour déplacer le point d’insertion 
dans le champ de texte. Pour découvrir quels sont les opérateurs que vous pouvez 
utiliser, consultez la rubrique « Utilisation d’opérateurs dans les formules » à la 
page 30.
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Remarque :  Lorsque votre formule ne comprenant pas d’opérateur en nécessite un, 
l’opérateur + est inséré automatiquement. Sélectionnez-le et tapez-en un autre au 
besoin. 
Â Pour ajouter des références de cellule au champ de texte, placez le point d’insertion, 
puis suivez les instructions données à la rubrique « Référencement de cellules dans 
des formules » à la page 26.
Â Pour ajouter des fonctions au champ de texte, placez le point d’insertion, puis suivez 
les instructions données à la rubrique « Ajout de fonctions à des formules » à la 
page 22.
m Pour supprimer un élément du champ, sélectionnez-le, puis appuyez sur la touche 
Suppr.
m Pour accepter les modifications, appuyez sur Retour, appuyez sur Entrée ou cliquez sur 
le bouton Accepter de l’éditeur de formules. Vous pouvez aussi cliquer à l’extérieur du 
tableau.
Pour fermer l’éditeur de formules sans confirmer les modifications effectuées, appuyez 
sur la touche Échap ou cliquez sur le bouton Annuler dans l’éditeur de formules.
Ajouter et modifier des formules à l’aide de la barre des formules
Dans Numbers, la barre des formules située sous la barre des formats vous permet 
de créer et de modifier des formules pour la cellule sélectionnée. Les références de 
cellule, les opérateurs, les fonctions et les constantes que vous ajoutez à une formule 
apparaissent comme suit. 
Référence à une  Opérateur de soustraction.
plage de trois 
cellules.
Références aux cellules 
Fonction Somme. d’après leur nom.
Toutes les formules 
doivent commencer par 
le signe égal.
Voici plusieurs manières d’utiliser la barre des formules :
m Pour ajouter ou modifier une formule, sélectionnez la cellule et ajoutez ou modifiez 
des éléments de la formule à partir de la barre des formules. 
m Pour ajouter des éléments à votre formule, procédez comme suit :
Â Pour ajouter un opérateur ou une constante, placez le point d’insertion dans la barre 
des formules et tapez. Vous pouvez utiliser les touches fléchées pour déplacer le 
point d’insertion. Pour découvrir quels sont les opérateurs que vous pouvez utiliser, 
consultez la rubrique « Utilisation d’opérateurs dans les formules » à la page 30.
Lorsque votre formule ne comprenant pas d’opérateur en nécessite un, l’opérateur 
+ est inséré automatiquement. Sélectionnez-le et tapez-en un autre au besoin.Â Pour ajouter des références de cellule à la formule, placez le point d’insertion, puis 
suivez les instructions données à la rubrique « Référencement de cellules dans des 
formules » à la page 26.
Â Pour ajouter des fonctions à la formule, placez le point d’insertion, puis suivez 
les instructions données à la rubrique « Ajout de fonctions à des formules » à la 
page 22.
m Pour augmenter ou réduire la taille d’affichage des éléments dans la barre des 
formules, choisissez une option dans le menu local Taille du texte des formules situé 
au-dessus de la barre des formules.
Pour augmenter ou réduire la hauteur de la barre des formules, faites glisser 
verticalement le contrôle de redimensionnement complètement à droite de la barre 
des formules, ou double-cliquez sur ce contrôle pour qu’il adapte automatiquement 
ses dimensions à la formule.
m Pour supprimer un élément de la formule, sélectionnez-le, puis appuyez sur la touche 
Suppr.
m Pour enregistrer les modifications, appuyez sur Retour, appuyez sur Entrée ou cliquez 
sur le bouton Accepter situé au-dessus de la barre des formules. Vous pouvez aussi 
cliquer à l’extérieur de la barre des formules.
Pour ne pas enregistrer les modifications, cliquez sur le bouton Annuler situé audessus de la barre des formules.
Ajout de fonctions à des formules
Une fonction est une opération prédéfinie qui porte un nom (comme SOMME et 
MOYENNE) qui permet de réaliser un calcul. Une fonction peut constituer soit l’un des 
éléments d’une formule, soit le seul élément d’une formule. 
Il existe plusieurs catégories de fonctions, allant des fonctions financières permettant 
de calculer des taux d’intérêt, des valeurs pour l’investissement et autres données, 
aux fonctions statistiques qui calculent des moyennes, des probabilités, des écartstypes, etc. Pour en savoir plus sur toutes les catégories de fonctions d’iWork et pour 
consulter de nombreux exemples illustrant leur utilisation, choisissez Aide > Aide 
sur les formules et fonctions d’iWork ou Aide > Guide de l’utilisateur des formules et 
fonctions d’iWork.« Introduction aux fonctions » :
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Bien que vous puissiez taper une fonction dans le champ de texte de l’éditeur de 
formules ou dans la barre des formules (dans Numbers uniquement), le navigateur des 
fonctions constitue un moyen plus pratique d’ajouter une fonction à une formule.
Sélectionnez une 
fonction pour 
consulter les 
informations qui s’y 
rapportent.
Recherchez une fonction.
Insérez la fonction sélectionnée.
Sélectionnez une 
catégorie pour 
retrouver les fonctions 
qui en font partie.
Sous-fenêtre de gauche :  répertorie les catégories de fonctions. Sélectionnez une 
catégorie pour connaître les fonctions qu’elle regroupe. La plupart des catégories 
représentent des familles de fonctions connexes. La catégorie Tous reprend toutes les 
fonctions par ordre alphabétique. La catégorie Récent affiche la liste des dix dernières 
fonctions insérées à l’aide du navigateur des fonctions.
Sous-fenêtre de droite :  affiche les différentes fonctions. Sélectionnez une fonction 
pour afficher des informations sur cette dernière et, le cas échéant, pour l’ajouter à une 
formule.
Sous-fenêtre du bas :  affiche des informations détaillées sur la fonction sélectionnée.
Pour ajouter une fonction à l’aide du navigateur des fonctions :
1 Dans l’éditeur de formules ou la barre de formules (disponible dans Numbers 
seulement), placez le point d’insertion à l’endroit où vous souhaitez ajouter la fonction. 
Remarque :  Lorsque votre formule ne comprenant pas d’opérateur avant ou après une 
fonction en nécessite un, l’opérateur + est inséré automatiquement. Sélectionnez-le et 
tapez-en un autre au besoin. 2 Dans Pages ou Keynote, choisissez Insérer > Fonction > Afficher le navigateur des 
fonctions, pour ouvrir le navigateur des fonctions. Dans Numbers, ouvrez le navigateur 
des fonctions en effectuant l’une des opérations suivantes : 
Â Cliquez sur le bouton Navigateur des fonctions dans la barre des formules.
Â Cliquez sur le bouton Fonction sur la barre d’outils, puis choisissez Afficher le 
navigateur des fonctions.
Â Sélectionnez Insérer > Fonction > Afficher le navigateur des fonctions. 
Â Choisissez Présentation > Afficher le navigateur des fonctions.
3 Sélectionnez une catégorie de fonctions.
4 Indiquez la fonction de votre choix en double-cliquant dessus ou en la sélectionnant 
puis en cliquant sur Insérer une fonction.
5 Dans l’éditeur de formules ou la barre des formules (disponible dans Numbers 
uniquement), remplacez chaque paramètre fictif de la fonction insérée par une valeur.
Aide relative à l’argument « émission » 
qui s’affiche lorsque le pointeur de la 
souris est placé sur le paramètre fictif.
Les paramètres fictifs 
correspondant aux arguments 
facultatifs sont en gris clair.
Cliquez ici pour retrouver la liste 
des valeurs possibles.
Pour afficher une brève description de la valeur d’un argument :  Maintenez le 
pointeur sur le paramètre fictif de l’argument. Vous pouvez aussi faire référence à des 
informations sur l’argument dans la fenêtre Navigateur des fonctions.
Pour indiquer la valeur devant remplacer le paramètre fictif d’un argument :  Cliquez 
sur l’argument fictif, puis saisissez une constante ou insérez une référence de cellule 
(pour obtenir des instructions, consultez la rubrique « Référencement de cellules dans 
des formules » à la page 26). Si l’endroit réservé à l’argument est affiché en gris clair, la 
saisie d’une valeur est facultative.
Pour indiquer la valeur remplaçant le paramètre fictif d’un argument doté d’un 
triangle d’affichage :  Cliquez sur le triangle d’affichage, puis choisissez une valeur 
dans le menu local. Pour consulter les informations sur une valeur du menu local, 
maintenez le pointeur sur la valeur. Pour accéder à l’aide sur la fonction, sélectionnez 
Aide Fonction.
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Gestion des erreurs et des avertissements dans les formules
Lorsque la formule d’une cellule de tableau est incomplète, qu’elle reprend des 
références des cellules non valides ou contient toute autre erreur, ou lorsqu’une 
opération d’importation génère une erreur de condition dans une cellule, Number 
ou Pages affiche une icône dans la cellule. Un triangle bleu dans la partie supérieure 
gauche d’une cellule affiche des alertes. Un triangle rouge au milieu d’une cellule 
indique une erreur provoquée par une formule.
Pour afficher les messages des avertissements et des erreurs :
m Cliquez sur l’icône.
Un message récapitule chaque erreur et chaque avertissement associés à la cellule.
Pour que Numbers génère un avertissement lorsqu’une cellule référencée dans une 
formule est vide, cliquez sur Numbers > Préférences, puis sélectionnez « Afficher les 
avertissements lorsque les formules réfèrent à des cellules vides » dans la sous-fenêtre 
Général. Cette option n’est pas proposée ni dans Keynote, ni dans Pages.
Suppression de formules
Si vous souhaitez ne plus utiliser de formule associée à une cellule, vous pouvez la 
supprimer rapidement.
Pour supprimer une formule d’une cellule :
1 Sélectionnez la cellule.
2 Appuyez ensuite sur la touche Suppr.
Dans Numbers, si vous voulez passer en revue les formules d’une feuille de calcul et 
choisir celles à supprimer, sélectionnez Présentation > Afficher la liste des formules.Référencement de cellules dans des formules
Tous les tableaux possèdent des onglets de référence. Ceux-ci correspondent au 
numéro des rangs et à l’en-tête des colonnes. Dans Numbers, ils sont visibles à tout 
moment lorsque le tableau est actif, par exemple, quand une cellule du tableau est 
sélectionnée. Dans Keynote et Pages, les onglets de référence apparaissent seulement 
lorsque la formule d’une cellule est sélectionnée. Dans Numbers, les onglets de 
référence ressemblent à ce qui suit :
Un onglet de référence se représente sous forme d’une zone grise située au-dessus de 
chaque colonne ou à gauche de chaque rangée, contenant respectivement la lettre 
de la colonne (par exemple, « A ») ou le numéro de la rangée (par exemple, « 3 »). 
L’apparence des onglets de référence dans Keynote et Pages est semblable à celle 
dans Numbers.
Vous pouvez faire appel aux références à des cellules pour identifier dont vous voulez 
utiliser les valeurs dans des formules. Dans Numbers, les cellules peuvent se trouver 
dans le même tableau que la cellule de la formule, dans un autre tableau situé sur la 
même feuille ou sur une autre feuille.
Les références de cellule présentent des formats différents selon que le tableau de la 
cellule possède des en-têtes, selon que vous faites référence à une seule cellule ou 
à un intervalle de cellules, etc. Voici un résumé des formats que vous pouvez utiliser 
pour les références de cellule. 
Pour faire référence à Utilisez le format Exemple
Une cellule du tableau qui 
contient la formule
La lettre de l’onglet de référence 
suivie par le numéro de l’onglet 
de référence de la cellule
C55 fait référence au 55
ème
 rang 
de la troisième colonne.
Une cellule pourvu d’un entête de rang et d’un en-tête de 
colonne 
Le nom de la colonne suivi du 
nom du rang
Produits 2006 fait référence à 
une cellule dont l’en-tête de 
rang contient Produits et dont 
l’en-tête de colonne contient 
2006.
Une cellule pourvue de 
plusieurs en-têtes de rang ou de 
colonne
Le nom de l’en-tête dont vous 
voulez faire référence aux 
colonnes ou aux rangs
Si 2006 correspond à un en-tête 
qui court sur deux colonnes 
(Produits et Charges), 2006 fait 
référence à toutes les cellules 
des colonnes Produits et 
Charges.
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Pour faire référence à Utilisez le format Exemple
Un intervalle de cellules Un signe deux-points (:) entre 
la première et la dernière 
cellule de l’intervalle en utilisant 
la notation des onglets de 
référence pour identifier les 
cellules
B2:B5 fait référence à quatre 
cellules de la seconde colonne. 
Toutes les cellules d’un rang Le nom du rang, ou numéro-durang:numéro-du-rang
1:1 fait référence à toutes les 
cellules du premier rang.
Toutes les cellules d’une 
colonne
La lettre ou le nom de la 
colonne 
C fait référence à toutes les 
cellules de la troisième colonne.
Toutes les cellules d’un intervalle 
de rangs
Un signe deux-points (:) entre le 
numéro ou le nom des premier 
et dernier rangs de l’intervalle
2:6 fait référence à toutes les 
cellules de cinq rangs. 
Toutes les cellules d’un intervalle 
de colonnes
Un signe deux-points (:) entre la 
lettre ou le nom des première et 
dernière colonnes de l’intervalle
B:C fait référence à toutes 
les cellules des seconde et 
troisième colonnes.
Dans Numbers, une cellule 
située dans un autre tableau de 
la même feuille
Si le nom de la cellule est 
unique dans la feuille de calcul, 
seul le nom est requis ; dans le 
cas contraire, le nom du tableau 
suivi de deux symboles deuxpoints (::) puis de l’identifiant de 
la cellule doivent être précisés
Tableau 2::B5 fait référence à la 
cellule B5 du tableau intitulé 
Tableau 2. Tableau 2::Inscriptions 
2006 fait référence à une cellule 
par son nom.
Dans Numbers, une cellule 
située dans un tableau qui se 
trouve dans une autre feuille
Si le nom de la cellule est 
unique dans la feuille de calcul, 
seul le nom est requis ; dans 
le cas contraire, le nom de la 
feuille suivi de deux symboles 
deux-points (::), puis du nom 
du tableau, de deux symboles 
deux-points supplémentaires et 
enfin de l’identifiant de la cellule 
doivent être précisés
Feuille 2::Tableau 2::Droit 
d’inscription 2006 fait référence 
à une cellule située dans un 
tableau intitulé Tableau 2 qui se 
trouve dans la feuille portant le 
nom de Feuille 2.
Dans Numbers, vous pouvez ignorer le nom d’un tableau ou d’une feuille si les cellules 
référencées ont des noms uniques dans la feuille de calcul.
Dans Numbers, en faisant référence à une cellule dans un en-tête couvrant plusieurs 
rangs ou plusieurs colonnes, le comportement suivant s’applique :
Â Le nom dans la cellule d’en-tête la plus proche de la cellule qui y fait référence est 
utilisé. Par exemple, si un tableau possède deux rangs d’en-tête, que B1 contient 
« Chien » et B2 contient « Chat », lorsque vous enregistrez une formule utilisant « 
Chien », « Chat » est enregistré à la place de « Chien ».
Â Toutefois, si « Chat » apparaît dans une autre cellule d’en-tête de la feuille de calcul, 
c’est « Chien » qui est retenu.Pour savoir comment insérer des références de cellule dans une formule, reportez-vous 
à la rubrique suivante « Utilisation du clavier et de la souris pour créer et modifier des 
formules ». Pour en savoir plus sur la différence entre références de cellule absolues 
et relatives, éléments importants si vous souhaitez copier ou déplacer des formules, 
consultez la rubrique « Distinction entre références absolues et relatives à des 
cellules » à la page 29. 
Utilisation du clavier et de la souris pour créer et modifier des 
formules
Vous pouvez saisir manuellement des références de cellule dans une formule ou les 
insérer à l’aide de la souris ou de raccourcis clavier.
Il existe plusieurs manières d’insérer des références à des cellules :
m Pour utiliser un raccourci clavier pour saisir la référence à une cellule, placez le point 
d’insertion dans l’éditeur de formules ou la barre des formules (Numbers uniquement) 
et effectuez l’une des opérations suivantes : 
Â Pour faire référence à une seule cellule, appuyez sur la touche Option et les touches 
fléchées simultanément pour sélectionner la cellule.
Â Pour faire référence à un intervalle de cellules, appuyez sur les touches Maj + Option 
et maintenez-les enfoncées après avoir sélectionné la première cellule de l’intervalle 
jusqu’à ce que la dernière cellule de l’intervalle soit atteinte.
Â Pour faire référence dans Numbers à des cellules situées dans un autre tableau 
d’une feuille quelconque, sélectionnez le tableau en appuyant sur les touches 
Option + Commande + Pg suiv pour descendre dans les tableaux ou sur Option + 
Commande + Pg préc pour monter. Le tableau voulu sélectionné, maintenez 
toujours la touche Option enfoncée, relâchez seulement la touche Commande, puis 
utilisez les touches fléchées pour sélectionner la cellule ou l’intervalle de cellules 
voulu (dans le cas d’un intervalle, l’utilisez Maj + Option).
Â Pour indiquer des attributs absolus et relatifs pour la référence à une cellule après 
l’avoir insérée, cliquez sur cette dernière et appuyez sur Commande + K pour passer 
d’option à l’autre. Consultez la rubrique « Distinction entre références absolues et 
relatives à des cellules » à la page 29 pour en savoir plus.
m Pour utiliser la souris pour saisir la référence à une cellule, placez le point d’insertion 
dans l’éditeur de formules ou la barre des formules (Numbers uniquement) et 
effectuez l’une des opérations suivantes dans le même tableau que la cellule de 
formule ou, dans Numbers uniquement, dans un tableau d’une feuille quelconque : 
Â Pour faire référence à une seule cellule, cliquez sur la cellule.
Â Pour faire référence à toutes les cellules d’une colonne ou d’un rang, cliquez sur 
l’onglet de référence de la colonne ou du rang.
Â Pour faire référence à un intervalle de cellules, cliquez sur une cellule de l’intervalle, 
puis faites glisser le curseur pour délimiter l’intervalle des cellules. 
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Â Pour spécifier des attributs absolus et relatifs d'une référence de cellule, cliquez sur 
le triangle d'affichage de la référence saisie et sélectionnez une option dans le menu 
local. Consultez la rubrique « Distinction entre références absolues et relatives à des 
cellules » à la page 29 pour en savoir plus.
Dans Numbers, la référence insérée utilise des noms plutôt que la notation par 
onglets de référence sauf si la case « Utiliser les noms des cellules d’en-tête comme 
références » est décochée dans la sous-fenêtre Général des préférences de Numbers. 
Dans Keynote et Pages, la référence insérée utilise des noms plutôt que la notation par 
onglets de référence si les cellules référencées possèdent des en-têtes.
m Pour taper la référence à une cellule, placez le point d’insertion dans l’éditeur de 
formules ou la barre des formules (Numbers uniquement), puis saisissez la référence 
en suivant l’un des formats cités dans « Référencement de cellules dans des 
formules » à la page 26.
 Lorsque vous tapez la référence d’une cellule contenant le nom d’une cellule d’entête (technique commune à toutes les applications), le nom d’un tableau (Numbers 
uniquement) ou d’une feuille (Numbers uniquement), et ce à partir du troisième 
caractère, une liste de suggestions apparaît si les caractères que vous avez tapés 
correspondent à un ou plusieurs des noms qui figurent dans votre feuille de calcul. 
Vous pouvez sélectionner une suggestion de la liste ou continuer à taper au clavier. 
Pour désactiver la suggestion de noms dans Numbers, choisissez Numbers > 
Préférences, puis décochez la case « Utiliser les noms des cellules d’en-tête comme 
références » dans la sous-fenêtre Général.
Distinction entre références absolues et relatives à des cellules
Utilisez des formes absolues et relatives de référence de cellule pour indiquer la cellule 
vers laquelle la référence doit renvoyer si vous copiez ou déplacez sa formule.
Si une référence est relative (A1) :  Elle ne change pas lorsque sa formule est déplacée. 
Par contre, si la formule est coupée ou copiée, puis collée, la référence de cellule 
change afin de conserver la même position relative par rapport à la cellule contenant 
la formule. Par exemple, si une formule contient A1 dans la cellule C4 et que vous 
copiez la formule et la collez en C5, la référence à la cellule dans C5 devient A2. 
Si les composants de rang et de colonne d’une référence sont absolus ($A$1) :  La 
référence à la cellule ne change pas lorsque la formule est copiée. Utilisez le signe 
dollar ($) pour rendre un composant de rang ou de colonne absolu. Par exemple, si 
une formule contenant $A$1 se trouve dans C4 et si vous copiez la formule et la collez 
dans la cellule C5 ou dans D5, la référence indiquée dans C5 ou D5 reste $A$1.
Si le composant de rang d’une référence est absolu (A$1) :  Le composant de 
colonne est relatif et peut changer pour conserver sa position par rapport à la cellule 
de la formule. Par exemple, si une formule contenant A$1 se trouve dans C4 et si vous 
copiez la formule et la collez dans D5, la référence change en B$1.Si le composant de colonne d’une référence est absolu ($A1) :  Le composant de 
rang est relatif et peut changer pour conserver sa position par rapport à la cellule de 
la formule. Par exemple, si une formule contenant $A1 se trouve dans C4 et si vous 
copiez la formule et la collez dans la cellule C5 ou dans D5, la référence indiquée dans 
C5 ou D5 devient $A2.
Voici plusieurs manières d’indiquer que des composants de référence sont absolus :
m Tapez la référence à la cellule à l’aide d’une des conventions décrites ci-avant.
m Cliquez sur le triangle d’affichage de la référence à une cellule, puis choisissez une 
option dans le menu local. 
m Sélectionnez la référence à une cellule et appuyez sur Commande + K pour passer 
d’une option à l’autre.
Utilisation d’opérateurs dans les formules
Faites appel aux formules pour réaliser des opérations arithmétiques et pour comparer 
des valeurs.
Â Les opérateurs arithmétiques effectuent des opérations arithmétiques, telles que 
l’addition ou la soustraction, et donnent des résultats numériques. Consultez la 
rubrique « Opérateurs arithmétiques » à la page 30 pour en savoir plus.
Â Les opérateurs de comparaison comparent deux valeurs et donnent uniquement la 
valeur VRAI ou FAUX. Reportez-vous à la rubrique « Opérateurs de comparaison » à 
la page 31 pour en savoir plus.
Opérateurs arithmétiques
Vous pouvez utiliser des opérateurs arithmétiques pour effectuer des calculs 
arithmétiques dans des formules. 
Si vous voulez Utilisez l’opérateur 
arithmétique
Par exemple, si A2 contient 20 
et B2 contient 2, la formule
Additionner deux valeurs + (signe plus) A2 + B2 donne 22.
Soustraire deux valeurs – (signe moins) A2 – B2 donne 18.
Multiplier deux valeurs * (astérisque) A2 * B2 donne 40.
Diviser une valeur par une autre / (barre oblique) A2 / B2 donne 10.
Élever une valeur à une 
puissance donnée
^ (accent circonflexe) A2 ^ B2 donne 400.
Calculer un pourcentage % (signe pourcentage) A2% donne 0,2 formaté pour 
l’affichage en 20 %.
L’utilisation d’une chaîne avec un opérateur arithmétique donne une erreur. Par 
exemple, 3 + "bonjour" n’est pas une opération arithmétique correcte.
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Opérateurs de comparaison
Vous pouvez faire appel aux opérateurs de comparaison entre deux valeurs dans des 
formules. Les opérations de comparaison ne renvoient que la valeur VRAI ou FAUX. Ils 
permettent également d’élaborer des conditions s’illustrant dans certaines fonctions. 
Voir « condition » dans le tableau « Les éléments de syntaxe et les termes utilisés dans 
la définition des fonctions » à la page 36
Si vous voulez déterminer si Utilisez l’opérateur de 
comparaison
Par exemple, si A2 contient 20 
et B2 contient 2, la formule
Deux valeurs sont égales = A2 = B2 donne FAUX.
Deux valeurs sont différentes  B2 donne VRAI.
La première valeur est plus 
grande que la seconde
> A2 > B2 donne VRAI.
La première valeur est plus 
petite que la seconde
< A2 < B2 donne FAUX.
La première valeur est plus 
grande ou égale à la seconde 
valeur
>= A2 >= B2 donne VRAI.
La première valeur est plus 
petite ou égale à la seconde 
valeur
 5 
donne VRAI.
VRAI et FAUX peuvent être comparés mutuellement mais ne peuvent pas être 
comparés avec des nombres ou des chaînes. VRAI > FAUX et FAUX < VRAI, car VRAI est 
interprété comme 1 et FAUX est interprété comme 0. VRAI = 1 donne FAUX, et VRAI = 
"DuTexte" donne FAUX.
Les opérations de comparaison sont principalement utilisées dans des fonctions telles 
que SI qui permettent de comparer deux valeurs, puis d’effectuer d’autres opérations 
selon que la comparaison renvoie le résultat VRAI ou FAUX. Pour en savoir plus sur ce 
sujet, choisissez Aide > « Aide sur les formules et fonctions d’iWork » ou Aide > « Guide 
de l’utilisateur des formules et fonctions d’iWork ».Opérateur de chaîne et jokers
L’opérateur de chaîne s’illustre dans les formules ; les jokers s’utilisent pour leur part 
dans les conditions.
Si vous voulez Utilisez cet opérateur de 
chaîne ou ce joker
Par exemple
Concaténez les chaînes ou le 
contenu de cellules
& "abc"&"def" renvoie « abcdef »
"abc"&A1 renvoie « abc2 » si la 
cellule A1 contient 2.
A1&A2 renvoie « 12 » si la cellule 
A1 contient 1 et la cellule A2 
contient 2.
Remplacement d’un seul 
caractère
? “ea?” se substitue à n’importe 
quelle chaîne commençant par 
« ea » et contenant exactement 
un caractère de plus.
Remplacement d’un nombre 
quelconque de caractères
* "*ed" correspond à une chaîne 
d’une longueur quelconque et 
terminant par « ed ».
Indication d’un caractère 
servant de joker
~ "~?" représente le point 
d’interrogation en tant que 
tel plutôt qu’un caractère 
quelconque de substitution.
Pour en savoir plus sur l’utilisation de jokers dans des conditions, reportez-vous à la 
rubrique « Usage de conditions et de jokers » à la page 389.
Copie ou déplacement de formules et de leurs valeurs 
calculées
Les techniques ci-dessous permettent de copier et de déplacer des cellules 
associées à une formule :
m Pour copier la valeur calculée d’une cellule de formule sans copier la formule ellemême, sélectionnez la cellule, choisissez Édition > Copier, sélectionnez la cellule 
destinataire de la valeur, puis choisissez Édition > Coller les valeurs. 
m Pour copier ou déplacer une formule dans une cellule ou une cellule faisant l’objet 
d’une référence dans une formule, suivez les instructions reprises dans la rubrique 
« Copie et déplacement de cellules » dans l’Aide Numbers ou dans le Guide de 
l’utilisateur de Numbers.
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Dans Numbers, si le tableau est volumineux et si vous voulez déplacer la formule sur 
une cellule non visible à l’écran, sélectionnez la cellule, choisissez Édition > Signaler 
pour être déplacé, sélectionnez la nouvelle cellule, puis Édition > Déplacer. Par 
exemple, si la formule =A1 se trouve dans la cellule D1 et que vous souhaitez déplacer 
cette formule dans la cellule X1, sélectionnez D1, cliquez sur Édition > Signaler pour 
être déplacé, puis sélectionnez X1 et cliquez sur Édition > Déplacer. La formule =A1 
s’affiche désormais dans la cellule X1.
Si vous copiez ou déplacez une cellule de formule :  Modifiez si nécessaire les 
références de cellule en vous référant aux instructions de la rubrique « Distinction 
entre références absolues et relatives à des cellules » à la page 29.
Si vous déplacez une cellule à laquelle une formule fait référence :  La référence dans 
la formule s’actualise alors automatiquement. Par exemple, si une référence à A1 se 
trouve dans une formule et si vous déplacez A1 sur D95, la référence dans la formule 
reste D95.
Affichage de toute les formules d’une feuille de calcul
Dans Numbers, pour accéder à la liste de toutes les formules d’une feuille de calcul, 
choisissez Présentation > Afficher la liste des formules, ou cliquez sur le bouton de la 
liste des formules situé dans la barre d’outils.
Emplacement : identifie la feuille et le tableau dans lesquels la formule se trouve.
Résultats :  affiche la valeur calculée par la formule.
Formule :  affiche la formule.
Voici plusieurs manières d’utiliser la fenêtre de la liste des formules :
m Pour identifier la cellule contenant une formule, cliquez sur cette dernière. Le tableau 
s’affiche au-dessus de la fenêtre de la liste des formules, où la cellule de la formule y 
est sélectionnée.
m Pour modifier la formule, double-cliquez dessus.
m Pour changer la taille de la fenêtre de la liste des formules, faites glisser verticalement 
la poignée de sélection située dans le coin supérieur droit.
m Pour rechercher des formules qui contiennent un élément en particulier, tapez 
l’élément dans le champ de recherche et appuyez sur Retour.Recherche et remplacement d’éléments de formule
Dans Numbers, la fenêtre Rechercher et remplacer vous permet de faire une recherche 
parmi toutes les formules d’une feuille de calcul afin de retrouver certains éléments et 
de les modifier si vous le souhaitez. 
Voici plusieurs manières d’ouvrir la fenêtre Rechercher et remplacer :
m Choisissez Édition > Rechercher > Afficher Rechercher, puis cliquez sur Rechercher et 
remplacer.
m Choisissez Présentation > Afficher la liste des formules, puis cliquez sur Rechercher et 
remplacer.
Rechercher : tapez l’élément de formule (référence à une cellule, opérateur, fonction, 
etc.) à rechercher.
Dans :  choisissez « formules uniquement » dans ce menu local.
Respecter la casse :  cochez cette case pour ne rechercher que les éléments dont les 
lettres majuscules et minuscules correspondent exactement à ce qui est indiqué dans 
le champ Rechercher.
Mots entiers :  cochez cette case pour ne rechercher que les éléments dont l’intégralité 
du contenu correspond à ce qui est indiqué dans le champ Rechercher.
Remplacer :  le cas échéant, tapez par quoi vous voulez remplacer ce qui est précisé 
dans le champ Rechercher.
Répéter la recherche (en boucle) :  cochez cette case pour rechercher ce qui est 
indiqué dans le champ Rechercher même après que la recherche ait été effectuée 
dans l’ensemble de la feuille de calcul.
Suivant ou Précédent :  cliquez sur le bouton pour rechercher l’occurrence précédente 
ou suivante de ce qui est précisé dans le champ Rechercher. Une fois l’élément trouvé, 
l’éditeur de formules s’ouvre et affiche la formule contenant l’occurrence de l’élément.
Tout remplacer :  cliquez pour remplacer toutes les occurrences de ce qui se trouve 
dans le champ Rechercher par ce qui est indiqué dans le champ Remplacer.
Remplacer :  cliquez pour remplacer l’occurrence active de ce qui se trouve dans le 
champ Rechercher par ce qui est indiqué dans le champ Remplacer.
Remplacer et rechercher :  cliquez pour remplacer l’occurrence active de ce qui se 
trouve dans le champ Rechercher et pour rechercher la suivante.
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Le présent chapitre constitue une introduction aux fonctions 
proposées dans iWork.
Introduction aux fonctions
Une fonction est une opération nommée que vous pouvez inclure dans une formule 
pour effectuer un calcul dans une cellule de tableau.
iWork contient des fonctions permettant de réaliser des opérations mathématiques ou 
financières, d’extraire des valeurs en s’appuyant sur une recherche, de manipuler des 
chaînes de texte ou d’obtenir la date et l’heure. Chaque fonction possède un nom suivi 
d’arguments entre parenthèses. Les arguments permettent de fournir les valeurs dont 
a besoin la fonction pour effectuer le traitement.
Par exemple, la formule suivante contient la fonction SOMME avec un argument 
unique (un intervalle de cellules) qui ajoute les valeurs de la colonne A, de la ligne 2 à 
la ligne 10 :
=SOMME(A2:A10)
Le nombre et les types d’arguments diffèrent pour chaque fonction. Le nombre 
d’arguments et leur description sont indiqués dans la description de la fonction sousjacente, organisés en liste alphabétique dans la rubrique « Liste des catégories de 
fonctions » à la page 44. Les descriptions contiennent aussi des informations et des 
exemples complémentaires pour chacune des fonctions.
2
Vue d’ensemble des fonctions 
d’iWorkInformations sur les fonctions
Pour en savoir plus sur Allez à
La syntaxe utilisée dans la définition des 
fonctions
« Les éléments de syntaxe et les termes utilisés 
dans la définition des fonctions » à la page 36
Les types d’arguments utilisés par les fonctions « Types de valeur » à la page 39
Les catégories de fonctions, par exemple les 
fonctions de durée et statistiques
« Liste des catégories de fonctions » à la page 44. 
Les fonctions sont triées par ordre alphabétique 
dans chaque catégorie.
Les arguments communs à plusieurs fonctions 
financières
« Arguments communs utilisés dans les fonctions 
financières » à la page 366
Exemples et rubriques supplémentaires « Exemples et rubriques supplémentaires 
inclus » à la page 365
Les éléments de syntaxe et les termes utilisés dans la 
définition des fonctions
Les fonctions sont décrites à l’aide d’éléments de syntaxe et de termes spécifiques.
Terme ou symbole Signification
texte en majuscules Le nom des fonctions est représenté en lettres 
majuscules. Le nom d’une fonction peut toutefois 
être saisi en associant des lettres majuscules et 
minuscules.
parenthèses Les arguments des fonctions sont écrits entre 
parenthèses. Ces dernières sont obligatoires, 
bien que, dans quelques cas, iWork puisse insérer 
automatiquement la parenthèse fermante finale.
texte en italique Le texte en italique indique que vous devez 
remplacer le nom de l’argument par la valeur que 
la fonction doit utiliser pour calculer le résultat. 
Les arguments possèdent un type de valeur, par 
exemple « nombre », « date/heure » ou « chaîne ». 
Les types sont décrits dans « Types de valeur » à 
la page 39.
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Terme ou symbole Signification
virgules et points-virgules La syntaxe des fonctions utilise le point-virgule 
pour séparer les arguments. Si vos préférences 
Langue et texte (Mac OS X 10.6 ou ultérieur) ou 
les préférences International (versions antérieures 
de Max OS X) sont configurées de façon à utiliser 
la virgule comme séparateur décimal, séparez les 
arguments à l’aide d’un point-virgule plutôt que 
la virgule.
points de suspension (…) Un argument suivi de points de suspension 
peut être répété autant de fois que nécessaire. 
Les éventuelles limitations sont décrites dans la 
définition de l’argument.
tableau Un tableau (ne pas confondre avec le tableau 
d’un tableur, tel que Numbers) est une séquence 
de valeurs utilisées ou renvoyées par une 
fonction.
constante de tableau  Une constante de tableau est un ensemble 
de valeurs entourées d’accolades ({}). Elle doit 
être tapée directement dans la fonction. Par 
exemple, {1; 2; 5; 7} ou {"12/31/2008"; "15/3/2009"; 
"20/8/2010"}.
fonction de tableau Un nombre réduit de fonctions sont appelées 
« fonctions de tableau » parce qu’elles renvoient 
un tableau de valeurs et non une seule valeur. 
Ces fonctions servent généralement à fournir des 
valeurs à une autre fonction.
expression booléenne Une expression booléenne est une expression qui 
a pour résultat la valeur booléenne VRAI ou FAUX.Terme ou symbole Signification
constante Une constante constitue une valeur précisée 
directement dans la formule qui ne contient 
aucun appel et aucune référence à une 
fonction. Par exemple, dans la formule 
=CONCATENER("chat"; "s"), « chat » et « s » 
représentent des constantes.
argument modal Un argument modal est un argument pouvant 
adopter une valeur parmi celles indiquées. 
Généralement, les arguments modaux apportent 
des informations sur le type de calcul que la 
fonction doit réaliser ou sur le type de données 
que la fonction doit renvoyer. Si un argument 
modal possède une valeur par défaut, celle-ci est 
indiquée dans la description de l’argument.
condition Une condition est une expression pouvant 
comprendre des opérateurs de comparaison, des 
constantes, l’opérateur de chaîne et commercial 
ainsi que des références. Le contenu d’une 
condition doit être présenté de sorte que le 
résultat de sa comparaison à une autre valeur 
génère la valeur booléenne VRAI ou FAUX. Vous 
trouverez d’autres informations et des exemples 
dans « Usage de conditions et de jokers » à la 
page 389.
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Types de valeur
Un argument de fonction possède un type qui indique le type d’information que 
l’argument peut contenir. Les fonctions renvoient aussi une valeur d’un type donné.
Type de valeur Description
quelconque Si un argument est spécifié sous la forme 
« quelconque », il peut correspondre à une 
valeur booléenne, une date/heure, une durée, un 
nombre ou une chaîne.
booléenne Une valeur booléenne correspond à la valeur 
VRAI (1) ou FAUX (0) logique ou une référence 
à une cellule contenant ou ayant pour 
résultat la valeur VRAI ou FAUX logique. Elle 
est généralement le résultat de l’évaluation 
d’une expression booléenne, mais une valeur 
booléenne peut être indiquée directement 
comme argument d’une fonction ou comme 
contenu d’une cellule. On utilise souvent les 
valeurs booléennes pour déterminer quelle 
expression doit être renvoyée par la fonction SI.
collection Un argument indiqué sous la forme d’une 
collection peut correspondre à une référence à 
un seul intervalle de cellules, à une constante 
de tableau ou à un tableau renvoyé par une 
fonction de tableau. Un argument spécifié sous 
la forme d’une collection possède un attribut 
supplémentaire définissant le type de valeurs 
qu’il peut contenir.Type de valeur Description
date/heure Il s’agit d’une valeur de date/heure ou d’une 
référence à une cellule contenant une valeur de 
date/heure dans un des formats pris en charge 
par iWork. Si vous tapez dans la fonction une 
valeur correspondant à une valeur de date/heure, 
vous devez l’indiquer entre guillemets. Vous 
pouvez n’afficher qu’une date ou une heure dans 
une cellule, mais toutes les valeurs de date/heure 
contiennent une date et une heure.
Bien qu’il soit généralement possible de taper 
directement des dates sous forme de chaînes 
(par exemple, « 31/12/2010 »), la fonction DATE 
permet de s’assurer que la date est interprétée 
correctement indépendamment du format 
des dates choisi dans les Préférences Système 
(recherchez « format de date » dans la fenêtre des 
Préférences Système).
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Type de valeur Description
durée Une durée est une période de temps ou une 
référence à une cellule contenant une période 
de temps. Les valeurs de durée peuvent être 
exprimées en semaines (sem. ou semaines), 
en jours (j ou jours), en heures (h ou heures), 
en minutes (m ou minutes), en secondes (s 
ou secondes) ou en millisecondes (ms ou 
millisecondes). Une durée peut être saisie dans 
deux formats différents.
Le premier format consiste en un nombre suivi 
d’une période de temps (comme h pour heures) 
éventuellement suivie d’un espace et est répété 
pour d’autres périodes de temps. Pour préciser 
une période de temps, vous pouvez soit utiliser 
l’abréviation, comme « h », soit le nom complet, 
comme « heures ». Par exemple, 12h 5j 3m 
représente une durée de 12 heures, 5 jours et 3 
minutes. Les périodes de temps ne doivent pas 
être saisies dans l’ordre et les espaces ne sont pas 
obligatoires. 5j 5h est équivalent à 5h5j. Si elle est 
tapée directement dans une formule, la chaîne 
doit être entourée de guillemets, comme dans 
« 12h 5j 3m ».
Une durée peut aussi être saisie sous la forme 
d’une série de nombres séparés par des deuxpoints. Si vous utilisez ce format, vous devez 
préciser l’argument des secondes et ce dernier 
doit se terminer par une virgule suivie des 
millisecondes, lesquelles peuvent être égales 
à 0, si la valeur de durée risque d’être prise 
pour une valeur de date/heure. Par exemple, 
12:15:30,0 représente une durée de 12 heures, 
15 minutes et 30 secondes, alors que 12:15:30 
représente l’heure 12:15:30. 5:00,0 représente 
une durée d’exactement 5 minutes. Si vous 
le tapez directement dans une fonction, la 
chaîne doit être entourée de guillemets, par 
exemple « 12:15:30,0 » ou « 5:00,0 ». Si la cellule 
est formatée pour afficher une durée sous un 
format en particulier, les unités s’affichent comme 
prévu et il n’est pas nécessaire d’indiquer les 
millisecondes.
liste Une liste constitue une séquence de valeurs 
d’un autre type, séparées par des points-virgules. 
Par exemple, =CHOISIR(3; "1er"; "deuxième"; 7; 
"dernier"). Dans certains cas, la liste est délimitée 
par des parenthèses supplémentaires. Par 
exemple, =ZONES((B1:B5; C10:C12)).Type de valeur Description
modale Une valeur modale est une simple valeur, souvent 
un nombre, représentant un mode donné pour 
un argument modal. Le terme « argument 
modal » est défini dans la rubrique « Les éléments 
de syntaxe et les termes utilisés dans la définition 
des fonctions » à la page 36.
nombre Un nombre est une valeur numérique, une 
expression numérique ou une référence à une 
cellule contenant une expression numérique. Si 
les valeurs acceptables d’un nombre sont limitées 
(par exemple, si le nombre doit être plus grand 
que 0), cela est inclus dans la description des 
arguments.
valeur d’intervalle Une valeur d’intervalle correspond à la référence 
à un seul intervalle de cellules (il peut s’agir d’une 
seule cellule). Une valeur d’intervalle possède un 
attribut supplémentaire définissant le type de 
valeurs que l’intervalle doit contenir. Cet attribut 
figure dans la description des arguments.
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Type de valeur Description
référence Il s’agit de la référence à une seule cellule ou à un 
intervalle de cellules. Si l’intervalle contient plus 
d’une cellule, les cellules de début et de fin sont 
séparées par un seul deux-points. Par exemple, 
=NB(A3:D7)
À moins que le nom de la cellule soit unique 
entre tous les tableaux, la référence doit 
mentionner le nom du tableau si elle se rapporte 
à une cellule d’un autre tableau. Par exemple, 
=Tableau 2::B2. Notez que le nom du tableau et la 
référence de cellule sont séparés par un double 
signe deux-points (::).
Si le tableau se trouve sur une autre feuille, il 
convient de préciser également le nom de cette 
dernière, sauf si le nom de la cellule est unique 
entre les tableaux de toutes les feuilles. Par 
exemple, =SOMME(Feuille 2::Tableau 1::C2:G2). 
Le nom de la feuille, le nom du tableau et la 
référence de la cellule sont séparés par un double 
deux-points.
Certaines fonctions qui acceptent les intervalles 
peuvent agir sur des intervalles qui couvrent 
plusieurs tableaux. Imaginons que vous avez 
ouvert un fichier qui possède une feuille 
contenant trois tableaux (Tableau 1, Tableau 
2, Tableau 3). Imaginons encore que la cellule 
C2 de chaque tableau contienne le nombre 
1. La formule couvrant plusieurs tableaux 
=SOMME(Tableau 1:Tableau 2 :: C2) additionne 
la cellule C2 dans tous les tableaux entre Tableau 
1 et Tableau 2. Le résultat correspond donc à 2. 
Si vous faites glisser Tableau 3 entre Tableau 1 
et Tableau 2 dans la barre latérale, la fonction 
renverra 3, puisqu’elle additionne maintenant la 
cellule C2 des trois tableaux (Tableau 3 se trouve 
entre Tableau 1 et Tableau 2).
chaîne Une chaîne se réfère à toute valeur 
alphanumérique ou à une référence à une 
cellule contenant un ou plusieurs caractères. Les 
caractères peuvent correspondre à n’importe 
quel caractère imprimable, y compris les 
nombres. Si vous tapez dans la formule une 
valeur correspondant à une chaîne, vous devez 
l’indiquer entre guillemets. Si la valeur de 
chaîne est limitée (par exemple, si la chaîne 
doit représenter une date), la description des 
arguments mentionne cette limite.Liste des catégories de fonctions
Il existe plusieurs catégories de fonctions. Par exemple, certaines fonctions réalisent 
des calculs sur des valeurs de date/heure, des fonctions logiques donnent un résultat 
booléen (VRAI ou FAUX), tandis que d’autres fonctions réalisent des calculs financiers. 
Chacune des catégories de fonctions est décrite dans un chapitre séparé.
« Liste des fonctions date et heure » à la page 46
« Liste des fonctions de durée » à la page 70
« Liste des fonctions d’ingénierie » à la page 78
« Liste des fonctions financières » à la page 102
« Liste des fonctions logiques et d’information » à la page 165
« Liste des fonctions numériques » à la page 179
« Liste des fonctions de référencement » à la page 222
« Liste des fonctions statistiques » à la page 244
« Liste des fonctions de texte » à la page 330
« Liste des fonctions trigonométriques » à la page 351
Collage d’exemples de l’aide
De nombreux exemples de l’aide peuvent être collés directement dans un tableau ou 
dans un document Numbers vierge. Deux groupes d’exemples peuvent être copiés 
depuis l’aide et collés dans un tableau. Le premier correspond à des exemples simples 
inclus dans l’aide. Tous ces exemples commencent par le signe égal (=). Dans l’aide 
relative à la fonction HEURE, deux exemples de ce type vous sont proposés.
Pour utiliser l’un de ces exemples, sélectionnez le texte commençant par le signe égal 
jusqu’à la fin de l’exemple.
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Une fois que ce texte est mis en surbrillance, vous pouvez le copier, puis le coller dans 
n’importe quelle cellule d’un tableau. Une autre méthode consiste à faire glisser la 
sélection de l’exemple et à le déposer dans n’importe quelle cellule d’un tableau. 
Le second type d’exemples représente des tableaux à copier, intégrés à l’aide. Voici le 
tableau illustrant la fonction INTERET.ACC.
Pour réutiliser un tableau, sélectionnez toutes les cellules du tableau, y compris le 
premier rang.
Lorsque le texte est en surbrillance, vous pouvez le copier puis le coller dans n’importe 
quelle cellule d’un tableau ou sur un document Numbers vierge. Faire glisser un 
élément reste impossible pour ce deuxième type d’exemples.46
Les fonctions de date d’et heure sont prévues pour simplifier 
vos manipulation de dates et d’heures et vous aident à 
résoudre certains problèmes se rapportant à ce type de 
ressources. Elles vous permettent, par exemple, de trouver le 
nombre de jours ouvrés entre deux dates ou de savoir le jour 
de la semaine pour une date donnée.
Liste des fonctions date et heure
iWork intégre ces fonctions de date et heure pour que vous puissiez les utiliser dans 
des tableaux.
Fonction Description
« ANNÉE » (page 48) La fonction ANNÉE renvoie l’année pour une 
valeur de date/heure donnée.
« AUJOURDHUI » (page 49) La fonction AUJOURDHUI renvoie la date système 
actuelle. L’heure est définie à 12 h 00.
« DATE » (page 50) La fonction DATE combine des valeurs distinctes 
correspondant à l’année, au mois et au jour et 
renvoie une valeur de date/heure. Bien qu’il soit 
généralement possible de taper directement 
des dates sous forme de chaînes (par exemple, 
« 31/12/2010 »), la fonction DATE permet de 
s’assurer que la date est interprétée correctement 
indépendamment du format des dates indiqué 
dans les Préférences Système (recherchez 
« format de date » dans la fenêtre des Préférences 
Système).
3
Fonctions date et heureChapitre 3    Fonctions date et heure 47
Fonction Description
« DATEDIF » (page 51) La fonction DATEDIF renvoie le nombre de jours, 
de mois ou d’années entre deux dates.
« DATEVAL » (page 53) La fonction DATEVAL convertit une chaîne de 
texte correspondant à une date et renvoie une 
valeur de date/heure. Cette fonction a été incluse 
afin d’assurer la compatibilité avec les tableurs 
plus anciens.
« EDATE » (page 54) La fonction EDATE renvoie une date antérieure ou 
postérieure d’un ou de plusieurs mois à une date 
donnée.
« FIN.MOIS » (page 54) La fonction FIN.MOIS renvoie une date qui est le 
dernier jour du mois antérieur ou postérieur d’un 
ou de plusieurs mois à une date donnée.
« FRACTION.ANNEE » (page 55) La fonction FRACTION.ANNEE trouve la fraction 
d’une année représentée par le nombre de jours 
entiers entre deux dates.
« HEURE » (page 56) La fonction HEURE renvoie l’heure pour une 
valeur de date/heure donnée.
« JOUR » (page 57) La fonction JOUR renvoie le jour du mois pour 
une valeur de date/heure donnée.
« JOURS360 » (page 58) La fonction JOURS360 renvoie le nombre de jours 
entre deux dates sur la base de douze mois de 30 
jours et d’une année de 360 jours.
« JOURSEM » (page 59) La fonction JOURSEM renvoie un numéro qui est 
le jour de la semaine pour une date donnée.
« MAINTENANT » (page 60) La fonction MAINTENANT renvoie la valeur de 
date/heure actuelle telle qu’elle est indiquée par 
l’horloge système.
« MINUTE » (page 60) La fonction MINUTE renvoie les minutes pour une 
valeur de date/heure donnée.
« MOIS » (page 61) La fonction MOIS renvoie le mois pour une valeur 
de date/heure donnée.
« NB.JOURS.OUVRES » (page 62) La fonction NB.JOURS.OUVRES renvoie le nombre 
de jours ouvrés entre deux dates. Les jours ouvrés 
excluent les week-ends et les dates indiquées de 
façon explicite.
« NOMDUMOIS » (page 63) La fonction NOMDUMOIS renvoie le nom du mois 
à partir d’un numéro. Le mois 1 correspond à 
janvier.
« NOMJOUR » (page 63) La fonction NOMJOUR renvoie le nom du jour de 
la semaine à partir d’une valeur de date/heure ou 
d’un numéro. Le jour 1 est dimanche.Fonction Description
« NO.SEMAINE » (page 65) La fonction NO.SEMAINE renvoie le numéro de la 
semaine dans l’année pour une date donnée.
« SECONDE » (page 66) La fonction SECONDE renvoie les secondes pour 
une valeur de date/heure donnée.
« SERIE.JOUR.OUVRE » (page 66) La fonction SERIE.JOUR.OUVRE renvoie la date qui 
correspond au nombre donné de jours ouvrés 
avant ou après une date donnée. Les jours ouvrés 
excluent les week-ends et toutes les autres dates 
prévues en tant que telles.
« TEMPS » (page 67) La fonction TEMPS convertit des valeurs distinctes 
correspondant à des heures, des minutes et des 
secondes en une valeur de date/heure.
« TEMPSVAL » (page 68) La fonction TEMPSVAL renvoie l’heure, sous la 
forme d’une fraction décimale d’une journée 
de 24 heures, d’après une valeur de date/heure 
donnée ou à partir d’une chaîne de texte.
ANNÉE
La fonction ANNÉE renvoie l’année pour une valeur de date/heure donnée.
ANNÉE(date)
Â date :  date à utiliser dans la fonction. date correspond à une valeur de date/heure. 
La partie correspondant à l’heure est ignorée par cette fonction.
Exemples
=ANNÉE("6 avril 2008") renvoie 2008.
=ANNÉE(MAINTENANT()) renvoie 2009 si le calcul est effectué le 4 juin 2009.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
« HEURE » à la page 56
« MINUTE » à la page 60
« MOIS » à la page 61
« SECONDE » à la page 66
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
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« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
AUJOURDHUI
La fonction AUJOURDHUI renvoie la date système actuelle. L’heure est définie à 
12 h 00.
AUJOURDHUI()
Remarques d’usage
Â La fonction AUJOURDHUI ne comprend aucun argument. Toutefois, vous devez 
inclure les parenthèses : =AUJOURDHUI().
Â La date affichée est mise à jour chaque fois que vous ouvrez ou modifiez votre 
fichier.
Â Vous pouvez vous servir de la fonction MAINTENANT pour obtenir la date et l’heure 
actuelles et pour mettre en forme la cellule de sorte qu’elle affiche ces deux valeurs.
Exemple
=AUJOURDHUI() renvoie 6 avril 2008 lorsque le calcul est effectué le 6 avril 2008.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« MAINTENANT » à la page 60
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44DATE
La fonction DATE combine des valeurs distinctes correspondant à l’année, au mois 
et au jour et renvoie une valeur de date/heure. Bien qu’il soit généralement possible 
de taper directement des dates sous forme de chaînes (par exemple, « 31/12/2010 »), 
la fonction DATE permet de s’assurer que la date est interprétée correctement 
indépendamment du format des dates indiqué dans les Préférences Système 
(recherchez « format de date » dans la fenêtre des Préférences Système).
DATE(année; mois; jour)
Â année :  année à inclure dans la valeur renvoyée. année correspond à un nombre. La 
valeur n’est pas convertie. Si vous indiquez 10, c’est l’année 10 qui est utilisée, et non 
pas l’année 1910 ou 2010.
Â mois :  mois à inclure dans la valeur renvoyée. mois correspond à un nombre 
compris entre 1 et 12.
Â jour :  jour à inclure dans la valeur renvoyée. jour correspond à un nombre compris 
entre 1 et le nombre de jours dans le mois.
Exemples
Si A1 contient 2014, A2 contient 11 et A3 contient 10 :
=DATE(A1; A2; A3) renvoie « 10 nov. 2014 » en s’adaptant au format de la cellule.
=DATE(A1; A3; A2) renvoie « 11 oct. 2014 ».
=DATE(2012; 2; 14) renvoie « 14 fév. 2012 ».
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DUREE » à la page 71
« TEMPS » à la page 67
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DATEDIF
La fonction DATEDIF renvoie le nombre de jours, de mois ou d’années entre deux 
dates.
DATEDIF(date-début; date-fin; méthode-calc)
Â date de début :  date de début de la période à calculer. date-début correspond à une 
valeur de date/heure.
Â date de fin :  date de fin de la période à calculer. date-fin correspond à une valeur de 
date/heure.
Â méthode-calc :  indique comment exprimer la différence temporelle et comment 
gérer les dates pour des années ou des mois différents.
"J" :  compte les jours entre les dates de début et de fin.
"M" :  compte les mois entre les dates de début et de fin.
"A" :  compte les années entre les dates de début et de fin.
"MJ" :  compte les jours entre les dates de début et de fin en ignorant les mois et 
les années. Le mois de date-fin est considéré comme étant le mois de date-début. 
Si la date de début est postérieure à la date de fin, le compte commence à la date 
de fin comme si celle-ci appartenait au mois précédent. L’année de la date-fin sert 
à vérifier s’il s’agit d’une année bissextile.
"AM" :  compte le nombre de mois entiers entre les dates de début et de fin en 
ignorant l’année. Si le mois/jour de début est antérieur au mois/jour de fin, les dates 
sont traitées comme s’ils appartenaient à la même année. Si le mois/jour de début 
est postérieur au mois/jour de fin, les dates sont traitées comme s’ils appartenaient 
à des années consécutives.
"AJ" :  compte le nombre de jours entre les dates de début et de fin en ignorant 
l’année. Si le mois/jour de début est antérieur au mois/jour de fin, les dates sont 
traitées comme s’ils appartenaient à la même année. Si le mois/jour de début est 
postérieur au mois/jour de fin, les dates sont traitées comme s’ils appartenaient à 
des années consécutives.Exemples
Si A1 contient la valeur de date/heure 6/4/88 et A2 contient la valeur de date/heure 30/10/06 :
=DATEDIF(A1; A2; "J") renvoie 6781, le nombre de jours entre le 6 avril 1988 et le 30 octobre 2006.
=DATEDIF(A1; A2; "M") renvoie 222, le nombre de mois entiers entre le 6 avril 1988 et le 
30 octobre 2006.
=DATEDIF(A1; A2; "A") renvoie 18, le nombre d’années entières entre le 6 avril 1988 et le 
30 octobre 2006.
=DATEDIF(A1; A2; "MJ") renvoie 24, le nombre de jours entre le sixième jour d’un mois et le trentième 
jour du même mois.
=DATEDIF(A1; A2; "AM") renvoie 6, le nombre de mois entre avril et le mois d’octobre suivant de 
n’importe quelle année.
=DATEDIF(A1; A2; "AJ") renvoie 207, le nombre de jours entre le 6 avril et le 31 octobre suivant de 
n’importe quelle année.
=DATEDIF("6/4/1988"; MAINTENANT(); "A") & " années, " & DATEDIF("6/4/1988"; MAINTENANT(); "AM") 
& " mois et " & DATEDIF(A1; MAINTENANT(); "AJ") & " jours" renvoie l’âge d’une personne née le 
6 avril 1988.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOURS360 » à la page 58
« NB.JOURS.OUVRES » à la page 62
« MAINTENANT » à la page 60
« FRACTION.ANNEE » à la page 55
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DATEVAL
La fonction DATEVAL convertit une chaîne de texte correspondant à une date et 
renvoie une valeur de date/heure. Cette fonction a été incluse afin d’assurer la 
compatibilité avec les tableurs plus anciens.
DATEVAL(date-texte)
Â date-texte :  chaîne de caractères de la date à convertir. date-texte est une valeur 
exprimée sous forme de chaîne. Ce doit être une date indiquée entre guillemets 
ou une valeur de date/heure. Si date-texte n’est pas une date valide, une erreur est 
renvoyée.
Exemples
Si la cellule B1 contient la valeur de date/heure 2 août 1979 06 h 30’ 00’’ et que la cellule C1 contient 
la chaîne 16/10/2008 :
=DATEVAL(B1) renvoie le 2 août 1979, laquelle date est considérée comme une valeur de date si elle 
fait l’objet d’une référence dans d’autres formules. La valeur renvoyée est mise en forme en fonction 
du format de la cellule active. Une cellule adoptant le format Automatique utilise le format de date 
indiqué dans les Préférences Système (recherchez « format de date » dans la fenêtre des Préférences 
Système).
=DATEVAL(C1) renvoie « 16 oct. 2008 ».
=DATEVAL(29/12/1974) renvoie « 29 déc. 1979 ».
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DATE » à la page 50
« TEMPS » à la page 67
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44EDATE
La fonction EDATE renvoie une date antérieure ou postérieure d’un ou de plusieurs 
mois à une date donnée.
EDATE(date-début; décalage-mois)
Â date de début :  date de début de la période à calculer. date-début correspond à une 
valeur de date/heure.
Â décalage-mois :  nombre de mois avant ou après la date de début. décalage-mois
correspond à un nombre. Une valeur de décalage-mois négative permet d’indiquer 
le nombre de mois avant la date de début ; à l’inverse une valeur de décalage-mois
positive permet d’indiquer les mois après la date de début.
Exemples
=EDATE("15/1/2000"; 1) renvoie 15/2/2000, la même date mais un mois plus tard.
=EDATE("15/1/2000"; –24) renvoie 15/1/1998, la même date, 24 mois plus tôt.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« FIN.MOIS » à la page 54
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
FIN.MOIS
La fonction FIN.MOIS renvoie une date qui est le dernier jour du mois un certain 
nombre de mois avant ou après une date donnée.
FIN.MOIS(date-début; décalage-mois)
Â date de début :  date de début de la période à calculer. date-début correspond à une 
valeur de date/heure.
Â décalage-mois :  nombre de mois avant ou après la date de début. décalage-mois
correspond à un nombre. Une valeur de décalage-mois négative permet d’indiquer 
le nombre de mois avant la date de début ; à l’inverse une valeur de décalage-mois
positive permet d’indiquer les mois après la date de début.
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Exemples
=FIN.MOIS("15/5/2010"; 5) renvoie « 31 oct. 2010 », c’est-à-dire le dernier jour du mois postérieur de 
cinq mois à mai 2010.
=FIN.MOIS("15/5/2010"; –5) renvoie « 31 déc. 2009 », c’est-à-dire le dernier jour du mois antérieur de 
cinq mois à mai 2010.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« EDATE » à la page 54
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
FRACTION.ANNEE
La fonction FRACTION.ANNEE trouve la fraction d’une année représentée par le 
nombre de jours entiers entre deux dates.
FRACTION.ANNEE(date-début; date-fin; base-journalière)
Â date de début :  date de début de la période à calculer. date-début correspond à une 
valeur de date/heure.
Â date de fin :  date de fin de la période à calculer. date-fin correspond à une valeur de 
date/heure.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).Exemples
=FRACTION.ANNEE("15/12/2009"; "30/6/2010"; 0) renvoie 0,541666667.
=FRACTION.ANNEE("15/12/2009"; "30/6/2010"; 1) renvoie 0,539726027.
=FRACTION.ANNEE("15/12/2009"; "30/6/2010"; 2) renvoie 0,547222222.
=FRACTION.ANNEE("15/12/2009"; "30/6/2010"; 3) renvoie 0,539726027.
=FRACTION.ANNEE("15/12/2009"; "30/6/2010"; 4) renvoie 0,541666667.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DATEDIF » à la page 51
« JOURS360 » à la page 58
« NB.JOURS.OUVRES » à la page 62
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
HEURE
La fonction HEURE renvoie l’heure pour une valeur de date/heure donnée.
HEURE(instant)
Â instant :  heure à utiliser dans la fonction. instant correspond à une valeur de date/
heure. La partie correspondant à la date est ignorée par cette fonction.
Remarques d’usage
Â L’heure renvoyée est au format 24 heures (0 correspond à minuit, 23 correspond à 
11 h 00 du soir).
Exemples
=HEURE(MAINTENANT()) renvoie l’heure actuelle du jour.
=HEURE("6/4/88 11 h 59’ 22") renvoie 11.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
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« MINUTE » à la page 60
« MOIS » à la page 61
« SECONDE » à la page 66
« ANNÉE » à la page 48
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
JOUR
La fonction JOUR renvoie le jour du mois pour une valeur de date/heure donnée.
JOUR(date)
Â date :  date à utiliser dans la fonction. date correspond à une valeur de date/heure. 
La partie correspondant à l’heure est ignorée par cette fonction.
Exemples
=JOUR("6/4/88 23 h 59’ 22’’) renvoie 6.
=JOUR("12/5/2009") renvoie 12.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NOMJOUR » à la page 63
« HEURE » à la page 56
« MINUTE » à la page 60
« MOIS » à la page 61
« SECONDE » à la page 66
« ANNÉE » à la page 48
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
JOURS360
La fonction JOURS360 renvoie le nombre de jours entre deux dates sur la base de 
douze mois de 30 jours et d’une année de 360 jours.
JOURS360(date-début; date-fin; utiliser-méthode-européenne)
Â date de début :  date de début de la période à calculer. date-début correspond à une 
valeur de date/heure.
Â date de fin :  date de fin de la période à calculer. date-fin correspond à une valeur de 
date/heure.
Â utiliser-méthode-européenne :  valeur facultative indiquant si la méthode NASD ou 
la méthode européenne doit être utilisée pour les dates tombant le 31 d’un mois.
méthode NASD (0, FAUX ou omis):  méthode NASD utilisée pour les dates qui 
tombent le 31 d’un mois.
méthode DEVISE (1 ou VRAI):  méthode européenne utilisée pour les dates qui 
tombent le 31 d’un mois.
Exemples
=JOURS360("20/12/2008"; "3/31/2009") renvoie 101d.
=JOURS360("27/2/2008"; "31/3/2009"; 0) renvoie 394d.
=JOURS360("27/2/2008"; "31/3/2009"; 1) renvoie 393d lorsque la méthode de calcul européenne est 
utilisée.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DATEDIF » à la page 51
« NB.JOURS.OUVRES » à la page 62
« FRACTION.ANNEE » à la page 55
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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JOURSEM
La fonction JOURSEM renvoie un numéro qui est le jour de la semaine pour une date 
donnée.
JOURSEM(date; premier-jour)
Â date :  date à utiliser dans la fonction. date correspond à une valeur de date/heure. 
La partie correspondant à l’heure est ignorée par cette fonction.
Â premier-jour :  valeur facultative qui précise le mode de numérotation des jours.
Dimanche correspond au jour numéro 1 (1 ou omis):  dimanche est le premier jour 
(jour 1) de la semaine et samedi est le septième jour.
Lundi correspond au jour numéro 1 (2):  lundi est le premier jour (jour 1) de la 
semaine et dimanche est le septième jour.
Lundi correspond au jour numéro 0 (3):  lundi est le premier jour (jour 0) de la 
semaine et dimanche est le sixième jour.
Exemples
=JOURSEM("6 avr. 1988"; 1) renvoie 4 (mercredi correspondant au quatrième jour si vous considérez 
que la semaine commence le dimanche).
=JOURSEM("6 avr. 1988") renvoie la même valeur que dans l’exemple précédent (car le système de 
numérotation démarrant à 1 est utilisé si aucun argument numérotation n’est indiqué).
=JOURSEM("6 avr. 1988"; 2) renvoie 3 (mercredi correspondant au troisième jour si vous considérez 
que la semaine commence le lundi).
=JOURSEM("6 avr. 1988"; 3) renvoie 2 (mercredi considéré le jour 2 si lundi sert de base commençant 
à 0).
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NOMJOUR » à la page 63
« NOMDUMOIS » à la page 63
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44MAINTENANT
La fonction MAINTENANT renvoie la valeur de date/heure actuelle telle qu’elle est 
indiquée par l’horloge système.
MAINTENANT()
Remarques d’usage
Â La fonction MAINTENANT ne comprend aucun argument. Toutefois, vous devez 
inclure les parenthèses : =MAINTENANT().
Exemple
=MAINTENANT() renvoie « 4 oct. 2008 10 h 47 » si votre fichier est mis à jour le 4 octobre 2008 à 
10 h 47.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« AUJOURDHUI » à la page 49
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
MINUTE
La fonction MINUTE renvoie les minutes pour une valeur de date/heure donnée.
MINUTE(instant)
Â instant :  heure à utiliser dans la fonction. instant correspond à une valeur de date/
heure. La partie correspondant à la date est ignorée par cette fonction.
Exemple
=MINUTE("6/4/88 11 h 59’ 22") renvoie 59.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
« HEURE » à la page 56
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« MOIS » à la page 61
« SECONDE » à la page 66
« ANNÉE » à la page 48
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
MOIS
La fonction MOIS renvoie le mois pour une valeur de date/heure donnée.
MOIS(date)
Â date :  date à utiliser dans la fonction. date correspond à une valeur de date/heure. 
La partie correspondant à l’heure est ignorée par cette fonction.
Exemple
=MOIS("6 avril 1988 11 h 59’ 22") renvoie 4.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
« HEURE » à la page 56
« MINUTE » à la page 60
« NOMDUMOIS » à la page 63
« SECONDE » à la page 66
« ANNÉE » à la page 48
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28« Collage d’exemples de l’aide » à la page 44
NB.JOURS.OUVRES
La fonction NB.JOURS.OUVRES renvoie le nombre de jours ouvrés entre deux dates. Les 
jours ouvrés excluent les week-ends et les dates indiquées de façon explicite.
NB.JOURS.OUVRES(date-début; date-fin; dates-exclues)
Â date de début :  date de début de la période à calculer. date-début correspond à une 
valeur de date/heure.
Â date de fin :  date de fin de la période à calculer. date-fin correspond à une valeur de 
date/heure.
Â dates-exclues :  collection facultative de dates devant être exclues du calcul. datesexclues correspond à une collection comprenant des valeurs de date/heure.
Exemple
=NB.JOURS.OUVRES("01/11/2009"; "30/11/2009"; {"11/11/2009"; "26/11/2009"}) renvoie 19d, c’est-à-dire 
le nombre de jours ouvrés en novembre 2009 qui exclut les week-ends et les deux jours chômés 
précisés.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DATEDIF » à la page 51
« JOURS360 » à la page 58
« SERIE.JOUR.OUVRE » à la page 66
« FRACTION.ANNEE » à la page 55
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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NOMDUMOIS
La fonction NOMDUMOIS renvoie le nom du mois à partir d’un numéro. Le mois 1 
correspond à janvier.
NOMDUMOIS(mois-nbre)
Â mois-nbre :  mois désiré. mois-nbre correspond à un nombre compris entre 1 et 12. 
Si la valeur de mois-nbre contient une fraction décimale, celle-ci est ignorée.
Exemples
=NOMDUMOIS(9) renvoie « septembre ».
=NOMDUMOIS(6) renvoie « juin ».
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NOMJOUR » à la page 63
« MOIS » à la page 61
« JOURSEM » à la page 59
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
NOMJOUR
La fonction NOMJOUR renvoie le nom du jour de la semaine à partir d’une valeur de 
date/heure ou d’un numéro. Le jour 1 est dimanche.
NOMJOUR(nbre-jour)
Â nbre-jour :  jour souhaité de la semaine. nbre-jour correspond à une valeur de date/
heure ou à un chiffre compris entre 1 et 7. Si la valeur de nbre-jour contient une 
fraction décimale, celle-ci est ignorée.Exemples
Si B1 contient la valeur de date/heure 2 août 1979 06 h 30’ 00’’, que C1 contient la chaîne 16/10/2008 
et que D1 contient 6 :
=NOMJOUR(B1) renvoie « jeudi ».
=NOMJOUR(C1) renvoie « jeudi ».
=NOMJOUR(D1) renvoie « vendredi ».
=NOMJOUR("29/12/1974") renvoie « dimanche ».
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
« NOMDUMOIS » à la page 63
« JOURSEM » à la page 59
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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NO.SEMAINE
La fonction NO.SEMAINE renvoie le numéro de la semaine dans l’année pour une date 
donnée.
NO.SEMAINE(date; premier-jour)
Â date :  date à utiliser dans la fonction. date correspond à une valeur de date/heure. 
La partie correspondant à l’heure est ignorée par cette fonction.
Â premier-jour :  valeur facultative indiquant si les semaines doivent commencer le 
dimanche ou le lundi.
Dimanche correspond au jour numéro 1 (1 ou omis):  dimanche est le premier jour 
(jour 1) de la semaine et samedi est le septième jour.
Lundi correspond au jour numéro 1 (2):  lundi est le premier jour (jour 1) de la 
semaine et dimanche est le septième jour.
Exemple
=NO.SEMAINE("12/7/2009"; 1) renvoie 29.
=NO.SEMAINE("12/7/2009"; 2) renvoie 28.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
« HEURE » à la page 56
« MINUTE » à la page 60
« MOIS » à la page 61
« SECONDE » à la page 66
« ANNÉE » à la page 48
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44SECONDE
La fonction SECONDE renvoie les secondes pour une valeur de date/heure donnée.
SECONDE(instant)
Â instant :  heure à utiliser dans la fonction. instant correspond à une valeur de date/
heure. La partie correspondant à la date est ignorée par cette fonction.
Exemple
=SECONDE("6/4/88 11 h 59’ 22") renvoie 22.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« JOUR » à la page 57
« HEURE » à la page 56
« MINUTE » à la page 60
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
SERIE.JOUR.OUVRE
La fonction SERIE.JOUR.OUVRE renvoie la date qui correspond au nombre donné de 
jours ouvrés avant ou après une date donnée. Les jours ouvrés excluent les week-ends 
et toutes les autres dates prévues en tant que telles.
SERIE.JOUR.OUVRE(date; jours-ouvrés; dates-exclues)
Â date :  date à utiliser dans la fonction. date correspond à une valeur de date/heure. 
La partie correspondant à l’heure est ignorée par cette fonction.
Â jours-ouvrés :  nombre de jours ouvrés avant ou après la date donnée. jours-ouvrés
correspond à un nombre. Elle est positive si la date souhaitée est postérieure à la 
valeur de date et négative si la date souhaitée est antérieure à la valeur de date.
Â dates-exclues :  collection facultative de dates devant être exclues du calcul. datesexclues correspond à une collection comprenant des valeurs de date/heure.
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Exemple
=SERIE.JOUR.OUVRE("01/11/2009"; 20; {"11/11/2009"; "26/11/2009"}) renvoie « 1 déc. 2009 », c’est-à-dire 
le jour ouvré qui vient 20 jours ouvré après le 01/11/2009 si l’on ne compte pas les week-ends et les 
deux jours chômés précisés.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NB.JOURS.OUVRES » à la page 62
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TEMPS
La fonction TEMPS convertit des valeurs distinctes correspondant à des heures, des 
minutes et des secondes en une valeur de date/heure.
TEMPS(heures; minutes; secondes)
Â heures :  nombre d’heures à inclure dans la valeur renvoyée. heures correspond à un 
nombre. Si la valeur d’heures contient une fraction décimale, celle-ci est ignorée.
Â minutes :  nombre de minutes à inclure dans la valeur renvoyée. minutes correspond 
à un nombre. Si la valeur de minutes contient une fraction décimale, celle-ci est 
ignorée.
Â secondes :  nombre de secondes à inclure dans la valeur renvoyée. secondes
correspond à un nombre. Si la valeur de secondes contient une fraction décimale, 
celle-ci est ignorée.
Remarques d’usage
Â Vous pouvez indiquer des valeurs d’heure, de minute et de seconde respectivement 
supérieures à 24, 60 et 60. Si la somme des heures, des minutes et des secondes est 
une valeur supérieure à 24 heures, des tranches de 24 heures lui sont soustraites 
autant de fois que nécessaire jusqu’à ce que la valeur soit inférieure à 24 heures.68 Chapitre 3    Fonctions date et heure
Exemples
=TEMPS(12; 0; 0) renvoie 00 h 00.
=TEMPS(16; 45; 30) renvoie 16 h 45.
=TEMPS(0; 900; 0) renvoie 15 h 00.
=TEMPS(60; 0; 0) renvoie 00 h 00.
=TEMPS(4,25; 0; 0) renvoie 4 h 00.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DATE » à la page 50
« DATEVAL » à la page 53
« DUREE » à la page 71
« Liste des fonctions date et heure » à la page 46
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TEMPSVAL
La fonction TEMPSVAL renvoie l’heure, sous la forme d’une fraction décimale d’une 
journée de 24 heures, à partir d’une valeur de date/heure donnée ou à partir d’une 
chaîne de texte.
TEMPSVAL(instant)
Â instant :  heure à utiliser dans la fonction. instant correspond à une valeur de date/
heure. La partie correspondant à la date est ignorée par cette fonction.
Exemples
=TEMPSVAL("6/4/88 12 h 00") renvoie 0,5 (midi représente en effet la moitié de la journée).
=TEMPSVAL("12 h 00’ 59") renvoie 0,5007 (arrondi à quatre décimales après la virgule).
=TEMPSVAL("21 h 00") renvoie 0,875 (21 heures ou 9 h 00 du soir, divisé par 24).
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions date et heure » à la page 46« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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Les fonctions de durée vous permettent de convertir 
différentes périodes dans le temps, comme des heures, des 
jours et des semaines.
Liste des fonctions de durée
Ces fonctions de manipulation de durées ont été intégrées à iWork pour que vous 
puissiez les utiliser dans des tableaux.
Fonction Description
« DUREE » (page 71) La fonction DUREE associe différentes valeurs 
représentant des semaines, des jours, des heures, 
des minutes, des secondes et des millisecondes, 
et renvoie une durée.
« DUREE.SUPPRESSION » (page 72) La fonction DUREE.SUPPRESSION évalue une 
valeur donnée et renvoie soit le nombre de jours 
représentés, s’il s’agit d’une durée, soit la valeur 
donnée. Cette fonction a été incluse afin d’assurer 
la compatibilité avec les tableurs plus anciens.
« DURHEURES » (page 73) La fonction DURHEURES exprime une durée en 
heures.
« DURJOURS » (page 74) La fonction DURJOURS exprime une durée en 
jours.
« DURMILLISECONDES » (page 74) La fonction DURMILLISECONDES exprime une 
durée en millisecondes.
« DURMINUTES » (page 75) La fonction DURMINUTES exprime une durée en 
minutes.
« DURSECONDES » (page 76) La fonction DURSECONDES exprime une durée 
en secondes.
« DURSEMAINES » (page 77) La fonction DURSEMAINES exprime une durée en 
semaines.
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DUREE
La fonction DUREE combine plusieurs valeurs pour des semaines, des jours, des heures, 
des minutes, des secondes et des millisecondes et renvoie une durée.
DUREE(semaines; jours; heures; minutes; secondes; millisecondes)
Â semaines :  valeur représentant le nombre de semaines. semaines correspond à un 
nombre.
Â jours :  valeur facultative représentant le nombre de jours. jours correspond à un 
nombre.
Â heures :  valeur facultative représentant le nombre d’heures. heures correspond à un 
nombre.
Â minutes :  valeur facultative représentant le nombre de minutes. minutes correspond 
à un nombre.
Â secondes :  valeur facultative représentant le nombre de secondes. secondes
correspond à un nombre.
Â millisecondes :  valeur facultative représentant le nombre de millisecondes. 
millisecondes correspond à un nombre.
Remarques d’usage
Â Un argument égal à 0 peut être omis, mais la virgule doit être insérée si d’autres 
valeurs sont indiquées. Par exemple, DUREE(; ;12; 3) renvoie une durée de 12 h 3 m 
(12 heures et 3 minutes).
Â Les valeurs négatives sont autorisées. Par exemple, DUREE(0; 2; –24) renvoie une 
durée de 1 jour (2 jours moins 24 heures).
Exemples
=DUREE(1) donne 1sem (1 semaine).
=DUREE(;;1) donne 1h (1 heure).
=DUREE(1;5) donne 1sem 3j 12h (1 semaine, 3 jours, 12 heures ou 1,5 semaines).
=DUREE(3; 2; 7; 10; 15,3505) donne 3sem 2j 7h 10m 15s 350ms (3 semaines, 2 jours, 7 heures, 10 
minutes, 15 secondes, 350 millisecondes).
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DATE » à la page 50
« TEMPS » à la page 67
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DUREE.SUPPRESSION
La fonction DUREE.SUPPRESSION évalue une valeur donnée et renvoie soit le nombre 
de jours représentés, s’il s’agit d’une durée, soit la valeur donnée. Cette fonction a été 
incluse afin d’assurer la compatibilité avec les tableurs plus anciens.
DUREE.SUPPRESSION(valeur-quelconque)
Â valeur-quelconque :  valeur quelconque. valeur-quelconque peut correspondre à 
une valeur de n’importe quel type.
Remarques d’usage
Â Si valeur-quelconque est une durée, le résultat est identique à DURJOURS. À défaut, 
valeur-quelconque est renvoyé tel quel.
Â Cette fonction peut être automatiquement insérée si un document Numbers ’08 
est mis à niveau ou si un document Excel ou Appleworks est importé. Elle est 
supprimée si le fichier est enregistré sous le format Numbers ‘08 ou Excel.
Exemples
=DUREE.SUPPRESSION("1sem") donne 7, l’équivalent d’une semaine en jours.
=DUREE.SUPPRESSION(12) donne 12, car, comme il ne s’agissait pas d’une durée, elle est renvoyée 
telle quelle.
=DUREE.SUPPRESSION ("abc") donne « abc ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DURHEURES
La fonction DURHEURES convertit une valeur de durée en un nombre d’heures.
DURHEURES(durée)
Â durée :  période temporelle à convertir. durée correspond à une valeur de durée.
Exemples
=DURHEURES("2sem 3j 2h 10m 0s 5ms") donne 410,1666681.
=DURHEURES("10:0:13:00:05,500") donne 1693,001528.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DURJOURS » à la page 74
« DURMILLISECONDES » à la page 74
« DURMINUTES » à la page 75
« DURSECONDES » à la page 76
« DURSEMAINES » à la page 77
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44DURJOURS
La fonction DURJOURS convertit une valeur de durée en un nombre de jours.
DURJOURS(durée)
Â durée :  période temporelle à convertir. durée correspond à une valeur de durée.
Exemples
=DURJOURS("2sem 3j 2h 10m 0s 5ms") donne 17,09027784.
=DURJOURS("10:0:13:00:05,500") donne 70,5417302.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DURHEURES » à la page 73
« DURMILLISECONDES » à la page 74
« DURMINUTES » à la page 75
« DURSECONDES » à la page 76
« DURSEMAINES » à la page 77
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DURMILLISECONDES
La fonction DURMILLISECONDES convertit une valeur de durée en un nombre de 
millisecondes.
DURMILLISECONDES(durée)
Â durée :  période temporelle à convertir. durée correspond à une valeur de durée.
Exemples
=DURMILLISECONDES("2sem 3j 2h 10m 0s 5ms") donne « 1 476 600 005 ».
=DURMILLISECONDES("10:0:13:00:05,500") donne « 6 094 805 500 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
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« DURJOURS » à la page 74
« DURHEURES » à la page 73
« DURMINUTES » à la page 75
« DURSECONDES » à la page 76
« DURSEMAINES » à la page 77
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DURMINUTES
La fonction DURMINUTES convertit une valeur de durée en un nombre de minutes.
DURMINUTES(durée)
Â durée :  période temporelle à convertir. durée correspond à une valeur de durée.
Exemples
=DURMINUTES("2sem 3j 2h 10m 0s 5ms") donne « 24 610,0000833333 ».
=DURMINUTES("10:0:13:00:05,500") donne « 101 580,091666667 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DURJOURS » à la page 74
« DURHEURES » à la page 73
« DURMILLISECONDES » à la page 74
« DURSECONDES » à la page 76
« DURSEMAINES » à la page 77
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DURSECONDES
La fonction DURSECONDES convertit une valeur de durée en un nombre de secondes.
DURSECONDES(durée)
Â durée :  période temporelle à convertir. durée correspond à une valeur de durée.
Exemples
=DURSECONDES("2sem 3j 2h 10m 0s 5ms") donne « 1 476 600,005 ».
=DURSECONDES("10:0:13:00:05,500") donne « 6 094 805,5 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DURJOURS » à la page 74
« DURHEURES » à la page 73
« DURMILLISECONDES » à la page 74
« DURMINUTES » à la page 75
« DURSEMAINES » à la page 77
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DURSEMAINES
La fonction DURSEMAINES convertit une valeur de durée en un nombre de semaines.
DURSEMAINES(durée)
Â durée :  période temporelle à convertir. durée correspond à une valeur de durée.
Exemples
=DURSEMAINES("2sem 3j 2h 10m 0s 5ms") donne 2,44146826223545.
=DURSEMAINES("10:0:13:00:05,500") donne 10,0773900462963.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DURJOURS » à la page 74
« DURHEURES » à la page 73
« DURMILLISECONDES » à la page 74
« DURMINUTES » à la page 75
« DURSECONDES » à la page 76
« Liste des fonctions de durée » à la page 70
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 4478
Les fonctions d’ingénierie vous aident à calculer certaines 
valeurs d’ingénierie courantes et à effectuer des conversions 
entre différentes bases numériques.
Liste des fonctions d’ingénierie
Ces fonctions d’ingénierie ont été intégrées à iWork pour que vous puissiez les utiliser 
dans des tableaux.
Fonction Description
« BASE10 » (page 79) La fonction BASE10 convertit un nombre de la 
base indiquée en un nombre en base 10.
« BASEN » (page 80) La fonction BASEN convertit un nombre en 
base 10 en un nombre correspondant dans la 
base indiquée.
« BESSELJ » (page 81) La fonction BESSELJ renvoie la fonction de Bessel 
d’ordre entier J
n
(x).
« BESSELY » (page 82) La fonction BESSELY renvoie la fonction de Bessel 
d’ordre entier Y
n
(x).
« BINDEC » (page 83) La fonction BINDEC convertit un nombre binaire 
en un nombre décimal correspondant.
« BINHEX » (page 84) La fonction BINHEX convertit un nombre binaire 
en un nombre hexadécimal correspondant.
« BINOCT » (page 85) La fonction BINOCT convertit un nombre binaire 
en un nombre octal correspondant.
« CONVERT » (page 86) La fonction CONVERT convertit un nombre 
d’un système de mesure en une valeur 
correspondante dans un autre système de 
mesure.
« DECBIN » (page 90) La fonction DECBIN convertit un nombre décimal 
en un nombre binaire correspondant.
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Fonction Description
« DECHEX » (page 91) La fonction DECHEX convertit un nombre décimal 
en un nombre hexadécimal correspondant.
« DECOCT » (page 92) La fonction DECOCT convertit un nombre 
décimal en un nombre octal correspondant.
« DELTA » (page 93) La fonction DELTA détermine si deux valeurs sont 
exactement égales.
« ERF » (page 94) La fonction ERF renvoie la fonction d’erreur 
intégrée entre deux valeurs.
« ERFC » (page 94) La fonction ERFC renvoie la fonction ERF 
complémentaire intégrée entre une limite 
inférieure donnée et l’infini.
« HEXBIN » (page 95) La fonction HEXBIN convertit un nombre 
hexadécimal en un nombre binaire 
correspondant.
« HEXDEC » (page 96) La fonction HEXDEC convertit un nombre 
hexadécimal en un nombre décimal 
correspondant.
« HEXOCT » (page 97) La fonction HEXOCT convertit un nombre 
hexadécimal en un nombre octal correspondant.
« OCTBIN » (page 98) La fonction OCTBIN convertit un nombre octal en 
un nombre binaire correspondant.
« OCTDEC » (page 99) La fonction OCTDEC convertit un nombre octal 
en un nombre décimal correspondant.
« OCTHEX » (page 100) La fonction OCTHEX convertit un nombre octal 
en un nombre hexadécimal correspondant.
« SUP.SEUIL » (page 101) La fonction SUP.SEUIL détermine si une valeur 
est supérieure ou exactement égale à une autre 
valeur.
BASE10
La fonction BASE10 convertit un nombre de la base indiquée en un nombre 
correspondant en base 10.
BASE10(convertir-chaîne; base)
Â convertir-chaîne :  chaîne représentant le nombre à convertir. convertir-chaîne
est une valeur exprimée sous forme de chaîne. Elle ne doit comprendre que des 
nombres et des lettres valides dans la base du nombre qui est converti.
Â base :  base actuelle du nombre à convertir. base correspond à un nombre compris 
entre 1 et 36.Remarques d’usage
Â Cette fonction renvoie une valeur numérique. Elle peut être utilisée sans problème 
dans une formule contenant d’autres valeurs numériques. Certains autres tableurs 
renvoient une valeur de chaîne de caractères.
Exemples
=BASE10("3f"; 16) renvoie 63.
=BASE10(1000100; 2) renvoie 68.
=BASETONUM("7279"; 8) génère une erreur puisque le chiffre « 9 » n’est pas valide en base 8.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINDEC » à la page 83
« HEXDEC » à la page 96
« BASEN » à la page 80
« OCTDEC » à la page 99
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
BASEN
La fonction BASEN convertit un nombre en base 10 en un nombre correspondant dans 
la base indiquée.
BASEN(chaîne-décimale; base; longueur-conversion)
Â chaîne-décimale :  chaîne représentant le nombre à convertir. chaîne-décimale est 
une valeur exprimée sous forme de chaîne. Elle ne doit contenir que des chiffres.
Â base :  base du nombre converti. base correspond à un nombre compris entre 1 et 
36.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
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Exemples
=BASEN(16; 16) renvoie 10.
=BASEN(100; 32; 4) renvoie 0034.
=BASEN(100; 2) renvoie « 1 100 100 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BASE10 » à la page 79
« DECBIN » à la page 90
« DECHEX » à la page 91
« DECOCT » à la page 92
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
BESSELJ
La fonction BESSELJ renvoie la fonction de Bessel d’ordre entier J
n
(x).
BESSELJ(valeur-x-quelconque; valeur-n)
Â valeur-x-quelconque :  valeur x à laquelle vous cherchez à évaluer la fonction. 
valeur-x-quelconque correspond à un nombre.
Â valeur-n :  ordre de la fonction. valeur-n correspond à un nombre supérieur ou égal 
à 0. Si la valeur de valeur-n contient une fraction décimale, celle-ci est ignorée.
Exemples
=BESSELJ(25; 3) renvoie 0,108343081061509.
=BESSELJ(25; 3,9) renvoie également 0,108343081061509 puisque toute fraction décimale de valeur-n
est ignorée.
=BESSELJ(–25; 3) renvoie « – 0,108343081061509 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BESSELY » à la page 82« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
BESSELY
La fonction BESSELY renvoie la fonction de Bessel d’ordre entier Y
n
(x).
BESSELY(valeur-pos-x; valeur-n)
Â valeur-pos-x :  valeur x positive à laquelle vous cherchez à évaluer la fonction. 
valeur-pos-x correspond à un nombre supérieur à 0.
Â valeur-n :  ordre de la fonction. valeur-n correspond à un nombre supérieur ou égal 
à 0. Si la valeur de valeur-n contient une fraction décimale, celle-ci est ignorée.
Remarques d’usage
Â Cette forme de la fonction de Bessel est aussi appelée fonction de Neumann.
Exemples
=BESSELY(25; 3) renvoie 0,117924850396893.
=BESSELY(25; 3,9) renvoie également 0,117924850396893 puisque toute fraction décimale de valeur-n
est ignorée.
=BESSELY(–25; 3) génère une erreur puisque les valeurs négatives ou égales à zéro ne sont pas 
autorisées.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BESSELJ » à la page 81
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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BINDEC
La fonction BINDEC convertit un nombre binaire en un nombre décimal 
correspondant.
BINDEC(chaîne-binaire; longueur-conversion)
Â chaîne-binaire :  chaîne représentant le nombre à convertir. chaîne-binaire est une 
valeur exprimée sous forme de chaîne. Elle ne doit contenir que les chiffres 0 et 1.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Exemples
=BINDEC("1001") renvoie 9.
=BINDEC("100111"; 3) renvoie 039.
=BINDEC(101101) renvoie 45.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINHEX » à la page 84
« BINOCT » à la page 85
« DECBIN » à la page 90
« HEXDEC » à la page 96
« OCTDEC » à la page 99
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44BINHEX
La fonction BINHEX convertit un nombre binaire en un nombre hexadécimal 
correspondant.
BINHEX(chaîne-binaire; longueur-conversion)
Â chaîne-binaire :  chaîne représentant le nombre à convertir. chaîne-binaire est une 
valeur exprimée sous forme de chaîne. Elle ne doit contenir que les chiffres 0 et 1.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Remarques d’usage
Â Cette fonction s’appuie sur la notation de complément de deux, sur 32 bits. Par 
conséquent, les nombres négatifs se limitent toujours à 8 chiffres.
Exemples
=BINHEX("100101") renvoie 25.
=BINHEX("100111"; 3) renvoie 027.
=BINHEX(101101) renvoie 2D.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINDEC » à la page 83
« BINOCT » à la page 85
« DECHEX » à la page 91
« HEXBIN » à la page 95
« OCTHEX » à la page 100
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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BINOCT
La fonction BINOCT convertit un nombre binaire en un nombre octal correspondant.
BINOCT(chaîne-binaire; longueur-conversion)
Â chaîne-binaire :  chaîne représentant le nombre à convertir. chaîne-binaire est une 
valeur exprimée sous forme de chaîne. Elle ne doit contenir que les chiffres 0 et 1.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Remarques d’usage
Â Cette fonction s’appuie sur la notation de complément de deux, sur 32 bits. Par 
conséquent, les nombres négatifs se limitent toujours à 11 chiffres.
Exemples
=BINOCT("10011") renvoie 23.
=BINOCT("100111"; 3) renvoie 047.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINHEX » à la page 84
« DECOCT » à la page 92
« HEXOCT » à la page 97
« OCTBIN » à la page 98
« BINDEC » à la page 83
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44CONVERT
La fonction CONVERT convertit un nombre d’un système de mesure en une valeur 
correspondante dans un autre système de mesure.
CONVERT(convertir-nbre; unité-initiale; unité-finale)
Â convertir-nbre :  nombre à convertir. convertir-nbre correspond à un nombre.
Â unité-initiale :  unité actuelle du nombre à convertir. unité-initiale est une valeur 
exprimée sous forme de chaîne. Elle doit correspondre à l’une des constantes 
mentionnées.
Â unité-finale :  unité du nombre converti. unité-finale est une valeur exprimée sous 
forme de chaîne. Elle doit correspondre à l’une des constantes mentionnées.
Remarques d’usage
Â Les valeurs possibles d’unité-initiale et d’unité-finale sont indiquées dans les tableaux 
qui suivent les exemples (« Unités de conversion prises en charge » à la page 87). 
Ces tableaux sont organisés en catégories. Si la valeur est saisie dans une cellule 
référencée, au lieu d’être tapée directement dans la fonction, les guillemets qui 
apparaissent dans les tableaux ne sont pas requis. La casse est importante. Elle doit 
être scrupuleusement respectée.
Exemples
=CONVERT(9; "lbm"; "kg") renvoie 4,08233133 (9 livres équivalent à environ 4,08 kilogrammes).
=CONVERT (26,2; "mi"; "m") renvoie 42164,8128 (26,2 miles équivalent à environ 42 164,8 mètres).
=CONVERT(1; "tsp"; "ml") renvoie 4,92892159375 (1 cuillère à café équivaut à environ 4,9 millilitres).
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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Unités de conversion prises en charge
Poids et masse
Mesure Constante
Gramme « g » (utilisable avec des préfixes métriques)
Slug « sg »
Livre (unité de masse du système avoirdupois) « lbm »
U (unité de masse atomique) « u » (utilisable avec des préfixes métriques)
Once (unité de masse du système avoirdupois) « ozm »
Distance
Mesure Constante
Mètre « m » (utilisable avec des préfixes métriques)
Mile terrestre « mi »
Mille nautique « Nmi »
Pouce « in »
Pied « ft »
Yard « yd »
Angström « ang » (utilisable avec des préfixes métriques)
Pica (1/6 po, Postscript Pica) « Pica »
Durée
Mesure Constante
Année « yr »
Semaine « wk »
Jour « day »
Heure « hr »
Minute « mn »
Seconde « sec » (can be used with metric prefixes)Vitesse
Mesure Constante
Miles par heure « mi/h »
Miles par minute « mi/mn »
Mètres par heure « m/h » (utilisable avec des préfixes métriques)
Mètres par minute « m/mn » (utilisable avec des préfixes métriques)
Mètres par seconde « m/s » (utilisable avec des préfixes métriques)
Pieds par minute « ft/mn »
Pieds par seconde « ft/s »
Nœud « kt »
Pression
Mesure Constante
Pascal « Pa » (utilisable avec des préfixes métriques)
Atmosphère « atm » (utilisable avec des préfixes métriques)
Millimètres de mercure « mmHg » (utilisable avec des préfixes métriques)
Force
Mesure Constante
Newton « N » (utilisable avec des préfixes métriques)
Dyne « dyn » (utilisable avec des préfixes métriques)
Livre « lbf »
Énergie
Mesure Constante
Joule « J » (utilisable avec des préfixes métriques)
Erg « e » (utilisable avec des préfixes métriques)
Calorie thermodynamique « c » (utilisable avec des préfixes métriques)
Calorie IT « cal » (utilisable avec des préfixes métriques)
Électronvolt « eV » (utilisable avec des préfixes métriques)
Cheval-heure « HPh »
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Mesure Constante
Watt-heure « Wh » (utilisable avec des préfixes métriques)
Livre-pied « flb »
BTU (Unité thermique britannique) « BTU »
Puissance
Mesure Constante
Cheval « HP »
Watt « W » (utilisable avec des préfixes métriques)
Magnétisme
Mesure Constante
Tesla « T » (utilisable avec des préfixes métriques)
Gauss « ga » (utilisable avec des préfixes métriques)
Température
Mesure Constante
Degrés Celsius « C »
Degrés Fahrenheit « F »
Kelvins « K » (utilisable avec des préfixes métriques)
Volume liquide
Mesure Constante
Cuillère à café « tsp »
Cuillère à soupe « tbs »
Once liquide « oz »
Tasse « cup »
Pinte américaine « pt »
Pinte britannique « uk_pt »
Quart « qt »
Gallon « gal »
Litre « l » (utilisable avec des préfixes métriques)Préfixes métriques
Mesure Constante Facteur
Exa « E » 1E+18
Péta « P » 1E+15
Téra « T » 1E+12
Giga « G » 1E+09
Méga « M » 1E+06
Kilo « k » 1E+03
Hecto « h » 1E+02
Déca « e » 1E+01
déci « d » 1E-01
centi « c » 1E-02
milli « m » 1E-03
micro « u » ou « µ » 1E-06
nano « n » 1E-09
pico « p » 1E–12
femto « f » 1E–15
atto « a » 1E–18
Remarques d’usage
Â Ces préfixes ne peuvent être utilisés qu’avec les constantes métriques g, u, m, ang, 
sec, m/h, m/mn, m/s, Pa, atm, mmHg, N, dyn, J, e, c, cal, eV, Wh, W, T, ga, K et l.
DECBIN
La fonction DECBIN convertit un nombre décimal en un nombre binaire 
correspondant.
DECBIN(chaîne-décimale; longueur-conversion)
Â chaîne-décimale :  chaîne représentant le nombre à convertir. chaîne-décimale est 
une valeur exprimée sous forme de chaîne. Elle ne doit contenir que des chiffres.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
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Exemples
=DECBIN(100) renvoie 01100100.
=DECBIN("1001"; 12) renvoie 001111101001.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINDEC » à la page 83
« DECHEX » à la page 91
« DECOCT » à la page 92
« HEXBIN » à la page 95
« OCTBIN » à la page 98
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DECHEX
La fonction DECHEX convertit un nombre décimal en un nombre hexadécimal 
correspondant.
DECHEX(chaîne-décimale; longueur-conversion)
Â chaîne-décimale :  chaîne représentant le nombre à convertir. chaîne-décimale est 
une valeur exprimée sous forme de chaîne. Elle ne doit contenir que des chiffres.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Exemples
=DECHEX(100) renvoie 64.
=DECHEX("1001"; 4) renvoie 03E9.Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINHEX » à la page 84
« DECBIN » à la page 90
« DECOCT » à la page 92
« HEXDEC » à la page 96
« OCTHEX » à la page 100
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DECOCT
La fonction DECOCT convertit un nombre décimal en un nombre octal correspondant.
DECOCT(chaîne-décimale; longueur-conversion)
Â chaîne-décimale :  chaîne représentant le nombre à convertir. chaîne-décimale est 
une valeur exprimée sous forme de chaîne. Elle ne doit contenir que des chiffres.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Exemples
=DECOCT(100) renvoie 144.
=DECOCT("1001"; 4) renvoie 1751.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINOCT » à la page 85
« DECBIN » à la page 90
« DECHEX » à la page 91
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« HEXOCT » à la page 97
« OCTDEC » à la page 99
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DELTA
La fonction DELTA détermine si deux valeurs sont exactement égales. Cette fonction 
s’appuie sur une égalité exacte. À titre de comparaison, l’opérateur = s’appuie sur une 
égalité de chaîne.
DELTA(comparer-de; comparer-à)
Â comparer-de :  valeur numérique. comparer-de correspond à un nombre.
Â comparer-à :  valeur numérique. comparer-à correspond à un nombre.
Remarques d’usage
Â DELTA renvoie 1 (VRAI) si la valeur comparer-de est exactement égale à la valeur 
comparer-à ; sinon, la fonction renvoie 0 (FAUX).
Exemples
=DELTA(5; 5) renvoie 1 (VRAI).
=DELTA(5; –5) renvoie 0 (FAUX).
=DELTA(5; 5000) renvoie 1 (VRAI).
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« SUP.SEUIL » à la page 101
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44ERF
La fonction ERF renvoie la fonction d’erreur intégrée entre deux valeurs.
ERF(inférieur; supérieur)
Â inférieur :  limite inférieure. inférieur correspond à un nombre.
Â supérieur :  argument facultatif représentant la limite supérieure. supérieur
correspond à un nombre. Si supérieur est omis, la valeur supposée par défaut 
correspond à 0.
Remarques d’usage
Â Cette fonction est aussi appelée la fonction d’erreur de Gauss.
Exemples
=ERF(0; 1) renvoie 0,842700792949715.
=ERF(–1; 1) renvoie 1,68540158589943.
=ERF(1; 8) renvoie 0,157299207050285.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« ERFC » à la page 94
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ERFC
La fonction ERFC renvoie la fonction ERF complémentaire intégrée entre une limite 
inférieure donnée et l’infini.
ERFC(inférieur)
Â inférieur :  limite inférieure. inférieur correspond à un nombre.
Exemples
=ERFC(-1) renvoie 1,84270079294971.
=ERFC(1) renvoie 0,157299207050285.
=ERFC(12) renvoie 1,3562611692059E–64.
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Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« ERF » à la page 94
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
HEXBIN
La fonction HEXBIN convertit un nombre hexadécimal en un nombre binaire 
correspondant.
HEXBIN(chaîne-hexadécimale; longueur-conversion)
Â chaîne-hexadécimale :  chaîne représentant le nombre à convertir. chaînehexadécimale est une valeur exprimée sous forme de chaîne. Elle ne doit contenir 
que des chiffres et des lettres se limitant à A à F.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Remarques d’usage
Â Cette fonction s’appuie sur la notation de complément de deux, sur 32 bits. Par 
conséquent, les nombres négatifs se limitent toujours à 32 chiffres.
Exemples
=HEXBIN("F"; 8) renvoie « 00 001 111 ».
=HEXBIN("3F") renvoie « 0 111 111 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINHEX » à la page 84
« HEXDEC » à la page 96
« HEXOCT » à la page 97« OCTBIN » à la page 98
« DECBIN » à la page 90
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
HEXDEC
La fonction HEXDEC convertit un nombre hexadécimal en un nombre décimal 
correspondant.
HEXDEC(chaîne-hexadécimale; longueur-conversion)
Â chaîne-hexadécimale :  chaîne représentant le nombre à convertir. chaînehexadécimale est une valeur exprimée sous forme de chaîne. Elle ne doit contenir 
que des chiffres et des lettres se limitant à A à F.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Exemples
=HEXDEC("F"; 3) renvoie 015.
=HEXDEC("3F") renvoie 63.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINDEC » à la page 83
« DECHEX » à la page 91
« HEXBIN » à la page 95
« HEXOCT » à la page 97
« OCTDEC » à la page 99
« Liste des fonctions d’ingénierie » à la page 78
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« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
HEXOCT
La fonction HEXOCT convertit un nombre hexadécimal en un nombre octal 
correspondant.
HEXOCT(chaîne-hexadécimale; longueur-conversion)
Â chaîne-hexadécimale :  chaîne représentant le nombre à convertir. chaînehexadécimale est une valeur exprimée sous forme de chaîne. Elle ne doit contenir 
que des chiffres et des lettres se limitant à A à F.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Remarques d’usage
Â Cette fonction s’appuie sur la notation de complément de deux, sur 32 bits. Par 
conséquent, les nombres négatifs se limitent toujours à 11 chiffres.
Exemples
=HEXOCT("F"; 3) renvoie 017.
=HEXOCT("4E") renvoie 116.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINOCT » à la page 85
« DECOCT » à la page 92
« HEXBIN » à la page 95
« HEXDEC » à la page 96
« OCTHEX » à la page 100
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
OCTBIN
La fonction OCTBIN convertit un nombre octal en un nombre binaire correspondant.
OCTBIN(chaîne-octale; longueur-conversion)
Â chaîne-octale :  chaîne représentant le nombre à convertir. chaîne-octale est une 
valeur exprimée sous forme de chaîne. Elle ne doit contenir que les chiffres 0 à 7.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Remarques d’usage
Â Cette fonction s’appuie sur la notation de complément de deux, sur 32 bits. Par 
conséquent, les nombres négatifs se limitent toujours à 32 chiffres.
Exemples
=OCTBIN(127; 8) renvoie 01 010 111.
=OCTBIN(15) renvoie 01 101.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINOCT » à la page 85
« DECBIN » à la page 90
« HEXBIN » à la page 95
« OCTDEC » à la page 99
« OCTHEX » à la page 100
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
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« Collage d’exemples de l’aide » à la page 44
OCTDEC
La fonction OCTDEC convertit un nombre octal en un nombre décimal correspondant.
OCTDEC(chaîne-octale; longueur-conversion)
Â chaîne-octale :  chaîne représentant le nombre à convertir. chaîne-octale est une 
valeur exprimée sous forme de chaîne. Elle ne doit contenir que les chiffres 0 à 7.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Exemples
=OCTDEC(127; 4) renvoie 0087.
=OCTDEC(15) renvoie 13.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINDEC » à la page 83
« DECOCT » à la page 92
« OCTBIN » à la page 98
« OCTHEX » à la page 100
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44OCTHEX
La fonction OCTHEX convertit un nombre octal en un nombre hexadécimal 
correspondant.
OCTHEX(chaîne-octale; longueur-conversion)
Â chaîne-octale :  chaîne représentant le nombre à convertir. chaîne-octale est une 
valeur exprimée sous forme de chaîne. Elle ne doit contenir que les chiffres 0 à 7.
Â longueur-conversion :  valeur facultative représentant la longueur minimale du 
nombre renvoyé. longueur-conversion correspond à un nombre compris entre 1 et 
32. En l’absence de valeur explicite, la valeur par défaut correspond à 1. Si elle est 
incluse, au besoin, des zéros sont ajoutés en tête de la valeur de convertir-chaîne de 
sorte que sa longueur atteigne au moins celle indiquée par longueur-conversion.
Remarques d’usage
Â Cette fonction s’appuie sur la notation de complément de deux, sur 32 bits. Par 
conséquent, les nombres négatifs se limitent toujours à 8 chiffres.
Exemples
=OCTHEX(127; 4) renvoie 0057.
=OCTHEX(15) renvoie 0D.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« BINHEX » à la page 84
« DECHEX » à la page 91
« HEXOCT » à la page 97
« OCTBIN » à la page 98
« OCTDEC » à la page 99
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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SUP.SEUIL
La fonction SUP.SEUIL détermine si une valeur est supérieure ou exactement 
égale à une autre valeur. Cette fonction s’appuie sur une égalité exacte. À titre de 
comparaison, l’opérateur = s’appuie sur une égalité de chaîne.
SUP.SEUIL(nbre-à-comparer; écart-nombre)
Â nbre-à-comparer :  nombre à comparer. nbre-à-comparer correspond à un nombre.
Â écart-nombre :  valeur du pas. écart-nombre correspond à un nombre.
Remarques d’usage
Â SUP.SEUIL renvoie 1 (VRAI) si la valeur nbre-à-comparer est supérieure ou égale à la 
valeur écart-nombre ; sinon, la fonction renvoie 0 (FAUX).
Exemples
=SUP.SEUIL(–4, –5) renvoie 1 (VRAI) puisque – 4 est supérieur à – 5.
=SUP.SEUIL(4, 5) renvoie 0 (FAUX) puisque 4 est inférieur à 5.
=SUP.SEUIL(5; 4) renvoie 1 (VRAI) puisque 5 est supérieur à 4.
=GESTEP(20; 20) renvoie 1 (VRAI) puisque 20 est exactement égal à 20.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DELTA » à la page 93
« Liste des fonctions d’ingénierie » à la page 78
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44102
L’aide sur les fonctions financières vous aide à travailler avec 
des flux de trésorerie, des actifs amortissables, des annuités 
et des investissements en résolvant des problèmes comme 
le calcul de l’amortissement annuel d’un actif, les intérêts 
gagnés sur un investissement et le prix du marché courant 
d’une obligation.
Liste des fonctions financières
Ces fonctions financières ont été intégrées à iWork pour que vous puissiez les utiliser 
dans des tableaux.
Fonction Description
« AMORLIN » (page 106) La fonction AMORLIN renvoie le montant de 
l’amortissement d’un actif par période en faisant 
appel à la méthode de l’amortissement linéaire.
« CUMUL.INTER » (page 107) La fonction CUMUL.INTER renvoie les intérêts 
totaux inclus dans des paiements de rente ou de 
remboursement d’un prêt dans un intervalle de 
temps donné en s’appuyant sur des paiements 
périodiques fixes et sur un taux d’intérêt fixe.
« CUMUL.PRINCPER » (page 109) La fonction CUMUL.PRINCPER renvoie le principal 
total inclus dans des paiements de rente ou de 
remboursement d’un prêt dans un intervalle de 
temps donné en s’appuyant sur des paiements 
périodiques fixes et sur un taux d’intérêt fixe.
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Fonction Description
« DB » (page 111) La fonction DB renvoie le montant 
d’amortissement d’un actif pour une 
période indiquée à l’aide de la méthode de 
l’amortissement dégressif à taux constant.
« DDB » (page 113) La fonction DDB renvoie le montant 
d’amortissement d’un actif en s’appuyant sur le 
taux d’amortissement indiqué.
« DUREE.M.OBLIGATION » (page 115) La fonction DUREE.M.OBLIGATION calcule 
la moyenne pondérée modifiée de la valeur 
actualisée des flux de trésorerie pour une valeur 
nominale de 100 €.
« DUREE.OBLIGATION » (page 116) La fonction DUREE.OBLIGATION calcule la 
moyenne pondérée de la valeur actualisée des 
flux de trésorerie pour une valeur nominale de 
100 €.
« INTERET.ACC » (page 118) La fonction INTERET.ACC calcule les intérêts 
courus totaux ajoutés au prix d’achat d’un titre 
et payés au vendeur lorsque le titre verse des 
intérêts périodiques.
« INTERET.ACC.MAT » (page 120) La fonction INTERET.ACC.MAT calcule les intérêts 
courus totaux ajoutés au prix d’achat d’un titre 
et payés au vendeur lorsque le titre ne verse 
d’intérêts qu’à l’échéance.
« INTPER » (page 121) La fonction INTPER renvoie la part des intérêts 
de paiement d’une rente ou de remboursement 
d’un prêt en s’appuyant sur des paiements 
périodiques fixes et sur un taux d’intérêt fixe.
« ISPMT » (page 123) La fonction ISPMT renvoie la part des intérêts 
de paiement d’une rente ou de remboursement 
d’un prêt en s’appuyant sur des paiements 
périodiques fixes et sur un taux d’intérêt fixe. 
Cette fonction a été incluse afin d’assurer la 
compatibilité avec les tableaux importés d’autres 
tableurs.
« NB.COUPONS » (page 124) La fonction NB.COUPONS renvoie le nombre 
de coupons restant à payer entre la date de 
règlement et l’échéance.Fonction Description
« NB.JOURS.COUPON » (page 125) La fonction NB.JOURS.COUPON renvoie le 
nombre de jours dans la période de coupon dans 
laquelle le règlement a lieu.
« NB.JOURS.COUPON.SUIV » (page 126) La fonction NB.JOURS.COUPON.PREC renvoie le 
nombre de jours entre le début de la période de 
coupon dans laquelle le règlement a lieu et la 
date de règlement.
« NB.JOURS.COUPON.SUIV » (page 128) La fonction NB.JOURS.COUPON.SUIV renvoie le 
nombre de jours entre la date de règlement et 
la fin de la période de coupon dans laquelle le 
règlement a lieu.
« NPM » (page 129) La fonction NPM renvoie le nombre de périodes 
de paiement pour un prêt ou une annuité en 
s’appuyant sur une série de flux de trésorerie 
périodiques réguliers (paiements d’un montant 
constant et tous les flux de trésorerie à intervalles 
constants) et d’un taux d’intérêt fixe.
« PRINCPER » (page 131) La fonction PRINCPER renvoie la part du principal 
du paiement d’une rente ou du remboursement 
d’un prêt en s’appuyant sur des paiements 
périodiques fixes et sur un taux d’intérêt fixe.
« PRIX.TITRE » (page 133) La fonction PRIX.TITRE renvoie le prix d’un titre 
qui verse des intérêts périodiques par tranche de 
100 € de valeur de remboursement (nominale).
« PRIX.TITRE.ECHEANCE » (page 134) La fonction PRIX.TITRE.ECHEANCE renvoie le prix 
d’un titre qui verse des intérêts périodiques par 
tranche de 100 € de valeur de remboursement 
(nominale).
« RENDEMENT.SIMPLE » (page 136) La fonction RENDEMENT.SIMPLE renvoie le taux 
d’intérêt annuel effectif d’un titre qui est vendu 
avec un escompte par rapport à son prix de 
remboursement et qui ne verse pas d’intérêts.
« RENDEMENT.TITRE » (page 137) La fonction RENDEMENT.TITRE renvoie le taux 
d’intérêt annuel effectif d’un titre qui verse des 
intérêts périodiques réguliers.
« RENDEMENT.TITRE.ECHEANCE » (page 139) La fonction RENDEMENT.TITRE.ECHEANCE renvoie 
le taux d’intérêt annuel effectif d’un titre qui ne 
verse d’intérêts qu’à l’échéance.
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Fonction Description
« SYD » (page 140) La fonction SYD renvoie le montant de 
l’amortissement d’un actif sur une période 
indiquée en s’appuyant sur la méthode de 
l’amortissement proportionnel à l’ordre 
numérique inversé des années.
« TAUX » (page 141) La fonction TAUX renvoie le taux d’intérêt d’un 
investissement, d’un prêt ou d’une annuité en 
s’appuyant sur une série de flux de trésorerie 
périodiques réguliers (paiements d’un montant 
constant et tous les flux de trésorerie à intervalles 
constants) et d’un taux d’intérêt fixe.
« TAUX.EFFECTIF » (page 144) La fonction TAUX.EFFECTIF renvoie le taux 
d’intérêt effectif annuel à partir du taux d’intérêt 
annuel nominal en s’appuyant sur le nombre 
de périodes par année de calcul de l’intérêt 
composé.
« TAUX.ESCOMPTE » (page 145) La fonction TAUX.ESCOMPTE renvoie le taux 
d’escompte annuel d’un titre qui ne paie pas 
d’intérêts et qui est vendu avec un escompte par 
rapport à son prix de remboursement.
« TAUX.INTERET » (page 146) La fonction TAUX.INTERET renvoie le taux 
d’intérêt annuel effectif d’un titre qui ne verse 
d’intérêts qu’à l’échéance.
« TAUX.NOMINAL » (page 147) La fonction TAUX.NOMINAL renvoie le taux 
d’intérêt nominal annuel à partir du taux d’intérêt 
annuel effectif en s’appuyant sur le nombre 
de périodes par année de calcul de l’intérêt 
composé.
« TRI » (page 148) La fonction TRI renvoie le taux de rendement 
interne d’un investissement qui s’appuie sur une 
série de flux de trésorerie pouvant être irréguliers 
mais réalisés à intervalles réguliers.
« TRIM » (page 150) La fonction TRIM renvoie le taux de rendement 
interne modifié pour un investissement qui 
est basé sur une série de flux de trésorerie 
potentiellement irréguliers réalisés à des 
intervalles réguliers. Le taux gagné sur les flux de 
trésorerie positifs et le taux payé pour financer les 
flux de trésorerie négatifs peuvent différer.
« VA » (page 152) La fonction VA renvoie la valeur actualisée d’un 
investissement ou d’une annuité en s’appuyant 
sur une série de flux de trésorerie périodiques 
réguliers (paiements d’un montant constant et 
tous les flux de trésorerie à intervalles constants) 
et d’un taux d’intérêt fixe.Fonction Description
« VALEUR.ENCAISSEMENT » (page 154) La fonction VALEUR.ENCAISSEMENT renvoie le 
prix d’un titre qui est vendu avec un escompte 
par rapport au prix de remboursement et qui 
ne verse pas d’intérêts par tranche de 100 € de 
valeur de remboursement (valeur nominale).
« VALEUR.NOMINALE » (page 156) La fonction VALEUR.NOMINALE renvoie la valeur 
à l’échéance d’un titre qui ne verse d’intérêts qu’à 
l’échéance.
« VAN » (page 157) La fonction VAN renvoie la valeur actualisée nette 
pour un investissement qui s’appuie sur une série 
de flux de trésorerie pouvant être irréguliers mais 
réalisés à intervalles réguliers.
« VC » (page 159) La fonction VC renvoie la valeur future d’un 
investissement en s’appuyant sur une série 
de flux de trésorerie périodiques réguliers 
(paiements d’un montant constant et tous les 
flux de trésorerie à intervalles constants) et d’un 
taux d’intérêt fixe.
« VDB » (page 161) La fonction VDB renvoie le montant 
d’amortissement d’un actif sur un intervalle 
de temps choisi en s’appuyant sur un taux 
d’amortissement indiqué.
« VPM » (page 163) La fonction VPM renvoie le paiement périodique 
pour un prêt ou une annuité en s’appuyant 
sur une série de flux de trésorerie périodiques 
réguliers (paiements d’un montant constant et 
tous les flux de trésorerie à intervalles constants) 
et d’un taux d’intérêt fixe.
AMORLIN
La fonction AMORLIN renvoie le montant de l’amortissement d’un actif par période en 
faisant appel à la méthode de l’amortissement linéaire.
AMORLIN(montant; amortissement comptable; vie)
Â coût :  coût initial de l’actif. montant correspond à un nombre supérieur ou égal à 0.
Â récupération :  valeur de récupération de l’actif. amortissement comptable
correspond à un nombre supérieur ou égal à 0.
Â vie :  nombre de périodes d’amortissement de l’actif. vie correspond à un nombre 
supérieur à 0. Une partie décimale (fraction) de vie est autorisée (par exemple, une 
durée d’amortissement de 5,5 années).
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Exemple
=AMORLIN(10000; 1000; 6) renvoie 1 500 €, l’amortissement par année en euros d’un actif qui a coûté 
à l’origine 10 000 € et qui présente une valeur résiduelle estimée de 1 000 € après 6 années.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DB » à la page 111
« DDB » à la page 113
« SYD » à la page 140
« VDB » à la page 161
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
CUMUL.INTER
La fonction CUMUL.INTER renvoie les intérêts totaux inclus dans des paiements 
de rente ou de remboursement d’un prêt dans un intervalle de temps donné en 
s’appuyant sur des paiements périodiques fixes et sur un taux d’intérêt fixe.
CUMUL.INTER(taux-périodique; nbre-périodes; valeur-actualisée; période-initiale; périodefinale; échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).Â période-initiale :  période de départ à inclure dans le calcul. période-initiale
correspond à un nombre.
Â période-finale :  période de fin à inclure dans le calcul. période-finale correspond à 
un nombre supérieur à 0 et à période-initiale.
Â échéance :  indique si les paiements sont dus au début ou à la fin de chaque 
période.
fin (0):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Remarques d’usage
Â Si règlement est antérieur à premier, la fonction renvoie les intérêts courus depuis 
émission. Si règlement est postérieur à premier, la fonction renvoie les intérêts courus 
depuis la date de paiement du coupon immédiatement antérieure à règlement.
Â Utilisez INTERET.ACC.MAT pour un titre qui ne paie des intérêts qu’à l’échéance.
Exemples
En général, le montant des intérêts payés sur un prêt est plus élevé dans les premières années que 
dans les dernières années. Cet exemple montre à quel point les premières années peuvent être plus 
élevées. Imaginons un prêt hypothécaire avec un prêt initial de 550 000 €, un taux d’intérêt de 6 % et 
une échéance à 30 ans.
La fonction CUMUL.INTER peut être utilisée pour déterminer les intérêts pour n’importe quelle 
période. Dans le tableau qui suit, CUMIPMT a été utilisé pour déterminer les intérêts payés la 
première année (paiements 1à 12) et la dernière année (paiements 349 à 360) du terme du prêt. La 
fonction renvoie respectivement les valeurs 32 816,27 € et 1 256,58 €. Le montant des intérêts payés 
la première année est plus de 26 fois supérieur au montant des intérêts payés la dernière année. 
tauxpériodique
nbre-périodes valeuractualisée
période-initiale période-finale échéance
=CUMUL.INTER 
(B2; C2; D2; E2; 
F2; G2)
=0,06/12 360 =550000 1 12 0
=CUMUL.INTER 
(B2; C2; D2; E3; 
F3; G2)
       349 360  
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« CUMUL.PRINCPER » à la page 109
« INTPER » à la page 121
« VPM » à la page 163
« PRINCPER » à la page 131
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« Exemple de tableau d’amortissement pour un prêt » à la page 381
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
CUMUL.PRINCPER
La fonction CUMUL.PRINCPER renvoie le principal total inclus dans des paiements 
de rente ou de remboursement d’un prêt dans un intervalle de temps donné en 
s’appuyant sur des paiements périodiques fixes et sur un taux d’intérêt fixe.
CUMUL.PRINCPER(taux-périodique; nbre-périodes; valeur-actualisée; période-initiale; 
période-finale; échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).
Â période-initiale :  période de départ à inclure dans le calcul. période-initiale
correspond à un nombre.
Â période-finale :  période de fin à inclure dans le calcul. période-finale correspond à 
un nombre supérieur à 0 et à période-initiale.
Â échéance :  indique si les paiements sont dus au début ou à la fin de chaque 
période.
fin (0):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.Exemples
En général, le montant de la réduction de principal sur un prêt est plus élevé dans les dernières 
années que dans les premières années. Cet exemple montre à quel point les dernières années 
peuvent être plus élevées. Imaginons un prêt hypothécaire avec un prêt initial de 550 000 €, un taux 
d’intérêt de 6 % et une échéance à 30 ans.
La fonction CUMUL.PRINCPER peut être utilisée pour déterminer les intérêts pour n’importe quelle 
période. Dans le tableau qui suit, CUMUL.PRINCPER a été utilisé pour déterminer le principal 
remboursé la première année (paiements 1à 12) et la dernière année (paiements 349 à 360) du terme 
du prêt. La fonction renvoie respectivement les valeurs 6 754,06 € et 38 313,75 €. Le montant de 
principal payé la première année ne représente que 18 % du montant de principal payé la dernière 
année. 
tauxpériodique
nbre-périodes valeuractualisée
période-initiale période-finale échéance
=CUMUL.
PRINCPER (B2; 
C2; D2; E2; F2; 
G2)
=0,06/12 360 =550000 1 12 0
=CUMUL.
PRINCPER (B2; 
C2; D2; E3; F3; 
G2)
       349 360  
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« CUMUL.INTER » à la page 107
« INTPER » à la page 121
« VPM » à la page 163
« PRINCPER » à la page 131
« Exemple de tableau d’amortissement pour un prêt » à la page 381
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DB
La fonction DB renvoie le montant d’amortissement d’un actif pour une période 
indiquée à l’aide de la méthode de l’amortissement dégressif à taux constant.
DB(montant; amortissement comptable; vie; période-amort; première-année-mois)
Â coût :  coût initial de l’actif. montant correspond à un nombre supérieur ou égal à 0.
Â récupération :  valeur de récupération de l’actif. amortissement comptable
correspond à un nombre supérieur ou égal à 0.
Â vie :  nombre de périodes d’amortissement de l’actif. vie correspond à un nombre 
supérieur à 0. Une partie décimale (fraction) de vie est autorisée (par exemple, une 
durée d’amortissement de 5,5 années).
Â période-amort :  période sur laquelle vous cherchez à calculer l’amortissement. 
période-amort correspond à un nombre supérieur à 0. Toute partie décimale 
(fraction) de période-amort est ignorée.
Â mois de la première année :  argument facultatif représentant le nombre de mois 
de la première année d’amortissement. première-année-mois correspond à un 
nombre compris entre 1 et 12. Toute partie décimale (fraction) de première-annéemois est ignorée.
Exemple 1
Construction d’un plan d’amortissement 
Imaginons que vous venez d’acquérir un actif d’une valeur de 1 000 €, une valeur résiduelle de 100 € 
et une durée de vie utile estimée à 4 ans. L’actif peut s’amortir sur 12 mois au cours de la première 
année.
Avec la fonction DB, vous pouvez construire un tableau d’amortissement indiquant l’amortissement 
pour chaque année.
   montant amortissement 
comptable
vie période-amort première-annéemois
   1 000 100 4   12
Première année 
(renvoie 438 €)
=DB(B2; C2; D2; 
E3; F2)
     1  
Deuxième année 
(renvoie 246,16 €)
=DB(B2; C2; D2; 
E4; F2)
     2  
Troisième année 
(renvoie 138,74 €)
=DB(B2; C2; D2; 
E5; F2)
     3  
Quatrième année 
(renvoie 77,75 €)
=DB(B2; C2; D2; 
E6; F2)
     4  Exemple 2
Amortissement pour la première année partielle
Prenons les mêmes faits que dans l’exemple 1, mais imaginons que l’actif soit amorti pendant mois 
de 12 mois la première année.
   montant amortissement 
comptable
vie période-amort première-annéemois
   1 000 100 4 1  
Amortir pendant 
9 mois (renvoie 
328,50 €)
=DB(B2; C2; D2; 
E2; F3)
       9
Amortir pendant 
6 mois (renvoie 
219 €)
=DB(B2; C2; D2; 
E2; F4)
       3
Amortir pendant 
3 mois (renvoie 
109,50 €)
=DB(B2; C2; D2; 
E2; F5)
       6
Amortir pendant 
1 mois (renvoie 
36,50 €)
=DB(B2; C2; D2; 
E2; F6)
       1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DDB » à la page 113
« AMORLIN » à la page 106
« SYD » à la page 140
« VDB » à la page 161
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DDB
La fonction DDB renvoie le montant d’amortissement d’un actif en s’appuyant sur le 
taux d’amortissement indiqué.
DDB(montant; amortissement comptable; vie; période-amort; facteur-amort)
Â coût :  coût initial de l’actif. montant correspond à un nombre supérieur ou égal à 0.
Â récupération :  valeur de récupération de l’actif. amortissement comptable
correspond à un nombre supérieur ou égal à 0.
Â vie :  nombre de périodes d’amortissement de l’actif. vie correspond à un nombre 
supérieur à 0. Une partie décimale (fraction) de vie est autorisée (par exemple, une 
durée d’amortissement de 5,5 années).
Â période-amort :  période sur laquelle vous cherchez à calculer l’amortissement. 
période-amort correspond à un nombre supérieur à 0. Toute partie décimale 
(fraction) de période-amort est ignorée.
Â facteur-amort :  nombre facultatif qui détermine le taux d’amortissement. facteuramort correspond à un nombre. En cas d’omission, cette valeur est considérée 
comme étant égale à 2 (200 % pour un amortissement décroissant à taux double). 
Plus le nombre est élevé, plus l’amortissement est rapide. Par exemple, si vous 
voulez obtenir un taux d’amortissement d’une fois et demie l’amortissement 
linéaire, utilisez 1,5 ou 150 %.
Exemples
Imaginons que vous venez d’acquérir un actif d’une valeur de 1 000 €, une valeur résiduelle de 100 € 
et une durée de vie utile estimée à 4 ans.
Avec la fonction DDB, vous pouvez déterminer l’amortissement pour différentes périodes et différents 
taux d’amortissement.
   montant amortissement 
comptable
vie période-amort facteur-amort
   1 000 100 4    
Première année, 
amortissement 
décroissant à taux 
double (renvoie 
500 €)
=DDB(B2; C2; D2; 
E3; F3)
     1 2
Deuxième année, 
amortissement 
décroissant à taux 
double (renvoie 
250 €)
=DDB(B2; C2; D2; 
E4; F4)
     2 2   montant amortissement 
comptable
vie période-amort facteur-amort
Troisième année, 
amortissement 
décroissant à taux 
double (renvoie 
125 €)
=DDB(B2; C2; D2; 
E5; F5)
     3 2
Quatrième année, 
amortissement 
décroissant à taux 
double (renvoie 
25 €)
=DDB(B2; C2; D2; 
E6; F6)
     4 2
Première année, 
amortissement 
linéaire (renvoie 
250 €)
=DDB(B2; C2; D2; 
E7; F7)
     1 1
Première année, 
amortissement 
décroissant à taux 
triple (renvoie 
750 €)
=DDB(B2; C2; D2; 
E8; F8)
     3 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DB » à la page 111
« AMORLIN » à la page 106
« SYD » à la page 140
« VDB » à la page 161
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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DUREE.M.OBLIGATION
La fonction DUREE.M.OBLIGATION calcule la moyenne pondérée modifiée de la valeur 
actualisée des flux de trésorerie pour une valeur nominale de 100 €.
DUREE.M.OBLIGATION(règlement; échéance; taux-annuel; rendement-annuel; fréquence; 
base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â rendement-annuel :  rendement annuel du titre. rendement-annuel correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Remarques d’usage
Â Cette fonction renvoie une valeur connue sous le nom de « durée Macauley ».Exemple
Supposons que vous étudiez la pertinence d’un investissement dans un titre. Le règlement final 
de l’investissement doit se faire le 2 avril 2010 et l’échéance tombe le 31 décembre 2015. Le taux du 
coupon est de 5 %, ce qui donne un rendement d’approximativement 5,284 % (le rendement se 
calcule par la fonction RENDEMENT.TITRE). Le bon verse un intérêt tous les trimestres, en s’appuyant 
sur le nombre de jours effectifs.
=DUREE.M.OBLIGATION("2/4/2010"; "31/12/2015"; 0,05; 0,05284; 4; 1) renvoie la valeur approximative de 
4,9554, à savoir la valeur actualisée des flux de trésorerie futurs (la durée du bon), selon la durée de 
Macauley. Les flux de trésorerie sont constitués du prix payé, des intérêts perçus et du principal perçu 
à l’échéance.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DUREE.OBLIGATION » à la page 116
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
DUREE.OBLIGATION
La fonction DUREE.OBLIGATION calcule la moyenne pondérée de la valeur actualisée 
des flux de trésorerie pour une valeur nominale de 100 €.
DUREE.OBLIGATION(règlement; échéance; taux-annuel; rendement-annuel; fréquence; 
base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â rendement-annuel :  rendement annuel du titre. rendement-annuel correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
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Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Remarques d’usage
Â Cette fonction renvoie une valeur connue sous le nom de « durée Macauley ».
Exemple
Supposons que vous étudiez la pertinence d’un investissement dans un titre. Le règlement final 
de l’investissement doit se faire le 2 avril 2010 et l’échéance tombe le 31 décembre 2015. Le taux du 
coupon est de 5 %, ce qui donne un rendement d’approximativement 5,284 % (le rendement se 
calcule par la fonction RENDEMENT.TITRE). Le bon verse un intérêt tous les trimestres, en s’appuyant 
sur le nombre de jours effectifs.
=DUREE.OBLIGATION("2/4/2010"; "31/12/2015"; 0,05; 0,05284; 4; 1) renvoie la valeur approximative de 
5,0208, à savoir la valeur actualisée des flux de trésorerie futurs (la durée du bon), selon la durée de 
Macauley. Les flux de trésorerie sont constitués du prix payé, des intérêts perçus et du principal perçu 
à l’échéance.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DUREE.M.OBLIGATION » à la page 115
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44INTERET.ACC
La fonction INTERET.ACC calcule les intérêts courus totaux ajoutés au prix d’achat d’un 
titre et payés au vendeur lorsque le titre verse des intérêts périodiques.
INTERET.ACC(émission; premier; règlement; taux-annuel; valeur-nominale; fréquence; 
base-journalière)
Â émission :  date à laquelle le titre a été émis à l’origine. émission correspond à une 
valeur de date/heure, la plus ancienne des dates précisées.
Â premier ordre :  date du premier paiement des intérêts. premier correspond à une 
valeur de date/heure et doit être postérieure à émission.
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â prix :  valeur faciale (valeur nominale) ou valeur à l’échéance du titre. valeurnominale correspond à un nombre. En cas d’omission (point-virgule sans autre 
valeur indiquée), la valeur de 1 000 est attribuée par défaut à valeur-nominale.
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Remarques d’usage
Â Si règlement est antérieur à premier, la fonction renvoie les intérêts courus depuis 
émission. Si règlement est postérieur à premier, la fonction renvoie les intérêts courus 
depuis la date de paiement du coupon immédiatement antérieure à règlement.
Â Utilisez INTERET.ACC.MAT pour un titre qui ne paie des intérêts qu’à l’échéance.
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Exemple 1
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées. La date de 
règlement est considérée comme étant antérieure à la date du premier coupon.
Vous pouvez utiliser la fonction INTERET.ACC pour déterminer le montant des intérêts courus qui 
sont à ajouter au prix d’achat/vente. La fonction donne 38,06 €, ce qui représente les intérêts courus 
entre la date d’émission et la date de règlement.
émission premier règlement taux-annuel valeurnominale
fréquence basejournalière
=INTERET.
ACC (B2; C2; 
D2; E2; F2; G2; 
H2)
14/12/2008 01/07/2009 01/05/2009 0,10 1 000 2 0
Exemple 2
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées. La date de 
règlement est considérée comme étant ultérieure à la date du premier coupon.
Vous pouvez utiliser la fonction INTERET.ACC pour déterminer le montant des intérêts courus qui 
sont à ajouter au prix d’achat/vente. La fonction donne approximativement 20,56 €, ce qui représente 
les intérêts courus entre la date de paiement du coupon immédiatement antérieure et la date de 
règlement.
émission premier règlement taux-annuel valeurnominale
fréquence basejournalière
=INTERET.
ACC (B2; C2; 
D2; E2; F2; G2; 
H2)
14/12/2008 01/07/2009 15/09/2009 0,10 1 000 2 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« INTERET.ACC.MAT » à la page 120
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44INTERET.ACC.MAT
La fonction INTERET.ACC.MAT calcule les intérêts courus totaux ajoutés au prix d’achat 
d’un titre et payés au vendeur lorsque le titre ne verse d’intérêts qu’à l’échéance.
INTERET.ACC.MAT(émission; règlement; taux-annuel; valeur-nominale; base-journalière)
Â émission :  date à laquelle le titre a été émis à l’origine. émission correspond à une 
valeur de date/heure, la plus ancienne des dates précisées.
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â prix :  valeur faciale (valeur nominale) ou valeur à l’échéance du titre. valeurnominale correspond à un nombre. En cas d’omission (point-virgule sans autre 
valeur indiquée), la valeur de 1 000 est attribuée par défaut à valeur-nominale.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Remarques d’usage
Â Utilisez INTERET.ACC pour un titre qui verse des intérêts périodiques.
Exemple
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées. Ce titre ne verse 
d’intérêts qu’à l’échéance.
Vous pouvez utiliser la fonction INTERET.ACC.MAT pour déterminer le montant des intérêts courus 
qui sont à ajouter au prix d’achat/vente. La fonction donne approximativement 138,06 €, ce qui 
représente les intérêts courus entre la date d’émission et la date de règlement.
émission règlement taux-annuel valeur-nominale base-journalière
=INTERET.ACC.
MAT(B2; C2; D2; 
E2; F2)
14/12/2007 01/05/2009 0,10 1 000 0
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Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« INTERET.ACC » à la page 118
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
INTPER
La fonction INTPER renvoie la part des intérêts de paiement d’une rente ou de 
remboursement d’un prêt en s’appuyant sur des paiements périodiques fixes et sur un 
taux d’intérêt fixe.
INTPER(taux-périodique, période, nbre-périodes, valeur-actualisée, valeur-future, échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â période :  période de paiement pour laquelle vous souhaitez calculer le montant du 
principal ou des intérêts. période correspond à un nombre supérieur à 0.
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).
Â valeur capitalisée :  argument facultatif représentant la valeur de l’investissement 
ou la valeur résiduelle de la rente (montant positif), ou du solde restant dû d’un 
prêt (montant négatif) à l’issue du dernier paiement. valeur-future correspond à un 
nombre. À la fin de la période d’investissement, un montant perçu est un montant 
positif et un montant investi est un montant négatif. Il peut s’agir par exemple d’un 
remboursement gonflé sur un prêt (négatif) ou de la valeur résiduelle d’un contrat 
à annuités (positif). En l’absence de valeur explicite, la valeur par défaut correspond 
à 0.Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Exemple
Dans cet exemple, INTPER sert déterminer la part des intérêts du premier paiement de la troisième 
année du terme du prêt (paiement 25) d’après les informations sur le prêt présentées. La fonction 
donne approximativement – 922,41 €, ce qui représente la part des intérêts du remboursement du 
prêt 25.
tauxpériodique
période nbre-périodes valeuractualisée
valeur-future échéance
=INTPER(B2; C2; 
D2; E2; F2; G2)
=0,06/12 25 =10*12 200000 –100000 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« CUMUL.INTER » à la page 107
« CUMUL.PRINCPER » à la page 109
« VPM » à la page 163
« PRINCPER » à la page 131
« Exemple de tableau d’amortissement pour un prêt » à la page 381
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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ISPMT
La fonction ISPMT renvoie la part des intérêts de paiement d’une rente ou de 
remboursement d’un prêt en s’appuyant sur des paiements périodiques fixes et sur un 
taux d’intérêt fixe. Cette fonction a été incluse afin d’assurer la compatibilité avec les 
tableaux importés d’autres tableurs.
ISPMT(taux-annuel; période; nbre-périodes; valeur-actualisée)
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â période :  période de paiement pour laquelle vous souhaitez calculer le montant du 
principal ou des intérêts. période correspond à un nombre supérieur à 0.
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).
Remarques d’usage
Â La fonction INTPER présente des fonctionnalités supplémentaires et reste à utiliser à 
la place d’ISPMT.
Exemple
Dans cet exemple, ISPMT sert déterminer la part des intérêts du premier paiement de la troisième 
année du terme du prêt (paiement 25) d’après les informations sur le prêt présentées.
La fonction donne approximativement – 791,67 €, ce qui représente la part des intérêts du 
remboursement du prêt 25.
taux-périodique période nbre-périodes valeur-actualisée
=ISPMT(B2; C2; D2; E2) =0,06/12 25 =10*12 200000
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« INTPER » à la page 121
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
NB.COUPONS
La fonction NB.COUPONS renvoie le nombre de coupons restant à payer entre la date 
de règlement et l’échéance.
NB.COUPONS(règlement; échéance; fréquence; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées.
Vous pouvez utiliser la fonction NB.COUPONS pour déterminer le nombre de coupons pouvant 
être perçus entre la date de règlement et l’échéance du titre. La fonction renvoie 23 car 23 dates de 
paiement de coupon trimestrielles marquent la période allant du 2 avril 2010 et le 31 décembre 2015, 
la première date correspondant au 30 juin 2010.
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règlement échéance fréquence base-journalière
=NB.COUPONS(B2; C2; 
D2; E2; F2; G2)
4/2/2010 12/31/2015 4 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
NB.JOURS.COUPON
La fonction NB.JOURS.COUPON renvoie le nombre de jours dans la période de coupon 
dans laquelle le règlement a lieu.
NB.JOURS.COUPON(règlement; échéance; fréquence; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées.
Vous pouvez utiliser la fonction NB.JOURS.COUPON pour déterminer le nombre de jours que compte 
la période de coupon de la date de règlement. La fonction renvoie 91 car 91 jours séparent le début 
et la fin de la période de paiement du coupon, commençant et se terminant respectivement le 1er 
avril 2010 et le 30 juin 2010.
règlement échéance fréquence base-journalière
=NB.JOURS.
COUPON(B2; C2; D2; 
E2; F2; G2)
4/2/2010 12/31/2015 4 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NB.JOURS.COUPON.SUIV » à la page 126
« NB.JOURS.COUPON.SUIV » à la page 128
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
NB.JOURS.COUPON.SUIV
La fonction NB.JOURS.COUPON.PREC renvoie le nombre de jours entre le début de la 
période de coupon dans laquelle le règlement a lieu et la date de règlement.
NB.JOURS.COUPON.SUIV(règlement; échéance; fréquence; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â fréquence :  nombre de règlements de coupons par année
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annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées.
Vous pouvez utiliser la fonction NB.JOURS.COUPON.PREC pour déterminer le nombre de jours jusqu’à 
la date de paiement du dernier coupon jusqu’à la date de règlement. Il s’agit dans ce cas du nombre 
de jours intervenant dans le calcul des intérêts courus censé s’ajouter au prix d’achat de l’obligation. 
La fonction renvoie 2 car 2 jours séparent la date de paiement du dernier coupon, à savoir le 31 mars 
2010, et la date de règlement du 2 avril 2010.
règlement échéance fréquence base-journalière
=NB.JOURS.COUPON.
PREC(B2; C2; D2; E2; 
F2; G2)
4/2/2010 12/31/2015 4 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NB.JOURS.COUPON » à la page 125
« NB.JOURS.COUPON.SUIV » à la page 128
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44NB.JOURS.COUPON.SUIV
La fonction NB.JOURS.COUPON.SUIV renvoie le nombre de jours entre la date de 
règlement et la fin de la période de coupon dans laquelle le règlement a lieu.
NB.JOURS.COUPON.SUIV(règlement; échéance; fréquence; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Imaginons que vous envisagiez l’achat du titre fictif décrit par les valeurs indiquées.
Vous pouvez utiliser la fonction NB.JOURS.COUPON.SUIV pour déterminer le nombre de jours jusqu’à 
la date de paiement du coupon suivant. Il s’agit du nombre de jours jusqu’au premier paiement de 
coupon à recevoir. La fonction renvoie 89 car 89 jours séparent la date de règlement, à savoir le 2 
avril 2010, et la date de paiement du coupon suivant.
règlement échéance fréquence base-journalière
=NB.JOURS.COUPON.
SUIV(B2; C2; D2; E2; 
F2; G2)
4/2/2010 12/31/2015 4 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NB.JOURS.COUPON » à la page 125
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« NB.JOURS.COUPON.SUIV » à la page 126
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
NPM
La fonction NPM renvoie le nombre de périodes de paiement pour un prêt ou une 
annuité en s’appuyant sur une série de flux de trésorerie périodiques réguliers 
(paiements d’un montant constant et tous les flux de trésorerie à intervalles constants) 
et d’un taux d’intérêt fixe.
NPM(taux-périodique; paiement; valeur-actualisée; valeur-future; échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â versement :  montant payé ou perçu à chaque période. paiement correspond à un 
nombre. À chaque période, un montant perçu est un montant positif et un montant 
investi est un montant négatif. Il peut s’agir par exemple d’un remboursement 
mensuel (négatif) ou d’un paiement périodique perçu sur une annuité (positif).
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
la rente indiqué sous la forme d’un nombre négatif. valeur-actualisée correspond à 
un nombre. Au moment 0, un montant perçu est un montant positif et un montant 
investi est un montant négatif. Il peut s’agir par exemple d’un montant emprunté 
(positif) ou du règlement de départ fait sur un contrat à annuités (négatif).
Â valeur capitalisée :  argument facultatif représentant la valeur de l’investissement 
ou la valeur résiduelle de la rente (montant positif), ou du solde restant dû d’un 
prêt (montant négatif) à l’issue du dernier paiement. valeur-future correspond à un 
nombre. À la fin de la période d’investissement, un montant perçu est un montant 
positif et un montant investi est un montant négatif. Il peut s’agir par exemple d’un 
remboursement gonflé sur un prêt (négatif) ou de la valeur résiduelle d’un contrat à 
annuités (positif).Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Exemple 1
Imaginons que vous planifiez une épargne destinée à financer les études supérieures de votre fille 
lorsqu’elle atteindra l’âge. Vous disposez de 50 000 € à placer sur un compte d’épargne et pouvez 
verser 200 € sur ce compte à la fin de chaque mois. Ce compte d’épargne devrait être rémunéré à un 
taux d’intérêt annuel de 4,5 % et rapporter des intérêts mensuels. Vous estimez qu’il sera nécessaire 
d’avoir économisé 150 000 € quand votre fille ira à l’université.
Avec la fonction NPM, vous pouvez déterminer le nombre de périodes dont vous avez besoin 
pour les paiements de 200 €. S’appuyant sur ce nos suppositions de départ, il devrait s’agir 
approximativement de 181 périodes, soit 15 ans et 1 mois.
taux-périodique paiement valeur-actualisée valeur-future échéance
=NPM(B2; C2; D2; 
E2; F2)
=0,045/12 –200 –50000 150000 1
Exemple 2
Imaginons que vous prévoyez de racheter la maison de vacances de votre oncle. Vous disposez 
de 30 000 € que vous pouvez utiliser comme acompte immédiat et vous pouvez faire face à des 
mensualités de 1 500 €. Votre oncle vous dit qu’il veut bien vous prêter la différence entre le prix de 
vente de sa maison de vacances, de 200 000 €, et votre acompte (soit 170 000 €) au taux annuel de 
7 %.
Avec la fonction NPM, vous pouvez déterminer le nombre de mois nécessaires pour rembourser le 
prêt de votre oncle. S’appuyant sur ce nos suppositions de départ, il devrait s’agir approximativement 
de 184 mois, soit 15 ans et 4 mois.
taux-périodique paiement valeur-actualisée valeur-future échéance
=NPM(B2; C2; D2; 
E2; F2)
=0,07/12 –1500 170000 0 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VC » à la page 159
« VPM » à la page 163
« VA » à la page 152
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« TAUX » à la page 141
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PRINCPER
La fonction PRINCPER renvoie la part du principal du paiement d’une rente ou du 
remboursement d’un prêt en s’appuyant sur des paiements périodiques fixes et sur un 
taux d’intérêt fixe.
PRINCPER(taux-périodique, période, nbre-périodes, valeur-actualisée, valeur-future, 
échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â période :  période de paiement pour laquelle vous souhaitez calculer le montant du 
principal ou des intérêts. période correspond à un nombre supérieur à 0.
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).
Â valeur capitalisée :  argument facultatif représentant la valeur de l’investissement 
ou la valeur résiduelle de la rente (montant positif), ou du solde restant dû d’un 
prêt (montant négatif) à l’issue du dernier paiement. valeur-future correspond à un 
nombre. À la fin de la période d’investissement, un montant perçu est un montant 
positif et un montant investi est un montant négatif. Il peut s’agir par exemple d’un 
remboursement gonflé sur un prêt (négatif) ou de la valeur résiduelle d’un contrat 
à annuités (positif). En l’absence de valeur explicite, la valeur par défaut correspond 
à 0.Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Exemple
Dans cet exemple, PRINCPER sert déterminer la part du principal du premier paiement de la troisième 
année du terme du prêt (paiement 25) d’après les informations sur le prêt présentées. La fonction 
donne approximativement – 687,80 €, ce qui représente la part du principal du paiement 25.
tauxpériodique
période nbre-périodes valeuractualisée
valeur-future échéance
=PRINCPER(B2; 
C2; D2; E2; F2; 
G2)
=0,06/12 25 =10*12 200000 –100000 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« CUMUL.INTER » à la page 107
« CUMUL.PRINCPER » à la page 109
« INTPER » à la page 121
« VPM » à la page 163
« Exemple de tableau d’amortissement pour un prêt » à la page 381
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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PRIX.TITRE
La fonction PRIX.TITRE renvoie le prix d’un titre qui verse des intérêts périodiques par 
tranche de 100 € de valeur de remboursement (nominale).
PRIX.TITRE(règlement; échéance; taux-annuel; rendement-annuel; remboursement; 
fréquence; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â rendement-annuel :  rendement annuel du titre. rendement-annuel correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â remboursement :  prix de remboursement par tranche de 100 € de valeur nominale. 
remboursement correspond à un nombre positif. remboursement est le montant qui 
sera perçu par tranche de 100 € de la valeur nominale. Il s’agit souvent de 100, ce qui 
signifie que le prix de remboursement du titre est égal à sa valeur nominale.
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).Exemple
Dans cet exemple, la fonction PRIX.TITRE sert à déterminer le prix d’achat du titre fictif décrit par les 
valeurs indiquées. Le titre verse des intérêts périodiques.
La fonction renvoie la valeur 106,50 € ce qui représente le prix par tranche de 100 € de valeur 
nominale.
règlement échéance taux-annuel rendementannuel
remboursement fréquence basejournalière
=PRIX.TITRE 
(B2; C2; D2; 
E2; F2; G2; 
H2)
01/05/2009 30/06/2015 0,065 0,0525 100 2 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VALEUR.ENCAISSEMENT » à la page 154
« PRIX.TITRE.ECHEANCE » à la page 134
« RENDEMENT.TITRE » à la page 137
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PRIX.TITRE.ECHEANCE
La fonction PRIX.TITRE.ECHEANCE renvoie le prix d’un titre qui verse des intérêts 
périodiques par tranche de 100 € de valeur de remboursement (nominale).
PRIX.TITRE.ECHEANCE(règlement; échéance; émission; taux-annuel; rendement-annuel; 
base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
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Â émission :  date à laquelle le titre a été émis à l’origine. émission correspond à une 
valeur de date/heure, la plus ancienne des dates précisées.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â rendement-annuel :  rendement annuel du titre. rendement-annuel correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction PRIX.TITRE.ECHEANCE sert à déterminer le prix d’achat du titre fictif 
décrit par les valeurs indiquées. Ce titre ne verse d’intérêts qu’à l’échéance. La fonction renvoie la 
valeur 99,002 € ce qui représente le prix par tranche de 100 € de valeur nominale.
règlement échéance émission taux-annuel rendementannuel
basejournalière
=PRIX.TITRE.
ECHEANCE (B2; 
C2; D2; E2; F2; 
G2)
01/05/2009 30/06/2015 14/12/2008 0,065 0.06565 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PRIX.TITRE » à la page 133
« VALEUR.ENCAISSEMENT » à la page 154
« RENDEMENT.TITRE.ECHEANCE » à la page 139
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
RENDEMENT.SIMPLE
La fonction RENDEMENT.SIMPLE renvoie le taux d’intérêt annuel effectif d’un titre qui 
est vendu avec un escompte par rapport à son prix de remboursement et qui ne verse 
pas d’intérêts.
RENDEMENT.SIMPLE(règlement; échéance; prix; remboursement; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â prix :  coût du titre par tranche de 100 € de valeur nominale. prix correspond à un 
nombre.
Â remboursement :  prix de remboursement par tranche de 100 € de valeur nominale. 
remboursement correspond à un nombre positif. remboursement est le montant qui 
sera perçu par tranche de 100 € de la valeur nominale. Il s’agit souvent de 100, ce qui 
signifie que le prix de remboursement du titre est égal à sa valeur nominale.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction RENDEMENT.SIMPLE sert à déterminer le rendement annuel effectif 
du titre fictif décrit par les valeurs indiquées. Le titre ne rapporte aucun intérêt et est vendu avec un 
escompte.
La fonction renvoie la valeur approximative de 8,37 %, ce qui représente le rendement annuel à un 
prix approximatif 65,98 € par tranche de 100 € de valeur nominale.
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règlement échéance prix remboursement base-journalière
=RENDEMENT.
SIMPLE(B2; C2; D2; 
E2; F2)
01/05/2009 30/06/2015 65,98 100 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VALEUR.ENCAISSEMENT » à la page 154
« RENDEMENT.TITRE » à la page 137
« RENDEMENT.TITRE.ECHEANCE » à la page 139
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
RENDEMENT.TITRE
La fonction RENDEMENT.TITRE renvoie le taux d’intérêt annuel effectif d’un titre qui 
verse des intérêts périodiques réguliers.
RENDEMENT.TITRE(règlement; échéance; taux-annuel; prix; remboursement; fréquence; 
base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â prix :  coût du titre par tranche de 100 € de valeur nominale. prix correspond à un 
nombre.Â remboursement :  prix de remboursement par tranche de 100 € de valeur nominale. 
remboursement correspond à un nombre positif. remboursement est le montant qui 
sera perçu par tranche de 100 € de la valeur nominale. Il s’agit souvent de 100, ce qui 
signifie que le prix de remboursement du titre est égal à sa valeur nominale.
Â fréquence :  nombre de règlements de coupons par année
annuel (1): un paiement par an.
semestriel (2): deux paiements par an.
trimestriel (4): quatre paiements par an.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction RENDEMENT.TITRE sert à déterminer le rendement annuel du titre fictif 
décrit par les valeurs indiquées. Le titre verse des intérêts périodiques.
La fonction renvoie la valeur approximative de 5,25 %.
règlement échéance taux-annuel prix remboursement fréquence basejournalière
=RENDEMENT.
TITRE(B2; C2; D2; 
E2; F2; G2; H2)
01/05/2009 30/06/2015 0,065 106,50 100 2 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PRIX.TITRE » à la page 133
« RENDEMENT.SIMPLE » à la page 136
« RENDEMENT.TITRE.ECHEANCE » à la page 139
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
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« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
RENDEMENT.TITRE.ECHEANCE
La fonction RENDEMENT.TITRE.ECHEANCE renvoie le taux d’intérêt annuel effectif d’un 
titre qui ne verse d’intérêts qu’à l’échéance.
RENDEMENT.TITRE.ECHEANCE(règlement; échéance; émission; taux-annuel; prix; basejournalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â émission :  date à laquelle le titre a été émis à l’origine. émission correspond à une 
valeur de date/heure, la plus ancienne des dates précisées.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â prix :  coût du titre par tranche de 100 € de valeur nominale. prix correspond à un 
nombre.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction RENDEMENT.TITRE.ECHEANCE sert à déterminer le rendement annuel 
effectif du titre fictif décrit par les valeurs indiquées. Ce titre ne verse d’intérêts qu’à l’échéance. La 
fonction renvoie la valeur approximative de 6,565 %.règlement échéance émission taux-annuel prix basejournalière
=RENDEMENT.
TITRE.
ECHEANCE (B2; 
C2; D2; E2; F2; 
G2)
01/05/2009 30/06/2015 14/12/2008 0,065 99,002 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PRIX.TITRE.ECHEANCE » à la page 134
« RENDEMENT.TITRE » à la page 137
« RENDEMENT.SIMPLE » à la page 136
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
SYD
La fonction SYD renvoie le montant de l’amortissement d’un actif sur une période 
indiquée en s’appuyant sur la méthode de l’amortissement proportionnel à l’ordre 
numérique inversé des années.
SYD(montant; amortissement comptable; vie; période-amort)
Â coût :  coût initial de l’actif. montant correspond à un nombre supérieur ou égal à 0.
Â récupération :  valeur de récupération de l’actif. amortissement comptable
correspond à un nombre supérieur ou égal à 0.
Â vie :  nombre de périodes d’amortissement de l’actif. vie correspond à un nombre 
supérieur à 0. Une partie décimale (fraction) de vie est autorisée (par exemple, une 
durée d’amortissement de 5,5 années).
Â période-amort :  période sur laquelle vous cherchez à calculer l’amortissement. 
période-amort correspond à un nombre supérieur à 0. Toute partie décimale 
(fraction) de période-amort est ignorée.
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Exemples
=SYD(10000; 1000; 9; 1) renvoie 1 800 €, le montant de l’amortissement de la première année pour 
un actif ayant un coût initial de 10 000 € et un valeur de récupération de 1 000 € après une vie de 9 
années.
=SYD(10000; 1000; 9; 2) renvoie 1 600 €, le montant de l’amortissement pour la seconde année.
=SYD(10000; 1000; 9; 8) renvoie 400 €, le montant de l’amortissement pour la huitième année.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DB » à la page 111
« DDB » à la page 113
« AMORLIN » à la page 106
« VDB » à la page 161
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TAUX
La fonction TAUX renvoie le taux d’intérêt d’un investissement, d’un prêt ou d’une 
annuité en s’appuyant sur une série de flux de trésorerie périodiques réguliers 
(paiements d’un montant constant et tous les flux de trésorerie à intervalles constants) 
et d’un taux d’intérêt fixe.
TAUX(nbre-périodes; paiement; valeur-actualisée; valeur-future; échéance; estimation)
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â versement :  montant payé ou perçu à chaque période. paiement correspond à un 
nombre. À chaque période, un montant perçu est un montant positif et un montant 
investi est un montant négatif. Il peut s’agir par exemple d’un remboursement 
mensuel (négatif) ou d’un paiement périodique perçu sur une annuité (positif).Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).
Â valeur capitalisée :  argument facultatif représentant la valeur de l’investissement 
ou la valeur résiduelle de la rente (montant positif), ou du solde restant dû d’un 
prêt (montant négatif) à l’issue du dernier paiement. valeur-future correspond à un 
nombre. À la fin de la période d’investissement, un montant perçu est un montant 
positif et un montant investi est un montant négatif. Il peut s’agir par exemple d’un 
remboursement gonflé sur un prêt (négatif) ou de la valeur résiduelle d’un contrat à 
annuités (positif).
Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Â estimation :  argument facultatif indiquant l’estimation initiale du taux de 
rendement. estimation correspond à un nombre et doit être saisi soit sous la forme 
d’un nombre décimal (par exemple 0,08), soit d’un pourcentage (par exemple, 8 %). 
En l’absence de valeur explicite, la valeur par défaut est de 10 %. Si la valeur par 
défaut ne donne pas de solution, essayez d’abord une valeur positive plus grande. 
Si cela ne donne rien, essayez une valeur négative inférieure. La valeur minimum 
autorisée est – 1.
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Exemple
Imaginons que vous planifiez une épargne destinée à financer les études supérieures de votre fille 
lorsqu’elle atteindra l’âge. Elle vient d’avoir 3 ans et vous partez de l’hypothèse qu’elle entrerait à 
l’université dans 15 ans. Vous estimez qu’il sera nécessaire d’avoir économisé 150 000 € sur un compte 
d’épargne au début de son cursus d’enseignement supérieur. Vous disposez de 50 000 € et versez 
200 € sur le compte à la fin de chaque mois. Pendant les 15 prochaines années, ce compte d’épargne 
devrait être rémunéré à un taux d’intérêt annuel de 4,5 % et rapporter des intérêts mensuels.
Avec la fonction TAUX, vous pouvez déterminer le taux de rémunération nécessaire du compte 
d’épargne afin que son montant atteigne 150 000 € au moment où votre fille est censée 
entrer à l’université. En s’appuyant sur nos suppositions, le taux renvoyé par la fonction est 
d’approximativement 0,377 % et correspond à un taux mensuel car nbre-périodes est mensuel, soit 
4,52 % l’an.
nbre-périodes paiement valeuractualisée
valeur-future échéance estimation
=TAUX(B2; C2; 
D2; E2; F2; G2)
=15*12 –200 –50000 150000 1 =0,1/12
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VC » à la page 159
« TRI » à la page 148
« NPM » à la page 129
« VPM » à la page 163
« VA » à la page 152
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44TAUX.EFFECTIF
La fonction TAUX.EFFECTIF renvoie le taux d’intérêt effectif annuel à partir du taux 
d’intérêt annuel nominal en s’appuyant sur le nombre de périodes par année de calcul 
de l’intérêt composé.
TAUX.EFFECTIF(taux-nominal; nbre-périodes-année)
Â taux-nominal :  taux d’intérêt nominal d’un titre. taux-nominal correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes-année :  nombre de périodes par année d’intégration des intérêts. 
nbre-périodes-année correspond à un nombre supérieur à 0.
Exemples
=TAUX.EFFECTIF(0,05; 365) renvoie approximativement 5,13 %, le taux d’intérêt annuel effectif si le 
taux de 5 % s’appuie sur une capitalisation quotidienne.
=TAUX.EFFECTIF(0,05; 12) renvoie approximativement 5,12 %, le taux d’intérêt annuel effectif si le taux 
de 5 % s’appuie sur une capitalisation mensuelle.
=TAUX.EFFECTIF(0,05; 4) renvoie approximativement 5,09 %, le taux d’intérêt annuel effectif si le taux 
de 5 % s’appuie sur une capitalisation trimestrielle.
=TAUX.EFFECTIF(0,05; 2) renvoie approximativement 5,06 %, le taux d’intérêt annuel effectif si le taux 
de 5 % s’appuie sur une capitalisation semestrielle.
=TAUX.EFFECTIF(0,05; 1) renvoie approximativement 5,00 %, le taux d’intérêt annuel effectif si le taux 
de 5 % s’appuie sur une capitalisation annuelle.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« TAUX.NOMINAL » à la page 147
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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TAUX.ESCOMPTE
La fonction TAUX.ESCOMPTE renvoie le taux d’escompte annuel d’un titre qui ne 
paie pas d’intérêts et qui est vendu avec un escompte par rapport à son prix de 
remboursement.
TAUX.ESCOMPTE(règlement; échéance; prix; remboursement; base-journalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â prix :  coût du titre par tranche de 100 € de valeur nominale. prix correspond à un 
nombre.
Â remboursement :  prix de remboursement par tranche de 100 € de valeur nominale. 
remboursement correspond à un nombre positif. remboursement est le montant qui 
sera perçu par tranche de 100 € de la valeur nominale. Il s’agit souvent de 100, ce qui 
signifie que le prix de remboursement du titre est égal à sa valeur nominale.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction TAUX.ESCOMPTE sert à déterminer le taux d’escompte annuel du titre 
fictif décrit par les valeurs indiquées.
La fonction donné 5,25 %, le taux d’escompte annuel.
règlement échéance prix remboursement base-journalière
=TAUX.
ESCOMPTE(B2; C2; 
D2; E2; F2)
01/05/2009 30/06/2015 67.64 100 0Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VALEUR.ENCAISSEMENT » à la page 154
« RENDEMENT.SIMPLE » à la page 136
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TAUX.INTERET
La fonction TAUX.INTERET renvoie le taux d’intérêt annuel effectif d’un titre qui ne 
verse d’intérêts qu’à l’échéance.
TAUX.INTERET(règlement; échéance; montant-investissements; remboursement; basejournalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â montant-investissements :  montant investi dans le titre. montant-investissements
correspond à un nombre supérieur ou égal à 0.
Â remboursement :  prix de remboursement par tranche de 100 € de valeur nominale. 
remboursement correspond à un nombre positif. remboursement est le montant qui 
sera perçu par tranche de 100 € de la valeur nominale. Il s’agit souvent de 100, ce qui 
signifie que le prix de remboursement du titre est égal à sa valeur nominale.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
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30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction TAUX.INTERET sert à déterminer le taux d’intérêt annuel effectif du titre 
fictif décrit par les valeurs indiquées. Ce titre ne verse d’intérêts qu’à l’échéance. La fonction renvoie 
la valeur approximative de 10,85 %.
règlement échéance montantinvestissements
valeur-nominale base-journalière
=TAUX.INTERET(B2; 
C2; D2; E2; F2)
01/05/2009 30/06/2015 990.02 1651.83 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VALEUR.NOMINALE » à la page 156
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TAUX.NOMINAL
La fonction TAUX.NOMINAL renvoie le taux d’intérêt annuel nominal à partir du taux 
d’intérêt effectif annuel en s’appuyant sur le nombre de périodes par année de calcul 
de l’intérêt composé.
TAUX.NOMINAL(taux-int-effectif; nbre-périodes-année)
Â taux-int-effectif :  taux d’intérêt effectif d’un titre. taux-int-effectif correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes-année :  nombre de périodes par année d’intégration des intérêts. 
nbre-périodes-année correspond à un nombre supérieur à 0.Exemples
=TAUX.NOMINAL(0,0513; 365) renvoie approximativement 5,00 %, le taux d’intérêt annuel nominal si 
le taux effectif de 5,13 % s’appuie sur une capitalisation quotidienne.
=TAUX.NOMINAL(0,0512; 12) renvoie approximativement 5,00 %, le taux d’intérêt annuel nominal si le 
taux effectif de 5,12 % s’appuie sur une capitalisation mensuelle.
=TAUX.NOMINAL(0,0509; 4) renvoie approximativement 5,00 %, le taux d’intérêt annuel nominal si le 
taux effectif de 5,09 % s’appuie sur une capitalisation trimestrielle.
=TAUX.NOMINAL(0,0506; 2) renvoie approximativement 5,00 %, le taux d’intérêt annuel nominal si le 
taux effectif de 5,06 % s’appuie sur une capitalisation semestrielle.
=TAUX.NOMINAL(0,0500; 1) renvoie approximativement 5,00 %, le taux d’intérêt annuel nominal si le 
taux effectif de 5,00 % s’appuie sur une capitalisation annuelle.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« TAUX.EFFECTIF » à la page 144
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TRI
La fonction TRI renvoie le taux de rendement interne d’un investissement qui s’appuie 
sur une série de flux de trésorerie pouvant être irréguliers (paiements d’un montant 
non obligatoirement constant) réalisés à intervalles réguliers.
TRI(flux-intervalle; estimation)
Â intervalle des mouvements :  collection comprenant les valeurs de flux de 
trésorerie. flux-intervalle correspond à une collection incluant des nombres. Un 
produit (un encaissement) doit être indiqué sous la forme d’un nombre positif, 
tandis qu’une dépense (un décaissement), un nombre négatif. La collection doit 
contenir au moins une valeur positive et une valeur négative. Les flux de trésorerie 
doivent être indiqués dans l’ordre chronologique et avec les mêmes intervalles dans 
le temps (par exemple, tous les mois). Si une période n’a pas de flux de trésorerie, 
utilisez 0 pour cette période.
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Â estimation :  argument facultatif indiquant l’estimation initiale du taux de 
rendement. estimation correspond à un nombre et doit être saisi soit sous la forme 
d’un nombre décimal (par exemple 0,08), soit d’un pourcentage (par exemple, 8 %). 
En l’absence de valeur explicite, la valeur par défaut est de 10 %. Si la valeur par 
défaut ne donne pas de solution, essayez d’abord une valeur positive plus grande. 
Si cela ne donne rien, essayez une valeur négative inférieure. La valeur minimum 
autorisée est – 1.
Remarques d’usage
Â Si les flux de trésorerie périodiques sont identiques, vous pouvez utiliser la fonction 
VAN.
Exemple 1
Imaginons que vous planifiez une épargne destinée à financer les études supérieures de votre fille 
lorsqu’elle atteindra l’âge. Elle vient d’avoir 13 ans et vous partez de l’hypothèse qu’elle entrerait à 
l’université dans 5 ans. Vous disposez de 75 000 € à placer sur un compte d’épargne le jour même et 
vous comptez y ajouter le bonus que vous octroie votre employeur à la fin de chaque année. Comme 
votre bonus devrait augmenter chaque année, vous espérez pouvoir économiser respectivement 
5 000 €, 7 000 €, 8 000 €, 9 000 € et 10 000 € à la fin de chacune des 5 années à venir. Vous estimez 
qu’il sera nécessaire d’avoir économisé 150 000 € pour les études de votre fille quand elle atteindra 
l’âge d’entrée à l’université.
Avec la fonction TRI, vous pouvez déterminer le taux à appliquer sur les sommes investies pour 
disposer à terme d’un capital de 150 000 €. En s’appuyant sur nos suppositions, le taux correspond à 
5,70 %.
Versement 
initial
Année 1 Année 2 Année 3 Année 4 Année 5 Montant 
nécessaire
=TRI(B2:H2) –75000 –5000 –7000 –8000 –9000 – 10 000 150000
Exemple 2
Imaginons que vous ayez l’occasion d’investir dans une société. L’investissement initial nécessaire est 
de 50 000 €. Comme la société développe toujours son produit, 25 000 € et 10 000 € supplémentaires 
doivent être investis respectivement à la fin de la première et de la seconde années. La troisième 
année, la société s’autofinance, mais sans rémunérer les investisseurs. Les quatrième et cinquième 
années, les investisseurs perçoivent respectivement 10 000 € et 30 000 €. À la fin de la sixième année, 
la société est vendue et les investisseurs doivent recevoir 100 000 €.
Avec la fonction TRI, vous pouvez déterminer le taux de rendement attendu sur cet investissement. 
En s’appuyant sur nos suppositions, le taux correspond à 10,24 %.
Versement 
initial
Année 1 Année 2 Année 3 Année 4 Année 5 Produit des 
ventes
=TRI(B2:H2) –50000 – 25 000 – 10 000 0 10 000 30 000 100 000Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« TRIM » à la page 150
« VAN » à la page 157
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
TRIM
La fonction TRIM renvoie le taux de rendement interne d’un investissement qui 
s’appuie sur une série de flux de trésorerie pouvant être irréguliers (paiements d’un 
montant non obligatoirement constant) réalisés à intervalles réguliers. Le taux gagné 
sur les flux de trésorerie positifs et le taux payé pour financer les flux de trésorerie 
négatifs peuvent différer.
TRIM(flux-intervalle, taux-finance, taux-réinvestissement)
Â intervalle des mouvements :  collection comprenant les valeurs de flux de 
trésorerie. flux-intervalle correspond à une collection incluant des nombres. Un 
produit (un encaissement) doit être indiqué sous la forme d’un nombre positif, 
tandis qu’une dépense (un décaissement), un nombre négatif. La collection doit 
contenir au moins une valeur positive et une valeur négative. Les flux de trésorerie 
doivent être indiqués dans l’ordre chronologique et avec les mêmes intervalles dans 
le temps (par exemple, tous les mois). Si une période n’a pas de flux de trésorerie, 
utilisez 0 pour cette période.
Â taux de financement :  taux d’intérêt payé sur les flux de trésorerie négatifs (sorties). 
taux-finance correspond à un nombre, doit être saisi soit sous la forme d’un nombre 
décimal (par exemple 0,08), soit d’un pourcentage (par exemple, 8 %) et représente 
le taux auquel les sommes investies (les flux de trésorerie négatifs) peuvent être 
financées. Par exemple, il est possible d’utiliser le coût du financement d’une société.
150 Chapitre 6    Fonctions financièresChapitre 6    Fonctions financières 151
Â taux-réinvestissement :  taux auquel les flux de trésorerie positifs (entrées) peuvent 
être réinvestis. taux-réinvestissement correspond à un nombre, doit être saisi soit 
sous la forme d’un nombre décimal (par exemple 0,08), soit d’un pourcentage 
(par exemple, 8 %) et représente le taux auquel les sommes perçues (les flux de 
trésorerie positifs) peuvent être réinvesties. Par exemple, il est possible d’utiliser le 
taux d’investissement à court terme d’une société.
Remarques d’usage
Â Les flux de trésorerie doivent être répartis équitablement dans le temps. Si aucun 
flux de trésorerie n’est apporté pendant une période de temps donnée, utilisez 0.
Exemple 1
Imaginons que vous ayez l’occasion d’investir dans une société. L’investissement initial nécessaire est 
de 50 000 €. Comme la société développe toujours son produit, 25 000 € et 10 000 € supplémentaires 
doivent être investis respectivement à la fin de la première et de la seconde années. La troisième 
année, la société s’autofinance, mais sans rémunérer les investisseurs. Les quatrième et cinquième 
années, les investisseurs perçoivent respectivement 10 000 € et 30 000 €. À la fin de la sixième année, 
la société est vendue et les investisseurs doivent recevoir 100 000 €. Supposons que vous puissiez 
emprunter au taux de 9,00 % (taux-finance) et puissiez obtenir 4,25 % sur des économies à court 
terme (taux-réinvestissement)
Avec la fonction TRI, vous pouvez déterminer le taux de rendement attendu sur cet investissement. 
En s’appuyant sur nos suppositions, le taux correspond approximativement à 9,75 %.
Versement 
initial
Année 1 Année 2 Année 3 Année 4 Année 5 Produit des 
ventes
=TRIM 
(B2:H2; 0,09; 
0,0425)
–50000 – 25 000 – 10 000 0 10 000 30 000 100 000
Exemple 2
Prenons les mêmes informations que dans l’exemple 1, mais plutôt que de mettre les flux de 
trésorerie dans des cellules distinctes, précisons les flux de trésorerie sous la forme d’une constante 
de tableau. La fonction TRIM se présente alors comme suit.
=TRIM({–50000; –25000; –10000; 0; 10000; 30000; 100000}; 0,09; 0,0425) renvoie approximativement 
9,75 %.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« TRI » à la page 148
« VAN » à la page 157
« VA » à la page 152
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
VA
La fonction VA renvoie la valeur actualisée d’un investissement ou d’une annuité en 
s’appuyant sur une série de flux de trésorerie périodiques réguliers (paiements d’un 
montant constant et tous les flux de trésorerie à intervalles constants) et d’un taux 
d’intérêt fixe.
VA(taux-périodique; nbre-périodes; paiement; valeur-future; échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â versement :  montant payé ou perçu à chaque période. paiement correspond à un 
nombre. À chaque période, un montant perçu est un montant positif et un montant 
investi est un montant négatif. Il peut s’agir par exemple d’un remboursement 
mensuel (négatif) ou d’un paiement périodique perçu sur une annuité (positif).
Â valeur capitalisée :  argument facultatif représentant la valeur de l’investissement 
ou la valeur résiduelle de la rente (montant positif), ou du solde restant dû d’un 
prêt (montant négatif) à l’issue du dernier paiement. valeur-future correspond à un 
nombre. À la fin de la période d’investissement, un montant perçu est un montant 
positif et un montant investi est un montant négatif. Il peut s’agir par exemple d’un 
remboursement gonflé sur un prêt (négatif) ou de la valeur résiduelle d’un contrat à 
annuités (positif).
Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
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Remarques d’usage
Â taux-périodique doit être indiqué en s’appuyant sur la même durée que nbrepériodes. Par exemple, si nbre-périodes représente des mois et le taux d’intérêt 
annuel est de 8 %, taux-périodique doit être spécifié sous la forme de 0,00667 ou 
0.667 % (0,08 divisé par 12).
Â Si paiement est indiqué sans valeur d’investissement, de valeur au comptant ou de 
solde restant dû, le paramètre valeur-future peut être omis.
Â Si paiement est omis, vous devez indiquer valeur-future.
Exemple 1
Imaginons que vous planifiez une épargne destinée à financer les études supérieures de votre fille 
lorsqu’elle atteindra l’âge. Elle vient d’avoir 3 ans et vous partez de l’hypothèse qu’elle entrerait à 
l’université dans 15 ans. Vous estimez qu’il sera nécessaire d’avoir économisé 150 000 € sur un compte 
d’épargne au début de son cursus d’enseignement supérieur. Vous êtes en mesure de verser 200 € 
sur le compte à la fin de chaque mois. Pendant les 15 prochaines années, ce compte d’épargne 
devrait être rémunéré à un taux d’intérêt annuel de 4,5 % et rapporter des intérêts mensuels.
Avec la fonction VA, vous pouvez déterminer le montant à déposer sur ce compte d’épargne afin que 
le montant de l’épargne atteigne 150 000 € au moment où votre fille est censée entrer à l’université. 
En s’appuyant sur nos suppositions, la fonction renvoie « – 50 227,88 € », correspondant au montant 
qu’il convient de déposer aujourd’hui sur le compte (la fonction renvoie un nombre négatif parce 
que le dépôt sur le compte d’épargne constitue un décaissement).
taux-périodique nbre-périodes paiement valeur-future échéance
=VA(B2; C2; D2; 
E2; F2)
=0,045/12 =15*12 –200 150000 1
Exemple 2
Dans cet exemple, vous avez l’occasion de réaliser un investissement. Il s’agit d’investir dans un titre 
escompté net, ne nécessitant aucun apport supplémentaire et ne bénéficiant d’aucun versement 
jusqu’à l’échéance du titre. Ce titre escompté arrive à échéance au bout de 14 années et son prix de 
remboursement est de 100 000 €. Une autre option consiste à laisser cette somme sur votre compte 
d’épargne, où ce dernier vous assure un rendement annuel de 5,25 %.
La fonction VA vous permet de déterminer le montant maximal à verser pour le titre escompté, en 
partant du principe que vous cherchez à obtenir un taux d’intérêt au moins égal à celui de votre 
compte de placement sur le marché monétaire. En s’appuyant sur nos suppositions, il s’agit de 
– 48 852,92 € (la fonction renvoie un montant négatif parce qu’il s’agit d’un décaissement).
taux-périodique nbre-périodes paiement valeur-future échéance
=VA(B2; C2; D2; 
E2; F2)
0,0525 14 0 100 000 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VC » à la page 159« TRI » à la page 148
« NPM » à la page 129
« VPM » à la page 163
« TAUX » à la page 141
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
VALEUR.ENCAISSEMENT
La fonction VALEUR.ENCAISSEMENT renvoie le prix d’un titre qui est vendu avec un 
escompte par rapport au prix de remboursement et qui ne verse pas d’intérêts par 
tranche de 100 € de valeur de remboursement (valeur nominale).
VALEUR.ENCAISSEMENT(règlement; échéance; rendement-annuel; remboursement; basejournalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â rendement-annuel :  rendement annuel du titre. rendement-annuel correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â remboursement :  prix de remboursement par tranche de 100 € de valeur nominale. 
remboursement correspond à un nombre positif. remboursement est le montant qui 
sera perçu par tranche de 100 € de la valeur nominale. Il s’agit souvent de 100, ce qui 
signifie que le prix de remboursement du titre est égal à sa valeur nominale.
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
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réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction VALEUR.ENCAISSEMENT sert à déterminer le prix d’achat du titre fictif 
décrit par les valeurs indiquées. Le titre ne rapporte aucun intérêt et est vendu avec un escompte.
La fonction renvoie la valeur approximative de 65,98 € ce qui représente le prix par tranche de 100 € 
de valeur nominale.
règlement échéance escompte remboursement base-journalière
=VALEUR.
ENCAISSEMENT 
(B2; C2; D2; E2; F2)
01/05/2009 30/06/2015 0.0552 100 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PRIX.TITRE » à la page 133
« PRIX.TITRE.ECHEANCE » à la page 134
« RENDEMENT.SIMPLE » à la page 136
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44VALEUR.NOMINALE
La fonction VALEUR.NOMINALE renvoie la valeur à l’échéance d’un titre qui ne verse 
d’intérêts qu’à l’échéance.
VALEUR.NOMINALE(règlement; échéance; montant-investissements; taux-annuel; basejournalière)
Â règlement :  date de règlement de la transaction. règlement correspond à une valeur 
de date/heure. La date de règlement de la transaction est généralement postérieure 
d’un ou de plusieurs jours à la date de la transaction.
Â échéance :  date à laquelle le titre arrive à échéance. échéance correspond à une 
valeur de date/heure. Elle doit être postérieure à règlement.
Â montant-investissements :  montant investi dans le titre. montant-investissements
correspond à un nombre supérieur ou égal à 0.
Â taux-annuel :  taux de coupon annuel ou taux d’intérêt annuel du titre. taux-annuel
correspond à un nombre et doit être saisi soit sous la forme d’un nombre décimal 
(par exemple 0,08), soit d’un pourcentage (par exemple, 8 %).
Â base-journalière :  argument facultatif indiquant le nombre de jours par mois et de 
jours par année servant aux calculs.
30/360 (0 ou omis):  30 jours pour chaque mois, 360 jours pour chaque année, 
méthode NASD pour les dates tombant le 31 du mois.
réels/réels (1):  jours naturels pour chaque mois, jours naturels pour chaque année.
réels/360 (2):  jours naturels pour chaque mois, 360 jours par année.
réels/365 (3):  jours naturels pour chaque mois, 365 jours par année.
30E/360 (4):  30 jours pour chaque mois, 360 jours pour chaque année, méthode 
européenne pour les dates tombant le 31 du mois (format européen 30/360).
Exemple
Dans cet exemple, la fonction VALEUR.NOMINALE sert à déterminer le montant reçu à l’échéance 
du titre fictif décrit par les valeurs indiquées. Ce titre ne verse d’intérêts qu’à l’échéance. La fonction 
donne 1 651,83 €, le montant se composant du principal et des intérêts à percevoir à l’échéance.
règlement échéance montantinvestissements
taux-annuel base-journalière
=VALEUR.
NOMINALE(B2; C2; 
D2; E2; F2)
01/05/2009 30/06/2015 990.02 0,065 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« TAUX.INTERET » à la page 146
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« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
VAN
La fonction VAN renvoie la valeur actualisée nette pour un investissement qui s’appuie 
sur une série de flux de trésorerie pouvant être irréguliers mais réalisés à intervalles 
réguliers.
VAN(taux-actualisation-périodique; flux-trésorerie; flux-trésorerie;…)
Â taux-actualisation-périodique :  taux d’escompte par période. taux-actualisationpériodique correspond à un nombre et doit être saisi soit sous la forme d’un 
nombre décimal (par exemple 0,08), soit d’un pourcentage (par exemple, 8 %). tauxactualisation-périodique correspond à un nombre supérieur ou égal à 0.
Â mouvement :   flux de trésorerie. flux-trésorerie correspond à un nombre. Une valeur 
positive représente une rentrée (un encaissement). Une valeur négative représente 
une dépense (un décaissement). Les flux de trésorerie doivent être répartis 
équitablement dans le temps.
Â flux-trésorerie;… :  vous pouvez ajouter un ou plusieurs flux de trésorerie 
supplémentaires.
Remarques d’usage
Â taux-actualisation-périodique doit être indiqué en s’appuyant sur la même 
périodicité que pour les flux de trésorerie. Par exemple, si les flux de trésorerie sont 
mensuels et le taux d’escompte annuel souhaité est de 8 %, taux-actualisationpériodique doit être indiqué sous la forme de 0,00667 ou 0,667 % (0,08 divisé par 12).
Â Si les flux de trésorerie sont irréguliers, utilisez la fonction TRI.Exemple
Imaginons que vous ayez l’occasion d’investir dans une société. Comme la société développe 
toujours son produit, 25 000 € et 10 000 € supplémentaires doivent être investis respectivement 
à la fin de la première et de la seconde années. La troisième année, la société s’autofinance, mais 
sans rémunérer les investisseurs. Les quatrième et cinquième années, les investisseurs perçoivent 
respectivement 10 000 € et 30 000 €. À la fin de la sixième année, la société est vendue et les 
investisseurs doivent recevoir 100 000 €. Pour investir, vous vous souhaitez un rendement annuel d’au 
moins 10 %.
Avec la fonction VAN, vous pouvez déterminer le montant maximum que vous devez investir 
initialement. En s’appuyant sur nos suppositions, la valeur actualisée nette correspond à 
50 913,43 €. C’est pourquoi, si l’investissement initial nécessaire est égal à ce montant ou moins, cet 
investissement répond à votre objectif de 10 %.
tauxpériodique
Année 1 Année 2 Année 3 Année 4 Année 5 Produit des 
ventes
=VAN(B2; 
C2:H2)
0,10 – 25 000 – 10 000 0 10 000 30 000 100 000
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« TRI » à la page 148
« VA » à la page 152
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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VC
La fonction VC renvoie la valeur future d’un investissement en s’appuyant sur une série 
de flux de trésorerie périodiques réguliers (paiements d’un montant constant et tous 
les flux de trésorerie à intervalles constants) et d’un taux d’intérêt fixe.
VC(taux-périodique; nbre-périodes; paiement; valeur-actualisée; échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â versement :  montant payé ou perçu à chaque période. paiement correspond à un 
nombre. À chaque période, un montant perçu est un montant positif et un montant 
investi est un montant négatif. Il peut s’agir par exemple d’un remboursement 
mensuel (négatif) ou d’un paiement périodique perçu sur une annuité (positif).
Â valeur-actualisée :  argument facultatif précisant la valeur de l’investissement initial 
ou le montant du prêt ou de la rente. valeur-actualisée correspond à un nombre. Au 
moment 0, un montant perçu est un montant positif et un montant investi est un 
montant négatif. Il peut s’agir par exemple d’un montant emprunté (positif) ou du 
règlement de départ fait sur un contrat à annuités (négatif).
Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Remarques d’usage
Â Si paiement est indiqué et qu’investissement initial n’est apporté, le paramètre 
valeur-actualisée peut être omis.Exemple 1
Imaginons que vous planifiez une épargne destinée à financer les études supérieures de votre fille 
lorsqu’elle atteindra l’âge. Elle vient d’avoir 3 ans et vous partez de l’hypothèse qu’elle entrerait à 
l’université dans 15 ans. Vous disposez de 50 000 € à placer sur un compte d’épargne et pouvez 
verser 200 € sur ce compte à la fin de chaque mois. Pendant les 15 prochaines années, ce compte 
d’épargne devrait être rémunéré à un taux d’intérêt annuel de 4,5 % et rapporter des intérêts 
mensuels.
À l’aide de la fonction VC, vous pouvez déterminer la valeur attendue du compte d’épargne 
au moment où votre fille entrera à l’université. En s’appuyant sur nos suppositions, il s’agit de 
149,553.00 €.
taux-périodique nbre-périodes paiement valeur-actualisée échéance
=VC(B2; C2; D2; 
E2; F2)
=0,045/12 =15*12 –200 –50000 1
Exemple 2
Partons du principe que vous avez l’occasion de réaliser un investissement. Vous devez investir 
50 000 € nets dans un titre escompté. Ce titre escompté arrive à échéance au bout de 14 années et 
son prix de remboursement est de 100 000 €. Une autre option consiste à laisser cette somme sur 
votre compte d’épargne, où ce dernier vous assure un rendement annuel de 5,25 %.
Une des manières d’évaluer le bien-fondé de ce placement consiste à estimer combien ces 50 000 € 
devraient valoir à la fin de la période d’investissement et de comparer ce résultat au prix de 
remboursement du titre.
Avec la fonction VC, vous pouvez déterminer la valeur future attendue du compte de placement 
sur le marché. En s’appuyant sur nos suppositions, il s’agit de 102 348,03 €. Si nos suppositions se 
vérifient, il est par conséquent plus intéressant de garder l’argent sur le compte de placement sur le 
marché monétaire car sa valeur au bout de 14 ans (à savoir, 102 348,03 €) est supérieure à celle du 
remboursement du titre (soit 100 000 €).
taux-périodique nbre-périodes paiement valeur-actualisée échéance
=VC(B2; C2; D2; 
E2; F2)
0,0525 14 0 –50000 1
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NPM » à la page 129
« VAN » à la page 157
« VPM » à la page 163
« VA » à la page 152
« TAUX » à la page 141
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« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
VDB
La fonction VDB (de l’anglais « Variable Declining Balance », pour Amortissement 
dégressif à taux variable) renvoie le montant d’amortissement d’un actif sur un 
intervalle de temps choisi en s’appuyant sur un taux d’amortissement indiqué.
VDB(montant; amortissement comptable; vie; période-initiale; période-finale; facteuramort; pas-de-bascule)
Â coût :  coût initial de l’actif. montant correspond à un nombre supérieur ou égal à 0.
Â récupération :  valeur de récupération de l’actif. amortissement comptable
correspond à un nombre supérieur ou égal à 0.
Â vie :  nombre de périodes d’amortissement de l’actif. vie correspond à un nombre 
supérieur à 0. Une partie décimale (fraction) de vie est autorisée (par exemple, une 
durée d’amortissement de 5,5 années).
Â période-initiale :  période de départ à inclure dans le calcul. période-initiale
correspond à un nombre.
Â période-finale :  période de fin à inclure dans le calcul. période-finale correspond à 
un nombre supérieur à 0 et à période-initiale.
Â facteur-amort :  nombre facultatif qui détermine le taux d’amortissement. facteuramort correspond à un nombre. En cas d’omission, cette valeur est considérée 
comme étant égale à 2 (200 % pour un amortissement décroissant à taux double). 
Plus le nombre est élevé, plus l’amortissement est rapide. Par exemple, si vous 
voulez obtenir un taux d’amortissement d’une fois et demie l’amortissement 
linéaire, utilisez 1,5 ou 150 %.
Â non-échange :  valeur facultative indiquant si l’amortissement doit passer à la 
méthode linéaire.
basculer (0, FAUX ou omis):  basculer vers la méthode d’amortissement linéaire 
l’année ou l’amortissement linéaire est supérieur à l’amortissement dégressif.
pas de bascule (1 ou VRAI):  ne pas basculer vers la méthode de l’amortissement 
linéaire.Remarques d’usage
Â période-initiale doit être indiqué comme la période antérieure à la première période 
que vous voulez inclure dans le calcul. Si vous voulez inclure la première période, 
utilisez 0 pour période-initiale.
Â Si vous voulez un amortissement qui n’inclut que la première période, indiquez la 
valeur 1 pour période-finale.
Exemples
Imaginons que vous venez d’acheter un actif ayant un coût de 11 000,00 €, une valeur de 
récupération de 1 000,00 € et une durée de vie utile estimée de 5 ans. Vous comptez amortir l’actif 
selon la méthode de l’amortissement dégressif de 1,5 (150 %).
=VDB(11000; 1000; 5; 0; 1; 1,5; 0) renvoie 3 300 €, l’amortissement pour la première année.
=VDB(11000; 1000; 5; 4; 5; 1,5; 0) renvoie 1 386,50 €, l’amortissement pour la cinquième (et dernière) 
année, en utilisant l’amortissement linéaire lorsque ce dernier est supérieur à l’amortissement 
dégressif.
=VDB(11000; 1000; 5; 4; 5; 1,5; 1) renvoie 792,33 €, l’amortissement pour la cinquième (et dernière) 
année, en utilisant tout le temps l’amortissement dégressif (pas-de-bascule est VRAI).
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« DB » à la page 111
« DDB » à la page 113
« AMORLIN » à la page 106
« SYD » à la page 140
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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VPM
La fonction VPM renvoie le paiement périodique pour un prêt ou une annuité en 
s’appuyant sur une série de flux de trésorerie périodiques réguliers (paiements d’un 
montant constant et tous les flux de trésorerie à intervalles constants) et d’un taux 
d’intérêt fixe.
VPM(taux-périodique, nbre-périodes, valeur-actualisée, valeur-future, échéance)
Â taux-périodique :  taux d’intérêt par période. taux-périodique correspond à un 
nombre et doit être saisi soit sous la forme d’un nombre décimal (par exemple 0,08), 
soit d’un pourcentage (par exemple, 8 %).
Â nbre-périodes :  nombre de périodes. nbre-périodes correspond à un nombre 
supérieur ou égal à 0.
Â valeur-actualisée :  valeur de l’investissement initial ou le montant du prêt ou de 
l’annuité. valeur-actualisée correspond à un nombre. Au moment 0, un montant 
perçu est un montant positif et un montant investi est un montant négatif. Il peut 
s’agir par exemple d’un montant emprunté (positif) ou du règlement de départ fait 
sur un contrat à annuités (négatif).
Â valeur capitalisée :  argument facultatif représentant la valeur de l’investissement 
ou la valeur résiduelle de la rente (montant positif), ou du solde restant dû d’un 
prêt (montant négatif) à l’issue du dernier paiement. valeur-future correspond à un 
nombre. À la fin de la période d’investissement, un montant perçu est un montant 
positif et un montant investi est un montant négatif. Il peut s’agir par exemple d’un 
remboursement gonflé sur un prêt (négatif) ou de la valeur résiduelle d’un contrat 
à annuités (positif). En l’absence de valeur explicite, la valeur par défaut correspond 
à 0.
Â échéance :  argument facultatif qui indique si les paiements sont dus au début ou 
à la fin de chaque période. Pour la plupart des crédits hypothécaires et autres prêts, 
le premier paiement doit être effectué à la fin de la première période (0), ce qui est 
la valeur par défaut. Par contre, la plupart des paiements dans le cadre d’un créditbail ou d’une location et certains autres types de paiements sont dus au début de la 
période (1).
fin (0 ou omis):  paiements dus à la fin de chaque période.
début (1):  paiements dus au début de chaque période.
Exemple
Dans cet exemple, VPM permet de déterminer le paiement fixe en s’appuyant sur les modalités 
indiqués pour un prêt.
La fonction renvoie la valeur – 1 610,21 €, ce qui représente le paiement fixe que vous devez effectuer 
(négative parce qu’il s’agit d’un décaissement) pour ce prêt.164 Chapitre 6    Fonctions financières
taux-périodique nbre-périodes valeur-actualisée valeur-future échéance
=VPM(B2; C2; D2; 
E2; F2)
=0,06/12 =10*12 200000 –100000 0
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« VC » à la page 159
« INTPER » à la page 121
« NPM » à la page 129
« PRINCPER » à la page 131
« VA » à la page 152
« TAUX » à la page 141
« Exemple de tableau d’amortissement pour un prêt » à la page 381
« Choix de la valeur temporelle à utiliser pour une fonction monétaire » à la page 375
« Arguments communs utilisés dans les fonctions financières » à la page 366
« Liste des fonctions financières » à la page 102
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44165
Les fonctions logiques et d’information vous aident à évaluer 
le contenu de cellules et à déterminer comment évaluer des 
contenus de cellule ou des résultats de formule et comment 
travailler avec ces derniers.
Liste des fonctions logiques et d’information
iWork intégre ces fonctions logiques et d’information pour que vous puissiez les 
utiliser dans des tableaux.
Fonction Description
« ESTERREUR » (page 166) La fonction ESTERREUR renvoie VRAI si une 
expression donnée donne une erreur et FAUX 
dans le cas contraire.
« EST.IMPAIR » (page 167) La fonction EST.IMPAIR renvoie VRAI si la valeur 
est impaire (présente un reste en cas de division 
par 2). Dans le cas contraire, elle renvoie FAUX.
« EST.PAIR » (page 168) La fonction EST.PAIR renvoie VRAI si la valeur est 
paire (n’a pas de reste en cas de division par 2). 
Dans le cas contraire, elle renvoie FAUX.
« ESTVIDE » (page 168) La fonction ESTVIDE renvoie VRAI si la cellule 
indiquée est vide et FAUX dans le cas contraire.
« ET » (page 169) La fonction ET renvoie VRAI si tous les arguments 
sont vrais et FAUX dans le cas contraire.
« FAUX » (page 171) La fonction FAUX renvoie la valeur booléenne 
FAUX. Cette fonction a été incluse afin d’assurer la 
compatibilité avec les tableaux importés d’autres 
tableurs.
7
Fonctions logiques et 
d’informationFonction Description
« NON » (page 172) La fonction NON renvoie l’opposé de la valeur 
booléenne d’une expression indiquée.
« OU » (page 173) La fonction OU renvoie VRAI si l’un des 
arguments est vrai. Dans le cas contraire, elle 
renvoie FAUX.
« SI » (page ###) La fonction SI renvoie la valeur booléenne VRAI 
ou FAUX selon que l’expression indiquée est vraie 
ou fausse.
« SI.ERREUR » (page 176) La fonction SI.ERREUR renvoie la valeur que 
vous précisez si une valeur donnée donne une 
erreur. Dans le cas contraire, elle renvoie la valeur 
donnée.
« VRAI » (page 177) La fonction VRAI renvoie la valeur booléenne 
VRAI. Cette fonction a été incluse afin d’assurer la 
compatibilité avec les tableaux importés d’autres 
tableurs.
ESTERREUR
La fonction ESTERREUR renvoie VRAI si une expression donnée donne une erreur et 
FAUX dans le cas contraire.
ESTERREUR(expression-quelconque)
Â expression-quelconque :  expression à évaluer. expression-quelconque peut 
correspondre à une valeur de n’importe quel type.
Remarques d’usage
Â Il est souvent préférable d’utiliser la fonction SI.ERREUR. La fonction SI.ERREUR a 
toutes les fonctionnalités d’ESTERREUR, mais permet également de piéger l’erreur, 
pas seulement de l’identifier.
Exemples
Si B1 correspond à un nombre et D1 renvoie la valeur 0, alors :
=SI(ESTERREUR(B1/D1); 0; B1/D1) renvoie 0 car la division par zéro donne une erreur.
=SI.ERREUR(B1/D1; 0) est équivalent à l’exemple précédent, mais ne nécessite qu’une seule fonction.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« SI.ERREUR » à la page 176
« ESTVIDE » à la page 168
« Liste des fonctions logiques et d’information » à la page 165
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« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
EST.IMPAIR
La fonction EST.IMPAIR renvoie VRAI si le nombre en question est impair (présente un 
reste en cas de division par 2). Dans le cas contraire, elle renvoie FAUX.
EST.IMPAIR(nbre)
Â nbre :  valeur numérique. nbre correspond à un nombre.
Remarques d’usage
Â Si nbre correspond à du texte, la fonction génère une erreur. Si nbre est la valeur 
booléenne VRAI (valeur 1), la fonction renvoie VRAI. Si nbre est la valeur booléenne 
FAUX(valeur 0), la fonction renvoie FAUX.
Exemples
=EST.IMPAIR(3) renvoie VRAI.
=EST.IMPAIR(3,75) renvoie VRAI.
=EST.IMPAIR(2) renvoie FAUX.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« EST.PAIR » à la page 168
« Liste des fonctions logiques et d’information » à la page 165
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44EST.PAIR
La fonction EST.PAIR renvoie VRAI si le nombre en question est pair (n’a pas de reste en 
cas de division par 2). Dans le cas contraire, elle renvoie FAUX.
EST.PAIR(nbre)
Â nbre :  valeur numérique. nbre correspond à un nombre.
Remarques d’usage
Â Si nbre correspond à du texte, la fonction génère une erreur. Si nbre est la valeur 
booléenne VRAI (valeur 1), la fonction renvoie FAUX. Si nbre est la valeur booléenne 
FAUX (valeur 0), la fonction renvoie VRAI.
Exemples
=EST.PAIR(2) renvoie VRAI.
=EST.PAIR(2,75) renvoie VRAI.
=EST.PAIR(3) renvoie FAUX.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« EST.IMPAIR » à la page 167
« Liste des fonctions logiques et d’information » à la page 165
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ESTVIDE
La fonction ESTVIDE renvoie VRAI si la cellule spécifiée est vide, et FAUX dans le cas 
contraire.
ESTVIDE(cellule)
Â cellule :  référence à une seule cellule de tableau. cellule est une valeur de référence 
à une seule cellule pouvant contenir n’importe quelle valeur ou être vide.
Remarques d’usage
Â Si la cellule est entièrement vide, la fonction renvoie VRAI, dans le cas contraire, elle 
renvoie FAUX. Si la cellule contient un espace ou un caractère non imprimable, la 
fonction renvoie FAUX, même si la cellule semble être vide.
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Exemples
Si la cellule de tableau A1 est vide et la cellule B2 contient 100 :
=ISBLANK(A1) renvoie VRAI.
=ESTVIDE(B2) renvoie FAUX.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« SI.ERREUR » à la page 176
« ESTERREUR » à la page 166
« Ajout de commentaires d’après le contenu de cellules » à la page 387
« Association de fonctions logiques et de fonctions d’information » à la page 386
« Liste des fonctions logiques et d’information » à la page 165
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ET
La fonction ET renvoie VRAI si tous les arguments sont vrais et FAUX dans le cas 
contraire.
ET(expression-test; expression-test; …)
Â expression-test :  expression quelconque. expression-test accepte tout type 
de donnée pour autant que l’expression du résultat corresponde à une valeur 
booléenne. Si l’expression renvoie un nombre, la valeur 0 est interprétée comme la 
valeur FAUX, alors que toute autre valeur est interprétée comme VRAI.
Â expression-test;… :  vous pouvez ajouter une ou plusieurs expressions.
Remarques d’usage
Â La fonction ET est équivalente à l’opérateur de conjonction logique utilisé dans les 
mathématiques ou en logique. Elle évalue d’abord chaque expression-test. Si toutes 
les expressions en question sont vraies, la fonction ET renvoie VRAI. Dans le cas 
contraire, elle renvoie FAUX.Exemples
=ET(VRAI; VRAI) renvoie VRAI parce que les deux arguments sont vrais.
=ET(1; 0; 1; 1) renvoie FAUX car l’un des arguments correspond au chiffre 0, ce qui est considéré 
comme faux.
=ET(A5>60; A560; SI(B260; B2=0; "Non négatif"; "Négatif") renvoie le texte « Non négatif » si la cellule A5 contient un 
nombre plus grand ou égal à zéro ou une valeur non numérique. Si la cellule A5 contient une valeur 
plus petite que 0, la fonction renvoie « Négatif ».
=SI(SI.ERREUR(OU(EST.PAIR(B4+B5); EST.IMPAIR(B4+B5); FAUX); ); "Tous des nombres"; "Pas tous des 
nombres") renvoie le texte « Tous des nombres » si les cellules B4 et B5 contiennent des nombres, le 
texte « Pas tous des nombres » dans le cas contraire. Pour les besoins du résultat, un test détermine si 
la somme des deux cellules est paire ou impaire. Si la cellule n’est pas un nombre, les fonctions EST.
PAIR et EST.IMPAIR renvoient une erreur et la fonction SI.ERREUR renvoie FAUX, dans le cas contraire, 
elle renvoie VRAI car soit EST.PAIR soit EST.IMPAIR donne VRAI. Donc, si B4 ou B5 n’est ni un nombre 
ni une valeur booléenne, l’expression SI renverra l’expression si-faux, c’est-à-dire « Pas tous des 
nombres ». À défaut, elle reverra l’expression si-vrai, c’est-à-dire « Tous des nombres ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« ET » à la page 169
« NON » à la page 172
« OU » à la page 173
« Usage de conditions et de jokers » à la page 389
« Interception de division par zéro » à la page 388
« Ajout de commentaires d’après le contenu de cellules » à la page 387
« Association de fonctions logiques et de fonctions d’information » à la page 386
« Liste des fonctions logiques et d’information » à la page 165
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44SI.ERREUR
La fonction SI.ERREUR renvoie la valeur que vous indiquez si une valeur donnée donne 
une erreur. Dans le cas contraire, elle renvoie la valeur donnée.
SI.ERREUR(expression-quelconque; erreur-si)
Â expression-quelconque :  expression à évaluer. expression-quelconque peut 
correspondre à une valeur de n’importe quel type.
Â erreur-si :  valeur renvoyée si expression-quelconque entraîne une erreur. si-erreur
peut correspondre à une valeur de n’importe quel type.
Remarques d’usage
Â Utilisez SI.ERREUR pour gérer les erreurs dans une formule. Par exemple, si la cellule 
D1 a pour valeur 0, qui est pourtant une valeur valide, la formule =B1/D1 génère 
une erreur (division par zéro). Cette erreur peut être évitée en utilisant une formule 
comme =SI.ERREUR(B1/D1; 0) qui renvoie le résultat de la division si D1 est différent 
de zéro, mais 0 dans le cas contraire.
Exemples
Si B1 correspond à un nombre et D1 renvoie la valeur 0, alors :
=SI.ERREUR(B1/D1; 0) renvoie 0 car la division par zéro donne une erreur.
=SI(ESTERREUR(B1/D1); 0; B1/D1) est équivalent à l’exemple SI.ERREUR ci-avant, mais nécessite 
l’utilisation de SI et de ESTERREUR.
=SI(SI.ERREUR(OU(EST.PAIR(B4+B5); EST.IMPAIR(B4+B5); FAUX); ); "Tous des nombres"; "Pas tous des 
nombres") renvoie le texte « Tous des nombres » si les cellules B4 et B5 contiennent des nombres, le 
texte « Pas tous des nombres » dans le cas contraire. Pour les besoins du résultat, un test détermine si 
la somme des deux cellules est paire ou impaire. Si la cellule n’est pas un nombre, les fonctions EST.
PAIR et EST.IMPAIR renvoient une erreur et la fonction SI.ERREUR renvoie FAUX, dans le cas contraire, 
elle renvoie VRAI car soit EST.PAIR soit EST.IMPAIR donne VRAI. Donc, si B4 ou B5 n’est ni un nombre 
ni une valeur booléenne, l’expression SI renverra l’expression si-faux, c’est-à-dire « Pas tous des 
nombres ». À défaut, elle reverra l’expression si-vrai, c’est-à-dire « Tous des nombres ».
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Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« ESTVIDE » à la page 168
« ESTERREUR » à la page 166
« Liste des fonctions logiques et d’information » à la page 165
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
VRAI
La fonction VRAI renvoie la valeur booléenne VRAI. Cette fonction a été incluse afin 
d’assurer la compatibilité avec les tableaux importés d’autres tableurs.
VRAI()
Remarques d’usage
Â La fonction VRAI n’a pas d’argument. Toutefois, vous devez inclure les parenthèses : 
=VRAI().
Â Au lieu d’utiliser la fonction VRAI, vous pouvez indiquer la valeur booléenne VRAI en 
tapant simplement VRAI (ou vrai) dans une cellule ou comme argument de fonction.
Exemples
=VRAI() renvoie la valeur booléenne VRAI.
=ET(1; VRAI()) renvoie la valeur booléenne VRAI.
=ET(1; VRAI) fonctionne exactement comme dans l’exemple précédent.178 Chapitre 7    Fonctions logiques et d’information
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« FAUX » à la page 171
« Liste des fonctions logiques et d’information » à la page 165
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44179
Les fonctions numériques vous aident à calculer des valeurs 
mathématiques souvent utilisées.
Liste des fonctions numériques
Ces fonctions de manipulation de nombres ont été intégrées à iWork pour que vous 
puissiez les utiliser dans des tableaux.
Fonction Description
« ABS » (page 182) La fonction ABS renvoie la valeur absolue d’un 
nombre ou d’une durée.
« ALEA » (page 183) La fonction ALEA renvoie un nombre aléatoire 
plus grand ou égal à 0 et plus petit que 1.
« ALEA.ENTRE.BORNES » (page 183) La fonction ALEA.ENTRE.BORNES renvoie un 
entier aléatoire pris dans l’intervalle indiqué.
« ARRONDI » (page 184) La fonction ARRONDI renvoie un nombre arrondi 
au nombre de chiffres indiqué.
« ARRONDI.AU.MULTIPLE » (page 185) La fonction ARRONDI.AU.MULTIPLE arrondit un 
nombre au plus petit multiple supérieur d’un 
facteur donné.
« ARRONDI.INF » (page 186) La fonction ARRONDI.INF renvoie un nombre 
arrondi vers le bas (en se rapprochant de zéro) au 
nombre de chiffres indiqué.
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Fonctions numériquesFonction Description
« ARRONDI.SUP » (page 187) La fonction ARRONDI.SUP renvoie un nombre 
arrondi vers le haut (en s’éloignant de zéro) au 
nombre de chiffres indiqué.
« COMBIN » (page 189) La fonction COMBIN renvoie le nombre de 
manières qu’il y a de combiner un nombre 
d’éléments pour former des groupes d’une taille 
donnée sans tenir compte de l’ordre dans les 
groupes.
« ENT » (page 190) La fonction ENT renvoie le nombre entier 
inférieur ou égal le plus proche du nombre.
« EXP » (page 191) La fonction EXP renvoie e (la base des 
logarithmes népériens) élevé à la puissance 
spécifiée.
« FACT » (page 192) La fonction FACT renvoie la factorielle d’un 
nombre.
« FACTDOUBLE » (page 192) La fonction FACTDOUBLE renvoie la factorielle 
double d’un nombre.
« IMPAIR » (page 193) La fonction IMPAIR arrondit un nombre au 
nombre impair supérieur.
« LN » (page 194) La fonction LN renvoie le logarithme népérien 
d’un nombre, la puissance à laquelle e doit être 
élevé pour donner le nombre.
« LOG » (page 195) La fonction LOG renvoie le logarithme d’un 
nombre en s’appuyant sur la base indiquée.
« LOG10 » (page 196) La fonction LOG10 renvoie le logarithme en base 
10 d’un nombre.
« MOD » (page 197) La fonction MOD renvoie le reste d’une division.
« MULTINOMIALE » (page 198) La fonction MULTINOMIALE renvoie la forme 
la plus proche du coefficient multinomial des 
nombres précisés.
« PAIR » (page 199) La fonction PAIR arrondit un nombre au nombre 
pair supérieur.
« PGCD » (page 200) La fonction PGCD renvoie le plus grand commun 
dénominateur (PGCD) des nombres indiqués.
« PI » (page 200) La fonction PI renvoie la valeur approximative 
de p (pi), le rapport entre la circonférence d’un 
cercle et son diamètre.
« PLAFOND » (page 201) La fonction PLAFOND arrondit un nombre au 
plus petit multiple supérieur du facteur donné.
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Fonction Description
« PLANCHER » (page 202) La fonction PLANCHER arrondit un nombre au 
plus petit multiple inférieur du facteur donné.
« PPCM » (page 203) La fonction PPCM renvoie le plus petit commun 
multiple (PPCM) des nombres indiqués.
« PRODUIT » (page 204) La fonction PRODUIT renvoie le produit d’un ou 
plusieurs nombres.
« PUISSANCE » (page 205) La fonction PUISSANCE renvoie un nombre élevé 
à une puissance.
« QUOTIENT » (page 206) La fonction QUOTIENT renvoie le quotient entier 
de deux nombres.
« RACINE » (page 207) La fonction RACINE renvoie la racine carrée d’un 
nombre.
« RACINE.PI » (page 207) La fonction RACINE.PI renvoie la racine carrée 
d’un nombre multiplié par p (pi).
« ROMAIN » (page 208) La fonction ROMAIN convertit un nombre en 
chiffres romains.
« SIGNE » (page 209) La fonction SIGNE renvoie 1 si le nombre en 
question est positif, – 1 s’il est négatif et 0 s’il est 
nul.
« SOMME » (page 209) La fonction SOMME renvoie la somme d’une 
collection de nombres.
« SOMME.CARRES » (page 211) La fonction SOMME.CARRES renvoie la somme 
des carrés d’une collection de nombres.
« SOMMEPROD » (page 212) La fonction SOMMEPROD renvoie la somme des 
produits des nombres correspondants dans un 
ou plusieurs intervalles.
« SOMME.SI » (page 213) La fonction SOMME.SI renvoie la somme d’une 
collection de nombres, y compris seuls les 
nombres qui répondent à la condition indiquée.
« SOMME.SIS » (page 215) La fonction SOMME.SIS renvoie la somme des 
cellules d’une collection dans laquelle les valeurs 
testées répondent aux conditions données.
« SOMME.X2MY2 » (page 217) La fonction SOMME.X2MY2 renvoie la somme 
de la différence des carrés des valeurs 
correspondantes dans deux collections.Fonction Description
« SOMME.X2PY2 » (page 218) La fonction SOMME.X2PY2 renvoie la somme des 
carrés des valeurs correspondantes dans deux 
collections.
« SOMME.XMY2 » (page 219) La fonction SOMME.XMY2 renvoie la somme 
des carrés des différences entre les valeurs 
correspondantes dans deux collections.
« TRONQUE » (page 220) La fonction TRONQUE scinde un nombre au 
chiffre indiqué.
ABS
La fonction ABS renvoie la valeur absolue d’un nombre ou d’une durée.
ABS(nbre-dur)
Â nbre-dur :  nombre ou valeur de durée. nbre-dur correspond à un nombre ou à une 
durée.
Remarques d’usage
Â Le résultat renvoyé par ABS est soit un nombre positif soit 0.
Exemples
=ABS(A1) renvoie 5, si la cellule A1 contient 5.
=ABS(8–5) renvoie 3.
=ABS(5–8) renvoie 3.
=ABS(0) renvoie 0.
=ABS(A1) renvoie 0, si la cellule A1 est vide.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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ALEA
La fonction ALEA renvoie un nombre aléatoire plus grand ou égal à 0 et plus petit que 
1.
ALEA()
Remarques d’usage
Â La fonction ALEA n’a pas d’argument. Toutefois, vous devez inclure les parenthèses : 
=ALEA().
Â Chaque fois que vous modifiez une valeur dans le tableau, un nouveau nombre plus 
grand ou égal à 0 et plus petit que 1 est généré.
Exemple
=ALEA() renvoie, par exemple, 0,217538648284972, 0,6137690856, 0,0296026556752622 et 
0,4684193600 dans le cas de quatre nouveaux calculs.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« ALEA.ENTRE.BORNES » à la page 183
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ALEA.ENTRE.BORNES
La fonction ALEA.ENTRE.BORNES renvoie un entier aléatoire pris dans l’intervalle 
indiqué.
ALEA.ENTRE.BORNES(inférieur; supérieur)
Â inférieur :  limite inférieure. inférieur correspond à un nombre.
Â supérieur :  limite supérieure. supérieur correspond à un nombre.
Remarques d’usage
Â Chaque fois que vous modifiez une valeur dans le tableau, un nouveau nombre 
aléatoire compris entre les limites inférieure et supérieure est généré.
Exemple
=ALEA.ENTRE.BORNES(1; 10) renvoie, par exemple, 8, 6, 2, 3 et 5 dans le cas de cinq nouveaux calculs.Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« ALEA » à la page 183
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ARRONDI
La fonction ARRONDI renvoie un nombre arrondi au nombre de chiffres indiqué.
ARRONDI(nbre-à-arrondir; décimales)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Â décimales :  nombre de décimales à conserver après la virgule. décimales
correspond à un nombre. Un nombre positif représente le nombre de décimales 
(chiffres après la virgule) à droite. Un nombre négatif représente le nombre de 
chiffres à gauche de la virgule décimale à remplacer par des zéros (le nombre de 
zéro à la fin du nombre).
Exemples
=ARRONDI(1,49; 0) renvoie 1.
=ARRONDI(1,50; 0) renvoie 2.
=ARRONDI(1,23456; 3) renvoie 1,235.
=ARRONDI(1111,222; –2) renvoie 1100.
=ARRONDI(–2,2; 0) renvoie « – 2 ».
=ARRONDI(–2,8; 0) renvoie « – 3 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PLAFOND » à la page 201
« PAIR » à la page 199
« PLANCHER » à la page 202
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
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« IMPAIR » à la page 193
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ARRONDI.AU.MULTIPLE
La fonction ARRONDI.AU.MULTIPLE arrondit un nombre au plus petit multiple 
supérieur d’un facteur donné.
ARRONDI.AU.MULTIPLE(nbre-à-arrondir; facteur)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Â facteur :  nombre à utiliser pour déterminer le multiple le plus proche. facteur
correspond à un nombre. La valeur doit présenter le même signe que nbre-à-
arrondir.
Exemples
=ARRONDI.AU.MULTIPLE(2; 3) renvoie 3.
=ARRONDI.AU.MULTIPLE(4; 3) renvoie 3.
=ARRONDI.AU.MULTIPLE(4,4999; 3) renvoie 3.
=ARRONDI.AU.MULTIPLE(4,5; 3) renvoie 6.
=ARRONDI.AU.MULTIPLE(–4,5; 3) génère une erreur.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PLAFOND » à la page 201
« PAIR » à la page 199
« PLANCHER » à la page 202« ENT » à la page 190
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ARRONDI.INF
La fonction ARRONDI.INF renvoie un nombre arrondi vers le bas (en se rapprochant de 
zéro) au nombre de chiffres indiqué.
ARRONDI.INF(nbre-à-arrondir; décimales)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Â décimales :  nombre de décimales à conserver après la virgule. décimales
correspond à un nombre. Un nombre positif représente le nombre de décimales 
(chiffres après la virgule) à droite. Un nombre négatif représente le nombre de 
chiffres à gauche de la virgule décimale à remplacer par des zéros (le nombre de 
zéro à la fin du nombre).
Exemples
=ARRONDI.INF(1,49; 0) renvoie 1.
=ARRONDI.INF(1,50; 0) renvoie 1.
=ARRONDI.INF(1,23456; 3) renvoie 1,234.
=ARRONDI.INF(1111,222; –2) renvoie 1100.
=ARRONDI.INF(–2,2; 0) renvoie « – 2 ».
=ARRONDI.INF(–2,8; 0) renvoie « – 2 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
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« PLAFOND » à la page 201
« PAIR » à la page 199
« PLANCHER » à la page 202
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
ARRONDI.SUP
La fonction ARRONDI.SUP renvoie un nombre arrondi vers le haut (en s’éloignant de 
zéro) au nombre de chiffres indiqué.
ARRONDI.SUP(nbre-à-arrondir; décimales)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Â décimales :  nombre de décimales à conserver après la virgule. décimales
correspond à un nombre. Un nombre positif représente le nombre de décimales 
(chiffres après la virgule) à droite. Un nombre négatif représente le nombre de 
chiffres à gauche de la virgule décimale à remplacer par des zéros (le nombre de 
zéro à la fin du nombre).Exemples
=ARRONDI.SUP(1,49; 0) renvoie 2.
=ARRONDI.SUP(1,50; 0) renvoie 2.
=ARRONDI.SUP(1,23456; 3) renvoie 1,235.
=ARRONDI.SUP(1111,222; –2) renvoie 1200.
=ARRONDI.SUP(–2,2; 0) renvoie « – 3 ».
=ARRONDI.SUP(–2,8; 0) renvoie « – 3 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PLAFOND » à la page 201
« PAIR » à la page 199
« PLANCHER » à la page 202
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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COMBIN
La fonction COMBIN renvoie le nombre de manières qu’il y a de combiner un nombre 
d’éléments pour former des groupes d’une taille donnée sans tenir compte de l’ordre 
dans les groupes.
COMBIN(total-éléments; taille-groupe)
Â total-éléments :  nombre d’éléments. total-éléments correspond à un nombre 
supérieur ou égal à 0. Si total-éléments présente une partie décimale (fraction), celleci est ignorée.
Â taille-groupe :  nombre d’éléments combinés dans chaque groupe. taille-groupe
correspond à un nombre supérieur ou égal à 0. Si taille-groupe présente une partie 
décimale (fraction), celle-ci est ignorée.
Remarques d’usage
Â Les combinaisons se distinguent des permutations. L’ordre des éléments d’un 
groupe est ignoré pour les combinaisons mais il est pris en compte pour les 
permutations. Par exemple, (1; 2; 3) et (3; 2; 1) constituent la même combinaison 
mais deux permutations uniques. Si vous voulez le nombre de permutations plutôt 
que le nombre de combinaisons, utilisez la fonction PERMUT.
Exemples
=COMBIN(3; 2) renvoie 3, le nombre de groupes uniques que l’on peut former en commençant par 3 
éléments et en les groupant par 2.
=COMBIN(3,2; 2,3) renvoie 3. La partie décimale des nombres est omise.
=COMBIN(5; 2) et =COMBIN(5; 3) renvoient tous deux 10.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PERMUTATION » à la page 306
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44ENT
La fonction ENT renvoie le nombre entier, inférieur ou égal, le plus proche du nombre.
ENT(nbre-à-arrondir)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Exemples
=ENT(1,49) renvoie 1.
=ENT(1,50) renvoie 1.
=ENT(1,23456) renvoie 1.
=ENT(1111,222) renvoie 1 111.
=ENT(–2,2) renvoie « – 3 ».
=ENT(–2,8) renvoie « – 3 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PLAFOND » à la page 201
« PAIR » à la page 199
« PLANCHER » à la page 202
« ARRONDI.AU.MULTIPLE » à la page 185
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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EXP
La fonction EXP renvoie e (la base des logarithmes népériens) élevé à la puissance 
indiquée.
EXP(exposant)
Â exposant :  puissance à laquelle vous souhaitez élever e. exposant correspond à un 
nombre.
Remarques d’usage
Â EXP et LN sont mathématiquement parlant l’inverse l’un de l’autre, à la différence 
où LN est défini mais où, de par l’arrondi en virgule flottante, EXP(LN(x)) peut ne pas 
donner exactement x.
Exemple
=EXP(1) renvoie 2,71828182845905, une approximation de e.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« LN » à la page 194
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44FACT
La fonction FACT renvoie la factorielle d’un nombre.
FACT(fact-nbre)
Â fact-nbre :  valeur numérique. fact-nbre correspond à un nombre supérieur ou égal à 
0. Toute partie décimale (fraction) de fact-nbre est ignorée.
Exemples
=FACT(5) renvoie 120, c’est-à-dire 1 * 2 * 3 * 4 * 5.
=FACT(0) renvoie 1.
=FACT(4,5) renvoie 24. La fraction est ignorée et la factorielle de 4 est calculée.
=FACT(–1) génère une erreur car le nombre ne peut pas être négatif.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« FACTDOUBLE » à la page 192
« MULTINOMIALE » à la page 198
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
FACTDOUBLE
La fonction FACTDOUBLE renvoie la factorielle double d’un nombre.
FACTDOUBLE(fact-nbre)
Â fact-nbre :  valeur numérique. fact-nbre correspond à un nombre supérieur ou égal à 
– 1. Les valeurs de l’intervalle – 1 à 1 renvoient 1. Toute partie décimale (fraction) de 
fact-nbre est ignorée.
Remarques d’usage
Â Pour un entier pair, la factorielle double est le produit de tous les entiers pairs plus 
petits ou égaux à l’entier donné et plus grands ou égaux à 2. Pour un entier impair, 
la factorielle double est le produit de tous les entiers impairs plus petits ou égaux à 
l’entier donné et plus grands ou égaux à 1.
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Exemples
=FACTDOUBLE(4) renvoie 8, le produit de 2 et 4.
=FACTDOUBLE(4,7) renvoie 8, le produit de 2 et 4. La partie décimale est ignorée.
=FACTDOUBLE (10) renvoie 3 840, le produit de 2, 4, 6, 8 et 10.
=FACTDOUBLE(1) renvoie 1 car tous les nombres entre – 1 et 1 renvoient 1.
=FACTDOUBLE(–1) renvoie 1 car tous les nombres entre – 1 et 1 renvoient 1.
=FACTDOUBLE (7) renvoie 105, le produit de 1, 3, 5 et 7.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« FACT » à la page 192
« MULTINOMIALE » à la page 198
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
IMPAIR
La fonction IMPAIR arrondit un nombre au nombre impair supérieur.
IMPAIR(nbre-à-arrondir)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Remarques d’usage
Â Pour arrondir à un nombre pair, utilisez la fonction PAIR.
Exemples
=IMPAIR(1) renvoie 1.
=IMPAIR(2) renvoie 3.
=IMPAIR(2,5) renvoie 3.
=IMPAIR(–2,5) renvoie « – 3 ».
=IMPAIR(0) renvoie 1.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’« PLAFOND » à la page 201
« PAIR » à la page 199
« PLANCHER » à la page 202
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
LN
La fonction LN renvoie le logarithme népérien d’un nombre, la puissance à laquelle e 
doit être élevé pour donner le nombre.
LN(nbre-pos)
Â nbre-pos :  nombre positif. nbre-pos correspond à un nombre supérieur à 0.
Remarques d’usage
Â EXP et LN sont mathématiquement parlant l’inverse l’un de l’autre, à la différence où 
LN est défini mais où, de par l’arrondi en virgule flottante, =LN(EXP(x)) peut ne pas 
donner exactement x.
Exemple
=LN(2,71828) renvoie approximativement 1, la puissance à laquelle il faut élever e pour donner 
2,71828.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
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« EXP » à la page 191
« LOG » à la page 195
« LOI.LOGNORMALE.INVERSE » à la page 278
« LOI.LOGNORMALE » à la page 277
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
LOG
La fonction LOG renvoie le logarithme d’un nombre en s’appuyant sur la base 
indiquée.
LOG(nbre-pos; base)
Â nbre-pos :  nombre positif. nbre-pos correspond à un nombre supérieur à 0.
Â base :  valeur facultative représentant la base du logarithme. base correspond à un 
nombre supérieur à 0. Si base est égal à 1, cela revient à effectuer une division par 
zéro et la fonction génère une erreur. Si base est omis, la valeur supposée par défaut 
correspond à 10.
Exemples
=LOG(8; 2) renvoie 3.
=LOG(100; 10) et LOG(100) renvoient tous deux 2.
=LOG(5,0625; 1,5) renvoie 4.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« LOG10 » à la page 196
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28« Collage d’exemples de l’aide » à la page 44
LOG10
La fonction LOG10 renvoie le logarithme en base 10 d’un nombre.
LOG10(nbre-pos)
Â nbre-pos :  nombre positif. nbre-pos correspond à un nombre supérieur à 0.
Remarques d’usage
Â Pour trouver le logarithme dans une base autre que la base 10, utilisez la fonction 
LOG.
Exemples
=LOG10(1) renvoie 0.
=LOG10(10) renvoie 1.
=LOG10(100) renvoie 2.
=LOG10(1000) renvoie 3.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« LN » à la page 194
« LOG » à la page 195
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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MOD
La fonction MOD renvoie le reste d’une division.
MOD(dividende; diviseur)
Â dividende :  nombre à diviser par un autre nombre. dividende correspond à un 
nombre.
Â diviseur :  nombre servant à diviser un autre nombre. diviseur correspond à un 
nombre. Si « diviseur » est égal à 0, cela revient à effectuer une division par zéro et la 
fonction génère une erreur.
Remarques d’usage
Â Le signe du résultat est identique à celui du diviseur.
Â Lors du calcul de MOD(a; b), la fonction renvoie un nombre r tel que a = bk + r, où r 
est compris entre 0 et b, et k est un entier.
Â MOD(a; b) équivaut à a-b*ENT(a/b).
Exemples
=MOD(6; 3) renvoie 0.
=MOD(7; 3) renvoie 1.
=MOD(8; 3) renvoie 2.
=MOD(–8; 3) renvoie 1.
=MOD(4,5; 2) renvoie 0,5.
=MOD(7; 0,75) renvoie 0,25.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« QUOTIENT » à la page 206
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44MULTINOMIALE
La fonction MULTINOMIALE renvoie le coefficient multinomial des nombres précisés. 
Pour ce faire, la fonction détermine le rapport de la factorielle de la somme des 
nombres en question sur le produit des factorielles des nombres en question.
MULTINOMIALE(nbre-non-nég; nbre-non-nég; …)
Â nbre-non-nég :  valeur numérique. nbre-non-nég correspond à un nombre supérieur 
ou égal à 0.
Â nbre-non-nég; … :  vous pouvez ajouter un ou plusieurs nombres.
Exemples
=MULTINOMIALE(2) renvoie 1. La factorielle de 2 est égale à 2. Le produit de 1 et 2 est égal à 2. Le 
rapport de 2:2 est égal à 1.
=MULTINOMIALE(1; 2; 3) renvoie 60. La factorielle de la somme de 1, 2 et 3 est égale à 720. Le produit 
des factorielles de 1, 2 et 3 est égal à 12. Le rapport de 720:12 est égal à 60.
=MULTINOMIALE(4; 5; 6) renvoie 630630. La factorielle de la somme de 4, 5 et 6 est égale à 
1,30767E+12 Le produit des factorielles de 4, 5 et 6 est égal à « 2 073 600 ». Le rapport de 
1,30767E+12:2073600 est égal à « 630 630 ».
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« FACT » à la page 192
« FACTDOUBLE » à la page 192
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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PAIR
La fonction PAIR arrondit un nombre au nombre pair supérieur.
PAIR(nbre-à-arrondir)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Remarques d’usage
Â Pour arrondir à un nombre impair, utilisez la fonction IMPAIR.
Exemples
=PAIR(1) renvoie 2.
=PAIR(2) renvoie 2.
=PAIR(2,5) renvoie 4.
=PAIR(–2,5) renvoie « – 4 ».
=PAIR(0) renvoie 0.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PLAFOND » à la page 201
« PLANCHER » à la page 202
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44PGCD
La fonction PGCD renvoie le plus grand commun dénominateur (PGCD) des nombres 
indiqués.
PGCD(valeur-num; valeur-nbre; …)
Â valeur-num :  valeur numérique. valeur-num correspond à un nombre. Si elle 
contient une fraction décimale, celle-ci est ignorée.
Â valeur-nbre; … :  vous pouvez ajouter un ou plusieurs nombres.
Remarques d’usage
Â Parfois appelé le plus grand facteur commun, le plus grand commun dénominateur 
est le plus grand entier qui divise chacun des nombres sans reste.
Exemples
=PGCD(8; 10) renvoie 2.
=PGCD(99; 102; 105) renvoie 3.
=PGCD(34; 51) renvoie 17.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PPCM » à la page 203
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PI
La fonction PI renvoie la valeur approximative de p (pi), le rapport entre la 
circonférence d’un cercle et son diamètre.
PI()
Remarques d’usage
Â La fonction PI n’a pas d’argument. Toutefois, vous devez inclure les parenthèses : 
=PI().
Â PI a une précision de l’ordre de 15 chiffres après la virgule.
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Exemples
=PI() renvoie 3,14159265358979.
=SIN(PI()/2) renvoie 1, le sinus de p/2 radians ou 90 degrés.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« COS » à la page 358
« SIN » à la page 361
« TAN » à la page 363
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PLAFOND
La fonction PLAFOND arrondit un nombre au plus petit multiple supérieur du facteur 
donné.
PLAFOND(nbre-à-arrondir; facteur-multiple)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Â facteur-multiple :  nombre servant à déterminer le multiple le plus proche. facteurmultiple correspond à un nombre de même signe que nbre-à-arrondir.
Exemples
=PLAFOND(0,25; 1) renvoie 1.
=PLAFOND(1,25; 1) renvoie 2.
=PLAFOND(–1,25; –1) renvoie « – 2 ».
=PLAFOND(5; 2) renvoie 6.
=PLAFOND(73; 10) renvoie 80.
=PLAFOND(7; 2.5) renvoie 7,5.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PAIR » à la page 199« PLANCHER » à la page 202
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PLANCHER
La fonction PLANCHER arrondit un nombre au plus petit multiple inférieur du facteur 
donné.
PLANCHER(nbre-à-arrondir; facteur)
Â nbre-à-arrondir :  nombre à arrondir. nbre-à-arrondir correspond à un nombre.
Â facteur :  nombre à utiliser pour déterminer le multiple le plus proche. facteur
correspond à un nombre. La valeur doit présenter le même signe que nbre-à-
arrondir.
Exemples
=PLANCHER(0,25; 1) renvoie 0.
=PLANCHER(1,25; 1) renvoie 1.
=PLANCHER(5; 2) renvoie 4.
=PLANCHER(73; 10) renvoie 70.
=PLANCHER(–0,25; –1) renvoie 0.
=PLANCHER(9; 2,5) renvoie 7.5.
202 Chapitre 8    Fonctions numériquesChapitre 8    Fonctions numériques 203
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PLAFOND » à la page 201
« PAIR » à la page 199
« ENT » à la page 190
« ARRONDI.AU.MULTIPLE » à la page 185
« IMPAIR » à la page 193
« ARRONDI » à la page 184
« ARRONDI.INF » à la page 186
« ARRONDI.SUP » à la page 187
« TRONQUE » à la page 220
« En savoir plus sur les arrondis » à la page 383
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PPCM
La fonction PPCM renvoie le plus petit commun multiple (PPCM) des nombres 
indiqués.
PPCM(valeur-num; valeur-nbre; …)
Â valeur-num :  valeur numérique. valeur-num correspond à un nombre.
Â valeur-nbre; … :  vous pouvez ajouter un ou plusieurs nombres.
Remarques d’usage
Â Le plus petit commun multiple est le plus petit entier qui est multiple des nombres 
indiqués.Exemples
=LCM(2; 3) renvoie 6.
=PPCM(34; 68) renvoie 68.
=PPCM(30; 40; 60) renvoie 120.
=PPCM(30,25; 40,333; 60,5) renvoie 120 (les parties fractionnelles sont ignorées).
=PPCM(2; –3) affiche une erreur (les nombres négatifs ne sont pas autorisés).
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PGCD » à la page 200
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PRODUIT
La fonction PRODUIT renvoie le produit d’un ou de plusieurs nombres.
PRODUIT(valeur-num; valeur-nbre; …)
Â valeur-num :  valeur numérique. valeur-num correspond à un nombre.
Â valeur-nbre; … :  vous pouvez ajouter un ou plusieurs nombres.
Remarques d’usage
Â Les cellules vides entre les valeurs sont ignorées et n’affectent pas le résultat.
Exemples
=PRODUIT(2; 4) renvoie 8.
=PRODUIT(0,5; 5; 4; 5) renvoie 50.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« SOMME » à la page 209
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
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« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
PUISSANCE
La fonction PUISSANCE renvoie un nombre élevé à une puissance.
PUISSANCE(nombre; exposant)
Â nombre :  valeur numérique. nombre correspond à un nombre.
Â exposant :  puissance à laquelle vous souhaitez élever le nombre indiqué. exposant
correspond à un nombre.
Remarques d’usage
Â La fonction PUISSANCE donne le même résultat que l’opérateur ^ :  =PUISSANCE(x; 
y) renvoie le même résultat que =x^y.
Exemples
=PUISSANCE(2; 3) renvoie 8.
=PUISSANCE(2; 10) renvoie 1024.
=PUISSANCE(0,5; 3) renvoie 0,125.
=PUISSANCE(100; 0,5) renvoie 10.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44QUOTIENT
La fonction QUOTIENT renvoie le quotient entier de deux nombres.
QUOTIENT(dividende; diviseur)
Â dividende :  nombre à diviser par un autre nombre. dividende correspond à un 
nombre.
Â diviseur :  nombre servant à diviser un autre nombre. diviseur correspond à un 
nombre. Si « diviseur » est égal à 0, cela revient à effectuer une division par zéro et la 
fonction génère une erreur.
Remarques d’usage
Â Si le dividende ou le diviseur est négatif, mais pas les deux, le résultat est alors 
également négatif. Si le signe du dividende et du diviseur est identique pour les 
deux, le résultat est alors toujours positif.
Â Seule la partie entière du quotient est renvoyée. La partie fractionnelle (ou reste) est 
ignoré.
Exemples
=QUOTIENT(5; 2) renvoie 2.
=QUOTIENT(5,99; 2) renvoie 2.
=QUOTIENT(–5; 2) renvoie « –2 ».
=QUOTIENT(6; 2) renvoie 3.
=QUOTIENT(5; 6) renvoie 0.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« MOD » à la page 197
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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RACINE
La fonction RACINE renvoie la racine carrée d’un nombre.
RACINE(nbre)
Â nbre :  valeur numérique. nombre correspond à un nombre.
Exemples
=RACINE(16) renvoie 4.
=RACINE(12,25) renvoie 3,5, la racine carrée de 12,25.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
RACINE.PI
La fonction RACINE.PI renvoie la racine carrée d’un nombre après l’avoir multiplié par 
p (pi).
RACINE.PI(nombre-non-nég)
Â nombre-non-nég :  nombre non négatif. nbre-non-nég correspond à un nombre 
supérieur ou égal à 0.
Exemples
=RACINE.PI(5) renvoie 3,96332729760601.
=RACINE.PI(8) renvoie 5,013256549262.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28« Collage d’exemples de l’aide » à la page 44
ROMAIN
La fonction ROMAIN convertit un nombre en chiffres romains.
ROMAIN(nbre-arabe; style-romain)
Â nbre-arabe :  nombre arabe à convertir. nbre-arabe correspond à un nombre 
compris entre 0 et 3999.
Â style-romain :  valeur facultative qui détermine avec quelle rigueur les règles 
classiques de formation des chiffres romains doivent être appliquées.
strict (0, VRAI ou omis):  utiliser les règles classiques les plus strictes. Quand un 
chiffre précède un autre supérieur pour indiquer qu’il y a soustraction, le premier 
chiffre doit correspondre à une puissance de 10 et peut précéder un nombre qui 
n’excède pas 10 fois sa taille. Par exemple, 999 est représenté par CMXCIX, et non par 
LMVLIV.
relâcher d’un degré (1):  relâcher les règles classiques strictes d’un degré. Quand 
un nombre plus petit précède un nombre plus grand, il n’est pas nécessaire que le 
nombre plus petit soit une puissance de 10 et la règle de taille relative est étendue 
d’un chiffre. Par exemple, 999 peut être représenté par LMVLIV, et non par XMIX.
relâcher de deux degrés (2):  relâcher les règles classiques strictes de deux degrés. 
Quand un nombre plus petit précède un plus grand, la règle de taille relative est 
étendue de deux chiffres. Par exemple, 999 peut être représenté par XMIX, et non 
par VMIV.
relâcher de trois degrés (3):  relâcher les règles classiques strictes de trois degrés. 
Quand un nombre précède un autre, la règle de taille relative est étendue de trois 
chiffres. Par exemple, 999 peut être représenté par VMIV, et non par IM.
relâcher de quatre degrés (4 ou FAUX):  relâcher les règles classiques strictes de 
quatre degrés. Quand un nombre plus petit précède un plus grand, la règle de taille 
relative est étendue de quatre chiffres. Par exemple, 999 peut être représenté par IM.
Exemples
=ROMAIN(12) renvoie XII.
=ROMAIN(999) renvoie CMXCIX.
=ROMAIN(999; 1) renvoie LMVLIV.
=ROMAIN(999; 2) renvoie XMIX.
=ROMAIN(999; 3) renvoie VMIV.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
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« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
SIGNE
La fonction SIGNE renvoie 1 si le numéro d’argument est positif, – 1 s’il est négatif et 0 
s’il est nul.
SIGNE(nbre)
Â nbre :  valeur numérique. nombre correspond à un nombre.
Exemples
=SIGNE(2) renvoie 1.
=SIGNE(0) renvoie 0.
=SIGNE(–2) renvoie « – 1 ».
=SIGNE(A4) renvoie – 1, si la cellule A4 contient – 2.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
SOMME
La fonction SOMME renvoie la somme d’une collection de nombres.
SOMME(nbre-date-dur; nbre-date-dur…)
Â nbre-date-dur :  valeur quelconque. nbre-date-dur correspond à un nombre, une 
valeur de date/heure ou une durée.Â nbre-date-dur…:  vous pouvez ajouter une ou plusieurs valeurs supplémentaires. 
Si plusieurs valeurs nbre-date-dur sont précisées, elles doivent toutes être du même 
type.
Remarques d’usage
Â Il existe toutefois un cas selon lequel toutes les valeurs ne doivent pas 
nécessairement être du même type. Si une seule valeur de date/heure est indiquée, 
toutes les valeurs numériques sont considérées comme étant des nombres de jours 
et toutes les valeurs numériques et de durée sont ajoutées à la valeur de date/heure.
Â Les valeurs de date/heure ne pouvant pas être additionnées (comme expliqué ciavant), une seule valeur de date/heure est donc autorisée.
Â Les valeurs peuvent se trouver dans des cellules distinctes, dans des intervalles de 
cellules ou dans les arguments de la fonction.
Exemples
=SOMME(A1:A4) additionne les nombres de quatre cellules.
=SOMME(A1:D4) additionne les nombres qui se trouvent dans un tableau carré de seize cellules.
=SOMME(A1:A4; 100) additionne les nombres de quatre cellules plus 100.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« PRODUIT » à la page 204
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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SOMME.CARRES
La fonction SOMME.CARRES renvoie la somme des carrés d’une collection de nombres.
SOMME.CARRES(valeur-num; valeur-nbre; …)
Â valeur-num :  valeur numérique. valeur-num correspond à un nombre.
Â valeur-nbre; … :  vous pouvez ajouter un ou plusieurs nombres.
Remarques d’usage
Â Les nombres peuvent se trouver dans des cellules distinctes, dans des intervalles de 
cellules ou dans les arguments de la fonction.
Exemples
=SOMME.CARRES(3; 4) renvoie 25.
=SOMME.CARRES(A1:A4) additionne les carrés de la liste de quatre nombres.
=SOMME.CARRES(A1:D4) additionne les carrés des 16 nombres qui figurent dans un tableau carré de 
cellules.
=SOMME.CARRES(A1:A4; 100) additionne les carrés des nombres qui figurent dans quatre cellules 
plus 100.
=RACINE(SOMME.CARRES(3; 4)) renvoie 5, en utilisant le théorème de Pythagore pour calculer la 
longueur de l’hypoténuse d’un triangle dont les côtés mesurent 3 et 4 unités.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44SOMMEPROD
La fonction SOMMEPROD renvoie la somme des produits des nombres correspondants 
dans un intervalle ou plus.
SOMMEPROD(intervalle; intervalle;…)
Â intervalle :  intervalle incluant les cellules. intervalle correspond à la référence à un 
seul intervalle de cellules pouvant contenir des valeurs de n’importe quel type. Si 
des valeurs de chaîne ou booléennes figurent dans intervalle, elles sont ignorées.
Â intervalle;… :  vous pouvez ajouter un ou plusieurs intervalles de cellules. Les 
intervalles doivent tous avoir les mêmes dimensions.
Remarques d’usage
Â La fonction SOMMEPROD multiplie les nombres correspondants dans chaque 
intervalle, puis additionne chacun des produits. Si un seul intervalle est indiqué, 
SOMMEPROD renvoie la somme de l’intervalle.
Exemples
=SOMMEPROD(3; 4) renvoie 12.
=SOMMEPROD({1; 2}; {3; 4}) = 3 + 8 = 11.
Rubriques connexes :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« Liste des fonctions numériques » à la page 179
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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SOMME.SI
La fonction SOMME.SI renvoie la somme d’une collection de nombres, en ne comptant 
que les nombres qui répondent à la condition indiquée.
SOMME.SI(valeurs-test; condition;  valeurs-somme)
Â valeurs-test :  collection comprenant les valeurs à tester. valeurs-test correspond à 
une collection pouvant contenir tout type de valeur.
Â condition :  expression qui entraîne un résultat logique VRAI ou FAUX. condition est 
une expression pouvant englober tout type de valeur pour autant que le résultat 
de la comparaison de condition et d’une valeur incluse dans valeurs-test puisse 
correspondre à une valeur booléenne (VRAI ou FAUX).
Â valeurs-somme :  collection facultative contenant les nombres à additionner. 
valeurs-somme correspond à une collection qui comprend des nombres, des valeurs 
de date/heure ou des durées. Elle doit avoir les mêmes dimensions que valeurs-test.
Remarques d’usage
Â Si valeurs-somme est omis, la valeur par défaut valeurs-test est utilisée.
Â Bien que valeurs-test puisse contenir des valeurs de n’importe quel type, toutes ces 
valeurs doivent généralement correspondre au même type.
Â Si valeurs-somme est omis, valeurs-test ne doit contenir que des nombres ou des 
durées.
Exemples
Prenons le tableau suivant :
=SOMME.SI(A1:A8; "=13/12/2010"; C2:C13; "=13/12/2010"; C2:C13; "=40"; D2:D13) renvoie « 75 200 », c’est-à-dire le revenu moyen des personnes 
qui ont 40 ans ou plus.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« MOYENNE » à la page 289
« AVERAGEA » à la page 250
« MOYENNE.SIS » à la page 294
« Usage de conditions et de jokers » à la page 389
« Liste des fonctions statistiques » à la page 244
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44MOYENNE.SIS
La fonction MOYENNE.SIS renvoie la moyenne (arithmétique) des cellules d’un 
intervalle donné lorsqu’un ou plusieurs intervalles remplissent une ou plusieurs 
conditions qui y sont liées.
MOYENNE.SIS(moyenne-valeurs; valeurs-test; condition; valeurs-test…; condition… )
Â moyenne-valeurs :  collection comprenant les valeurs dont on souhaite établir la 
moyenne.. moyenne-valeurs est une référence à un seul intervalle de cellules ou à un 
tableau, qui ne peut contenir que des nombres, des expressions numériques ou des 
valeurs booléennes.
Â valeurs-test :  collection comprenant les valeurs à tester. valeurs-test correspond à 
une collection pouvant contenir tout type de valeur.
Â condition :  expression qui entraîne un résultat logique VRAI ou FAUX. condition est 
une expression pouvant englober tout type de valeur pour autant que le résultat 
de la comparaison de condition et d’une valeur incluse dans valeurs-test puisse 
correspondre à une valeur booléenne (VRAI ou FAUX).
Â valeurs-test;… :  vous pouvez également ajouter une ou plusieurs collections 
contenant des valeurs à évaluer. Chaque collection de valeurs-test doit être 
immédiatement suivie d’une expression de condition. Cette succession valeurs-test, 
condition peut être répétée autant de fois que nécessaire.
Â condition;… :  expression logique VRAI ou FAUX, si la collection facultative de 
valeurs-test est précisée. une condition doit obligatoirement être placée après 
chaque argument valeurs-test ; par conséquent, cette fonction présente toujours un 
nombre impair d’arguments.
Remarques d’usage
Â Pour chacune des paires formées par valeurs-test et condition, la valeur 
correspondante (même position à l’intérieur de l’intervalle ou du tableau) est 
comparée au test conditionnel. Si tous les tests conditionnels sont satisfaits, la valeur 
correspondante dans moyenne-valeurs est prise en compte dans la moyenne.
Â Les collections moyenne-valeurs et toutes celles de valeurs-test doivent présenter les 
mêmes dimensions.
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Exemples
Prenons le tableau suivant :
=MOYENNE.SIS (D2:D13;A2:A13;"0") renvoie 5 puisque toutes les cellules de l’intervalle ont une valeur supérieure à 
zéro.
=NB.SI(A3:E3; ">=100") renvoie 3 puisque les trois nombres ont tous une valeur supérieure à 100 et 
que les deux valeurs texte sont ignorées pour la comparaison.
=NB.SI(A1:E5; "=amet") renvoie 2 puisque la chaîne de test « amet » apparaît deux fois dans 
l’intervalle.
=NB.SI(A1:E5; "=*t") renvoie 4 puisque quatre chaînes se terminent par la lettre « t » dans l’intervalle.
Rubriques associées :
Pour connaître les fonctions connexes et pour en savoir plus, reportez-vous à l’
« NB » à la page 296
« NBVAL » à la page 301
« NB.VIDE » à la page 302
« NB.SIS » à la page 299
« Usage de conditions et de jokers » à la page 389
« Exemple de résultats d’une étude » à la page 391
« Liste des fonctions statistiques » à la page 244
« Types de valeur » à la page 39
« Éléments des formules » à la page 15
« Utilisation du clavier et de la souris pour créer et modifier des formules » à la page 28
« Collage d’exemples de l’aide » à la page 44
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NB.SIS
La fonction NB.SIS renvoie le nombre de cellules d’un ou plusieurs intervalles qui 
remplissent des conditions données (une condition par intervalle).
NB.SIS(valeurs-test; condition; valeurs-test…; condition…)
Â valeurs-test :  collection comprenant les valeurs à tester. valeurs-test correspond à 
une collection pouvant contenir tout type de valeur.
Â condition :  expression qui entraîne un résultat logique VRAI ou FAUX. condition est 
une expression pouvant englober tout type de valeur pour autant que le résultat 
de la comparaison de condition et d’une valeur incluse dans valeurs-test puisse 
correspondre à une valeur booléenne (VRAI ou FAUX).
Â valeurs-test;… :  vous pouvez également ajouter une ou plusieurs collections 
contenant des valeurs à évaluer. Chaque collection de valeurs-test doit être 
immédiatement suivie d’une expression de condition. Cette succession valeurs-test, 
condition peut être répétée autant de fois que nécessaire.
Â condition;… :  expression logique VRAI ou FAUX, si la collection facultative de 
valeurs-test est précisée. une condition doit obligatoirement être placée après 
chaque argument valeurs-test ; par conséquent, cette fonction présente toujours un 
nombre impair d’arguments.
Remarques d’usage
Â Chaque valeur de valeurs-test est comparée à la condition correspondante. Si les 
valeurs correspondantes de chaque collection satisfont aux tests conditionnels 
correspondants, le nombre est augmenté de 1.Exemples
Prenons le tableau suivant :
=NB.SIS(A2:A13;"60; B2100) évalue si les données ne sont pas valides. La première expression 
dans la fonction OU, « NONVIDE(B2) », donne la valeur VRAI si aucune note n’est indiquée. Le 
deuxième argument renvoie VRAI si la note est négative. Quant à la troisième expression, elle renvoie 
VRAI si la note dépasse 100. OU renvoie ainsi VRAI si n’importe laquelle des conditions évaluées 
correspond à VRAI, indiquant que les données ne sont pas valides d’une façon ou d’une autre. La 
fonction OU renvoie FAUX si aucune des conditions n’est VRAIE ; les données sont donc valides.
Expression 3
=B260; B2100); "Données non valides"; 
SI(B25 », « 2 ».  Elles acceptent également des jokers dans 
leurs conditions. Par exemple, pour compter le nombre de cellules de la colonne B, 
commençant par la lettre « a », vous pouvez utiliser =SOMME.SI(B; "a*").
Le second groupe de fonctions acceptent les conditions, telles que RECHERCHEH, mais 
ne peuvent pas évaluer les conditions incluant les nombres. Ces fonctions autorisent 
parfois l’usage de jokers.
Fonction Autorise les comparaisons de 
nombres
Accepte les jokers
MOYENNE.SI Oui Oui
MOYENNE.SIS Oui Oui
NB.SI Oui Oui
NB.SIS Oui Oui
SOMME.SI Oui Oui
SOMME.SIS Oui Oui
RECHERCHEH Non Si la correspondance exacte est 
précisée
EQUIV Non Si la correspondance exacte est 
précisée
RECHERCHEV Non Si la correspondance exacte est 
précisée
Des exemples de conditions, avec ou sans joker, sont illustrés dans la présente 
rubrique.Expression Exemple
">4" désigne toute valeur correspondant à tout 
nombre supérieur à 4.
=NB.SI(B2:E7; “>4") renvoie le nombre de valeurs, 
issues des cellules incluses dans l’intervalle B2:E7, 
supérieures à 4.
">7" désigne toute valeur correspondant à tout 
nombre supérieur ou égal à 7.
=SOMME.SI(B; ">=7") additionne les cellules 
de la colonne B et qui contiennent une valeur 
supérieure ou égale à 7.
"=15" se rapporte à 
l’équivalence à tout nombre inférieur ou égal à 5 
ou supérieur ou égal à 15. Les nombres de 6 à 14 
inclus ne sont alors pas pris en compte.
=SOMME.SI(A3:B12; "=15") additionne les cellules incluses dans 
l’intervalle A3:B12 contenant une valeur inférieure 
ou égale à 5 ou supérieure ou égale à 15.
"*it" désigne toute valeur se terminant par « it ». 
L’astérisque (*) correspond à n’importe quelle 
séquence de caractères.
=NB.SI(B2:E7; "*it") renvoie le nombre de valeurs, 
issues des cellules incluses dans l’intervalle 
B2:E7, terminant par « it » telles que « bit » ou 
« cockpit ». Elle ne renvoie pas de valeur telle que 
« termite ».
"~*" se rapporte à l’astérisque en tant que tel 
(*). Le caractère tilde (~) indique à l’application 
de prendre le caractère suivant dans sa forme 
littérale plutôt que de l’utiliser en tant que joker.
=NB.SI(E; "~*") renvoie le nombre de valeurs, 
issues des cellules de la colonne E, et qui 
contiennent le caractère astérisque.
B2 & ", " & E2 renvoie le contenu des cellules B2 et 
E2 séparé par une virgule et un espace.
=B2&", "&E2 renvoie « Dernier, Premier » si B2 
contient « Dernier » et si E2 reprend « Premier ».
« ?ip » signifie toute valeur commençant par un 
seul caractère suivi de « ip ».
=NB.SI(B2:E7; "?ip") renvoie le nombre de valeurs, 
issues des cellules incluses dans l’intervalle B2:E7, 
commençant par un caractère suivi de « ip » 
telles que « bip » ou « VIP ». Elle ne renvoie pas de 
valeur telle que « VOIP » ou « fripe ».
"~?" se rapporte au point d’interrogation en 
tant que tel (?). Le caractère tilde (~) indique à 
l’application de prendre le caractère suivant dans 
sa forme littérale plutôt que de l’utiliser en tant 
que joker.
=CHERCHE("~?"; B2) renvoie 19 si la cellule B2 
contient « Quelle question poser ? Celle-ci, tout 
simplement. », puisque le point d’interrogation 
correspond au 23
e
 caractère dans la chaîne.
"*in?" revient à indiquer toute valeur 
commençant par n’importe quel nombre de 
caractères suivis de « in » puis un seul caractère 
final.
=NB.SI(B2:E7; "*in?") renvoie le nombre de valeurs, 
issues des cellules incluses dans l’intervalle B2:E7, 
commençant par n’importe quel nombre de 
caractères (y compris aucun) suivis de « in » puis 
d’un seul caractère final. Cela peut correspondre à 
des mots tels que « usine », « opina » ou « peint ». 
En seraient exclus des mots tels que « teinte » 
(ayant deux caractères après « in ») ou « loin » (ne 
possédant aucun caractère après « in »).
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Exemple de résultats d’une étude
Cet exemple compile les illustrations utilisées dans les fonctions statistiques. Il s’appuie 
sur une étude fictive. Cette étude est courte (seulement cinq questions) et prévoit un 
nombre très limité de sondés (10). Chaque question peut être répondue d’après une 
échelle de 1 à 5 (pouvant se présenter sous la forme de réponses allant de « jamais » 
à « toujours ») ou peuvent être laissées sans réponse. Chaque copie se voit attribuée 
un numéro avant leur envoi par courrier. Le tableau suivant reprend les résultats. Les 
questions dont la réponse n’est pas prévue à l’avance (incorrecte) ou non répondues 
sont indiquées d’une cellule vide dans le tableau.
Pour illustrer des fonctions précises, supposons que le numéro de contrôle de l’étude 
inclut un préfixe alphabétique allant de A à E au lieu de 1 à 5. Le tableau ressemble 
alors à ce qui suit :
À l’aide du présent tableau de données et de quelques unes des fonctions statistiques 
proposées dans iWork, vous pouvez rassembler des informations relatives aux résultats 
de l’étude. Gardez simplement à l’esprit que l’exemple reste volontairement réduit 
et les résultats peuvent paraître évidents. Cependant, si vous disposez de 50 sondés, 
100 ou plus encore, et de plus de questions, les résultats peuvent alors ne plus être 
aussi évidents.Fonction et arguments Description du résultat
=COEFFICIENT.CORRELATION(B2:B11; C2:C11) Détermine la corrélation de la question 1 et de 
la question 2 à l’aide de l’analyse par régression 
linéaire. La corrélation constitue une mesure 
du degré de changement simultané de deux 
variables (dans notre cas, les réponses aux 
questions de l’étude). Plus précisément, cela 
revient à se poser la question suivante :  si un 
sondé répond à la question 1 dont la valeur est 
supérieure (ou inférieure) à la moyenne de cette 
question, le sondé répond-il aussi à la question 
2 avec une valeur supérieure (ou inférieure) à la 
moyenne de la question 2 ? Dans le cas présent, 
les réponses ne sont pas particulièrement 
corrélées (–0,1732)
=NB(A2:A11) ou =NBVAL(A2:A11) Détermine le nombre total de questionnaires 
renvoyés (10). Notez que si l’identifiant de 
contrôle de l’étude ne correspond pas à un 
nombre, vous devez faire appel à NBVAL plutôt 
qu’à NB.
=NB(B2:B11) ou =NBVAL(B2:B11) Détermine le nombre total de réponses à la 
première question (9). En étendant cette formule 
sur la rangée, vous pouvez déterminer le nombre 
total de réponses à chaque question. Dans la 
mesure où toutes les données sont des nombres, 
NBVAL renvoie les mêmes résultats. Cependant, 
si l’étude utilise des réponses de A à E plutôt que 
de 1 à 5, vous devez faire appel à NBVAL pour 
additionner les résultats.
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Fonction et arguments Description du résultat
=NB.VIDE(B2:B11) Détermine le nombre de cellules vides, 
représentant des réponses non valides ou aucune 
réponse du tout. Si vous étendez cette formule 
à toute la rangée, vous pouvez remarquer que la 
question 3 (colonne D) présente 3 réponses non 
valides ou sans réponse. Cela peut vous obliger 
à regarder de plus près la question dans l’étude 
pour savoir si sa formulation s’avère controversée 
ou imprécise, si d’autres questions ne dépassent 
pas 1 seule réponse incorrecte ou aucune 
réponse.
=NB.SI(B2:B11; "=5") Détermine le nombre de sondés ayant attribué 
un 5 à une question donnée (dans notre cas, la 
question 1). Si vous étendez cette formule à toute 
la rangée, vous pouvez remarquer que seules les 
questions 3 et 4 ont vu un nombre quelconque 
de sondés leur attribuer un 5. En cas d’utilisation 
des notes de A à E pour la plage de données, 
vous devez alors utiliser =NB.SI(B2:B11; "=E")
=COVARIANCE(B2:B11; C2:C11) Détermine la covariance des questions 1 et 2. 
La covariance constitue une mesure du degré 
de changement simultané de deux variables 
(dans notre cas, les réponses aux questions de 
l’étude). Plus précisément, cela revient à se poser 
la question suivante :  si un sondé répond à la 
question 1 dont la valeur est supérieure (ou 
inférieure) à la moyenne de cette question, le 
sondé répond-il aussi à la question 2 avec une 
valeur supérieure (ou inférieure) à la moyenne de 
la question 2 ?
Remarque : COVARIANCE ne fonctionne pas 
si le tableau fait appel à une échelle de A à E, 
puisqu’elle impose l’usage d’arguments exprimés 
sous forme de nombres.Fonction et arguments Description du résultat
=ECARTYPE(B2:B11) ou =ECARTYPEP(B2:B11) Détermine l’écart-type, à savoir une mesure 
de dispersion, des réponses à la question 1. Si 
vous étendez cette formule à toute la rangée, 
vous pouvez remarquer que les réponses à 
la question 3 présentent l’écart-type le plus 
élevé. Si les résultats représentent les réponses 
de l’intégralité de la population étudiée, par 
opposition à un simple échantillon représentatif, 
la fonction ECARTYPEP est alors à utiliser plutôt 
qu’ECARTYPE. Notez qu’ECARTYPE correspond à 
la racine carrée de VAR.
=VAR(B2:B11) ou =VARP(B2:B11) Détermine la variance, à savoir une mesure de 
dispersion, des réponses à la question 1. Si vous 
étendez cette formule à toute la rangée, vous 
pouvez remarquer que les réponses à la question 
5 présentent la variance la plus faible. Si les 
résultats représentent les réponses de l’intégralité 
de la population étudiée, par opposition à un 
simple échantillon représentatif, la fonction VAR.P 
est alors à utiliser plutôt que VAR. Notez que VAR 
correspond au carré de ECARTYPE.
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1 Premiers contacts
Apple vous félicite pour l’acquisition de votre 
iPod shuffle. Lisez cette rubrique afin de vous 
familiariser rapidement avec l’iPod shuffle.
L’iPod shuffle fonctionne avec votre ordinateur. Importez des morceaux à partir de 
votre collection de musique sur CD ou de l’iTunes Music Store (disponible dans certains 
pays uniquement) vers votre ordinateur, puis connectez l’iPod shuffle pour transférer 
des morceaux choisis à écouter partout où vous allez.4 Premiers contacts
Configuration requise
Pour utiliser l’iPod shuffle avec un Macintosh, vous devez disposer des éléments 
suivants :
• Un Macintosh avec port USB intégré. Pour recharger l’iPod shuffle, connectez-le à un 
port USB à forte alimentation. Pour optimiser la rapidité des transferts, connectez-le 
à un port USB 2.0.
• Mac OS X 10.2.8, Mac OS X 10.3.4 ou ultérieur.
Pour utiliser des ports USB à faible alimentation, vous devez disposer de Mac OS X 
10.3.6 ou ultérieur.
• iTunes 4.7.1 ou ultérieur (iTunes étant disponible sur le CD de l’iPod).
Pour vérifier que vous disposez de la dernière version d’iTunes, allez à l’adresse 
www.apple.com/fr/itunes.
• Le logiciel de l’iPod (inclus sur le CD de l’iPod).
Pour utiliser l’iPod shuffle avec un PC sous Windows, vous devez disposer des 
éléments suivants :
• Un PC sous Windows avec un port USB intégré ou une carte USB. Pour recharger 
l’iPod shuffle, connectez-le à un port USB à forte alimentation. Pour effectuer des 
transferts rapides, connectez-le à un port USB 2.0.
• Windows 2000 avec le Service Pack 4 ou ultérieur ; Windows XP Édition Familiale 
ou Professionnel avec le Service Pack 2 ou ultérieur
• iTunes 4.7.1 ou ultérieur (iTunes étant disponible sur le CD de l’iPod).
Pour vérifier que vous disposez de la dernière version d’iTunes, allez à l’adresse 
www.apple.com/fr/itunes.
• Le logiciel de l’iPod (inclus sur le CD de l’iPod).Premiers contacts 5
Important :  si l’iPod shuffle ne s’adapte pas aux ports USB de votre ordinateur, vous 
pouvez utiliser un socle iPod shuffle Dock ou un câble d’extension USB. Ces accessoires 
sont disponibles sur www.apple.com/francestore.
Votre iPod shuffle comprend les éléments suivants :
iPod shuffle
Capuchon USB 
Cordon
Écouteurs Apple Earphones6 Premiers contacts
Quatre étapes pour écouter de la musique sur votre 
iPod shuffle
Pour configurer l’iPod shuffle, installez le logiciel se trouvant sur le CD de l’iPod et 
importez des morceaux à partir de votre collection de musique sur CD ou de l’iTunes 
Music Store (disponible dans certains pays uniquement). Transférez ensuite les 
morceaux vers l’iPod shuffle pour les écouter partout où vous allez.
Étape 1 :  Installation du logiciel
Insérez le CD de l’iPod dans votre ordinateur, puis installez iTunes et le logiciel de l’iPod.
Étape 2 :  Importation de musique sur votre ordinateur
Terminez cette étape si vous n’avez pas encore transféré de la musique sur votre 
ordinateur. Vous pouvez soit importer de la musique provenant de vos CD audio, soit 
(si vous disposez d’une connexion à Internet) acheter de la musique en ligne et la 
télécharger sur votre ordinateur via la boutique iTunes Music Store. Vous pouvez faire 
votre choix parmi un million de morceaux et écouter un extrait de 30 secondes de 
n’importe quelle chanson.
Pour importer la musique de vos CD audio dans votre ordinateur :
1 Insérez un CD dans votre ordinateur. iTunes s’ouvre automatiquement et le CD est 
sélectionné dans la liste Source d’iTunes.
2 Désélectionnez les morceaux que vous ne souhaitez pas transférer puis cliquez sur 
Importer.
3 Répétez l’opération pour tout autre CD avec des morceaux que vous voulez importer.
Pour acheter de la musique en ligne :
1 Ouvrez iTunes, puis cliquez sur Music Store dans la liste Source.Premiers contacts 7
2 Cliquez sur le bouton Compte puis suivez les instructions à l’écran pour créer un 
compte ou saisir les informations de votre compte Apple ou AOL (America Online) ; 
cette option est disponible dans certains pays uniquement.
Étape 3 :  Connectez l’iPod shuffle pour recharger la batterie et transférer de la 
musique
Retirez le cache USB de l’iPod shuffle et connectez l’iPod shuffle à un port USB à forte 
alimentation sur votre ordinateur. Pour optimiser la rapidité des transferts, connectez 
l’iPod shuffle à un port USB 2.0.
Important :  si l’iPod shuffle ne s’adapte pas aux ports USB de votre ordinateur, vous 
pouvez utiliser un socle iPod shuffle Dock ou un câble d’extension USB, disponibles sur 
www.apple.com/francestore.
Insérez l’iPod shuffle
dans un port
USB 2.0 à forte 
alimentation de
votre ordinateur8 Premiers contacts
Pour recharger la batterie de l’iPod shuffle :
Lorsque l’iPod shuffle est connecté à un port USB à forte alimentation sur votre 
ordinateur, la batterie se recharge. Le voyant d’état de la batterie, au dos de 
l’iPod shuffle (voir la page 15), s’allume en jaune lorsque la batterie se recharge et en 
vert lorsqu’elle est complètement rechargée. Si le voyant ne s’allume pas, connectez 
l’iPod shuffle à un autre port USB.
La première fois que vous connectez l’iPod shuffle, laissez-le branché pendant environ 
une heure afin de charger complètement la batterie.
Pour transférer des morceaux sur l’iPod shuffle : 
Lorsque vous connectez l’iPod shuffle à votre ordinateur, iTunes s’ouvre 
automatiquement et transfère les morceaux sélectionnés vers l’iPod shuffle. Au terme 
du transfert des morceaux, un message d’iTunes apparaît indiquant que l’iPod est à 
jour et que la déconnexion est autorisée.
Étape 4 :  Écoute de morceaux
Une fois que vous avez rechargé la batterie de l’iPod shuffle et transféré des morceaux, 
vous pouvez écouter votre musique.
Déconnectez l’iPod shuffle de votre ordinateur et réglez le bouton (au dos de 
l’iPod shuffle) pour écouter les morceaux dans l’ordre ( ) ou bien dans un ordre 
aléatoire (¡).
Connectez ensuite les écouteurs Apple Earphones, appuyez sur le bouton Lire de 
l’iPod shuffle et profitez de votre musique !9
1 Transfert et lecture de votre 
musique
Lisez cette rubrique pour en savoir plus sur le 
transfert de musique vers l’iPod shuffle et la lecture 
de vos morceaux.
Une fois que vous possédez de la musique sur votre ordinateur (voir la page 6), vous 
pouvez connecter l’iPod shuffle et configurer iTunes pour transférer de la musique vers 
l’iPod shuffle comme vous le souhaitez. Puis, chaque fois que vous connectez l’iPod shuffle, 
iTunes transfère de la musique en fonction des réglages que vous avez effectués.
Utilisation d’iTunes pour organiser votre musique sur votre 
ordinateur
En utilisant iTunes, vous pouvez rechercher, lire et organiser la musique qui se trouve 
sur votre ordinateur. Vous pouvez organiser votre musique par listes de morceaux, 
appelées listes de lecture. Vous pouvez configurer iTunes pour transférer de la musique 
à partir d’une de ces listes de lecture vers l’iPod shuffle.10 Transfert et lecture de votre musique
Pour créer une liste de lecture dans iTunes : 
n Dans iTunes, cliquez sur le bouton plus Ajouter (+) et attribuez un nom à la liste de 
lecture, puis faites glisser les morceaux depuis la bibliothèque ou une autre liste de 
lecture vers la nouvelle liste de lecture.
Remarque :  iTunes dispose de nombreuses autres fonctionnalités. Vous pouvez créer 
des CD pouvant être lus par des lecteurs de CD standard (si votre ordinateur dispose 
d’un graveur de CD), créer des listes de lecture actualisées de manière dynamique, 
appelées Listes de lecture intelligentes, écouter la radio via Internet, coter des 
morceaux selon vos préférences et bien plus encore.
Ce manuel contient des informationssur le transfert de musique vers l’iPod shuffle via 
iTunes. Pour plus d’informations sur l’utilisation des fonctionnalités d’iTunes, ouvrez 
iTunes et choisissez Aide > Aide iTunes et Music Store.
Transfert de musique vers l’iPod shuffle
Vous pouvez connecter l’iPod shuffle à n’importe quel port USB de votre ordinateur 
afin de transférer des morceaux provenant d’iTunes. Pour effectuer des transferts 
encore plus rapides, connectez l’ iPod shuffle à un port USB 2.0.
Vous pouvez transférer des morceaux automatiquement ou manuellement.Transfert et lecture de votre musique 11
Pour transférer des morceaux automatiquement vers l’iPod shuffle :
n Retirez simplement le cache USB et connectez l’iPod shuffle à votre ordinateur. iTunes 
s’ouvre et transfère de la musique vers l’iPod shuffle en fonction des réglages que vous 
avez effectués dans iTunes (voir la page 12). 
n Si l’iPod shuffle est déjà connecté et si vous avez modifié les réglages, cliquez sur 
Remplissage auto pour sélectionner et transférer les nouveaux morceaux suivant les 
nouveaux réglages.
Remarque :  avec les versions de Mac OS X antérieures à Mac OS X 10.3.6, un port USB à 
forte alimentation est nécessaire.
Pour transférer manuellement des morceaux vers l’iPod shuffle :
n Connectez l’iPod shuffle et faites-y glisser les morceaux dans la liste Source.
Pour supprimer manuellement des morceaux de l’iPod shuffle :
1 Connectez l’iPod shuffle et sélectionnez-le dans la liste Source. 
2 Choisissez un morceau et appuyez sur la touche Suppr. du clavier.
Pour configurer iTunes de telle sorte que l’iPod shuffle soit maintenu dans la liste 
Source lorsqu’il n’est pas connecté :
Vous pouvez configurer iTunes de manière à maintenir l’iPod shuffle dans la liste 
Source même lorsqu’il est déconnecté. Vous avez également la possiblité de modifier 
les réglages ou d’ajouter et de supprimer des morceaux dans la liste de l’iPod shuffle. 
Si vous connectez à nouveau l’iPod shuffle, les morceaux sont transférés suivant vos 
modifications.
1 Dans iTunes, selectionnez iPod shuffle dans la liste Source puis cliquez sur le bouton 
Options.12 Transfert et lecture de votre musique
2 Sélectionnez l’option “Conserver cet iPod dans la liste Source.”
Configuration d’iTunes pour transférer de la musique vers 
l’iPod shuffle
Vous pouvez configurer iTunes pour transférer des morceaux choisis dans toute votre 
bibliothèque musicale ou dans une liste de lecture d’iTunes en particulier. Vous pouvez 
configurer l’application pour choisir des morceaux dans l’ordre ou de manière aléatoire.
Connectez l’iPod shuffle à votre ordinateur et sélectionnez iPod shuffle dans la liste 
Source d’iTunes. Suivez ensuite les instructions ci-dessous. 
Pour sélectionner la source à partir de laquelle iTunes transfère des morceaux vers 
l’iPod shuffle :
n Sélectionnez une liste de lecture dans le menu local “Remplissage auto depuis”. Pour 
transférer des morceaux à partir de votre bibliothèque tout entière, sélectionnez 
Bibliothèque.
Pour configurer iTunes pour sélectionner des morceaux au hasard à partir de la 
source sélectionnée :
n Choisissez “Sélectionner les morceaux de manière aléatoire.”
Si cette option n’est pas sélectionnée, iTunes transférera les morceaux dans l’ordre où 
ils apparaissent dans la liste de lecture sélectionnée ou dans la Bibliothèque.
Bouton OptionsTransfert et lecture de votre musique 13
Pour configurer iTunes de sorte à sélectionner plus souvent les morceaux les mieux 
cotés pour le transfert :
n Sélectionnez “Choisir plus souvent les morceaux les mieux classés.”
Pour configurer iTunes de sorte à laisser des morceaux déjà sélectionnés sur 
l’iPod shuffle lorsque vous cliquez sur Remplissage auto :
n Désélectionnez l’option “Remplacer tous les morceaux lors du remplissage auto.”
En cliquant sur Remplissage auto, les morceaux que vous avez déjà sélectionnés ne 
sont pas effacés et iTunes sélectionne de nouveaux morceaux pour remplir l’espace 
disponible sur l’iPod shuffle.
Conversion de morceaux pour économiser de l’espace sur 
l’iPod shuffle
Les morceaux encodés n’utilisant pas le format AAC peuvent occuper plus d’espace. 
Vous pouvez configurer iTunes pour convertir les morceaux à débit supérieur lors de 
leur transfert, afin qu’ils occupent moins d’espace sur l’iPod shuffle.
Pour configurer iTunes afin de convertir au format AAC à 128 kbps les morceaux 
à débit supérieur lors de leur transfert : 
1 Connectez l’iPod shuffle à votre ordinateur.
2 Dans iTunes, sélectionnez iPod shuffle dans la liste Source et cliquez sur le bouton 
Options.
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3 Sélectionnez “Convertir en AAC de 128 kbps les morceaux à débit supérieur”.
Remarque :  en sélectionnant cette option, les morceaux encodés aux formats AIFF ou 
Apple Lossless sont convertis à 128 kbps lors de leur transfert vers l’iPod shuffle (les 
fichiers des morceaux dans iTunes ne sont pas affectés). Dans le cas contraire, 
iPod shuffle ne lit pas les morceaux dans ces formats d’encodage.
Formats de fichiers audio pris en charge par l’iPod shuffle
• AAC (M4A, M4B, M4P) (jusqu’à 320 Kb/s)
• MP3 (jusqu’à 320 Kb/s)
• MP3 Variable Bit Rate (VBR)
• WAV
• AA (texte lu audible.com, formats 2, 3 et 4)
Un morceau encodé au format AAC ou MP3 possède la même qualité qu’un CD tout en 
occupant deux fois moins d’espace qu’un morceau encodé au format AIFF ou WAV. 
Quand vous importez de la musique depuis un CD à l’aide d’iTunes, elle est convertie 
par défaut au format AAC.
Si vous utilisez iTunes pour Windows, vous pouvez convertir les fichiers WMA non 
protégés au format AAC ou MP3. Cela peut être utile si vous disposez d’une 
bibliothèque de musique encodée au format WMA. Pour plus d’informations, ouvrez 
iTunes et choisissez Aide > Aide iTunes et Music Store.
L’iPod shuffle ne prend pas en charge les fichiers audio AIFF, Apple Lossless, MPEG 
Layer 1, MPEG Layer 2, WMA ni le format 1 d’audible.com. Transfert et lecture de votre musique 15
Utilisation des commandes de l’iPod shuffle
Utilisez les commandes de l’iPod shuffle pour lire et interrompre des morceaux mais 
aussi modifier le volume. Utilisez le bouton situé au dos de l’iPod shuffle pour 
configurer l’iPod shuffle afin de lire les morceaux dans l’ordre ou dans le désordre.
Réglage du volume (+)
Voyant d’état Port pour les écouteurs
Bouton 
Lecture/Pause
Précédent/Rembobiner
Réglage du volume (-)
Suivant/Avance rapide
Position Éteint
Lecture dans l'ordre
Lecture aléatoire
Voyant/bouton d’état  
de la batterie
Connecteur USB16 Transfert et lecture de votre musique
Commandes de l’iPod shuffle
Configurer l’iPod shuffle pour lire les 
morceaux dans l’ordre
Réglez le bouton pour lire les morceaux dans 
l’ordre(/).
ConfigureriPod shuffle pour mélanger les 
morceaux
Réglez le bouton pour mélanger (¡).
Aller au début de la liste de lecture Appuyez trios fois rapidement sur les boutons 
Lecture/Pause (’).
Éteindre l’iPod shuffle Réglez le bouton sur Off. 
Lire ou interrompre un morceau Appuyez sur le bouton Lecture/Pause (’). 
Lorsque l'iPod shuffle est mis sur pause, le voyant 
d'état est vert et clignote pendant une minute.
Réglage du volume Appuyez sur le bouton (?) pour augmenter le 
volume ou (D) pour le baisser.
Saut au morceau suivant Appuyez sur le bouton Suivant/Avance rapide (‘).Transfert et lecture de votre musique 17
Réécouter le morceau ou lire le morceau 
précédent
Appuyez une fois sur le bouton Précédent/
Rembobiner (]) pour réécouter un morceau. 
Appuyez deux fois dessus pour lire le morceau 
précédent.
Avance rapide ou rembobiner Maintenez enfoncé le bouton Suivant/Avance 
rapide (‘) ou Précédent/Rembobiner (]).
Désactivation des boutons de l’iPod shuffle
(Pour ne pas les utiliser accidentellement)
Maintenez enfoncé le bouton Lecture/Pause (’) 
pendant 3 secondes environ. Le voyant d'état est 
orange et clignote trois fois. Maintenez à nouveau 
le bouton Lecture/Pause enfoncé pour activer les 
boutons.
Vérification du niveau de la batterie Appuyez sur le bouton d’état de la batterie.
Voir page 19.
Commandes de l’iPod shuffle18  
1 Recharge de la batterie
Lisez cette rubrique pour en savoir plus sur la 
recharge de la batterie de l’iPod shuffle.
L’iPod shuffle possède une batterie rechargeable, interne et que vous ne pouvez pas 
remplacer vous-même.
Pour recharger la batterie de l’iPod shuffle :
Retirez le cache USB et connectez l’iPod shuffle à un port USB à forte alimentation sur 
votre ordinateur. Le voyant d’état de la batterie qui se trouve sur le dos de l’iPod shuffle 
s’allume.
Il faut environ 2 heures pour recharger la batterie de l’iPod shuffle à 80 % et 4 heures 
pour la recharger complètement.
Lorsque la batterie se recharge, son voyant d’état de l’iPod shuffle s’allume en jaune. 
Une fois la batterie complètement rechargée, le voyant devient vert jusqu’à ce que 
vous déconnectiez l’iPod shuffle. Si le voyant d'état ne s'allume pas, essayez d’utiliser 
un autre port USB de votre ordinateur.
Remarque :  si l'iPod shuffle est utilisé en tant que disque (voir page 20), le voyant 
d'état clignote de couleur jaune de façon continue.Recharge de la batterie 19
Remarque :  les batteries rechargeables ont un nombre limité de cycles de recharge. La 
durée de vie de la batterie et le nombre de cycles de recharge varient en fonction de 
l’utilisation et des réglages de l’iPod. Pour plus d’informations, rendez-vous sur 
www.apple.com/fr/batteries.
Pour vérifier l’état de la batterie :
Appuyez sur le bouton d’état de la batterie, au dos de l’iPod shuffle. Le voyant d’état de 
la batterie indique le niveau de la recharge.
Si le voyant d'état de la batterie et vert lorsque vous appuyez sur le bouton d'état de la 
batterie, l'iPod shuffle est suffisamment rechargé. Si le voyant est jaune, l'iPod shuffle 
est faiblement rechargé ; s'il est rouge, l'iPod shuffle est pratiquement déchargé et 
vous devez le recharger rapidement. Si aucun voyant ne s'allume, la batterie est 
complètement déchargée : rechargez l'iPod shuffle pour pouvoir l'utiliser.
Bouton d’état  
de la batterie
Voyant d’état  
de la batterie20  
1 Stockage de fichiers sur 
l’iPod shuffle
Lisez cette rubrique pour en savoir plus 
sur l’utilisation de l’iPod shuffle comme 
disque dur externe.
Vous pouvez stocker des données sur l’iPod shuffle, et connecter celui-ci à un autre 
ordinateur pour transférer ces données.
Pour utiliser l’iPod shuffle comme disque dur :
1 Connectez l’iPod shuffle à votre ordinateur.
2 Dans iTunes, selectionnez iPod shuffle dans la liste Source puis cliquez sur le bouton 
Options.
3 Sélectionnez Activer l’utilisation du disque.
4 Si vous souhaitez réserver une certaine quantité d’espace au stockage de vos fichiers, 
utilisez le curseur d’allocation de stockage.
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Remarque :  pour faire de la place aux morceaux, vous devez supprimer des fichiers 
de l’iPod shuffle.
Lorsque vous utilisez l’iPod shuffle comme disque dur, le voyant d'état sur la face avant 
de l'iPod est orange et clignote de façon continue et l’icône du disque dur de 
l’iPod shuffle apparaît sur le bureau si vous utilisez un Mac, ou bien la lettre de lecteur 
suivante disponible dans l’Explorateur Windows si vous utilisez un PC sous Windows. 
Faites glisser des fichiers à partir de et en direction de l’iPod shuffle afin de les copier.
Éjection de l’iPod shuffle
Important :  si le voyant d'état de l'ipod shuffle est orange et clignote, éjectez l'iPod 
shuffle avant de le déconnecter de l'ordinateur. Si vous n’éjectez pas l’iPod shuffle 
avant de le déconnecter, vous risquez d’endommager les fichiers qui s’y trouvent.
Pour éjecter l’iPod shuffle :
n Cliquez sur le bouton d’éjection (C) à côté de l’iPod shuffle dans la liste Source d’iTunes.
Si vous utilisez un Mac, vous pouvez également éjecter l’iPod shuffle en faisant glisser 
son icône sur le bureau jusque dans la Corbeille.
Si vous utilisez un PC sous Windows, vous pouvez éjecter l’iPod shuffle en cliquant sur 
l’icône Supprimer le périphérique en toute sécurité de la barre des tâches Windows 
puis en le sélectionnant.
Prévention de l’ouverture automatique d’iTunes
Si vous utilisez l’iPod shuffle principalement comme disque dur, il est recommandé 
d’empêcher l’ouverture automatique d’iTunes lorsque vous connectez l’iPod shuffle 
à votre ordinateur.22 Stockage de fichiers sur l’iPod shuffle
Pour empêcher iTunes de s’ouvrir automatiquement quand vous connectez 
l’iPod shuffle à votre ordinateur : 
1 Dans iTunes, selectionnez iPod shuffle dans la liste Source puis cliquez sur le bouton 
Options.
2 Désélectionnez l’option “Ouvrir iTunes à la connexion de cet iPod”.23
1 Accessoires de l’iPod shuffle 
L’iPod shuffle est accompagné d’un certain nombre 
d’accessoires mais bien d’autres sont disponibles sur 
www.apple.com/francestore.
Écouteurs Apple Earphones
L’iPod shuffle est livré avec une paire d’écouteurs de grande qualité. 
Pour utiliser ces écouteurs :
n Branchez-les écouteurs sur le port correspondant, puis placez-les dans vos oreilles 
comme illustré. 
Le cordon des écouteurs est réglable24 Accessoires de l’iPod shuffle
Cordon de l’iPod shuffle
Retirez le cache USB de l’iPod shuffle, puis attachez fermement l’iPod shuffle au cordon. 
Pour détacher l’iPod shuffle, retirez simplement le cordon.
Accessoires disponibles
Vous pouvez acheter des accessoires de l’iPod shuffle sur www.apple.com/francestore. 
Parmi les accessoires disponibles, citons :
• Le socle iPod shuffle Dock
• Le brassard de l’iPod shuffle
• L’adaptateur secteur USB iPod Power Adapter
• Des accessoires supplémentaires comme par exemple haut-parleurs, casques 
d’écoute, adaptateurs stéréo pour votre voiture et bien d’autres encore
Avertissement :  faites attention lorsque vous transportez l’iPod shuffle avec le cordon. 
Certaines activités peuvent comporter un risque de blessure, surtout si le cordon se 
coince quelque part (par exemple si vous courez, si vous faites du vélo ou bien si vous 
travaillez avec des machines).
Enclenchez l’iPod shuffle
au cordon.25
1 Astuces et dépannage
La plupart des problèmes de l’iPod shuffle peuvent 
être rapidement résolus en suivant les conseils de ce 
chapitre.
Votre iPod shuffle ne s’allume pas ou ne répond plus
• Si le voyant d'état est orange et clignote lorsque vous appuyez sur un bouton, cela 
signifie que les boutons de l'iPod shuffle sont désactivés. Maintenez le bouton 
Lecture/Pause enfoncé pendant environ trois secondes, jusqu'à ce que le voyant 
d'état vert clignote. 
• Si vous n'obtenez aucun résultat, connectez l'iPod shuffle à un port USB à forte 
alimentation sur votre ordinateur. Votre iPod shuffle a peut-être besoin d'être 
rechargé.
• Éteignez l'iPod shuffle, patientez cinq secondes puis rallumez-le.
• Si le problème persiste, il se peut que vous deviez restaurer le logiciel de l’iPod shuffle. 
Consultez “Mise à jour et restauration du logiciel de l’iPod shuffle” à la page 27.
Votre iPod shuffle ne lit plus la musique
• Assurez-vous que les écouteurs sont correctement connectés.
• Assurez-vous que le volume est correctement réglé. 26 Astuces et dépannage
• Si le problème persiste, appuyez sur le bouton Lecture/Pause. Votre iPod shuffle est 
peut-être en mode pause.
Rien ne se produit si vous connectez l’iPod shuffle à votre 
ordinateur
• Connectez l’iPod shuffle à un port USB à forte alimentation de votre ordinateur. 
Il a peut-être besoin d’être rechargé. 
Remarque :  avec les versions de Mac OS X antérieures à Mac OS X 10.3.6, vous ne 
pouvez utiliser l’iPod shuffle qu’avec un port USB à forte alimentation.
• Assurez-vous que l’iPod shuffle est bien connecté à votre ordinateur. Assurez-vous 
que le connecteur est orienté correctement. Il ne peut être inséré que dans un sens.
• Éteignez l’iPod shuffle, patientez cinq secondes puis rallumez-le.
• Assurez-vous que vous avez installé le logiciel situé sur le CD de l’iPod.
• Assurez-vous que vous disposez de l’ordinateur et du logiciel requis. Consultez 
“Configuration requise” à la page 4.
• Si le problème persiste, il se peut que vous deviez restaurer le logiciel de 
l’iPod shuffle. Consultez la rubrique “Mise à jour et restauration du logiciel de 
l’iPod shuffle” ci-dessous.
Si l’iPod shuffle s’adapte pas au port USB
• Vous pouvez le connecter à l’aide d’un socle iPod shuffle Dock ou d’un câble 
d’extension USB, disponibles sur www.apple.com/francestore.
Si le transfert des morceaux est lent
• Connectez l’iPod shuffle à un port USB 2.0 de votre ordinateur pour réaliser des 
transferts plus rapides. Une connexion USB 2.0 permet de transférer des morceaux et 
des données beaucoup vite qu’une connexion USB 1.1.Astuces et dépannage 27
Mise à jour et restauration du logiciel de l’iPod shuffle
Apple met régulièrement à jour le logiciel de l’iPod shuffle pour améliorer ses 
performances ou lui ajouter des fonctionnalités. Il vous est recommandé de mettre 
à jour votre iPod shuffle pour utiliser le logiciel le plus récent.
Vous pouvez soit mettre à jour, soit restaurer le logiciel de l’iPod shuffle 
• Si vous choisissez de mettre à jour, le logiciel sera mis à jour, mais vos réglages et 
morceaux seront conservés. 
• Si vous choisissez de restaurer, tous les morceaux et données seront effacés de votre 
iPod shuffle. Tous les réglages d’origine de l’iPod shuffle seront rétablis.
Pour mettre à jour ou restaurer l’iPod shuffle avec le logiciel le plus récent :
1 Allez à l’adresse www.apple.com/fr/support/ipod et téléchargez la dernière mise à jour 
de l’iPod. La mise à jour comprend le logiciel le plus récent pour tous les modèles 
d’iPod.
2 Double-cliquez sur le fichier d’installation du logiciel et suivez les instructions à l’écran 
pour installer la mise à jour de l’iPod shuffle.
3 Connectez l’iPod shuffle à votre ordinateur et ouvrez iTunes. L’application de mise à 
jour de l’iPod s’ouvre.
Si vous utilisez un PC sous Windows et que l’application de mise à jour de l’iPod ne 
s’ouvre pas automatiquement, vous pouvez la lancer en sélectionnant Démarrer > 
Programmes > iPod.
4 Suivez les instructions à l’écran pour mettre à jour ou restaurer le logiciel de 
l’iPod shuffle.
Si vous utilisez l’application de mise à jour de l’iPod et qu’elle ne détecte pas que 
l’iPod shuffle est connecté à votre ordinateur, réinitialisez l’iPod shuffle.28 Astuces et dépannage
Si vous souhaitez restaurer le logiciel de l’iPod shuffle et que vous ne disposez pas 
d’une connexion à Internet, vous pouvez utiliser l’application de mise à jour de l’iPod 
installée sur votre ordinateur en même temps que le logiciel à partir du CD de l’iPod. 
Pour restaurer le logiciel de l’iPod shuffle à l’aide du programme de mise à jour de 
l’iPod fourni sur le CD de l’iPod :
• Si vous possédez un Mac, vous pouvez trouver le programme de mise à jour de l’iPod 
dans Applications/Utilitaires/Logiciel iPod. 
• Si vous possédez un PC sous Windows, vous pouvez le trouver en sélectionnant 
Démarrer > Programmes > iPod.29
1 En savoir plus, service et 
assistance
Vous trouverez plus d’informations sur l’utilisation 
de l’iPod shuffle dans l’aide à l’écran et sur le Web.
Aide à l’écran
Pour en savoir plus sur l’utilisation d’iTunes, ouvrez iTunes et choisissez 
Aide > Aide iTunes et Music Store.
Ressources en ligne 
Pour obtenir les toutes dernières informations sur l’iPod shuffle, consultez le site Web 
www.apple.com/fr/ipod.
Pour consulter l’initiation en ligne de l’iPod shuffle, les informations sur les services et 
l’assistance concernant l’iPod shuffle, ainsi que les téléchargements de logiciels Apple 
les plus récents, rendez-vous sur www.apple.com/fr/support/ipod.
Pour enregistrer l’iPod shuffle, rendez-vous sur www.apple.com/register.30 En savoir plus, service et assistance
Obtention du service assuré par garantie
Si, malgré tout, le périphérique continue à ne pas fonctionner, rendez-vous sur 
www.apple.com/fr/support pour en savoir sur la manière d'obtenir un service 
dans le cadre de la garantie.
Emplacement du numéro de série de votre iPod shuffle
Le numéro de série est imprimé au dos de votre iPod shuffle, à côté du connecteur USB.31
1 Sécurité et entretien
Lisez cette rubrique pour en savoir plus sur la 
sécurité d’utilisation et l’entretien de l’iPod shuffle.
Nettoyage
Respectez les règles générales suivantes lorsque vous nettoyez l’extérieur de votre 
iPod shuffle et ses composants :
• Assurez-vous que votre iPod shuffle est débranché.
• Utilisez un chiffon doux, humide et non pelucheux. Évitez toute pénétration 
d’humidité dans les orifices de l’appareil.
• N’utilisez ni vaporisateur aérosol, ni dissolvant, ni alcool, ni abrasif.
À propos de la manipulation
Une manipulation ou un rangement inappropriés peuvent endommager votre 
iPod shuffle. Veillez à ne pas faire tomber votre iPod shuffle lorsque vous l’utilisez 
ou le transportez. Remettez le cache USB sur l’iPod shuffle lorsque celui-ci n’est pas 
connecté à votre ordinateur.32 Sécurité et entretien
Instructions de sécurité importantes
Lorsque vous installez et utilisez votre iPod shuffle, ne perdez pas de vue les points 
suivants :
• Respectez toutes les instructions et les avertissements concernant votre iPod shuffle.
• Conservez ces instructions à portée de main pour que vous ou d’autres personnes 
puissiez vous y reporter.
Connecteurs et Ports
N’essayez jamais de brancher un connecteur dans un port. Si le connecteur et le port 
ne s’assemblent pas avec une relative facilité, c’est probablement parce qu’ils ne sont 
pas compatibles. Assurez-vous que le connecteur est compatible avec le port et que 
vous l’avez positionné correctement par rapport à ce dernier.
Avertissement :  les appareils électriques peuvent s’avérer dangereux s’ils ne sont pas 
utilisés correctement. L’utilisation de ce produit ou de produits analogues doit 
toujours être supervisée par un adulte. Ne laissez jamais les enfants accéder à la partie 
interne de tout produit électrique ni manipuler aucun câble.Sécurité et entretien 33
N’utilisez jamais les écouteurs au volant
Important :  l’utilisation des écouteurs n’est pas recommandée lorsque vous conduisez 
et constitue d’ailleurs une infraction au code de la route dans certains endroits. Soyez 
prudent et attentif au volant. Cessez d’utiliser votre iPod shuffle si vous vous rendez 
compte que cela vous distrait ou vous dérange lorsque vous conduisez un véhicule ou 
lorsque vous réalisez quelque autre activité nécessitant toute votre attention.
À propos des températures d’utilisation et de stockage
• Utilisez votre iPod shuffle dans un endroit où la température est toujours comprise 
entre 0 et 35 ºC.
• Rangez votre iPod shuffle dans un endroit où la température est toujours comprise 
entre -20º et 45 ºC. Ne laissez pas l’iPod shuffle dans votre voiture car la température 
dans les voitures en stationnement peut dépasser cette fourchette.
• L’autonomie de l’iPod shuffle peut diminuer temporairement dans des conditions de 
basses températures. 
Avertissement :  vous risquez une perte d’audition irréparable si vous écoutez de 
la musique à très haut volume avec un casque ou des écouteurs. Vous pouvez vous 
habituer petit à petit à un volume de son plus élevé qui peut vous paraître normal 
mais entraîner une détérioration de votre audition. Pour vous éviter ce risque, réglez 
le volume de votre iPod shuffle à un niveau raisonnable. Si vous entendez un 
sifflement, diminuez le volume ou pensez à interrompre régulièrement l’utilisation 
de votre iPod shuffle.34 Sécurité et entretien
Éviter les endroits humides
• Gardez votre iPod shuffle à l’écart de toute source de liquide telle que boissons, 
lavabos, baignoires, cabines de douche, pluie, etc.
S’il vous arrive de renverser un liquide sur votre iPod, il se peut que vous deviez le 
renvoyer à Apple pour une réparation. Reportez-vous à la section “En savoir plus, 
service et assistance” à la page 29.
N’effectuez aucune réparation vous-même
Pour toute réparation, reportez-vous à la section “En savoir plus, service et assistance” à 
la page 29.
Avertissement :  pour réduire les risques d’électrocution ou d’accident, n’utilisez pas 
votre iPod shuffle dans l’eau, près de l’eau ou dans des endroits humides.
Avertissement :  n’essayez pas d’ouvrir votre iPod shuffle, de le démonter ou de retirer 
la batterie. Vous courez le risque de recevoir une décharge électrique et d’annuler la 
garantie limitée. L’appareil ne contient pas de pièces qui puissent être réparées par 
l’utilisateur.35
Communications Regulation Information
FCC Compliance Statement
This device complies with part 15 of the FCC 
rules. Operation is subject to the following two 
conditions:  (1) This device may not cause 
harmful interference, and (2) this device must 
accept any interference received, including 
interference that may cause undesired 
operation. See instructions if interference to 
radio or television reception is suspected.
Radio and Television Interference
This computer equipment generates, uses, and 
can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict 
accordance with Apple’s instructions—it may 
cause interference with radio and television 
reception.
This equipment has been tested and found to 
comply with the limits for a Class B digital 
device in accordance with the specifications in 
Part 15 of FCC rules. These specifications are 
designed to provide reasonable protection 
against such interference in a residential 
installation. However, there is no guarantee that 
interference will not occur in a particular 
installation.
You can determine whether your computer 
system is causing interference by turning it off. 
If the interference stops, it was probably caused 
by the computer or one of the peripheral 
devices.
If your computer system does cause 
interference to radio or television reception, try 
to correct the interference by using one or more 
of the following measures:
• Turn the television or radio antenna until the 
interference stops.
• Move the computer to one side or the other 
of the television or radio.
• Move the computer farther away from the 
television or radio.
• Plug the computer in to an outlet that is on a 
different circuit from the television or radio. 
(That is, make certain the computer and the 
television or radio are on circuits controlled by 
different circuit breakers or fuses.)
If necessary, consult an Apple Authorized 
Service Provider or Apple. See the service and 
support information that came with your Apple 
product. Or, consult an experienced radio/
television technician for additional suggestions.36
Important:  Changes or modifications to this 
product not authorized by Apple Computer, Inc. 
could void the EMC compliance and negate 
your authority to operate the product.
This product was tested for EMC compliance 
under conditions that included the use of Apple 
peripheral devices and Apple shielded cables 
and connectors between system components. 
It is important that you use Apple peripheral 
devices and shielded cables and connectors 
between system components to reduce the 
possibility of causing interference to radios, 
television sets, and other electronic devices. You 
can obtain Apple peripheral devices and the 
proper shielded cables and connectors through 
an Apple Authorized Reseller. For non-Apple 
peripheral devices, contact the manufacturer or 
dealer for assistance. Responsible party (contact 
for FCC matters only): Apple Computer, Inc. 
Product Compliance, 1 Infinite Loop M/S 26-A, 
Cupertino, CA 95014-2084, 408-974-2000.
Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de classe B respecte 
toutes les exigences du Règlement sur le 
matériel brouilleur du Canada.
VCCI Class B Statement
Caractéristiques électriques
5 V C.C. 1 A maximum
Batterie
Votre iPod shuffle renferme une batterie. Si vous 
rencontrez des problèmes avec celle-ci, assurezvous d’actualiser l’iPod shuffle avec le logiciel le 
plus récent. Si les problèmes persistent, vous 
trouverez plus d’informations sur 
www.apple.com/fr/support/ipod. Débarrassezvous de l’iPod shuffle en respectant les lois et les 
directives environnementales locales.37
Taïwan :
Nederlands: Gebruikte batterijen kunnen 
worden ingeleverd bij de chemokar of in een 
speciale batterijcontainer voor klein chemisch 
afval (kca) worden gedeponeerd.
Communauté Européenne
Conforme aux directives européennes 72/23/
EEC et 89/336/EEC.
Apple et l’environnement 
Chez Apple, nous sommes conscients de la 
responsabilité qui nous incombe de réduire les 
impacts écologiques de nos activités et de nos 
produits. 
Pour plus d’informations, rendez-vous sur 
www.apple.com/environment/summary.html.
© 2005 Apple Computer, Inc. Tous droits réservés. 
Apple, le logo Apple, iPod, iTunes, Mac, Macintosh et 
Mac OS sont des marques d’Apple Computer, Inc. 
déposées aux États-Unis et dans d’autres pays.
Finder est une marque d’Apple Computer, Inc.
Apple Store et iTunes Music Store sont des marques de 
service d’Apple Computer, Inc., déposées aux États-Unis 
et dans d’autres pays.www.apple.com/fr/ipod
www.apple.com/fr/support/ipod
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1
1 Premiers contacts
Votre MacBook comprend les composants suivants : 
Important :  lisez attentivement toutes les instructions d’installation (et les consignes 
de sécurité de l’annexe B, «Consignes de sécurité, d’utilisation et d’entretien», à la 
page 113) avant de brancher votre ordinateur sur une prise secteur.
Câble secteur
Télécommande Apple Remote
Fiche 
secteur
Adaptateur secteur MagSafe de 60 W
MENU
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Configuration de votre MacBook
Votre MacBook est conçu pour être configuré rapidement et utilisé immédiatement. 
Les pages suivantes contiennent des informations qui vous guident tout au long du 
processus de configuration, notamment :
Â branchement de l’adaptateur secteur Apple MagSafe de 60 W ;
Â connexion des câbles ;
Â mise sous tension de votre MacBook ;
Â configuration d’un compte d’utilisateur et d’autres paramètres via Assistant réglages.
Étape 1 :  branchez l’adaptateur secteur Apple MagSafe de 60 W
Si l’adaptateur secteur est entouré d’un film protecteur, retirez ce dernier avant de 
configurer votre MacBook.
m Branchez la fiche secteur de votre adaptateur sur une prise secteur. Branchez ensuite 
la fiche de l’adaptateur secteur sur le port d’adaptateur secteur du MacBook. Lorsque 
vous rapprochez la fiche du port, vous ressentirez la force d’un aimant attirant la fiche 
de l’adaptateur secteur.
Fiche
secteur
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Pour étendre la portée de votre adaptateur, vous pouvez y connecter le câble d’alimentation secteur. Tirez d’abord sur la fiche secteur pour la retirer de l’adaptateur, puis 
connectez-y le câble d’alimentation secteur inclus. Branchez l’autre extrémité sur une 
prise secteur. Une illustration de cette opération se trouve à la page 33.
Étape 2 :  connectez vos câbles
Pour obtenir une connexion Internet, connectez votre MacBook à un modem DSL, 
un modem câble, un modem externe ou un réseau Ethernet. Si vous vous connectez 
à un réseau sans fil tel qu’AirPort Extreme, vous n’avez pas besoin de câbles.
Pour obtenir des informations sur les types de connexions, consultez l’annexe C, 
«Connexion à Internet», à la page 123.
Avertissement :  assurez-vous que la fiche secteur est complètement insérée dans 
l’adaptateur et que les broches de votre fiche secteur sont complètement déployées 
avant de brancher l’adaptateur sur la prise secteur.
¯
Câble secteur
Fiche 
secteur
Fiche de l’adaptateur  Port de l’adaptateur secteur
secteur
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Remarque :  pour une connexion par ligne téléphonique, vous aurez besoin 
du modem USB externe d’Apple, disponible sur l’Apple Store en ligne à l’adresse 
www.apple.com/francestore ou auprès des revendeurs agréés Apple. Branchez
le modem USB d’Apple dans un port USB du MacBook, puis connectez un câble 
téléphonique (non inclus) entre le modem et une prise téléphonique. 
Pour se connecter à un modem DSL ou câble ou à un réseau Ethernet :
m Connectez le câble à votre modem DSL ou modem câble comme indiqué dans les instructions du modem ou bien connectez le câble Ethernet à un concentrateur ou une prise 
Ethernet. Branchez ensuite l’autre extrémité du câble au port Ethernet de l’ordinateur.
Remarque :  si vous souhaitez utiliser AirPort pour vous connecter sans fil, les réseaux 
sans fil disponibles sont détectés lorsque vous allumez votre ordinateur. Si nécessaire, 
choisissez «Activer AirPort» dans le menu d’état AirPort (Z) de la barre des menus, 
puis choisissez votre réseau.
G
Câble 
Ethernet
Port Ethernet Gigabit 
(10/100/1000Base-T)
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Étape 3 :  allumez votre MacBook
1 Pour allumer votre MacBook, appuyez rapidement (jusqu’à une seconde) sur le bouton 
d’alimentation (®). 
Votre ordinateur émet un signal sonore lorsque vous l’allumez. Après avoir entendu 
ce signal, n’appuyez pas sur le bouton d’alimentation, car vous risqueriez d’éteindre 
l’ordinateur.
Sa mise en route prend quelques instants. Après le démarrage, Assistant réglages 
s’ouvre automatiquement.
® Bouton d’alimentation
Lampe témoin de 
suspension d’activité
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2 Le trackpad de votre MacBook permet de sélectionner et de déplacer des éléments à 
l’écran de la même façon que la souris d’un ordinateur de bureau. 
Â Pour déplacer le pointeur à l’écran, glissez votre index sur le trackpad. 
Important :  n’utilisez qu’un seul doigt sur le trackpad pour déplacer le pointeur. 
Le trackpad vous permet de faire défiler en déplaçant deux doigts. Cette fonction 
est activée par défaut. Pour toute information supplémentaire, consultez la section 
«Utilisation du trackpad» à la page 34.
Â Utilisez le bouton du trackpad pour sélectionner un élément, cliquer ou faire un 
double-clic.
Trackpad  Bouton du trackpad
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Étape 4 :  configurez votre MacBook à l’aide d’Assistant réglages
La première fois que vous démarrez votre ordinateur, Assistant réglages se met en 
route. Il vous aide à saisir les informations concernant la configuration Internet et 
le courrier électronique et à configurer un compte d’utilisateur sur votre ordinateur. 
Si vous possédez déjà un ordinateur Macintosh, l’Assistant réglages peut vous aider 
à transférer automatiquement les fichiers, les applications et d’autres informations 
depuis votre ancien ordinateur vers votre nouveau MacBook.
Problèmes de mise sous tension de l’ordinateur
Rien ne se produit lorsque vous appuyez sur le bouton d’alimentation (®).
Â La batterie est peut-être déchargée. Assurez-vous que l’adaptateur secteur est fermement connecté à l’ordinateur et relié à une prise secteur. La prise de l’adaptateur 
secteur doit s’éclairer lorsque que vous la branchez sur l’ordinateur.
Â Si l’ordinateur ne démarre toujours pas, consultez la section «Problèmes vous empê-
chant d’utiliser votre ordinateur» à la page 100.
Un point d’interrogation clignotant sur une icône de disque ou de dossier apparaît 
à l’écran.
Cette icône signifie généralement que l’ordinateur ne parvient pas à localiser le logiciel 
système sur le disque dur interne ou sur tout disque externe relié à l’ordinateur. Déconnectez tous les périphériques externes puis essayez de redémarrer. Maintenez enfoncé 
le bouton d’alimentation (®) de 8 à 10 secondes jusqu’à l’arrêt de l’ordinateur. Appuyez 
ensuite de nouveau sur le bouton d’alimentation. Si le problème persiste, vous devrez 
peut-être réinstaller le logiciel système. Voir «Réinstallation des logiciels fournis avec 
votre ordinateur» à la page 106.
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Pour transférer des informations, vérifiez les éléments suivants :
Â Votre autre ordinateur Mac dispose d’un port FireWire intégré et prend en charge 
le mode disque cible FireWire.
Â Votre autre ordinateur Mac fonctionne sous Mac OS X version 10.1 ou ultérieure.
Â Vous disposez d’un câble FireWire standard 6 broches vers 6 broches.
Assistant réglages vous guide tout au long du processus de transfert d’informations ; 
il vous suffit de suivre les instructions à l’écran. Le transfert des informations vers votre 
MacBook n’a aucune conséquence sur les informations qui se trouvent sur l’autre Mac 
(si vous avez partitionné le disque dur du nouveau MacBook, toutes les informations 
présentes sur l’autre Mac seront transférées vers une seule partition).
Assistant réglages vous permet de transférer :
Â les comptes d’utilisateur, y compris les préférences et le courrier électronique ; 
Â les réglages de réseau, pour que votre nouveau MacBook soit automatiquement 
configuré avec les mêmes réglages de réseau que votre autre Mac ;
Â les fichiers et dossiers qui se trouvent sur votre disque dur et sur vos partitions. 
Cela vous permet d’accéder facilement aux fichiers et dossiers que vous utilisiez 
sur votre autre Mac ;
Â le dossier Applications, pour que la plupart des applications que vous utilisiez sur 
votre autre Mac soient installées sur votre nouveau MacBook (vous devrez peut-être 
réinstaller certaines applications transférées).
Important :  veillez à ne pas écraser des versions plus récentes d’applications déjà 
installées sur votre MacBook lors du transfert de ces applications.
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Si vous ne comptez pas conserver ou utiliser votre autre Mac, il est préférable de lui 
retirer son autorisation de lecture de musique, de clips vidéo ou de livres audio achetés sur le magasin de musique en ligne iTunes Music Store. Le retrait d’autorisation 
d’accès à un ordinateur empêche toute autre personne de lire la musique, les clips 
vidéo et les livres audio que vous avez achetés et permet de libérer une autre autorisation (un compte iTunes vous permet d’autoriser jusqu’à cinq ordinateurs seulement). 
Pour plus d’informations sur le retrait d’autorisation, ouvrez iTunes et choisissez Aide > 
Aide iTunes et Music Store.
Si vous n’utilisez pas l’Assistant réglages pour transférer vos informations lors du démarrage initial de votre MacBook, vous pouvez le faire ultérieurement. Allez dans le dossier 
Applications, ouvrez le dossier Utilitaires, puis double-cliquez sur Assistant migration.
Remarque :  si vous avez utilisé Assistant réglages pour transférer vos informations à 
partir de votre autre Macintosh et que vous souhaitez utiliser l’Assistant migration pour 
transférer à nouveau des informations, assurez-vous que FileVault est désactivé sur l’autre 
Macintosh. Pour désactiver FileVault, ouvrez la fenêtre Sécurité des Préférences Système 
et cliquez sur Désactiver FileVault. Suivez les instructions à l’écran. 
Assistant réglages peut également vous aider à configurer la connexion à Internet de 
votre ordinateur. Pour les particuliers, l’accès à Internet requiert généralement l’ouverture d’un compte auprès d’un fournisseur d’accès à Internet (éventuellement payant). 
Si vous disposez déjà d’un compte Internet, consultez l’annexe C, «Connexion à Internet», à la page 123 pour savoir quelles sont les informations à saisir.
Félicitations, votre ordinateur est prêt !
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Composants de base de votre MacBook
®?
® Bouton d’alimentation
Lampe témoin 
de la caméra
Caméra iSight
Microphone
Haut-parleurs stéréo
Lampe témoin de 
suspension d’activité
Récepteur à infrarouge 
Trackpad 
Bouton du trackpad
Lecteur optique à 
chargement par fente
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Microphone
Permet de capturer des sons directement avec ce microphone intégré (situé à gauche de 
la caméra iSight).
Caméra iSight intégrée et lampe témoin de la caméra
Participez à une vidéoconférence avec d’autres via l’application iChat AV incluse. La lampe 
témoin de la caméra brille lorsque la caméra capture et affiche des données vidéo.
Haut-parleurs stéréo intégrés (3)
Permettent d’écouter de la musique, des films, des jeux et d’autres types de données 
multimédia.
Trackpad
Permet de déplacer le pointeur sur l’écran du MacBook en utilisant un doigt  ; inclut 
également une fonction de défilement en utilisant deux doigts sur le trackpad. 
Lampe témoin de suspension d’activité
Une lumière blanche clignote lorsque le MacBook est en suspension d’activité.
Récepteur à infrarouge intégré
Utilisez votre télécommande Apple Remote et le récepteur infrarouge intégré pour 
contrôler votre MacBook à distance.
Lecteur de disque optique à chargement par fente
Votre disque optique peut lire des disques CD et DVD et écrire sur des CD. Si vous disposez 
d’un lecteur SuperDrive, vous pouvez également écrire sur des disques DVD. Consultez 
«Utilisation du lecteur optique» à la page 76 pour obtenir plus de détails.
® Bouton d’alimentation
Permet d’allumer ou d’éteindre votre MacBook ou d’en suspendre l’activité.
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Fonctionnalités du clavier de votre MacBook
esc 
num 
F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12 
lock 
— i
C
-
Touche 
de fonction (Fn)
Touches de 
réglage du 
volume
Touches de
réglage de la
luminosité
Touche de
verrouillage
numérique
Touche 
d’éjection 
de disques
Touche 
Silence
Touches de
fonction 
standard
Touche de bascule
du mode vidéo
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Touche de fonction (Fn)
Maintenez cette touche enfoncée pour activer les actions personnalisées affectées aux 
touches de fonction (F1 à F12). Pour apprendre comment personnaliser les touches de 
fonction, choisissez Aide > Aide Mac dans la barre des menus, puis recherchez «touches 
de fonction».
Touches de réglage de la luminosité
Permettent d’augmenter ( ) ou de diminuer ( ) la luminosité de l’écran de votre 
MacBook.
— Commande Silence
Permet de désactiver le son provenant des haut-parleurs intégrés et du port de sortie 
casque.
- Touches de réglage du volume
Permettent d’augmenter (-) ou de diminuer (–) le volume du son provenant des 
haut-parleurs intégrés et du port de sortie casque.
Touche de verrouillage numérique
Permet d’activer et de désactiver le pavé numérique intégré au clavier du MacBook. Lorsque 
le pavé numérique est activé, une lumière verte brille sur la touche de verouillage numérique.
i Touche de bascule du mode vidéo
Permet de passer du mode double-écran (affichage de votre bureau sur l’écran intégré et 
sur un écran externe) au mode de recopie vidéo (affichage des mêmes informations sur 
les deux écrans) et vice versa.
F11, F12
Par défaut, la touche F11 ouvre Exposé et la touche F12 ouvre Dashboard. 
C Touche d’éjection de disque
Maintenez cette touche enfoncée pour éjecter un disque. Il est également possible 
d’éjecter un disque en faisant glisser son icône dans la Corbeille.
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Composants supplémentaires de votre MacBook
¯
Port Ethernet 
Gigabit (10/100/
1000 Base-T)
G
Logement
de sécurité
Port de sortie 
casque/audio 
numérique 
optique
f
Port d’entrée 
de ligne audio/
audio numérique 
optique
,
Port 
Mini-DVI
£ Port 
FireWire 
400
H Ports 
USB 2.0
Port  d
d’adaptateur 
secteur 
MagSafe
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¯ Port de l’adaptateur secteur Apple MagSafe
Branchez-y l’adaptateur secteur Apple MagSafe 60 W fourni pour recharger la batterie de 
votre MacBook.
G Port Ethernet Gigabit (10/100/1000Base-T)
Permet de se connecter soit à un réseau Ethernet haute vitesse, soit à un autre ordinateur 
et de transférer des fichiers. La fonction de détection automatique du port Ethernet détecte 
d’autres périphériques Ethernet sans avoir besoin de câble croisé Ethernet pour établir 
la connexion.
£ Port Mini-DVI (sortie vidéo)
Permet de se connecter à un affichage externe ou à un appareil de projection utilisant un 
connecteur DVI, VGA, composite ou S-Vidéo. Selon le type de périphérique externe auquel 
vous connectez votre ordinateur, utilisez un adaptateur Mini-DVI vers DVI, Mini-DVI vers VGA 
ou Mini-DVI vers Vidéo, tous vendus séparément à l’adresse www.apple.com/francestore.
H Port FireWire 400
Permettent de connecter des périphériques à haute vitesse tels que des caméras vidéo 
numériques et des périphériques de stockage externes.
d Deux ports haute vitesse USB 2.0 (Universal Serial Bus)
Permettent de connecter des périphériques supplémentaires à votre MacBook, notamment 
imprimantes, unités de stockage externes, appareils photo numériques, modems, claviers ou 
manettes de jeu.
, Port d’entrée de ligne audio/audio numérique optique
Permet de connecter un micro ou un appareil audio numérique à votre MacBook.
f Port de sortie casque/audio numérique optique
Il permet de connecter des haut-parleurs externes, un casque ou des appareils audio 
numériques.
Logement de sécurité
Permet de protéger votre MacBook contre le vol en l’attachant à l’aide d’un câble de 
sécurité (vendu séparément).
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Pour des informations supplémentaires sur ces fonctionnalités, consultez le chapitre 3, 
«Utilisation de votre MacBook», à la page 57.
Extinction ou suspension d’activité de votre MacBook
Une fois que vous avez fini d’utiliser votre MacBook, vous pouvez suspendre son 
activité ou l’éteindre.
Suspension de l’activité de votre MacBook
Suspendez l’activité de votre MacBook si vous ne comptez vous en éloigner que 
quelques instants. Vous pourrez ensuite le réactiver sans avoir à le redémarrer. 
Pour suspendre l’activité de votre ordinateur, procédez de l’une des manières 
suivantes :
Â Rabattez l’écran.
Â Choisissez Pomme (?) > Suspendre l’activité, dans la barre des menus.
Â Appuyez sur le bouton d’alimentation (®) et cliquez sur Suspendre l’activité dans 
la zone de dialogue qui apparaît.
Â Choisissez le menu Pomme (?) > Préférences Système, cliquez sur 
Économiseur d’énergie et définissez un délai pour la minuterie de mise en veille.
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Â Maintenez enfoncé le bouton Lecture/Pause (’) de la télécommande Apple Remote 
pendant 3 secondes. 
Pour réactiver l’ordinateur :
Â Si l’écran est fermé, il suffit de l’ouvrir pour réactiver votre MacBook.
Â Si l’écran est déjà ouvert, appuyez sur le bouton d’alimentation (®), sur l’une des 
touches du clavier ou sur un bouton de la télécommande Apple Remote.
Extinction de votre MacBook
Si vous ne comptez pas utiliser votre MacBook pendant un jour ou deux, il est préférable 
de l’éteindre. La lampe témoin de suspension d’activité reste allumée quelques instants 
au moment de l’extinction.
Pour éteindre votre ordinateur, procédez de l’une des manières suivantes :
Â Choisissez Pomme (?) > Éteindre, dans la barre des menus.
Â Appuyez sur le bouton d’alimentation (®) et cliquez sur Éteindre dans la zone de 
dialogue qui apparaît.
Si vous comptez ranger votre MacBook pour une durée prolongée, consultez la section 
«Rangement de votre MacBook» à la page 117 afin d’obtenir des informations sur les 
mesures à prendre pour éviter que votre batterie ne se décharge complètement.
Avertissement :  patientez quelques secondes jusqu’à ce que la lampe témoin de suspension d’activité clignote (signalant que l’activité de l’ordinateur est suspendue et que 
le disque dur a cessé de tourner) avant de déplacer votre MacBook. Tout déplacement 
de votre ordinateur lorsque le disque dur est en train de tourner risque d’endommager 
ce dernier et d’entraîner une perte de données ou l’impossibilité de démarrer à partir 
du disque dur.
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Étalonnage de la batterie
Pour obtenir une autonomie optimale de votre batterie, effectuez son étalonnage 
durant la première semaine d’utilisation de votre MacBook et répétez régulièrement 
cette procédure afin que votre batterie fonctionne à pleine capacité.
Pour étalonner votre batterie :
1 Branchez votre adaptateur secteur et chargez complètement la batterie de votre MacBook 
jusqu’à ce que le témoin lumineux de l’adaptateur passe au vert et que l’icône de la batterie dans la barre des menus indique que la batterie est complètement chargée.
2 Laissez la batterie complètement rechargée pendant deux heures ou plus. Vous pouvez 
utiliser votre ordinateur durant cette période à condition de brancher l’adaptateur secteur.
3 Débranchez l’adaptateur secteur en gardant le MacBook allumé et commencez à l’utiliser 
avec la batterie. Vous pouvez utiliser votre ordinateur durant cette période. 
Lorsque votre batterie est presque déchargée, un message d’avertissement apparaît
à l’écran. 
4 Gardez votre ordinateur allumé jusqu’à ce qu’il suspende son activité. Enregistrez votre 
travail et fermez toutes les applications lorsque la batterie est presque déchargée et 
avant que le système ne suspende son activité. 
5 Éteignez l’ordinateur ou mettez-le en mode de suspension d’activité pendant cinq heures 
ou plus.
6 Connectez l’adaptateur secteur jusqu’à ce que la batterie soit complètement rechargée. 
Important :  recommencez la procédure d’étalonnage environ tous les deux mois afin 
de maintenir votre batterie dans un état optimal. Si vous n’utilisez pas fréquemment 
votre MacBook, il est préférable d’étalonner à nouveau la batterie au moins une fois 
par mois.
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Si vous avez acheté des batteries supplémentaires, appliquez-leur également la procédure 
d’étalonnage. Pour plus d’informations, consultez la section «Utilisation de la batterie» à la 
page 81.
Informations supplémentaires
Pour en savoir plus sur votre MacBook, consultez les ressources suivantes :
Â Consultez le chapitre 2, «Familiarisation avec votre MacBook», à la page 29, pour 
découvrir les notions importantes élémentaires.
Â Si vous n’êtes pas familiarisé avec Mac OS X, lisez le fascicule Bienvenue sur Tiger livré 
avec votre ordinateur et ouvrez l’Aide Mac pour y explorer les informations disponibles. 
Pour plus d’informations, consultez la section «Obtention de réponses grâce à l’Aide 
Mac» à la page 28.
Â Si un problème vous empêche d’utiliser votre ordinateur, consultez le chapitre 5, 
«Dépannage», à la page 99.
Â Consultez les questions les plus fréquemment posées dans «Les dix questions principales» à la page 133 .
Â Pour plus d’information sur l’assistance, les groupes de discussion et les dernières 
nouveautés logicielles Apple à télécharger, visitez le site www.apple.com/fr/support.
Â Si vous ne trouvez pas de réponse à votre problème, consultez le Guide de service et 
support AppleCare qui accompagne votre ordinateur pour savoir comment joindre 
Apple.
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Obtention de réponses grâce à l’Aide Mac
La plupart des informations sur l’utilisation de votre Macintosh sont disponibles 
directement sur votre ordinateur, dans l’Aide Mac.
Pour faire apparaître l’Aide Mac :
1 Cliquez sur l’icône Finder dans le Dock (barre d’icônes située au bas de l’écran).
2 Choisissez Aide > Aide Mac (cliquez sur le menu Aide dans la barre des menus puis 
sélectionnez Aide Mac).
3 Cliquez dans le champ Rechercher, tapez votre question et appuyez sur la touche 
Retour du clavier.
Champ Rechercher
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2
2 Familiarisation avec 
votre MacBook
Ce chapitre présente des notions élémentaires 
importantes concernant votre MacBook. 
Lorsque vous cessez d’utiliser votre MacBook, patientez quelques instants avant de 
transporter l’ordinateur afin de laisser le temps au disque dur ou à tout disque optique 
situé dans votre lecteur (CD ou DVD) d’arrêter de tourner. Évitez de bousculer ou de 
heurter votre MacBook pendant que des disques sont en train de tourner.
Remarque :  votre MacBook utilise la technologie Sudden Motion Sensor qui contribue 
à protéger le disque dur en cas de chute ou de vibrations subies par l’ordinateur. Pour 
plus de détails, consultez la section «Technologie Sudden Motion Sensor» à la page 81.
Lorsque vous utilisez votre MacBook ou que vous rechargez sa batterie, il est normal 
de constater une augmentation de la température de la partie inférieure du boîtier. 
En cas d’utilisation prolongée, placez votre MacBook sur une surface plane et stable. 
Le dessous du boîtier est légèrement surélevé pour permettre la circulation d’air et 
assurer ainsi à l’équipement une température de fonctionnement normale.
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Vous entendrez parfois de petits bruits émis par le système au démarrage ou lorsque 
le lecteur de disque dur et le lecteur optique sont utilisés. De même, il arrive qu’après 
une certaine période de fonctionnement du MacBook, un petit ventilateur se mette en 
marche pour refroidir le système, ce qui peut produire un léger bruit. Ce genre de sons, 
qu’émet le système, font partie du fonctionnement normal de votre ordinateur.
Pour obtenir plus de consignes de sécurité sur la manipulation et l’utilisation de votre 
MacBook dans différents lieux, veuillez consulter l’annexe B, «Consignes de sécurité, 
d’utilisation et d’entretien», à la page 113.
Le reste du présent chapitre comprend des sections concernant l’utilisation des composants de votre MacBook, notamment l’affichage, l’adaptateur secteur, le trackpad, 
le clavier, la caméra iSight intégrée et la télécommande Apple Remote. Vous trouverez 
également des informations sur Mac OS X, l’Aide Mac, les applications et la connexion 
de périphériques.
Réglage de l’écran
Après avoir commencé à travailler sur votre nouvel MacBook, réglez si nécessaire 
la luminosité de l’écran pour un meilleur confort visuel. Utilisez les touches F1 et F2 
portant l’icône de luminosité (¤) pour régler la luminosité de l’écran.
Pour régler les préférences de votre écran dans le but d’optimiser la durée de vie de 
la batterie :
1 Ouvrez Préférences Système puis cliquez sur Économiseur d’énergie.
2 Dans le menu local «Réglages de», choisissez Batterie puis cliquez sur Options.
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3 Décochez la case «Réduire la luminosité de l’écran lors de l’utilisation de cette source 
d’énergie» si vous ne souhaitez pas que votre écran s’assombrisse pour réduire la 
consommation de la batterie.
Lorsque cette fonction est activée, votre écran s’assombrit légèrement lorsque vous passez de l’utilisation de l’adaptateur secteur à celle de la batterie. Lorsque vous branchez à 
nouveau l’adaptateur secteur, votre écran revient à son niveau précédent de luminosité.
Décochez la case «Réduire automatiquement la luminosité de l’écran avant sa mise 
en veille» si vous ne souhaitez pas que l’écran s’assombrisse avant que le MacBook 
ne suspende son activité.
Modification de la taille des images à l’écran
Votre MacBook est équipé d’un écran large de 13,3 pouces doté d’une résolution par 
défaut de 1280 x 800. Vous pouvez modifier la taille des images affichées en réglant 
la résolution de l’écran. 
Vous pouvez choisir une résolution inférieure dans la fenêtre Moniteurs des 
Préférences Système. Lorsque vous diminuez la résolution, les éléments apparaissent plus 
grands à l’écran et sont par conséquent plus faciles à visualiser. Les résolutions réduites 
ne sont cependant pas toujours aussi nettes que la résolution d’écran par défaut.
Lorsque vous employez certaines résolutions, deux bandes noires apparaissent des deux 
côtés de l’écran. Si vous souhaitez supprimer ces bandes, vous pouvez choisir une version 
«étirée» de la résolution, afin que l’image couvre l’ensemble de l’écran et les bandes.
Pour changer la résolution de votre écran :
m Choisissez le menu Pomme (?) > Préférences Système dans la barre des menus. 
Ouvrez la fenêtre Moniteurs des Préférences Système. 
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Pour changer la résolution de votre écran via le menu d’état Moniteurs de la barre des 
menus, cliquez sur l’option «Ouvrir Moniteurs dans la barre des menus».
Utilisation de l’adaptateur secteur
Le branchement de l’adaptateur secteur alimente le MacBook et recharge sa batterie.
Important :  pour des performances optimales, n’utilisez que l’adaptateur secteur livré 
avec votre ordinateur ou procurez-vous un adaptateur secteur MagSafe Apple de 60 W 
supplémentaire.
La première fois que vous connectez l’adaptateur secteur à votre ordinateur, une lampe 
témoin placée sur la fiche de l’adaptateur s’illumine. Une lumière orange indique que 
la batterie est alimentée. Une lumière verte indique que la batterie n’est pas alimentée, 
ce qui peut signifier que la batterie est complètement rechargée, n’est pas installée ou 
présente un problème. Si vous ne voyez pas de lampe témoin, votre fiche n’est probablement pas branchée correctement. Si des débris sont présents, enlevez-les. Vous 
pouvez contrôler le niveau de la batterie soit à l’aide du menu d’état Batterie de la 
barre des menus, soit en vérifiant les lampes témoins de niveau de la batterie situés 
sur la partie inférieure de la batterie (voir la page 81).
Avertissement :  le port d’adaptateur secteur du MacBook contient un aimant qui peut 
effacer les données d’une carte de crédit, d’un iPod ou d’autres périphériques. Pour 
préserver vos données, maintenez-les, ainsi que les autres supports magnétiques, à 
distance du port d’adaptateur secteur.
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Pour rallonger le câble de l’adaptateur secteur, tirez d’abord sur la fiche secteur pour la 
retirer de l’adaptateur. Connectez le câble secteur inclus à l’adaptateur, en vous assurant 
qu’il est fermement connecté. Branchez l’autre extrémité sur une prise secteur. Le câble 
d’alimentation secteur fournit une connexion avec mise à la terre.
Utilisez le câble d’alimentation secteur et connectez-le à une prise secteur de terre 
chaque fois que cela est possible. Utilisez uniquement le câble d’alimentation secteur 
fourni avec votre adaptateur secteur. Veillez à ce que le connecteur soit fermement 
engagé dans le port de l’adaptateur secteur de l’ordinateur afin de garantir l’arrivée 
de courant à l’ordinateur. Si le câble est correctement branché, une lampe témoin 
s’allume à l’extrémité du câble branché sur votre MacBook .
Lorsque vous déconnectez l’adaptateur secteur d’une prise de courant ou de l’ordinateur, débranchez la prise et non le câble. Pour obtenir des consignes de sécurité concernant l’utilisation de votre adaptateur secteur, consultez la section «Configuration de 
votre MacBook et de l’adaptateur secteur» à la page 115.
Câble secteur Fiche secteur
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Utilisation du trackpad
La distance de déplacement du pointeur à l’écran dépend de la vitesse à laquelle vous 
déplacez votre doigt sur le trackpad. Pour déplacer le pointeur sur une courte distance 
à l’écran, faites glisser l’index lentement sur le trackpad ; plus le déplacement du doigt 
est rapide, plus la distance parcourue par le pointeur à l’écran est grande. Vous pouvez 
également régler la vitesse de déplacement dans la fenêtre Clavier et souris des 
Préférences Système.
Vous pouvez faire défiler verticalement ou horizontalement une fenêtre munie de 
barres de défilement en déplaçant deux doigts sur le trackpad. Vous pouvez activer 
ou désactiver cette option dans la fenêtre Clavier et souris des Préférences Système. 
Conseils d’utilisation du trackpad
Pour optimiser votre utilisation du trackpad :
Â N’utilisez qu’un seul doigt, sauf si la fonction de défilement est activée et que vous 
souhaitez l’utiliser. 
Â N’utilisez pas de stylo ou tout autre objet. 
Â Veillez à ce que votre doigt et le trackpad soient secs. Si l’humidité ou la condensation 
provoque une accumulation de buée sur le trackpad, essuyez-le avec un chiffon propre 
avant de l’utiliser. 
Â N’utilisez jamais de produit nettoyant sur le trackpad.
Pour en savoir plus sur l’utilisation du trackpad, choisissez Aide > Aide Mac dans 
la barre des menus, en haut de l’écran.
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En plus d’utiliser le bouton du trackpad, vous pouvez utiliser votre doigt pour cliquer 
ou double-cliquer directement sur le trackpad. Les options du trackpad peuvent être 
activées via la fenêtre Clavier et souris des Préférences Système.
Remarque :  s’il vous arrive souvent que le pointeur bouge lorsque vous tapez parce que 
vous effleurez le trackpad par inadvertance, sélectionnez l’option «Ignorer les utilisations 
accidentelles du trackpad» dans la fenêtre Clavier et souris des Préférences Système.
Utilisation du clavier
Votre MacBook est équipé d’un pavé numérique intégré au sein des touches normales 
du clavier. Les touches utilisées par le pavé numérique sont pourvues d’une indication 
secondaire.
Touche de 
verrouillage
numérique
Pavé numérique
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Pour utiliser le pavé numérique, appuyez sur la touche de verrouillage numérique. 
Lorsque le pavé numérique est actif, l’indicateur de la touche de verrouillage numérique 
brille. Lorsque vous avez fini de l’utiliser, appuyez à nouveau sur la touche de verrouillage 
numérique pour le désactiver. 
Important :  si votre clavier ne semble pas fonctionner correctement, vérifiez la touche 
de verrouillage numérique. Lorsque le pavé numérique est activé, les autres touches 
et raccourcis clavier correspondant à des commandes de menu (comme x + Q pour 
quitter l’application en cours) sont désactivées.
Vous pouvez utiliser votre clavier ou la télécommande Apple Remote pour contrôler 
l’application Front Row. (Voir «Utilisation du clavier pour contrôler Front Row» à la 
page 42.)
Si vous souhaitez utiliser les raccourcis clavier pour travailler de manière plus efficace, 
ouvrez l’Aide Mac et recherchez «raccourcis de clavier». Vous y trouverez une liste complète 
de raccourcis clavier pour un grand nombre de procédures et d’applications courantes.
Utilisation d’une souris
Si vous disposez d’une souris Apple dotée d’un connecteur USB, insérez celui-ci dans le port 
USB 2.0 pour l’utiliser immédiatement. Si vous possédez une souris Apple Wireless Mouse, 
consultez la section «Utilisation de la technologie sans fil Bluetooth» à la page 67 pour 
obtenir des informations sur son utilisation. Vous pouvez vous procurer une souris sans 
fil ou USB sur l’Apple Store en ligne à l’adresse www.apple.com/francestore ou chez un 
revendeur agréé Apple.
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Utilisation de la télécommande Apple Remote et de Front Row
Votre télécommande Apple Remote fonctionne avec l’interface de Front Row et le 
récepteur infrarouge intégré, situé en bas et à droit de la face avant de votre MacBook. 
Utilisez la télécommande Apple Remote pour ouvrir Front Row et interagir à distance 
avec entre autres iTunes, iPhoto, iMovie et Lecteur DVD.
Utilisez votre télécommande Apple Remote pour :
Â ouvrir Front Row et parcourir les menus Musique, Photos, Clips vidéo et DVD ;
Â régler le volume d’un morceau, lire ou mettre en pause un morceau ou passer à 
la piste suivante ou précédente dans iTunes ; 
Â visualiser un diaporama à partir d’un album photo dans iPhoto ; 
Â lire des séquences dans votre dossier Séquences ou regarder des bandes-annonces 
QuickTime en ligne ; 
Â lire un disque DVD dans votre lecteur optique avec Lecteur DVD ;
Â parcourir les présentations Keynote ;
Â suspendre l’activité de votre MacBook ou le réactiver.
Pour utiliser votre télécommande Apple Remote avec Front Row, dirigez-la vers 
l’avant du MacBook et :
Â appuyez sur le bouton Menu (») pour ouvrir ou fermer Front Row ou pour revenir 
au menu précédent lorsque vous explorez Front Row ;
Â appuyez sur le bouton Suivant/Avance rapide (‘) ou sur le bouton Précédent/
Retour rapide (]) pour passer d’une application à l’autre dans Front Row ;
Â appuyez sur les boutons Augmenter le volume/Élément de menu précédent (?) et 
Baisser le volume/Élément de menu suivant (D) pour vous déplacer parmi les options 
d’un menu ou régler le volume ;
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Â appuyez sur le bouton Sélection/Lecture/Pause (’) pour sélectionner un élément de 
menu ou pour lire ou mettre en pause un morceau, un diaporama ou un DVD ;
Â appuyez sur le bouton Suivant/Avance rapide (‘) ou sur le bouton Précédent/Retour 
rapide (]) pour explorer votre contenu multimédia (maintenez les boutons enfoncés 
pour accélérer le défilement) ;
Â maintenez le bouton Sélection/Lecture/Pause (’) enfoncé pendant 3 secondes pour 
suspendre l’activité de votre MacBook.
Bouton Suivant/Avance rapide
Bouton Sélection/Lecture/Pause
Compartiment de la pile
Bouton Augmenter 
le volume/Élément  
de menu précédent
Fenêtre infrarouge
Bouton Baisser le volume/
Élément de menu suivant
Bouton Précédent/
Retour rapide
Bouton Menu
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Utilisation de la télécommande Apple Remote avec Keynote
Si Keynote est installé sur votre ordinateur, vous pouvez contrôler vos présentations 
avec la télécommande Apple Remote. Une fois Keynote ouvert, appuyez sur le bouton 
Sélection/Lecture/Pause (’) pour lancer une présentation. Ensuite, selon l’endroit de 
l’application où vous souhaitez travailler (dans une présentation ou dans le classeur de 
diapositives), dirigez la télécommande Apple Remote vers votre MacBook et appuyez 
sur ses boutons pour contrôler Keynote suivant les indications du tableau suivant.
Appuyez sur le bouton... dans une présentation dans le classeur de diapositives
’ (Sélection/Lecture/Pause) pour interrompre/reprendre 
la présentation
pour passer à la diapositive 
sélectionnée
» (Menu) pour lancer le classeur de 
diapositives
pour quitter le classeur de 
diapositives
» et maintenez-le enfoncé pour quitter l’application pour quitter la présentation
] (Précédent/Retour rapide) pour passer à la diapositive 
précédente
pour sélectionner la diapositive 
précédente
] et maintenez-le enfoncé pour passer à la première 
diapositive
‘ (Suivant/avance rapide) pour passer à la diapositive 
suivante
pour sélectionner la diapositive 
suivante
‘ et maintenez-le enfoncé pour passer à la dernière 
diapositive
? (Augmenter le volume/
Élément de menu précédent) 
pour augmenter le volume pour augmenter le volume
D (Baisser le volume/
Élément de menu suivant)
pour baisser le volume pour baisser le volume
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Jumelage de votre télécommande Apple Remote
Si vous possédez dans une pièce plusieurs ordinateurs ou autres appareils dotés de 
récepteurs à infrarouge intégrés (par exemple, plusieurs MacBook ou iMac dans un 
bureau personnel ou un laboratoire), vous avez la possibilité de «jumeler» votre télé-
commande Apple Remote avec un ordinateur ou un appareil précis. Le jumelage 
permet de configurer l’ordinateur ou l’appareil récepteur de façon à ce qu’il ne soit 
contrôlé que par une télécommande Apple Remote spécifique. 
Pour jumeler votre télécommande Apple Remote avec votre MacBook :
1 Mettez la télécommande Apple Remote à 8 à 10 centimètres du récepteur infrarouge 
de votre MacBook. 
2 Maintenez simultanément enfoncés les boutons Menu (») et Suivant/Avance rapide (‘) 
de votre télécommande Apple Remote pendant 5 secondes.
Lorsque vous avez correctement jumelé votre télécommande Apple Remote avec votre 
MacBook, le symbole d’un maillon de chaîne ( ) apparaît à l’écran.
Pour annuler le jumelage de la télécommande Apple Remote et du MacBook :
1 Choisissez le menu Pomme (?) > Préférences Système dans la barre des menus.
2 Cliquez sur Sécurité puis sur Désactiver le jumelage.
F3626M42.book  Page 40  Wednesday, April 5, 2006  2:17 PMChapitre 2   Familiarisation avec votre MacBook 41
Remplacement de la batterie
La télécommande Apple Remote inclut une pile non rechargeable. Si nécessaire, 
remplacez la pile par une pile CR 2032. N’essayez pas de recharger la pile.
Pour remettre la pile en place :
1 Ouvrez le logement de la pile en appuyant sur le bouton (illustré ci-dessus) avec un 
petit objet, tel que l’extrémité d’un trombone.
2 Ôtez le compartiment de la pile et retirez-la.
3 Insérez la nouvelle pile, son côté positif (+) tourné vers le haut.
4 Refermez le logement de la pile.
Appuyez sur ce bouton à l’aide d’un petit objet arrondi 
pour éjecter partiellement le logement de la pile.
Face positive (+) vers le haut.
Tirez afin de libérer le 
logement de la pile.
MENU
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Désactivation de la réception infrarouge
Vous pouvez utiliser les préférences Sécurité pour activer ou désactiver la réception 
infrarouge sur votre MacBook. 
Pour désactiver la réception infrarouge :
Â Choisissez le menu Pomme (?) > Préférences Système dans la barre des menus et 
cliquez sur Sécurité.
Â Cochez la case «Désactiver le récepteur à infrarouge de la télécommande».
Utilisation du clavier pour contrôler Front Row
Vous pouvez utiliser votre clavier au lieu de la télécommande Apple Remote pour 
contrôler Front Row. Les touches suivantes correspondent aux boutons de la télécommande Apple Remote :
Équivalent clavier Bouton de la télécommande Apple Remote
Commande (x) - Échap Ouvrir menu (»)
Échap Quitter menu (»)
Espace ou Retour Sélection/Lecture/Pause (’)
Flèche vers le haut (Ò) Augmenter le volume/Élément de menu précédent (?)
Flèche vers la bas (¬) Baisser le volume/Élément de menu suivant (D)
Flèche vers la droite (°) Suivant/avance rapide (‘)
Flèche vers la gauche (k) Précédent/Retour rapide (])
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En savoir plus sur la télécommande Apple Remote
L’Aide Mac fournit des informations supplémentaires sur la télécommande Apple Remote. 
Choisissez Aide > Aide Mac dans la barre des menus, puis recherchez «Apple Remote». 
Utilisation de la caméra vidéo iSight intégrée
À l’aide de la caméra iSight intégrée, vous pouvez prendre des photos avec 
Photo Booth ou participer à des conférences vidéo avec d’autres utilisateurs d’iChat AV.
Prise de photos avec Photo Booth
Utilisez Photo Booth pour prendre des photos et ajouter des effets visuels amusants 
tels que sépia, noir et blanc, éclat, crayon de couleur et plus encore.
Caméra iSight
Lampe témoin
de la caméra
Microphone 
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Pour prendre une photo avec Photo Booth :
1 Cliquez sur l’icône de Photo Booth dans le Dock pour ouvrir Photo Booth, puis allumez 
la caméra iSight intégrée.
La lampe témoin située à côté de la caméra brille lorsque celle-ci est allumée.
2 Vous pouvez sélectionner un effet à appliquer à votre photo.
3 Cliquez sur l’icône de caméra sous l’image pour prendre une photo.
Enregistrez l’image comme photo de contact iChat, envoyez-la par courrier électronique 
à vos amis ou enregistrez-la dans votre photothèque iPhoto.
Pour utiliser une photo comme photo de contact ou de compte :
1 Ouvrez Photo Booth et prenez une photo.
2 Sélectionnez la photo que vous souhaitez utiliser comme photo de contact ou photo 
de compte.
3 Cliquez sur l’icône de photo de contact ou de compte pour automatiquement mettre 
à jour votre photo.
Pour plus d’informations sur Photo Booth, choisissez Aide > Aide Mac dans la barre des 
menus, puis sélectionnez Centre d’aide > Aide Photo Booth.
Utilisation de votre caméra iSight avec iMovie HD 
Vous pouvez capturer de la vidéo en direct de votre caméra iSight, directement dans 
iMovie HD.
Pour capturer de la vidéo en direct :
1 Ouvrez iMovie HD en cliquant sur son icône dans le Dock.
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2 Cliquez sur l’option de changement de mode pour régler iMovie HD sur le mode 
caméra intégrée.
3 Cliquez sur l’icône de caméra à gauche de l’option de changement de mode puis 
choisissez iSight intégrée dans le menu local.
4 Cliquez sur le bouton «Enregistrer avec iSight» dans le moniteur iMovie pour commencer 
à enregistrer. La vidéo que vous voyez dans le moniteur iMovie est enregistrée comme 
clip dans le panneau des clips iMovie.
5 Cliquez à nouveau sur le bouton «Enregistrer avec iSight» pour arrêter l’enregistrement. 
Vous pouvez enregistrer de la vidéo tant que votre MacBook possède suffisamment 
d’espace libre.
L’Aide Mac fournit des informations supplémentaires sur iMovie HD. Choisissez Aide > 
Aide Mac dans la barre de menus, puis choisissez Centre d’aide > Aide iMovie HD.
Vidéoconférences avec iChat AV
Lorsque vous ouvrez iChat AV, la lampe témoin de la caméra s’allume. Cliquez sur 
l’icône vidéo d’un contact pour participer avec lui à une vidéoconférence iChat AV, 
en temps réel avec animation vidéo intégrale. Votre MacBook est également doté d’un 
micro intégré, ce qui vous permet de profiter à la fois du son et de l’image durant vos 
vidéoconférences iChat AV.
Option de changement de mode
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Pour utiliser la caméra iSight intégrée en vue de lancer une vidéoconférence, vous avez 
besoin des éléments suivants :
Â un compte .Mac, America Online (AOL) ou AOL Instant Messenger (AIM) (requis pour 
iChat AV) ;
Â une connexion à Internet à haut débit via câble modem ou DSL ou un réseau local (LAN). 
Veuillez notez que les vidéoconférences ne sont pas possibles sous une connexion à 
Internet par ligne commutée.
Pour débuter une vidéoconférence :
1 Ouvrez iChat AV.
2 Cliquez sur le bouton représentant une caméra situé à côté d’un contact dans votre 
liste de contacts. 
Pour en savoir plus sur l’ajout de contacts à votre liste, choisissez Aide > Aide iChat AV.
Lorsque vous cliquez sur un bouton représentant une caméra dans la liste des contacts, 
la lampe témoin de la caméra brille pour indiquer que vous affichez de la vidéo. Cela 
enverra également une invitation à votre contact et vous permettra de voir de quoi vous 
avez l’air à la caméra. Lorsqu’un contact accepte votre invitation, vous pouvez le voir 
apparaître sur votre écran, ainsi que vous-même. 
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Vidéoconférence avec plusieurs contacts
Il est possible de réaliser des vidéoconférences en compagnie de deux, et jusqu’à trois, 
contacts à la fois. Un des contacts accueille la vidéoconférence et les autres y participent. 
Pour débuter une vidéoconférence avec plusieurs contacts :
1 Ouvrez iChat AV.
2 Maintenez enfoncée la touche Commande tout en sélectionnant les contacts que vous 
souhaitez inviter. 
3 Cliquez sur le bouton représentant une caméra situé au bas de votre liste de contacts.
Extinction de la caméra iSight
Pour éteindre la caméra iSight, fermez la fenêtre active iChat. La lampe témoin de la 
caméra s’éteint, ce qui indique que la caméra iSight est éteinte et que l’enregistrement 
a été interrompu.
Utilisation de votre photo en tant qu’image de contact
Vous avez la possibilité de vous prendre en photo à l’aide de la caméra iSight et d’utiliser 
cette photo comme image de contact. Elle apparaîtra dans la liste de contacts des autres 
utilisateurs, si vous en faites partie. 
Pour définir votre image de contact :
1 Ouvrez iChat AV.
2 Choisissez Contacts > Changer ma photo.
3 Cliquez sur le bouton représentant une caméra.
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À propos de Mac OS X
Votre ordinateur est doté de Mac OS X version 10.4 Tiger qui comprend entre autres 
Spotlight (un moteur de recherche qui répertorie automatiquement l’ensemble de vos 
fichiers), Dashboard (qui vous permet de garder à portée de mains des «widgets», ou 
mini-applications, très pratiques) et Exposé (qui dispose et affiche de manière élégante 
toutes les fenêtres des applications ouvertes).
Lorsque vous serez prêt à en apprendre davantage sur Mac OS X et les applications iLife 
maintes fois primées qui accompagnent votre ordinateur, consultez le livret Bienvenue 
sur Tiger fourni avec votre MacBook ou consultez les informations dans l’Aide Mac. En 
cas de problèmes lors de l’utilisation de Mac OS X, consultez le chapitre 5, «Dépannage», ou l’Aide Mac.
Pour obtenir des informations sur les applications qui sont compatibles avec Mac OS X 
ou pour en savoir plus sur Mac OS X en général, consultez le site web d’Apple à l’adresse 
www.apple.com/fr/macosx.
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Personnalisation du bureau et réglage des préférences
Grâce aux Préférences Système, vous pouvez donner à votre bureau l’apparence 
souhaitée sans perdre de temps. Choisissez le menu Pomme (?) > Préférences Système 
dans la barre des menus. 
N’hésitez pas à expérimenter avec les réglages apparaissant dans les fenêtres suivantes :
Â Apparence :  sélectionnez cette fenêtre de préférences pour changer entre autres 
la couleur des boutons, menus et fenêtres, ainsi que celle de mise en surbrillance.
Â Dashboard et Exposé :  sélectionnez cette fenêtre des Préférences pour définir les 
coins d’écran actifs et les raccourcis de Dashboard, de votre bureau, des fenêtres 
de l’application ainsi que de toutes les fenêtres.
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Â Bureau et économiseur d’écran :  sélectionnez cette fenêtre de préférences pour changer 
la couleur et le motif du bureau ou pour le remplacer par la photo ou l’image de votre 
choix. Vous pouvez également choisir un effet d’écran accrocheur qui apparaîtra lorsque 
l’ordinateur reste inactif.
Â Dock :  sélectionnez cette fenêtre de préférences pour modifier la taille, l’emplacement 
et le comportement de votre Dock (c’est-à-dire, la barre d’icônes au bas de votre écran).
Tout en vous familiarisant avec votre ordinateur, découvrez progressivement les autres 
Préférences Système. Préférences Système constitue le poste de commande qui vous 
permet d’effectuer la plupart des réglages de votre MacBook. Pour en savoir plus, 
ouvrez l’Aide Mac et recherchez «Préférences Système» ou la fenêtre de préférences 
spécifique que vous souhaitez modifier.
Remarque :  Apple publiant régulièrement de nouvelles versions et mises à jour de son 
logiciel système, ses applications et ses sites Internet, il est possible que les illustrations 
figurant dans ce manuel diffèrent légèrement de celles qui apparaissent sur votre écran.
Utilisation des applications
Votre MacBook est accompagné d’applications logicielles vous permettant d’envoyer 
des messages électroniques, de naviguer sur Internet et de bavarder en ligne. Il inclut 
également la suite d’applications iLife, utile par exemple pour l’organisation de votre 
musique et de vos photos numériques, la création de séquences et de sites web. Pour 
en savoir plus sur ces applications, consultez le livret Bienvenue sur Tiger fourni avec 
votre ordinateur.
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Lorsqu’une application ne répond plus
Il peut arriver, très rarement, qu’une application se «fige» à l’écran. Mac OS X permet 
de quitter une application figée sans redémarrer votre ordinateur. Vous pouvez ainsi 
enregistrer le travail effectué dans d’autres applications ouvertes.
Pour forcer une application à se fermer :
1 Appuyez sur les touches Commande (x) + Option + Échap ou choisissez Pomme (?) > 
Forcer à quitter dans la barre des menus.
La boîte de dialogue Forcer à quitter des applications apparaît. L’application est 
sélectionnée.
2 Dans la zone de confirmation, cliquez sur Forcer à quitter.
L’application se ferme, en laissant toutes les autres applications ouvertes.
Si nécessaire, vous pouvez également redémarrer le Finder à partir de cette zone de 
dialogue.
Si vous rencontrez d’autres difficultés avec une application, consultez le chapitre 5, 
«Dépannage», à la page 99.
Maintien à jour de vos logiciels
Vous pouvez vous connecter à Internet pour télécharger et installer automatiquement les 
dernières versions de logiciels, gestionnaires et autres améliorations fournies par Apple. 
Chaque fois que vous vous connectez à Internet, «Mise à jour de logiciels» consulte 
les serveurs Internet d’Apple pour rechercher les mises à jour disponibles pour votre 
ordinateur. Vous pouvez configurer votre Mac pour qu’il recherche régulièrement dans 
les serveurs Apple des mises à jour de logiciels, puis les télécharge et les installe.
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Pour rechercher des logiciels mis à jour :
1 Ouvrez les Préférences Système. 
2 Cliquez sur l’icône «Mise à jour de logiciels» et suivez les instructions à l’écran.
Â Pour plus d’informations, recherchez «Mise à jour de logiciels» dans l’Aide Mac. 
Â Pour obtenir les toutes dernières informations concernant Mac OS X, accédez au site 
web Mac OS X à l’adresse www.apple.com/fr/macosx.
Connexion à une imprimante
Suivez les instructions fournies avec votre imprimante pour installer les logiciels requis 
et connecter l’imprimante. Mac OS X intègre la plupart des gestionnaires d’imprimantes. 
Vous pouvez connecter la plupart des imprimantes au moyen d’un câble USB ; d’autres 
peuvent requérir une connexion en réseau, par exemple via Ethernet. Si vous possédez 
une borne d’accès AirPort Express ou AirPort Extreme, vous pouvez connecter une 
imprimante USB à la borne d’accès (plutôt qu’à l’ordinateur) pour effectuer des tâches 
d’impression sans fil. Pour en savoir plus sur les ports USB, consultez la section «Utilisation de périphériques USB (Universal Serial Bus)» à la page 58. Pour en savoir plus sur 
les connexions réseau ou sans fil, consultez la section «Fonctionnement de l’accès sans 
fil à Internet via AirPort» à la page 66 et «Connexion via Ethernet» à la page 69.
Lorsque vous connectez une imprimante USB, elle est normalement automatiquement 
détectée par votre ordinateur qui l’ajoute alors à la liste des imprimantes disponibles. 
Il se peut que vous ayez besoin du nom réseau ou de l’adresse des imprimantes connectées à un réseau pour pouvoir imprimer. Utilisez la fenêtre Imprimantes et fax des 
Préférences Système pour sélectionner votre imprimante.
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Remarque :  si votre imprimante ne fonctionne pas, il sera peut-être nécessaire de consulter le site web de son fabricant pour obtenir le logiciel de gestionnaire d’imprimante 
compatible à installer.
Pour configurer une imprimante :
1 Ouvrez Préférences Système et cliquez sur l’icône Imprimantes et fax.
2 Cliquez sur Impression puis sur le bouton Ajouter (+) pour ajouter une imprimante.
3 Sélectionnez l’imprimante que vous souhaitez utiliser, puis cliquez sur Ajouter.
4 Utilisez les boutons Ajouter (+) et Supprimer (–) pour choisir les imprimantes que vous 
souhaitez voir apparaître dans la liste des imprimantes.
Contrôle de l’impression
Après avoir envoyé un document à une imprimante, vous pouvez contrôler l’impression, 
interrompre votre tâche d’impression ou la placer temporairement en attente. Cliquez 
sur l’icône Imprimante dans le Dock pour ouvrir la fenêtre Imprimante. Pour plus d’informations, choisissez Aide > Aide Mac et recherchez «impression».
Lecture d’un CD et connexion d’un casque d’écoute
Vous pouvez utiliser iTunes, un juke-box numérique et magasin facile à utiliser, d’où vous 
pouvez télécharger de la musique, des clips vidéos, des podcasts et des livres audio et 
écouter votre musique iTunes et des CD tout en utilisant votre ordinateur. Insérez un CD 
de musique dans votre lecteur optique et iTunes apparaîtra automatiquement à l’écran. 
Vous pouvez écouter de la musique soit via les haut-parleurs internes du MacBook, soit 
en branchant un casque d’écoute sur le port de sortie casque de votre MacBook. 
Pour en savoir plus sur iTunes :
m Ouvrez iTunes et choisissez Aide > Aide iTunes et Music Store. 
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Connexion d’un appareil photo ou de tout autre périphérique 
FireWire ou USB
Vous pouvez connecter un iPod, un appareil photo numérique, une caméra vidéo, un 
scanneur ou tout autre appareil doté d’un connecteur FireWire ou USB à votre MacBook. 
Suivez les instructions d’installation fournies avec votre appareil. Pour obtenir des informations sur FireWire, consultez la section «Connexion via FireWire» à la page 62. Pour 
obtenir des informations sur les connexions USB, consultez la section «Utilisation de périphériques USB (Universal Serial Bus)» à la page 58.
Transfert de fichiers depuis ou vers un autre ordinateur
Si vous souhaitez transférer des fichiers ou des documents depuis ou vers un autre 
ordinateur, vous pouvez procéder de différentes manières.
Â Vous pouvez facilement transférer tous vos fichiers à l’aide d’Assistant migration 
et d’un câble FireWire (vendu séparément). 
Â Vous pouvez également vous connecter à un autre Mac à l’aide d’un câble FireWire 
et démarrer votre MacBook en mode disque cible FireWire. Votre MacBook apparaît 
alors en tant que disque dur sur l’autre ordinateur et vous pouvez y faire glisser 
des fichiers. Pour plus d’informations sur l’utilisation de FireWire pour transférer des 
fichiers, consultez la section «Connexion de votre MacBook à un autre ordinateur via 
FireWire» à la page 64.
Â Si vous possédez un lecteur de disque dur externe, un iPod, un lecteur flash ou tout 
autre périphérique de stockage de données qui se connecte via un câble USB ou 
FireWire, vous pouvez l’utiliser pour transférer des fichiers. 
Â Si vous disposez d’un compte de messagerie, vous pouvez envoyer vos fichiers par 
courrier électronique vers un autre ordinateur.
F3626M42.book  Page 54  Wednesday, April 5, 2006  2:17 PMChapitre 2   Familiarisation avec votre MacBook 55
Â Si vous souscrivez un compte .Mac (payant) auprès d’Apple, vous pouvez l’utiliser 
pour transférer des fichiers. Avec un compte .Mac, vous obtenez un iDisk qui vous 
fournit un espace Internet pour la sauvegarde et le stockage de fichiers, afin que 
d’autres ordinateurs puissent accéder aux fichiers que vous y transférez. 
Â À l’aide d’un lecteur optique enregistrable, vous pouvez enregistrer des fichiers pour 
les transférer sur CD ou DVD.
Â Si vous connectez votre ordinateur à un réseau via Ethernet, vous pouvez échanger 
des fichiers avec d’autres ordinateurs du réseau. Vous pouvez accéder à un serveur 
ou à un autre ordinateur en cliquant sur Réseau dans la barre latérale du Finder ou 
en choisissant Aller > «Se connecter au serveur» dans la barre des menus du Finder.
Â Vous pouvez créer un petit réseau Ethernet en connectant un câble Ethernet depuis 
votre MacBook jusqu’au port Ethernet d’un autre ordinateur. Après vous être connecté 
à l’autre ordinateur, vous pouvez transférer des fichiers directement d’un ordinateur à 
l’autre. Pour plus d’informations, ouvrez l’Aide Mac et recherchez «Connexion de deux 
ordinateurs».
Â Vous pouvez vous connecter à un réseau sans fil AirPort Extreme pour transférer des 
fichiers. Pour plus d’informations, consultez la section «Fonctionnement de l’accès 
sans fil à Internet via AirPort» à la page 66.
Â Si vous avez accès à des appareils qui communiquent via la technologie sans fil 
Bluetooth®, vous pouvez transférer des fichiers vers d’autres appareils équipés de 
cette technologie. Pour plus d’informations, consultez la section «Utilisation de la 
technologie sans fil Bluetooth» à la page 67.
Pour obtenir des informations générales sur le transfert de fichiers et de documents, 
ouvrez l’Aide Mac et recherchez «transfert» ou le type de connexion dont vous avez besoin.
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3
3 Utilisation de votre MacBook
Votre MacBook comporte de nombreuses fonctions 
et capacités de connexion intégrées. 
En voici la liste :
Â des ports USB 2.0 (Universal Serial Bus) pour la connexion d’appareils, notamment 
iPod, imprimantes ou scanneurs (voir «Utilisation de périphériques USB (Universal 
Serial Bus)» à la page 58) ;
Â un port FireWire 400 pour connecter des périphériques à haute vitesse, tels que 
caméras vidéo numériques et disques durs externes (voir «Connexion via FireWire» à 
la page 62) ;
Â la connectivité sans fil Bluetooth, la capacité réseau sans fil AirPort Extreme et la capacité réseau Ethernet Gigabit. (voir «Fonctionnement de l’accès sans fil à Internet via 
AirPort» à la page 66 et «Connexion via Ethernet» à la page 69) ;
Â un port d’entrée de ligne audio/audio numérique optique et un port de sortie casque/
audio numérique optique pour connecter un casque, des haut-parleurs et des appareils 
audio numériques (voir «Connexion de haut-parleurs et autres périphériques audio» à la 
page 75) ;
F3626M42.book  Page 57  Wednesday, April 5, 2006  2:17 PM58 Chapitre 3   Utilisation de votre MacBook
Â un port vidéo mini-DVI pour connecter votre MacBook à un moniteur externe via un 
adaptateur Mini-DVI vers DVI ou Mini-DVI vers VGA : utilisez un adaptateur Mini-DVI 
vers Vidéo pour connecter tout appareil vidéo nécessitant une connexion composite 
ou S-Vidéo ; tous les adaptateurs sont vendus séparément (voir «Gestion de la vidéo 
externe» à la page 71) ;
Â un lecteur optique à chargement par fente pour la lecture de CD et de DVD et pour 
la gravure de CD ; si vous disposez d’un lecteur SuperDrive, vous pouvez également 
graver des DVD (voir «Utilisation du lecteur optique» à la page 76) ;
Â la technologie Sudden Motion Sensor qui contribue à protéger le disque dur en cas 
de chute ou de vibrations subies par votre MacBook (voir «Technologie 
Sudden Motion Sensor» à la page 81) ;
Â une batterie MacBook dont vous pouvez facilement consulter l’état de charge 
(voir «Utilisation de la batterie» à la page 81) ;
Â un logement de sécurité pour éviter que votre MacBook ne disparaisse (voir «Protection 
de votre MacBook» à la page 87).
Utilisation de périphériques USB (Universal Serial Bus)
Votre MacBook est livré avec deux ports USB 2.0 (d), ou ports USB haute vitesse, à utiliser 
pour connecter de nombreux périphériques externes, notamment iPod, imprimantes, scanneurs, appareils photo numériques, manettes de jeu, claviers ou lecteurs de disquette. 
Ces ports USB 2.0 sont compatibles avec les anciens modèles de périphériques USB. Vous 
pouvez, dans la plupart des cas connecter et déconnecter un périphérique USB pendant 
que l’ordinateur est allumé. Vous pouvez utiliser les périphériques dès leur branchement. 
Il n’est pas nécessaire de redémarrer ni de reconfigurer votre ordinateur.
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Pour utiliser un périphérique USB avec votre ordinateur, connectez-le. Votre ordinateur 
détecte automatiquement tout nouveau périphérique connecté et ouvre le logiciel 
adéquat. 
Remarque :  si vous avez connecté un périphérique USB et que votre MacBook ne 
trouve pas le gestionnaire approprié, vous pouvez installer le gestionnaire fourni avec 
le périphérique ou consulter le site web du fabricant du périphérique afin de trouver 
et installer le gestionnaire approprié.
Périphériques USB et énergie de la batterie
Vous pouvez utiliser des périphériques USB, tels qu’une manette de jeu ou un clavier, qui 
sont alimentés via le port USB de votre MacBook plutôt que via un adaptateur secteur 
distinct. Ce type de périphérique USB peut toutefois provoquer un déchargement plus 
rapide de la batterie du MacBook. Si vous comptez connecter le périphérique pendant 
une longue période, il est recommandé de brancher le MacBook à son adaptateur secteur.
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Utilisation simultanée de plusieurs périphériques USB
Vous pouvez vous procurer un concentrateur USB pour connecter plusieurs périphériques USB à votre ordinateur. Vous pouvez connecter le concentrateur à un port USB 
disponible de votre ordinateur pour disposer de ports USB supplémentaires (en général 
quatre ou sept). Les concentrateurs haute vitesse prennent en charge les périphériques 
USB 2.0 haute vitesse, ainsi que les périphériques compatibles USB 1.1. Les concentrateurs 
USB 1.1 ne permettent pas aux périphériques USB haute vitesse de fonctionner à leur 
vitesse maximale. La plupart des concentrateurs USB disposent d’un adaptateur secteur 
et doivent être branchés sur une prise secteur.
Remarque :  si vous utilisez une chaîne de périphériques et de concentrateurs USB, certains d’entre eux risquent de ne pas fonctionner s’ils sont connectés via une combinaison 
de concentrateurs USB 2.0 haute vitesse et de concentrateurs USB 1.1 à vitesse normale 
ou faible. Il se peut, par exemple, qu’aucun disque dur externe USB ne s’affiche sur votre 
bureau. Pour éviter ce problème, ne connectez pas ensemble des périphériques USB pré-
sentant des vitesses différentes. Connectez directement votre concentrateur à haut débit à 
votre ordinateur, puis connectez-y des périphériques à haut débit. Connectez directement 
un concentrateur à vitesse normale ou faible à votre ordinateur, puis connectez-y des 
périphériques de vitesse similaire.
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Pour en savoir plus à propos de la technologie USB
L’Aide Mac contient des informations supplémentaires sur la technologie USB. Choisissez 
Aide > Aide Mac dans la barre des menus et recherchez «USB». Vous trouverez d’autres 
informations sur le site web USB d’Apple, à l’adresse www.apple.com/fr/usb. Pour obtenir 
des informations sur les périphériques USB disponibles pour votre ordinateur, consultez 
le Guide des Produits Macintosh à l’adresse www.apple.com/fr/guide.
Concentrateur USB
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Connexion via FireWire
Votre ordinateur est équipé d’un port FireWire 400 (H). La technologie FireWire vous 
permet de connecter et de déconnecter aisément des périphériques haute vitesse, 
tels que des caméras haute définition HDV ou numériques DV et des disques durs, 
sans redémarrer votre ordinateur. 
Vous pouvez connecter un périphérique FireWire standard à 6 broches directement 
au port FireWire 400 (H). Le port fournit en alimentation les périphériques connectés 
(ces derniers n’ont donc pas besoin de prise d’alimentation séparée). 
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La technologie FireWire vous permet notamment de :
Â connecter une caméra HDV ou DV pour capturer, transférer et faire des montages 
vidéo de grande qualité directement sur votre ordinateur au moyen de logiciels 
de montage vidéo tels qu’iMovie HD, Final Cut Express ou Final Cut Studio (vendus 
séparément) ;
Â connecter un disque dur FireWire externe et l’utiliser pour sauvegarder des données 
ou transférer des fichiers ; 
Â démarrer à partir d’un disque dur externe FireWire : connectez un disque dur FireWire 
externe (doté de Mac OS X version 10.4.6 ou ultérieure), ouvrez la fenêtre Démarrage 
des Préférences Système, puis cliquez sur l’icône de disque dur FireWire et redémarrez 
votre ordinateur) ;
Â transférer des fichiers entre votre MacBook et un autre ordinateur FireWire via le mode 
disque cible FireWire : pour toute information supplémentaire, consultez la section 
«Connexion de votre MacBook à un autre ordinateur via FireWire» à la page 64.
Utilisation de périphériques FireWire
Pour utiliser un périphérique FireWire avec votre ordinateur, connectez-le à l’ordinateur 
et installez tout logiciel fourni avec le périphérique en question. Votre ordinateur détecte 
automatiquement les nouveaux périphériques connectés.
Remarque :  si vous avez connecté un périphérique FireWire et que votre MacBook ne 
trouve pas le gestionnaire approprié, vous pouvez installer le gestionnaire fourni avec 
le périphérique ou consulter le site web du fabricant du périphérique afin de trouver 
et installer le gestionnaire approprié.
F3626M42.book  Page 63  Wednesday, April 5, 2006  2:17 PM64 Chapitre 3   Utilisation de votre MacBook
Périphériques FireWire et énergie de la batterie
Vous pouvez utiliser des périphériques FireWire (comme certains disques durs externes) 
alimentés par la connexion FireWire du MacBook plutôt que par un adaptateur secteur 
séparé. Ce type de périphérique FireWire peut toutefois provoquer un déchargement 
plus rapide de la batterie du MacBook. Si vous comptez connecter un périphérique 
pendant une longue période, il est recommandé de brancher le MacBook sur son adaptateur secteur.
Remarque :  le port FireWire (H) est conçu pour prendre en charge l’alimentation des 
périphériques FireWire (7 watts maximum). Il est possible de connecter plusieurs périphériques entre eux, puis de connecter cette chaîne de périphériques au port FireWire 
de votre ordinateur, à condition que seul l’un d’eux soit alimenté directement par 
l’ordinateur. Les autres périphériques de la chaîne doivent alors être alimentés par 
des adaptateurs secteur distincts. La connexion de plusieurs périphériques FireWire 
alimentés par le port peut poser des problèmes. En cas de problème, éteignez l’ordinateur, déconnectez les périphériques FireWire, puis redémarrez l’ordinateur.
Connexion de votre MacBook à un autre ordinateur via FireWire
Si vous souhaitez transférer des fichiers de votre MacBook à un autre ordinateur Macintosh 
équipé de la technologie FireWire ou que vous êtes confronté à un problème qui empêche 
le démarrage de votre ordinateur, utilisez le mode disque cible FireWire pour vous connecter à l’autre ordinateur. Lorsque vous démarrez votre ordinateur en mode disque cible 
FireWire, l’autre ordinateur peut accéder à votre MacBook comme s’il s’agissait d’un disque 
dur externe.
Remarque :  lorsque vous utilisez le mode disque cible FireWire, il est conseillé de 
connecter l’adaptateur secteur à votre MacBook.
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Pour connecter votre MacBook avec un autre ordinateur en mode disque cible 
FireWire :
1 Assurez-vous que votre MacBook est éteint.
2 Utilisez un câble FireWire pour connecter votre MacBook à un autre ordinateur équipé 
de FireWire. 
3 Démarrez votre MacBook, puis maintenez immédiatement la touche T enfoncée. 
L’écran de votre MacBook affiche alors le logo FireWire. L’écran de l’autre ordinateur 
affiche l’icône du disque dur interne de votre MacBook. Vous pouvez maintenant 
glisser-déposer des fichiers entre les deux ordinateurs.
4 Une fois que vous avez terminé de transférer les fichiers, faites glissez l’icône du disque 
dur du MacBook dans la corbeille (icône d’éjection).
5 Appuyez sur le bouton d’alimentation (®) de votre MacBook pour l’éteindre, puis 
débranchez le câble FireWire.
Pour en savoir plus à propos de FireWire
L’Aide Mac fournit des informations supplémentaires sur FireWire. Choisissez Aide > 
Aide Mac dans la barre des menus du Finder et cherchez «FireWire». Vous 
trouverez d’autres informations sur le site web FireWire d’Apple, à l’adresse 
www.apple.com/fr/firewire.
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Fonctionnement de l’accès sans fil à Internet via AirPort
Grâce à la technologie AirPort Extreme, votre MacBook établit une connexion sans fil 
à une borne d’accès AirPort Express ou AirPort Extreme ou à tout produit compatible 
802.11b ou 802.11g, qui est connecté à Internet via une ligne téléphonique, un modem 
DSL ou câble ou un réseau local (LAN).
Pour en savoir plus sur AirPort Extreme
Pour acheter une borne d’accès AirPort Extreme ou AirPort Express, accédez à 
l’Apple Store en ligne, à l’adresse www.apple.com/francestore ou adressez-vous 
à votre revendeur agréé Apple.
Connexion
à Internet
AirPort Express   Prise secteur
Modem câble ou DSL
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Des informations complémentaires sur AirPort Extreme et AirPort Express sont disponibles 
dans l’Aide AirPort. Sélectionnez Aide > Aide Mac, puis Centre d’aide > Aide AirPort. Des 
informations supplémentaires sont disponibles sur le site AirPort d’Apple aux pages 
www.apple.com/fr/airportexpress et www.apple.com/fr/airportextreme.
Utilisation de la technologie sans fil Bluetooth
La technologie sans fil Bluetooth est intégrée à votre MacBook. Elle vous permet d’établir des connexions sans fil de faible portée entre ordinateurs de bureau ou portables, 
assistants personnels (PDA), téléphones portables, téléphones appareils photo, imprimantes, appareils photo numériques et périphériques sans fil tels que le clavier 
Apple Wireless Keyboard ou la souris Apple Wireless Mouse (disponibles sur l’Apple Store 
en ligne à l’adresse www.apple.com/francestore). 
La technologie sans fil Bluetooth permet d’éliminer les câbles reliant normalement 
les périphériques. Les périphériques équipés de la technologie Bluetooth peuvent 
se connecter l’un à l’autre sans besoin de liaison physique, dans la mesure où ils sont 
séparés d’une distance égale ou inférieure à 10 mètres.
Grâce à la technologie sans fil Bluetooth, vous pouvez :
Â utiliser votre MacBook pour communiquer avec un téléphone portable compatible 
Bluetooth : votre téléphone peut servir de modem pour vous connecter à un fournisseur d’accès sans fil, à un débit égal ou inférieur à 56 kilobits par seconde (kbps), 
suffisant pour vous connecter à Internet ;
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Â synchroniser votre ordinateur avec votre organiseur de poche équipé de la technologie 
Bluetooth : à l’aide d’iSync, vous pouvez exécuter une opération HotSync sans fil ou 
transmettre votre carte de visite ou encore des événements de calendrier directement 
sur le PDA d’un collègue ;
Â échanger des fichiers entre ordinateurs et périphériques équipés de la technologie 
Bluetooth, même entre Mac et PC ;
Â utiliser une imprimante, un clavier, une souris ou un casque d’écoute sans fil Bluetooth.
Configuration d’un périphérique Bluetooth
Avant de pouvoir utiliser un périphérique Bluetooth avec votre MacBook, vous devez 
configurer le périphérique de manière à ce qu’il puisse fonctionner avec votre ordinateur. Une fois que vous avez configuré le périphérique, celui-ci est jumelé avec votre 
ordinateur et apparaît dans la fenêtre Périphériques des Préférences Bluetooth. Le 
jumelage du périphérique avec votre ordinateur ne doit être effectué qu’une seule fois. 
Il demeure activé aussi longtemps que vous ne le supprimer pas de manière explicite.
Pour configurer un périphérique Bluetooth :
1 Choisissez Configurer l’appareil Bluetooth dans le menu d’état Bluetooth (?).
2 Suivez les instructions affichées à l’écran pour le type de périphérique que vous 
souhaitez configurer.
Si le menu d’état Bluetooth (?) n’apparaît pas dans la barre des menus, ouvrez 
Préférences Système et cliquez sur Bluetooth. Cliquez sur Réglages, puis sélectionnez 
«Afficher l’état Bluetooth dans la barre des menus».
Pour supprimer un jumelage avec un autre périphérique :
1 Ouvrez Préférences Système, puis cliquez sur Bluetooth. 
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2 Cliquez sur Périphériques et choisissez le périphérique dans la liste. 
3 Cliquez sur Supprimer.
Pour en savoir plus sur la technologie sans fil Bluetooth
Pour plus d’informations sur Bluetooth, ouvrez l’application Échange de fichiers Bluetooth 
(dans le dossier Utilitaires du dossier Applications) et sélectionnez Aide > Aide Bluetooth. 
Vous trouverez d’autres informations sur le site web Bluetooth d’Apple, à l’adresse 
www.apple.com/fr/bluetooth.
Connexion via Ethernet
Votre ordinateur est fourni avec des capacités de mise en réseau Ethernet Gigabit (G) 
intégrées, qui permettent de vous connecter à un réseau, à un modem DSL ou à un 
modem câble. 
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La connexion à un réseau permet d’accéder à d’autres ordinateurs et potentiellement 
à des imprimantes réseau, des modems, le courrier électronique et Internet. Vous pouvez utiliser Ethernet pour partager des fichiers entre deux ordinateurs ou établir un 
petit réseau. Le port Ethernet de votre MacBook détecte automatiquement les autres 
périphériques Ethernet. Pour établir des connexions à d’autres périphériques Ethernet, 
il est inutile d’utiliser un câble croisé Ethernet.
Pour en savoir plus sur l’utilisation d’Ethernet
Des informations supplémentaires, y compris sur la configuration d’un réseau Ethernet et 
le transfert de fichiers via Ethernet, sont disponibles dans l’Aide Mac. Choisissez Aide > 
Aide Mac, puis recherchez «Ethernet» ou «réseau». 
Pour obtenir des informations sur les produits de mise en réseau que vous pouvez 
utiliser avec votre MacBook, consultez le Guide des produits Macintosh à l’adresse 
www.apple.com/fr/guide/.
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Gestion de la vidéo externe 
Votre ordinateur est équipé d’un port de moniteur externe (mini DVI) permettant une connexion directe à un écran ou à un projecteur muni d’un port DVI ou VGA. Utilisez l’adaptateur Mini-DVI vers DVI d’Apple (vendu séparément) pour connecter votre MacBook à un 
moniteur ou projecteur DVI. Utilisez l’adaptateur Mini-DVI vers VGA d’Apple (vendu séparément) pour connecter votre MacBook à un moniteur ou projecteur VGA.
Vous pouvez également afficher des images sur un téléviseur, enregistrer des images 
numériques sur un magnétoscope ou lire des DVD sur votre téléviseur à l’aide d’un adaptateur Mini-DVI vers Vidéo d’Apple à utiliser avec des connecteurs composite ou S-Vidéo. 
Vous pouvez vous procurer les adaptateurs chez un revendeur agréé Apple, dans un 
magasin Apple Store ou sur l’Apple Store en ligne à l’adresse www.apple.com/francestore.
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Lorsqu’un moniteur externe ou un téléviseur est connecté, vous pouvez soit faire en 
sorte que la même image s’affiche sur l’écran intégré et le moniteur externe (c’est ce 
que l’on appelle la recopie vidéo), soit utiliser le moniteur externe pour étendre la taille 
du bureau Mac OS (on parle dans ce cas de mode double-écran ou de bureau étendu). 
Par défaut, votre MacBook démarre en mode double-écran. Appuyez sur la touche F7 (i) 
pour alterner entre les modes double-écran et recopie vidéo.
Si vous souhaitez que le son soit émis par un écran externe (un projecteur ou un téléviseur, par exemple), vous devez relier le port de sortie casque (f) de l’ordinateur à ce 
périphérique via un câble audio (non inclus).
Remarque :  en raison des limites d’affichage de la plupart des téléviseurs, les images 
apparaissent avec une qualité inférieure à celle de l’écran intégré ou du moniteur externe.
Connexion d’un écran externe ou d’un projecteur
Pour connecter à votre ordinateur un écran externe ou un projecteur via un 
connecteur DVI ou VGA :
1 Allumez l’écran externe ou le projecteur.
2 Vérifiez que le câble de l’écran est bien relié au projecteur ou à l’écran externe.
3 Connectez le câble de l’écran à votre MacBook à l’aide de l’adaptateur adéquat 
(adaptateur Mini-DVI vers DVI ou Mini-DVI vers VGA d’Apple). Votre MacBook détecte 
automatiquement l’écran externe ou le projecteur.
4 Réglez la résolution d’un écran externe via la fenêtre Moniteurs des 
Préférences Système ou l’icône Moniteurs de la barre de menus.
Remarque :  votre MacBook gère les résolutions de moniteurs externes jusqu’à 
1920 x 1200 (moniteurs DVI d’Apple) ou 1600 x 1200 (moniteurs VGA).
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Utilisation de votre MacBook écran rabattu
Vous pouvez utiliser votre MacBook en gardant l’écran rabattu si l’ordinateur est 
connecté à un moniteur, un clavier et une souris externes. 
Important :  pour utiliser votre MacBook écran rabattu, branchez-le sur une prise secteur.
Pour utiliser votre ordinateur écran rabattu avec un moniteur externe connecté :
1 Connectez un clavier et une souris USB à votre MacBook.
2 Connectez l’adaptateur secteur à votre MacBook et à une prise secteur. Vérifiez que 
la lampe de l’adaptateur secteur est allumée.
3 Rabattez l’écran du MacBook afin d’en suspendre l’activité.
4 Connectez votre MacBook à un écran externe en suivant les étapes décrites dans 
la section précédente.
5 Attendez quelques secondes, puis appuyez sur n’importe quelle touche du clavier 
externe pour réactiver le MacBook.
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Connexion d’un téléviseur, d’un magnétoscope ou de tout autre 
appareil vidéo
Pour connecter un téléviseur ou tout autre appareil vidéo nécessitant une connexion 
composite ou S-Vidéo :
1 Connectez l’adaptateur Mini-DVI vers vidéo d’Apple (vendu séparément) au port 
Mini-DVI de votre MacBook.
2 Connectez le périphérique à l’adaptateur.
3 Si vous souhaitez que le son de votre MacBook soit restitué sur le périphérique, 
connectez le port de sortie casque (f) de votre MacBook aux ports d’entrée audio 
du périphérique via un câble mini-jack vers RCA (non inclus).
4 Allumez l’appareil.
5 Pour détecter le téléviseur ou tout autre périphérique externe, maintenez la touche 
Commande (x) enfoncée et appuyez sur la touche F2. Vous pouvez également ouvrir 
la fenêtre Moniteurs des Préférences Système et cliquez sur le bouton Détecter les 
moniteurs.
6 Pour régler l’apparence de l’image affichée à l’écran, ouvrez la fenêtre Moniteurs des 
Préférences Système.
Pour en savoir plus sur l’utilisation d’un moniteur externe ou d’un 
téléviseur
Vous pourrez trouver des informations supplémentaires sur la configuration et l’utilisation 
d’un moniteur externe dans l’Aide Mac. Choisissez Aide > Aide Mac dans la barre des 
menus, puis recherchez «moniteur externe». 
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Connexion de haut-parleurs et autres périphériques audio
Votre MacBook est équipé de trois haut-parleurs intégrés, d’un microphone intégré, 
d’un port d’entrée ligne audio/audio numérique optique et d’un port de sortie casque/
audio numérique optique (f). 
Vous pouvez connecter des haut-parleurs externes, des écouteurs et d’autres périphériques de sortie audio au port de sortie casque (f). Ce port de sortie constitue également 
une prise mini-phono stéréo S/PDIF de 3,5 mm. Les haut-parleurs intégrés n’émettent 
aucun son lorsque des périphériques sont branchés sur l’ordinateur. Pour que le son soit 
émis de ces haut-parleurs, débranchez le casque ou les haut-parleurs externes éventuellement connectés à l’ordinateur.
Vous pouvez enregistrer des sons sur votre disque dur à l’aide du micro intégré situé à 
côté de la caméra iSight intégrée. Vous avez également la possibilité de connecter des 
micros externes ou tout autre appareil audio sur le port d’entrée de ligne audio. Le port 
d’entrée de ligne audio constitue également une prise mini-phono stéréo S/PDIF de 
3,5 mm. Étant donné que cette prise ne permet pas d’alimenter les périphériques 
connectés, ces derniers doivent être auto-alimentés. Si vous disposez d’un adaptateur 
Toslink prise vers mini-jack, vous pouvez utiliser un câble Toslink pour connecter un 
lecteur Digital Audio Tape (DAT) ou des instruments numériques afin d’enregistrer et 
de mixer votre propre musique.
Pour les applications capables d’enregistrement audio, telles qu’iMovie HD, utilisez 
la fenêtre Son des Préférences Système pour sélectionner le périphérique d’entrée 
audio à utiliser (y compris des micros connectés via USB). 
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Les commandes de volume de votre clavier vous permettent de régler facilement le 
volume de sortie. Vous pouvez également régler le volume d’entrée et de sortie dans 
la fenêtre Son des Préférences Système.
Pour plus d’informations sur l’utilisation ou le dépannage du son de votre ordinateur, 
choisissez Aide > Aide Mac, puis effectuez une recherche à l’aide du mot son.
Utilisation du lecteur optique
Votre MacBook comprend un lecteur optique, Combo ou SuperDrive. 
Avec votre lecteur optique, vous pouvez :
Â installer ou utiliser des logiciels à partir de CD et de DVD ;
Â lire de la musique et des fichiers multimédia à partir de CD ;
Â écrire des fichiers musicaux, des documents et d’autres fichiers numériques sur CD-R 
ou CD-RW ;
Â lire des films DVD ainsi que la plupart des disques DVD.
Si vous disposez d’un lecteur SuperDrive, vous pouvez également enregistrer des 
données sur des disques DVD±R ou DVD±RW vierges.
Important :  le lecteur optique de votre MacBook gère les disques standard circulaires de 
12 cm de diamètre. Les disques de forme irrégulière et les disques de moins de 12 cm ne 
peuvent pas être lus. Les disques de ce type risquent de se bloquer dans le lecteur.
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Insertion d’un CD ou DVD
Pour installer ou utiliser des logiciels à partir d’un CD ou d’un DVD :
1 L’ordinateur étant allumé, introduisez le disque (étiquette vers le haut) dans la fente du 
lecteur jusqu’à ce que le lecteur le saisisse. 
Il se peut qu’il faille insérer le disque presque entièrement avant que cela ne se produise. 
Cela est normal.
2 Dès que son icône apparaît sur le bureau, le disque peut être utilisé.
Éjection d’un disque
Pour éjecter un disque, procédez comme suit :
Â Glissez l’icône du disque dans la Corbeille (icône d’éjection).
Â Maintenez enfoncée la touche d’éjection de disque (C) du clavier jusqu’à ce que 
le disque soit éjecté.
Attendez que le disque soit complètement éjecté avant de le retirer ou de le réinsérer.
®?
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Si vous ne parvenez pas à éjecter le disque, fermez toutes les applications susceptibles 
d’utiliser le disque et réessayez. Si cela ne donne pas de résultats, redémarrez l’ordinateur tout en maintenant le bouton du trackpad enfoncé.
Lecture de DVD
Pour lire un disque vidéo DVD sur votre MacBook, insérez le DVD. Lecteur DVD s’ouvre 
automatiquement. Vous pouvez constater que Lecteur DVD offre des commandes 
simples d’utilisation pour lancer, interrompre et visionner les DVD.
Si vous avez connecté votre MacBook à un téléviseur afin de pouvoir regarder le DVD 
sur l’écran du téléviseur, sélectionnez 720 x 480 NTSC (aux États-Unis) ou 720 x 576 PAL 
(en Europe et dans d’autres régions) dans la fenêtre Moniteurs des Préférences Système. 
Il est très facile de connecter votre MacBook à une chaîne stéréo. Utilisez un câble 
mini-jack vers RCA (non inclus) pour relier le port de sortie casque (f) de votre 
MacBook aux ports d’entrée audio de votre chaîne stéréo.
Enregistrement de disques CD-R ou CD-RW
Votre MacBook peut enregistrer des données sur des disques CD-R ou CD-RW. Si vous 
disposez d’un lecteur SuperDrive, vous pouvez également enregistrer vos propres films 
numériques sur des disques DVD±R ou DVD±RW enregistrables vierges. Vous pouvez 
également enregistrer d’autres types de données numériques, telles que des sauvegardes 
de fichiers, sur un DVD enregistrable.
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Pour enregistrer des données sur des disques CD-R, CD-RW, DVD±R ou DVD+RW :
1 Insérez un disque CD ou DVD (SuperDrive seulement) enregistrable vierge dans 
le lecteur optique.
2 Dans la zone de dialogue qui apparaît, attribuez un nom au disque et sélectionnez 
le format que vous souhaitez utiliser.
3 Double-cliquez sur l’icône du disque qui apparaît sur votre bureau, puis faites-y glisser 
des fichiers et des dossiers.
4 Cliquez sur l’icône Graver le disque située à côté du nom du disque dans la barre latérale 
du Finder.
Vous pouvez également enregistrer de la musique sur des disques CD ou DVD 
directement à partir de votre bibliothèque iTunes.
Pour enregistrer de la musique depuis votre bibliothèque iTunes :
1 Cliquez sur l’icône iTunes dans le Dock.
2 Sélectionnez la liste de lecture ou les morceaux à enregistrer.
3 Insérez un disque CD ou DVD (SuperDrive seulement) vierge.
4 En haut de la fenêtre iTunes, cliquez sur l’option Graver le CD.
Important :  si votre batterie se décharge lors de la gravure d’un CD, il se peut que 
la gravure échoue et que le CD devienne inutilisable. Pour éviter cela, utilisez toujours 
votre adaptateur secteur lorsque vous gravez un CD.
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Si vous disposez d’un lecteur SuperDrive, vous pouvez enregistrer vos films numériques sur des disques DVD enregistrables vierges. Vous pouvez également enregistrer 
d’autres types de données numériques. Vous pouvez, par exemple, sauvegarder des 
fichiers sur des DVD enregistrables. Les applications telles qu’iDVD vous permettent de 
créer vos propres projets multimédias numériques, de les graver sur des disques DVD 
enregistrables vierges, puis de les lire sur la plupart des lecteurs DVD standard.
Pour graver un projet iDVD sur un disque vierge DVD±R ou DVD±RW :
1 Ouvrez iDVD puis votre projet iDVD.
2 Cliquez sur le bouton Graver.
3 À l’invite, insérez un disque DVD enregistrable vierge dans le lecteur.
4 Cliquez de nouveau sur le bouton Graver.
Pour en savoir plus, ouvrez iDVD puis choisissez Aide > Aide iDVD.
Important :  si votre batterie se décharge lors de la gravure d’un DVD, il se peut que la 
gravure échoue et que le DVD devienne inutilisable. Pour éviter cela, utilisez toujours 
votre adaptateur secteur lorsque vous gravez un DVD.
Pour en savoir plus
Pour obtenir davantage d’informations sur Lecteur DVD et iTunes, consultez les sources 
suivantes :
Â Pour plus d’informations sur l’utilisation de l’application Lecteur DVD, choisissez 
Aide > Aide Lecteur DVD au sein de Lecteur DVD.
Â Pour obtenir des informations sur la manière d’utiliser iTunes afin d’enregistrer des 
fichiers de musique sur disque CD ou DVD, choisissez Aide > «Aide iTunes et Music Store» 
dans l’application iTunes.
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Technologie Sudden Motion Sensor
Votre MacBook utilise la technologie Sudden Motion Sensor qui contribue à protéger le 
disque dur contre tout dommage en cas de chute ou de vibrations subies par l’ordinateur.
En règle générale, la protection Sudden Motion Sensor ne modifie en rien les performances du disque dur au cours du fonctionnement normal du MacBook. Il peut arriver 
que des vibrations anormalement fortes activent le capteur Sudden Motion Sensor 
pendant que votre MacBook est en cours d’écriture ou de lecture intense (comme lors 
de la lecture ou de l’enregistrement vidéo ou audio). Si vous constatez des pertes 
d’images ou d’éléments sonores, assurez-vous que votre MacBook se trouve dans un 
environnement stable protégé contre les vibrations et les mouvements brusques.
Utilisation de la batterie 
Lorsque l’adaptateur secteur externe n’est pas connecté, votre ordinateur est alimenté 
par sa batterie. L’autonomie de votre MacBook varie en fonction des applications utilisées et des périphériques externes connectés. La désactivation de fonctions telles 
qu’AirPort Extreme ou Bluetooth contribue à économiser l’énergie de votre batterie. 
Pour plus d’informations sur l’utilisation de la batterie, lisez la section «Conseils pour 
économiser la batterie» à la page 85.
Pour connaître le niveau de charge de votre batterie, vous pouvez observer les lampes 
témoins de niveau de charge dont elle est dotée. Appuyez sur le bouton situé en regard 
des témoin lumineux afin que ces derniers brillent brièvement pour indiquer le niveau 
de charge de la batterie. Vous pouvez vérifier le niveau de charge, que la batterie soit ou 
non insérée dans votre MacBook.
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Si votre batterie faiblit pendant que vous travaillez, branchez l’adaptateur secteur et 
laissez la batterie se recharger. Pour remplacer une batterie presque déchargée par une 
batterie chargée lorsque votre ordinateur n’est pas connecté à un adaptateur secteur, 
éteignez l’ordinateur. 
Important :  si un seul témoin est allumé, le niveau restant est très faible. Si aucun témoin 
n’est allumé, c’est que la batterie est complètement vide et que l’ordinateur ne pourra 
démarrer sans l’adaptateur secteur. Branchez l’adaptateur secteur et laissez la batterie 
se recharger ou remplacez la batterie à plat par une batterie complètement rechargée 
(voir «retrait de la batterie» à la page 90).
Batterie
Témoins LED 
de la batterie
Bouton
¥
Á
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Si l’icône de la batterie (dans la barre des menus du Finder) est réglée pour afficher 
le pourcentage de charge, vous constaterez parfois que la batterie n’indique pas un 
niveau de charge de 100 pour cent alors que l’adaptateur secteur est branché. Cela 
est tout à fait normal : le niveau de la batterie est maximisé lorsque le chargement n’est 
pas continu, et cette fonction est désactivée lorsque la capacité de charge de la batterie 
est située entre 95 et 100 pour cent. Dès que le niveau de la batterie passe en dessous 
de 95 pour cent, elle est automatiquement rechargée jusqu’à 100 pour cent. 
Retrait et remise en place de la batterie
Pour obtenir des instructions sur le retrait et la remise en place de la batterie, consultez 
les sections «retrait de la batterie» à la page 90 et «remplacement de la batterie» à la 
page 96.
Remarque :  jetez vos batteries usagées en respectant les lois et les consignes environnementales locales. Pour plus d’informations, consultez la section «Informations sur l’enlèvement de la batterie» à la page 142.
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Recharge d’une batterie
Lorsque l’adaptateur secteur est connecté à votre ordinateur, la batterie se recharge, 
que l’ordinateur soit éteint, allumé ou en mode de suspension d’activité. La recharge 
sera toutefois plus rapide si l’ordinateur est éteint ou en mode de suspension d’activité. Lorsque l’ordinateur est allumé, vous pouvez contrôler le niveau de charge de 
la batterie au moyen de l’icône d’état Batterie dans la barre des menus.
Le niveau affiché dépend de la quantité d’énergie restant dans la batterie, mais aussi 
des applications et des périphériques en cours d’utilisation, ainsi que des réglages de 
votre système (luminosité de l’écran, réglages d’Économiseur d’énergie, etc.). Pour 
disposer de plus d’énergie, fermez des applications, déconnectez les périphériques 
non utilisés et réglez Économiseur d’énergie (voir section suivante).
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Conseils pour économiser la batterie
L’autonomie assurée par la batterie de votre MacBook avant qu’il soit nécessaire de la 
recharger dépend des applications et des périphériques utilisés, ainsi que des mesures 
prises pour économiser l’énergie.
Pour économiser l’énergie de la batterie, procédez comme suit :
Â Déconnectez les périphériques USB ou FireWire alimentés par bus lorsqu’ils ne sont 
pas utilisés.
Â Quittez les applications ouvertes non utilisées.
Â Désactivez AirPort et Bluetooth quand vous ne les utilisez pas : utilisez les icônes 
d’état AirPort et Bluetooth dans la barre des menus. Si ces icônes n’apparaissent 
pas dans la barre des menus, vous pouvez les activer dans les fenêtres Réseau et 
Bluetooth des Préférences Système. 
Â Éjectez les CD ou DVD non utilisés.
Â Réduisez la luminosité de l’écran à l’aide des boutons de réglage de luminosité situés 
sur le clavier du MacBook.
Â Réglez le disque dur afin qu’il réduise sa vitesse de rotation après un bref délai. 
Dans la fenêtre Économiseur d’énergie des Préférences Système, sélectionnez 
l’option «Suspendre l’activité du/des disque(s) dur(s) chaque fois que possible». 
Â Réglez votre MacBook afin qu’il suspende son activité après un maximum de 
cinq minutes.
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Â Votre MacBook est préréglé pour réduire automatiquement sa vitesse de traitement 
durant les périodes de faible activité, lorsqu’il est alimenté via la batterie, afin d’économiser de l’énergie. Vous pouvez déterminez cela via l’option Normal du menu local 
Optimisation des réglages (situé dans la fenêtre Économiseur d’énergie des 
Préférences Système). Pendant les périodes de grande activité, votre ordinateur passera automatiquement à une vitesse de traitement plus élevée. Pour prolonger au 
maximum la durée de vie de la batterie, choisissez «Meilleure autonomie de la batterie» 
dans le menu local Optimisation des réglages. Cette option risque toutefois de diminuer les performances de votre ordinateur. Pour régler votre ordinateur afin qu’il utilise 
sa vitesse de traitement maximale en permanence, choisissez Meilleures performances.
Informations supplémentaires concernant la batterie de 
votre MacBook
De plus amples informations sont disponibles dans l’Aide Mac. Choisissez Aide > Aide Mac, 
puis effectuez une recherche sur le terme «batterie». Vous trouverez également des 
informations sur la manière de prolonger la durée de vie de votre batterie sur le site 
www.apple.com/fr/batteries/notebooks.html.
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Protection de votre MacBook
Vous pouvez vous procurer un câble de sécurité pour protéger votre MacBook. 
Ce câble vous permet d’attacher votre ordinateur à un bureau ou une table. 
Pour en savoir plus sur les options de sécurité
L’Aide Mac contient des informations supplémentaires concernant les fonctions de 
sécurité logicielles de votre MacBook, y compris les mots de passe pour plusieurs 
utilisateurs et le chiffrement de fichiers. Choisissez Aide > Aide Mac, puis effectuez 
une recherche sur les termes «sécurité» ou «utilisateurs multiples».
Dispositif de 
verrouillage
avec câble 
de sécurité
Logement 
de sécurité
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4
4 Ajout de mémoire à 
votre MacBook
Ce chapitre fournit des informations et des instructions pour installer de la mémoire supplémentaire 
et pour retirer et remettre en place la batterie de 
votre MacBook. 
Votre ordinateur est doté de deux logements de mémoire auxquels vous pouvez accéder 
en retirant sa batterie. Votre MacBook est fourni avec un minimum de 512 mégaoctets 
(Mo) de mémoire DDR2 (Double Data Rate) 667 MHz SDRAM (Synchronous Dynamic 
Random-Access Memory). Les deux logements de mémoire peuvent accueillir un module 
SDRAM conforme aux spécifications suivantes :
Â format DDR2 SO-DIMM (Double Data Rate Small Outline Dual Inline Memory Module) ;
Â taille inférieure à 3,8 cm ;
Â 256 Mo, 512 Mo ou 1 Go ;
Avertissement :  Apple vous recommande de confier l’installation de mémoire à un 
technicien agréé Apple. Consultez les informations sur l’assistance technique fournies 
avec l’ordinateur pour savoir comment joindre la société Apple. Tout dommage causé 
à votre matériel en tentant d’installer vous-même de la mémoire n’est pas couvert par 
la garantie limitée de votre ordinateur.
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Â 200 broches ;
Â mémoire RAM de type PC2-5300 DDR2 667 MHz.
Pour optimiser les performances, installez des modules mémoire de même type dans 
chaque logement. La quantité maximale de mémoire que vous pouvez installer sur votre 
MacBook est de 2 Go, en insérant une barrette DIMM de 1 Go dans chaque logement.
Installation de mémoire supplémentaire
Pour installer de la mémoire, il faut enlever et remettre en place la batterie. La procédure 
suivante inclut des instructions sur l’ajout de mémoire et la remise en place de la batterie.
Étape 1 :  retrait de la batterie
1 Éteignez votre MacBook. Débranchez l’adaptateur secteur, le câble Ethernet et tous 
les autres câbles connectés au MacBook afin d’éviter toute détérioration.
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2 Retournez le MacBook et repérez l’emplacement du verrou de la batterie. Utilisez une 
pièce de monnaie pour faire tourner le verrou d’un quart de tour vers la droite afin de 
débloquer la batterie, puis retirez cette dernière avec précaution.
Avertissement :  les composants internes de votre MacBook risquent d’être chauds. 
Si vous venez d’utiliser votre MacBook, attendez 10 minutes après l’extinction, afin de 
laisser aux composants internes le temps de se refroidir.
¥
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Étape 2 :  installation de mémoire
1 Desserrez les trois vis imperdables maintenant le support en L, tirez sur la barre la plus 
longue pour retirer le support et écartez celui-ci. 
Les leviers situés dans les logements de mémoire se soulèvent automatiquement 
lorsque vous retirez le support.
2 Touchez la surface métallique de l’intérieur de l’ordinateur afin de décharger toute 
électricité statique que vous pouvez avoir emmagasinée.
Desserrez les trois vis
Tirez sur cette barre
¥
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3 Pour retirer un module de mémoire installé dans un logement, placez le levier correspondant complètement vers la gauche jusqu’à ce que le bord du module de mémoire 
se soulève. Retirez le module de mémoire. Répétez l’opération avec l’autre module de 
mémoire.
Leviers
¥
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4 Insérez les nouveaux modules de mémoire dans les logements :
a Commencez par insérer le bord doré, avec l’encoche sur le côté gauche.
b Poussez fermement avec deux doigts sur les modules de mémoire pour les mettre en 
place. Vous devriez entendre un clic lorsque la mémoire s’enclenche.
c Si les leviers ne reviennent pas en position fermée, déplacez-les vers la droite pour 
les fermer.
Encoches
¥
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5 Replacez le support en L en insérant d’abord le bras le plus court, puis resserrez les vis.
Insérez  Resserrez les trois vis
d’abord 
ce bras
¥
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Étape 3 :  remplacement de la batterie
1 Placez le bord droit de la batterie dans son compartiment. Appuyez doucement sur 
le bord gauche de la batterie jusqu’à ce que le loquet soit bloqué.
2 Reconnectez l’adaptateur secteur et tout autre câble connecté auparavant à l’ordinateur.
¥
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Reconnaissance de la nouvelle mémoire par votre MacBook
Après avoir ajouté de la mémoire dans votre MacBook, vérifiez si elle est reconnue. 
Pour vérifier la mémoire de votre ordinateur :
1 Démarrez votre MacBook.
2 Lorsque le bureau Mac OS s’affiche, choisissez le menu Pomme (?) > À propos de ce Mac.
Pour plus de détails sur la mémoire installée sur votre ordinateur, ouvrez 
Informations Système en cliquant sur Plus d’infos puis sur Mémoire. 
Si votre ordinateur ne reconnaît pas la mémoire ou qu’il ne démarre pas correctement, 
éteignez-le et relisez les instructions afin de vous assurer que la mémoire est correctement installée et compatible avec votre MacBook. Si les problèmes persistent, retirez la 
mémoire et consultez les informations d’assistance technique fournies avec la mémoire 
ou contactez le fournisseur de la mémoire. 
Mémoire totale installée 
sur votre MacBook
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Si vous rencontrez un problème avec votre MacBook, 
commencez par rechercher ici des solutions et des 
conseils. 
Il existe généralement une solution simple et rapide aux problèmes que vous pourriez 
rencontrer au cours de l’utilisation de votre MacBook. Réfléchissez aux conditions qui 
ont entraîné l’apparition de ce problème. Ce récapitulatif de la totalité des opérations 
effectuées avant que le problème ne survienne permet de restreindre les causes possible 
et de trouver la solution. 
Notez les choses suivantes :
Â les applications que vous étiez en train d’utiliser quand le problème est apparu ; les 
problèmes qui n’apparaissent qu’avec une application spécifique peuvent indiquer 
que cette application n’est pas compatible avec la version de Mac OS installée sur 
votre ordinateur ;
Â les logiciels que vous avez installés récemment, notamment ceux qui ont ajouté des 
éléments à votre Dossier Système ;
Â tout composant matériel installé (mémoire supplémentaire ou périphérique, 
par exemple).
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Vous trouverez des informations supplémentaires concernant le dépannage dans 
l’Aide Mac et sur le site web de service et d’assistance Apple à l’adresse 
www.apple.com/fr/support.
Problèmes vous empêchant d’utiliser votre ordinateur
Si l’ordinateur ne répond plus ou que le pointeur se fige
Â Appuyez sur Commande (x) + Option + Échap pour forcer la fermeture d’une application figée. Sélectionnez l’application que vous souhaitez quitter dans le zone de 
dialogue qui apparaît, puis cliquez sur Forcer à quitter.
Enregistrez ensuite votre travail dans les applications ouvertes, puis redémarrez 
l’ordinateur afin de vous assurer que le problème est entièrement réglé. 
Â Si vous ne parvenez pas à forcer la fermeture d’une application, maintenez enfoncé 
le bouton d’alimentation (®) durant quelques secondes pour éteindre l’ordinateur.
Â Si l’ordinateur ne répond toujours pas, essayez de le redémarrer en appuyant simultanément sur le bouton d’alimentation (®) et les touches Commande (x) et Contrôle.
Si le problème survient fréquemment, choisissez Aide > Aide Mac dans la barre des menus 
en haut de l’écran. Recherchez le mot «bloquer» pour obtenir de l’aide en cas de blocage 
de l’ordinateur ou s’il ne répond pas.
Si le problème ne survient que lorsque vous utilisez une application particulière, vérifiez 
auprès de son éditeur si elle est compatible avec votre ordinateur. Si vous savez qu’une 
application est compatible, vous devrez peut-être réinstaller le logiciel système de 
votre ordinateur.
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Si l’ordinateur se bloque au démarrage, un point d’interrogation clignotant apparaît 
ou l’écran est éteint et la lampe témoin de suspension d’activité reste allumée (pas 
en mode de suspension d’activité)
Â Patientez quelques secondes. Si l’ordinateur ne démarre pas après un court instant, 
éteignez-le en maintenant le bouton d’alimentation (®) enfoncé pendant 5 secondes 
environ, jusqu’à ce qu’il s’éteigne complètement. Maintenez ensuite la touche Option 
enfoncée puis appuyez à nouveau sur le bouton d’alimentation (®) pour démarrer votre 
ordinateur. Lorsque votre ordinateur démarre, cliquez sur l’icône du disque dur, puis 
sur la flèche droite. Une fois que l’ordinateur a démarré, ouvrez Préférences Système et 
cliquez sur Démarrage. Sélectionnez un dossier Système Mac OS X.
Â Si cela ne donne pas de résultats, essayez d’utiliser Utilitaire de disque pour réparer 
le disque. Insérez le disque 1 d’installation de Mac OS X dans votre ordinateur. Redé-
marrez ensuite votre ordinateur en maintenant la touche C enfoncée lors du démarrage. Choisissez Installation > Ouvrir Utilitaire de disque. Lorsque Utilitaire de disque 
s’ouvre, suivez les instructions dans la fenêtre S.O.S pour tenter de le réparer.
Si Utilitaire de disque ne résout pas le problème, vous devrez peut-être réinstaller 
le logiciel système de votre ordinateur. Pour obtenir des instructions, consultez la 
section «Réinstallation des logiciels fournis avec votre ordinateur» à la page 106.
Si l’ordinateur ne s’allume ou ne démarre pas
Â Assurez-vous que l’adaptateur secteur est connecté à l’ordinateur et branché sur une 
prise secteur en état de marche. Veillez à utiliser l’adaptateur secteur fourni avec votre 
ordinateur. Si l’adaptateur secteur ne recharge plus l’ordinateur et que la lampe témoin 
de l’adaptateur secteur ne s’allume pas lorsque vous branchez le câble d’alimentation, 
essayez de le débrancher puis de le brancher à nouveau afin de le réinitialiser.
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Â Vérifiez si votre batterie à besoin d’être rechargée. Appuyez sur le petit bouton situé 
sur la batterie. Vous devriez voir apparaître un à quatre voyants indiquant le niveau 
de charge de la batterie. Si une seule lampe témoin de niveau de la batterie clignote, 
branchez l’adaptateur secteur pour charger la batterie jusqu’à ce qu’au moins une 
lampe témoin reste allumée en permanence.
Â Si vous avez suivi les deux premiers conseils sans succès, rétablissez les réglages par 
défaut de l’ordinateur en débranchant l’adaptateur secteur, en retirant la batterie et 
en maintenant le bouton d’alimentation (®) enfoncé pendant au moins 5 secondes. 
Â Si vous avez récemment ajouté de la mémoire, assurez-vous qu’elle est correctement 
installée et compatible avec votre ordinateur. Vérifiez si son retrait permet à l’ordinateur de démarrer (voir «installation de mémoire» à la page 92). 
Â Si cela ne fonctionne pas, appuyez sur le bouton d’alimentation (®) et maintenez 
immédiatement les touches Commande (x), Option, P et R enfoncées jusqu’à ce 
que vous entendiez une deuxième fois le signal sonore de démarrage. 
Â Si vous ne parvenez toujours pas à démarrer votre MacBook, consultez les informations 
sur service après-vente fournies avec votre MacBook pour savoir comment contacter 
Apple.
Si l’écran devient soudainement noir ou que votre système se bloque
Essayez de redémarrer votre ordinateur. 
1 Débranchez tout périphérique connecté à votre MacBook excepté l’adaptateur secteur.
2 Maintenez les touches Commande (x) et Contrôle enfoncées, puis appuyez sur le bouton 
d’alimentation (®) pour redémarrer le système.
3 Le niveau de charge de la batterie doit atteindre au moins 10 pour cent avant 
la connexion d’un périphérique et la reprise du travail. 
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Pour vérifier le niveau de charge de la batterie, observez le menu d’état Batterie dans 
la barre des menus.
Votre écran pourrait également s’assombrir si les fonctions d’économie d’énergie sont 
réglées pour l’utilisation de la batterie. Pour plus d’informations, consultez la section 
«Réglage de l’écran» à la page 30.
Autres problèmes
Si vous avez oublié votre mot de passe
Vous pouvez réinitialiser votre mot de passe d’administrateur et les mots de passe de 
tous les autres comptes.
1 Insérez le CD «Mac OS X Install Disc 1». Ensuite, redémarrez votre ordinateur et maintenez la touche C enfoncée pendant le démarrage.
2 Choisissez Installation > Réinitialiser le mot de passe dans la barre des menus. Suivez 
les instructions à l’écran.
En cas de problème avec une application
Â Pour les problèmes liés aux logiciels provenant d’éditeurs tiers, contactez l’éditeur 
concerné. Les éditeurs de logiciels fournissent souvent des mises à jour logicielles 
sur leurs sites web.
Â Vous pouvez configurer votre MacBook pour qu’il cherche et installe automatiquement les dernières mises à jour Apple via la fenêtre Mise à jour de logiciels des 
Préférences Système. Pour plus d’informations, choisissez Aide > Aide Mac, puis 
recherchez «mise à jour de logiciels».
Remarque :  les applications Classic (ou Mac OS 9) ne sont pas compatibles avec votre 
ordinateur et ne s’ouvriront pas.
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En cas de problèmes avec les communications sans fil AirPort Extreme
Â Vérifiez que l’ordinateur ou le réseau auquel vous souhaitez vous connecter est activé 
et dispose d’un point d’accès sans fil.
Â Assurez-vous que vous êtes bien dans la zone de couverture de l’antenne de l’autre 
ordinateur ou du point d’accès du réseau en vérifiant le menu d’état AirPort (Z) 
dans la barre des menus. Jusqu’à quatre barres de mesure apparaissent pour indiquer 
la puissance du signal.
Des appareils électroniques ou des structures métalliques se trouvant à proximité 
peuvent interférer avec les communications sans fil et réduire la portée de votre 
antenne. Vous pouvez éventuellement améliorer la réception en tournant et en 
réorientant l’ordinateur.
Â Assurez-vous que le logiciel est correctement configuré conformément aux instructions 
incluses avec votre borne d’accès ou point d‘accès.
Â Pour plus d’informations, consultez l’Aide AirPort (choisissez Aide > Aide Mac, puis 
Bibliothèque > Aide AirPort dans la barre des menus), ainsi que les instructions 
fournies avec votre appareil sans fil.
Si le disque dur de votre ordinateur n’enregistre pas les données correctement
Â Il peut arriver, dans certains cas très rares, qu’en raison de vibrations anormalement 
fortes subies par le disque dur, le capteur Sudden Motion Sensor s’active et provoque des pertes d’images ou des portions de son ou de données non enregistrées 
lorsque le disque est en train d’enregistrer de manière intensive. Si cela se produit, 
assurez-vous que votre MacBook est dans un environnement stable sans vibrations 
ni mouvements brusques.
Â Si les vibrations ne sont pas la source du problème, ouvrez Utilitaire de disque 
(dans /Applications/Utilitaires) pour vérifier le lecteur. 
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En cas de problème à l’éjection d’un disque
m Fermez toutes les applications susceptibles d’utiliser le disque et essayez à nouveau. 
Si cela ne donne pas de résultats, redémarrez l’ordinateur tout en maintenant le bouton 
du trackpad enfoncé.
Si vous suspectez un problème matériel
Â Vous pouvez utiliser l’application «Apple Hardware Test» pour déterminer s’il existe 
un problème dû à l’un des composants de votre ordinateur, tels que la mémoire ou 
le processeur.
Pour plus d’informations sur Apple Hardware Test, consultez la section «Utilisation 
d’Apple Hardware Test» à la page 108.
En cas de problèmes de connexion à Internet
Â Assurez-vous que votre ligne téléphonique ou que votre câble réseau est connecté 
et qu’il fonctionne correctement.
Â Si vous utilisez une connexion à Internet par ligne commutée, veillez à ce que votre 
câble téléphonique soit bien branché sur le modem USB d’Apple (vendu séparément) 
et non au port Ethernet (G) de l’ordinateur.
Â Ouvrez la fenêtre Réseau des Préférences Système et vérifiez auprès de votre Fournisseur 
d’Accès Internet (FAI) ou de votre administrateur réseau les informations qui y sont saisies.
En cas de problèmes de fonctionnement de votre ordinateur ou de Mac OS
Â Si les réponses à vos questions ne figurent pas dans ce manuel, choisissez Aide > 
Aide Mac dans la barre des menus et recherchez des instructions et des informations 
sur le dépannage.
Â Pour obtenir les dernières informations de dépannage et des mises à jour de logiciels, 
consultez le site web d’assistance Apple, à l’adresse www.apple.com/fr/support.
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Réinstallation des logiciels fournis avec votre ordinateur
Les disques d’installation de logiciels fournis avec votre ordinateur permettent de 
réinstaller Mac OS X et les applications livrées avec votre ordinateur.
Important :  Apple vous recommande de sauvegarder les données de votre disque dur 
avant de procéder à la restauration du logiciel. Apple décline toute responsabilité en 
cas de perte de données.
Installation de Mac OS X et des applications
Pour installer Mac OS X et les applications qui accompagnent votre ordinateur :
1 Sauvegardez vos fichiers essentiels.
Nous vous conseillons de sauvegarder vos fichiers essentiels avant d’installer Mac OS X 
et d’autres applications car l’option Effacer et installer efface votre disque de destination.
2 Assurez-vous que l’adaptateur secteur est correctement branché.
3 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur.
4 Double-cliquez sur «Install Mac OS X and Bundled Software».
5 Suivez les instructions à l’écran.
6 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. Il se peut que votre ordinateur redémarre et vous invite à insérer le disque 
d’installation Mac OS X suivant.
Remarque :  pour rétablir les réglages d’origine de Mac OS X sur votre ordinateur, 
cliquez sur Options dans la fenêtre Sélectionner une destination du programme 
d’installation, puis choisissez Effacer et installer. 
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Après avoir sélectionné le disque de destination de l’installation, continuez à suivre les 
instructions à l’écran pour effectuer une installation de base de Mac OS X. Pour personnaliser l’installation des applications, cliquez sur Personnaliser, cliquez sur le triangle en 
regard de l’application et sélectionnez la version que vous souhaitez installer.
Installation des applications
Pour installer uniquement les applications fournies avec votre ordinateur, veuillez 
procéder comme suit. Mac OS X doit déjà être installé sur votre ordinateur.
1 Sauvegardez vos fichiers essentiels.
2 Assurez-vous que l’adaptateur secteur est correctement branché.
3 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur.
4 Double-cliquez sur «Install Bundled Software Only».
5 Suivez les instructions à l’écran.
6 Après avoir sélectionné le disque de destination pour l’installation, suivez les instructions 
à l’écran. Il se peut que votre ordinateur redémarre et vous invite à insérer le disque 
d’installation Mac OS X suivant.
Remarque :  pour installer iCal, iChat AV, iSync, Safari et les applications iLife, suivez les 
instructions exposées dans «Installation de Mac OS X et des applications» à la page 106. 
Il est possible que vous deviez insérer le disque 2 d’installation de Mac OS X, selon les 
applications que vous souhaitez installer.
F3626M42.book  Page 107  Wednesday, April 5, 2006  2:17 PM108 Chapitre 5   Dépannage
Utilisation d’Apple Hardware Test
Apple Hardware Test vous aide à déterminer s’il existe un problème matériel sur votre 
ordinateur. 
Pour utiliser Apple Hardware Test :
1 Déconnectez tous les périphériques externes de votre ordinateur, sauf l’adaptateur 
secteur. Si un câble Ethernet est connecté, déconnectez-le.
2 Insérez le disque 1 d’installation de Mac OS X livré avec votre ordinateur. 
3 Redémarrez ensuite votre ordinateur en maintenant la touche D enfoncée lors du 
démarrage.
4 Lorsque l’écran principal d’Apple Hardware Test s’affiche, suivez les instructions à l’écran.
5 En cas de détection d’un problème, Apple Hardware Test affiche un code d’erreur. Notez 
le code d’erreur avant d’entreprendre les démarches d’assistance. Si Apple Hardware Test 
ne détecte pas de panne matérielle, il est probable que le problème soit lié aux logiciels.
Pour en savoir plus sur Apple Hardware Test, consultez le fichier «À propos d’AHT» sur 
le disque «Mac OS X Install Disc 1».
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Localisation du numéro de série de votre produit
Utilisez l’une des méthodes suivantes pour trouver le numéro de série de votre 
ordinateur :
Â Choisissez Apple (?) > À propos de ce Mac puis cliquez sur le numéro de version 
au-dessous des mots «Mac OS X». Cliquez pour afficher l’un après l’autre la version 
de Mac OS X, le numéro de sous-version et le numéro de série. 
Â Ouvrez Informations Système (dans /Applications/Utilitaires/), et cliquez sur Matériel. 
Vous pouvez également ouvrir Informations Système en cliquant sur le bouton Plus 
d’infos dans la zone de dialogue À propos de ce Mac.
Â Retirez la batterie. Le numéro de série de votre MacBook se trouve dans la baie de la 
batterie. Pour en savoir plus sur l’extraction de la batterie, consultez la section «retrait 
de la batterie» à la page 90 . 
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Vous pouvez utiliser Informations Système pour 
obtenir des informations détaillées sur votre MacBook.
Vous y trouverez entre autres la quantité de mémoire vive, la taille du disque dur, les 
périphériques connectés et le numéro de série du produit. Pour accéder au contenu 
des Informations Système, sélectionnez le menu Pomme (?) > À propos de ce Mac 
dans la barre des menus, puis cliquez sur Plus d’infos ou ouvrez Informations Système, 
situé dans /Applications/Utilitaires.
Dans la fenêtre qui s’ouvre, cliquez sur 
les triangles pour afficher ou cacher 
le contenu des différentes catégories.
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Conditions de fonctionnement
Â Température de fonctionnement :  10° C à 35° C
Â Altitude :  3 048 m maximum
Â Humidité relative :  de 0 % à 90 % sans condensation
Adaptateur secteur
Â Entrée :  100 à 240 Volts (V), 50/60 Hertz (Hz)
Â Sortie :  16,5 V à 3,65 A
Batterie
Â Sortie :  10,8 V 
Â Capacité :  55 Wh 
Des informations supplémentaires sont disponibles sur le site d’Apple aux pages 
www.apple.com/fr/macbook et www.apple.com/fr/support.
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B Consignes de sécurité, 
d’utilisation et d’entretien
Veuillez lire attentivement les consignes de sécurité 
et d’entretien suivantes concernant votre MacBook.
Les produits Apple sont conçus et évalués selon les standards de sécurité les plus 
récents de l’équipement des technologies de l’information. Cependant, pour assurer 
une utilisation sûre, il est important de suivre les consignes de sécurité indiquées sur 
le produit et dans la documentation.
Consignes générales de sécurité
Lisez et suivez toutes les consignes indiquées sur le produit et dans ce manuel avant 
d’utiliser votre MacBook. Gardez ces instructions dans un endroit facile d’accès pour 
vous et pour les utilisateurs éventuels.
Â Installez votre MacBook sur un plan de travail stable.
Â Évitez de placer votre ordinateur à proximité d’un évier, d’un lavabo, d’une baignoire 
ou d’une douche, par exemple.
Â Protégez votre ordinateur de l’humidité et des intempéries (neige, pluie, brouillard 
par exemple).
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Â Pour votre propre sécurité et celle de votre matériel, veillez à toujours prendre les 
précautions ci-après. Débranchez le cordon d’alimentation (en tirant sur la prise 
plutôt que sur le cordon), retirez la batterie et débranchez tous les autres câbles si 
l’un des cas suivants se présente :
Â Vous souhaitez installer de la mémoire.
Â Vous voulez retirer un ou plusieurs composants.
Â La prise ou le câble d’alimentation est endommagé.
Â Un liquide a été renversé dans le boîtier.
Â Votre ordinateur est exposé à la pluie ou à une humidité excessive.
Â Votre ordinateur a subi une chute ou le boîtier a été endommagé de quelque autre 
façon.
Â Vous pensez que votre ordinateur a besoin d’être inspecté ou réparé.
Â Vous souhaitez nettoyer le boîtier (pour ce faire, suivez à la lettre les instructions 
fournies plus bas).
Â Le port d’adaptateur secteur du MacBook contient un aimant. Ne mettez pas des 
matériaux ou des appareils à sensibilité magnétique à 25 mm ou moins de ce port.
Â N’introduisez jamais d’objets d’aucune sorte dans les ouvertures de ventilation de 
le MacBook.
Â La batterie du MacBook peut présenter un risque d’incendie ou de brûlure en cas de 
mauvais traitement. Ne la désassemblez pas, ne la chauffez pas au-delà de 100 º C 
et ne l’incinérez pas. Ne remplacez la batterie que par une batterie certifiée par Apple 
pour ce produit. L’utilisation de toute autre batterie peut présenter un risque d’incendie 
ou d’explosion. Éliminez rapidement les batteries usagées conformément aux directives 
d’environnement locales en vigueur.
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Configuration de votre MacBook et de l’adaptateur secteur
Assurez-vous que la fiche ou le câble d’alimentation CA est complètement inséré dans 
l’adaptateur secteur avant de brancher l’adaptateur sur la prise secteur. Pour un fonctionnement optimal, veillez à connecter l’adaptateur via le câble d’alimentation CA et 
à utiliser une prise secteur de terre.
Utilisez uniquement l’adaptateur secteur fourni avec votre MacBook. Les adaptateurs destinés à d’autres appareils électroniques (y compris à d’autres modèles de MacBook Pro et 
d’ordinateurs portables) peuvent sembler similaires, mais risquent d’avoir une incidence 
négative sur les performances de votre ordinateur, voire de l’endommager.
L’adaptateur secteur peut chauffer pendant l’utilisation normale de votre MacBook. 
Faites toujours en sorte que l’adaptateur soit correctement ventilé et soyez prudent 
lorsque vous le manipulez pendant ou immédiatement après l’avoir utilisé. Si possible, 
placez l’adaptateur secteur sur une surface plane et dure pour dissiper la chaleur.
Ne forcez jamais l’insertion d’un connecteur dans un port. Vérifiez la présence d’obstructions sur le port. Si le connecteur ne se raccorde pas facilement au port, c’est qu’ils 
sont probablement incompatibles. Assurez-vous que le connecteur correspond bien au 
port et que vous l’avez correctement positionné par rapport à ce dernier.
La présence de débris dans le port d’adaptateur secteur peut empêcher l’adaptateur 
secteur de se brancher correctement. Nettoyez doucement les débris avec une tige 
de coton ouaté.
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Utilisation de votre MacBook
Lorsque vous utilisez votre MacBook ou que vous rechargez la batterie, il est normal 
que la température du dessous du boîtier s’élève. En cas d’utilisation prolongée, placez 
votre MacBook sur une surface plane et stable. 
Ne laissez pas la partie inférieure de votre MacBook au contact de vos genoux ou de 
toute autre surface de votre corps de manière prolongée. Un contact étendu avec votre 
corps pourrait provoquer des douleurs et éventuellement des brûlures.
Cette partie du boîtier du MacBook sert de surface de refroidissement et permet d’évacuer la chaleur de l’ordinateur vers l’extérieur. Le dessous du boîtier est légèrement suré-
levé pour permettre la circulation d’air et assurer ainsi à l’équipement une température 
de fonctionnement normale. De plus, l’ordinateur dégage de l’air chaud des logements 
à l’arrière du boîtier.
Avertissement :  ne posez pas votre MacBook allumé sur un oreiller ou toute autre surface dans laquelle il pourrait s’enfoncer, car cela pourrait bloquer les conduites d’aération, en particulier les conduites arrière, et entraîner une surchauffe de l’ordinateur. 
Évitez également de placer des objets sur le clavier lors de l’utilisation avec écran 
rabattu. Cela risque de provoquer une succession d’arrêts et de mises en marche de 
votre ordinateur, entraînant une surchauffe et la décharge de la batterie. N’allumez 
jamais l’ordinateur tant que tous ses composants internes ou externes ne sont pas 
en place. L’utilisation de l’ordinateur lorsque son boîtier est ouvert ou que certains 
composants ont été démontés peut s’avérer dangereuse et risque de l’endommager.
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Transport de votre MacBook
Si vous transportez votre MacBook dans un sac ou dans un attaché-case, assurez-vous que 
ce dernier ne contient pas d’objets non attachés (tels que des trombones ou des pièces 
de monnaie) qui pourraient pénétrer accidentellement dans l’ordinateur par une ouverture telle que la fente du lecteur optique ou se coincer à l’intérieur d’un port. Maintenez 
également à l’écart du port de l’adaptateur secteur tout objet magnétiquement sensible.
Rangement de votre MacBook
Si vous décidez de ranger votre MacBook pendant une période de temps prolongée, 
placez-le dans un endroit frais (idéalement à 22 ° C) et prenez l’une des mesures 
suivantes afin de préserver la durée de vie de la batterie :
Â Déchargez la batterie à 50 pour cent avant de ranger votre MacBook.
Â Avant de ranger votre ordinateur pour une période de temps supérieure à cinq mois, 
déchargez la batterie jusqu’à environ 50 pour cent, puis retirez-la du MacBook. Si vous 
décidez de ranger votre ordinateur pour une période prolongée, pensez à recharger la 
batterie de 50 pour cent tous les six mois environ.
Nettoyage de votre MacBook
Respectez les consignes suivantes lors du nettoyage de votre ordinateur et de ses 
accessoires :
Â Éteignez votre MacBook, débranchez l’adaptateur secteur et retirez la batterie.
Â Pour nettoyer le boîtier de l’ordinateur, utilisez un chiffon doux, humide et non 
pelucheux. Évitez les infiltrations d’humidité par quelque ouverture que ce soit. 
Ne vaporisez jamais de liquide directement sur l’ordinateur.
Â N’utilisez ni aérosols, ni dissolvants, ni abrasifs qui pourraient endommager le fini.
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Nettoyage de l’écran de votre MacBook
Pour nettoyer l’écran de votre MacBook, procédez comme suit :
Â Éteignez votre MacBook, débranchez l’adaptateur secteur et retirez la batterie.
Â Humidifiez, à l’eau seulement, un chiffon propre, doux et non pelucheux et essuyez 
l’écran. Ne vaporisez jamais de liquide directement sur l’écran.
Comment éviter les problèmes auditifs
Informations se rapportant au laser
Avertissement :  l’utilisation d’écouteurs ou d’un casque d’écoute à un niveau de 
volume trop élevé peut provoquer une perte d’acuité auditive permanente. L’oreille 
peut s’adapter petit à petit à des volumes sonores de plus en plus élevés qui peuvent 
sembler normaux, mais qui risquent à la longue d’endommager votre système auditif. 
En cas de sifflements ou de perte d’acuité auditive, arrêtez d’utiliser le casque ou les 
écouteurs et consultez un médecin. Plus le volume est élevé, plus votre audition risque d’être affectée rapidement. Pour protéger votre système auditif, les spécialistes 
conseillent de prendre les mesures suivantes :
Â Limitez la durée d’utilisation à volume élevé de vos écouteurs ou de votre casque 
d’écoute.
Â Évitez d’augmenter le volume afin de bloquer les bruits environnants. 
Â Baissez le volume si vous ne parvenez pas à entendre une personne qui parle à côté 
de vous.
Avertissement :  l’exécution de réglages ou d’opérations qui ne sont pas spécifiés dans 
la manuel de votre équipement risque de vous exposer à des rayonnements dangereux. 
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N’essayez pas de démonter le boîtier qui contient le laser. Le faisceau laser utilisé dans 
ce produit est nocif pour les yeux. L’utilisation d’instruments optiques, tels que les loupes grossissantes, avec ce produit augmente les risques potentiels pour vos yeux. Afin 
d’assurer votre sécurité, cet équipement ne doit être réparé que par un fournisseur de 
services agréé Apple. 
Votre ordinateur est classé comme produit laser de Catégorie 1 à cause de son lecteur 
optique. L’étiquette de Catégorie 1, située dans un emplacement accessible à l’utilisateur, indique que le lecteur obéit aux exigences minimales de sécurité. Une étiquette 
de mise en garde destinée au réparateur est située dans un emplacement qui lui est 
accessible. Les étiquettes placées sur votre produit peuvent être légèrement différentes 
de celles qui sont affichées ici.
Avertissement relatif aux activités à haut risque
Cet ordinateur n’est pas conçu pour être utilisé dans des installations nucléaires, pour 
la navigation ou la communication aérienne, pour le contrôle du trafic aérien, ni dans 
aucune autre situation où une panne du système informatique pourrait entraîner la 
mort, des blessures ou de graves dommages écologiques.
Étiquette 
«Catégorie 1»
Étiquette de mise en garde 
destinée au réparateur
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Ergonomie
Voici quelques conseils sur la mise en place d’un environnement de travail sain.
Clavier et trackpad
Lorsque vous tapez au clavier ou que vous vous servez du trackpad, vos épaules 
doivent être détendues. Le bras et l’avant-bras doivent former un angle droit, la main 
étant placée dans le prolongement du poignet.
Vous devez avoir les mains et les doigts détendus lorsque vous tapez au clavier ou 
que vous utilisez le trackpad. Évitez de replier les pouces à l’intérieur des paumes.
Position
à éviter
Position
recommandée
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Modifiez fréquemment la position de vos mains pour éviter la fatigue. Après un travail 
continu et intensif sur ordinateur, certains utilisateurs peuvent ressentir des douleurs 
aux mains, aux poignets ou aux bras. Si ces douleurs persistent, consultez un spécialiste.
Siège
Optez pour un siège de bureau réglable et offrant un dossier et une assise confortables. Réglez la hauteur du siège de telle sorte que vos cuisses reposent à l’horizontale 
et vos pieds à plat sur le sol. Le dossier du siège doit soutenir votre région lombaire, 
c’est-à-dire la partie inférieure de votre dos. Suivez les instructions du fabricant de 
sorte que le réglage du dossier soit parfaitement adapté à votre morphologie.
Au besoin, relevez le siège de manière à ce que vos avant-bras et vos mains soient 
placés correctement par rapport au clavier. Si, dans ce cas, vos pieds ne reposent plus 
à plat sur le sol, utilisez un repose-pied inclinable et réglable en hauteur. Si vous disposez d’un bureau modulaire, vous pouvez abaisser le niveau du plan de travail pour 
éviter l’emploi d’un repose-pied. Une troisième solution consiste à utiliser un bureau 
dont le clavier est situé plus bas que le plan de travail.
Position
à éviter
Position
recommandée
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Souris externe
Si vous utilisez une souris externe, veillez à ce qu’elle se trouve à hauteur du clavier. 
Ménagez un espace suffisant pour la manipuler avec aisance.
Écran intégré
Orientez l’écran de manière à réduire le plus possible les reflets de l’éclairage électrique 
et de la lumière du jour. Ne forcez pas l’écran si vous rencontrez une résistance. L’angle 
d’ouverture maximal de l’écran ne peut dépasser 130 degrés.
Réglez la luminosité et le contraste de l’écran chaque fois que vous déplacez l’ordinateur 
ou que l’éclairage ambiant change.
Pour en savoir plus
Accédez au site web www.apple.com/about/ergonomics.
À propos d’Apple et de l’environnement
Apple Computer, Inc. reconnaît sa responsabilité en matière de réduction de l’impact 
de ses produits et de ses activités sur l’environnement. Pour en savoir plus, consultez 
la page www.apple.com/environment/summary.html.
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C Annexe
C Connexion à Internet
Votre ordinateur vous permet de naviguer sur le 
Web, d’échanger du courrier électronique avec vos 
amis et votre famille ou de dialoguer en temps réel 
via Internet. Utilisez ces informations pour vous 
aider à vous connecter à Internet.
Lors du premier démarrage de Mac OS X, Assistant réglages vous aide à saisir vos informations concernant la configuration Internet. Si vous n’avez pas utiliser Assistant réglages pour configurer votre connexion à Internet, vous pouvez utiliser Assistant réglages 
de Réseau plus tard (consultez «Utilisation d’Assistant réglages de réseau pour se connecter» à la page 127 ). Si vous choisissez de ne pas utiliser Assistant réglages de réseau, 
vous pouvez utiliser les informations figurant dans cette annexe pour configurer votre 
connexion manuellement.
Il existe quatre types de connexion à Internet :
Â connexion via un modem câble ou DSL à haut débit :  l’ordinateur est relié via 
un câble Ethernet à un modem spécial fourni par un FAI ;
Â connexion sans fil :  l’ordinateur est connecté sans fil via une borne d’accès 
AirPort Extreme, AirPort Express ou un autre point d’accès 802.11ou 802.11 ;
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Â réseau local (LAN) :  l’ordinateur est connecté à un réseau local via un câble Ethernet. 
C’est le type de connexion habituellement utilisé dans les entreprises.
Â connexion par ligne téléphonique :  l’ordinateur est connecté à un modem externe 
branché sur une prise téléphonique murale via un câble téléphonique.
Avant de vous connecter à Internet :
1 Ouvrez un compte auprès d’un fournisseur d’accès à Internet (FAI). 
2 Procurez-vous les informations concernant la connexion auprès de votre fournisseur 
d’accès à Internet ou de votre administrateur réseau. Consultez la section suivante 
«Regroupement des informations nécessaires», pour savoir quelles sont les informations dont vous avez besoin pour chaque type de connexion. Vous pouvez écrire ces 
informations directement sur les pages suivantes, puis les saisir dans Assistant réglages.
Si un autre ordinateur se trouvant au même emplacement est déjà connecté à Internet, 
vous pouvez probablement utiliser ses réglages. 
Pour accéder aux réglages sur un ordinateur Mac OS X :
Â Ouvrez la fenêtre Réseau des Préférences Système.
Â Dans le menu local Afficher, sélectionnez votre mode de connexion. 
Â Copiez les informations concernant votre connexion.
Pour accéder aux réglages d’un ordinateur Windows :
Les informations d’un PC Windows concernant la connexion se trouvent à deux endroits.
Â Pour rechercher l’adresse IP et le masque de sous-réseau, ouvrez le tableau de bord 
«Connexions Réseau et Internet».
Â Pour accéder aux informations relatives aux comptes d’utilisateurs, ouvrez le tableau de 
bord Comptes d’utilisateurs. 
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3 Si vous utilisez un modem externe, tel que le modem USB d’Apple (vendu séparément), 
branchez-le dans un port USB de votre MacBook, puis utilisez un câble téléphonique (non 
inclus) pour connecter le modem à une prise téléphonique murale. Si vous disposez d’un 
modem DSL ou câble, connectez-le à votre ordinateur en suivant les instructions incluses.
4 Allumez votre ordinateur et saisissez les informations dans Assistant réglages pour 
configurer votre connexion à Internet.
Remarque :  si vous avez déjà démarré votre ordinateur sans utiliser Assistant réglages 
pour configurer votre connexion à Internet, consultez «Utilisation d’Assistant réglages 
de réseau pour se connecter» à la page 127 .
Regroupement des informations nécessaires
Vous pouvez noter sur ces pages les informations obtenues auprès de votre FAI, de 
votre administrateur réseau ou récupérées sur un autre ordinateur, puis les saisir dans 
Assistant réglages de réseau.
Pour configurer une connexion téléphonique classique, procurez-vous les informations 
suivantes :
Â nom du fournisseur d’accès ;
Â nom d’utilisateur ou de compte ;
Â mot de passe ;
Â numéro de téléphone du FAI ;
Â autre numéro de téléphone ;
Â préfixe pour obtenir la ligne externe.
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Pour configurer un modem DSL, un modem câble, un réseau local (LAN) ou une 
connexion AirPort Extreme sans fil, choisissez votre méthode de connexion (en cas 
de doute, adressez-vous à votre administrateur système ou à votre FAI) :
Â manuellement ;
Â utilisation de DHCP (Dynamic Host Configuration Protocol, protocole de configuration 
dynamique d’hôte) avec une adresse manuelle ;
Â via DHCP ;
Â via BootP ;
Â PPP (Point-to-Point Protocol, protocole point à point).
En cas de doute sur la méthode à utiliser, l’option «Via DHCP» peut s’avérer un bon 
choix car le réseau fournit automatiquement la plupart des informations requises.
Si vous sélectionnez «Manuellement» ou «Via DHCP avec une adresse manuelle», 
rassemblez les informations suivantes :
Â adresse IP ;
Â masque de sous-réseau ;
Â adresse du routeur.
Remarque :  si vous sélectionnez «Utilisation de DHCP avec une adresse manuelle», 
vous n’avez pas besoin d’un masque de sous-réseau ou d’une adresse de routeur.
Si vous sélectionnez «Via DHCP», rassemblez les informations facultatives suivantes 
(demandez à votre FAI si c’est nécessaire) :
Â numéro de client DHCP ;
Â serveurs DNS.
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Si vous sélectionnez «PPPoE» (pour les connexions via PPP sur Ethernet ), rassemblez 
les informations suivantes :
Â fournisseur d’accès ;
Â nom de compte ;
Â mot de passe ;
Â nom de service PPPoE.
Les informations ci-dessous sont facultatives. Demandez à votre fournisseur d’accès à 
Internet ou à votre administrateur système si elles sont requises.
Â serveurs DNS ;
Â nom de domaine ;
Â serveur proxy.
Saisie de vos informations
Après vous être procuré les informations spécifiques concernant la configuration auprès 
de votre FAI ou de votre administrateur réseau, vous pouvez utiliser Assistant réglages 
de réseau pour vous connecter ou pour saisir les informations manuellement. 
Utilisation d’Assistant réglages de réseau pour se connecter
Si vous n’avez pas utilisé l’Assistant réglages pour configurer vos réglages Internet 
au premier démarrage de votre MacBook, vous pouvez utiliser l’Assistant réglages de 
réseau à tout moment pour configurer votre connexion à Internet ou pour modifier 
vos réglages. 
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Pour utiliser Assistant réglages de réseau :
1 Choisissez le menu Pomme (?) > Préférences Système.
2 Cliquez sur Réseau puis cliquez sur «Assistant». 
3 Cliquez sur Assistant pour lancer Assistant réglages de réseau.
4 Suivez les instructions à l’écran.
Pour plus d’informations sur la configuration d’une connexion à Internet, consultez 
l’Aide Mac. Choisissez Aide > Aide Mac puis recherchez «connexion à Internet».
Saisie manuelle de vos informations
Pour saisir vos informations manuellement :
1 Ouvrez Préférences Système > Réseau.
2 Faites votre sélection dans le menu local Afficher et réglez les options selon le type de 
connexion souhaité :
Â connexion par modem câble, modem DSL ou LAN en utilisant l’une de ces 
configurations :
Â manuellement :  dans le cas d’une configuration manuelle, votre FAI ou administrateur réseau vous indique une adresse IP statique et d’autres informations que vous 
devez saisir dans les Préférences réseau ;
Â utilisation du protocole DHCP (Dynamic Host Configuration Protocol) :  avec 
une configuration DHCP, le serveur DHCP saisit automatiquement les informations 
à votre place ;
Â utilisation du protocole PPPoE (Point-to-Point Protocol over Ethernet) :  si vous 
utilisez un modem DSL et que vous avez besoin d’un nom d’utilisateur et d’un mot 
de passe pour vous connecter à Internet, contactez votre FAI pour savoir si vous 
devez vous connecter via PPPoE ; 
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Â modem téléphonique externe avec connexion PPP (Point-to-Point Protocol) :  saisissez 
le nom et le mot de passe de votre compte, votre numéro de téléphone et les autres 
informations requises ;
Â connexion sans fil AirPort Extreme :  vous pouvez configurer votre réseau AirPort 
Extreme et votre connexion Internet via Assistant réglages AirPort, situé dans le 
dossier /Applications/Utilitaires. 
3 Cliquez sur «Assistant» pour obtenir une assistance supplémentaire. 
Dépannage de votre connexion
En cas de problèmes avec votre connexion à Internet, vous pouvez essayer les méthodes 
de cette section pour votre type de connexion ou vous pouvez utiliser Diagnostic réseau.
Pour utiliser Diagnostic réseau :
1 Choisissez le menu Pomme (?) > Préférences Système.
2 Cliquez sur Réseau puis cliquez sur «Assistant». 
3 Cliquez sur Diagnostic pour lancer Diagnostic réseau.
4 Suivez les instructions à l’écran.
Si Diagnostic réseau n’est pas en mesure de résoudre le problème, celui-ci se situe 
peut-être au niveau du fournisseur d’accès à Internet auquel vous essayez de vous 
connecter, du périphérique externe utilisé pour la connexion au fournisseur d’accès à 
Internet ou du serveur auquel vous essayez d’accéder. Vous pouvez également essayer 
les méthodes suivantes.
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Connexions à Internet par modem câble, modem DSL ou réseau 
local (LAN)
Si vous ne parvenez pas à vous connecter à Internet à l’aide de votre modem câble 
ou DSL ou via votre réseau local (LAN), suivez les instructions ci-après. 
Important :  les instructions relatives aux modems ne concernent pas les utilisateurs 
de réseau LAN. Contrairement aux utilisateurs de modems câble et de modems DSL, 
les utilisateurs de réseau LAN peuvent disposer de concentrateurs, commutateurs, 
routeurs et autres dispositifs de connexion. Ils doivent faire appel à leur administrateur 
réseau plutôt qu’à un FAI.
Vérifiez les câbles et les sources d’alimentation
Assurez-vous que tous les câbles du modem sont correctement branchés, y compris 
le câble d’alimentation du modem, le câble reliant le modem à l’ordinateur et le câble 
raccordant le modem à la prise murale. Vérifiez les câbles et l’alimentation des routeurs 
et des concentrateurs Ethernet. 
Éteignez puis rallumez le modem et réinitialisez les composants matériels du modem.
Éteignez votre modem DSL ou votre modem câble pendant quelques minutes, puis 
rallumez-le. Certains fournisseurs d’accès à Internet conseillent de débrancher le câble 
d’alimentation du modem. Si votre modem dispose d’un bouton de réinitialisation, 
vous pouvez l’actionner avant ou après avoir éteint puis rallumé le modem.
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Connexions PPPoE 
Si vous n’arrivez pas à vous connecter à votre fournisseur d’accès à Internet via PPPoE, 
commencez par vérifier les câbles et l’alimentation, puis éteignez le modem et rallumez-le et réinitialisez le matériel modem. Vérifiez ensuite vos réglages dans la fenêtre 
Réseau des Préférences Système.
Pour vérifier les réglages des Préférences Système :
1 Choisissez le menu Pomme (?) > Préférences Système dans la barre des menus.
2 Cliquez sur Réseau.
3 Dans le menu local Afficher, sélectionnez Configurations de ports réseau.
4 Sélectionnez Ethernet intégré, puis faites glisser cette configuration en haut de la liste 
des configurations de ports. 
5 Dans le menu local Afficher, sélectionnez Ethernet intégré.
6 Cliquez sur PPPoE. 
7 Sélectionnez Se connecter via PPPoE.
8 Vérifiez le champ Nom de compte pour vous assurer d’avoir tapé les informations 
correctes fournies par votre fournisseur d’accès à Internet. 
9 Si vous avez choisi d’enregistrer votre mot de passe, saisissez-le à nouveau afin d’être 
sûr qu’il est correct. 
10 Cliquez sur TCP/IP. Assurez-vous d’avoir saisi dans cette fenêtre les informations correctes 
fournies par votre fournisseur d’accès à Internet. 
11 Cliquez sur Appliquer.
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Connexions au réseau
Si vous disposez de plusieurs ordinateurs tentant de partager une connexion à Internet, 
assurez-vous que votre réseau est correctement configuré. Vous devez savoir si votre 
fournisseur d’accès à Internet fournit une adresse IP ou plusieurs (une pour chaque 
ordinateur).
Si une seule adresse IP est utilisée, vous devez disposer d’un routeur capable de partager la connexion (on parle alors de conversion d’adresse réseau (NAT) ou de masquage 
d’adresses IP). Pour obtenir des informations sur la configuration, consultez la documentation fournie avec votre routeur ou contactez la personne qui a configuré votre 
réseau. La borne d’accès AirPort Extreme peut être utilisée pour que plusieurs ordinateurs partagent une adresse IP. Pour obtenir plus d’informations sur l’utilisation de 
la borne d’accès AirPort Extreme, consultez l’aide à l’écran ou le site web AirPort, à 
l’adresse www.apple.com/fr/airportextreme.
Si ces instructions s’avèrent insuffisantes pour résoudre les problèmes rencontrés, 
contactez votre fournisseur d’accès à Internet.
F3626M42.book  Page 132  Wednesday, April 5, 2006  2:17 PM133
D Annexe
D Les dix questions principales
Une question ? Les dix questions les plus 
fréquemment posées par les nouveaux 
utilisateurs du MacBook sont les suivantes : 
Ma connexion Internet ne semble pas fonctionner. Comment la configurer ?
Il y a différents types de connexions Internet. Vous pouvez, par exemple, vous connecter via un modem, une connexion DSL, une connexion sans fil AirPort ou un réseau 
Ethernet. Vous devez saisir sous Mac OS X des informations spécifiques sur votre type 
de connexion, votre fournisseur d’accès Internet ou votre réseau. La première étape de 
configuration de votre connexion consiste à regrouper les informations requises pour 
votre type de connexion. Pour connaître les informations requises et savoir comment 
configurer votre type de connexion, consultez l’annexe C, «Connexion à Internet», à la 
page 123 . Votre ordinateur dispose également de l’application Assistant réglages pour 
vous aider à configurer votre connexion Internet. Ouvrez Préférences Système, puis 
cliquez sur Réseau. Cliquez sur le bouton d’assistance pour ouvrir Assistant réglages 
de réseau.
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Comment configurer mon imprimante ? Est-elle compatible avec mon MacBook ? 
Commencez par connecter votre imprimante et installer tous les logiciels en suivant les 
instructions incluses avec l’imprimante. Ensuite, ouvrez les Préférences Système, puis 
cliquez sur l’icône Imprimantes et fax. Utilisez la fenêtre Imprimantes et fax pour configurer votre MacBook de façon qu’il puisse utiliser l’imprimante. Vous trouverez de plus 
amples informations sur la configuration des imprimantes dans l’Aide Mac (choisissez 
Aide > Aide Mac dans la barre des menus, puis recherchez «imprimante»). Consultez 
également «Connexion à une imprimante» à la page 52. 
Si votre imprimante ne fonctionne pas comme prévu, consultez le site web du fabricant 
pour obtenir les gestionnaires d’imprimante mis à jour. La dernière version du logiciel 
d’imprimante est souvent disponible en téléchargement.
Si vous envoyez une tâche à votre imprimante et que celle-ci n’imprime pas, cliquez sur 
l’icône de l’imprimante dans le Dock pour vérifier si l’impression est interrompue ou 
si la tâche est en pause. (Si aucune icône n’apparaît dans le Dock, ouvrez Configuration 
d’imprimante dans le dossier /Applications/Utilitaires et double-cliquez sur le nom de 
l’imprimante.) Si la fenêtre de l’imprimante annonce «Tâche suspendue», cliquez sur 
le bouton Démarrer tâches. Si «Pause» apparaît à côté du nom de la tâche, reprenez 
l’impression en sélectionnant le nom de la tâche, puis en cliquant sur Reprendre. Si 
l’impression d’une tâche a été interrompue à la suite d’une erreur technique, effacez 
la tâche défectueuse en la sélectionnant et en cliquant sur Effacer. Essayer ensuite 
d’imprimer à nouveau la tâche.
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Comment fonctionne l’interface Mac OS X ?
Les utilisateurs qui découvrent Mac OS X se demandent souvent comment exécuter 
certaines tâches. L’ Aide Mac constitue la meilleure source d’informations sur Mac OS X. 
Elle comprend des explications préliminaires destinées aux nouveaux utilisateurs, aux 
utilisateurs Windows s’initiant à Mac OS X, ainsi qu’aux utilisateurs ayant effectué une 
mise à niveau de Mac OS 9. Ouvrez l’Aide Mac en choisissant Aide > Aide Mac dans la 
barre des menus du Finder, en haut de votre écran. Explorez les informations destinées 
aux nouveaux utilisateurs Mac OS X. La plupart des tâches élémentaires recherchées 
par l’utilisateur impliquent le Finder, essayez donc de rechercher «Finder» également.
Comment prolonger la longévité de la batterie de mon MacBook ?
N’oubliez pas d’étalonner votre batterie lors de la première utilisation (voir «Étalonnage 
de la batterie» à la page 26). Vous pouvez économiser l’énergie de la batterie en utilisant les options de la fenêtre des préférences Économiseur d’énergie pour spécifier 
quand l’ordinateur doit suspendre son activité et quand l’écran doit s’éteindre. Ouvrez 
Préférences Système et cliquez sur l’icône Économiseur d’énergie. Choisissez les réglages les mieux adaptés à votre mode d’utilisation. L’utilisation de périphériques, tels que 
les disques durs, qui tirent leur énergie de votre ordinateur, peut aussi contribuer à diminuer l’autonomie de votre batterie. Vous pouvez économiser l’énergie de la batterie 
en déconnectant ces appareils. Vous pouvez également vous procurer une batterie 
supplémentaire et la brancher sur votre ordinateur lorsque la batterie est faible. Pour 
obtenir plus d’informations sur les moyens d’économiser l’énergie de la batterie, 
consultez la section «Conseils pour économiser la batterie» à la page 85.
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J’ai inséré un disque dans le lecteur optique, mais rien ne se passe. Comment savoir 
si le disque est compatible avec mon lecteur optique ?
Appuyez sur la touche d’éjection de disque (C) pour éjecter le disque. Les lecteurs optiques 
à chargement par fente Apple ne prennent en charge que des disques circulaires de 12 cm. 
Les disques non standard et les disques n’ayant pas une forme circulaire ne fonctionnent 
pas avec le lecteur optique. Pour plus d’informations sur les disques non standard, accédez 
au site d’assistance et de service Apple à l’adresse www.apple.com/fr/support, puis recherchez «disques non standard».
Comment connecter un moniteur externe, un téléviseur ou un projecteur à mon 
MacBook ?
1 Allumez l’écran externe ou le projecteur.
2 Vérifiez que le câble de l’écran est bien relié au projecteur ou à l’écran externe.
3 Connectez le câble du moniteur à votre MacBook à l’aide du câble adéquat.
a Si vous connectez un périphérique externe via une connexion DVI, utilisez l’adaptateur 
Mini-DVI vers DVI d’Apple (vendu séparément).
b Si vous connectez un périphérique externe via une connexion VGA, utilisez l’adaptateur 
Mini-DVI vers VGA d’Apple (vendu séparément).
c Si vous connectez un périphérique externe via une connexion S-vidéo, utilisez 
l’adaptateur Mini-DVI vers Vidéo Apple (vendu séparément).
Votre MacBook détecte automatiquement le moniteur externe, le téléviseur ou 
le projecteur.
Avertissement :  l’insertion d’un disque non standard peut endommager le lecteur.
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4 Réglez la résolution de l’écran externe via la fenêtre Moniteurs des Préférences Système 
ou le menu d’état Moniteurs de la barre de menus.
Pour obtenir plus d’informations sur la connexion d’écrans et autres périphériques, 
consultez «Gestion de la vidéo externe» à la page 71.
J’ai oublié mon mot de passe. Comment le réinitialiser ?
Pour réinitialiser votre mot de passe, démarrez à partir du disque d’installation de logiciels fourni avec votre ordinateur. Une fois le programme d’installation ouvert, sélectionnez Installation > «Réinitialiser le mot de passe» dans la barre des menus. Suivez 
les instructions à l’écran.
J’entends un ventilateur se déclencher et la température de mon MacBook semble 
augmenter. Est-ce normal ?
Votre MacBook est conçu pour fonctionner dans le cadre de limites thermiques sûres. Le 
ventilateur se déclenche et fonctionne pour maintenir le MacBook à des températures 
normales lorsqu’il est en activité. La partie inférieure de votre MacBook peut s’échauffer 
car elle sert à évacuer la chaleur du boîtier. Il s’agit d’un comportement tout à fait normal. 
Pour plus d’informations, consultez la section «Utilisation de votre MacBook» à la page 116.
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Une application ou Mac OS X semble ne pas fonctionner correctement. Dois-je 
réinstaller Mac OS X ?
Le processus de dépannage d’un problème demande que vous répondiez à plusieurs 
questions, notamment si le problème survient toujours avec une application spécifique, 
s’il est lié au système d’exploitation ou s’il est dû à un matériel défectueux. Avant de 
réinstaller, consultez la section «Dépannage» à la page 99 pour vous aider à analyser le 
problème. Apple fournit également de nombreuses explications et des conseils techniques de résolution de problèmes sur le site d’assistance et de service Apple, à l’adresse 
www.apple.com/fr/support. Si vous constatez qu’une réinstallation de Mac OS X 
s’impose, vous trouverez toutes les instructions nécessaires dans la section «Réinstallation 
des logiciels fournis avec votre ordinateur» à la page 106.
J’ai installé une application sur mon MacBook, mais elle ne semble pas fonctionner. 
Où trouver de l’aide ?
Vérifiez la documentation fournie avec l’application pour savoir comment obtenir de 
l’assistance. Les fabricants sont souvent conscients des problèmes courants susceptibles 
de survenir avec leurs applications et fournissent des solutions et des mises à jours à 
usage immédiat. Si votre application n’est pas un produit Apple, contactez directement 
l’éditeur concerné afin d’obtenir une assistance adaptée.
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Communications Regulation Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions:  (1) 
This device may not cause harmful interference, and (2) 
this device must accept any interference received, 
including interference that may cause undesired 
operation. See instructions if interference to radio or 
television reception is suspected.
L’utilisation de ce dispositif est autorisée seulement aux 
conditions suivantes : (1) il ne doit pas produire de 
brouillage et (2) l’utilisateur du dispositif doit étre prêt à 
accepter tout brouillage radioélectrique reçu, même si 
ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed and 
used properly—that is, in strict accordance with Apple’s 
instructions—it may cause interference with radio and 
television reception. 
This equipment has been tested and found to comply 
with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These 
specifications are designed to provide reasonable 
protection against such interference in a residential 
installation. However, there is no guarantee that 
interference will not occur in a particular installation. 
You can determine whether your computer system is 
causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of 
the peripheral devices. 
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops. 
Â Move the computer to one side or the other of the 
television or radio. 
Â Move the computer farther away from the television or 
radio. 
Â Plug the computer in to an outlet that is on a different 
circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on 
circuits controlled by different circuit breakers or 
fuses.) 
If necessary, consult an Apple-authorized service 
provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician for 
additional suggestions. 
Important:  Changes or modifications to this product 
not authorized by Apple Computer, Inc., could void the 
EMC compliance and negate your authority to operate 
the product.
This product has demonstrated EMC compliance under 
conditions that included the use of compliant peripheral 
devices and shielded cables between system 
components. It is important that you use compliant 
peripheral devices and shielded cables between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices.
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Responsible party (contact for FCC matters only):  
Apple Computer, Inc. Product Compliance, 
1 Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 
408-974-2000.
Wireless Radio Use
This device is restricted to indoor use due to its 
operation in the 5.15 to 5.25 GHz frequency range to 
reduce the potential for harmful interference to cochannel Mobile Satellite systems.
Cet appareil doit être utilisé à l’intérieur.
Exposure to Radio Frequency Energy
The radiated output power of the AirPort Extreme 
technology is below the FCC radio frequency exposure 
limits. Nevertheless, it is advised to use the wireless 
equipment in such a manner that the potential for 
human contact during normal operation is minimized.
FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be 
collocated or operated in conjunction with any other 
antenna or transmitter subject to the conditions of the 
FCC Grant.
Bluetooth Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment regulations.
Cet appareil numérique de la Classe B respecte toutes 
les exigences du Règlement sur le matériel brouilleur 
du Canada.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B 
specifications. Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada. This device 
complies with RSS 210 of Industry Canada.
Bluetooth Europe–EU Declaration of Conformity
This wireless device complies with the specifications 
EN 300 328, EN 301-489, and EN 60950 following the 
provisions of the R&TTE Directive.
Europe - EU Declaration of Conformity
The equipment complies with the RF Exposure 
Requirement 1999/519/EC, Council Recommendation of 
12 July 1999 on the limitation of exposure of the general 
public to electromagnetic fields (0 Hz to 300 GHz). This 
equipment meets the following conformance standards:
EN300 328, EN301 893, EN301 489-17, EN60950
Par la présente Apple Computer, Inc. déclare que 
l’appareil 802.11a/b/g Mini-PCIe card est conforme aux 
exigences essentielles et aux autres dispositions 
pertinentes de la directive 1999/5/CE.
Complies with European Directives
72/23/EEC, 89/336/EEC, 1999/5/EC
See http://www.apple.com/euro/compliance
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Korea Statements
Singapore Wireless Certification
Taiwan Wireless Statements
Taiwan Class B Statement
VCCI Class B Statement
Informations sur les modems USB externes
Si vous connectez votre MacBook à une ligne 
téléphonique par le biais d’un modem USB externe, 
veuillez vous reporter aux informations fournies par 
l’agence de télécommunications mentionnées dans 
la documentation livrée avec votre modem. 
ENERGY STAR®
 Compliance
As an ENERGY STAR®
 partner, Apple has determined that 
standard configurations of this product meet the 
ENERGY STAR®
 guidelines for energy efficiency. The 
ENERGY STAR®
 program is a partnership with office 
product equipment manufacturers to promote energyefficiency. Reducing energy consumption of office 
products saves money and reduces pollution by 
eliminating wasted energy.
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Informations sur l’élimination et le recyclage
La lampe du rétro-éclairage interne à ce produit 
contient du mercure. Elle doit être recyclée ou traitée 
conformément à la législation locale, nationale 
et fédérale. Pour vous informer sur le programme 
de recyclage d’Apple, rendez-vous sur le site 
www.apple.com/environment/summary.html
Informations sur l’enlèvement de la batterie
Disposez des batteries conformément aux directives 
d’environnement locales en vigueur.
Deutschland: Das Gerät enthält Batterien. Diese gehören 
nicht in den Hausmüll. Sie können verbrauchte Batterien 
beim Handel oder bei den Kommunen unentgeltlich 
abgeben. Um Kurzschlüsse zu vermeiden, kleben Sie die 
Pole der Batterien vorsorglich mit einem Klebestreifen 
ab.
Nederlands:Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) worden 
gedeponeerd.
Taïwan:
Union européenne—instructions concernant 
l’élimination des déchets :
Le symbole ci-dessus signifie que vous devez vous 
débarrasser de votre produit sans le mélanger avec les 
ordures ménagères, selon les normes et la législation 
de votre pays. Lorsque ce produit n’est plus utilisable, 
portez-le dans un centre de traitement des déchets 
agréé par les autorités locales. Certains centres 
acceptent les produits gratuitement. Le traitement 
et le recyclage séparé de votre produit lors de son 
élimination aideront à préserver les ressources naturelles 
et à protéger l’environnement et la santé des êtres 
humains.
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Deux doigts 
d’astuces
Démarrage
Bienvenue dans l’univers iPhone. Ce guide de 
démarrage rapide vous présente comment 
con?gurer votre iPhone et utiliser ses 
fonctionnalités principales. Une fois prêt à 
pro?ter de votre iPhone, vous pouvez obtenir 
plus d’informations à son sujet en visitant la page 
web www.apple.com/fr/iphone.
À vos marques, configurez, partez !
1. Téléchargement d’iTunes. 
Rendez-vous sur 
www.apple.com/fr/itunes/download et 
téléchargez la dernière version d’iTunes à 
installer sur votre Mac ou PC.
2. Connexion à votre ordinateur.
Connectez votre iPhone au port USB de votre
ordinateur.
3. Synchronisation.
Lorsque l’iPhone est connecté, iTunes s’ouvre et 
vous guide dans l’installation. Sélectionnez les 
contacts, les calendriers, la musique, les vidéos 
et les photos que vous souhaitez synchroniser, 
puis cliquez sur Appliquer dans l’angle droit 
inférieur. Si vous n’avez jamais utilisé iTunes 
ou que vous souhaitez vous informer sur 
la synchronisation, vous pouvez consulter 
un guide d’initiation rapide disponible sur 
www.apple.com/fr/itunes/tutorials.
Effectuer un appel.
Pour effectuer un appel, touchez un numéro de 
téléphone dans Contacts, Favoris, une adresse 
électronique, un message écrit ou tapotez sur 
n’importe quelle zone de l’iPhone. Ou touchez 
le bouton du clavier numérique pour marquer 
un numéro manuellement. Pour répondre à un 
appel alors que vous utilisez les écouteurs de 
l’iPhone, appuyez une fois sur le bouton central. 
Appuyez à nouveau dessus pour mettre ?n à 
l’appel. 
Agrandir pour modifier le texte.
Touchez le texte que vous voulez modi?er. Pour 
replacer le point d’insertion, touchez le mot et 
maintenez votre doigt dessus pour afficher la 
loupe. Faites glisser votre doigt pour déplacer 
le point d’insertion puis modi?ez ce dernier en 
utilisant le clavier. 
Envoi de messages.
Touchez l’icône Messages. Écrivez un nom ou 
un numéro de téléphone dans le champ À ou 
sélectionnez une personne dans vos contacts. 
Écrivez votre message puis tapotez sur Envoyer. 
Pour envoyer des photos, touchez le bouton 
Appareil photo. Pour effacer ou réexpédier 
l’ensemble ou une partie d’un message, touchez 
Modi?er. Pour supprimer une conversation 
entière dans votre liste de messages, tapotez 
dessus avec votre doigt puis touchez Supprimer.
Configuration d’un compte de messagerie.
Pour con?gurer un compte de messagerie 
directement depuis votre iPhone, touchez 
Ajouter un compte dans les réglages de 
messagerie. Puis, tapotez sur le type de 
compte que vous souhaitez ou touchez Autre 
pour procéder à la con?guration de la plupart 
des comptes POP3 ou IMAP. Les réglages de 
compte de messagerie peuvent aussi être 
synchronisés avec votre Mac ou PC par le biais 
d’iTunes.
Bouton Marche/Veille.
Pour allumer l’iPhone, appuyez fermement sur 
le bouton Marche/Veille. Pour éteindre ou 
redémarrer l’iPhone, maintenez le bouton 
Marche/Veille enfoncé, puis faites glisser pour 
con?rmer. Pour mettre l’iPhone en mode veille, 
appuyez une fois sur le bouton Marche/Veille. 
Cela a pour effet d’éteindre l’écran tout en 
permettant à l’iPhone de recevoir des appels. 
Pour mettre en silence un appel entrant, 
appuyez une fois. Pour renvoyer un appel vers 
la messagerie vocale, appuyez deux fois. 
Accueil.
Lorsque vous utilisez une application, appuyez 
sur le bouton principal pour fermer celle-ci et 
revenir à l’écran d’accueil. Appuyez à nouveau 
sur le bouton principal pour revenir à votre écran 
d’accueil principal. Durant un appel, vous pouvez 
accéder à votre courrier électronique, votre 
calendrier ou aux autres applications et même 
naviguer sur le web, dans la mesure où vous êtes 
connecté via Wi-Fi ou 3G. Double-cliquez sur le 
bouton principal chaque fois que vous voulez 
accéder à vos Favoris. Double-cliquez sur le 
mode veille pour afficher les contrôles de l’iPod.
Clavier intelligent.
L’iPhone corrige et suggère des mots 
automatiquement au fur et à mesure que vous 
écrivez. Donc, si vous saisissez une lettre erronée, 
continuez à écrire. Pour accepter le mot suggéré, 
touchez la barre d’espace. Touchez le « x » pour 
refuser le mot suggéré. Le clavier apprend les 
mots que vous écrivez. Il insère également les 
apostrophes dans les contractions à votre place. 
Pour activer le clavier numérique et celui des 
symboles, tapotez la touche « .?123 ». Touchez 
deux fois la barre d’espace pour ajouter un point.
Couper, copier et coller.
Lors de la saisie, tapotez deux fois sur un mot 
pour le sélectionner. Faites glisser les points de 
capture pour sélectionner plus ou moins de texte, 
puis tapotez sur couper, copier ou coller. Pour 
copier un texte depuis des pages web, courriers 
électroniques ou messages de texte, touchez et 
maintenez votre doigt sur le texte sélectionné. 
Pour annuler une modi?cation, remuez l’iPhone 
puis tapotez sur le bouton Annuler.
Sonnerie/
Silencieux
Volume 
Augmenter/
Diminuer
Marche/
Veille 
Suspendre/
Réactiver
Barre d’état
Accueil
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Voir une page web de plus près.
Tapotez deux fois sur un élément d’une page 
web (image ou texte) pour l’agrandir. Tapotez 
à nouveau deux fois pour revenir à la taille 
normale. Touchez le bouton Multi-page pour 
feuilleter plusieurs pages web ou en ouvrir une 
nouvelle. Faites pivoter l’iPhone pour visualiser 
la page web au format grand écran.
Rechercher un lieu. Effectuer des recherches 
dans les environs.
Pour situer où vous vous trouvez sur une carte, 
touchez le bouton Localisation. Un cercle bleu 
ou un point apparaît, signalant votre position à 
cet instant. Recherchez des lieux précis dans les 
alentours en écrivant des mots comme 
« Starbucks » ou « pizza » dans le champ de 
recherche. Tapotez deux fois pour activer le 
zoom. Tapotez une fois avec deux doigts pour 
désactiver le zoom.
Contrôles de vidéo et de morceaux.
Touchez l’écran pour afficher les contrôles à 
l’écran. Touchez-le à nouveau pour les masquer. 
Le fait de tapoter deux fois sur une vidéo 
permet de passer d’un affichage grand écran 
à un affichage plein écran. Lors de l’écoute de 
morceaux de musique avec les écouteurs sans 
?l, appuyez sur le bouton central une fois pour 
mettre en pause ou en lecture, et appuyez 
rapidement deux fois pour passer au morceau 
suivant. 
Perfectionner ses connaissances.
Vous pouvez regarder des démonstrations 
et perfectionner vos connaissances sur les 
fonctionnalités de l’iPhone en vous rendant 
sur la page web www.apple.com/fr/iphone.
Pour lire le Guide de l’utilisateur de 
l’iPhone sur votre iPhone, rendez-vous 
sur help.apple.com/iphone ou dans les 
signets de Safari. Pour obtenir des versions 
téléchargeables du Guide de l’utilisateur 
de l’iPhone et du Guide d’informations 
importantes sur le produit, visitez 
www.apple.com/fr/support/iphone.
Obtenir de l’assistance.
Contactez votre fournisseur de service sans ?l 
pour obtenir une assistance sur les services 
liés au réseau, y compris la messagerie vocale 
visuelle et la facturation.*
 Rendez-vous sur 
www.apple.com/fr/support/iphone pour 
obtenir une assistance technique sur l’iPhone 
et iTunes.
Parcours de votre musique dans Cover Flow.
Faites pivoter votre iPhone pour faire dé?ler vos 
pochettes d'albums dans Cover Flow. Tapotez 
sur n’importe quel album pour visualiser sa liste 
de pistes, puis touchez-en une pour l’écouter. 
Tapotez à l’extérieur de la liste de pistes pour 
revenir à la pochette de l’album.
Recherche avec Spotlight.
Pour utiliser la recherche Spotlight, allez à l’écran 
d’accueil et appuyez sur le bouton Accueil ou 
passez le doigt sur l’écran de gauche à droite. 
Écrivez ce que vous voulez rechercher (un 
nom, un mot clé, une chanson, un artiste ou 
le titre d’un ?lm). L’iPhone vous propose des 
suggestions au fur et à mesure que vous écrivez 
pour accélerer encore plus votre recherche. Pour 
lancer des recherches depuis une application 
comme Mail, Contacts ou iPod, touchez la barre 
d’état. 
Obtenir des itinéraires.
Dans Plans, tapotez sur Itinéraires puis saisissez 
les points de départ et d’arrivée. Vous pouvez 
utiliser votre lieu actuel, saisir une adresse ou 
en sélectionner une depuis vos contacts ou 
des emplacements placés dans les signets. 
Touchez Itinéraire pour afficher les itinéraires 
de conduite. Touchez le bouton Marche pour 
obtenir les itinéraires à pied, ou Bus pour afficher 
les itinéraires et horaires des bus. L’iPhone peut 
suivre et afficher votre progression le long de 
n’importe quel itinéraire que vous suivez.
Voir des photos.
Chargez vos photos favorites dans l’iPhone 
depuis votre ordinateur en utilisant iTunes, ou 
utilisez l’appareil photo intégré pour prendre 
des photos. Passez le doigt sur l’écran vers la 
droite ou la gauche pour vous déplacer entre les 
images. Tapotez deux fois pour activer le zoom. 
Tapotez une fois pour afficher les contrôles 
à l’écran. Tapotez sur le bouton Action pour 
envoyer une photo dans un MMS ou un courrier 
électronique, pour l'utiliser comme fond d’écran 
ou pour l’assigner à un contact.
Accéder à l’App Store.
Tapotez sur l’icône App Store pour naviguer sans 
?l parmi des dizaines de milliers d’applications 
pouvant être regroupées sous les catégories 
jeux, travail, voyage, réseaux sociaux, etc. 
Parcourez-les par Sélection, Genres ou Top 25, 
ou lancez une recherche par nom. Pour acheter 
et télécharger une application directement 
sur votre iPhone, touchez Acheter. Beaucoup 
d’applications sont gratuites.
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Leia este capítulo para obter informações sobre os recursos do iPad, sobre como usar 
os controles e outros temas.
 Visão Geral do
Tela Multi-Touch
Barra de estado
Início
Câmera frontal
Ícones de 
aplicativos
Alto-falante
Bandeja Micro-SIM
(em alguns modelos)
Microfone Tomada do fone 
de ouvido
Botões 
de volume
Interruptor 
Lateral
Repouso/
Despertar
Conector Dock
Câmera
posterior
1
Visão Geral Acessórios
Adaptador de alimentação  Cabo de Conector Dock a USB
USB de 10 W
Item O que você pode fazer com ele
Adaptador de alimentação USB de 10 W Use o adaptador de alimentação USB de 10 W 
para ligar o iPad à corrente elétrica e carregar a 
bateria.
Cabo de Conector Dock a USB Use este cabo para conectar o iPad ao seu computador para sincronizar, ou ao adaptador de 
alimentação USB de 10 W para carregá-lo. Use o 
cabo com o Dock opcional do iPad ou conecte-o 
diretamente ao iPad.
Botões
Alguns botões simples facilitam a ativação e desativação do iPad e o ajuste do volume. 
Botão Repousar/Despertar
Você pode bloquear o iPad colocando-o no modo de repouso quando não o estiver 
usando. Quando você bloqueia o iPad, não acontece nada ao tocar a tela, mas a música continua tocando e você pode usar os botões de volume.
Botão Repousar/
Despertar
Bloquear a tela do iPad Pressione o botão Repousar/Despertar.
Para desbloquear o iPad Pressione o botão Início  ou o botão Repousar/
Despertar e depois arraste o controle deslizante.
Para desligar o iPad Mantenha pressionado o botão Repousar/
Despertar por alguns segundos até que o controle deslizante vermelho apareça, depois arraste o 
controle.  
Ligar o iPad Mantenha pressionado o botão Repousar/
Despertar até que o logotipo da Apple apareça.
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Se você não tocar na tela por um minuto, o iPad se bloqueia automaticamente. Para alterar este ajuste, consulte “Bloqueio Automático” na página 173. Se você deseja utilizar 
uma senha para desbloquear o iPad, consulte “Bloqueio por Código” na página 173.
Você pode usar o Smart Cover do iPad, disponível separadamente, para desbloquear 
automaticamente o iPad 2 quando abrir a capa e bloquear o iPad 2 quando fechá-la. 
Consulte “Bloqueio/Desbloqueio da capa do iPad” na página 174.
Botões de Volume
Use os botões de volume para ajustar o volume de áudio das músicas e de outras mí-
dias, e dos avisos e efeitos sonoros.
Botões de
volume
Interruptor
Lateral
Para aumentar o volume Pressione o botão Aumentar Volume. Para definir 
um limite de volume para música e outras mídias, 
escolha iPod > Limite de Volume.
Para diminuir o volume Pressione o botão Diminuir Volume.
Para silenciar o som Mantenha pressionado o botão Diminuir Volume 
para silenciar o áudio ou a reprodução de vídeo. 
Suprimir notificações e efeitos sonoros Deslize o interruptor lateral para baixo para 
silenciar as notificações e efeitos sonoros. Este 
interruptor não silencia o áudio ou a reprodução 
de vídeo. Consulte “Sons” na página 171.
Você também pode usar o interruptor lateral para bloquear a rotação da tela. Em 
Ajustes, escolha Geral > Usar Interruptor Lateral… e, em seguida, toque em Bloquear 
Rotação. Consulte “Interruptor Lateral” na página 176.
ADVERTÊNCIA: Para obter informações importantes sobre como evitar a perda 
de audição, consulte o Manual de Informações Importantes do Produto iPad no site 
support.apple.com/pt_BR/manuals/ipad. Bandeja do cartão Micro-SIM
O cartão micro-SIM em alguns modelos do iPad Wi-Fi + 3G é usado para dados de 
celular. Também é conhecido como um SIM 3FF (third form factor). Se o seu cartão 
micro-SIM não tiver sido pré-instalado ou se você mudar de provedor de dados de celular, talvez tenha que instalar ou substituir o cartão micro-SIM.
Ferramenta 
de ejeção 
do SIM
Cartão Micro-SIM
Bandeja 
SIM
Para abrir a bandeja do SIM:
1 Introduza a ponta da ferramenta de ejeção do SIM no orifício da bandeja do SIM. 
Pressione com firmeza, empurrando para dentro até que a bandeja salte para fora. Se 
você não tiver uma ferramenta de ejeção do SIM, use a ponta de um clipe de papel.
2 Puxe a bandeja do SIM para instalar ou substituir o cartão micro-SIM.
Para obter mais informações, consulte “Como conectar-se a uma Rede de Dados de 
Celular ” na página 31.
Tela de Início
Pressione o botão Início  a qualquer momento para ir para a tela Início, que contém 
os aplicativos do seu iPad. Toque em qualquer ícone para abrir o aplicativo.
Ícones de Estado
Os ícones da barra de estado situada na parte superior da tela fornecem informações 
sobre o iPad:
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Ícone de estado O que significa
Modo Avião Mostra que o modo avião está ativado—você 
não pode acessar a Internet, ou utilizar dispositivos Bluetooth®. Os recursos que não utilizam uma conexão sem fio estão disponíveis. 
Consulte “Modo Avião” na página 166.
3G Mostra que a rede 3G da sua operadora (iPad 
Wi-Fi + 3G) está disponível e que você pode 
conectar-se à Internet via 3G. Consulte “Como 
Conectar-se à Internet” na página 30.
EDGE Mostra que a rede EDGE da sua operadora 
(em alguns modelos do iPad Wi-Fi + 3G) está 
disponível e que você pode conectar-se à 
Internet via EDGE. Consulte “Como Conectar-se 
à Internet” na página 30.
GPRS Mostra que a rede GPRS da sua operadora 
(em alguns modelos do iPad Wi-Fi + 3G) está 
disponível e que você pode conectar-se à 
Internet via GPRS. Consulte “Como Conectar-se 
à Internet” na página 30.
Wi-Fi Mostra que o iPad possui uma conexão à 
Internet Wi-Fi. Quanto mais barras, melhor 
a conexão. Consulte “Como Conectar-se à 
Internet” na página 30.
Atividade Mostra a rede e outras atividades. Talvez alguns 
aplicativos de outros fabricantes também utilizem este ícone para indicar um processo ativo.
VPN Mostra que você está conectado a uma rede 
usando VPN. Consulte “VPN” na página 167.
Cadeado Mostra que o iPad está bloqueado. Consulte 
“Botão Repousar/Despertar” na página 10.
Bloqueio de orientação da tela Mostra que a orientação da tela está bloqueada. Consulte “Visualização na Vertical ou 
Horizontal” na página 16.
Reproduzir Mostra que uma música, audiolivro ou podcast 
está sendo reproduzido. Consulte “Reprodução 
de Músicas” na página 115.
Bluetooth Ícone branco: o Bluetooth está ativado e há um 
dispositivo, como um headset ou um teclado, 
conectado.  Ícone cinza: o Bluetooth está ativado, mas nenhum dispositivo está conectado.  
Sem ícone: o Bluetooth está desativado.
Bateria Mostra o nível da bateria ou o estado da 
carga. Consulte “Como Carregar a Bateria” na 
página 35.Aplicativos do iPad
Os seguintes aplicativos estão incluídos no iPad:
Safari
Navegue por sites na Internet. Gire o iPad de lado para visualizar em formato panorâ-
mico. Toque duas vezes para ampliar ou reduzir—o Safari ajusta automaticamente a 
coluna da página web na tela. Abra várias páginas. Sincronize favoritos com o Safari ou 
com o Microsoft Internet Explorer em seu computador. Adicione web clipes do Safari à 
tela Início para acesso rápido aos sites favoritos. Salve imagens de sites na sua Fototeca. 
Imprima as páginas web usando o AirPrint. Consulte Capítulo 4,“Safari,” na página 50.
Mail
Envie e receba o correio usando vários dos serviços de e-mails mais populares, 
Microsoft Exchange ou serviços de correio POP3 e IMAP padrão da indústria. Envie 
e salve fotos. Visualize arquivos PDF e outros anexos, ou abra-os em outros aplicativos. Imprima mensagens e anexos usando o AirPrint. Consulte Capítulo 5,“Mail,” na 
página 56.
Fotos
Organize as suas fotos e vídeos favoritos em álbuns. Assista uma apresentação de slides. Amplie para obter uma visão mais de perto. Compartilhe fotos e vídeos usando o 
correio ou o MobileMe (vendido separadamente), ou imprima fotos usando o AirPrint. 
Consulte Capítulo 9,“Fotos,” na página 74.
iPod
Sincronize com a biblioteca do seu iTunes e ouça suas músicas, audiolivros e podcasts no iPad. Crie e gerencie listas ou use o Genius para criar listas para você. Escute 
Seleções do Genius a partir de músicas da sua biblioteca. Use o Compartilhamento 
Familiar para reproduzir música do seu computador. Transmita a sua música ou vídeos 
sem fio para um Apple TV ou sistema de áudio compatível usando o AirPlay. Consulte 
Capítulo 16,“iPod,” na página 114.
Calendário
Mantenha o seu calendário atual no iPad ou sincronize-o com o seu Mac OS X 
ou calendário do Windows. Inscreva-se em calendários de terceiros. Sincronize 
pela Internet com os servidores do Microsoft Exchange ou CalDAV. Consulte 
Capítulo 12,“Calendário,” na página 92.
Contatos
Organize a sua agenda e mantenha-a atualizada no iPad, ou sincronize-a com o seu 
Mac OS X ou agenda do Windows. Sincronize sem fio com o MobileMe (vendido separadamente), Contatos do Google, Yahoo! Agenda e Microsoft Exchange. Consulte 
Capítulo 13,“Contatos,” na página 98.
Notas
Faça notas breves—lembretes, lista de compras, ideias brilhantes. Envie-as por e-mail. 
Sincronize as notas com o Mail, com o Microsoft Outlook ou com o Outlook Express. 
Consulte Capítulo 14,“Notas,” na página 102.
Mapas
Consulte uma visualização clássica, de satélite, de terreno ou híbrida de locais ao 
redor do mundo. Amplie para dar uma olhada mais de perto ou verifique o Google 
Street View. Encontre a sua localização atual. Obtenha itinerários detalhados para 
dirigir, itinerários para ir a pé, informações sobre transporte público e veja as condições atuais de tráfego nas autoestradas. Para buscar empresas na área: Consulte 
Capítulo 15,“Mapas,” na página 104.
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Vídeos
Reproduza filmes, programas de TV, podcasts e vídeos da biblioteca do seu iTunes 
ou da sua coleção de filme. Compre ou alugue filmes no iPad usando a iTunes Store. 
Transfira podcasts de vídeo. Consulte Capítulo 10,“Vídeos,” na página 83.
YouTube
Reproduza vídeos da coleção on-line do YouTube. Procure qualquer vídeo ou navegue 
pelos vídeos mais visualizados, mais recentemente atualizados e melhor classificados. 
Configure e inicie a sessão na sua conta do YouTube e depois classifique vídeos, sincronize seus favoritos, mostre assinaturas e muito mais. Consulte Capítulo 11,“YouTube,” na 
página 88.
iTunes
Busque músicas, audiolivros, programas de TV, vídeos de música e filmes na iTunes 
Store. Explore, visualize, compre e transfira novos lançamentos, itens mais vendidos e 
muito mais. Compre ou alugue filmes e programas de TV para assistir no iPad. Transfira 
podcasts. Leia opiniões ou escreva suas próprias opiniões sobre seus itens favoritos da 
loja. Consulte Capítulo 17,“iTunes Store,” na página 123.
App Store
Busque na App Store aplicativos para comprar ou transferir. Leia ou escreva suas pró-
prias opiniões sobre seus aplicativos favoritos. Transfira e instale o aplicativo na sua tela 
de Início. Consulte Capítulo 18,“App Store,” na página 130.
Game 
Center
Descubra novos jogos e compartilhe suas experiências com eles com seus amigos. 
Convide um amigo ou comece uma partida com outro oponente. Consulte os rankings 
do jogador nos quadros de classificação. Ganhe pontos extras para cada proeza do 
jogo. Consulte Capítulo 20,“Game Center,” na página 142.
FaceTime
Realize videoconferências para outros usuários do FaceTime através de Wi-Fi. Use a 
câmera frontal para conversar cara a cara ou a câmera posterior para compartilhar o 
que você está vendo. Consulte Capítulo 7,“FaceTime,” na página 68.
Câmera
Tire fotos e grave vídeos. Veja-os no iPad, envie-os por e-mail ou carregue-os no seu 
computador, ou Internet. Toque para definir a exposição. Recorte e salve videoclipes. 
Envie vídeos diretamente ao YouTube ou MobileMe. Consulte Capítulo 6,“Câmera,” na 
página 64.
Photo 
Booth
Use a câmera frontal ou posterior para tirar uma instantânea. Adicione um efeito especial, como um giro ou estiramento, antes de tirar uma instantânea. As instantâneas 
são salvas em um álbum no aplicativo de Fotos. Consulte Capítulo 8,“Photo Booth,” na 
página 71.
Ajustes
Personalize os ajustes do iPad em um lugar prático — rede, correio, web, música, vídeo, 
fotos e outros. Configure a moldura, contas de correio, contatos e calendários. Gerencie 
a sua conta de dados celular (iPad Wi-Fi + 3G). Defina um bloqueio automático e um 
código de segurança. Consulte Capítulo 22,“Ajustes,” na página 166.
Adicionalmente, você pode obter os seguintes aplicativos da App Store no iPad:iBooks
Transfira o aplicativo iBooks gratuito da App Store. Toque no botão da loja e navegue por milhares de livros ePub e PDF—muitos deles grátis. Imprima PDFs usando o 
AirPrint. Use favoritos e destaques para salvar o seu lugar e anotar suas passagens favoritas. Consulte Capítulo 19,“iBooks,” na página 135.
Pages
Use os gestos Multi-Touch para criar e compartilhar documentos no iPad. Crie cartas, 
folhetos, brochuras, relatórios e muito mais. Inicie um documento no iPad e termine-o 
no seu computador. Você pode comprar o aplicativo Pages na App Store.  
Numbers
Crie planilhas com tabelas, gráficos, fotos e texto. Com poucos toques, você pode organizar dados, executar cálculos e gerenciar listas. O Numbers oferece modelos ou você 
pode escolher o modelo em branco para criar uma planilha única. Você pode comprar 
o aplicativo Numbers na App Store.  
Keynote
Escolha os temas do Keynote para criar uma apresentação. Adicione fotos e vídeos do 
aplicativo Photos; organize dados com tabelas e gráficos; e quando a sua apresentação 
estiver pronta, use a visualização em tela cheia para reproduzi-la no iPad. Importe as 
apresentações do Keynote que você criar no seu computador. Você pode comprar o 
aplicativo Keynote na App Store.  
Nota: A funcionalidade e disponibilidade dos aplicativos pode variar dependendo de 
onde você comprou e vai utilizar o iPad.
Visualização na Vertical ou Horizontal
Você pode visualizar os aplicativos integrados ao iPad tanto na orientação vertical 
como na horizontal. Gire o iPad e a tela gira também, ajustando-se automaticamente 
para se encaixar na nova orientação. 
Talvez você prefira a orientação paisagem para visualizar as páginas da web no Safari, 
por exemplo, ou ao digitar texto. As páginas da web são automaticamente dimensionadas para a tela maior, deixando o texto e as imagens maiores. O teclado na tela 
também se torna maior, o que pode ajudar a aumentar sua velocidade e precisão de 
digitação. Bloqueie a orientação da tela se desejar impedir que ela gire.
Para bloquear a tela do na orientação vertical ou horizontal: Clique duas vezes no 
botão Início  para visualizar a barra de estado do multi-tarefas e, em seguida, passe o 
dedo da esquerda para a direita. Toque no  para bloquear a orientação da tela.
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Você também pode configurar o Interruptor Lateral para bloquear a orientação da tela 
em vez de silenciar os efeitos sonoros e notificações. Vá para Ajustes > Geral.
Tela Multi-Touch
Os controles da tela Multi-Touch mudam dinamicamente dependendo da tarefa que 
você está executando. Para controlar o iPad, use os seus dedos executar o toque, 
toque-duplo e deslizar.
Como ajustar o brilho
Para ajustar o brilho da tela, clique duas vezes no botão Início  para visualizar a barra 
de estado de multi-tarefas. Passe o dedo da esquerda para a direita e, em seguida, arraste o controle de brilho.
Brilho
Você pode usar a opção Brilho Automático para ajustar automaticamente o brilho da 
tela. Nos Ajustes, escolha Brilho e Imagem de Fundo e, sem seguida, ative ou desative a 
opção Brilho Automático. Consulte “Brilho e Imagem de Fundo” na página 170.
Como usar listas
Algumas listas possuem um índice na parte lateral, o qual ajuda você a navegar 
rapidamente.
ÍndicePara buscar itens em uma lista indexada: Toque em uma letra para ir para os itens 
que começam por essa letra. Arraste o seu dedo ao longo do índice para rolar rapidamente pela lista.
Para escolher um item: Toque em um item da lista.
Dependendo da lista, ao tocar em um item você pode realizar coisas diferentes—por 
exemplo, pode abrir uma nova lista, reproduzir uma música, abrir uma mensagem de 
e-mail ou mostrar a informação de contato de alguém para que você possa ligar para 
aquela pessoa.
Para retornar para uma lista anterior: Toque no botão Voltar no canto superior 
esquerdo.
Como Ampliar ou Reduzir
Ao visualizar fotos, páginas web, e-mail ou mapas, você pode usar o zoom para ampliar ou reduzir. Toque a tela com dois dedos e separe-os ou aproxime-os. Para fotos e 
páginas web, você pode realizar um toque duplo (tocar duas vezes rapidamente) para 
ampliar e depois dar novamente um toque duplo para reduzir. Para mapas, realize um 
toque duplo para ampliar e toque uma vez com dois dedos para reduzir.
O zoom também é um recurso de acessibilidade que permite ampliar a tela de 
qualquer aplicativo que você estiver utilizando e o ajuda a ver o que há nessa tela. 
Consulte “Zoom” na página 162.
Teclado da Tela
O teclado na tela aparece automaticamente sempre que você precise digitar. Use o 
teclado para digitar textos, como informações de contato, e-mail e endereços da web. 
O teclado corrige erros de digitação, antecipa o que você está digitando e aprende a 
medida em que você o usa.
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Você também pode usar um teclado Apple Wireless Keyboard para digitar. Quando 
você utiliza um teclado externo, o teclado na tela não aparece. Consulte “Como Utilizar 
um Teclado Apple Wireless Keyboard” na página 20.
Como Digitar
Dependendo do app que você estiver usando, o teclado inteligente pode sugerir automaticamente correções enquanto você digita para ajudá-lo a evitar palavras com erro 
de digitação.
Para digitar texto:
1 Toque em um campo de texto, como em uma nota ou um novo contato, para mostrar 
o teclado.
2 Toque nas teclas do teclado.
Se tocar na tecla errada, você pode deslizar seu dedo para a tecla certa. A letra não é 
digitada até que você retire o dedo da tecla.
Para usar a tecla Retroceder para apagar o caractere anterior
Toque na  .
Digitar rapidamente um ponto final e espaço Toque duas vezes na barra de espaço.  
Você pode ativar ou desativar esse recurso em 
Configurações > Geral > Teclado.
Digitar em letras maiúsculas Toque na tecla Maiúsculas  antes de tocar uma 
letra. Ou toque e mantenha a tecla Maiúsculas 
pressionada e deslize para uma letra.Ativar o comando fixar maiúsculas Toque duas vezes na tecla Maiúsculas  . A 
tecla Maiúsculas fica azul e todas as letras que 
digitar ficarão em letras maiúsculas. Toque a 
tecla Maiúsculas para desativar o comando fixar 
maiúsculas.  
Você pode ativar ou desativar esse recurso em 
Configurações > Geral > Teclado.
Mostrar números, sinais de pontuação ou 
símbolos
Toque na tecla de Números  . Toque na tecla 
Symbol  para visualizar pontuação e símbolos 
adicionais.
Para usar um teclado internacional Mantenha o toque sobre a tecla Próximo Teclado 
 para exibir um menu de idiomas e depois 
toque no idioma. Consulte Apêndice B,“Teclados 
Internacionais,” na página 191.
Você pode adicionar ou remover teclados internacionais em Ajustes > Geral > Teclado.
Digite letras ou símbolos que não estão no 
teclado
Toque e mantenha pressionada a letra ou símbolo relacionado, depois deslize para escolher uma 
variação.
Para ocultar o teclado na tela Toque na tecla Teclado  para ocultar o teclado 
na tela.
Como Utilizar um Teclado Apple Wireless Keyboard
Para facilitar a digitação, você pode utilizar o Apple Wireless Keyboard com o iPad.
O teclado Apple Wireless Keyboard conecta-se através do Bluetooth e, para isso, você 
deverá emparelhar o teclado com o iPad. Consulte “Como Emparelhar Dispositivos 
Bluetooth” na página 46.
Uma vez que o teclado esteja emparelhado com o iPad, ele se conecta sempre que o 
teclado estiver no raio de alcance (até 10 metros). Você poderá saber que o teclado 
está conectado se o teclado da tela não aparecer quando você tocar em um campo de 
texto.
Para alternar o idioma ao utilizar um teclado de hardware:Mantenha pressionada 
a tecla Comando e, em seguida, toque na barra de espaços para exibir uma lista de 
idiomas disponíveis. Toque na barra de espaço novamente para selecionar um idioma 
diferente.
Para desconectar um teclado sem fio do iPad: Mantenha pressionado o botão de for-
ça do teclado até que a luz verde se apague.
O iPad desconecta o teclado quando ele estiver fora de alcance.
Para desemparelhar um teclado sem fio do iPad: Em Ajustes, selecione Geral 
> Bluetooth, toque  ao lado do nome do dispositivo e, em seguida, toque em 
"Esquecer este Dispositivo".
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É possível aplicar leiautes diferentes a um teclado sem fio. Consulte 
Apêndice B,“Teclados Internacionais,” na página 191 e “Leiautes de Teclado” na 
página 23.
Dicionário
Para vários idiomas, o iPad possui dicionários que podem ajudá-lo a digitar. O dicionário adequado é ativado automaticamente quando você seleciona um teclado 
compatível.  
Para ver uma lista de idiomas compatíveis, nos Ajustes, escolha Geral > Internacional > 
Teclados.
O iPad usa o dicionário ativo para sugerir correções ou para completar a palavra que 
você está digitando. Você não precisa interromper a digitação para aceitar a palavra 
sugerida.
Para aceitar ou rejeitar as sugestões do dicionário:
m Para rejeitar a palavra sugerida, termine a digitação da palavra como desejar e depois 
toque na sugestão para descartá-la antes de digitar qualquer outra coisa. Cada vez que 
você rejeitar uma sugestão para a mesma palavra, o iPad fica mais propenso a aceitar a 
sua palavra.
m Para usar a palavra sugerida, digite um espaço, um sinal de pontuação ou a tecla 
retorno.
Para redefinir sugestões do dicionário: Nos Ajustes, escolha Geral > Redefinir > 
Redefinir Dicionário do Teclado. Isso redefine todas as sugestões que você tenha feito 
ao dicionário.
Para ativar ou desativar a Correção Automática:  Nos Ajustes, escolha Geral > Teclado 
e depois ative ou desative a opção Correção Automática. Normalmente, a Correção 
Automática está ativada.Para ativar ou desativar o recurso “Falar texto automático”:  Nos Ajustes, escolha 
Geral > Acessibilidade e depois ative ou desative a opção Falar Texto Automático. A 
opção Falar Texto Automático fala as sugestões de texto.
Nota: Se você estiver digitando caracteres em Chinês ou Japonês, toque em uma das 
alternativas que o dicionário sugere.
Como Editar—Cortar, Copiar e Colar
A tela Multi-Touch facilita a alteração do texto digitado. Uma lente de aumento na tela 
ajuda a posicionar o ponto de inserção exatamente onde você necessita. Os pontos de 
captura do texto selecionado permitem selecionar rapidamente mais ou menos textos. 
Também é possível cortar, copiar e colar textos e fotos com aplicativos, ou em múltiplos aplicativos.
Para posicionar o ponto de inserção: Toque e mantenha o dedo na tela para fazer a 
lente de aumento aparecer e então arraste para posicionar o ponto de inserção.
Para selecionar texto: Toque no ponto de inserção para exibir os botões de seleção. 
Toque em Selecionar para selecionar a palavra adjacente ou toque em Selecionar Tudo 
para selecionar o texto inteiro. Você também pode tocar duas vezes em uma palavra 
para selecioná-la. Em documentos somente para leitura tais como páginas web, mantenha o toque sobre a palavra para selecioná-la.
Arraste os pontos de seleção para selecionar mais ou menos texto.
Para cortar ou copiar texto: Selecione o texto e toque em Cortar ou Copiar.
Para colar texto: Toque no ponto de inserção depois toque em Colar para inserir o 
último texto que você cortou ou copiou. Ou, selecione o texto, depois toque em Colar 
para substituir o texto.
Para desfazer a última edição: Agite o iPad ou toque em Desfazer no teclado.
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Leiautes de Teclado
Você pode utilizar os Ajustes para definir os leiautes do teclado de software da tela e 
para quaisquer teclados de hardware. Os leiautes disponíveis dependem do idioma do 
teclado.
Para selecionar um leiaute de teclado:  Em Ajustes, escolha Geral > Teclado > Teclados 
Internacionais e, em seguida, selecione um teclado. Para cada idioma é possível fazer 
seleções separadas tanto para os teclados de software na tela quanto para os teclados 
de hardware externos.
O leiaute do teclado do software determina o leiaute do teclado da tela do iPad . O 
leiaute do teclado do hardware determina o leiaute de um Teclado Apple Wireless 
Keyboard conectado ao iPad.24
Conecte o iPad ao seu computador e use o iTunes para configurar, registrar e sincronizar conteúdo.
Requisitos
· ADVERTÊNCIA: Para evitar danos, leia todas as instruções de funcionamento deste 
manual e as informações de segurança do iPad Manual de Informações Importantes 
do Produto no site support.apple.com/pt_BR/manuals/ipad antes de usar o iPad.
Para usar o iPad, você precisa de:
Â Um Mac ou PC com uma porta USB 2.0 e um dos seguintes sistemas operacionais:
Â Mac OS X versão 10.5.8 ou posterior
Â Windows 7, Windows Vista, ou Windows XP Home ou Profissional com Service Pack 
3 ou posterior
Â iTunes 10.2 ou posterior, disponível no site www.itunes.com/br/download/
Â Um ID Apple 
Â Acesso de Internet de banda larga
Como Configurar o iPad
Antes de poder usar o iPad, você deve usar o iTunes para configurá-lo. Você também 
pode registrar o iPad e criar um ID Apple (não disponível em alguns países) se ainda 
não tiver um.
Para configurar o iPad:
1 Transfira e instale a última versão do iTunes do site www.itunes.com/br/download/.
2
IntroduçãoCapítulo 2    Introdução 25
2 Conecte o iPad à uma porta USB 2.0 do seu Mac ou PC usando o cabo que acompanha 
o iPad.
3 Siga as instruções do iTunes na tela para registrar o iPad e sincronizar o iPad com mú-
sica, vídeo e outros conteúdos da biblioteca do seu iTunes, e com os contatos, calendá-
rios e favoritos no seu computador.
Na tela Como Configurar Seu iPad, selecione “Sincronizar automaticamente contatos, 
calendários e favoritos” para sincronizar estes itens automaticamente quando conectar 
o iPad ao seu computador.
Como Sincronizar com o iTunes
Use o iTunes para sincronizar sua música, vídeos, aplicativos transferidos e outros conteúdos da sua biblioteca do iTunes do seu computador. Você também pode sincronizar 
os seus contatos, calendários e favoritos do navegador. O iTunes permite que você escolha as informações e conteúdo que você deseja sincronizar com o iPad. Por padrão, 
o iTunes sincroniza-se automaticamente sempre que você conecta o iPad ao seu computador. Quando você sincroniza, você também pode transferir informações criadas ou 
compradas no seu iPad para o seu computador.
Como configurar a sincronização
Você pode configurar o iTunes para sincronizar o seguinte:
Â Música
Â Filmes
Â Programas de TV
Â Jogos e aplicativos transferidos da App Store
Â Vídeos musicais
Â Podcasts
Â Livros e audiolivros
Â Coleções do iTunes U
Â Fotos e vídeos (na pasta ou app de fotos do seu computador)
Â Contatos—nomes, números de telefone, endereços, endereços de e-mail e maisÂ Calendários—compromissos e eventos
Â Notas
Â Ajustes da conta de e-mail
Â Favoritos de página web
Você pode configurar os ajustes de sincronização sempre que conectar o iPad ao seu 
computador.
Sincronize suas músicas, audiolivros, podcasts, coleções do iTunes U, vídeos, livros e 
aplicativos da sua biblioteca do iTunes. Se você ainda não tem conteúdo no iTunes, vá 
para a iTunes Store (disponível em alguns países) para pré-visualizar e transferir conte-
údo para o iTunes. Você também pode adicionar as músicas dos seus CDs à sua biblioteca do iTunes. Para saber mais sobre o iTunes e a iTunes Store, abra o iTunes e escolha 
Ajuda > Ajuda iTunes.
Os contatos, calendários, notas e páginas web favoritas são sincronizados com aplicativos no seu computador. Novas entradas ou modificações que você fizer no iPad serão 
sincronizadas em seu computador e vice-versa. 
O iTunes também permite que você sincronize fotos e vídeos de um aplicativo ou de 
uma pasta.
Os ajustes das contas de e-mail são sincronizados apenas em uma direção, do app de 
e-mail do seu computador para o iPad. Isso permite personalizar suas contas de e-mail 
no iPad sem afetar os ajustes de contas de e-mail do seu computador.
Nota: Você pode também configurar contas de e-mail diretamente no iPad. Consulte 
“Como adicionar Mail, Contatos e Contas do Calendário” na página 32.
As compras da iTunes Store e da App Store que você faz com o iPad são sincronizadas 
com a biblioteca do iTunes no seu computador quando você conecta. Você também 
pode comprar ou transferir conteúdo e aplicativos da iTunes Store para o seu computador e depois sincronizá-los no iPad.
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Também é possível ajustar o iPad para sincronizar uma parte do que está em seu computador. Por exemplo, talvez você queira sincronizar somente algumas listas musicais 
ou somente podcasts de vídeo que não foram vistos ainda.  
Importante: Você deve iniciar a sessão com sua própria conta de usuário em seu computador antes de conectar o iPad.
Para configurar a sincronização do iTunes:
1 Conecte o iPad ao seu computador e abra o iTunes (se ele não abrir automaticamente).
2 No iTunes, selecione iPad na barra lateral.
3 Configure os ajustes de sincronização em cada um dos painéis de ajuste.
Consulte a seguinte seção para obter uma descrição de cada painel.
4 Clique em Aplicar no canto inferior direito da tela.
Por padrão, a opção “Abrir o iTunes quando este iPad estiver conectado" está 
selecionada. 
Painéis de ajuste do iPad no iTunes
As seguintes seções fornecem uma visão geral de cada um dos painéis de ajuste do 
iPad. Para obter mais informações, abra o iTunes e escolha Ajuda > Ajuda iTunes.
Painel Resumo
Selecione “Abrir iTunes quando este iPad é conectado” para que o iTunes seja aberto 
e sincronize o iPad automaticamente sempre que for conectado ao seu computador. 
Desmarque esta opção se deseja sincronizar somente ao clicar no botão Sincronizar 
do iTunes. Para obter mais informações sobre como evitar a sincronização automática, 
consulte “Como Impedir a Sincronização Automática” na página 30.Selecione “Sincronizar somente músicas e vídeos selecionados” se deseja que o iTunes 
ignore os itens desmarcados da sua biblioteca do iTunes ao sincronizar.
Selecione “Gerenciar músicas e vídeos manualmente” para desativar a sincronização 
automática dos painéis de ajustes Música e Vídeo.
Selecione “Criptografar backup do iPad>" se quiser criptografar as informações armazenadas em seu computador quando o iTunes fizer um backup. Backups criptografados são mostrados com um ícone de cadeado  , e requerem uma senha para restaurar as informações do iPad. Consulte “Como atualizar e restaurar o software do iPad” na 
página 199.
Para ativar os recursos de acessibilidade, clique em Configurar Acesso Universal Para 
obter mais informações, consulte “Recursos de Acesso Universal” na página 150.
Painel Informações
O painel Informações permite configurar os ajustes de sincronização para seus contatos, calendários, contas de e-mail e navegador.
Â Contatos
Você pode sincronizar contatos com aplicativos como a Agenda do Mac OS X, o 
"Yahoo! Listas de Endereços" e Contatos do Google em um Mac, ou com a Agenda 
do Yahoo! Agenda, os Contatos do Google, o Catálogo de Endereços do Windows 
(Microsoft Outlook Express), o Catálogo de Endereços do Windows Vista ou do 
Microsoft Outlook 2003, 2007 ou 2010 em um PC. (No Mac, você pode sincronizar 
contatos com vários aplicativos. Em um PC, você pode sincronizar contatos somente 
com um aplicativo de cada vez.)
Se você sincronizar com Agenda do Yahoo! você só precisa clicar em Configurar para 
digitar a sua nova informação de início de sessão quando alterar o seu Identificador 
ou senha do Yahoo! após configurar a sincronização.
Â Calendários
Você pode sincronizar os calendários de aplicativos como o iCal no Mac ou do 
Microsoft Outlook 2003, 2007 ou 2010 no PC. (No Mac, você pode sincronizar calendários com vários aplicativos. No PC, você pode sincronizar os calendários com apenas um aplicativo de cada vez.)
Â Contas do Mail
Você pode sincronizar os ajustes das contas de e-mail do Mail em um Mac e do 
Microsoft Outlook 2003, 2007, 2010 ou do Microsoft Outlook Express em um PC. Os 
ajustes das contas são transferidos somente do seu computador para o iPad. As 
alterações realizadas em uma conta de e-mail no iPad não afetam a conta no seu 
computador.
Nota: A senha da sua conta de e-mail do Yahoo! não é salva no seu computador, 
por isso não pode ser sincronizada e deve ser digitada no iPad. Em Ajustes, escolha 
“Mail, Contatos, Calendários”, toque em sua conta Yahoo! e digite a senha. 
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Â Outra
Sincronize favoritos do Safari em um Mac, ou do Safari ou Microsoft Internet 
Explorer em um PC.  
Sincronize notas do aplicativo Notas do iPad com notas do Mail em um Mac ou com 
o Microsoft Outlook 2003 ou 2007 em um PC.  
Â Avançado
Selecione uma ou mais destas opções se deseja substituir as informações do iPad 
pelas informações do seu computador durante a próxima sincronização.
Painel Apps
Utilize o Painel Apps para sincronizar aplicativos da App Store, organizar aplicativos na 
tela Início do iPad ou copiar documentos entre o iPad e seu computador. 
Selecione "Sincronizar automaticamente novos aplicativos" para sincronizar novos 
aplicativos para o iPad que foram transferidos ou sincronizados de outro dispositivo. 
Se você apagar um app do iPad, poderá reinstalá-lo a partir do painel Apps, se ele tiver 
sido previamente sincronizado.
Você pode criar documentos no iPad e, em seguida, copiá-los no seu computador. 
Você também pode copiar documentos do seu computador para o iPad e utilizá-los 
com aplicativos compatíveis com o compartilhamento de arquivos. Os aplicativos 
compatíveis com o compartilhamento de arquivo são mostrados na lista Aplicativos de 
Compartilhamento de Arquivos Para obter mais informações sobre o compartilhamento de arquivos, consulte “Compartilhamento de Arquivos” na página 47. 
Painéis Música, Filmes, Programas de TV, Podcasts e iTunes U
Utilize estes painéis para especificar a mídia que deseja sincronizar. Você pode sincronizar todas as coleções de músicas, filmes, programas de TV, podcasts, iTunes U ou 
então selecionar o conteúdo que deseja no iPad.
Para assistir a filmes alugados na sua biblioteca do iTunes no iPad, transfira-os para o 
iPad usando o painel Filmes do iTunes.
Painel Livros
Você pode sincronizar livros transferidos da iBookstore, e muitos livros ePub grátis de 
outras fontes. Você também pode sincronizar audiolivros e se o livro tiver mais de uma 
parte, sincronizar somente a parte que desejar.
Painel Fotos
Você pode sincronizar fotos e vídeos com o iPhoto 6.0.6 ou superior, ou com o 
Aperture 3.0.2 ou superior no Mac; ou com o Adobe Photoshop Elements 8.0 ou posterior em um PC. Você também pode sincronizar fotos e vídeos em qualquer pasta do 
seu computador que contenha imagens ou vídeos.Como Impedir a Sincronização Automática
Você pode impedir que o iPad sincronize automaticamente quando conectar o iPad a 
um computador diferente.
Para evitar a sincronização automática para todos os iPad s: No iTunes escolha iTunes > Preferências (em um Mac) ou Editar > Preferências (em um PC), clique em Dispositivos e selecione “Impedir que iPods, iPhones e iPad sincronizem 
automaticamente”.
Se esta opção estiver selecionada, o iPad não sincroniza automaticamente, mesmo se 
a opção “Abrir o iTunes quando este iPad é conectado” estiver selecionada no painel 
Resumo.
Para evitar a sincronização automática uma vez, sem alterar os ajustes: Abra o iTunes, conecte o iPad ao seu computador, mantenha pressionadas as teclas ComandoOpção (em um Mac) ou Maiúsculas-Controle (em um PC) até que iPad apareça na 
barra lateral.
Para sincronizar manualmente: No iTunes, selecione iPad na barra lateral e clique em 
Sincronizar no canto inferior direito da janela. Ou, se você alterou algum ajuste de sincronização, clique em Aplicar.
Como Conectar-se à Internet
O iPad pode unir-se à AirPort e outras redes Wi-Fi em casa, no trabalho ou em pontos de acesso Wi-Fi pelo mundo. Ao unir-se a uma rede Wi-Fi que está conectada à 
Internet, o iPad se conecta à Internet automaticamente sempre que você usar o Mail, 
Safari, YouTube, a App Store ou a iTunes Store. o iPad se conecta à Internet usando 
uma rede Wi-Fi. O iPad Wi-Fi + 3G também pode se conectar à Internet usando uma 
rede de dados celular. O serviço de dados é vendido separadamente.
Como conectar-se a uma Rede Wi-Fi
Use os ajustes Wi-Fi para ativar a Wi-Fi e conectar a redes Wi-Fi.
Para ativar a Wi-Fi: Escolha Ajustes > Wi-Fi e ative a opção Wi-Fi.
Para conectar-se a uma rede Wi-Fi: Escolha Ajustes > Wi-Fi, espere um momento enquanto o iPad detecta as redes que estão no raio de alcance e depois selecione uma 
rede (talvez o acesso a algumas redes Wi-Fi não seja gratuito). Se necessário, digite 
uma senha e toque em Conectar (as redes que requerem uma senha aparecem com 
um ícone de  cadeado).
Uma vez que você tenha se conectado a uma rede Wi-Fi, o iPad se conecta a ela 
automaticamente sempre que a rede estiver no raio de alcance. Se houver mais de 
uma rede usada anteriormente dentro do raio de alcance, o iPad se conecta à última 
utilizada.
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Quando o iPad se conecta a uma rede Wi-Fi, o ícone Wi-Fi  situado na barra de estado mostra a intensidade do sinal. Quanto mais barras você vir, melhor a conexão.
Para obter mais informações sobre como ajustar as configurações Wi-Fi, consulte “WiFi” na página 167.
Como conectar-se a uma Rede de Dados de Celular 
Antes de que você possa unir-se a uma rede de dados celular no iPad Wi-Fi + 3G, você 
deve inscrever-se em um plano de dados celular com um provedor de serviços do iPad 
na sua área. Com alguns provedores, você pode escolher um plano de dados, controlar 
o uso de seus dados e alterar ou cancelar o seu plano no iPad. 
Em alguns modelos, 3G, EDGE e GPRS permitem conectividade à Internet através da 
rede celular disponível mediante o serviço sem fio da sua operadora. Verifique a cobertura da rede da operadora na sua área para ver a disponibilidade.
Se o iPad estiver conectado à Internet usando uma rede de dados celular, você vê o 
ícone de estado do 3G ( ), EDGE ( ) ou GPRS ( ) na barra de estado.
Para ativar o Roaming de Dados: Se você estiver fora da rede da sua operadora, talvez 
você possa usar uma rede de dados de celular de outra operadora. Em Ajustes, escolha 
Dados de Celular e ative o Roaming de Dados.  
Importante: Podem ser aplicadas taxas sobre o Roaming. Para evitar taxas de roaming 
de dados, certifique-se de que o Roaming de Dados esteja desativado.
Para monitorar o uso da sua rede de dados celular: Em Ajustes, escolha Dados de 
Celular > Ver Conta.  
Para configurar um plano de dados de celular no iPad:  Na tela de Início do iPad, toque em Ajustes e escolha Dados de Celular. Toque em Visualizar Conta e depois siga as 
instruções na tela.
Os ajustes de dados de celular podem variar dependendo da operadora.  
O iPad está desbloqueado, então você pode escolher sua operadora preferida. Os ajustes de dados de celular variam dependendo da operadora. Se o seu iPad Wi-Fi + 3G 
não veio fornecido com um cartão micro-SIM, entre em contato com o seu provedor 
para configurar uma conta e obter um cartão micro-SIM compatível. Nem todos os 
provedores fornecem planos de dados 3G.
Acesso à Internet em um Avião
O modo avião no iPad Wi-Fi + 3G desativa os transmissores de rádio do iPad para cumprir com as normas das empresas aéreas. Em algumas regiões - quando permitido pelo 
piloto da aeronave e pelas leis e normas aplicáveis - você pode ativar a Wi-Fi enquanto 
o modo avião está ativado, para:
Â Enviar e receber e-mail
Â Navegar na InternetÂ Sincronizar seus contatos e calendários com a tecnologia over the air
Â Transmitir vídeos do YouTube em tempo real
Â Comprar músicas e aplicativos
Para obter mais informações, consulte “Modo Avião” na página 166.
Como adicionar Mail, Contatos e Contas do Calendário
O iPad funciona com MobileMe, Microsoft Exchange e com muitos dos e-mails, contatos e servidores de serviço calendários mais conhecidos baseados em Internet. Se você 
ainda não tem uma conta de e-mail, pode obter uma conta gratuita on-line no site 
br.yahoo.com/, www.google.com.br/ ou www.aol.com. Para experimentar um período 
de teste grátis do MobileMe, vá para www.apple.com/br/mobileme.
Para obter mais informações sobre como configurar uma conta Microsoft Exchange 
em um ambiente empresarial, consulte “Como Configurar Contas do Microsoft 
Exchange” na página 189.  
Como Configurar Contas MobileMe
Para usar o MobileMe no iPad, você pode configurar uma conta gratuita do MobileMe 
ou uma assinatura paga do MobileMe.
Uma conta gratuita do MobileMe permite que você use o Buscar Meu iPad; um recurso 
que o ajuda a localizar o iPad caso for perdido ou roubado, e proteger as informações 
nele contidas (não disponível em todos os países ou regiões). Consulte “Recursos de 
segurança” na página 48.
Uma conta gratuita do MobileMe está disponível para qualquer cliente que possua um 
iPad com o iOS 4.2 ou posterior. Se você já criou um ID da Apple para a App Store ou 
para o Game Center, pode usar o mesmo ID da Apple para configurar a sua conta do 
MobileMe. Crie uma nova conta se você ainda não tiver uma.
Para configurar uma conta gratuita do MobileMe:
1 Em Ajustes, toque em “Mail, Contatos, Calendários”.
2 Toque em Adicionar Conta e, em seguida, toque MobileMe.
3 Insira o seu ID e senha da Apple ou toque em Criar ID Apple Gratuito.
4 Siga as instruções da tela.
Verifique o seu endereço de e-mail, se necessário.
5 Certifique-se de que Buscar Meu iPad está ativado.
Para configurar uma Assinatura paga do MobileMe:
1 Em Ajustes, toque em “Mail, Contatos, Calendários”.
2 Toque em Adicionar Conta e, em seguida, toque MobileMe.
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3 Insira o seu ID Apple e senha, ou escolha criar uma nova conta.
4 Ative os serviços que deseja usar no iPad.
Uma assinatura paga do MobileMe permite que você use Buscar Meu iPad, mais os 
seguintes recursos:
Â Conta do Mail em me.com
Â Sincronização over-the-air para os contatos, calendários, favoritos e notas
Â Galeria do MobileMe para o compartilhamento de fotos e vídeos
Â O MobileMe iDisk para armazenamento e compartilhamento de arquivos
Você pode experimentar esses recursos com uma avaliação grátis de 60 dias em www.
apple.com/br/mobileme. 
Os serviços que ativar são sincronizados automaticamente através da tecnologia over 
the air, sem ter que conectar o iPad ao seu computador. Consulte “Como Sincronizar 
com o iTunes” na página 25.
Você pode definir múltiplas contas MobileMe; no entanto, apenas uma conta 
MobileMe poderá ser utilizada de cada vez para o Buscar Meu iPad e para contatos de 
sincronização, calendários, favoritos e notas.
Para usar Galeria, iDisk e Buscar Meu iPad em iPad, transfira os aplicativos gratuitos 
Galeria do MobileMe, MobileMe iDisk e Buscar Meu iPhone a partir da App Store.
Como Configurar Contas do Google, Yahoo! e AOL
Para diversas contas conhecidas (Google, Yahoo!, AOL), o iPad digita a maioria dos ajustes para você. Ao configurar a conta, você pode escolher quais serviços de conta deseja utilizar com o iPad. Os serviços ativados são sincronizados automaticamente com o 
sistema over the air. Consulte “Como Sincronizar com o iTunes” na página 25.
Para configurar uma conta:
1 Em Ajustes, toque em “Mail, Contatos, Calendários”.
2 Toque em Adicionar Conta e, em seguida, toque Google, Yahoo! ou AOL
3 Digite seu nome, endereço de e-mail, senha e uma descrição.
4 Toque nos itens que deseja utilizar no iPad. Os itens disponíveis dependem do 
servidor.
Como Configurar Outras Contas
Selecione Outras Contas para configurar outras contas para e-mail (como POP), contatos (como LDAP ou CardDAV), ou calendários (como CalDAV). Contate seu servidor ou 
administrador de sistema para obter os ajustes de conta que necessita.
Para configurar uma conta:
1 Em Ajustes, toque em “Mail, Contatos, Calendários”.2 Toque em Adicionar Conta e, em seguida, toque em Outras.
3 Selecione o tipo de conta que deseja adicionar (Mail, Contatos ou Calendários).
4 Digite as informações da sua conta e toque em Salvar.
Como desconectar o iPad de seu computador
A menos que o iPad esteja sincronizando com o computador, você pode desconectá-
lo a qualquer momento.
Quando o iPad está sincronizando com seu computador, a tela de Início do iPad mostra a mensagem “Sincronização em andamento.” Se você desconectar o iPad antes de 
finalizar a sincronização, alguns dados podem não ser transferidos. Quando o iPad terminar a sincronização, o iTunes mostra “A sincronização do iPad está concluída”.
Para cancelar uma sincronização: Arraste o controle deslizante do iPad.  
Como visualizar o Manual do Usuário do iPad
O Manual do Usuário do iPad pode ser visto iPad no Safari, ou através da instalação do 
aplicativo gratuito iBooks e de sua transferência a partir da iBookstore.
Para visualizar o Manual do Usuário no Safari: No Safari, toque no  , em seguida toque no favorito  Manual do Usuário do iPad. Ou vá para http://help.apple.com/br/ipad.
Para adicionar um ícone para o manual do usuário na tela Início: Toque no  e toque em “Adicionar à Tela Início.”
Visualize o Manual do Usuário no iBooks
1 Se você não tiver instalado o iBooks, abra a App Store, procure por “iBooks” e, em 
seguida, toque nele na lista de resultados. Toque em Grátis e, em seguida, toque em 
Instalar.
2 Abra o iBooks e toque em Loja. 
3 Procure pelo “iPad Manual do Usuário” e toque no manual do usuário na lista de 
resultados. 
4 Toque em Grátis e, em seguida, toque em Obter Livro. 
Para obter mais informações sobre o iBooks, consulte Capítulo 19,“iBooks,” na 
página 135.
Bateria
O iPad possui uma bateria interna recarregável. A bateria do não pode ser acessada 
pelo usuário e deve ser substituída por um Fornecedor de Serviço Autorizado Apple. 
Para obter mais informações sobre as baterias do iPad, visite o site www.apple.com/br/
batteries/ipad.html.
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Como Carregar a Bateria
ADVERTÊNCIA: Para obter informações de segurança importantes sobre o carregamento do iPad, consulte o Manual de Informações Importantes do Produto iPad no site  
support.apple.com/pt_BR/manuals/ipad. 
O ícone da bateria no canto superior direito da barra de estado mostra o nível de bateria ou o estado do carregamento.  
Carregando Carregado
Para carregar a bateria: A melhor maneira de carregar a bateria do iPad é conectar o 
iPad a uma tomada elétrica usando o Cabo Conector Dock para USB e o adaptador de 
alimentação USB de 10 W. Quando você conecta o iPad a uma porta USB 2.0 em um 
Mac com o Cabo Conector Dock para USB, o iPad pode carregar lentamente enquanto 
sincroniza.
Importante: A bateria do iPad pode gastar em lugar de carregar se o iPad for conectado a um PC, a um computador desligado ou em modo Repouso ou Espera, a um hub 
USB, ou à porta USB em um teclado.
Se o seu Mac ou PC não fornecerem energia suficiente para carregar o seu iPad, 
uma mensagem Não está carregando aparecerá na barra de estado. Para carregar o 
iPad, desconecte-o do seu computador e conecte-o em uma tomada usando o Cabo 
Conector Dock para USB e o Adaptador de Alimentação USB de 10W.Importante: Se a carga da bateria do iPad estiver muito baixa, ele pode exibir uma das 
seguintes imagens, indicando que o iPad precisa ser carregado por pelo menos dez 
minutos antes de você poder usá-lo. Se a carga da bateria do iPad estiver extremamente baixa, a tela poderá ficar em branco por até dois minutos antes que uma das 
imagens indicando pouca bateria apareça.
ou
Como Maximizar a Autonomia da Bateria
O iPad usa uma bateria de lítio-íon. Para obter informações sobre como maximizar a 
vida útil da bateria do seu iPad, visite o site www.apple.com/br/batteries/ipad.html.
Como Trocar a Bateria
As baterias recarregáveis possuem um número limitado de ciclos de carregamento e 
talvez necessitem ser trocadas com o passar do tempo. A bateria do iPad não pode 
ser substituída pelo usuário; ela só pode ser substituída por um Fornecedor de Serviço 
Autorizado Apple (AASP). Os AASPs também reciclam as baterias do iPad de acordo 
com leis e normas locais. Para obter mais informações, visite www.apple.com/br/
batteries/replacements.html.
Utilização e Limpeza do iPad
Manipule o seu iPad com cuidado para conservar seu aspecto. Se estiver preocupado 
com arranhões ou desgaste da tela, você pode usar um estojo ou uma capa, vendidos 
separadamente. 
Como usar o iPad confortavelmente
É importante encontrar uma postura confortável para usar o iPad e fazer intervalos 
frequentes. Use o seu colo, uma mesa, um estojo ou o acessório dock para sustentar o 
iPad durante o uso.  
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Como limpar o iPad
Para limpar o iPad, desconecte todos os cabos e desligue o iPad (mantenha pressionado o botão Repousar/Despertar e depois deslize o controle da tela). Use um pano macio, levemente umedecido e sem fiapos. Evite que entre umidade nas aberturas. Não 
utilize limpadores de vidro, produtos de limpeza caseiros, aerossóis, solventes, álcool, 
amônia ou abrasivos para limpar o iPad. A tela do iPad possui um revestimento oleofó-
bico; limpe a tela simplesmente com um pano macio que não solte fiapos para remover o óleo deixado pelas suas mãos. A capacidade deste revestimento de repelir óleo 
diminui com o uso ao longo do tempo; esfregar a tela com material abrasivo diminuirá 
ainda mais o seu efeito e poderá arranhar sua tela.
Para obter mais informações sobre como utilizar o iPad, consulte o Manual de 
Informações Importantes do Produto do iPad em support.apple.com/pt_BR/manuals/
ipad.38
Leia este capítulo para informar-se como usar os aplicativos no iPad, e para buscar, imprimir, compartilhar arquivos e mais. 
Como Utilizar os Apps
A tela de alta resolução Multi-Touch e os simples gestos dos seus dedos facilitam a 
utilização dos aplicativos do iPad. Abra um aplicativo tocando no seu ícone. Você pode 
alternar entre aplicativos, reorganizar aplicativos e organizá-los em pastas.
Como Abrir e Alternar Apps
Para abrir um app: Toque no seu ícone na tela de Início.
Para voltar à tela Início:Pressione o botão Início  .
O multi-tarefas permite que certos aplicativos sejam executados no fundo, para que 
você possa alternar rapidamente entre os aplicativos que estiver usando.
Para visualizar os aplicativos utilizados mais recentemente:Clique duas vezes no botão Início. 
Os aplicativos usados mais recentemente aparecem na lista de "recentes" na parte inferior da tela. Passe o dedo para a esquerda para ver mais aplicativos.
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Para remover um aplicativo da lista de aplicativos recentes:Toque e mantenha pressionado o ícone do aplicativo até que ele comece a tremular; em seguida, toque em 
.
O aplicativo será adicionado à lista de recentes novamente da próxima vez que for 
aberto.
Para bloquear a orientação da tela ou usar os controles do iPod: Clique duas vezes 
do botão Início e, em seguida, passe o dedo na parte inferior da tela da esquerda para 
a direita.
O bloqueio de orientação da tela, o controle de brilho e os controles do iPod 
aparecem.
Bloqueio de 
orientação de tela
Controles iPod
Brilho
Para apagar um aplicativo da tela de Início: Toque e mantenha o ícone até que ele 
fique trêmulo e um  apareça. Toque em  para apagar o aplicativo. 
Importante: Apagar um aplicativo do iPad também apaga os documentos e os dados 
criados pelo aplicativo.
Rolagem
Arraste para cima ou para baixo para rolar. Você também pode rolar para as laterais 
nos aplicativos como o Safari, Fotos e Mapas.
Arrastando o seu dedo para rolar não irá selecionar ou ativar nada na tela.Passe o dedo para rolar rapidamente.
Você pode esperar até que a rolagem pare ou tocar em qualquer lugar da tela para 
para-la imediatamente. Tocar a tela para parar a rolagem não irá selecionar ou ativar 
nada na tela.
Para rapidamente rolar para o início de uma lista, página web ou mensagem de e-mail, 
toque na barra de estado na parte superior da tela.
Como reorganizar os ícones dos aplicativos
Você pode personalizar o leiaute dos ícones dos aplicativos na tela de Início—
incluindo os ícones no Dock junto aos botões da tela. Se desejar, organize-os em várias 
telas de Início.
Para reorganizar os ícones:
1 Mantenha o toque qualquer ícone até que ele comece a tremular.
2 Organize os ícones, arrastando-os.
3 Pressione o botão Início  para salvar sua ordenação. 
Você também pode organizar os ícones dos aplicativos na tela Início, assim como a 
ordem das telas, quando conectar o iPad ao seu computador. Selecione iPad na barra 
lateral do iTunes e depois clique na aba Apps.
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Para criar telas de Início adicionais: Enquanto você organiza os ícones, arraste um 
ícone para o canto direito da tela até que apareça uma nova tela. Você pode retornar à 
tela anterior e arrastar mais ícones para a nova tela.
Você pode ter até onze telas. O pontos acima do Dock mostram o número de telas que 
você possui e indica qual tela você está visualizando.
Para ir para uma tela de Início diferente: Passe o dedo para a direita ou esquerda, ou 
toque à esquerda ou à direita da linha de pontos. 
Para ir para a primeira tela de Início: Pressione o botão Início  .
Redefina a sua tela de Início para o leiaute original: Escolha Ajustes > Geral > 
Redefinir e depois toque em Redefinir Leiaute de Tela de Início.
Como Organizar com Pastas
As pastas permitem organizar os ícones na tela Início. Você pode colocar até 20 ícones 
em uma pasta. O iPad nomeia automaticamente uma pasta quando ela é criada, com 
base nos ícones que você usou para criá-la. Entretanto, você pode alterar o nome. 
Reorganize as pastas arrastando-as na tela de Início ou movendo-as para uma nova 
tela de Início ou para o Dock.
Para criar uma pasta:Toque e mantenha pressionado um ícone até que os ícones da 
tela Início comecem a tremular e, em seguida, arraste o ícone para dentro de outro 
ícone.
O iPad cria uma nova pasta incluindo os dois ícones e mostra o nome da pasta. Você 
pode tocar no campo do nome para digitar um nome diferente.
Você pode também criar pastas do iPad usando o iTunes.
Para criar uma pasta usando o iTunes:Com o iPad conectado ao seu computador, selecione o ícone do iPad na lista Dispositivos do iTunes. Clique em Aplicativos na parte 
superior da tela e, na tela Início próxima a parte superior da janela, arraste um aplicativo sobre outro.Adicionar um ícone à uma pasta Enquanto ordena ícones, arraste o ícone para 
dentro de uma pasta.
Remover um ícone de uma pasta Enquanto ordena ícones, toque para abrir a pasta 
e, em seguida, arraste o ícone para fora da pasta.
Abrir uma pasta Toque em uma pasta. Você pode tocar no ícone 
de um app para abrir o app.
Fechar uma pasta Toque fora da pasta ou pressione o botão Início.
Apagar uma pasta Remova todos os ícones da pasta.
A pasta é apagada automaticamente quando 
vazia.
Renomear uma pasta Enquanto ordena ícones, toque para abrir a 
pasta e, em seguida, toque no nome da parte 
superior e utilize o teclado para digitar um novo 
nome. Pressione o botão Início para salvar suas 
alterações. 
Ao terminar a organização da sua tela de Início, pressione o botão Início  para salvar 
suas alterações.
Vários aplicativos, como o Mail e a App Store, exibem um indicador no seu ícone da 
tela de Início com um número (para indicar os itens recebidos) ou um ponto de exclamação (para indicar um problema). Se o aplicativo estiver em uma pasta, o símbolo 
também aparece na pasta. Um indicador numerado mostra o número total de itens 
não atendidos, como mensagens de e-mail recebidas e aplicativos atualizados para 
transferir. Um símbolo de alerta indica um problema com o aplicativo. 
Impressão
O AirPrint permite que você imprima sem fio para impressoras com compatibilidade 
para AirPrint. Você pode imprimir a partir dos seguintes aplicativos do iPad:
Â Mail—mensagens de e-mail e anexos visíveis
Â Fotos—fotos
Â Safari—páginas web, arquivos PDF e anexos visíveis
Â iBooks—arquivos PDF
Outros aplicativos disponíveis da App Store também podem ser compatíveis com o 
AirPrint.
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As impressoras compatíveis com o AirPrint não necessitam um software de impressão; elas apenas precisam estar conectadas à mesma rede Wi-Fi que o iPad. Se você 
não tem certeza de que sua impressora é compatível com o AirPrint, consulte sua 
documentação.
Para obter informações adicionais, visite o site support.apple.com/kb/
HT4356?viewlocale=pt_BR.
Como imprimir um documento
O AirPrint usa a sua rede Wi-Fi para enviar trabalhos de impressão sem fio para a sua 
impressora. O iPad deve estar conectado à mesma rede sem fio que a impressora 
AirPrint.
Para imprimir um documento:
1 Toque no  ou no  (dependendo do aplicativo que estiver usando) e, em seguida, 
toque em Imprimir.
2 Toque em Selecionar Impressora para selecionar uma impressora.
3 Defina as opções da impressora como a quantidade de cópias e saída frente e verso 
(se for compatível com a impressora). Alguns aplicativos também permitem que você 
defina um intervalo de páginas a serem impressas.
4 Toque em Imprimir.Se você clicar duas vezes no botão de Início durante a impressão de um documento, o 
aplicativo Impressão aparece como o aplicativo mais recente. Um símbolo com o ícone 
mostra quantos documentos estão prontos para impressão, incluindo o documento 
sendo impresso no momento.
Para obter o estado de um trabalho de impressão: Clique duas vezes no botão de 
Início, toque no ícone Impressão e, em seguida, selecione um trabalho de impressão.
Para cancelar um trabalho de impressão: Clique duas vezes no botão de Início, toque no ícone Impressão, selecione o trabalho de impressão e, em seguida, toque em 
Cancelar Impressão.
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Como fazer uma busca
Você pode fazer buscas em muitos aplicativos integrados do iPad incluindo o Mail, o 
Calendário, o iPod, o Vídeo, o Notas e os Contatos. Faça buscas em um aplicativo individual ou em todos os aplicativos de uma só vez utilizando o Spotlight.
Para abrir o Spotlight: Na página principal da tela de Início, passe o dedo para a direita ou pressione no botão de Início. Na página do Spotlight, você pode pressionar o 
botão Início para voltar à página principal da tela Início.
Como buscar no iPad: Na página do Spotlight, digite o texto no campo de busca. Os 
resultados da busca aparecem automaticamente à medida que você digita. Toque em 
Buscar para que o teclado desapareça e você possa ver mais resultados. 
Toque em um item na lista de resultados para abri-lo. Os ícones à esquerda dos resultados da busca permitem saber de qual app os resultados vieram.  
No topo da lista, o iPad mostra os seus resultados mais relevantes baseado em buscas 
anteriores. Na parte inferior da lista, os resultados de pesquisa também incluem op-
ções de busca na web ou na Wikipedia.
App O que está sendo buscado
Contatos Nome, sobrenome e nomes de empresas
Mail Campos Para, De e Assunto de todas as contas (o 
texto das mensagens não é buscado)
Calendário Títulos de eventos, convidados e locaisApp O que está sendo buscado
iPod Música (nomes de músicas, artistas e álbuns) e os 
títulos de podcasts e audiolivros
Notas Texto das notas
O Spotlight também busca os nomes de aplicativos integrados e instalados no iPad. Se 
você tiver muitos aplicativos, você pode usar o Spotlight para localizá-los e abri-los.
Para abrir um aplicativo do Spotlight: Digite o nome do aplicativo e depois toque 
para abri-lo.
Você pode escolher em quais aplicativos é realizada a busca e a ordem na qual eles 
são buscados. Em Ajustes, selecione Geral > Busca do Spotlight.
Como usar os dispositivos Bluetooth
Você pode usar o iPad com o teclado Apple Wireless Keyboard e com outros dispositivos Bluetooth, como fones de ouvido Bluetooth. Para os perfis compatíveis Bluetooth, 
consulte o site support.apple.com/kb/HT3647?viewlocale=pt_BR.
Como Emparelhar Dispositivos Bluetooth
Primeiro você deve emparelhar os dispositivos Bluethooth (como o teclado ou os fones de ouvido) com o iPad, antes de poder usá-los.
Como emparelhar um dispositivo Bluetooth com o iPad:
1 Siga as instruções fornecidas com o dispositivo para torná-lo visível.
2 Nos Ajustes, escolha Geral > Bluetooth e ative a opção Bluetooth.
3 Selecione o dispositivo e, caso solicitado, digite o código de acesso ou o número 
PIN. Consulte as instruções sobre o código de acesso ou PIN que acompanham o 
dispositivo.
Nota: Antes de emparelhar um teclado Apple Wireless Keyboard, pressione o botão 
de alimentação para ligar o teclado. Você apenas pode emparelhar um teclado Apple 
Wireless Keyboard de cada vez com o iPad. Para emparelhar um teclado diferente, primeiro você deve desemparelhar o atual.
Depois de emparelhar seu teclado com o iPad, o nome do produto e um ícone 
Bluetooth  aparecem na tela.
Depois de emparelhar seus fones de ouvido com o iPad, o nome do produto e um 
ícone de áudio Bluetooth  aparecem na tela quando você estiver visualizando os 
controles de reprodução de áudio ou vídeo. Toque no  para mudar para uma saída 
de áudio diferente, como o alto-falante interno.
Para usar o teclado na tela novamente, desative o Bluetooth (Ajustes > Geral > 
Bluetooth), ou pressione a tecla Ejetar no teclado Bluetooth.
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Estado do Bluetooth
O ícone do Bluetooth aparece na barra de estado do iPad, que está situada na parte 
superior da tela:
Â (branco):   O Bluetooth está ativado e o dispositivo está conectado ao iPad. 
Â (cinza):   O Bluetooth está ativado mas não há nenhum dispositivo conectado. Se 
você emparelhou um dispositivo com o iPad, talvez ele esteja fora do raio de alcance ou desligado.
Â Nenhum ícone Bluetooth:  O Bluetooth está desativado.
Como Desemparelhar um Dispositivo do iPad
Se você emparelhar o iPad com um dispositivo Bluetooth e depois quiser usar outro 
dispositivo do mesmo tipo no lugar, você deve desemparelhar o primeiro dispositivo.  
Para desemparelhar um dispositivo Bluetooth:
1 Nos Ajustes, escolha Geral > Bluetooth e depois ative a opção Bluetooth.
2 Escolha o dispositivo, depois toque em “Esquecer este Dispositivo”.
Compartilhamento de Arquivos
O Compartilhamento de Arquivos permite transferir arquivos entre o iPad e o seu computador. É possível compartilhar arquivos criados com um aplicativo compatível salvo 
no formato compatível.
Os aplicativos compatíveis com o compartilhamento de arquivos aparecem na lista 
Apps de Compartilhamento de Arquivos no iTunes. Para cada app, a lista exibe os 
documentos que estão no iPad. Consulte a documentação do aplicativo para saber 
como ele compartilha os arquivos; nem todos os aplicativos são compatíveis com este 
recurso.
Para transferir um arquivo do iPad ao seu computador:
1 Conecte o iPad ao seu computador. 
2 No iTunes, selecione o iPad na lista Dispositivos e clique em Aplicativos, na parte superior da tela.
3 Na seção Compartilhamento de Arquivos, selecione um aplicativo da lista à esquerda.
4 À direita, selecione o arquivo que deseja transferir e, em seguida, clique em "Salvar 
para" e selecione um destino do seu computador.
Para transferir um arquivo do seu computador ao iPad:
1 Conecte o iPad ao seu computador. 
2 No iTunes, selecione o iPad na lista Dispositivos e clique em Aplicativos, na parte superior da tela.
3 Na seção Compartilhamento de Arquivos, clique em Adicionar.4 Selecione um arquivo e, em seguida, clique em Selecionar (Mac) ou OK (PC).
O arquivo é transferido para seu dispositivo e pode ser aberto utilizando um aplicativo 
compatível com o tipo de arquivo. Para transferir mais de um arquivo, selecione cada 
arquivo adicional.
Para apagar um arquivo do iPad: Selecione o arquivo na lista Arquivos e, em seguida, 
toque em Apagar.
Como usar o AirPlay
Você pode transmitir música, fotos e vídeo sem fio para a sua HDTV e alto-falantes 
usando o AirPlay e o Apple TV.
Você também pode usar o AirPlay para transmitir áudio para uma estação base Airport 
Express ou AirPort Extreme. Outros receptores compatíveis com o AirPlay estão disponíveis através de terceiros, consulte a Apple Store para obter mais detalhes.
Para iniciar a transmissão para um dispositivo compatível com o AirPlay:
1 Certifique-se de que o iPad e o dispositivo (como um Apple TV) estão conectados à 
mesma rede Wi-Fi.
2 Inicie o vídeo, apresentação de slides ou música e, em seguida toque no  e escolha 
o dispositivo AirPlay que deseja usar. Alguns dispositivos podem solicitar um código 
de acesso.
Uma vez que a transmissão é iniciada, você pode sair do aplicativo.
Para parar a transmissão para um dispositivo compatível com o AirPlay:
1 Abra o aplicativo (como Vídeos) a partir do qual está transmitindo.
2 Toque em  e escolha iPad da lista.
Para solução de problemas, consulte “Sem vídeo ou som ao utilizar o AirPlay” na 
página 204.
Recursos de segurança
Os recursos de segurança ajudam a proteger as informações do iPad, impedindo que 
sejam acessadas por outras pessoas.  
Códigos de acesso e Proteção de Dados
Por segurança, você pode configurar um código que precisará ser digitado sempre 
que você ativar ou interromper o repouso do iPad.
Para definir um código: Escolha Ajustes > Geral > Bloqueio por Código > Ativar 
Código. Insira um código de 4 dígitos e, em seguida, insira-o novamente para comprová-lo. O iPad solicitará que você insira o código para desbloqueá-lo ou para exibir os 
ajustes de bloqueio do código.
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A configuração de um código ativa a proteção de dados, a qual utiliza o código de 
acesso como chave para criptografar mensagens de e-mail e seus anexos armazenados 
no iPad. (Talvez a proteção de dados também possa ser utilizada por alguns aplicativos 
disponíveis na App Store). Um aviso na parte inferior da tela Bloqueio por Código, em 
Ajustes, mostra quando a proteção de dados está ativada.
Para aumentar a segurança, desative o Código Simples (um número de quatro dígitos) 
e utilize um código mais complexo que contenha uma combinação de números, letras, 
pontuação e caracteres especiais. Para obter mais informações, consulte “Bloqueio por 
Código” na página 173.
Buscar Meu iPad
Buscar Meu iPad ajuda a localizar um iPad perdido ou mal posicionado usando um 
outro iPhone, iPad ou iPod touch com o aplicativo gratuito Buscar Meu iPhone, ou um 
Mac ou PC com um navegador da web. O recurso Buscar Meu iPad inclui:
Â Buscar:Localiza seu iPad em um mapa em tela cheia do seu computador
Â Exibir uma Mensagem ou Reproduzir um Som:Permite que você especifique uma 
mensagem a ser exibida ou um som a ser reproduzido no seu iPad
Â Bloqueio de Código Remoto:Permite bloquear remotamente seu iPad e criar um 
código de acesso de 4 dígitos, se você não tiver definido um anteriormente 
Â Limpeza Remota:Elimina todas as informações e mídia no seu iPad e restaura-o iPad 
para os seus ajustes originais de fábrica
Para usar o recurso Buscar Meu iPad: Ative Buscar Meu iPad nos seus ajustes de conta 
MobileMe. Consulte “Como Configurar Contas MobileMe” na página 32.
Localize o seu iPad perdido: Transfira e use o aplicativo Buscar Meu iPhone a partir 
da App Store em um dispositivo iOS diferente, ou inscreva-se ao www.me.com em um 
navegador web em um Mac ou PC.
Nota: O recurso Buscar Meu iPad requer uma conta do MobileMe. O MobileMe é um 
serviço on-line que fornece Buscar Meu iPad gratuitamente para clientes de 4ª geração 
do iPad, iPhone e iPod touch. O MobileMe fornece recursos adicionais com uma assinatura paga. O MobileMe pode não estar disponível em todos os países ou regiões. Para 
obter mais informações, visite o site www.apple.com/br/mobileme.50
Sobre o Safari
Use o Safari no iPad para navegar pela web e visitar os seus sites favoritos. Use o 
AirPrint para imprimir as páginas web e PDFs. Abra múltiplas páginas e adicione web 
clips à tela de Início para acesso rápido. Crie favoritos no iPad e sincronize-os com seu 
computador. 
Para usar o Safari, o iPad deve ter uma conexão à Internet. Consulte “Como Conectar-se 
à Internet” na página 30.
Como Visualizar Páginas Web
Você pode visualizar páginas web na vertical ou na horizontal.  Gire o iPad e a página 
web girará, ajustando-se automaticamente para ajustar-se à página.
4
SafariCapítulo 4    Safari 51
Como Abrir Páginas Web
Para abrir uma página web: Toque no campo de endereço (na barra de título) para 
que apareça o teclado na tela, digite o endereço web e depois toque em Ir. Se o campo de endereço não estiver visível, toque na barra de estado situada na parte superior 
da tela para rolar rapidamente para o campo de endereço.
À medida que você digita, aparecem os endereços web que começam com aquela 
letra. São as suas páginas favoritas ou as que você abriu recentemente. Toque em um 
endereço para ir para aquela página. Continue digitando se deseja inserir um endere-
ço web que não está na lista.
Para apagar o texto no campo de endereço: Toque no campo endereço e, em seguida, toque em  .
Como Realizar o Zoom e a Rolagem
Para ampliar e reduzir: Toque duas vezes em uma coluna de uma página web para 
ampliá-la. Toque duas vezes novamente para reduzi-la..
Você pode também separar ou juntar os dedos para ampliar ou reduzir.
Para rolar por uma página web Arraste para cima, para baixo ou para os lados. 
Ao rolar, você pode tocar e arrastar em qualquer 
lugar da página sem ativar nenhum link.
Para rolar dentro de um quadro em uma página 
web
Use dois dedos para rolar dentro de um quadro 
de uma página web. Use um dedo para rolar a 
página web inteira.
Para rolar rapidamente para o topo de uma 
página web
Toque na barra de estado na parte superior da 
tela do iPad.
Como Navegar por Páginas Web
Os links de uma página web normalmente o levam a um lugar diferente na web.
Para seguir um link em uma página web: Toque no link.Links no iPad também podem exibir uma localização nos Mapas ou criar uma mensagem do Mail com endereço predefinido. Para voltar ao Safari após um link abrir outro 
aplicativo, clique duas vezes no botão Início  e toque em Safari.
Para ver o endereço de destino de um link Mantenha pressionado o link. O endereço aparece em uma janela próxima ao seu dedo. Você 
pode abrir o link na página ativa, em uma nova 
página ou copiar o endereço.
Para interromper o carregamento de uma pá-
gina web
Toque  .
Para recarregar uma página web
Toque no  .
Para ir para a página anterior ou seguinte Toque na  ou  na parte superior da tela.
Como colocar uma página nos favoritos
Toque no  e, em seguida, toque em Favorito.
Como adicionar um clipe de uma página web à 
tela Início
Toque no  e toque em “Adicionar à Tela Início.”
Para retornar a uma página visualizada 
recentemente
Toque no  e toque em Histórico. Para limpar a 
lista do histórico, toque em Limpar.
Como enviar um endereço de página web em 
um e-mail
Toque no  e toque em “Enviar Link por e-mail".
Como salvar uma imagem ou foto na sua 
Fototeca
Mantenha pressionada a imagem e, em seguida, 
toque em Salvar Imagem.
Como Abrir Várias Páginas
Você pode abrir até nove páginas ao mesmo tempo. Alguns links abrem automaticamente uma nova página ao invés de substituir a página atual.
Para abrir uma nova página: Toque no  e toque em Nova Página.
Para ir para uma página diferente:Toque no  e, em seguida, toque na página que 
deseja visualizar.
Para fechar uma página: Toque no  e toque no  .
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Como Digitar Texto e Preencher Formulários
Algumas páginas web possuem campos de texto e formulários para preencher. Você 
pode configurar o Safari para que memorize nomes e senhas de sites que visitar e para 
preencher campos de texto automaticamente com as informações dos Contatos.
Como fazer o teclado aparecer Toque dentro de um campo de texto.
Para mover para outro campo de texto Toque em outro campo de texto ou nos botões 
Próximo ou Anterior acima do teclado na tela.
Para enviar um formulário Depois de preencher o formulário, toque em Ir 
ou Buscar. A maioria das páginas também possuem um link que você pode tocar para enviar o 
formulário.
Para fechar o teclado sem enviar o formulário Toque na tecla Teclado  para ocultar o teclado 
na tela.
Para ativar o Preenchimento Automático para ajudá-lo a preencher formulários da 
web: Em Ajustes, escolha Safari > Preenchimento Automático e, em seguida, siga um 
destes procedimentos:
Â Para utilizar as informações dos contatos, ative Dados de Contato; em seguida, escolha Meus Dados e selecione o contato que deseja utilizar.
O Safari utiliza as informações dos Contatos para preencher os campos de contato 
nos formulários da web.
Â Para utilizar as informações dos nomes e senhas, ative Nomes e Senhas.
Quando esse recurso está ativado, o Safari se lembra dos nomes e senhas dos sites 
que você visitou e automaticamente preenche as informações quando você visita o 
site novamente.
Â Para remover todas as informações do Preenchimento Automático, toque em Limpar 
Tudo.
Como imprimir páginas web e arquivos PDF
Use o AirPrint para imprimir as páginas web e PDFs do Safari.
Para imprimir uma página web ou PDF: Toque em  na parte superior da tela e, em 
seguida, toque em Imprimir. Toque em Selecionar Impressora para selecionar uma impressora e definir as opções da impressora. Em seguida, toque em Imprimir.
Para obter mais informações sobre impressão a partir do iPad, consulte “Impressão” na 
página 42.Como Buscar na Web
Insira palavras ou frases no campo de busca para pesquisar pela web e página web 
atual. Conforme você digita, aparecem buscas recentes e sugeridas. 
Para buscar na web:
1 Toque no campo de busca (do lado direito da barra de título).
2 Digite uma palavra ou frase que descreva o que você está procurando, depois toque 
em Buscar.
3 Toque em um link da lista de resultados da busca para abrir uma página web.
Para obter dicas sobre como buscar na Internet efetivamente, visite o site www.google.
com/help/features.html ou help.yahoo.com/us/yahoo/search/basics.
Para procurar uma palavra ou frase na página web atual: No final da lista de resultados, toque na entrada embaixo de Nesta Página para localizar a primeira ocorrência de 
uma palavra ou frase. Para localizar ocorrências subsequentes, toque em Seguinte na 
parte inferior da tela.
Por padrão, o Safari realiza buscas utilizando o Google. Para alterar o padrão para um 
mecanismo de pesquisa diferente, em Ajustes, escolha Safari > Motor de Busca e escolha um motor de busca.
Favoritos
Você pode marcar uma página web que deseja ver mais tarde como favorita.
Como marcar uma página web como favorito: Abra a página e toque em  . Depois 
toque em Adicionar Favorito.
Quando você salva um favorito, pode editar o seu título. Por padrão, os favoritos são 
salvos na parte superior dos Favoritos. Toque em Favoritos para escolher uma pasta 
diferente.
Se você usa o Safari em um Mac, ou o Safari ou o Microsoft Internet Explorer em um 
PC, você pode sincronizar os favoritos com o navegador do seu computador.
Para sincronizar os favoritos com o seu computador:
1 Conecte o iPad ao seu computador.
2 No iTunes, selecione iPad na barra lateral.
3 Clique na aba de Informações, selecione “Sincronizar favoritos do Safari" em Outros e 
depois clique em Aplicar.
Para obter mais informações, consulte “Como Sincronizar com o iTunes” na página 25.
Para sincronizar os favoritos com o MobileMe:  Nos Ajustes do iPad, selecione 
Favoritos em sua conta do MobileMe. Consulte “Como Configurar Contas MobileMe” na 
página 32.
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Para abrir uma página web guardada como favorito: Toque no  ; depois, escolha 
um favorito ou toque em uma pasta para ver os favoritos dentro dela.
Para editar um favorito ou uma pasta de favoritos:Toque no  , escolha a pasta que 
possui o favorito ou a pasta que deseja editar e toque em Editar. Em seguida, realize 
uma das seguintes ações:
Â Para criar uma nova pasta, toque em Nova Pasta.
Â Para apagar um favorito ou pasta, toque no  e, em seguida, toque em Apagar.
Â Para reposicionar um favorito ou pasta, arraste  .
Â Para editar o nome ou endereço, ou para colocá-lo em uma pasta diferente, toque no 
favorito ou na pasta.
Quando acabar, pressione OK.
Web Clips
Adicione web clips à tela de Início para obter acesso rápido as suas páginas web marcadas como favoritas. Os web clips aparecem como ícones na tela de Início, e você 
pode organizá-los junto com os outros ícones de aplicativos. Consulte “Como reorganizar os ícones dos aplicativos” na página 40.
Para adicionar um clip da web: Abra a página web e toque em  . Em seguida, toque 
em “Adicionar à Tela Início”.
Ao abrir um web clip, o Safari amplia e rola automaticamente para a área da página 
web que foi exibida quando você salvou o web clip. A área exibida é também usada 
para criar o ícone do web clip na sua tela de Início, a menos que a página web tenha o 
seu próprio ícone personalizado.
Quando você adiciona um web clip, você pode editar o nome dele. Se o nome for muito longo (mais de 10 caracteres), ele pode aparecer abreviado na tela de Início.
Os web clips não são sincronizados pelo MobileMe ou iTunes, mas são copiados como 
backup pelo iTunes.
Para apagar um clip da web:
1 Mantenha pressionado qualquer ícone na tela de Início até que os ícones comecem a 
tremular.
2 Toque no  no canto do web clip que deseja apagar.
3 Toque em Apagar; depois, pressione o botão Início  para salvar sua ordenação.56
Sobre o Mail
Leia este capítulo para aprender como usar o Mail para ler suas mensagens de e-mail e 
compor novas mensagens.
Você pode visualizar as mensagens de todas as suas contas de e-mail de uma vez, e o 
Mail exibe os encadeamentos de mensagens para que seja fácil seguir uma conversa. 
Você pode enviar ou receber fotos e gráficos integrados e visualizar PDFs e outros anexos. Use o AirPrint para imprimir mensagens e seus anexos. 
O Mail funciona com o MobileMe, Microsoft Exchange e com muitos dos serviços de 
correio mais populares, incluindo o Yahoo! Mail, o e-mail do Google e AOL—assim 
como com outros serviços de e-mail padrão POP3 e IMAPs. 
Para enviar ou receber mensagens no Mail, o iPad deve possuir uma conexão à 
Internet. Consulte “Como Conectar-se à Internet” na página 30.
Como Configurar Contas de E-mail
Você pode configurar contas de e-mail no iPad de uma das seguintes formas:
Â Configure suma conta diretamente no iPad. Consulte “Como adicionar Mail, Contatos 
e Contas do Calendário” na página 32.
Â No iTunes, utilize os painéis de ajustes do iPad para sincronizar ajustes de contas de 
e-mail a partir do seu computador. Consulte “Como Sincronizar com o iTunes” na 
página 25.
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Como Enviar um e-mail
Você pode enviar uma mensagem de e-mail a qualquer pessoa que possua um endereço de e-mail.
Para escrever e enviar uma mensagem:
1 Toque no  na parte superior da tela.
2 Digite um nome ou um endereço de e-mail no campo Para ou toque no  para adicionar um nome dos seus contatos.
À medida em que você digita um endereço de e-mail, os endereços de e-mail coincidentes da sua lista de contatos vão aparecendo. Toque em um endereço para adicioná-lo. Para adicionar mais nomes, toque no  . 
Nota: Se você estiver redigindo uma mensagem da sua conta Microsoft Exchange e 
possuir acesso à lista GAL (Global Address List) da sua empresa, os endereços coincidentes dos contatos do iPad aparecerão primeiro e depois aparecerão os endereços 
GAL coincidentes.
3 Toque em Cc/Cco/De se você deseja enviar a mensagem com cópia ou com cópia 
oculta a outras pessoas, ou se deseja alterar a conta a partir da qual você envia a mensagem. Se tiver mais de uma conta de e-mail, você pode tocar no campo De para alterar a conta de onde a está enviando.
4 Digite um assunto e depois digite sua mensagem.
Você pode tocar em Retornar para mover-se do campo Título para o corpo da 
mensagem.
5 Toque em Enviar.
Como enviar uma foto em uma mensagem de 
e-mail
Em Fotos, escolha uma foto, toque em  , depois 
toque em Enviar Foto por E-mail. Para enviar 
várias fotos na mesma mensagem, toque em 
quando estiver visualizando miniaturas em um 
álbum. Você também pode copiar e colar fotos.
A foto é enviada usando a sua conta de e-mail 
padrão. Para alterar a conta de envio padrão, consulte “Mail, Contatos, Calendários” na página 179.
Como salvar um rascunho de uma mensagem 
para completá-la mais tarde
Toque em Cancelar e depois toque em Salvar. A 
mensagem é salva na caixa Rascunhos. Para abrir 
rapidamente o rascunho salvo mais recentemente, toque e mantenha o  .
Para responder uma mensagem Abra uma mensagem e toque em  . Toque em 
Responder para responder somente ao remetente ou em Responder a Todos para responder ao 
remetente e a todos os destinatários. Digite a sua 
resposta e depois toque em Enviar.
As imagens ou arquivos anexos da mensagem 
original não são incluídos na resposta.Para encaminhar uma mensagem Abra uma mensagem e toque em  e, em seguida, toque em Encaminhar. Adicione um ou 
mais endereços de e-mail, digite a sua mensagem 
e depois toque em Enviar.
Ao encaminhar uma mensagem, você pode 
incluir as imagens ou arquivos anexos da mensagem original. 
Para compartilhar informações de contatos Nos Contatos, escolha um contato, depois toque 
em Compartilhar. Adicione um ou mais endere-
ços de e-mail, digite a sua mensagem e depois 
toque em Enviar.
Como Verificar e Ler E-mails
O ícone do Mail mostra o número total de mensagens que ainda não foram lidas em 
todas as suas caixas de entrada. Você pode ter outras mensagens não lidas em outras 
caixas de correio.
Quantidade de mensagens 
não lidas nas suas caixas 
de entrada
Para verificar se há novas mensagens: Escolha uma caixa de correio, toque em Caixa 
de Entrada ou em  .
Na tela de cada conta, você pode ver o número de mensagens não lidas em cada caixa 
de correio. Toque em uma caixa de correio para ver as mensagens. As mensagens não 
lidas possuem um ponto azul  ao lado delas. 
Se você tiver mais de uma conta de correio, toque em Caixas de Correio para alternar 
entre contas. Para visualizar todas as suas mensagens em uma caixa de entrada unificada, toque em Todas as Caixas de Correio.
Quantidade de 
mensagens não lidas
Mensagens
não lidas
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As mensagens relacionadas são agrupadas em um encadeamento. Somente a primeira 
mensagem é exibida na caixa de entrada e a quantidade de mensagens relacionadas 
é indicada. Para visualizar o encadeamento, toque-o. Para desativar o encadeamento 
de mensagens, vá para Ajustes > “Mail, Contatos, Calendários” e desative “Organizar Por 
Encadeamento”.
Ao abrir uma caixa de correio, o Mail carrega a quantidade de mensagens especificadas nas configurações do Mail, caso as mensagens ainda não tenham sido carregadas 
automaticamente. Consulte “Mail, Contatos, Calendários” na página 179.
Para carregar mensagens adicionais: Role para o final da lista de mensagens e toque 
em Carregar Mais Mensagens.
Para ler uma mensagem: Toque em uma caixa de correio e depois toque em uma 
mensagem. Dentro de uma mensagem, toque na  ou  para ver a próxima mensagem ou a mensagem anterior.Girar o iPad entre as orientações vertical e horizontal permite que você enfoque em 
uma única mensagem, ou veja todas as mensagens para que possa rapidamente verificar e visualizar aquelas que lhe interessam mais.
Como ampliar uma parte de uma mensagem Toque duas vezes na área para ampliá-la. Toque 
duas vezes novamente para reduzi-la.
Como redimensionar qualquer coluna de texto 
para que se ajuste à tela
Toque duas vezes no texto.
Para redimensionar uma mensagem  Toque a mensagem com dois dedos e separe-os 
ou aproxime-os para ampliar ou reduzir.
Como abrir um link Toque no link.
Os textos dos links normalmente aparecem sublinhados em azul. Muitas imagens também são 
links. Um link pode levá-lo uma página web, abrir 
um mapa, ou abrir uma mensagem de e-mail 
com o campo de endereço já preenchido.
Os links de web e mapas abrem o Safari ou o 
Mapas no iPad. Para voltar ao Mail, pressione o 
botão Início e pressione Mail.
Para ver o endereço de destino de um link Mantenha pressionado o link. Você pode abrir o 
link no Safari ou copiar o endereço do link para a 
área de transferência.
O iPad mostra os anexos de imagem nos formatos usados mais frequentemente (JPEG, 
GIF e TIFF) alinhados com o texto das mensagens de e-mail. O iPad pode reproduzir 
vários anexos de áudio, como MP3, AAC, WAV e AIFF. Você pode transferir e visualizar 
arquivos (como PDF, páginas web, textos, arquivos do Pages, Keynote, Numbers e documentos do Microsoft Word, Excel e PowerPoint) que estejam anexos às mensagens 
que receber.
Para abrir um arquivo anexo: Toque no anexo para transferi-lo para o iPad e, em seguida, abra-o. Se o iPad não for compatível com o formato de uma arquivo em anexo, 
você pode ver o nome do arquivo, mas não pode abri-lo.  
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Para abrir um arquivo anexo com um aplicativo diferente: Toque e mantenha pressionado o anexo e, em seguida, escolha um aplicativo. Se você não tiver nenhum 
aplicativo que possa abrir o anexo, você pode vê-lo, desde que seja um tipo de arquivo 
que compatível com o iPad.
Para obter uma lista de formatos de documento compatíveis, consulte “Se os anexos 
do e-mail não abrirem” na página 202.
Para salvar uma foto anexa no seu álbum Fotos Salvas: Toque na foto e depois toque 
em Salvar Imagem.  
Como ver todos os destinatários de uma 
mensagem
Toque em Detalhes na parte superior da tela.
Pressione o nome ou o endereço de e-mail para 
ver as informações de contato do destinatário. 
Toque no endereço de e-mail para contatar 
a pessoa. Toque em Ocultar para ocultar os 
destinatários.
Para adicionar um destinatário de e-mail a sua 
lista de contatos
Toque na mensagem e toque em Detalhes para 
ver os destinatários. Depois toque em um nome 
ou endereço de e-mail e toque em Criar Novo 
Contato ou "Adicionar a Contato”.
Para marcar uma mensagem como não lida Abra a mensagem e toque em “Marcar como Não 
Lida” próximo à linha do título.
Um ponto azul  aparecerá ao lado da mensagem na lista de caixas de correio até que você a 
abra novamente.
Para abrir um convite de uma reunião: Toque no convite.
Você pode obter as informações de contato do organizador e dos convidados, definir 
um alerta, adicionar notas ao evento e adicionar comentários que serão incluídos na 
sua resposta e enviados por e-mail ao organizador. Você pode aceitar, aceitar provisoriamente ou recusar o convite. Consulte “Como Responder a Convites de Reuniões” na 
página 96.
Para salvar uma foto anexada no Fotos:  Toque na foto e depois toque em Salvar 
Imagem. Como Buscar E-mails
Você pode buscar nos campos Para, De e Assunto das mensagens de e-mail. O Mail 
busca as mensagens transferidas na caixa de correio aberta no momento. Para o 
MobileMe, Exchange e algumas contas de e-mail IMAP, você pode também buscar 
mensagens do servidor.
Para buscar mensagens de e-mail: Abra uma caixa de correio, role até o topo e digite 
o texto no campo Buscar. Toque em De, Para, Assunto ou Tudo (De, Para e Assunto) 
para escolher os campos nos quais deseja buscar. (Toque na barra de estado para rolar 
rapidamente para o topo da lista e revelar o campo de busca.)
Os resultados da busca nas mensagens já transferidas para o iPad aparecem automaticamente conforme você digita. Toque em Buscar para que o teclado desapareça e 
você possa ver mais resultados. 
Para apagar ou mover mensagens encontradas:  Após concluir a pesquisa, toque em 
Editar e, em seguida, selecione as mensagens que deseja apagar ou mover. Uma marca 
aparece ao lado de cada mensagem selecionada. Para apagar as mensagens, toque 
em Apagar. Para mover as mensagens, toque em Mover e, em seguida, toque em uma 
pasta de destino.
Para buscar mensagens no servidor: Toque em “Continuar Busca no Servidor” no final 
dos resultados da busca.
Nota: Os resultados de pesquisa de mensagens nos servidores podem variar porque 
alguns servidores procuram somente palavras completas.
Para imprimir mensagens e anexos
Você pode usar o AirPrint para imprimir as mensagens de e-mail e anexos que o iPad 
pode visualizar. 
Para imprimir Receber uma mensagem de e-mail:Toque no  e, em seguida, toque 
em Imprimir. Selecione as opções de impressão que deseja e, em seguida, toque em 
Imprimir.
Para imprimir uma imagem sem o restante da mensagem de e-mail, salve a imagem 
(toque na imagem e toque em Salvar Imagem) e, em seguida, abra Fotos e imprima a 
imagem do seu álbum Fotos Salvas.
Para imprimir um anexo: Toque no anexo para visualizá-lo e, em seguida, toque em 
 e toque em Imprimir. Selecione as opções que deseja e, em seguida, toque em 
Imprimir.
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Para obter mais informações sobre a utilização de impressoras AirPrinter, consulte 
“Impressão” na página 42.
Como Organizar os E-mails
Você pode apagar mensagens uma de cada vez ou selecionar um grupo para apagar 
todas de uma vez. Você também pode mover mensagens de uma caixa de correio ou 
pasta para outra.
Para apagar uma mensagem: Abra a mensagem e toque em  . Ou, passe o dedo para 
a esquerda ou para a direita sobre o título da mensagem na lista de mensagens e depois toque em Apagar.
Para apagar várias mensagens: Ao visualizar uma lista de mensagens, toque em 
Editar, selecione as mensagens que você deseja apagar e depois toque em Apagar. 
Você também pode pesquisar as mensagens e escolher aquelas que deseja apagar. 
Consulte “Como Buscar E-mails” na página 62.
Para mover uma mensagem para outra caixa de correio ou pasta: Ao visualizar uma 
mensagem, toque no  e depois escolha uma caixa de correio ou pasta.
Para mover várias mensagens: Quando visualizar uma lista de mensagens, pressione 
Editar, selecione as mensagens que deseja mover, toque em Mover e selecione uma 
caixa de correio ou pasta. Você também pode pesquisar as mensagens e escolher 
aquelas que deseja mover. Consulte “Como Buscar E-mails” na página 62.64
Sobre a Câmera
Com o iPad, você tem uma ótima câmera fotográfica e uma câmera de vídeo para levar 
a qualquer lugar. O iPad possui uma câmera posterior que tira fotos e realiza vídeos de 
alta definição. Além disso, possui uma câmera frontal que permite que você faça liga-
ções de vídeo do FaceTime e que você realize fotos e vídeos próprios.
Use a tela para controlar a câmera posterior e para ver a foto ou o vídeo que está realizando. Você pode tocar em qualquer lugar da tela para selecionar um objeto ou área 
especifica, e ajustar automaticamente a exposição baseada naquela parte da imagem. 
O recurso de autofoco (máximo de 10 cm) e um zoom digital de 5x permitem tirar ótimos close-ups. 
Se você possui uma conexão de Internet e os serviços de localização estão ativados, as 
fotos e vídeos são etiquetados com dados de localização. Você pode usar os dados de 
localização com alguns aplicativos e sites de compartilhamento de fotos para controlar 
e publicar onde você tirou as fotos. Por exemplo, o aplicativo Fotos organiza fotos de 
acordo com lugares.
Nota: Se os serviços de localização estiverem desativados quando abrir a Câmera pela 
primeira vez, talvez seja solicitado que você ative estes serviços. Se você não quiser 
incluir os dados da localização em suas fotos e vídeos, poderá utilizar a Câmera sem 
ativar os serviços de localização. Consulte “Serviços de Localização” na página 169.
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Como tirar fotos e gravar vídeos
Tirar fotos e gravar vídeos com o iPad é tão fácil como apontar e tocar. Certifique-se de 
que o botão Câmera/Vídeo esteja ajustado para  .
Para tirar uma foto: Direcione o iPad e toque  .
Ao tirar uma foto ou iniciar uma gravação de vídeo, o iPad emite um som de obturador. Você pode usar os botões de volume para controlar o volume do som do obturador. O som não será emitido se você ajustar o botão Interruptor Lateral para silencioso. 
Consulte “Botões” na página 10.
Nota: Em algumas regiões, os efeitos de som da Câmera são reproduzidos, mesmo se 
o botão Interruptor Lateral estiver ajustado para o modo silencioso.
Para gravar um vídeo: Deslize o interruptor Câmera/Vídeo para  , depois toque em 
 para iniciar a gravação. O botão de gravação pisca enquanto você grava. Toque 
em  novamente para parar a gravação.
Para alterar a área de foco e ajustar a exposição: Toque no local onde deseja definir a 
exposição. A câmera ajusta a exposição para a área selecionada da imagem. 
Para ampliar e reduzir: Toque na tela e, em seguida, arraste o controle deslizante da 
parte inferior da tela para ampliar ou reduzir (câmera principal, somente no modo 
câmera).
Para alternar entre as câmeras frontal e posterior:Toque em  no canto superior 
direito da tela.
Para rever uma foto ou vídeo que você acabou de fazer: Toque na miniatura de sua 
última foto, no canto inferior esquerdo da tela. 
Utilize as flechas esquerda e direita na parte inferior da tela para rever outras fotos e 
vídeos no Rolo da Câmera, ou apenas passe o dedo para a esquerda ou para a direita. 
Toque OK para voltar ao modo câmera ou vídeo. Se você não estiver visualizando os 
controles, toque na tela para exibi-los.Para apagar uma foto ou vídeo: Toque em  . Se não estiver visualizando o  , toque 
na tela para exibir os controles.
Para tirar uma foto: Pressione e solte rapidamente os botões Repousar/Despertar e 
o botão Início. A tela pisca quando uma captura de tela é tirada e a captura de tela é 
adicionada ao álbum Rolo da Câmera.
Como visualizar e compartilhar fotos e vídeos
As fotos e vídeos criados com a câmera são salvos no álbum Rolo da Câmera do iPad. 
Você pode visualizar o álbum Rolo da Câmera tanto em Câmera como em Fotos.  
Para visualizar fotos e vídeos do álbum Rolo da Câmera: Na Câmera, toque na imagem em miniatura do canto inferior esquerdo da tela. Em Fotos, toque no álbum Rolo 
da Câmera. Toque no botão esquerdo ou direito ou passe o dedo para a esquerda ou 
para a direita para navegar pelas fotos e vídeos.
Ao visualizar uma foto ou vídeo no álbum Rolo da Câmera, toque na tela para exibir os 
controles.
Para obter mais informações sobre visualização e compartilhamento de fotos e vídeos, 
consulte:
Â “Como visualizar fotos e vídeos” na página 76
Â “Compartilhamento de Fotos” na página 78
Como recortar vídeos
É possível recortar os fotogramas do começo e fim de um vídeo que acabou de gravar 
ou de qualquer outro vídeo no álbum Rolo de Câmera. Você pode substituir o vídeo 
original ou salvar a versão recortada como um novo videoclipe.
Para recortar um vídeo:
1 Enquanto visualiza um vídeo, toque na tela para exibir os controles.
2 Arraste as duas extremidades do visualizador de fotogramas que fica na parte superior 
do vídeo e toque em Recortar.
3 Toque em Recortar Original ou em "Salvar como Novo Clipe”.
Importante: Se selecionou Recortar Original, os fotogramas recortados são apagados 
permanentemente do vídeo original. Se selecionou "Salvar como Novo Clipe", um 
novo videoclipe recortado é salvo no álbum Rolo da Câmera e o vídeo original fica 
inalterado.
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Para carregar fotos e vídeos em seu computador
Você pode carregar as fotos e vídeos criados com sua câmera para os aplicativos de 
fotos de seu computador, como o iPhoto em um Mac.
Para carregar fotos e vídeos em seu computador:Conecte o iPad ao seu computador.
Â Mac:  Selecione as fotos e vídeos desejados e clique no botão Importar ou Transferir 
do iPhoto ou em outro aplicativo de foto compatível do seu computador.
Â PC:  Siga as instruções fornecidas com seu aplicativo de foto.
Se apagar as fotos e os vídeos do iPad quando transferi-los para o seu computador, 
eles serão removidos do álbum Rolo de Câmera. Você pode utilizar o painel de ajustes 
Fotos do iTunes para sincronizar fotos e vídeos (os vídeos apenas podem ser sincronizados com Macs) com o aplicativo Fotos do iPad. 68
Sobre o FaceTime
O FaceTime permite que você faça videoconferências através de Wi-Fi. Use a câmera 
frontal para conversar cara a cara ou a câmera posterior para compartilhar o que você 
está vendo ao redor.
Para usar o FaceTime, você precisa de um iPad 2 e uma conexão Wi-Fi com a Internet. 
A pessoa para a qual você ligar também deve ter um dispositivo ou computador 
que funcione com o FaceTime. Para obter mais informações, consulte “FaceTime” na 
página 186. 
Nota: Talvez o FaceTime não esteja disponível em todos os países ou regiões.
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Como iniciar a sessão
Para usar o FaceTime, você necessita um ID da Apple. Se você possui uma conta da 
iTunes Store, da MobileMe ou outra conta da Apple, você pode usar esse ID da Apple 
com o FaceTime. Se você não tiver um ID da Apple, poderá criar um quando abrir o 
FaceTime.
Você não precisa iniciar ou finalizar a sessão cada vez que utilizar o FaceTime. Uma 
vez que iniciar a sessão, você pode iniciar uma videoconferência do FaceTime 
imediatamente.
Para iniciar a sessão no FaceTime:
1 Abra o FaceTime, digite o seu ID e senha da Apple e depois toque em Iniciar a Sessão. 
Caso você ainda não tenha uma conta da Apple, você pode tocar em Criar Nova Conta 
e configurar uma nesse momento.
2 Na tela FaceTime, digite o e-mail que outras pessoas utilizarão para ligar para você no 
FaceTime e toque em Seguinte. Se é a primeira vez que você usou este e-mail para o 
FaceTime, talvez você tenha que verificar se recebeu novos e-mails nesta conta e responder a mensagem de confirmação da Apple. (Se você já adicionou a conta ao Mail 
no seu iPad, a verificação é automática.)
Agora você pode escolher um contato para iniciar uma ligação do FaceTime e outras 
pessoas podem ligar para você utilizando o e-mail que você forneceu. Caso utilize mais 
de um e-mail, você pode adicionar outros, como descrito abaixo.
Para criar uma nova conta:
1 Abra o FaceTime e digite Criar Nova Conta.
2 Siga as instruções da tela. O e-mail que você digitar será o ID da Apple da nova conta.
3 Na tela FaceTime, digite o e-mail que você deseja que as pessoas utilizem para conectar com você. Este endereço não necessita ser o mesmo que você digitou para o ID da 
Apple, mas deve ser um e-mail que funcione.
4 Responda o e-mail de confirmação enviado da Apple ao e-mail que você digitou no 
passo anterior.
Caso possua mais de um endereço de e-mail, você pode permitir que as pessoas liguem para você usando qualquer um deles.
Para adicionar e-mails:Escolha Ajustes > FaceTime e depois clique em Adic. Outro 
E-mail.
Para finalizar a sessão:Normalmente não é necessário finalizar a sessão do FaceTime—
basta apenas iniciar a sessão uma vez e abrir o FaceTime posteriormente, sem receber 
nenhuma solicitação de início de sessão novamente. Você não pode receber ligações 
do FaceTime quando a sessão não está iniciada. Mas, se precisar finalizar a sessão, escolha Ajustes > FaceTime e, em seguida, toque em Conta. Para desativar o FaceTime:  Se você não desejar receber ligações do FaceTime, escolha 
Ajustes > FaceTime e desative o FaceTime. 
Como realizar uma videoconferência do FaceTime
Para realizar uma ligação do FaceTime, escolha o aplicativo FaceTime e, em seguida, 
alguém dos seus contatos, favoritos ou da lista de ligações recentes. 
Para ligar para um contato:Toque em Contatos, escolha um nome e, em seguida, toque no endereço de e-mail ou número de telefone usado com o FaceTime.
Para adicionar um contato: Toque em Contatos, toque em  e depois digite o nome 
da pessoa e seu e-mail ou número de telefone. Para um contato fora da sua região, 
certifique-se de inserir o número completo, incluindo o código do país e o código de 
área—por exemplo, +1 (408) 555-1234 nos Estados Unidos.
Para reiniciar uma ligação recente:Toque em Recentes e escolha o nome ou número.
Para ligar para um favorito:Toque em Favoritos e, em seguida, toque em um nome ou 
número da lista.
Enquanto você está falando
Enquanto você está falando com alguém no FaceTime, você pode alternar entre as câ-
meras, mudar a orientação da câmera, silenciar o microfone, mover sua tela imagem a 
imagem, abrir outro aplicativo e finalmente, finalizar a sua ligação.
Para alternar entre as câmeras frontal e posterior:Toque em  .
Para alterar a orientação da câmera:Gire o iPad. A imagem que seu amigo vê se altera 
para coincidir com a tela.
Para evitar a rotação da tela quando você mover a câmera, ative o bloqueio de orienta-
ção. Consulte “Visualização na Vertical ou Horizontal” na página 16.
Para silenciar o microfone:Toque em  . Seu amigo poderá apenas vê-lo e você poderá ver e ouvir seu amigo.
Para mover sua tela imagem a imagem:Arraste a janela pequena para qualquer canto.
Para usar outros aplicativos durante uma ligação: Pressione o botão Início  , depois 
toque no ícone de um aplicativo. Você ainda poderá falar com o seu amigo, mas vocês 
não estarão visíveis. Para retornar ao vídeo, toque na barra verde da parte superior da 
tela.
Para finalizar a ligação:  Toque em  .
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Sobre o Photo Booth
É fácil tirar uma foto usando o Photo Booth. Torne a sua foto mais interessante aplicando um efeito ao tirá-la. O Photo Booth funciona com ambas as câmeras frontal e 
posterior. 
Como selecionar um efeito 
Antes de tirar uma foto, você pode selecionar um efeito a ser aplicado na imagem. 
Para selecionar um efeito:Toque no  e, em seguida, toque no efeito que deseja usar.
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Photo BoothPara distorcer uma imagem:  Se você selecionar um efeito de distorção, arraste o seu 
dedo pela tela para alterar a distorção. Você também pode juntar, passar ou girar os 
dedos na imagem para alterar a distorção.
Como tirar uma foto 
Para tirar uma foto no Photo Booth, simplesmente direcione o iPad e toque.
Para tirar uma foto: Direcione o iPad e toque  .
Quando você tira uma foto, o iPad reproduz o som de um obturador. Você pode utilizar 
os botões de volume da lateral do iPad para controlar o volume do som do obturador. 
O som não será emitido se você ajustar o botão Interruptor Lateral para silencioso. 
Consulte “Botões” na página 10.
Nota: Em algumas regiões, os efeitos de som são reproduzidos mesmo se o botão 
Interruptor Lateral estiver ajustado para o modo silencioso.
Para alternar entre as câmeras frontal e posterior:  Toque no  na parte inferior da 
tela.
Para rever a foto que acabou de tirar: Toque na miniatura da sua última captura. Passe 
os dedos para a esquerda ou para a direita para visualizar mais miniaturas. 
Se você não estiver visualizando os controles, toque na tela para exibi-los.
Para apagar uma foto: Selecione uma miniatura e, em seguida, toque no  .
Para gerenciar fotos:Toque na miniatura da foto—você pode selecionar mais que 
uma. Toque no  e, em seguida, toque em E-mail, Copiar ou Apagar.
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Como visualizar e compartilhar fotos
As fotos tiradas com o Photo Booth são salvas no álbum Rolo da Câmera no iPad. Você 
pode visualizar o álbum Rolo da Câmera no aplicativos Fotos. 
Para visualizar fotos no álbum Rolo da Câmera:  Em Fotos, toque no álbum Rolo da 
Câmera. Para navegar pelas fotos, toque no botão esquerdo ou direito, ou passe os dedos para a esquerda ou para a direita.
Você pode usar o Mail para enviar um foto do Photo Booth em uma mensagem de 
e-mail.
Para enviar uma foto: Toque em uma miniatura para selecionar a foto ou toque novamente para selecionar mais de uma foto. Toque no  e, em seguida toque no botão 
E-mail na parte inferior da tela. 
O Mail é aberto e cria ma nova mensagem com a foto anexada.
Como carregar fotos para o seu computador
Carregue as fotos tiradas com o Photo Booth para os aplicativos de fotos de seu computador, como o iPhoto em um Mac.
Para carregar as fotos para o seu computador: Conecte o iPad ao seu computador.
Â Mac:  Selecione as fotos que deseja carregar e clique no botão Importar ou Transferir 
no iPhoto ou em outro aplicativo de fotos compatível do seu computador.
Â PC:  Siga as instruções fornecidas com seu aplicativo de foto.
Se você apagar as fotos do iPad quando transferi-las para o seu computador, elas serão 
removidas do álbum Rolo de Câmera. Você pode usar o painel de ajustes de Fotos no 
iTunes para sincronizar fotos para o aplicativo Fotos em iPad.74
Sobre as fotos
O iPad permite que você carregue fotos e vídeo com você para que possa usufruí-los 
onde estiver. Você pode compartilhá-los facilmente com amigos e familiares, diretamente no iPad ou em um HDTV usando o AirPlay e o Apple TV. Você pode até imprimir 
fotos do iPad usando o AirPrint. Se o seu iPad possuir uma câmera, você poderá visualizar fotos e vídeos à medida que os vai criando. Você pode sincronizar fotos e vídeos 
no seu computador, importá-las de uma câmera digital ou do iPhone, ou salvá-las de 
um e-mail ou da web. Use-os em aplicativos, envie-os em mensagens de e-mail ou 
transfira-os para a sua Galeria do MobileMe. Você pode usar o iPad como porta-retrato 
que exibe uma apresentação de slides animada das suas fotos.
Como sincronizar fotos e vídeos com o seu computador
O iPad é compatível com formatos de foto padrão como JPEG, TIFF, GIF e PNG. Use o 
iTunes para sincronizar fotos para iPad. Ao sincronizar fotos para o iPad, o iTunes automaticamente cria um tamanho otimizado para o iPad, se necessário. Consulte “Como 
configurar a sincronização” na página 25.
O iPad é compatível com os formatos de vídeo H.264 e MPEG-4, com áudio AAC. Você 
usa o iTunes para sincronizar vídeos gravados com uma câmera digital, iPhone ou iPod 
touch (4ª geração) para iPad.
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Como importar fotos e vídeos do iPhone ou de uma câmera 
digital
Com o Kit de Conexão de Câmera para iPad (vendido separadamente), você pode importar fotos e vídeos diretamente de uma câmera digital ou iPhone, ou de um cartão 
de memória SD.
Para importar fotos:
1 Insira o Leitor de Cartão SD ou o Conector de Câmera, incluídos com o Kit de Conexão 
de Câmera para iPad, no conector de dock do iPad.
Â Para conectar uma câmera ou iPhone, use o cabo USB que acompanha a câmera 
ou o iPhone, e conecte-o à porta USB do Conector da Câmera. Se estiver usando o 
iPhone, certifique-se de que esteja ligado e desbloqueado. Para conectar uma câ-
mera, certifique-se de que a câmera esteja ligada e no modo de transferência. Para 
obter ajuda, consulte a documentação que acompanha a câmera. 
Â Para usar um cartão de memória SD, insira-o no slot do Leitor de Cartões SD. Não 
force o cartão no slot; ele se encaixa somente de uma maneira.
Para obter mais informações sobre os conectores, consulte a documentação do Kit de 
Conexão de Câmera para iPad.
2 Desbloqueie o iPad.
3 O aplicativo Fotos se abre e exibe as fotos e vídeos que estão disponíveis para 
importação.
4 Selecione as fotos e vídeos que deseja importar.
Â Para importar todos itens, toque em Importar Tudo.
Â Para importar somente alguns itens, toque naqueles que deseja incluir (deve aparecer um sinal em cada uma deles), depois toque em Importar e selecione Importar 
Selecionado.
5 Depois que as fotos foram importadas, você pode escolher manter ou apagar as fotos 
e vídeos do cartão, da câmera ou do iPhone.
6 Desconecte o Leitor de Cartão SD ou o Conector de Câmera.
Para visualizar as fotos, procure no álbum Última Importação. Um novo Evento contém 
todas as fotos que foram selecionadas para importar.  
Para transferir as fotos do iPad para o seu computador, conecte o iPad ao seu computador e importe as imagens com um aplicativo de fotos como o iPhoto ou o Adobe 
Elements.Como visualizar fotos e vídeos
O aplicativo Fotos permite que você visualize fotos sincronizadas do aplicativo de fotos 
do seu computador, importadas de uma câmera digital ou iPhone, ou salvas de uma 
mensagem de e-mail ou página web.  
O aplicativo Fotos organiza coleções por Álbuns, Eventos, Faces e Lugares. O Lugares 
usa as informações de local codificadas nas fotos, mas pode ser que nem todas as 
fotos tenham essas informações—é necessário uma câmera compatível com "geotagging". Os Eventos e Rostos devem primeiro ser configurados no iPhoto ou no Aperture 
em um Mac, depois sincronizados para o iPad.
Para visualizar fotos:
1 No Fotos, toque em Álbuns de Fotos, Eventos, Rostos ou Lugares.
Para abrir uma coleção, toque nela. Ou toque a coleção com dois dedos e afaste-os 
para obter uma pré-visualização das fotos, depois tire os dedos para abri-la. As fotos 
são ordenadas pela data de criação.
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Quando você está visualizando Lugares, toque em um pino no mapa para exibir a 
localização, depois toque com dois dedos e afaste-os para ampliar e mostrar todas as 
fotos tiradas nesta localização.
2 Toque em uma miniatura para visualizar a foto em tela cheia.
Você também pode unir ou afastar os dedos para ampliar ou reduzir a foto.
Para mostrar ou ocultar os controles: Toque na foto para mostrar os controles. Toque 
novamente para ocultar os controles.
Para visualizar uma foto na orientação horizontal: Vire o iPad de lado. A foto ou o 
vídeo são redimensionados automaticamente para se ajustar à tela.Para ampliar uma parte de uma foto: Toque duas vezes onde desejar para ampliar. 
Toque novamente duas vezes para reduzir. Você também pode separar ou aproximar 
dois dedos para ampliar ou reduzir.
Para girar uma foto: Arraste a foto.
Para ver a foto anterior ou a próxima foto: Passe o dedo para a esquerda ou para a 
direita Ou toque na tela para mostrar a miniatura na parte inferior e depois toque ou 
arraste para visualizar uma foto diferente.
Para apagar uma foto:  Você pode apagar fotos do álbum Fotos Salvas, que contém 
fotos salvas de e-mails ou da web. Para fotos sincronizadas do seu computador, você 
necessita apagar a foto do álbum no seu computador e depois sincronizar o iPad 
novamente.
Para girar uma foto:  Toque no  . Para girá-la mais, toque novamente.
Para visualizar as fotos ou vídeos em um televisor usando o AirPlay e o Apple 
TV: Certifique-se de que o iPad está na mesma rede sem fio que o Apple TV e, em seguida, toque no  e escolha o Apple TV da lista. Quando você passa os dedos pelas 
fotos no seu iPad, o vídeo no televisor é atualizado enquanto você pausa. Consulte o 
“Como usar o AirPlay” na página 48 para obter mais informações.
Compartilhamento de Fotos
Você pode compartilhar suas fotos como apresentação de slides, completar com música e transições. Com o AirPlay e o Apple TV, você pode transmitir sem fio as suas fotos 
para um televisor. Você pode enviar fotos e vídeos em mensagens de e-mail, e adicionar fotos a sua Galeria MobileMe. Você também pode copiar e colar fotos, salvar fotos 
de e-mails nas Fotos e salvar imagens de páginas web em um álbum.
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Apresentação de Slides
Você pode criar e visualizar uma apresentação de slides que mostre suas fotos com 
transições e música. Você pode visualizar uma apresentação de slides no iPad, ou 
transmiti-la sem fio para um Apple TV. Você também pode usar o iPad para visualizar 
uma apresentação de slides em um exibidor externo, como um projetor.
Para visualizar uma apresentação de slides:
1 Toque em um álbum para abri-lo.
Você pode selecionar um álbum que contém fotos, vídeos, ou ambos. Se o seu iPad 
possuir uma câmera, as fotos ou vídeos criados aparecerão no álbum Rolo da Câmera. 
2 Toque no botão apresentação de slides e, na lista que aparecer, selecione as opções da 
apresentação. Você pode:
Â Selecionar uma música da sua biblioteca de música durante uma apresentação de 
slides.
Â Selecionar um efeito de transição que seja reproduzido entre uma foto e outra.
Para definir por quanto tempo cada foto deve ser exibida, abra Geral > Ajustes > 
Fotos. Você também pode definir se a apresentação de slides deve ser repetida, ou 
deve ocorrer seguindo uma sequência aleatória.
As transições disponíveis são determinadas pela forma que você visualiza a apresentação de slides. Se você estiver conectado a um Apple TV, escolha uma das transi-
ções disponíveis. Se você conectar o iPad a uma TV ou projetor usando um cabo de 
vídeo, escolha a transição Dissolver. Para obter informações sobre a conexão a um 
monitor externo, consulte Capítulo 10,“Vídeos,” na página 83.
3 Toque em Iniciar Apresentação de Slides.
Para parar a apresentação de slides, toque na tela.
Se você estiver usando o AirPlay para transmitir fotos para um Apple TV, toque no  e 
selecione o Apple TV da lista. Consulte o “Como usar o AirPlay” na página 48 para obter 
mais informações.
Como enviar uma foto ou vídeo em uma mensagem de e-mail
Para enviar uma foto ou vídeo: Toque em uma foto ou vídeo e toque no  , depois 
toque em Enviar Foto por E-mail.  
Se você não vir  , toque na tela para mostrar os controles.
Para enviar várias fotos ou vídeos:  Toque em um álbum e depois toque no  . Toque 
em cada foto ou vídeo que deseja enviar (aparece uma marca em cada miniatura), depois toque em E-mail. Se o botão E-mail não estiver disponível, selecione menos itens.
Para copiar uma foto ou vídeo:
1 Toque em  .
2 Toque para selecionar a foto ou vídeo que você deseja copiar.3 Toque em Copiar. 
Para colar uma foto ou vídeo: Toque para colocar o ponto de inserção onde você deseja colar a foto ou o vídeo; em seguida, toque no ponto de inserção e em Colar.
Como adicionar uma foto ou vídeo a uma Galeria do MobileMe
Se você é um assinante do MobileMe, você pode adicionar fotos e vídeos do seu iPad 
para a sua Galeria MobileMe. Você também pode adicionar itens para as Galerias 
MobileMe de outras pessoas se eles permitirem contribuições por e-mail.
Antes de poder adicionar fotos a uma galeria de sua conta MobileMe, você precisa:
Â Configure a sua conta MobileMe no iPad Se você não possui uma conta MobileMe, 
vá ao site www.apple.com/br/mobileme/setup/ipad.html.
Â Publique uma galeria MobileMe e permita a adição de fotos via e-mail ou iPad
 Para adicionar uma foto ou vídeo à sua galeria: Escolha uma foto ou vídeo e toque 
em  ; em seguida, toque em “Enviar ao MobileMe”. Digite um título e uma descrição, 
se desejar; selecione o álbum ao qual adicionar a foto e em seguida, toque em Publicar.
Se você não vir  , toque na tela para mostrar os controles.
O iPad diz a você quando a foto foi publicada e dá opções para visualizá-los no 
MobileMe ou para enviar um link a um amigo por e-mail.
Para adicionar uma foto à galeria de outra pessoa: Escolha uma foto e toque em 
e, em seguida, toque em Enviar Foto por E-mail. Digite o endereço de e-mail do álbum 
e clique em Enviar.
Como Salvar Fotos de Mensagens de E-mail ou Páginas Web
Para salvar uma foto de uma mensagem de e-mail no seu álbum Fotos Salvas:
Toque na foto e depois toque em Salvar Imagem. Se a foto não tiver sido transferida, 
toque no ícone transferência primeiro.
Para salvar uma foto de uma página web no seu álbum Fotos Salvas: Toque na foto 
e mantenha-a pressionada; depois, toque em Salvar a Imagem.
Para copiar fotos do álbum Fotos Salvas para seu computador:  Conecte o iPad à 
porta USB do seu computador e depois use um aplicativo de foto, como o iPhoto em 
um Mac, para copiar as imagens.
Como Atribuir uma Foto a um Contato
Você pode atribuir uma foto a um contato.  
Para atribuir uma foto a um contato:
1 Escolha uma foto no iPad, em seguida toque em  .
2 Toque em “Atribuir a Contato” e depois escolha um contato.
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3 Arraste a foto para girá-la e una ou afaste os dedos na foto para ampliá-la ou reduzi-la, 
até que fique do jeito que deseja.
4 Toque em Definir Foto.
Nos Contatos, você pode atribuir uma foto a um contato tocando em Editar e depois 
tocando no ícone da foto.
Como imprimir fotos
Você pode usar o AirPrint para imprimir fotos do iPad.
Para imprimir uma foto: Toque no  e, em seguida, toque em Imprimir. Toque em 
Selecionar Impressora para selecionar uma impressora e defina as opções de impressão, como a quantidade de cópias e, em seguida toque em Imprimir. Se a sua impressora tiver uma bandeja para papel de foto, pode ser que ela alterne automaticamente 
para essa bandeja quando você imprime uma foto.
Para obter mais informações, consulte “Impressão” na página 42.
Fotos de Imagem de Fundo e da Tela de Bloqueio
Você pode mostrar uma foto como imagem de fundo da tela de Bloqueio e da tela de 
Início. Você pode escolher de várias fotos de imagem de fundo incluídas com o iPad, 
ou pode usar uma foto sua.
Para definir uma foto como imagem de fundo:
1 Escolha qualquer foto e toque em  , depois, toque em Imagem de Fundo
2 Arraste para girar a foto ou una ou afaste os dedos na foto para ampliá-la ou reduzi-la, 
até que fique do jeito que deseja. Uma foto que tem pelo menos 1024 x 1024 pixels 
preenche a tela quando o iPad é girado.
3 Toque em Definir Imagem de Fundo. Depois toque para usar a imagem como imagem 
de fundo da tela Início, da tela Bloqueio, ou ambas.
Para escolher entre várias fotos de imagem de fundo incluídas com o iPad, vá para 
Ajustes > Brilho e Imagem de Fundo.
Utilização de Porta-Retrato
Quando o iPad está bloqueado, você pode exibir um álbum de fotos. Esta é uma excelente maneira de aproveitar o iPad enquanto o carrega em um Dock para iPad.
Para alterar os ajustes de Porta-Retrato, vá para Ajustes > Porta-Retrato e depois ajuste 
qualquer uma das seguintes opções:
Â A transição selecionada é reproduzida entre fotos. A duração da apresentação de 
slides não pode ser alterada.Â O Porta-Retrato pode ampliar a imagem para focar nos rostos que estão nas imagens. Ele também pode selecionar aleatoriamente um dos rostos como o centro do 
foco, se houver mais de um rosto. O Porta-Retrato usa as informações de identifica-
ção de rostos em fotos importadas do iPhoto ou do Aperture em um Mac. Ampliar 
os rostos não é uma opção com a transição Origami.
Â O Porta-Retrato pode exibir todas as fotos, ou apenas aquelas em uma categoria do 
Álbum, Rostos ou Evento. Selecione uma opção, depois refine sua seleção na lista 
que aparece. As seleções de Rostos, Álbuns e Eventos são as mesmas que as do aplicativo Fotos.
Para iniciar ou parar o Porta-Retrato:
1 Pressione o botão Repousar/Despertar para bloquear o iPad.
2 Na tela de Bloqueio, toque no  .
3 Toque na tela para parar a apresentação de slides, depois toque no  para retornar à 
tela de Bloqueio ou deslize o controle para desbloquear o iPad.
Para desativar o recurso Moldura, vá para Ajustes > Geral > Bloqueio por Código.
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Sobre Vídeos
Você pode usar o iPad para visualizar filmes, vídeos musicais, podcasts de vídeo e, se 
houver disponibilidade na sua área, programas de TV. O iPad também suporta recursos 
especiais tais como capítulos, legendas, áudio alternado e legendas ocultas.
Você pode alugar ou comprar vídeos da iTunes Store e você pode usar um cabo de 
adaptador de vídeo para assistir vídeos em uma TV ou projetor. Se você tiver um Apple 
TV, você pode usar o AirPlay para assistir vídeos em um televisor.
10
VídeosComo Reproduzir Vídeos
Para reproduzir um vídeo: Toque em Vídeos e depois toque em uma categoria de 
vídeos, tal como Filmes. Toque no vídeo que deseja visualizar. Se o vídeo possui capítulos, toque no título de um capítulo ou simplesmente toque no  .
Para exibir os controles de reprodução: Enquanto um vídeo está sendo reproduzido, 
toque na tela para mostrar os controles. Toque novamente para ocultá-los.
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Como Controlar a Reprodução do Vídeo
Gire o iPad para reproduzir vídeos em formato panorâmico e aproveitar ao máximo a 
tela.
Arraste o cursor de reprodução pela barra de progressão para saltar para qualquer 
ponto do vídeo. Para ajustar a velocidade da progressão de rápido a lento, deslize o 
dedo para baixo à medida que arrasta o cursor de reprodução ao longo da barra de 
progressão.
Pausar um vídeo Toque no  ou pressione o botão central (ou botão equivalente) em um headset compatível.
Retomar reprodução Toque no  ou pressione o botão central (ou 
botão equivalente) em um headset compatível.
Aumentar ou diminuir o volume Arraste o controle de volume ou use os botões 
de volume do iPad ou os botões em um headset 
compatível.
Reiniciar um vídeo Arraste o cursor de reprodução da barra de progressão totalmente para a esquerda, ou toque em 
 se o vídeo não contiver capítulos.
Passar para o próximo capítulo (se disponível) Toque no  ou pressione duas vezes rapidamente o botão central (ou botão equivalente) em um 
headset compatível.
Voltar ao capítulo anterior (se disponível) Toque no  ou pressione três vezes rapidamente o botão central (ou botão equivalente) em um 
headset compatível.
Começar a reproduzir a partir de um capítulo 
específico (se disponível)
Toque em  e depois escolha um capítulo da 
lista.
Avançar ou retroceder Toque e mantenha o toque  ou no  .Saltar para qualquer ponto de um vídeo Arraste o cursor de reprodução pela barra de progressão. Deslize seu dedo para baixo para ajustar 
a velocidade de progressão de rápido para lento.
Interromper a visualização de um vídeo antes 
que a reprodução termine
Toque em OK ou pressione o botão Início  .
Como redimensionar um vídeo para preencher 
ou ajustar à tela
Toque no  para que o vídeo preencha a tela 
ou toque no  para que ele se ajuste à tela. 
Você também pode tocar duas vezes no vídeo 
para alternar visualizações.
Quando você redimensiona um vídeo para que 
ele preencha a tela, talvez as laterais ou a parte 
superior sejam recortadas. Quando você redimensiona o vídeo para que ele se ajuste à tela, 
talvez você veja barras negras nas laterais ou 
acima e abaixo do vídeo.
Reproduzir um vídeo no Apple TV usando 
AirPlay
Toque em  e escolha um Apple TV. Consulte 
“Como Assistir Vídeos em uma TV” na página 87.
Como selecionar um idioma de áudio diferente 
(se disponível)
Toque no  e, em seguida, selecione um idioma 
da lista de Áudio.
Mostrar ou ocultar as legendas (se disponível)
Toque no  e, em seguida selecione um idioma, 
ou Desative a partir da lista Legendas.
Como mostrar ou ocultar legendas ocultas (se 
disponível)
Toque no  para mostrar ou ocultar as legendas, 
se houver.
Sincronização de Vídeos
Use o iTunes para sincronizar vídeos para o iPad. Com o iPad conectado ao seu computador, use os painéis Filmes, Programas de TV, Podcasts e iTunes U para selecionar 
quais vídeos sincronizar.
Como Assistir a Filmes Alugados
Você pode alugar filmes em formato de definição padrão ou alta definição na iTunes 
Store e assisti-los no iPad. Também é possível transferir filmes alugados ao iPad ou 
transferi-los do iTunes de seu computador para o iPad. (Os filmes alugados não estão 
disponíveis em todas as regiões.)
Os filmes devem ter sido completamente transferidos antes de que você possa assistilos. Você pode fazer uma pausa na transferência e continuar mais tarde. Os filmes alugados vencem após um certo número de dias e, uma vez que você comece a assisti-lo, 
terá um tempo limitado para terminar de assistir. Os filmes são automaticamente apagados quando expiram. Antes de alugar um filme, verifique na iTunes Store o prazo do 
vencimento.
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Para ver um filme alugado: Escolha Vídeos, toque na categoria Filmes e depois toque 
no filme que deseja assistir. Selecione um capítulo ou simplesmente toque no  .
Para transferir filmes alugados para o iPad: Conecte o iPad ao seu computador. Em 
seguida, selecione iPad na barra lateral do iTunes, clique em Filmes, e selecione os 
filmes alugados que você deseja transferir. O seu computador deve estar conectado à 
Internet. Filmes alugados no iPad não podem ser transferidos a um computador.
Como Assistir Vídeos em uma TV
Para assistir vídeos em uma TV, você pode conectar o iPad usando o AirPlay e o Apple 
TV, ou usar um cabo para conectar o iPad diretamente a seu televisor ou receptor AV. 
Para obter informações sobre como conectar o iPad com um televisor ou projetor, consulte “Vídeo” na página 185. 
Para conectar usando o AirPlay:  Inicie a reprodução de vídeo e, em seguida, toque 
em  e escolha o seu Apple TV da lista de dispositivos AirPlay. Consulte o “Como usar 
o AirPlay” na página 48 para obter mais informações.
Enquanto o vídeo está sendo reproduzido, você pode sair do Vídeo e usar outros 
aplicativos.
Para retornar a reprodução para o iPad:  Abra Vídeos e, em seguida toque em  e 
escolha o seu iPad da lista.
Como apagar vídeos do iPad
Para economizar espaço, você pode apagar vídeos do iPad.
Para apagar um vídeo: Na lista de vídeos , mantenha o toque em um filme até aparecer o botão apagar e depois toque no  . Toque em Cancelar ou Início quando terminar de apagar vídeos.
Quando você apaga um vídeo (que não sejam filmes alugados) do iPad, ele não é 
eliminado da sua biblioteca do iTunes no seu computador e você pode sincronizar o 
vídeo de volta para o iPad mais tarde. Se você não quiser sincronizar o vídeo de volta para o iPad, ajuste o iTunes para que ele não sincronize o vídeo. Consulte “Como 
Sincronizar com o iTunes” na página 25.
Importante: Se você apagar um filme alugado do iPad, ele será apagado permanentemente e não poderá ser transferido de volta para o seu computador.88
Como Buscar e Visualizar Vídeos
O YouTube apresenta vídeos curtos enviados por pessoas do mundo inteiro. Você pode 
assistir os últimos e mais populares vídeos, buscar por vídeos pelos temas de interesse, marcar seus favoritos e rapidamente acessar vídeos que você transferiu para o 
YouTube do seu computador.
Para usar certos recursos no iPad, é preciso iniciar sessão em uma conta do YouTube 
quando solicitado. Para obter mais informações sobre os requisitos e sobre como obter 
uma conta do YouTube, visite o site www.youtube.com.
Nota: O YouTube não está disponível em todos os idiomas e localizações.
Para usar o YouTube, o iPad deve ter uma conexão à Internet. Consulte “Como 
Conectar-se à Internet” na página 30.
Para navegar pelos vídeos: Toque em um botão na barra de ferramentas para selecionar uma categoria.
Â Em Destaque:  Vídeos revisados e destacados pela equipe do YouTube.
Â Melhores:  Vídeos melhor avaliados pelos usuários do YouTube. Você pode classificar 
vídeos no iPad se possuir uma conta no YouTube.
Â Mais Vistos:  Vídeos mais vistos pelos usuários do YouTube. Toque em Tudo para ver 
Todos para os vídeos mais vistos de todos os tempos ou em Hoje ou Esta Semana 
para os vídeos mais vistos do dia ou da semana.
Â Favoritos:  Vídeos que você adicionou aos Favoritos. Quando você inicia sessão com 
uma conta do YouTube, aparece os favoritos da conta.
Â Mais Recentes:  Vídeos enviados recentemente ao YouTube.
Â Assinaturas: Vídeos de contas do YouTube que você assina. Para usar este recurso, é 
preciso iniciar sessão em uma conta do YouTube.
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Â Listas: Vídeos que você adiciona às listas. Para usar este recurso, é preciso iniciar sessão em uma conta do YouTube.
Â Meus Vídeos:  Vídeos que você transferiu para o YouTube. Para usar este recurso, é 
preciso iniciar sessão em uma conta do YouTube.
Â Histórico: Vídeos que você viu recentemente.
Para buscar um vídeo:
1 Toque no campo de busca do YouTube.
2 Digite uma palavra ou frase e depois toque em Buscar.
O YouTube mostra os resultados baseado na busca de títulos de vídeo, descrições, 
etiquetas e nomes de usuário. Cada resultado de busca mostra o título, a classificação, 
o número de visualizações, o comprimento e o nome da conta de onde o vídeo foi 
colocado.
Para reproduzir um vídeo: Toque no vídeo.
O vídeo começa a ser transferido para o iPad e aparece uma barra de progresso. 
Quando tiver sido transferida uma parte suficiente do vídeo, ele começa a ser reproduzido. Você também pode tocar no  para iniciar o vídeo.
Como Controlar a Reprodução do Vídeo
Gire o iPad para orientação horizontal para visualizar o vídeo no seu tamanho máximo. 
Quando um vídeo está sendo reproduzido, os controles desaparecem para não ficarem 
na frente do vídeo.
Para mostrar ou ocultar os controles de vídeo: Toque na tela.Reproduzir ou Colocar um Vídeo em Pausa Toque no  ou no  . Você também pode pressionar o botão central (ou botão equivalente) em 
um headset compatível.
Ajustar o volume Arraste o controle de volume ou use os botões 
de volume do iPad ou os botões de volume de 
um headset compatível.
Reiniciar um vídeo Toque em  .
Para passar para o próximo vídeo ou para o 
vídeo anterior de uma lista
Toque em  duas vezes para saltar para o vídeo 
anterior. Toque no  para saltar para o próximo 
vídeo.
Avançar ou retroceder Toque e mantenha o toque  ou no  .
Saltar para qualquer ponto de um vídeo Arraste o cursor de reprodução pela barra de 
progressão.
Para parar de assistir um vídeo Toque em OK ou pressione o botão Início  .
Alternar entre os modos padrão e tela cheia Toque duas vezes no vídeo. Você também pode 
tocar no  para que o vídeo preencha a tela ou 
tocar no  para que ele se ajuste à tela. 
Para adicionar um vídeo aos Favoritos Comece a reproduzir um vídeo e toque no  .
Enviar um link do vídeo por e-mail Comece a reproduzir um vídeo e toque no  .
Reproduzir um vídeo no Apple TV usando 
AirPlay
Toque em  e escolha um Apple TV. Para obter 
informações, consulte “Como usar o AirPlay” na 
página 48.
Para visualizar informação sobre um vídeo Toque em  para sair do modo tela cheia e 
visualizar vídeos, comentários e outros controles 
relacionados.
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Como gerenciar os vídeos
Quando estiver assistindo um vídeo em tela cheia, toque para mostrar o controlador e 
depois toque no  para ver vídeos relacionados e opções para gerenciar vídeos.
Para classificar ou adicionar um comentário a 
um vídeo
Toque no vídeo para exibir a barra de ferramentas e depois toque em Classificar e selecione uma 
classificação.. Você deve ter iniciado sessão em 
uma conta do YouTube.
Para ver mais vídeos deste usuário do YouTube Na barra lateral, toque em “Mais De”. Você deve ter 
iniciado sessão em uma conta do YouTube.
Para ver vídeos similares a este Na barra lateral, toque em “Relacionado(a)”.
Para assinar vídeos deste usuário do YouTube Na tela Mais Informações, toque em Mais Vídeos; 
em seguida, toque em “Assinar ” no final 
da lista de vídeos. Você deve ter iniciado sessão 
em uma conta do YouTube.
Para adicionar um vídeo aos Favoritos ou a uma 
lista
Toque em Adicionar e depois selecione Favoritos 
ou uma lista.
Para enviar um link de um vídeo por e-mail Toque em Compartilhar.
Para marcar um vídeo Toque no filme para exibir a barra de ferramentas 
e depois toque no  .
Como Assistir o YouTube em uma TV
Se você tiver um Apple TV, você pode usar o AirPlay para assistir vídeos do YouTube 
em um televisor. Consulte “Como Controlar a Reprodução do Vídeo” na página 89.
Você pode conectar o iPad diretamente a sua TV ou a um projetor e assistir o YouTube 
na tela grande. Para obter mais informações sobre como usar o iPad com uma TV ou 
projetor, consulte “Vídeo” na página 185.92
Sobre o Calendário
O iPad facilita seguir uma agenda de horários. Você pode visualizar calendários individualmente ou vários calendários ao mesmo tempo. Você pode visualizar seus eventos 
por dia, semana ou mês, ou em uma lista. Você também pode buscar eventos por título, convidados ou localização.
Também é possível sincronizar o iPad com os calendários do seu computador. Você 
pode também criar, editar ou cancelar eventos no iPad e sincronizá-los com o seu 
computador. Também é possível assinar calendários do Google, Yahoo! ou iCal. 
Também é possível assinar calendários iCalendar (.ics) somente para leitura ou importar arquivos .ics do e-mail. Se possuir uma conta Microsoft Exchange ou uma conta 
CaIDAV compatível, você poderá receber e responder aos convites de reuniões de outras pessoas e convidar pessoas para eventos que agendou.
Como Sincronizar Calendários
Você pode sincronizar seus calendários das seguintes formas:
Â No iTunes, use o painel Ajustes do iPad para sincronizar com o iCal ou Microsoft 
Entourage no Mac, ou com Microsoft Outlook em um PC ao conectar o iPad ao seu 
computador. Consulte “Como Sincronizar com o iTunes” na página 25.
Â Nos Ajustes do iPad, ative a opção Calendários na sua conta MobileMe, Google, 
Yahoo! ou Microsoft Exchange para sincronizar sem fios as informações de seu calendário. Se a sua empresa ou organização for compatível com ele, você também 
pode configurar uma conta CalDAV. Consulte “Como adicionar Mail, Contatos e 
Contas do Calendário” na página 32. Para sincronizar os calendários com o método 
over the air, o iPad deve estar conectado à Internet.
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Como adicionar, editar e apagar eventos do calendário
Você pode criar e editar eventos do calendário diretamente no iPad.
Se você possui uma conta Microsoft Exchange com os calendários ativados ou uma 
conta CaIDAV compatível, poderá convidar outras pessoas para o seu evento ou 
reunião.
Para adicionar um evento:  Toque no  e digite uma informação de evento e, em seguida, toque em OK. 
Você pode digitar o seguinte:
Â Título
Â Local
Â Hora de início e finalização (ou ativar Dia inteiro se for um evento que dura o dia 
inteiro)
Â Repetições—nenhuma, ou a cada dia, a cada semana, a cada duas semanas, a cada 
mês ou a cada ano
Â Hora do Alerta—de cinco minutos até dois dias antes do evento
Quando você define um alerta, aparece a opção para definir um segundo alerta. 
Quando ocorre um alerta, o iPad exibe uma mensagem. Para ajustar o iPad para reproduzir um som, consulte “Alertas” na página 97.
Importante: Quando você viaja, o iPad pode não alertar você na hora local correta. 
Para ajustar a hora correta manualmente, consulte “Data e Hora” na página 176. Para 
obter informações sobre como ajustar o fuso horário do calendário, consulte “Como 
Visualizar seus Calendários” na página 93.
Â Notas
Se você tiver mais de um calendário, você pode selecionar em qual calendário adicionar o evento. Calendários apenas para leitura não aparecem na lista.
Como editar um evento Toque em o evento e depois em Editar.
Como apagar um evento Toque no evento, toque em Editar, depois role 
para baixo e toque em Apagar Evento.
Como Visualizar seus Calendários
Você pode visualizar um único calendário, calendários selecionados, ou todos os calendários de uma vez. Isso facilita o gerenciamento dos calendários de trabalho e da 
família ao mesmo tempo.
Para visualizar um calendário diferente: Toque em Calendários e, em seguida, selecione os calendários que deseja visualizar. Para visualizar os aniversários dos seus contatos, como definido em Contatos, selecione o calendários de Aniversários.Você pode visualizar calendários em uma lista, ou por dia, semana ou mês. Os eventos 
de todos os calendários selecionados aparecem no iPad.
Para alternar visualizações: Toque em Lista, Dia, Semana ou Mês.
Â Visualização em lista: Todos os seus compromissos e eventos aparecem em uma lista navegável, próxima ao dia selecionado. Para visualizar outro dia, toque em  ou 
ou selecione um dia no controle de tempo abaixo do calendário.  
Â Visualização por Dia:  Role para cima e para baixo para ver os eventos daquele dia. 
Toque em  ou  para ver os eventos do dia anterior ou do próximo dia, ou selecionar um dia no controle de tempo abaixo do calendário.
Â Visualização por semana:  Role para cima ou para baixo para ver os eventos da semana. Toque em  ou  para ver a semana anterior ou próxima, ou selecionar uma 
semana no controle de tempo abaixo do calendário.  
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Â Visualização mensal: Toque num dia para visualizar seus eventos. Toque em  ou 
para ver o mês anterior ou próximo, ou selecionar um mês no controle de tempo 
abaixo do calendário.
Para ver os detalhes de um evento: Toque no evento.
Para ver os eventos ajustados para um fuso horário:  Em Ajustes, vá para “Mail, 
Contatos, Calendários”. Em Calendários, toque em Gestão Fuso Horário. Ative a Gestão 
Fuso Horário e selecione uma cidade principal para o fuso horário que deseja usar. 
Quando a Gestão Fuso Horário está desativada, o iPad Wi-Fi + 3G exibe os eventos no 
fuso horário da sua localização atual, conforme determinada pela hora da rede celular. 
Como buscar nos calendários
Em seus calendários, você pode buscar por títulos, convidados, notas e localizações 
dos eventos. O Calendário busca apenas o calendário ou calendários que você está 
visualizando no momento.  
Para buscar eventos: Digite texto no campo de busca.
Os resultados da busca aparecem à medida que você digita. Toque em um resultado 
para visualizar o evento. Toque no calendário para fechar a lista dos resultados da 
busca.
Como Assinar Calendários 
Você pode assinar calendários que utilizem formato iCalendar (.ics). Muitos serviços 
com base no calendário, incluindo Yahoo!, Google e iCal no Mac, são compatíveis com 
as inscrições de calendários.
Os calendários assinados são somente para leitura. Você pode ler os eventos dos calendários assinados no iPad, mas não pode editá-los nem criar novos eventos. Para assinar um calendário CalDAV ou .ics:
1 Em Ajustes, escolha “Mail, Contatos, Calendários” e toque em Adicionar Conta.
2 Selecione Outros e, em seguida, selecione Adicionar Calendário Assinado.
3 Digite as informações da conta e toque em Próximo para verificar a inscrição.
4 Toque em Salvar.
A Apple fornece links a vários calendários iCal gratuitos—para feriados nacionais ou 
eventos esportivos, por exemplo—os quais talvez você queira assinar. 
Você também pode assinar um calendário iCal (ou outro calendário .ics) publicado na 
web tocando em um link do calendário que você tenha recebido por uma mensagem 
de e-mail no iPad.
Como Responder a Convites de Reuniões
Se você possui uma conta do Microsoft Exchange no iPad com os calendários ativados, 
ou uma conta CalDAV compatível, ou um calendário MobileMe, você pode receber e 
responder aos convites de reuniões de pessoas da sua empresa. 
Quando você recebe um convite, a reunião aparece no seu calendário com uma linha 
pontilhada ao seu redor. O ícone  no canto inferior direito da tela mostra a quantidade de novos convites que você possui. Para receber e responder aos convites de 
reuniões, o iPad deve possuir uma conexão à Internet.
Para responder a um convite do Calendário:
1 Toque em um convite de reunião do calendário, ou toque em  para exibir a tela 
Evento e toque em convite.
Â Toque em "Convite de” para obter as informações de contato do organizador da reunião. Toque no endereço de e-mail para enviar uma mensagem ao organizador.  
Â Toque em Convidados para ver quem foi convidado para a reunião. Toque em um 
nome para ver as informações de contato dos participantes. Toque em um endereço 
de e-mail para enviar uma mensagem ao participante.  
Â Toque em Alerta para que o iPad reproduza um alerta sonoro antes da reunião.
Â Toque em Adicionar Comentários para adicionar comentários para o organizador da 
reunião. Seus comentários também aparecerão na tela Informações da reunião
As notas são criadas pelo organizador da reunião.
2 Toque em Aceitar, Talvez ou Recusar.
Quando você toca nas opções aceitar, talvez ou recusar o convite, um e-mail de resposta que inclui todos os comentários que você adicionou é enviado ao organizador.
Você pode alterar sua resposta depois, a não ser que recusar o convite. Toque em 
Adicionar Comentários para alterar ou adicionar comentários.
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Como importar arquivos do Calendário a partir do Mail
Você pode adicionar eventos a um calendário importando um arquivo de calendário 
de uma mensagem de e-mail. Você pode importar qualquer arquivo de calendário .ics 
padrão.
Para importar eventos de um arquivo de calendário:  No Mail, abra a mensagem e toque no arquivo de calendário. Quando a lista de eventos aparece, toque em Adicionar 
Tudo, escolha o calendário ao qual deseja adicionar os eventos e toque em OK.
Alertas
Para definir alertas de calendário: Em Ajustes, escolha Geral > Sons, depois ative 
a opção Alertas de Calendário. Se a opção Alertas de Calendário estiver desativada 
quando ocorrer um evento, o iPad exibe uma mensagem mas não emite som.
Para emitir os alertas de convites: Nos Ajustes, escolha “Mail, Contatos, Calendários”. 
Abaixo de Calendários, toque em Alerta de Novo Convite para ativá-lo.98
Sobre os Contatos
O iPad permite que você acesse e edite facilmente suas listas de contato das suas 
contas pessoais, empresariais e organizacionais. Você pode buscar por todos os seus 
grupos, e as informações dos Contatos são automaticamente acessadas para que o 
endereçamento de e-mails seja rápido e fácil.  
Você pode adicionar contatos diretamente no iPad ou sincronizar contatos a partir 
dos aplicativos do seu computador. Se você tiver uma conta MobileMe ou Microsoft 
Exchange com Contatos ativada, ou uma conta CardDAV compatível, você pode sincronizar seus contatos sem conectar o iPad ao seu computador.
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Como Sincronizar e Adicionar Contatos
Você pode adicionar contatos ao iPad das seguintes formas:
Â Digite contatos no iPad
Â No iTunes, sincronize contatos do Google ou Yahoo! ou sincronize com aplicativos 
do seu computador (consulte “Como Sincronizar com o iTunes” na página 25)
Â Configure uma conta do MobileMe ou do Microsoft Exchange no iPad com 
os Contatos ativados (consulte “Como adicionar Mail, Contatos e Contas do 
Calendário” na página 32)
Â Instale um perfil que configure uma conta Exchange com os Contatos ativados (consulte “Como Configurar Contas do Microsoft Exchange” na página 189)
Â Configure uma conta LDAP ou CardDAV no iPad para acessar diretórios do trabalho 
ou da escola (consulte “Contas LDAP e CardDAV” na página 190)
Como Buscar Contatos
Você pode buscar nomes, sobrenomes e nomes de empresas nos seus contatos do 
iPad. Se você possui uma conta Microsoft Exchange no iPad, talvez também consiga 
buscar os contatos na lista GAL (Global Address List) da sua empresa. Se tiver uma conta LDAP no iPad, poderá buscar contatos no servidor LDAP de sua organização. Se possuir uma conta CardDAV, você pode buscar contatos sincronizados ao iPad ou contatos 
que permitem buscas em um servidor CardDAV disponível.
Quando você digita as informações de busca, os contatos com as informações coincidentes aparecem à medida que digita.
Para buscar contatos: Em Contatos, toque no campo de busca no topo da tela e insira 
um nome, sobrenome ou nome de empresa. Para rolar rapidamente até o topo da lista, 
toque na barra de estado.
Para buscar em uma GAL: Toque em Grupos, toque no nome do servidor Exchange, 
depois digite um nome, um sobrenome ou um nome de empresa.
Você não pode editar contatos GAL ou salvá-los no iPad.
Para buscar em um servidor LDAP: Toque em Grupos, toque no nome do servidor 
LDAP e digite um nome, um sobrenome ou um nome de empresa.
Você não pode editar contatos LDAP ou salvá-los no iPad.
Buscar um servidor CardDAV:Toque em Grupos, toque no grupo CardDAV que permite buscas na parte inferior da lista e, em seguida, digite sua busca.
Você não pode editar contatos CardDAV que permitem buscas a partir do servidor, 
mas pode editar contatos CardDAV sincronizados no iPad.Como gerenciar contatos
Você pode editar os seus contatos e marcar aqueles que você usa frequentemente 
com o FaceTime como favorito
Para adicionar um contato ao iPad: Toque Contatos e, em seguida, toque em  .
Apagar um contato Em Contatos, escolha um contato, depois toque 
em Editar. Role para baixo e toque em Apagar 
Contato.
Adicionar um contato nos Favoritos do 
FaceTime
Nos Contatos, escolha um contato, depois toque 
em Favoritos. 
Editar os Favoritos do FaceTime No FaceTime, toque em Favoritos e, em seguida, 
toque em Editar. Para apagar um item, toque o 
.
Editar informações de contato Em Contatos, escolha um contato, depois toque 
em Editar. Para adicionar um item, toque o  . 
Para apagar um item, toque o  .
Para atribuir uma foto a um contato:
1 Toque em Contatos e depois escolha um contato.
2 Toque em Editar e toque em Adicionar Foto, ou toque na foto existente.
3 Toque em um álbum, depois toque e uma foto..
4 Arraste e redimensione a foto.
5 Toque em Escolher.
Como Utilizar as Informações de um Contato
Você pode utilizar as informações da tela Informações de um contato para:
Â Criar uma mensagem de e-mail no Mail, endereçada ao contato
Â Abrir a página Inicial do contato no Safari
Â Buscar a localização do endereço do contato nos Mapas e obter instruções
Â Compartilhar as informações do contato com outras pessoas
Â Ligar para um contato usando o FaceTime
Para usar a tela de informações de um contato:  Toque em Contatos e escolha um 
contato, em seguida toque em um item.
Para realizar uma videoconferência do FaceTime:  Toque em Contatos e escolha um 
contato e, em seguida, toque em FaceTime e escolha um endereço de e-mail ou nú-
mero de telefone a ser usado para a ligação. Se não estiver conseguindo ver o botão 
FaceTime, ative o FaceTime em Ajustes > FaceTime.
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Contatos Unificados
Ao sincronizar contatos com várias contas, talvez você tenha entradas para a mesma 
pessoa em mais de uma conta. Para impedir que os contatos redundantes apareçam 
na lista Todos os Contatos, você pode vincular os contatos que possuem os mesmos 
nomes e sobrenomes (mas não um prefixo, sufixo ou segundo nome diferente) e 
exibi-los como um único contato unificado. Ao visualizar um contato unificado, o título 
Informação Unificada aparece na parte inferior da entrada do contato. Os contatos unificados somente aparecem quando você visualiza a lista Todos os Contatos.
Para vincular contatos:  Encontre o primeiro contato que você deseja vincular e, em 
seguida, toque em Editar. Toque em  e selecione o outro contato e, em seguida, 
toque em Vincular.
Quando um contato estiver vinculado, toque no ícone da silhueta para visualizar, adicionar ou apagar entradas vinculadas.
Os contatos vinculados não são combinados. A menos que você edite um contato 
unificado, o contato em cada conta de origem permanecerá separado. Se você alterar 
as informações em um contato unificado, as alterações são copiadas para cada conta 
de origem onde já existem informações. Se você adicionar informações a um contato 
unificado, as informações são adicionadas ao contato em cada conta de origem.102
Como Escrever e Ler Notas
Com a sua tela ampla e o teclado na tela, o iPad torna fácil realizar notas.  
Você pode visualizar notas na vertical ou na horizontal. Na vertical, toque em Notas 
para visualizar uma lista das suas notas. Na horizontal, a lista de notas aparece na esquerda, e a nota atual é circundada em vermelho.  
As notas são listadas pela última data modificada, com a nota mais recente no topo. 
A lista mostra as primeiras palavras de cada nota. Toque em uma nota na lista para 
visualizá-la ou editá-la.
Para adicionar uma nota: Toque no  , digite a nota, depois toque em OK.
Para ler uma nota: Toque na nota. Toque na  ou na  para ver a nota seguinte ou o 
anterior.
Para editar uma nota: Toque em qualquer lugar da nota para que apareça o teclado. 
Edite a nota, depois toque em OK.
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Para apagar uma nota: Toque na nota, depois toque no  .
Para alterar a fonte usada para exibir as notas:  Nos Ajustes, escolha Notas e selecione uma fonte da lista.
Como buscar notas
Você pode buscar pelo texto das notas para encontrar uma nota em particular.
Como buscar notas: Digite texto no campo de busca que aparece na parte superior 
da lista de notas. (Na vertical, toque em Notas para exibir a lista das notas.)
Os resultados da busca aparecem automaticamente à medida que você digita. Toque 
no botão do teclado para que o teclado desapareça e você possa ver mais resultados. 
Para visualizar uma nota, toque nela na lista de resultados da busca.  
Como Enviar Notas por E-Mail
Para enviar uma nota por e-mail: Toque na nota e, em seguida toque no  .
Para enviar uma nota por e-mail, o iPad deve estar configurado para e-mail. Consulte 
“Como Configurar Contas de E-mail” na página 56.
Para sincronizar as notas
Você pode ajustar o iTunes para sincronizar automaticamente as suas notas com alguns aplicativos de e-mail. Consulte “Como configurar a sincronização” na página 25.
Você também pode sincronizar as notas com o método over the air, quando o iPad 
possuir uma conexão com a Internet. Vá para Ajustes > Notas e, em seguida, selecione 
a conta de correio padrão para sincronização das notas. As novas notas criadas no iPad 
serão armazenadas na conta que você selecionar. Para visualizar as notas armazenadas 
em uma conta específica, abra Notas e toque em Contas.104
Sobre os Mapas
O Mapas fornecem visualizações clássicas, de satélite, do terreno e híbridas de localiza-
ções em vários países. Busque uma localização, depois obtenha orientações para dirigir, caminhar ou sobre o transporte público, assim como informações sobre o tráfego.
ADVERTÊNCIA: Para obter informações importantes sobre a segurança na direção 
e navegação, consulte o Manual de Informações Importantes do Produto no site 
support.apple.com/pt_BR/manuals/ipad.
Para usar o Mapas, o iPad deve ter uma conexão à Internet. Consulte “Como Conectarse à Internet” na página 30.
Importante: Mapas, endereços e aplicativos baseados na localização fornecidos pela 
Apple dependem de serviços de dados fornecidos por terceiros. Estes serviços de 
dados estão sujeitos a alterações e talvez não estejam disponíveis em todas as áreas 
geográficas, resultados nos mapas, direções, ou informações baseadas em localização 
que talvez não estejam disponíveis, sejam imprecisas ou incompletas. Compare as informações fornecidas no iPad com as redondezas e consulte a sinalização viária para 
solucionar qualquer discrepância. Para fornecer a sua localização, são coletados dados 
que não identificam você pessoalmente. Se você não quiser que estes dados sejam 
coletados, não utilize o recurso. O fato de não utilizar esse recurso não afetará a funcionalidade do seu iPad que não seja baseada em localização.
Se os serviços de localização estiverem desativados quando abrir os Mapas pela 
primeira vez, será solicitado a você que ative estes serviços. Você pode utilizar os 
Mapas sem a necessidade de ativar os serviços de localização. Consulte “Serviços de 
Localização” na página 169.
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Como Buscar e Visualizar Localizações
Você pode fazer buscas por localizações, buscar sua localização atual, colocar um alfinete para marcar uma localização e obter diferentes visualizações de mapas, incluindo 
as do Google Street.
Como buscar Localizações
Você pode buscar localizações de várias maneiras—por endereço, cruzamento, área, 
ponto de referência, favoritos, contato ou código postal.  
Como encontrar uma localização e ver um mapa:
1 Toque no campo de busca para que o teclado apareça. 
2 Digite um endereço ou outra informação de busca.
3 Toque em Buscar.
Um alfinete marca a localização.  
Toque       para obter 
informações sobre a 
localização, obter 
itinerários, adicionar a 
localização dos seus 
favoritos ou lista de 
contatos, ou enviar um 
link por e-mail para o 
Google Maps.
Uma localização pode incluir lugares de interesse adicionados pelos usuários do 
Google My Maps (“Conteúdo criado pelo usuário”), e links patrocinados que aparecem 
como ícones especiais (por exemplo,  ).Para ampliar Toque o mapa com dois dedos. Ou toque duas 
vezes na parte que deseja ampliar. Toque novamente duas vezes para ampliar ainda mais.
Para reduzir Toque a tela com dois dedos e separe-os no 
mapa. Ou toque no mapa com dois dedos. Toque 
com dois dedos novamente para reduzir ainda 
mais.
Para girar ou rolar Arraste para cima, para baixo, para a esquerda ou 
para a direita para visualizar uma parte diferente 
do mapa.
Para ver a localização de uma entrada da sua lista de Contatos: Toque no  na parte 
superior da tela e escolha um contato.
O contato deve incluir pelo menos um endereço. Se o contato tiver mais de um endereço, escolha aquele que deseja localizar. Você também pode tocar no endereço nos 
Contatos para encontrar uma localização.
Como Encontrar sua Localização Atual
Um toque rápido busca a sua localização atual. A bússola digital na tela mostra a dire-
ção para a qual você está orientado.
Para buscar a sua localização atual: Toque no  na barra de estado na parte superior 
da tela.
Um marcador azul mostra a sua localização atual. Se o Mapas não puder determinar 
a sua localização exata, um círculo azul aparecerá ao redor do marcador. O tamanho 
do círculo depende da precisão em que sua localização pode ser determinada: quanto 
menor for o círculo, maior a precisão.
Se você arrastar o mapa, depois toque no  novamente, o iPad centraliza o mapa de 
volta a sua localização atual.
Para usar a bússola digital: Toque no  uma segunda vez. O  é alterado para  e 
uma pequena bússola digital  aparece na tela. Use a bússola digital para buscar a 
direção para a qual você está orientado.  
Nota: Você deve calibrar a bússola da primeira vez que for utilizar e depois talvez tenha que calibrá-la de vez em quando.
Para calibrar a bússola: Quando aparece o símbolo de calibragem  mova o iPad 
formando o número oito no ar. Talvez seja solicitado que você se afaste de uma fonte 
de interferência.
Para saber qual é a sua direção: Mantenha o iPad na posição horizontal. A bússola 
gira para apontar o norte.
Para retornar à visualização do mapa: Toque no  para voltar à visualização do 
mapa.
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Para determinar a sua localização, o iPad utiliza os Serviços de Localização. Os Serviços 
de Localização usam informações disponíveis de redes Wi-Fi locais se o recurso Wi-Fi 
estiver ativado. Este recurso não está disponível em todas as áreas.
A sua localização atual não pode ser encontrada se os Serviços de Localização estiverem desativados, então talvez seja pedido que você o ative. Consulte “Serviços de 
Localização” na página 169.
Quando não estiver usando os Serviços de Localização, você pode desativá-los para 
conversar a bateria. Em Ajustes, escolha Geral > Serviços de Localização.
Para obter mais informações sobre sua localização atual: Toque no marcador azul e, 
em seguida, toque em  . O iPad exibe o endereço de sua localização atual, se disponível. Você pode utilizar esta informação para:
Â Para obter itinerários a partir de e para esta localização
Â Adicionar a localização aos contatos
Â Para enviar o endereço por e-mail
Â Marcar a localização como favorito
Â Para ver uma visualização de rua (quando disponível)
Como Marcar uma Localização com um Alfinete
O alfinete permite que você marque uma localização manualmente.
Para colocar um alfinete:Mantenha pressionada qualquer localização no mapa. Ou, 
você pode arrastar ou tocar no canto inferior direito da tela, depois tocar em Alfinete.
Um alfinete é colocado no mapa. Mantenha o toque sobre o alfinete, depois arraste-o 
a qualquer localização que escolher.Como Guardar as Localizações nos Favoritos
Você pode colocar em favoritos qualquer localização que deseja encontrar de novo 
posteriormente.
Para guardar uma localização nos favoritos: Busque uma localização, toque no alfinete, toque no  próximo ao nome ou descrição, depois toque em “Adicionar aos 
Favoritos.”  
Para ver uma localização favorita ou vista recentemente:  Toque no  na parte superior da tela, depois toque em Favoritos ou Recentes.
Para limpar a lista de recentes:    Toque em Limpar.
Para organizar ou apagar um favorito:  Toque em Editar. 
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Visualizações de Mapas
Você pode escolher uma visualização clássica, de satélite, de terreno ou híbrida. Você 
também pode ver uma localização na visualização rua, se disponível.
Para alterar a visualização: Toque ou arraste o canto superior direito da tela, depois 
toque em Clássico, Satélite, Híbrido ou Terreno.
Para ver a visualização de uma rua: Toque em um alfinete fixado, depois toque no  . 
Você pode passar o dedo para cima ou para baixo, para a esquerda ou para a direita 
para girar através da visualização panorâmica 360°. O mapa em miniatura no canto 
inferior direito mostra sua visualização atual. Toque em uma seta para deslocar-se pela 
rua. A visualização de ruas não está disponível em todas as áreas.
Para retornar à visualização do mapa, toque na miniatura.  
Toque para retornar à visualização do mapaComo Obter Itinerários
Você pode obter itinerários passo-a-passo para dirigir, caminhar ou de transporte 
público.
Para obter itinerários:
1 Toque em Itinerários.
2 Toque nos campos na parte superior da tela para digitar sua localização inicial e de 
destino. Normalmente, o iPad começa com sua localização atual (se disponível). 
Se um endereço estiver na sua lista de contatos, toque no  , escolha o contato e toque em Instruções Até Aqui e Instruções a Partir Daqui.
Toque no  para reverter o itinerário.
3 Selecione os itinerários para dirigir carro ( ), transporte público ( ) ou para ir a pé ( ) 
na parte inferior da tela.
As opções de viagem disponíveis dependem do itinerário.  
4 Proceda de uma das seguintes maneiras:
Â Para visualizar o itinerário um passo de cada vez, toque em Início e depois toque na 
 para ver o próximo trecho da viagem. Toque em  para voltar.
Â Para visualizar todo o itinerário em uma listatoque em Iniciar e depois toque no  . 
Toque em qualquer item da lista para ver um mapa mostrando aquele trecho da 
viagem. Toque em Visão Geral da Rota para voltar à tela de visão geral.
Também é possível obter itinerários buscando uma localização no mapa, tocando no 
alfinete que aponta para ela, tocando o  e, em seguida, tocando em Itinerários até 
aqui ou Itinerários a partir daqui.
Para reverter o itinerário: Toque no  para alternar o ponto inicial e o ponto final.
Para ver os itinerários visualizados recentemente:Toque no  no campo de busca, 
depois toque em Recentes.
Para ver itinerários para dirigir ou caminhar: Toque no  ou  .
Se você estiver dirigindo ou caminhando, a distância aproximada e o tempo da viagem 
aparecem na tela. Se houver dados disponíveis sobre o tráfego, o tempo da viagem se 
ajusta apropriadamente.
Para ver itinerários do transporte público: Toque no  .
Â Toque no  para definir a hora de saída ou chegada e escolha uma programação 
para a viagem.
Â Toque em Iniciar, depois toque no  para ver a tela Visão Geral da Rota. Desta tela, 
você vê o tempo estimado de chegada, o preço total, informações sobre cada trecho da viagem, e o modo de transporte—incluindo onde você precisa caminhar.
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Como Mostrar as Condições de Tráfego
Quando disponível, é possível exibir as condições de tráfico das ruas principais e estradas no mapa. 
Para mostrar ou ocultar as condições de tráfego: Toque ou arraste a esquina inferior 
direita da tela, depois ative ou desative Tráfego.
Verde= limite de 
velocidade anunciado
Amarelo = mais 
lento que o limite 
de velocidade 
anunciado
Vermelho = 
pare e siga
As ruas e rodovias possuem um código de cor de acordo ao fluxo ou tráfego: Se uma 
rua ou rodovia estiver cinza, as informações do tráfego não estão disponíveis.
Se você não conseguir ver as condições de tráfego, reduza para ver as rodovias principais. As condições de tráfego não estão disponíveis em todas as áreas.
Como Buscar e Contatar Empresas
Para buscar empresas em uma área:
1 Busque uma localização—por exemplo, uma cidade ou uma rua—ou role até uma localização no mapa.
2 Digite o tipo de negócio no campo de Busca e toque em Buscar no teclado.
Aparecem alfinetes para coincidir com as localizações na área. Por exemplo, se você 
localizar a sua cidade e depois digitar “filmes” e tocar em Buscar, os alfinetes marcam 
os cinemas da sua cidade.
Toque no alfinete que marca uma empresa para ver o seu nome ou descrição.
Para buscar uma empresa sem buscar antes a localização: Digite algo como:
Â restaurantes rio de janeiro rj
Â apple inc nova iorquePara contatar uma empresa ou obter endereços: Toque no alfinete que marca uma 
empresa e, em seguida, toque no  ao lado do nome.
De lá, você pode fazer o seguinte:
Â Toque em Instruções até Aqui ou Instruções a Partir Daqui para encontrar itinerários.
Â Toque em Página Inicial para visitar o site, ou E-mail para enviar um e-mail.
Â Toque em “Adicionar Contatos“, depois toque em “Criar Novo Contato“, ou toque em 
“Adicionar a Contato”.
Â Como compartilhar a localização do negócio por e-mail.
Â Toque no  para ver a visualização da rua.  
Para ver uma lista de empresas encontradas na busca: Toque no  no campo de 
busca.
Escolha um negócio na lista de Resultados para ver sua localização. Toque no alfinete 
que marca uma empresa e, em seguida, toque no  ao lado do nome para ver suas 
informações.
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Como Compartilhar Informações de Localização
Você pode adicionar uma localização aos seus contatos. Você também pode enviar 
links a uma localização por e-mail.
Para adicionar uma localização à sua lista de contatos:  Encontre uma localização, 
toque no alfinete que aponta para ela, toque no  próximo ao nome ou descrição, 
toque em “Adicionar a Contatos” e, em seguida, pressione “Criar Novo Contato” ou 
“Adicionar a Contato ”. 
Para enviar o link de uma localização no mapa por e-mail Busque uma localiza-
ção, toque no alfinete fixado nela, toque no  e depois toque em Compartilhar 
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Como adicionar música e mais ao iPad
Navegue pela sua coleção musical por música, artista, álbum, gênero ou compositor. 
Escute suas músicas, audiolivros e podcasts. Crie e gerencie listas ou use o Genius para 
criar listas para você. Transmita a sua música, podcasts ou audiolivros sem fio para um 
Apple TV usando o AirPlay.
Existem duas maneiras de obter música, vídeos e outro conteúdo para o iPad:
Â Para transferir o conteúdo sincronizando-o do iTunes para o seu computador. Você 
pode sincronizar toda a sua música ou pode selecionar músicas, podcasts e coleções 
iTunes U específicas. Consulte “Como Sincronizar com o iTunes” na página 25.
Â Utilize a iTunes Store no iPad para comprar e transferir músicas, álbuns, programas 
de TV, filmes, videoclipes e audiolivros. Você também pode transmitir e transferir 
podcasts de áudio e vídeo, assim como conteúdo do iTunes U. Depois de escutar um 
podcast ou de assistir um programa de TV, você pode tocar em um link para obter 
mais episódios da iTunes Store. Consulte Capítulo 17,“iTunes Store,” na página 123.
Reprodução de Música e Outros Áudios
Escute áudio usando o alto-falante integrado. Você também pode conectar fones 
de ouvido cabeados na porta para fones de ouvido ou emparelhar fones de ouvido 
sem fio Bluetooth. O som não sai pelo alto-falante quando você conecta os fones de 
ouvido.
ADVERTÊNCIA: Para obter informações importantes sobre como evitar perda de audição, consulte o Guia de Informações Importantes do Produto iPad  em 
support.apple.com/pt_BR/manuals/ipad.
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Reprodução de Músicas
Para navegar por sua coleção: Toque em Música, Podcasts, Audiolivros, iTunes U ou 
Adquirido. Na parte inferior da tela, toque em Músicas, Artistas, Álbuns, Gêneros ou 
Compositores para navegar.
Para navegar por listas do Genius ou pela Seleção do Genius: Toque em Genius ou 
Seleção do Genius. Se o Genius não aparecer, talvez você precise ativar o Genius no 
iTunes e depois sincronizar o iPad. Consulte “Como Criar Listas Genius” na página 120.
Para reproduzir uma música: Toque em uma música.
Controle da Reprodução de Músicas
Ao reproduzir uma música, a tela Reproduzindo Agora aparece.
Pausar uma música Toque no  .
Retomar reprodução Toque no  .
Aumentar ou diminuir o volume Arraste o controle deslizante de volume da tela 
ou use os botões de volume do iPad.
Reiniciar uma música ou capítulo de um audiolivro ou podcast
Toque em  .
Passar para a música ou capítulo seguinte de 
um audiolivro ou podcast
Toque no  .
Passar para a música ou capítulo anterior de um 
audiolivro ou podcast
Toque em  duas vezes.
Avançar ou retroceder Mantenha o toque sobre o  ou  ; quanto 
mais tempo você manter o controle, mais rápido 
a música será retrocedida ou avançada. Como visualizar as capas no tamanho normal Toque na capa quando estiver reproduzindo uma 
música. 
Você pode exibir os controles de reprodução quando estiver ouvindo música e usando 
um outro aplicativo—ou mesmo quando o iPad estiver bloqueado.  
Para exibir os controles de reprodução de áudio a partir de outro app ou a partir da 
tela de bloqueio: Clique duas vezes do botão Início  e, em seguida, passe o dedo na 
parte inferior da tela, da esquerda para a direita.
Após usar os controles, toque em iPod para ira para a biblioteca do iPod ou clique no 
botão Início  para retornar ao aplicativo que você estava usando.
Se o iPad estiver bloqueado, os controles aparecerão na parte superior da tela e desaparecerão depois que você terminar de utilizá-los.
Controles de música adicionais
Na tela reproduzindo Agora, toque na capa do álbum para ver os controles.
Os controles de repetição  e aleatório  aparecem na barra de progressão. Você 
pode ver o tempo decorrido, o tempo restante e o número da música.  
Arraste o cursor de reprodução pela barra de progressão para saltar para qualquer 
ponto da música. Você pode ajustar a velocidade da progressão de alta velocidade 
para exploração detalhada, deslizando o dedo para baixo à medida que arrasta o cursor de reprodução ao longo da barra de progressão. Quanto mais você desliza o dedo 
para baixo, mais lenta fica a progressão.
Repetir Cursor de 
reprodução
Barra de 
progressão
Aleatório
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Ajustar o iPad para repetir músicas Toque no  . Toque no  novamente para definir o iPad para repetir apenas a música atual.
 = iPad está definido para repetir todas as mú-
sicas do álbum ou lista atual.
 = iPad está definido para repetir a música 
atual uma e outra vez.
 = iPad não está definido para repetir músicas.
Saltar para qualquer ponto de uma música Arraste o cursor de reprodução pela barra de 
progressão. Deslize o dedo para baixo para 
ajustar a velocidade da progressão. Quanto mais 
você desliza o dedo para baixo, mais lenta fica a 
progressão.
Ajustar o iPad para reproduzir músicas 
aleatoriamente
Toque no  para reproduzir as músicas de forma 
aleatória. Toque no  novamente para definir o 
iPad para reproduzir músicas ordenadamente.
 = iPad está definido para tocar músicas 
aleatoriamente.
 = iPad está definido para tocar músicas 
ordenadamente.
Misturar as faixas aleatoriamente em qualquer 
lista, álbum ou outra lista de músicas
Na tela Reproduzindo Agora, toque na capa do 
álbum para mostrar os controles da música na 
tela. Toque no  na parte inferior da tela, em 
seguida toque em Aleatório  na parte superior 
da lista de músicas. 
Esteja o iPad ajustado ou não para reproduzir 
aleatoriamente, se você tocar em Aleatório no 
alto de uma lista de músicas, o iPad reproduzirá 
as músicas dessa lista em ordem aleatória.
Reproduza música em um sistema de som 
AirPlay ou Apple TV
Toque em  e escolha um sistema de som. Se 
 não aparecer ou se você não vir o sistema 
AirPlay que está procurando, certifique-se de que 
ele está na mesma rede sem fio 
Alterne do AirPlay de volta para o iPad Toque em  e escolha iPad da lista.Controles de Podcast e Audiolivros
Na tela reproduzindo Agora, toque na capa do podcast ou do audiolivro para ver os 
controles.
O controle de e-mail e o controle da velocidade de reprodução aparecem junto com 
a barra de progressão. Você pode ver o tempo decorrido, o tempo restante, o número 
do episódio ou do capítulo. A barra de progressão permite a você saltar para qualquer 
ponto no podcast ou audiolivro.
E-mail Cursor de 
reprodução
Velocidade 
de reprodução
Para enviar um link do podcast por e e-mail:  Toque no  .
Para passar para qualquer ponto:  Arraste o cursor de reprodução pela barra de progressão. Ajuste a velocidade da progressão de alta velocidade para exploração detalhada, deslizando o dedo para baixo à medida que arrasta o cursor de reprodução ao 
longo da barra de exploração. Quanto mais você desliza o dedo para baixo, mais lenta 
fica a progressão. 
Para alterar a velocidade da reprodução:  Toque no  para alterar a velocidade.
Â = Reproduzir em velocidade normal
Â = Reproduzir em dupla velocidade
Â = Reproduzir com metade da velocidade
Lista de 
Faixas
Repetição de 
30 segundos
O controle de repetição de 30 segundos e o controle com a lista das faixas aparecem 
na parte inferior da tela.  
Para reproduzir novamente os últimos 30 segundos:  Toque no  .
Veja outros podcasts em série ou capítulos em um audiolivro:  Toque no  . Toque na 
miniatura do podcast ou do audiolivro para voltar à tela Reproduzindo Agora.
Como Visualizar Todas as Faixas de um Álbum
Para visualizar todas as faixas do álbum que contém a música atual: Na tela 
Reproduzindo Agora toque no  . Toque em uma faixa para reproduzi-la. Toque na miniatura do álbum para voltar à tela Reproduzindo Agora.
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Na visualização da lista de faixas, você pode atribuir classificações às músicas. Você 
pode utilizar classificações para criar listas inteligentes no iTunes que se atualizam de 
forma dinâmica para incluir, por exemplo, suas músicas melhor classificadas.
Para classificar uma música: Arraste sua miniatura através da barra de classificação (os 
cinco pontos debaixo do cursor de reprodução) para atribuir à música de zero à cinco 
estrelas.
Como buscar músicas
Você pode buscar por títulos, artistas, álbuns, compositores de músicas, podcasts e outro conteúdo que tiver sincronizado com o iPad.
Para buscar música, podcasts, audiolivros ou outro conteúdo na sua biblioteca:
Digite o texto no campo de busca da parte superior de uma lista de músicas, lista, lista 
de artistas ou outra visualização de conteúdo do seu iPod. (Toque na barra de estado 
para rolar rapidamente para o topo de uma lista e revelar o campo de busca.)
Os resultados da busca aparecem automaticamente à medida que você digita. Toque 
em Buscar para que o teclado desapareça e você possa ver mais resultados. 
Você também pode utilizar o Spotlight para buscar uma música. Consulte “Busca do 
Spotlight” na página 173.
Utilização de Listas
Uma lista é uma compilação personalizada de músicas. Você pode desejar criar uma 
lista com um ritmo ou ocasião específica ou organizar sua biblioteca musical. Você 
pode usar três tipo de listas no iPad—listas padrão, listas Genius e Seleção do Genius.
Como criar listas
Você pode criar listas das músicas, podcasts e audiolivros que estão na sua biblioteca 
do iPod.  
Para criar uma lista padrão:
1 Toque no iPod, em seguida toque no  na parte inferior da tela. 
2 Digite um nome para a lista e depois toque em Salvar.
3 Toque no  ao lado das suas seleções, em seguida toque em OK quando terminar de 
selecionar. Você também pode tocar em Fontes para navegar por seleções.  
4 Quando acabar, pressione OK.
Você também pode criar listas de outras categorias na biblioteca do seu iPod, tais 
como podcasts ou audiolivros.
Quando você cria uma lista no iPad, a lista também é salva na biblioteca do iTunes no 
seu computador na próxima vez que você sincronizar.Para editar uma lista: Toque na lista de reprodução, toque em Editar e faça o seguinte:
Â Para mover uma seleção mais para cima ou para baixo da lista, arraste o  ao lado da 
seleção.
Â Para apagar uma seleção, toque no  ao lado da seleção e, em seguida, toque em 
Apagar. Apagar uma música de uma lista não a apaga do iPad.
Â Para adicionar mais músicas, toque em Adicionar Músicas, toque no  ao lado da 
seleção e depois toque em OK.
Para limpar uma lista: Toque na lista, toque em Editar e, em seguida, toque no  .
Como Criar Listas Genius
O Genius busca as músicas da sua biblioteca do iTunes que combinam bem entre si. 
Uma lista Genius é uma coleção de músicas selecionadas que combinam com uma 
música que você escolher da sua biblioteca.  
Você pode criar listas Genius no iTunes e sincronizá-las com o iPad. Você também pode 
criar e salvar listas Genius no iPad.
Para utilizar o Genius no iPad, primeiro ative o Genius no iTunes, depois sincronize o 
iPad com o iTunes. O Genius é um serviço gratuito, mas requer um ID Apple. 
Como criar uma lista Genius no iPad:
1 Toque no  ; depois, toque em Nova.
2 Toque em uma música da lista. O Genius cria uma listas de músicas similares.
Você também pode criar uma lista Genius de músicas que combinam perfeitamente 
com a música que está sendo reproduzida. Na tela Reproduzindo Agora, toque na capa 
do álbum para exibir os controles adicionais e toque no  .
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Para salvar uma lista Genius: Na lista, toque em Salvar. A lista é salva no Genius com o 
título da música que você escolheu.
Você pode criar e salvar quantas listas Genius desejar. Se você salvar uma lista Genius 
criada no iPad, ela será sincronizada no iTunes na próxima vez que você conectar.
Para atualizar uma lista Genius: Na lista, toque em Atualizar.
Atualizar uma listas Genius cria uma lista Genius de músicas diferentes que combinam 
com a música que você escolheu. Você pode atualizar qualquer lista Genius, mesmo se 
ela foi criada no iTunes e sincronizada com o iPad, ou criada no iPad.
Para criar uma lista Genius a partir de uma música nova: Na lista, toque em Nova e 
depois escolha uma nova música.
Para apagar uma lista Genius salva: Toque a lista Genius e, em seguida, toque em 
Apagar.
Quando uma lista Genius é sincronizada no iTunes, talvez você não possa apagá-la diretamente no iPad. Você pode usar o iTunes para editar o nome da lista, interromper a 
sincronização ou apagar a lista.
Reprodução de Seleção do Genius
O Genius automaticamente busca na biblioteca do seu iPad e encontra músicas da sua 
biblioteca daquele gênero ou formato. As Seleções Genius são recriadas cada vez que 
você as ouve para que sejam sempre novas e originais. 
A Seleção do Genius cria diferentes seleções dependendo da variedade de música que 
você possui na sua biblioteca do iPad. Por exemplo, você pode ter Seleções do Genius 
que destacam músicas Clássicas, Jazz ou Rock Alternativo.
Para explorar as Seleções Genius: No lado esquerda da janela do iPod (abaixo do 
Genius), toque em Seleção do Genius.
Para reproduzir uma Seleção Genius: Toque na seleção.
Compartilhamento Familiar
O Compartilhamento Familiar permite que você reproduza músicas, filmes e programas de TV no iPad a partir da biblioteca do iTunes no seu Mac ou PC. 
Nota: Manuais, álbuns, LPs e outros conteúdos de bônus não podem ser 
compartilhados.
O iPad e o seu computador devem estar na mesma rede Wi-Fi. O iTunes deve estar 
aberto no seu computador, com o Compartilhamento Familiar ativado e com a sessão 
iniciada na mesma conta da Apple que o Compartilhamento Familiar do iPad. 
Para ativar o Compartilhamento Familiar no iTunes: No seu computador, abra o iTunes e escolha Avançado > Ativar Compartilhamento Familiar. Digite seu ID e senha da 
Apple, depois clique em Criar Compartilhamento Familiar.Para reproduzir música ou vídeo no iPad a partir da sua biblioteca do iTunes:
1 Em Ajustes, escolha iPod e, em seguida, em Compartilhamento Familiar, insira o mesmo ID e senha da Apple usados ao ativar o Compartilhamento Familiar no iTunes.
2 No iPod, toque em Mais e, em seguida, toque em Compartilhado e escolha a sua biblioteca do iTunes.
As guias Listas, Artistas, Músicas e outras no iPod agora mostram o conteúdo da sua 
biblioteca do iTunes, em vez do conteúdo do seu iPad.
Para retornar ao conteúdo do seu iPad: No iPod, toque em Mais e, em seguida, toque 
em Compartilhado e escolha iPad no topo da lista.
Transferência de Conteúdo
Você pode transferir as compras feitas no iPad para um computador que esteja autorizado a reproduzir o conteúdo do seu ID Apple. Para autorizar o computador, abra o 
iTunes no computador e escolha Loja > Autorizar Este Computador.
Para transferir o conteúdo comprado: Conecte o iPad ao seu computador. O iTunes 
perguntará que você deseja transferir o conteúdo comprado.
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Sobre a iTunes Store
Use a iTunes Store para adicionar conteúdo ao seu iPad. Você pode navegar e comprar 
música e programas de TV, comprar e alugar filmes ou transferir e reproduzir podcasts 
ou coleções do iTunes U.  
Muitos filmes e programas de TV estão disponíveis tanto em definição padrão como 
alta definição. Para acessar a iTunes Store, o iPad deve possuir conexão à Internet. 
Consulte “Como Conectar-se à Internet” na página 30.
Nota: A iTunes Store não está disponível em todas as regiões e o conteúdo da iTunes 
Store pode variar, dependendo da região.
Transferência de Conteúdo
Você pode transferir compras realizadas no iPad a um computador autorizado a reproduzir conteúdo do seu ID da Apple.
Para autorizar um computador:  Abra o iTunes no computador, depois escolha Loja > 
Computador Autorizado.
Para transferir o conteúdo comprado: Conecte o iPad ao seu computador. O iTunes 
verifica se você deseja transferir o conteúdo comprado.
17
iTunes StoreComo buscar músicas, vídeos e muito mais
Para explorar o conteúdo: Na parte superior da tela, navegue por Gêneros, Destaques, 
Paradas de Sucesso ou Genius. Na parte inferior da tela, toque em Música, Filmes, 
Programas de TV, Podcasts, Audiolivros, iTunes U ou Transferências.  
Para buscar conteúdo: Toque no campo de busca na parte superior da tela, depois 
use o teclado na tela para digitar uma ou mais palavras. Toque em Buscar do teclado. 
Os resultados da busca são agrupados por categoria, como Filmes, Álbuns ou Podcasts.
Toque em um item para ver mais informações. Você pode ler opiniões, escrever sua 
própria opinião ou enviar por e-mail um link sobre o item a um amigo. Dependendo 
do item, você também pode comprá-lo, transferi-lo ou alugá-lo.
Como Seguir Artistas e Amigos
Utilize o iTunes Ping para se conectar com fãs de música do mundo inteiro. Siga seus 
artistas favoritos para descobrir sobre novos lançamentos, shows e tours agendados. 
Sinta-se nos bastidores dos shows vendo suas fotos e vídeos e sabendo mais sobre 
suas influências musicais. Leia os comentários de seus amigos sobre as músicas que 
eles estão ouvindo, veja o que eles estão comprando e fique por dentro dos shows 
que eles pretendem assistir. Expresse seus gostos musicais e publique comentários 
para os seus próprios seguidores.
Para criar e explorar as conexões musicais, é preciso criar um perfil.
Para criar seu perfil do iTunes Ping:Abra o aplicativo iTunes em seu Mac ou PC, clique 
em Ping e siga as instruções da tela.
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Para explorar o iTunes Ping no seu iPad:  Abra o aplicativo iTunes, toque em Ping (toque em Mais, primeiro, se Ping não estiver visível) e, em seguida:
Â Toque em Activity para ver as últimas novidades das pessoas que você segue. As 
atualizações incluem compras, comentários, gostos e publicações.
Â Toque em People para ver quem você está seguindo e quem está seguindo você e 
para buscar artistas ou amigos.
Â Toque em My Profile para ver as informações do seu perfil.
Para seguir um artista:  Toque em Follow na página do perfil do artista.
Â Por busca: Toque em People, insira o nome do artista no campo de busca na parte 
superior da página e, em seguida, toque em Search. Toque no nome do artista na 
lista de resultados e, em seguida, toque em Follow.
Â Durante a busca: Toque em Profile na parte inferior de qualquer página de álbum e, 
em seguida, toque em Follow.
Para seguir um amigo:Escolha seu grupo inicial de amigos quando você configurar 
seu perfil usando o iTunes no seu Mac ou PC. Depois disso, você pode seguir amigos 
usando o Ping no iPad.
Â Por busca: Toque em People, insira o nome do seu amigo no campo de busca e, em 
seguida toque em Search. Toque no nome do seu amigo na lista de coincidências e, 
em seguida, toque em Follow.
Â Durante a exploração do Ping: Toque o nome de uma pessoa e, em seguida, toque 
em Follow.
Quando você segue uma pessoa, ela não segue você automaticamente. Em seu perfil, 
você pode optar por aprovar ou recusar pedidos de seguimento quando eles chegarem ou simplesmente aceitar todos os novos seguidores sem aprovação.
Para compartilhar seus pensamentos:  Conforme você navega pelos álbuns e músicas, 
toque em Post para comentar uma obra musical ou toque em Like, para dizer que você 
gosta. Seus amigos verão seus pensamentos no documento Activity do iTunes Ping.
Para compartilhar planos para assistir a shows:  Toque em Concerts em sua página 
de perfil para ver os futuros shows dos artistas que você segue e para ver quais dos 
seus amigos irão a um show. Toque em Tickets para comprar o seu tíquete ou toque 
em I’m Going para que outras pessoas saibam que você vai também. (Não está disponível em todos os países ou regiões.)Como comprar música ou audiolivros
Quando você encontrar uma música, um álbum ou um audiolivro que gostar na iTunes 
Store, poderá comprá-los e transferi-los para o iPad. Você também pode pré-visualizá-
los para certificar-se que são o que você deseja.
Para realizar compras ou escrever opiniões, você necessitará um ID da Apple. O iPad 
obtém seus ajustes de conta do iTunes quando você sincronizar. Se você não tiver um 
ID Apple ou se quiser fazer compras com um ID da Apple diferente, abra Ajustes > 
Store.
Você não precisa de um ID da Apple para reproduzir ou transferir podcasts ou aulas do 
iTunes U.
Para pré-visualizar uma música: Toque no número na coluna e depois toque no  .
Para pré-visualizar um audiolivro:Toque no item.
Para comprar e transferir uma música, álbum ou audiolivro:
1 Toque no preço e depois toque em Comprar.
2 Inicie sessão usando o seu ID da Apple conforme solicitado e toque em OK.
Se você não tiver um ID da Apple, toque em Criar Novo ID da Apple para configurar 
um. 
As compras são cobradas no seu ID da Apple. Se você fizer outras compras no prazo 
de quinze minutos, não precisará digitar sua senha novamente.
Um aviso aparece no caso de você já haver comprado uma ou mais músicas do 
álbum. Toque em Comprar se deseja adquirir o álbum completo incluindo as músicas que já comprou ou toque em Cancelar se deseja adquirir as músicas restantes 
individualmente.
Uma vez que o item tenha sido comprado, ele começa a ser transferido. Consulte 
“Como verificar o estado de uma transferência” na página 128.
As músicas compradas são adicionadas à lista Adquirido no iPad (iPod > Adquirido). Se 
você apagar a lista Adquirido, o iTunes criará uma nova lista quando você adquirir um 
item da iTunes Store.
Você pode usar cartões de presente, vales-presente ou outros códigos promocionais 
da iTunes Store para comprar. Quando você iniciar a sessão na sua conta, seu crédito 
restante aparece com as informações da sua conta na parte inferior da maioria das 
telas da iTunes Store.
Para digitar um código de resgate: Toque em Música, role até a parte inferior da tela, 
toque em Resgatar e siga as instruções na tela.
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Como comprar e alugar vídeos
Se você encontrar um filme, um programa de TV ou um videoclipe que gostar na iTunes Store, poderá adquiri-lo e transferi-lo para o iPad. Você pode adquirir filmes e programas de TV em formato padrão (480p) ou em alta definição (720p). Se você comprar 
uma versão em alta definição, você também recebe a versão com a definição padrão.
Para pré-visualizar um vídeo: Toque em Pré-visualizar.
Para comprar ou alugar um vídeo:
1 Toque em Comprar ou Alugar.
2 Inicie sessão usando o seu ID da Apple conforme solicitado e toque em OK.
Se você não tiver um ID da Apple, toque em Criar Novo ID da Apple para configurar 
um. 
Sua compra é cobrada no seu ID da Apple. Para compras adicionais feitas nos quinze 
minutos seguintes, você não terá que digitar sua senha novamente.
Uma vez que o item tenha sido comprado, ele começa a ser transferido. Os filmes alugados só começam a ser reproduzidos quando a transferência é totalmente concluída. 
Consulte “Como verificar o estado de uma transferência” na página 128.
Os vídeos comprados são adicionadas à lista de reprodução Adquiridos no iPad (iPod 
> Adquiridos). Se você apagar a lista Adquirido, o iTunes criará uma nova lista na pró-
xima vez que você adquirir um item da iTunes Store. Os vídeos comprados também 
aparecem no aplicativo Vídeo.
Você pode usar cartões de presente, vales-presente ou outros códigos promocionais 
da iTunes Store para comprar. Quando você iniciar a sessão usando seu ID da Apple, 
seu crédito de loja restante aparece com as informações da sua conta na parte inferior 
da maioria das telas da iTunes Store.
Para digitar um código de resgate: Toque em Música, depois toque em Resgatar na 
parte inferior da tela e siga as instruções.
Como Ouvir ou Assistir Podcasts
você pode ouvir podcasts de áudio ou assistir podcasts de vídeo no iPad. Você também pode transferir podcasts para o iPad, e sincronizá-los com a biblioteca do iTunes 
no seu computador quando se conectar.
Toque em Podcasts na parte inferior da tela da iTunes Store. Navegue por Destaques 
ou Paradas de Sucesso. Para ver uma lista de episódios, toque em um podcast. O ícone 
 indica os podcasts de vídeo.
Para ouvir um podcast: Toque no título do podcast.
Para transferir um podcast: Toque no botão Grátis e depois toque em Obter Episódio. 
Os podcasts baixados aparecem na lista de podcasts no iPod.Para ouvir ou assistir um podcast transferido: No iPod, toque em Podcasts e depois 
toque em podcast. Os podcasts de vídeo também aparecem no aplicativo Vídeo.
Obtenha mais episódios do podcast que você transferiu: Na lista de podcasts do 
iPod, toque no podcast e depois toque em Obter Mais Episódios.
Para apagar um podcast: Na lista Podcasts do iPod, passe o dedo para a esquerda ou 
para a direita sobre o podcast e toque em Apagar.
Como verificar o estado de uma transferência
Você pode verificar a tela Transferências para ver o estado das transferências programadas e em andamento, inclusive o estado das compras que você tenha reservado.
Para ver o estado dos itens que estão sendo transferidos: Toque em Transferências.
Para pausar uma transferência, toque o  .
Se uma transferência for pausada ou interrompida, o iPad começará a transferir novamente na próxima vez que se conectar à Internet. Ou, se você abrir o iTunes no 
seu computador, ele concluirá a transferência na sua biblioteca do iTunes (se o seu 
computador possuir uma conexão à Internet e você tiver iniciado a sessão utilizando o 
mesmo ID da Apple).
Para ver o estado dos itens reservados: Toque em Transferências.
Os itens reservados aparecem em uma lista até a data de lançamento do item. Toque 
no item para ver as informações da data de lançamento. Uma vez que o item estiver 
disponível para transferência, um ícone de transferência  aparecerá ao lado da 
transferência.
Para transferir um item reservado: Toque no item e, em seguida, toque no  .
Os itens reservados não são transferidos automaticamente quando são lançados. Volte 
à tela Transferências para iniciar a transferência.
Alguns álbuns incluem bônus, que podem ser transferidos para a biblioteca do iTunes 
do seu computador. Nem todo o conteúdo de bônus pode ser transferido diretamente 
para o iPad. 
Para transferir conteúdo de bônus: Inicie a sessão usando o seu ID da Apple. No 
iTunes, escolha Loja > “Verificar Transferências Disponíveis” e, em seguida, clique em 
Verificar.
Sincronização de Conteúdo
O iTunes sincroniza automaticamente tudo que você transfere ou compra no iPad com 
a biblioteca do seu iTunes quando você conecta o iPad ao computador. Isso permite 
acessar as transferências do seu computador e fornece um backup caso você apague 
algum conteúdo adquirido do iPad.
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O conteúdo adquirido é sincronizado com a lista “Adquirido em ”. 
O iTunes cria a lista se ela não existir. O iTunes também sincroniza as suas aquisições 
na lista Adquirido que ele utiliza para as aquisições feitas no seu computador, caso 
essa lista exista e esteja configurada para sincronizar com o iPad.
Os podcasts transferidos são sincronizados com a lista de podcasts da sua biblioteca 
do iTunes.
Como verificar as informações do ID da Apple
Para visualizar as informações da iTunes Store do seu ID da Apple no iPad, role até a 
parte inferior da tela e toque em Iniciar Sessão. Se já houver iniciado a sessão, toque 
em Conta. Ou vá para Ajustes > Loja e toque em Ver ID da Apple. Você deve iniciar a 
sessão para visualizar as informações da sua conta.
Como Verificar suas Compras
Você pode usar o iTunes em seu computador para verificar se todas as músicas, vídeos, 
aplicativos e outros itens comprados na iTunes Store ou App Store estão na biblioteca 
do iTunes. Talvez você queira realizar esta verificação se uma transferência tiver sido 
interrompida.
Para verificar suas compras:
1 Certifique-se que seu computador possui uma conexão à Internet.
2 No iTunes, escolha Loja > Buscar Transferências Disponíveis.
3 Digite seu ID e senha da Apple, depois clique em Verificar.
As compras que ainda não estão no seu computador são transferidas.
A lista Adquirido exibe as suas compras. Entretanto, como você pode adicionar ou 
remover itens dessa lista, talvez ela não mostre todos os itens com precisão. Para ver 
todas as suas compras, inicie a sessão em sua conta, escolha Loja > Visualizar Minha 
Conta e depois clique em Histórico de Compras.130
Sobre a App Store
Use a App Store para adicionar aplicativos ao iPad. Navegue, compre e descarregue 
aplicativos especialmente desenhados para o iPad, ou para o iPhone e o iPod touch.  
Os aplicativos que você transfere e instala da App Store no iPad são guardados como 
backup na sua biblioteca do iTunes da próxima vez que você sincronizar. Quando 
você sincroniza, também pode instalar no iPad os aplicativos que comprou através no 
iTunes no seu computador. O iPad funciona com a maioria dos aplicativos do iPhone e 
iPod touch, portanto se você já tiver aplicativos para o seu iPhone ou iPod touch, pode 
sincronizá-los para o iPad a partir do seu Mac ou PC. Use-os no seu tamanho original 
ou toque  no canto inferior direito da tela para ampliá-los.
Nota: A App Store e alguns aplicativos não estão disponíveis em todas as regiões. A 
disponibilidade e o preço dos aplicativos estão sujeitos à mudanças.
Para usar a App Store, o iPad deve possuir conexão à Internet. Consulte “Como 
Conectar-se à Internet” na página 30. Você também precisa de um ID da Apple (não 
disponível em alguns países) para transferir os aplicativos. O iPad obtém os seus ajustes do ID da Apple a partir do iTunes. Se você não tiver um ID da Apple ou se quiser 
fazer compras usando um ID da Apple diferente, abra Ajustes > Loja. Consulte “Loja” na 
página 187.
Como Navegar e Buscar
Navegue pelos destaques para ver os aplicativos novos, incríveis ou recomendados ou 
navegue pelas Paradas de Sucesso para ver os aplicativos mais populares. Se estiver 
buscando um aplicativo específico, use Buscar.
Para explorar os aplicativos: Toque em Destaques, Paradas de Sucesso ou Categorias 
na parte inferior da tela.
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Para navegar usando o Genius: Toque em Genius para ver uma lista de aplicativos 
recomendados com base em sua coleção atual de aplicativos. Para ativar o Genius, siga 
as instruções da tela. O Genius é um serviço gratuito, mas requer um ID da Apple. 
Como buscar aplicativos: Toque no campo de busca situado na parte superior da tela 
e digite uma ou mais palavras. Selecione na lista de sugestões ou toque em Buscar no 
teclado.
Como Obter Mais Informações
Toque em qualquer aplicativo de uma lista para ver a tela Informações, que mostra o 
preço do aplicativo, capturas de tela e classificações.
Para enviar um link à página de informações do aplicativo, via e-mail: Toque em 
“Avisar um Amigo“ situado na parte superior da tela.
Como comunicar um problema: Toque em “Comunicar Problema” na parte inferior da 
tela Informações. Selecione um problema da lista ou digite seus comentários, depois 
pressione Comunicar.
Para visualizar as capturas de tela: Role para baixo até as capturas de tela e então 
passe o dedo para a esquerda ou para a direita para ver outras capturas de tela.  
Para obter classificações e ler opiniões: Role para baixo até “Classificações e Opiniões 
de Clientes.”  
Como comprar aplicativos
Quando encontrar um app que deseja na App Store, você pode adquiri-lo e transferi-lo 
para o iPad. Se este aplicativo estiver livre, você pode transferi-lo sem carregar.Uma vez transferido o aplicativo, ele é imediatamente instalado no iPad.
Para adquirir e transferir um app:
1 Toque no preço e depois toque em Comprar App (ou toque em Grátis e depois toque 
em Instalar App).
2 Inicie sessão usando o seu ID da Apple conforme solicitado e toque em OK.
Se você não tiver um ID da Apple, toque em Criar Novo ID da Apple para configurar 
um. 
As compras são cobradas no seu ID da Apple. Se você fizer outras compras no prazo 
de quinze minutos, não precisará digitar sua senha novamente.
Você pode usar cartões de presente, vales-presente ou outros códigos promocionais 
da iTunes Store para comprar. Quando você iniciar a sessão usando o seu ID da Apple, 
seu crédito restante aparece com as informações da sua conta na parte inferior da 
maioria das telas da App Store.
Para digitar um código de resgate: Toque em Destaques ou Paradas de Sucesso, role 
até a parte inferior da tela, toque em Resgatar, e depois siga as instruções na tela.
Para ver o estado dos aplicativos transferidos: Depois que começar a transferir 
um aplicativo, o ícone do aplicativo aparecerá na tela Início com um indicador de 
progresso.
Se uma transferência for interrompida, o iPad começará a transferir novamente na 
próxima vez que se conectar à Internet. Ou, se abrir o iTunes no seu computador, ele 
terminará a transferência na sua biblioteca do iTunes (se o seu computador estiver conectado à Internet e você tiver iniciado a sessão usando o mesmo ID da Apple).
Como Utilizar os Apps
Os aplicativos desenhados para o iPad funcionam em qualquer orientação - vertical 
ou horizontal. Quando você usa um aplicativo na orientação horizontal, ele preenche a 
tela.
No iPad, você pode usar aplicativos desenhados para iPhone ou iPod touch no tamanho original ou ampliá-los.
Para ampliar um aplicativo: Toque no  no canto inferior direito.
Retornar um aplicativo ao seu tamanho original: Toque no  no canto inferior 
direito.
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Alguns aplicativos permitem que você faça compras dentro do aplicativo. Você pode 
restringir as compras feitas de dentro do app nos Ajustes. Consulte “Restrições” na 
página 174.
Alguns aplicativos utilizam notificações push para alertá-lo sobre novas informações, 
mesmo quando o aplicativo não está sendo executado. Dependendo do aplicativo, as 
notificações diferem, mas podem incluir alertas de texto ou de som, ou um número no 
ícone do aplicativo na tela Início. 
Como Atualizar Apps
A App Store verifica atualizações para os aplicativos que você instalar. O ícone da App 
Store mostra o número total de atualizações de aplicativos disponíveis.
Se houver uma atualização disponível quando você acessar a App Store, a tela de 
Atualizações aparece imediatamente. As atualizações de aplicativos são transferidas e 
instaladas quando você decide atualizá-los.  
Nota: Atualizações de aplicativos são novas versões, que você pode comprar ou 
transferir.
Para atualizar um app:
1 Na parte inferior da tela, toque em Atualizações.
2 Toque em um app para ver mais informações sobre a atualização.  
3 Toque em Atualizar.
Para atualizar todos os aplicativos: Na parte inferior da tela, toque em Atualizações e, 
em seguida, toque em Atualizar Tudo.
Se você tentar atualizar um aplicativo comprado com um ID da Apple diferente, será 
solicitado tal ID da Apple e a senha.
Como escrever opiniões
Você pode escrever e enviar opiniões sobre os aplicativos no iPad.
Para escrever uma opinião:
1 Na tela Informações, role para baixo até “Classificações e Opiniões de Clientes.”  
2 Toque em “Escrever uma Opinião.”
3 Defina a classificação (1–5 estrelas), digite um título para a opinião e adicione comentários opcionalmente.  4 Toque em Enviar.
Antes de enviar uma revisão, você deve haver iniciado a sessão com o seu ID da Apple 
e ter comprado, ou transferido, o aplicativo.
Como Apagar Apps
Você pode apagar aplicativos do iPad que instalou da App Store. Você não pode apagar os aplicativos integrados do iPad.  
Quando você sincroniza, o iTunes faz automaticamente o backup de quaisquer aplicativos que você transfira para o iPad. Se você apagar um aplicativo do iPad, é possível 
reinstalá-lo se ele foi previamente sincronizado.
Importante: Se você apaga um aplicativo, os documentos associados ao aplicativo são 
apagados do iPad, a menos que você reinstale o aplicativo e restaure seus dados de 
um backup usando o iTunes.
Para apagar um app da App Store:
1 Mantenha o toque sobre qualquer ícone de aplicativo da tela Início até que os ícones 
comecem a tremular.
2 Toque  no canto do aplicativo que deseja apagar.
3 Toque em Apagar. 
Pressione o botão Início  para cancelar.
Quando você apaga um aplicativo, seus dados já não ficam acessíveis, mas não são 
apagados do iPad. Para obter informações sobre como eliminar todo o conteúdo e 
ajustes, consulte “Como redefinir o iPad” na página 178.
Como Sincronizar Compras
Quando você conectar o iPad ao seu computador, o iTunes automaticamente sincroniza os aplicativos que você transferiu ou comprou no iPad para sua biblioteca do 
iTunes. Esta ação permite acessar as transferências de aplicativos no seu computador e 
fornece um backup, caso você apague aplicativos do iPad.
Será realizado o backup dos aplicativos transferidos na próxima vez que você sincronizar com iTunes. Em outras palavras, o backup é realizado somente nos dados dos 
aplicativos, quando você sincroniza com o iTunes.
Os aplicativos são sincronizados para a lista Apps na sua biblioteca do iTunes.
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Sobre o iBooks
O iBooks é uma ótima maneira de ler e comprar livros. Faça a transferência grátis do 
aplicativo iBooks da App Store e adquira de clássicos a best-sellers da loja iBookstore 
integrada. Depois de ter transferido um livro, ele é mostrado na sua prateleira de livros.
Adicione livros ePub e PDFs a sua estante de livros utilizando o iTunes. Depois, toque 
em um livro para começar a ler. O iBooks guarda a sua localização, assim você pode 
retomar facilmente a leitura do ponto onde parou. A ampla gama de opções de visualização torna fácil a leitura dos livros.
19
iBooksO iBooks e a iBookstore não estão disponíveis em todos os idiomas e todas as 
localizações.
Disponível no iBookstore. A disponibilidade do título está sujeita a alterações.
Para transferir o aplicativo iBooks e utilizar a iBookstore, você precisa de uma conexão 
à Internet e de uma conta da Apple. Se você não tiver uma conta ID ou se quiser fazer 
compras usando um ID Apple diferente, abra Ajustes > Loja. 
Como Sincronizar Livros e PDFs
Você pode transferir ou comprar a partir da iBookstore. Você também pode adicionar 
livros ePub DRM-free e PDFs na sua biblioteca do iTunes. Existem vários sites que oferecem livros nos formatos ePub e PDF.
Utilize o iTunes para sincronizar seus livros e PDFs entre o iPad e o seu computador. 
Quando o iPad estiver conectado ao seu computador, o painel Livros permite selecionar quais itens sincronizar.
Para sincronizar um livro ePub ou um PDF no iPad:  Transfira o livro ou o PDF usando 
o seu computador. Em seguida, no iTunes, escolha Arquivo > Adicionar à Biblioteca e 
selecione o arquivo. Conecte o iPad ao seu computador, selecione o livro ou PDF no 
painel Livros do iTunes e, em seguida, sincronize o iPad.
Se um PDF não aparecer no painel Livros, você necessitará alterar seu tipo no iTunes. 
Busque na sua biblioteca do iTunes para encontrar o arquivo PDF, selecione-o e, em 
seguida, escolha Arquivo > Obter Informações. Na seção Opções da janela de informa-
ções do arquivo, selecione Livro do menu local Tipo de Mídia e, em seguida, clique em 
OK.
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Como Utilizar a iBookstore
No aplicativo iBooks, toque em Loja para abrir a iBookstore. A partir dela, você pode 
navegar pelos livros em destaque ou pelos livros mais vendidos e buscar livros por autor ou assunto. Quando encontrar um livro que goste, pode comprá-lo e transferi-lo.
Nota: Talvez alguns recursos da iBookstore não estejam disponíveis em todas as 
localizações.
Para obter mais informações:  Na iBookstore, você pode ler um resumo do livro, ler ou 
escrever uma opinião e transferir uma amostra do livro antes de comprá-lo.
Para comprar um livro:  Busque um livro que deseja, toque no preço e, em seguida, 
toque em Comprar Agora. Inicie sessão usando o seu ID Apple e toque em OK. Talvez 
alguns livros tenham a transferência gratuita.
A compra será cobrada na sua conta da Apple. Se fizer compras adicionais nos quinze 
minutos seguintes, você não terá que digitar sua senha novamente.
Se já comprou um livro e deseja transferi-lo novamente, toque em Compras na iBookstore e busque o livro na lista. Em seguida toque Retransferir.
Os livros que você comprar serão sincronizados na sua biblioteca do iTunes da próxima vez que sincronizar o iPad com o seu computador. Esta ação proporciona um backup, caso você apague o livro do iPad.
Como Ler Livros
Ler um livro é fácil. Vá para a estante e toque no libro que deseja ler. Se você não vir o 
livro que está procurando, toque em Coleções para visualizar outros grupos de livros.Para virar a página:  Toque próximo da margem direita ou esquerda de uma página, 
ou passe o dedo para a esquerda ou para a direita. Para alterar a direção da passagem 
da página quando você toca a margem esquerda, abra Ajustes > iBooks.
Para ir para uma página específica:  Toque próximo ao centro da página atual para 
exibir os controles. Arraste o controle de navegação da página da parte inferior da tela 
para a página desejada e solte-o. 
Para ir para o índice:  Toque próximo do centro da página atual para mostrar controles 
e, em seguida, toque em  . Toque em uma entrada para saltar para aquela localização, 
ou toque Retomar para retornar à página atual.
Para adicionar ou remover um favorito:  Toque na fita para definir um favorito. Você 
pode ter vários favoritos. Para remover um favorito, toque nele. Você não necessita adicionar um favorito ao fechar um livro, o iBooks lembra onde você parou e volta para 
essa posição quando você abrir o livro novamente.
Para adicionar, remover ou editar um texto destacado:  Toque e mantenha pressionada qualquer palavra até que ela seja selecionada. Utilize os pontos de captura para 
ajustar a seleção, depois toque em Destacar. Para remover um texto destacado, toque 
no texto e, em seguida, toque em Remover Destaque. Para alterar a cor de um texto 
destacado, toque no texto destacado e, em seguida, toque em Cores e selecione uma 
cor no menu.
Para adicionar, visualizar ou remover uma nota:  Toque e mantenha pressionada 
qualquer palavra até que ela seja selecionada. Utilize os pontos de captura para ajustar 
a seleção, depois toque em Nota. Digite o texto e, em seguida, toque no botão OK. 
Para visualizar uma nota, toque no indicador da margem próxima ao seu texto destacado. Para remover uma nota, toque no texto destacado e, em seguida, escolha em 
Apagar Nota. Para alterar a cor de uma nota, toque no texto destacado e, em seguida, 
toque em Cores e selecione uma cor no menu.
Para ver todos os seus favoritos, textos destacados e notas:  Para ver os favoritos, textos destacados e as notas que adicionou, toque em  , depois toque em Favoritos. Para 
visualizar uma nota, toque no seu indicador.
Para aumentar uma imagem:  Toque duas vezes em uma imagem. 
Para ler um livro quando estiver deitado, use o bloqueio de rotação de tela para impedir que o iPad gire a tela quando você inclinar o iPad. Para obter informações, consulte 
“Visualização na Vertical ou Horizontal” na página 16.
Como ler PDFs
Você pode utilizar o iBooks para ler PDFs. Vá para a estante de livros e toque em 
Coleções, selecione uma coleção e, em seguida, toque no PDF que deseja ler.
Para virar a página:  Passe o dedo para a esquerda ou para a direita 
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Para aumentar uma página:  Separe dois dedos para ampliar uma página e, em seguida, role para ver a parte que deseja.
Para ir para uma página específica:  Toque próximo ao centro da página atual para 
exibir os controles. Em seguida, nos controles de navegação na parte inferior da página, arraste até que apareça o número de página desejado ou toque em uma miniatura 
para saltar para aquela página.
Para adicionar ou remover um favorito:  Para adicionar um favorito, toque na fita. 
Você pode ter vários favoritos. Para remover um favorito, toque nele. Você não necessita definir um favorito ao fechar um PDF, o iBooks lembra onde você parou e volta para 
essa posição quando você abrir o PDF novamente.
Para ir para o índice:  Toque próximo do centro da página atual para mostrar controles 
e, em seguida, toque em  . Toque em uma entrada para saltar para aquela localização, 
ou toque em Retomar para retornar para a página atual. Se o autor não definiu um 
índice, em vez disso, você pode tocar em um ícone de página.
Como Alterar a Aparência de um Livro
Para alterar a aparência de um livro acesse os controles tocando próximo do centro de 
uma página.
Para alterar o tamanho do tipo ou fonte:  Toque em  e, em seguida, na lista que 
aparece, toque em  ou em  para reduzir ou aumentar o tamanho do tipo. Para alterar a fonte, toque em Fontes e, em seguida, selecione uma fonte da lista. A alteração da 
fonte e tamanho da letra também altera a formatação do texto.
Para alterar o brilho:  Toque no  , depois ajuste o brilho.
Para alterar a cor da página e da letra:  Toque no  , e ative a opção Sépia para alterar a cor da página e da letra. Esse ajuste é aplicável a todos os livros.
Você pode alterar a forma que o iBooks justifica o texto dos parágrafos em Ajustes > 
iBooks.
Como sincronizar livros e PDFs
É possível buscar por título e autor de um livro para localizá-lo rapidamente na estante. 
Também é possível buscar o conteúdo de um livro para encontrar todas as referências 
para uma palavra ou frase na qual está interessado. Também é possível enviar uma 
busca para Wikipédia ou Google para encontrar outros recursos relacionados.
Para buscar um livro:  Vá para a estante de livros. Toque na barra de estado para rolar 
para o topo da tela, depois toque na lupa. Digite uma palavra que aparece no título de 
um livro, ou o nome do autor e toque em Buscar. Os livros coincidentes são exibidos 
na estante.Para buscar em um livro:  Abra um livro e toque próximo ao centro da página para 
exibir os controles. Toque na lupa e, em seguida, digite uma frase de busca e toque em 
Buscar. Toque em um resultado da busca para ir para aquela página do livro. 
Para enviar sua busca ao Google ou Wikipédia, toque em Buscar no Google ou Buscar 
na Wikipédia. O Safari é aberto e exibe o resultado.
Para buscar rapidamente uma palavra em um livro, mantenha pressionada a palavra e, 
em seguida, toque em Buscar.
Como Procurar a Definição de uma Palavra
É possível procurar a definição de uma palavra utilizando o dicionário.
Para procurar uma palavra:  Selecione uma palavra do livro e, em seguida, toque em 
Dicionário no menu que aparece. Talvez os dicionários não estejam disponíveis em 
todos os idiomas.
Como fazer para que o livro seja lido
Se você tem uma deficiência visual, pode utilizar o VoiceOver para ler um livro em voz 
alta. Consulte “VoiceOver” na página 151.
Talvez alguns livros não sejam compatíveis com o VoiceOver.
Como imprimir ou enviar um PDF por e-mail
Você pode usar o iBooks para enviar uma cópia de um PDF via e-mail ou imprimir todo 
ou uma porção do PDF em uma impressora compatível.
Para enviar uma PDF por e-mail:  Abra o PDF, em seguida toque em  e escolha 
Enviar por E-mail. Uma mensagem é exibida com o PDF anexado. Toque Enviar quando 
houver terminado de escrever e colocado o endereço em sua mensagem.
Para imprimir um PDF:  Abra o PDF, em seguida toque em  e escolha Imprimir. 
Selecione uma impressora e o intervalo de página e a quantidade de cópias e, em seguida, toque em Imprimir. Para obter mais informações sobre impressoras compatíveis, 
consulte “Impressão” na página 42.
Você somente pode imprimir ou enviar os PDFs por e-mail. Essas opções não estão 
disponíveis para os livros ePub.
Para organizar a estante de livros
Utilize a estante de livros para navegar por seus livros e PDFs. Você também pode organizar os itens em coleções.
Para ordenar a estante:  Vá para a estante de livros e toque em  e, em seguida, selecione um método de classificação a partir das opções na parte inferior da tela.
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Para reordenar itens:  Toque e mantenha pressionado um livro ou PDF e, em seguida, 
arraste-o para um novo local da estante.
Para apagar um item da estante:  Vá a sua estante de livros e toque em Editar. Toque 
em cada livro ou PDF que você deseja apagar para que uma marca de seleção apareça 
e, em seguida, toque em Apagar. Quando terminar de apagar, toque em OK. Se você 
apagar um livro que comprou, poderá transferi-lo novamente a partir das Compras na 
iBookstore. Se você tiver sincronizado o seu dispositivo com o seu computador, o livro 
também permanecerá na sua biblioteca do iTunes. 
Para criar, renomear ou apagar uma coleção:  Toque em Coleções para exibir a lista 
de coleções. Toque em Novo para adicionar uma nova coleção. Para apagar um teclado, toque em Editar e, em seguida, toque em  e toque em Apagar. Você não pode 
editar ou remover as coleções de Livros e PDFs integrados. Para editar o nome de uma 
coleção, toque no seu nome. Quando acabar, pressione OK.
Mova um livro ou PDF para uma coleção:  Vá a sua estante de livros e toque em 
Editar. Toque em cada livro ou PDF que você deseja mover para que uma marca de seleção apareça e, em seguida, toque em Mover e selecione uma coleção. Um item pode 
estar somente em uma coleção por vez. Quando você adiciona um livro ou PDF à sua 
estante de livros, ele é colocado na coleção de Livros ou PDF. A partir daí, você pode 
movê-lo para uma coleção diferente. Talvez você deseje criar coleções para o trabalho 
ou para a escola, ou para leitura de referência ou lazer.
Para visualizar uma coleção:  Toque em Coleções e, em seguida, toque em um item na 
lista que aparece.142
Sobre o Game Center
No Game Center, você pode descobrir novos jogos e compartilhar suas experiências 
com eles com seus amigos no mundo todo. 
Convide seus amigos para jogar ou use a autosseleção para encontrar outros oponentes do mesmo nível. Veja os placares para saber quem são os melhores jogadores. 
Ganhe pontos atingindo metas específicas em um jogo.
Nota: Talvez o Game Center não esteja disponível em todos os países ou regiões, e os 
jogos disponíveis podem variar de acordo com esses países ou regiões.
Para usar o Game Center, é preciso ter uma conexão com a Internet e um ID Apple. Se 
você já tiver uma conta da loja iTunes Store, uma conta MobileMe ou outra conta da 
Apple, poderá usar esse ID Apple com o Game Center. Se ainda não tiver um ID Apple, 
poderá criar um no Game Center, conforme descrito abaixo.
Como configurar o Game Center
Quando você abre o Game Center pela primeira vez, aparece uma mensagem perguntando se você deseja permitir notificações push. Essas notificações incluem alertas, 
sons e indicadores de ícones que permitem saber sobre os eventos do Game Center, 
mesmo se você não estiver usando o Game Center. Você pode, por exemplo, receber 
um alerta dizendo que um amigo convidou você para jogar um jogo. 
Para permitir notificações: Toque em OK.
Se você tocar em Não Permitir, você não receberá notificações do Game Center. Você 
poderá ativar as notificações mais tarde, se quiser, e poderá especificar quais tipos de 
notificações deseja receber.
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Para ativar ou desativar as notificações: Em Ajustes, escolha Notificações. Desativar 
Notificações desativa as notificações de todos os aplicativos. Você também pode silenciar as notificações usando o Interruptor Lateral (consulte “Interruptor Lateral” na 
página 176).
Especifique quais notificações você deseja receber para o Game Center: Em Ajustes, 
escolha Notificações > Game Center; depois, configure os ajustes dos Sons, Alertas e 
Indicadores. Se o Game Center não estiver aparecendo, ative as notificações.
Para ajustar as informações do Game Center para o seu ID Apple:
1 Digite seu ID e senha da Apple e, em seguida, toque em Iniciar Sessão.
Talvez seja solicitado que você forneça informações adicionais. Se você não tiver um ID 
Apple, poderá criar um tocando em Criar Nova Conta.
2 Toque em Concordar para aceitar os Termos e Condições do Game Center.
3 Digite um apelido—o nome que as outras pessoas verão e que pelo qual você será 
conhecido.
4 Para configurar seus ajustes no Game Center:
Â Para permitir que outros usuários convidem você para jogar um jogo, deixe a opção 
Permitir Convites para Jogos ativada. Caso não queira deixá-la ativada, toque nela 
para desativá-la.
Â Para permitir que outros usuários localizem você por seu endereço de e-mail, deixe 
a opção Localizar-me por E-mail ativada. Caso não queira deixá-la ativada, toque 
nela para desativá-la.
Â Verifique o e-mail de sua conta. Caso não queira digitar o endereço que utiliza para 
iniciar a sessão no ID Apple, você poderá digitar um endereço diferente. Para confirmar esse endereço e provar que ele é seu, será preciso responder ao e-mail enviado 
para esse endereço.
Â Para adicionar outros endereços de e-mail que as pessoas possam utilizar para entrar em contato com você no Game Center, toque em Adicionar Outro E-mail.
5 Toque em Seguinte quando sua conta for configurada.
Para alterar os ajustes do Game Center para o seu Apple ID:
1 Toque em Eu e, em seguida, toque no símbolo da sua conta.
2 Toque em Ver Conta.
3 Faça suas alterações e toque em OK.
Para iniciar a sessão usando um Apple ID diferente:
1 Toque em Eu e, em seguida, toque no símbolo da conta.
2 Toque em Finalizar Sessão.
3 Digite seu novo ID e senha da Apple e, em seguida, toque em Iniciar Sessão.Jogos
Como comprar e transferir jogos
Os jogos para o Game Center estão disponíveis na loja App Store. Se você ainda não 
inseriu as informações de seu cartão de crédito em seu ID Apple, uma mensagem aparecerá, pedindo que você insira essas informações antes de poder comprar e transferir 
jogos.
Para comprar e transferir jogos:Toque em Jogos; depois, toque em Buscar Jogos do 
Game Center. 
A seção do Game Center da loja App Store mostra os jogos que funcionam com o 
Game Center. Você pode navegar essa seção e comprar e transferir jogos a partir dela. 
Consulte Capítulo 18,“App Store,” na página 130.
Se quiser adquirir um jogo que um amigo seu tem, toque no nome do jogo na tela de 
informações de seu amigo para ir direto para esse jogo na loja App Store. 
Como jogar
A tela Jogos mostra os jogos que você transferiu da loja App Store. Para cada um dos 
jogos, são exibidos o seu número de proezas e a sua classificação entre todos os jogadores do jogo.
Para obter informações sobre um jogo: Toque em Jogos, depois toque em um jogo. 
Se disponível, você pode exibir os placares do jogo, ver as suas proezas do jogo e descobrir quem jogou o jogo recentemente.
Para jogar um jogo:Toque em Jogos, escolha um jogo e toque em Jogar.
Dependendo do jogo, a tela inicial pode fornecer instruções ou outras informações 
e poderá também mostrar quadros de classificações e proezas e opções para ajustar 
o jogo ou definir se ele será um jogo de um ou de vários jogadores. Para jogar com 
outros jogadores, você pode convidar um amigo ou usar a autosseleção para que o 
Game Center encontre outros jogadores para você. Para obter mais informações sobre 
como fazer amigos no Game Center, consulte “Amigos” na página 147.
Para jogos de vários jogadores, você pode também enviar um convite para o jogo a 
partir da tela Amigos.
Para convidar um amigo para um jogo de vários jogadores a partir da tela Amigos:
1 Toque em Amigos na parte inferior da tela.
2 Escolha um amigo.
3 Escolha um jogo e toque em Jogar.
Se o jogo permitir ou precisar de jogadores adicionais, você pode escolher quais jogadores deseja convidar. Em seguida, toque em Seguinte.
4 Digite e envie o seu convite, depois espere que as pessoas aceitem.
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5 Inicie a partida.
Se o amigo não estiver disponível ou não responder ao seu convite, você pode tocar 
em Autosseleção para que o Game Center procure um outro jogador para você, ou 
pode tocar em Convidar para tentar convidar um outro amigo.
Talvez outros jogadores convidem você para jogar o jogo.
Para responder a um convite para jogar um jogo: Toque em Aceitar ou Recusar no 
alerta que aparece.
Em Restrições, você pode desativar os jogos de vários jogadores. Consulte 
“Restrições” na página 174. Você pode impedir que outros jogadores convidem você 
para jogar jogos desativando a opção Permitir Convites para Jogos nos ajustes do 
Game Center. Consulte “Seu estado e as informações da conta” na página 148.
Para retornar ao Game Center:Pressione o botão de Início e toque em Game Center 
na tela de Início.
Você também pode pressionar o botão de Início duas vezes rapidamente e escolher o 
Game Center em seus aplicativos recentes.
Placares
Alguns jogos fornecem um ou mais placares para mostrar a ordem de classificação 
dos jogadores, com suas pontuações, tempos ou outras pontuações do sucesso do 
jogador.
Para ver o placar de um jogo: Toque em Jogos, escolha o jogo e toque em Placar.
Também é possível visualizar os placares de dentro do jogo.
Se um jogo tiver variações (como Fácil, Normal e Difícil), a tela Categorias permite escolher o placar do jogo em geral ou para uma das variações.O placar mostra a classificação de seus amigos e de todos os jogadores. Você poderá 
visualizar as estatísticas do placar de um período de tempo específico, como hoje, esta 
semana ou sempre.
Gire o iPad para ver o placar na horizontal. 
Para começar a jogar um jogo do placar: Toque em Jogar no canto superior direito.
Proezas
Alguns jogos recompensam você com pontos de bônus para certas proezas.
Veja as proezas possíveis de um jogo: Toque em Jogos, escolha um jogo e toque em 
Proezas.
Para cada proeza, o Game Center mostra quantos pontos de bônus são concedidos e 
se você concluiu a proeza. O total de pontos concedidos para as suas proezas aparecem na parte superior. Você pode obter pontos de bônus para uma proeza específica 
apenas uma vez.
Você pode também visualizar as proezas de dentro do jogo.
Jogos Recentes
Alguns jogos permitem ver quais de seus amigos jogaram o jogo recentemente.
Para ver quem jogou um jogo recentemente: Toque em Jogos, toque em um jogo e 
escolha Jogos Recentes.
Para obter informações sobre um jogador:Toque no nome do jogador na lista. 
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Amigos
O Game Center coloca você em contato com jogadores do mundo inteiro. Você adiciona amigos ao Game Center fazendo uma solicitação ou aceitando uma solicitação de 
outro jogador.
Como adicionar um amigo ao Game Center:
1 Toque em Amigos ou em Pedidos.
2 Toque em  e digite o endereço de e-mail de um amigo ou o apelido no Game Center.
Os endereços e nomes correspondentes de seus contatos aparecem conforme você 
digita. Toque em um contato para incluir essa pessoa em seu pedido. Toque em 
para navegar pelos seus contatos.
Para adicionar vários amigos de uma vez, digite mais contatos.
3 Digite uma mensagem para o seu pedido e toque em Enviar.
Para poder se tornar um amigo, a pessoa precisa aceitar o seu pedido.
Outros jogadores poderão enviar-lhe um pedido. Se você receber um alerta, você pode 
aceitar o pedido ou fechá-lo e responder ao pedido mais tarde, a partir da tela Pedido. 
Um símbolo no botão Pedidos exibe o número de pedidos de amigos pendentes.
Para atender um pedido de amizade: Toque em Pedidos, toque no nome da pessoa 
que está fazendo o pedido e, em seguida, toque em Aceitar, Ignorar ou Comunicar 
Problema.
Quando um jogador aceita o pedido de outro jogador, um se torna amigo do outro. Os 
nomes dos amigos aparecem na tela Amigos.
Para obter informações sobre um amigo: Toque no nome do amigo.
Para buscar um amigo:Toque na barra de estado para rolar para o topo da tela, depois 
toque no campo de busca e comece a digitar. Os amigos que corresponderem à sua 
busca aparecerão conforme você digitar.
A página de informações de um amigo mostra quantos amigos (incluindo você) a 
pessoa possui, o número de jogos diferentes que ele jogou e quantas proezas ele concluiu. A tela de informações também pode mostrar:
Â Os jogos que vocês jogaram juntos
Â Os jogos que vocês têm em comum
Â Outros jogos que seu amigo tem
Você pode tocar em um jogo em qualquer uma das listas para ver sua posição e a posição de seu amigo no placar geral e suas respectivas proezas para o jogo.
Para convidar um amigo para jogar um jogo: Toque em Amigos, toque no nome do 
amigo, toque em um jogo e, finalmente, toque em Jogar. Consulte “Como jogar” na 
página 144.Para remover um amigo:Toque em Amigos, toque em um nome, toque em Desfazer 
Amizade e toque em Remover.
Se um jogador for agressivo ou estiver exibindo comportamento inadequado, você 
pode comunicar o problema.
Para comunicar um problema com um amigo: Toque em Amigos, toque no nome do 
amigo, e, em seguida, toque em "Comunicar Problema". Descreva o problema e toque 
em Comunicar para enviar a comunicação. 
Se você desativar a opção Jogos em Grupo nos Ajustes, não poderá enviar ou receber 
convites para jogar jogos. Consulte “Restrições” na página 174.
Seu estado e as informações da conta
A tela Eu resume as informações sobre seus amigos, seus jogos e suas proezas.
O campo de texto do centro da tela permite digitar sua mensagem de estado atual. O 
seu estado aparece com o seu apelido nas telas Amigos dos outros jogadores.
Para alterar o seu estado:Toque no campo de estado para inserir ou atualizar o seu 
estado.
Para visualizar as informações da sua conta: Toque no banner da conta e toque em 
Ver Conta.
Você pode alterar ou atualizar os seguintes ajustes:
Â Apelido
Â Permitir convites para jogos
Â Localizar-me por E-mail
Â O seu endereço postal do Game Center
Â Endereços de e-mail adicionais
Quando acabar, pressione OK.
Você também pode iniciar e finalizar a sessão em uma conta diferente ou criar uma 
nova conta.
Para finalizar a sessão:Toque no banner da conta e toque em Finalizar.
Para iniciar sessão em uma conta diferente: Digite seu nome de usuário e senha e, 
em seguida, toque em Iniciar Sessão.
Para criar uma nova conta: Toque em Criar Nova Conta e siga as instruções na tela.
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Controles Parentais
Você pode usar os controles parentais para gerenciar a forma que a sua família adiciona amigos e participar de jogos em grupo no Game Center.
Para configurar os controles parentais do Game Center: Escolha Ajustes > Geral > 
Restrições, depois toque em Ativar Restrições. Insira um código de quatro dígitos e, em 
seguida, reinsira o código.
Você pode ativar as restrições nos seguintes ajustes:
Â Jogos em Grupo
Â Como adicionar amigos
Para obter mais informações, consulte “Restrições” na página 174.150
Além dos inúmeros recursos que tornam o iPad fácil de usar por qualquer pessoa, o 
iPad inclui recursos de acesso universal.  
Recursos de Acesso Universal
Os recursos de acesso universal tornam o iPad fácil de usar por pessoas com deficiência visual, deficiência auditiva ou surdez, ou deficiência física ou de aprendizagem. Os 
recursos de acessibilidade do iPad incluem:
Â Suporte para reprodução de conteúdo com legendas ocultas
Â Leitor de tela do VoiceOver
Â Ampliação de zoom
Â Branco sobre Preto
Â Texto Grande
Â Áudio Mono
Â Falar texto automático
Â Suporte para terminais braile
Os recursos Zoom, Branco sobre Preto e Áudio Mono funcionam com todos os aplicativos. O Texto Grande funciona com o Mail e Notas. O VoiceOver funciona com os 
aplicativos integrados do iPad e com alguns aplicativos de outros fabricantes que você 
pode transferir da App Store. A legenda oculta funciona com vídeos e podcasts que 
sejam compatíveis.
Para obter mais informações sobre os recursos de acessibilidade do iPad, visite o site 
www.apple.com/br/accessibility/ipad.
É possível ativar ou desativar os recursos de acessibilidade no ajuste Acessibilidade do 
iPad. Também é possível ativar alguns recursos de acessibilidade no iTunes ao conectar 
o iPad ao seu computador.  
Para ativar ou desativar os recursos de acessibilidade no iTunes:
1 Conecte o iPad ao seu computador. 
2 No iTunes, selecione iPad na barra lateral.
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3 No painel Resumo, clique em Configurar Acesso Universal na seção Opções.
4 Selecione os recursos de acessibilidade que deseja utilizar e clique em OK.
Os recursos selecionados ficam disponíveis imediatamente no iPad quando você clica 
em OK.
VoiceOver
O VoiceOver descreve, em voz alta, o que aparece na tela. Assim, você pode utilizar o 
iPad sem ter que vê-lo.  
O VoiceOver descreve cada elemento da tela conforme você os seleciona. Quando 
você seleciona um elemento, ele é envolto por um retângulo preto (para beneficiar as 
pessoas que podem enxergar a tela) e o VoiceOver diz o nome do item ou o descreve. 
O retângulo preto é referido como "cursor" do VoiceOver.  
Toque na tela ou arraste seus dedos para ouvir diferentes itens na tela. Para interagir 
com itens da tela, tais como botões e links, utilize os gestos descritos em “Gestos do 
VoiceOver” na página 154. Quando você seleciona texto, o VoiceOver lê o texto. Se você 
ativa a opção Falar Dicas, o VoiceOver pode lhe dizer o nome do item. Quando você 
seleciona um controle (tal como um botão ou um interruptor), o VoiceOver fornece 
instruções a você — por exemplo, “toque duas vezes para abrir”.
Quando você vai para uma tela nova, o VoiceOver reproduz um som e automaticamente seleciona e fala o primeiro elemento que está na tela (normalmente, o item 
do canto superior esquerdo). O VoiceOver também permite que você saiba quando o 
visor muda para a orientação horizontal ou vertical e quando a tela está bloqueada ou 
desbloqueada.
Nota: O VoiceOver utiliza o idioma especificado em Internacional (nos Ajustes), que 
pode ser influenciado pelo ajuste da região. O VoiceOver está disponível em diversos 
idiomas, mas não em todos.Como Configurar o VoiceOver
O VoiceOver altera os gestos que você usa para controlar o iPad. Depois que ativar o 
VoiceOver, você deve utilizar os gestos do VoiceOver para utilizar o iPad—até mesmo 
para desativar o VoiceOver a fim de retomar o funcionamento padrão.
Para ativar ou desativar o VoiceOver no iPad: Em Ajustes, escolha Geral > 
Acessibilidade > VoiceOver e depois toque no controle Ativar/Desativar do VoiceOver.
Para ativar ou desativar o VoiceOver no iTunes: Selecione iPad na barra lateral do 
iTunes. Na seção Opções do painel Resumo, clique em Configurar Acesso Universal. 
Selecione VoiceOver e depois clique em OK.
Você também pode definir Início Triplo Clique para ativar ou desativar o VoiceOver. 
Consulte “Clique Triplo em Início” na página 164.
Nota: Não é possível utilizar o VoiceOver e o Zoom de Tela Cheia ao mesmo tempo.
Ajustes VoiceOver
É possível ajustar o VoiceOver para fornecer dicas faladas, aumentar ou diminuir a velocidade da fala ou dar feedback da digitação.  
Para ativar ou desativar as dicas faladas: Em Ajustes, escolha Geral > Acessibilidade > 
VoiceOver e depois toque no controle Ativar/Desativar do recurso Falar Dicas. As dicas 
faladas são ativadas por padrão.
Para definir a velocidade da fala do VoiceOver: Em Ajustes, escolha Geral > 
Acessibilidade > VoiceOver e depois ajuste o controle deslizante Velocidade da Fala.
Você pode escolher o tipo de fala obtida ao digitar. É possível ajustar o VoiceOver 
para falar caracteres, palavras, ambos, ou nada. Se você escolher ouvir tanto caracteres 
como palavras, o VoiceOver pronunciará cada caractere à medida que você o digitar e 
depois pronunciará a palavra inteira quando você digitar um espaço ou pontuação.
Para selecionar a fala da digitação: Em Ajustes, selecione Geral > Acessibilidade 
> VoiceOver > Falar Digitação. Você pode escolher Caracteres, Palavras, Caracteres 
e Palavras, ou Nada para teclados de software e para um teclado Apple Wireless 
Keyboard.
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Para utilizar fonética Em Ajustes, selecione Geral > Acessibilidade > 
VoiceOver e, em seguida, toque no interruptor 
Usar Fonética para ativá-lo.
Utilize este recurso quando digitar ou ler caractere por caractere para ajudar a esclarecer quais 
caracteres foram falados. Quando a opção Usar 
Fonética está ativada, o VoiceOver primeiro fala 
o caractere e, em seguida, fala uma palavra que 
começa com o caractere. Por exemplo, se você 
digitar o caractere "f", o VoiceOver fala "f" e, em 
seguida, "foxtrot".
Alteração de Tom Em Ajustes, selecione Geral > Acessibilidade > 
VoiceOver e, em seguida, toque no interruptor 
Alteração de Tom para ativá-lo.
O VoiceOver utiliza um tom mais alto ao digitar 
uma letra e um tom mais baixo para ao apagar 
uma letra. O VoiceOver também utiliza um tom 
mais alto quando fala o primeiro item de um 
grupo (como uma lista ou tabela) e um tom mais 
baixo quando fala o último item de um grupo.
Por padrão, o VoiceOver utiliza o idioma definido para o iPad. É possível definir um 
idioma diferente para o VoiceOver.
Para alterar o idioma falado pelo VoiceOver: Em Ajustes, escolha Geral, > 
Internacional> Idioma, selecione um idioma e toque em OK.  
Alguns idiomas podem ser influenciados pelo ajuste da região. Em Ajustes, escolha 
Geral > Internacional > Formato da Região e depois selecione o formato.
Para definir as opções do rotor para navegação web:Em Ajustes, selecione Geral > 
Acessibilidade > VoiceOver > Rotor Web. Toque para selecionar ou desmarcar opções. 
Para alterar a posição de um item da lista, toque em  ao lado do item e, em seguida, 
arraste para cima ou para baixo.
Para selecionar os idiomas disponíveis no rotor Idioma:Em Ajustes, selecione Geral 
> Acessibilidade > VoiceOver > Rotor de Idioma e toque para selecionar o idioma ou 
idiomas que deseja que apareça no rotor de Idioma. Para alterar a posição de um idioma da lista, toque em  ao lado do item e arraste para cima ou para baixo.
O rotor Idioma sempre está disponível quando você tiver selecionado mais de um 
idioma.Gestos do VoiceOver
Quando o VoiceOver é ativado, ele altera os gestos que você usa para controlar o iPad 
de forma que você possa ouvir as descrições sem ativar os botões. Estes gestos do 
VoiceOver permitem que você se mova pela tela e controle os elementos individuais 
que selecionar. Alguns gestos do VoiceOver usam dois, três ou quatro dedos para tocar 
ou passar o dedo. Para obter os melhores resultados usando mais de um dedo, relaxe e 
permita que seus dedos toquem a tela com algum espaço entre eles.
Há várias maneiras de introduzir gestos do VoiceOver. Por exemplo, você pode tocar 
com dois dedos usando tanto os dois dedos da mesma mão como um dedo de cada 
mão. Também pode utilizar os polegares. Tente utilizar técnicas diferentes para descobrir o que funciona melhor para você.
Se os seus gestos não funcionarem, tente usar movimentos mais rápidos, especialmente para os gestos de toque duplo e de passar o dedo. Para passar o dedo, tente roçar a 
tela rapidamente com o seu dedo ou dedos. 
Para praticar os gestos: Em Ajustes, escolha Geral > Acessibilidade > VoiceOver > 
Praticar Gestos e depois toque no botão Praticar Gestos do VoiceOver. Pratique os gestos descritos nos “Ajustes VoiceOver,” abaixo. Quando acabar de praticar, pressione OK.
Realize os gestos de passar um único dedo rapidamente para distingui-los dos gestos 
de arrastar.
Veja abaixo um resumo dos gestos do VoiceOver:
Navegação e Leitura
Â Tocar: Fala o item.
Â Passar o dedo para a direita ou para a esquerda: Seleciona o item seguinte ou 
anterior.
Â Passar o dedo para cima ou para baixo: o efeito varia dependendo do ajuste Controle 
do Rotor. Consulte “Como Usar o VoiceOver” na página 157.
Â Tocar com dois dedos: Para de falar o item atual.
Â Passar dois dedos para cima: lê tudo a partir do tipo da tela.
Â Passar dois dedos para baixo: lê tudo a partir da posição atual.
Â Passar três dedos para cima ou para baixo: Rola uma página de cada vez.
Â Passar três dedos para a direita ou esquerda: vai para a página seguinte ou anterior 
(por exemplo, na tela de Início ou no Safari).
Â Tocar com três dedos: Fala o estado da rolagem (qual página ou linhas estão visíveis).
Â Passar quatro dedos par cima ou para baixo: vai para o primeiro ou último elemento 
de uma página.  
Â Passar quatro dedos para a direita ou para a esquerda: vai para a próxima seção ou a 
seção anterior (por exemplo, em uma página web).
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Selecionar e Ativar
Â Dois toques: Ativa o item selecionado.
Â Tocar um item com um dedo, tocar a tela com outro dedo (“toque-dividido”): Ativar 
item.
Â Tocar duas vezes e segurar (1 segundo) + gesto padrão: Usa um gesto padrão.
O gesto de tocar duas vezes e segurar faz com que o iPad interprete o gesto subsequente como um gesto padrão. Você pode, por exemplo, dar um toque duplo e 
segurar; então, sem levantar o dedo, pode arrastá-lo para deslizar um controle.
Tocando duas vezes e mantendo o seu dedo na tela, você pode utilizar os gestos 
padrão quando o VoiceOver estiver ativado. Uma série de tons indica que os gestos 
normais estão em vigor. Eles ficam efetivos até você levantar o dedo, então são retomados os gestos do VoiceOver.
Â Toque duplo com dois dedos:  Reprodução ou pausa no iPod, YouTube ou Fotos. Inicia 
ou para o cronômetro.
Â Toque duplo com três dedos: Silencia ou ativa o som do VoiceOver.
Â Toque triplo com três dedos: Ativa ou desativa a tela.
Controle do Rotor
O rotor é um controle virtual que age como um mostrador físico quando o VoiceOver 
é ativado. Use o rotor para alterar os ajustes do VoiceOver e para acessar outros comandos e recursos.  
Para usar o rotor: Gire dois dedos na tela do iPad para “ativar” o seletor para escolher 
itens do rotor. Passe o dedo para cima e para baixo para usar o item selecionado.
O efeito do rotor dependerá do que você está fazendo. Por exemplo, se você estiver 
lendo texto em um e-mail, poderá utilizar o rotor para alternar entre ouvir o texto 
falado palavra por palavra, caractere por caractere ou linha por linha quando passar o 
dedo para cima ou para baixo. Ao navegar por uma página da web, utilize o rotor para 
escolher se deseja ouvir o texto palavra por palavra ou caractere por caractere, ouvir 
apenas os cabeçalhos, ouvir apenas os links (todos eles, os links visitados ou os links 
ainda não visitados), ouvir elementos de formulários ou ouvir descrições de imagens. 
Você pode utilizar o ajuste do rotor para ouvir todo o texto ou para pular de um elemento para outro de um certo tipo, como cabeçalhos ou links.
Leitura de texto
Selecione e escute o texto por:
Â Caractere
Â Palavra
Â LinhaNavegação de uma página web
Selecione e escute o texto por:
Â Caractere
Â Palavra
Â Linha
Â Cabeçalho
Â Link
Â Link visitado
Â Link não visitado
Â Link na página
Â Controle de Forma
Â Tabela
Â Linha (ao navegar em uma tabela)
Â Lista
Â Ponto de referência
Â Imagem
Â Texto estático
Ampliação ou redução
Digitação de texto
Mova o ponto de inserção e escute o texto por:
Â Caractere
Â Palavra
Â Linha
Selecione a função editar
Selecione o idioma
Utilização de controle 
Selecione e escute os valores por:
Â Caractere
Â Palavra
Â Linha
Ajuste o valor do objeto de controle
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Como Usar o VoiceOver
Para desbloquear o iPad: Selecione o botão Desbloquear e toque duas vezes na tela.
Para selecionar itens na tela: Arraste o dedo pela tela. O VoiceOver identifica cada 
elemento que você toca. Você pode também mover sistematicamente de um elemento para o outro passando um dedo para a esquerda ou para a direita. Os elementos 
são selecionados da esquerda para a direita, de cima para baixo. Passar o dedo para a 
direita vai para o elemento seguinte e passar o dedo para a esquerda volta para o elemento anterior.
Para “tocar” um item selecionado quando o VoiceOver está ativado: Toque duas vezes em qualquer lugar da tela.  
Para falar o texto de um elemento, caractere por caractere, palavra por palavra ou 
linha por linha: Com o elemento selecionado, passe um dedo para cima ou para baixo. Passe um dedo para baixo para ler o caractere seguinte ou passe o dedo para cima 
para ler o caractere anterior. Gire o controle do rotor para ler palavra por palavra ou 
linha por linha.
Para ajustar um controle deslizante: Com um dedo, arraste para cima para aumentar 
o ajuste ou arraste para baixo para diminuí-lo. O VoiceOver fala o ajuste conforme você 
o ajusta.
Para rolar em uma lista ou área da tela: Passe três dedos para cima ou para baixo. 
Passe os dedos para baixo para descer uma página ou passe os dedos para cima para 
subir uma página. Se estiver passando por uma lista, o VoiceOver pronunciará o intervalo de itens exibidos (por exemplo, “mostrando linhas 5 a 10”).
Rolar continuamente por uma lista: Toque duas vezes e mantenha o elemento pressionado. Quando escutar uma série de sons, você pode mover o seu dedo para cima 
ou para baixo para rolar a lista. A rolagem contínua se interromperá quando você levantar o dedo.
Usar um índice: Algumas listas possuem um índice alfabético do lado direito. O índice 
não pode ser selecionado passando o dedo entre os elementos; você deve tocar no 
índice para selecioná-lo. Com o índice selecionado, passe o dedo para cima ou para 
baixo para mover-se pelo índice. Você também pode tocar duas vezes e, em seguida, 
deslizar o seu dedo para cima ou para baixo.
Para reordenar a tela Início: Na tela Início, selecione o ícone que deseja mover. Toque 
duas vezes, segure e depois arraste o ícone. O VoiceOver fala a posição da linha e da 
coluna enquanto você arrasta o ícone. Solte o ícone quando ele estiver na localização 
desejada. Você pode arrastar ícones adicionais. Arraste um item para a extremidade 
esquerda ou direita da tela para movê-lo para outra página da tela Início. Quando você 
terminar de reordenar os ícones, pressione o botão Início  .
Você pode ativar a fala, parar de falar um item, desativar a tela ou fazer com que o 
VoiceOver fale a tela inteira.Silenciar o VoiceOver Toque duas vezes com três dedos. Toque duas 
vezes novamente com três dedos para reativar a 
fala. Para silenciar apenas os sons do VoiceOver, 
coloque o Interruptor Lateral na posição de 
silêncio.
Parar de falar um item Toque uma vez com dois dedos. Toque com os 
dois dedos novamente para retomar a fala. A 
função de fala automática é retomada quando 
você selecionar outro item.
Desativar a tela enquanto você utiliza o 
VoiceOver
Toque três vezes com três dedos. Repita para 
ativar a tela novamente.
Falar a tela inteira desde a parte superior Passe dois dedos para cima.
Para falar do item atual até a parte de baixo da 
tela
Passe dois dedos para baixo.
É possível ouvir informações do estado do iPad tocando na barra de estado na parte 
superior da tela. As informações incluem a hora, a vida útil da bateria, a intensidade do 
sinal Wi-Fi e outros.
Digitação e edição de texto
Quando você seleciona um campo de texto com o VoiceOver, você pode usar o teclado da tela para digitar o texto. Você pode usar os recursos de edição do iPad para 
cortar, copiar ou colar no campo de texto.
Nota: O Safari não é compatível com a cópia de conteúdo de páginas web. Os recursos de edição funcionam somente em campos de texto editáveis.
Para digitar texto:
1 Utilize o VoiceOver para selecionar um campo de texto editável e depois toque duas 
vezes para exibir o ponto de inserção e fazer aparecer o teclado da tela. Se o campo já 
possui texto, o ponto de inserção está colocado no começo ou no final do texto. Toque 
duas vezes novamente para colocar o ponto de inserção na extremidade oposta. O 
VoiceOver fala a posição do ponto de inserção.
O ponto de inserção e o teclado da tela podem aparecer automaticamente quando 
você selecionar um campo de texto. O VoiceOver avisa quando estiver no modo de 
edição—baseado no ajuste do rotor.
2 Para digitar, realize uma das seguintes ações:
Â “Tipo toque” arrastando seu dedo até a tecla selecionada e levantando seu dedo 
para digitar o caractere.
Â “Tipo padrão” passando o dedo para a esquerda ou para a direita para selecionar 
uma tecla no teclado e tocando duas vezes para digitar o caractere.
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Â Digite um caractere arrastando seu dedo pelo teclado para selecionar uma tecla 
e, enquanto mantém a tecla pressionada com um dedo, toque a tela com o outro 
dedo.  
O VoiceOver fala a tecla quando ela for selecionada e novamente quando ela for 
digitada.
Para digitar um caractere acentuado:Toque duas vezes e mantenha a tecla pressionada até ouvir um som indicando que os caracteres alternativos apareceram; em seguida, 
arraste para a esquerda ou para a direita para selecionar e ouvir as opções. Solte o 
dedo para inserir a seleção atual.
Para mover o ponto de inserção: Passe o dedo para cima ou para baixo para mover o 
ponto de inserção para frente ou para trás no texto. O VoiceOver emite um som quando o ponto de inserção se move e fala o caractere sobre o qual o ponto de inserção 
passou. Use o rotor para escolher se você deseja mover o ponto de inserção por caractere, palavra ou linha.
Para selecionar texto: Use o rotor para selecionar a edição. Passe o dedo para cima ou 
para baixo para escolher entre as funções Selecionar e Selecionar Tudo e, em seguida, 
toque duas vezes. Se você escolher Selecionar, a palavra que estiver mais próxima ao 
ponto de inserção será selecionada quando você tocar duas vezes. Se você escolher 
Selecionar Tudo, todo o texto será selecionado.
Separe ou junte os dedos para aumentar ou diminuir a seleção.
Para cortar, copiar ou colar:Certifique-se de que o rotor esteja ajustado em edição. 
Com o texto selecionado, passe o dedo para cima ou para baixo para escolher Cortar, 
Copiar ou Colar e, em seguida, toque duas vezes.
Para desfazer: Agite o iPad, passe o dedo para a esquerda ou para a direita para escolher a ação de desfazer e, em seguida, toque duas vezes.
Para alterar o tom: Em Ajustes, escolha Geral > Acessibilidade > VoiceOver e depois 
toque no botão Alteração de Tom. Em seguida, quando apagar uma letra, será falado 
com um tom mais baixo.  
Para falar teclas foneticamente: Em Ajustes, escolha Geral > Acessibilidade > 
VoiceOver e depois toque no botão Usar Fonética. Em seguida, quando colocar uma 
tecla em pausa, o VoiceOver falará a letra daquela tecla foneticamente (por exemplo, 
alfa para a, bravo para b, carlos para c, e assim por diante).  Como controlar o VoiceOver usando um teclado Apple Wireless 
Keyboard
Você pode controlar o VoiceOver usando um teclado Apple Wireless Keyboard emparelhado com o iPad. Consulte “Como usar os dispositivos Bluetooth” na página 46.
Os comandos de teclado do VoiceOver permitem navegar na tela, selecionar itens, ler 
conteúdo da tela, ajustar o rotor e realizar outras ações do VoiceOver. Todos os comandos de teclado (exceto um) incluem Controle + Opção, abreviado na tabela abaixo 
como “VO”. 
A Ajuda do VoiceOver fala as teclas ou os comandos do teclado conforme você os digita. Você pode usar a Ajuda VoiceOver para aprender o leiaute do teclado e as ações 
associadas com as combinações de tecla. 
Comandos de teclado do VoiceOver
VO = Controle-Opção
Ler tudo, começando da posição atual VO–A
Ler a partir do início VO–B
Mover para a barra de estado VO–M
Pressionar o botão Início VO–H
Selecionar o item seguinte ou anterior VO–Seta à direita ou VO–Seta à esquerda
Tocar em um item VO–barra de espaço
Tocar duas vezes com dois dedos VO–”-”
Selecionar o item de rotor seguinte ou anterior VO–Seta para cima ou VO–Seta para baixo
Selecionar o item de rotor de fala seguinte ou 
anterior
VO–Comando–Seta à esquerda ou VO–Seta à 
direita
Ajustar o item de rotor de fala VO–Comando–Seta Acima ou VO–Seta Abaixo
Desativar ou reativar som do VoiceOver VO–S
Ativar ou desativar a cortina de tela VO–Maiúsculas-S
Ativar a Ajuda do VoiceOver VO–K
Voltar à tela anterior ou desativar a Ajuda do 
VoiceOver
Escape
Nav Rápida
Ative a Navegação Rápida para controlar o VoiceOver com as teclas de seta. A 
Navegação Rápida está desativada por padrão.
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Ativar ou desativar a Navegação Rápida Seta à esquerda–Seta à direita
Selecionar o item seguinte ou anterior Seta à direita ou seta à esquerda
Selecionar o item seguinte ou anterior especificado pelo ajuste do rotor
Seta para cima ou seta para baixo
Selecionar o primeiro ou o último item Controle–Seta para cima ou Controle–Seta para 
baixo
"Tocar" em um item Seta para cima–Seta para baixo
Rolar para cima, para baixo, para a esquerda ou 
para a direita
Opção–Seta para cima, Opção–Seta para baixo, 
Opção–Seta à esquerda ou Opção–Seta à direita
Alterar o rotor Seta para cima–Seta à esquerda ou Seta para 
cima–Seta à direita
Utilização dos Mapas
Use o VoiceOver para ampliar ou reduzir, selecionar alfinetes e obter informações sobre 
localizações.
Para ampliar e reduzir: Use o rotor para escolher o modo de zoom e, em seguida, passe o dedo para cima ou para baixo para ampliar ou reduzir.
Para selecionar um alfinete: Toque em um alfinete, passe o dedo para a esquerda ou 
para a direita para mover de um item a outro.  
Para obter informações sobre uma localização: Com um alfinete selecionado, toque 
duas vezes para exibir a sinalização de informação. Passe o dedo para a esquerda ou 
para a direita para selecionar a sinalização e, em seguida, toque duas vezes para exibir 
a página de informações.
Como utilizar um Terminal Braile com o VoiceOver
Configuração de um Terminal Braile
Você pode utilizar um terminal em braile Bluetooth atualizável para ler a saída do 
VoiceOver em braile. Além disso, os terminais em braile com teclas de entrada e outros controles podem ser utilizados para controlar o iPad quando o VoiceOver estiver 
ativado. O iPad funciona com muitos terminais em braile sem fio mais populares Para 
obter uma lista dos terminais em braile compatíveis, acesse o site www.apple.com/br/
accessibility/voiceover/devicesupport.html.
Para configurar um terminal em braile:
1 Ative o terminal em braile.
2 No iPad, ative o Bluetooth.
Em Ajustes, escolha Geral > Bluetooth, em seguida, toque no botão Bluetooth.
3 Em Ajustes, escolha Geral > Acessibilidade > VoiceOver > Braile, em seguida, escolha o 
terminal em braile.Para ativar ou desativar o braile abreviado:Em Ajustes, escolha Geral > Acessibilidade 
> VoiceOver > Braile, em seguida, toque para ativar o Braile Abreviado.
Seleção de um Idioma
O terminal em braile utiliza o idioma definido para o Controle por Voz. Por padrão, esse 
é o idioma definido para o iPad em Ajustes > Internacional > Idioma. Você pode usar 
o ajuste de idioma do VoiceOver para ajustar um idioma diferente para o VoiceOver e 
para os terminais em braile.
Para definir o idioma do VoiceOver: Em Ajustes, escolha Geral > Internacional > 
Controle por Voz e selecione o idioma.
Se alterar o idioma do iPad, talvez você necessite redefinir o idioma do VoiceOver e do 
terminal em braile.
Controle do VoiceOver com seu Terminal em Braile
É possível definir a célula mais à esquerda e mais à direita do seu terminal em braile 
para fornecer o estado do sistema e outras informações:
Â O Histórico de Avisos contém um mensagem não lida
Â A mensagem do Histórico de Avisos atual não foi lida
Â A fala do VoiceOver está silenciada
Â A bateria do iPad está baixa (carga inferior a 20%)
Â O iPad está em orientação horizontal
Â A exibição de tela está desativada
Â A linha atual contém texto adicional à esquerda
Â A linha atual contém texto adicional à direita
Para ajustar a célula mais à esquerda e mais à direita para exibir as informações 
de estado:Em Ajustes, escolha Geral > Acessibilidade > VoiceOver > Braile, Célula de 
Estado, em seguida, toque em Esquerda ou Direita. 
Para ver uma descrição expandida da célula de estado:No seu terminal em braile, 
pressione o botão do roteador da célula de estado.
Zoom
O recurso de acessibilidade Zoom permite aumentar toda a tela para ajudá-lo a ver o 
que há na tela.  
Para ativar ou desativar o zoom: Em Ajustes, escolha Geral > Acessibilidade > Zoom 
e depois toque no controle Ativar/Desativar o Zoom. Ou, use o Clique triplo em Início, 
(consulte “Clique Triplo em Início” na página 164).
Para ampliar e reduzir: Toque duas vezes na tela com três dedos. Por padrão, a tela é 
ampliada em 200 por cento. Se você alterar a ampliação manualmente (utilizando o 
gesto de tocar e arrastar descrito abaixo), o iPad retorna automaticamente à ampliação 
que estava quando você ampliou tocando duas vezes com três dedos.
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Para aumentar a ampliação: Usando três dedos, toque e arraste para cima para aumentar a ampliação e para baixo para diminuir. O gesto de tocar e arrastar é semelhante a um toque duplo, exceto pelo fato de que você não levanta os dedos no segundo 
toque; em vez disso, você arrasta os dedos na tela.  
Para mover-se pela tela: Quando estiver ampliado, arraste a tela usando três dedos. 
Mantenha um dedo pressionado perto da borda da tela para obter uma imagem 
panorâmica da tela. Mova o dedo mais perto da borda para deslocar-se mais rapidamente. Quando você abre uma nova janela, o Zoom sempre vai para o centro da parte 
superior da tela.
Ao usar o Zoom com em teclado Apple Wireless Keyboard (consulte “Como controlar o 
VoiceOver usando um teclado Apple Wireless Keyboard” na página 160), a imagem da 
tela segue o ponto de inserção, mantendo-o no centro a exibição.
Texto Grande
O Texto Grande permite aumentar o tamanho do texto no Mail e Notas. Você pode 
escolher textos de 20, 24, 32, 40, 48 ou 56 pontos.
Para definir o tamanho do texto:Em Ajustes, escolha Geral > Acessibilidade > toque 
em Texto Grande, em seguida, toque no tamanho do texto desejado.
Branco sobre Preto
Utilize a função Branco sobre Preto para inverter as cores da tela do iPad, o que pode 
facilitar a leitura. Quando a função Branco sobre Preto estiver ativada, a tela fica semelhante a um negativo de foto.
Para inverter as cores da tela: Em Ajustes, escolha Geral > Acessibilidade e toque em 
“Branco sobre Preto”.Áudio Mono
O recurso de Áudio Mono combina o som dos canais esquerdo e direito em um sinal 
mono reproduzido dos dois lados. Isso permite que usuários com deficiências auditivas 
em um ouvido possam ouvir o sinal de som inteiro com o outro ouvido.
Para ativar ou desativar o Áudio Mono: Em Ajustes, escolha Geral > Acessibilidade e 
depois toque no botão Áudio Mono.
Falar texto automático
O recurso “Falar texto automático” pronuncia as correções e as sugestões de texto que 
o iPad faz quando você está digitando.
Para ativar ou desativar o recurso “Falar texto automático”: Em Ajustes, escolha Geral 
> Acessibilidade e depois toque no botão “Falar texto automático”.
O recurso “Falar texto automático” também funciona com o VoiceOver ou o Zoom.
Clique Triplo em Início
O Clique Triplo em Início é uma forma fácil de ativar ou desativar alguns recursos de 
acessibilidade, pressionando rapidamente o botão Início  três vezes. Você pode ajustar o Clique Triplo em Início para ativar ou desativar o VoiceOver, ativar ou desativar 
Branco sobre Preto ou perguntar se gostaria de clicar três vezes no botão Início para:
Â Ativar ou desativar o VoiceOver
Â Ativar ou desativar o Branco sobre Preto
Â Ativar ou desativar o Zoom
Normalmente, o Clique Triplo em Início está desativado.
Para definir a função do Clique Triplo em Início: Em Ajustes, escolha Geral > 
Acessibilidade > Clique Triplo em Início e depois escolha a função desejada.
Legendas Ocultas e Outros Recursos Úteis
Muitos recursos padrão disponíveis no iPad além disso, ajudam a que ele seja acessível 
para todos os usuários, incluindo aqueles com deficiência.
Teclados com Formato Panorâmico
Todos os aplicativos integrados ao iPad mostram um teclado maior na tela quando 
você gira o iPad para o modo horizontal. Você também pode digitar usando um teclado Apple Wireless Keyboard.
Tamanho Mínimo de Fonte das Mensagens do Mail
Ajuste o tamanho mínimo de fonte para o texto das mensagens do Mail para Grande, 
Extra Grande ou Gigante para aumentar a legibilidade. Consulte “Mail” na página ###.
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Acesso Universal no Mac OS X
Utilize as recursos do Acesso Universal no Mac OS X quando usar o iTunes para sincronizar informações e conteúdos da biblioteca do seu iTunes para o iPad. No Finder, 
escolha Ajuda > Ajuda Mac, depois busque “acesso universal”.
Para obter mais informações sobre os recursos de acessibilidade do iPad e do Mac OS 
X, visite o site www.apple.com/br/accessibility.
Legendas Ocultas
Você pode ativar as legendas ocultas dos vídeos nos ajustes de Vídeo. Consulte 
“Vídeo” na página 185.166
Sobre os Ajustes
Os ajustes permitem personalizar os aplicativos do iPad ajustar data e hora, configurar 
a sua conexão de rede e digitar outras preferências para o iPad.
Modo Avião
O modo Avião desativa os recursos sem fio do iPad para cumprir com as normas das 
companhias aéreas. 
Para ativar ou desativar o modo Avião: Toque em Ajustes e ative ou desative o modo 
avião.
Quando o modo avião estiver ativo, um pequeno  aparecerá na barra de estado na 
parte superior da tela. Não são emitidos sinais Wi-Fi e Bluetooth e a recepção GPS é 
desativada, desativando também muitos recursos do iPad. Você não poderá: 
Â Enviar ou receber e-mail
Â Navegar na Internet
Â Sincronizar contatos, calendários ou favoritos
Â Transmitir vídeos do YouTube em tempo real
Â Obter informes meteorológicos
Â Obter localizações de mapas
Â Usar as lojas iTunes Store, iBookstore ou App Store
Â Usar o Game Center
Se for permitido pelo operador da aeronave e pelas leis e regulamentos aplicáveis, 
você pode continuar a usar o iPad para:
Â Ouvir música ou assistir a vídeos
Â Verificar o seu calendário
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Â Visualizar fotos
Â Tomar notas
Â Ler mensagens de e-mail armazenadas no iPad
Se for permitido pelo operador da aeronave e pelas leis e regulamentos aplicáveis, 
você pode reativar a Wi-Fi, para:
Â Enviar e receber e-mail
Â Navegar na Internet
Â Sincronizar contatos, calendários e favoritos
Â Transmitir vídeos do YouTube em tempo real
Â Usar as lojas iTunes Store, iBookstore ou App Store
Â Usar o Game Center
Talvez você também possa ativar o Bluetooth para utilizar os dispositivos Bluetooth 
com o iPad. 
VPN
Este ajuste aparece quando você configura uma VPN (Rede Virtual Privada). Consulte 
“Acesso VPN” na página 189.
Para ativar ou desativar VPN: Toque em VPN para ativá-la ou desativá-la.
Para configurar uma VPN: Escolha Geral > Rede > VPN.
Wi-Fi
Os ajustes Wi-Fi determinam se o iPad usa redes Wi-Fi locais para conectar-se à 
Internet. Se nenhuma rede Wi-Fi estiver disponível, ou se você tiver desativado o Wi-Fi, 
o iPad se conecta à Internet pela sua rede de dados celular (iPad Wi-Fi + 3G).  
Para ativar ou desativar a Wi-Fi:  Escolha Wi-Fi e depois ative ou desative a opção 
Wi-Fi.
Para conectar-se a uma rede Wi-Fi: Escolha Wi-Fi, espere um momento enquanto o 
iPad detecta as redes no raio de alcance, depois selecione uma rede. Se for necessário, 
digite uma senha e toque em Conectar. (As redes que requerem uma senha aparecem 
com um ícone de cadeado  .)
Uma vez que você tenha se conectado a uma rede Wi-Fi, o iPad se conecta a ela automaticamente sempre que a rede estiver no raio de alcance. Se houver mais de uma 
rede usada anteriormente dentro do raio de alcance, o iPad se conecta a mais recentemente utilizada.Quando o iPad se conecta a uma rede Wi-Fi, o ícone Wi-Fi  situado na barra de estado na parte superior da tela mostra a intensidade do sinal. Quanto mais barras você vir, 
mais forte o sinal.
Para ajustar o iPad para perguntar se você deseja conectar-se a uma nova rede:
Escolha Wi-Fi e depois ative ou desative “Solicitar Conexão”.
Quando você tentar acessar a Internet utilizando o Safari ou o Mail, por exemplo, e 
você não estiver no raio de alcance de uma rede Wi-Fi que tenha utilizado anteriormente, esta opção diz ao iPad para buscar uma outra rede. O iPad mostra uma lista 
com todas as redes Wi-Fi disponíveis entre as quais você pode escolher. As redes que 
requerem uma senha aparecem com um ícone de cadeado  . Se a opção “Solicitar 
Conexão” estiver desativada e uma rede Wi-Fi ou de dados celular previamente usadas não estiverem disponíveis, você deve conectar-se manualmente a uma rede para 
conectar-se à Internet.
Para esquecer uma rede de forma que o iPad não se conecte a ela automaticamente:  Escolha Wi-Fi e depois toque no  ao lado de uma rede a qual você tenha se conectado antes. Depois pressione “Esquecer esta Rede”.
Para conectar-se a uma rede Wi-Fi fechada: Para conectar-se a uma rede Wi-Fi que 
não é mostrada na lista de redes, escolha Wi-Fi > Outra e digite o nome da rede. Se a 
rede pedir uma senha, toque em Segurança, toque no tipo de segurança que a rede 
usa e digite a senha.
Para conectar-se a uma rede fechada, você precisa saber o nome da rede, a senha e o 
tipo de segurança.
Algumas redes Wi-Fi podem pedir que você forneça informações adicionais, tais como 
um ID do cliente ou o endereço IP estático. Pergunte ao administrador da sua rede 
quais ajustes usar.
Para configurar os ajustes para conectar-se a uma rede Wi-Fi: Escolha Wi-Fi e depois 
toque no  ao lado de uma rede. 
Notificações
Este ajuste aparecerá quando você abrir um aplicativo, como o Game Center, que utilize o serviço de Notificações Push da Apple. As notificações push o alertam sobre novas 
informações, mesmo quando o aplicativo não está sendo executado. Dependendo do 
aplicativo, as notificações diferem, mas podem incluir alertas de texto ou de som e um 
identificador numerado no ícone do aplicativo na tela Início. Você poderá desativar 
as notificações se não quiser ser avisado ou se quiser conservar a bateria. Consulte 
“Interruptor Lateral” na página 176.
Para ativar ou desativar todas as notificações: Toque em Notificações e ative-as ou 
desative-as.
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Para ativar ou desativar sons, alertas ou avisos de um aplicativo: Toque em 
Notificações, escolha um aplicativo na lista e, em seguida, escolha os tipos de notifica-
ções que deseja ativar ou desativar. 
Serviços de Localização
Os Serviços de Localização permitem que aplicativos como o Mapas obtenham e usem 
dados baseando-se na sua localização. Os Serviços de Localização não conectam os 
dados que coletam com as suas informações de identificação pessoais. Se você estiver 
com o Wi-Fi ligado, a sua localização aproximada é determinada utilizando as informações disponíveis das redes Wi-Fi locais. O iPad Wi-Fi + 3G também usa as redes de 
celular e GPS para determinar a sua localização.
Quando um aplicativo está utilizando serviços de localização, o  aparece na barra de 
estado.
Cada aplicativo que utiliza os serviços de localização aparece na tela de ajustes dos 
Serviços de Localização, mostrando se esses serviços estão ativados ou não para esse 
aplicativo. O  aparece para cada aplicativo que tenha solicitado a sua localização 
dentro das últimas 24 horas. Se não desejar utilizar este recurso, você pode desativar 
os serviços de localização para alguns ou todos os aplicativos. Se você desativar os serviços de localização, aparecerá uma mensagem perguntando se você deseja ativá-lo 
novamente, na próxima vez que um aplicativo tentar utilizar o recurso.
Para ativar ou desativar os serviços de localização para todos os aplicativos:Escolha 
Geral > Serviços de Localização e ative ou desative os serviços de localização.
Para ativar ou desativar os serviços de localização para alguns aplicativos:Escolha 
Geral > Serviços de Localização, escolha um aplicativo e, em seguida, ative ou desative 
os serviços de localização para esse aplicativo.
Para conservar a vida útil da bateria, desative os serviços de localização quando não os 
estiver utilizando.
Operadora
Este ajuste aparece no iPad Wi-Fi + 3G quando você está fora da rede da sua operadora e há redes de dados de outras operadoras disponíveis para as conexões à Internet 
de rede celular.  
Para selecionar uma operadora: Escolha Operadora e selecione a rede que deseja 
utilizar.Dados do Celular
Use os ajustes de dados do celular (iPad Wi-Fi + 3G) para ativar ou desativar o Roaming 
de Dados, visualizar ou alterar as informações da sua conta, ou adicionar um PIN 
(Número de Identificação Pessoal) para bloquear o cartão micro-SIM.  
Para ativar ou desativar a rede de dados de celular: Escolha Dados do Celular e depois ative ou desative os dados do celular.
Para ativar ou desativar o Roaming de Dados: Escolha Dados do Sistema de Itinerário 
e depois ative ou desativa os dados do sistema de itinerário.
Para visualizar as informações da sua conta: Toque em Ver Conta para ver ou alterar 
as informações da sua conta.
Para adicionar um PIN do SIM (em alguns modelos): Toque em PIN do SIM e adicione 
um PIN para bloquear seu cartão micro-SIM.
Brilho e Imagem de Fundo
Use o ajuste Brilho para configurar o brilho da tela a um nível confortável. Use o ajuste 
Imagem de Fundo para personalizar o seu iPad.
Para ajustar o brilho da tela: Escolha Brilho e depois arraste o controle deslizante.
Para definir se o iPad deve ajustar o brilho da tela automaticamente: Escolha Brilho 
e depois ative ou desative a opção Brilho Automático. Se o Brilho Automático está ativado, o iPad ajusta o brilho da tela para as condições de luz atuais usando o sensor de 
luz ambiente integrado. Para ajustar o brilho da tela manualmente, consulte o “Como 
ajustar o brilho” na página 17.
Uma imagem de fundo é exibida na tela Bloqueio e na tela Início. Você pode escolher 
uma das imagens que acompanham o iPad, uma imagem salva no iPad ou uma foto 
da sua Biblioteca de Fotos. Uma imagem que tem pelo menos 1024 x 1024 pixels preenche a tela quando o iPad é girado.
Para definir uma imagem de fundo: Escolha Imagem de Fundo, selecione uma imagem e depois faça o seguinte:
Â Para usar a imagem como fundo da tela Bloqueio, toque em Definir Tela Bloqueio.
Â Para usar a imagem como fundo da tela Início, toque em Definir Tela Início.
Â Para usar a imagem como fundo de ambas telas Bloqueio e Início, toque em Definir 
Ambas.
Porta-retrato
O modo Moldura transforma o iPad em uma moldura animada. Escolha quais transi-
ções e fotos exibir. Escolha se deseja ampliar os rostos e se deseja misturar as fotos.
Para ativar o Porta-Retrato: Toque no  na tela Bloqueio.
170 Capítulo 22    AjustesCapítulo 22    Ajustes 171
Geral
O ajuste Geral inclui ajustes de data e hora, segurança, rede e outros ajustes que afetam mais de um aplicativo. Aqui é também onde você pode encontrar informações 
sobre o seu iPad ou redefinir o iPad ao seu estado original.
Sobre
Escolha Geral > Sobre para obter informações sobre o iPad, incluindo:
Â Número de músicas, vídeos, fotos e aplicativos
Â Capacidade de armazenamento total
Â Espaço disponível
Â Versão do software
Â Modelo e números de série
Â Número de dados de celular (iPad Wi-Fi + 3G) e endereços Wi-Fi e Bluetooth 
Â Versão do firmware do modem do transmissor celular iPad Wi-Fi + 3G
Â Números IMEI (International Mobile Equipment Identity) e ICCID (Integrated Circuit 
Card Identifier, ou Smart Card) (iPad Wi-Fi + 3G)
Â Informações Legais e Regulamentares
Uso
Para mostrar a porcentagem de uso da bateria: Ative a Porcentagem de Bateria para 
exibir a porcentagem de carregamento da bateria próximo ao ícone de bateria no canto superior direito.
Para visualizar dados da rede de Celular:  No iPad Wi-Fi + 3G, veja a quantidade de 
dados enviados e recebidos pela rede de dados celular.
Para redefinir as suas estatísticas de uso:  Toque em Redefinir estatísticas para limpar 
dados e estatísticas acumuladas.
Sons
Para ajustar o volume do toque e do aviso: Escolha Geral > Sons e arraste o controle 
deslizante. Se a opção “Ajustar com Botões” estiver ativada, use os botões de volume 
na lateral do iPad. Os botões de volume não alteram o volume do toque e do aviso se 
uma música ou vídeo estiver sendo reproduzido.
Para usar os botões de volume para ajustar o volume do toque ou do aviso:  Escolha 
Geral > Sons e, em seguida, toque em “Ajustar com Botões”.
Para definir o toque: Escolha Geral > Sons > Toque e, em seguida, escolha um toque.
Para definir os sons de aviso e de efeitos: Escolha Geral > Sons e depois ative ou 
desative os itens. Quando “Ajustar com Botões” está ativado, o iPad reproduz sons para 
alertas e efeitos que estão ativados.Você pode ajustar o iPad para reproduzir um som sempre que você:
Â Obtenha uma nova mensagem de e-mail
Â Enviar uma mensagem de e-mail
Â Tiver um evento do Calendário configurado para alertar você
Â Bloquear a tela do iPad
Â Digitar utilizando o teclado na tela
Rede
Use os ajustes Rede para configurar uma conexão VPN (rede virtual privada) ou para 
acessar os ajustes Wi-Fi.
Para adicionar uma nova configuração VPN:  Escolha Geral > Rede > VPN > Adicionar 
Configuração.
Redes VPNs utilizadas dentro de empresas permitem a comunicação de informação 
privada de forma segura via uma rede não privada. Talvez você precise configurar a 
rede VPN, por exemplo, para acessar o seu e-mail do trabalho no iPad.
O iPad pode conectar-se à redes VPNs que usam os protocolos L2TP, PPTP, IPSec Cisco. 
VPN funciona tanto com conexões Wi-Fi como com rede de dados de celular (iPad WiFi + 3G).
Pergunte ao administrador da sua rede quais ajustes utilizar. Na maioria dos casos, se 
você tem uma rede VPN configurada no seu computador, você pode usar os mesmos 
ajustes de VPN para o iPad.
Uma vez digitados os ajustes da VPN, um botão VPN aparece no menu de Ajustes que 
você pode usar para ativar ou desativar a VPN.
A VPN também pode ser automaticamente configurada por um perfil de configuração. 
Consulte “Utilização de Perfis de Configuração” na página 188.
Para alterar uma configuração VPN: Escolha Geral > Rede > VPN e toque na configuração que deseja atualizar.
Para ativar ou desativar VPN: Toque em Ajustes e depois ative ou desative a opção 
VPN. Quando VPN está ativada, você vê o  na barra de estado na parte superior da 
tela.
Para apagar uma configuração VPN: Escolha Geral > Rede > VPN, toque na seta azul 
à direita do nome da configuração, e pressione Apagar VPN na parte inferior da tela de 
configuração.
Bluetooth
O iPad pode conectar sem fio a um teclado Apple Wireless Keyboard para digitação 
sem fio ou para fones de ouvido Bluetooth para escuta sem fio. Consulte “Como usar 
os dispositivos Bluetooth” na página 46.
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Para ativar ou desativar o Bluetooth:Escolha Geral > Bluetooth e ative ou desative o 
Bluetooth. Quando o Bluetooth está ativado, você vê o ícone Bluetooth  na barra de 
estado na parte superior da tela. 
Busca do Spotlight
Você pode especificar as áreas de conteúdo que deseja buscar no iPad usando o 
Spotlight. 
Defina as áreas de conteúdo de busca do Spotlight: Escolha Geral > Busca do 
Spotlight e toque em um item para selecioná-lo ou anular sua seleção.
Para definir a ordem do resultado da busca: Escolha Geral > Busca do Spotlight, toque em  ao lado de um item e arraste-o para cima ou para baixo para reorganizar a 
ordem da busca.
Bloqueio Automático
Defina Bloqueio Automático para exibir e impedir uma operação não intencionada do 
seu iPad. 
Para ajustar durante quanto tempo o iPad permanecerá ativo antes de que seja bloqueado: Escolha Geral> Bloqueio Automático e escolha um tempo.
Bloqueio por Código
Inicialmente, o iPad não pede que você digite um código para desbloqueá-lo. Por segurança, você pode criar um código.
Para definir um código: Escolha Geral > Bloqueio por Código > Ativar Código. Digite 
um código de 4 dígitos e, em seguida, digite o código novamente para verificá-lo. O 
iPad então pede que você digite o código de acesso para desbloqueá-lo ou para exibir 
os ajustes de bloqueio do código de acesso.
Para definir o tempo antes de que o código seja pedido: Escolha Geral > Bloqueio 
por Código e digite seu código. Toque em Requer Código e selecione quanto tempo o 
iPad pode ficar ocioso antes que você precise digitar um código para desbloqueá-lo.
Desative o código de acesso.Escolha Geral > Bloqueio por Código > Desativar Código 
e digite seu código. 
Para alterar o código: Escolha Geral > Bloqueio por Código, digite seu código e toque 
em Alterar Código. Digite o código novamente; em seguida, digite e redigite seu novo 
código.
Se você esquecer o seu código, deverá restaurar o software do iPad. Consulte “Como 
Remover um Backup” na página 199.
Para ativar ou desativar um Código Simples:Escolha Geral > Bloqueio por Código e 
ative ou desative um Código Simples.
Um código simples é um número de quatro dígitos. Para aumentar a segurança, desative o Código Simples e utilize um código mais longo com uma combinação de números, letras, pontuação e caracteres especiais.Para ativar ou desativar a Moldura: Escolha Geral > Bloqueio por Código e ative ou 
desative a Moldura.
Quando a Moldura está ativada, o iPad exibe as suas fotos a partir da tela bloqueada. 
Consulte “Porta-retrato” na página 170.
Para apagar todos os dados após digitar o código incorretamente dez vezes:
Escolha Geral > Bloqueio por Código, digite seu código e toque em Eliminar Dados 
para ativar esse recurso.
Após digitar o código incorretamente dez vezes, seus ajustes serão redefinidos para os 
valores padrão, todas suas informações e mídia serão apagadas, e o código criptografado é removido. 
Bloqueio/Desbloqueio da capa do iPad
Você pode bloquear ou desbloquear automaticamente o iPad 2 ao usá-lo com o Smart 
Cover do iPad (disponível separadamente).
Para usar a capa para bloquear ou desbloquear o iPad: Escolha Geral > Bloqueio/
Desbloqueio da capa do iPad e, em seguida, toque em Ativar. O iPad se bloqueia e 
entra no modo de repouso automaticamente quando você fecha a capa e depois se 
desperta e se desbloqueia quando você abre a capa.
Se você houver definido um código de acesso, deve inseri-lo quando abrir a capa para 
despertar o iPad.
Restrições
No iPad, você pode definir restrições para o uso de certos aplicativos e para o conteú-
do do iPod. Por exemplo, os pais podem restringir o acesso a conteúdos explícitos ou 
desativar o acesso ao YouTube.
Para ativar as restrições:
1 Escolha Geral > Restrições, depois toque em Ativar Restrições.
2 Digite um código de quatro dígitos.  
3 Digite o código novamente.
Para desativar as restrições: Escolha Geral > Restrições e depois digite o código de 
acesso. Toque em Desativar Restrições, depois digite novamente o código.
Se você esquecer o seu código, você deve restaurar o software do iPad usando o iTunes. Consulte “Como Remover um Backup” na página 199.
Para configurar restrições de aplicativos: Defina as restrições que deseja tocando 
para ativar ou desativar os controles individuais. Inicialmente, todos os controles estão 
ativados (sem restrições). Toque em um item para desativá-lo e restringir seu uso.
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Safari
O Safari é desativado e o seu ícone é removido da tela de Início. Você não poderá utilizar o Safari para navegar na web ou acessar web clips. Apps de outras marcas poderão 
permitir a navegação na web mesmo se o Safari estiver desativado.
YouTube
O YouTube é desativado e o seu ícone é removido da tela de Início.
Câmera
O aplicativo Câmera é desativado e o seu ícone é removido da tela de Início. Você não 
pode tirar fotos ou criar vídeos com o iPad.
FaceTime
Fazer ou receber videoconferências do FaceTime.
iTunes
A iTunes Store é desativada e seu ícone é removido da tela de Início. Você não pode 
pré-visualizar, comprar ou transferir conteúdo.
Ping
O Ping está desativado. Você não pode seguir artistas ou outras pessoas.
Como 
instalar 
aplicativos
A instalação de aplicativos é desativada e o ícone da App Store é removido da tela de 
Início. 
Como 
Apagar 
Apps
O apagamento de aplicativos do iPad é desativado. O  não aparece nos ícones do 
aplicativo quando você está personalizando a tela de Início.
Local
Os ajustes dos Serviços de Localização não podem ser alterados.
Contas
Os ajustes dos Serviços de Localização não podem ser alterados.
Para restringir compras dentro dos aplicativos: Desative a opção “Compras em Aplic.”. 
Quando ativado, este recurso permite comprar conteúdo adicional ou recursos dentro 
de aplicativos transferidos da App Store.Para ajustar as restrições de conteúdo: Toque em Classificações Para e selecione um 
país na lista. Você pode ajustar as restrições utilizando o sistema de classificação daquele país para as seguintes categorias de conteúdo:
Â Música e Podcasts
Â Filmes
Â Programas de TV
Â Apps
Nos Estados Unidos, por exemplo, para permitir apenas filmes com classificação PG ou 
inferior, toque em Filmes e selecione PG na lista.  
Nota: Nem todos os países têm sistemas de classificação.
Para restringir jogos com vários jogadores: Ative a opção Jogos em Grupo.
Quando a opção Jogos em Grupo está desativada, você não pode convidar para uma 
partida, ou enviar ou receber convites para jogar ou adicionar amigos no Game Center.
Para restringir a adição de amigos: Desative Adicionar Amigos.
Quando a opção Adicionar Amigos está desativada, você não pode fazer ou receber 
solicitações de amigos no Game Center. Você pode continuar jogando com os amigos 
existentes se a opção Jogos em Grupo está ativada.
Interruptor Lateral
Você pode usar o Interruptor Lateral para bloquear a orientação da tela ou para silenciar as notificações e efeitos sonoros.
Para bloquear a tela do na orientação vertical ou horizontal: Escolha Geral > Usar 
Interruptor Lateral… e, em seguida, toque em Bloquear Rotação.
Para silenciar as notificações e outros efeitos sonoros: Escolha Geral > Usar 
Interruptor Lateral… e, em seguida, toque em Silenciar.
O Interruptor Lateral não silencia a reprodução de áudio ou de vídeo. 
Data e Hora
Estes ajustes se aplicam à hora mostrada na barra de estado na parte superior da tela, 
relógios internacionais e calendários.
Para definir se o iPad deve mostrar o padrão 12h ou 24h:   Escolha Geral > Data e 
Hora e ative ou desative a opção Relógio de 24 horas (Talvez o Relógio de 24 horas 
não esteja disponível em todos os países ou regiões).
Para definir se o iPad deve atualizar a data e a hora automaticamente:  Escolha 
Geral > Data e Hora e ative ou desative a opção Ajustar Automaticamente.
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Para definir a data e a hora manualmente:  Escolha Geral > Data e Hora e desative a 
opção Ajustar Automaticamente. Toque em Fuso Horário e digite o nome de uma cidade principal que esteja no seu fuso horário. Toque no botão “Data e Hora”, depois toque 
em “Ajustar Data e Hora” e ajuste a data e a hora.
Teclado
Para ativar ou desativar as maiúsculas automáticas:  Escolha Geral > Teclado e ative 
ou desative a opção Maiúsculas Automáticas.
Normalmente, o iPad automaticamente coloca em maiúsculas a primeira letra das palavras depois de pontos finais ou do caractere retorno.
Para ativar ou desativar a Correção Automática:  Escolha Geral > Teclado e ative ou 
desative a opção Correção Automática.
Normalmente, se o teclado normal do idioma que você selecionou tiver um dicioná-
rio, o iPad automaticamente sugerirá correções ou completará palavras à medida que 
você digitar.
Para verificar a ortografia ao digitar: Escolha Geral > Teclado e ative ou desative a op-
ção Verificar Ortografia.
Para ativar Fixar Maiúsculas: Escolha Geral > Teclado e ative ou desative a opção 
Ativar Fixar Maiúsculas.
Se a fixação de maiúsculas estiver ativada e você tocar duas vezes na tecla Maiúsculas 
no teclado, todas as letras que digitar ficarão em maiúsculas. A tecla Maiúsculas fica 
azul quando a opção Fixar Maiúsculas está ativada.
Para ativar ou desativar o atalho “.”:Escolha Geral > Teclado e ative ou desative o atalho “.” Ativar ou desativar o atalho.
O atalho “.” permite tocar duas vezes na barra de espaço para digitar um ponto final 
seguido de um espaço quando você está digitando. Está ativado inicialmente.
Para adicionar teclados Internacionais:Escolha Geral > Teclados > Teclados 
Internacionais > Adicionar Novo Teclado e toque nos teclados que deseja adicionar.
Para alterar um leiaute de teclado:Escolha Geral > Teclados > Teclados Internacionais 
e selecione um teclado. Para alguns idiomas, você pode alterar o leiaute de teclado da 
tela e o leiaute do teclado do hardware externo.
Internacional
Use os ajustes em Internacional para definir o idioma do iPad, para adicionar teclados 
para diferentes idiomas e para definir os formatos de data, hora e número de telefone 
para sua região. Você também pode escolher um formato de calendário. 
Para definir o idioma do iPad:Escolha Geral > Internacional > Idioma, escolha o idioma que deseja utilizar e toque em OK.
Para ativar ou desativar teclados internacionais: Escolha Geral > Internacional > 
Teclados e adicione os teclados que deseja usar.Se houver mais de um teclado ativado, mantenha pressionado  o teclado para ver 
um menu de teclados. Consulte Apêndice B,“Teclados Internacionais,” na página 191.
Para definir os formatos de data, hora e número de telefone:  Escolha Geral > 
Internacional > Formato da Região e escolha a sua região.
O Formato da Região também determina o idioma usado nos dias e meses que aparecem nos aplicativos integrados do iPad.
Para definir um formato do calendário:Escolha Geral > Internacional > Calendário e 
selecione o formato de calendário que deseja usar; por exemplo Gregoriano, Japonês 
ou Budista.
Acessibilidade
Para ativar os recursos de acessibilidade, vá para os ajustes de Acessibilidade e escolha 
os recursos desejados. Consulte Capítulo 21,“Acessibilidade,” na página 150.
Como redefinir o iPad
Para redefinir todas os ajustes:  Escolha Geral > Redefinir > Redefinir Todos os Ajustes.
Insira o se código de acesso se você o tiver. Todos os seus ajustes são redefinidos. As 
informações (como seus contatos e calendários) e as mídias (como suas músicas e ví-
deos) não são apagadas.
Para excluir todo o conteúdo e ajustes:Escolha Geral > Redefinir > Apagar Todo o 
Conteúdo e Ajustes.
Insira o se código de acesso se você o tiver. Isto redefine todos os ajustes do iPad para 
os valores originais e apaga todas as suas informações e mídia.
Para redefinir os ajustes de rede: Escolha Geral > Redefinir > Redefinir Ajustes da 
Rede.
Insira o se código de acesso se você o tiver. Quando você redefine os ajustes de rede, 
sua lista de redes usadas anteriormente e os ajustes da VPN não instalados por um 
perfil de configuração são removidos. A rede Wi-Fi é desativada e ativada novamente, 
desconectando você de qualquer rede. Os ajustes Wi-Fi e “Solicitar Conexão” permanecem ativados.
Para remover os ajustes da VPN instalados por um perfil de configuração, escolha 
Ajustes > Geral > Perfil; em seguida, selecione o perfil e toque em Remover.
Para redefinir o dicionário do teclado: Escolha Geral > Redefinir > Redefinir 
Dicionário do Teclado.
Insira o se código de acesso se você o tiver. Você adiciona palavras ao dicionário do 
teclado ao rejeitar palavras que o iPad sugere enquanto você digita. Toque em uma 
palavra para rejeitar a correção e adicionar a palavra ao dicionário do teclado. A redefinição do dicionário do teclado apaga todas as palavras que você adicionou.
Para redefinir o leiaute da tela de Início: Escolha Geral > Redefinir > Redefinir Leiaute 
da Tela de Início para redefinir a sua tela de Início para os padrões originais.
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Para redefinir os avisos de localização: Escolha Geral > Redefinir > Redefinir Avisos de 
Localização e insira o seu código de acesso se tiver.
Os Avisos de Localização são solicitações feitas por um aplicativo (como o Mapas) para 
usar os Serviços de Localização com aquele aplicativo. O iPad para de apresentar os 
avisos para um aplicativo na segunda vez que você toca em OK. Toque em Redefinir 
Avisos de Localização para reativar os avisos.
Mail, Contatos, Calendários
Use os ajustes Mail, Contatos e Calendários para configurar e personalizar contas para 
o iPad: 
Â Microsoft Exchange
Â MobileMe
Â E-mail do Google
Â Yahoo! Mail
Â AOL
Â Outros sistemas de correio POP e IMAP
Â Contas LDAP para Contatos
Â Contas CalDAV ou iCalendar (.ics) para Calendários
Contas
A seção Contas permite configurar contas no iPad. Os ajustes específicos que aparecem dependem do tipo de conta que está configurando. Seu provedor de acesso ou 
administrador de sistema deve fornecer a informação que você necessita digitar.
Para obter mais informações, consulte:  
Â “Como adicionar Mail, Contatos e Contas do Calendário” na página 32
Â “Como Sincronizar e Adicionar Contatos” na página 99
Â “Como Assinar Calendários ” na página 95
Para alterar os ajustes de uma conta:Escolha “Mail, Contatos, Calendários”, escolha 
uma conta, depois faça as alterações desejadas.
As alterações que você faz aos ajustes de uma conta no iPadnão são sincronizadas 
com seu computador; portanto, você pode configurar suas contas para que funcionem 
com o iPad sem afetar os ajustes da conta no seu computador.
Para parar de usar uma conta: Escolha “Mail, Contatos, Calendários,” escolha uma conta, depois desative Conta.
Se uma conta está desativada, o iPad não exibe a conta e não envia ou verifica e-mail, 
nem sincroniza outras informações com aquela conta até que você a ative novamente.Para definir ajustes avançados: Escolha “Mail, Contatos, Calendários,” escolha uma 
conta, toque em Avançado e depois proceda da seguinte maneira:
Â Para definir se rascunhos e mensagens apagadas são armazenados no iPad ou remotamente no seu servidor de e-mail (somente contas IMAP), toque nas caixas de correio 
Rascunhos ou Apagadas.
Se você armazenar mensagens no iPad, poderá vê-las mesmo quando o iPad não 
estiver conectado à Internet.
Â Para configurar SSL e os ajustes de senha, toque em Avançado. Peça ao administrador 
da sua rede ou ao seu provedor de acesso à Internet os ajustes corretos.
Para apagar uma conta do iPad:  Escolha “Mail, Contatos, Calendários”, escolha uma 
conta, depois role para baixo e toque em Apagar Conta.
Apagar uma conta significa que não poderá mais acessar a conta no seu iPad. Todos 
os e-mails e as informações dos contatos, calendários e favoritos sincronizadas com a 
conta são removidas do iPad. Entretanto, excluir uma conta não remove a conta ou a 
informação associada do seu computador.
Obter Novos Dados
Este ajuste permite ativar ou desativar a tecnologia Push para o MobileMe, Microsoft 
Exchange, Yahoo! Mail e qualquer outra conta push no iPad. As contas push entregam 
as novas informações automaticamente ao iPad quando essas novas informações 
aparecem no servidor (podem ocorrer atrasos). Para obter ou sincronizar os dados do 
push, o iPad deve ter uma conexão à Internet. Desative o Push para suspender a entrega de e-mails e outras informações, ou para conservar a vida útil da bateria.
Quando o Push estiver desativado, e com contas não compatíveis com o push, o iPad 
pode ainda verificar o servidor para ver se há novas informações disponíveis. Utilize 
o ajuste Obter Novos Dados para determinar a frequência de solicitação dos dados. 
Para manter uma melhor autonomia da bateria, não obtenha os dados com muita 
frequência.  
Para ativar o Push: Escolha “Mail, Contatos, Calendários” > Obter Novos Dados e pressione para ativar o Push.
Para definir a frequência de obtenção de dados: Escolha “Mail, Contatos, Calendários” 
> Obter Novos Dados e escolha a frequência com a qual você deseja obter os dados. 
Para conservar a autonomia da bateria, obtenha dados com menos frequência.
Ajustar o Push para desativado ou ajustar a opção Obter para Manualmente na tela 
Obter Novos Dados substitui os ajustes específicos de uma conta.
Nota: Quando o Push está desativado, a opção Buscar Meu iPad não funciona.
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Mail
Os ajustes do Mail, exceto quanto descrito, aplicam-se a todas as contas configuradas 
no iPad.
Para ligar ou desligar sons de alerta para novos e-mails ou e-mails enviados, use Geral 
> Ajustes de Sons.
Para definir o número de mensagens exibidas no iPad: Escolha "Mail, Contatos, 
Calendários” > Mostrar, depois escolha um ajuste.
Escolha ver as 25, 50, 75, 100 ou 200 mensagens mais recentes. Para transferir mensagens adicionais quanto estiver no Mail, role até o final da sua caixa de entrada e toque 
em Carregar Mais Mensagens.
Nota: Para as contas de Microsoft Exchange, escolha “Mail, Contatos, Calendários” e 
escolha a conta do Exchange. Pressione "Sincronizar Mail" e escolha o número de dias 
de e-mail que deseja sincronizar com o servidor.
Para definir quantas linhas de cada mensagem são pré-visualizadas na lista de 
mensagens: Escolha "Mail, Contatos, Calendários” > Pré-visualizar, depois escolha um 
ajuste.
Você pode optar por ver até cinco linhas de cada mensagem. Desta forma, você pode 
examinar uma lista de mensagens em uma caixa de correio e ter uma ideia do que 
trata cada mensagem.
Para definir um tamanho mínimo de fonte das mensagens: Escolha "Mail, Contatos, 
Calendários” > Tamanho de Fonte, depois escolha Pequena, Média, Grande, Extra 
Grande ou Gigante.
Para definir se o iPad mostra as etiquetas Para e Cc nas listas de mensagens:  Escolha 
"Mail, Contatos, Calendários”, depois ative ou desative a opção Mostrar Para/Cc.
Se a opção Mostrar Para/Cc estiver ativada, o  ou o  Cc próximos a cada mensagem 
em uma lista indicam se a mensagem foi enviada diretamente para você ou se você 
recebeu uma cópia.
Para definir se o iPad confirma que você deseja apagar uma mensagem: Escolha 
“Mail, Contatos, Calendários”, depois nos ajustes do Mail, ative ou desative Perguntar 
Antes de Apagar.
Para definir se o iPad carregará automaticamente as imagens remotas: Escolha 
"Mail, Contatos, Calendários” e ative ou desative a opção Carregar Imagens.  
Se a opção Carregar Imagens estiver desativada, você poderá carregar as imagens manualmente ao ler uma mensagem.
Para definir se o iPad envia uma cópia de cada mensagem enviada: Escolha “Mail, 
Contatos, Calendários”; depois, ative ou desative a opção Cco para Mim.
Para adicionar uma assinatura às suas mensagens:  Escolha "Mail, Contatos, 
Calendários” > Assinatura; depois, digite uma assinatura.Você pode ajustar o iPad para adicionar uma assinatura—a sua citação favorita, ou o 
seu nome, cargo, e número de telefone, por exemplo—no final da cada mensagem 
que enviar.
Para definir a conta de e-mail padrão: Escolha “Mail, Contatos, Calendários” > Conta 
Padrão, depois escolha uma conta.
Este ajuste determina a partir de qual das suas contas uma mensagem é enviada 
quando você cria uma mensagem de outro aplicativo do iPad — por exemplo, enviando uma foto de Fotos ou tocar em um endereço de e-mail de um empresa em Mapas. 
Para enviar a mensagem de uma conta diferente, toque no campo De em uma mensagem e escolha a conta.
Contatos
Para definir como os contatos são ordenados: Escolha "Mail, Contatos, Calendários,” 
depois em Contatos toque em Tipo de Ordenação e proceda da seguinte maneira:
Â Para ordenar pelo nome, primeiro, toque em Primeiro, Último.
Â Para ordenar pelo sobrenome, primeiro, toque em Último, Primeiro.
Para definir como os contatos são exibidos: Escolha "Mail, Contatos, Calendários,” depois sob Contatos toque em Ordenar por e proceda da seguinte maneira:
Â Para mostrar o nome primeiro, toque em Nome, Sobrenome.
Â Para mostrar o sobrenome primeiro, toque em Sobrenome, Nome.
Calendários
Para definir se haverá um aviso sonoro ao receber convites de reuniões: Escolha 
“Mail, Contatos, Calendários,” e em Calendários toque em “Novos Convites” para ativar.
Para definir quanto tempo no passado mostrar seus eventos de calendário no iPad:
Escolha “Mail, Contatos, Calendários” > Sincronizar, depois escolha um período de 
tempo.
Para ativar a gestão de fuso horário do Calendário:  Escolha “Mail, Contatos, 
Calendários” > Gestão Fuso Horário, depois ative Gestão Fuso Horário. Selecione um 
fuso horário para os calendários tocando em Fuso Horário e digitando o nome de uma 
cidade conhecida.
Quando a Gestão Fuso Horário está ativada, o Calendário exibe a data e hora dos eventos no fuso horário da cidade selecionada. Quando a Gestão Fuso Horário está desativada, o Calendário exibe os eventos na zona horária da sua localização atual, conforme 
determinada pela hora da rede.
Importante: Se você está viajando, o iPad pode não exibir eventos ou reproduzir alertas na hora local correta. Para ajustar a hora correta manualmente, consulte “Data e 
Hora” na página 176.
Para definir um aviso sonoro ao receber um convite para uma reunião: Escolha “Mail, 
Contatos, Calendários,” e em Calendários toque em “Novos Convites” para ativar.
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Safari
Os ajustes do Safari permitem selecionar o seu buscador na Internet, definir opções de 
segurança e, para desenvolvedores, ativar o depurador.
Geral
Para realizar buscas na Internet, você pode definir o motor de busca como Google, 
Yahoo! ou Bing. 
Para selecionar um buscador: Escolha Safari > Buscador e selecione o buscador que 
deseja utilizar.
Você pode configurar o Safari para preencher automaticamente formulários da web 
utilizando informações de contato, nomes e senhas que tenha inserido anteriormente, 
ou ambos.
Para ativar o Preenchimento Automático: Escolha Safari > Preenchimento 
Automático e siga um destes procedimentos:
Â Para utilizar as informações dos contatos, ative Dados de Contato; em seguida, escolha Meus Dados e selecione o contato que deseja utilizar.
Quando este recurso está ativado, o Safari utiliza as informações dos Contatos para 
preencher os campos de contato nos formulários da web.
Â Para usar as informações dos nomes e senhas, ative Nomes e Senhas.
Quando esse recurso está ativado, o Safari se lembra dos nomes e senhas dos sites 
que você visitou e automaticamente preenche as informações quando você visita o 
site novamente.
Â Para remover todas as informações do Preenchimento Automático, toque em Limpar 
Tudo.
Segurança
Por padrão, o Safari está ajustado para mostrar recursos da web tais como alguns filmes, animações e aplicativos web. Talvez você queira alterar os ajustes de segurança 
para ajudar a proteger o iPad de possíveis riscos de segurança na Internet.
Para alterar os ajustes de segurança: Escolha Safari, depois proceda da seguinte 
maneira:
Â Para definir se você deseja ser avisado quando estiver visitando sites potencialmente 
fraudulentos, ative ou desative a opção Aviso de Fraude.
O aviso de fraude o protege de sites da Internet potencialmente fraudulentos. 
Quando você visita um site suspeito, o Safari lhe avisa sobre a sua natureza duvidosa e não carrega a página.
Â Para ativar ou desativar o JavaScript, ative ou desative a opção JavaScript.O JavaScript permite que programadores web controlem elementos na página—por 
exemplo, uma página que usa JavaScript pode exibir a data e a hora atuais ou fazer 
com que uma página proveniente de um link apareça em uma nova página.
Â Para bloquear ou permitir pop-ups, ative ou desative a opção Bloquear Pop-ups. O 
bloqueio de pop-ups para somente os pop-ups que aparecem quando você fecha 
uma página ou abre uma página digitando seu endereço. Ele não bloqueia os popups que se abrem quando você toca em um link.
Â Para definir se o Safari aceita cookies, toque em Aceitar Cookies e escolha Nunca, “Dos 
Visitados”, ou Sempre.
Um cookie é um segmento de informação que um site coloca no iPad para que ele 
possa lembrar de você quando você o visitar novamente. Desta forma, as páginas 
web podem ser personalizadas para você baseado na informação que você possa 
ter fornecido.
Algumas páginas web não funcionam corretamente a menos que o iPad aceite 
cookies.
Â Para limpar o histórico de páginas web visitadas, toque em Limpar Histórico.
Â Para limpar todos os cookies do Safari, toque em Limpar Cookies.
Â Para limpar o cache do navegador, toque em Limpar Cache.
O cache do navegador armazena o conteúdo das páginas de forma que as páginas 
sejam abertas mais rapidamente da próxima vez que as visitar. Se uma página que 
você abriu não estiver mostrando conteúdo novo, limpar o cache pode ajudar.
Desenvolvedores
O console de depuração pode ajudar a resolver erros de páginas web. Se estiver ativado, o console aparece quando ocorre um erro de página web.
Para ativar ou desativar o console de depuração: Escolha Safari > Desenvolvedor, e 
ative ou desative o Console de Depuração.
iPod
Use os Ajustes do iPod para configurar a reprodução de áudio no aplicativo iPod no 
iPad.
Para ajustar o iTunes para reproduzir músicas no mesmo nível de som: No iTunes, 
escolha iTunes > Preferências se estiver utilizando um Mac, ou Editar > Preferências se 
estiver utilizando um PC. Em seguida, clique em Reprodução e selecione Verificação de 
Som.
Para ajustar o iPad para usar os ajustes de volume do iTunes (Verificação de Som):
Escolha iPod e ative ou desative a opção Verificação de Som.
Use EQ para personalizar o som:  Escolha iPod, toque em EQ e escolha um ajuste de 
equalizador.
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Para definir um limite de volume: Escolha iPod, toque em Limite do Volume e arraste 
o controle para ajustar o volume máximo.
Toque em Bloquear Limite de Volume para atribuir um código para evitar que os ajustes sejam alterados.
Para obter letras de músicas e informações sobre podcasts: Escolha iPod e ative ou 
desative a opção Letra/Inf. de Podcast.
Para compartilhar a sua biblioteca do iTunes: Insira o seu ID e senha da Apple e, em 
seguida, use o Compartilhamento Familiar para importar os itens de até cinco bibliotecas do iTunes em outros computadores na sua rede local.
ADVERTÊNCIA: Para obter informações importantes sobre como evitar a perda 
de audição, consulte o Manual de Informações Importantes do Produto iPad no site 
support.apple.com/pt_BR/manuals/ipad.
Vídeo
Os ajustes de vídeo se aplicam ao conteúdo de vídeo, incluindo filmes e programas de 
TV alugados. Você pode definir onde retomar a reprodução dos vídeos que já come-
çou a assistir, ativar ou desativar as legendas e configurar o iPad para reproduzir vídeos 
na sua TV.
Para definir onde retomar a reprodução: Escolha Vídeo > Iniciar Reprodução, depois 
selecione se deseja que os vídeos que já começou a assistir sejam retomados do começo ou de onde você parou.
Para ativar ou desativar as legendas ocultas: Escolha Vídeo e ative ou desative a op-
ção Legenda Oculta.
Para ativar ou desativar o formato panorâmico: Escolha Vídeo e ative ou desative a 
opção Formato Panorâmico. Se o vídeo que você está reproduzindo estiver no formato 
panorâmico, ativar esta opção preserva as proporções panorâmicas.
Para ajustar o sinal de TV para NTSC ou PAL: Escolha Vídeo > Sinal de TV e selecione 
NTSC ou PAL. NTSC e PAL são padrões de transmissão usados em diferentes regiões. Se 
você está nas Américas, provavelmente, o NTSC é a escolha correta. Em qualquer outro 
lugar, tente o PAL. Se não tiver certeza, verifique a documentação que acompanha sua 
TV ou projetor.
Utilize os ajustes Saída TV para configurar como o iPad reproduz vídeos na sua TV.
Para usar um desses para conectar o iPad a um televisor ou projetor:
Â Adaptador Digital AV da Apple e um cabo HDMI
Â Cabo AV por componentes da Apple
Â Cabo AV Composto da Apple
Â Adaptador VGA da AppleSe você usar o Adaptador AV Digital da Apple ou o Cabo AV por componentes da 
Apple, os vídeos de alta resolução são exibidos com qualidade HD. Os cabos da Apple 
estão disponíveis para compra em vários países. Visite o site www.apple.com/br/store. 
Com o iPad 2, quando o cabo é conectado a um televisor ou projetor, a tela do iPad é 
automaticamente refletida no monitor externo com até 1080 pixels de resolução, e os 
vídeos são reproduzidos com uma resolução máxima de 720 pixels. Alguns aplicativos 
como o Keynote podem usar o monitor externo como um segundo monitor de vídeo. 
Nos modelos anteriores do iPad, somente alguns aplicativos (incluindo o YouTube, 
Vídeos e Fotos) usam o monitor externo.
Fotos
Utilize os ajustes de Fotos para especificar como as apresentações de slides exibem 
suas fotos.
Para definir durante quanto tempo cada slide é apresentado: Escolha Fotos > 
Mostrar Cada Slide e selecione a duração.
Para definir se a apresentação de slides deve ser repetida ou não: Escolha Fotos e 
ative ou desative a opção Repetir.
Para definir se as fotos aparecerão em ordem ou aleatoriamente: Escolha Fotos e 
ative ou desative a opção Aleatório.
FaceTime
Use os ajustes do FaceTime para ativar o FaceTime ou alterar o seu endereço.
Digite seu ID e senha da Apple para ativar o FaceTime. Se você não tiver um ID da 
Apple, toque em Criar Novo ID da Apple e siga as instruções na tela. O endereço de 
e-mail que você especificar quando estiver criando a conta será o seu endereço do 
FaceTime.
Para ativar ou desativar o FaceTime: Quando o FaceTime está desativado, você não 
pode fazer ou receber ligações do FaceTime.
Para especificar endereços adicionais do FaceTime: Para adicionar um endereço de 
e-mail para que outros possam usá-lo para ligar para você com o FaceTime, toque em 
Adicionar Outro E-mail.
Notas
Use os ajustes de Notas para escolher a fonte usada para exibir suas notas.
Para escolher uma fonte: Escolha Notas e selecione uma fonte.
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Loja
Use os ajustes Loja para alterar ou criar um ID da Apple. Por padrão, o ID da Apple que 
você iniciou a sessão quando sincronizou o iPad com o seu computador aparece nos 
ajustes Loja. Você pode mudar as contas no iPad para adquirir música ou aplicativos de 
outra conta. Se não tiver um ID Apple, poderá criar um nos ajustes da Loja.
Para criar uma nova conta: Escolha Loja e toque em Criar Nova Conta; em seguida, 
siga as instruções da tela.
Para iniciar sessão em uma conta: Escolha Loja e toque em Iniciar Sessão; em seguida, 
digite seu ID e senha da Apple.
Para visualizar as informações do seu ID da Apple: Escolha Loja, inicie a sessão usando o seu ID da Apple e toque em Ver ID Apple.
Para iniciar sessão em uma conta diferente: Escolha Loja e toque em Finalizar Sessão; 
em seguida, toque em Iniciar Sessão e digite seu nome de usuário e senha.188
O iPad no Trabalho
Tendo o suporte para acessar com segurança as redes e diretórios corporativos e o 
Microsoft Exchange, o iPad está pronto para ir trabalhar. Para obter informações detalhadas sobre como usar o iPad nos negócios vá para www.apple.com/br/ipad/business.
Utilização de Perfis de Configuração
Se você está em um ambiente empresarial, talvez você possa configurar contas e 
outros itens no iPad instalando um perfil de configuração. Os perfis de configuração 
permitem que seu administrador configure o seu iPad para usar os sistemas de informação na sua empresa, escola ou organização. Por exemplo, um perfil de configuração 
poderia configurar seu iPad para acessar os servidores Microsoft Exchange no trabalho, 
de forma que o iPad pudesse acessar seu e-mail, calendários e contatos do Exchange.
Um simples perfil de configuração pode configurar muitos ajustes diferentes no iPad. 
Por exemplo, um perfil de configuração pode configurar sua conta Microsoft Exchange, 
sua conta VPN e certificar o acesso seguro à rede e às informações da sua empresa. 
Um perfil de configuração também pode ativar o Bloqueio por Código, que requer que 
você crie e digite um código para usar o iPad.
Seu administrador pode distribuir perfis de configuração tanto por e-mail, colocandoos em uma página web segura, como instalando-os diretamente no iPad pra você. O 
seu administrador pode pedir que você instale um perfil que vincule o seu iPad a um 
servidor de gerenciamento de dispositivo móvel, o que permite que o seu administrador configure os seus ajustes remotamente.
Como Instalar Perfis de Configuração:
1 No iPad, abra uma mensagem de e-mail ou transfira os perfis de configuração do site 
que o seu administrador fornecer.
2 Para cada perfil de configuração, toque no perfil e, em seguida, toque em Instalar.
3 Digite senhas e outras informações solicitadas.
Importante: Talvez seja perguntado a você se o perfil de configuração é confiável. Se 
tiver dúvidas, pergunte ao seu administrador antes de instalar o perfil de configuração.
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Você não pode alterar os ajustes de um perfil de configuração. Se deseja alterar os 
ajustes, você deve primeiro remover o perfil de configuração ou instalar um perfil de 
configuração novo junto com os novos ajustes.
Como remover um perfil: Em Ajustes, escolha Geral > Perfil e, em seguida, selecione o 
perfil de configuração e toque em Remover.
A remoção de um perfil de configuração apaga os ajustes e outras informações instaladas pelo perfil.  
Como Configurar Contas do Microsoft Exchange
O O Microsoft Exchange fornece informações de e-mail, de contato e de calendário 
que pode ser automaticamente sincronizada sem fio para o iPad. Você pode configurar 
uma conta Exchange diretamente no iPad.  
Para configurar uma conta no iPad:
1 Na tela de Início do iPad, toque em Ajustes.
2 Toque em “Mail, Contatos, Calendários”, depois toque em Adicionar Conta.
3 Toque em Microsoft Exchange.
4 Digite as informações da sua conta e toque em Salvar.
Seu provedor de serviços ou administrador pode fornecer-lhe as configurações de 
conta necessárias.
Contas do Exchange:  Digite o seu endereço de e-mail, domínio (opcional), nome de 
usuário, senha e uma descrição.
O iPad é compatível com o serviço Descoberta Automática da Microsoft, que usa seu 
nome de usuário e sua senha para determinar o endereço do servidor Exchange. Se 
o endereço do servidor não poder ser determinado, você será solicitado a fornecê-lo. 
Assim que conectar-se ao servidor Exchange, você será solicitado a alterar o seu código de acesso para cumprir com os requisitos do servidor.
5 Quando estiver configurando uma conta Microsoft Exchange, toque nos itens que deseja usar no iPad—correio, contatos e calendários.
Acesso VPN
A VPN (rede privada virtual) fornece acesso seguro via Internet à redes privadas, como 
redes da sua empresa ou escola. Utilize os ajustes de rede no iPad para configurar e 
ativar a VPN. Pergunte ao seu administrador quais ajustes deve usar.
A VPN também pode ser automaticamente configurada por um perfil de configura-
ção. Quando a VPN é configurada por um perfil de configuração, o iPad pode ativar a 
VPN automaticamente sempre que necessário. Para obter mais informações, consulte 
“Utilização de Perfis de Configuração” na página 188 ou contate seu administrador.190 Apêndice A    O iPad na Empresa
Contas LDAP e CardDAV
Quando você configura uma conta LDAP, você pode visualizar e buscar contatos no 
servidor LDAP de sua empresa ou organização. O servidor aparece como um novo 
grupo de Contatos. Como os contatos LDAP não são transferidos para o iPad, você precisará ter uma conexão à Internet para visualizá-los. Consulte seu administrador para 
obter os ajustes e os outros requisitos da conta (como VPN).
Ao configurar uma conta CardDAV, os contatos da sua conta são sincronizados com o 
iPad através da tecnologia over the air. Você também pode buscar contatos do servidor CardDAV da sua organização ou empresa.
Para configurar uma conta LDAP ou CardDAV: 
1 Em Ajustes, toque em “Mail, Contatos, Calendários” e toque em Adicionar Conta.
2 Toque em Outros e, em seguida, toque em Adicionar Conta LDAP ou adicionar conta 
CardDAV.
3 Digite as informações da sua conta LDAP e toque em Seguinte para verificá-la.
4 Toque em Salvar.191
O Teclados Internacionais permitem digitar o texto em vários idiomas diferentes, incluindo idiomas asiáticos e outros idiomas que são escritos da direita para a esquerda. 
Como adicionar teclados
Para digitar texto em idiomas diferentes no iPad, você utiliza teclados diferentes. Por 
padrão, somente o teclado para o idioma que você definiu está disponível. Para tornar 
os teclados para outros idiomas disponíveis, use os ajustes de Teclado.
Para adicionar um teclado: 
1 Em Ajustes, escolha Geral > Teclado > Teclados Internacionais.
O número antes da flecha indica o número de teclados atualmente ativados.
2 Toque em Adicionar Novo Teclado e, em seguida, selecione um teclado da lista.
Repita o processo para adicionar mais teclados. Alguns idiomas possuem diversos teclados disponíveis.
Para obter uma lista dos teclados compatíveis com o iPad, visite o site 
www.apple.com/br/ipad/specs.
Para editar sua lista de teclados:Selecione Geral > Teclado > Teclados Internacionais e, 
em seguida, toque em Editar e execute uma das seguintes ações:
Â Para apagar um teclado, toque no  e, em seguida, toque em Apagar.
Â Para reordenar a lista, arraste  ao lado de um teclado para um novo lugar da lista.
Como alternar teclados
Para digitar texto em um idioma diferente, alterne os teclados.
Para alternar teclados ao digitar:Toque  . Ao tocar no símbolo, o nome do teclado 
ativado mais recentemente aparece rapidamente.
Também é possível tocar e manter pressionada  para exibir uma lista de teclados disponíveis. Para selecionar um teclado da lista, deslize seu dedo para o nome do teclado 
e, em seguida, solte.
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Muitos teclados fornecem letras, números e símbolos não visíveis no teclado.
Para digitar letras, números ou símbolos que não estão no teclado:Toque e mantenha pressionada a letra, número ou símbolo relacionado, depois deslize o seu dedo 
para escolher uma variação. Nos teclados em tailandês, por exemplo, você pode 
escolher os números nativos tocando e mantendo pressionado o número arábico 
relacionado.
Chinês
Você pode usar os teclados para digitar em chinês em vários formas diferentes, incluindo Pinyin, Cangjie, Wubi Hua e Zhuyin. Você também pode utilizar o seu dedo para 
escrever caracteres em chinês na tela.
Como digitar em Chinês Pinyin Simplificado ou Tradicional
Use o teclado QWERTY para digitar Pinyin para caracteres em chinês. Conforme você 
digita, aparecem caracteres sugeridos em chinês. Toque em uma sugestão para selecioná-la ou continue digitando em Pinyin para ver mais opções.
Se você continuar digitando o Pinyin sem espaços, aparecem sugestões de frases.
Como digitar em Chinês Cangjie
Use o teclado para construir caracteres chineses a partir das teclas Cangjie componentes. Conforme você digita, aparecem caracteres sugeridos em chinês. Toque um caractere para selecioná-lo ou continue digitando até um total de cinco componentes para 
ver mais opções de caracteres.
Como digitar com Traço de Chinês Simplificado (Wubi Hua)
Use o teclado para construir caracteres chineses usando até cinco traços na sequência 
de escrita correta: da esquerda para a direita, de cima para baixo, de fora para dentro e 
de dentro para um traço de fechamento [por exemplo, o caractere chinês ? (círculo) 
deve começar com o traço vertical ?].
Conforme digita, os caracteres chineses sugeridos aparecem (os caracteres mais comumente utilizados aparecem primeiro). Toque em um caractere para selecioná-lo. 
Se não souber qual é o traço correto, digite um asterisco (*). Para ver mais opções de 
caracteres, digite outro traço ou role pela lista de caracteres.
Toque na tecla ?? correspondente para exibir apenas os caracteres que coincidem 
exatamente com o que você digitou. Por exemplo, se digitar ?? (um um) e tocar ?
? correspondente, o mais comumente usado ? (dois) aparece como a combinação 
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Como digitar em Chinês Tradicional Zhuyin
Utilize o teclado para digitar as letras Zhuyin. Conforme você digita, aparecem caracteres sugeridos em chinês. Toque em uma sugestão para selecioná-la ou continue digitando letras Zhuyin para ver mais opções. Depois de digitar uma letra inicial, o teclado 
é alterado para mostrar mais letras.
Se você continuar digitando em Zhuyin sem espaços, aparecem sugestões de frases.
Como digitar escrita manual em chinês simplificado ou tradicional
Escreva caracteres em Chinês diretamente na tela com o dedo. Conforme você escreve 
os traços, o iPad os reconhece e mostra caracteres coincidentes em uma lista, com o 
mais parecidos em primeiro. Ao escolher um caractere, é provável que caracteres seguintes relacionados apareçam na lista como escolhas adicionais.
Você pode obter alguns caracteres complexos escrevendo dois ou mais caracteres 
componentes. Por exemplo, se você inserir o caractere ? (peixe) e depois inserir o 
caractere ? (pelo), o caractere ? (nome parcial do Aeroporto Internacional de Hong 
Kong) aparecerá na lista de caracteres com uma seta ao lado. Toque no caractere para 
substituir os caracteres inseridos.
Com a escrita à mão em chinês simplificado, os caracteres romanos também são 
reconhecidos.
Como converter entre Chinês Simplificado e Tradicional
Selecione o caractere ou caracteres que deseja converter e, em seguida, toque em 
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Como desenhar os caracteres em chinês
Quando os formatos manuscritos de chinês tradicional ou simplificado estão ativados, 
você pode digitar caracteres em chinês com o dedo, conforme mostrado:
Touchpad
Japonês
Você pode digitar em japonês usando o teclado Romaji ou o teclado Fifty Key.
Como digitar Romaji japonês
Utilize o teclado Romaji para digitar sílabas. Opções alternativas aparecem na parte 
superior do teclado; toque em uma para digitá-la.
Como digitar Fifty Key japonês
Use o teclado Fifty Key para introduzir código para sílabas em Japonês. Conforme você 
vai digitando, aparecem sugestões de sílabas. Toque na sílaba para selecioná-la.
Coreano
Use o teclado coreano 2-Set para digitar letras Hangul. Para digitar consoantes duplas 
ou vogais compostas, toque e mantenha pressionada a letra e depois deslize para escolher a letra dupla.Apêndice B    Teclados Internacionais 195
Vietnamita
Toque e mantenha pressionado um caractere para ver os pontos diacríticos disponíveis 
e, em seguida, deslize para selecionar o que deseja.
Você pode também digitar as seguintes sequências de teclas para inserir caracteres 
com pontos diacríticos:
Â aa—â (a circunflexo)
Â aw—a (a com haCek)
Â ee—ê (e circunflexo)
Â oo—ô (o circunflexo)
Â ow—o (o com gancho)
Â w—u (u com gancho)
Â dd—d (d com traço)
Â as—á (a agudo)
Â af—à (a craseado)
Â ar—? (a com ponto de interrogação)
Â ax—ã (a com til)
Â aj—? (a com ponto inferior)
Como criar dicionários
Ao usar certos teclados chineses ou japoneses, você pode criar um dicionários de palavras e pares de entrada. Quando você digita uma palavra do dicionário enquanto usa 
um teclado compatível, a entrada associada é substituída pela palavra. O dicionário 
está disponível para os seguintes teclados:
Â Chinês - Simplificado (Pinyin)
Â Chinês - Tradicional (Pinyin)
Â Chinês - Tradicional (Zhuyin)
Â Japonês (Romaji)
Â Japonês (T50 Key)
Para adicionar uma palavra ao dicionário: Em Ajustes, escolha Geral > Teclado > 
Editar Dicionários. Toque no  , toque no campo Palavra e insira a palavra e, em seguida, toque no campo Yomi, Pinyin ou Zhuyin e insira a entrada.
Você pode ter várias entradas para cada palavra, dependendo dos teclados que estiverem ativados.
Para apagar uma palavra do dicionário: Toque na palavra na lista Dicionário do 
Usuário e, em seguida, toque em Apagar Palavra.196
Dicas e Solução de Problemas
Site de suporte da Apple para o iPad
Abrangentes informações de suporte on-line estão disponíveis no site www.apple.
com/br/support/ipad. Você também pode usar a Linha Expressa para obter suporte 
personalizado (não disponível em todos os países). Consulte expresslane.apple.com/br.  
Se aparecer a imagem de bateria baixa ou a mensagem “Não está 
carregando”
iPad tem pouca bateria e necessita ser carregado por até dez minutos antes de você 
poder usá-lo.Para obter informações sobre como carregar o iPad, consulte “Como 
Carregar a Bateria” na página 35.
ou
Â Ao carregar, certifique-se que esteja usando o adaptador de alimentação USB de 
10 W que acompanha o seu iPad ou a porta USB em um Mac recente. A forma mais 
rápida de carregar é usando o adaptador de alimentação. Consulte “Como Carregar 
a Bateria” na página 35.
Â Para carregar mais depressa, desligue o iPad.
Â O iPad pode não carregar se estiver conectado à porta USB de um Mac mais antigo, 
um PC, um teclado ou um hub USB.
Se o seu Mac ou PC não fornecerem energia suficiente para carregar o seu iPad, 
uma mensagem Não está carregando aparecerá na barra de estado. Para carregar o 
iPad, desconecte-o do seu computador e conecte-o em uma tomada usando o Cabo 
Conector Dock para USB e o Adaptador de Alimentação USB de 10W.
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Se o iPad não responde
Â O iPad pode ter pouca bateria. Conecte o iPad ao adaptador de alimentação USB de 
10 W para carregar. Consulte “Como Carregar a Bateria” na página 35.
Â Mantenha o botão Repouso/Despertar pressionado por alguns segundos até que 
um controle deslizante vermelho apareça e, em seguida, mantenha o botão Início 
pressionado até que o aplicativo que você estava usando encerre.
Â Se isso não funcionar, desligue o iPad e volte a ligá-lo. Mantenha pressionado o 
botão Repousar/Despertar até que o controle deslizante vermelho apareça, depois 
arraste o controle. Depois mantenha pressionado o botão Repouso/Despertar até 
que o logotipo da Apple apareça.
Â Se isso não funcionar, reinicie o iPad. Mantenha pressionados os botões Repouso/
Despertar e Início  por pelo menos dez segundos até que apareça o logotipo da 
Apple.
Â Se a tela não girar quando você virar o iPad, segure o iPad na posição vertical e 
certifique-se de que o bloqueio de rotação da tela não esteja ativado.
A mensagem “Este acessório não é compatível com o iPad"aparece
O acessório conectado talvez não funcione com o iPad. Certifique-se de que o Cabo de 
Conector Dock a USB está livre de detritos e consulte a documentação fornecida com 
o acessório.
Se a tela Conectar-ao-iTunes aparecer
Para usar o iPad, primeiro você precisa configurá-lo no iTunes. Conecte o iPad ao seu 
computador, abra o iTunes se não abrir automaticamente e depois siga as instruções 
na tela.
Se um aplicativo aparecer muito pequeno
Muitos aplicativos para o iPhone e iPod touch podem ser usados com o iPad, mas 
talvez não utilizem a tela grande. Neste caso, toque no  para ampliar o aplicativo. 
Toque no  para retornar ao tamanho original.
Consulte a App Store para ver se há uma versão do aplicativo otimizada para iPad ou 
uma versão universal otimizada para iPhone, iPod touch e iPad.
Se o teclado não aparecer na tela
Se o iPad estiver emparelhado com um teclado Bluetooth, o teclado na tela não aparece. Para fazer que o teclado na tela apareça, pressione a tecla Ejetar em um teclado 
Bluetooth. Você também pode fazer que apareça o teclado na tela movendo o teclado 
Bluetooth para fora do alcance ou desligando-o.198 Apêndice C    Dicas e Solução de Problemas
iTunes e Sincronização
Se o iPad não aparecer ou a sincronização não funcionar 
Se o iPad não aparecer no iTunes no seu computador ou não for capaz de sincronizar 
conteúdo, calendários ou favoritos, tente o seguinte:
Â Recarregue a bateria se o iPad estiver com pouca força. Consulte “Como Carregar a 
Bateria” na página 35.
Â Desconecte outros dispositivos USB do seu computador e conecte o iPad a uma 
porta USB 2.0 diferente no seu computador (que não seja no teclado ou hub USB).
Â Desbloqueie o iPad se estiver bloqueado com uma senha.
Â Reinicie seu computador e reconecte o iPad ao seu computador.
Â Reinicie o iPad.
Â Transfira e instale (ou reinstale) a última versão do iTunes de www.apple.com/br/
itunes.
Â Para contas push, certifique-se de que o iPad possua uma conexão à Internet. 
Consulte “Como Conectar-se à Internet” na página 30.
Backup do iPad
Backup do
O iTunes cria um backup de ajustes, dados de aplicativos e outras informações no iPad 
quando você:  
Â Sincroniza o iPad com o iTunes no seu computador 
Â Atualiza o iPad usando o iTunes
Â Restaura o iPad usando o iTunes, se você escolheu fazer backup quando perguntado
Você pode restaurar as informações de backup no iPad depois de atualizar ou restaurar o software do iPad ou pode usar um backup para copiar suas informações atuais 
do iPad para outro iPad. Consulte “Como atualizar e restaurar o software do iPad” na 
página 199.
Os backups não incluem itens sincronizados, tais como músicas e vídeos da sua biblioteca do iTunes ou informações tais como contatos ou calendários do seu computador. 
Para restaurar itens sincronizados, você deve sincronizar o iPad depois de restaurar as 
informações de backup. Se o iPad estiver ajustado para sincronizar automaticamente, 
os itens sincronizados são restaurados imediatamente depois de uma restauração ou 
atualização de software. Consulte “Como Sincronizar com o iTunes” na página 25.
Aplicativos da App Store são incluídos no primeiro backup depois que os aplicativos 
são transferidos. Os backups subsequentes incluem apenas os dados dos aplicativos.
Para maior segurança, você pode ajustar o iTunes para criptografar seus backups.Apêndice C    Dicas e Solução de Problemas 199
Para criptografar backups do iPad:
1 Conecte o iPad ao seu computador. 
2 No iTunes, selecione iPad na barra lateral.
3 No painel Resumo, selecione “Criptografar backups.”
4 Selecione uma senha e depois clique em Definir Senha.
Se o backup for criptografado, você precisará digitar sua senha antes de restaurar sua 
informação de backup para o iPad. Backups criptografados são exibidos com um ícone 
de cadeado  na lista de backups do painel Dispositivos das preferências do iTunes
Como Remover um Backup
Você pode remover o backup de um iPad da lista de backups no iTunes. Você pode desejar fazer isto, por exemplo, se um backup foi criado no computador de outra pessoa.
Para remover um backup:
1 No iTunes, abra as Preferências do iTunes.
Â Mac:  Escolha iTunes > Preferências.
Â Windows:  Escolha Editar > Preferências.
2 Clique em Dispositivos (o iPad não precisa estar conectado).
3 Selecione o backup que deseja remover e clique em Apagar Backup.
4 Clique em Apagar Backup para confirmar seu desejo de remover o backup 
selecionado.
5 Clique em OK.
Como atualizar e restaurar o software do iPad
Sobre a Atualização e Restauração do Software
Você pode usar o iTunes para atualizar ou restaurar o software do iPad.
Â Se você atualizar, o software do iPad será atualizado. Seus aplicativos transferidos, 
ajustes e dados não são afetados.
Nota: Em alguns casos, uma atualização inclui também a restauração do iPad.
Â Se você restaurar, a última versão do software do iPad é reinstalada, os ajustes são 
restaurados aos valores padrão e os dados armazenados no iPad são apagados, 
incluindo aplicativos, músicas, vídeos, contatos, fotos, informações de calendário 
e quaisquer outros dados. Se você tiver feito o backup do iPad com o iTunes no 
seu computador, poderá restaurar os dados do backup no final do processo de 
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Os dados apagados não estarão mais acessíveis através da interface de usuário do 
iPad, mas não serão apagados do seu iPad. Para obter informações sobre como eliminar todo o conteúdo e ajustes, consulte “Como redefinir o iPad” na página 178.
Se você utiliza um headset Bluetooth ou um teclado com o iPad e restaurou os ajustes, 
você deve emparelhar o dispositivo Bluetooth com o iPad novamente para usá-lo.
Para obter mais informações sobre atualização e restauração do software do iPad, visite o site support.apple.com/kb/HT1414.
Atualização do iPad
Certifique-se de que seu computador possui uma conexão à Internet e de que você 
instalou a última versão do iTunes do site www.apple.com/br/itunes.
Para atualizar o iPad:
1 Conecte o iPad ao seu computador. 
2 Selecione iPad na barra lateral do iTunes e depois clique na aba Resumo.
3 Clique em “Verificar Atualizações”. O iTunes dirá se há disponível uma nova versão do 
software do iPad.
4 Clique em Atualizar para instalar a última versão do software. 
Restauração do iPad
Certifique-se de que seu computador possui uma conexão à Internet e de que você 
instalou a última versão do iTunes do site www.apple.com/br/itunes.
Para restaurar o iPad:
1 Conecte o iPad ao seu computador. 
2 Selecione iPad na barra lateral do iTunes e depois clique na aba Resumo.
3 Clique em “Verificar Atualizações”. O iTunes dirá se há disponível uma nova versão do 
software do iPad.
4 Clique em Restaurar. Siga as instruções on-line para completar o processo de restauração. Ao restaurar, é recomendado que você realize o backup do iPad quando for 
solicitado.
Quando o software do iPad foi restaurado, você pode escolher configurar o iPad como 
um novo iPad ou restaurar sua música vídeo, dados do aplicativo e outros conteúdos 
de um backup.
Depois de restaurar de um backup, os dados anteriores já não estarão acessíveis através da interface de usuário do iPad, mas não serão eliminados do seu iPad. Para obter 
informações sobre como eliminar todo o conteúdo e ajustes, consulte “Como redefinir 
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Como Restaurar de um Backup
Você pode restaurar os ajustes, dados de aplicativo e outras informações a partir de 
um backup, ou usar este recurso para copiar estes itens a outro iPad. Certifique-se de 
que seu computador possui uma conexão à Internet e de que você instalou a última 
versão do iTunes de www.apple.com/br/itunes.
Importante: Restaurar de um backup não é o mesmo que restaurar o iPad do painel 
Resumo no iTunes. Restaurar de um backup não restaura completamente o software 
do iPad. Além disso, a restauração do iPad a partir de um backup restaura todos os dados do backup, incluindo dados de aplicativos. Se você escolher um backup antigo, a 
restauração poderia substituir os dados de aplicativos por dados não atualizados. Para 
obter mais informações, consulte “Como redefinir o iPad” na página 178. 
Para restaurar o iPad de um backup:
1 Conecte o iPad ao computador com o qual você normalmente sincroniza
2 No iTunes, mantenha a tecla Controle pressionada e clique em iPad na barra lateral, 
depois escolha “Restaurar do Backup” no menu que aparece.
3 Escolha o backup que você deseja restaurar no menu local e, em seguida, clique em 
Restaurar.
Se o backup estiver criptografado, você terá de digitar sua senha.
Depois de restaurar de um backup, os dados anteriores já não estarão acessíveis através da interface de usuário do iPad, mas não serão eliminados do seu iPad. Para obter 
informações sobre como eliminar todo o conteúdo e ajustes, consulte “Como redefinir 
o iPad” na página 178.
Safari, Mail e Contatos
Não é possível enviar e-mails
Se o iPad não estiver conseguindo enviar e-mails, tente fazer o seguinte:
Â Nos Ajustes, escolha “Mail, Contatos, Calendários” e depois selecione a conta que 
você está tentando utilizar. Toque em Dados da Conta; em seguida, toque em SMTP 
sob Servidor de Correio de Saída. Você pode configurar outros servidores SMTP ou 
selecionar um de outra conta de correio no iPad. Entre em contato com seu provedor de serviços de Internet para obter as informações de configuração.
Â Em vez de sincronizá-la do iTunes, configure sua conta de e-mail diretamente no 
iPad. Nos Ajustes, escolha “Mail, Contatos, Calendários”, toque em Adicionar Conta 
e digite as informações de sua conta. Se o iPad não conseguir localizar os ajustes 
do seu provedor de serviços quando você digitar o endereço de e-mail, vá para 
support.apple.com/kb/HT1277 para obter ajuda na configuração da sua conta.202 Apêndice C    Dicas e Solução de Problemas
Â Desligue o iPad e volte a ligá-lo. Mantenha pressionado o botão Repousar/Despertar 
por alguns segundos até que apareça um controle deslizante vermelho, depois arraste o controle. Depois mantenha pressionado o botão Repouso/Despertar até que 
o logotipo da Apple apareça.
Para outras informações sobre a resolução de problemas, visite o site www.apple.com/
br/support/ipad. Se você ainda não estiver conseguindo enviar e-mails, pode usar a 
Linha Expressa (não disponível em todos os países). Vá para expresslane.apple.com/br.
Não é possível receber e-mails
Se o iPad não puder receber e-mails, tente o seguinte:
Â Se você usa um ou mais computadores para verificar a mesma conta de e-mail, 
pode ter sido criado um bloqueio. Para obter mais informações, visite o site support.
apple.com/kb/TS2621.
Â Em vez de sincronizá-la do iTunes, configure sua conta de e-mail diretamente no 
iPad. Em Ajustes, escolha “Mail, Contatos, Calendários,” toque em Adicionar Conta e 
depois digite as informações de sua conta. Se o iPad não conseguir localizar os ajustes do seu provedor de serviços quando você digitar o endereço de e-mail, vá para 
support.apple.com/kb/HT1277 para obter ajuda na configuração da sua conta.
Â Desligue o iPad e volte a ligá-lo. Mantenha pressionado o botão Repousar/Despertar 
por alguns segundos até que apareça um controle deslizante vermelho, depois arraste o controle. Depois mantenha pressionado o botão Repouso/Despertar até que 
o logotipo da Apple apareça.
Â Se o seu iPad Wi-Fi + 3G usa uma rede de dados de celular, desligue o Wi-Fi para 
que o iPad se conecte à Internet através da rede de dados de celular. Nos Ajustes, 
escolha Wi-Fi e desative a opção Wi-Fi.  
Para outras informações sobre a resolução de problemas, visite o site www.apple.com/
br/support/ipad. Se você ainda não estiver conseguindo enviar e-mails, pode usar a 
Linha Expressa (não disponível em todos os países). Vá para expresslane.apple.com/br.
Se os anexos do e-mail não abrirem
O iPad pode não ser compatível com o tipo de arquivo anexado. O iPad é compatível 
com os seguintes tipos de anexos de e-mail:
.doc Microsoft Word
.docx Microsoft Word (XML)
.htm página web
.html página web
.ics Item Calendário
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.numbers Numbers
.pages Pages
.pdf Pré-Visualização, Adobe Acrobat
.ppt Microsoft PowerPoint
.pptx Microsoft PowerPoint (XML)
.rtf Formato RTF
.txt texto
.vcf informações de contato
.xls Microsoft Excel
.xlsx Microsoft Excel (XML)
Som, Música e Vídeo
Não Há Nenhum Som
Â Certifique-se de que o alto-falante do iPad não esteja coberto.
Â Certifique-se de que o Interruptor Lateral não está na posição silêncio. Consulte 
“Botões de Volume” na página 11.
Â Se você não estiver usando um fone de ouvido, desconecte-o e, em seguida, conecte-o novamente. Certifique-se de que o conector esteja totalmente encaixado.
Â Certifique-se que o volume não esteja no mínimo.
Â A música do iPad pode estar pausada. Se você estiver usando um headset com botão de reprodução, tente pressionar o botão para retomar a reprodução. Ou, na tela 
Início, toque em iPod e depois toque no  .
Â Verifique se há um limite de volume definido. Na tela de Início, escolha Ajustes > 
iPod > Limite de Volume. Para obter mais informações, consulte “iPod” na página 184.
Â Se você estiver usando a porta de saída de linha no Dock opcional do iPad, certifique-se de ligar o aparelho de som ou alto-falantes externos e de que estejam conectados e funcionando apropriadamente. Use os controles do volume do aparelho 
de som ou alto-falantes externos, não os do iPad.
Â Se você estiver usando um aplicativo que funciona com o AirPlay, verifique se o 
dispositivo AirPlay para o qual você está enviando o som está ligado e o volume 
ativado. Se você quiser ouvir som através do alto-falante do iPad, toque em  e 
selecione-o da lista.
Se músicas, vídeos ou outros itens não puderem ser reproduzidos
A música, vídeo, audiolivro ou podcast podem estar codificados em um formato não 
compatível com o iPad. Para obter informações sobre os formatos de arquivo de áudio 
e vídeo compatíveis com o iPad, visite o site www.apple.com/br/ipad/specs.204 Apêndice C    Dicas e Solução de Problemas
Se uma música ou vídeo na biblioteca do seu iTunes não é compatível com o iPad, 
talvez você possa convertê-la a um formato compatível com o iPad. Por exemplo, você 
pode usar o iTunes para Windows para converter arquivos WMA não protegidos para 
um formato compatível com o iPad. Para obter mais informações, abra o iTunes e escolha Ajuda > Ajuda iTunes.
Sem vídeo ou som ao utilizar o AirPlay
Para enviar vídeo ou áudio para um dispositivo AirPlay como um Apple TV, o iPad e o 
dispositivo AirPlay devem estar conectados à mesma rede sem fio. Se você não vir o 
botão  , significa que o iPad não está conectado à mesma rede Wi-Fi que o dispositivo AirPlay, ou que o aplicativo que você está usando não é compatível com o AirPlay.
Â Quando som ou vídeo está sendo enviado para um dispositivo AirPlay, o iPad não 
exibe o vídeo ou a reproduz o áudio. Para direcionar o conteúdo para iPad e desconectar o iPad do dispositivo AirPlay, toque no  e selecione o seu iPad da lista.
Â Alguns aplicativos reproduzem áudio somente através do AirPlay. Se o vídeo não 
estiver funcionando, certifique-se de que o aplicativo que você está usando é compatível com ambos, áudio e vídeo.
Â Se o Apple TV foi configurado para necessitar um código, você deve inseri-lo no 
iPad quando solicitado, para poder usar o AirPlay.
Â Certifique-se de que os alto-falantes no dispositivo AirPlay estão ligados e ativados. 
Se você estiver usando um Apple TV, certifique-se de que a origem de entrada da TV 
está definida para Apple TV. Certifique-se de que o controle de volume no iPad está 
ativado.
Â Quando o iPad está transmitindo com o AirPlay, ele deve permanecer conectado à 
rede Wi-Fi. Se você retirar o iPad do intervalo, a reprodução é interrompida.
Â Dependendo da velocidade da sua rede, pode levar 30 segundos ou mais para que 
a reprodução seja iniciada durante a utilização do AirPlay.
Para obter informações sobre o AirPlay, visite o site support.apple.com/kb/
HT4437?viewlocale=pt_BR.
Sem imagem no televisor ou no projetor conectado ao iPad
Quando você conecta o iPad a um televisor ou projetor, o monitor anexado reflete automaticamente a tela do iPad. Alguns aplicativos podem ser compatíveis com o uso do 
monitor anexado como um monitor secundário. Verifique os ajustes e a documentação 
do aplicativo.
Â Abra Ajustes > Vídeo e certifique-se de que os ajustes estejam corretos para sua TV 
ou projetor. Para visualizar vídeos HD em alta resolução, você deve usar um cabo de 
vídeo por componentes ou o Adaptador AV Digital da Apple.
Â Certifique-se que o cabo de vídeo esteja firmemente conectado em ambas extremidades e que seja um cabo compatível. Se o iPad estiver conectado a uma caixa de 
alternagem A/V ou receptor, tente conectá-lo diretamente ao televisor ou projetor.Apêndice C    Dicas e Solução de Problemas 205
Â Certifique-se de que o seu televisor possui a entrada de vídeo correta selecionada, 
como HDMI ou componente de vídeo.
Â Se não aparecer vídeo, pressione o botão Início e desconecte e reconecte o cabo e 
tente novamente.
FaceTime
Se não for possível fazer ou receber ligações do FaceTime
Para usar o FaceTime, você deve ativá-lo com o seu ID da Apple. Consulte 
Capítulo 7,“FaceTime,” na página 68.
Â Certifique-se de que a pessoa que está ligando para você está usando um endere-
ço de e-mail associado ao FaceTime. Normalmente este é o seu ID da Apple, mas 
você pode adicionar outros endereços também. Consulte “Para iniciar a sessão no 
FaceTime:” na página 69.
Â Para usar o FaceTime, o iPad deve estar conectado à Internet via Wi-Fi.
Â Quando você fizer uma ligação do FaceTime, dê tempo suficiente para que a conexão seja estabelecida, o que pode resultar em vários toques.
Como melhorar a qualidade do FaceTime
Para obter os melhores resultados com o FaceTime, experimente estas dicas:
Â Se o vídeo parecer de má qualidade ou lento, certifique-se de que tanto você como 
a pessoa para qual você está ligando estejam conectados à rede Wi-Fi mais rápida 
disponível.
Â Se a sua imagem estiver granulada, significa que a câmera necessita de mais luz. Se 
a imagem de entrada estiver granulada, peça ao interlocutor para ajustar a ilumina-
ção dele.
Â A sua imagem não caberá na tela inteira se você mantiver o iPad na orientação 
horizontal. A pessoa com a qual você está conversando talvez necessite girar o seu 
dispositivo para enviar a você uma imagem maior.
iTunes Store e App Store
As lojas iTunes ou App Store não estão Disponíveis
Para usar a iTunes Store ou a App Store, o iPad deve possuir uma conexão à Internet. 
Consulte “Como Conectar-se à Internet” na página 30.
Para comprar conteúdo da iTunes Store ou da App Store, você precisa de um ID Apple. 
Você pode configurar um ID Apple no iPad. A partir da tela de Início, escolha Ajustes > 
Loja > Criar Novo ID Apple. Consulte “Loja” na página 187. 206 Apêndice C    Dicas e Solução de Problemas
Você também pode configurar uma conta no seu computador abrindo o iTunes e selecionando Loja > Criar Conta.
Nota: A iTunes Store e a App Store não estão disponíveis em alguns países.
Como reiniciar e redefinir o iPad
Se algo não estiver funcionando bem, tente reiniciar o iPad, forçando o encerramento 
de um aplicativo ou redefinindo-o iPad.
Para reiniciar o iPad: Mantenha o botão Repousar/Despertar pressionado até que o 
controle deslizante vermelho apareça. Deslize o seu dedo pelo controle para desligar o 
iPad. Para ligar novamente o iPad mantenha pressionado o botão Repousar/Despertar 
até que o logotipo da Apple apareça.
Para forçar o encerramento de um aplicativo: Mantenha o botão Repouso/Despertar 
que fica na parte superior do iPad pressionado por alguns segundos até que um controle deslizante vermelho apareça e, em seguida, mantenha o botão Início pressionado 
até que o aplicativo encerre.
Se você não conseguir desligar o iPad ou se o problema persistir, talvez seja necessário 
redefinir o iPad. A redefinição só deve ser feita se desligar e ligar novamente o iPad 
não tenha solucionado o problema.
Para redefinir o iPad:Mantenha o botão Repousar/Despertar e Início pressionados ao 
mesmo tempo por 10 segundos, no mínimo, até que o logotipo Apple apareça.
Se o iPad não responder mesmo depois de ser reiniciado
Â Redefina os ajustes do iPad. Na tela de Início, escolha Ajustes > Geral > Redefinir > 
Redefinir Todos os Ajustes. Todas as suas configurações são redefinidas, mas não é 
apagado nenhum dado ou mídia.
Â Se isso não funcionar, apague todo o conteúdo do iPad. Consulte “Como redefinir o 
iPad” na página 178.
Â Se isso não funcionar, restaure o software do iPad. Consulte “Como Remover um 
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Informações Sobre Segurança, Serviços e Softwares
A seguinte tabela descreve onde obter mais informações sobre segurança, software e 
serviços relacionados ao iPad.
Para obter informações sobre Faça o seguinte
Como usar o iPad com segurança Consulte o Manual de Informações Importantes do 
Produto iPad  no site support.apple.com/pt_BR/
manuals/ipad para obter as últimas informações 
sobre segurança e normas.
iPad Serviço e suporte, dicas, fóruns e transferências de software da Apple
Visite o site www.apple.com/br/support/ipad.
As últimas informações sobre o iPad Visite o site www.apple.com/br/ipad.
Como gerenciar a sua conta ID Apple Vá para appleid.apple.com/pt_BR.
Como usar o iTunes Abra o iTunes e escolha Ajuda > Ajuda iTunes. 
Para ver o tutorial on-line do iTunes (disponível 
apenas em algumas áreas), visite www.apple.
com/br/support/itunes.
MobileMe Visite o site www.apple.com/br/mobileme.
Como usar o iPhoto no Mac OS X Abra o iPhoto e escolha Ajuda > Ajuda iPhoto.
Como usar a Agenda no Mac OS X Abra a Agenda e escolha Ajuda > Ajuda Agenda.
Como usar o iCal no Mac OS X Abra o iCal e escolha Ajuda > Ajuda iCal.
Microsoft Outlook, Catálogo de Endereços do 
Windows, Adobe Photoshop Album e Adobe 
Photoshop Elements
Consulte a documentação que acompanha estes 
aplicativos.
Como obter serviços da garantia Primeiramente siga os conselhos neste manual. Em seguida, visite o site www.apple.com/
br/support/ipad ou consulte o Manual de 
Informações Importantes do Produto iPad em 
support.apple.com/pt_BR/manuals/ipad.
Como Substituir a Bateria Visite o site www.apple.com/br/batteries/
replacements.html.
Como usar o iPad em um ambiente empresarial Visite o site www.apple.com/br/ipad/business.
Informações sobre descarte e reciclagem
O seu iPad deve ser eliminado de acordo com as leis e normas locais que regem a 
eliminação de detritos tóxicos. Porque contém uma bateria, o iPad deve ser eliminado 
separadamente do lixo doméstico. Quando o seu iPad atingir o final do seu ciclo de 
vida, contate a Apple ou as autoridades locais para obter informações sobre as opções 
de reciclagem.
Para obter informações sobre o programa de reciclagem da Apple, visite o site: 
www.apple.com/br/recycling.208 Apêndice C    Dicas e Solução de Problemas
A Apple e o meio ambiente
Na Apple, reconhecimentos nossa responsabilidade em minimizar os impactos ambientais de nossas operações e produtos. Para obter mais informações, visite o site 
www.apple.com/br/environment.K Apple Inc.
© 2011 Apple Inc. Todos os direitos reservados.
Apple, o logotipo da Apple, AirPlay, AirPort, AirPort 
Express, AirPort Extreme, Aperture, Apple TV, FaceTime, 
Finder, iBooks, iCal, iPhone, iPhoto, iPod, iPod touch, iTunes, Keynote, Mac, Macintosh, Mac OS, Numbers, Pages, 
Photo Booth, Safari e Spotlight são marcas comerciais 
da Apple Inc., registradas nos EUA e em outros países.
AirPrint, iPad, Multi-Touch e Shuffle são marcas comerciais da Apple Inc.
Apple, Apple Store, iDisk e iTunes Store são marcas de 
serviço da Apple Inc., registradas nos EUA e em outros 
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App Store, iBookstore e MobileMe são marcas de serviço 
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registradas da Adobe Systems Incorporated nos EUA e/
ou outros países.
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IOS é uma marca comercial ou registrada da Cisco nos 
EUA e em outros países e é utilizada sob licença.
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Disponível no iTunes. A disponibilidade to título está 
sujeita a alterações. Airplane! © 1992 Paramount Pictures. 
Todos os direitos reservados. Back to the Future (De Volta 
ao Futuro)© 1985 Universal Studios. Todos os direitos 
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sejam precisas. A Apple não se responsabiliza pelos erros de impressão ou administrativos.
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Finder Dock
MagSafe 2 USB 3
USB 3 Thunderbolt
Premiers pas
La première fois que vous démarrez votre MacBook Air, Assistant réglages vous 
aide à vous lancer. Il vous suffit de suivre quelques étapes simples pour vous 
connecter rapidement à votre réseau Wi-Fi, transférer vos données à partir d’un 
autre Mac ou d’un PC, et créer un compte utilisateur pour votre Mac.
Vous pouvez également vous connecter avec votre identifiant Apple, afin de 
pouvoir télécharger des apps dans l’App Store, effectuer des achats dans 
l’iTunes Store et l’Apple Store en ligne, accéder à iCloud et passer des appels 
vidéo grâce à FaceTime. Si vous ne possédez pas d’identifiant Apple, créez-en 
un facilement et gratuitement.
Gestes Multi-Touch
Vous pouvez réaliser un grand nombre d’actions sur votre MacBook Air à 
l’aide de gestes simples sur le trackpad. Voici quelques-uns des plus utilisés.
Le bureau
Le bureau est l’endroit où vous pouvez tout trouver et tout faire sur votre 
Mac. Le Dock, situé en bas de l’écran, est un endroit pratique où garder les 
apps que vous utilisez le plus. Il vous permet également d’ouvrir les 
Préférences Système, grâce auxquelles vous pouvez personnaliser votre 
bureau et d’autres réglages sur votre Mac. Cliquez sur l’icône du Finder pour 
accéder rapidement à la totalité de vos fichiers et dossiers. La barre des 
menus, située en haut de l’écran, propose des informations utiles concernant 
votre Mac. Pour vérifier l’état de votre connexion Internet sans fil, cliquez sur 
l’icône du Wi-Fi. Votre Mac se connecte automatiquement au réseau choisi 
pendant la configuration.
Bonjour.
Trackpad 
Multi-Touch
Connecteur 
d’alimentation 
MagSafe 2
Adaptateur 
secteur
Cordon 
d’alimentation 
secteur
Bouton 
d’alimentation
iCloud
iCloud stocke votre musique, vos photos, votre courrier électronique, etc. et 
les pousse sans fil vers vos Mac, iPad, iPhone, iPod touch et même votre PC. 
Le tout sans station d’accueil ni synchronisation. Lorsque vous achetez un 
morceau sur un appareil, il est automatiquement téléchargé sur tous vos 
autres appareils. Grâce à Flux de photos, vos photos les plus récentes 
apparaissent partout où vous le souhaitez. Pour personnaliser vos réglages 
iCloud, ouvrez le menu Pomme, choisissez Préférences Système, et cliquez sur 
iCloud. Connectez-vous à l’aide de votre identifiant Apple, puis choisissez les 
fonctionnalités iCloud que vous souhaitez utiliser.
Remarque importante
Veuillez lire attentivement ce document et les consignes de sécurité du Guide 
d’informations importantes sur le produit avant d’utiliser votre ordinateur 
pour la première fois.
En savoir plus
Obtenez des informations supplémentaires, regardez des vidéos 
de démonstration et apprenez-en plus sur les fonctionnalités du 
MacBook Air à l’adresse www.apple.com/fr/macbookair.
Aide
Vous trouverez souvent des réponses à vos questions ainsi que des 
instructions et des informations concernant le dépannage dans le Centre 
d’aide. Cliquez sur l’icône du Finder, cliquez sur Aide dans la barre des 
menus et choisissez Centre d’aide. 
Utilitaires Mac OS X
Si vous rencontrez un problème avec votre Mac, Utilitaires Mac OS X peut 
vous aider à réparer le stockage flash de votre ordinateur, restaurer les 
logiciels et les données à partir d’une copie de sauvegarde Time Machine, 
ou effacer votre stockage flash et réinstaller OS X Lion et les applications 
Apple. Safari peut également vous aider à trouver de l’aide en ligne. Votre 
Mac ouvre automatiquement Utilitaires Mac OS X s’il détecte un problème. 
Vous pouvez également l’ouvrir manuellement en redémarrant votre 
ordinateur en maintenant les touches Commande et R enfoncées. 
Assistance
Votre MacBook Air bénéficie d’une assistance technique de 90 jours et 
d’un an de couverture pour les réparations de matériel effectuées dans les 
magasins Apple Store ou les Centres de services agréés Apple. Consultez 
www.apple.com/fr/support/macbookair pour obtenir une assistance 
technique pour votre MacBook Air. Ou composez l’un des numéros suivants :  
France (Metropolitain) : +33 0 805 540 003 ; France (DOM-TOM) : +33 0 825 
770 035 ; Belgique : +32 070 700 773 ; Suisse : +41 0848 000 132.
www.apple.com/support/country
Toutes les fonctions ne sont pas disponibles dans toutes les régions.
TM et © 2012 Apple Inc. Tous droits réservés. Designed by Apple in California. Printed in XXXX.
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Prise secteur
Menu 
Aide
Barre des 
menus
Préférences 
Système
Guide de démarrage rapide
Ensuite
Déplacer des fichiers, tels des documents, courriers électroniques, photos, 
morceaux et films, d’un autre Mac ou d’un PC vers votre nouveau Mac est très 
simple. La première fois que vous démarrez votre Mac, celui-ci vous guide 
étape par étape tout au long du processus. Il vous suffit de suivre les 
instructions à l’écran.
Bienvenue sur votre nouveau MacBook Air. Laissez-nous vous montrer.
Caméra FaceTime HD
État du 
Wi-Fi 
Écouteurs
Cliquer
Appuyez n’importe où sur le trackpad pour 
cliquer. Ou alors, si vous activez Toucher pour 
cliquer, touchez simplement la surface.
Clic secondaire (clic droit)
Cliquez avec deux doigts pour ouvrir les 
menus contextuels. Ou alors, si vous activez 
Toucher pour cliquer, touchez n’importe où 
avec deux doigts.
Balayer pour naviguer
Balayez avec deux doigts pour feuilleter
des pages web, des documents, etc. 
Double-clic
Appuyez deux fois n’importe où sur le 
trackpad. Ou alors, si vous activez Toucher 
pour cliquer, touchez deux fois la surface.
Faire défiler avec deux doigts
Passez deux doigts pour faire défiler dans 
n’importe quelle direction : verticalement, 
horizontalement ou en diagonale.
Zoom intelligent
Touchez deux fois le trackpad avec deux 
doigts pour agrandir rapidement une
page web.
Pincer pour zoomer
Effectuez un zoom avant ou arrière sur 
les photos et les pages web avec plus de 
précision en pinçant avec le pouce et l’index. 
Basculer entre des apps en plein écran
Balayez avec trois doigts pour vous 
déplacer entre apps en plein écran.
Afficher le Launchpad
Pincez avec quatre doigts pour afficher 
toutes vos apps dans le Launchpad.
Faire pivoter
Faites tourner le pouce et l’index dans le sens 
des aiguilles d’une montre ou en sens inverse 
pour faire pivoter une image.
Afficher Mission Control
Balayez vers le haut avec trois doigts 
pour afficher toutes les fenêtres ouvertes 
sur votre Mac.
En savoir plus
Choisissez Préférences Système dans le menu 
Pomme et cliquez sur Trackpad pour en savoir 
plus sur les gestes. Cliquez sur l’icône située dans le 
Dock, et naviguez rapidement et 
simplement sur le Web à l’aide des 
gestes Multi-Touch. Faites défiler 
verticalement avec deux doigts sur 
le trackpad. Balayez vers la droite 
ou la gauche avec deux doigts pour 
Navigateur web Safari Mail
Top Sites
Obtenez un aperçu des 
sites que vous visitez le 
plus souvent.
Messagerie regroupée
Consultez tous vos 
comptes dans Mail,
en un clic.
Affichage Conversations
Affichez tous les messages 
d’un même échange.
Rechercher
Affinez rapidement les 
résultats de recherche pour 
trouver exactement ce que 
vous cherchez.
Mail vous permet de gérer tous vos 
comptes de messagerie à partir 
d’une seule boîte aux lettres, sans 
publicité, même lorsque vous n’êtes 
pas connecté à Internet. Mail 
fonctionne avec la plupart des 
services de messagerie standards 
(notamment POP3 et IMAP) les plus 
passer d’une page à l’autre. Touchez 
deux fois avec deux doigts pour 
agrandir une page, puis touchez deux 
fois à nouveau pour revenir à la taille 
originale. Vous pouvez également 
pincer pour agrandir ou réduire.
connus, tels que Gmail, Yahoo!, Mail 
et AOL Mail. Vous pouvez également 
utiliser Mail avec le compte de 
messagerie gratuit me.com que vous 
obtenez avec iCloud. La première 
fois que vous ouvrez Mail, Assistant 
réglages se lance pour vous aider.
Launchpad
Ouvrir le Launchpad
Cliquez sur l’icône du 
Launchpad dans le Dock.
Dossiers
Regrouper les apps en 
dossiers en les faisant 
glisser l’une sur l’autre.
Le Launchpad réunit toutes les 
applications de votre Mac. Cliquez 
simplement sur l’icône du 
Launchpad dans le Dock. Les 
fenêtres ouvertes sont remplacées 
par une vue en plein écran de toutes 
vos apps. Arrangez les apps comme 
vous le souhaitez, regroupez-les en 
dossiers ou supprimez-les de votre 
Mac. Lorsque vous téléchargez une 
app dans le Mac App Store, elle 
apparaît automatiquement dans 
le Launchpad.
Mission Control
Mission Control vous offre une vue 
d’ensemble de tout ce qui se passe 
sur votre Mac. Cliquez sur l’icône 
Mission Control dans le Dock et 
votre bureau effectue un zoom 
arrière pour afficher toutes les 
fenêtres ouvertes dans chaque 
application, toutes les apps en
plein écran et le Dashboard, le lieu 
des mini-apps appelées widgets. 
Cliquez n’importe où pour effectuer 
un zoom avant ou arrière. Imaginez 
Mission Control comme le point 
central de votre système ; voyez 
tout et allez partout d’un seul clic.
Ouvrir Mission Control
Cliquez sur l’icône Mission 
Control dans le Dock.
Ajouter des espaces de bureau
Cliquez sur le bouton + à droite 
de la rangée du haut pour ajouter 
un nouvel espace.
Dashboard
Situé en haut à 
gauche pour un 
accès facile.
Liste de lecture
Cliquez sur l’icône de lunettes 
pour enregistrer des pages à 
lire plus tard.
Mac App Store
Le Mac App Store est le meilleur 
moyen de trouver et de télécharger 
des milliers d’apps pour le Mac, 
notamment des jeux et des apps 
de réseau social et de productivité. 
Installer une nouvelle app dans le 
Launchpad ne requiert qu’une seule 
étape. Vous pouvez installer des 
apps sur chacun des Mac autorisés 
pour votre usage personnel et 
même les télécharger plusieurs fois. 
Le Mac App Store vous alerte dès 
qu’une mise à jour est disponible. 
Ainsi, vous possédez toujours la 
dernière version. Ouvrez le 
Mac App Store en cliquant sur 
son icône dans le Dock.
iTunes
Avec iTunes, vous pouvez organiser 
et lire la musique et les vidéos 
numériques sur votre Mac. Dans 
l’iTunes Store, vous pouvez 
également acheter de nouveaux 
morceaux, films, séries TV, livres, etc. 
iTunes donne également accès à 
l’App Store pour iPad, iPhone et 
iPod touch.
iTunes Store
Découvrez et achetez de 
nouveaux morceaux, films, etc.
Mix Genius
iTunes parcourt votre musique 
et regroupe les morceaux qui 
s’accordent.
iCal
Calendriers multiples
Accédez à tous vos 
calendriers en un seul 
endroit.
Gardez un oeil sur votre agenda 
grâce à iCal. Créez des calendriers 
distincts : un pour la maison, un 
autre pour l’école, un troisième pour 
le travail. Affichez calendrier par 
calendrier ou tous dans une seule 
fenêtre. Créez et envoyez des 
invitations à l’aide des informations 
de contact de Carnet d’adresses, puis 
consultez les réponses. Utilisez iCloud 
pour mettre vos calendriers à jour 
automatiquement sur tous vos 
appareils ou pour les partager avec 
d’autres utilisateurs iCloud.
iPhoto
Créer
Créez des livres,
des cartes et des 
calendriers.
Visages
iPhoto peut même 
organiser vos photos 
selon les personnes 
qui y figurent.
Événements
Cliquez deux fois sur un 
événement pour en voir 
les photos.
iPhoto est la meilleure façon 
d’organiser, de parcourir, de modifier 
et de partager vos photos sur le Mac. 
Organisez votre bibliothèque par 
visage, lieu ou événement. 
Sélectionnez une photo et cliquez 
sur Partager en bas à droite de 
l’écran pour l’envoyer par courrier 
électronique ou pour la publier sur 
Facebook. Cliquez sur Créer pour 
transformer vos photos préférées en 
livres de photos, calendriers et cartes.
iMovie
Navigateur d’événements
Les vidéos importées 
apparaissent ici pour que 
vous puissiez accéder à 
tous vos plans.
Navigateur de projets
Faites simplement glisser une 
sélection dans un projet pour 
créer un grand film.
iMovie rassemble tous vos clips 
vidéo en un seul endroit, et vous 
fournit tous les outils d’édition, 
thèmes et effets spéciaux dont vous 
avez besoin pour en faire quelque 
chose de vraiment particulier. Vous 
pouvez les transformer en quelques 
clics en films dignes d’une 
récompense ou même en bandesannonces hollywoodiennes. iMovie 
permet également d’importer des 
vidéos depuis les caméras numériques 
les plus répandues, votre iPad, iPhone 
ou iPod touch, ou la caméra FaceTime 
de votre Mac.
FaceTime
FaceTime pour Mac permet de parler 
face à face sur l’iPad, l’iPhone, 
l’iPod touch ou le Mac à partir 
de votre Mac.* La configuration 
de FaceTime ne requiert qu’un 
identifiant Apple et une adresse 
électronique. Pour commencer un 
appel vidéo, il vous suffit de cliquer 
sur un nom dans la liste de contacts 
de Carnet d’adresses.
Favoris
Ajoutez les contacts 
fréquents aux Favoris 
pour un accès facile.
*Requiert des appareils prenant en charge FaceTime pour l’appelant et l’interlocuteur. Non disponible dans toutes les régions.
Affichage du calendrier
Sélectionnez l’affichage 
que vous préférez : jour, 
semaine, mois ou année.
Affichage Plein écran
Cliquez sur le bouton Plein 
écran pour passer en mode 
plein écran.
Toujours à jour
Les mises à jour pour les 
apps achetées apparaissent 
automatiquement.
Ajouter un événement
Cliquez deux fois 
pour créer un 
nouvel événement.
Découvrir de nouvelles apps
Parcourez des milliers d’apps 
et téléchargez-les directement 
dans le Launchpad.
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Welcome to Nike + iPod
Your Personal Workout Assistant
Nike + iPod is a workout partner and coach all in one. Select the type of workout you 
want—open-ended, distance, time, or calorie-burning—choose music to keep you 
motivated, and then keep track of your progress every step of the way with spoken and 
onscreen feedback. Upload your workout data to nikeplus.com, where you can set goals 
and monitor your improvement from workout to workout. Join the world’s largest online 
running community, participating in challenges with runners from across the globe.
Nike + iPod is supported by iPhone (3GS or later), all iPod nano models
1
, and 
iPod touch (2nd generation or later).
iPod nano
(all models)
iPod touch
(2nd generation or later)
iPhone 3GS
or later
1  
For iPod nano (6th generation), the Nike + iPod Sensor is optional and only required for workouts using the 
Polar Wearlink® + Heart Rate Transmitter for Nike+.5
Quick Start
Follow these instructions to get started using Nike + iPod right away.
Step 1: Enable Nike + iPod on your device.
m iPod nano (5th generation or earlier):  Attach the Nike + iPod receiver to iPod nano. 
Nike + iPod appears in the main menu.
m iPod nano (6th generation):  Attach the Nike + iPod receiver to iPod nano. Tap Fitness.
Note: iPod nano (6th generation) can optionally track your workouts without using 
the Nike + iPod receiver and sensor. For more information, see the iPod nano User Guide
that came with the device. 
m iPhone and iPod touch:  Choose Settings > Nike + iPod and set it to On.
A Nike + iPod icon appears on the Home screen.
Note: iPhone 3GS or later and iPod touch have an internal receiver; no external receiver 
is required.  
Step 2: Make sure you have the latest iPod and iTunes software.
1 Download and install the latest iTunes software to your computer from 
www.apple.com/itunes.6
2 Connect the device to your computer, then select it in the iTunes sidebar and 
click Summary.
3 If iTunes indicates that your device needs an update, click Update and follow the 
onscreen instructions.
Step 3: Insert the Nike + iPod Sensor in your Nike+ ready shoe.
m Lift the insole of the left shoe, remove the foam insert from the pocket underneath, 
and replace it with the sensor, flat side up.
Sensor
You can leave the sensor in your shoe when you aren’t working out, but if you plan to 
wear your shoes for a long time without working out, replace the sensor with the foam 
insert to save battery life.
The battery in the sensor is not replaceable or rechargeable, and has a life of over 1000 
hours of active use. Battery life varies, depending on use and other factors.7
Step 4: Choose a type of workout.
To choose Do this
An open-ended workout iPod nano (5th generation or earlier): Choose Nike + iPod > 
Nike + iPod > Basic.
iPod nano (6th generation): Choose Fitness > Run > Basic. 
iPhone and iPod touch: Choose Nike + iPod > Basic.
A workout with 
a time goal
iPod nano (5th generation or earlier): Choose Nike + iPod > 
Nike + iPod > Time.
iPod nano (6th generation): Choose Fitness > Run >Time. 
iPhone and iPod touch:  Choose Nike + iPod > Time.
A workout with 
a distance goal
iPod nano (5th generation or earlier): Choose Nike + iPod > 
Nike + iPod > Distance.
iPod nano (6th generation): Choose Fitness > Run > Distance. 
iPhone and iPod touch: Choose Nike + iPod > Distance.
A workout with a 
calorie-burning goal
iPod nano (5th generation or earlier): Choose Nike + iPod > Settings > 
Weight and enter your weight. Then press the Menu button and 
choose Nike + iPod > Nike + iPod > Calorie.
iPod nano (6th generation): Choose Settings > Fitness > Weight and 
enter your weight. Choose Fitness > Run > Calorie. 
iPhone and iPod touch:  Choose Settings > Nike + iPod > Weight and 
enter your weight. Then press the Home button and choose 
Nike + iPod > Calorie.
Note: You need to enter your weight only the first time you start a 
calorie-burning workout.8
Step 5: Choose music for your workout.
To play Do this
A Nike+ Workout mix Choose the mix (see page 22). 
The currently playing song Choose Now Playing.
A Genius mix Choose Genius Mixes (iPod nano 6th generation).
Songs from a playlist Choose Playlists and then choose a playlist.
A podcast Choose Podcasts (iPod nano 6th generation).
An audiobook Choose Audiobooks (iPod nano 6th generation).
Songs in random order Choose Shuffle Songs.
A radio station Choose Radio. (iPod nano 6th generation).
No music Choose None.
Step 6: Start your workout.
You next walk or run a few steps to activate your sensor. When your device detects 
and links to the sensor, you’re ready to start the workout.
m iPod nano (5th generation or earlier):  Press the Center button and begin walking 
or running.
m iPod nano (6th generation):  Tap Start Workout and begin walking or running.
m iPhone and iPod touch:  Tap Play and begin walking or running.
Step 7: Monitor your progress.
Nike + iPod automatically displays your workout status on the screen, similar to 
the following illustration. (Depending on your device type, the screen may appear 
slightly different.)9
iPod nano 
(6th generation)
iPhone3GS or later, 
and iPod touch
Nike + iPod gives you spoken feedback on your progress during your workout (see 
“Getting Spoken Feedback” on page 15). You can also get feedback whenever you want it.
To get spoken feedback manually:
m iPod nano (5th generation or earlier):  Press the Center button at any time during 
your workout.
m iPod nano (6th generation):  Press the Sleep/Wake button at any time during your workout.
m iPhone and iPod touch:  Press the Home button at any time during your workout.
Note: iPhone and iPod touch must be locked to get spoken feedback manually 
(see “Getting Spoken Feedback” on page 15).10
Step 8: End your workout.
You can end your workout at any time. If you continue working out after you reach 
your time, distance, or calorie goal, your progress continues to be monitored.
To end your workout:
m iPod nano (5th generation or earlier):  Press the Play/Pause button (’) to pause your 
workout. Then press the Menu button and choose End Workout.
m iPod nano (6th generation):  Tap the screen to display the Pause button, then tap Pause. 
Tap End Workout. If the screen is off, press the Sleep/Wake button.
Note: To quickly pause or resume your workout on an iPod nano (6th generation), 
double-click the Sleep/Wake button.
m iPhone and iPod touch:  Tap End Workout. If iPhone or iPod touch is locked, press the 
Home button and tap Pause. Then drag the slider and tap End Workout.
Step 9: Track your progress at nikeplus.com.
At nikeplus.com you can track your progress over time, view a record of all of your past 
workouts, set and monitor goals, and compare your results with others. You can even 
compete with other Nike + iPod users in online workout challenges.
If you have an iPhone or iPod touch, you can send your workout data wirelessly to the 
Nike website. If you have an iPod nano, you can send your workout data from your 
computer to nikeplus.com.
It’s recommended that you first create a nikeplus.com account before you upload 
your workout data. Follow the instructions on the nikeplus.com website to sign up for 
a free account. 11
To send your workout data wirelessly to nikeplus.com from your iPhone or 
iPod touch:
1 Make sure your device is connected to the Internet, and then choose Nike + iPod.
When you have a workout that hasn’t been synced with your nikeplus.com account,
a small red dot appears on the History button.
2 Tap the History button to view your workouts.
3 Tap the “Send to Nike+” button to send your workout data to nikeplus.com. You can 
do it later if you don’t want to do it now.
4 Enter your email address and nikeplus.com account password and then tap “Login 
to Nike+.”
After you log in, your workouts are sent to your nikeplus.com account.
If you don’t have a nikeplus.com account, tap “Join Nike+” and follow the instructions 
for creating an account.
The nikeplus.com website opens with a graph exhibiting your most recent workout.
5 Follow the onscreen instructions for accessing your workouts.
To send your iPod nano workout data from your computer to nikeplus.com:
1 Make sure your computer is connected to the Internet, and then connect iPod nano 
to your computer.
2 Click Send in the dialog that asks if you want to send your workout data to 
nikeplus.com. You can do it later if you don’t want to do it now.
3 Click Visit in the dialog that asks if you want to go to nikeplus.com.
The nikeplus.com website opens with a graph showing your most recent workout.
4 Click Save Your Runs, then click Sign Me Up and follow the onscreen instructions.12
Using Nike + iPod
Follow these instructions to get the most out of Nike + iPod.
Calibrating Nike + iPod
The default calibration for Nike + iPod is accurate for many users. You can improve 
the accuracy by calibrating Nike + iPod to your natural running and walking style. 
On iPod nano, you can perform a calibration workout over a known distance, or 
use your latest workout and enter the distance travelled. On iPhone or iPod touch, 
you can calibrate using your latest completed workout for which you know the 
distance traveled.
To calibrate Nike + iPod for running and walking using iPod nano (5th generation
or earlier):
1 Choose Nike + iPod > Settings > Sensor > Calibrate.
2 Choose Run or Walk and enter a distance.
For best results, use a distance of at least one mile. The shortest calibration distance 
you can enter is one quarter of a mile.
3 Press the Center button.
4 Run or walk the set distance at a steady, natural pace.
5 Press the Menu button and choose Done Calibrating.
A message lets you know if the calibration was successful. If you want to calibrate for 
both running and walking, repeat steps 1–5.
Note: Even after calibrating, the accuracy of the distance measurements may vary 
depending on gait, running surface, incline, and temperature.13
You can also calibrate iPod nano using the workout you just finished. This is useful if 
you’ve traveled a known distance that doesn’t match the summary distance displayed 
on your device.
To calibrate iPod nano (5th generation or earlier) using your latest completed workout:
m Choose End Workout, press and hold the Center button, then choose Calibrate. 
Set the correct distance you walked or ran, then press the Center button.
The device senses whether the workout was a walk or run, and correctly uses the new 
calibration instead of the existing one.
To calibrate Nike + iPod for running and walking using iPod nano (6th generation):
1 Choose Settings >Fitness > Nike + iPod Sport Kit > Sensor > Calibrate.
2 Choose Walk Calibration or Run Calibration, then select a distance and tap Done.
For best results, use a distance of at least one mile. The shortest calibration distance 
you can enter is one quarter of a mile.
3 Choose music to accompany your calibration workout.
4 Run or walk the set distance at a steady, natural pace.
5 Press the Sleep/Wake button if the screen is off, tap the screen to display the Pause 
button, then tap Stop.
A message lets you know if the calibration was successful. If you want to calibrate for 
both running and walking, repeat steps 1–5.
Note: Even after calibrating, the accuracy of the distance measurements may vary 
depending on gait, running surface, incline, and temperature.
Using iPhone or iPod touch, you can calibrate Nike + iPod using the workout you just 
finished. You can only calibrate workouts that are a distance of a quarter mile or more. 14
To calibrate iPhone or iPod touch using your latest completed workout:
m Tap End Workout, then tap Calibrate. Set the correct distance you ran or walked and 
tap Done.
The device updates with the new calibration to override the previous one for a walking 
or running pace.
To reset Nike + iPod calibration to the default setting:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings > Sensor > 
Calibrate > Reset Walk (or Reset Run).
m iPod nano (6th generation): Choose  Settings > Fitness > Nike + iPod Sport Kit > 
Sensor > Calibrate > Reset Walk (or Reset Run) > Reset.
m iPhone and iPod touch: Choose Settings > Nike + iPod, then tap Reset Calibration. 
Setting the Unit of Distance
You can set Nike + iPod to measure your workouts in either miles or kilometers.
To set the unit of distance:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings, and set Distances 
to Miles or Kilometers.
m iPod nano (6th generation):  Choose Settings >Fitness > Distances, then choose 
Miles or Kilometers.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > Distances, then choose 
Miles or Kilometers.15
Entering Your Weight
To enter your weight:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings > Weight, 
then enter your weight.
m iPod nano (6th generation):  Choose Settings > Fitness > Weight, then enter your weight.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > Weight, then enter your weight.
For better accuracy in calculating calories burned, update your weight if it changes.
Locking Your Device During a Workout
You can lock iPhone or iPod touch so that its controls can’t be accidentally activated 
during a workout.
To lock iPhone or iPod touch:
m Press the Sleep/Wake button.
To unlock, press the Sleep/Wake button or the Home button and drag the slider.
Getting Spoken Feedback
As you work out, Nike + iPod periodically gives spoken feedback on your status.
You can choose a female or male voice, or turn off feedback.
To set the voice type or turn spoken feedback off:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings, then set Spoken 
Feedback to Male, Female, or Off.
m iPod nano (6th generation):  Choose Settings > Fitness > Spoken Feedback, then choose 
Male, Female, or Off.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > Spoken Feedback, then choose 
Male, Female, or Off.16
When spoken feedback is turned off, you can still get spoken feedback manually.
To get spoken feedback manually:
m iPod nano (5th generation or earlier):  Press the Center button at any time during 
your workout.
m iPod nano (6th generation):  Press the Sleep/Wake button at any time during your workout.
m iPhone and iPod touch:  Press the Home button while the device is locked.
On iPod nano, spoken feedback is available in some languages besides English. 
If you set iPod nano to one of these languages and connect it to your computer 
(which must be connected to the Internet), iTunes prompts you to download 
feedback in that language.
Â iPod nano (5th generation or earlier) can have only one non-English version of 
spoken feedback at a time.
Â iPhone, iPod touch, and iPod nano (6th generation) automatically support all spoken 
feedback languages.
Using a PowerSong
Choose a song that motivates you and make it your PowerSong. You can switch quickly 
to your PowerSong at any time during your workout.
To choose a PowerSong:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings > PowerSong, then 
choose a song.
iPod nano (5th generation) can also use a playlist as a PowerSong. 
m iPod nano (6th generation):  Choose Settings > Fitness > PowerSong, then choose a song.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > PowerSong, then choose a song.17
To play your PowerSong:
m iPod nano (5th generation or earlier):  Hold down the Center button during a workout. 
After a short pause, your PowerSong plays.
m iPod nano (6th generation):  Press the Sleep/Wake button to wake the screen, then tap 
the screen to display the PowerSong button and tap PowerSong. When the screen is 
on, you can also place and hold two fingers on the screen to start the PowerSong. 
m iPhone and iPod touch:  Tap PowerSong on the workout screen. If iPhone or iPod touch 
is locked, press the Home button, drag the slider to unlock, then tap PowerSong.
Pausing a Workout
You can pause your workout, temporarily stopping music and data collection, 
and resume the workout later without losing any data.
To pause or resume a workout:
m iPod nano (5th generation or earlier):  Press the Play/Pause button (’).
m iPod nano (6th generation):  Tap the screen to display the Pause button. Tap Pause. Tap 
Resume to resume your workout. If the iPod nano (6th generation) screen is off, press 
the Sleep/Wake button to wake it.
m iPhone and iPod touch:  Tap Pause. If iPhone or iPod touch is locked, first press the Home 
button once. Tap Play to resume your workout.18
Receiving Calls During a Workout
You can use iPhone to answer calls during your workout. When you receive a call, your 
workout is automatically paused when you answer.
To answer a call:
m Tap Answer, or press the mic button if you’re wearing the stereo headset. If iPhone is 
locked, drag the slider to unlock it.
To silence a call:
m Press the Sleep/Wake button or either volume button. You can still answer the call after 
silencing it, until it goes to voicemail.
To decline a call:
m Tap Decline, or hold down the mic button on the headset for about two seconds and 
then release it. Two low beeps confirm that the call was declined.
You can also press the Sleep/Wake button twice quickly to decline a call. This silences 
the ringer but the music doesn’t resume until the call has gone to voicemail; the 
workout continues in the background.
To resume your workout after a call:
m Tap Play.
Changing Music During a Workout
You can change your music during a workout without losing your workout data.
Your workout is paused while the music changes.
To change music during a workout:
1 iPod nano (5th generation or earlier):  Press the Menu button and choose Change Music. 
Your workout pauses.19
iPod nano (6th generation):  Tap the screen to display the Pause button.Tap Pause, then 
tap Change Music. If the iPod nano (6th generation) screen is off, press the Sleep/Wake 
button to wake it.
iPhone and iPod touch:  Tap Pause, then tap Change Music. If the device is locked, first 
press the Home button and drag the slider to unlock it. 
2 iPod nano (5th generation or earlier):  Choose new music. Your workout resumes 
automatically.
iPhone, iPod touch, and iPod nano (6th generation):  Choose new music. 
Sending Workouts to Nikeplus.com Automatically
You can set iTunes to automatically send your workout data to nikeplus.com over the 
Internet whenever you connect your iPod nano to your computer. 
To send workouts to nikeplus.com automatically:
1 Make sure your computer is connected to the Internet, and then connect iPod nano to 
your computer.
2 Open iTunes on your computer, click the Nike + iPod tab, then select “Automatically 
send workout data to nikeplus.com.”
3 Click “Visit nikeplus.com” below the checkbox or, if you’ve already set your workout to 
be sent automatically, click Visit in the dialog that appears.
The nikeplus.com website opens with a graph showing your most recent workout.
4 Click Save Your Runs and log in, or register if you haven’t already done so.
See the nikeplus.com website for Nike’s privacy policy and terms and conditions.20
Reviewing Workouts on Your Device
iPod nano, iPhone, or iPod touch saves the date, time, duration, distance, pace, and 
calories burned for up to your last one thousand workouts.
To review recent workouts on your device:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > History.
m iPod nano (6th generation):  Choose Fitness > History at the bottom of the screen.
m iPhone and iPod touch:  Choose Nike + iPod, then tap History at the bottom of the screen.
iPod nano (5th generation or earlier) provides daily totals of all your workouts:  
Nike + iPod workouts, pedometer steps, and cardio workouts using Nike + iPod 
compatible gym equipment.
To view workouts on iPod nano (5th generation or earlier):
1 Choose Daily Totals from the History menu.
2 Choose a date and activity.
3 Rotate iPod nano (5th generation) to landscape orientation to see a graph of that activity.
To delete a single workout session:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > History. Choose a workout 
session, press and hold the Center button, then choose Delete.
You cannot delete individual workouts on iPod nano (6th generation). 
m iPhone and iPod touch:  Choose Nike + iPod and tap History. Tap Edit, choose a workout 
session, then tap Delete.
On iPhone, iPod touch, and iPod nano (6th generation), you can delete all workout 
sessions from History by tapping Clear at the top of the History screen.21
Creating Custom Workout Shortcuts
Custom workout shortcuts let you easily choose and repeat a workout. iPod nano 
(4th generation or later) automatically saves your completed workouts as shortcuts.
iPhone and iPod touch also let you create custom workout shortcuts.
To create a custom workout shortcut on iPhone or iPod touch:
1 Choose Nike + iPod, then tap My Workouts at the bottom of the screen.
2 Tap Plus (+), then choose the type of workout and the workout goal.
3 Choose music, enter a name for the workout, then tap Save.
Note: You can create custom workout shortcuts only on iPhone and iPod touch
(2nd generation or later).
To delete a custom workout shortcut on iPhone or iPod touch:
m Choose Nike + iPod, then tap My Workouts. Tap Edit, choose a shortcut, then tap Delete. 
To choose a custom workout shortcut:
m iPod nano (4th and 5th generation):  Choose Nike + iPod, then choose a shortcut. 
Shortcuts are named according to the type of workout and music. They can’t be deleted.
m iPod nano (6th generation):  Choose Fitness > Run> , then tap My Workouts. Choose a 
shortcut. Shortcuts are named according to the type of workout and music. They can’t 
be deleted.
m iPhone and iPod touch:  Choose Nike + iPod, then tap My Workouts. Shortcuts are listed 
by the name you specified when you created the workout.
Your most recent custom workout shortcut appears at the top of the list.22
Purchasing Nike+ Workouts
You can purchase and download Nike+ Workouts that feature continuous music mixed 
with professional coaching. When you purchase a Nike+ Workout, you get a single 
workout track with music and voiceover, and you also get all the individual songs in the 
mix. Choose mixes for your level and style of workout.
To purchase a Nike+ Workout:
1 Open iTunes and click iTunes Store on the left side of the window, then type 
“Nike Sport Music” in the iTunes search field.
2 Click the Buy button next to the Nike+ Workout of your choice.
3 Follow the onscreen instructions to complete the purchase. The download begins 
automatically.
4 Connect the device to your computer and load the workout onto the device.
Note: The iTunes Store is available only to people age 13 or older, in the U.S. and many 
other countries; for a list of countries, go to www.apple.com/itunes/download. Terms 
apply. You must have Internet access (fees may apply) to use the iTunes Store.
Linking a Nike + iPod Compatible Remote or Heart Rate Monitor
Nike + iPod compatible devices are sold separately from the Nike + iPod Sport Kit and 
the Nike + iPod Sensor.
You can use a compatible remote to control Nike + iPod wirelessly while you work out.
iPod nano (5th generation or later) also supports Nike + iPod compatible heart rate 
monitors.
Note: You must have the iPod + Nike receiver attached to your iPod nano (6th 
generation) to use a heart rate monitor or remote.23
Before using one of these devices for the first time, you must link it to your iPod nano 
receiver, iPhone, or iPod touch.
To link to a Nike + iPod compatible remote (sold separately):
m iPod nano (5th generation or earlier):  Connect your Nike + iPod receiver to iPod nano, 
choose Nike + iPod > Settings > Remote > Link, then follow the onscreen instructions.
m iPod nano (6th generation):  Choose Settings > Fitness > Nike + iPod Sport Kit > Remote. 
Turn on the Remote option and tap Link.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > Remote, then follow the 
onscreen instructions.
To link to a Nike + iPod compatible heart rate monitor (sold separately):
m iPod nano (5th generation):  Connect your Nike + iPod receiver to iPod nano, choose 
Nike + iPod > Settings > Heart Rate Monitor > Link, then follow the onscreen instructions.
m iPod nano (6th generation):  Choose Settings > Fitness > Nike + iPod Sport Kit > 
Heart Rate Monitor > Link, then follow the onscreen instructions.
To unlink a device:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings > Remote (or Heart 
Rate Monitor) > Unlink, then follow the onscreen instructions.
m iPod nano (6th generation):  Choose Settings > Fitness > Nike + iPod Sport Kit > Remote 
(or Heart Rate Monitor), then tap Unlink.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > Remote, then tap Unlink.
You can turn the functions of a Nike + iPod compatible remote on or off without 
unlinking the device.24
To turn remote functionality on or off:
m iPod nano (5th generation or earlier):  Choose Nike + iPod > Settings > Remote, then set 
Remote to On or Off.
m iPod nano (6th generation):  Choose Settings > Fitness > Nike + iPod Sport Kit > Remote, 
then set Remote to On or Off.
m iPhone and iPod touch:  Choose Settings > Nike + iPod > Remote, then link or unlink 
the remote.
Working Out with iPod nano (6th Generation) and a Heart Rate Monitor
If you have iPod nano (6th generation) and a compatible Nike + iPod heart rate 
monitor (purchased separately), iPod nano can record and display your heart rate as 
you work out. You can also specify a range or “zone” of the maximum and minimum 
heart rates that you want to maintain during a workout and track how well you 
maintain your heart rate within that zone as you exercise. As you work out, iPod nano 
displays your current heart rate and an upward- or downward-pointing arrow appears 
when you need to increase or decrease your activity. You can use a heart rate monitor 
while doing any of the standard workouts.
You can also monitor your heart rate as you participate in activities besides running 
or walking. For example, you can use iPod nano and a heart rate monitor as you 
participate in sports activities such as basketball, aerobics, circuit training, golf, hiking, 
soccer, and more. 
When your workout is done, you can transfer your heart rate information to your 
nikeplus.com account, where you can review it.
As you set up a workout, you can set a zone of maximum and minimum heart rates 
that you want to maintain when you select a workout.  You must first turn on the 
zone workout feature.25
To turn zone workouts on or off:
m Tap Settings > Fitness > Nike + iPod Sport Kit, then tap the On/Off button in 
Zone Workout.
When you turn on zone workouts and select a workout, options appear for setting 
a heart rate zone. As you work out, heart rate information is recorded and displayed 
during any of the workout types. 
iPod nano (6th generation) also provides a heart rate workout. To perform a heart rate 
workout, you specify the heart rate zone you want to maintain, choose the activity type 
that you’ll be doing, and then enjoy a good workout. All your heart rate information is 
recorded automatically. When you do a heart rate workout, you don’t need a sensor in 
your shoe to record motion.
To start a heart rate workout:
1 Tap Fitness > Run > Heart Rate.
2 Set the heart rate zone you want.
3 Choose an activity and tap Done.
4 Choose the workout music you want.
5 Tap Start Workout and begin your workout.
6 When done, press the Sleep/Wake button to wake the screen, tap the screen to display 
the Pause button, tap Pause.Tap End Workout to finish your heart rate workout.
Once you complete a heart rate workout, you can transfer the information to your 
nikeplus.com account just as you do with your other workouts. 26
Linking to Another Sensor
Once your device links to a specific sensor, it’s set to link with that sensor only. If you 
use a different sensor, you must set the device to link to the other sensor. You may want 
to do this, for example, if there’s more than one person in your family with a sensor and 
Nike+ ready shoes.
To link to another sensor:
1 iPod nano:  Connect the receiver to iPod.
2 Put on the shoes with the new sensor, and make sure there’s no other Nike + iPod 
Sensor nearby.
Walk around to activate the sensor so that your receiver can detect it.
3 Link the sensor to your device:
Â iPod nano (5th generation or earlier): Choose Nike + iPod > Settings > Sensor > Link, 
then follow the onscreen instructions. A message indicates iPod is now linked to the 
new sensor.
Â iPod nano (6th generation): Choose Settings > Fitness > Nike + iPod Sport Kit > 
Sensor, tap Link, then tap the screen while walking or running to relink the device to 
the different sensor.
Â iPhone and iPod touch: Choose Settings > Nike + iPod > Sensor, tap Link New, then 
follow the onscreen instructions.
Note: If you link to a previously linked sensor, Nike + iPod detects your calibration 
settings. You don’t need to recalibrate.
If you connect an iPod receiver to a different iPod and use it with the same sensor, 
you don’t need to relink or recalibrate. The receiver stores your settings, your workout 
history, and your workout shortcuts. You don’t need to relink or recalibrate.27
Putting the Nike + iPod Sensor to Sleep
The sensor is awake and on by default. If you want to store the sensor for a long period 
of time or stop it from transmitting, you can put it to sleep.
Important: To comply with applicable government regulations, put the sensor to sleep 
before taking it on an aircraft.
To put the sensor to sleep:
m Use a pen or a paper clip to hold down the Sleep/Wake button for three seconds.
Sleep/Wake button
To wake the sensor:
m Use a pen or a paper clip to press the Sleep/Wake button.28
Important Safety Information
WARNING: Failure to follow these safety instructions could result in injury or damage.
Exercising Before starting any exercise program, you should have a complete physical 
examination by your physician. Do a warmup or stretching exercise before beginning 
any workout. Be careful and attentive while exercising. Slow down, if necessary, before 
adjusting your device while running. Stop exercising immediately if you feel pain, 
or feel faint, dizzy, exhausted, or short of breath. By exercising, you assume the risks 
inherent in physical exercise, including any injury that may result from such activity.
Do not use the receiver, iPhone, or iPod in or near water or wet locations.
Choking hazard The receiver and sensor are potential choking hazards. Keep them 
away from children under three years of age.
Avoid hearing damage Permanent hearing loss may occur if earphones are used 
at high volume. Set the volume to a safe level. You can adapt over time to a higher 
volume of sound that may sound normal but can be damaging to your hearing. If you 
experience ringing in your ears or muffled speech, stop listening and have your hearing 
checked. The louder the volume, the less time is required before your hearing could be 
affected. Hearing experts suggest that to protect your hearing:
Â Limit the amount of time you use the earphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings.
Â Turn down the volume if you can’t hear people speaking near you.
Disassembling the sensor Do not attempt to open the sensor, disassemble it, 
or remove the battery. No user-serviceable parts are inside.29
Learning More, Service, and Support
For Do this
Answers to frequently asked questions
about Nike + iPod
Go to www.apple.com/support/nikeplus.
Service and support for the Nike + iPod
Sensor and Receiver
Go to www.apple.com/support/nikeplus.
Service and support for Nike+ ready shoes
or the nikeplus.com website
Go to www.nikeplus.com.
Information about using iTunes Open iTunes and choose Help > iTunes Help.
Information about using iPod nano or
iPod touch
Go to www.apple.com/support/ipod.
Information about using iPhone Go to www.apple.com/support/iphone.31
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Bienvenue sur Nike + iPod
Votre assistant personnel d’entraînement
Nike + iPod est à la fois votre partenaire d’entraînement et votre entraîneur. 
Sélectionnez le type d’entraînement souhaité (séance ouverte, distance, temps 
ou dépense calorique), choisissez une musique qui vous motive, puis suivez votre 
progression grâce aux informations vocales ou affichées à l’écran. Téléchargez les 
données d’entraînement sur nikeplus.com, afin de définir des objectifs et surveiller 
votre évolution d’une séance à l’autre. Rejoignez la plus grande communauté de 
coureurs du monde en participant à des défis avec des coureurs du monde entier.
Nike + iPod est pris en charge par l’iPhone (3GS ou ultérieur), tous les modèles 
d’iPod nano
1
 et l’iPod touch (à partir de la 2e génération).
iPod nano
(tous les modèles)
iPod touch
(à partir de la
2e génération)
iPhone 3GS
ou ultérieur
1
Pour l’iPod nano de 6e génération, le capteur Nike + iPod est facultatif. Il est nécessaire uniquement pour 
les entraînements utilisant Polar Wearlink et le transmetteur de fréquence cardiaque pour Nike+.33
Démarrage rapide
Les instructions ci-dessous vous permettront d’utiliser Nike + iPod immédiatement.
Étape 1 :  Activez Nike + iPod sur votre dispositif.
m iPod nano (5e génération ou antérieure) :  reliez le récepteur Nike + iPod à l’iPod nano. 
Nike + iPod apparaît dans le menu principal.
m iPod nano (6e génération) :  reliez le récepteur Nike + iPod à l’iPod nano. Touchez Fitness.
Remarque :  l’iPod nano (6e génération) peut suivre vos entraînements sans utiliser le 
capteur et le receveur Nike + iPod. Pour en savoir plus, consultez le Manuel d’utilisateur 
de l’iPod nano livré avec l’appareil. 
m iPhone et iPod touch :  sélectionnez Réglages > Nike + iPod et réglez sur Activé.
Une icône Nike + iPod apparaît dans l’écran d’accueil.
Remarque :  l’iPhone 3GS ou ultérieur et l’iPod touch possèdent un récepteur interne ; 
aucun récepteur externe ne doit être branché. 
Étape 2 :  Assurez-vous d’avoir installé les logiciels iPod et iTunes les plus récents.
1 Téléchargez et installez le logiciel iTunes le plus récent depuis www.apple.com/fr/itunes.
2 Connectez le dispositif à votre ordinateur, sélectionnez-le dans la barre latérale 
d’iTunes, puis cliquez sur Résumé.34
3 Si le logiciel iTunes vous informe que votre dispositif doit être mis à jour, cliquez sur 
Mettre à jour et suivez les instructions à l’écran.
Étape 3 :  Insérez le capteur Nike + iPod dans votre chaussure compatible Nike+.
m Soulevez la semelle de votre chaussure gauche, enlevez la pièce en mousse de la poche 
située sous la semelle et remplacez-la par le capteur, côté plat en haut.
Capteur
Vous pouvez laisser le capteur dans la chaussure lorsque vous ne vous entraînez 
pas. Il est cependant conseillé de remplacer le capteur par la pièce en mousse pour 
économiser la charge de la batterie si vous comptez porter longtemps vos chaussures 
sans vous entraîner.
La batterie du capteur ne peut pas être remplacée ou rechargée ; sa durée de vie est 
d’environ 1000 heures d’utilisation active. Cette durée de vie varie en fonction de 
l’usage et d’autres facteurs.35
Étape 4 :  Choisissez un type de séance d’entraînement.
Pour choisir Procédez ainsi :
Une séance sans objectif 
de temps
iPod nano (5e génération ou antérieure) : sélectionnez Nike + iPod >
Nike + iPod > Standard.
iPod nano (6e génération) : sélectionnez Fitness > Course > Standard. 
iPhone et iPod touch : sélectionnez Nike + iPod > Standard.
Une séance avec objectif 
de temps
iPod nano (5e génération ou antérieure) : sélectionnez Nike + iPod >
Nike + iPod > Durée.
iPod nano (6e génération) : sélectionnez Fitness > Course > Durée. 
iPhone et iPod touch :  sélectionnez Nike + iPod > Durée.
Une séance avec objectif 
de distance
iPod nano (5e génération ou antérieure) : sélectionnez Nike + iPod >
Nike + iPod > Distance.
iPod nano (6e génération) : sélectionnez Fitness > Course > Distance. 
iPhone et iPod touch : sélectionnez Nike + iPod > Distance.
Une séance avec objectif 
de dépense calorique
iPod nano (5e génération ou antérieure) : sélectionnez Nike + iPod > 
Réglages > Poids, puis entrez votre poids. Cliquez ensuite sur 
le bouton Menu, puis choisissez Nike + iPod > Calories.
iPod nano (6e génération) : sélectionnez Réglages > Fitness > Poids, 
puis entrez votre poids. Sélectionnez Fitness > Course > Calories. 
iPhone et iPod touch :  sélectionnez Réglages > Nike + iPod > Poids, 
puis entrez votre poids. Appuyez ensuite sur le bouton principal, 
puis choisissez Nike + iPod > Calories.
Remarque :  vous ne devez saisir votre poids que lorsque vous 
débutez votre toute première séance de dépense de calories.36
Étape 5 :  Choisissez la musique pour votre séance.
Pour écouter : Procédez ainsi :
Un mix de séance Nike+ Choisissez le mix (voir la page 52). 
Le morceau en cours de lecture Choisissez En lecture.
Un mix Genius Choisissez Mix Genius (iPod nano 6e génération).
Des morceaux d’une liste de lecture Choisissez Listes de lecture et sélectionnez une liste 
de lecture.
Un podcast Choisissez Podcasts (iPod nano 6e génération).
Un livre audio Choisissez Livres audio (iPod nano 6e génération).
Des morceaux dans un ordre 
aléatoire
Choisissez Mix de morceaux.
Une station de radio Choisissez Radio iPod nano (6e génération).
Aucune musique Choisissez Aucune.
Étape 6 :  Démarrez votre séance.
Vous devez ensuite marcher ou courir un petit peu pour activer votre capteur. Une fois 
que votre dispositif a détecté votre capteur et établi un lien avec ce dernier, vous êtes 
prêt à commencer la séance.
m iPod nano (5e génération ou antérieure) :  appuyez sur le bouton central et commencez 
à marcher ou à courir.
m iPod nano (6e génération) :  appuyez sur Commencer l’entraînement et commencez 
à marcher ou à courir.
m iPhone et iPod touch :  appuyez sur Lecture et commencez à marcher ou à courir.37
Étape 7 :  Suivez votre progression.
Nike + iPod affiche automatiquement l’état de votre séance à l’écran, comme dans 
l’illustration suivante. (L’aspect de l’écran peut varier en fonction votre type de dispositif.)
iPod nano 
(6e génération)
L’iPhone 3GS ou ultérieur 
et l’iPod touch.
Nike + iPod vous fournit des commentaires vocaux sur la progression de votre 
séance (voir « Commentaires vocaux » à la page 45). Vous pouvez également obtenir 
ces commentaires à tout moment.
Pour obtenir manuellement des informations vocales :
m iPod nano (5e génération ou antérieure) :  appuyez sur le bouton central à tout moment 
durant votre entraînement.
m iPod nano (6e génération) :  appuyez sur le bouton marche/veille à tout moment durant 
votre entraînement.38
m iPhone et iPod touch :  appuyez sur le bouton principal à tout moment durant votre 
entraînement.
Remarque :  l’iPhone et l’iPod touch doivent être verrouillés pour obtenir manuellement 
des commentaires vocaux (voir « Commentaires vocaux » à la page 45).
Étape 8 :  Terminez votre séance.
Vous pouvez arrêter votre séance d’entraînement à tout moment. Si vous continuez à 
vous entraîner après avoir atteint votre objectif de temps, de distance ou de calories, 
vos progrès continuent à être suivis.
Pour arrêter votre séance d’entraînement :
m iPod nano (5e génération ou antérieure) :  appuyez sur le bouton Lecture/Pause (’) pour 
mettre votre entraînement en pause. Appuyez ensuite sur le bouton Menu, 
puis choisissez Arrêter la séance.
m iPod nano (6e génération) :  touchez l’écran pour afficher le bouton Pause, puis appuyez 
sur Pause. Appuyez sur Arrêter la séance. Si l’écran est désactivé, appuyez sur le bouton 
de marche/veille.
Remarque :  pour rapidement interrompre ou reprendre votre séance sur un iPod nano 
(6e génération), double-cliquez sur le bouton de marche/veille.
m iPhone et iPod touch :  appuyez sur Arrêter la séance. Si l’iPhone ou l’iPod touch est 
verrouillé, appuyez sur le bouton principal, puis sur Pause. Faites ensuite glisser 
le curseur, puis sélectionnez Arrêter la séance.39
Étape 9 :  Suivez le détail de votre progression sur nikeplus.com.
Sur nikeplus.com, vous pouvez suivre le détail de votre progression avec le temps, afficher 
les données relatives à toutes vos séances passées, définir des objectifs et les surveiller 
et comparer vos résultats avec d’autres coureurs. Vous pouvez même vous mesurer à 
d’autres utilisateurs Nike + iPod en participant à des défis d’entraînement en ligne.
Si vous possédez un iPhone ou un iPod touch, vous pouvez transmettre sans fil les 
données de vos séances au site web de Nike. Si vous possédez un iPod nano, vous 
pouvez transmettre les données de vos séances de votre ordinateur à nikeplus.com.
Nous vous conseillons de créer un compte nikeplus.com avant de transférer vos 
données d’entraînement. Pour créer un compte gratuit, suivez les instructions 
disponibles sur le site web nikeplus.com. 
Pour utiliser votre iPhone ou votre iPod touch afin d’envoyer vos données 
d’entraînement à nikeplus.com via une connexion sans fil :
1 Assurez-vous que votre appareil est connecté à Internet, puis choisissez Nike + iPod.
Si l’une de vos séances n’a pas encore été synchronisée avec votre compte nikeplus.com, 
un petit point rouge apparaît sur le bouton Historique.
2 Appuyez sur le bouton Historique pour consulter vos séances.
3 Appuyez sur le bouton Envoyer à Nike+ pour envoyer vos données d’entraînement 
à nikeplus.com. Vous pouvez effectuer cette opération ultérieurement, si vous ne 
souhaitez pas l’exécuter maintenant.
4 Saisissez votre adresse électronique et le mot de passe de votre compte nikeplus.com, 
puis appuyez sur Se connecter à Nike +.
Une fois que vous êtes connecté, vos données sont envoyées à votre compte nikeplus.com.40
Si vous ne possédez pas de compte nikeplus.com, appuyez sur S’inscrire à Nike+ et 
suivez les instructions de création de compte.
Le site web nikeplus.com s’ouvre sur une représentation graphique reprenant les 
données de votre entraînement le plus récent.
5 Suivez les instructions à l’écran pour accéder à vos séances.
Pour envoyer vos données d’entraînement recueillies sur un iPod nano à nikeplus.
com depuis votre ordinateur :
1 Assurez-vous que votre ordinateur est connecté à Internet, puis connectez votre 
iPod nano à votre ordinateur.
2 Cliquez sur Envoyer dans la zone de dialogue qui vous demande si vous souhaitez 
envoyer vos données d’entraînement à nikeplus.com. Vous pouvez effectuer cette 
opération ultérieurement, si vous ne souhaitez pas l’exécuter maintenant.
3 Cliquez sur Aller dans la zone de dialogue qui vous demande si vous souhaitez accéder 
à nikeplus.com.
Le site web nikeplus.com s’ouvre sur une représentation graphique montrant 
les données de votre entraînement le plus récent.
4 Cliquez sur Mes courses, puis sur S’inscrire et suivez les instructions à l’écran.41
Utilisation de Nike + iPod
Suivez ces instructions pour profiter au mieux de Nike + iPod.
Étalonnage de Nike + iPod
Nike + iPod est suffisamment précis pour la plupart des utilisateurs. Vous pouvez 
améliorer le niveau de précision en étalonnant Nike + iPod en fonction de votre style 
naturel de course ou de marche. Avec l’iPod nano, vous pouvez effectuer une séance 
d’étalonnage sur une distance connue ou utiliser votre dernière séance et saisir la 
distance parcourue. Avec l’iPhone ou l’iPod touch, vous pouvez procéder à l’étalonnage 
à l’aide de votre dernière séance complète pour laquelle vous connaissez la distance 
parcourue.
Pour étalonner Nike + iPod pour la course et la marche à l’aide d’un iPod nano 
(5e génération ou antérieure) :
1 Choisissez Nike + iPod > Réglages > Capteur > Étalonner.
2 Sélectionnez Course ou Marche, puis saisissez une distance.
Pour de meilleurs résultats, utilisez une distance d’au moins 1,6 km. La distance 
d’étalonnage la plus courte que vous pouvez saisir est de 400 mètres.
3 Appuyez sur le bouton central.
4 Courez ou marchez ensuite sur la distance définie à un rythme constant et naturel.
5 Appuyez ensuite sur le bouton Menu, puis choisissez Étalonnage terminé.
Un message vous indique si l’étalonnage s’est effectué correctement. Si vous souhaitez 
effectuer un étalonnage pour la course et pour la marche, répétez les étapes 1–5.
Remarque :  même après l’étalonnage, la précision de mesure des distances peut varier 
selon l’allure, la surface de course, la pente et la température.42
Vous pouvez également calibrer l’iPod nano à l’aide de la séance d’entraînement que 
vous venez de terminer. Cette opération est utile si vous avez parcouru une distance 
connue qui ne correspond pas à la distance affichée sur votre dispositif.
Pour étalonner un iPod nano (5e génération ou antérieure) au moyen de votre 
dernière séance complète :
m Choisissez Terminer, maintenez le bouton central enfoncé et choisissez Étalonner. 
Indiquez la distance parcourue, puis appuyez sur le bouton central.
Le dispositif détecte le type de séance d’entraînement (marche ou course) et utilise 
correctement le nouvel étalonnage plutôt que l’ancien.
Pour étalonner Nike + iPod pour la course et la marche à l’aide d’un iPod nano 
(6e génération) :
1 Choisissez Réglages > Fitness > Nike + iPod Sport Kit > Capteur > Étalonner.
2 Choisissez Étalonnage de la marche ou Étalonnage de la course, sélectionnez une 
distance, puis appuyez sur OK.
Pour de meilleurs résultats, utilisez une distance d’au moins 1,6 km. La distance 
d’étalonnage la plus courte que vous pouvez saisir est de 400 mètres.
3 Choisissez la musique qui accompagnera votre séance d’étalonnage.
4 Courez ou marchez ensuite sur la distance définie à un rythme constant et naturel.
5 Appuyez sur le bouton de marche/veille si l’écran est éteint, puis touchez l’écran pour 
faire apparaître le bouton Pause et appuyez sur Arrêter.
Un message vous indique si l’étalonnage s’est effectué correctement. Si vous souhaitez 
effectuer un étalonnage pour la course et pour la marche, répétez les étapes 1–5.43
Remarque :  même après l’étalonnage, la précision de mesure des distances peut varier 
selon l’allure, la surface de course, la pente et la température.
Vous pouvez également calibrer Nike + iPod au moyen d’un iPhone ou d’un iPod touch 
en utilisant la séance d’entraînement que vous venez de terminer. Vous pouvez 
seulement utiliser des séances d’une distance minimum de 400 mètres. 
Pour étalonner un iPhone ou un iPod touch au moyen de votre dernière séance 
complète :
m Sélectionnez Arrêter la séance, puis Étalonner. Indiquez la distance parcourue, puis 
appuyez sur OK.
L’appareil se met à jour avec le nouvel étalonnage qui remplace l’ancien pour le rythme 
de course ou de marche.
Pour rétablir le réglage par défaut de l’étalonnage Nike + iPod :
m iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages > Capteur > 
Réinitialiser la marche (ou Réinitialiser la course).
m iPod nano (6e génération) : choisissez Réglages > Fitness > Nike + iPod Sport Kit > 
Capteur > Étalonner >Réinitialiser la marche (ou Réinitialiser la course).
m iPhone et iPod touch : choisissez Réglages > Nike + iPod, puis sélectionnez Réinitialiser 
l’étalonnage. 44
Réglage des unités de distance
Vous pouvez configurer Nike + iPod pour que vos séances d’entraînement soient 
mesurées en milles ou en kilomètres.
Pour régler les unités de distance :
m iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages et 
sélectionnez Kilomètres ou Milles
m iPod nano (6e génération) :  choisissez Réglages > Fitness > Distances, puis sélectionnez 
Kilomètres ou Miles.
m iPhone et iPod touch :  choisissez Réglages > Nike + iPod > Distances, puis sélectionnez 
Kilomètres ou Miles.
Saisie de votre poids
Pour saisir votre poids :
m iPod nano (5e génération ou antérieure) :  sélectionnez Nike + iPod > Réglages > 
Poids, puis entrez votre poids.
m iPod nano (6e génération) :  sélectionnez Réglages > Fitness > Poids, puis entrez votre poids.
m iPhone et iPod touch :  sélectionnez Réglages > Nike + iPod > Poids, puis entrez votre poids.
Pour une plus grande précision de calcul des calories dépensées, actualisez votre poids 
au fur et à mesure de ses variations.
Verrouillage de votre dispositif pendant une séance
Vous pouvez verrouiller votre iPhone ou votre iPod touch, afin que ses commandes ne 
puissent être accidentellement activées durant une séance d’entraînement.
Pour verrouiller un iPhone ou un iPod touch :
m Appuyez sur le bouton de marche/veille.45
Pour déverrouiller l’iPod, appuyez sur le bouton de marche/veille ou sur le bouton 
principal et faites glisser le curseur.
Commentaires vocaux
Pendant vos séances d’entraînement, Nike + iPod vous donne périodiquement des 
informations vocales sur vos progrès.
Vous pouvez choisir une voix de femme ou d’homme, ou désactiver les informations 
vocales.
Pour régler le type de voix ou désactiver les informations vocales :
m iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages, puis réglez 
Commentaires vocaux sur Homme, Femme ou Désactivés.
m iPod nano (6e génération) :  choisissez Réglages > Fitness > Commentaires vocaux, 
puis sélectionnez Homme, Femme ou Désactivé.
m iPhone et iPod touch :  choisissez Réglages > Nike + iPod > Commentaires vocaux, 
puis sélectionnez Homme, Femme ou Désactivé.
Vous pouvez toujours obtenir des informations vocales manuellement, même lorsque 
cette option est désactivée.
Pour obtenir manuellement des informations vocales :
m iPod nano (5e génération ou antérieure) :  appuyez sur le bouton central à tout moment 
durant votre entraînement.
m iPod nano (6e génération) :  appuyez sur le bouton marche/veille à tout moment durant 
votre entraînement.
m iPhone et iPod touch :  appuyez sur le bouton principal lorsque l’appareil est verrouillé.46
Sur l’iPod nano, les commentaires vocaux sont disponibles dans certaines langues 
autres que l’anglais. Si vous avez réglé votre iPod nano sur une de ces langues et que 
vous le branchez sur l’ordinateur (connecté à Internet), iTunes vous invite à télécharger 
les commentaires vocaux correspondant à cette langue.
Â L’iPod nano (5e génération ou antérieure) ne peut disposer que d’une version non 
anglaise des commentaires vocaux à la fois.
Â L’iPhone, l’iPod touch et l’iPod nano (6e génération) prennent automatiquement en 
charge les commentaires vocaux dans toutes les langues.
Utilisation d’un morceau PowerSong
Choisissez un morceau qui vous motive et faites-en votre PowerSong. Vous pouvez 
sélectionner très rapidement votre PowerSong, à tout moment de votre séance.
Pour choisir un morceau PowerSong :
m iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages > 
PowerSong, puis sélectionnez un morceau.
L’iPod nano (5e génération) peut également convertir une liste de lecture en une 
PowerSong. 
m iPod nano (6e génération) :  choisissez Réglages > Fitness > PowerSong, 
puis sélectionnez un morceau.
m iPhone et iPod touch :  choisissez Réglages > Nike + iPod > PowerSong, 
puis sélectionnez un morceau.47
Pour écouter votre morceau PowerSong :
m iPod nano (5e génération ou antérieure) :  maintenez le bouton central appuyé durant 
une séance. Le PowerSong démarre après une courte pause.
m iPod nano (6e génération) :  appuyez sur le bouton de marche/veille si l’écran est éteint, 
puis touchez l’écran pour faire apparaître le bouton PowerSong et appuyez sur celuici. Si l’écran est activé, vous pouvez aussi maintenir deux doigts appuyés dessus pour 
lancer le PowerSong. 
m iPhone et iPod touch :  appuyez sur PowerSong sur l’écran de séance. Si votre iPhone ou 
iPod touch est verrouillé, appuyez sur le bouton central, faites glisser le curseur pour 
déverrouiller l’appareil, puis appuyez sur PowerSong.
Suspension d’une séance d’entraînement
Vous pouvez suspendre votre séance d’entraînement à tout moment, ce qui suspend 
également la lecture de musique et le recueil des données, et la reprendre plus tard 
sans en perdre les données.
Pour suspendre ou reprendre une séance d’entraînement :
m iPod nano (5e génération ou antérieure) :  appuyez sur le bouton Lecture/Pause (’).
m iPod nano (6e génération) :  touchez l’écran pour afficher le bouton Pause. Appuyez 
sur Pause. Touchez Reprendre pour reprendre votre séance. Si l’écran de l’iPod nano 
(6e génération)est désactivé, appuyez sur le bouton de marche/veille pour le réactiver. 
m iPhone et iPod touch :  appuyez sur Pause. Si l’iPhone ou l’iPod touch est verrouillé, 
appuyez une seule fois sur le bouton principal. Tapotez sur Lecture pour reprendre 
votre séance.48
Réception d’appels pendant une séance d’entraînement
Vous pouvez utiliser votre iPhone pour répondre à des appels pendant votre séance 
d’entraînement. Lorsque vous recevez un appel, votre séance est immédiatement 
suspendue dès vous répondez.
Pour répondre à un appel :
m Sélectionnez Répondre ou appuyez sur le bouton micro si vous portez le casque. 
Si l’iPhone est verrouillé, faites glisser le curseur pour le déverrouiller.
Pour couper le son d’un appel :
m Appuyez sur le bouton de marche/veille ou sur le bouton du volume. Vous pouvez 
toujours répondre à l’appel après avoir coupé le son, jusqu’à ce qu’il soit dirigé sur 
la messagerie vocale.
Pour refuser un appel :
m Sélectionnez Refuser ou maintenez le bouton micro du casque enfoncé pendant environ 
deux secondes. Deux longs signaux sonores confirment que l’appel a été refusé.
Vous pouvez aussi appuyer sur le bouton de marche/veille deux fois rapidement pour 
refuser un appel. Cela coupe le son de la sonnerie mais la musique ne reprend pas 
tant que l’appel n’a pas été transféré sur la messagerie vocale ; la séance continue en 
arrière-plan.
Pour suspendre votre séance d’entraînement à l’issue d’un appel :
m Sélectionnez Lecture.
Changement de musique durant une séance
Vous pouvez changer de musique en cours de séance sans pour autant perdre de vos 
données. Votre séance est suspendue pendant le changement de musique.49
Pour changer de musique durant une séance :
1 iPod nano (5e génération ou antérieure) :  appuyez sur le bouton Menu, puis choisissez 
Musique. Votre séance est suspendue.
iPod nano (6e génération) :  touchez l’écran pour afficher le bouton Pause, appuyez sur 
Pause, puis sur Musique. Si l’écran de l’iPod nano (6e génération)est désactivé, appuyez 
sur le bouton de marche/veille pour le réactiver. 
iPhone et iPod touch :  appuyez sur Pause, puis sur Musique. Si l’appareil est verrouillé, 
appuyez d’abord sur le bouton central, puis faites glisser le curseur pour le déverrouiller. 
2 iPod nano (5e génération ou antérieure) :  choisissez une nouvelle musique. Votre séance 
reprend automatiquement.
iPhone, iPod touch et iPod nano (6e génération) :  choisissez une nouvelle musique. 
Envoi automatique des données d’entraînement à Nikeplus.com
Vous pouvez configurer iTunes pour transmettre vos données d’entraînement à 
nikeplus.com à travers Internet, à chaque fois que vous branchez votre iPod nano sur 
votre ordinateur. 
Pour envoyer automatiquement des données d’entraînement à nikeplus.com :
1 Assurez-vous que votre ordinateur est connecté à Internet, puis connectez votre 
iPod nano à votre ordinateur.
2 Ouvrez iTunes sur votre ordinateur, cliquez sur l’onglet Nike + iPod, puis sélectionnez 
« Envoyer automatiquement les données de séance vers nikeplus.com ».
3 Cliquez sur « Visiter nikeplus.com » en dessous de la case ou, si vous avez déjà 
configuré votre séance pour qu’elle soit envoyée automatiquement, cliquez sur Visiter 
dans la zone de dialogue qui apparaît.50
Le site web nikeplus.com s’ouvre sur une représentation graphique montrant 
les données de votre entraînement le plus récent.
4 Cliquez sur Mes courses, puis connectez-vous ou inscrivez-vous si vous ne l’avez pas 
déjà fait.
Consultez le site nikeplus.com pour vous informer de la politique de confidentialité et 
des conditions générales de Nike.
Visionnage de séances d’entraînement sur votre dispositif
Votre iPod nano, votre iPhone ou votre iPod touch enregistre la date, l’heure, la durée, la 
distance, le rythme et les calories dépensées des mille dernières séances d’entraînement.
Pour consulter les séances d’entraînement récentes sur votre dispositif :
m iPod nano (5e génération ou antérieure) :  sélectionnez Nike + iPod > Historique.
m iPod nano (6e génération) :  choisissez Fitness > Historique, au bas de l’écran.
m iPhone et iPod touch :  choisissez Nike + iPod, puis sélectionnez Historique, dans le bas 
de l’écran;
L·iPod nano (5e génération ou antérieur) fournit des totaux quotidiens de vos séances :  
séances Nike + iPod, avec podomètre ou séance cardio avec utilisation d’équipement 
compatible avec Nike + iPod.
Pour consulter les séances d’entraînement sur un iPod nano (5e génération ou 
antérieur) :
1 Choisissez Total quotidien dans le menu Historique.
2 Choisissez une date et une activité.
3 Faites pivoter l’iPod nano (5e génération) en position paysage pour afficher un 
graphique de l’activité.51
Pour supprimer une seule séance d’entraînement :
m iPod nano (5e génération ou antérieure) :  sélectionnez Nike + iPod > Historique. 
choisissez une session d’entraînement, maintenez le bouton central enfoncé, 
puis choisissez Supprimer.
Il est impossible de supprimer des séances individuelles sur un iPod nano (6e génération). 
m iPhone et iPod touch :  sélectionnez Nike + iPod > Historique. sélectionnez Modifier, 
choisissez une session d’entraînement, puis sélectionnez Supprimer.
Sur l’iPhone, l’iPod touch et l’iPod nano (6e génération), vous pouvez supprimer toutes 
les séances d’entraînement dans l’historique en appuyant sur Effacer dans le haut de 
l’écran Historique.
Création de raccourcis personnalisés vers des séances d’entraînement
Les raccourcis personnalisés vers des séances d’entraînement vous permettent de 
choisir et de recommencer une séance. L’iPod nano(4e génération ou ultérieure) 
enregistre automatiquement vos séances terminées sous forme de raccourcis. 
L’iPhone et l’iPod touch vous permettent aussi de créer des raccourcis personnalisés 
vers des séances.
Pour créer un raccourci personnalisé vers une séance sur un iPhone ou un 
iPod touch :
1 Choisissez Nike + iPod, puis sélectionnez Mes séances dans le bas de l’écran.
2 Sélectionnez Plus (+), puis choisissez le type de séances et l’objectif de la séance.
3 Choisissez la musique, saisissez le nom de la séance, puis sélectionnez Enregistrer.
Remarque :  il n’est possible de créer des raccourcis personnalisés vers des séances 
d’entraînement que sur l’iPhone et l’iPod touch (2e génération ou ultérieure).52
Pour supprimer un raccourci personnalisé vers une séance sur un iPhone ou un 
iPod touch :
m Choisissez Nike + iPod, puis sélectionnez Mes séances. Sélectionnez Modifier, choisissez 
un raccourci, puis sélectionnez Supprimer. 
Pour choisir un raccourci de séance personnalisé :
m iPod nano (4e et 5e génération) :  choisissez Nike + iPod, puis sélectionnez un raccourci. 
Les raccourcis sont nommés selon le type de séance et de musique. Il n’est pas possible 
de les supprimer.
m iPod nano (6e génération) :  choisissez Fitness > Course, puis sélectionnez Mes séances. 
Choisissez un raccourci. Les raccourcis sont nommés selon le type de séance et de 
musique. Il n’est pas possible de les supprimer.
m iPhone et iPod touch :  choisissez Nike + iPod, puis sélectionnez Mes séances. 
Les raccourcis sont classés en fonction du nom que vous avez choisi au moment 
de leur création.
Le raccourci de séance personnalisé le plus récent figure au début de la liste.
Achat de séances d’entraînement Nike+
Vous pouvez acheter et télécharger des séances d’entraînement Nike+ contenant 
de la musique en continu et des conseils d’entraînement professionnels. Lorsque 
vous achetez une séance d’entraînement Nike+, vous obtenez une seule piste 
d’entraînement avec de la musique et des commentaires vocaux, ainsi que tous les 
morceaux de musique qui composent cette piste. Choisissez des morceaux selon votre 
niveau et votre style d’entraînement.53
Pour acheter une séance d’entraînement Nike+ :
1 Ouvrez iTunes, cliquez sur iTunes Store dans la partie gauche de la fenêtre, 
puis saisissez « Nike Sport Music » dans le champ de recherche iTunes.
2 Cliquez sur le bouton Acheter en regard de la séance d’entraînement Nike+ de votre 
choix.
3 Suivez les instructions à l’écran pour terminer l’achat. Le téléchargement commence 
immédiatement.
4 Connectez le dispositif à votre ordinateur et chargez la séance sur le dispositif.
Remarque :  l’iTunes Store n’est disponible que pour les personnes de 13 ans et plus, 
aux États-Unis et dans beaucoup d’autres pays. Pour obtenir la liste de ces pays, 
consultez la page www.apple.com/fr/itunes/download. L’utilisation du site est soumise 
à certaines conditions. Vous devez disposer d’un accès à Internet (éventuellement 
payant) pour utiliser l’iTunes Store.
Jumelage d’une télécommande compatible Nike + iPod ou d’un 
cardiofréquencemètre
Les appareils compatibles Nike + iPod sont vendus séparément du kit sportif 
Nike + iPod et du capteur Nike + iPod.
Vous avez la possibilité d’utiliser une télécommande compatible pour contrôler sans fil 
le système Nike + iPod au cours de votre séance d’entraînement.
L’iPod nano (5e génération ou ultérieure) prend également en charge les moniteurs 
cardiaques compatibles Nike + iPod.
Remarque :  le récepteur iPod + Nike doit être connecté à votre iPod nano 
(6e génération) pour utiliser un cardiofréquencemètre ou une télécommande.54
Avant d’utiliser l’un de ces appareils pour la première fois, vous devez le jumeler avec 
votre récepteur iPod nano, votre iPhone ou votre iPod touch.
Pour jumeler une télécommande compatible Nike + iPod (vendue séparément) :
m iPod nano (5e génération ou antérieure) :  connectez votre récepteur Nike + iPod à 
l’iPod nano, choisissez Nike + iPod > Réglages > Télécommande > Jumeler, puis suivez 
les instructions à l’écran.
m iPod nano (6e génération) :  choisissez Réglages > Fitness > Nike + iPod Sport Kit > 
Télécommande. Activez l’option Télécommande et appuyez sur Jumeler.
m iPhone et iPod touch :  choisissez Réglages > Nike + iPod > Télécommande, puis suivez 
les instructions à l’écran.
Pour jumeler un cardiofréquencemètre compatible Nike+ iPod (vendu séparément) :
m iPod nano (5e génération) :  connectez votre récepteur Nike + iPod à l’iPod nano, 
choisissez Nike + iPod > Réglages > Cardiofréquencemètre > Jumeler, puis suivez 
les instructions à l’écran.
m iPod nano (6e génération) :  choisissez Réglages >Fitness >Nike + iPod Sport Kit > 
Cardiofréquencemètre > Jumeler, puis suivez les instructions à l’écran.
Pour supprimer le jumelage d’un appareil :
m iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages > 
Télécommande (ou Cardiofréquencemètre) > Supprimer, puis suivez les instructions 
à l’écran.
m iPod nano (6e génération) :  choisissez Réglages > Fitness > Nike + iPod Sport Kit > 
Télécommande (ou Cardiofréquencemètre), puis appuyez sur Supprimer.
m iPhone et iPod touch :  choisissez Réglages > Nike + iPod > Télécommande, puis appuyez 
sur Supprimer.55
Vous pouvez activer ou désactiver les fonctions d’une télécommande compatible 
Nike + iPod sans supprimer le jumelage avec l’appareil.
Pour activer ou désactiver la fonction télécommande :
m iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages > 
Télécommande, puis activez ou désactivez-la.
m iPod nano (6e génération) :  choisissez Réglages > Fitness > Nike + iPod Sport Kit > 
Télécommande, puis activez ou désactivez-la.
m iPhone et iPod touch :  choisissez Réglages > Nike + iPod > Télécommande, puis jumelez 
ou supprimez le jumelage de la télécommande.
Entraînement avec un iPod Nano (6e génération) et un 
cardiofréquencemètre
Si vous disposez d’un iPod nano (6e génération) et d’un cardiofréquencemètre 
compatible avec Nike + iPod (vendu séparément), l’iPod nano peut enregistrer et 
afficher votre fréquence cardiaque pendant que vous vous entraînez. Vous pouvez 
également spécifier une plage ou « zone » de fréquences cardiaques maximales et 
minimales à respecter durant l’entraînement et contrôler votre capacité à maintenir 
votre fréquence cardiaque au sein de cette zone pendant que vous vous entraînez. 
Pendant que vous vous entraînez, l’iPod nano affiche votre fréquence cardiaque 
actuelle et une flèche pointant vers le haut ou vers le bas apparaît lorsque vous devez 
augmenter ou diminuer votre activité. L’usage d’un cardiofréquencemètre est possible 
durant n’importe quelle séance d’entraînement standard.56
Le contrôle de votre fréquence cardiaque peut s’appliquer à d’autres activités 
que la course ou la marche. Vous pouvez, par exemple, utiliser un iPod nano et un 
cardiofréquencemètre lorsque vous participez à des activités sportives comme le 
basket-ball, l’aérobic, l’entraînement en circuit, le golf, la randonnée, le football et bien 
plus encore. 
Une fois votre entraînement terminé, vos données de fréquence cardiaque peuvent 
être transférées sur votre compte nikeplus.com où vous pourrez les consulter.
Lorsque vous configurez une séance d’entraînement, vous pouvez déterminer une 
zone de fréquences cardiaques maximales et minimales à maintenir durant l’activité 
que vous choisissez. Pour cela, il faut d’abord activer la fonction de séance avec zone.
Pour activer ou désactiver les séances avec zone :
m Appuyez sur Réglages > Fitness > Nike + iPod Sport Kit, puis sur le bouton de 
marche/arrêt dans Séance avec zone.
Si vous activez les séances avec zone et que vous sélectionnez un entraînement, 
des options de définition d’une zone de fréquences cardiaques vous sont proposées. 
Pendant que vous vous entraînez, les données de fréquence cardiaque sont 
enregistrées et affichées quel que soit le type d’entraînement choisi. 
L’iPod nano (6e génération) propose également un entraînement avec contrôle de 
la fréquence cardiaque. Pour effectuer ce type d’entraînement, vous devez d’abord 
spécifier la zone de fréquences cardiaques à maintenir, puis choisir un type d’activité. 
Toutes vos données de fréquence cardiaque sont automatiquement enregistrées. 
Lorsque vous effectuez un entraînement avec contrôle de la fréquence cardiaque, 
il n’est pas nécessaire d’équiper votre chaussure d’un capteur de détection de 
mouvement.57
Pour démarrer un entraînement avec contrôle de la fréquence cardiaque :
1 Appuyez sur Fitness > Course > Fréquence cardiaque.
2 Déterminez la zone de fréquences cardiaques souhaitée.
3 Choisissez une activité et appuyez sur OK.
4 Choisissez la musique d’entraînement souhaitée.
5 Appuyez sur Commencer l’entraînement.
6 Une fois l’entraînement terminé, appuyez sur le bouton de marche/veille pour réactiver 
l’écran, appuyez sur l’écran pour faire apparaître le bouton Pause et appuyez sur celui-ci, 
puis sur Terminer pour terminer votre séance d’entraînement.
Lorsque vous avez terminé une séance d’entraînement avec contrôle de la fréquence 
cardiaque, vous pouvez transférer les données enregistrées sur votre compte nikeplus.
com comme vous le faites pour tous les autres types d’entraînement. 
Jumelage avec un autre capteur
Une fois que votre dispositif est jumelé avec un capteur particulier, il ne peut 
fonctionner qu’avec ce dernier. Si vous souhaitez utiliser un autre capteur, vous devez 
régler le dispositif pour le jumeler avec le nouveau capteur. Cela peut être utile si, par 
exemple, plusieurs membres de votre famille possèdent un capteur et des chaussures 
compatibles Nike+.
Pour jumeler le récepteur avec un autre capteur :
1 iPod nano :  connectez le récepteur à l’iPod.
2 Enfilez les chaussures dotées du nouveau capteur et assurez-vous qu’il n’y a aucun 
autre capteur Nike + iPod à proximité.
Marchez un petit peu pour activer le capteur afin que votre récepteur puisque le détecter.58
3 Jumeler le capteur à votre appareil :
Â iPod nano (5e génération ou antérieure) :  choisissez Nike + iPod > Réglages >Capteur > 
Jumeler, puis suivez les instructions à l’écran. Un message indique que l’iPod est 
maintenant jumelé avec le nouveau capteur.
Â iPod nano (6e génération) :  choisissez Réglages > Fitness > Nike + iPod Sport Kit > 
Capteur, appuyez sur Jumeler, puis touchez l’écran durant votre marche ou votre 
course pour rejumeler l’appareil à l’autre capteur.
Â iPhone et iPod touch :  choisissez Réglages > Nike + iPod > Capteur, appuyez sur Autre, 
puis suivez les instructions à l’écran.
Remarque :  si vous jumelez le récepteur avec un capteur ayant déjà été jumelé, 
Nike + iPod détecte vos réglages d’étalonnage. Il est inutile de l’étalonner à nouveau.
Si vous connectez le récepteur d’un iPod à un autre iPod et que vous l’utilisez avec le 
même capteur, il est inutile de refaire le jumelage ou l’étalonnage. Le récepteur stocke 
vos réglages, votre historique de séances et vos raccourcis vers vos séances. Il est inutile 
de rétablir le jumelage ou de l’étalonner à nouveau.59
Mise en veille du capteur Nike + iPod
Le capteur est éveillé et activé par défaut. Si vous souhaitez stocker le capteur pendant 
une période prolongée ou l’empêcher de transmettre, mettez-le en veille.
Important :  mettez le capteur en veille avant de l’emporter à bord d’un avion, 
conformément à la réglementation en vigueur.
Pour mettre en veille le capteur :
m Utilisez un stylo ou un trombone pour maintenir enfoncé le bouton de marche/veille 
pendant trois secondes.
Bouton Marche/Veille
Pour réactiver le capteur :
m Utilisez un stylo ou un trombone pour appuyer sur le bouton de marche/veille.60
Informations importantes sur la sécurité
ATTENTION :  le non-respect de ces instructions de sécurité peut provoquer des 
dommages physiques ou corporels.
Exercices  Avant de commencer un programme d’exercices, demandez à votre 
médecin de vous faire passer un examen physique complet. Effectuez des exercices 
d’échauffement ou d’étirement musculaire avant de commencer votre séance 
d’entraînement. Soyez prudent et attentif pendant vos exercices physiques. 
Ralentissez, le cas échéant, avant de régler votre dispositif pendant la course. 
Arrêtez immédiatement de courir en cas de douleur, de faiblesse, d’étourdissement, 
d’épuisement ou d’essoufflement. En pratiquant un exercice physique, vous assumez 
les risques inhérents à ce type d’activités, y compris les blessures qui pourraient en 
résulter.
N’utilisez pas le récepteur ou l’iPhone ou l’iPod dans ou près de l’eau ou dans tout 
autre lieu humide.
Risque d’étouffement  Le récepteur et le capteur présentent des risques potentiels 
d’étouffement. Gardez-les hors de portée des enfants de moins de trois ans.61
Prévention des dommages auditifs  L’utilisation des écouteurs à un volume trop 
élevé peut entraîner une perte d’audition permanente. Réglez le volume sur un niveau 
raisonnable. Il est possible de s’habituer petit à petit à un volume sonore élevé qui, s’il 
peut sembler normal, risque néanmoins d’entraîner des troubles auditifs. Si vos oreilles 
bourdonnent ou si les sons vous semblent étouffés, arrêtez l’écoute et faites vérifier 
votre audition par un spécialiste. Plus le volume est élevé, plus vous risquez d’abîmer 
rapidement votre audition. Les spécialistes de l’audition recommandent de prendre 
les précautions suivantes :
Â Limitez la durée d’utilisation d’écouteurs à volume sonore élevé.
Â Évitez d’augmenter le volume pour vous isoler du bruit ambiant.
Â Diminuez le volume si vous n’entendez plus les personnes qui parlent autour de vous.
Démontage du capteur  N’essayez jamais d’ouvrir le capteur, de le démonter ni de 
retirer la batterie. L’appareil ne contient pas de pièces pouvant être réparées par 
l’utilisateur.62
Informations supplémentaires, service et assistance
Pour en savoir plus sur : Procédez ainsi :
Les réponses aux questions fréquemment 
posées sur Nike + iPod
Rendez-vous sur 
www.apple.com/fr/support/nikeplus.
Le service et l’assistance pour le capteur et le 
récepteur Nike + iPod
Rendez-vous sur 
www.apple.com/fr/support/nikeplus.
Le service et l’assistance pour les chaussures 
compatibles Nike+ ou le site web nikeplus.com
Rendez-vous sur www.nikeplus.com.
L’utilisation d’iTunes Ouvrez iTunes et choisissez Aide > Aide iTunes.
L’utilisation de l’iPod nano ou de l’iPod touch Rendez-vous sur 
www.apple.com/fr/support/ipod.
L’utilisation d’iTunes Rendez-vous sur 
www.apple.com/fr/support/iphone.63
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Willkommen bei Nike + iPod
Ihr persönlicher Fitnesstrainer
Nike + iPod ist Trainingspartner und Trainer in einem. Wählen Sie die gewünschte 
Trainingsart aus – normales Training ohne besonderes Ziel, Training mit Streckenvorgabe, Training mit Zeitvorgabe oder Training mit Kalorienverbrauchsvorgabe – wählen 
Sie eine Musik zur Motivationsunterstützung aus und verfolgen Sie dann Ihren 
Trainingsfortschritt mithilfe des audio-visuellen Feedbacks. Senden Sie Ihre Trainingsdaten an nikeplus.com, hier können Sie Ihr persönliches Trainingsziel angeben und 
Ihren Leistungsfortschritt von Training zu Training überwachen. Sie können auch 
Mitglied in der weltweit größten Online-Joggergemeinschaft werden und an Wettkämpfen mit anderen Joggern auf dem ganzen Globus teilnehmen.
Nike + iPod wird vom iPhone 3GS, iPhone 4, allen iPod nano-Modellen
1
 und dem 
iPod touch (2. Generation oder neuer) unterstützt.
iPod nano
(alle Modelle)
iPod touch
(2. Generation oder neuer)
iPhone 3GS
oder neuer
1  
Für den iPod nano (6. Generation) ist der Nike + iPod-Sensor optional und nur für Trainings mit dem 
Polar Wearlink® + Heart Rate Transmitter for Nike+ erforderlich.65
Einführung
Befolgen Sie die nachstehenden Anleitungen, um Nike + iPod sofort zu verwenden.
Schritt 1: Aktivieren Sie Nike + iPod auf Ihrem Gerät.
m iPod nano (5. Generation oder älter):  Schließen Sie den Nike + iPod-Empfänger an den 
iPod nano an. Nike + iPod wird im Hauptmenü angezeigt.
m iPod nano (6. Generation):  Schließen Sie den Nike + iPod-Empfänger an den iPod nano 
an. Tippen Sie auf „Fitness“.
Hinweis: Ihr iPod nano (6. Generation) kann Ihre Trainingsdaten optional auch ohne 
den Nike + iPod-Empfänger und -Sensor aufzeichnen. Weitere Informationen finden 
Sie im iPod nano-Benutzerhandbuch, das Sie mit dem Gerät erhalten haben. 
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ und dann „Ein“ aus.
Auf dem Home-Bildschirm wird ein Nike + iPod-Symbol angezeigt.
Hinweis: Ihr iPhone 3GS (oder neuer) und iPod touch besitzen einen internen 
Empfänger, daher ist kein externer Empfänger erforderlich. 66
Schritt 2: Vergewissern Sie sich, dass Sie die neuste iPod- und iTunes-Software 
verwenden.
1 Laden und installieren Sie die neuste  iTunes-Software auf Ihrem Computer von der 
Website www.apple.com/de/itunes.
2 Verbinden Sie Ihr Gerät mit Ihrem Computer, wählen Sie es in der iTunes-Seitenleiste 
aus und klicken Sie auf „Übersicht“.
3 Wird in iTunes die Meldung angezeigt, dass Ihr Gerät aktualisiert werden muss, klicken 
Sie auf „Aktualisieren“ und befolgen Sie die Anleitungen auf dem Bildschirm.
Schritt 3: Legen Sie den Nike + iPod-Sensor in Ihren Nike+ kompatiblen Schuh.
m Heben Sie hierfür die Innensohle Ihres linken Schuhs an, entfernen Sie die Schaumstofffüllung aus der Aussparung und legen Sie dort den Sensor mit der flachen Seite nach 
oben hinein.
Sensor67
Sie können den Sensor in Ihrem Schuh lassen, auch wenn Sie nicht trainieren. Wenn Sie 
jedoch die Schuhe längere Zeit ohne Training tragen, tauschen Sie den Sensor wieder 
durch die Schaumstofffüllung aus, um die Batterielebensdauer zu verlängern.
Die Batterie des Sensors, die eine Lebensdauer von bis zu 1000 aktiven Stunden hat, 
kann nicht ausgetauscht oder wieder aufgeladen werden. Die Batterielebensdauer 
variiert abhängig von der Verwendung und anderen Faktoren.
Schritt 4: Wählen Sie die gewünschte Trainingsart bzw. Option.
Für folgende Funktion Aktion
Open-End-Training iPod nano (5. Generation oder älter): Wählen Sie „Nike+iPod“ > 
„Nike+iPod“ > „Normal“.
iPod nano (6. Generation): Wählen Sie „Fitness“ > „Nike+iPod“ > 
„Normal“. 
iPhone und iPod touch: Wählen Sie „Nike+iPod“ > „Normal“.
Training mit Zeitvorgabe iPod nano (5. Generation oder älter): Wählen Sie „Nike+iPod“ > 
„Nike+iPod“ > „Zeit“.
iPod nano (6. Generation): Wählen Sie „Fitness“ > „Laufen“ > „Zeit“. 
iPhone und iPod touch:  Wählen Sie „Nike+iPod“ > „Zeit“.
Training mit 
Streckenvorgabe
iPod nano (5. Generation oder älter): Wählen Sie „Nike+iPod“ > 
„Nike+iPod“ > „Strecke“.
iPod nano (6. Generation): Wählen Sie „Fitness“ > „Laufen“ > „Strecke“. 
iPhone und iPod touch: Wählen Sie „Nike+iPod“ > „Strecke“.68
Training mit Vorgabe für 
Kalorienverbrauch
iPod nano (5. Generation oder älter): Wählen Sie „Nike+iPod“ > „Einstellungen“ > „Gewicht“ und geben Sie Ihr Gewicht ein. Drücken Sie 
dann die Taste „Menu“ und wählen Sie „Nike+iPod“ > „Nike+iPod“ > 
„Kalorien“.
iPod nano (6. Generation): Wählen Sie „Einstellungen“ > „Fitness“ > 
„Gewicht“ und geben Sie Ihr Gewicht ein. Wählen Sie „Fitness“ > 
„Laufen“ > „Kalorien“. 
iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ 
> „Gewicht“ und geben Sie Ihr Gewicht ein. Drücken Sie dann die 
Home-Taste und wählen Sie „Nike+iPod“ > „Kalorien“.
Hinweis:^>Ihr Gewicht müssen Sie nur eingeben, wenn Sie das 
erste Mal ein Training mit Kalorienverbrauchsvorgabe beginnen.
Schritt 5: Wählen Sie Ihre Trainingsmusik.
Für Folgendes Wählen Sie
Nike+ Trainingsmusik die Trainingsmusik (vgl. Seite 84). 
Musiktitel, der gerade spielt die Option „Sie hören“.
Genius-Mix die Option „Genius-Mixe“ (iPod nano 6. Generation).
Titel von einer Wiedergabeliste die Option „Wiedergabelisten“ und dann die gewünschte 
Liste.
Podcast die Option „Podcast“ (iPod nano 6. Generation).
Hörbuch die Option „Hörbücher“ (iPod nano 6. Generation).
Titel in beliebiger Reihenfolge die Option „Zufällige Titel“.
Radiosender die Option „Radio“. iPod nano (6. Generation):
Keine Musik die Option „Nichts“.69
Schritt 6: Beginnen Sie Ihr Training.
Gehen oder laufen Sie einige Schritte, um den Sensor zu aktivieren. Wenn das Gerät 
den Sensor erkennt und die Verbindung herstellt, können Sie mit Ihrem Training 
beginnen.
m iPod nano (5. Generation oder älter):  Drücken Sie die Mitteltaste und gehen oder 
laufen Sie.
m iPod nano (6. Generation):  Tippen Sie auf „Training starten“ und gehen oder laufen Sie.
m iPhone und iPod touch:  Tippen Sie auf „Start“ und gehen oder laufen Sie.
Schritt 7: Beobachten Sie Ihren Trainingsfortschritt.
Nike + iPod zeigt Ihnen automatisch den Trainingsstatus auf dem Bildschirm an, der 
ungefähr wie in der folgenden Abbildung aussieht. (Abhängig von Ihrem Gerätetyp 
kann der Bildschirm anders aussehen.)
iPod nano 
(6. Generation)
iPhone3GS oder neuer 
und iPod touch70
Während des Trainings erhalten Sie mit Nike + iPod Audio-Feedback zu Ihrem Trainingsfortschritt (vgl. „Hören von Audio-Feedback“ auf Seite 77). Sie können das Feedback jederzeit abrufen.
Das Audio-Feedback manuell abrufen
m iPod nano (5. Generation oder älter):  Drücken Sie beim Training zu jeder beliebigen Zeit 
die Mitteltaste.
m iPod nano (6. Generation):  Drücken Sie beim Training zu jeder beliebigen Zeit die 
Standby-Taste.
m iPhone und iPod touch:  Drücken Sie beim Training zu jeder beliebigen Zeit die 
Home-Taste.
Hinweis: iPhone und iPod touch müssen gesperrt sein, damit Sie das Audio-Feedback 
manuell abrufen können (vgl. „Hören von Audio-Feedback“ auf Seite 77).
Schritt 8: Beenden Sie Ihr Training.
Sie können Ihr Training jederzeit beenden. Wenn Sie Ihr Training fortsetzen, nachdem 
Sie Ihre Zeit-, Strecken- oder Kalorienvorgabe erreicht haben, wird Ihr Trainingsfortschritt weiterhin aufgezeichnet.
Training beenden
m iPod nano (5. Generation oder älter):  Drücken Sie die Taste „Start/Pause“ (’), um Ihr 
Training zu unterbrechen. Drücken Sie die Taste „Menu“ und wählen Sie „Training Aus“.
m iPod nano (6. Generation):  Tippen Sie auf den Bildschirm, um die Taste „Pause“ anzuzeigen. Tippen Sie dann auf „Pause“. Tippen Sie auf „Training Aus“. Ist der Bildschirm aus, 
drücken Sie die Standby-Taste.
Hinweis: Drücken Sie auf einem iPod nano (6. Generation) zweimal die Standby-Taste, 
um Ihr Training schnell zu unterbrechen bzw. fortzusetzen.71
m iPhone und iPod touch:  Tippen Sie auf „Training Aus“. Sind iPhone oder iPod touch gesperrt, drücken Sie die Home-Taste und tippen Sie auf „Pause“. Schieben Sie den Pfeil 
mit dem Finger nach rechts und tippen Sie auf „Training Aus“.
Schritt 9: Verwalten Sie Ihre Trainingsdaten auf nikeplus.com.
Auf nikeplus.com können Sie Ihren Leistungsfortschritt in einem bestimmten Zeitraum 
überprüfen, Ihre Trainingseinheiten ansehen, Zielvorgaben festlegen bzw. überprüfen 
und Ihre Ergebnisse mit anderen Benutzern vergleichen. Sie können sogar mit anderen 
Nike + iPod-Benutzern Online-Wettkämpfe veranstalten.
Wenn Sie ein iPhone oder einen iPod touch besitzen, können Sie Ihre Trainingsdaten 
auch per Funk an die Nike-Website senden. Wenn Sie einen iPod nano besitzen, können 
Sie Ihre Trainingsdaten von Ihrem Computer aus an die Nike-Website senden.
Es empfiehlt sich, vor dem Senden der Trainingsdaten zunächst einen nikeplus.comAccount einzurichten. Befolgen Sie die Anleitungen auf der nikeplus.com-Website, um 
einen kostenlosen Account einzurichten. 
Trainingsdaten per Funk von einem iPhone oder iPod touch an nikeplus.com senden
1 Stellen Sie sicher, dass Ihr Gerät mit dem Internet verbunden ist und wählen Sie dann 
„Nike+iPod“.
Wenn eine Trainingseinheit noch nicht mit Ihrem nikeplus.com-Account synchronisiert 
wurde, wird auf der Taste „Übersicht“ ein kleiner roter Punkt angezeigt.
2 Tippen Sie auf „Übersicht“, um Ihre Trainingseinheiten anzusehen.
3 Tippen Sie auf „An Nike+ senden“, um Ihre Trainingsdaten an nikeplus.com zu senden. 
Sie können dies auch später nachholen.72
4 Geben Sie Ihre E-Mail-Adresse und das Kennwort für den nikeplus.com-Account ein 
und tippen Sie auf „Bei Nike + anmelden“.
Nach dem Anmelden werden Ihre Trainingsdaten an Ihren nikeplus.com-Account 
gesendet.
Besitzen Sie noch keinen nikeplus.com-Account, tippen Sie auf „Bei Nike+ mitmachen“. 
Befolgen Sie anschließend die angezeigten Anleitungen zum Erstellen eines Accounts.
Die Website „nikeplus.com“ wird geöffnet und Ihre neusten Trainingsdaten werden in 
einem Diagramm dargestellt.
5 Befolgen Sie die Anleitungen auf dem Bildschirm zum Zugriff auf Ihre Trainingsdaten.
Ihre iPod nano-Trainingsdaten von Ihrem Computer an nikeplus.com senden
1 Stellen Sie sicher, dass Ihr Computer mit dem Internet verbunden ist, und schließen Sie 
iPod nano an den Computer an.
2 Klicken Sie auf „Senden“, wenn Sie in einem Dialogfenster gefragt werden, ob Sie die 
Daten an nikeplus.com senden wollen. Sie können dies auch später nachholen.
3 In einem weiteren Dialogfenster werden Sie gefragt, ob Sie die Verbindung zu nikeplus.
com herstellen wollen. Klicken Sie auf „Verbinden“.
Die Website „nikeplus.com“ wird geöffnet und Ihre neusten Trainingsdaten werden in 
einem Diagramm dargestellt.
4 Klicken Sie auf die Option zum Sichern Ihrer Läufe und dann auf „Registrieren“. 
Befolgen Sie die angezeigten Anleitungen.73
Verwenden von Nike + iPod
Befolgen Sie die nachstehenden Anleitungen, um möglichst viel Nutzen und Freude 
mit Nike + iPod zu haben.
Kalibrieren von Nike + iPod
Die Standardkalibrierung für Nike + iPod ist für die meisten Benutzer ausreichend 
genau. Sie können die Genauigkeit verbessern, indem Sie Nike + iPod auf Ihr persönliches Gehen und Laufen kalibrieren. Auf einem iPod nano können Sie ein Kalibrierungstraining über eine bestimmte Strecke ausführen oder Ihr letztes Training verwenden 
und die Strecke eingeben. Auf einem iPhone oder einem iPod touch können Sie für die 
Kalibrierung Ihr letztes beendetes Training verwenden, dessen Strecke Sie kennen.
Nike + iPod fürs Gehen oder Laufen mit einem iPod nano (5. Generation oder älter) 
kalibrieren
1 Wählen Sie „Nike+iPod“ > „Einstellungen“ > „Sensor“ > „Kalibrieren“.
2 Wählen Sie „Laufen“ oder „Gehen“ und legen Sie eine Strecke fest.
Optimale Ergebnisse werden mit einer mindestens 400 m langen Strecke erzielt. Die 
kürzeste Kalibrierungsdistanz, die Sie eingeben können, sind ca. 100 m.
3 Drücken Sie die Mitteltaste.
4 Laufen oder gehen Sie die gewählte Strecke in einem gleichmäßigen natürlichen 
Tempo.
5 Drücken Sie die Mitteltaste und wählen Sie „Kalibrieren fertig“.
Auf dem Bildschirm sehen Sie, ob die Kalibrierung erfolgreich war. Wiederholen Sie 
die Schritte 1-5, wenn Sie die Kalibrierung für Ihr Lauf- und Ihr Gehtempo vornehmen 
wollen.74
Hinweis: Auch nach dem Kalibrieren kann die Genauigkeit von Streckenmessungen 
je nach Gangart, Beschaffenheit des Weges, Steigung oder Temperatur unterschiedlich 
ausfallen.
Sie können einen iPod nano mit den Daten Ihrer soeben abgeschlossenen Trainingseinheit kalibrieren. Dies ist nützlich, wenn Sie eine Strecke gelaufen sind, die nicht der auf 
dem Gerät angezeigten Gesamtstrecke entspricht.
Kalibrierung eines iPod nano (5. Generation oder älter) mit den Daten Ihres letzten 
abgeschlossenen Trainings vornehmen
m Wählen Sie „Training Aus“ und drücken Sie die Mitteltaste und halten Sie sie gedrückt. 
Wählen Sie dann „Kalibrieren“. 
Geben Sie die korrekte Strecke ein, die Sie gelaufen oder gegangen sind. Drücken Sie 
dann die Mitteltaste.
Das Gerät erkennt, ob die Strecke gelaufen oder gegangen wurde. Es verwendet dann 
die neue Kalibrierung statt der vorhandenen.
Nike + iPod fürs Gehen oder Laufen mit einem iPod nano (6. Generation) kalibrieren
1 Wählen Sie „Einstellungen“ > „Fitness“ > „Nike+iPod-Sport Kit“ > „Sensor“ > „Kalibrieren“.
2 Wählen Sie „Kalibrierung (Gehen)“ oder „Kalibrierung (Laufen)“. Wählen Sie dann die 
Strecke aus und tippen Sie auf „Fertig“.
Optimale Ergebnisse werden mit einer mindestens 400 m langen Strecke erzielt. Die 
kürzeste Kalibrierungsdistanz, die Sie eingeben können, sind ca. 100 m.
3 Wählen Sie Ihre Trainingsmusik.
4 Laufen oder gehen Sie die gewählte Strecke in einem gleichmäßigen natürlichen 
Tempo.75
5 Drücken Sie die Standby-Taste, wenn der Bildschirm aus ist. Tippen Sie auf den 
Bildschirm, um die Taste „Pause“ anzuzeigen. Tippen Sie dann auf „Stopp“.
Auf dem Bildschirm sehen Sie, ob die Kalibrierung erfolgreich war. Wiederholen Sie die 
Schritte 1-5, wenn Sie die Kalibrierung für Ihr Lauf- und Ihr Gehtempo vornehmen wollen.
Hinweis: Auch nach dem Kalibrieren kann die Genauigkeit von Streckenmessungen 
je nach Gangart, Beschaffenheit des Weges, Steigung oder Temperatur unterschiedlich 
ausfallen.
Mit einem iPhone oder iPod touch können Sie Nike + iPod mit den Daten Ihrer soeben 
abgeschlossenen Trainingseinheit kalibrieren. Zum Kalibrieren können Sie nur Trainingseinheiten mit einer Strecke von mindestens 100 m verwenden. 
Kalibrierung von iPhone oder iPod touch mit den Daten Ihres letzten abgeschlossenen Trainings vornehmen
m Tippen Sie auf „Training Aus“ und dann auf „Kalibrieren“. Geben Sie dann die korrekte 
gelaufene oder gegangene Strecke an. Tippen Sie auf „Fertig“.
Das Gerät verwendet die neue Kalibrierung und überschreibt die vorhandene für die 
Geh- oder Laufgeschwindigkeit.
Die Nike + iPod-Kalibrierung auf Standardwerte zurücksetzen
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ > „Sensor“ 
> „Kalibrieren“ > „Gehen zurücksetzen“ (oder „Laufen zurücksetzen“).
m iPod nano (6. Generation): Wählen Sie „Einstellungen“ > „Fitness“ > „Nike+iPod-Sport 
Kit“ > „Sensor“ > „Kalibrieren“ > „Gehen zurücksetzen“ (oder „Laufen zurücksetzen“) > 
„Zurücksetzen“.
m iPhone und iPod touch: Wählen Sie „Einstellungen“ > „Nike+iPod“ und tippen dann auf 
„Kalibrierung zurücksetzen“. 76
Festlegen der Maßeinheit für die Strecke
Mit Nike + iPod können Sie Ihre Trainingsstrecke in Kilometern oder in Meilen messen.
Maßeinheit für die Strecke festlegen
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ und für 
„Strecke“ entweder „Kilometer“ oder „Meilen“.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „Strecke“ und dann 
„Kilometer“ oder „Meilen“.
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Strecke“ und dann 
„Kilometer“ oder „Meilen“.
Eingeben des Gewichts
Gewicht eingeben
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ > 
„Gewicht“ und geben Sie Ihr Gewicht ein.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „Gewicht“ und geben 
Sie Ihr Gewicht ein.
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Gewicht“ und 
geben Sie Ihr Gewicht ein.
Damit der Kalorienverbrauch präzise errechnet werden kann, sollten Sie mit steigender 
Fitness die Gewichtsangabe aktualisieren.
Sperren Ihres Geräts beim Trainieren
Sie können das iPhone oder den iPod touch sperren, sodass die Bedienelemente 
während des Trainings nicht versehentlich aktiviert werden können.77
iPhone oder iPod touch sperren
m Drücken Sie die Standby-Taste.
Zum Aufheben der Sperre drücken Sie die Standby-Taste bzw. die Home-Taste und 
schieben den Regler mit dem Finger nach rechts.
Hören von Audio-Feedback
Während Sie trainieren, hören Sie, wie Nike + iPod Ihnen regelmäßig Audio-Feedback 
zu Ihrem Trainingsstatus gibt. Sie können zwischen einer Frauen- oder Männerstimme 
wählen oder das Feedback deaktivieren.
Die Stimme für das Audio-Feedback festlegen bzw. das Audio-Feedback deaktivieren
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ und stellen Sie „Audio-Feedback“ auf „Männlich“, „Weiblich“ oder „Aus“.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „Audio-Feedback“ 
und dann „Männlich“, „Weiblich“ oder „Aus“.
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Audio-Feedback“ 
und dann „Männlich“, „Weiblich“ oder „Aus“.
Wenn die Option „Audio-Feedback“ ausgeschaltet ist, können Sie das Audio-Feedback 
weiterhin manuell abrufen.
Das Audio-Feedback manuell abrufen
m iPod nano (5. Generation oder älter):  Drücken Sie beim Training zu jeder beliebigen Zeit 
die Mitteltaste.
m iPod nano (6. Generation):  Drücken Sie beim Training zu jeder beliebigen Zeit die 
Standby-Taste.78
m iPhone und iPod touch:  Drücken Sie die Home-Taste des gesperrten Geräts.
Auf dem iPod nano steht die Funktion „Audio-Feedback“ außer in Englisch auch in 
einigen anderen Sprachen zur Verfügung. Wenn Sie für Ihren iPod nano eine Sprache 
festgelegt haben und Sie ihn an Ihren Computer (der mit dem Internet verbunden sein 
muss) anschließen, werden Sie von iTunes aufgefordert, die Feedback-Funktion in 
dieser Sprache zu laden.
Â Auf dem iPod nano (5. Generation oder älter) kann immer nur eine nicht-englische 
Version für das Audio-Feedback installiert sein.
Â Auf dem iPhone, iPod touch und iPod nano (6. Generation) werden alle FeedbackSprachen automatisch unterstützt.
Verwenden von PowerSongs
Sie können einen Musiktitel wählen, der Sie besonders motiviert und diesen als 
PowerSong festlegen. Sie können jederzeit während Ihres Trainings schnell zu Ihrem 
PowerSong wechseln.
PowerSongs festlegen
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ > 
„PowerSong“ und dann den gewünschten Titel.
Auf einem iPod nano (5. Generation) kann auch eine Wiedergabeliste als PowerSong 
verwendet werden. 
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „PowerSong“ und 
dann den gewünschten Titel.
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „PowerSong“ und 
dann den gewünschten Titel.79
Ihren PowerSong anhören
m iPod nano (5. Generation oder älter):  Drücken Sie während des Trainings die Mitteltaste. 
Nach einer kleinen Pause wird der Song gespielt.
m iPod nano (6. Generation):  Drücken Sie die Standby-Taste, wenn der Bildschirm aus ist. 
Tippen Sie auf den Bildschirm, um die Taste „PowerSong“ anzuzeigen. Tippen Sie dann 
auf „PowerSong“. Bei aktiver Bildschirmanzeige können Sie auch zwei Finger auf den 
Bildschirm legen, um den PowerSong zu starten. 
m iPhone und iPod touch:  Tippen Sie im Trainingsbildschirm auf „PowerSong“. Sind 
iPhone oder iPod touch gesperrt, drücken Sie die Home-Taste, bewegen Sie den 
Regler mit dem Finger nach rechts, um die Sperre aufzuheben, und tippen Sie dann 
auf „PowerSong“.
Unterbrechen des Trainings
Sie können eine Trainingspause einlegen – wobei die Musik und die Datenaufzeichnung ebenfalls pausieren – und das Training dann später fortsetzen, ohne Ihre Trainingsdaten zu verlieren.
Training unterbrechen oder fortsetzen
m iPod nano (5. Generation oder älter):  Drücken Sie die Taste „Start/Pause“ (’).
m iPod nano (6. Generation):  Tippen Sie auf den Bildschirm, um die Taste „Pause“ anzuzeigen. Tippen Sie dann auf „Pause“. Tippen Sie auf „Fortsetzen“, um das Training fortzusetzen. Wenn der Bildschirm des iPod nano (6. Generation) nicht eingeschaltet ist, drücken 
Sie die Standby-Taste, um die Anzeige zu aktivieren.
m iPhone und iPod touch:  Tippen Sie auf „Pause“. Sind iPhone oder iPod touch gesperrt, 
drücken Sie zuerst einmal auf die Home-Taste. Tippen Sie auf „Start“, um das Training 
fortzusetzen.80
Empfangen von Anrufen beim Trainieren
Mit einem iPhone können Sie auch während des Trainings Anrufe annehmen. Erhalten Sie einen Anruf, wird Ihr Training automatisch gestoppt, sobald Sie den Anruf 
annehmen.
Anrufe annehmen
m Tippen Sie auf „Antworten“ oder drücken Sie die Mikrofontaste, wenn Sie das StereoHeadset verwenden. Wenn das iPhone gesperrt ist, schieben Sie den Regler mit dem 
Finger nach rechts, um die Sperrung aufzuheben.
Anrufe stumm schalten
m Drücken Sie die Standby-Taste oder eine Lautstärketaste. Auch nach dem Stummschalten können Sie Anrufe annehmen, solange Voicemail noch nicht eingeschaltet ist.
Anrufe ablehnen
m Tippen Sie auf „Ablehnen“ oder halten Sie die Mikrofontaste am Headset ungefähr 
2 Sekunden lang gedrückt und lassen Sie sie dann los. Zwei tiefe Piepstöne bestätigen, 
dass der Anruf abgelehnt wurde.
Drücken Sie die Standby-Taste zweimal schnell, um einen Anruf abzulehnen. Hierdurch 
wird der Klingelton abgestellt, die Musik wird jedoch erst fortgesetzt, wenn der Anruf 
an Voicemail übergeben wurde. Das Training wird im Hintergrund weiter aufgezeichnet.
Training nach einen Anruf fortsetzen
m Tippen Sie auf „Start“.
Wechseln der Musik beim Trainieren
Sie können Ihre Musik jederzeit beim Trainieren wechseln, ohne Ihre Trainingsdaten zu 
verlieren. Das Training ist während des Musikwechsels gestoppt.81
Musik beim Trainieren wechseln
1 iPod nano (5. Generation oder älter):  Drücken Sie die Taste „Menu“ und wählen Sie 
„Musik wechseln“. Ihr Training wird gestoppt.
iPod nano (6. Generation):  Tippen Sie auf den Bildschirm, um die Taste „Pause“ anzuzeigen. Tippen Sie dann auf „Pause“ und „Musik wechseln“. Wenn der Bildschirm des 
iPod nano (6. Generation) nicht eingeschaltet ist, drücken Sie die Standby-Taste, um die 
Anzeige zu aktivieren.
iPhone und iPod touch:  Tippen Sie dann auf „Pause“ und „Musik wechseln“. Ist das Gerät 
gesperrt, drücken Sie die Home-Taste, bewegen Sie den Regler mit dem Finger nach 
rechts, um die Sperre aufzuheben. 
2 iPod nano (5. Generation oder älter):  Wählen Sie eine neue Musik. Ihr Training wird 
automatisch fortgesetzt.
iPhone, iPod touch und iPod nano (6. Generation):  Wählen Sie eine neue Musik. 
Automatisches Senden von Trainingsdaten an Nikeplus.com
Sie können iTunes so konfigurieren, dass Ihre Trainingsdaten automatisch über das 
Internet an nikeplus.com gesendet werden, wenn Sie Ihren iPod nano an den Computer anschließen. 
Trainingsdaten automatisch an nikeplus.com senden
1 Stellen Sie sicher, dass Ihr Computer mit dem Internet verbunden ist, und schließen Sie 
iPod nano an den Computer an.
2 Öffnen Sie iTunes auf dem Computer, klicken Sie auf „Nike + iPod“ und wählen Sie 
„Trainingsdaten automatisch an nikeplus.com senden“.82
3 Klicken Sie auf „nikeplus.com Webseite öffnen“ unter dem Markierungsfeld. Klicken Sie 
im angezeigten Dialogfenster auf „Verbinden“, wenn Sie bereits festgelegt haben, dass 
Ihre Trainingsdaten automatisch gesendet werden.
Die Website „nikeplus.com“ wird geöffnet und Ihre neusten Trainingsdaten werden in 
einem Diagramm dargestellt.
4 Klicken Sie auf die Option zum Sichern Ihrer Läufe und melden Sie sich an oder 
registrieren Sie sich, falls noch nicht geschehen.
Informationen zum Datenschutz bei Nike („Privacy Policy“) sowie die Nike Nutzungsbedingungen („Terms & Conditions“) finden Sie auf der Website nikeplus.com.
Anzeigen von Trainingsdaten auf Ihrem Gerät
Ihr iPod nano, iPhone oder iPod touch sichert Datum, Uhrzeit, Dauer, Strecke, Tempo 
und Kalorienverbrauch Ihrer bis zu eintausend letzten Trainingseinheiten.
Die letzten Trainingseinheiten auf Ihrem Gerät anzeigen
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Übersicht“.
m iPod nano (6. Generation):  Wählen Sie „Fitness“ > „Übersicht“ unten im Bildschirm.
m iPhone und iPod touch:  Wählen Sie „Nike+iPod“ und tippen Sie dann unten im Bildschirm auf „Übersicht“.
Der iPod nano (5. Generation oder älter) bietet eine tägliche Übersicht Ihrer Trainingseinheiten:  Nike + iPod-Trainingseinheiten, Schrittzähler und Herz-/Kreislauf-Training 
unter Verwendung von Nike + iPod-kompatiblen Trainingsgeräten.
Trainingsübersicht auf einem iPod nano (5. Generation oder älter) anzeigen
1 Wählen Sie „Gesamtwerte“ aus dem Menü „Übersicht“.
2 Wählen Sie ein Datum und eine Aktivität aus.83
3 Drehen Sie den iPod nano (5. Generation) ins Querformat, um das Diagramm dieser 
Aktivität anzusehen.
Eine einzelne Trainingseinheit löschen
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Übersicht“. Wählen Sie 
eine Trainingseinheit aus und drücken und halten Sie die Mitteltaste. Wählen Sie dann 
„Löschen“.
Es ist nicht möglich, einzelne Trainingseinheiten auf dem iPod nano (6. Generation) zu 
löschen. 
m iPhone und iPod touch:  Wählen Sie „Nike+iPod“ und tippen Sie auf „Übersicht“. Tippen 
Sie auf „Bearbeiten“, wählen Sie eine Trainingseinheit und tippen Sie auf „Löschen“.
Auf einem iPhone, iPod touch und iPod nano (6. Generation) können Sie alle Trainingseinheiten aus der Übersicht löschen, indem Sie oben im Bildschirm „Übersicht“ auf 
„Löschen“ tippen.
Erstellen und Auswählen eigener Trainingskurzbefehle
Mithilfe eigener Trainingskurzbefehle können Sie Trainingseinheiten schnell und einfach auswählen und wiederholen. Der iPod nano (4. Generation und neuer) sichert alle 
abgeschlossenen Trainingseinheiten automatisch als Kurzbefehle. Mit einem iPhone 
und iPod touch können Sie eigene Trainingskurzbefehle erstellen.
Eigene Trainingskurzbefehle auf einem iPhone oder iPod touch erstellen
1 Wählen Sie „Nike+iPod“ und tippen Sie dann unten auf dem Bildschirm auf „Meine 
Trainings“.
2 Tippen Sie auf das Pluszeichen (+) und wählen die Trainingsart und das Trainingsziel aus.
3 Wählen Sie eine Musik aus, geben einen Namen für die Trainingseinheit ein und tippen 
auf „Sichern“.84
Hinweis: Eigene Trainingskurzbefehle können Sie nur auf einem iPhone und 
iPod touch (2. Generation oder neuer) erstellen.
Eigene Trainingskurzbefehle auf einem iPhone oder iPod touch löschen
m Wählen Sie „Nike+iPod“ und tippen Sie auf „Meine Trainings“. Tippen Sie auf „Bearbeiten“, wählen Sie einen Kurzbefehl aus und tippen Sie auf „Löschen“. 
Eigene Trainingskurzbefehle auswählen
m iPod nano (4. und 5. Generation):  Wählen Sie „Nike+iPod“ und einen Trainingskurzbefehl. 
Kurzbefehle werden entsprechend der gewählten Trainingsart und Musik benannt. Sie 
können nicht gelöscht werden.
m iPod nano (6. Generation):  Wählen Sie „Fitness“ > „Nike+iPod“ und tippen Sie auf „Meine 
Trainings“. Wählen Sie einen Kurzbefehl. Kurzbefehle werden entsprechend der gewählten Trainingsart und Musik benannt. Sie können nicht gelöscht werden.
m iPhone und iPod touch:  Wählen Sie „Nike+iPod“ und tippen Sie auf „Meine Trainings“. 
Kurzbefehle werden nach dem Namen aufgelistet, den Sie beim Erstellen der Trainingseinheit gewählt haben.
Der zuletzt von Ihnen erstellte Kurzbefehl wird oben in der Liste angezeigt.
Kaufen von Nike+ Trainingsmusik
Sie können Nike+ Trainingsmusik kaufen und über das Internet laden. Nike+ Titel bieten Musik ohne Unterbrechung, die mit Kommentaren von professionellen Trainern 
gemischt ist. Wenn Sie eine Nike+ Trainingsmusik kaufen, erhalten Sie zunächst eine 
Audioaufnahme mit Musik und gesprochenen Kommentaren. Darüber hinaus erhalten 
Sie auch alle einzelnen Musiktitel, die in der Trainingsmusik enthalten sind. Wählen Sie 
die Trainingsmusik, die zu Ihrem Trainingsstil und Leistungsniveau passt.85
Nike+ Trainingsmusik kaufen
1 Öffnen Sie iTunes und klicken Sie links im Fenster auf „iTunes Store“. Geben Sie 
„nike+ sport music“ in das iTunes-Suchfeld ein.
2 Klicken Sie neben der gewünschten Nike+ Trainingsmusik auf „Kaufen“.
3 Befolgen Sie die angezeigten Anleitungen, um den Kauf abzuschließen. Die Musik wird 
automatisch geladen.
4 Verbinden Sie Ihr Gerät mit Ihrem Computer und laden Sie die Trainingsmusik auf das 
Gerät.
Hinweis: In den USA sowie in vielen anderen Ländern müssen Kunden des 
iTunes Store mindestens 13 Jahre alt sein. Eine Liste dieser Länder finden Sie unter: 
www.apple.com/de/itunes/download. Bitte beachten Sie die Geschäftsbedingungen. 
Sie benötigen einen Internetzugang (Gebühren können anfallen), um den iTunes Store 
verwenden zu können.
Verbinden einer Nike + iPod-kompatiblen Fernbedienung oder eines 
Herzfrequenzmonitors
Nike + iPod-kompatible Geräte werden separat vom Nike + iPod-Sport Kit und 
Nike + iPod-Sensor verkauft.
Sie können während Ihres Trainings eine kompatible Fernbedienung verwenden, um 
Nike + iPod drahtlos zu steuern.
Der iPod nano (5. Generation oder neuer) unterstützt zudem Nike + iPod-kompatible 
Herzfrequenzmonitore.
Hinweis: Sie müssen den iPod + Nike-Empfänger an den iPod nano (6. Generation) 
anschließen, um einen Herzfrequenzmonitor oder eine Fernbedienung verwenden 
zu können.86
Bevor Sie eines dieser Geräte zum ersten Mal verwenden, müssen Sie den iPod nanoEmpfänger, das iPhone oder den iPod touch mit dem Gerät verbinden.
Verbindung zur Nike + kompatiblen Fernbedienung (separat erhältlich) herstellen
m iPod nano (5. Generation oder älter):  Schließen Sie den Nike + iPod-Empfänger an Ihren 
iPod nano an. Wählen Sie dann „Nike+iPod“ > „Einstellungen“ > „Fernbedienung“ > 
„Verbinden“ und befolgen Sie die angezeigten Anleitungen.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „Nike+iPod-Sport 
Kit“ > „Fernbedienung“. Aktivieren Sie die Option „Fernbedienung“ und tippen Sie auf 
„Verbinden“.
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Fernbedienung“ 
und befolgen Sie die angezeigten Anleitungen.
Verbindung zum Nike + iPod-kompatiblen Herzfrequenzmonitor (separat erhältlich) 
herstellen
m iPod nano (5. Generation):  Schließen Sie den Nike + iPod-Empfänger an Ihren iPod nano 
an. Wählen Sie dann „Nike+iPod“ > „Einstellungen“ > „Herzfrequenzmonitor“ > „Verbinden“ und befolgen Sie die angezeigten Anleitungen.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „Herzfrequenzmonitor“ > „Verbinden“ und befolgen Sie die angezeigten Anleitungen.
Verbindung zu einem Gerät trennen
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ > „Fernbedienung“ (oder „Herzfrequenzmonitor“) > „Verbindung trennen“ und befolgen Sie die 
angezeigten Anleitungen.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Nike+iPod-Sport Kit“ > „Fernbedienung“ (oder „Herzfrequenzmonitor“) > „Verbindung trennen“.87
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Fernbedienung“ 
und tippen Sie auf „Verbindung trennen“.
Sie können die Funktionen einer Nike+ iPod-kompatiblen Fernbedienung deaktivieren, 
ohne die Verbindung zum Gerät zu trennen.
Funktion für die Fernbedienung ein- oder ausschalten
m iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ > „Fernbedienung“ und legen Sie für „Fernbedienen“ die Option „Ein“ oder „Aus“ fest.
m iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Nike+iPod-Sport Kit“ > „Fernbedienung“ und legen Sie für „Fernbedienen“ die Option „Ein“ oder „Aus“ fest
m iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Fernbedienung“ 
und verbinden oder trennen Sie die Fernbedienung.
Trainieren mit einem iPod nano (6. Generation) und einem 
Herzfrequenzmonitor
Wenn Sie einen iPod nano (6. Generation) und einen Nike + iPod-kompatiblen Herzfrequenzmonitor (separat erhältlich) besitzen, kann der iPod nano Ihre Herzfrequenz aufzeichnen und beim Trainieren anzeigen. Sie können auch einen Bereich der maximalen 
bzw. minimalen Herzfrequenzen festlegen, den Sie während eines Trainings erreichen 
wollen. Außerdem können Sie festhalten, wie gut sich die Frequenz im angegebenen 
Bereich gehalten hat. Beim Training zeigt der iPod nano Ihre aktuelle Herzfrequenz an 
und ein Aufwärts- bzw. Abwärtspfeil zeigt an, ob Sie Ihre Aktivität erhöhen oder verringern müssen. Sie können einen Herzfrequenzmonitor während eines Standardtrainings 
verwenden.88
Sie können die Herzfrequenz auch bei anderen Aktivitäten außer beim Gehen oder 
Laufen überwachen. So können Sie zum Beispiel den iPod nano und einen Herzfrequenzmonitor bei anderen Sportarten wie Basketball, Aerobic, Zirkeltraining, Golf, 
Wandern, Fußball uvm. verwenden. 
Nach dem Training können Sie Ihre Herzfrequenzen an Ihren nikeplus.com-Account 
senden und dort prüfen.
Beim Einrichten eines Trainings können Sie den Bereich für maximale und minimale 
Herzfrequenzen festlegen, die Sie beim gewählten Training erreichen wollen. Zunächst 
müssen Sie die Funktion für den Trainingsbereich aktivieren.
Funktion für den Trainingsbereich aktivieren bzw. deaktivieren
m Tippen Sie auf „Einstellungen“ > „Fitness“ > „Nike+iPod-Sport Kit“ und dann für den 
Trainingsbereich auf „Ein“ oder „Aus“.
Wenn Sie diese Funktion aktiviert und ein Training gewählt haben, werden Optionen 
zum Festlegen eines Herzfrequenzbereichs angezeigt. Beim Training werden die Herzfrequenzen aufgezeichnet und für jeden Trainingstyp angezeigt. 
Der iPod nano (6. Generation) unterstützt ebenfalls Herzfrequenz-Trainings. Für ein 
solches Training geben Sie zunächst einen Herzfrequenzbereich an, den Sie einhalten 
wollen. Anschließend wählen Sie die Art der Aktivität aus, die Sie ausführen möchten, 
und starten dann das Training. Alle Herzfrequenzinformationen werden automatisch 
aufgezeichnet. Wenn Sie diese Art Training ausführen, benötigen Sie keinen Sensor in 
Ihrem Schuh, um die Bewegung aufzuzeichnen.89
Herzfrequenz-Training starten
1 Tippen Sie auf „Fitness“ > „Laufen“ > „Herzfrequenz“.
2 Legen Sie den gewünschten Herzfrequenzbereich fest.
3 Wählen Sie eine Aktivität aus und tippen Sie anschließend auf „Fertig“.
4 Wählen Sie Ihre Trainingsmusik aus.
5 Tippen Sie auf „Training starten“ und beginnen Sie mit Ihrem Training.
6 Drücken Sie nach Ihrem Training die Standby-Taste, um den Bildschirm zu aktivieren. 
Tippen Sie dann auf den Bildschirm, um die Taste „Pause“ anzuzeigen. Tippen Sie auf 
„Pause“ und auf „Training beenden“, um Ihr Herzfrequenz-Training abzuschließen.
Wenn Sie ein Herzfrequenz-Training abgeschlossen haben, können Sie diese Informationen wie bei anderen Trainings an Ihren nikeplus.com-Account senden. 
Verbinden mit einem anderen Sensor
Nachdem Sie Ihr Gerät mit einem bestimmten Sensor verbunden haben, kann es nur 
zu diesem einen Sensor eine Verbindung herstellen. Möchten Sie einen anderen Sensor 
verwenden, müssen Sie das Gerät so einstellen, dass es eine Verbindung zu diesem 
Sensor herstellt. Dies ist praktisch, wenn es z. B. in Ihrer Familie mehrere Personen mit 
eigenem Sensor und Nike+ kompatiblen Schuhen gibt.
Empfänger mit einem anderen Sensor koppeln:
1 iPod nano  Schließen Sie den Empfänger an den iPod an.
2 Ziehen Sie die Schuhe mit dem neuen Sensor an und stellen Sie sicher, dass sich kein 
anderer Nike + iPod-Sensor in der Nähe befindet.
Laufen Sie ein paar Schritte, um den Sensor zu aktivieren, sodass er vom Empfänger 
erkannt wird.90
3 Verbinden Sie den Sensor wie folgt mit Ihrem Gerät:
Â iPod nano (5. Generation oder älter):  Wählen Sie „Nike+iPod“ > „Einstellungen“ > 
„Sensor“ > „Verbinden“ und befolgen Sie die angezeigten Anleitungen. Eine Meldung 
wird auf Ihrem iPod angezeigt, wenn der neue Sensor verbunden ist.
Â iPod nano (6. Generation):  Wählen Sie „Einstellungen“ > „Fitness“ > „Nike+iPod-Sport 
Kit“ > „Sensor“ und tippen Sie auf „Verbinden“. Durch Tippen auf den Bildschirm können Sie dann beim Gehen oder Laufen das Gerät erneut mit dem anderen Sensor 
verbinden.
Â iPhone und iPod touch:  Wählen Sie „Einstellungen“ > „Nike+iPod“ > „Sensor“, tippen 
Sie auf „Neu verbinden“ und befolgen Sie die angezeigten Anleitungen.
Hinweis: Falls Sie eine Verbindung für einen Sensor herstellen, der schon einmal mit 
dem Empfänger verbunden war, erkennt Nike + iPod Ihre vorherigen Kalibrierungseinstellungen. Sie müssen den Sensor nicht erneut zu kalibrieren.
Wenn Sie einen externen iPod-Empfänger an einen anderen iPod anschließen und ihn 
mit demselben Sensor verwenden, müssen Sie das Gerät nicht erneut verbinden oder 
kalibrieren. Der Empfänger speichert Ihre Einstellungen, Trainingsdaten und Trainingskurzbefehle. Sie müssen den Sensor nicht erneut verbinden oder kalibrieren.91
Aktivieren des Ruhezustands für den Nike + iPod-Sensor
Der Sensor ist standardmäßig eingeschaltet und in Betrieb. Sie können den Ruhezustand aktivieren, wenn Sie den Sensor für längere Zeit nicht einsetzen möchten oder 
wenn er keine Signale aussenden soll.
Wichtig: Den geltenden gesetzlichen Vorschriften entsprechend müssen Sie den 
Sensor deaktivieren, bevor Sie damit in einem Flugzeug reisen.
Sensor deaktivieren
m Drücken Sie mithilfe eines Kugelschreibers oder einer Büroklammer die Taste „Ruhezustand/Betrieb“ und halten Sie diese 3 Sekunden lang gedrückt.
Taste „Ruhezustand/Betrieb“
Sensor wieder aktivieren
m Drücken Sie mithilfe eines Kugelschreibers oder einer Büroklammer die Taste 
„Ruhezustand/Betrieb“.92
Wichtige Sicherheitsinformationen
ACHTUNG: Bei Nichtbeachtung dieser Sicherheitsinformationen kann es zu Verletzungen oder zur Beschädigung von Komponenten kommen.
Training  Bevor Sie ein Trainingsprogramm beginnen, sollten Sie sich von Ihrem Arzt 
gründlich untersuchen lassen. Machen Sie vor jedem Trainingsbeginn Aufwärm- und 
Dehnübungen. Seien Sie beim Sport stets vorsichtig und aufmerksam. Verringern Sie 
wenn nötig Ihr Tempo, bevor Sie beim Laufen Einstellungen an Ihrem Gerät ändern. 
Beenden Sie Ihr Training sofort, wenn Sie Schmerzen haben oder sich schwach, schwindelig oder erschöpft fühlen oder wenn Sie außer Atem sind. Wenn Sie Sport treiben, 
sind Sie für sämtliche Risiken selbst verantwortlich, die mit körperlichen Betätigungen 
einhergehen, einschließlich evtl. hierdurch verursachter Verletzungen.
Verwenden Sie den Empfänger, das iPhone bzw. den iPod nicht im Wasser bzw. in der 
Nähe von Wasser oder in feuchten Umgebungen.
Erstickungsgefahr  Empfänger und Sensor sind für Kinder unter drei Jahren nicht 
geeignet, da solche Kleinteile verschluckt werden und damit eine Erstickungsgefahr 
darstellen können. Achten Sie darauf, dass Kleinkinder keinen Zugang zu diesen Komponenten haben.93
Vermeiden von Hörschäden  Das Verwenden von Ohrhörern mit hoher Lautstärke kann 
eine dauerhafte Schädigung des Gehörs zur Folge haben. Stellen Sie die Lautstärke nicht 
zu hoch ein. Sie gewöhnen sich mit der Zeit zwar an höhere Lautstärken, sodass diese 
für Sie normal erscheinen mögen, Ihre Hörfähigkeit kann dadurch jedoch beeinträchtigt 
werden. Falls Sie in Ihren Ohren ein Klingeln wahrnehmen oder Gespräche gedämpft 
hören, sollten Sie die Verwendung einstellen und ggf. einen Ohrenarzt aufsuchen. Je 
höher Sie die Lautstärke einstellen, desto schneller kann Ihr Gehör geschädigt werden. 
Experten empfehlen, das Gehör wie folgt zu schützen:
Â Benutzen Sie Ohrhörer bei hohen Lautstärken nur für eine begrenzte Dauer.
Â Vermeiden Sie es, die Lautstärke zu erhöhen, um Umgebungsgeräusche zu 
übertönen.
Â Reduzieren Sie die Lautstärke, wenn Sie nicht hören können, was Personen in Ihrer 
Nähe sprechen.
Öffnen des Sensors  Versuchen Sie nicht, den Sensor zu öffnen, auseinanderzubauen 
oder die Batterie zu entfernen. Im Sensor befinden sich keine Teile, die vom Benutzer 
gewartet werden könnten.94
Weitere Informationen, Service und Support
Funktion Aktion
Antworten auf häufig gestellte Fragen über 
Nike + iPod
Besuchen Sie die Website: 
www.apple.com/de/support/nikeplus.
Service & Support für den Nike + iPod-Sensor 
und -Empfänger
Besuchen Sie die Website: 
www.apple.com/de/support/nikeplus.
Service & Support für Nike+ kompatible 
Schuhe bzw. die nikeplus.com-Website
Besuchen Sie die Website: www.nikeplus.com.
Verwenden von iTunes Öffnen Sie iTunes und wählen Sie „Hilfe“ > 
„iTunes-Hilfe“.
Verwenden von iPod nano oder iPod touch Besuchen Sie die Website: 
www.apple.com/de/support/ipod.
Verwenden eines iPhone Besuchen Sie die Website: 
www.apple.com/de/support/iphone.95
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Benvenuto in Nike + iPod
L’assistente personale per le sessioni di allenamento
Nike + iPod è un compagno di sessione e un allenatore, tutto in uno. Seleziona 
il tipo di sessione desiderato - senza limiti precisi, basato sulla distanza o sul tempo, 
o per bruciare calorie - scegli la musica giusta che ti da una marcia in più, quindi 
tieni traccia dei tuoi progressi lungo tutto il percorso grazie alle informazioni vocali 
e su schermo. Carica i dati della sessione su nikeplus.com, dove puoi impostare i tuoi 
obiettivi e verificare i tuoi miglioramenti da una sessione all’altra. Entra a far parte della 
più grande comunità online di runner del mondo e partecipa alle gare con corridori 
provenienti da ogni angolo del pianeta.
Nike + iPod è supportato da iPhone (3GS o versione successiva), tutti i modelli di 
iPod nano
1
 e iPod touch (seconda generazione o versione successiva).
iPod nano
(tutti i modelli)
iPod touch
(seconda generazione
o successiva)
iPhone 3GS
o successivo
1 
Per iPod nano (sesta generazione), il sensore Nike + iPod è facoltativo e richiesto solo per gli allenamenti con 
il Cardiofrequenzimetro Wearlink®+ di Polar per Nike+.97
Guida rapida
Segui queste istruzioni per iniziare a usare subito Nike + iPod.
Passo 1:  abilita Nike + iPod sul dispositivo.
m iPod nano (solo quinta generazione):  collega il ricevitore Nike + iPod a iPod nano. 
“Nike + iPod” appare nel menu principale.
m iPod nano (solo quinta generazione):  collega il ricevitore Nike + iPod a iPod nano. 
Tocca Fitness.
Nota:  opzionalmente, iPod nano (sesta generazione) è in grado di tenere traccia delle 
tue sessioni anche senza utilizzare il sensore Nike + iPod. Per ulteriori informazioni, 
consulta il Manuale Utente di iPod nano fornito con il dispositivo. 
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod e impostalo su Attivo.
Nella schermata Inizio compare l’icona Nike + iPod.
Nota:  iPhone 3GS o versione successiva e iPod touch dispongono di un ricevitore 
interno; non è necessario collegare un ricevitore esterno. 
Passo 2:  assicurati di disporre del software iPod e iTunes più recente.
1 Scarica l’ultima versione del software iTunes da www.apple.com/it/itunes e installala sul 
computer.98
2 Collega il dispositivo al computer, quindi selezionalo nella barra laterale di iTunes e fai 
clic su Riepilogo.
3 Se iTunes comunica che il dispositivo deve essere aggiornato, fai clic su Aggiorna e 
segui le istruzioni su schermo.
Passo 3:  inserisci il sensore Nike + iPod nella scarpa Nike+.
m Solleva la soletta della scarpa sinistra, togli l’inserto in gomma situato sotto la tasca e 
sostituiscilo con il sensore, con il lato piatto rivolto verso l’alto.
Sensore
Quando non ti alleni puoi lasciare il sensore nella scarpa, ma se prevedi di indossare 
a lungo le scarpe senza allenarti, sostituisci il sensore con l’inserto in gomma per 
risparmiare la batteria.
La batteria del sensore non può essere sostituita, non è ricaricabile e ha una vita utile 
di oltre 1000 ore. La vita della batteria varia in base all’uso e ad altri fattori.99
Passo 4:  scegli un tipo di sessione.
Per scegliere Procedi così
Sessione senza limiti 
precisi
iPod nano (solo quinta generazione): scegli Nike + iPod > 
Nike + iPod > Base.
iPod nano (solo quinta generazione): scegli Fitness > Corsa > Base. 
iPhone e iPod touch: scegli Nike + iPod > Base.
Sessione con limite di 
tempo
iPod nano (solo quinta generazione): scegli Nike + iPod > 
Nike + iPod > Tempo.
iPod nano (solo quinta generazione): scegli Fitness > Corsa > Tempo. 
iPhone e iPod touch:  scegli Nike + iPod > Tempo.
Sessione con limite di 
distanza
iPod nano (solo quinta generazione): scegli Nike + iPod > 
Nike + iPod > Distanza.
iPod nano (solo quinta generazione): scegli Fitness > Corsa > Distanza. 
iPhone e iPod touch: scegli Nike + iPod > Distanza.
Sessione con l’obiettivo di 
bruciare calorie
iPod nano (solo quinta generazione): scegli Nike + iPod > 
Impostazioni > Peso e inserisci il tuo peso. Quindi, premi il pulsante 
Menu e scegli Nike + iPod > Nike + iPod > Calorie.
iPod nano (solo quinta generazione): scegli Impostazioni > Fitness > 
Peso e inserisci il tuo peso. scegli Fitness > Corsa > Calorie. 
iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Peso e 
inserisci il tuo peso. Quindi, premi il tasto Home e scegli 
Nike + iPod > Calorie.
Nota:  devi inserire il peso solo la prima volta che inizi una sessione 
per bruciare calorie.100
Passo 5:  scegli la musica per la sessione.
Per riprodurre Procedi così
Un mix per sessione Nike+ Scegli il mix (consulta pagina 116). 
Il brano in riproduzione Scegli “In riproduzione”.
Un mix Genius Scegli “Mix Genius” (iPod nano sesta generazione).
I brani di una playlist Scegli Playlist, quindi scegli una playlist.
Un podcast Scegli Podcast (iPod nano sesta generazione).
Un audiolibro Scegli Audiolibri (iPod nano sesta generazione).
Brani in ordine casuale Scegli “Brani casuali”.
Una stazione radio Scegli Radio (iPod nano sesta generazione).
Senza musica Scegli Nessuno.
Passo 6:  inizia la sessione.
Per attivare il sensore, inizia a correre o a camminare. Quando il dispositivo rileva e 
associa il sensore, sei pronto per iniziare la sessione.
m iPod nano (solo quinta generazione):  premi il pulsante centrale e inizia a camminare o a 
correre.
m iPod nano (solo quinta generazione):  tocca “Avvia sessione” e inizia a camminare o a 
correre.
m iPhone e iPod touch:  tocca Riproduci e inizia a camminare o a correre.101
Passo 7:  controlla i progressi.
Nike + iPod mostra automaticamente lo stato della sessione sullo schermo, come 
nella seguente illustrazione (a seconda del dispositivo, lo schermo potrebbe avere un 
aspetto leggermente diverso).
iPod nano 
(sesta generazione)
iPhone3GS o successivo 
e iPod touch
Nike + iPod fornisce informazioni vocali sui tuoi progressi durante la sessione (consulta 
“Ottenere informazioni vocali” a pagina 108). Inoltre, puoi ricevere un feedback ogni volta 
che lo desideri.
Per ottenere manualmente informazioni vocali:
m iPod nano (solo quinta generazione):  premi il pulsante centrale in qualsiasi momento 
durante la sessione.102
m iPod nano (solo quinta generazione):  premi il pulsante Standby/Riattiva in qualsiasi 
momento durante la sessione.
m iPhone e iPod touch:  premi il tasto Home in qualsiasi momento durante la sessione.
Nota:  iPhone e iPod touch devono essere bloccati per ottenere informazioni vocali 
manualmente (consulta “Ottenere informazioni vocali” a pagina 108).
Passo 8:  concludi la sessione.
Puoi concludere la sessione in qualsiasi momento. Se continui ad allenarti anche dopo 
aver raggiunto l’obiettivo di tempo, distanza o calorie, i tuoi progressi continuano a 
essere monitorati.
Per concludere la sessione:
m iPod nano (solo quinta generazione):  premi il pulsante Riproduci/Pausa (’) per mettere 
in pausa la sezione. Quindi premi il pulsante Menu e scegli “Termina sessione”.
m iPod nano (solo quinta generazione):  tocca lo schermo per visualizzare il pulsante Pausa, 
quindi tocca Pausa. Tocca “Termina sessione”. Se lo schermo non è attivo, premi il tasto 
Standby/Riattiva.
Nota:  per mettere in pausa o riprendere velocemente la sessione su iPod nano 
(sesta generazione), fai doppio clic sul tasto Standby/Riattiva.
m iPhone e iPod touch:  tocca “Termina sessione”. Se iPhone o iPod touch è bloccato, premi 
il pulsante Home e tocca Pausa. Quindi trascina il cursore e tocca “Termina sessione”.103
Passo 9:  tieni traccia dei tuoi progressi su nikeplus.com.
Su nikeplus.com puoi controllare l’andamento dei tuoi progressi, visualizzare un 
resoconto di tutte le sessioni passate, impostare e monitorare gli obiettivi e confrontare 
i tuoi risultati con gli altri. Puoi anche gareggiare con altri utenti di Nike + iPod in sfide 
di allenamento online.
Se utilizzi un iPhone o iPod touch, puoi inviare i dati della tua sessione al sito web Nike, 
in modalità wireless. Se utilizzi un iPod nano, puoi inviare i dati della tua sessione dal 
computer a nikeplus.com.
Prima di inviare i dati delle sessione si consiglia di creare un account nikeplus.com. 
Segui le istruzioni sul sito web nikeplus.com per accedere con un account gratuito. 
Per inviare i dati della sessione a nikeplus.com in modalità wireless da iPhone 
o iPod touch:
1 Assicurati che il dispositivo sia connesso a Internet, quindi scegli “Nike + iPod”.
Se una sessione non è stata sincronizzata con il tuo account nikeplus.com, sul pulsante 
Cronologia appare un puntino rosso.
2 Per visualizzare le tue sessioni, tocca il pulsante Cronologia.
3 Tocca il pulsante “Invia a Nike+” per inviare i dati della tua sessione a nikeplus.com. 
Se lo desideri, puoi effettuare questa operazione in un secondo momento.104
4 Inserisci il tuo indirizzo e-mail e la password del tuo account nikeplus.com, quindi tocca 
“Accedi a Nike+”.
Dopo il login, le tue sessioni vengono inviate al tuo account nikeplus.com.
Se non hai un account nikeplus.com, tocca “Entra a far parte di Nike+”
Si apre il sito web nikeplus.com e viene visualizzato un grafico con i dati relativi alla tua 
sessione più recente.
5 Segui le istruzioni su schermo per accedere alle tue sessioni.
Per inviare i dati delle tue sessioni di allenamento con iPod nano dal computer a 
nikeplus.com:
1 Assicurati che il computer sia connesso a Internet, quindi collega iPod nano al computer.
2 Nella finestra di dialogo che appare per l’invio dei dati della tua sessione a nikeplus.
com, fai clic su Invia. Se lo desideri, puoi effettuare questa operazione in un secondo 
momento.
3 Nella finestra di dialogo che appare per visitare nikeplus.com, fai clic su Visita.
Si apre il sito web nikeplus.com e viene visualizzato un grafico con i dati relativi alla tua 
sessione più recente.
4 Fai clic su “Registra le corse”, quindi fai clic su Iscrivimi e segui le istruzioni su schermo.105
Usare Nike + iPod
Segui queste istruzioni per ottenere il massimo da Nike + iPod.
Calibrare Nike + iPod
La calibrazione di default di Nike + iPod è valida per molti utenti. Puoi ottimizzare 
il livello di precisione calibrando Nike + iPod per il tuo stile naturale di corsa e 
camminata. Su iPod nano, puoi eseguire una sessione di calibrazione su una distanza 
che conosci, o utilizzare la tua ultima sessione e inserire la distanza percorsa. Su iPhone 
o iPod touch, puoi eseguire la calibrazione servendoti dell’ultima sessione completata, 
per la quale conosci la distanza percorsa.
Per calibrare Nike + iPod per la corsa e la camminata con iPod nano (5a generazione 
o precedente):
1 Scegli Nike + iPod > Impostazioni > Sensore > Calibra.
2 Scegli Corsa o Passo e inserisci una distanza.
Per risultati migliori, utilizza una distanza di almeno 1.600 metri. La distanza minima di 
calibrazione che puoi inserire è di 400 metri.
3 Premi il pulsante centrale.
4 Corri o cammina per la distanza impostata ad un passo costante e naturale.
5 Premi il pulsante Menu e scegli “Calibrazione terminata”.
Un messaggio comunica che la calibrazione è riuscita. Per calibrare sia la corsa che la 
camminata, ripeti i passi 1–5.
Nota:  anche dopo la calibrazione, la precisione delle misurazioni della distanza può 
variare in funzione dell’andatura, della superficie su cui si corre, dell’inclinazione e della 
temperatura.106
Inoltre, puoi calibrare Nike + iPod servendoti della sessione appena conclusa. Questo 
risulta utile se hai percorso una distanza che conosci e che non corrisponde al riepilogo 
della distanza mostrata dal dispositivo.
Per calibrare iPod nano (5a generazione o precedente) usando l’ultima sessione 
completata:
m Scegli “Termina sessione”, quindi premi il pulsante centrale e scegli Calibra. 
Imposta la distanza esatta percorsa correndo o camminando e premi il pulsante 
centrale.
Il dispositivo rileva se si è trattato di una sessione di corsa o camminata e usa 
correttamente la nuova calibrazione invece di quella esistente.
Per calibrare Nike + iPod per la corsa e la camminata con iPod nano (sesta generazione):
1 Scegli Impostazioni > Fitness > Kit Sport Nike + iPod > Sensore > Calibra.
2 Scegli “Calibrazione camminata” o “Calibrazione corsa”, quindi seleziona una distanza 
e tocca Fine.
Per risultati migliori, utilizza una distanza di almeno 1.600 metri. La distanza minima 
di calibrazione che puoi inserire è di 400 metri.
3 Scegli la musica per accompagnare la sessione di calibrazione.
4 Corri o cammina per la distanza impostata ad un passo costante e naturale.
5 Se lo schermo non è attivo, premi il tasto Standby/Riattiva, tocca lo schermo per 
visualizzare il pulsante Pausa, quindi tocca Stop.
Un messaggio comunica che la calibrazione è riuscita. Per calibrare sia la corsa che 
la camminata, ripeti i passi 1–5.107
Nota:  anche dopo la calibrazione, la precisione delle misurazioni della distanza può 
variare in funzione dell’andatura, della superficie su cui si corre, dell’inclinazione e della 
temperatura.
Su iPhone o iPod touch, puoi calibrare Nike + iPod servendoti della sessione appena 
conclusa. Puoi calibrare solo le sessioni con distanza di 400 metri o superiore. 
Per calibrare iPhone o iPod touch usando l’ultima sessione completata:
m Tocca “Termina sessione”, quindi tocca Calibra. Imposta la distanza esatta percorsa 
correndo o camminando, quindi tocca Fine.
Il dispositivo si aggiorna con la nuova calibrazione e sostituisce la precedente per un 
passo da camminata o corsa.
Per ripristinare le impostazioni di default della calibrazione di Nike + iPod:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni > Sensore > 
Calibra > Reimposta passo (o Reimposta corsa).
m iPod nano (solo quinta generazione): scegli Impostazioni > Fitness > Kit Sport Nike + 
iPod > Sensore > Calibra > Reimposta camminata (o Reimposta corsa) > Reimposta.
m iPhone e iPod touch: scegli Impostazioni > Nike + iPod, quindi tocca “Reimposta 
calibrazione”. 
Impostare l’unità di distanza
Puoi impostare Nike + iPod in modo che misuri le sessioni in miglia o chilometri.
Per impostare l’unità di distanza:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni e imposta 
Distanze su Miglia o Chilometri.108
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Distanze, quindi 
scegli Miglia o Chilometri.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Distanze, quindi scegli Miglia 
o Chilometri.
Inserire il peso
Per inserire il tuo peso:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni > Peso, quindi 
inserisci il tuo peso.
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Peso, quindi 
inserisci il tuo peso.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Peso, quindi inserisci il tuo peso.
Per migliorare la precisione del calcolo delle calorie bruciate, aggiorna il peso se cambia.
Bloccare il dispositivo durante una sessione
Puoi bloccare iPhone o iPod touch in modo da impedire l’attivazione accidentale dei 
comandi durante una sessione.
Per bloccare iPhone o iPod touch:
m Premi il pulsante Pausa/Riattiva.
Per sbloccarlo, premi il pulsante Pausa/Riattiva o il pulsante Home e trascina il cursore.
Ottenere informazioni vocali
Quando ti alleni, Nike + iPod fornisce periodicamente informazioni vocali sul tuo stato.
Puoi scegliere una voce femminile o maschile oppure disattivare il feedback.109
Per impostare il tipo di voce o disattivare le informazioni vocali:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni, quindi imposta 
“Feedback parlato” su Uomo, Donna o No.
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Feedback parlato, 
quindi scegli Uomo, Donna o Disattivato.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Feedback parlato, quindi scegli 
Uomo, Donna o Disattivato.
Quando le informazioni vocali sono disattivate, puoi comunque ottenere le informazioni 
vocali manualmente.
Per ottenere manualmente informazioni vocali:
m iPod nano (solo quinta generazione):  premi il pulsante centrale in qualsiasi momento 
durante la sessione.
m iPod nano (solo quinta generazione):  premi il pulsante Standby/Riattiva in qualsiasi 
momento durante la sessione.
m iPhone e iPod touch:  premi il pulsante Home mentre il dispositivo è bloccato.
Su iPod nano, il feedback parlato è disponibile in alcune lingue oltre alla lingua inglese. 
Se imposti iPod nano su una di queste lingue e lo colleghi al computer (che deve 
essere connesso a Internet) iTunes ti chiede di scaricare le informazioni in quella lingua.
Â iPod nano (quintaa generazione o precedente) può avere solo una versione del 
feedback parlato diversa dall’Inglese.
Â iPhone, iPod touch e iPod nano (sesta generazione) supportano automaticamente 
il feedback parlato in tutte le lingue.110
Usare una PowerSong
Scegli un brano che ti da una marcia in più e convertilo nella tua PowerSong. 
In qualsiasi momento durante la sessione potrai ascoltare la tua PowerSong.
Per scegliere una PowerSong:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni > PowerSong, 
quindi scegli un brano.
Con iPod nano (quinta generazione) puoi anche utilizzare una playlist come 
PowerSong. 
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > PowerSong, 
quindi scegli un brano.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > PowerSong, quindi scegli 
un brano.
Per riprodurre il brano PowerSong:
m iPod nano (solo quinta generazione):  tieni premuto il pulsante centrale durante una 
sessione. Il brano PowerSong viene riprodotto dopo una breve pausa.
m iPod nano (solo quinta generazione):  premi il tasto Standby/Riattiva per riattivare lo 
schermo, quindi tocca lo schermo per visualizzare il pulsante PowerSong, quindi tocca 
PowerSong. Quando lo schermo è attivo, puoi anche mettere due dita sullo schermo e 
tenerle premute per avviare il brano PowerSong. 
m iPhone e iPod touch:  tocca PowerSong nella schermata della sessione. Se iPhone 
o iPod touch è bloccato, premi il pulsante Home, trascina il cursore per sbloccare, 
quindi tocca PowerSong.111
Mettere in pausa una sessione
Puoi mettere in pausa una sessione, arrestando temporaneamente la musica e la raccolta 
di dati e riprendere la sessione in un secondo momento senza perdere alcun dato.
Per mettere in pausa o riprendere una sessione:
m iPod nano (solo quinta generazione):  premi il pulsante Riproduci/Pausa (’).
m iPod nano (solo quinta generazione):  tocca lo schermo per visualizzare il pulsante Pausa. 
Tocca Pausa. Tocca Riprendi per riprendere la sessione. Se lo schermo di iPod nano 
(sesta generazione) non è attivo, premi il tasto Standby/Riattiva per riattivarlo.
m iPhone e iPod touch:  tocca Pausa. Se iPhone o iPod touch è bloccato, premi il pulsante 
Home una volta. Tocca Riproduci per riprendere la sessione.
Ricevere chiamate durante una sessione
Puoi utilizzare iPhone per rispondere alle chiamate durante la sessione. Quando ricevi 
una chiamata, la sessione viene automaticamente messa in pausa quando rispondi.
Per rispondere a una chiamata:
m Tocca Rispondi oppure premi il tasto microfono se stai utilizzando la cuffia auricolare 
stereo. Se iPhone è bloccato, trascina il cursore per sbloccarlo.
Per silenziare una chiamata:
m Premi il pulsante Pausa/Riattiva o il pulsante del volume. Puoi sempre rispondere a una 
telefonata dopo averla silenziata, fino a quando non si attiva la segreteria.
Per rifiutare a una chiamata:
m Tocca Rifiuta oppure tieni premuto il pulsante microfono sulla cuffia auricolare per circa 
due secondi, quindi rilascialo. Due leggeri bip confermano che la telefonata è stata 
rifiutata.112
Inoltre, per rifiutare una chiamata, puoi premere il pulsante Pausa/Riattiva due volte. 
Questo disattiva la suoneria e la musica non riprenderà fino a quando la chiamata non 
verrà trasferita alla segreteria telefonica; la sessione continua in background.
Per ripristinare la sessione dopo una chiamata:
m Tocca Riproduci.
Cambiare la musica nel corso di una sessione
Durante una sessione, puoi cambiare musica senza perdere i dati della sessione.
Mentre cambi musica, la sessione viene messa in pausa.
Per cambiare la musica nel corso di una sessione:
1 iPod nano (solo quinta generazione):  premi il pulsante Menu e scegli “Cambia musica”. 
La sessione viene messa in pausa.
iPod nano (solo quinta generazione): tocca lo schermo per visualizzare il pulsante 
Pausa. Tocca Pausa, quindi tocca “Modifica musica”. Se lo schermo di iPod nano 
(sesta generazione) non è attivo, premi il tasto Standby/Riattiva per riattivarlo.
iPhone e iPod touch:  tocca Pausa, quindi tocca “Cambia musica”. Se il dispositivo è 
bloccato, premi prima il pulsante Home, quindi trascina il cursore per sbloccarlo. 
2 iPod nano (solo quinta generazione):  scegli una nuova musica. La sessione riprende 
automaticamente.
iPhone iPod touch e iPod nano (sesta generazione):  scegli una nuova musica. 113
Inviare automaticamente le sessioni a Nikeplus.com
Puoi impostare iTunes per l’invio automatico dei dati relativi alla sessione a nikeplus.
com via Internet, quando colleghi iPod nano al computer. 
Per inviare automaticamente delle sessioni a nikeplus.com:
1 Assicurati che il computer sia connesso a Internet, quindi collega iPod nano al 
computer.
2 Apri iTunes sul computer, fai clic sul pannello “Nike + iPod”, quindi seleziona “Invia 
automaticamente i dati della sessione a nikeplus.com”.
3 Fai clic su “Visita nikeplus.com” sotto il riquadro oppure, se hai già impostato l’invio 
automatico della sessione, fai clic su Visita nella finestra di dialogo che appare.
Si apre il sito web nikeplus.com e viene visualizzato un grafico con i dati relativi alla tua 
sessione più recente.
4 Fai clic su “Registra le corse” ed esegui il login oppure registrati se necessario.
Per la Politica di tutela della privacy e i Termini e condizioni di utilizzo Nike, consulta 
il sito web nikeplus.com.
Riesaminare le sessioni sul dispositivo
iPod nano, iPhone o iPod touch salvano data, ora, durata, distanza, passo e calorie 
bruciate delle ultime mille sessioni.
Per riesaminare sessioni recenti sul dispositivo:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Cronologia.
m iPod nano (solo quinta generazione):  scegli Fitness > Cronologia, nella parte inferiore 
dello schermo.114
m iPhone e iPod touch:  scegli Nike + iPod, quindi tocca Cronologia nella parte inferiore 
dello schermo.
iPod nano (quinta generazione o precedente) fornisce i totali giornalieri di tutte le tue 
sessioni:  sessioni di Nike + iPod, pedometro contapassi e sessioni cardio utilizzando 
attrezzature da ginnastica compatibili con Nike + iPod.
Per visualizzare le sessioni su iPod nano (quinta generazione o precedente):
1 Scegli “Totali giornalieri” dal menu Cronologia.
2 Scegli una data e un’attività.
3 Ruota iPod nano (5a generazione) in posizione orizzontale per visualizzare una 
rappresentazione grafica dell’attività.
Per eliminare una singola sessione di allenamento:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Cronologia. Scegli una 
sessione di allenamento, tieni premuto il pulsante centrale, quindi scegli Elimina.
Non puoi eliminare singole sessioni su iPod nano (sesta generazione). 
m iPhone e iPod touch:  scegli “Nike + iPod” e tocca Cronologia. Tocca Modifica, scegli una 
sessione di allenamento, quindi tocca Elimina.
Su iPhone, iPod touch e iPod nano (sesta generazione), puoi eliminare tutte le sessioni 
di allenamento dalla Cronologia, toccando Cancella nella parte superiore della 
schermata Cronologia.115
Creare abbreviazioni di sessione personalizzate
Le abbreviazioni di sessione personalizzate ti consentono di scegliere e ripetere 
facilmente una sessione. iPod nano (quarta generazione o successiva) salva 
automaticamente le sessioni completate come abbreviazioni. iPhone e iPod touch 
ti consentono di creare abbreviazioni di sessione personalizzate.
Per creare un’abbreviazione di sessione personalizzata su iPhone o iPod touch:
1 Scegli “Nike + iPod”, quindi tocca “Le mie sessioni” nella parte inferiore della schermata.
2 Tocca Più (+), quindi scegli il tipo di sessione e il relativo obiettivo.
3 Scegli la musica, inserisci un nome per la sessione, quindi tocca Registra.
Nota:  puoi creare abbreviazioni di sessione personalizzate solo su iPhone e iPod touch 
(seconda generazione o successiva).
Per eliminare un’abbreviazione di sessione personalizzata su iPhone o iPod touch:
m Scegli “Nike + iPod”, quindi tocca “Le mie sessioni”. Tocca Modifica, scegli 
un’abbreviazione, quindi tocca Elimina. 
Per scegliere un’abbreviazione di sessione personalizzata:
m iPod nano (quarta e quinta generazione):  scegli Nike + iPod, quindi scegli 
un’abbreviazione. Il nome assegnato alle abbreviazioni varia in base al tipo di sessione 
e musica. Non è possibile eliminarle.
m iPod nano (solo quinta generazione):  scegli Fitness > Corsa, quindi tocca “Le mie 
sessioni”. Scegli un’abbreviazione. Il nome assegnato alle abbreviazioni varia in base al 
tipo di sessione e musica. Non è possibile eliminarle.
m iPhone e iPod touch:  scegli “Nike + iPod”, quindi tocca “Le mie sessioni”. Le abbreviazioni 
vengono elencate in base al nome specificato al momento della creazione.116
La abbreviazioni di sessione personalizzata più recente compare in alto nell’elenco.
Acquistare sessioni Nike+
Puoi acquistare e scaricare sessioni Nike+ contenenti un mix di musica continua e 
allenamento professionale. Quando acquisti una sessione Nike+, ricevi un’unica traccia 
di sessione con musica e voce, oltre a tutti i singoli brani presenti nel mix. Scegli mix 
per il tuo livello e stile di sessione.
Per acquistare una sessione Nike+:
1 Apri iTunes e fai clic su “Tunes Store” sul lato sinistro della finestra, quindi digita 
“Nike Sport Music” nel campo di ricerca di iTunes.
2 Fai clic sul pulsante Acquista accanto alla sessione Nike+ di tua scelta.
3 Segui le istruzioni su schermo per completare l’acquisto. Il download inizia 
automaticamente.
4 Collega il dispositivo al computer e carica la sessione sul dispositivo.
Nota:  negli Stati Uniti e in molti altri paesi, iTunes Store non è disponibile per 
i minori di età inferiore a 13 anni; per un elenco completo dei paesi consulta il sito 
www.apple.com/it/itunes/download. Soggetto a termini e condizioni. Per usare iTunes 
Store è necessario disporre di un accesso a Internet (potrebbe non essere gratuito).
Associare un telecomando compatibile con Nike + iPod o un 
cardiofrequenzimetro
I dispositivi compatibili con Nike + iPod sono in vendita separatamente dal kit sportivo 
Nike + iPod e dal sensore Nike + iPod.
Puoi usare un telecomando compatibile per gestire Nike + iPod in modalità wireless 
durante l’allenamento.117
iPod nano (quinta generazione o successiva) supporta anche cardiofrequenzimetri 
compatibili con Nike + iPod.
Nota:  per utilizzare un cardiofrequenzimetro o un telecomando, il ricevitore 
iPod + Nike deve essere collegato a iPod nano (sesta generazione).
Prima di usare uno di questi dispositivi per la prima volta, devi associare il ricevitore di 
iPod nano, iPhone o iPod touch.
Per associare un telecomando compatibile con Nike + iPod (in vendita separatamente):
m iPod nano (solo quinta generazione):  collega il ricevitore Nike + iPod a iPod nano, scegli 
Nike + iPod > Impostazioni > Telecomando > Associa, quindi segui le istruzioni su 
schermo.
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Kit Sport 
Nike + iPod > Telecomando. Attiva le opzioni Telecomando, quindi tocca Associa.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Telecomando, quindi segui le 
istruzioni su schermo.
Per associare un cardiofrequenzimetro compatibile con Nike + iPod (in vendita 
separatamente):
m iPod nano (quinta generazione):  collega il ricevitore Nike + iPod a iPod nano, scegli 
Nike + iPod > Impostazioni > Cardiofrequenzimetro > Associa, quindi segui le istruzioni 
su schermo.
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Kit Sport 
Nike + iPod > Cardiofrequenzimetro > Associa, quindi segui le istruzioni su schermo.118
Per eliminare l’associazione di un dispositivo:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni > Telecomando 
(o Cardiofrequenzimetro) > “Elimina associazione”, quindi segui le istruzioni su schermo.
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Kit Sport Nike + 
iPod > Telecomando (o Cardiofrequenzimetro), quindi tocca “Elimina associazione”.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Telecomando, quindi tocca 
Elimina associazione.
Puoi attivare o disattivare le funzioni di un telecomando compatibile con Nike + iPod 
senza eliminare l’associazione del dispositivo.
Per attivare o disattivare la funzionalità telecomando:
m iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni > Telecomando, 
quindi imposta Telecomando su Attivato o Disattivato.
m iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Kit Sport 
Nike + iPod > Telecomando, quindi imposta Telecomando su Attivato o Disattivato.
m iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Telecomando, quindi 
crea o rimuovi l’associazione con il telecomando.119
Allenarsi con iPod nano (sesta generazione) e un cardiofrequenzimetro
Se disponi di iPod nano (sesta generazione) e di un cardiofrequenzimetro Nike + iPod 
compatibile (acquistato separatamente), iPod nano può registrare e visualizzare la tua 
frequenza cardiaca mentre ti alleni. Puoi anche specificare un intervallo o “zona” con la 
frequenza cardiaca minima e massima che desideri mantenere durante una sessione 
e tracciare quanto riesci a mantenere la tua frequenza cardiaca in quella zona mentre 
ti alleni. Quando ti alleni, iPod nano visualizza la tua frequenza cardiaca corrente; una 
freccia rivolta verso l’alto o il basso appare quando devi aumentare o ridurre l’attività. 
Puoi usare un cardiofrequenzimetro con una qualsiasi delle sessioni standard.
Inoltre, puoi monitorare la tua frequenza cardiaca anche se partecipi ad attività 
diverse dalla corsa o dalla camminata. Ad esempio, puoi usare iPod nano e un 
cardiofrequenzimetro quando partecipi ad attività sportive come basket, aerobica, 
circuito, golf, escursionismo, calcio e altro ancora. 
Quando finisci di allenarti, puoi trasferire le informazioni sulla frequenza cardiaca al tuo 
account nikeplus.com, per poterle rivedere.
Mentre configuri una sessione, puoi impostare una zona con la frequenza cardiaca 
minima e massima che vuoi mantenere quando selezioni una sessione. Devi prima 
attivare la funzionalità di allenamento a zona.
Per attivare o disattivare gli allenamenti a zona:
m Tocca Impostazioni > Fitness > Kit Sport Nike + iPod, quindi tocca il pulsante Sì/No in 
“Zona sessione”.
Quando attivi gli allenamenti a zona e selezioni una sessione, appaiono delle opzioni 
per l’impostazione di una zona di frequenza cardiaca. Mentre ti alleni, le informazioni 
sulla frequenza cardiaca vengono registrate e visualizzate per qualsiasi tipo di sessione. 120
iPod nano (sesta generazione) fornisce anche una sessione con frequenza cardiaca. 
Per eseguire una sessione con frequenza cardiaca, specifica la zona di frequenza 
cardiaca che vuoi mantenere, scegli il tipo di attività che stai per compiere e goditi 
l’allenamento. Tutte le informazioni sulla frequenza cardiaca vengono registrate 
automaticamente. Quando esegui una sessione con frequenza cardiaca, non hai 
bisogno di un sensore nella scarpa per registrare il movimento.
Per iniziare una sessione con frequenza cardiaca:
1 Tocca Fitness > Corsa > Frequenza cardiaca.
2 Imposta la zona di frequenza cardiaca che desideri.
3 Scegli un’attività e tocca Fine.
4 Scegli la musica che preferisci per l’allenamento.
5 Tocca “Avvia sessione” e inizia la sessione.
6 Quando hai finito, premi il tasto Standby/Riattiva per riattivare lo schermo, tocca 
Pausa, tocca lo schermo per visualizzare il pulsante Pausa, tocca Pausa. Tocca “Termina 
sessione” per terminare la tua sessione con frequenza cardiaca.
Quando completi una sessione con frequenza cardiaca, puoi trasferire le informazioni al 
tuo account nikeplus.com, così come faresti per qualsiasi altra sessione. 121
Associare un altro sensore
Una volta che il dispositivo viene associato a un sensore specifico, esso viene impostato 
per collegarsi solo a quel sensore. Se usi un sensore diverso, devi impostare il dispositivo 
per associare l’altro sensore. Potresti farlo, ad esempio, se in famiglia c’è più di una 
persona con un sensore e scarpe Nike+ ready.
Per creare un’associazione con un altro sensore:
1 iPod nano:  collega il ricevitore a iPod.
2 Mettiti le scarpe con il nuovo sensore assicurandoti che nelle vicinanze non vi sia un 
altro sensore Nike + iPod.
Cammina per attivare il sensore in modo che il ricevitore possa rilevarlo.
3 Associa il sensore al tuo dispositivo:
Â iPod nano (solo quinta generazione):  scegli Nike + iPod > Impostazioni > Sensore > 
Associa, quindi segui le istruzioni su schermo. Un messaggio indica che iPod è stato 
associato al nuovo sensore.
Â iPod nano (solo quinta generazione):  scegli Impostazioni > Fitness > Kit Sport Nike + 
iPod > Sensore, tocca Associa, quindi tocca lo schermo mentre cammini o corri per 
associare nuovamente il dispositivo con un altro sensore.
Â iPhone e iPod touch:  scegli Impostazioni > Nike + iPod > Sensore, tocca Nuovo, quindi 
segui le istruzioni su schermo.
Nota:  se effettui l’associazione con un sensore già associato in precedenza, Nike + iPod 
rileva le impostazioni di calibrazione. Non è necessario calibrare di nuovo.122
Se colleghi un ricevitore iPod a un altro iPod e lo utilizzi con lo stesso sensore, non 
dovrai riassociare o ricalibrare. Il ricevitore archivia le impostazioni, la cronologia 
di sessione e le abbreviazioni di sessione. Non è necessario eseguire nuovamente 
l’associazione o la calibrazione.
Mettere in stop il sensore Nike + iPod
Di default, il sensore è pronto e attivo. Se desideri conservare il sensore per un periodo 
di tempo prolungato o fare in modo che smetta di trasmettere, puoi metterlo in stop.
Importante:  per il rispetto della normativa vigente, metti il sensore in stop prima di 
salire su un aereo.
Per mettere il sensore in stop:
m Usa una penna o una graffetta per tenere premuto il pulsante Standby/Riattiva per tre 
secondi.
Pulsante Pausa/Riattiva
Per riattivare il sensore:
m Usa una penna o una graffetta per mantenere premuto il pulsante Standby/Riattiva.123
Informazioni importanti sulla sicurezza
ATTENZIONE:  la mancata osservanza delle norme di sicurezza qui riportate può 
causare lesioni o danni.
Esercizio fisico  Prima di iniziare un programma di esercizio fisico, sottoporsi a un 
esame fisico completo da parte del medico. Prima di iniziare una sessione, praticare 
un esercizio di riscaldamento o stiramento. Praticare gli esercizi con precauzione e 
attenzione. Se necessario, rallenta prima di regolare il dispositivo mentre corri. Smettere 
immediatamente l’allenamento in caso di dolori, senso di debolezza, vertigine, 
spossatezza o respirazione affannosa. Quando si pratica esercizio fisico, ci si assumono 
i rischi inerenti a tale attività, comprese eventuali lesioni che possano derivarne.
Non usare il ricevitore, iPhone o iPod sotto la pioggia o in prossimità di bacini d’acqua 
o altri luoghi umidi.
Rischio di soffocamento  Il ricevitore e il sensore rappresentano un rischio di soffocamento 
potenziale. Mantenerli fuori della portata dei bambini di età inferiore a tre anni.
Evitare danni all’udito  L’uso di auricolari a volume elevato può causare danni 
permanenti all’udito. Impostare il volume su un livello di sicurezza. Con il passare del 
tempo ci si può abituare a un volume più alto che può sembrare normale e danneggia 
invece l’udito. Se si sente un ronzio nelle orecchie o le voci giungono attutite, 
interrompere l’ascolto e farsi controllare l’udito. Più alto è il volume e più immediati i 
danni all’udito. Gli esperti suggeriscono di proteggere l’udito:
Â Limitare la quantità di tempo in cui si usano auricolari a volume elevato.
Â Evitare di aumentare il volume per isolarsi da un ambiente rumoroso.
Â Abbassa il volume se non senti le persone che parlano nelle vicinanze.124
Smontare il sensore  Non tentare di aprire il sensore, disassemblarlo o rimuoverne la 
batteria. Il sensore non contiene parti sostituibili dall’utente.
Ulteriori informazioni, servizio e supporto
Per Procedi così
Risposte a domande frequenti su Nike + iPod Vai su www.apple.com/it/support/nikeplus.
Servizio e supporto per il sensore e il ricevitore 
Nike + iPod
Vai su www.apple.com/it/support/nikeplus.
Servizio e supporto per le scarpe Nike+ ready o 
il sito web nikeplus.com
Vai su www.nikeplus.com.
Informazioni sull’uso di iTunes Apri iTunes e scegli Aiuto > Aiuto iTunes.
Informazioni sull’uso di iPod nano o iPod touch Vai su www.apple.com/it/support/ipod.
Informazioni sull’uso di iPhone Visita il sito www.apple.com/it/support/iphone.125
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. Operation 
is subject to the following two conditions: (1) This device may 
not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause 
undesired operation. See instructions if interference to radio or 
television reception is suspected.
Radio and Television Interference
This computer equipment generates, uses, and can radiate radiofrequency energy. If it is not installed and used properly—that 
is, in strict accordance with Apple’s instructions—it may cause 
interference with radio and television reception.
This equipment has been tested and found to comply with 
the limits for a Class B digital device in accordance with the 
specifications in Part 15 of FCC rules. These specifications 
are designed to provide reasonable protection against such 
interference in a residential installation. However, there is 
no guarantee that interference will not occur in a particular 
installation.
You can determine whether your computer system is causing 
interference by turning it off. If the interference stops, it was 
probably caused by the computer or one of the peripheral devices.
If your computer system does cause interference to radio or 
television reception, try to correct the interference by using one or 
more of the following measures:
• Turn the television or radio antenna until the interference stops.
• Move the computer to one side or the other of the television 
or radio.
• Move the computer farther away from the television or radio.
• Plug the computer into an outlet that is on a different circuit 
from the television or radio. (That is, make certain the computer 
and the television or radio are on circuits controlled by different 
circuit breakers or fuses.)
If necessary, consult an Apple Authorized Service Provider or 
Apple. See the service and support information that came with 
your Apple product. Or, consult an experienced radio/television 
technician for additional suggestions.
Important: Changes or modifications to this product not 
authorized by Apple Inc. could void the EMC compliance and 
negate your authority to operate the product.
This product was tested for EMC compliance under conditions that 
included the use of Apple peripheral devices and Apple shielded 
cables and connectors between system components. 
It is important that you use Apple peripheral devices and shielded 
cables and connectors between system components to reduce 
the possibility of causing interference to radios, television sets, and 
other electronic devices. You can obtain Apple peripheral devices 
and the proper shielded cables and connectors through an Apple 
Authorized Reseller. For non-Apple peripheral devices, contact the 
manufacturer or reseller for assistance.
Responsible party (contact for FCC matters only):
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A
Cupertino, CA 95014
Wireless Information
FCC Wireless Compliance for the Nike + iPod Sensor. The antenna 
used with this transmitter must not be colocated or operated in 
conjunction with any other antenna or transmitter subject to the 
conditions of the FCC Grant.
Canadian Compliance Statement
This device complies with Industry Canada license-exempt RSS 
standard(s). Operation is subject to the following two conditions: 
(1) this device may not cause interference, and (2) this device must 
accept any interference, including interference that may cause 
undesired operation of the device.
Cet appareil est conforme aux normes CNR exemptes de licence 
d’Industrie Canada. Le fonctionnement est soumis aux deux 
conditions suivantes : (1) cet appareil ne doit pas provoquer 
d’interférences et (2) cet appareil doit accepter toute interférence, 
y compris celles susceptibles de provoquer un fonctionnement 
non souhaité de l’appareil.126
Industry Canada Statement
Complies with the Canadian ICES-003 Class B, RSS 200 
specifications. Cet appareil numérique de la classe B est conforme 
à la norme NMB-003 RSS 210 du Canada.
European Wireless EU Declaration of Conformity
This wireless device complies with the specifications EN 300 328, 
EN 301-489, EN 50371, and EN 60950 following the provisions of 
the R&TTE Directive.
European Community
Complies with European Directives 72/23/EEC, 89/336/ EEC, 
and 99/5/EEC.
Exposure to Radio Frequency Energy
The radiated output power of the included devices is far below the 
FCC radio frequency exposure limits. 
Disposal and Recycling Information
The Nike + iPod Sensor contains a battery. Dispose of your 
Nike + iPod Sensor according to local environmental laws and 
guidelines. When discarding shoes, remove the Nike + iPod Sensor 
and dispose of it properly.
For information about Apple’s recycling program, go to 
www.apple.com/recycling.
   2011
Türkiye
EEE yönetmeligine (Elektrikli ve Elektronik Esyalarda Bazi Zararli 
Maddelerin Kullaniminin Sinirlandirilmasina Dair Yönetmelik) 
uygundur.127
Brasil:  Informações sobre descarte e reciclagem
O símbolo acima indica que este produto e/ou sua bateria não 
devem ser descartadas no lixo doméstico.  Quando decidir 
descartar este produto e/ou sua bateria, faça-o de acordo com 
as leis e diretrizes ambientais locais.  Para informações sobre o 
programa de reciclagem da Apple, pontos de coleta e telefone de 
informações, visite www.apple.com/br/environment.
European Union:  Disposal Information
The symbol above means that according to local laws and 
regulations your product should be disposed of separately from 
household waste. When this product reaches its end of life, take 
it to a collection point designated by local authorities. Some 
collection points accept products for free. The separate collection 
and recycling of your product at the time of disposal will help 
conserve natural resources and ensure that it is recycled in a 
manner that protects human health and the environment.
Deutschland:  Dieses Gerät enthält Batterien. Bitte nicht in den 
Hausmüll werfen. Entsorgen Sie dieses Gerät am Ende seines 
Lebenszyklus entsprechend der maßgeblichen gesetzlichen 
Regelungen.
Nederlands:  Gebruikte batterijen kunnen worden ingeleverd 
bij de chemokar of in een speciale batterijcontainer voor klein 
chemisch afval (kca) worden gedeponeerd.
Taiwan Battery Statement
Chinese Battery Statement
Apple and the Environment
At Apple, we recognize our responsibility to minimize the 
environmental impact of our operations and products.
For more information, go to:  www.apple.com/environmentwww.apple.com/ipod/nike
www.apple.com/support/nikeplus
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Votre MacBook Pro est conçu pour pouvoir être configuré rapidement et utilisé
immédiatement. Si vous n’avez jamais utilisé de MacBook Pro ou si vous n’êtes pas
familiarisé avec les ordinateurs Mac, vous trouverez dans ce chapitre des instructions
qui vous aideront à débuter.
Important : lisez attentivement toutes les instructions d’installation (et les consignes
de sécurité à partir de la page 74) avant d’utiliser votre ordinateur pour la première fois.
Si vous êtes un utilisateur expérimenté, peut-être êtes-vous déjà en mesure d’utiliser
votre nouvel ordinateur. Veillez néanmoins à consulter les informations du chapitre 2,
« Votre MacBook Pro au quotidien », pour découvrir les nouvelles fonctionnalités de ce
MacBook Pro.
Vous trouverez la plupart des réponses à vos questions dans le Centre d’aide. Pour
obtenir des informations sur l’utilisation du Centre d’aide, consultez la section
« Comment obtenir des réponses à vos doutes » à la page 31. Les plus récentes
informations concernant votre MacBook Pro sont disponibles sur le site web Assistance
Apple à la page www.apple.com/fr/support/macbookpro. Comme Apple publie
régulièrement de nouvelles versions et mises à jour de ses logiciels système, il est
possible que les images de ce manuel soient légèrement différentes de ce que vous
voyez à l’écran.Chapitre 1   Prêt, feu, configurez ! 9
Contenu de la boîte
Adaptateur secteur  Câble secteur
MagSafe de 85 W
®
Configuration du MacBook Pro
Votre MacBook Pro est conçu pour pouvoir être configuré rapidement et utilisé
immédiatement. Les pages suivantes contiennent des informations qui vous guideront
tout au long du processus de configuration, notamment des opérations suivantes :
Â Le branchement de l’adaptateur secteur MagSafe 85 W.
Â Le branchement des câbles et l’accès à un réseau.
Â Allumage de votre MacBook Pro
Â La configuration d’un compte d’utilisateur et d’autres paramètres via Assistant
réglages.10 Chapitre 1   Prêt, feu, configurez !
Â La configuration des préférences et du bureau Mac OS X.
Important : Retirez le film protecteur qui entoure l’adaptateur secteur MagSafe 85 W
avant de configurer le MacBook Pro.
Étape 1 : Branchez l’adaptateur secteur MagSafe 85 W pour alimenter le 
MacBook Pro et recharger sa batterie.
Assurez-vous que la fiche CA est complètement insérée dans l’adaptateur et que
les broches de la fiche sont complètement déployées. Branchez la fiche CA de votre
adaptateur sur une prise secteur, puis branchez le connecteur MagSafe sur le port
secteur MagSafe. En approchant le connecteur MagSafe du port, vous ressentirez la
force d’un aimant l’attirant.
Connecteur MagSafe
Câble secteur
Fiche CA ¯Port secteur MagSafe
Pour rallonger le câble de l’adaptateur secteur, remplacez la fiche CA par le câble
d’alimentation secteur. Tirez d’abord sur la fiche CA pour la retirer de l’adaptateur, puis
branchez le câble d’alimentation secteur inclus sur l’adaptateur, en vous assurant que
tout est branché correctement.Chapitre 1   Prêt, feu, configurez ! 11
Lorsque vous déconnectez l’adaptateur secteur d’une prise de courant ou de
l’ordinateur, débranchez la prise et non le câble.
La première fois que vous branchez l’adaptateur secteur sur le MacBook Pro, la
lampe témoin du connecteur MagSafe s’allume. Si la lumière est orange, la batterie
est en cours de rechargement. Un voyant lumineux vert indique que la batterie est
complètement chargée. Si aucune lumière ne s’allume, assurez-vous que le connecteur
est correctement branché et que l’adaptateur secteur est branché sur une prise
de courant.12 Chapitre 1   Prêt, feu, configurez !
Étape 2 : Connectez-vous à un réseau sans fil ou câblé.
Â Pour utiliser un réseau sans fil à l’aide de la technologie Wi-Fi 802.11n intégrée,
assurez-vous que la borne d’accès sans fil est activée et que vous disposez du nom
du réseau. Après avoir allumé votre MacBook Pro, l’Assistant réglages vous guide à
travers le processus de connexion. Pour obtenir des conseils de dépannage, consultez
la page 67.
Â Pour utiliser une connexion câblée, reliez votre MacBook Pro et un modem câble, un
modem DSL ou un réseau à l’aide d’un câble Ethernet.
®
Câble 
Ethernet
Port Ethernet Gigabit
(10/100/1000Base-T)
GChapitre 1   Prêt, feu, configurez ! 13
Étape 3 : Appuyez brièvement sur le bouton d’alimentation (®) pour allumer 
votre MacBook Pro.
Votre ordinateur émet un signal sonore lorsque vous l’allumez.
®
® Bouton d’alimentation
Le démarrage du MacBook Pro prend quelques instants. Après le démarrage, Assistant
réglages s’ouvre automatiquement.
Si votre MacBook Pro ne s’allume pas, consultez la section « Si votre MacBook Pro ne
s’allume ou ne démarre pas » à la page 55.14 Chapitre 1   Prêt, feu, configurez !
Étape 4 : Configurez votre MacBook Pro à l’aide de l’Assistant réglages.
La première fois que vous démarrez votre MacBook Pro, Assistant réglages se lance.
Assistant réglages vous aide à définir votre réseau Wi-Fi, à configurer un compte
utilisateur et à transférer des informations d’un autre Mac ou PC. Vous pouvez
également transférer des informations d’une copie de sauvegarde Time Machine ou
d’un autre disque.
Si vous effectuez la migration depuis un autre Mac, vous devrez peut-être mettre
à jour les logiciels si Mac OS X 10.5.3 ou ultérieur n’est pas installé sur l’autre Mac.
Pour effectuer la migration depuis un PC, téléchargez Assistant migration sur
www.apple.com/fr/migrate-to-mac, et installez-le sur le PC d’origine.
Une fois Assistant réglages lancé sur votre MacBook Pro, vous pouvez, sans quitter
cet assistant, passer à l’autre ordinateur si vous devez mettre à jour ses logiciels, puis
revenir à votre MacBook Pro pour terminer la configuration.
Remarque : Si vous ne passez pas par Assistant réglages pour transférer vos
informations lors du premier démarrage de votre MacBook Pro, vous pouvez procéder
à cette opération ultérieurement. Ouvrez Assistant migration dans le dossier Utilitaires
du Launchpad. Pour obtenir de l’aide sur l’utilisation d’Assistant migration, ouvrez le
Centre d’aide et recherchez le terme « Assistant migration ».Chapitre 1   Prêt, feu, configurez ! 15
Pour configurer votre MacBook Pro :
1 Dans Assistant réglages, suivez les instructions à l’écran jusqu’à ce que l’écran
« Transférer des données vers ce Mac » s’affiche.
2 Optez pour une configuration de base ou une configuration avec migration, ou
transférez les informations d’une copie de sauvegarde Time Machine ou d’un autre
disque :
Â Pour effectuer une configuration de base, sélectionnez « Ne pas transférer maintenant »
et cliquez sur Continuer. Suivez les invites restantes pour sélectionner votre réseau
câblé ou sans fil, configurez votre compte puis quittez Assistant réglages.
Â Pour effectuer une configuration avec migration, sélectionnez « À partir d’un autre
Mac ou d‘un PC » et cliquez sur Continuer. Suivez les instructions à l’écran pour
sélectionner le Mac ou le PC depuis lequel effectuer la migration. Votre Mac ou PC
doit se trouver sur le même réseau câblé ou sans fil. Suivez les instructions à l’écran.
Â Pour transférer des informations d’une copie de sauvegarde Time Machine ou d’un autre 
disque, sélectionnez « À partir d’une sauvegarde Time Machine ou d’un autre disque »
et cliquez sur Continuer. Sélectionnez la copie de sauvegarde ou l’autre disque depuis
lequel effectuer la migration. Suivez les instructions à l’écran.
Si vous ne comptez pas conserver ou utiliser votre autre ordinateur, il est préférable de
lui retirer son autorisation à lire la musique, les vidéos ou les livres audio achetés dans
l’iTunes Store. Le retrait d’autorisation d’accès d’un ordinateur empêche qu’un autre
utilisateur lise les morceaux, vidéos et livres audio que vous avez achetés et libère une
autre autorisation pour en permettre l’utilisation. Pour en savoir plus sur le retrait de
l’autorisation d’accès, choisissez Aide iTunes dans le menu Aide de l’application iTunes.16 Chapitre 1   Prêt, feu, configurez !
Étape 5 : Personnalisez le bureau Mac OS X et définissez les préférences.
Vous avez la possibilité de personnaliser rapidement l’apparence de votre bureau grâce
à Préférences Système, votre centre de commandes renfermant la plupart des réglages
de votre MacBook Pro. Choisissez le menu Pomme (?) > Préférences Système dans la
barre des menus ou cliquez sur l’icône Préférences Système dans le Dock.
Barre des menus menu Aide icône de recherche Spotlight
icône du Finder Dock Icône de Préférences SystèmeChapitre 1   Prêt, feu, configurez ! 17
Important : Dans les préférences Utilisateurs et groupes, vous pouvez définir une
option pour réinitialiser votre mot de passe d’ouverture de session en cas d’oubli de ce
dernier. Pour obtenir de l’aide sur des préférences système, ouvrez le Centre d’aide et
recherchez « préférences système » ou la préférence spécifique qui vous intéresse.
Extinction ou suspension d’activité de votre MacBook Pro
Lorsque vous avez terminé d’utiliser votre MacBook Pro, suspendez son activité ou
éteignez-le.
Suspension de l’activité de votre MacBook Pro
Suspendez l’activité de votre MacBook Pro si vous ne comptez vous en éloigner
que quelques instants. Vous pourrez ensuite le réactiver rapidement sans avoir à le
redémarrer.
Pour suspendre l’activité de votre MacBook Pro, procédez de l’une des manières 
suivantes :
Â Rabattez l’écran.
Â Choisissez le menu Pomme (?) > Suspendre l’activité dans la barre des menus.
Â Appuyez sur le bouton d’alimentation (®) et cliquez sur Suspendre l’activité dans la
zone de dialogue qui apparaît.
Â Choisissez le menu Pomme (?) > Préférences Système, cliquez sur Économiseur
d’énergie, puis définissez un délai pour la suspension d’activité.18 Chapitre 1   Prêt, feu, configurez !
AVIS : Patientez quelques secondes jusqu’à ce que la lampe témoin de suspension
d’activité clignote (signalant que l’activité de l’ordinateur est suspendue et
que le disque dur a cessé de tourner) avant de déplacer le MacBook Pro Tout
déplacement de votre ordinateur lorsque le disque dur est en train de tourner risque
d’endommager ce dernier et d’entraîner une perte de données ou l’impossibilité de
démarrer à partir du disque dur.
Pour réactiver votre MacBook Pro :
Â Si l’écran est fermé, il suffit de l’ouvrir pour réactiver votre MacBook Pro.
Â Si l’écran est déjà ouvert, appuyez sur le bouton d’alimentation (®) ou sur l’une des
touches du clavier.
À la réactivation de votre MacBook Pro, vos applications, vos documents et vos
réglages sont conservés tels que vous les aviez laissés.
Extinction de votre MacBook Pro
Si vous ne comptez pas utiliser votre MacBook Pro pendant deux jours ou plus, il est
préférable de l’éteindre. Le voyant lumineux		de suspension d’activité reste allumé
quelques instants au moment de l’extinction.
Pour éteindre votre MacBook Pro, procédez de l’une des manières suivantes :
Â Choisissez le menu Pomme (?) > Éteindre dans la barre des menus.
Â Appuyez sur le bouton d’alimentation (®) et cliquez sur Éteindre dans la zone de
dialogue qui apparaît.
Si vous comptez ranger votre MacBook Pro pour une durée prolongée, consultez la
rubrique page 81 pour obtenir des informations sur les mesures à prendre pour éviter
que votre batterie ne se décharge complètement.Centre d’aide      Mac OS X
www.apple.com/fr/macosx
Votre MacBook Pro au 
quotidien
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Caractéristiques de base de votre MacBook Pro
®
® Bouton 
     d’alimentation
Lampe témoin 
de la caméra
Caméra FaceTime HD
Haut-parleurs 
stéréo integrés
Lampes témoins 
de la batterie (côté)
Microphone
Lampe témoin de 
suspension d’activité
Récepteur 
à infrarouge
Trackpad
Lecteur optique 
à chargement par fente
Logement
de sécuritéChapitre 2   Votre MacBook Pro au quotidien 21
Caméra FaceTime intégrée et lampe témoin de la caméra
Utilisez l’application FaceTime incluse pour passer des appels vidéo vers d’autres utilisateurs de
FaceTime (sur n’importe quel iPhone 4, nouvel iPod touch ou Mac doté de FaceTime), prendre
des photos avec Photo Booth ou capturer de la vidéo avec iMovie. La lampe témoin brille
lorsque la caméra FaceTime HD fonctionne.
Micro intégré
Capturez des sons grâce au micro ou discutez avec des amis sur Internet à l’aide de FaceTime
ou d’iChat.
Haut-parleurs stéréo intégrés
Permettent d’écouter de la musique, des films, des jeux et d’autres types de données
multimédias.
Batterie intégrée et témoins de la batterie
Utilisez la batterie lorsque vous n’êtes pas à proximité d’une prise de courant. Appuyez sur le
bouton de la batterie pour activer les lampes témoins du niveau de charge.
Trackpad
Vous pouvez cliquer ou double-cliquer n’importe où sur le trackpad. Touchez le trackpad avec
un ou plusieurs doigts pour déplacer le pointeur ou utiliser les gestes Multi-Touch (décrits à la
page 26).
Lampe témoin de suspension d’activité
Une lumière blanche clignote lorsque le MacBook Pro est en suspension d’activité.
Récepteur à infrarouge
Associé à une télécommande Apple Remote (vendue séparément), le récepteur à infrarouge
vous permet de contrôler, jusqu’à une distance de 9,1 mètres, l’application Keynote sur votre
MacBook Pro.
Logement de sécurité
Ce logement vous permet de protéger votre ordinateur contre le vol en y fixant un cadenas et
un câble (disponible séparément).
SuperDrive à chargement par fente
Ce lecteur optique permet de lire et de graver des CD et DVD de taille standard.
® Bouton d’alimentation
Permet d’allumer ou d’éteindre votre MacBook Pro ou d’en suspendre l’activité.22 Chapitre 2   Votre MacBook Pro au quotidien
Fonctionnalités du clavier de votre MacBook Pro
Touches de réglage 
du volume
Touches de 
réglage de luminosité
Touche
d’éjection de disque
Touche 
silence
Touches 
multimédias
Touches d’éclairage
du clavier
Touche 
Mission Control
Touche 
Launchpad
®
Touche 
de fonction (Fn)Chapitre 2   Votre MacBook Pro au quotidien 23
Touche de fonction (Fn)
Maintenez cette touche enfoncée pour activer les actions personnalisées affectées
aux touches de fonction (F1 à F12). Pour apprendre comment personnaliser les touches
de fonction, choisissez Aide > Centre d’aide dans la barre des menus, puis recherchez
« touches de fonction ».
Touches de réglage de luminosité (F1, F2)
Permettent d’augmenter ( ) ou de réduire ( ) la luminosité de l’écran.
Touche Mission Control (F3)
Permet d’ouvrir Mission Control afin d’avoir une vue complète des éléments en cours
d’exécution sur votre MacBook Pro, y compris le Dashboard, tous vos espaces et toutes
les fenêtres ouvertes.
Touche Launchpad (F4)
Permet d’ouvrir le Launchpad afin d’afficher instantanément toutes les applications de
votre MacBook Pro. Cliquez sur une application pour l’ouvrir.
o Touches d’éclairage du clavier (F5, F6)
Permettent d’augmenter (o) ou de diminuer (ø) la luminosité de l’éclairage du clavier.
’ Touches multimédias (F7, F8, F9)
Retour rapide ( ), lecture ou pause (’) ou avance rapide ( ) d’un morceau de
musique, d’un film ou d’un diaporama.
— Touche silence (F10)
Permet de désactiver le son provenant des haut-parleurs intégrés et du port de sortie
audio.
- Touches de réglage du volume (F11, F12)
Permettent d’augmenter (-) ou de diminuer (–) le volume du son provenant des hautparleurs intégrés ou du port de sortie audio.
C Touche d’éjection de disques
Maintenez cette touche enfoncée pour éjecter un disque que vous n’utilisez pas. Il est
également possible d’éjecter un disque en faisant glisser son icône dans la Corbeille.24 Chapitre 2   Votre MacBook Pro au quotidien
Ports de votre MacBook Pro
®
¯
Port Ethernet Gigabit 
(10/100/1000Base-T)
G
Port de sortie
de ligne audio
f
Port d’entrée 
de ligne audio
,
Ports 
USB 2.0
d Logement 
ExpressCard/34
Port
d’adaptateur 
secteur MagSafe
Port 
FireWire 800
H
Port 
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¯ Port d’adaptateur secteur MagSafe
Connectez-y l’adaptateur secteur MagSafe 85 W (inclus) pour recharger la batterie du
MacBook Pro.
G Port Gigabit Ethernet
Connectez-le à un réseau Ethernet haut débit, à un modem câble ou DSL ou encore à un
autre ordinateur. Le port Ethernet détecte automatiquement les périphériques Ethernet
sans avoir besoin de câble croisé Ethernet.
H Port FireWire 800
Connectez-y des périphériques externes tels que des caméras vidéo numériques et des
périphériques de stockage.
Port Thunderbolt (données, vidéo et audio haut débit)
Connectez-y des périphériques compatibles Thunderbolt pour des transferts de données
haut débit, ou un moniteur externe utilisant un port Mini DisplayPort. Vous pouvez
acheter des adaptateurs pour connecter des moniteurs DVI, HDMI ou VGA.
d Trois ports USB 2.0 (Universal Serial Bus) haut débit
Grâce à ces ports, vous pouvez brancher entre autres un iPod, un iPhone, un iPad, une
souris, un clavier, une imprimante, un disque dur, un appareil photo numérique, une
manette de jeu, un modem sur votre MacBook Pro.
, Port d’entrée audio
Permet de connecter un micro ou un appareil audio numérique à votre MacBook Pro.
f Port de sortie audio
Permet de connecter des haut-parleurs externes, un casque (y compris iPhone) ou tout
autre périphérique audio numérique.
Logement ExpressCard/34
Développez les fonctionnalités de votre MacBook Pro grâce aux cartes ExpressCard
standard de 34 mm. Pour éjecter une ExpressCard, appuyez doucement dessus pour
activer le ressort puis retirez-la du logement.26 Chapitre 2   Votre MacBook Pro au quotidien
Remarque : Les adaptateurs et les autres accessoires sont vendus séparément sur le
site www.apple.com/fr/store ou dans votre Apple Store local.
Utilisation du trackpad Multi-Touch
Le trackpad vous permet de déplacer le pointeur et de réaliser divers gestes MultiTouch. Contrairement aux trackpads habituels, celui du MacBook Pro fonctionne
comme un bouton en vous permettant de cliquer n’importe où sur sa surface. Pour
activer les gestes Multi-Touch, visionner des vidéos d’apprentissage des gestes et
définir d’autres options pour le trackpad, choisissez le menu Pomme (?) > Préférences
Système, puis cliquez sur Trackpad.
Voici différentes manières d’utiliser le trackpad de votre MacBook Pro :
Â Le défilement à deux doigts vous permet de défiler rapidement vers le haut, le bas ou
latéralement dans la fenêtre active.Chapitre 2   Votre MacBook Pro au quotidien 27
Â Le clic secondaire ou « clic droit » vous permet d’accéder aux commandes du menu
contextuel.
• Pour configurer le clic secondaire à deux doigts n’importe où sur le trackpad,
sélectionnez « Clic secondaire » dans la sous-fenêtre Pointer et cliquer des
préférences Trackpad.
	 	
• Pour configurer une zone de clic secondaire à un doigt dans le coin inférieur
gauche ou droit du trackpad, sélectionnez « Clic secondaire » dans la sous-fenêtre
Pointer et cliquer des préférences Trackpad et choisissez une option dans le menu
local.
	 	
zone de clic secondaire
Remarque : Vous pouvez également effectuer un clic secondaire en maintenant la
touche Contrôle (Ctrl) enfoncée au moment où vous cliquez.28 Chapitre 2   Votre MacBook Pro au quotidien
Les gestes de trackpad suivants fonctionnent dans certaines applications. Pour
effectuer ces gestes, faites glisser légèrement vos doigts sur la surface du trackpad. Pour
en savoir plus, reportez-vous aux préférences Trackpad ou choisissez Aide > Centre
d’aide, puis lancez une recherche sur le mot « trackpad ».
Â Le pincement ou l’écartement de deux doigts vous permet d’effectuer un zoom avant
ou arrière dans les PDF, les images, les photos, etc.
Â Le pivotement de deux doigts vous permet de faire pivoter des photos, des pages, etc.Chapitre 2   Votre MacBook Pro au quotidien 29
Â Le balayage à trois doigts fonctionne dans le Finder et dans toutes les applications.
Le balayage à trois doigts vers la gauche ou la droite vous permet de passer d’une
application plein écran à une autre. Le balayage à trois doigts vers le haut permet
d’ouvrir Mission Control. Vous pouvez aussi configurer ces options pour qu’elles
fonctionnent avec quatre doigts.
Â Le pincement à quatre doigts affiche le Launchpad lorsque vous rapprochez votre
pouce et vos trois doigts. Écartez ces mêmes doigts pour retourner sur le bureau.
Remarque : Vous pouvez définir d’autres fonctions pour de nombreux gestes. Pour en
savoir plus sur les gestes disponibles, choisissez le menu Pomme (?) > Préférences
Système, puis cliquez sur Trackpad. Cochez les cases pour activer les gestes et consultez
les menus locaux pour découvrir les options disponibles pour chaque geste.30 Chapitre 2   Votre MacBook Pro au quotidien
Utilisation de la batterie du MacBook Pro
Lorsque l’adaptateur secteur MagSafe n’est pas branché, le MacBook Pro puise son
alimentation de sa batterie intégrée. L’autonomie du MacBook Pro varie en fonction
des applications utilisées et des périphériques externes qui sont connectés à votre
MacBook Pro.
La désactivation de fonctions comme la technologie sans fil Wi-Fi ou Bluetooth ® et
la réduction de la luminosité de l’écran peuvent contribuer à économiser la batterie
lors des voyages en avion par exemple. De nombreuses Préférences Système sont
automatiquement réglées pour optimiser l’autonomie de la batterie.
Il est possible de déterminer la charge restante de la batterie en observant les huit
lampes témoins du niveau de la batterie, qui se trouvent sur le côté gauche de votre
MacBook Pro. Appuyez sur le bouton situé en regard des lampes témoins afin que ces
dernières s’allument brièvement pour indiquer la charge restante de la batterie.
Important : si un seul témoin est allumé, le niveau restant est très faible. Si aucun
témoin ne s’allume, c’est que la batterie est totalement vide et que le MacBook Pro ne
peut alors pas démarrer sans que l’adaptateur secteur soit branché sur une prise de
courant. Branchez l’adaptateur secteur pour permettre à la batterie de se recharger.
Pour en savoir plus sur les lampes témoins de la batterie, consultez la page 57.Chapitre 2   Votre MacBook Pro au quotidien 31
Vous pouvez également vérifier la charge restante de la batterie en observant l’icône
d’état ( ) de la batterie qui se trouve dans la barre des menus. Le niveau affiché
dépend de la quantité d’énergie restant dans la batterie, mais aussi des applications
et des périphériques en cours d’utilisation, ainsi que des réglages actuels de votre
système. Pour disposer de plus d’énergie, fermez des applications, déconnectez les
périphériques non utilisés et réglez la fonction d’Économiseur d’énergie. Pour en
savoir plus sur l’économie de la batterie et obtenir des astuces pour améliorer ses
performances, consultez la page www.apple.com/fr/batteries/notebooks.html.
Recharge de la batterie
Lorsque l’adaptateur secteur fourni avec le MacBook Pro est branché, la batterie se
recharge, que l’ordinateur soit éteint, allumé ou en suspension d’activité. La recharge
est toutefois plus rapide si l’ordinateur est éteint ou en mode de suspension d’activité.
La batterie de votre MacBook Pro ne peut être remplacée que par un Centre de
Services Agréé Apple ou dans un magasin Apple Store.
Comment obtenir des réponses à vos doutes
De plus amples informations sur l’utilisation du MacBook Pro sont disponibles
dans le Centre d’aide qui s’affiche sur votre ordinateur et sur Internet, à l’adresse
www.apple.com/fr/support/macbookpro.
Pour ouvrir le Centre d’aide :
1 Cliquez sur l’icône du Finder dans le Dock (la barre des icônes située au bord de l’écran).32 Chapitre 2   Votre MacBook Pro au quotidien
2 Cliquez sur le menu Aide dans la barre des menus et procédez de l’une des manières
suivantes :
a Saisissez une question ou un terme dans le champ de recherche, puis sélectionnez
une rubrique dans la liste des résultats ou sélectionnez « Afficher tous les résultats »
pour voir toutes les rubriques.
b Choisissez Centre d’aide pour ouvrir la fenêtre du Centre d’aide, dans laquelle vous
parcourir ou rechercher des rubriques.
Informations supplémentaires
Pour plus de renseignements sur l’utilisation de votre MacBook Pro, consultez les
sections suivantes :
Pour obtenir des 
informations sur :
Reportez-vous aux sources suivantes :
L’installation de mémoire chapitre 3, « Améliorez les performances de votre MacBook Pro
» à la page 35.
Le dépannage de votre
MacBook Pro en cas de
problème
chapitre 4, « À tout problème sa solution » à la page 51.
Le service et l’assistance
technique pour votre
MacBook Pro
« Informations, services et assistance » à la page 69. Vous pouvez
également vous rendre sur le site d’assistance Apple à l’adresse
www.apple.com/fr/support/macbookpro.
L’utilisation de Mac OS X Site web de Mac OS X à l’adresse www.apple.com/fr/macosx.
Vous pouvez également rechercher « Mac OS X » dans le Centre
d’aide.
La migration depuis un PC vers
un Mac
« Pourquoi vous adorerez le Mac » à l’adresse www.apple.com/fr/
getamac/whymac.Chapitre 2   Votre MacBook Pro au quotidien 33
Pour obtenir des 
informations sur :
Reportez-vous aux sources suivantes :
L’utilisation des applications
iLife
Site web d’iLife à l’adresse www.apple.com/fr/ilife. Vous pouvez
également ouvrir une application iLife, ouvrir l’Aide de cette
application, puis saisir une question dans le champ de recherche.
La modification des
Préférences Système
Préférences Système, accessibles en choisissant le menu
Pomme (K) > Préférences Système. Vous pouvez également
rechercher « préférences système » dans le Centre d’aide.
L’utilisation du trackpad Préférences Système et cliquez sur Trackpad.
L’utilisation du clavier Recherchez « clavier » dans le Centre d’aide.
L’utilisation de la caméra
FaceTime HD
Recherchez « caméra » dans le Centre d’aide.
L’utilisation de la technologie
Wi-Fi
Recherchez « wi-fi » dans le Centre d’aide.
L’utilisation de la technologie
sans fil Bluetooth
Page web d’assistance Bluetooth à l’adresse www.apple.com/
fr/support/bluetooth. Vous pouvez également ouvrir l’utilitaire
Échange de fichiers Bluetooth (dans le dossier Utilitaires du
Launchpad) et sélectionner Aide > Aide Bluetooth.
L’entretien de la batterie Recherchez « batterie » dans le Centre d’aide.
La connexion d’une
imprimante
Recherchez « impression » dans le Centre d’aide.
Les connexions FireWire et USB Recherchez « FireWire » ou « USB » dans le Centre d’aide
La connexion à Internet Recherchez « Internet » dans le Centre d’aide.
L’utilisation du port
Thunderbolt
Recherchez « Thunderbolt » dans le Centre d’aide.34 Chapitre 2   Votre MacBook Pro au quotidien
Pour obtenir des 
informations sur :
Reportez-vous aux sources suivantes :
La connexion d’un moniteur
externe
Recherchez « port affichage » dans le Centre d’aide.
La gravure d’un CD ou DVD Recherchez « graver disque » dans le Centre d’aide.
Les caractéristiques Page web des spécifications, à l’adresse support.apple.com/
fr_FR/specs. Vous pouvez également ouvrir Informations système
en choisissant le menu Pomme (K) > À propos de ce Mac dans
la barre des menus, puis en cliquant sur Plus d’infos.
L’actualité Apple Site web d’Apple à l’adresse www.apple.com/fr.
Les téléchargements de
logiciels
Le Mac App Store (disponible dans Mac OS X 10.6.6. ou ultérieur).
Les instructions, assistance
technique et manuels des
produits Apple
Site web d’assistance Apple à l’adresse www.apple.com/fr/
support.Centre d’aide      RAM
www.apple.com/fr/store
Améliorez les performances de 
votre MacBook Pro
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Ce chapitre fournit des informations et des instructions pour l’installation d’un disque
dur plus performant et la mise en place de mémoire supplémentaire dans votre
MacBook Pro.
AVERTISSEMENT : Apple vous recommande de confier l’ajout de mémoire et la
mise en place d’un nouveau disque dur à un technicien agréé Apple. Consultez les
informations sur le dépannage et l’assistance qui accompagnent votre ordinateur
pour savoir comment contacter Apple. Tout dommage causé à votre matériel en
tentant d’installer vous-même de la mémoire ou un disque dur n’est pas couvert par
la garantie limitée de votre ordinateur.
Vous ne pouvez pas remplacer la batterie de votre MacBook Pro vous-même. Si vous
pensez que votre batterie doit être changée, contactez un revendeur Apple ou un
Centre de Services Agréé Apple.Chapitre 3   Améliorez les performances de votre MacBook Pro 37
Remplacement du disque dur
Vous pouvez remplacer le disque dur de votre MacBook Pro par un modèle plus
performant. Vous trouverez le disque dur à côté de la batterie intégrée, une fois l’arrière
de votre MacBook Pro ouvert. Le disque dur de remplacement doit être de 2,5 pouces
et doté d’un connecteur Serial ATA (SATA).
Important : Apple vous recommande de sauvegarder les données de votre disque dur
avant de l’enlever et de le remplacer. Apple décline toute responsabilité en cas de perte
de données.
Pour remplacer le disque dur de votre MacBook Pro :
1 Éteignez votre MacBook Pro. Débranchez l’adaptateur secteur, le câble Ethernet, les
câbles USB, le verrou de sécurité et tous les autres câbles connectés au MacBook Pro
afin d’éviter toute détérioration de ce dernier.
AVERTISSEMENT : Les composants internes de votre MacBook Pro risquent d’être
chauds. Si vous venez d’utiliser votre MacBook Pro, attendez 10 minutes après l’avoir
éteint, afin de laisser aux composants internes le temps de se refroidir.
2 Retournez votre MacBook Pro et retirez les dix (10) vis qui maintiennent le fond du
boîtier. Retirez les vis les plus courtes des angles, comme indiqué sur l’illustration.
Soulevez ce dernier et placez-le sur le côté.38 Chapitre 3   Améliorez les performances de votre MacBook Pro
Important : Comme ces vis sont de longueurs différentes, prenez note de leur longueur
et de leur position respective pour pouvoir les replacer correctement. Rangez-les en
lieu sûr à portée de main.
Petite
GrandeChapitre 3   Améliorez les performances de votre MacBook Pro 39
Important : Tout retrait de la plaque du socle expose des composants internes
sensibles, en particulier à l’électricité statique.
3 Avant de toucher la structure de montage du disque dur, déchargez toute électricité
statique de votre corps en touchant une surface métallique située à l’intérieur de
l’ordinateur.40 Chapitre 3   Améliorez les performances de votre MacBook Pro
4 Repérez l’attache qui se trouve au-dessus du disque dur. Utilisez un tournevis
cruciforme pour desserrer les deux vis imperdables qui maintiennent l’attache en place.
Rangez cette dernière en lieu sûr à portée de main.
5 À l’aide de la languette, inclinez doucement le disque vers le haut.
Attache
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6 Tenez le disque dur par les côtés tout en tirant doucement sur le connecteur qui se
trouve sur le côté droit du disque afin de le déconnecter. N’écrasez pas le disque entre
vos doigts et évitez de toucher les circuits situés sur la face inférieure du disque.
Connecteur
Le connecteur est relié à un câble et demeure à l’intérieur de la baie de disque dur.42 Chapitre 3   Améliorez les performances de votre MacBook Pro
Important : Il y a quatre (4) vis de montage sur les côtés de votre disque dur. Si votre
nouveau disque dur n’est pas fourni avec des vis de montage, récupérez les vis de votre
ancien disque dur et montez-les sur le nouveau avant de l’installer.
Vis de montage
7 Branchez le connecteur sur la partie droite du nouveau disque dur.Chapitre 3   Améliorez les performances de votre MacBook Pro 43
8 Insérez le nouveau disque dur en le tenant incliné et en vous assurant que les vis de
montage sont correctement placées.
9 Replacez l’attache et serrez les vis.44 Chapitre 3   Améliorez les performances de votre MacBook Pro
10 Remettez le fond du boîtier en place. Remettez à leur place respective et serrez les dix vis
que vous avez retirées à l’étape 2 après vous être assuré que les plus courtes étaient dans les
angles, comme indiqué sur l’illustration.
Petite
Grande
Pour obtenir des informations sur l’installation de Mac OS X et des applications incluses,
consultez la section « Réparation, restauration ou réinstallation de logiciels Mac OS X » à la
page 58.Chapitre 3   Améliorez les performances de votre MacBook Pro 45
Installation de mémoire supplémentaire 
Votre ordinateur est doté de deux logements de mémoire auxquels vous pouvez accéder en
retirant le fond du boîtier. Le MacBook Pro est doté d’une mémoire DDR3 (Double Data Rate)
SDRAM (Synchronous Dynamic Random-Access Memory) à 1 333 MHz, d’un minimum de
quatre gigaoctets (4 Go). Chaque logement de mémoire peut accueillir un module SDRAM
conforme aux spécifications suivantes :
Â Module DDR3 (Double Data Rate Small Outline Dual Inline Memory Module)
Â 30 mm
Â 204 broches
Â 2 Go ou 4 Go
Â Mémoire RAM de type PC3-10600S DDR3 à 1 333 MHz
Vous pouvez ajouter deux modules de mémoire de 4 Go pour un total de 8 Go de mémoire
au maximum. Pour des performances optimales, remplissez les deux logements de mémoire
en y installant des modules identiques.
Pour installer de la mémoire supplémentaire dans votre MacBook Pro :
1 Suivez les étapes 1 et 2 à partir de la page 37 pour retirer la plaque du socle.
Important : Tout retrait de la plaque du socle expose des composants internes sensibles, en
particulier à l’électricité statique.
2 Avant de toucher la structure de montage de la mémoire, déchargez toute électricité statique
de votre corps en touchant une surface métallique située à l’intérieur de l’ordinateur.46 Chapitre 3   Améliorez les performances de votre MacBook Pro
3 Repoussez vers l’extérieur les leviers qui se trouvent sur les côtés du module de
mémoire, afin de libérer le module du logement de la carte mémoire.
La carte mémoire se dégage alors en se soulevant légèrement d’un côté. Avant de la
retirer, assurez-vous que les encoches en demi-cercle sont bien visibles. Si ce n’est pas
le cas, réessayez en appuyant une nouvelle fois sur les leviers vers l’extérieur.
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4 Saisissez le module de mémoire en le tenant par ses encoches, puis retirez-le du
logement.
5 Retirez l’autre module de mémoire.
Important : Saisissez les modules de mémoire en les tenant par les côtés et en veillant
à ne pas toucher les connecteurs dorés.
6 Insérez le nouveau module de mémoire dans le logement :
a Alignez l’encoche du bord doré du module sur celle qui se trouve dans le logement
de mémoire inférieur.
b Inclinez la carte et poussez-la dans le logement.
c Utilisez deux doigts pour exercer une pression ferme et uniforme afin de pousser
le module de mémoire vers le bas. Vous devez entendre un clic indiquant que la
mémoire est correctement insérée.
d Répétez l’opération pour installer un module de mémoire supplémentaire dans
le logement supérieur. Appuyez sur le module pour vous assurer qu’il est bien de
niveau.48 Chapitre 3   Améliorez les performances de votre MacBook Pro
Encoches
7 Suivez les instructions de replacement de la plaque du socle, présentées à l’étape 10 à
la page 44.Chapitre 3   Améliorez les performances de votre MacBook Pro 49
Reconnaissance de la nouvelle mémoire par le MacBook Pro
Après avoir ajouté de la mémoire à votre MacBook Pro, vérifiez si elle est reconnue.
Pour vérifier la mémoire de votre ordinateur :
1 Démarrez votre MacBook Pro.
2 Lorsque le bureau Mac OS X apparaît, choisissez le menu Pomme (?) dans la barre des
menus, puis sélectionnez « À propos de ce Mac ».
Pour en savoir plus sur la mémoire installée sur votre ordinateur, ouvrez Informations
système en cliquant sur Plus d’infos, puis cliquez sur Mémoire.
Si le MacBook Pro ne reconnaît pas la mémoire ou ne démarre pas correctement,
vérifiez que la mémoire est compatible avec le MacBook Pro et qu’elle est correctement
installée.Centre d’aide      aide
www.apple.com/fr/support
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Vous pouvez occasionnellement rencontrer des problèmes en utilisant votre
MacBook Pro. Lisez la suite pour obtenir des conseils de dépannage utiles en cas de
problème. Vous trouverez des informations supplémentaires concernant le dépannage
dans le Centre d’aide et sur le site web d’assistance consacré au MacBook Pro, à
l’adresse www.apple.com/fr/support/macbookpro.
Il existe généralement une solution simple et rapide aux problèmes que vous pouvez
rencontrer lors de l’utilisation de votre MacBook Pro. Réfléchissez aux conditions qui
ont entraîné l’apparition de ce problème. Ce récapitulatif de la totalité des opérations
effectuées avant que le problème ne survienne permet de restreindre les causes
possibles et de trouver la solution. Les éléments à noter comprennent :
Â les applications que vous étiez en train d’utiliser quand le problème est apparu ; les
problèmes qui n’apparaissent qu’avec une application spécifique peuvent indiquer
que cette application n’est pas compatible avec la version de Mac OS X installée sur
votre ordinateur ;
Â les nouveaux logiciels installés, notamment ceux qui ont ajouté des éléments à votre
dossier Système ;
Â tout nouveau composant matériel installé (mémoire supplémentaire ou périphérique,
par exemple).Chapitre 4   À tout problème sa solution 53
Une once de prévention
Si vous rencontrez un problème avec votre ordinateur ou un logiciel, des copies de
sauvegarde à jour permettront d’éviter de perdre des données. Si vous effectuez des
copies de sauvegarde Time Machine régulières, vous pouvez restaurer vos logiciels ainsi
que l’ensemble de vos données tels qu’ils se trouvaient au moment de la sauvegarde.
Même les problèmes les plus graves sont moins sérieux lorsque vous sauvegardez vos
informations avec Time Machine.
Problèmes vous empêchant d’utiliser votre MacBook Pro
Si votre MacBook Pro ne répond plus ou que le pointeur se fige
Il peut arriver, très rarement, qu’une application se « bloque » à l’écran. Mac OS X offre
un moyen de fermer une application bloquée sans redémarrer votre ordinateur.
Pour forcer la fermeture d’une application :
1 Appuyez sur les touches Commande (x) + Option + esc ou choisissez le menu
Pomme (?) > Forcer à quitter dans la barre des menus.
La boîte de dialogue « Forcer à quitter des applications » apparaît. L’application est
sélectionnée.
2 Cliquez sur Forcer à quitter.
L’application se ferme, en laissant toutes les autres applications ouvertes.
Si nécessaire, vous pouvez également redémarrer le Finder à partir de cette zone
de dialogue.
Redémarrez ensuite l’ordinateur afin de vous assurer que le problème est entièrement
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Si le problème survient fréquemment, choisissez Aide > Centre d’aide dans la barre des
menus en haut de l’écran. Recherchez le mot « bloquer » pour obtenir de l’aide en cas
de blocage ou d’absence de réponse de l’ordinateur.
Si le problème ne survient que lorsque vous utilisez une application particulière,
vérifiez auprès de son éditeur si elle est compatible avec votre ordinateur. Pour obtenir
des informations de contact et une assistance concernant les logiciels fournis avec le
MacBook Pro, consultez la page www.apple.com/fr/downloads.
Si vous savez qu’une application est compatible, vous devrez peut-être réinstaller le
logiciel système de votre ordinateur. Consultez la section « Une once de prévention » à
la page 53.
Si le MacBook Pro se bloque au démarrage, si un point d’interrogation clignotant 
apparaît ou si l’écran est éteint et que le voyant lumineux de suspension d’activité 
reste allumé (pas en mode de suspension d’activité) 
Le point d’interrogation clignotant signifie généralement que l’ordinateur ne parvient
pas à localiser le logiciel système sur le disque dur interne ou sur tout disque externe
relié à l’ordinateur.
Â Patientez quelques secondes. Si l’ordinateur ne démarre pas de suite, éteignez-le
en maintenant le bouton d’alimentation (®) enfoncé pendant 8 à 10 secondes.
Débranchez tous les périphériques, puis tentez de redémarrer l’ordinateur en
appuyant sur le bouton d’alimentation (®) tout en maintenant la touche Option
enfoncée. Lorsque votre ordinateur démarre, cliquez sur l’icône du disque dur, puis
sur la flèche droite. Une fois que l’ordinateur a démarré, ouvrez Préférences Système
et cliquez sur Démarrage. Sélectionnez un dossier Système local de Mac OS X.Chapitre 4   À tout problème sa solution 55
Si le problème se produit fréquemment, vous devez peut-être réinstaller le logiciel
système de votre ordinateur. Consultez la section « Une once de prévention » à la
page 53.
Si votre MacBook Pro ne s’allume ou ne démarre pas
Tentez les opérations suivantes dans l’ordre jusqu’à ce que votre ordinateur s’allume :
Â Assurez-vous que l’adaptateur secteur est connecté à l’ordinateur et branché sur une
prise de courant en état de marche. Veillez à utiliser l’adaptateur secteur MagSafe
85 W fourni avec le MacBook Pro. Si l’adaptateur secteur ne recharge plus l’ordinateur
et que le voyant lumineux du connecteur MagSafe ne s’allume pas lorsque vous
branchez le câble d’alimentation, essayez de débrancher le câble puis de le brancher
à nouveau afin de le réinitialiser ou essayez à partir d’une autre prise.
Â Vérifiez si votre batterie a besoin d’être rechargée. Appuyez sur le petit bouton qui
se trouve sur le côté gauche de votre ordinateur. Vous devez voir apparaître un à
huit témoins lumineux indiquant le niveau de charge de la batterie. Si un seul voyant
lumineux est allumé, branchez votre adaptateur secteur pour recharger l’ordinateur.
Pour en savoir plus sur les voyants lumineux de la batterie, consultez la page 56.
Â Si le problème persiste, fermez tous les documents ouverts et quittez toutes les
applications. Rétablissez les réglages d’origine de votre ordinateur (tout en préservant
vos fichiers) en appuyant pendant cinq secondes simultanément sur la touche Maj,
la touche Option (alt) de gauche, la touche Contrôle et le bouton d’alimentation (®),
jusqu’au redémarrage de l’ordinateur.
Â Si vous avez récemment ajouté de la mémoire, assurez-vous qu’elle est correctement
installée et qu’elle est compatible avec votre ordinateur. Vérifiez si le retrait de cette
mémoire et la remise en place de l’ancienne permettent à l’ordinateur de démarrer
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Â Pour réinitialiser la PRAM, appuyez sur le bouton d’alimentation (®) et maintenez
immédiatement les touches Commande (x), Option, P et R enfoncées jusqu’à ce que
vous entendiez une deuxième fois le signal sonore de démarrage.
Â Si vous ne parvenez toujours pas à démarrer le MacBook Pro, consultez la section
« Informations, services et assistance » à la page 69 qui contient les informations
nécessaires pour prendre contact avec Apple.
Si l’écran devient subitement noir ou que votre MacBook Pro se bloque
Essayez de redémarrer votre MacBook Pro.
1 Débranchez tout périphérique connecté à votre MacBook Pro excepté l’adaptateur
secteur.
2 Appuyez sur le bouton d’alimentation (®) pour redémarrer le système.
3 Le niveau de charge de la batterie doit atteindre au moins 10 pour cent avant la
connexion d’un périphérique et la reprise du travail.
Pour savoir où en est la charge de la batterie, cliquez sur l’icône d’état de la
batterie ( ) dans la barre des menus ou jetez un œil aux témoins de la batterie, à
gauche de votre MacBook Pro.
L’écran pourrait également s’assombrir si les fonctions d’économie d’énergie de la
batterie sont en place.Chapitre 4   À tout problème sa solution 57
Si vous appuyez sur le bouton de la batterie et que tous les voyants lumineux 
clignotent cinq fois de suite
Votre batterie doit être remplacée. Prenez contact avec un magasin Apple Store ou un
Centre de Services Agréé Apple.
Si vous appuyez sur le bouton de la batterie et que les voyants lumineux clignotent 
cinq fois de suite de gauche à droite, puis de droite à gauche
Votre batterie n’est pas reconnue. Prenez contact avec un magasin Apple Store ou un
Centre de Services Agréé Apple.
En cas de problème à l’éjection d’un disque
Fermez toutes les applications susceptibles d’utiliser le disque et essayez à
nouveau. Si cela ne donne pas de résultats, redémarrez l’ordinateur, puis maintenez
immédiatement le trackpad enfoncé.58 Chapitre 4   À tout problème sa solution
Réparation, restauration ou réinstallation de logiciels Mac OS X
Si vous avez un problème avec vos logiciels ou votre matériel Mac, Mac OS X fournit
des utilitaires de réparation et de restauration qui peuvent supprimer les problèmes
et même restaurer les réglages d’origine de vos logiciels. Vous pouvez accéder à
ces utilitaires depuis l’application Utilitaires Mac OS X, même si votre ordinateur ne
démarre pas correctement.
Utilisez l’application Utilitaires Mac OS X pour :
Â restaurer vos logiciels et vos données depuis une copie de sauvegarde Time
Machine ;
Â réinstaller Mac OS X et les applications Apple ;Chapitre 4   À tout problème sa solution 59
Â restaurer les réglages d’origine de votre ordinateur en effaçant son disque et en
réinstallant Mac OS X et vos applications Apple ;
Â réparer le disque de votre ordinateur au moyen d’Utilitaire de disque.
Votre ordinateur ouvre automatiquement l’application Utilitaires Mac OS X s’il détecte
un problème. Vous pouvez également l’ouvrir manuellement en redémarrant votre
ordinateur.
Pour ouvrir l’application Utilitaires Mac OS X :
m Redémarrez votre ordinateur en maintenant les touches Commande (x) et R
enfoncées. La sous-fenêtre Utilitaires Mac OS X s’affiche.
Certains des utilitaires de l’application Utilitaires Mac OS X nécessitent un accès à
Internet et à l’Apple Store Mac. Vous devrez peut-être vous assurer que votre ordinateur
est connecté à Internet en utilisant votre réseau Ethernet ou Wi-Fi.
Pour vous connecter via un réseau Wi-Fi :
1 Choisissez un réseau dans le menu d’état Wi-Fi situé dans le coin supérieur droit de
l’écran.
2 Si nécessaire, saisissez le mot de passe du réseau.
Pour vous connecter à un réseau fermé, choisissez Se connecter à un autre réseau.
Saisissez le nom et le mot de passe du réseau.60 Chapitre 4   À tout problème sa solution
Réparation d’un disque avec Utilitaire de disque
Si vous avez un problème avec votre ordinateur ou si, au démarrage, celui-ci affiche
l’application Utilitaires Mac OS X, une réparation du disque de votre ordinateur peut
être nécessaire.
1 Sélectionnez Utilitaire de disque dans la sous-fenêtre Utilitaires Mac OS X et cliquez sur
Continuer.
2 Sélectionnez le disque ou la partition dans la liste de gauche, puis cliquez sur l’onglet
S.O.S.
3 Cliquez sur Réparer le disque.
Si Utilitaire de disque ne peut pas réparer le disque, sauvegardez autant d’informations
que possible, puis suivez les instructions de la section « Une once de prévention » à la
page 53.
Pour obtenir des informations sur Utilitaire de disque et ses options, consultez le Centre
d’aide, ou ouvrez Utilitaire de disque (dans le dossier Utilitaires du Launchpad) et
choisissez Aide > Aide Utilitaire de disque.
Restauration d’informations depuis une copie de sauvegarde 
Time Machine
Si vous avez précédemment créé une copie de sauvegarde Time Machine, utilisez
l’utilitaire Restaurer pour restaurer tous les éléments de votre ordinateur à leur état
précédent.
N’utilisez votre copie de sauvegarde Time Machine que pour restaurer des informations
sur l’ordinateur sur lequel la sauvegarde a été effectuée. Si vous souhaitez transférer
des informations sur un nouvel ordinateur, utilisez Assistant migration (dans le dossier
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1 Si votre copie de sauvegarde se trouve sur une Time Capsule, assurez-vous que votre
ordinateur est connecté à un réseau Ethernet ou Wi-Fi. (Pour vous connecter à un
réseau Wi-Fi, suivez les instructions présentées à la page 59.)
2 Dans la sous-fenêtre Utilitaires Mac OS X, sélectionnez Restaurer à partir d’une
sauvegarde Time Machine, puis cliquez sur Continuer.
3 Sélectionnez le disque qui contient la copie de sauvegarde Time Machine, puis suivez
les instructions à l’écran.
Réinstallation de Mac OS X et des applications Apple
La réinstallation de Mac OS X et des applications Apple peut parfois s’avérer nécessaire.
Vous pouvez procéder à cette réinstallation tout en conservant vos fichiers et vos
réglages utilisateur.
1 Assurez-vous que votre MacBook Pro est connecté à Internet via un réseau Ethernet
ou Wi-Fi. (Pour vous connecter à un réseau Wi-Fi, suivez les instructions présentées à la
page 59.)
2 Dans la sous-fenêtre Utilitaires Mac OS X, sélectionnez Réinstaller Mac OS X, puis
cliquez sur Continuer.
3 Dans la sous-fenêtre dans laquelle vous êtes invité à sélectionner un disque,
sélectionnez votre disque Mac OS X actuel (il s’agit bien souvent du seul disque
disponible).
4 Pour sélectionner ou désélectionner des logiciels facultatifs, cliquez sur Personnaliser.
5 Cliquez sur Installer.
Vous pouvez soit installer Mac OS X sans effacer le disque, afin de conserver vos fichiers
et réglages existants,soit effacer d’abord le disque pour supprimer toutes vos données et
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Important : Apple vous recommande de sauvegarder les données du disque avant de
procéder à la restauration des logiciels. Apple décline toute responsabilité en cas de
perte de données.
Restauration des réglages d’origine de votre ordinateur
Lorsque vous restaurez les réglages d’origine de votre ordinateur, tous les éléments
présents sur ce dernier (vos comptes utilisateur, vos réglages réseau, ainsi que tous vos
fichiers et dossiers) sont supprimés. Avant de procéder à une restauration, sauvegardez
tous les fichiers que vous souhaitez conserver en les copiant sur un autre disque.
Notez les réglages réseau enregistrés dans les préférences Réseau pour pouvoir vous
reconnecter plus aisément après la réinstallation de Mac OS X.
1 Assurez-vous que vous êtes connecté à Internet via un réseau Ethernet ou Wi-Fi.
(Pour vous connecter à un réseau Wi-Fi, suivez les instructions présentées à la page 59.)
2 Dans la sous-fenêtre Utilitaires Mac OS X, sélectionnez Utilitaire de disque, puis cliquez
sur Continuer.
3 Sélectionnez le disque dans la liste de gauche, puis cliquez sur l’onglet Effacer.
4 Sélectionnez « Mac OS étendu (journalisé) » dans le menu local Format, saisissez le nom
du disque, puis cliquez sur Effacer.
5 Une fois le disque effacé, choisissez Utilitaire de disque > Quitter Utilitaire de disque.
6 Dans la sous-fenêtre Utilitaires Mac OS X, sélectionnez Réinstaller Mac OS X, puis
cliquez sur Continuer.
7 Pour réinstaller Mac OS X et vos applications, suivez les instructions du programme
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Une fois Mac OS X et vos applications Apple restaurés, vous pouvez restaurer de
façon sélective vos autres données et applications depuis une copie de sauvegarde
Time Machine.
Utilisation d’Apple Hardware Test
Si vous pensez qu’il y a un problème avec les composants matériels du MacBook Pro,
vous pouvez utiliser l’application Apple Hardware Test pour savoir si tel est le cas (les
composants affectés peuvent être la mémoire ou le processeur, par exemple).
Pour utiliser Apple Hardware Test :
1 Déconnectez tous les périphériques externes de votre ordinateur, sauf l’adaptateur
secteur.
Si un câble Ethernet est connecté, déconnectez-le.
2 Redémarrez ensuite votre ordinateur en maintenant la touche D enfoncée lors du
démarrage.
3 Lorsque l’écran de sélection d’Apple Hardware Test s’affiche, choisissez votre langue.
4 Appuyez sur la touche Retour ou cliquez sur la flèche droite.
5 Lorsque l’écran principal d’Apple Hardware Test s’affiche (après 45 secondes environ),
suivez les instructions à l’écran.
6 En cas de détection d’un problème, Apple Hardware Test affiche un code d’erreur.
Notez le code d’erreur avant d’entreprendre les démarches d’assistance. Si
Apple Hardware Test ne détecte pas de panne matérielle, il est probable que le
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Problèmes de connexion à Internet
Votre MacBook Pro dispose de l’application Assistant réglages de réseau pour vous
aider tout au long de la procédure de configuration d’une connexion à Internet. Ouvrez
Préférences Système, puis cliquez sur Réseau. Cliquez sur le bouton « Assistant » pour
ouvrir Assistant réglages de réseau.
En cas de problème avec votre connexion à Internet, vous pouvez essayer les méthodes
exposées dans cette rubrique pour votre type de connexion ou vous pouvez utiliser
Diagnostic réseau.
Pour utiliser Diagnostic réseau :
1 Choisissez le menu Pomme (?) > Préférences Système.
2 Cliquez sur Réseau puis cliquez sur « Assistant ».
3 Cliquez sur Diagnostic pour lancer Diagnostic réseau.
4 Suivez les instructions à l’écran.
Si Diagnostic réseau n’est pas en mesure de résoudre le problème, celui-ci se situe
peut-être au niveau du fournisseur d’accès à Internet (FAI) auquel vous essayez de vous
connecter, du périphérique externe utilisé pour la connexion au FAI ou du serveur
auquel vous essayez d’accéder. Vous pouvez également tenter de réaliser les opérations
suivantes.
Connexions à Internet par modem câble, modem DSL ou réseau local (LAN)
Assurez-vous que tous les câbles du modem sont correctement branchés, y compris
le câble d’alimentation du modem, le câble reliant le modem à l’ordinateur et le câble
raccordant le modem à la prise murale. Vérifiez également les câbles et l’alimentation
de vos routeurs et concentrateurs Ethernet.Chapitre 4   À tout problème sa solution 65
Éteignez le modem câble ou DSL, puis rallumez-le après quelques minutes. Certains
fournisseurs d’accès à Internet conseillent de débrancher le câble d’alimentation
du modem. Si votre modem dispose d’un bouton de réinitialisation, vous pouvez
l’actionner avant ou après avoir éteint puis rallumé le modem.
Important : les instructions relatives aux modems ne concernent pas les utilisateurs
de réseau LAN. Contrairement aux utilisateurs de modems câble et DSL, les utilisateurs
de réseau LAN peuvent disposer de concentrateurs, commutateurs, routeurs et autres
blocs de connexion. Ils doivent prendre contact avec leur administrateur réseau plutôt
qu’avec un FAI.
Connexions PPPoE 
Si vous ne parvenez pas à vous connecter à votre fournisseur d’accès à Internet via
PPPoE (Point to Point Protocol over Ethernet), assurez-vous que les informations que
vous avez saisies dans les préférences Réseau sont correctes.
Pour vérifier les réglages de vos préférences Réseau :
1 Choisissez le menu Pomme (?) > Préférences Système.
2 Cliquez sur Réseau.
3 Cliquez sur Ajouter (+) en bas de la liste des services de connexion réseau et choisissez
PPPoE dans le menu local Interface.
4 Choisissez une interface pour le service PPPoE dans le menu local Ethernet. Choisissez
Ethernet si vous vous connectez à un réseau câblé ou Wi-Fi si vous vous connectez à
un réseau sans fil.
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6 Saisissez les informations fournies par votre fournisseur d’accès, tel que le nom du
compte, le mot de passe et le nom du service PPPoE (si votre fournisseur d’accès le
demande).
7 Cliquez sur Appliquer pour activer les réglages.
Connexions au réseau 
Assurez-vous que le câble Ethernet est branché sur le MacBook Pro et sur le réseau.
Vérifiez les câbles et l’alimentation de vos routeurs et concentrateurs Ethernet.
Si vous disposez de plusieurs ordinateurs tentant de partager une connexion à
Internet, assurez-vous que votre réseau est correctement configuré. Vous devez savoir
si votre FAI fournit une seule ou plusieurs adresses IP, autrement dit, une pour chaque
ordinateur.
Si une seule adresse IP est fournie, vous devez disposer d’un routeur capable de
partager la connexion ; on parle alors de conversion d’adresse réseau (NAT) ou de
masquage d’adresses IP. Pour obtenir des informations sur la configuration, consultez
la documentation fournie avec votre routeur ou contactez la personne qui a configuré
votre réseau. Il est possible d’utiliser la borne d’accès AirPort pour que plusieurs
ordinateurs partagent une adresse IP. Pour obtenir des informations sur l’utilisation
d’une borne d’accès AirPort, consultez le Centre d’aide ou le site web d’assistance
d’AirPort, à l’adresse www.apple.com/fr/support/airport.
Si ces méthodes s’avèrent insuffisantes pour résoudre les problèmes rencontrés,
adressez-vous à votre fournisseur d’accès à Internet ou à votre administrateur réseau.Chapitre 4   À tout problème sa solution 67
Problèmes de communication Wi-Fi
En cas de problèmes avec les communications Wi-Fi :
Â Vérifiez que l’ordinateur ou le réseau auquel vous souhaitez vous connecter est activé
et dispose d’un point d’accès sans fil.
Â Assurez-vous que le logiciel est correctement configuré conformément aux
instructions incluses avec votre borne d’accès ou point d‘accès.
Â Assurez-vous que votre MacBook Pro se trouve à portée de l’autre ordinateur ou du
point d’accès au réseau. Des appareils électroniques ou des structures métalliques se
trouvant à proximité peuvent interférer avec les communications sans fil et réduire
la portée de votre antenne. Vous pouvez éventuellement améliorer la réception en
tournant et en réorientant l’ordinateur.
Â Vérifiez l’icône d’état Wi-Fi (Z) dans la barre des menus. Jusqu’à quatre barres de
mesure apparaissent pour afficher la puissance du signal. Si les barres ne s’affichent
pas, tentez de changer de place.
Â Pour obtenir de l’aide en ligne, choisissez Aide > Centre d’aide et recherchez le terme
« wi-fi ». Consultez également les instructions fournies avec votre appareil sans fil.68 Chapitre 4   À tout problème sa solution
Maintien à jour de vos logiciels
Vous pouvez vous connecter à Internet pour télécharger et installer automatiquement
les dernières versions de logiciels, gestionnaires et autres améliorations fournies
par Apple.
Chaque fois que vous vous connectez à Internet, Mise à jour de logiciels recherche
d’éventuelles mises à jour pour votre ordinateur. Vous pouvez configurer votre
MacBook Pro afin qu’il recherche régulièrement les mises à jour disponibles, pour que
vous puissiez ensuite télécharger et installer les mises à jour de logiciels.
Pour rechercher des logiciels mis à jour :
1 Choisissez le menu Pomme (?) > Préférences Système.
2 Cliquez sur l’icône Mise à jour de logiciels et suivez les instructions à l’écran.
Â Pour en savoir plus, recherchez « Mise à jour de logiciels » dans le Centre d’aide.
Â Pour obtenir les toutes dernières informations sur Mac OS X, rendez-vous à l’adresse
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Informations, services et assistance
Outre le disque dur et la mémoire, votre MacBook Pro ne contient aucune pièce que
vous puissiez réparer vous-même. Si vous avez besoin de services de réparation,
adressez-vous à Apple ou portez votre MacBook Pro chez un Centre de Services Agréé
Apple. Vous trouverez de plus amples informations sur le MacBook Pro en ligne, dans
l’aide à l’écran, dans Informations système et via Apple Hardware Test.
Ressources en ligne
Pour obtenir des informations en ligne sur le service et l’assistance, consultez la page
www.apple.com/fr/support. Choisissez votre pays dans le menu local. Vous pouvez faire
des recherches dans la base de connaissances AppleCare, vérifier si de nouvelles mises
à jour de logiciels sont disponibles ou obtenir de l’aide dans les forums de discussion
Apple. Les informations les plus récentes concernant les produits sont disponibles à
l’adresse www.apple.com/fr/support/macbookpro.
Aide à l’écran
Vous pouvez chercher des réponses à vos questions ainsi que des instructions et
des informations concernant le dépannage dans le Centre d’aide. Choisissez Aide >
Centre d’aide.
Informations système
Pour obtenir des informations sur votre MacBook Pro, servez-vous d’Informations
système. Cette application vous fournit la liste des composants matériels et des
logiciels installés, le numéro de série et de version du système d’exploitation, la
quantité de mémoire installée, etc. Pour ouvrir Informations système, choisissez le
menu Pomme (?) > À propos de ce Mac dans la barre des menus, puis cliquez sur
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Service et assistance AppleCare
Votre MacBook Pro bénéficie d’une assistance technique de 90 jours et d’un an de
couverture pour les réparations de matériel effectuées dans les magasins Apple Store
ou les centres de réparations agréés Apple, tels que les Centres de Services Agréé
Apple (CSAA). Vous avez la possibilité d’étendre la durée de cette couverture en
adhérant à un programme AppleCare Protection Plan. Pour en savoir plus, consultez
la page www.apple.com/fr/support/products ou le site web correspondant à votre pays
(voir la liste ci-dessous).
Si vous avez besoin d’assistance, le personnel d’assistance par téléphone AppleCare
peut vous aider à installer et à ouvrir les applications, et propose des services de
dépannage élémentaires. Appelez le centre d’assistance le plus proche de chez vous
(gratuit pendant les 90 premiers jours). Gardez à portée de main la date d’achat et le
numéro de série de votre MacBook Pro lorsque vous appelez.
Remarque : La période de 90 jours d’assistance téléphonique gratuite débute à la date
d’achat. Des frais téléphoniques peuvent éventuellement s’appliquer.Chapitre 4   À tout problème sa solution 71
Pays Téléphone Site web
Allemagne (49) 01805 009 433 www.apple.com/de/support
Autriche (43) 0810 300 427 www.apple.com/at/support
Belgique (flamand)
															(français)
(32) 070 700 772
(32) 070 700 773
www.apple.com/benl/support
www.apple.com/befr/support
France (Metropolitain)
												(DOM-TOM)
(33) 0805 540 003
(33) 0825 77 00 35
www.apple.com/fr/support
Luxembourg (352) 800 24550 www.apple.com/lu/support/
Suisse (français)
											(allemand)
(41) 0848 000 132
(41) 0848 000 132
www.apple.com/chfr/support
www.apple.com/chde/support
Les numéros de téléphone sont susceptibles d’être modifiés. Les tarifs téléphoniques
locaux et nationaux peuvent s’appliquer. Une liste complète est disponible sur Internet :
www.apple.com/support/contact/phone_contacts.html (en anglais)72 Chapitre 4   À tout problème sa solution
Localisation du numéro de série de votre produit
Utilisez l’une des méthodes suivantes pour trouver le numéro de série de votre
ordinateur :
Â Retournez votre MacBook Pro. Le numéro de série est gravé sur le boîtier, près de la
charnière.
Numéro de série
Â Choisissez le menu Pomme (?) > À propos de ce Mac. Cliquez sur le numéro de
version sous « Mac OS X » pour passer du numéro de version de Mac OS X au numéro
de révision, puis au numéro de série.
Â Ouvrez Informations système, dans le dossier Utilitaires du Launchpad.Centre d’aide      ergonomie
www.apple.com/fr/environment
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Afin d’assurer votre sécurité et de préserver votre matériel, veillez à observer ces
consignes concernant le nettoyage et la manipulation de votre MacBook Pro ainsi que
l’aménagement d’un espace de travail confortable. Gardez ces instructions dans un
endroit facile d’accès pour vous et pour les utilisateurs éventuels.
AVIS : La garantie du fabricant pourra être annulée si votre ordinateur a été utilisé ou
stocké de manière impropre.
Informations importantes en matière de sécurité
AVERTISSEMENT : Ne pas suivre ces consignes pourrait déclencher un feu,
occasionner des décharges électriques ou entraîner tout type de blessure ou
dommage.
Batterie intégrée		Ne retirez pas la batterie de votre MacBook Pro. La batterie doit être
remplacée uniquement par un Centre de Services Agréé Apple Abandonnez toute
utilisation de votre MacBook Pro après une chute ou s’il semble avoir été écrasé, plié,
déformé ou endommagé. N’exposez pas votre MacBook Pro à des sources extrêmes de
chaleur, telles que des radiateurs ou des cheminées, où la température est susceptible
d’excéder 100 °C.
Manipulation correcte		La partie inférieure du MacBook Pro peut chauffer au cours
d’une utilisation normale de l’appareil. Le MacBook Pro respecte les limites de
température de surfaces accessible à l’utilisateur définies par la norme IEC 6590-1
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Pour un fonctionnement de l’ordinateur en toute sécurité et une réduction de la
possibilité de blessures liées à la chaleur, suivez les directives suivantes :
Â Installez le MacBook Pro sur un plan de travail stable en veillant à ce que l’air puisse
circuler librement sous l’ordinateur et autour de celui-ci.
Â N’utilisez pas le MacBook Pro en le posant sur un coussin, une couverture ou tout
autre objet de structure non solide car cela pourrait empêcher les conduits d’aération
de fonctionner correctement.
Â Évitez également de placer des objets sur le clavier lorsque vous utilisez votre
MacBook Pro.
Â N’introduisez aucun objet dans les ouvertures servant à la ventilation.
Â S’il est posé sur vos genoux et que la chaleur qu’il dégage vous gêne, posez-le plutôt
sur un plan de travail stable.
Eau et endroits humides Évitez de placer votre MacBook Pro à proximité de sources de
liquide telles que des boissons, un évier, un lavabo, une baignoire ou une douche, par
exemple. Protégez votre MacBook Pro de l’humidité et des intempéries (neige, pluie et
brouillard par exemple).
Adaptateur secteur MagSafe 85 W		N’utilisez que l’adaptateur secteur qui
accompagne le MacBook Pro ou, au besoin, un adaptateur secteur agréé Apple
compatible avec ce produit. Veillez à ce que la fiche ou le câble d’alimentation secteur
CA soit totalement enclenché dans l’adaptateur secteur avant de brancher ce dernier
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L’adaptateur secteur peut chauffer au cours d’une utilisation normale de l’appareil.
L’adaptateur secteur MagSafe respecte les limites de température de surfaces
accessible à l’utilisateur définies par la norme IEC 6590-1 (International Standard for
Safety of Information Technology Equipment),
Pour réduire la possibilité de surchauffe de l’adaptateur secteur et de blessures liées à
la chaleur, effectuez l’une des actions suivantes :
Â Branchez directement l’adaptateur secteur à une prise secteur.
Fiche CA Connecteur MagSafe
Adaptateur secteur MagSafe
Â Si vous utilisez le cordon d’alimentation secteur, placez l’adaptateur secteur sur un
bureau, une table ou le sol, dans un endroit bien ventilé.Chapitre 5   Dernières recommandations 77
Connecteur MagSafe
Adaptateur secteur MagSafe
Câble secteur
Débranchez l’adaptateur secteur et débranchez tous les autres câbles si l’un des cas
suivants se présente :
Â Vous cherchez à ajouter de la mémoire ou à remplacer le disque dur.
Â Vous souhaitez nettoyer le boîtier (pour ce faire, suivez à la lettre les instructions
fournies à la page 81).
Â La prise ou le câble d’alimentation est endommagé.
Â Le MacBook Pro ou l’adaptateur secteur est exposé à la pluie ou à une humidité
excessive, ou du liquide a été versé dans le boîtier.
Â Le MacBook Pro ou l’adaptateur secteur a subi une chute, le boîtier a été
endommagé ou vous pensez qu’une réparation est nécessaire.
Le port secteur MagSafe contient un aimant qui peut effacer les données d’une carte
de crédit, d’un iPod ou d’autres appareils. Pour protéger vos données, ne placez pas de
matériaux ou d’appareils à sensibilité magnétique (comme ceux cités précédemment
ou autres) à moins de 25 mm de ce port.78 Chapitre 5   Dernières recommandations
Si des résidus quelconques se trouvent dans le port secteur MagSafe, enlevez-les
doucement à l’aide d’un bâtonnet de coton.
Spécifications de l’alimentation MagSafe :
Â Fréquence :		phase unique de 50 à 60 Hz
Â Tension de secteur :		de 100 à 240 V
Â Tension de sortie :		18,5 V CC, 4,6 A
Diminution de l’acuité auditive		Vous risquez une perte d’audition irréparable si vous
utilisez un casque ou des écouteurs à un volume sonore élevé. L’oreille peut s’adapter
petit à petit à des volumes sonores de plus en plus élevés qui peuvent sembler
normaux, mais qui risquent à la longue d’endommager votre système auditif. En cas de
sifflements ou de perte d’acuité auditive, arrêtez d’utiliser le casque ou les écouteurs
et consultez un médecin. Plus le volume est élevé, plus votre audition risque d’être
affectée rapidement. Pour protéger votre système auditif, les spécialistes conseillent de
prendre les mesures suivantes :
Â Limitez la durée d’utilisation à volume élevé de vos écouteurs ou de votre casque
d’écoute.
Â Évitez d’augmenter le volume afin de bloquer les bruits environnants.
Â Baissez le volume si vous ne parvenez pas à entendre une personne qui parle à côté
de vous.
Activités à haut risque Cet ordinateur n’est pas conçu pour être utilisé dans des
installations nucléaires, pour la navigation ou la communication aérienne, pour le
contrôle du trafic aérien, ni dans aucune autre situation où une panne du système
informatique pourrait entraîner la mort, des blessures ou de graves dommages
écologiques.Chapitre 5   Dernières recommandations 79
Informations concernant le laser pour lecteurs optiques
AVERTISSEMENT : La mise en place de réglages ou la réalisation d’opérations qui ne
sont pas spécifiées dans le manuel de votre appareil risque de vous exposer à des
rayonnements dangereux.
Le lecteur optique de votre ordinateur contient un laser qui est entièrement sans
danger si l’on en fait un usage normal, mais qui peut s’avérer dangereux pour les yeux
s’il est démonté. Afin d’assurer votre sécurité, ce dispositif ne doit être réparé que par
un Centre de Services Agréé Apple.
Informations importantes sur la manipulation
AVIS : Ne pas suivre les présentes instructions sur la manipulation peut provoquer
des dommages à votre MacBook Pro ou à d’autres objets.
Environnement d’utilisation		L’utilisation de votre MacBook Pro en dehors de ces
plages peut gêner son bon fonctionnement :
Â Température de fonctionnement :		de 10 à 35 °C
Â Température de stockage :		de -20 à 45 °C
Â Humidité relative :		de 5 % à 90 % (sans condensation)
Â Altitude de fonctionnement :		de 0 à 3 048 mètres80 Chapitre 5   Dernières recommandations
Mise sous tension de votre MacBook Pro		N’allumez jamais le MacBook Pro tant
que tous ses composants internes ou externes ne sont pas en place. L’utilisation de
l’ordinateur alors que certains composants manquent peut s’avérer dangereuse et
risque de l’endommager.
Transport du MacBook Pro Si vous transportez le MacBook Pro dans un sac ou dans
un attaché-case, assurez-vous que ce dernier ne contient pas d’objets non attachés
(des trombones ou des pièces de monnaie, par exemple) qui pourraient pénétrer
accidentellement dans l’ordinateur par une ouverture (comme la fente du lecteur
optique) ou se coincer à l’intérieur d’un port. Maintenez également à l’écart du port
secteur MagSafe tout objet à sensibilité magnétique.
Utilisation des connecteurs et des ports  Ne forcez jamais un connecteur à entrer
dans un port. Lorsque vous branchez un appareil, assurez-vous que le port ne contient
aucun résidu quelconque, que le connecteur correspond bien au port et qu’il est placé
de manière à entrer correctement dans le port.
Utilisation du lecteur optique		Le lecteur SuperDrive du MacBook Pro prend en charge
les disques standard de 12 cm. Les disques de forme irrégulière et de moins de 12 cm
ne peuvent pas être lus et peuvent rester coincés dans le lecteur.
Manipulation des parties en verre		Votre MacBook Pro contient des composants
en verre, notamment l’écran et le trackpad. Si elles sont abîmées, n’utilisez pas votre
MacBook Pro tant qu’il n’a pas été réparé par un Centre de Services Agréé Apple.Chapitre 5   Dernières recommandations 81
Stockage du MacBook Pro		Si vous décidez de ranger le MacBook Pro pendant une
longue période, placez-le dans un endroit frais (idéalement, à 22 °C), et déchargez la
batterie jusqu’à 50 pour cent.		Avant de ranger votre MacBook Pro pour une période de
temps supérieure à cinq mois, déchargez la batterie jusqu’à environ 50 pour cent. Pour
conserver les capacités de la batterie, rechargez la batterie jusqu’à 50 pour cent tous les
six mois environ.
Nettoyage du MacBook Pro		Pour nettoyer le boîtier de votre MacBook Pro et de ses
composants, éteignez d’abord le MacBook Pro et débranchez l’adaptateur secteur.
Puis, pour nettoyer le boîtier de l’ordinateur, utilisez un chiffon doux, humide et non
pelucheux. Évitez les infiltrations d’humidité par quelque ouverture que ce soit. Ne
vaporisez jamais de liquide directement sur l’ordinateur. N’utilisez ni aérosols, ni
dissolvants, ni abrasifs qui pourraient endommager les finitions de l’appareil.
Nettoyage de l’écran du MacBook Pro		Pour nettoyer l’écran du MacBook Pro, éteignez
d’abord le MacBook Pro et débranchez l’adaptateur secteur. Humidifiez ensuite, à
l’eau seulement, le chiffon fourni et essuyez l’écran. Ne vaporisez jamais de liquide
directement sur l’écran.82 Chapitre 5   Dernières recommandations
Ergonomie
Voici quelques conseils pour la mise en place d’un environnement de travail sain.
Clavier et trackpad
Lorsque vous tapez au clavier ou que vous vous servez du trackpad, vos épaules
doivent être détendues. Le bras et l’avant-bras doivent former un angle droit, la main
étant placée dans le prolongement du poignet.
Position
à éviter
Position 
recommandéeChapitre 5   Dernières recommandations 83
Vous devez avoir les mains et les doigts détendus lorsque vous tapez au clavier ou que
vous utilisez le trackpad. Évitez de replier les pouces à l’intérieur des paumes.
Position
à éviter
Position 
recommandée
Modifiez fréquemment la position de vos mains pour éviter la fatigue. Après un travail
continu et intensif sur ordinateur, certains utilisateurs peuvent ressentir des douleurs
aux mains, aux poignets ou aux bras. Si ces douleurs persistent, consultez un spécialiste.
Souris externe
Si vous utilisez une souris externe, veillez à ce qu’elle se trouve à hauteur du clavier.
Ménagez un espace suffisant pour la manipuler avec aisance.
Siège
Optez pour un siège de bureau réglable et offrant un dossier et une assise confortables.
Réglez la hauteur du siège de telle sorte que vos cuisses reposent à l’horizontale et vos
pieds à plat sur le sol. Le dossier du siège doit soutenir votre région lombaire, c’est-à-
dire la partie inférieure de votre dos. Suivez les instructions du fabricant de sorte que le
réglage du dossier soit parfaitement adapté à votre morphologie.84 Chapitre 5   Dernières recommandations
Au besoin, relevez le siège de manière à ce que vos avant-bras et vos mains soient
placés correctement par rapport au clavier. Si, dans ce cas, vos pieds ne reposent plus à
plat sur le sol, utilisez un repose-pied inclinable et réglable en hauteur. Si vous disposez
d’un bureau modulaire, vous pouvez abaisser le niveau du plan de travail pour éviter
l’emploi d’un repose-pied. Une troisième solution consiste à utiliser un bureau dont le
poste de saisie est situé plus bas que le plan de travail.
Écran intégré
Orientez l’écran de manière à optimiser l’affichage dans votre environnement. Ne forcez
pas l’écran si vous rencontrez une résistance. L’angle d’ouverture maximal de l’écran ne
peut dépasser 130 degrés.
Réglez la luminosité et le contraste de l’écran chaque fois que vous déplacez
l’ordinateur ou que l’éclairage ambiant change.
Vous trouverez d’autres informations concernant l’ergonomie sur Internet :
www.apple.com/about/ergonomics (en anglais)
Apple et l’environnement
Apple Inc. reconnaît sa responsabilité en matière de réduction de l’impact de ses
produits et de ses activités sur l’environnement.
Des informations supplémentaires sont disponibles sur Internet :
www.apple.com/fr/environment85
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. Operation
is subject to the following two conditions:		(1) This device may
not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause
undesired operation. See instructions if interference to radio or
television reception is suspected.
L‘utilisation de ce dispositif est autorisée seulement aux conditions
suivantes : (1) il ne doit pas produire de brouillage et (2)
l’utilisateur du dispositif doit être prêt à accepter tout brouillage
radioélectrique reçu, même si ce brouillage est susceptible de
compromettre le fonctionnement du dispositif.
Radio and Television Interference
This computer equipment generates, uses, and can radiate radiofrequency energy. If it is not installed and used properly—that
is, in strict accordance with Apple’s instructions—it may cause
interference with radio and television reception.
This equipment has been tested and found to comply with
the limits for a Class B digital device in accordance with the
specifications in Part 15 of FCC rules. These specifications
are designed to provide reasonable protection against such
interference in a residential installation. However, there is
no guarantee that interference will not occur in a particular
installation.
You can determine whether your computer system is causing
interference by turning it off. If the interference stops, it was
probably caused by the computer or one of the peripheral devices.
If your computer system does cause interference to radio or
television reception, try to correct the interference by using one or
more of the following measures:
•	 Turn the television or radio antenna until the interference stops.
•	 Move the computer to one side or the other of the television
or radio.
•	 Move the computer farther away from the television or radio.
•	 Plug the computer into an outlet that is on a different circuit
from the television or radio. (That is, make certain the computer
and the television or radio are on circuits controlled by different
circuit breakers or fuses.)
If necessary, consult an Apple Authorized Service Provider or
Apple. See the service and support information that came with
your Apple product. Or, consult an experienced radio/television
technician for additional suggestions.
Important: Changes or modifications to this product not
authorized by Apple Inc. could void the EMC compliance and
negate your authority to operate the product.
This product has demonstrated EMC compliance under conditions
that included the use of compliant peripheral devices and shielded
cables (including Ethernet network cables) between system
components. It is important that you use compliant peripheral
devices and shielded cables between system components to
reduce the possibility of causing interference to radios, television
sets, and other electronic devices.
Responsible party (contact for FCC matters only):  
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A
Cupertino, CA 95014
Utilisation de la radio sans fil
Cet appareil est restreint à un usage intérieur lorsqu’il fonctionne à
des bandes de fréquence de 5,15 à 5,25 GHz.
Cet appareil doit être utilisé à l’intérieur.
Exposure to Radio Frequency Energy
The radiated output power of the Wi-Fi technology is below the
FCC radio frequency exposure limits. Nevertheless, it is advised to
use the wireless equipment in such a manner that the potential for
human contact during normal operation is minimized.
FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be colocated or
operated in conjunction with any other antenna or transmitter
subject to the conditions of the FCC Grant.86
Canadian Compliance Statement
This device complies with Industry Canada license-exempt RSS
standard(s). Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause
undesired operation of the device.
Cet appareil est conforme aux normes CNR exemptes de licence
d’Industrie Canada. Le fonctionnement est soumis aux deux
conditions suivantes : (1) cet appareil ne doit pas provoquer
d’interférences et (2) cet appareil doit accepter toute interférence,
y compris celles susceptibles de provoquer un fonctionnement
non souhaité de l’appareil.
Bluetooth Industry Canada Statement
This Class B device meets all requirements of the Canadian
interference-causing equipment regulations.
Cet appareil numérique de la Classe B respecte toutes les
exigences du Règlement sur le matériel brouilleur du Canada.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B specifications.
Cet appareil numérique de la classe B est conforme à la norme
NMB-003 du Canada. This device complies with RSS 210 of Industry
Canada.
Bluetooth Europe - Déclaration de conformité UE
Cet appareil sans fil est conforme à la directive R&TTE.
Europe : déclaration de conformité EU
?????????  Apple Inc. ?????????, ?? ???? MacBook Pro ? 
? ???????????? ??? ???????????? ?????????? ? ??????? 
????????? ??????? ?? ????????? 1999/5/??.
Cesky  Spolecnost Apple Inc. tímto prohlašuje, že tento 
MacBook Pro je ve shode se základními požadavky a dalšími 
príslušnými ustanoveními smernice 1999/5/ES.
Dansk  Undertegnede Apple Inc. erklærer herved, at følgende 
udstyr MacBook Pro overholder de væsentlige krav og øvrige 
relevante krav i direktiv 1999/5/EF.
Deutsch  Hiermit erklärt Apple Inc., dass sich das MacBook Pro 
in Übereinstimmung mit den grundlegenden Anforderungen 
und den übrigen einschlägigen Bestimmungen der Richtlinie 
1999/5/EG befinden.
Eesti  Käesolevaga kinnitab Apple Inc., et see MacBook Pro 
vastab direktiivi 1999/5/EÜ põhinõuetele ja nimetatud direktiivist 
tulenevatele teistele asjakohastele sätetele.
English  Hereby, Apple Inc. declares that this MacBook Pro is in 
compliance with the essential requirements and other relevant 
provisions of Directive 1999/5/EC.
Español  Por medio de la presente Apple Inc. declara que este 
MacBook Pro cumple con los requisitos esenciales y cualesquiera 
otras disposiciones aplicables o exigibles de la Directiva 
1999/5/CE. 
????????  Me t?? pa???sa, ? Apple Inc. d????e? ?t? a?t? 
? s?s?e?? MacBook Pro s?µµ??f??eta? p??? t?? ßas???? 
apa?t?se?? ?a? t?? ???p?? s?et???? d?ata´?e?? t?? ?d???a? 
1999/5/??. 
Français  Par la présente Apple Inc. déclare que l’appareil 
MacBook Pro est conforme aux exigences essentielles et aux 
autres dispositions pertinentes de la directive 1999/5/CE. 
Islenska  Apple Inc. lýsir því hér með yfir að þetta tæki 
MacBook Pro fullnægir lágmarkskröfum og öðrum viðeigandi 
ákvæðum Evróputilskipunar 1999/5/EC.
Italiano  Con la presente Apple Inc. dichiara che questo 
dispositivo MacBook Pro è conforme ai requisiti essenziali ed alle 
altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE. 
Latviski  Ar šo Apple Inc. deklare, ka MacBook Pro ierice atbilst 
Direktivas 1999/5/EK butiskajam prasibam un citiem ar to 
saistitajiem noteikumiem. 
Lietuviu  Šiuo „Apple Inc.“ deklaruoja, kad šis MacBook Pro 
atitinka esminius reikalavimus ir kitas 1999/5/EB Direktyvos 
nuostatas. 
Magyar  Alulírott, Apple Inc. nyilatkozom, hogy a MacBook Pro 
megfelel a vonatkozó alapvetõ követelményeknek és az 
1999/5/EC irányelv egyéb elõírásainak. 
Malti  Hawnhekk, Apple Inc., jiddikjara li dan MacBook Pro 
jikkonforma mal-htigijiet essenzjali u ma provvedimenti ohrajn 
relevanti li hemm fid-Dirrettiva 1999/5/EC.87
Nederlands  Hierbij verklaart Apple Inc. dat het toestel 
MacBook Pro in overeenstemming is met de essentiële eisen 
en de andere bepalingen van richtlijn 1999/5/EG.
Norsk  Apple Inc. erklærer herved at dette MacBook Pro 
-apparatet er i samsvar med de grunnleggende kravene og 
øvrige relevante krav i EU-direktivet 1999/5/EF. 
Polski  Niniejszym Apple Inc. oswiadcza, ze ten MacBook Pro sa 
zgodne z zasadniczymi wymogami oraz pozostalymi stosownymi 
postanowieniami  Dyrektywy 1999/5/EC. 
Português  Apple Inc. declara que este dispositivo 
MacBook Pro está em conformidade com os requisitos 
essenciais e outras disposições da Directiva 1999/5/CE. 
Româna  Prin prezenta, Apple Inc. declara ca acest  aparat 
MacBook Pro este în conformitate cu cerintele esentiale si cu 
celelalte prevederi relevante ale Directivei 1999/5/CE. 
Slovensko  Apple Inc. izjavlja, da je ta MacBook Pro skladne z 
bistvenimi zahtevami in ostalimi ustreznimi dolocili direktive 
1999/5/ES. 
Slovensky  Apple Inc. týmto vyhlasuje, že toto MacBook Pro splna 
základné požiadavky a všetky príslušné ustanovenia Smernice 
1999/5/ES. 
Suomi  Apple Inc. vakuuttaa täten, että tämä MacBook Pro 
tyyppinen laite on direktiivin 1999/5/EY oleellisten vaatimusten ja  
sitä koskevien direktiivin muiden ehtojen mukainen. 
Svenska  Härmed intygar Apple Inc. att denna MacBook Pro står i 
överensstämmelse med de väsentliga egenskapskrav och övriga 
relevanta bestämmelser som framgår av direktiv 1999/5/EG.
A copy of the EU Declaration of Conformity is available at:
www.apple.com/euro/compliance
This equipment can be used in the following countries:
Korea Warning Statements
B???(??????????)
???????(B?) ???????????
????????????????, ???
???????????.
????????????
????????????????????
????????????????????????
???? ?? ? ??
Singapore Wireless Certification
Taiwan Wireless Statements
Taiwan Class B Statement88
Japan VCCI Class B Statement
External USB Modem Information
When connecting your MacBook Pro to the phone line using an
external USB modem, refer to the telecommunications agency
information in the documentation that came with your modem.
ENERGY STAR
®
 Compliance
As an ENERGY STAR
®
partner, Apple has determined that standard
configurations of this product meet the ENERGY STAR
®
guidelines
for energy efficiency. The ENERGY STAR
®
program is a partnership
with electronic equipment manufacturers to promote energyefficient products. Reducing energy consumption of products
saves money and helps conserve valuable resources.
This computer is shipped with power management enabled with
the computer set to sleep after 10 minutes of user inactivity. To
wake your computer, click the mouse or trackpad or press any key
on the keyboard.
For more information about ENERGY STAR
®
, visit:
www.energystar.gov
Informations sur l’élimination et le recyclage
Le symbole ci-dessus signifie que vous devez vous débarrasser
de votre produit selon les normes et la législation de votre pays.
Lorsque votre produit n’est plus utilisable, contactez Apple ou les
autorités locales afin de connaître les possibilités de recyclage.
Pour en savoir plus sur le programme de recyclage Apple,
consultez le site www.apple.com/fr/recycling.
Union européenne—instructions concernant l’élimination 
des déchets :
Le symbole ci-dessus signifie que vous devez vous débarrasser
de votre produit sans le mélanger avec les ordures ménagères,
selon les normes et la législation de votre pays. Lorsque ce produit
n’est plus utilisable, portez-le dans un centre de traitement des
déchets agréé par les autorités locales. Certains centres acceptent
les produits gratuitement. Le traitement et le recyclage séparé
de votre produit lors de son élimination aideront à préserver les
ressources naturelles et à protéger l’environnement et la santé
des êtres humains.
Türkiye 
EEE yönetmeligine (Elektrikli ve Elektronik Esyalarda Bazi Zararli 
Maddelerin Kullaniminin Sinirlandirilmasina Dair Yönetmelik) 
uygundur.
Brasil—Informações sobre descarte e reciclagem
O símbolo acima indica que este produto e/ou sua bateria
não devem ser descartadas no lixo doméstico. Quando decidir
descartar este produto e/ou sua bateria, faça-o de acordo com
as leis e diretrizes ambientais locais. Para informações sobre o
programa de reciclagem da Apple, pontos de coleta e telefone de
informações, visite www.apple.com/br/environment.89
Informations sur l’enlèvement de la batterie
Jetez vos batteries usagées en respectant les lois et les consignes
environnementales de votre pays.
Deutschland:  Dieses Gerät enthält Batterien. Bitte nicht in den
Hausmüll werfen. Entsorgen Sie dieses Gerätes am Ende seines
Lebenszyklus entsprechend der maßgeblichen gesetzlichen
Regelungen.
Nederlands:  Gebruikte batterijen kunnen worden ingeleverd bij de
chemokar of in een speciale batterijcontainer voor klein chemisch
afval (kca) worden gedeponeerd.
China Battery Statement
Taiwan Battery StatementK Apple Inc.
© 2011 Apple Inc. Tous droits réservés.
En application des lois et conventions en vigueur, aucune
reproduction totale ni partielle du manuel n’est autorisée, sauf
consentement écrit préalable d’Apple.
Tout a été mis en œuvre pour que les informations présentées
dans ce manuel soient exactes. Apple n’est pas responsable des
erreurs de reproduction ou d’impression.
Apple
1 Infinite Loop
Cupertino, CA 95014
408-996-1010
www.apple.com
Le logo Apple est une marque d’Apple Inc. déposée aux États-Unis
et dans d’autres pays. En l’absence du consentement écrit d’Apple,
l’utilisation à des fins commerciales de ce logo via le clavier
(Option + Maj + K) peut constituer un acte de contrefaçon et de
concurrence déloyale.
Apple, le logo Apple, AirPort, FaceTime, Finder,FireWire,
GarageBand, iChat, iLife, iMovie, iPhone, iPhoto, iPod, iPod touch,
iTunes, Keynote, Mac, MacBook, Mac OS, MagSafe, Photo Booth,
Safari, Spaces, Spotlight, SuperDrive, Time Capsule et Time Machine
sont des marques d’Apple Inc., déposées aux États-Unis et dans
d’autres pays.
Le logo FireWire, iPad et Multi-Touch sont des marques d’Apple Inc.
Apple, AppleCare, Apple Store et iTunes Store sont des marques de
service d’Apple Inc. déposées aux États-Unis et dans d’autres pays.
App Store est une marque de service d’Apple Inc.
ENERGY STAR® est une marque déposée aux États-Unis.
Thunderbolt et le logo Thunderbolt sont des marques d’Intel Corp.
aux États-Unis et dans d’autres pays.
La marque et les logos Bluetooth® sont la propriété de Bluetooth
SIG, Inc. et sont concédés sous licence par Apple Inc.
Les autres noms de produits et de sociétés sont la propriété de
leurs détenteurs respectifs. Les produits commercialisés par des
entreprises tierces ne sont mentionnés que pour information,
sans aucune intention de préconisation ni de recommandation.
Apple décline toute responsabilité quant à l’utilisation et au
fonctionnement de ces produits.
Fabriqué sous licence de Dolby Laboratories. « Dolby », « Pro
Logic » et le symbole double-D sont des marques déposées de
Dolby Laboratories. Ouvrages confidentiels inédits. © 1992–1997
Dolby Laboratories, Inc. Tous droits réservés.
Publié simultanément aux États-Unis et au Canada.
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Communications regulation information
FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected. 
Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception. 
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation. 
Note: If a 10BASE-T Ethernet connector is used, the system complies only with the FCC Part
15, Class A limits and the CISPR 22, Class A limits, and may not be used in a residential area.
You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices. 
If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures: 
m Turn the television or radio antenna until the interference stops. 
m Move the computer to one side or the other of the television or radio. 
m Move the computer farther away from the television or radio. 
m Plug the computer into an outlet that is on a different circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.) 
If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402. 
IMPORTANT  Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.
This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance. DOC statement
DOC Class B Compliance  This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications. 
Observation des normes—Classe B  Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications. 
VCCI statement
CD-ROM drive
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous exposure.
WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider. 
If you have an internal Apple CD-ROM drive in your computer, your computer is a Class 1
laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets
minimum safety requirements. A service warning label is located in a service-accessible area.
The labels on your product may differ slightly from the ones shown here. 
Class 1 label Service warning label
Communications Regulation Information viiCongratulations on the purchase of your new Macintosh. Your computer is
designed to give you the highest performance combined with real ease of
use—it’s easy to set up, easy to use, and easy to expand. This book will guide
you through the setup procedure, tell you how to expand your Macintosh, and
provide many tips on using your new system.
Your Macintosh computer is powered by the new  microprocessor
(or “chip”). This microprocessor was designed by Apple Computer, Inc.,
Motorola, Inc., and IBM Corporation. The  microprocessor uses
Reduced Instruction Set Computing (RISC) technology to deliver very high
performance at the lowest possible cost. The  RISC microprocessor
represents the state of the art in microprocessor design.
Your new Macintosh will run almost all your existing Macintosh software, but
for best performance and greatest speed, look for the new software programs
designed especially for Power Macintosh computers. You’ll find Power
Macintosh programs at any software store that carries products for Macintosh.
ix
Welcome to Power MacintoshI
part
Chapter 1 Getting Started
Chapter 2 Getting Help
Chapter 3 Connecting Additional Equipment
Chapter 4 Installing and Using Application Programs
Chapter 5 Using the Optional CD-ROM DriveThe illustration on the next page shows all the equipment you will need to set
up your computer and begin using it. (Note that your monitor and keyboard
may look slightly different depending on what you purchased.)
Place your equipment on a sturdy, flat surface near a grounded wall outlet.
(Your computer was designed to be placed on the floor to conserve desk
space, but it can also be placed on any stable, flat surface.) 
Before following the setup instructions in this chapter, you may want to read
“Arranging Your Office” in Appendix A (in the section on health-related
information) for tips on adjusting your work furniture so that you’re
comfortable when using the computer.
1
1  Getting Started
Follow the instructions in this
chapter to set up your computer
and learn the basics.Monitor power cord
(sometimes built into the monitor)
Computer power cord
Monitor cable
(sometimes built into the monitor)
Mouse Keyboard
Keyboard cable
(sometimes built
into the keyboard
as shown here)
Monitor
Macintosh computer
Apple PlainTalk Microphone (optional)Getting Started 3
Plugging in the computer
Before you plug your Macintosh into a wall socket, carefully read all the
setup instructions in this chapter. Then, before you connect anything to your
Macintosh, follow the instructions in this section to plug it in. The plug
grounds the computer and protects it from electrical damage while you are
setting up. When you are ready to begin, follow these steps:
1 Plug the socket end of the computer’s power cord into the recessed power socket
(marked with the symbol ²) on the back of the computer.
2 Plug the other end of the power cord into a three-hole grounded outlet or power strip.
IMPORTANT  The only way to disconnect power completely is to unplug the
power cord. Make sure that at least one end of the power cord is within easy
reach so that you can unplug the computer when you need to.
Power cord plug
Power cord socket
WARNING  This equipment is intended to be electrically grounded. 
Your Macintosh is equipped with a three-wire grounding plug—a plug
that has a third (grounding) pin. This plug will fit only a grounded 
AC outlet. This is a safety feature. If you are unable to insert the plug
into the outlet, contact a licensed electrician to replace the outlet 
with a properly grounded outlet. Do not defeat the purpose of the
grounding plug!Installing an expansion card
If you purchased an expansion card for your Macintosh, install it now. (See
Appendix B, “Installing an Expansion Card,” for instructions.)
If you don’t have to install an expansion card, go on to the next section,
“Connecting a Monitor.”
Connecting a monitor
You can connect many types of monitors (often called displays) to your
Macintosh computer, including most standard monitors. See the Technical
Information booklet that came with your computer for a complete list.
This section contains instructions on connecting most types of monitors. If
you are connecting a monitor from a manufacturer other than Apple, also
refer to the instructions that came with the monitor.
Connecting the monitor power cord
Monitors have two cords to connect: a power cord and a monitor cable. To
connect the monitor power cord, follow these steps:
1 Place the monitor next to the computer.
Keep these considerations in mind:
m Allow a few inches for air circulation around the computer and monitor.
m Make sure that the top of the screen is slightly below eye level when you’re
sitting at the keyboard.
m Position the monitor to minimize glare and reflections on the screen from
overhead lights and windows.
For further suggestions about locating your computer equipment, consult
“Arranging Your Office” in Appendix A (in the section on health-related
information).
4 Chapter 12 Connect the monitor power cord to the monitor.
On some monitors, the cord is already attached.
3 Plug in the monitor power cord.
Some monitor power cords are designed to plug into the back of your
computer. 
Some monitor power cords must be connected to a grounded electrical outlet,
not to the computer. Check the information that came with the monitor.
Monitor power socket Monitor power cord
Getting Started 5Connecting the monitor cable
After you plug in the monitor power cord, you connect the monitor cable to
the computer’s monitor port. 
To connect the monitor cable, follow these steps:
1 Attach the monitor cable to the monitor.
On some monitors, the cable is already attached.
2 Attach the monitor cable to the monitor port on the back panel of the computer.
See the information that came with the monitor to use its special features.
ªMonitor port Monitor cable
6 Chapter 1Connecting the mouse and keyboard
You have a choice of several keyboards for your Macintosh. The way you
connect the mouse and keyboard depends on whether the keyboard has a
separate cable or a built-in cable.
Connecting a keyboard with a built-in cable
1 Plug the mouse cable into the recessed port on the back of the keyboard.
The plug and the port are marked with the × icon (symbol). The positions of
the port and icon on your keyboard may be different from those pictured.
By the way:  A port marked with the × icon is called an Apple Desktop Bus
(ADB) port.
2 Plug the keyboard cable into the port marked with the × icon on the back of 
the computer.
Some monitors have a port to which you can connect the keyboard or mouse.
See the information that came with your monitor.
This cable plugs into the Apple Desktop Bus (ADB) port,
marked with the × icon, on the back of the computer.
Plug the mouse cable into the recessed port
on the keyboard. The flat part of the plug
should be pointing down, as shown here.
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Connecting a keyboard with a separate cable
1 Plug the mouse cable into the port on either side of the keyboard.
Most right-handed people prefer to use the mouse with their right hand; most
left-handed people prefer to use their left hand. Plug the mouse into the port
on the side you prefer.
The plug and the port are marked with the × icon (symbol). Align the
symbols before you insert the plug. (The positions of the port and icon on
your keyboard may be different from those pictured here.)
By the way:  A port marked with the × icon is called an Apple Desktop Bus
(ADB) port.
2 Plug the keyboard cable (both ends are the same) into the other port on the keyboard.
If you plugged the mouse cable in on the right, for example, plug the keyboard
cable in on the left.
3 Plug the keyboard cable into the port marked with the × icon on the back of 
the computer.
Some monitors have a port to which you can connect the keyboard or mouse.
See the information that came with your monitor.
ADB iconGetting Started 9
Connecting other equipment
If you are new to the Macintosh, it’s a good idea to get some experience using
your computer before you connect other equipment, such as a printer or
scanner. To learn basic Macintosh skills, continue with the instructions in 
this chapter.
When you’re ready to connect other equipment to your Macintosh, see the
instructions in Chapter 3.
Turning the computer on
To turn on the computer for the first time, follow these steps:
1 Turn on your monitor.
See the information that came with your monitor for the location of the power
switch. On Apple monitors, the power switch is located on the front of the
unit.
By the way:  When the monitor is plugged into the computer, you only need 
to turn on the monitor once. From now on, the monitor will turn off
automatically when you shut down the computer, and it will turn on
automatically when you start up the computer. (If the monitor is not plugged
into the computer, it must be turned on separately each time you turn on the
computer.)2 Turn on your computer by pressing the Power key on the keyboard or pressing the
power button on the front panel of the computer.
The Power key is marked with a triangle. Its location depends on which
keyboard you have.
You hear a tone from the computer as it starts up.
10 Chapter 13 Check to see what’s on your screen.
You’ll see a sequence of messages describing what is happening, followed by
the Energy Star dialog box. 
m If you’re a beginning Macintosh user, press the Return key. 
m If you’re an experienced Macintosh user, you may want to set your energysaving options now (refer to the “Power & Energy Saving” topic of
Macintosh Guide, available in the Guide (h) menu, and “Saving Energy
With the Energy Saver Control Panel,” later in this chapter).
Getting Started 11m If, when you press Return, you see the Macintosh desktop (shown here),
your system software is already set up correctly. 
Skip now to “What’s Next?”
m If you see a blinking question mark, see “Solutions to Common Problems”
in Chapter 6.
m If you see anything else on your screen, or if you see nothing at all, see the
section “Problems Turning Your Computer On?” next in this chapter.
Note:  To save energy, your computer is automatically set to put itself to sleep
if you haven’t used it for 30 minutes or more (the screen dims). If your
computer attempts to go to sleep while you’re setting it up, simply press a key
on the keyboard to “wake it up.”
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Macintosh desktop
Hard disk iconProblems turning your computer on?
If you don’t see anything on the screen, check these items to see if you can
identify the problem:
m Is the computer plugged into a power source? If it is plugged into a power
strip, is the power strip turned on?
m Is the computer turned on? The power-on light on the front panel of the
computer should be on. If it isn’t on, press the power button, also on the
front panel.
m Are the keyboard and mouse cables connected correctly? (Don’t connect or
disconnect the keyboard or mouse cable while the computer is on. You
could damage your equipment.)
m Is the monitor power cord plugged in?
m Is the monitor cable attached firmly to both the monitor and computer?
m Is the monitor turned on? (Check the power-on light on the front of the
monitor.)
m Is the brightness control on the monitor adjusted correctly? (On most
monitors, the brightness control is marked with the symbol Û.)
m Is the computer asleep? (Press a key on the keyboard to wake the computer.
It may take a moment or two for the computer to wake up.)
Getting Started 13What’s next?
You’ve finished setting up your computer. Continue with one of the 
following steps:
m If you are new to the Macintosh, turn to the next section, “Learning 
the Basics.” When you’ve learned the basic Macintosh skills, turn to the
section, “Saving Energy With the Energy Saver Control Panel” to learn
how to set energy-saving options for your computer.
m If you are an experienced Macintosh user, turn to the section “Saving
Energy With the Energy Saver Control Panel,” later in this chapter, to 
learn how to set energy-saving options for your computer. Then turn to
Chapter 2, “Getting Help,” to learn about Macintosh Guide, your main
source of information when you’re working with the Macintosh. 
m If you want to connect additional equipment, such as a microphone, to your
computer, see Chapter 3, “Connecting Additional Equipment,” for
instructions.
m If you want to install application software on your computer, see Chapter 4,
“Installing and Using Application Programs.” You’ll need this information
to properly set up any software programs specifically designed for Power
Macintosh computers.
IMPORTANT  If you need to turn off your computer at any point, please see
“Turning the Computer Off” later in this chapter. It is very important to use
the correct procedure for shutting down your Macintosh before turning it off.
14 Chapter 1Learning the basics
If you are new to the Macintosh, you should begin by looking at the 
easy-to-use program called the Macintosh Tutorial. The tutorial teaches you
the basic skills you’ll need to use your computer. To start the tutorial, follow 
these steps:
1 Slide your mouse along your mouse pad or desk.
Hold the mouse as shown, with the cable pointing away from you. Rest the
heel of your palm on the desk and grasp the sides of the mouse between your
thumb and fingers. Use your wrist and fingers to slide the mouse around with
the index finger resting on the mouse button. Don’t press the mouse button
(under your index finger). Notice that the arrow (8) on the screen moves in
the same direction that you move the mouse.
If the arrow doesn’t move, make sure that the cables connecting the mouse
and keyboard are secure and that your mouse is positioned as shown in 
the illustration.
2 Move the tip of the arrow (8) to the question mark (h) in the upper-right portion of 
the screen.
If you run out of room on your mouse pad or desk while moving the mouse,
pick up the mouse and place it where there’s more room. (The arrow on the
screen moves only when the mouse is in contact with the mouse pad or desk.)
Mouse button
Getting Started 153 With the tip of the arrow on the question mark, press and hold down the mouse button.
A list of choices (called a menu) appears. This is the Guide (h) menu, which
is the place to go when you have a question about how to use your computer.
4 While holding down the mouse button, move the arrow until the words “Macintosh
Tutorial” are highlighted, then release the mouse button.
A window appears welcoming you to the tutorial. You can set this book aside
for now and follow the instructions on the screen. When you have completed
the tutorial, return to this book.
16 Chapter 1Reviewing the basics
You can use the following illustrations to review the elements you use on your
screen to do work with your computer. 
Menus
The strip across the top of the screen is called the menu bar. The symbols and
words in it represent menus of commands. To open a menu, place the pointer
on the symbol or word for the menu and press the mouse button.
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Menu
Window
Icons 
Application menu
You can have several
application programs open
at once. To see which
program is active or to switch
from one program to another,
use this menu (called the
Application menu).
Guide menu
To find an answer to a question, 
look in the Guide (h) menu.Icons
Icons are small pictures that represent disks, programs, documents and
folders. You can double-click any icon to open it and see what it contains.
This icon represents your computer’s internal hard disk.
Icons like this one represent application programs, which you use to create
documents and do other work.
Icons like this one represent documents, which you can create and edit.
Icons like this represent folders. A folder contains other icons.
To throw away an item you no longer want, drag it to the Trash icon and choose
Empty Trash from the Special menu.
Windows
Windows are boxes that display text, graphics, or icons. To change the shape
or position of a window, or to close the window, use the elements shown here.
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Scroll arrow
To bring hidden portions 
of a window’s contents into 
view, click one of the four 
scroll arrows.
Close box
To close a window,
click the close box.
Title bar
To move a window, drag it by the middle of the title 
bar (anywhere in the bar except the small boxes).
Size box
To change the shape or size of 
a window, drag the size box.
To bring a partially
covered window 
to the front, click
anywhere in it.Saving energy with the Energy Saver control panel
When you save energy, you save natural resources and reduce pollution. Your
Power Macintosh contains features that automatically save energy. You can
increase the energy savings by using the Energy Saver control panel to turn
your computer off if you won’t be using it for a while—for example, overnight
or over the weekend.
The Energy Star dialog box (shown in step 3 of “Turning the Computer On”
earlier in this chapter) appears every time you start your computer until you
open the Energy Saver control panel. Once you you open the control panel,
you can keep the pre-set options shown there, or set your own energy-saving
options. If you do not want to set your energy-saving options when the
Energy Star dialog box is displayed, you can click Close Message or press
Return (the Energy Star dialog box continues to appear when you start your
computer). 
Setting energy-saving options
You can get to the Energy Saver control panel by clicking Specify Settings in
the Energy Star dialog box that appears when you start your computer or by
choosing Control Panels in the Apple (K) menu. 
The Energy Saver control panel displays the options you can accept or
change. For more information on using the Energy Saver control panel, see
the “Power & Energy Saving” topic of Macintosh Guide, available in the
Guide (h) menu.
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Putting your computer to sleep
Your Power Macintosh is pre-set to put itself to sleep after 30 minutes of
inactivity. When your computer goes to sleep, the screen dims to save energy
and to prevent images from “burning” into the screen. You do not lose any of
the information you were working on even if you did not save it before the
computer went to sleep. 
To put your computer to sleep immediately, press the Power key on the
keyboard or choose the Sleep command from the Special menu. You can set
sleep options using the Energy Saver control panel, available under Control
Panels in the Apple (K) menu. 
Waking your computer from sleep
To wake the computer from sleep, press a key on the keyboard. (It may take a
moment or two for the computer to awaken.) The documents and application
programs you had open when the computer went into sleep are still open and
unsaved changes are preserved.
Accessing a sleeping computer over a network
If your computer is being used as a server, other users can still access it over
a network while it is asleep. (The network connection does not have to be
established before the computer goes to sleep.) You can set server options in
the Energy Saver control panel.
Scheduling automatic startup and shutdown
You can set your computer to start up and shut down at specified times using
the Energy Saver control panel. For information on using the Energy Saver
control panel, see the “Power & Energy Saving” topic of Macintosh Guide,
available in the Guide (h) menu.Getting Started 21
Turning the computer off
Using the Power key
To turn the computer off using the Power key on the keyboard, follow these
instructions: 
1 If the computer is in sleep, press the Power key (or any other key on the keyboard except
Caps Lock) to wake it.
For information on the sleep feature of your Macintosh see “Saving Energy
With the Energy Saver Control Panel” earlier in this chapter.
2 Press and hold the Power key on the keyboard for about 2 seconds.
The following dialog box appears on the screen:
3 Press the Return key on the keyboard (or click the Shut Down button in the dialog box).22 Chapter 1
Using the Shut Down command
You can also turn your computer off by using the Shut Down command in the
Special menu. Follow these steps:
1 If the computer is in sleep, press the Power key (or any key on the keyboard except Caps
Lock) to wake it.
2 Move the tip of the arrow to the word “Special” at the top center of the screen.
If the word “Special” does not appear in the menu bar at the top of the
screen, you’re not working in the Finder, the program you need to be in when
you shut down your computer. Choose Finder from the Application menu 
(at the far right of the menu bar). Then try step 2 again.
3 With the tip of the arrow on the word Special, press and hold down the mouse button.
4 While holding down the mouse button, move the arrow until the words “Shut Down” are
highlighted, then release the button.Trouble?  If a problem with the computer prevents you from using the Power
key on the keyboard or choosing Shut Down—for example, if the computer
“freezes” so that the pointer does not respond to the mouse—you can turn off
the computer by pressing the power button on the front of the computer. Use
this method only if you cannot choose Shut Down or Restart (when you press
the Power key on the keyboard, or when you open the Special menu).
IMPORTANT  You could lose unsaved work if you use the power button on the
front of the computer to turn off your computer. Only use the power button
when there is a problem that prevents the computer from being turned off
with the Power key on the keyboard or the Shut Down command. To make
sure your work is saved, use the Power key on the keyboard or the Shut Down
command.
To turn the computer on again, just press the Power key on the keyboard.
Getting Started 23Where to find answers
When you have questions about using your Macintosh, there are several
places you can look for answers.
In this book 
Use this book to help you set up your computer and learn about it,
or to find solutions to problems with your equipment.
In the Guide menu
The Guide menu (marked with the h icon) is your main source 
of information about the Macintosh. To learn how to get different
kinds of help from the Guide menu, see Chapter 2 in this book.
In other manuals
For answers to questions about other equipment or about
application programs you have purchased, see the manuals 
that came with the equipment or programs.
In the About Apple Extras file
The Apple Extras folder on your hard disk contains a SimpleText
document called About Apple Extras (often called a “Read Me” file)
with important information about some of the application programs
included with your computer. Read Me files can also be found
inside application folders.
From Apple’s customer support hotline
If you can’t find an answer in any of the materials provided, call the
customer support hotline. (The phone number for the hotline is in
the service and support information that came with your computer.) 
User’s Guide
Power Macintosh
24 Chapter 1If you have problems with a particular application program, contact the
manufacturer of the program. Refer to the section “Obtaining Updated Apple
Software,” in Chapter 6 for information about getting updated Apple software.
Refer to “Ask Apple Online Technical Support” in the same section of
Chapter 6 for information about getting answers to your computer questions
using eWorld.
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The Guide menu is your main source of information when you’re working
with your computer. The menu is identified by a question mark (h) in the
upper-right corner of the screen.
2  Getting Help
Use the instructions in this
chapter to learn about the help
available to you in the Guide menu.Getting answers to your questions
When you have a question while working with your computer, you can get the
answer by choosing Macintosh Guide from the Guide (h) menu.
1 Pull down the Application menu (in the upper-right corner of the screen) and choose
Finder to make it the active application program.
A checkmark in the menu indicates that the Finder is the active program.
2 Pull down the Guide menu (marked with the h icon) and choose Macintosh Guide.
The Macintosh Guide window appears.
Whenever you use Macintosh Guide, its window remains in front of other
windows. If the window gets in your way, you can move it by dragging its
title bar (the gray bar across the top of the window).
28 Chapter 23 Notice the three buttons at the top of the window: Topics, Index, and Look For.
Macintosh Guide gives you three ways of finding information:
m Topics lets you choose from a list of general subjects; it is like the table of
contents in a book.
m Index lets you choose from an alphabetical list of more specific subjects; it
is like the index in a book.
m Look For lets you search for information related to a specific word or phrase
that you type.
In the following sections you will practice using each method.
If you have problems while using Macintosh Guide, see “Tips for Using
Macintosh Guide,” at the end of this section.
Getting answers with the Topics button
1 In the Macintosh Guide window, click the Topics button.
A list of general topics appears on the left side of the Macintosh Guide
window. (Depending on the hardware and software you have, the list of topics
may look different.)
Getting Help 292 Click “Setting Options” in the list of topics.
When you click any topic area, a list of related questions appears on the right
side of the Macintosh Guide window.
3 Click the question “How do I set the time and date?” and then click OK. Or double-click
the question.
A small window appears with instructions for you to follow.
4 Read and follow the instructions in this window.
Macintosh Guide provides step-by-step instructions to answer the question
you selected. When you have completed each step, click the right arrow in the
lower-right corner to see the next step. 
5 When you have completed all the steps, click the Topics (or h) button in the lower-left
corner to return to the main Macintosh Guide window. 
Now continue with the next section.
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Click here to see the next 
step (if there is one).
To get instructions, 
click a question…
…and then click OK.
If you want to 
return to the main
Macintosh Guide
window, click this
Topics button. (On
some computers, it
says “Topics.”)Getting answers with the Index button
1 In the Macintosh Guide window, click the Index button.
An alphabetical list of subjects appears on the left side of the window.
2 Scroll through the alphabetical list until the phrase “background pattern” is visible.
You can scroll through the list either by dragging the slider to the letter B or
by using the scroll bar at the right of the list.
3 Click the phrase “background pattern” in the alphabetical list.
When you click any index entry, a list of related questions appears on the
right side of the Macintosh Guide window.
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Scroll bar
Slider
To get instructions, 
click a question…
…and then click OK.4 Click the question “How do I change the background pattern?” and then click OK. Or
double-click the question.
A small window appears with instructions for you to follow.
5 Read and follow the instructions in the window.
Macintosh Guide provides step-by-step instructions to answer the question
you selected. When you have completed each step, click the right arrow in the
lower-right corner to see the next step.
6 When you have completed all the steps, click the Topics (or h) button in the lower-left
corner to return to the main Macintosh Guide window.
Now continue with the next section.
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Click here to see the next 
step (if there is one).
If you want to 
return to the main
Macintosh Guide
window, click this
Topics button. (On
some computers, it
says “Topics.”)Getting answers with the Look For button
1 In the Macintosh Guide window, click the Look For button.
A small box appears on the left side of the window, where you can type text.
2 Click the arrow button to activate the text box.
3 Type “trash” in the text box and then click Search.
When you click Search, a list of questions related to the word or phrase you
typed appears on the right side of the Macintosh Guide window.
Getting Help 33
To get instructions, 
click a question…
…and then click OK.
To activate the text
box, click here.
Type a word or
phrase 
…and then click here.4 Click the question “How do I turn off the Empty Trash warning?” and then click OK. Or
double-click the question.
A small window appears with instructions for you to follow.
5 Read and follow the instructions in the window.
Macintosh Guide provides step-by-step instructions to answer the question
you selected. When you have completed each step, click the right arrow in the
lower-right corner to display the next step. 
6 When you have completed all the steps, click the close box in the upper-left corner to
close Macintosh Guide.
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If you want to close
Macintosh Guide,
click here.
Click here to see the next 
step (if there is one).Getting Help 35
Tips for using Macintosh Guide
Here are a few tips for using Macintosh Guide effectively:
m Macintosh Guide is available only when you are in the Finder—the
desktop area where you can see the icons of disks, folders, and files.
(Other programs may also have help available in the Guide menu,
however.) If you don’t see Macintosh Guide in the Guide menu, pull
down the Application menu (to the right of the Guide menu) and
choose Finder. 
m Follow the steps when you’re instructed to; don’t skip ahead or read
ahead. That way the computer can check to make sure you’ve done a
step correctly.
m Unlike most windows, the Macintosh Guide window stays in front of
other windows on the screen so that your instructions are never
covered. If you need to move the Guide window out of the way, drag
it by the title bar at the top of the window.
You can also move the window out of the way by clicking the zoom
box. Click the box once to shrink the window; click it a second time
to expand the window to its original size.
m If you need more information about an instruction or a term, click the
button labeled “Huh?” to get further explanation. (The “Huh?” button
is dimmed when no additional information is available.)
m If you want to return to the main Macintosh Guide window, click the
Topics (or h) button in the lower-left corner of the Guide window.
m When you’re finished using Macintosh Guide, click the close box in
the upper-left corner of the window.
Close box Title bar
Zoom box
Right arrow
Topics button
(On some computers,
it says “Topics.”)
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Identifying objects on the screen
Sometimes you’ll see an unfamiliar item on the screen and ask yourself,
“What’s that?” You can get an answer by using a Macintosh feature known as
Balloon Help.
Balloon Help explains the function of icons, menus, commands, and other
items on the Macintosh screen in balloons like those you see in comic strips.
Follow these steps to use Balloon Help:
1 Pull down the Guide menu (marked with the h icon) and choose Show Balloons.
2 Point to any object on the screen that you want to identify.
A balloon appears next to the object. In the following illustration, for
example, pointing to the Trash displays a balloon that explains how to use the
Trash to throw items away.
Although balloons appear next to items when you point to them, the way 
you work does not change; you can still select icons, choose commands, and
so on.
3 When you’re finished using Balloon Help, choose Hide Balloons from the Guide menu.Learning useful shortcuts
You can perform many tasks in the Finder more quickly if you use keyboard
or mouse shortcuts. For example, instead of clicking an icon and choosing
Open from the File menu, you can simply double-click the icon to open it.
Follow these steps to learn keyboard and mouse shortcuts:
1 Pull down the Guide menu (marked with the h icon) and choose Shortcuts.
The main Macintosh Shortcuts window appears.
2 Click one of the category buttons.
Another window appears, describing shortcuts for that category.
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If you want to
close the window,
click here.
Click here to see the next 
window (if there is one).
Click the Topics
button to return to the
main Macintosh
Shortcuts window for
more categories. 
(On some computers, 
it says “Topics.”)3 Read about the shortcuts available for the category you selected.
Click the right arrow in the lower-right corner of the window to display the
next window (if there is one).
4 When you finish reading about the shortcuts for your category, click the Topics (or h)
button in the lower-left corner to return to the main Macintosh Shortcuts window. Or
click the close box in the upper-left corner to close the window.
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Your computer at a glance
The illustration on the next page shows a basic Power Macintosh system,
ready to use. (Remember that your monitor and keyboard may appear slightly
different from the ones pictured here, depending on what you purchased.)
You can also expand your computer system by connecting other equipment to
it. The illustration of your Power Macintosh system shows where equipment
should be connected to your Macintosh.
For instructions on connecting audio equipment or SCSI devices, refer to the
next two sections of this chapter. For instructions on connecting other
equipment, such as a CD-ROM drive, see the manual that came with the
equipment.
IMPORTANT Make sure each device you add is compatible with your computer
and does not exceed the maximum power allowance for that device. If it is a
SCSI or ADB device, make sure to turn off your computer before connecting
the device. For further information, consult your Apple-authorized dealer, the
manufacturer of the component you want to add, or the Technical Information
booklet that came with your computer.
Read this chapter for information on
expanding your computer system
with additional hardware.
3  Connecting Additional EquipmentYour computer’s ports and connectors
SCSI port g Connects your Macintosh to SCSI equipment such as external
hard disk drives and scanners.
Ethernet port (AAUI) G Connects your Macintosh to a high-speed Ethernet network
using an adapter.
Ethernet port (10BASE-T) G Connects your Macintosh to a high-speed 10BASE-T Ethernet
network.
Modem port (GeoPort) W Connects an external modem, GeoPort Adapter, or LocalTalk
cable to your Macintosh. 
Printer port (GeoPort) [ Connects your Macintosh to a printer, LocalTalk network or
GeoPort Adapter.
Sound input port Å Connects your Macintosh to an Apple PlainTalk microphone or
other audio input equipment.
Sound output port - Connects your Macintosh to headphones, externally powered
(amplified) speakers, or other audio output equipment.
S-video ports ¾® Connects your Macintosh to VCRs, laserdisc players, video
(IN and OUT) cameras, or other video equipment that uses an S-video
connector.
Monitor
Microphone
(optional)
Keyboard Mouse
CD-ROM drive
(optional)
Speaker
Floppy disk drive
Hard disk drive
(internal)
Power-on light
A green light
indicates that the
computer is on.
Power button
CD-ROM drive
Open/Close button
P  Power key
      Use this key
      to turn your 
      computer on
      and off.
40 Chapter 3Monitor port ª Connects a monitor to your Macintosh.
Apple desktop bus  V Connects your Macintosh to an input device, such as a 
(ADB) port keyboard or a trackball.
Audio input ports  - Connects your Macintosh to the RCA-type audio output ports 
(left & right)  of video or audio equipment such as VCRs and tape decks.
Audio output ports - Connects your Macintosh to the RCA-type audio input ports of 
(left & right)  video or audio equipment such as VCRs and tape decks.
Access covers for Your Macintosh supports up to three Peripheral Component 
expansion slots (3) Interconnect (PCI) cards.
Security lock ports F You can attach a security lock to your Macintosh. See your
computer products retailer for security lock devices that work
with your computer.
Composite video ports ÷å Connects your Macintosh to most VCRs, laserdisc players,
(IN and OUT) video cameras, and other video equipment. 
Monitor power socket
Monitor port
SCSI port
Ethernet port (AAUI)
Sound output port
Apple Desktop Bus
(ADB) port
Sound input port
Power socket
Security lock ports
Modem port (GeoPort)
Printer port (GeoPort)
g
G
G Ethernet port (10BASE-T)
W
[
ª
¾®S-video ports (IN and OUT) ÷å Composite video ports (IN and OUT)
²
V
Å
Audio input ports
(left & right)
-
-
F
Access covers for
expansion slots (3)
Audio output ports
(left & right)
-
Connecting Additional Equipment 41About your computer’s A/V panel
The back of your computer has an A/V panel with ports that allow you to
connect a variety of audio and video input and output devices.
Connecting audio equipment
Your Macintosh can play and record stereo sound from a variety of sources.
You can listen to or reproduce stereo sound by connecting audio equipment to
the sound input and output ports on the computer. If you have an internal 
CD-ROM drive, you can also use your computer to play and record sound
from audio compact discs (CDs).
Use the Sound & Displays control panel, available under Control Panels in the
Apple (K) menu, to set up sound options. For further information on using
Macintosh system software to choose audio input and output options, record
an alert sound, or play audio CDs, see the “Sound” topic of Macintosh Guide,
available in the Guide (h) menu.
S-video input port
Connects your Macintosh
to the S-video Out port
of VCRs, laserdisc players,
video cameras, or other
video input equipment that
uses an S-video connector
¾
S-video output port
Connects your Macintosh to the S-video In
port of VCRs, or other video recording or
video display equipment that uses an
S-video connector
®
Composite video input port
Connects your Macintosh to the
RCA-type Video Out port of most
VCRs, laserdisc players, video cameras,
and other video input equipment 
÷
Composite video output port
Connects your Macintosh to the
RCA-type Video In port of most
VCRs, or other video recording or
video display equipment 
å
Audio input ports (left & right)
Connect your Macintosh to the
RCA-type Audio Out ports of
video or audio equipment such
as VCRs and tape decks
-
Audio output ports
(left & right)
Connect your Macintosh
to the RCA-type Audio In
ports of video or audio
equipment such as VCRs
and tape decks
-
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About your computer’s sound ports
The sound input port is marked with an icon of a microphone. The sound
output port is marked with an icon of a speaker.
The computer’s sound ports accept these 3.5 mm connectors:
The smaller connector (a “stereo miniplug”) is found most often on stereo
equipment. The slightly longer connector is found on the Apple PlainTalk
Microphone and other voice quality microphones. If your equipment has a
different type of connector, you can purchase an adapter at an electronics
supply store.
Stereo miniplug Extended miniplug
Sound input port
Sound output portYour computer also has ports that accept left and right audio input and output
through RCA-type connectors. These connectors are found on devices like
VCRs and tape decks. (See the previous section, “About Your Computer’s A/V
Panel,” for more information on the types of equipment you can attach to
these ports.)
Connecting most audio equipment
To play or record sound with your Macintosh, you can attach a microphone,
amplifier, tape recorder, headphones, or a pair of speakers. (When you have
headphones connected, you don’t hear beeps or other computer noises
through the built-in speaker.)
For specific instructions on connecting a microphone, skip to the next
section, “Connecting and Positioning a Microphone.” For specific instructions
on connecting speakers, see “Connecting External Stereo Speakers” later in
this chapter.
Follow these steps to connect most audio equipment to the Macintosh:
1 Make sure that the audio equipment has a cable with a stereo miniplug connector or two
RCA-type connectors.
2 Place the audio equipment near the Macintosh.
RCA RCA
Stereo miniplug
RCA
RCA-type plug
44 Chapter 33 Shut down the Macintosh and turn off the audio equipment.
4 Attach the cable to the audio equipment and to the appropriate sound or audio port on
the Macintosh.
To hear or record incoming sound on the computer using a cable with a stereo
miniplug, connect the audio equipment to the sound input port (X). If you’re
using a cable with two RCA-type connectors, connect the audio equipment to
the right and left audio input ports (-) on the A/V panel, described in
“About Your Computer’s A/V Panel” earlier in this chapter.
To record the sound produced by the computer or play that sound through
external speakers using a cable with a stereo miniplug, connect the audio
equipment to the sound output port (-) described in “About Your Computer’s
Sound Ports” earlier in this section. If you’re using a cable with two 
RCA-type connectors, connect the audio equipment to the right and left 
audio output ports (-) on the A/V panel, described in “About Your
Computer’s A/V Panel” earlier in this chapter.
5 Turn on the computer and the audio equipment.
You’re now ready to begin listening to and working with sound. For more
information on working with sound, see the “Sound” topic of Macintosh
Guide, available in the Guide (h) menu.
Connecting and positioning a microphone
With appropriate software, you can use the Apple PlainTalk Microphone that
comes with some Macintosh computers (or a compatible line-level
microphone) to give spoken commands to your Macintosh and to record your
voice or other sounds.
Apple PlainTalk Microphone
Connecting Additional Equipment 45Do not use the round omnidirectional microphone supplied with some other
Macintosh models.
Follow these steps to connect and position the microphone:
1 Shut down the Macintosh.
2 Plug the microphone’s connector into the sound input port (X) on the back of the
computer.
3 Place the microphone at the top center of the monitor, so that the microphone’s
Apple (K) icon is facing you.
If you can’t place the microphone on top of the monitor, position the
microphone according to these guidelines:
m The microphone should be between 1 and 3 feet away from you.
m The microphone should be directly in front of you to minimize the 
effect of background noises.
4 Turn on the computer.
You’re now ready to begin using your microphone.
To install software that enables you to give spoken commands to the
computer, get computer-voice feedback to your spoken commands, and have
the computer read text to you, see Chapter 4.
For further instructions on how to use speech software, see the “Speech” topic
of Macintosh Guide, available in the Guide (h) menu.
46 Chapter 3Connecting external stereo speakers
You can take advantage of your computer’s stereo sound output by attaching
externally powered (amplified) speakers.
1 Assemble the speakers and the cable you need.
You need a cable with stereo miniplugs at each end to connect one or both
speakers to the computer. (Some speakers require a dual-plug adapter.
Others, like those shown in the next illustration, accept a single stereo
miniplug and are joined by standard speaker wires.) You can also use a cable
with RCA-style connectors.
2 Turn off the Macintosh.
3 Plug a stereo miniplug into the sound output port (-) on the Macintosh.
If you’re using a cable with RCA-style connectors, you should plug them into
the left and right audio output ports on the A/V panel instead.
4 Plug a stereo miniplug into the Audio In port on one of the speakers.
If the speakers take a dual-plug cable, connect both plugs.
5 Connect the speakers together with speaker wires, if necessary.
Your finished connections should look something like this:
Audio In port
Sound
output
port
-
Externally
powered
speakers
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Now you hear the computer’s sound through the external speakers. (You may
also need to set options in the Sound & Displays control panel in order to
hear sound through your speakers. Refer to the “Sound” topic of Macintosh
Guide, available in the Guide [h] menu for more information.)
Note:  To control the volume of your external speakers, use the Sound &
Displays control panel to control volume and to set other options for playing
sound through the external speakers. If you are playing an audio CD, you 
may also need to adjust the volume control in the program you’re using to 
play CDs.
Connecting video equipment
You can connect video equipment to your Power Macintosh so that you can
display, edit, and store video images on the computer. You can also view or
record the computer’s images on a television or videocassette recorder (VCR). 
In this section you will learn to
m connect video equipment for input, so that you can view video on your
monitor, capture single video images, or save digitized video in files
m connect video equipment for output, so that you can display or record
images or sound from the computer
Your Power Macintosh can display and use video images from a variety of
sources. To view video on your monitor, you connect video equipment to the
video input port on the computer. To display or record the computer’s output
on videotape, you connect video equipment to the video output port.
Your Macintosh can work with two major video formats:
m S-video
m composite video
S-video is a high-quality video format used by many video cameras and
VCRs. Most televisions, most VCRs, and laserdisc players use the composite
format. To find out which format your equipment uses, check the manual that
came with your equipment.
48 Chapter 3S-video connectors 
The S-video connector is a round plug with several small metal pins. You can
plug this type of connector into your computer’s S-video input or output port.
IMPORTANT  The S-video connector resembles other Macintosh connectors,
such as those for a printer, modem, mouse, or keyboard. Don’t confuse the
connectors; they’re not interchangeable.
Composite video connectors
Many video devices use composite video format instead of S-video. The
cables for these devices have RCA-type connectors (plugs).
Connect the RCA connectors to the appropriate composite video port (input
or output) on the A/V panel on the back of your computer.
RCA-type plug
S-video connector
Connecting Additional Equipment 49Connecting video equipment for input to the computer
When you connect video equipment to the Power Macintosh, you can view
video on the computer, capture video images, and hear the sound from the
video equipment through the computer’s speaker. The instructions that follow
are for connecting a stereo VCR and video camera, but you can use them as a
model for connecting your computer to any video equipment.
Connecting a VCR or video camera for input
Before you start, do the following:
m Make sure that the VCR or camera has either a composite video 
(RCA-type) port or an S-video port.
m Place the VCR or camera near the Macintosh.
m Shut down the Macintosh and turn off the VCR or camera.
Then follow these steps:
1 Assemble the cables you need to connect the VCR or camera to the Macintosh.
Depending on what kind of ports your VCR or camera has, you’ll need
different cables (available at an electronics supply store). 
m If your equipment has an S-video port, you’ll need the following cables:
Video cable with S-video connectors at each end.
Audio cable with dual RCA connectors (plugs) at each end.
m If your equipment has a composite video port (for an RCA-type port),
you’ll need an all-in-one cable (three joined cables—one video and two
audio) with RCA-type connectors at each end. (The red connector is for
the right audio port, the white connector is for the left audio port, and the
yellow connector is for composite video.)
RCA RCA
RCA RCA
S-video S-video
50 Chapter 32 Attach one end of the video cable to the Video Out port on the VCR or camera.
Follow the directions that came with the VCR or camera.
3 Plug the other end of the video cable into either the S-video input port (¾) or the
composite video input port (÷) on the Macintosh.
If the connector doesn’t slide easily into the port, realign it and try again.
Don’t use force, which could damage the computer or cable.
4 Plug the RCA connectors on the audio cable into the left and right Audio Out ports on 
the VCR or camera.
5 Plug the RCA connectors on the audio cable into the left and right audio input ports (-)
on the computer.
The following illustrations show S-video connections and composite video
connections for both a VCR and a camera. Your finished connections should
look like one of the following:
S-video connection for input from a VCR 
S-video input
port
S-video Out
port
S-video cable
VCR
¾ Audio input
ports
(left and right)
Audio Out ports
(left and right)
Dual RCA-plug cable
(available at most electronics supply stores)
-
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S-video connection for input from a camera
S-video input
port S-video Out port
S-video cable
¾
Audio input ports (left and right)
Audio Out ports
(left and right)
-
Dual RCA-plug cable
(available at most electronics supply stores)
Composite video
input port
Audio input
ports
(left and right)
Triple RCA-plug cable
(available at most electronics supply stores)
VCR
÷   -
Video Out
port
Audio Out ports
(left and right)
52 Chapter 3Composite video connection for input from a camera 
6 Turn on the computer and the VCR or camera.
You can now begin working with the video equipment connected to your
Macintosh. For instructions on how to view video images, capture frames,
and use video in other ways, see the “Video” topic of Macintosh Guide,
available in the Guide (h) menu.
Composite video
input port
Video Out port Audio Out ports
(left and right)
Triple RCA-plug cable
(available at most electronics supply stores)
÷ Audio input
ports
(left and right)
-
Connecting Additional Equipment 53Connecting video equipment for output from the computer
You can deliver and record a sophisticated presentation by combining the
video and sound capabilities of your Macintosh. The steps that follow explain
how to set up equipment for recording the computer’s output on videotape.
Before you start, do the following:
m Make sure that the VCR has either a composite video (RCA-type) port or
an S-video port.
m Place the VCR near the Macintosh.
m Shut down the Macintosh and turn off the VCR.
Then follow these steps:
1 Assemble the VCR and cables you need.
Depending on what kind of ports your VCR has, you’ll need different cables
(available at an electronics supply store). 
m If your equipment has S-video ports, you’ll need the following cables:
Video cable with S-video connectors at each end
Audio cable with dual RCA connectors (plugs) at both ends.
m If your equipment has a composite video (RCA-type) port, you’ll need 
an all-in-one cable (three joined cables—one video and two audio) with 
RCA-type connectors at each end. (The red connector is for the right audio
port, the white connector is for the left audio port, and the yellow
connector is for composite video.)
RCA RCA
RCA RCA
S-video S-video
54 Chapter 32 Attach one end of the video cable to the Video In port on the VCR.
Follow the directions that came with the VCR.
3 Plug the other end of the video cable into either the S-video output port (®) or the
composite video output port (å) on the Macintosh.
If the connector doesn’t slide easily into the port, realign it and try again.
Don’t use force, which could damage the computer or cable.
4 Plug the dual RCA plugs on the audio cable into the left and right Audio In ports on 
the VCR.
5 Plug the RCA connectors on the audio cable into the left and right audio input ports (-)
on the Macintosh.
Depending on whether your equipment has S-video or composite video 
(RCA-type) ports, your finished connections should look like one of the
following:
S-video connection for output from the computer
S-video output
port
Audio output
ports
(left and right)
S-video In
port
Audio In ports
(left and right)
Dual RCA-plug cable
(available at most electronics supply stores)
VCR
® -
S-video cable
Connecting Additional Equipment 55Composite video connection for output from the computer
6 Turn on the computer and the VCR.
7 Select “line input” on your VCR.
See the manual that came with your VCR for instructions on how to select
the line input source.
For further instructions on how to record the computer’s output on videotape
and add voice annotation, see the “Video” topic of Macintosh Guide, available
in the Guide (h) menu.
Composite video
output port
Audio output
ports
(left and right)
Video In
port
Audio In ports
(left and right)
Triple RCA-plug cable
(available at most electronics supply stores)
VCR
å -
56 Chapter 3Using a television as a monitor
You can connect a television directly to the computer’s S-video or composite
video output port and display the computer’s images on the television. This
capability is especially useful if you’re using your Macintosh to give a
presentation and you have access to a large-screen television. 
Depending on the type of connectors your equipment has (S-video or
composite video), your connection should look similar to one of the
following:
Television used as a monitor with an S-video connection
Television used as a monitor with a composite video connection
Continue reading this section if you have less than 4 MB V.
For further instructions on using a television as a monitor, see the “Video”
topic of Macintosh Guide, available in the Guide (h) menu.
TV
Composite video
output port
Audio output
ports
(left and right)
Video In
port
Audio In ports
(left and right)
Triple RCA-plug cable
(available at most electronics supply stores)
å -
TV
S-video output
port
Audio output
ports
(left and right)
Dual RCA-plug cable
(available at most electronics supply stores)
® -
S-video cable
S-video In
port
Audio In ports
(left and right)
Connecting Additional Equipment 57IMPORTANT  You can use a television as a monitor on any model of Power
Macintosh 8500. Some models, however, cannot display the desktop
simultaneously on both a television and a computer monitor plugged into the
computer’s monitor port. If your computer is equipped with 4 megabytes
(MB) of video random access memory (VRAM), you can view the desktop on
both the monitor and the television. If your computer is equipped with 2 MB
of VRAM, you can switch between the monitor and television, but you can’t
view the desktop on both at the same time.
For information on installing more VRAM, see the technical information
booklet that came with your computer.
If your computer has 2 MB of VRAM, the following tips will help you use a
television as a monitor.
m If you want to use a television as the only monitor attached to your
computer (that is, if you have nothing attached to the computer’s monitor
port), plug the television into either the composite video output port or the
S-video output port, as shown in the illustrations earlier in this section. 
(Be sure that the computer is turned off before you plug the television into
the appropriate port.) Turn on the television and then start up the computer.
The desktop appears on the television.
m If you have both a television and a monitor attached to your computer, the
desktop appears on the monitor and the television is dimmed or black. To
switch to the television, shut down and turn off the computer and then
unplug the monitor from the computer’s monitor port. Start up the
computer. The desktop now appears on the television screen.
m If you have been using a television as your only monitor, and you want to
add a monitor, shut down and turn off the computer and then plug the
monitor into the computer’s monitor port. (For more detailed instructions,
see Chapter 1 of this manual.) Start up the computer. The desktop now
appears on the monitor; the television screen is dimmed or black.
58 Chapter 3Connecting external SCSI devices
Your computer has a port for connecting devices that use the Small Computer
System Interface (SCSI, pronounced “skuh-zee”). The SCSI port permits
high-speed communication between the computer and the device. The SCSI
icon appears above the port on the computer’s back panel.
You can connect SCSI devices to the SCSI port in a chain. The first device in
the chain plugs into the SCSI port; the second device plugs into the first
device, and so on. SCSI devices commonly used with the Macintosh include
hard disk drives, CD-ROM drives, scanners, some printers, and tape or
cartridge backup drives.
You can attach up to seven external SCSI devices to the SCSI port. However,
if you have a second internal hard disk connected to this SCSI chain you can
attach only six external SCSI devices to the port. All SCSI devices connected
to this chain must have their own unique ID number.
Note:  In addition to the external SCSI port, your computer has a second,
internal SCSI connection. The internal hard disk drive that came with the
computer is connected to this internal SCSI interface. If your computer came
with a CD-ROM drive, it is also attached to the internal SCSI interface. An
authorized Apple dealer or service provider can attach additional devices to
the internal SCSI interface. For more information about the SCSI interfaces,
see the Technical Information booklet that came with your computer.
All devices on the same SCSI chain must have unique ID numbers, but
devices on different SCSI chains may use the same SCSI ID number. (For
example, you could have a CD-ROM drive with ID number 3 connected to the
internal SCSI chain and a tape drive with ID number 3 connected to the
external SCSI chain.)
IMPORTANT  “Before You Connect a Device” and “Connecting a SCSI Device,”
both later in this chapter, contain general instructions for attaching SCSI
devices to your computer. Be sure also to follow the specific instructions that
came with your external hard disk drive or other SCSI device when
connecting the device to your Macintosh.
SCSI port
SCSI icon
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Before you connect a SCSI device to your Macintosh, be sure to complete
these tasks:
m Make sure each SCSI device connected to your Macintosh has its own,
unique ID number from 0 to 6 (or from 1 to 6 if you have a second internal
hard disk connected to the external SCSI chain). See the instructions that
came with each SCSI device for information on checking and setting its
SCSI ID number.
IMPORTANT If you use two or more devices attached to the same SCSI
interface with the same ID number, your equipment could malfunction and
you could lose data as a result. 
m Make sure you have the appropriate cable for attaching the SCSI device to
your Macintosh. 
If the device is the first or only one you’re connecting, use a SCSI system
cable to connect it to the computer’s SCSI port:
If the device is not the first one, use a SCSI peripheral interface cable to
connect it to the last device in the chain:
SCSI peripheral interface cable
SCSI system cable
60 Chapter 3IMPORTANT The total length of the cables in a SCSI chain should not exceed
6 meters (20 feet). SCSI cables must have a 110-ohm impedance. For best
results, use SCSI cables manufactured by Apple Computer.
m Make sure that the last (or only) device in the SCSI chain has a terminator.
Make sure that no other external SCSI device has a terminator.
To ensure accurate transmission of information, a terminator must be at
each end of a SCSI chain. Your internal hard disk, which is the first device
in the chain, has a built-in terminator.
Some external SCSI devices from manufacturers other than Apple have
built-in terminators. (Check the information that came with the device.) If
the device at the end of the SCSI chain does not have a built-in terminator,
you need to attach an external terminator.
If your SCSI device has a built-in terminator, you may choose to use it as
your first or last device in the chain, or you may have your Apple-authorized
service provider remove any extra built-in terminators. You can attach or
remove external terminators yourself.
SCSI terminator
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Use these general instructions in conjunction with the instructions that came
with your SCSI device:
1 Turn off your Macintosh.
2 Make sure the SCSI device is switched off.
3 Use a SCSI cable to connect the device either to the computer’s SCSI port or to the last
SCSI device already in the chain. 
4 Turn on all devices in your SCSI chain.
IMPORTANT Always turn on any external SCSI devices connected to your
Macintosh before turning on the computer itself. Otherwise, your computer
won’t be able to recognize that the SCSI devices are connected to it and your
computer may not be able to start.
5 Install any necessary device drivers (software that makes a device work with your
computer).
Drivers needed for a SCSI device usually come on a floppy disk with the
device. (If no drivers come with the device, contact the device manufacturer.)
Note: If you experience problems after connecting a SCSI device, see the
troubleshooting information in Chapter 6 for possible solutions.
Expanding memory
The random-access memory (RAM) in your computer can be expanded.
Installing additional RAM adds more memory chips to your computer and
expands its capabilities. The Technical Information booklet that came with
your computer describes how much additional memory can be installed in
your Power Macintosh.
WARNING  Do not connect or disconnect any device while the device or
your Macintosh is turned on. Doing so could damage the device, your
computer, or both.
62 Chapter 3Memory for your computer is provided in packages called Dual Inline
Memory Modules (DIMMs). Adding dynamic random-access memory
(DRAM) DIMMs increases your computer’s memory. The DIMMs must be
the correct type for your computer, and can be installed one-at-a-time. For
best performance, however, the DIMMs should be installed in pairs of the
same size into paired slots in your computer. Installing a cache DIMM can
also increase your computer’s performance. The memory used to display
images on the screen (called video RAM, or VRAM) can also be expanded
by installing DIMMs.
It is very important that the DIMMs be correctly installed in your Power
Macintosh, because incorrect installation can result in errors, unpredictable
results, and damage to your equipment and data.
Installing internal drives
Your Macintosh can hold up to four internal storage devices. Possible
configurations could include a floppy disk drive, a CD-ROM drive, and two
hard disk drives (several capacities are available) or a CD-ROM drive, a
floppy disk drive, a removable cartridge drive, and a digital audiotape (DAT)
drive. Depending on the configuration you purchased, these drives may
already be installed. If you want to add an internal drive to your Macintosh,
see your Apple-authorized dealer. For more information about internal drives,
see the Technical Information booklet that came with your Macintosh.
WARNING  To avoid damage to your computer, Apple recommends that
only an Apple-certified technician install additional DIMMs. Consult
the service and support information that came with your computer for
instructions on how to contact an Apple-authorized service provider or
Apple for service. If you attempt to install additional DIMMs yourself,
any damage you may cause to your equipment will not be covered by
the limited warranty on your computer. See an Apple-authorized dealer
or service provider for additional information about this or any other
warranty question.
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Your Macintosh can be connected to a high-speed Ethernet network via an
AAUI Ethernet connector or a high-speed 10BASE-T Ethernet connector. You
can also connect to a LocalTalk network. 
It is possible to be physically connected to more than one kind of network at
the same time, but you can use only one of your connections at one time. If
both 10BASE-T and AAUI networks are connected, your Macintosh
automatically uses the 10BASE-T connection. If 10BASE-T and LocalTalk are
connected, your Macintosh uses the 10BASE-T connection. If AAUI and
LocalTalk are connected, your Macintosh uses the AAUI connection.
About Macintosh networking
Your Power Macintosh can connect to a network that consists of as few as two
computers or as many as thousands or even millions of computers and other
devices. The network allows you and the other people connected to it to share
information, access remote services, and share computing resources such as
printers and modems.
A network extends the features of your Macintosh by extending your reach to
the services and resources provided on the network. For example, your
computer alone lets you store, retrieve, and modify information on floppy
disks, hard disks, and CD-ROM discs. On a network, however, you can also
store and retrieve information on the hard disks and CD-ROM discs of other
computers, access information that other people have stored for you, or use
mail or other network services.
Your computer comes equipped with two built-in network interfaces:
LocalTalk and Ethernet. You can also purchase additional Peripheral
Component Interconnect (PCI) cards for alternative networks such as
TokenRing, ISDN, or FDDI.
To connect your computer to a network you need to do two things: connect
your computer to the network using the appropriate cable, and set up your
network configuration in the AppleTalk control panel, the TCP/IP control
panel, or both.
64 Chapter 3To set up your network configuration, open the AppleTalk control panel to
choose the physical network interface you are using. (The AppleTalk control
panel also contains zone information—a default zone is chosen for you.) If
you plan to use TCP/IP on your Power Macintosh, you also need to choose
settings in the TCP/IP control panel. You can set up your connection in two
ways: manually, by entering a static Internet address, or automatically by
using a network service to connect with a dynamic Internet address. Refer to
the “Networking & Communications” topic of Macintosh Guide, available in
the Guide (h) menu for more information on setting up network
configurations. 
If you’re using a static Internet address, you’ll need the following information
before configuring your system (your network administrator or Internet
access provider can provide this information):
m Internet (IP) address:  for example, 192.3.232.55
m Domain name and domain name server address:  A domain connects an Internet
address to a name for your site, for example, apple.com. Enter your
Domain name or type a period (.).
m Gateway address:  This address provides the path the information will take
through the network at your site to reach the Internet.
m Subnet mask:  A subnet mask further defines the location of your machine.
You don’t need to change the default unless instructed to do so by your
network administrator.
If you’re using a server on the network that will be issuing you an Internet
address using a technique called bootstrapping, then you need to decide what
protocol you will use: BOOTP (BOOTstrap Protocol), or DHCP (Dynamic
Host Configuration Protocol). Your network administrator will tell you which
to choose.
If, after configuring your AppleTalk and TCP/IP control panels, you see an
error message such as, “Unable to locate host,” or “Could not create a socket,”
your software is unable to reach the Internet. This indicates a problem in the
TCP/IP configuration. Contact your network administrator for additional
assistance.
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Read this chapter for information on
installing and working with application
programs on your computer.
Installing application programs
Your computer has several application programs already installed, as well as
some programs that need to be installed before you can use them. The
programs that come with your computer include
m AppleScript, which allows you to automate any actions you perform
repeatedly on your Macintosh
m Drive Setup, which enables you to initialize, test, and update hard disks and
other storage media. Drive Setup lets you partition very large disks (up to 2
terabytes).
m PowerTalk, which provides built-in mail and collaboration services
m eWorld, a program that lets you send and receive electronic mail and gives
you access to a range of online information and services
m text-to-speech software that allows your Macintosh to speak typed text in
compatible applications such as SimpleText
m Speakable Items, speech recognition software that lets you give spoken
commands to the computer and have the computer respond by executing
the commands and giving computer-voice feedback
You’ll find these and other programs in the Apple Extras folder on your hard
disk. (However, eWorld is in its own folder on your hard disk, and Drive Setup
is in the Utilities folder.) To find out if a program needs to be installed, look
inside the program’s folder for an icon labeled Installer. If you find an
Installer icon and want to use that program, double-click the Installer and
follow the instructions on the screen.
4 Installing and Using Application ProgramsIf you have questions about installing and using an application program, refer
to Macintosh Guide, available in the Guide (h) menu and the Read Me files
for the program. (Read Me files are text files that contain additional
information about application programs. They are usually found inside the
program’s folder.)
IMPORTANT  If your computer did not come with a CD-ROM drive and you did
not get the CD-ROM disc that contains system software, be sure to make a
backup copy of the programs in the Apple Extras folder. Backup copies allow
you to restore your software if anything should go wrong. It is a good idea to
always make backup copies of application programs and other software.
You’ll probably want to buy and install additional programs. See the manuals
you receive with your programs for instructions on installing and using them.
In most cases, you’ll install an application program on your internal hard disk
from a CD-ROM disc that contains the program. The illustration shows how
to insert a CD-ROM disc into your computer’s CD-ROM drive, the disc lying
flat with the label side up.
For instructions on how to eject CD-ROM discs, see “Ejecting a CD-ROM
Disc” in Chapter 5. Some application programs come on floppy disks. See the
“Disks” topic of Macintosh Guide, available in the Guide (h) menu, for
information on inserting and ejecting floppy disks.
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m To avoid installation problems, turn off virus protection programs and use
Apple Extensions Manager to turn off system extensions (except for
Macintosh Easy Open) before you install any software. To start Apple
Extensions Manager, restart your computer while holding down the Space
bar. Use Apple Extensions Manager to turn off all system extensions except
Macintosh Easy Open (this extension is needed to rebuild the desktop
correctly). To turn extensions back on, use Apple Extensions Manager to
turn them on, then restart your computer.
m Put only one copy of each program on your hard disk. Having more than
one copy can cause errors.
m Whenever you copy a program disk to your hard disk, be careful not to
copy a System Folder. Always check to see what you’ve copied, and drag
any extra System Folders to the Trash.
m If a program malfunctions consistently, try installing a fresh copy. If that
doesn’t help, find out from the software manufacturer whether your version
of the program is compatible with the hardware and system software 
you’re using.
Working with several programs at a time
You can open as many application programs and desk accessories as your
computer’s memory allows.
All open programs are listed in the Application menu at the right end of the
menu bar. The name of the active program (the one you’re using right now)
has a checkmark next to it, and its icon appears in the menu bar.
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A checkmark
indicates the 
active program.
Commands to hide or 
display open windows
Open programs
The Finder iconFinding out which programs are open
If you have several programs and windows open, you can find out which
program is active and which other programs are open by pulling down the
Application menu.
Switching programs
You can switch to another open program or desk accessory by choosing its
name from the Application menu.
If a program’s icon is dimmed in the menu, that means its windows are
hidden. Choosing the program from the Application menu displays its
windows.
You can also switch to another program by clicking in a window that belongs
to an open program or by double-clicking a program icon (or the icon of a
document that was created with the program).
Hiding and showing windows on the desktop
You can hide all windows except those of the active program by choosing
Hide Others from the Application menu.
The other programs remain open even though their windows are hidden.
When you switch to another program, its windows become visible again.
If you want to see all the open windows, choose Show All from the
Application menu.
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Making backup copies of important files is good protection against possible
damage to the originals.
m You can back up files stored on your hard disk by copying them to 
floppy disks.
m You can back up an entire floppy disk by copying it to another floppy disk
of the same capacity or larger, or by copying it to a hard disk.
m You can use a commercial backup program to copy new and changed files
from a hard disk to another hard disk, to a tape drive, or to a series of
floppy disks.
m If your computer is on a network, you may be able to back up files by
copying them to a shared disk on the network.
Using Power Macintosh application programs
Your Power Macintosh is compatible with most application programs
intended for use with Macintosh computers. But certain programs are
designed especially for Power Macintosh computers. (These are sometimes
called “native” applications.) You’ll find that these programs take best
advantage of your computer’s speed.
Special memory requirements
Some Power Macintosh programs may be slightly larger than other programs
and may take up more memory. If you find that you are running out of
memory when you use your Power Macintosh programs, you can use space
on your computer’s hard disk as additional memory (called “virtual
memory”). For instructions on how to use hard disk space as memory, see the
“Memory” topic of Macintosh Guide, available in the Guide (h) menu.
You can also add more memory to your computer, as described in “Expanding
Memory” in Chapter 3.
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Power Macintosh programs use special files called shared libraries. These files
help Power Macintosh programs to run more efficiently, and can be used by
more than one Power Macintosh program simultaneously. Any necessary
shared libraries are installed automatically in the System Folder when you
install Power Macintosh programs.
If a Power Macintosh program requires a shared library and there is not
enough memory available for the shared library, you’ll see a message that 
the program could not be opened because of insufficient system memory. If
this happens, see the “Memory” topic of Macintosh Guide, available in the
Guide (h) menu, for instructions on increasing available memory.
If a required shared library is missing, you’ll see a message that the program
could not be opened because the shared library could not be found. If this
happens, follow the directions that came with your program to reinstall the
program. If the shared library is still missing, contact the program’s
manufacturer for assistance.
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Read this chapter for information on using the optional internal CD-ROM
(Compact Disc Read-Only Memory) drive, if your computer has one. 
(CD-ROM drives are also sometimes called CD-ROM players.) Refer to
Appendix A, “Health, Safety, and Maintenance Tips,” for information on the
proper handling of CD-ROM discs.
Your internal CD-ROM drive works with CD-ROM discs, standard audio
compact discs (CDs), and single-session or multisession Photo CDs. 
Your CD-ROM drive provides access to large amounts of information.
However, you cannot save information on CD-ROM discs. ROM stands 
for read-only memory, meaning that the player cannot “write” information
onto CD-ROM discs.
A wide selection of CD-ROM discs is available for entertainment, education,
and business. A typical disc can hold over 650 megabytes (MB) of
information—the equivalent of 270,000 pages of text, up to 8 hours 
of speech or music (depending on the sound quality), hundreds of highresolution images, or any combination of text, sound, and graphics. 
5 Using the Optional CD-ROM Drive
Read this chapter for information on
using the internal CD-ROM drive,
if your computer has one.Chapter 5
Inserting a CD-ROM disc
Follow these instructions to insert a CD-ROM disc into your CD-ROM drive.
Then follow the instructions provided with your disc, as well as the
instructions in this manual.
1 Start up your Macintosh computer, if it’s not already on.
2 Press the Open/Close button to open the tray of the CD-ROM drive.
The tray opens.
3 Place a CD-ROM disc in the tray, with the disc label facing up.
Make sure the disc is lying flat and centered in the tray. If you are using a
small (8 cm) disc, make sure it is centered within the inside ring on the tray.
4 Push the tray in, or press the Open/Close button, to close the tray.
In a few moments, an icon for the CD-ROM disc appears on your screen.
Open/Close button
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Ejecting a CD-ROM disc
Follow these instructions to open the tray and eject a CD-ROM disc from
your computer.
IMPORTANT  You may not be able to eject a disc if it is being shared. To turn
off file sharing, use the Sharing Setup control panel.
1 Open the tray.
There are several ways to open the tray of your CD-ROM drive.
If a CD-ROM disc icon appears on your screen:
m Select the disc icon on your screen and drag the icon to the Trash.
m Click the disc icon, then choose the Put Away command in the File menu.
m While the AppleCD Audio Player window is active, choose Eject CD from
the File menu, or simultaneously press the x and E keys. (AppleCD Audio
Player is a program that allows you to control your CD-ROM drive and is
available in the Apple [K] menu.)
If no CD-ROM disc icon appears on your screen:
m Press the Open/Close button for your CD-ROM drive.
2 Take the CD-ROM disc out of the tray.
Store your disc in a safe place, away from heat, dust, and moisture.
3 Push the tray in, or press the Open/Close button, to close the tray.
To avoid possible damage to the tray or the CD-ROM drive, keep the tray
closed when you are not using it.
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With your CD-ROM drive and your computer’s built-in speaker, you can play
audio compact discs (CDs) or audio tracks on CD-ROM discs. You can also
attach headphones or speakers to the computer to listen to audio CDs and
audio tracks. See Chapter 3, “Connecting Additional Equipment,” for
information on connecting sound equipment to your computer. 
Note that you may need to set control panel options in order to play audio
CD-ROM discs. Refer to the “Sound” topic of Macintosh Guide, available in
the Guide (h) menu.
To start, stop, and otherwise control audio discs, use the AppleCD Audio
Player program, available in the Apple (K) menu. Your audio CD software
will only play tracks that contain audio information. You can listen to an
audio CD or audio tracks in the background while you do other work on your
computer. For more information about playing audio CDs, see the “CD-ROM
Discs” topic of Macintosh Guide, available in the Guide (h) menu. 
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Working with Photo CDs
You can use your CD-ROM drive to open Photo CD images stored on Photo
CDs. A Photo CD image is a digitized version of a standard photograph that
you can open and view on your computer screen. 
You can do many things with the images on your Photo CDs:
m Open and view the images individually on your computer screen. 
m View the images on your computer screen in a series, as you would view 
a slide presentation. 
m Copy and save the images, print them, paste them into word-processing
documents or other documents that accept graphics, and edit them with 
a graphics application program. 
Photo CD images are an excellent source of graphics for desktop
publishing, multimedia presentations, business documents, and
professional-quality graphic design. For more information on working with
Photo CD images, see the “CD-ROM Discs” topic of Macintosh Guide,
available in the Guide (h) menu.
77Sharing a CD-ROM disc over a network
You can share a CD-ROM disc using the file-sharing feature of System 7.5.2.
If the disc has audio portions, you will be able to hear the audio yourself, but
other people on the network will not. Likewise, you cannot hear the audio
portions of discs you access over a network.
For further information about file sharing in System 7.5.2, see the “Networks
& Telecommunications” topic of Macintosh Guide, available in the Guide (h)
menu.
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81
Consult this chapter if you experience 
problems using your computer.
When you have questions
If you want to know how to do a particular task with your computer, refer to
Macintosh Guide in the Guide (h) menu. For instructions on using
Macintosh Guide, see “Getting Help,” Chapter 2 of this manual.
If you have trouble
While you’re using your computer, you may occasionally see a bomb icon 
or an error message, or the pointer (8) may “freeze” on the screen. 
If you have trouble with your computer, take a few minutes to read the
information in this chapter. If your problem is related to a particular
procedure, you should also look for information on that procedure in
Macintosh Guide, available in the Guide (h) menu. For additional
troubleshooting information and a list of common questions relating to your
system software, see the “Troubleshooting” topic of Macintosh Guide.If you are unable to access Macintosh Guide (for example, if your screen 
is “frozen”), refer to this chapter to see if you can resolve the problem. 
Take your time
When you see an error message, you don’t have to take action immediately.
The message stays on the screen until you click the OK button (or Restart) or
turn off the computer.
To help diagnose and correct the problem, gather as much information on the
situation as you can. Then follow the instructions in the next section, “Start
Over.”
m Make a note of exactly what you were doing when the problem occurred.
Write down the message on the screen and its ID number (if any). Also list
the programs you were using and the names of any items you know have
been added to the System Folder since the system software was installed.
This information will help a service person diagnose the problem. (It is
helpful to keep a printed copy of the items in your System Folder. For
instructions on printing the contents of a folder, see the “Printing & Fonts”
topic of Macintosh Guide, available in the Guide [h] menu.)
m Check the screen for any clues. Is a menu selected? What programs and
document icons are open? Note anything else that seems relevant.
m If you were typing text and were not able to save it before the problem
occurred, you can write down the parts of the text still visible on the
screen so that some of your work will be easy to replace.
m Ask other Macintosh users about the problem you’re having; they may have
a solution for it.
WARNING  If you have a problem with your computer and nothing
presented in this chapter solves it, consult the service and support
information that came with your computer for instructions on how to
contact an Apple-authorized service provider or Apple for assistance. If
you attempt to repair the computer yourself, any damage you may cause
to the computer will not be covered by the limited warranty on your
computer. Contact an Apple-authorized dealer or service provider for
additional information about this or any other warranty question.
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came with your computer for instructions on how to contact an Appleauthorized service provider or Apple for assistance.
If you know that the problem is with a particular application program, contact
the manufacturer of that software for assistance.
Start over
Often you can eliminate a problem simply by clearing the computer’s memory
and starting over. 
If you can, save any open documents before restarting the Macintosh. If your
system is frozen and does not respond to anything you do, or if you have a
“bomb” message on the screen, saving may not be possible. You can try
pressing x-Option-Esc to quit the program in use when the problem
occurred; if this works, you can then save the documents open in other
programs before restarting. (Be sure to restart the computer immediately after
you save your documents—quitting a program using x-Option-Esc may leave
corrupted data in the computer’s memory. This corrupted data is erased when
you restart the computer.)
To restart your Macintosh, try the following solutions:
m If you can, choose Restart from the Special menu or from the dialog box that’s on the
screen. 
Dialog boxes contain messages from the computer. If something goes
wrong, a message may appear on the screen, asking you to restart the
computer.
m If you can’t choose Restart, press the Power key on the keyboard.
Select Restart from the dialog box that appears.
m If the Power key on the keyboard doesn’t work, hold down the x and Control keys
while you press the Power key on the keyboard (marked with a triangle).
This key combination restarts the computer. (Use this key combination
only when you can’t choose Restart from the Special menu.)
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at least 10 seconds, and then turn it on again. 
If the computer does not turn off, try pressing and holding down the power
button for 3 to 4 seconds.
m If the power button doesn’t turn off the computer, unplug your Macintosh.
m If you suspect that the problem is with other equipment, such as a printer or an
external hard disk that’s attached to your computer, turn that equipment off and
restart the Macintosh.
Rebuild your desktop regularly
A process known as “rebuilding the desktop” helps your Macintosh keep
track of data on your startup disks. Although you usually use the hard disk in
your computer as a startup disk, you can also start up from any other disk that
has system software installed. It’s a good idea to rebuild the desktop of your
startup disks once a month or so.
To rebuild the desktop of a startup disk, follow these steps:
1 While holding down the Space bar, restart your computer.
Do not release the Space bar until you see the Extensions Manager control
panel.
2 Use the Extensions Manager control panel to turn off all extensions except Macintosh
Easy Open.
3 While holding down the x and Option keys, close the Extensions Manager control panel.
The desktop is rebuilt.
4 Open the Extensions Manager control panel again and turn back on all the extensions
you turned off.
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This section contains descriptions of problems you could experience with
your computer. Some problems may be caused by your CD-ROM drive, so if
you don’t find your problem here, be sure to check the section “Solutions to
CD-ROM Problems” later in this chapter.
The computer is turned on but the screen is dark.
One of the following is probably the cause:
m The computer is in sleep mode. 
Press a key on the keyboard.
m You have a screen saver program that darkens the screen when the
computer has not been used for a certain period. 
Press a key or move the mouse to turn off the screen saver.
m The monitor’s brightness control (Û) is not adjusted properly.
Check the monitor’s brightness control and turn it up if necessary.
m The Macintosh or the monitor is not getting power.
If you have a separate monitor, check that the monitor is plugged in and
turned on and that the monitor cable is firmly connected to both the
computer and the monitor.
Check that the computer’s power cord is firmly connected to the computer
and plugged into a grounded electrical outlet and that the outlet has power.
If you have more than one monitor, and only one is dark, check that it is
set up correctly in the Monitors control panel. For information on using
more than one monitor, see the “Monitors” topic of Macintosh Guide,
available in the Guide (h) menu.
m If none of these steps solves the problem, you may need to reset your
computer’s parameter RAM (PRAM). Reset PRAM by turning off the
computer and disconnecting all external SCSI devices. Next, restart the
Macintosh while holding down the key combination x-Option-p-r. Wait for
the second startup chime, then release the keys. (Note that the “caps lock”
key must be in the up position. This procedure won’t work with the
uppercase “P” and “R” keys.)
If you are displaying video from your computer on a television screen, it is
normal for your computer monitor to be dark.
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Your computer has a clock that runs continuously. When the computer is
turned off, a battery keeps the clock running. If your clock begins to keep
time inaccurately, have an Apple-authorized service provider replace the
battery. Consult the service and support information that came with your
computer for instructions on how to contact an Apple-authorized service
provider or Apple for assistance.
When you start up, a disk icon with a blinking question mark appears in the middle of 
the screen.
This icon indicates that your Macintosh cannot find the system software it
needs to start up. One of the following is probably the cause:
m Your computer may be having a problem recognizing external equipment
that uses the Small Computer System Interface (SCSI).
Shut down the computer, turn off all external SCSI equipment, and
disconnect the first SCSI device in the chain from your computer’s SCSI
port. Then restart the computer. If the computer starts up after you
disconnect your SCSI equipment, refer to the manuals that came with the
equipment for information on the proper way to connect SCSI equipment
and assign SCSI ID numbers.
If you have a printer connected to your computer’s SCSI port, make sure
your printer is not supposed to be connected to the printer port instead.
Check the manuals that came with your printer for information on how to
connect it properly.
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software may be damaged, or the hard disk may not be working properly.
Start up your computer using the Disk Tools floppy disk or (if you have a
built-in CD-ROM drive) with the CD-ROM disc that contains system
software. (For instructions on how to start up your computer from the 
CD-ROM disc, see “Starting Up From a CD-ROM Disc” in the section
“Initializing a Hard Disk” later in this chapter.) Then follow the
instructions in “Repairing a Damaged Disk” later in this chapter to test
your startup hard disk and repair any damage.
If repairing the disk doesn’t help, follow the instructions in “Installing or
Reinstalling System Software” later in this chapter to reinstall system
software on your startup hard disk.
When you try to start up from a floppy disk, a disk icon with an X appears in the middle
of the screen, and the floppy disk is ejected.
This icon indicates that the floppy disk you tried to start up from is not a
startup disk.
Wait a few seconds. The computer should start up from its internal hard disk.
Make sure you insert floppy disks only after the computer has begun starting up.
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This icon indicates that your Macintosh cannot start up because of a problem
with the system software or the computer hardware.
Eject any floppy disks by turning off the computer and then holding down 
the mouse button while you turn the computer on again. Try starting up with
the Disk Tools floppy disk or (if you have a built-in CD-ROM drive) with the
CD-ROM disc that contains system software. (For instructions on how to start
up your computer from the CD-ROM disc, see “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” later in this chapter.) If the “sad
Macintosh” icon appears again, consult the service and support information
that came with your computer for information on contacting an Appleauthorized service provider or Apple for assistance.
The hard disk icon does not appear on the desktop.
If you don’t see a hard disk icon on the desktop, try the following:
m Use the Drive Setup program to make the disk available. Drive Setup is
located in the Apple Extras folder. For instructions, start Drive Setup, then
choose Drive Setup Guide from the Guide (h) menu.
m If the hard disk is internal, shut down your computer, wait at least 10
seconds, and then turn it on again.
m If the hard disk is external, make sure that it is turned on and that its cable
is connected firmly; then restart the Macintosh.
m Check the ID numbers of all SCSI equipment connected to your computer.
No two SCSI devices on the same SCSI chain can have the same ID
number. In addition, there are special requirements for assigning SCSI ID
numbers that don’t conflict with your computer or its internal storage
devices. See Chapter 3 and the manuals that came with your SCSI
equipment for information on setting SCSI ID numbers.
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Tools floppy disk or (if you have a built-in CD-ROM drive) with the 
CD-ROM disc that contains system software. (For instructions on how to
start up your computer from the CD-ROM disc, see “Starting Up From a
CD-ROM Disc” in the section “Initializing a Hard Disk” later in this
chapter.) Then follow the instructions in “Repairing a Damaged Disk” later
in this chapter to test your startup hard disk and repair any damage.
If repairing the disk doesn’t help, follow the instructions in “Installing or
Reinstalling System Software” later in this chapter to reinstall system
software on your startup hard disk.
Icons do not appear correctly on your screen.
You need to rebuild the desktop—a process that helps your Macintosh keep
track of files and folders on your hard disk. For instructions, see “Rebuild
Your Desktop Regularly” in the section “If You Have Trouble” earlier in 
this chapter.
Your Macintosh can’t read a floppy disk.
If you see a message that a floppy disk is unreadable, try one of the following:
m If the disk has never been used, you may simply need to initialize it. For
instructions, see the “Disks” topic of Macintosh Guide, available in the
Guide (h) menu.
m The disk may be damaged. See “Repairing a Damaged Disk” later in this
chapter for information on testing and repairing disks.
m If the disk is a high-density disk previously used on another computer, the
disk may have been formatted incorrectly as an 800K disk rather than as a
1440K (high-density) disk. If so, use the other computer to copy the disk’s
contents onto a properly formatted disk.
m The disk may have been formatted for use on another kind of computer.
You may be able to use a program that lets you work with such disks on
your Macintosh.
You can’t eject a floppy disk.
If you can’t eject a floppy disk in the usual way, try the following in order:
m Hold down the x and Shift keys and press the number 1 key on your
keyboard to eject a disk in the internal disk drive.
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on your mouse or other pointing device while you turn the computer 
on again.
m Locate the small hole near the disk drive’s opening, and carefully insert the
end of a large straightened paper clip into it. Push gently until the disk is
ejected. Do not use excessive force. 
If none of these solutions works, take the computer or disk drive to your
Apple-authorized service provider to have the disk removed.
You installed a CD-ROM drive after you bought your computer and your computer won’t
restart after you’ve copied software for your CD-ROM drive to the System Folder.
m If you attempt to install software for your CD-ROM drive without using the
Installer, you may not be able to restart your computer. Restart the
computer while holding down the Shift key (to turn off system extensions)
and then remove any CD-ROM software files you copied by dragging them
to the Trash. Reinstall the software according to the instructions that came
with the drive.
If this procedure doesn’t solve the problem, restart your computer using the
Disk Tools floppy disk or the CD-ROM disc containing system software that
came with your computer. (For instructions on starting your computer
using a floppy disk, see “Starting Up From a Floppy Disk” later in this
chapter.)
Your computer won’t restart, and a CD-ROM disc is in the CD-ROM drive.
m Your computer may be trying to start up from the CD-ROM disc. Press the
Open/Close button of your CD-ROM drive to open the tray and remove the
CD-ROM disc. Close the tray, then restart your computer.
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a program, you see a message that not enough memory is available.
One of the following is probably the cause:
m The Macintosh ran out of memory.
Quit the programs that you have open and then open the program you want
to use, or restart your Macintosh.
Make sure virtual memory is turned on (unless you changed the memory
setting, virtual memory was already turned on for you at the factory). If it
isn’t, use the Memory control panel to turn on virtual memory. For more
information on virtual memory, see the “Memory” topic of Macintosh
Guide, available in the Guide (h) menu.
m The program needs more memory.
Use the program’s Info window to give it more memory. For more
information on increasing a program’s memory, see the “Memory” topic of
Macintosh Guide, available in the Guide (h) menu.
m The program is a non-Power Macintosh application program running in
emulation mode that requires a separate floating-point unit (FPU). It
cannot use the built-in FPU on your computer’s microprocessor.
Check the documentation that came with the program or contact the
program’s manufacturer to find out if the program requires the FPU found
in a non-Power Macintosh chip. If it does, you may need to upgrade to a
Power Macintosh version of the program, or install software that emulates
a non-Power Macintosh FPU. (See your dealer for this software.)
m Sometimes incompatible system extensions or control panels can cause
software problems. Restart while holding down the Shift key to temporarily
turn off all system extensions.
If your program works normally after you do this, use the Extensions
Manager control panel to turn off individual extensions and control panels.
For detailed instructions, see the “Setting Options” topic of Macintosh
Guide, available in the Guide (h) menu.
If your program performs better when a particular extension or control
panel is turned off, contact the software’s manufacturer for information or
an upgrade.
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Your system has a software problem.
m Write down what you were doing when the message appeared and write
down the message.
m Restart your Macintosh. (See “Start Over” in the section “If You Have
Trouble” earlier in this chapter for instructions.) Most software problems
are temporary, and restarting usually corrects the problem.
m Check the startup disk and application program you were using when the
dialog box appeared. Make sure that all programs, desk accessories, and
system extensions you’re using are compatible with the system software.
Reinstalling the system software may correct the problem.
m If the bomb only occurs in one application program, try reinstalling the
program from the original disks. If reinstalling doesn’t solve the problem,
contact the manufacturer of the program.
m Sometimes incompatible system extensions or control panels can cause
system software problems. Restart while holding down the Shift key to
temporarily turn off all system extensions.
If your computer works normally after you do this, use the Extensions
Manager control panel to turn off individual extensions and control panels.
For detailed instructions, see the “Setting Options” topic of Macintosh
Guide, available in the Guide (h) menu.
If your computer performs better when a particular extension or control
panel is turned off, contact the extension’s or control panel’s manufacturer
for information or an upgrade.
m If the problem recurs, you may need to reinstall system software. See
“Installing or Reinstalling System Software” later in this chapter for
instructions.
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One of the following situations is probably the cause:
m Your system has a software problem.
Press x-Option-Esc to quit the application program in use when the
problem occurred. If this works, you can save the documents open in other
programs before restarting.
Restart your Macintosh. See “Start Over” in the section “If You Have
Trouble” earlier in this chapter for instructions.
Check the startup disk and program you were using when the problem
occurred. Make sure that all programs, desk accessories, and system
extensions you’re using are compatible with the system software. Try
starting up the computer from the Disk Tools disk or the CD-ROM disc that
contains system software. (For instructions on how to start up your
computer from the CD-ROM disc, see “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” later in this chapter.) If your
computer starts up normally, there may be an extension conflict. 
If the problem recurs, you may need to reinstall system software. See
“Installing or Reinstalling System Software” later in this chapter for
instructions.
m The mouse is not connected properly. 
Turn the computer off using the power button on the front of the computer,
check that the mouse and keyboard cables are connected properly, and then
restart the computer.
IMPORTANT  Don’t connect the mouse while the computer is turned on. You
may damage your computer.
m Signals from the mouse are not reaching the computer, either because the
mouse needs cleaning or because there is something wrong with the mouse.
Clean the mouse according to the instructions in Appendix A of this book.
If you have another mouse or pointing device, try connecting and using it.
(Turn the computer off before connecting it.) If the new device works, there
is probably something wrong with the mouse you replaced.
If none of these procedures solves the problem, consult the service and
support information that came with your computer for instructions on how to
contact an Apple-authorized service provider or Apple for assistance.
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One of the following is probably the cause:
m Your system has a software problem.
Restart your Macintosh. For instructions, see “Start Over” in the section
“If You Have Trouble” earlier in this chapter.
Check the startup disk and application program you were using when the
problem occurred. Make sure that all programs, desk accessories, and
system extensions you’re using are compatible with the system software.
If the problem recurs, try restarting the computer with system extensions
turned off. (To turn system extension off, hold down the Shift key while
restarting the computer.) If that doesn’t work, you may need to reinstall
system software. See “Installing or Reinstalling System Software” later in
this chapter for instructions.
m The computer beeps every time you press a key. 
Easy Access is probably turned on. Open Easy Access from the control
panels listed under the Apple (K) menu and turn it off.
m You haven’t selected any text or set the insertion point (i).
Make sure the program you want to type in is the active program. Then
place the pointer (8) in the active window and click to set an insertion
point (i) or drag to select text (if you want to replace the text with your
typing).
m The keyboard is not connected properly.
Turn off the computer using the power button on the front of the computer
then check that the keyboard cable is connected properly at both ends.
If you have a keyboard with an ADB port (marked with the × icon) on
each end, turn off the Macintosh using the power button and plug the
keyboard cable into the other ADB port on the keyboard. (You may have to
unplug the mouse to do this.) Then restart the computer.
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If you have access to another keyboard, try using it instead. (Turn the
computer off before connecting it.) If the new keyboard works, there is
probably something wrong with the one you replaced.
If none of these procedures solves the problem, consult the service and
support information that came with your computer for instructions on how to
contact an Apple-authorized service provider or Apple for assistance.
You can’t open a document, or you see a message that an application program can’t 
be found.
m Some documents can be opened by more than one application program.
Try starting a program that you think might be able to open the document,
then choose Open from the program’s File menu to try to open the
document. 
m Purchase and install the correct software to use the document, or find out
if the creator of the document can convert it to a form that one of your
programs can use.
m Don’t try to open the files in your System Folder. Most of the files in your
System Folder are used by your computer for internal purposes and are not
intended to be opened.
m Rebuild your desktop (refer to “Rebuild Your Desktop Regularly” in the
section “If You Have Trouble” earlier in this chapter).
m If the document is from a DOS computer, use the PC Exchange control
panel to specify which Macintosh program will open the document. For
information about working with DOS documents on your Macintosh, see
the “Using DOS Files & Disks” topic of Macintosh Guide, available in the
Guide (h) menu.
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If you can’t open a DOS document using a Macintosh program, try the
following:
m Open the document from within the program by choosing Open in the
program’s File menu.
m Use the PC Exchange control panel to specify which Macintosh program
will open the document.
If a DOS document is displayed incorrectly, or you see strange codes or
characters in the document, try one of the following:
m Your application program may have special procedures for opening and
saving documents with different file formats. See the information that
came with your program.
m Try opening the document in another program.
Note:  Some characters that can be displayed on the Macintosh are not
accurately displayed on DOS computers, and vice versa. 
For more information about working with DOS documents on your
Macintosh, see the “Using DOS Files & Disks” topic of Macintosh Guide,
available in the Guide (h) menu.
You see a message that your application program can’t be opened because a file can’t
be found.
Power Macintosh programs use special files called shared libraries. Any
necessary shared libraries should be installed automatically when you install
Power Macintosh programs.
Follow the directions that came with your program to reinstall the program. If
the shared library is still missing, contact the software program’s manufacturer
for assistance.
You experience problems using an older Macintosh program.
Some older Macintosh programs are not completely compatible with Power
Macintosh computers. Check with the program’s manufacturer for
compatibility and upgrade information.
Open the Memory control panel and turn off Modern Memory Manager. For
more detailed instructions, see the “Working with Programs” topic of
Macintosh Guide, available in the Guide (h) menu.
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Problems using the CD-ROM drive
The CD-ROM drive icon does not appear on screen.
m If you have other internal SCSI devices attached to your computer, make
sure that each device has a unique SCSI ID number (If your CD-ROM
drive was installed in your computer at the factory, it has SCSI ID 3.)
Refer to the documentation that came with your SCSI devices if you need
to reset SCSI ID numbers.
Note:  Your computer also has an external SCSI connector. All devices on the
same SCSI chain must have unique ID numbers, but devices on different SCSI
chains may use the same SCSI ID number. (For example, you could have a
CD-ROM drive with ID number 3 connected to the internal SCSI chain and a
tape drive with ID number 3 connected to the external SCSI chain.
m If you installed a CD-ROM drive after you bought your computer, make
sure the CD-ROM software that came with the drive is installed. See the
manual that came with the CD-ROM drive for software installation
instructions.
m If you reinstall the CD-ROM software, make sure to restart your computer
after you reinstall the software.
You installed a CD-ROM drive after you bought your computer and your computer won’t
restart after you’ve copied software for your CD-ROM drive to the System Folder.
m If you attempt to install software for your CD-ROM drive without using the
Installer, you may not be able to restart your computer. Restart the
computer while holding down the Shift key (to turn off system extensions),
and then remove any CD-ROM software files you copied by dragging them
to the Trash. Reinstall the software according to the instructions that came
with the drive.
If this procedure doesn’t solve the problem, restart your computer using the
Disk Tools floppy disk. (For instructions on starting your computer using a
floppy disk, see “Starting Up From a Floppy Disk” in the section
“Initializing a Hard Disk,” later in this chapter.)
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pictorial buttons, instead of the usual Macintosh desktop.
m Your computer may have started up from a CD-ROM disc containing At
Ease, an alternative to the Macintosh desktop. You need to have the
Macintosh desktop on your screen before you can use any of the
installation instructions in this manual.
To return to the Macintosh desktop, choose Shut Down from the Special
menu. When your computer is off, press the Open/Close button of your
CD-ROM drive to open the tray, then remove the CD-ROM disc. Close the
tray. Then start up your computer again.
To avoid having the computer start up from a CD-ROM disc, remember to
remove any disc in the drive before you shut down your computer.
The tray of your CD-ROM drive won’t open.
If a CD-ROM disc icon appears on your screen:
m Drag the disc icon to the Trash, or select it and choose Put Away from the
File menu. If the AppleCD Audio Player program is active, choose Eject
CD from the File menu.
If you see a message that a disc can’t be put away because it is being
shared, turn off file sharing, then try again to put away the disc.
If no CD-ROM disc icon appears on your screen:
m Press the Open/Close button of your CD-ROM drive.
m The signal to open the tray may not be reaching the computer. Turn off
your computer and locate the small pinhole to the lower right of the 
CD-ROM tray opening. Insert the end of a large, straightened paper clip
firmly and horizontally into the pinhole. Push gently until the tray is
released, then carefully pull the tray open. Do not force the tray open; wait
until the paper clip has dislodged it, or you may break the front of the tray.
If neither of these suggestions works, your CD-ROM drive may be damaged.
Contact an Apple-authorized service provider or Apple for further assistance.
WARNING  Turn off your computer before you attempt to eject the tray
using a paper clip. If you don’t, you may damage the CD-ROM drive.
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m Your computer may be trying to start up from the CD-ROM disc. Press the
Open/Close button of your CD-ROM drive to open the tray, and remove
the CD-ROM disc. Close the tray, then restart your computer.
Problems using CD-ROM discs
You insert a CD-ROM disc, but its icon doesn’t appear on the Macintosh desktop. 
m Make sure that the disc label is facing up and the disc is centered in the
tray. If you’re using a small (8 cm) disc, make sure it is within the tray’s
inner ring.
m Make sure the tray is closed all the way.
m Try restarting your computer.
m Try starting your computer from the CD-ROM disc that contains system
software while holding the “c” key down. If only the hard drive icon
appears on the desktop, then there may be a hardware problem with your
CD-ROM drive. If the CD-ROM icon appears above the hard drive icon,
try reinstalling your CD-ROM software following the instructions in
“Installing or Reinstalling CD-ROM Software” later in this chapter.
m If you installed the CD-ROM drive after you bought your computer, make
sure the CD-ROM software is installed. (Refer to the documentation that
came with the CD-ROM drive.) 
CD-ROM software is already installed on Macintosh computers that come
with CD-ROM drives. You can reinstall it by following the procedure in
“Installing or Reinstalling CD-ROM Software” later in this chapter.
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initialize it?” when you insert a CD-ROM disc in the CD-ROM drive. 
m Make sure that the Foreign File Access and Audio CD Access CD-ROM
extensions are installed in your Extensions Folder and are turned on. (If
they are not turned on, use the Extensions Manager control panel to turn
them on and then restart your computer.)
m Make sure the CD-ROM software is installed. (The CD-ROM software is
already installed on Macintosh computers that come with CD-ROM
drives.) If you installed a CD-ROM drive after buying your computer, see
the manual that came with your drive.
m The disc may use a format that the Macintosh cannot recognize. 
Your computer ejects a CD-ROM disc without giving you any error message. 
m Make sure the disc is flat in the tray and the disc label is facing up. If
you’re using a small (8 cm) disc, make sure it’s centered within the tray’s
inner ring. 
m The disc may need to be cleaned. (See “Handling CD-ROM Discs” in
Appendix A.) If there are visible scratches on the shiny side of the disc,
you may be able to remove them with a CD polishing kit (available from
your audio CD dealer). If the scratches can’t be removed, you’ll need to
replace the disc.
m The disc may be damaged. Try another disc in the drive, and try the
original disc in another drive. If the original drive reads other discs or if
the original disc doesn’t work in another drive, the disc is probably
damaged. You’ll need to replace the disc.
You can’t open a document on a CD-ROM disc.
m Try opening the application program first; then open the document.
m Read the manual that came with your CD-ROM disc. Some discs come
with software that you need to install on your computer before using the
disc.
You can’t save changes you make to information on a CD-ROM disc. 
m CD-ROM is a read-only medium. This means that information can be read
(retrieved) from it, but not written (stored) on it. You can save the changed
information on a hard disk or floppy disk. 
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You cannot access files on a CD-ROM disc that uses the ISO 9660 or High Sierra format.
m Discs in the ISO 9660 and High Sierra disc formats have version numbers
attached to filenames. Some application programs need these version
numbers in order to work with files. To make the version numbers
available to programs on your computer, follow these instructions:
Drag the CD icon to the Trash. When the tray opens, hold down the Option
key and push the tray back in, continuing to hold down the Option key
until the disc is fully in the drive. The program you are using should now
be able to locate filenames on that CD-ROM disc.
m Make sure that Foreign File Access, ISO 9660 File Access and High Sierra
File Access are present in the Extensions folder in your System Folder.
Problems playing audio CDs
You don’t hear any sound when you play an audio CD or an audio track on a CD-ROM
disc using the AppleCD Audio Player.
m If your CD-ROM drive was installed after you bought your computer, make
sure the audio cable is properly connected. See the documentation that
came with the CD-ROM drive for more information.
m If you have headphones or speakers connected to the computer, adjust the
connector to make sure they are firmly connected. Make sure the volume
control on your headphones or speakers is not turned down too low.
m Some programs change the sound options to suit their needs. You may need
to reset the sound options in the Sound & Displays control panel. Refer to
the “Sound” topic of Macintosh Guide, available in the Guide (h) menu.
m If you are using a CD-ROM disc over a network, you won’t be able to hear
the audio portion. 
m Make sure the volume is turned up in the AppleCD Audio Player. With the
Audio Player open, drag the volume control slider up or press the Up
Arrow key on your keyboard.
m The CD may have been paused. Click the Play/Pause button in the
AppleCD Audio Player once or twice. 
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you double-click the disc icon and the audio track stops playing.
m You can’t open data files on a CD-ROM disc and listen to audio tracks on
that disc at the same time. 
You are unable to record sound from an audio CD.
m Check your computer’s sound input port to see if a microphone or other
device is connected. 
m You may need to reset the sound options in the Sound & Displays control
panel. Refer to the “Sound” topic of Macintosh Guide, available in the
Guide (h) menu.
Problems using Photo CDs
Your CD-ROM drive will not open Photo CDs.
m Reinstall the CD-ROM software (available through the “Multimedia
Software” option in Custom Install when you reinstall system software).
Your computer does not display color icons for individual images on a Photo CD.
m Your computer may be low on memory. To view color icons, restart your
computer and then reopen the Photos folder. See the “Memory” topic of
Macintosh Guide, available in the Guide (h) menu, for more information
on managing memory.
After you open an image on a Photo CD, the image is scrambled, colors are displayed
incorrectly, or no image appears in the window.
m The program you are using may not be designed to work with large (highresolution) image files. You can open the image with another program or
you can assign more memory to the program. (For more information on
managing memory, see the “Memory” topic of Macintosh Guide, available
in the Guide [h] menu.)
After you open an image on a Photo CD, your system is “frozen” and does not respond
to any input, or you have a “bomb” message on your screen.
m Restart your Macintosh. The program you are using may not be designed
to work with large (high-resolution) image files. You can open the image
with another program, or you can assign more memory to the program (see
the “Memory” topic of Macintosh Guide, available in the Guide [h] menu,
for more information on managing memory).
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If you notice a decrease in your computer’s speed and general performance
after you add special software like a control panel, system extension, or
custom utility, it may be because this software does not work well with Power
Macintosh computers.
m To find out if a system extension or control panel is the problem, use the
Extensions Manager control panel to turn off system extensions. Next, use
the Extensions Manager control panel to turn the system extensions and
control panels back on one at a time, restarting and checking your
computer’s performance each time until you identify the software that is
causing problems. Contact the software’s manufacturer for information or
an upgrade.
m To find out if a custom utility you’ve added is the problem, drag it out of
the System Folder. (This software may be in the Control Panels folder or
elsewhere inside the System Folder.) Next, restart your computer and check
its performance. If there’s an improvement, the new software was probably
the cause of the problem. Contact the software’s manufacturer for
information or an upgrade.
If you still do not notice an improvement, follow the instructions in
“Installing or Reinstalling System Software” later in this chapter to reinstall
system software on your startup hard disk.
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The following suggestions should work for all printers.
m Check your printer settings in the Chooser, making sure you have selected
the correct printer. 
m Next, turn off the computer and printer and check the printer cable
connections. 
m If neither of these suggestions solves the problem, reinstall your printer
driver. If your printer is an older model, do not use the driver that came
with the printer. Instead, use the updated printer drivers provided on the
system software CD-ROM that came with your Power Macintosh. These
drivers are created especially for use with the Power Macintosh.
Obtaining updated Apple software
Apple software updates include all of the latest versions of Apple software,
including most printer drivers, system enablers, and updates to utilities,
networking, and communication software. 
IMPORTANT  Be sure to read the posted Apple Software License Agreement
before installing any software.
Currently, Apple’s Customer Service Division (CSD) posts Apple software
updates to the following online services:
m AppleLink
m eWorld
m CompuServe
m Internet:  Apple Computer Higher Education gopher server
m Internet:  ftp.info.apple.com (formerly ftp.austin.apple.com)
m Internet:  ftp.support.apple.com
Specific paths and details for each service follow.
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Apple software updates are posted to the APPLE SW UPDATES board
located in the following path:
AppleLink Services (main window)
Software Sampler
Apple Software Updates
eWorld
Apple software updates are posted to the Apple Software Updates board
located in the following path:
Computer Center
Apple Customer Center
Apple Software Updates
Ask Apple Online Technical Support
You can also get your questions answered through “Ask Apple Online
Technical Support,” available through eWorld. You can expect a response to
your posted question the next business day after posting it.
To use Ask Apple Online Technical Support, log on to eWorld and go to the
Computer Center building in the Town Square. Use the following path: 
Apple Customer Center (shortcut:APPLE)
Apple Technical Support (formerly Quick Answers shortcut SUPPORT)
How Do I Use This Area? or Ask Apple USA.
Inside “How Do I Use This Area,” you can choose among the following
folders to learn more about how to use Ask Apple Online Technical Support:
m What’s New in Tech Support
m How to Use Tech Support
m All About Apple Software Updates
m Ask Apple, USA FAQs
m Who Maintains What
m Support Professional Series
m If You Need to Call
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board areas:
m Power Macintosh—All Power Macintosh computers, A/V and GeoPort.
m Performa—All Macintosh Performa computers.
m PowerBook—All PowerBook computers, Mobile Computing and Telecom.
m Quadra and Centris—All Macintosh Centris and Quadra computers.
m Apple Software—Mac OS system software, utilities, and application
programs from Apple.
m Peripherals—Printers, scanners, monitors and multimedia hardware.
m Servers, Networks & Comm—Workgroup Servers, AppleShare, networking
and communications.
m Newton—Apple MessagePad models and Apple accessories.
m Other Macintosh Computers—Compact and modular Macintosh models.
m DOS & Windows Products—DOS compatibility cards from Apple.
Ask Apple Online Technical Support does not arrange for service or send
products. It is available only to Apple US customers with full subscriptions to
eWorld. You cannot post questions from the Internet or from outside the
United States.
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Apple software updates are posted to two separate areas on CompuServe:
Apple Support Forum and Apple New Updates. All updates are posted
simultaneously to both areas. Updates are removed from the Apple New
Updates area after three weeks.
Apple Support Forum (GO APLSUP) contains all software and information
libraries. Software is organized by category into separate libraries, including:
m System Software
m Apple II
m Newton
m System Enablers
m Printing
m Display & Peripheral Software
m Networking & Communications
m DOS & Windows
Apple New Updates (GO APLNEW) contains all recently published Apple
software updates, allowing you to download the latest and most popular
Apple software updates quickly and easily.
Internet:  Apple Computer Higher Education gopher server
Apple recommends using TurboGopher client software to access the Apple
Computer Higher Education Gopher server. The “Apple Support Area” folder
is located in the following path:
Home Gopher Server
Computer Information
Apple Computer Higher Education gopher server
Apple Support Area
Apple SW Updates
TurboGopher Client software is available via anonymous file transfer protocol
(ftp) to boombox.micro.umn.edu in the /pub/gopher directory. 
m Host name:  info.hed.apple.com
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This is a file transfer protocol (ftp) server with all of the latest Apple software
updates. (This ftp site was formerly called ftp.austin.apple.com.) 
m Host name:  ftp.info.apple.com, IP number: 204.96.16.4
m Path:  ftp/Apple.Support.Area/Apple.SW.Updates
You can also download Apple software updates via our Worldwide Web server,
www.info.apple.com. The Apple web site allows you an easy way to download
Apple software updates from ftp.info.apple.com.
m URL for the Apple web site is:  http://www.info.apple.com
m IP number for the Web site is:  204.96.16.2
Internet:  ftp.support.apple.com
This is a file transfer protocol (ftp) server with all of the latest Apple software
updates.
m Host name:  ftp.support.apple.com
m IP number:  130.43.6.3
m Path:  /pub/Apple SW Updates
America Online:  ftp.info.apple.com gateway
You can log onto Apple’s ftp.info.apple.com server via the America Online file
transfer protocol (ftp) gateway. To do this, you’ll need an America Online
account. Once you’re online, follow these steps:
1 Use the keyword ftp to take you to the ftp area.
2 Click the FTP button (disk with sunglasses icon)
3 In the favorite sites list, double-click ftp.info.apple.com
A dialog box will appear with the ftp.info.apple.com welcome screen.
4 Click the OK button.
5 Double-click the Apple.Support.Area folder to open it.
6 Double-click the Apple.Software.Updates folder to open it.
Each time you open a folder, a new Macintosh window opens.
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Before you can use a new disk, the disk must be prepared so that the
computer knows where to store information on the disk. This preparation is
called initializing (or formatting) the disk.
When do you need to initialize a hard disk?
The hard disk inside your computer was initialized at the factory, so you
shouldn’t need to initialize it. You need to initialize a hard disk only if one of
the following is true:
m You purchase a hard disk that has not been initialized at the factory.
m Your hard disk is damaged.
If a hard disk needs to be initialized, the disk’s icon does not appear on the
desktop when you start up the computer using another disk.
If the hard disk you want to initialize is not the startup disk, you can use the
Drive Setup program to initialize it. Drive Setup is located on the floppy disk
labeled Disk Tools that came with your computer. If your computer came with
a CD-ROM drive and you didn’t receive floppy disks, you can find Drive
Setup on the CD-ROM disc that contains system software. For instructions,
start Drive Setup and choose Drive Setup Guide from the Guide (h) menu.
If the hard disk you want to initialize is the startup disk, follow the
instructions in this chapter. (First, start up from a CD-ROM disc or a floppy
disk. Then follow the instructions in “How to Initialize a Hard Disk” later in
this section.)
WARNING Initializing a disk erases any information that may be on it.
Before you initialize a damaged disk, try to repair it as described in
“Repairing a Damaged Disk” later in this chapter. 
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To initialize, test, or repair a hard disk, or to install system software on a hard
disk, you need to start up your computer from another disk. If your computer
has a CD-ROM drive, you can start up your computer using the CD-ROM
disc containing system software that came with the computer.
To start up the computer using the CD-ROM disc, follow these steps:
1 Turn your computer on. 
2 When you see the desktop on your screen, press the Open/Close button on your 
CD-ROM drive, and insert the CD-ROM disc containing system software into the drive.
3 Turn your computer off.
The CD-ROM disc will remain in the CD-ROM drive.
4 Hold down the “c” key on your keyboard and restart your computer.
Continue to hold down the key until you see the “Welcome to Macintosh”
message. 
Starting up from a floppy disk
To initialize, test, or repair a hard disk, or to install system software or 
CD-ROM software on a hard disk, you need to start up your computer from
another disk. If you don’t have a built-in CD-ROM drive, you can start up the
computer using one of these floppy disks—Disk Tools or System Backup 
Disk 1—that came with your computer.
To start up your computer using a floppy disk, follow these steps:
1 Shut down your computer.
2 Insert the floppy disk into the disk drive.
If you want to initialize, test, or repair your hard disk, use the Disk Tools
disk to start up your computer. If you want to install system software, use 
the System Backup Disk 1 disk. 
3 Turn on the computer.
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You initialize an Apple SCSI hard disk by using a program called 
Drive Setup, which is on the floppy disk labeled Disk Tools that came with
your computer. If your computer came with a CD-ROM drive and you didn’t
receive floppy disks, you can find Drive Setup on the CD-ROM disc that
contains system software. (To initialize a hard disk from another
manufacturer, use the utility software that came with the hard disk.)
1 Start up your computer from the Disk Tools disk or the CD-ROM disc that contains
system software. 
See “Starting Up From a CD-ROM Disc” or “Starting Up From a Floppy
Disk” earlier in this section. 
2 Open the Drive Setup icon.
You may need to look in a folder called Utilities to find Drive Setup.
3 In the list of drives, click the disk you want to initialize.
4 Click Initialize to initialize the hard disk.
5 Click Quit when you see a message reporting that initialization was successful.
If a message reports that initialization failed, try again. If initialization 
fails a second time, take the disk to your Apple-authorized service provider
for repair.
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Click the drive you
want to initialize...
...then click Initialize.Repairing a damaged disk
Disks can become damaged by repeated use and handling. 
When do you need to repair a disk?
If you see a message reporting that a disk is damaged or unreadable, you may
need to repair the disk.
Try these suggestions first
If you can’t start up from a hard disk or you don’t see the hard disk icon on the
desktop, try the following:
m If the hard disk is internal, shut down your Macintosh, wait at least 10
seconds, and then turn it on again.
m If the hard disk is external, make sure that it is turned on and that its cable
is connected firmly; then restart the Macintosh.
m If the hard disk is your startup disk, start up with a different startup disk. If
the hard disk’s icon appears on your desktop, reinstall system software on
the hard disk. See “Installing or Reinstalling System Software” later in this
chapter.
m Check the ID numbers of all SCSI equipment connected to your computer.
Your computer has two SCSI chains, an internal one and an external one.
All devices on the same SCSI chain must have unique ID numbers, but
devices on different SCSI chains may use the same SCSI ID number. (For
example, you can have a CD-ROM drive with ID number 3 connected to
the internal SCSI chain and a tape drive with ID number 3 connected to
the external SCSI chain. You cannot have two SCSI devices connected to
the external SCSI chain that both use ID number 3.)
On the internal SCSI chain, the computer itself has the ID number 7, and
the factory-installed hard disk has the number 0. If your computer came
with a CD-ROM drive installed, it is also connected to the internal SCSI
chain and has ID number 3. 
On the external SCSI chain, SCSI devices are numbered from 0 to 6, or 
1 to 6 if you have an additional hard drive installed (its number is 0). 
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on setting SCSI ID numbers and terminating a SCSI chain, see Chapter 3
of this manual and the manuals that came with your SCSI equipment
m Test the disk following the instructions that come next.
How to test a hard disk
You can test an Apple SCSI hard disk with the Drive Setup program, which is
on the floppy disk labeled Disk Tools that came with your computer. If your
computer has a built-in CD-ROM drive, and you didn’t receive floppy disks,
you can find the Drive Setup program on the CD-ROM disc that contains
system software. 
1 Start up your computer from the Disk Tools disk or the CD-ROM disc that contains
system software. 
See “Starting Up From a CD-ROM Disc” or “Starting Up From a Floppy
Disk” in the section “Initializing a Hard Disk” earlier in this chapter. 
2 Open the Drive Setup icon.
You may need to look in a folder called Utilities to find Drive Setup.
3 In the list of drives, click the disk you want to test.
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5 When a message tells you that testing is complete, click Quit.
If the test reveals a problem, you may be able to correct it by using Disk First
Aid or another disk repair program (see the instructions in the next section),
or you may need to reinitialize the disk (see “Initializing a Hard Disk” earlier
in this chapter). Consult an Apple-authorized service provider for assistance if
necessary. If you had a hard disk from another manufacturer installed after
you bought your computer, use the software that came with the disk or contact
the disk vendor to get the latest version of software.
How to repair a hard disk or floppy disk
You can repair some types of disk damage by using the Disk First Aid
program, which is included either on the Disk Tools floppy disk or on the 
CD-ROM disc containing system software that came with your computer.
1 Start up your computer from the Disk Tools disk or the CD-ROM disc that contains
system software. 
See “Starting Up From a CD-ROM Disc” or “Starting Up From a Floppy
Disk” in the section “Initializing a Hard Disk” earlier in this chapter. 
2 Open the Disk First Aid icon.
You may need to look in a folder called Utilities to find Disk First Aid. 
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Disk icons appear in a box at the top of the Disk First Aid window.
4 Click Repair to begin testing and repairing the disk.
You can’t repair the startup disk or the disk that contains the Disk First Aid
program, but you can test these disks by clicking Verify. If the program
reveals a problem with either of these disks, start up the computer from
another disk so that you can repair the damaged disk. 
If you want to test and repair another disk, click its icon and then click
Repair. 
5 When testing and repair are finished, choose Quit from the File menu.
If Disk First Aid cannot correct the problem
m Try repairing the disk again. Sometimes repeating the process corrects the
problem.
m Use another disk repair or recovery program. Some disk repair programs
let you recover information from a damaged disk.
m Consult a computer repair specialist for help.
m Once you have recovered all the information you can, erase (reinitialize)
the disk. If initialization doesn’t work, discard the damaged disk (if it’s a
floppy disk), or take it to your Apple-authorized service provider for repair
(if it’s a hard disk).
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System software is the set of programs and other files that your computer uses
to start itself up, keep track of your files, and run the application programs
you use. System software is kept in the folder called the System Folder. When
you turn on your computer, it looks for a startup disk, which is a disk that
contains the system software. The startup disk is usually the hard disk that’s
inside your computer, though another hard disk or a floppy disk can also be a
startup disk.
The accessory kit that came with your Macintosh provides system software on
either a set of floppy disks or a CD-ROM disc. You can use the floppy disks
or the CD-ROM disc to install the system software on your Macintosh if you
need to do so.
When should you install system software?
Your Macintosh came with all the necessary system software installed on its
internal hard disk, so you don’t need to install system software on that disk
unless you encounter software problems.
If you have a new hard disk or a newly initialized hard disk that doesn’t
contain system software, or if you want to upgrade to a more recent version of
system software on a hard disk, follow the instructions in “Installing System
Software” later in this section.
When should you reinstall system software?
If you have a problem with your system software, you may see this icon in the
middle of the screen:
If this icon appears, follow the instructions in “Repairing a Damaged Disk”
earlier in this chapter to test your startup hard disk and repair any damage. 
If repairing the disk doesn’t help, follow the instructions in the next section,
“Installing System Software,” to reinstall system software on your startup 
hard disk.
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Follow the steps in this section to do what is commonly called a “normal”
installation of system software.
If you’re installing system software on a hard disk for the first time, make sure
that your hard disk has been initialized, a process that prepares the disk to
store information. If you see the hard disk’s icon on the desktop when you
start up the computer, the disk has been initialized. If no disk icon appears
when you start up, see “Initializing a Hard Disk” earlier in this chapter for
instructions.
To do a normal installation, follow these steps:
1 Start up your computer from the Disk Tools disk or the CD-ROM disc that contains
system software. 
See “Starting Up From a Floppy Disk” or “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” earlier in this chapter. 
2 Find and open the Disk First Aid icon.
You may need to look in a folder called Utilities to find Disk First Aid.
After Disk First Aid starts, follow the instructions on the screen. Disk First
Aid checks your hard disk for any problems.
3 When Disk First Aid has finished checking your hard disk, choose Quit from the 
File menu.
4 Open the Drive Setup program.
You use the Drive Setup program to update your hard disk.
5 In the list of drives, click your startup disk.
6 Open the Functions menu and choose Update Driver.
7 When the update process is finished, quit Drive Setup.
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9 Start up your computer from the System Backup Disk 1 disk or the CD-ROM disc that
contains system software. 
See “Starting Up From a Floppy Disk” or “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” earlier in this chapter. 
The Installer’s Welcome screen may appear or you may have to double-click
the System Software Installer icon to open the Installer program.
10 Click OK.
The Easy Install dialog box appears.
11 Make sure that the hard disk named in the box is the one on which you want to install
system software.
If it isn’t, click Switch Disk until the correct disk name appears.
12 Click Install.
13 Follow the instructions that appear on the screen.
If you’re installing system software from floppy disks, you see messages
asking you to insert different disks.
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Disk on which 
system software 
will be installed
You click here to install
the software you need.
To install the software on a
different disk, you click here.14 When you see a message reporting that the installation was successful, click Restart (or
“Quit,” if you’re installing from the CD-ROM disc). 
Don’t forget to eject the CD-ROM disc or floppy disk containing system
software. If a message reports that installation was not successful, try
installing again. (Follow the instructions on the screen.)
If, after reinstalling system software by doing a normal installation, you still
experience problems with your computer, follow the steps in the next section
for doing a “clean” installation of system software.
IMPORTANT  Certain system extensions or application programs that were
originally on your hard disk may not be installed with the Installer program.
If you notice that a certain extension or program was not installed, you may
need to install it separately. You can find these additional extensions and
programs on the CD-ROM disc that contains system software. (Application
programs from other vendors can be reinstalled from backup copies you
made.) If you don’t have a CD-ROM drive, see the service and support
information that came with your computer for information on how to contact
Apple directly for assistance. 
Doing a clean installation of system software
The steps in this section outline what is commonly called a “clean”
installation of system software. A clean installation allows you to discover
which item in your System Folder is causing a problem. A clean installation
creates a brand new System Folder and saves everything in your original
System Folder in a different location. You can then follow the instructions in
“Replacing Special Software,” later in this chapter, to reinstall system
extensions, control panels, and other special software one at a time from the
old System Folder to the new System Folder. This procedure allows you to
determine which item in the old System Folder was the source of the
problem.
Do a clean installation if you can’t determine what is damaged in your System
Folder (especially if you think any special software, such as control panels,
system extensions, or custom utilities, may be causing the problems you’re
experiencing). You should also do a clean installation if you’re still having
problems with your computer after you’ve reinstalled system software by
doing a normal installation. 
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1 Start up your computer from the Disk Tools disk or the CD-ROM disc that contains
system software. 
See “Starting Up From a Floppy Disk” or “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” earlier in this chapter. 
2 Find and open the Disk First Aid icon.
You may need to look in a folder called Utilities to find Disk First Aid.
After Disk First Aid starts, follow the instructions on the screen. Disk First
Aid checks your hard disk for any problems.
3 When Disk First Aid has finished checking your hard disk, choose Quit from the File
menu.
4 Open the Drive Setup program.
You use the Drive Setup program to update your hard disk.
5 In the list of drives, click your startup disk.
6 Open the Functions menu and choose Update Driver.
7 When the update process is finished, quit Drive Setup.
8 Shut down your computer.
9 Start up your computer from the System Backup Disk 1 disk or the CD-ROM disc that
contains system software. 
See “Starting Up From a Floppy Disk” or “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” earlier in this chapter. 
The Installer’s Welcome screen may appear or you may have to double-click
the System Software Installer icon to open the Installer program.
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The Easy Install dialog box appears.
11 Make sure that the hard disk named in the Destination Disk box is the one on which you
want to install system software.
If it isn’t, click Switch Disk until the correct disk name appears.
12 Hold down Shift–x–K to start the clean installation.
The following dialog box appears.
13 Click the Install New System Folder button and click OK.
The Easy Install dialog box appears. The Install button has changed to Clean
Install, and the contents of your old System Folder have been moved to a new
folder named Previous System Folder.
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Disk on which 
system software 
will be installed
For a clean installation,
DO NOT click the 
Install button.
To install the software on a different
disk, you click this button.14 Click Clean Install. 
15 Follow the instructions that appear on the screen. 
It takes a few minutes to complete the installation.
16 When you see a message reporting that the installation was successful, you may need to
click Restart. 
You need to click Restart only if you installed software onto the startup disk. 
If a message reports that installation was not successful, try repeating the
clean installation procedure. 
IMPORTANT  Certain system extensions or application programs that were
originally on your hard disk may not be installed with the Installer program.
If you notice that a certain extension or program was not installed, you may
need to install it separately. You can find these additional extensions and
programs on the CD-ROM disc that contains system software. (Application
programs from other vendors can be reinstalled from backup copies you
made.) If you don’t have a CD-ROM drive, see the service and support
information that came with your computer for information on how to contact
Apple directly for assistance. 
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Click here to install the
software you need.Replacing special software
Special software consists of items such as control panels, system extensions,
custom utilities, fonts, or Apple menu items that you may have had in your
old System Folder. To make sure that special software does not create any
conflicts with other programs on your computer, follow this procedure to
safely replace these items in your new System Folder:
1 Copy any special software items from the Previous System Folder back to your System
Folder one item at a time, restarting the computer after copying each item.
IMPORTANT  Be very careful not to replace (copy over) any of the files in the
System Folder with files from the Previous System Folder.
2 Check after each restart to make sure your computer is not having any software
problems.
If any of your special software items cause software problems, contact the
software manufacturer for assistance or an upgrade.
Doing a custom installation
For most Macintosh users, the Easy Install procedure described in the
previous sections is appropriate, because it automatically installs all the items
you need. However, if you’d like to select a combination of system software
files for your specific needs, you can customize your system software
installation. You use custom installation to install or update one or more
specific files, or to save space on your hard disk by installing only the files
you want.
To install customized system software, follow these steps:
1 Start up your computer from the System Backup Disk 1 disk or the CD-ROM disc that
contains system software. 
See “Starting Up From a Floppy Disk” or “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” earlier in this chapter. 
The Installer’s Welcome screen may appear or you may have to double-click
the System Software Installer icon to open the Installer program.
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The Easy Install dialog box appears.
3 Choose Custom Install from the pop-up menu.
The Custom Install dialog box appears, listing all available system software
components.
4 Scroll through the list of components, clicking the checkbox next to each component
you want to install.
You can see and select individual items within each component by clicking
the arrow to the left of the component, then clicking the item you want to
install. To get additional information about each component listed, click the
box with the letter i in it to the right of the component.
5 Click Install.
6 Follow the instructions that appear on the screen.
7 When you see a message reporting that the installation was successful, click Quit.
If a message reports that installation was not successful, try installing again.
(Follow the instructions on the screen.)
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The system software is installed and your computer is ready to use. Don’t
forget to eject the CD-ROM disc or floppy disk containing system software
when you are finished
Installing or reinstalling CD-ROM software
CD-ROM software is a set of programs and files that allow your CD-ROM
drive to work correctly with your computer and allow it to play different
kinds of CDs, like Photo CDs or audio CDs. If your computer came with a
CD-ROM drive installed, the CD-ROM software is part of system software
and was preinstalled for you on your computer’s hard disk. (It is also available
on floppy disks and a CD-ROM disc that came with your Macintosh.)
If you added a CD-ROM drive after you bought your computer, the CD-ROM
software is probably on floppy disks that came with the drive.
When should you install or reinstall CD-ROM software?
If your Macintosh came with the CD-ROM drive already installed, you don’t
need to install the CD-ROM software unless you encounter problems. (See
“Solutions to CD-ROM Problems” earlier in this chapter for descriptions of
the kinds of problems you might encounter.)
If you added a CD-ROM drive after you bought your computer, you should
install the CD-ROM software before you attempt to use the CD-ROM drive.
Installing or reinstalling CD-ROM software
1 Start up your computer from the System Backup Disk 1 disk or the CD-ROM disc that
contains your system software.
See “Starting Up From a Floppy Disk” or “Starting Up From a CD-ROM
Disc” in the section “Initializing a Hard Disk” earlier in this chapter. 
The Installer’s Welcome screen may appear. Or, you may have to double-click
the System Software Installer icon to open the Installer program.
2 Click OK.
The Easy Install dialog box appears.
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The Custom Install dialog box appears, listing all available system software
components.
4 Select Multimedia Software by clicking the checkbox next to it.
To get additional information about each component listed, click the box with
the letter i in it to the right of the component. 
5 Click Install.
6 Follow the instructions that appear on the screen.
7 When you see a message reporting that the installation was successful, click Quit.
If a message reports that installation was not successful, try installing again.
(Follow the instructions on the screen.)
8 Restart your Macintosh.
The CD-ROM software is reinstalled and your computer is ready to use. Don’t
forget to eject the CD-ROM disc or floppy disk containing system software
when you are finished.
126 Chapter 6III
part
Appendix A Health, Safety, and Maintenance Tips
Appendix B Installing an Expansion Card
Appendix C Special Keys on Your KeyboardFor your own safety and that of your equipment, follow all the instructions in
this chapter. Keep these instructions available for reference by you and others.
Health-related information about computer use
Muscle soreness, eye fatigue, and other discomforts and injuries sometimes
associated with using computers can occur from performing any number of
activities. In fact, misuse of the same muscles during multiple activities can
create a problem that might not otherwise exist. For example, if you engage in
nonwork activities that involve repetitive stress on the wrist—such as
bicycling—and also use your computer’s keyboard improperly, you may
increase your likelihood of developing wrist problems. Some individuals are
at greater risk of developing these problems because of their health,
physiology, lifestyle, and general exposure to stress. Work organization and
conditions, such as workstation setup and lighting, also play a part in your
overall health and comfort. Preventing health problems is a multifaceted task
that requires careful attention to the way you use your body every hour of
every day.
The most common health effects associated with using a computer are
musculoskeletal discomfort and eye fatigue. We’ll discuss each area of
concern.
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Health, Safety, and Maintenance Tips 
Read this appendix for important
health and safety instructions, 
as well as tips on keeping your
computer in good working order.Musculoskeletal discomfort
As with any activity that involves sitting for long periods of time, using a
computer can make your muscles sore and stiff. To minimize these effects, set
up your work environment carefully, using the guidelines that follow, and take
frequent breaks to rest tired muscles. To make working with your computer
more comfortable, allow enough space in your work area so that you can
change position frequently and maintain a relaxed posture. 
Another type of musculoskeletal concern is repetitive stress injuries (RSIs),
also known as cumulative trauma disorders (CTDs). These problems can
occur when a certain muscle or tendon is repeatedly overused and forced into
an unnatural position. The exact causes of RSIs are not totally understood, but
in addition to awkward posture, such factors as the amount of repetition, the
force used in the activity, the individual’s physiology, workplace stress level,
and lifestyle may affect the likelihood of experiencing an RSI.
RSIs did not suddenly arise when computers were invented; tennis elbow and
writer’s cramp, for example, are two RSIs that have been with us for a long
time. Although less common than other RSIs, one serious RSI discussed more
often today is a wrist problem called carpal tunnel syndrome, which may be
aggravated by improper use of computer keyboards. This nerve disorder
results from excessive pressure on the median nerve as it passes through the
wrist to the hand.
This section offers advice on setting up your work area to enhance your
comfort while you use your computer. Since the effects of repetitive
movements associated with using a computer can be compounded by those of
other work and leisure activities to produce or aggravate physical problems,
proper use of your computer system must be considered as just one element
of a healthy lifestyle.
No one, of course, can guarantee that you won’t have problems even when you
follow the most expert advice on using computer equipment. You should
always check with a qualified health specialist if muscle, joint, or eye
problems occur.
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Eye fatigue can occur whenever the eyes are focused on a nearby object for a
long time. This problem occurs because the eye muscles must work harder to
view an object that’s closer than about 20 feet (6 meters). Improper lighting
can hasten the development of eye fatigue. Although eye fatigue is annoying,
there’s no evidence that it leads to permanent damage.
Whenever you’re engaged in an activity that involves close-up work—such as
reading a magazine, doing craft work, or using a computer—be sure to have
sufficient glare-free lighting and give your eyes frequent rest breaks by
looking up and focusing on distant objects. Remember to have your eyes
examined regularly.
To prevent discomfort and eye fatigue:
m Arrange your work space so that the furniture is properly adjusted for you
and doesn’t contribute to an awkward working posture.
m Take frequent short breaks to give your muscles and eyes a chance to rest.
Arranging your office
Here are some guidelines for adjusting the furniture in your office to
accommodate your physical size and shape.
m An adjustable chair that provides firm, comfortable support is best. Adjust
the height of the chair so your thighs are horizontal and your feet flat on
the floor. 
The back of the chair should support your lower back (lumbar region).
Follow the manufacturer’s instructions for adjusting the backrest to fit your
body properly.
m When you use the computer keyboard, your shoulders should be relaxed.
Your upper arm and forearm should form an approximate right angle, with
your wrist and hand in roughly a straight line. 
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proper angle to the keyboard. If this makes it impossible to rest your feet
flat on the floor, you can use a footrest with adjustable height and tilt to
make up for any gap between the floor and your feet. Or you may lower
the desktop to eliminate the need for a footrest. Another option is to use a
desk with a keyboard tray that’s lower than the regular work surface.
m Position the mouse at the same height as your keyboard. Allow adequate
space to use the mouse comfortably.
m Arrange the monitor so the top of the screen is slightly below your eye
level when you’re sitting at the keyboard. The best distance from your eyes
to the screen is up to you, although most people seem to prefer 18 to 28
inches (45 to 70 cm). 
m Position the monitor to minimize glare and reflections on the screen from
overhead lights and windows. You may want to use a tiltable monitor
stand. The stand lets you set the monitor at the best angle for viewing,
helping to reduce or eliminate glare from lighting sources you can’t move.
Thighs horizontal
Shoulders relaxed
Screen positioned to avoid
reflected glare
Forearms and hands
in a straight line
Forearms level
or tilted up slightly
Lower back supported
Feet flat on the floor
Top of the screen at or slightly
below eye level (You may need
to adjust the height of your
monitor by placing something
under it or by raising your
work surface.)
Clearance under work surface
45–70 cm (18–28 in.)
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m Change your seated position, stand up, or stretch whenever you start to feel
tired. Frequent short breaks are helpful in reducing fatigue.
m Use a light touch when typing or using a mouse and keep your hands and
fingers relaxed.
m Some computer users may develop discomfort in their hands, wrists, or
arms after intensive work without breaks. If you begin to develop chronic
pain or discomfort in your hands, wrists, or arms, consult a qualified
health specialist.
m Allow adequate work space so that you can use your keyboard and mouse
comfortably. Place papers or other items so you can view them easily while
using your computer. A document stand may make reading papers more
comfortable.
m Eye muscles must work harder to focus on nearby objects. Occasionally
focus your eyes on a distant object, and blink often while you work.
m Clean your screen regularly. Keeping the screen clean helps reduce
unwanted reflections.
What about electromagnetic emissions?
There has been recent public discussion of the possible health effects of
prolonged exposure to extremely low frequency (ELF) and very low
frequency (VLF) electromagnetic fields. Such fields are associated with
electromagnetic sources such as television sets, electrical wiring, and some
household appliances—as well as computer monitors.
Apple has reviewed scientific reports and sought the counsel of government
regulatory agencies and respected health organizations. Based on the
prevailing evidence and opinions, Apple believes that the electric and
magnetic fields produced by computer monitors do not pose a health risk.
In response to those customers who wish to reduce their exposure to
electromagnetic fields, Apple has lowered the emission levels of our products.
We are also actively encouraging further scientific research so we can
continue to promote the health and safety of our customers and employees.
Health, Safety, and Maintenance Tips 133Safety instructions
For your own safety and that of your equipment, always take the following
precautions.
Turn off the computer completely and disconnect the power plug (by pulling
the plug, not the cord) if any of the following conditions exists:
m the power cord or plug becomes frayed or otherwise damaged 
m you spill something into the case 
m your Macintosh is exposed to rain or any other excess moisture 
m your Macintosh has been dropped or the case has been otherwise damaged 
m you suspect that your Macintosh needs service or repair 
m you want to clean the case (use only the recommended procedure
described later in this chapter) 
Be sure that you always do the following: 
m Keep your Macintosh away from sources of liquids, such as wash basins,
bathtubs, shower stalls, and so on.
m Protect your Macintosh from dampness or wet weather, such as rain, snow,
and so on.
m Read all the installation instructions carefully before you plug your
Macintosh into a wall socket.
m Keep these instructions handy for reference by you and others.
m Follow all instructions and warnings dealing with your system. 
WARNING  Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.
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Follow these guidelines for handling your computer and its components: 
m When setting up your computer, place components on a sturdy, flat surface,
and carefully follow all setup instructions.
m When connecting or disconnecting a cable, always hold the cable by its
connector (the plug, not the cord).
m Turn off your computer and all its components before connecting or
disconnecting any cables to add or remove any component. Failure to do so
could seriously damage your equipment.
m Never force a connector into a port. If the connector and port do not join
with reasonable ease, they probably don’t match. Make sure that the
connector matches the port and that you have positioned the connector
correctly in relation to the port.
m Take care not to spill any food or liquid on the computer, keyboard, mouse,
or other components. If you do, turn your computer off immediately and
unplug it before cleaning up the spill. Depending on what you spilled and
how much of it got into your equipment, you may have to bring your
equipment to an Apple-authorized service provider.
m Protect the computer and its components from direct sunlight and rain or
other moisture.
m Keep all ventilation openings clear and unobstructed. Without proper air
circulation, components can overheat, causing damage or unreliable
operation.
WARNING  This equipment is intended to be electrically grounded. Your
Macintosh is equipped with a three-wire grounding plug—a plug that
has a third (grounding) pin. This plug will fit only a grounded AC
outlet. This is a safety feature. If you are unable to insert the plug into
the outlet, contact a licensed electrician to replace the outlet with a
properly grounded outlet. Do not defeat the purpose of the grounding
plug!
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Follow these procedures for handling a monitor:
m Your Macintosh comes with an energy-saving feature that dims the screen
and puts the computer to “sleep” when it hasn’t been used in a specified
length of time. (By default, the time setting is 30 minutes, but you may
have changed the time setting using the Energy Saver control panel.) You
can also turn down the screen brightness control if you leave the computer
turned on for extended periods. If the brightness is not turned down, the
image on the screen could “burn in” and damage the screen.
Another alternative is to use a “screen saver” program, which dims or
varies the image on the screen when the computer has been idle for a
specified period of time. These programs are available from independent
suppliers and user groups.
m Make sure that the ventilation openings on the computer and the monitor
are clear and unobstructed.
m Some large monitors cannot safely be placed on top of the computer.
Check the instructions that came with the monitor for setup information. 
m If there is interference on the monitor’s screen or on a television or radio
near your computer, move the affected equipment farther away.
Handling the keyboard
Take care not to spill any liquid on the keyboard. If you do, turn off your
computer immediately.
m If you spill liquid that is thin and clear, unplug the keyboard, turn it upside
down to let the liquid drain out, and let it dry for 24 hours at room
temperature. If, after you take these steps, the keyboard doesn’t work, take
it to an Apple-authorized service provider for repair.
m If you spill liquid that is greasy, sweet, or sticky, unplug the keyboard and
take it to an Apple-authorized service provider for repair.
136 Appendix AHandling floppy disks
125° F (52° C)
50° F (10° C)
Keep disks dry.
Do not use a
pencil or an 
eraser on a disk
or disk label.
Store disks at
temperatures
between 50° F
and 125° F.
Do not touch the
exposed part of the
disk behind the 
metal shutter.
Keep disks away 
from magnets.
Avoid exposing
disks to extremely
hot temperatures.
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Keep these important safety instructions in mind as you use CD-ROM discs:
m Hold a disc by the edges or by one edge and the center hole. Do not touch
the disc surface.
m To clean discs, wipe the shiny surface with a soft damp cloth, working in
straight lines from center to edge. Do not use any form of cleaning agent.
m To avoid damage to your discs, keep these points in mind:
Do not put tape
on discs.
Do not scratch
discs.
Do not write on
discs.
Do not spill liquids
on discs.
Do not get
dust on discs.
Do not expose discs
to direct sunlight.
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CD-ROM drive.
m Position your computer so that when the tray opens, it doesn’t bump 
into anything.
m Do not leave the disc tray open. If dust gets on the lens of the CD-ROM
drive, the drive may have problems reading your compact discs.
m Do not put anything (for instance, a cup) on top of the tray when it is open.
m Do not force the tray open by hand.
m Do not wipe the lens with a paper towel or other abrasive surface. If you
need to clean the lens, see an Apple-authorized service provider for a lens
cleaner. 
m Never transport your computer with a disc inside the CD-ROM drive.
m Keep your computer equipment away from any source of liquid (such as
wash basins, bathtubs, and shower stalls). If you drink coffee or other
beverages while you’re at your computer, take care not to spill.
m Avoid exposing your equipment to damp or wet weather. If your system is
near a window, be sure the window is closed in rainy weather.
The tray on your CD-ROM drive automatically closes when you shut down
your computer. You may want to open the tray and take out your CD-ROM
disc before shutting down.
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For instructions on ejecting a floppy disk or a removable media disk, see the
“Disks” topic of Macintosh Guide, available in the Guide (h) menu.
If you can’t eject a floppy disk
If you can’t eject a floppy disk in the usual way, try the following in order:
m Hold down the x and Shift keys and press the number 1 key at the upper
left of your keyboard to eject a disk in the internal disk drive.
m Turn off the computer. If the disk isn’t ejected, then hold down the button
on your mouse or other pointing device while you turn the computer on
again.
m Locate the small hole near the disk drive’s opening, and carefully insert the
end of a large straightened paper clip into it. Push gently until the disk is
ejected. Do not use excessive force. 
If nothing works, take the computer or disk drive to your Apple-authorized
service provider to have the disk removed.
Power supply
The power supply in your computer is a high-voltage component and should
not be opened for any reason, even when the computer is off. If the power
supply needs service, contact your Apple-authorized dealer or service
provider.
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Follow these general rules when cleaning the outside of your computer and
its components:
m Use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid
getting moisture in any openings.
m Don’t use aerosol sprays, solvents, or abrasives.
Cleaning the computer case
To clean the case, do the following: 
1 Turn off the computer completely and then disconnect the power plug. (Pull the plug, not
the cord.) 
2 Wipe the surfaces lightly with a clean, soft cloth dampened with water. 
Cleaning the monitor
To clean the screen, put household glass cleaner on a soft cloth and wipe the
screen. Don’t spray the cleaner directly on the screen, because the liquid
might drip into the monitor or computer.
Cleaning the mouse
The mouse contains a small ball that must roll smoothly for the mouse to
work properly. You can keep this ball free of dirt and grease by using the
mouse on a clean, lint-free surface and cleaning it occasionally.
You need a few cotton swabs and a clean, soft, lint-free cloth.
1 Turn off your computer.
Health, Safety, and Maintenance Tips 1412 Turn the mouse upside-down and turn the plastic ring on the bottom counterclockwise
to disengage it.
On some mouse devices, you may need to press the plastic ring (rather than
turn it) to disengage it.
If the mouse is locked, see the next section, “Locking and Unlocking the
Mouse,” for instructions on how to unlock it.
3 Turn the mouse right-side up with one hand and catch the ring and the ball with your
other hand.
4 Clean the three small rollers inside the mouse with a cotton swab moistened with water.
Rotate the rollers to clean all around them.
5 Wipe the mouse ball with a clean, soft, dry, and lint-free cloth.
6 If necessary, wash the mouse ball with warm soapy water (use a mild soap such as a
dishwashing liquid) and then dry the mouse ball thoroughly.
7 Gently blow into the mouse case to remove any dust that has collected there.
142 Appendix A8 Put the ball and the ring back in place.
Your mouse should roll smoothly across your mouse pad or desk. If it doesn’t,
repeat these instructions carefully.
Locking and unlocking the mouse
Some mouse devices can be locked so that the ball can’t be removed. A
locking mouse has a small hole on the plastic ring.
To lock the mouse, follow these steps:
1 Insert a straightened paper clip into the hole on the plastic ring.
2 Press down on the paper clip while you turn the ring clockwise.
Turn the ring a very short distance, until it stops. When the recessed area on
the ring is not lined up with the recessed area surrounding the ring, the mouse
is locked.
The mouse ring is locked when the recessed area on the ring
does not line up with the recessed area surrounding the ring.
Recessed area on ring
Recessed area surrounding ring
Insert a straightened paper clip into this hole.
(The hole may be located here on your mouse.)
Health, Safety, and Maintenance Tips 143To unlock the mouse, follow these steps:
1 Insert a straightened paper clip into the hole on the plastic ring.
2 Press down on the paper clip while you turn the ring counterclockwise.
Turn the ring a very short distance. When the recessed area on the ring is
lined up with the recessed area surrounding the ring, the mouse is unlocked.
The mouse ring is unlocked when the recessed area on the
ring lines up with the recessed area surrounding the ring.
Recessed area on ring
Recessed area surrounding ring
Insert a straightened paper clip into this hole.
(The hole may be located here on your mouse.)
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Appendix B 
Installing an Expansion Card
You can install printed circuit boards (called cards) for video and graphics
applications, networking and communications, additional processing power,
or other purposes. The cards fit into connectors, called expansion slots, inside
the computer.
Your Macintosh has three expansion slots, each designed to accept a
Peripheral Component Interconnect (PCI) card. Install only expansion cards
that come with Macintosh drivers and are compliant with the PCI 2.0
standard. NuBus™
cards cannot be used in these expansion slots. There is also
an expansion slot that contains the computer’s processor card. (The processor
card can be upgraded by replacing it with a more powerful processor card.) 
WARNING  To avoid damaging your computer and expansion card, do not
attempt to install any expansion card without first checking the
documentation for that card. If the documentation specifies that an
Apple-certified technician must install the card (usually because the
installation requires special training or tools), consult the service and
support information that came with your computer for instructions on
how to contact an Apple-authorized service provider or Apple for
assistance. If you attempt to install the card yourself, any damage you
may cause to the computer or card will not be covered by the limited
warranty on your computer. If the card is not an Apple-labeled product,
check with an Apple-authorized dealer or service provider to see if you
can install it yourself.
Read this appendix for instructions
on installing an expansion card 
in your computer.Expansion card power requirements
The combined power consumption of expansion cards must not exceed the
limits specified for your Macintosh model. If you have more than one
expansion card installed, check the information that came with your cards to
make sure that their power consumption is within the limits specified in the
Technical Information booklet.
Card installation
1 Turn off the computer.
Leave the computer plugged in to ground it and protect its components from
static electricity damage.
2 Loosen the four large screws at the corners of the back panel.
Do not completely remove the screws or the back panel.
146 Appendix B3 Remove the cover from the computer.
Slide the cover away from the back panel an inch or two. Then raise the cover
straight up and off the computer.
Installing an Expansion Card 1474 Touch the metal part of the power supply case inside the computer to discharge static
electricity.
Always do this before you touch any parts, or install any components, inside
the computer.
Power supply
148 Appendix B5 Lower the retainer.
Squeeze the sides of the retainer and pull down.
To lower the retainer, squeeze the sides to unlatch it.
Installing an Expansion Card 1496 Being careful not to touch the sharp edges, pull out the metal access port cover behind
the expansion slot you want to use, and set the access port cover aside.
7 Remove the card from its static-proof bag.
Hold the card by its edges to avoid touching the connector.
Connector
1 Press apart the two
levers that are next to
the card access port
to release the access
port cover.
2 Slide the access port cover out and away from the access port. 
150 Appendix B8 Align the connector end of the card with the expansion slot.
9 Press the card gently but firmly until the connector is fully inserted.
m Slide the card between the two levers that held the access port cover you
removed earlier. You may need to press the levers apart slightly to guide the
card between them.
m Don’t force the card. If you meet a lot of resistance, pull the card out and
try again.
m To see if the card is properly connected, pull it gently. If it resists and stays
in place, it’s connected. (Make sure you don’t pull the card so much that
you accidentally disconnect it.)
If you have other cards to install, put them in now by repeating steps 6 
through 9.
If your expansion card is
full-length, be sure that
it engages the card guide
in the computer’s interior.
Connector Expansion slot
Installing an Expansion Card 15110 Replace the retainer.
When the card is properly seated, the levers
snap into place and secure the card.
This guide on the retainer
engages the processor card
in the computer.
Snap the retainer
back into place.
Processor card
152 Appendix B11 Replace the cover on the computer.
Lower the cover all the way down onto the case. Push the cover back until it
touches the back panel.
12 Tighten the screws on the back panel.
You may now turn on the computer and use its expanded capabilities.
WARNING  Never turn on your computer unless all of its internal and
external parts are in place. Operating the computer when it is open or
missing parts can be dangerous, and can damage your computer.
Installing an Expansion Card 153Upgrading the processor
Your computer’s processor can be upgraded with the installation of a
processor upgrade card. 
To upgrade the processor, remove the old processor card following the
instructions in this chapter for opening the computer safely. Then, the new
processor card can be installed following the procedure in this chapter for
installing expansion cards. (Note that an access port cover does not need to
be removed as described in step 6 of “Card Installation” earlier in this
chapter.) 
IMPORTANT The processor card can be damaged by static electricity. To avoid
damaging the card, hold it only by the edges—do not touch the connectors or
the components on the card.
Refer to the documentation that came with the processor upgrade card for
important installation instructions specific to the card.
Processor card (behind retainer)
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Your computer keyboard contains certain special keys that typewriter
keyboards don’t have. Many of these keys allow you to give commands to 
the computer without using the mouse. For example, in many application
programs, you can press the x (Command) key at the same time as the Q key
to quit a program. 
The following table describes what you can do with the special keys on your
keyboard. The special keys on your keyboard depend on the model of
keyboard you have; some keyboards do not have all the keys listed here.
Special keys on Apple keyboards 
Arrow keys Use to move the insertion point, as an alternative to using the
pointer. In some programs, the arrow keys have other functions.
Caps Lock key Use to capitalize a series of letters (numbers and symbols 
aren’t affected).
Clear key Use to delete the current selection (or use the Delete key). 
In some programs, Clear has other functions.
x (Command) key Use in combination with other keys as an alternative to 
choosing a menu command.
continued .
num
 lock
clear
caps
 lock
Read this appendix to learn
how to use the special
keys on your keyboard.
Appendix C  
Special Keys on Your KeyboardSpecial keys on Apple keyboards (continued)
Control key In combination with other keys, this key provides shortcuts or
modifies other actions.
Delete key Use to delete selected material, or the character to the left of the
insertion point.
Enter key In a dialog box, pressing Enter is the same as clicking the
outlined button. In some programs, pressing this key confirms
information you have provided.
Escape key The function of this key depends on the program you’re using.
Function keys Some programs allow you to use the 12 function keys to give
commands. You can assign commands or action sequences to
function keys with special utility programs.
Option key Use in combination with other keys to produce special
characters or modify actions.
Numeric keys Use to produce numbers and mathematical symbols; some
programs use these keys as function keys to initiate actions.
Power key On some models, press to turn on the computer. Also press to
shut down the computer, to put the computer to sleep, or to
restart the computer.
Return key Use to move the insertion point to the beginning of the next line.
In a dialog box, pressing Return is the same as clicking the
outlined button.
Shift key Use to produce capital letters (or the upper character 
on the key).
Tab key Use to move the insertion point to the next stopping place 
(such as a tab stop or field in a dialog box or program).
Other special keys The function of these keys depends on the operating system
and program you’re using.
help home
end
ins
del
page
 up
page
 down
tab
shift
return
num
 lock
clear = /
*
7
4
0
8
5
2
9
6
3
enter
1
.
option
alt
F1
esc
enter
delete
control
156 Appendix CTyping special characters and symbols
You can type a variety of international and other special symbols and
characters (including characters with diacritical marks, such as accents) 
by pressing combinations of keys.
The Key Caps program, which is installed with your system software, shows
you the characters produced when you type certain keys and key
combinations in the fonts available on your computer. Choose Key Caps from
the Apple (K) menu, then choose the font from the Key Caps menu.
To have Key Caps show more options for special characters, press each of
these keys or key combinations: Option, Shift, Shift-Option, Shift-x, and
Option-x.
If you press the Option key, Key Caps outlines lightly the keys that you can
use in combination with letter keys to type letters with accents or other
diacritical marks.
Special Keys on Your Keyboard 157
Characters available
in the Chicago font
Characters appear 
here when you press 
keys on the keyboard 
or click them in 
the window.
Characters available
in the Chicago font
when the Option key
is pressed
The highlighted key represents the
key held down on the keyboard—
in this case, the Option key.If you see rectangles:  If you see rectangles instead of diacritical marks on
some of the pictures of keys in Key Caps, try pressing Option-x to see the
diacritical marks. However, you only need to use the Option key (not 
Option-x) in combination with the other keys to type letters with diacritical
marks.
If you press the Option key at the same time as a key for a specific diacritical
mark and then release both keys, Key Caps outlines in bold the keys for
letters that can be typed with that mark. (You’ll see that most key
combinations for diacritical marks can be used with the Space bar as well 
as letter keys—producing the mark without a letter.)
The most common diacritical marks and how to create them are summarized
next.
Diacritical mark Key combination
Grave accent ( ` ) Option-`, then type the character
Acute accent ( ´ ) Option-e, then type the character
Circumflex (^) Option-i, then type the character
Tilde (~) Option-n, then type the character
Umlaut ( ¨ ) Option-u, then type the character 
The letter “c” with a cedilla (ç) Option-c
m To type a letter or a space with a specific diacritical mark, press the Option key and
the key for the mark simultaneously. Then type the letter that needs the mark.
If you are having trouble getting a mark and letter to appear together, try
again. Be sure to press the Option key before (or at the same time as) the
key for the mark; then, after you release both keys, type the letter to be
marked.
158 Appendix CSpecial key combinations
If difficulties with your mouse or computer don’t allow you to use standard
methods of quitting a program or restarting your computer, you can try using
these special key combinations. 
To do this... …press this key combination
Force a program to quit x-Option-Esc
Force the computer to restart x–Control–Power key
Here are other key combinations you may find useful:
To do this… …press this key combination
Start a “debugging” program used by software programmers* x-Power key
Start the computer from a CD-ROM disc C key (at startup)
Ignore SCSI ID 0 (zero) x-Option-Shift-Delete
Turn off system extensions Shift key (while starting up)
Rebuild the desktop Option-x (while starting up)
*If you do not have a debugging program installed, your screen displays a caret prompt (>). To return to the desktop,
type “G.”
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AAUI Ethernet connector  64
AAUI Ethernet port  40, 41
About Apple Extras file  24
accent marks, typing  157–158
access covers for expansion slots  41
access port cover  150
active program  17, 69–70
acute accent (´), typing  158
ADB ports. 7, 8, 41, 94
air circulation around computer
components  135
America Online, obtaining Apple
software updates from  108
Apple-authorized service providers
adding internal drives  63
attaching devices to the internal SCSI
interface  59
damaged equipment  93, 95, 98
ejecting floppy disks  90, 140
hard disk initialization failure  
111, 115
installing additional memory  63
installing expansion cards  145
interference with radio or television
reception  vi
liquid spills on keyboard  136
removing extra built-in SCSI
terminators  61
repair service  82, 83
replacing the clock battery  86
“sad Macintosh” icon on screen  88
servicing the power supply  140
AppleCD Audio Player program  75, 
76, 98
Apple Desktop Bus (ADB) ports  7, 8,
41, 94
Apple Extensions Manager  69
AppleLink, obtaining Apple software
updates from  105
Apple PlainTalk Microphone, connecting
2, 45–46
AppleScript program  67
Apple software updates, obtaining
104–108
AppleTalk control panel  65
Application menu
activating the Finder  28, 35
Hide Others/Show All commands  70
identifying the active program  17,
69–70
switching programs  17, 70
application programs
active and open  69–70
“can’t be found” message  72, 95
161
Index
If you can’t find what you’re looking for
in this index, look in Macintosh Guide—
available in the Guide (h) menu 
on your computer.“can’t be opened because a file can’t
found” message  72, 96
compatibility with older Macintosh
programs  96
installing  67–69
memory problems  91
not installed with the Installer program
119, 122
opening  17
Power Macintosh “native”
applications  71–72
switching  70
won’t start or quit unexpectedly  91
arrow keys  155
arrow pointer
“freezes” and won’t move  23, 81–82,
93, 102
moving  15–16
Ask Apple Online Technical Support
service  105–106
At Ease  98
audio cables  50–57
audio CDs
adjusting volume control  48, 101
playing  76
troubleshooting  101–102
audio equipment, connecting  42–48
Audio File Access CD-ROM 
extension  100
Audio In/Out ports (on video equipment)
51–53, 55–57
Audio In port (on stereo speakers)  47
audio input/output ports (on computer)
41, 42, 45, 51–53, 55–57
automatic startup/shutdown  20
A/V panel  42
B
backing up
files and disks  71
programs  68
Balloon Help  36
battery in computer’s clock, replacing  86
blinking question mark icon,
troubleshooting  86–87, 116
“bomb” icon/message, troubleshooting
81, 83, 92, 102
BOOTP bootstrapping protocol  65
brightness control on monitor  13, 
85, 136
C
cables
audio  45, 50–57
checking connections  85, 93
keyboard  2, 7–8
monitor  2, 6
mouse  7–8, 93
network  64
safety instructions for  135
SCSI  59–61, 62
stereo speaker  47
video  50–57
Caps Lock key  155
carpal tunnel syndrome  130
CD-ROM discs
can’t open a document on  100
damaged  100
ejecting  75
eject unexpectedly  100
icon doesn’t appear on desktop  99
inserting  68, 74
overview  73
playing audio CDs  76
problems using ISO 9660 or High
Sierra discs  101
removing scratches on  100
safety instructions for  138–139
saving changed information  100
starting At Ease from  98
“This is not a Macintosh disk: Do you
want to initialize it” 
message  100
using Photo CDs  77
CD-ROM disc that contains system
software, starting the computer
from  110
162 IndexCD-ROM drive
computer won’t restart after copying
software to System Folder  
90, 97
computer won’t restart with a disc in
the drive  86, 90
icon doesn’t appear on screen  97
illustration  40
opening/closing the tray  74, 75, 98
safety instructions for  vii, 139
software problems  90, 97
CD-ROM software, installing  125–126
cedilla (ç), typing  158
chair, adjusting for optimal support and
comfort  131
circumflex (^), typing  158
C key (at startup), to start from a CDROM disc  159
cleaning computer equipment  141–143.
See also safety instructions
clean installation of system software
119–123
Clear key  155
clock in computer keeps time
inaccurately  86
close box  18
in Macintosh Guide  34, 35
closing the cover on the computer  153
x (Command)-Control-Power keys, to
restart the computer  83, 159
x (Command)-E keys, to eject a CDROM disc  75
x (Command) key  155
x (Command)-Option-Esc keys, to quit a
program  83, 93, 159
x (Command)-Option keys, to rebuild
the desktop  84, 159
x (Command)-Option-p-r keys, to restart
the computer  85
x (Command)-Option-Shift-Delete keys,
to ignore SCSI ID 0 (zero)  159
x (Command)-Power keys, to start a
debugging program  159
x (Command)-Shift-1 keys, to eject a
floppy disk  89, 140
x (Command)-Shift-K keys, to start a
clean installation of system
software  121
composite video connections
for input from a camera  53
for input from a VCR  52
for output from the computer  56
for using a television as a monitor  57
composite video connectors  49, 50. 
See also RCA-type connectors
composite video input/output ports (on
computer)  41–42, 51–53, 55–57
CompuServe, obtaining Apple software
updates from  107
computer components. See equipment
computer power cord  2, 3
connecting
audio equipment  42–48
the computer  3
external stereo speakers  47–48
a microphone  45–46
a monitor  4–6
the mouse and keyboard  7–8
to a network  64–65
SCSI devices  59–62
video equipment  48–58
connectors
AAUI Ethernet  64
miniplug  43, 44, 47
RCA-type  44, 49, 50, 54
safety instructions for  135
S-video  49, 50, 54
Control key  156
control panels
AppleTalk  65
Energy Saver  19–20, 136
Extensions Manager  84, 91, 92, 100,
103
Memory  91, 96
Monitors  85
PC Exchange  95, 96
Sound & Displays  48
TCP/IP  65
turning off  91, 92
cumulative trauma disorders (CTDs)  130
Index 163customer service
obtaining Apple software updates
104–108
support hotline  24
custom installation of system software
123–125
Custom Install dialog box  124, 126
D
Delete key  156
desktop
At Ease and  98
rebuilding  84, 89, 95
device drivers, SCSI  62
DHCP bootstrapping protocol  65
diacritical marks, typing  157–158
diagnosing problems. See Appleauthorized service providers;
error messages; troubleshooting
dialog boxes
Custom Install  124, 126
Easy Install  118, 121–122
Energy Star  11, 19
DIMMs. See Dual Inline Memory
Modules (DIMMs)
dim screen  20, 85, 136
disconnecting the computer  3, 134
Disk First Aid program
installing system software  117, 120
repairing damaged disks  114–115
disks. See CD-ROM discs; floppy disks;
hard disk
Disk Tools disk, starting the computer
from  110
disk with an X icon  87
display. See monitor; screen
documents. See also files
can’t open  95
opening DOS documents on the
Macintosh  95, 96
DRAM. See dynamic RAM
drivers
printer  104
SCSI device  62
Drive Setup program
hard disk icon doesn’t appear  88
initializing a hard disk  109, 111
overview  67
testing a hard disk  113–114
updating the hard disk  117, 120
Dual Inline Memory Modules 
(DIMMs)  63
dual RCA-type connectors  44, 50–52,
54–55, 57
dynamic RAM, adding  63
E
Easy Access, turning off  94
Easy Install dialog box  118, 121–122
Eject CD command (AppleCD Audio
Player File menu)  75, 98
ejecting
CD-ROM discs  75, 98
floppy disks  89–90, 140
electromagnetic emissions from computer
monitors  133
Energy Saver control panel  19–20, 136
energy-saving options, setting  11, 
19, 136
Energy Star dialog box  11, 19
Enter key  156
equipment
arranging to prevent discomfort
131–132
cleaning  141–143
guidelines for handling  135–139
illustration  2, 40–41
setting up  1–8
error messages. See also troubleshooting
“Application program can’t be found”
72, 95
“Application program can’t be opened
because a file can’t be found”
72, 96
blinking question mark icon  
86–87, 116
“bomb” icon/message  81, 83, 92, 102
“Can’t open a document...”  95
164 Index“Could not create a socket”  65
disk with an X icon  87
“Not enough memory”  72, 91
“sad Macintosh” icon  88
“This is not a Macintosh disk: Do you
want to initialize it?”  100
“Unable to locate host”  65
what to do about  81, 82–83, 92
Escape key  156
Ethernet network, connecting to  64–65
Ethernet ports  40, 41
eWorld program  67, 105–106
expansion card
installing  145–154
power requirements of  146
expansion slots  145, 151
access covers for  41
extended miniplugs  43
Extensions Manager control panel  84,
91, 92, 100, 103
external stereo speakers, connecting
47–48
eye fatigue from computer use  129, 
131, 133
F
fatigue, tips for avoiding  133
FDDI networks  64
File menu
Eject CD command (AppleCD Audio
Player program)  75, 98
Put Away command  75, 98
files. See also documents
backing up  71
file sharing, CD-ROM discs and  78
Finder, activating  28, 35
floating-point unit (FPU)  91
floppy disk drive, illustration  40
floppy disks
backing up  71
can’t eject  89–90, 140
computer can’t read  89
repairing  114–115
safety instructions for  137
folders. See System Folder; 
Utilities folder
Foreign File Access extension  100, 101
formatting a hard disk  109–111
frozen pointer  93
Function keys  156
furniture, arranging to prevent discomfort
131–132
G
graphics, using Photo CDs  77
grave accent (`), typing  158
grounding the computer  3, 135
Guide menu. See also Macintosh Guide
Shortcuts command  37–38
Show/Hide Balloons command  36
using  16, 17, 24, 27–28
H
hard disk
backing up files on  71
can’t start up from  112–113
icon doesn’t appear on screen  88–89,
112–113
initializing  109–111
repairing  112–115
testing  113–114
using space as virtual memory  71
hard disk drive, illustration  40
health-related information about
computer use  129–133
help. See Apple-authorized service
providers; Balloon Help;
customer service; Macintosh
Guide; troubleshooting
Hide Balloons command (Guide menu)
36
Hide Others command (Application
menu)  70
hiding/showing windows on the 
desktop  70
High Sierra CD-ROM discs, problems
using  101
“Huh?” button, Macintosh Guide  35
Index 165I, J
icons
ADB  7, 8
application program  18
blinking question mark  86–87, 116
“bomb”  81, 83, 92, 102
defined  17, 18
Disk First Aid  114, 117, 120
disk with an X  87
document  18
don’t appear correctly on screen
88–89, 98–99
Drive Setup  111, 113
folder  18
hard disk  12, 18, 88–89
“sad Macintosh”  88
SCSI  59
sound input/output ports  43
Trash  12, 17, 18
ID numbers. See SCSI ID numbers
Index button, Macintosh Guide  29,
31–32
initializing a hard disk  109–111
inserting CD-ROM discs  68, 74
insertion point, setting  94
Installer program  118, 120
installing
additional RAM  62–63
application programs  67–69
CD-ROM software  125–126
expansion card  145–154
internal drives  63
system software  116–125
interference with radio or television
reception  vi, 136
internal drives, installing  63
international characters and symbols,
typing  157–158
Internet
configuring your system for  65
obtaining Apple software updates
from  107–108
ISDN networks  64
ISO 9660 CD-ROM discs, problems
using  101
K
keyboard
connecting  7–8
illustration  2, 40
positioning  131–132
safety instructions for  136
special keys on  155–156
typing produces nothing on screen
94–95
keyboard cable
checking connections  93, 94
connecting  7–8
illustration  2
keyboard shortcuts  37–38, 159
keyboard tray  132
Key Caps program  157–158
L
learning the basics  15–16
liquid spills on the computer equipment
134, 135, 136, 138, 139
LocalTalk network, connecting to  64–65
locking/unlocking the mouse  143–144
Look For button, Macintosh Guide  29,
33–34
M
Macintosh Guide
activating the text box  33
closing  34, 35
going to the next step  30, 32, 34
“Huh?” button  35
Index button  29, 31–32
Look For button  29, 33–34
moving the window out of the way  35
returning to the main window  30, 
32, 35
Topics button  29–30
using the scroll bar  31
using the slider  31
using the zoom box  35
Macintosh Shortcuts  37–38
166 IndexMacintosh Tutorial  15–16
memory. See also RAM
expanding  62–63
“not enough memory” message  72, 91
shared libraries and  72, 96
virtual  71
Memory control panel  91, 96
menu bar  17
menu, opening  16, 17
microphone, connecting  2, 45–46
miniplugs  43, 44, 47
modem port (GeoPort)  40, 41
moisture or wetness, computer exposure
to  134, 135, 139
monitor. See also screen
brightness control  13, 85, 136
cleaning  141
connecting  4–6
electromagnetic emissions from  133
illustration  2, 40
positioning  4, 132
safety instructions for  136
turning on  11
using a television as  57
monitor cable  2, 6
monitor port  6, 41
monitor power cord  2, 4–5
monitor power socket  41
Monitors control panel  85
mouse
cleaning  141–143
connecting  7–8
illustration  2, 40
learning to use  15–16
locking/unlocking  143–144
proper positioning of  132
troubleshooting  93
mouse button  15–16
mouse cable
checking connections  93
connecting  7–8
mouse pad  15
mouse shortcuts  37–38
musculoskeletal discomfort from
computer use  129, 130, 133
N
network cables, connecting  64
networks
backing up files on  71
connecting to  64–65
sharing a CD-ROM disc on  78
network server options, sleep state 
and  20
normal installation of system software
117–119
Numeric keys  156
O
office furniture, arranging to prevent
discomfort  131–132
online help. See Balloon Help; Guide
menu; Macintosh Guide
online services, obtaining Apple software
updates from  104–108
Open/Close button on CD-ROM drive
40, 74, 75, 98
opening the computer  146–147
Option key  156
Key Caps program and  157–158
P
parameter RAM  85
PC Exchange control panel  95, 96
PCI. See Peripheral Component
Interconnect (PCI) cards
performance decreases after adding
software, troubleshooting  103
Peripheral Component Interconnect (PCI)
cards  64, 145
Photo CDs  77, 102
pointer. See arrow pointer
ports
AAUI Ethernet  40, 41
ADB  7, 8, 41, 94
Audio In (on stereo speakers)  47
Audio In/Out (on video equipment)
51–53, 55–57
Index 167audio input/output (on computer)  41,
42, 45, 51–53, 55–57
composite video input/output  41, 42,
51–53, 55–57
illustration  40–41
monitor  6, 41
SCSI  40, 41, 59, 62
sound input/output  40–41, 43, 
45–47, 55
S-video In/Out (on video equipment)
51–52, 55–57
S-video input/output (on computer)
40–42, 51–52, 55, 57
Video In/Out (on video equipment)
52–53, 55–57
power button  13, 23, 40, 84
power cords
checking connections  85
frayed  134
illustration  2, 3, 5
plugging in  3, 5
Power key
illustration  10, 40, 156
putting the computer to sleep  20, 156
restarting the computer  83, 156
starting the computer  10, 156
turning the computer off  21, 23, 156
Power Macintosh “native” application
programs  71–72
power-on light  13, 40
PowerPC microprocessor  ix
power sockets  41
power supply  140, 148
PowerTalk program  67
PRAM. See parameter RAM
presentations, using the Macintosh for
57–58
Previous System Folder  121, 123
printer port (GeoPort)  40, 41
printer problems  104
problems. See Apple-authorized service
providers; customer service;
error messages; troubleshooting
processor card, upgrading  145, 154
programs. See application programs
Put Away command (File menu)  75, 98
Q
question mark icon, troubleshooting
86–87, 116
quitting a program if you’re having
trouble  83
R
radio or television reception, interference
with  vi, 136
RAM. See also memory
expanding  62–63
resetting parameter RAM  85
RCA-type connectors  44, 49, 50, 54
Read Me files  24, 68
read-only memory, defined  73
rebuilding the desktop  84, 89, 95
reinstalling
CD-ROM software  125–126
system software  116–125
repairing damaged disks  112–115
repetitive stress injuries (RSIs)  130
Restart command (Special menu)  83
restarting the computer  85, 156, 159
retainer for processor card  149, 152
Return key  156
S
“sad Macintosh” icon on screen,
troubleshooting  88
safety instructions
CD-ROM drive  vii
cleaning equipment  141–143
connecting additional equipment  39
connecting a SCSI device  62
ejecting CDs using a paper clip  98
ejecting floppy disks using a paper
clip  90, 140
168 Indexgeneral precautions  134–135
grounding the computer  3, 135
handling and care of equipment
135–139
installing additional memory  62–63
installing an expansion card  145–154
liquid spills on computer equipment
134, 135, 136, 138, 139
locking/unlocking the mouse
143–144
saving documents if you’re having
trouble  83
screen. See also monitor
dark, troubleshooting  85
dimming  20, 136
minimizing glare and reflections  
132, 133
positioning  4, 132
screen saver programs  85, 136
scroll arrows  18
scroll bar, Macintosh Guide  31
SCSI cables  60–61, 62
SCSI devices
computer doesn’t recognize  86, 97
connecting  59–62
SCSI ID numbers
setting  60
troubleshooting and  88, 97, 112–113
SCSI internal interface  59
SCSI port  40, 41, 59, 62
SCSI terminator  61
security lock ports  41
shared disks  71, 75, 78
shared libraries  72, 96
Shift key  156, 159
Shortcuts command (Guide menu)
37–38
Show All command (Application 
menu)  70
Show Balloons command (Guide 
menu)  36
showing/hiding windows on the 
desktop  70
Shut Down command (Special menu)
22–23
shutting down the computer  20, 21–23
size box  18
Sleep command (Special menu)  20
sleep state  12, 20
slider, Macintosh Guide  31
Small Computer System Interface. 
See SCSI
software updates, obtaining  104–108
Sound & Displays control panel  48
sound input/output ports  40, 41, 43,
45–47, 55
speaker on computer, illustration  40
speakers, connecting external stereo
speakers  47–48
special characters and symbols, typing
157–158
special keys  155–156, 159
Special menu
Restart command  83
Shut Down command  22–23
Sleep command  20
starting the computer  20, 83–84
startup disks
initializing  109–111
rebuilding the desktop and  84
troubleshooting  87, 89
static electricity
discharging  148
handling the processor card  154
stereo miniplugs  43, 44, 47
stereo speakers  47–48
sunlight, computer exposure to  135
S-video connections
for input from a camera  52
for input from a VCR  51
for output from the computer  55
for using a television as a monitor  57
S-video connectors  49, 50, 54
S-video In/Out ports (on video
equipment)  51–52, 55–57
S-video input/output ports (on computer)
40–42, 51–52, 55, 57
switching programs  17
Index 169symbols and international characters,
typing  157–158
System Backup Disk 1 disk, starting the
computer from  110
system extensions
not installed with the Installer program
119, 122
turning off  69, 91, 92
System Folder
clean installation of system software
and  119, 121, 123
dragging extras to the Trash  69
replacing special software  123
shared libraries  72
system software
installing/reinstalling  116–125
troubleshooting  86–88, 92–94, 116
T
Tab key  156
TCP/IP control panel  65
television, connecting for use as a
monitor  57–58
television or radio reception, interference
with  vi, 136
temperature limits for floppy disks  137
10BASE-T Ethernet connector  64
10BASE-T Ethernet port  40, 41
terminators, SCSI  61
text box, Macintosh Guide  33
Text-to-speech software  67
tilde (~), typing  158
title bar of a window  18
TokenRing networks  64
Topics button
Macintosh Guide  29–30
Macintosh Shortcuts window  37, 38
Trash  18
triple RCA-type connectors  50, 52–54,
56–57
troubleshooting. See also error messages
application program problems  69, 91,
95–96
arrow pointer “freezes” on screen  23,
81–82, 93, 102
audio CD problems  101–102
CD-ROM disc problems  99–100
CD-ROM drive problems  90, 97–99,
125
computer’s clock keeps time
inaccurately  86
desktop looks unusual  98
diagnosing problems  82–83, 92
floppy disk problems  89–90, 140
hard disk problems  88–89, 109–114
icons don’t appear correctly on
desktop  88–89, 98–99
interference with radio or television
reception  vi, 136
keyboard problems  94–95
memory problems  71, 72, 91, 96
mouse problems  93
network configuration problems  65
opening DOS documents on the
Macintosh  95, 96
performance decreases after adding
software  103
Photo CD problems  102
printer problems  104
problems turning on the computer  13
screen is dark  85
SCSI devices not recognized  86, 97
shared library problems  72, 96
startup disk problems  87, 89
system software problems  86–88,
92–94, 116
typing produces nothing on screen
94–95
turning off
the computer  21–23
control panels  91, 92
Easy Access  94
system extensions  69, 91, 92, 103
virus detection programs  69
170 Indexturning on
the computer  9–13
external SCSI devices  62
Foreign File Access/Audio File
Access CD-ROM 
extensions  100
the monitor  11
system extensions  69, 103
virtual memory  91
tutorial  15–16
typing produces nothing on screen,
troubleshooting  94–95
U
umlaut (ü), typing  158
unlocking/locking the mouse  143–144
unsaved work, losing  23
updated software, obtaining  104–108
upgrading the processor  145, 154
Utilities folder
Disk First Aid  114, 117
Drive Setup  111, 113
V
ventilation around computer 
components  135
ventilation openings on computer and
monitor  136
video cables  50–57
video camera, connecting for input
50–53
videocassette recorder (VCR)
connecting for input  50–53
connecting for output  54–56
video formats  48
video In/Out ports (on video equipment)
52–53, 55–57
video RAM, expanding  63
videotape, recording computer output on
54–56
virtual memory  71, 91
virus detection programs  69
volume control
for AppleCD Audio Player  101
for external speakers  48, 101
VRAM. See video RAM
W, X, Y
waking the computer  12, 20
warranty on computer  82, 145
wetness or moisture, computer exposure
to  134, 135, 139
windows
hiding and showing  70
working with  18
work space, arranging to prevent
discomfort  131–132
Worldwide Web server (Internet),
obtaining Apple software
updates from  108
Z
zoom box, Macintosh Guide  35
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manualFetchingWhenRoaming ã? a8?c¥«ª?Ù};?v!???¿/CÏ
44?JK?!§�©ª
maxGracePeriod ©\ a8?c/?®*j=?¬\( Ç� aó
|ä?8c=|ä 0O ?Ù Ç�h??Û
=?¬
EmailAccountDescription \?´a8?c4?8Ì????�?º»1à!
0??3( 0¥±3q4ÀÁ?
EmailAccountName \?´a8?c�?E4?no!PË????(
%&)t:?4?no
EmailAccountType \?´aJchï?  EmailTypePOP (
EmailTypeIMAP«Ñ45µ�?
EmailAddress \?´aJcD«�?E????)úbdÙÚ
`Û?B!?¾º»[?À?¥¦:jà=?\
?´
IncomingMailServerAuthentication \?´aJcD«±L??Ó«túhï? 
EmailAuthPassword ( EmailAuthNone
IncomingMailServerHostName \?´aJcD«±?ef?T,no a IP )úc
IncomingMailServerPortNumber ©\ a8?cD«±?ef?$W�bd	D«$W
�k:�4Ì«=|$W
IncomingMailServerUseSSL ã? a8?c=|ä 0YES3D«±?ef? +�
4 SSL HIÓ«
IncomingMailServerUsername \?´aJcD«????�?4?no ar?
???)ú? @ ?�órpcbdÙÚ`Û?
B!B¶�?C¥±ä??X±L????HIÓ«
?¾º»[?À?¥¦/jà=?\?´
IncomingPassword \?´a8?c±?ef?¬u°FP?¬º»
[?�4
OutgoingPassword \?´a8?cË?ef?¬u°FP?¬º»
[?�4
OutgoingPasswwordSameAsIncomi
ngPassword
ã? a8?c¥«ª/°jà4?=?¬Ø
/C45Ë;??(±??
OutgoingMailServerAuthentication \?´aJcD«Ë???Ó«túhï? 
EmailAuthPassword ( EmailAuthNone
OutgoingMailServerHostName \?´aJcD«Ë?ef?T,no a IP )úc© B     69
Web Clip 
Web Clip ÙÚ`Û ? PayloadType  com.apple.webClip.managed ?D«Ã
%?ÙÙÚ`Ûp¥±{&ÙÚ`Û«Ñ%óôø
0ÇÈ3ÙÚ`Û ? com.apple.applicationaccess PayloadType ?D«Ã%
?ÙÙÚ`Ûp¥±{&ÙÚ`Û«Ñ%óôø
OutgoingMailServerPortNumber ©\ a8?cD«Ë?ef?$W�bd	D«$W
�kî5!Á�4$W 25b 587 ( 465
OutgoingMailServerUseSSL ã? a8?c=|ä 0YES3D«Ë?ef? +�
4 SSL HIÓ«
OutgoingMailServerUsername \?´aJcD«????�?4?no ar?
???)ú? @ ?�órpcbdÙÚ`Û?
B!B¶�?C¥±ä??XË?????HIÓ«
?¾º»[?À?¥¦:jà=?\?´
URL \?´aJcDî Web Clip ? Web Clip qµÁÊ
URLµ URL JKó HTTP  HTTPS Ê�+k/9¶v
Label \?´aJc1à!T23T Web Clip no
Icon ©ªa8?c?1à!T23T PNG x%??qµä
59 x 60 ÀÁbdD«/1àÞ�tÆ
IsRemovable ã? a8?cbd¥«ä 0No3k4?9ÂÃ Web 
ClippbdÂÃº»[?k/CÂÃ
allowAppInstallation ã? a8?c³ä 0FALSE3? App Store :CÏ4B
¶%x:gT23®¡4?/²@?¾?�&Oq4
ÀÁ
allowCamera ã? a8?c³ä 0FALSE3?p,:CÏ4B
¶%x:gT23®¡4?/²@/5
allowExplicitContent ã? a8?c³ä 0FALSE3?g iTunes Store ¦§
¨PQRS:C©ª³ iTunes Store «¨
?j', ab¬Jkc:/Ogä¨
allowScreenShot ã? a8?c³ä 0FALSE3?4?/²@BA1à
22345
allowYouTube ã? a8?c³ä 0FALSE3? YouTube q4ÀÁ:C
Ï4B¶%x:gT23®¡70 © B    
LDAP 
LDAP ÙÚ`Û ? PayloadType  com.apple.ldap.account ?D«g LDAP �
?L LDAPSearchSettings B!Xð´�8ó/ LDAP  v\??
SearchSettings Xä¿zà\??g%Ê¤67äDó$67Z[aä
Db?äDôÎäDb?äD?ÙôÎäDcÃ%?ÙÙÚ`Ûp
¥±{&ÙÚ`Û«Ñ%óôø
allowiTunes ã? a8?c³ä 0FALSE3?iTunes Music Store :C
Ï4B¶%x:gT23®¡4?/9wb¦§ô
Û
allowSafari ã? a8?c³ä 0FALSE3? Safari Web 'Ý?q4
ÀÁ:CÏ4B¶%x:gT23®¡h9O-.%4
?ÁÊ Web Clip
LDAPAccountDescription \?´a8?c�?º»
LDAPAccountHostName \?´aJcT,
LDAPAccountUseSSL ã? aJc +?�4 SSL
LDAPAccountUserName \?´a8?c4?no
LDAPAccountPassword \?´a8?cu°FP?¬º»[?�4
LDAPSearchSettings "×?Xä?�?8óÙh�??ð??qµ??
Ù?�?? ÙÚ
LDAPSearchSettingDescription \?´a8?c67¥±º»
LDAPSearchSettingSearchBase \?´aJcg_#TÉD LäD5Móg
0ou=people,o=example corp3Ê¤67
LDAPSearchSettingScope \?´aJc«Ñ?!67?�4f$Ô
8ó óô 3 ????ø
LDAPSearchSettingScopeBaseø° ? SearchBase DÂ\
äD
LDAPSearchSettingScopeOneLeveløäD?T%\?
äD
LDAPSearchSettingScopeSubtreeøäD?T?Ù?äDn
%ubø© B     71
CalDAV 
CalDAV ÙÚ`Û ? PayloadType  com.apple.caldav.account ?D«Ã%
?ÙÙÚ`Ûp¥±{&ÙÚ`Û«Ñ%óôø
CalSub ÙÚ`Û ? PayloadType  com.apple.subscribedcalendar.account ?D«
Ã%?ÙÙÚ`Ûp¥±{&ÙÚ`Û«Ñ%óôø
SCEP 
SCEP a>??+cÙÚ`Û ? PayloadType  com.apple.encryptedprofile-service ?D«Ã%?ÙÙÚ`Ûp¥±{&ÙÚ`Û«Ñ
%óôø
CalDAVAccountDescription \?´a8?c�?º»
CalDAVHostName \?´aJcef?)ú
CalDAVUsername \?´aJc4?aUno
CalDAVPassword \?´a8?c4?¬
CalDAVUseSSL ã? aJc +?�4 SSL
CalDAVPort ©\ a8?c?Lef?$W
CalDAVPrincipalURL \?´a8?cDÂ4?ÜÝ URL
SubCalAccountDescription \?´a8?c�?º»
SubCalAccountHostName \?´aJcef?)ú
SubCalAccountUsername \?´a8?c4?aUno
SubCalAccountPassword \?´a8?c4?¬
SubCalAccountUseSSL ã? aJc +?�4 SSL
URL \?´aJc
no \?´a8?c8C SCEP ef?æ*Äø\?´á
b89 &b example.org Ìnbd?UË,è
Ùð? CA ?\{845'Ö??
TW ©Õ a8?czàä OID ©Õ(? X.500 noº»
áb/C=US/O=Apple Inc./CN=foo/1.2.5.3=bar/CÅ?äø
[ [ [“C”, “US”] ], [ [“O”, “Apple Inc.”] ], ..., [ [“1.2.5.3”, “bar”] ] ]
OID 8CzàäVD©\¶ÙóôÂèøCb Lb STb
Ob OUb CNa#' / )*b?!)b? / (bÕ@bÕ@?
8b4noc72 © B    
SubjectAltName 
SCEP ÙÚ`Û8óD«?8? SubjectAltName \?ój' CA UË??
?	8óÌ??1D«??\?´\?´©ÕD«?§ù5?�4
 CAp89:éî DNS nob URL ?????Ù´àáwßr 78Ð
0z{ 3 SCEP :@ef?qàá3
GetCACaps 
bd	??VÙ GetCACaps 1\?¥¦:�4	j'\?´väÙ´
	 CA ?9)UV¢+k¥¦:Â CA üO GetCACaps B�4q?
!q*bd CA ?Ùq¥¦:=|ä GET 3DES ( SHA-1 ?
APN 
APN a§¨DnocÙÚ`Û ? PayloadType  com.apple.apn.managed ?D«
Ã%?ÙÙÚ`Ûp¥±{&ÙÚ`Û«Ñ%óôø
WÚ \?´a8?c¿ÈÉ¬Ê
Keysize ©\ a8?ckeysize ó8ä?88ó  1024  2048
Key Type \?´a8?c³r¤õä 0RSA3
Key Usage ©\ a8?czà¬Ê4781 zàÍn 4 z
à?¬5 zàÍn(?¬j� CA ab Windows CAcu
ÐÑ?¬Ínj ?ÐÑn*
DefaultsData \? aJc\?êÙnÕ1/ ?X
DefaultsDomainName \?´aJc?hï? 
com.apple.managedCarrier
apns ©Õ aJc©ÕêÙÄ?©\???\?º»
? APN °±Oéêóô1 / ?X
apn \?´aJc\?´D«§¨Dno
username \?´aJc\?´D« APN 4?nobd?
???¾º»[?À?¥¦:jà=??
password ©ª a8?c©ªzà APN 4?¬45+,&
þP¼bdÙÚ`Û?????¾º»[?À
?¥¦:jà=??
proxy \?´a8?c APN yæ IP )ú URL
proxyPort ©\ a8?cAPN yæ$W�© B     73
Exchange 
Exchange ÙÚ`Û ? PayloadType  com.apple.eas.account ?D«ÙÚ`
Û:!¥¦T¸¹? Microsoft Exchange �?Ã%?ÙÙÚ`Ûp¥±
{&ÙÚ`Û«Ñ%óôø
VPN 
VPN ÙÚ`Û ? PayloadType  com.apple.vpn.managed ?D«Ã%?Ù
ÙÚ`Û8p¥±{& VPN ÙÚ`Û«Ñ%óô1
!"×b1 0PPP3( 0IPSec3ôÙn?89B!\?ôº»hn?\
?1ó$�4%h�1 VPNType ?
EmailAddress \?´aJcbdÙÚ`Û?B!?¾º»[?
À?¥¦:jà=?\?´D«�?E????
)ú
Host \?´aJcD« Exchange ef?T,no a IP 
)úc
SSL ã? a8?c=|ä 0YES3D« Exchange ef? 
+�4 SSL HIÓ«
UserName \?´aJc\?´D« Exchange �?4?n
obd??\?´?¾º»[?À?¥¦:jà
=?\?´
¬ \?´a8?c�?¬u°FP?¬º»[?
�4
Certificate 8?Ò45hï? a�4 NSData -.@Ô .p12 
???cHIÓ«�?
CertificateName \?´a8?cD«?noº»
CertificatePassword 8?Ò45 p12 ???J¬u°FP?¬º
»[?�4
UserDefinedName \?´VPN º»:1à!¥¦T
OverridePrimary ã?D« + VPN WË;?ÙUbdµ?ä
0TRUE3?Ù??U¿: VPN Ë;
VPNType \?´ù«ÙÚ`Û?8458 VPN ¥±
8óÙs?89?ø0L2TP3b0PPTP3 0IPSec3
Özà L2TPb PPTP ( Cisco IPSec74 © B    
PPP 
óô/Á45 PPP 8 VPN ÙÚ`Û
IPSec 
óô/Á45 IPSec 8 VPN ÙÚ`Û
AuthName \?´VPN �?4?no45 L2TP ( PPTP
AuthPassword \?´a8?cu³ TokenCard ä 0FALSE3?M8Ì
45 L2TP ( PPTP
TokenCard ã? +�4ÚHab RSA SecurIDcHI4
5 L2TP
CommRemoteAddress \?´VPN ef? IP )úT,no45 L2TP (
PPTP
AuthEAPPlugins ©Õu³�4 RSA SecurID ?MB!!hI>?ôµ
©ÕêÙ???h??? êÙ? 0EAP-RSA3\
?´45 L2TP ( PPTP
AuthProtocol ©Õu³�4 RSA SecurID ?MB!!hI>?ôµ
©ÕêÙ???h??? êÙ? 0EAP3\?
´45 L2TP ( PPTP
CCPMPPE40Enabled ã?wß CCPEnabled ô0n45 PPTP
CCPMPPE128Enabled ã?wß CCPEnabled ô0n45 PPTP
CCPEnabled ã??4?¬bd1( CCPMPPE40Enabled ä
0TRUE3kzà???¬ÎÖàbd1(
CCPMPPE128Enabled ä 0TRUE3kzà\??¬ÎÖb
d	�4?¬k?Ù? CCP 1ä 0TRUE345 PPTP
RemoteAddress \?´VPN ef? IP )úT,no45 Cisco 
IPSec
AuthenticationMethod \?´ 0SharedSecret3  0Certificate345
L2TP ( Cisco IPSec
XAuthName \?´VPN �?4?no45 Cisco IPSec
XAuthEnabled E©bd XAUTH ä ON kä 1 àbd XAUTH ä OFF kä
045 Cisco IPSec
LocalIdentifier \?´u³ AuthenticationMethod ÷5 SharedSecret ?M
:B!?�4ÕÖnobd�4 0	FÓ«3k
\?´JKó 0[hybrid]3Ý¶45 Cisco IPSec
LocalIdentifierType \?´u³ AuthenticationMethod ÷5 SharedSecret ?M
:B!µ?  0KeyID345 L2TP ( Cisco IPSec
SharedSecret ©ª VPN �?ÈÉ¬Êu³ AuthenticationMethod 
÷5 SharedSecret ?M:B!45 L2TP ( Cisco IPSec© B     75
Wi-Fi 
Wi-Fi ÙÚ`Û ? PayloadType  com.apple.wifi.managed ?D«µ?º»?
 0  PayloadVersion ?Ã%?ÙÙÚ`Û8p¥±{&ÙÚ`Û
«Ñ%óô1
X5 802.1X ?6Î??JKj' EAPClientConfiguration \?
EAPClientConfiguration 
Ã%W?¬8{&89: 0EAPClientConfiguration3¬ÊäÌ«
??D«??6Îº»[?bdB!®? êÙóô1\?
PayloadCertificateUUID \?´? UUID45�?X?u³
AuthenticationMethod ÷5 Certificate ?M:B!45
Cisco IPSec
PromptForVPNPIN ã?? +jà=? PIN45 Cisco IPSec
SSID_STR \?´?�4 Wi-Fi ?? SSID
HIDDEN_NETWORK ã?Ã SSID &¥¦�4¯°8(?¬8÷U
VÉÖ??=|>?ô«°±?Ù??¿ ÊR
¯°?D«©ª??	?Ì1
0HIDDEN_NETWORK31?ã?
EncryptionType \?´0EncryptionType389?  0WEP3b0WPA3
 0Any30WPA3Xq WPA ( WPA2q45hnI?¬
8S«h�???§¨D?9?°bd	
S«?¬8 I*	?23q45?Ù?¬8
�4? 0Any3
¬ \?´a8?c??¬:-.??C?LP²??
[z?Lµ???4?\õ:Cjàj'¬
UserName \?´a8?cÃm	²cWS4?no+k3?
/:?!ñ?°±?HIÓ«?4?8ó=?
UV
AcceptEAPTypes E©?©Õóôh� EAP 8:CÀø
13 = TLS
17 = LEAP
21 = TTLS
25 = PEAP
43 = EAP-FAST76 © B    
EAP-Fast 
! EAPClientConfiguration \?? EAP-FAST eC�4óô3?
h�1µT Ù×Øøbd EAPFASTUsePAC ä 0FALSE3k:x%&n
?3?8S)bd EAPFASTProvisionPAC ä 0FALSE3k:x
EAPFASTProvisionPACAnonymously
PayloadCertificateAnchorUUID \?´©Õa8?cÓÖCUÄHIÓ«???
??¿JKéê?ÙÚ`Û UUID�418-.¥
¦O¨4? +UÄ?[??
bdD«%3?k?UÄ a?X®c:CÏ4Ã
m TLSAllowTrustExceptions OCD«%? 0TRUE3
TLSTrustedServerNames \?´?©Õ a8?ch 9ØCÀef??4
no[z	8ó�4°?ÉD«nob
wpa.*.example.combdef??![z?/
:CUÄ
!??�4 TLSTrustedCertificates ÕF�4>?ô
µ3?84??)¶¥«?Ì«??UÄ�?
B±²?UÄ?
bdD«%3?k?UÄ a?X®c:CÏ4Ã
m TLSAllowTrustExceptions OCD«%? 0TRUE3
TLSAllowTrustExceptions ã? a8?chï / hï4?û??UÄù«
?UÄ ?CUÄ???X®bdµ?ä
0FALSE3¶??ÙCUÄkÓ«xywßT[
PayloadCertificateAnchorUUID ( TLSTrustedNames
3?=|?  0TRUE3Ãmj'%
PayloadCertificateAnchorUUID  TLSTrustedServerNames ah
I>?ô=|?  0FALSE3c
TTLSInnerAuthentication \?´a8?ch  TTLS eC?�4Ó«=|
?  0MSCHAPv23
89?  0PAP3b0CHAP3b0MSCHAP3(
0MSCHAPv23
OuterIdentity \?´a8?c1° TTLSb PEAP ( EAP-FAST p´
hhï4?©ª& a4c??4?µno°:?
!?¬àcáb8óC¥«ä
0anonymous3b0anon3 0anon@mycompany.net3
8ój???ä5*²@ó[]Ô LÓ«4
?no
EAPFASTUsePAC ã? a8?c
EAPFASTProvisionPAC ã? a8?c
EAPFASTProvisionPACAnonymously ã? a8?c© B     77
bd EAPFASTUsePAC ä 0FALSE3kÓ«ùV PEAP  TTLS £pSøef?
?Ø¿�4?É2???
bd EAPFASTUsePAC ä 0TRUE3k:�4Ù PAC abdB!®c?
r!¥¦T! PAC ?t@ hï PAC 'ÌaPAC provisioningc
	??4 EAPFASTProvisionPACj¶bd?®O??4
EAPFASTProvisionPACAnonymously EAPFASTProvisionPACAnonymously Ù??6
Dø:Ó«ef????ó:À?)þ578
b VPN °±9/???°± Wi-Fi °±p´= 89ûL«ÑX
?ó¹Û??6Î???h9ûsÙÇÈ?´=???
0PayloadCertificateUUID31ÉD«ÙÚ`Û UUID
éî%9»²³+(°±z{º»[?àáh�° ò?j
	µ??/àáQpÙ´?@ÇÈwß Ur[j'ÍÎ
UVÙ´??z{º»wßr 21 Ð 0²³+(°±3
 1 




    PayloadContent
    
        URL
        https://profileserver.example.com/iphone
        DeviceAttributes
        
UDID
IMEI
ICCID
VERSION
PRODUCT
        
    Challenge
optional challenge
or
base64-encoded
    
PayloadCertificateUUID \?´ä?ÙÚ`Û UUID45??X?78 © B    
    PayloadOrganization
    Example Inc.
    PayloadDisplayName
    Profile Service
    PayloadVersion
    1
    PayloadUUID
    fdb376e5-b5bb-4d8c-829e-e90865f990c9
    PayloadIdentifier
    com.example.mobileconfig.profile-service
    PayloadDescription
    Enter device into the Example Inc encrypted profile service
    PayloadType
Profile Service


 2 




    UDID
    
    VERSION
    7A182
    MAC_ADDRESS_EN0
    00:00:00:00:00:00
    CHALLENGE
either:
    String
or:
    "base64 encoded data"


 3 SCEP 



  
    PayloadVersion
    1
    PayloadUUID© B     79
    Ignored
    PayloadType
    Configuration
    PayloadIdentifier
    Ignored
    PayloadContent
    
      
        PayloadContent
        
          URL
          https://scep.example.com/scep
          Name
          EnrollmentCAInstance
          Subject
          
            
              
                O
                Example, Inc.
              
            
            
              
                CN
                User Device Cert
              
            
          
          Challenge
          ...
          Keysize
          1024
          Key Type
          RSA
          Key Usage
          5
        
        PayloadDescription
        Provides device encryption identity
        PayloadUUID
        fd8a6b9e-0fed-406f-9571-8ec98722b713
        PayloadType
        com.apple.security.scep
        PayloadDisplayName
        Encryption Identity
        PayloadVersion80 © B    
        1
        PayloadOrganization
        Example, Inc.
        PayloadIdentifier
        com.example.profileservice.scep
      
    
  

 4 




    UDID
    
    VERSION
    7A182
    MAC_ADDRESS_EN0
    00:00:00:00:00:00
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 iPhone OS 
?CqûÒ³¹âóÒq	?(°±
iPhone  C# 
àáC:àbø�4 0iPhone °±µ4¶· aWindows ?c3¸¹°±
[?
using System;
using Com.Apple.iPCUScripting;
public class TestScript : IScript
{
private IApplication _host;
public TestScript()
{
}
public void main(IApplication inHost)
{
_host = inHost;
string msg = string.Format("# of config profiles : {0}", 
_host.ConfigurationProfiles.Count);
Console.WriteLine(msg);
IConfigurationProfile profile = _host.AddConfigurationProfile();
profile.Name = "Profile Via Script";
profile.Identifier = "com.example.configviascript";
profile.Organization = "Example Org";
profile.Description = "This is a configuration profile created via the 
new scripting feature in iPCU";
// passcode
IPasscodePayload passcodePayload = profile.AddPasscodePayload();
passcodePayload.PasscodeRequired = true;
passcodePayload.AllowSimple = true;82 © C    
// restrictions
IRestrictionsPayload restrictionsPayload = 
profile.AddRestrictionsPayload();
restrictionsPayload.AllowYouTube = false;
// wi-fi
IWiFiPayload wifiPayload = profile.AddWiFiPayload();
wifiPayload.ServiceSetIdentifier = "Example Wi-Fi";
wifiPayload.EncryptionType = WirelessEncryptionType.WPA;
wifiPayload.Password = "password";
wifiPayload = profile.AddWiFiPayload();
profile.RemoveWiFiPayload(wifiPayload);
// vpn
IVPNPayload vpnPayload = profile.AddVPNPayload();
vpnPayload.ConnectionName = "Example VPN Connection";
vpnPayload = profile.AddVPNPayload();
profile.RemoveVPNPayload(vpnPayload);
// email
IEmailPayload emailPayload = profile.AddEmailPayload();
emailPayload.AccountDescription = "Email Account 1 Via Scripting";
emailPayload = profile.AddEmailPayload();
emailPayload.AccountDescription = "Email Account 2 Via Scripting";
// exchange
IExchangePayload exchangePayload = profile.AddExchangePayload();
exchangePayload.AccountName = "ExchangePayloadAccount";
// ldap
ILDAPPayload ldapPayload = profile.AddLDAPPayload();
ldapPayload.Description = "LDAP Account 1 Via Scripting";
ldapPayload = profile.AddLDAPPayload();
ldapPayload.Description = "LDAP Account 2 Via Scripting";
// webclip
IWebClipPayload wcPayload = profile.AddWebClipPayload();
wcPayload.Label = "Web Clip 1 Via Scripting";
wcPayload = profile.AddWebClipPayload();
wcPayload.Label = "Web Clip 2 Via Scripting";
}
}© C     83
iPhone  AppleScript 
àáC:àbø�4 0iPhone °±µ4¶· aMac OS X ?c3¸¹°±
[?
tell application "iPhone Configuration Utility"
log (count of every configuration profile)
set theProfile to make new configuration profile with properties 
{displayed name:"Profile Via Script", profile 
identifier:"com.example.configviascript", organization:"Example Org.", 
account description:"This is a configuration profile created via 
AppleScript"}
tell theProfile
make new passcode payload with properties {passcode required:true, 
simple value allowed:true}
make new restrictions payload with properties {YouTube allowed:false}
make new WiFi payload with properties {service set identifier:"Example 
Wi-Fi", security type:WPA, password:"password"}
set theWiFiPayload to make new WiFi payload
delete theWiFiPayload
make new VPN payload with properties {connection name:"Example VPN 
Connection"}
set theVPNPayload to make new VPN payload
delete theVPNPayload
make new email payload with properties {account description:"Email 
Account 1 Via Scripting"}
make new email payload with properties {account description:"Email 
Account 2 Via Scripting"}
make new Exchange ActiveSync payload with properties {account 
name:"ExchangePayloadAccount"}
make new LDAP payload with properties {account description:"LDAP 
Account 1 Via Scripting"}
make new LDAP payload with properties {account description:"LDAP 
Account 2 Via Scripting"}
make new web clip payload with properties {label:"Web Clip Account 1 
Via Scripting"}
make new web clip payload with properties {label:"Web Clip Account 2 
Via Scripting"}
end tell
end tell
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iPhone-Überblick
Kopfhöreranschluss
Hörer
Klingeln/Aus
Oberes Mikrofon
Lautstärketasten
Apple 
Retina-Display
Lautsprecher
Home-Taste
Frontkamera
Hauptkamera
LED-Blitz
SIM-Kartenfach
Dockanschluss
Ein-/Aus-Taste
Unteres 
Mikrofon
App-Symbole
Statusleiste
iPhone
Möglicherweise sehen Ihr iPhone und der Home-Bildschirm anders aus, je nachdem, welches 
iPhone-Modell Sie verwenden und ob Sie Ihren Home-Bildschirm angepasst haben.
Zubehör
Folgendes Zubehör ist im Lieferumfang des iPhone enthalten:
Dock Connector-auf-USB-Kabel
Apple Earphones mit 
Fernbedienung und Mikrofon
Werkzeug zum Auswerfen 
der SIM-Karte
USB-Netzteil
9Komponente Funktion
Apple Earphones mit 
Fernbedienung und Mikrofon
Hören Sie Musik, den Ton von Videos und Ihren Gesprächspartner am 
Telefon. Weitere Informationen unter „Apple Earphones mit Fernbedienung 
und Mikrofon“ auf Seite 36.
Dock Connector-auf-USB-Kabel Verbinden Sie mit diesem Kabel das iPhone mit Ihrem Computer, um es zu 
synchronisieren und zu laden. Das Kabel kann mit dem optionalen Dock 
verwendet oder direkt an das iPhone angeschlossen werden.
USB-Netzteil Verbinden Sie mithilfe des mitgelieferten Kabels das Netzteil mit dem 
iPhone und stecken Sie es in eine Steckdose, um das iPhone zu laden.
Werkzeug zum Auswerfen der 
SIM-Karte (nicht in allen Ländern 
oder Regionen im Lieferumfang 
enthalten)
Öffnen Sie hiermit das SIM-Kartenfach, um die SIM-Karte auszuwerfen.
Tasten
Ein-/Aus-Taste
Wenn Sie das iPhone nicht verwenden, können Sie es sperren, um den Bildschirm auszuschalten 
und die Batterie zu schonen. 
Sperren des iPhone:  Drücken Sie die Ein-/Aus-Taste.
Ist das iPhone gesperrt, passiert nichts, wenn Sie den Bildschirm berühren. Das iPhone kann aber 
weiterhin Anrufe, Textmitteilungen und andere Aktualisierungen empfangen. Sie haben außerdem 
folgende Möglichkeiten:
Â Hören Sie Musik.
Â Passen Sie die Lautstärke während eines Anrufs bzw. der Musikwiedergabe mit den Tasten an 
der Seite des iPhone an (bzw. mit den Tasten der iPhone-Ohrhörer).
Â Drücken Sie die Mitteltaste auf den iPhone-Ohrhörern, um einen Anruf anzunehmen oder zu 
beenden bzw. um die Audiowiedergabe zu steuern (weitere Informationen unter „Wiedergeben 
von Musik und anderen Audiodateien“ auf Seite 85).
Ein-/Aus-Taste
Entsperren des iPhone Drücken Sie die Home-Taste  bzw. die Ein-/Aus-Taste und bewegen Sie 
dann den Regler.
Öffnen der App „Kamera“ bei 
gesperrtem iPhone
Drücken Sie die Home-Taste  bzw. die Ein-/Aus-Taste und bewegen Sie 
nach oben.
Anzeigen der 
Audiobedienelemente, wenn das 
iPhone gesperrt ist
Drücken Sie zweimal die Home-Taste  .
Ausschalten des iPhone Drücken und halten Sie die Ein-/Aus-Taste einige Sekunden lang, bis der 
rote Regler eingeblendet wird, und bewegen Sie den Schieberegler.
Einschalten des iPhone Drücken und halten Sie die Ein-/Aus-Taste, bis das Apple-Logo angezeigt 
wird.
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automatisch gesperrt. Informationen, wie Sie die automatische Sperre deaktivieren bzw. die Dauer 
für das Aktivieren der Sperre für das iPhone ändern, finden Sie unter „Automatische Sperre“ auf 
Seite 188. Um einen Code festzulegen, mit dem das iPhone entsperrt wird, lesen Sie „CodeSperre“ auf Seite 188.
Home-Taste
Mit der Home-Taste  können Sie jederzeit zum Home-Bildschirm zurückkehren. Sie bietet auch 
andere praktische Kurzbefehle.
Zum Home-Bildschirm:  Drücken Sie die Home-Taste  .
Auf dem Home-Bildschirm kann eine App nur geöffnet werden, indem Sie darauf tippen. Weitere 
Informationen unter „Öffnen und Wechseln von Apps“ auf Seite 21.
Anzeigen der Multitaskingleiste mit 
kürzlich verwendeten Apps
Drücken Sie bei entsperrtem iPhone die Home-Taste  zweimal. 
Einblenden der Bedienelemente für 
die Audiowiedergabe
Bei gesperrtem iPhone:  Drücken Sie zweimal die Home-Taste 
. Weitere Informationen unter „Wiedergeben von Musik und anderen 
Audiodateien“ auf Seite 85.
Beim Verwenden einer anderen App:  Drücken Sie zweimal die Home-Taste 
und bewegen Sie den App-Umschalter von links nach rechts.
Starten von Siri (iPhone 4S) bzw. 
der Sprachsteuerung
Drücken und halten Sie die Home-Taste  . Weitere Informationen unter 
Kapitel 4,„Siri,“ auf Seite 43 und „Sprachsteuerung“ auf Seite 32.
Lautstärketasten
Wenn Sie telefonieren oder Musik, Filme oder andere Medien abspielen, können Sie mit den 
Tasten an der Seite des iPhone die Lautstärke anpassen. Andernfalls wird mit den Tasten die 
Lautstärke für Klingeltöne, Hinweise und andere Töne gesteuert.
ACHTUNG:  Wichtige Hinweise zur Vermeidung von Hörschäden finden Sie im Handbuch 
Wichtige Produktinformationen unter www.apple.com/de/support/manuals/iphone. 
Lauter
Leiser
Um eine maximale Lautstärke für Musik und Videos festzulegen, öffnen Sie „Einstellungen“ > 
„Musik“.
Sie können die Lauter-Taste alternativ dazu verwenden, ein Foto oder ein Video aufzunehmen. 
Weitere Informationen unter „Aufnehmen von Fotos und Videos“ auf Seite 104.
Kapitel 1    Das iPhone auf einen Blick 11Schalter „Klingeln/Aus“
Mit dem Schalter „Klingeln/Aus“ können Sie zwischen dem Modus mit Klingelton  und dem 
ohne Klingelton  für das iPhone wechseln.
Klingeln
Aus
Wird der Modus mit Klingelton verwendet, spielt das iPhone alle Töne ab. Im Modus ohne 
Klingelton gibt das iPhone kein Klingeln oder sonstige Töne aus.
Wichtig:  Die akustische Ausgabe von Wecktönen, audiobasierten Apps wie „iPod“ und zahlreichen 
Spielen erfolgt auch dann über den integrierten Lautsprecher, wenn das iPhone stummgeschaltet 
ist.
Weitere Informationen zum Ändern der Töne sowie zu Vibrationseinstellungen finden Sie unter 
„Töne und der Schalter „Klingeln/Aus““ auf Seite 184.
Symbole in der Statusleiste
Die Symbole oben im Bildschirm in der Statusleiste zeigen Informationen zum iPhone an:
Symbol in der 
Statusleiste
Bedeutung
Mobilfunksignal* Zeigt, ob Sie sich in Reichweite des Funknetzes befinden 
und Anrufe tätigen und annehmen können. Je mehr 
Balken angezeigt werden, desto stärker ist das Signal. 
Ist kein Signal verfügbar, werden die Balken durch den 
Hinweis „Kein Dienst“ ersetzt.
Flugmodus Zeigt, dass der Flugmodus aktiviert ist, d. h., Sie können 
nicht telefonieren, nicht auf das Internet zugreifen und 
keine Bluetooth®-Geräte verwenden. Funktionen, für 
die keine Funkverbindungen erforderlich sind, stehen 
weiterhin zur Verfügung. Weitere Informationen unter 
„Flugmodus“ auf Seite 180.
UMTS Zeigt, dass das 4G UMTS (GSM)-Netz Ihres 
Mobilfunkanbieters verfügbar ist und das iPhone 
über dieses Netz auf das Internet zugreifen kann. (Nur 
iPhone 4S. Nicht in allen Regionen verfügbar.) Weitere 
Informationen unter „Netzwerk“ auf Seite 186.
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Statusleiste
Bedeutung
UMTS/EV-DO Zeigt, dass das 3G UMTS (GSM)- oder EV-DO (CDMA)-Netz 
Ihres Mobilfunkanbieters verfügbar ist und das iPhone 
über dieses Netz auf das Internet zugreifen kann. Weitere 
Informationen unter „Netzwerk“ auf Seite 186.
EDGE Zeigt, dass das EDGE (GSM)-Netz Ihres Mobilfunkanbieters 
verfügbar ist und das iPhone über dieses Netz auf das 
Internet zugreifen kann. Weitere Informationen unter 
„Netzwerk“ auf Seite 186.
GPRS/1xRTT Zeigt, dass das GPRS (GSM)- oder 1xRTT (CDMA)-Netz 
Ihres Mobilfunkanbieters verfügbar ist und das iPhone 
über dieses Netz auf das Internet zugreifen kann. Weitere 
Informationen unter „Netzwerk“ auf Seite 186.
WLAN* Zeigt, dass das iPhone über WLAN mit dem Internet 
verbunden ist. Je mehr Balken angezeigt werden, desto 
besser ist die Verbindung. Weitere Informationen unter 
„WLAN“ auf Seite 180.
Persönlicher Hotspot Zeigt, dass das iPhone als persönlicher Hotspot für ein 
anderes iPhone fungiert. Weitere Informationen unter 
„Persönlicher Hotspot“ auf Seite 183.
Synchronisieren Zeigt, dass das iPhone mit iTunes synchronisiert wird.
Netzwerkaktivität Zeigt Netzwerkaktivität an. Möglicherweise wird dieses 
Symbol von Drittanbieter-Apps verwendet, um einen 
aktiven Prozess anzuzeigen.
Rufweiterleitung Zeigt, dass die Anrufweiterleitung auf dem iPhone 
eingerichtet ist. Weitere Informationen unter 
„Rufweiterleitung“ auf Seite 69.
VPN Zeigt, dass Sie mit einem Netzwerk über VPN verbunden 
sind. Weitere Informationen unter „Netzwerk“ auf Seite 186.
Schloss Zeigt, dass das iPhone gesperrt ist. Weitere Informationen 
unter „Ein-/Aus-Taste“ auf Seite 10.
TTY Zeigt, dass das iPhone mit einem TTY-Gerät verwendet 
werden kann. Weitere Informationen unter „TTYUnterstützung“ auf Seite 178.
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Statusleiste
Bedeutung
Abspielen Zeigt, dass ein Musiktitel, Hörbuch oder Podcast 
wiedergegeben wird. Weitere Informationen unter 
„Wiedergeben von Musik und anderen Audiodateien“ auf 
Seite 85.
Hochformat-Sperre Zeigt, dass der iPhone-Bildschirm im Hochformat gesperrt 
ist. Weitere Informationen unter „Anzeigen im Hoch- oder 
Querformat“ auf Seite 23.
Wecker Zeigt, dass ein Wecker gestellt wurde. Weitere 
Informationen unter „Stellen eines Weckers“ auf Seite 120.
Ortungsdienste Zeigt, dass eine App Ortungsdienste verwendet. Weitere 
Informationen unter „Ortungsdienste“ auf Seite 182.
Bluetooth* Blaues oder weißes Symbol: Zeigt, dass Bluetooth aktiviert 
und mit einem Gerät verbunden ist. 
Graues Symbol: Bluetooth ist aktiviert und mit einem 
Gerät verbunden, das Gerät befindet sich jedoch außer 
Reichweite oder ist ausgeschaltet. 
Kein Bluetooth-Symbol: Bluetooth ist deaktiviert oder nicht 
mit einem Gerät verbunden. 
Weitere Informationen unter „Bluetooth-Geräte“ auf 
Seite 37.
Bluetooth-Batterie Zeigt den Batteriestatus eines unterstützten gekoppelten 
Bluetooth-Geräts an.
Batterie Zeigt den Batterieladezustand oder den Status des 
Aufladevorgangs an. Weitere Informationen unter 
„Batterie“ auf Seite 38.
* Möglicherweise beeinträchtigt die Verwendung bestimmten Zubehörs mit dem iPhone die 
drahtlose Kommunikation.
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ACHTUNG:  Lesen Sie zu Ihrer eigenen Sicherheit alle Anleitungen zum Umgang mit dem Gerät 
in diesem Handbuch und im Handbuch iPhone – Wichtige Produktinformationen unter  
http://support.apple.com/de_DE/manuals/iphone, bevor Sie das iPhone verwenden.
·
Ansehen dieses Handbuchs auf dem iPhone
Das iPhone-Benutzerhandbuch kann auf dem iPhone in Safari und in der kostenlosen App „iBooks“ 
angezeigt werden.
Anzeigen des Benutzerhandbuchs in Safari: Tippen Sie auf  und dann auf das Lesezeichen 
„iPhone-Benutzerhandbuch“.
Um ein Symbol für das Handbuch zum Home-Bildschirm hinzuzufügen, tippen Sie auf  und 
dann auf „Zum Home-Bildschirm“. Tippen Sie auf „Sprache wechseln“, um das Handbuch in einer 
anderen Sprache anzuzeigen.
Anzeigen des Benutzerhandbuchs in iBooks:  Wenn Sie iBooks nicht installiert haben, öffnen 
Sie den App Store, suchen Sie danach und installieren Sie die App. Öffnen Sie iBooks und tippen 
auf „Store“. Suchen Sie nach „iPhone-Benutzerhandbuch“, tippen Sie darauf und laden Sie das 
Handbuch.
Weitere Informationen zu iBooks finden Sie unter Kapitel 30,„iBooks,“ auf Seite 156.
Voraussetzungen
Zum Verwenden des iPhone benötigen Sie Folgendes:
Â Einen Mobilfunkvertrag eines Anbieters, der den iPhone-Mobilfunkdienst für Sie bereitstellt
Â Eine Apple-ID (für einige Funktionen), die während der Einrichtung erstellt werden kann
Â Einen Mac oder PC mit einem USB 2.0-Anschluss und eines der folgenden Betriebssysteme:
Â Mac OS X 10.5.8 oder neuer
Â Windows 7, Windows Vista oder Windows XP Home oder Professional (SP3)
Â Eine Internetverbindung für Ihren Computer (Breitband wird empfohlen)
Â iTunes 10.5 oder neuer (für einige Funktionen), erhältlich unter www.itunes.com/de/download
Einsetzen einer SIM-Karte
Wenn Sie eine SIM-Karte erhalten haben, setzen Sie diese ein, bevor Sie das iPhone konfigurieren.
15Wichtig:  Eine SIM-Karte ist erforderlich, wenn Sie in GSM- und manchen CDMA-Netzwerken 
Mobilfunkdienste nutzen möchten. Wurde ein iPhone 4S in einem WLAN-CDMA-Netzwerk 
aktiviert, kann eine SIM-Karte ebenfalls benutzt werden, um eine Verbindung mit dem GSMNetzwerk herzustellen (hauptsächlich für internationales Roaming). Ihr iPhone unterliegt den 
Bestimmungen und Richtlinien Ihres WLAN-Dienstanbieters. Möglicherweise beinhalten diese 
Einschränkungen im Hinblick auf Roaming und das Wechseln des Dienstanbieters. Dies kann auch 
nach Abschluss eines erforderlichen Servicevertrags der Fall sein. Wenden Sie sich an Ihren WLANDienstanbieter, um weitere Informationen zu erhalten. Die Verfügbarkeit des Funknetzes ist vom 
WLAN-Netzwerk abhängig.
Einsetzen der SIM-Karte in das iPhone 4S
Micro 
SIM-Karte
Micro SIMKartenfach
Büroklammer 
oder Werkzeug 
zum Entfernen 
der SIM-Karte
Installieren der SIM-Karte:  Führen Sie eine aufgebogene Büroklammer oder das Werkzeug zum 
Auswerfen der SIM-Karte in die Öffnung des SIM-Kartenfachs ein. Ziehen Sie das SIM-Fach heraus 
und legen Sie die SIM-Karte wie hier gezeigt in das Fach ein. Richten Sie das Fach mit der SIMKarte aus und setzen Sie es vorsichtig wieder ein.
Konfiguration und Aktivierung
Um das iPhone zu konfigurieren und zu aktivieren, schalten Sie das iPhone ein und befolgen Sie 
die angezeigten Anweisungen. Die Einrichtung umfasst das Verbinden mit einem WLAN-Netzwerk, 
das Anmelden mit bzw. das Erstellen einer kostenlosen Apple-ID, das Einrichten von iCloud, das 
Aktivieren empfohlener Funktionen wie den Ortungsdiensten und „Mein iPhone suchen“ sowie 
das Aktivieren des iPhone bei Ihrem Anbieter. Sie können das iPhone während der Konfiguration 
auch aus einem iCloud- oder iTunes-Backup wiederherstellen.
Die Aktivierung erfolgt über ein WLAN-Netzwerk oder mit einem iPhone 4S über das 
Datennetzwerk Ihres Anbieters (nicht in allen Regionen verfügbar). Ist keine dieser Optionen 
verfügbar, schließen Sie das iPhone zur Aktivierung an den Computer an.
Verbinden des iPhone mit dem Computer
Wenn Sie weder über eine WLAN-Verbindung noch über ein Datennetzwerk verfügen, schließen 
Sie das iPhone an den Computer an, um die Aktivierung abzuschließen. Wenn das iPhone an den 
Computer angeschlossen wird, können Sie auch Informationen, Musik und andere Inhalte mit 
iTunes synchronisieren. Weitere Informationen unter „Synchronisieren mit iTunes“ auf Seite 19.
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Dock Connector-auf-USB-Kabel.
Herstellen der Internetverbindung
Das iPhone stellt immer dann eine Internetverbindung her, wenn diese erforderlich ist. Wenn 
verfügbar, wird dafür eine WLAN-Verbindung verwendet, andernfalls das Datennetzwerk Ihres 
Anbieters. Weitere Informationen zum Herstellen einer Internetverbindung über WLAN erhalten 
Sie unter „WLAN“ auf Seite 180. 
Hinweis:  Ist kein WLAN-Netzwerk verfügbar, fallen für bestimmte iPhone-Funktionen und 
-Dienste zusätzliche Gebühren für die Datenübertragung über das Datennetzwerk an. Setzen 
Sie sich mit Ihrem Anbieter in Verbindung, um Informationen zu den anfallenden Kosten für die 
Datenübertragung einzuholen. Weitere Informationen zur Verwaltung des Datenplans erhalten Sie 
unter „Netzwerk“ auf Seite 186.
Konfigurieren von Mail und anderen Accounts
Das iPhone funktioniert mit iCloud, Microsoft Exchange und den meisten internetbasierten 
E-Mail-, Kontakte- und Kalenderdienstanbietern. 
Wenn Sie noch keinen E-Mail-Account besitzen, können Sie bei der ersten Konfiguration des 
iPhone einen kostenlosen iCloud-Account einrichten. Dies ist auch später über „Einstellungen“ > 
„iCloud“ möglich. Weitere Informationen unter „iCloud“ auf Seite 18.
Einrichten eines iCloud-Accounts: Wählen Sie „Einstellungen“ > „iCloud“.
Einrichten eines weiteren Accounts: Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“.
Sie können Kontakte außerdem mithilfe eines LDAP- oder CardDAV-Accounts hinzufügen, 
sofern Ihr Unternehmen oder Ihre Organisation dies unterstützt. Weitere Informationen unter 
„Synchronisieren von Kontakten“ auf Seite 139.
Sie können einen CalDAV-Account hinzufügen und iCal (.ics)-Kalender abonnieren bzw. diese aus 
Mail importieren. Weitere Informationen unter „Abonnieren von Kalendern“ auf Seite 98.
Verwalten der Inhalte auf Ihren iOS-Geräten
Sie können entweder über iCloud oder iTunes Informationen und Dateien zwischen Ihren iOSGeräten und Computern übertragen.
Â iCloud speichert Inhalte wie Musik, Fotos und mehr und überträgt diese drahtlos auf Ihre 
iOS-Geräte und Computer. So sind Ihre Inhalte immer auf dem neuesten Stand. Weitere 
Informationen nachfolgend unter „iCloud“.
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iPhone synchronisieren. Wenn Sie auf einem Gerät Änderungen vornehmen, werden diese 
übernommen, wenn das Gerät das nächste Mal synchronisiert wird. Verwenden Sie iTunes, 
um eine Datei auf das iPhone zu übertragen und diese mit einer App zu verwenden. Oder 
übertragen Sie ein Dokument, das Sie auf dem iPhone erstellt haben, auf Ihren Computer. 
Weitere Informationen unter „Synchronisieren mit iTunes“ auf Seite 19.
Sie können, je nach Ihren Bedürfnissen, iCloud oder iTunes oder auch beides verwenden. So 
können Sie zum Beispiel mit Fotostream in iCloud Fotos, die Sie mit dem iPhone gemacht haben, 
auf andere Geräte übertragen und mit iTunes Fotoalben auf Ihrem Computer mit dem iPhone 
synchronisieren.
Hinweis:  Synchronisieren Sie keine Objekte im iTunes-Infobereich (wie Kontakte, Kalender und 
Notizen). Verwenden Sie dafür iCloud, um diese Daten auf allen Geräten auf dem neuesten Stand 
zu halten. Andernfalls können duplizierte Daten die Folge sein.
iCloud
iCloud speichert Ihre Inhalte, einschließlich Musik, Fotos, Kontakte, Kalender und unterstützte 
Dokumente. In iCloud gespeicherte Inhalte werden drahtlos an Ihre anderen iOS-Geräte und 
Computer übertragen, die mit demselben iCloud-Account konfiguriert wurden. 
iCloud ist für iOS 5-Geräte, Macs mit OS X Lion 10.7.2 (oder neuer) und PCs mit der iCloudSystemsteuerung für Windows (Windows Vista Service Pack 2 oder Windows 7 erforderlich) 
verfügbar. 
Die iCloud-Funktionen umfassen:
Â iTunes in the Cloud – Laden Sie Musiktitel und Fernsehsendungen, die Sie schon früher bei 
iTunes gekauft haben, kostenlos und jederzeit auf das iPhone.
Â Apps und Bücher – Laden Sie Apps und Bücher, die Sie im App Store und iBookstore gekauft 
haben, kostenlos und jederzeit auf das iPhone.
Â Fotostream – Fotos, die Sie auf einem Gerät aufgenommen haben, sind automatisch auf allen 
anderen Geräten verfügbar. Weitere Informationen unter „Fotostream“ auf Seite 106.
Â Dokumente in der Cloud – Mit iCloud-fähigen Apps können Sie Ihre Dokumente und App-Daten 
auf Ihren Geräten immer auf dem neuesten Stand halten.
Â Mail, Kontakte, Kalender – Halten Sie Ihre Mail-Kontakte, Kalender, Notizen und Erinnerungen auf 
allen Geräten auf dem aktuellen Stand.
Â Backup – Sichern Sie Ihr iPhone automatisch auf iCloud, wenn es mit dem Stromnetz und 
einem WLAN-Netzwerk verbunden ist. Weitere Informationen unter „Erstellen eines iPhoneBackups“ auf Seite 198.
Â Mein iPhone suchen – Finden Sie Ihr iPhone auf einer Karte, zeigen Sie eine Nachricht an, geben 
Sie einen Ton wieder, sperren Sie den Bildschirm oder löschen Sie die Daten darauf. Weitere 
Informationen unter „Mein iPhone suchen“ auf Seite 40.
Â Freunde suchen – Lassen Sie Personen, die Ihnen wichtig sind, Ihren Standort wissen. Laden Sie 
die kostenlose App im App Store.
Â iTunes Match – Mit einem iTunes Match-Abonnement werden Ihre Musiktitel, einschließlich 
der von einer CD importierten Titel und den nicht in iTunes gekauften Titeln, auf allen Geräten 
angezeigt und können bei Bedarf geladen werden. Weitere Informationen unter „iTunes 
Match“ auf Seite 89.
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Dokumente und Backups. Musik, Apps, Fernsehsendungen und Bücher, die Sie kaufen, sowie Ihr 
Fotostream zählen nicht zu diesen 5 GB.
Wenn Sie über ein MobileMe-Abonnement verfügen, können Sie dieses von einem Mac oder PC 
auf www.me.com/move bis zum 30. Juni 2012 auf iCloud übertragen.
Hinweis:  iCloud ist nicht in allen Regionen verfügbar. Die Funktionen können nach Region 
variieren.
Anmelden bei einem iCloud-Account (bzw. Erstellen eines iCloud-Accounts):  Wählen Sie 
„Einstellungen“ > „iCloud“. 
Aktivieren oder Deaktivieren von 
iCloud-Diensten
Wählen Sie „Einstellungen“ > „iCloud“.
Aktivieren des iCloud-Backups Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“.
Finden Ihres iPhone Besuchen Sie www.icloud.com, melden Sie sich mit Ihrer Apple-ID an und 
wählen Sie „Mein iPhone suchen“. 
Wichtig:  Auf dem iPhone muss unter „Einstellungen“ > „iCloud“ die 
Funktion „Mein iPhone suchen“ aktiviert sein, damit Ihr iPhone geortet 
werden kann.
Erwerben zusätzlichen iCloudSpeichers
Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“ und tippen 
Sie auf „Speicherplatz verwalten“. Weitere Informationen zum Erwerben 
zusätzlichen Speichers erhalten Sie unter help.apple.com/de/icloud.
Anzeigen und Laden vorheriger 
iTunes Store-Käufe
Öffnen Sie iTunes und tippen Sie auf „Einkäufe“.
Anzeigen und Laden vorheriger 
App Store-Käufe
Tippen Sie im App Store auf „Updates“ und dann auf „Gekaufte Artikel“.
Anzeigen und Laden vorheriger 
iBookstore-Käufe
Tippen Sie in iBooks auf „Store“ und dann auf „Gekaufte Artikel“.
Aktivieren der Option 
„Automatische Downloads“ für 
Musik, Apps oder Bücher
Wählen Sie „Einstellungen“ > „Store“.
Weitere Informationen zu iCloud finden Sie unter www.apple.com/de/icloud. Support erhalten Sie 
unter www.apple.com/de/support/icloud
Synchronisieren mit iTunes
Bei der Synchronisierung mit iTunes werden Daten von Ihrem iPhone auf Ihren Computer 
kopiert und umgekehrt. Sie können das iPhone synchronisieren, indem Sie es über das Dock 
Connector-auf-USB-Kabel mit dem Computer verbinden. Alternativ können Sie in iTunes die 
Synchronisierung über WLAN einrichten. Legen Sie fest, dass iTunes Musik, Fotos, Videos, Podcasts, 
Apps und andere Inhalte synchronisiert. Weitere Informationen zum Synchronisieren des iPhone 
mit dem Computer erhalten Sie, indem Sie iTunes öffnen und dann im Hilfemenü die iTunes-Hilfe 
aufrufen.
Konfigurieren der iTunes-Synchronisierung über WLAN:  Verbinden Sie das iPhone über das 
mitgelieferte Dock Connector-auf-USB-Kabel mit dem Computer. Aktivieren Sie in iTunes im 
Bereich „Übersicht“ des Geräts die Option „Über WLAN synchronisieren“. 
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automatisch. Dazu muss das iPhone an eine Stromquelle angeschlossen und iTunes auf dem 
Computer geöffnet sein. Sowohl das iPhone als auch der Computer müssen sich im gleichen 
WLAN-Netzwerk befinden. Weitere Informationen unter „iTunes WLAN Sync“ auf Seite 187. 
Tipps zur Synchronisierung mit iTunes
Â Wenn Sie mithilfe von iCloud Ihre Kontakte, Kalender, Lesezeichen und Notizen speichern, 
synchronisieren Sie diese nicht auch mit iTunes.
Â iTunes Store- oder App Store-Käufe, die über das iPhone erfolgen, werden mit Ihrer iTunesMediathek synchronisiert. Sie können auch Inhalte und Apps im iTunes Store kaufen und auf 
Ihren Computer laden und diesen dann mit dem iPhone synchronisieren.
Â Im Bereich „Übersicht“ des Geräts können Sie festlegen, dass iTunes Ihr Gerät automatisch 
synchronisiert, wenn dieses an den Computer angeschlossen wird. Um diese Einstellung 
vorübergehend zu deaktivieren, halten Sie die Befehls- und Wahltaste (Mac) bzw. die Umschalt- 
und Strg-Taste (PC) gedrückt, bis das iPhone in der Seitenleiste angezeigt wird.
Â Wählen Sie im Bereich „Übersicht“ des Geräts die Option „iPhone-Backup verschlüsseln“, wenn 
die Informationen, die auf Ihrem Computer gesichert werden, beim Erstellen des Backups 
mit iTunes verschlüsselt werden sollen. Verschlüsselte Backups sind durch ein Schlosssymbol 
 gekennzeichnet. Um diese wiederherzustellen, ist ein Kennwort erforderlich. Wenn Sie 
diese Option nicht wählen, werden Kennwörter (u. a. für E-Mail-Accounts) nicht in das Backup 
eingeschlossen und müssen erneut eingegeben werden, wenn Sie das Gerät wiederherstellen.
Â Wenn Sie im Bereich „Infos“ des Geräts E-Mail-Accounts synchronisieren, werden lediglich die 
Einstellungen von Ihrem Computer auf das iPhone übertragen. Werden Änderungen an einem 
E-Mail-Account auf dem iPhone vorgenommen, wirkt sich dies nicht auf den Account auf Ihrem 
Computer aus.
Â Wählen Sie im Bereich „Infos“ des Geräts unter „Erweitert“ die Optionen aus, mit denen Sie bei 
der nächsten Synchronisierung die Daten auf Ihrem iPhone durch Daten auf dem Computer 
ersetzen möchten.
Â Wenn Sie einen Podcast oder ein Hörbuch teilweise gehört haben, wird die Stelle, an der 
Sie die Wiedergabe unterbrechen, auch bei der Synchronisierung der Inhalte mit iTunes 
gekennzeichnet. Haben Sie den ersten Teil eines Hörbuchs mit dem iPhone angehört, können 
Sie die Wiedergabe in iTunes auf Ihrem Computer genau an der Stelle fortsetzen, an der Sie 
unterbrochen haben – oder umgekehrt. 
Â Im Bereich „Fotos“ des Geräts können Sie Fotos und Videos von einem Ordner auf dem 
Computer synchronisieren.
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Verwenden von Apps
Der hochauflösende Multi-Touch-Bildschirm und einfache Fingerbewegungen (Gesten) machen 
das Verwenden von iPhone-Apps sehr einfach.
Öffnen und Wechseln von Apps
Drücken Sie die Home-Taste  , um zum Home-Bildschirm zu gelangen und Ihre Apps zu sehen.
Öffnen einer App:  Tippen Sie darauf.
Drücken Sie die Home-Taste  , um zum Home-Bildschirm zurückzukehren. Streichen Sie nach 
links oder rechts, um einen anderen Home-Bildschirm anzuzeigen.
Streichen Sie nach links oder 
rechts, um einen anderen 
Home-Bildschirm anzuzeigen.
Wenn Sie die Home-Taste  zweimal drücken, wird die Multitaskingleiste mit den zuletzt 
verwendeten Apps angezeigt. Tippen Sie auf eine App, um sie erneut zu öffnen, oder streichen Sie 
nach links oder rechts, um weitere Apps anzuzeigen.
Zuletzt verwendete Apps
21Entfernen einer App aus der 
Multitaskingleiste
Legen Sie den Finger auf ein beliebiges Symbol, bis die Symbole anfangen, 
sich leicht zu bewegen, und tippen Sie dann auf  . Sie können eine App 
auch aus der Multitaskingleiste entfernen, um die App sofort zu beenden.
Blättern
Bewegen Sie einen Finger auf dem Bildschirm, um aufwärts und abwärts zu blättern. Bei einigen 
Bildschirmanzeigen wie Webseiten können Sie auch seitlich blättern.
Beim Blättern mithilfe des Fingers werden die Objekte auf dem Bildschirm nicht ausgewählt oder 
aktiviert.
Streichen Sie mit dem Finger schnell über den Bildschirm, um schnell zu blättern.
Sie können warten, bis der Blättervorgang stoppt, oder den Bildschirm berühren, um den Vorgang 
sofort zu stoppen. Wenn Sie den Bildschirm berühren, um einen Blättervorgang zu stoppen, 
werden keine Objekte ausgewählt oder aktiviert.
Tippen Sie auf die Statusleiste oben auf dem Bildschirm, um schnell an den Anfang einer Seite zu 
blättern.
Legen Sie Ihren Finger auf 
den Index, um schnell zu 
blättern. Tippen Sie auf 
einen Buchstaben, um zu 
einem Bereich zu springen. 
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um welche Art Liste es sich handelt, wird durch Tippen auf ein Objekt eine andere Aktion 
ausgeführt – etwa eine neue Liste geöffnet, ein Musiktitel abgespielt, eine E-Mail angezeigt oder 
die Kontaktdaten einer Person eingeblendet, sodass Sie diese anrufen können.
Verkleinern oder Vergrößern
Bei der Anzeige von Fotos, Webseiten, E-Mails oder Karten können Sie ein- und auszoomen. 
Ziehen Sie die Anzeige mit den Fingern zu oder auf. Bei Fotos und Webseiten können Sie durch 
Doppeltippen (schnelles zweimaliges Tippen) einzoomen und durch nochmaliges Doppeltippen 
auszoomen. Karten lassen sich durch Doppeltippen einzoomen und durch einmaliges Tippen mit 
zwei Fingern auszoomen.
Das Zoomen ist eine Bedienungshilfefunktion, mit der Sie den gesamten Bildschirm einer 
App vergrößern können, um die einzelnen Bestandteile besser sehen zu können. Weitere 
Informationen unter „Zoomen“ auf Seite 174.
Anzeigen im Hoch- oder Querformat
Bei vielen Apps für das iPhone können Sie die Anzeige im Hoch- oder im Querformat verwenden. 
Drehen Sie einfach das iPhone – der Bildschirm wird automatisch mitgedreht und für die neue 
Ausrichtung angepasst.
Das Querformat eignet sich zum Beispiel für die Anzeige von Webseiten in Safari und für die 
Texteingabe. Webseiten werden im Querformat für die größere Bildschirmbreite skaliert, d. h., 
Texte und Bilder werden größer angezeigt. Auch die Bildschirmtastatur ist im Querformat größer.
Filme, die in den Apps „Videos“ und „YouTube“ angezeigt werden, werden nur im Querformat 
wiedergegeben. Ebenso werden Straßenkarten in der App „Karten“ nur im Querformat angezeigt.
Sperren des Bildschirms im Hochformat: Drücken Sie zweimal die Home-Taste  und streichen 
Sie dann unten auf dem Bildschirm mit dem Finger von links nach rechts. Tippen Sie dann auf  .
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im Hochformat gesperrt wurde.
Anpassen des Home-Bildschirms
Neuanordnen von Apps
Sie können die Anordnung der App-Symbole auf dem Home-Bildschirm anpassen und auch die 
Anordnung der Symbole im Dock unten auf dem Bildschirm. Wenn Sie möchten, können Sie 
die Symbole auch in mehreren Home-Bildschirmen anordnen. Sie können Apps auch verwalten, 
indem Sie sie in Ordnern organisieren.
Neuanordnen von Symbolen
1 Legen Sie den Finger auf ein beliebiges Symbol im Home-Bildschirm, bis es anfängt, sich leicht zu 
bewegen.
2 Ordnen Sie die Symbole an, indem Sie sie wunschgemäß bewegen.
3 Drücken Sie die Home-Taste  , um Ihre Änderungen zu sichern.
Bewegen eines Symbols in einen 
anderen Bildschirm
Bewegen Sie beim Anordnen von Apps ein Symbol an den Rand des 
Bildschirms.
Erstellen weiterer HomeBildschirme
Streichen Sie beim Anordnen von Apps mit dem Finger bis an den rechten 
Rand des Home-Bildschirms. Bewegen Sie dann eine App an den rechten 
Rand des Bildschirms. Sie können bis zu elf Bildschirme erstellen.
Zurücksetzen Ihres HomeBildschirms auf die 
Standardanordnung
Wählen Sie „Einstellungen“ > „Allgemein“ > „Zurücksetzen“ und tippen Sie 
auf „Home-Bildschirm“.
Durch das Zurücksetzen des Home-Bildschirms werden alle von Ihnen 
erstellten Ordner entfernt und der Standardhintergrund des HomeBildschirms wiederhergestellt.
Sie können auf dem Home-Bildschirm Apps hinzufügen, um Ihre bevorzugten Webseiten zu 
öffnen. Weitere Informationen unter „Web-Clips“ auf Seite 84.
Wenn das iPhone an den Computer angeschlossen ist (mit dem Dock Connector-auf-USB-Kabel), 
können Sie Ihre Home-Bildschirme in iTunes anpassen. Wählen Sie das iPhone in iTunes in der 
Liste unter „Geräte“ aus und klicken Sie oben auf dem Bildschirm auf „Apps“.
Verwalten mithilfe von Ordnern
Mithilfe von Ordnern können Sie die Apps auf dem Home-Bildschirm verwalten und ordnen. Sie 
können bis zu 12 Apps in einem Ordner ablegen. Das iPhone benennt einen Ordner automatisch, 
wenn Sie ihn erstellen. Maßgeblich hierbei ist die Kategorie der Apps, mit denen Sie den Ordner 
erstellt haben. Sie können den Namen jederzeit ändern. Ebenso wie Apps können auch Ordner 
durch Bewegen auf dem Home-Bildschirm neu angeordnet werden.
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anfängt, sich leicht zu bewegen. Bewegen Sie dann die App auf eine andere App.
Das iPhone erstellt einen neuen Ordner, der beide Apps enthält, und zeigt den Ordnernamen an. 
Sie können auf das Namensfeld tippen und einen anderen Namen eingeben.
Tippen Sie auf einen Ordner, um ihn zu öffnen, und tippen Sie dann auf eine App in diesem 
Ordner. Tippen Sie auf eine Stelle außerhalb des Ordners oder drücken Sie die Home-Taste  , um 
einen Ordner zu schließen.
Anordnen von Apps
Hinzufügen einer App zu einem 
Ordner
Bewegen Sie die App auf den Ordner.
Entfernen einer App aus einem 
Ordner
Tippen Sie, um den Ordner zu öffnen, und bewegen Sie die App aus dem 
Ordner hinaus.
Löschen eines Ordners Bewegen Sie alle Apps aus dem Ordner hinaus. Der Ordner wird 
automatisch gelöscht.
Umbenennen eines Ordners Tippen Sie, um den Ordner zu öffnen. Tippen Sie dann auf den oben 
angezeigten Namen und geben Sie mithilfe der Tastatur einen neuen 
Namen ein.
Wenn Sie Ihren Home-Bildschirm wunschgemäß angeordnet haben, drücken Sie die Home-Taste 
, um Ihre Änderungen zu sichern.
Hinzufügen eines Hintergrundbilds
Sie können ein Bild oder ein Foto als Hintergrundbild für die Anzeigesperre auswählen. Auch für 
den Home-Bildschirm können Sie ein Hintergrundbild festlegen. Wählen Sie ein Bild, das bereits 
auf dem iPhone ist, ein Foto aus Ihrem Album „Aufnahmen“ oder eines aus einem anderen Album 
auf Ihrem iPhone.
Hintergrundbild festlegen
1 Wählen Sie „Einstellungen“ > „Hintergrundbild“, tippen Sie auf das Bild für die Anzeigesperre und 
den Home-Bildschirm und dann auf „Hintergrundbild“ oder auf ein Album.
Kapitel 3    Grundlagen 252 Wählen Sie ein Bild oder Foto durch Tippen aus. Wenn Sie ein Foto gewählt haben, bewegen Sie 
es an die gewünschte Position und vergrößern bzw. verkleinern Sie es durch Auf- und Zuziehen, 
bis es Ihren Wünschen entspricht.
3 Tippen Sie auf „Festlegen“ und wählen Sie dann, ob Sie das Foto als Hintergrundbild für die 
Anzeigesperre, den Home-Bildschirm oder für beide verwenden wollen.
Eingeben von Text, Zahlen und Symbolen
Die Bildschirmtastatur wird immer dann eingeblendet, wenn Sie Text, Zahlen und Symbole 
eingeben müssen.
Eingeben von Text
Geben Sie mithilfe der Tastatur Text ein. Die Tastatur korrigiert Rechtschreibfehler, schlägt während 
der Eingabe Wörter vor und lernt aus Ihren Eingaben. Je nachdem, welche App Sie verwenden, 
schlägt die intelligente Tastatur bei der Eingabe möglicherweise Korrekturen vor. Auf diese Weise 
können Tippfehler vermieden werden.
Eingeben von Text:  Wählen Sie ein Textfeld aus, um die Bildschirmtastatur einzublenden, und 
tippen Sie dann auf die Tastatur.
Während Sie tippen, wird der jeweilige Buchstabe über Ihrem Daumen oder Zeigefinger 
eingeblendet. Wenn Sie auf eine falsche Taste tippen, ziehen Sie Ihren Finger oder Daumen 
einfach auf die richtige Taste. Der Buchstabe wird erst eingegeben, wenn Sie den Finger oder 
Daumen von der Taste nehmen.
Löschen des vorherigen Zeichens Tippen Sie auf  .
Großbuchstaben Tippen Sie auf die Umschalttaste  , bevor Sie einen Buchstaben 
auswählen, oder halten Sie den Finger auf der Umschalttaste und bewegen 
Sie ihn von da aus zum gewünschten Buchstaben.
Schnelles Eingeben von Punkt und 
Leerzeichen
Tippen Sie zweimal auf die Leertaste. Sie können diese Funktion aktivieren 
oder deaktivieren, indem Sie „Einstellungen“ > „Allgemein“ > „Tastatur“ 
wählen.
Verwenden der Auto-Korrektur 
zur Eingabe von „’ll“ (in englischen 
Texten)
Geben Sie „lll“ ein. Geben Sie zum Beispiel „youlll“ ein, um „you‘ll“ zu 
erhalten.
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Umschalttaste, um die Feststelltaste wieder zu deaktivieren. Sie können 
diese Funktion aktivieren oder deaktivieren, indem Sie „Einstellungen“ > 
„Allgemein“ > „Tastatur“ wählen.
Eingeben von Zahlen, Satzzeichen 
oder Symbolen
Tippen Sie auf die Nummerntaste  . Tippen Sie auf die Symboltaste  , 
um weitere Satzzeichen und Symbole anzuzeigen.
Festlegen der Optionen für die 
Texteingabe
Wählen Sie „Einstellungen“ > „Allgemein“ > „Tastatur“.
Um ein alternatives Zeichen 
einzugeben, legen Sie Ihren Finger 
auf eine Taste und schieben Sie ihn 
dann auf die gewünschte Option.
Auto-Korrektur und Rechtschreibprüfung
Bei vielen Sprachen korrigiert das iPhone automatisch Rechtschreibfehler oder schlägt bei der 
Texteingabe Wörter vor. Wenn das iPhone ein Wort vorschlägt, können Sie dieses übernehmen, 
ohne die Texteingabe zu unterbrechen.
Hinweis:  Eine vollständige Liste der unterstützten Sprachen finden Sie auf der folgenden Website: 
www.apple.com/de/iphone/specs.html
Vorgeschlagenes 
Wort
Annehmen eines Vorschlags: Geben Sie ein Leerzeichen, ein Satzzeichen oder ein 
Zeilenendezeichen ein.
Ablehnen eines Vorschlags: Tippen Sie auf das „x“.
Mit jedem Ablehnen eines Vorschlags für dasselbe Wort erhöht sich die Wahrscheinlichkeit, dass 
Ihr iPhone das von Ihnen geschriebene Wort als korrekt interpretiert.
Das iPhone unterstreicht auch Wörter, die Sie bereits eingegeben und möglicherweise falsch 
geschrieben haben.
Ersetzen eines falsch geschriebenen 
Wortes
Tippen Sie auf das Wort und dann auf einen der Vorschläge.
Wenn das gewünschte Wort nicht angezeigt wird, geben Sie es erneut ein.
Aktivieren und Deaktivieren 
der Auto-Korrektur und 
Rechtschreibprüfung
Wählen Sie „Einstellungen“ > „Allgemein“ > „Tastatur“.
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Mit Kurzbefehlen können Sie ein paar Buchstaben anstatt eines langen Wortes oder Satzes 
eingeben. Der ausgeschriebene Text wird angezeigt, sobald Sie den Kurzbefehl wählen. So wird 
„adw“ beispielsweise zu „Auf dem Weg!“. 
Erstellen eines Kurzbefehls:  Tippen Sie auf „Einstellungen“ > „Allgemein“ > „Tastatur“ und dann 
auf „Kurzbefehl hinzufügen“.
Hinzufügen eines Wortes oder Satzes zu Ihrem persönlichen Wörterbuch, damit das iPhone es 
nicht korrigiert oder ersetzt:  Erstellen Sie den Kurzbefehl, lassen Sie das Feld „Kurzbefehl“ jedoch 
leer.
Bearbeiten eines Kurzbefehls Öffnen Sie „Einstellungen“ > „Tastatur“ und tippen Sie dann auf den 
Kurzbefehl.
Bearbeiten von Text
Der Touchscreen-Bildschirm macht es Ihnen besonders leicht, bereits eingegebenen Text zu 
ändern. Die Lupe erleichtert die genaue Positionierung der Einfügemarke an der gewünschten 
Stelle. Mithilfe der Aktivpunkte können Sie schnell mehr oder weniger Text auswählen. Darüber 
hinaus können Sie Text und Fotos innerhalb einer App oder in mehreren Apps ausschneiden, 
kopieren und einsetzen.
Positionieren der Einfügemarke: Tippen und halten Sie den Finger auf einem Textelement, um 
die Lupe einzublenden, und bewegen Sie im vergrößerten Ausschnitt die Einfügemarke an die 
gewünschte Position.
Auswählen von Text: Tippen Sie auf die Einfügemarke, um die Auswahltasten anzuzeigen. 
Sie können ein Wort auch durch Doppeltippen auswählen. Tippen Sie in Dokumenten, auf 
die Sie nur Lesezugriff haben (z. B. Webseiten oder empfangene E-Mails), auf ein Wort, um es 
auszuwählen. Bewegen Sie die Aktivpunkte, um die Auswahl an Textzeichen zu erweitern oder zu 
verringern.
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Text
Wählen Sie Text aus und tippen Sie auf „Ausschneiden“ oder „Kopieren“.
Einsetzen von Text Tippen Sie auf die Einfügemarke und danach auf „Einsetzen“. An der 
Einfügemarke wird der Text eingesetzt, den Sie zuletzt ausgeschnitten oder 
kopiert haben. Wählen Sie alternativ Text aus und tippen Sie auf „Einsetzen“, 
wenn der ausgewählte Text durch den eingesetzten Text ersetzt werden 
soll.
Widerrufen des letzten 
Bearbeitungsvorgangs
Schütteln Sie das iPhone und tippen Sie auf „Widerrufen“.
Formatieren von Text (fett, kursiv, 
unterstreichen)
Tippen Sie, wenn verfügbar, auf  und dann auf „B“/„I“/„U“.
Nachschlagen der Definition eines 
Wortes im Wörterbuch
Tippen Sie, wenn verfügbar, auf  und dann auf „Nachschlagen“.
Übernehmen von Wortvorschlägen Tippen Sie, wenn verfügbar, auf „Vorschlag“ und auf eines der Wörter.
Tastaturbelegungen
In den Einstellungen können Sie die Tastaturbelegungen für Software- und Hardwaretastaturen 
festlegen. Die verfügbaren Tastaturbelegungen hängen von der gewählten Sprache für die 
Tastatur ab.
Auswählen einer Tastaturbelegung: Wählen Sie in den Einstellungen „Allgemein“ > „Tastatur“ > 
„Internationale Tastaturen“ und dann eine Tastatur aus.
Es ist möglich, für jede Sprache unterschiedliche Belegungen für die Softwaretastatur auf 
dem Bildschirm und externe Hardwaretastaturen auszuwählen. Die Softwaretastaturbelegung 
bestimmt das Layout der Tastatur auf dem iPhone-Bildschirm. Die Hardwaretastaturbelegung 
bestimmt das Layout des Apple Wireless Keyboard, das an das iPhone angeschlossen ist.
Verwenden eines Apple Wireless Keyboard
Sie können zur Eingabe von Text auf dem iPhone auch ein Apple Wireless Keyboard (separat 
erhältlich) verwenden. Das Apple Wireless Keyboard wird über Bluetooth verbunden. Weitere 
Informationen unter „Koppeln eines Bluetooth-Geräts mit dem iPhone“ auf Seite 37.
Nach dem Koppeln der Tastatur mit dem iPhone wird die Verbindung hergestellt, sobald sich 
die Tastatur in Reichweite (bis zu ca. 10 m) befindet. Sie können feststellen, dass die Tastatur 
verbunden ist, wenn die Bildschirmtastatur beim Tippen auf ein Textfeld nicht eingeblendet wird. 
Schalten Sie die Tastatur aus oder trennen Sie die Verbindung, um die Batterie zu schonen, wenn 
Sie sie nicht verwenden.
Diktieren
Mit der Diktierfunktion erstellen und bearbeiten Sie Text, statt ihn über die Tastatur einzugeben. 
So können Sie beispielsweise E-Mails, Nachrichten und Notizen diktieren. Da die Diktierfunktion 
auch mit Apps anderer Hersteller verwendet werden kann, können Sie unter anderem Ihren 
Facebook-Status aktualisieren, Tweets posten oder Instagramme zu schreiben oder zu senden. Sie 
können jederzeit diktieren, wenn die Bildschirmtastatur mit der  -Taste angezeigt wird.
Hinweis:  Aktivieren Sie Siri in „Einstellungen“ > „Allgemein“ > „Siri“. Die Diktierfunktion ist nur 
auf dem iPhone 4S verfügbar und benötigt einen Internetzugang über eine Mobilfunk- oder 
WLAN-Verbindung. Möglicherweise ist die Diktierfunktion nicht in allen Sprachen oder Regionen 
verfügbar. Die Funktionen variieren je nach Region. Es können Roaming-Gebühren anfallen.
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Tippen, um Diktat 
zu starten
Werden angezeigt, 
während Siri den Text 
nach Ihrem Diktat 
zusammenstellt.
Zum Hinzufügen von Text tippen Sie erneut auf  und diktieren weiter. 
Sie können die Diktierfunktion zum Einfügen eines Worts oder zum Ersetzen von ausgewähltem 
Text verwenden. Platzieren Sie die Einfügemarke an der Stelle, an der Sie weiteren Text einfügen 
möchten, oder wählen Sie den Text aus, der ersetzt werden soll. Tippen Sie dann auf  und 
diktieren Sie den Text. Zum Ändern eines Worts wählen Sie es durch Doppeltippen aus, tippen auf 
 und sprechen das gewünschte Wort.
Zum Starten des Diktats können Sie das iPhone auch an Ihr Ohr halten, statt auf der Tastatur auf 
zu tippen. Zum Beenden des Diktats halten Sie das iPhone einfach vor sich.
Satzzeichen hinzufügen:  Nennen Sie das entsprechende Satzzeichen. 
Sprechen Sie beispielsweise „Liebe Maria Komma der Scheck ist in der Post Ausrufezeichen“ das 
Ergebnis ist: „Liebe Maria, der Scheck ist in der Post!”
Drucken
AirPrint
Mit AirPrint können Sie drahtlos auf AirPrint-fähigen Druckern drucken. Sie können in folgenden 
Apps drucken:
Â Mail: E-Mail-Nachrichten und Anhänge, die mit der Übersicht angezeigt werden können
Â Fotos und Kamera: Fotos
Â Safari: Webseiten, PDFs und andere Anhänge, die mit der Übersicht angezeigt werden können
Â iBooks: PDF-Dokumente
Â Karten: Kartenausschnitt, der auf dem Bildschirm angezeigt wird
Â Notizen: Angezeigte Notiz
Möglicherweise wird AirPrint auch von anderen im App Store verfügbaren Apps unterstützt.
Für AirPrint-fähige Drucker ist keine Druckersoftware erforderlich. Sie müssen lediglich mit 
demselben WLAN-Netzwerk wie das iPhone verbunden sein. Weitere Informationen erhalten Sie 
unter support.apple.com/kb/HT4356?viewlocale=de_DE.
Drucken eines Dokuments
AirPrint verwendet Ihr WLAN-Netzwerk zum drahtlosen Senden von Druckaufträgen an Ihren 
Drucker. iPhone und Drucker müssen sich im gleichen WLAN-Netzwerk befinden.
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Sie dann „Drucken“. Wählen Sie einen Drucker und die Druckoptionen aus und tippen Sie auf 
„Drucken“.
Anzeigen des Status von 
Druckaufträgen
Drücken Sie zweimal die Home-Taste  und tippen Sie auf „Druckzentrale“.
Die App „Druckzentrale“ wird als zuletzt verwendete App angezeigt, wenn ein Dokument gedruckt 
wird. Auf der App wird ein Kennzeichen eingeblendet, das die Anzahl der Dokumente in der 
Warteschlange angibt.
Wenn Sie mehrere Dokumente drucken, wählen Sie einen Druckauftrag aus, um seinen Status 
anzuzeigen.
Abbrechen von Druckaufträgen Tippen Sie zweimal auf die Home-Taste  , tippen Sie auf „Druckzentrale“ 
und wählen Sie den Druckauftrag aus (sofern Sie mehrere Dokumente 
drucken). Tippen Sie dann auf „Drucken abbrechen“.
Suchen
Sie können viele Apps auf dem iPhone durchsuchen, einschließlich „Kontakte“, „Mail“, „Kalender“, 
„Musik“, „Nachrichten“, „Notizen“ und „Erinnerungen“. Sie können einzelne Apps oder alle Apps 
gleichzeitig durchsuchen.
Durchsuchen des iPhone:  Gehen Sie zum Such-Bildschirm. (Wenn Sie auf der Hauptseite des 
Home-Bildschirms sind, streichen Sie mit dem Finger nach rechts oder drücken die Home-Taste 
.) Geben Sie den gesuchten Text in das Feld „iPhone durchsuchen“ ein.
Die Suchergebnisse werden parallel zur Texteingabe angezeigt. Tippen Sie auf einen Eintrag in der 
Liste, um das betreffende Objekt in der jeweiligen App zu öffnen. Tippen Sie auf „Suchen“, um die 
Tastatur auszublenden, sodass mehr Suchergebnisse angezeigt werden können.
Anhand der Symbole neben den Suchergebnissen können Sie erkennen, aus welcher App das 
Suchergebnis stammt.
Das iPhone zeigt entsprechend Ihrer vorherigen Suchen die besten Treffer an. Safari bietet bei den 
Suchergebnissen die Option an, das Internet oder Wikipedia zu durchsuchen.
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Kontakte Vor-, Nach- und Firmennamen
Mail Felder „An“, „Von“ und „Betreff“ und die Mitteilungen aus allen Accounts
Kalender Veranstaltungsnamen, eingeladene Personen, Veranstaltungsorte und 
Notizen
Musik Musik (Namen von Musiktiteln, Interpreten und Alben) sowie Namen von 
Podcasts, Videos und Hörbüchern
Nachrichten Namen und Text von Nachrichten
Notizen Textinhalt der Notizen
Erinnerungen Titel
Die App „Suche“ durchsucht außerdem die Namen der nativen und nachträglich installierten Apps 
auf dem iPhone. Daher können Sie, wenn sehr viele Apps installiert sind, die Suche auch dazu 
verwenden, nach einer App zu suchen, um sie gezielt zu öffnen.
Öffnen von Apps mithilfe der Suche Geben Sie den Namen der gesuchten App ein und tippen Sie in der 
Ergebnisliste auf den Eintrag der App, um sie zu öffnen.
In den Spotlight-Sucheinstellungen können Sie festlegen, welche Inhalte durchsucht werden und 
in welcher Reihenfolge die Suchergebnisse angezeigt werden. Vgl. „Spotlight-Suche“ auf Seite 188.
Sprachsteuerung
Die Sprachsteuerung bietet die Möglichkeit, mittels gesprochener Befehle Telefonanrufe zu 
tätigen und die Musikwiedergabe zu steuern. Mit dem iPhone 4S können Sie dank Siri das iPhone 
über Ihre Stimme steuern. Weitere Informationen unter Kapitel 4,„Siri,“ auf Seite 43.
Hinweis:  Die Sprachsteuerung steht möglicherweise nicht in allen Sprachen zur Verfügung. Wenn 
Siri aktiviert ist, steht die Sprachsteuerung auf dem iPhone 4S nicht zur Verfügung.
Verwenden der Sprachsteuerung: Halten Sie die Home-Taste gedrückt  , bis der Bildschirm 
mit den Optionen für die Sprachsteuerung angezeigt wird und Sie ein akustisches Signal hören. 
Alternativ können Sie auf den iPhone-Kopfhörern die Mitteltaste drücken.
Die besten Ergebnisse erzielen Sie, wenn Sie Folgendes beachten:
Â Sprechen Sie in das iPhone-Mikrofon, als würden Sie jemanden anrufen. Sie können auch das 
Mikrofon Ihres Bluetooth-Headsets oder ein kompatibles Bluetooth-Auto-Kit verwenden.
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Â Verwenden Sie ausschließlich iPhone-Befehle und -Namen sowie Zahlen. Machen Sie zwischen 
Befehlen kurze Pausen.
Â Verwenden Sie vollständige Namen.
Weitere Informationen zur Sprachsteuerung, einschließlich Informationen zur Verwendung 
der Sprachsteuerung in verschiedenen Sprachen, finden Sie unter support.apple.com/kb/
HT3597?viewlocale=de_DE.
Die Sprachsteuerung erwartet normalerweise, dass Sie die Sprachsteuerungsbefehle in 
der Landessprache sprechen, die für das iPhone eingestellt ist (im Bereich „Allgemein“ > 
„Landeseinstellungen“ > „Sprache“). Sie können in den Einstellungen für die Sprachsteuerung 
eine abweichende Sprache für die Sprachbefehle festlegen. Für einige Sprachen werden darüber 
hinaus bestimmte Dialekte und Akzente unterstützt.
Ändern der Sprache und des Landes: Tippen Sie auf „Einstellungen“, wählen Sie „Allgemein“ > 
„Landeseinstellungen“ > „Sprachstrg.“ aus und tippen Sie auf die entsprechende Sprache oder 
Region.
Für die App „Musik“ ist die Sprachsteuerung standardmäßig eingeschaltet. Sie können aber aus 
Sicherheitsgründen veranlassen, dass bei gesperrtem iPhone die Sprachwahl verhindert wird.
Verhindern der Sprachwahl, wenn das iPhone gesperrt ist: Tippen Sie auf „Einstellungen“, 
wählen Sie „Allgemein“ > „Code-Sperre“ und deaktivieren Sie die Option für die Sprachwahl. 
Entsperren Sie das iPhone, um die Sprachwahl (Voice Dialing) zu aktivieren.
Weitere Informationen unter „Sprachwahl“ auf Seite 63 und „Verwenden von Siri bzw. der 
Sprachsteuerung mit der App „Musik““ auf Seite 88.
Benachrichtigungen
In der Mitteilungszentrale werden alle Ihre Mitteilungen angezeigt. Dazu gehören Mitteilungen 
über:
Â Verpasste Anrufe und Sprachmitteilungen
Â Neue E-Mail
Â Neue Nachrichten
Â Erinnerungen
Â Kalenderereignisse
Â Kontaktanfragen (Game Center)
Â Wetter
Â Aktien
Kapitel 3    Grundlagen 33Anzeigen der Mitteilungszentrale: Streichen Sie auf dem Bildschirm von oben nach unten. 
Durchblättern Sie die Liste, um weitere Mitteilungen zu sehen.
Mitteilungen werden auch auf dem gesperrten Bildschirm oder oben auf dem Bildschirm 
angezeigt, wenn Sie das iPhone benutzen. In der Mitteilungszentrale sehen Sie alle aktuellen 
Mitteilungen.
Viele Apps wie Telefon, Nachrichten, Mail und der App Store zeigen auf ihren Symbolen im HomeBildschirm ein Kennzeichen mit einer Zahl (für eingehende Objekte) oder ein Ausrufezeichen 
(für ein Problem) an. Befinden sich diese Apps in einem Ordner, wird dieses Kennzeichen auf 
dem Ordner angezeigt. Ein Kennzeichen mit einer Nummer zeigt die Anzahl der Objekte an, die 
Sie noch nicht bearbeitet haben, etwa eingehende Telefonanrufe, E-Mails, Nachrichten sowie 
aktualisierte Apps zum Laden. Ein Kennzeichen mit einem Ausrufezeichen weist auf ein Problem 
mit einer App hin. 
Antworten auf einen Hinweis in der 
Mitteilungszentrale
Tippen Sie auf den Hinweis.
Antworten auf eine Mitteilung bei 
gesperrtem Bildschirm
Wischen Sie das Symbol, das in der Mitteilung angezeigt wird, nach rechts.
Entfernen von Mitteilungen aus der 
Mitteilungszentrale
Tippen Sie auf  und anschließend auf „Löschen“.
Festlegen der 
Benachrichtigungsoptionen
Wählen Sie „Einstellungen“ > „Mitteilungen“.
Twitter
Melden Sie sich unter „Einstellungen“ bei Ihrem Twitter-Account an (oder erstellen Sie einen), um 
Tweets mit Anhängen von den folgenden Apps zu aktivieren:
Â „Kamera“ oder „Fotos“: Foto als Anhang
Â Safari: Webseite als Anhang
Â Karten: Ort als Anhang 
Â YouTube: Video als Anhang
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„Einstellungen“ > „Twitter“. Geben Sie den Benutzernamen und das Kennwort eines bestehenden 
Accounts sein oder tippen Sie auf „Neuen Account erstellen“.
Tippen Sie in „Kamera“ 
oder „Fotos“ auf die 
Aktionstaste, um ein 
Foto auf Twitter zu 
veröffentlichen.
Veröffentlichen Sie 
ein Foto auf Twitter.
Veröffentlichen eines Fotos, eines 
Videos oder einer Webseite auf 
Twitter
Zeigen Sie das Objekt an, tippen Sie auf  und dann auf „Tweet“. Wird 
nicht angezeigt, tippen Sie auf den Bildschirm.
Um Ihren Standort hinzuzufügen, wählen Sie „Ort hinzufügen“. Aktivieren 
Sie die Ortungsdienste in „Einstellungen“ > „Ortungsdienste“.
Anzeigen des Standorts mit Twitter 
in der App „Karten“
Tippen Sie auf die Stecknadel, auf  , auf „Ort senden“ und dann auf 
„Tweet“. 
Hinzufügen Ihres aktuellen Ortes 
zu einem Tweet
Tippen Sie auf  . Aktivieren Sie die Ortungsdienste in „Einstellungen“ > 
„Ortungsdienste“.
Hinzufügen von TwitterBenutzernamen und Fotos zu 
Kontakten
Öffnen Sie „Einstellungen“ > „Twitter“ und tippen Sie auf „Kontakte 
aktualisieren“.
Aktivieren/Deaktivieren von Twitter 
für „Fotos“ oder „Safari“
Wählen Sie „Einstellungen“ > „Twitter“.
Wenn Sie einen Tweet verfassen, zeigt die Zahl unten links im Tweet-Bildschirm die Anzahl der 
verbleibenden Zeichen an. Beachten Sie, dass Anhänge einige der 140 zulässigen Zeichen eines 
Tweets beanspruchen.
Alternativ können Sie die Twitter-App installieren, um Tweets zu veröffentlichen, Ihre Timeline 
anzuzeigen, nach trendigen Themen zu suchen und vieles mehr.
Installieren der Twitter-App:  Öffnen Sie „Einstellungen“ > „Twitter“ und tippen Sie auf 
„Installieren“.
Um zu erfahren, wie die Twitter-App funktioniert, öffnen Sie sie, tippen Sie auf „…“, dann auf 
„Konten und Einstellungen“, „Einstellungen“ und anschließend auf „Handbuch“.
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Die Apple Earphones mit Fernbedienung und Mikrofon, die mit dem iPhone mitgeliefert werden, 
haben ein Mikrofon, einen Lautstärkeregler und eine eingebaute Taste, mit der Sie Anrufe 
annehmen und beenden sowie die Audio- und Videowiedergabe steuern können.
Mitteltaste
Verbinden Sie die Ohrhörer mit dem Gerät, um Musik zu hören oder zu telefonieren. Drücken Sie 
die Mitteltaste, um die Musikwiedergabe zu steuern und Anrufe anzunehmen oder zu beenden. 
Dies funktioniert auch, wenn das iPhone gesperrt ist.
Anhalten eines Musiktitels oder 
Videos
Drücken Sie die Mitteltaste. Durch erneutes Drücken wird die Wiedergabe 
fortgesetzt.
Wechseln zum nächsten Musiktitel Drücken Sie die Mitteltaste zweimal schnell hintereinander.
Zurückkehren zum vorherigen 
Musiktitel
Drücken Sie die Mitteltaste dreimal schnell hintereinander.
Schneller Vorlauf Drücken Sie die Mitteltaste zweimal schnell hintereinander und halten Sie 
sie gedrückt.
Schneller Rücklauf Drücken Sie die Mitteltaste dreimal schnell hintereinander und halten Sie 
sie gedrückt.
Anpassen der Lautstärke Drücken Sie auf die Taste „+“ oder „-“.
Annehmen eines eingehenden 
Anrufs
Drücken Sie die Mitteltaste.
Beenden des aktuellen Anrufs Drücken Sie die Mitteltaste.
Ablehnen eines eingehenden 
Anrufs
Drücken Sie die Mitteltaste und lassen Sie sie erst nach ungefähr 2 
Sekunden wieder los. Zwei Pieptöne geben an, dass der Anruf abgelehnt 
wurde.
Wechseln zu einem eingehenden 
oder gehaltenen Anruf und Halten 
des aktuellen Anrufs
Drücken Sie die Mitteltaste. Drücken Sie die Taste erneut, um wieder zurück 
zum ersten Anruf zu wechseln.
Wechseln zu einem eingehenden 
oder gehaltenen Anruf und 
Beenden des aktuellen Anrufs
Drücken Sie die Mitteltaste und lassen Sie sie erst nach ungefähr 2 
Sekunden wieder los. Zwei Pieptöne geben an, dass der erste Anruf 
beendet wurde.
Verwenden von Siri bzw. der 
Sprachsteuerung
Drücken und halten Sie die Mitteltaste. Weitere Informationen unter 
Kapitel 4,„Siri,“ auf Seite 43 oder „Sprachsteuerung“ auf Seite 32.
Wenn Sie einen Anruf erhalten, während die Ohrhörer angeschlossen sind, wird der Klingelton 
über den Lautsprecher des iPhone und über die Ohrhörer ausgegeben.
AirPlay
Mithilfe von AirPlay und Apple TV können Sie Musik, Fotos und Videos drahtlos an Ihr HDFernsehgerät streamen. Sie können mit AirPlay auch Audiodateien an eine Airport ExpressBasisstation übertragen. Andere AirPlay-fähige Receiver sind von Drittanbietern erhältlich. Weitere 
Details erhalten Sie im Apple Store.
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Musik, tippen Sie auf  und wählen Sie das AirPlay-Gerät aus. Sobald das Streaming beginnt, 
können Sie die App schließen, die den Inhalt wiedergibt.
Das iPhone und das AirPlay-Gerät müssen sich im gleichen WLAN-Netzwerk befinden.
Schneller Zugriff auf die AirPlaySteuerung
Drücken Sie bei eingeschaltetem Bildschirm zweimal die Home-Taste 
und scrollen Sie in der Multitaskingleiste nach links.
Ändern der Tonausgabe von AirPlay 
zurück zum iPhone
Tippen Sie auf  und wählen Sie iPhone.
Sie können mit dem iPhone 4S den iPhone-Bildschirm über Apple TV mit einem Fernseher 
synchronisieren. Alle Elemente des iPhone-Bildschirms werden auf dem Fernseher angezeigt.
Synchronisieren des iPhone-Bildschirms auf einem Fernseher:  Tippen Sie links in der 
Multitaskingleiste auf  , wählen Sie ein Apple TV und tippen Sie auf die angezeigte Taste 
„Synchronisierung“.
Wenn die AirPlay-Synchronisierung aktiviert ist, wird oben auf dem iPhone 4S-Bildschirm eine 
blaue Leiste angezeigt. Sie können den iPhone-Inhalt auch mithilfe eines Kabels mit dem 
Fernseher synchronisieren. Weitere Informationen unter „Ansehen eines Videos auf einem 
Fernsehgerät“ auf Seite 145.
Bluetooth-Geräte
Sie können das iPhone mit dem Apple Wireless Keyboard und anderen Bluetooth-Geräten 
verwenden, z. B. mit Bluetooth-Headsets, -Auto-Kits und Stereokopfhörern. Bluetooth-Kopfhörer 
anderer Hersteller unterstützen möglicherweise die Bedienelemente für Lautstärke und 
Wiedergabe. Beachten Sie die Informationen in der Dokumentation zu Ihrem Bluetooth-Gerät. 
Unterstützte Bluetooth-Profile finden Sie unter: support.apple.com/kb/HT3647?viewlocale=de_DE.
Koppeln eines Bluetooth-Geräts mit dem iPhone
ACHTUNG:  Wichtige Hinweise zur Vermeidung von Hörschäden und zur Sicherheit im 
Straßenverkehr finden Sie im Handbuch Wichtige Produktinformationen unter  
http://www.apple.com/de/support/manuals/iphone.
Um ein Bluetooth-Gerät mit dem iPhone zu verwenden, müssen Sie es zunächst koppeln.
Bluetooth-Headset, -Auto-Kit oder anderes Gerät mit dem iPhone koppeln
1 Befolgen Sie die Anleitungen, die Sie mit dem Gerät erhalten haben, um das Gerät so 
einzurichten, dass es erkannt werden kann oder nach anderen Bluetooth-Geräten sucht.
2 Wählen Sie „Einstellungen“ > „Allgemein“ > „Bluetooth“ und aktivieren Sie Bluetooth.
3 Wählen Sie das Gerät auf dem iPhone aus und geben Sie den Code oder die PIN-Nummer ein. 
Weitere Informationen hierzu finden Sie in den Anleitungen zur Kennung oder PIN-Nummer, die 
Sie mit dem Gerät erhalten haben.
Nach dem Koppeln eines Bluetooth-Geräts mit dem iPhone müssen Sie eine Verbindung 
herstellen, damit das iPhone für Anrufe das entsprechende Gerät verwendet. Beachten Sie die 
Informationen in der Dokumentation zu dem Gerät.
Wenn das iPhone mit einem Bluetooth-Headset oder -Auto-Kit verbunden ist, werden abgehende 
Anrufe über dieses Gerät weitergeleitet. Eingehende Anrufe werden an das Gerät weitergeleitet, 
wenn Sie Anrufe mit diesem entgegennehmen. Die Anrufe werden an das iPhone weitergeleitet, 
wenn Sie sie mit dem iPhone annehmen.
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1 Wählen Sie „Einstellungen“ > „Allgemein“ > „Bluetooth“ und aktivieren Sie Bluetooth.
2 Drücken Sie den Ein-/Ausschalter am Apple Wireless Keyboard, um es einzuschalten.
3 Wählen Sie auf dem iPhone die unter „Geräte“ aufgelistete Tastatur aus.
4 Geben Sie die Kennung auf der Tastatur nach Anleitung ein und drücken Sie den Zeilenschalter.
Hinweis:  Es kann nur ein Apple Wireless Keyboard mit dem iPhone gekoppelt werden. Wenn 
Sie eine andere Tastatur koppeln wollen, müssen Sie zunächst die Verbindung zur derzeit 
verwendeten Tastatur trennen.
Weitere Informationen unter „Verwenden eines Apple Wireless Keyboard“ auf Seite 29.
Bluetooth-Status
Das Bluetooth-Symbol wird oben im Bildschirm in der Statusleiste des iPhone angezeigt:
Â oder  :  Zeigt, dass Bluetooth aktiviert und mit einem Gerät gekoppelt ist. (Die Farbe wird 
durch die aktuelle Farbe der Statusleiste bestimmt.)
Â :  Bluetooth ist aktiviert und mit einem Gerät gekoppelt, das Gerät befindet sich jedoch außer 
Reichweite oder ist ausgeschaltet.
Â Kein Bluetooth-Symbol:  Bluetooth ist deaktiviert oder nicht mit einem Gerät gekoppelt.
Trennen eines Bluetooth-Geräts vom iPhone
Wenn Sie ein Bluetooth-Gerät nicht mehr mit dem iPhone verwenden möchten, können Sie es 
trennen.
Bluetooth-Gerät trennen
1 Wählen Sie „Einstellungen“ > „Allgemein“ > „Bluetooth“ und aktivieren Sie Bluetooth.
2 Tippen Sie auf  neben dem Gerät und dann auf „Dieses Gerät ignorieren“.
Batterie
Das iPhone hat eine eingebaute aufladbare Batterie.
Aufladen der Batterie
ACHTUNG:  Wichtige Sicherheitshinweise zum Aufladen des iPhone finden Sie im Handbuch 
Wichtige Produktinformationen unter http://www.apple.com/de/support/manuals/iphone. 
Das Batteriesymbol oben rechts im Bildschirm zeigt den Ladezustand der Batterie an. Sie 
können den Ladezustand auch als prozentualen Wert anzeigen. Wählen Sie in den Einstellungen 
„Allgemein“ > „Benutzung“ und aktivieren Sie die Option unter „Batterieverbrauch“.
Wird geladen Aufgeladen
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Hinweis:  Wenn das iPhone an die Stromversorgung angeschlossen wird, kann dies zu einem 
iCloud-Backup oder einer WLAN-Synchronisierung mit iTunes führen. Weitere Informationen unter 
„Erstellen eines iPhone-Backups“ auf Seite 198 und „Synchronisieren mit iTunes“ auf Seite 19.
Aufladen der Batterie und Synchronisieren des iPhone: Verbinden Sie das iPhone über das 
mitgelieferte Dock Connector-auf-USB-Kabel mit dem Computer. Oder verbinden Sie das iPhone 
über das mitgelieferte Kabel und das Dock mit dem Computer (separat erhältlich).
Verbinden Sie das iPhone mit einem USB 2.0-Anschluss Ihres Computers, es sei denn, Ihre Tastatur 
ist mit einem High-Power-USB 2.0-Anschluss ausgestattet.
Wichtig:  Die Batterie des iPhone wird möglicherweise entladen anstatt aufgeladen, wenn das 
iPhone mit einem Computer verbunden wird, der ausgeschaltet ist oder sich im Ruhezustand bzw. 
Standby-Modus befindet.
Wenn Sie die Batterie laden, während das iPhone synchronisiert oder aufgeladen wird, kann der 
Ladevorgang länger dauern. 
Wichtig:  Bei geringer Batterieladung des iPhone wird unter Umständen einer der folgenden 
Batteriewarnhinweise eingeblendet, um Sie darauf aufmerksam zu machen, dass das iPhone 
mindestens 10 Minuten lang aufgeladen werden muss, bevor Sie es wieder verwenden können. 
Ist die Batterie des iPhone nahezu vollständig entladen, bleibt die Bildschirmanzeige unter 
Umständen bis zu zwei Minuten lang leer, bevor einer der Batteriewarnhinweise eingeblendet 
wird.
oder
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Das iPhone verwendet eine Lithium-Ionen-Batterie. Weitere Informationen dazu, wie Sie die 
Lebensdauer der Batterie des iPhone maximieren und Batteriestrom sparen können, finden Sie auf 
der folgenden Website: www.apple.com/de/batteries.
Austauschen der Batterie
Die Anzahl der Ladezyklen von wiederaufladbaren Batterien ist begrenzt. Daher müssen diese 
Batterien irgendwann ersetzt werden. Die Batterie ist fest im iPhone verbaut und darf nicht 
vom Benutzer ausgetauscht werden. Sie darf nur von einem autorisierten Apple Service-Partner 
ausgewechselt werden. Weitere Informationen erhalten Sie unter www.apple.com/de/support/
iphone/service/battery.
Sicherheits- und Schutzfunktionen
Die Sicherheits- und Schutzfunktionen helfen Ihnen, die Informationen auf dem iPhone vor 
unbefugtem Zugriff zu schützen.
Codes und Datenschutz
Sie können einen Code festlegen, der eingegeben werden muss, wann immer das iPhone 
eingeschaltet oder sein Ruhezustand beendet wird.
Festlegen eines Codes: Wählen Sie in den Einstellungen „Allgemein“ > „Code-Sperre“ und geben 
Sie einen vierstelligen Code ein. Geben Sie den Code danach ein weiteres Mal ein, um ihn zu 
bestätigen. Das iPhone fordert Sie dazu auf, den Code einzugeben, um es zu entsperren bzw. um 
die Code-Einstellungen anzuzeigen.
Durch das Festlegen eines Codes wird der Datenschutz aktiviert . Die Schutzfunktion für Ihre 
Daten verwendet den Code zum Verschlüsseln von E-Mail-Nachrichten und deren Anhänge, die 
auf dem iPhone gespeichert sind. (Diese Funktion wird möglicherweise auch von einigen Apps 
verwendet, die im App Store erhältlich sind.) Unten auf dem Bildschirm für die Code-Sperre in den 
Einstellungen wird angezeigt, wenn die Datenschutzfunktion aktiviert ist.
Sie können die Sicherheit für das iPhone erhöhen, indem Sie statt eines einfachen Codes einen 
längeren Code verwenden, der aus einer Kombination von Zahlen, Buchstaben, Satz- und 
Sonderzeichen besteht. Weitere Informationen unter „Code-Sperre“ auf Seite 188.
Wichtig:  Auf einem iPhone 3GS, das nicht mit iOS 4 oder neuer ausgeliefert wurde, müssen Sie 
zum Aktivieren der Schutzfunktion die iOS-Software wiederherstellen. Weitere Informationen 
unter „Aktualisieren und Wiederherstellen der iPhone-Software“ auf Seite 200.
Verhindern der Sprachwahl, wenn das iPhone gesperrt ist: Tippen Sie auf „Einstellungen“, 
wählen Sie „Allgemein“ > „Code-Sperre“ und deaktivieren Sie die Option für die Sprachwahl. 
Entsperren Sie das iPhone, um die Sprachwahl (Voice Dialing) zu aktivieren.
Mein iPhone suchen
Die Funktion „Mein iPhone suchen“ kann Ihnen dabei helfen, Ihr iPhone zu orten und zu schützen. 
Verwenden Sie hierzu die kostenlose App „Mein iPhone suchen“ auf einem anderen iPhone, iPad 
oder iPod touch oder den Webbrowser auf einem Mac oder PC, wenn Sie bei www.icloud.com
oder www.me.com angemeldet sind.
„Mein iPhone suchen“ beinhaltet:
Â Anzeigen der Position auf einer Karte: Die ungefähre Position Ihres iPhone wird auf einer 
Karte angezeigt.
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die auf dem Bildschirm Ihres iPhone angezeigt wird, oder einen Ton festlegen, der bei voller 
Lautstärke zwei Minuten lang wiedergegeben wird, und zwar auch, wenn der Schalter „Klingeln/
Aus“ in die Position „Aus“ gesetzt wurde.
Â Code-Sperre per Fernzugriff: Diese Funktion ermöglicht das Sperren des iPhone per 
Fernzugriff und das Erstellen eines vierstelligen Codes, sofern Sie noch keinen festgelegt hatten.
Â Fernlöschen: Mithilfe dieser Funktion können Sie Ihre privaten Daten schützen, indem Sie alle 
Medien und Daten auf dem iPhone löschen und die Werkseinstellungen wiederherstellen.
Wichtig:  Um diese Funktion zu verwenden, müssen Sie in den iCloud- oder MobileMeEinstellungen auf Ihrem iPhone die Option „Mein iPhone suchen“ aktivieren. „Mein iPhone suchen“ 
kann nur in einem Account aktiviert werden.
Aktivieren von „Mein iPhone 
suchen“ in der iCloud
Öffnen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie „Mein iPhone 
suchen“. 
Aktivieren von „Mein iPhone 
suchen“ mit MobileMe
Öffnen Sie „Einstellungen“ > „Mail, Kontakte Kalender“, tippen Sie auf Ihren 
MobileMe-Account und aktivieren Sie „Mein iPhone suchen“. 
Weitere Informationen unter „iCloud“ auf Seite 18 oder „Konfigurieren von Mail und anderen 
Accounts“ auf Seite 17.
Reinigen des iPhone
Säubern Sie das iPhone sofort, wenn es mit Substanzen in Kontakt gekommen ist, die Flecken 
verursachen, wie etwa Tinte, Farbe, Makeup, Schmutz, Lebensmittel, Öle oder Lotionen. Zum 
Reinigen des iPhone trennen Sie alle Kabel und schalten das iPhone aus (drücken und halten Sie 
die Ein-/Aus-Taste und bewegen Sie dann den Finger auf dem Schieberegler). Verwenden Sie ein 
weiches, leicht angefeuchtetes und fusselfreies Tuch. Achten Sie darauf, dass keine Feuchtigkeit in 
das Gehäuse eindringt. Verwenden Sie keine Fensterreiniger, Haushaltsreiniger, Druckluft, Sprays, 
Lösungsmittel, alkoholhaltigen Reiniger, Ammoniaklösungen oder Scheuermittel für die Reinigung 
des iPhone. Die Vorderseite des iPhone 3GS und die Vorder- und Rückseite des iPhone 4S und 
iPhone 4 besteht aus Glas und besitzt eine schmutzabweisende (oleophobe) Beschichtung. 
Zum Reinigen wischen Sie diese Flächen mit einem weichen, fusselfreien Tuch ab. Bei normaler 
Benutzung lässt die schmutzabweisende Wirkung mit der Zeit nach. Wenn Sie den Bildschirm mit 
Scheuermitteln reinigen, wird dieser Schutzeffekt weiter verringert und die Bildschirmoberfläche 
kann Kratzer bekommen.
Weitere Informationen zum Umgang mit dem iPhone finden Sie im Handbuch iPhone Wichtige 
Produktinformationen unter www.apple.com/de/support/manuals/iphone.
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Treten funktionelle Probleme auf, versuchen Sie, das iPhone neu zu starten, beenden Sie die 
betreffende App sofort oder setzen Sie das iPhone zurück.
Neustarten des iPhone: Drücken und halten Sie die Ein-/Aus-Taste, bis der rote Schieberegler 
angezeigt wird. Bewegen Sie den Schieberegler mit dem Finger, um das iPhone auszuschalten. 
Drücken und halten Sie die Ein-/Aus-Taste, bis das Apple-Logo angezeigt wird, um das iPhone 
erneut einzuschalten.
Wenn Sie das iPhone nicht ausschalten können oder das Problem weiterhin besteht, müssen Sie 
das iPhone möglicherweise zurücksetzen. Das Zurücksetzen sollte aber nur erfolgen, wenn ein 
Fehler durch das Aus- und erneute Einschalten des iPhone nicht behoben werden konnte.
Sofortiges Beenden einer App: Drücken Sie die Ein-/Aus-Taste einige Sekunden lang, bis ein roter 
Regler eingeblendet wird. Drücken Sie danach die Home-Taste  und halten Sie sie gedrückt, bis 
die verwendete App beendet wird.
Sie können eine App sofort beenden, indem Sie sie aus der Liste der Multitaskingleiste löschen. 
Weitere Informationen unter „Öffnen und Wechseln von Apps“ auf Seite 21.
Zurücksetzen des iPhone: Drücken Sie die Ein-/Aus-Taste und die Home-Taste  mindestens 
zehn Sekunden lang, bis das Apple-Logo angezeigt wird.
Weitere Informationen zur Fehlerbeseitigung unter Anhang B,„Support und weitere 
Informationen,“ auf Seite 198.
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Siri
Siri ist der intelligente persönliche Assistent, dem Sie sagen können, welche Aufgaben zu 
erledigen sind. Siri versteht, was Sie sagen und meinen. Deshalb ist es auch nicht notwendig, 
spezielle Befehle zu erlernen und sich an Schlagwörter zu erinnern. Sie können Ihre Anweisungen 
auf unterschiedliche Art und Weise sagen. Sagen Sie zum Beispiel „Stelle einen Wecker für 6:30 Uhr 
morgens“ oder „Wecke mich um 6:30 Uhr“. Egal, wie Sie es sagen, Siri versteht es.
Mit Siri können Sie Nachrichten eingeben und senden, Termine festlegen, Telefonnummern 
wählen, Wegbeschreibungen abrufen, Erinnerungen festhalten, das Internet durchsuchen – und 
vieles mehr. Und das ganz einfach, indem Sie ganz normal sprechen. Siri versteht, was Sie sagen, 
und weiß, was Sie meinen. Siri reagiert auf das, was Sie gesagt haben, damit Sie wissen, ob es 
korrekt verstanden wurde. Und Siri fragt nach, wenn eine Klarstellung oder weitere Informationen 
erforderlich sind. Das ist einer Unterhaltung mit einer anderen Person sehr ähnlich.
Wenn Sie also sagen „Treffe heute um 17 Uhr Tobias zum Kaffee“, antwortet Siri und sagt, dass 
der Termin mit Tobias eingetragen ist. Wenn Sie dann sagen „Erinnere mich daran, ihn anzurufen, 
wenn ich ins Büro komme“ weiß Siri, dass Sie gerade von Tobias gesprochen haben und kann 
deshalb die richtige Erinnerung einrichten.
Zusätzlich zu der internen Verarbeitungsleistung des iPhone verwendet Siri die Datenzentren von 
Apple, um Ihre Spracheingabe zu verstehen und die richtige Antwort zu geben. Siri verwendet 
zudem die Informationen aus Ihren Kontakten, Ihrer Musikmediathek, Ihren Kalendern usw., um zu 
verstehen, wovon Sie reden.
Siri unterstützt fast alle integrierten Apps auf dem iPhone 4S und ist intelligent genug, um zu 
wissen, welche App verwendet werden muss. Siri verwendet bei der Interaktion mit Ihnen auch 
Such- und Ortungsdienste.
Es gibt so viele Dinge, die Sie Siri sagen können! Hier einige weitere Beispiele für Siri-Neulinge:
Â Rufe Tobias an
Â Stelle den Timer auf 30 Minuten
Â Wie weit ist es bis zum nächsten Apple Store?
Â Wie wird das Wetter morgen?
Hinweis:  Siri ist nur auf dem iPhone 4S verfügbar und benötigt einen Internetzugang über eine 
Mobilfunk- oder WLAN-Verbindung. Möglicherweise ist Siri nicht in allen Sprachen oder Regionen 
verfügbar. Die Funktionen variieren je nach Region. Es können Roaming-Gebühren anfallen.
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Starten von Siri
Siri wird durch das Drücken einer Taste gestartet.
Siri starten:  Drücken Sie die Home-Taste  , bis Siri angezeigt wird.
Sie hören zwei kurze Töne und auf dem Bildschirm wird „Wie kann ich behilflich sein?“ angezeigt. 
Sie können nun sprechen. Das Mikrofonsymbol leuchtet auf, um anzuzeigen, dass Siri Sie hört. 
Tippen Sie nach dem Starten eines Dialogs mit Siri auf das Mikrofonsymbol, um erneut zu 
sprechen.
Siri wartet, bis Sie mit dem Sprechen aufhören. Sie können aber auch auf das Mikrofonsymbol 
tippen, um Siri mitzuteilen, das Sie fertig sind. Dies ist besonders nützlich, wenn viele 
Hintergrundgeräusche vorhanden sind. Außerdem kann hierdurch die Unterhaltung mit Siri 
beschleunigt werden, da Siri nicht darauf warten muss, dass Sie eine Sprechpause machen.
Wenn Sie Ihre Spracheingabe beendet haben, zeigt Siri das Gesagte und die Antwort an. Siri 
bietet auch zusätzliche Informationen, die nützlich sein können. Bezieht sich die Information auf 
eine App, z. B. eine von Ihnen verfasste Textnachricht, tippen Sie auf den Bildschirm, um die App 
zu öffnen und weitere Details und Aktionen anzuzeigen.
Was Siri verstanden hat
Tippen, um mit Siri zu 
sprechen
Siris Antwort
Verwandte Informationen: 
Hier tippen, um die App 
zu öffnen
Möglicherweise fragt Siri nach, wenn weitere Informationen benötigt werden, um die Anfrage zu 
bearbeiten. Sagen Sie z. B. zu Siri „Erinnere mich Mama anrufen“ und Siri fragt nach „Wann soll ich 
dich erinnern?“. Es ist nicht erforderlich, Siri alles auf einmal mitzuteilen. Siri fragt von sich aus die 
benötigten Details ab.
Zum Sprechen mit Siri halten Sie das iPhone wie bei einem Telefonanruf einfach an Ihr Ohr. Ist der 
Bildschirm nicht eingeschaltet, drücken Sie zunächst die Ein-/Aus-Taste oder die Home-Taste. Sie 
hören zwei kurze Töne, wenn Siri auf Empfang ist. Beginnen Sie zu sprechen.
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der Bildschirm zu ihnen und Ihre Hand nach oben weist.
Abbrechen einer Aufgabe Sagen Sie „Abbrechen“, tippen Sie auf  oder drücken Sie die Home-Taste 
.
Beenden eines Anrufs, den Sie mit 
Siri begonnen haben.
Drücken Sie die Home-Taste  , bevor die Telefon-App geöffnet wird. Ist die 
Telefon-App bereits geöffnet, tippen Sie auf „Beenden“.
Mitteilen persönlicher Informationen
Je besser Siri Sie kennt, desto besser können diese Informationen genutzt werden, um Ihnen zu 
helfen. Siri ruft Ihre Informationen von Ihrer persönlichen Karte („Meine Info“) in den Kontakten 
ab.
Sagen Sie Siri, wer Sie sind:  Öffnen Sie „Einstellungen“ > „Siri“ > „Meine Info“ und tippen Sie dann 
auf Ihren Namen.
Geben Sie Ihre Privat- und Ihre Geschäftsadresse auf der Karte ein, um Siri zu fragen: „Wie komme 
ich nach Hause?“ oder „Erinnere mich daran Diana anzurufen, wenn ich daheim bin“. 
Da Siri auch etwas über die Personen wissen will, die Ihnen wichtig sind, geben Sie Informationen 
zu den Beziehungen zu diesen Personen auf Ihrer persönlichen Karte ein. Siri kann diese 
Informationen für Sie erfassen. Wenn Sie Siri beispielsweise zum ersten Mal auffordern, Ihre 
Schwester anzurufen, fragt Siri Sie, wer Ihre Schwester ist (sofern Sie diese Informationen nicht 
bereits auf der Karte angegeben haben). Siri fügt die Beziehnungsinformationen auf Ihrer 
persönlichen Karte hinzu, sodass nicht mehr nachgefragt werden muss. 
Legen Sie in den Kontakten Karten an, auf denen die Beziehungen zu allen wichtigen Personen 
sowie Informationen wie Telefonnummern, E-Mail-Adressen, Privat- oder Büroadressen und 
Spitznamen vermerkt sind.
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Siri gibt Ihnen direkt auf dem Bildschirm Beispiele für die Dinge, die Sie sagen können. Fragen Sie 
Siri „Was kannst du für mich tun?“ oder tippen Sie auf  , wenn Siri zum ersten Mal geöffnet wird.
Freisprecheinrichtung für Siri
Sie können Siri mit den mit Ihrem iPhone gelieferten Apple Earphones mit Fernbedienung und 
Mikrofon oder mit anderen unterstützten Kopfhörern und Bluetooth-Headsets verwenden.
Verwenden der Ohrhörer zum Sprechen mit Siri:  Drücken und halten Sie die Mitteltaste.
Verwenden eines Bluetooth-Headsets zum Sprechen mit Siri:  Drücken und halten Sie die 
Anruftaste.
Zum Fortsetzen der Unterhaltung mit Siri drücken Sie diese Taste jedes Mal, wenn Sie sprechen 
wollen. 
Wenn Sie Ohrhörer oder Headset verwenden, spricht Siri die Antworten. Siri liest Text- und 
E-Mail-Nachrichten, die Sie diktiert haben, vor dem Versenden vor. Auf diese Weise haben Sie die 
Möglichkeit, die Nachrichten ggf. zu ändern. Siri liest auch den Betreff von Erinnerungen vor, bevor 
die Erinnerung selbst generiert wird.
Kontext
Siri merkt sich, wo Sie sich befinden und was Sie tun, sodass es den Kontext versteht. Wenn Sie 
gerade eine Textnachricht von Diana erhalten haben, sagen Sie einfach „Antworten“ und Siri weiß, 
dass die Nachricht an Diana gesendet werden soll. Sagen Sie „Rufe sie an“ und Siri weiß, dass 
Diana angerufen werden soll. Siri informiert Sie immer über die nächsten Schritte. 
Festlegen der Optionen für Siri
Aktivieren oder Deaktivieren von Siri:  Wählen Sie „Einstellungen“ > „Allgemein“ > „Siri“.
Hinweis:  Durch Deaktivieren wird Siri zurückgesetzt und vergisst alle Informationen über Ihre 
Stimme.
Festlegen der Optionen für Siri:  Wählen Sie „Einstellungen“ > „Allgemein“ > „Siri“.
Sprache:  Wählen Sie die Sprache aus, in der Sie mit Siri sprechen wollen.
Sprach-Feedback:  Standardmäßig spricht Siri die Antworten nur, wenn Sie das iPhone an Ihr Ohr 
halten oder Siri mit Ohrhörern oder einem Headset verwenden. Soll Siri die Antworten immer 
sprechen, wählen Sie für diese Option „Immer“ aus.
Meine Info:  Lassen Sie Siri wissen, auf welcher Karte in den Kontakten Ihre persönlichen 
Informationen zu finden sind. Weitere Informationen unter „Mitteilen persönlicher 
Informationen“ auf Seite 45.
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eingeschaltet sein.
Zugriff auf Siri erlauben oder verhindern, wenn das iPhone mit einem Code gesperrt ist:  
Wählen Sie „Einstellungen“ > „Allgemein“ > „Code-Sperre“.
Sie können Siri auch deaktivieren, indem Sie entsprechende Einschränkungen festlegen. Weitere 
Informationen unter „Einschränkungen“ auf Seite 189. 
Ortungsdienste
Da Siri Ortsbezeichnungen wie „aktueller“, „Zuhause“ und „Büro“ kennt, kann Siri Sie an bestimmte 
Aufgaben erinnern, wenn Sie einen Standort verlassen bzw. einen anderen Ort erreichen. Sagen 
Sie zu Siri „Erinnere mich meine Frau anzurufen, wenn ich das Büro verlasse“ und Siri tut genau 
das.
Informationen zum Standort werden außerhalb des Telefons weder erfasst noch gespeichert. Sie 
können Siri auch bei deaktivierten Ortungsdiensten verwenden, Siri wird jedoch keine Aufgaben 
ausführen, für die die Ortungsdienste erforderlich sind.
Deaktivieren der Ortungsdienste für Siri:  Wählen Sie „Einstellungen“ > „Ortungsdienste“.
Bedienungshilfen
Blinde oder sehbehinderte Benutzer können Siri mithilfe von VoiceOver verwenden, dem in iOS 
integrierten Bildschirmleseprogramm. VoiceOver liest vor, was auf dem Bildschirm geschieht. 
Hierzu gehört auch der Text in der Antwort von Siri. Auf diese Weise können Sie das iPhone auch 
verwenden, wenn Sie sehbehindert sind.
Aktivieren von VoiceOver:  Wählen Sie „Einstellungen“ > „Bedienungshilfen“.
Durch das Aktivieren von VoiceOver werden Ihre Mitteilungen ebenfalls laut vorgelesen. Weitere 
Informationen unter „VoiceOver“ auf Seite 162.
Korrigieren von Siri
Siri hat Probleme
Es kann vorkommen, dass Siri Probleme hat, Sie zu verstehen. Laute Umgebungen machen es Siri 
zum Beispiel schwer zu verstehen, was Sie sagen. Wenn Sie mit Akzent sprechen, kann es sein, 
dass Siri länger braucht, um sich mit Ihrer Stimme vertraut zu machen. Wenn Siri Sie nicht richtig 
verstanden hat, können Sie das Gesagte korrigieren.
Siri zeigt das Gesagte und die Antwort an. 
So korrigieren Sie Siri:  Tippen Sie auf die Sprechblase, die anzeigt, was Siri verstanden hat. 
Bearbeiten Sie Ihre Anfrage, indem Sie das Gewünschte eintippen, oder tippen Sie auf  , um Ihre 
Anfrage zu diktieren.
Weitere Informationen zum Diktieren finden Sie unter „Diktieren“ auf Seite 60.
Sind Teile des Texts blau unterstrichen, tippen Sie darauf und Siri schlägt Alternativen von. Tippen 
Sie auf einen Vorschlag oder ersetzen Sie den Text, indem Sie ihn eingeben oder diktieren.
Korrigieren per Sprachsteuerung:  Tippen Sie auf  und formulieren Sie Ihre Anfrage um oder 
korrigieren Sie sie. Sagen Sie zum Beispiel: „Ich meinte München“.
Achten Sie beim Korrigieren von Siri darauf, nicht zu sagen, was Sie nicht wollen, sondern Siri 
einfach zu sagen, was Sie wollen.
Korrigieren einer E-Mail oder Textmitteilung:  Wenn Siri Sie fragt, ob die E-Mail oder Mitteilung 
gesendet werden soll, können Sie Folgendes sagen:
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„Füge hinzu: Sehen wir uns da Fragezeichen“
„Nein, an Diana senden“
„Nein“ (dann wird die Nachricht nicht gesendet)
„Abbrechen“
Damit Siri die Nachricht vorliest, sagen Sie „Bitte vorlesen“ oder „Lies die Nachricht vor“. Ist die 
Nachricht korrekt, können Sie so etwas sagen wie „Ja, senden“.
Weitere Informationen unter „Mail“ auf Seite 54 und „Nachrichten“ auf Seite 50.
Wie Siri lernt
Siri funktioniert sofort ohne Konfiguration und wird mit der Zeit immer besser. Siri lernt Ihren 
Akzent oder andere Charakteristika Ihrer Stimme und ordnet sie den Dialekten oder Akzenten zu, 
die Siri versteht. Je mehr Personen Siri verwenden und je mehr Sprachvariationen Siri kennenlernt, 
desto besser wird die Spracherkennung und desto besser funktioniert Siri.
Laute Umgebungen
Halten Sie das iPhone in lauten Umgebungen dicht an Ihren Mund, sprechen Sie jedoch nicht 
direkt in das untere Mikrofon. Sprechen Sie weiterhin klar und deutlich. Tippen Sie auf  , wenn Sie 
fertig sind.
Sie können das iPhone auch an Ihr Ohr halten, um mit Siri zu sprechen.
Netzwerkverbindung
Möglicherweise teilt Siri Ihnen mit, dass es Probleme gibt, eine Verbindung zum Netzwerk 
herzustellen. Da Siri zur Spracherkennung auf Apple-Server und andere Dienste zugreift, 
benötigen Sie eine gute, stabile 3G- oder 4G-Funk- oder WLAN-Verbindung zum Internet. 
Siri und Apps
Siri unterstützt fast alle integrierten Apps auf dem iPhone 4S und die Apps, die es benötigt, 
um Ihre Anfragen zu bearbeiten. Siri weiß, wenn Sie eine App verwenden, also können Sie sich 
einfach auf die Elemente auf dem Bildschirm beziehen. Wenn Sie eine E-Mail lesen, können Sie 
zum Beispiel sagen „Antworte, es ist in Ordnung“. 
Telefon
Verwenden Sie Siri zum Telefonieren oder Starten eines FaceTime-Anrufs. Sie können auf 
Verwandte, Freunde und Geschäftspartner in Ihren Kontakten verweisen oder sagen, welche 
Telefonnummer verwendet werden soll. 
Beispiel:
Â Wähle die Handynummer von Susanne Ring
Â Rufe Diana auf ihrer Geschäftsnummer an
Â 040 1250043 anrufen
Â Rufe zuhause an
Â Starte einen FaceTime-Anruf mit Georg
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Sie können aber auch nur den Vornamen oder nur den Nachnamen sagen und Siri die richtige 
Person finden lassen. Siri sucht zuerst in Ihren Favoriten. Wenn eine Übereinstimmung gefunden 
wird, wird die betreffende Nummer angerufen. Als nächstes prüft Siri alle Kontakte. Sind in 
den Kontakten mehrere Personen mit demselben Namen vorhanden, fragt Siri, welche Person 
angerufen werden soll. Siri fragt auch nach, welche Telefonnummer verwendet werden soll, wenn 
mehrere Nummern aufgelistet werden.
Sie können Siri auch anweisen, ein Unternehmen in Ihren Kontakten anzurufen.
Stellen Sie sicher, dass Sie Siri Informationen über Ihre Person mitgeteilt haben, damit Siri weiß, 
für wen der Anruf getätigt werden soll. Weitere Informationen unter „Mitteilen persönlicher 
Informationen“ auf Seite 45. 
Beenden eines Anrufs, den Sie mit 
Siri begonnen haben
Drücken Sie die Home-Taste  , bevor die Telefon-App geöffnet wird. 
Tippen Sie auf „Beenden“, wenn das Telefonat noch andauert.
Musik
Weisen Sie Siri an, einen Musiktitel, ein Album oder eine Wiedergabeliste abzuspielen. 
Unterbrechen Sie die Wiedergabe und setzen Sie sie fort. Geben Sie eine Stimmung vor, indem Sie 
nach einer bestimmten Art von Musik fragen.
Oder sagen Sie einfach „Abspielen“ und lassen Sie Siri die Musik aussuchen. Wenn Sie den Titel 
nicht kennen, fragen Sie Siri „Wie heißt der Song?“.
Im Folgenden finden Sie einige Vorschläge, wie Sie Musik mit Siri wiedergeben können:
Â Spiele The Light of the Sun
Â Leg Trouble auf
Â Zufällige Wiedergabe von Taking Back Sunday
Â Spiele Alicia Keys
Â Spiele klassische Musik
Â Spiele meinen Party-Mix
Â Gib meine Wiedergabeliste für unterwegs zufällig wieder
Â Abspielen
Â Pause
Â Fortfahren
Â Überspringen
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eine temporäre Genius-Wiedergabeliste, die jedoch nicht gesichert wird.)
Nachrichten
Sie können Textmitteilungen senden, neue Nachrichten von Siri vorlesen lassen und auf 
empfangene Nachrichten antworten.
Fügen Sie den Namen der Person zum Text hinzu, oder warten Sie, bis Siri fragt, an wen die 
Nachricht gesendet werden soll. Sie können eine SMS an eine Telefonnummer oder an mehrere 
Personen gleichzeitig senden.
Zum Senden einer Nachricht sagen Sie etwa Folgendes:
Â Sage Diana, ich bin gleich da
Â Sende eine Nachricht an Tobias Appel
Â Sende eine Nachricht an Georg und sage wie wärs mit morgen
Â Schicke eine Nachricht an Dianas Handy und sage ich komme heute später
Â Sende eine Nachricht an 0401270043
Â SMS an Georg und Tobias wo seid ihr
Zum Anzeigen oder Anhören von empfangenen Textnachrichten, können Sie sagen:
Â Lies meine Nachrichten
Â Zeig neue SMS an
Â Lies sie noch einmal vor
Wenn Sie gerade eine Textnachricht erhalten haben oder eine Nachricht lesen wollen, die Sie 
früher empfangen haben, sagen Sie einfach:
Â Antworte das sind tolle Neuigkeiten
Â Sag ihm ich bin in 10 Minuten dort
Â Ruf sie an
Siri versteht den Kontext und weiß, an wen die Antwort gehen soll.
Bevor die erstellte Nachricht gesendet wird, zeigt sie Siri an oder liest sie Ihnen vor, um 
sicherzustellen, dass sie korrekt ist. Wenn Siri Sie fragt, ob die Nachricht gesendet werden soll, 
können Sie Folgendes sagen:
Â Ändern zu: Ruf mich morgen an
Â Füge hinzu: Sehen wir uns da Fragezeichen
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Â Nein (dann wird die Nachricht nicht gesendet)
Â Abbrechen
Soll Ihre Nachricht ein Smiley erhalten? Sagen Sie natürlich: „Smiley“ :-)
Bearbeiten von Nachrichten
Wenn Sie eine Textnachricht mit Siri erstellt haben, diese jedoch nicht genau das trifft, was Sie 
sagen wollten, können Sie Siri zum Ändern auffordern. Ist die Nachricht fast richtig, können Sie 
sie auch bearbeiten. Wenn Siri die Nachricht zur Prüfung anzeigt, tippen Sie auf die Sprechblase, 
um die Nachricht in der App „Nachrichten“ zu öffnen. Bearbeiten Sie die Nachricht dann, indem 
Sie den Text auf der Tastatur eingeben oder diktieren. Weitere Informationen unter „Diktieren“ auf 
Seite 60.
Kalender
Fügen Sie neue Ereignisse zu Ihrem Kalender hinzu, ändern Sie vorhandene Ereignisse oder 
zeigen Sie Ihre Termine an. Beim Erstellen eines Ereignisses können Sie eine Uhrzeit, einen Ort, 
einen Titel und die Personen angeben, die eingeladen werden sollen.
Zum Erstellen eines Ereignisses können Sie sagen:
Â Termin um 9 einrichten
Â Erstelle eine Besprechung mit Christian um 9 Uhr
Â Neues Treffen mit Georg am Donnerstag um 12 Uhr
Â Plane eine Besprechung wegen Urlaub morgen früh um 9 Uhr
Â Neuer Termin mit Diana Pelzl Freitag um 15 Uhr
Â Erstelle eine Planbesprechung heute um 8:30 Uhr im Tagungsraum
Zum Ändern oder Abbrechen eines Ereignisses können Sie sagen:
Â Verschiebe meine Besprechung von 15 Uhr auf 16:30 Uhr
Â Verschiebe meinen Termin mit Herrn Wilde auf nächsten Montag um 9 Uhr morgens
Â Füge Georg zu meinem Termin heute um 9 Uhr hinzu
Â Sage meinen Termin zum Thema Urlaub ab
Siri nach Veranstaltungen fragen:
Â Wie beschäftigt bin ich den Rest des Tages?
Â Was steht am Freitag in meinem Kalender?
Â Wann ist mein nächster Termin?
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Â Wo ist meine nächste Besprechung?
Wenn Sie ein Ereignis erstellen, ändern oder danach fragen, zeigt Siri Informationen darüber an. 
Tippen Sie auf das Ereignis, um weitere Informationen anzuzeigen. 
Erinnerungen
Siri bietet eine hervorragende Möglichkeit, schnell eine Erinnerung festzuhalten. 
Zum Erstellen einer Erinnerung sagen Sie etwa Folgendes:
Â Erinnere mich Mama anrufen
Â Denke dran Schirm mitnehmen
Â Erinnere mich morgen früh um 6 daran Medizin nehmen
Â Erinnere mich daran Tobias anrufen wenn ich das Büro verlasse
Â Neue Erinnerung für 18 Uhr Bericht fertigstellen
Siri fragt die Informationen ab, die es zum Erstellen der Erinnerung benötigt. Hierzu gehören 
Datum, Uhrzeit und Ort. 
Durch die Angabe von Ortsinformationen kann Siri Sie an das zugehörige Ereignis erinnern, wenn 
Sie sich einem Ort nähern bzw. einen Ort verlassen. Bei dem Ort kann es sich um Ihren aktuellen 
Standort („hier“) oder eine Adresse in den Kontakten handeln. Wie Sie Ortsinformationen über 
Ihr Zuhause oder Büro Siri mitteilen, finden Sie unter „Mitteilen persönlicher Informationen“ auf 
Seite 45.
Â Erinnere mich daran Mama anrufen wenn ich nach Hause komme
Â Erinnere mich daran meine Frau anrufen wenn ich im Büro ankomme
Â Erinnere mich dran Blumen abholen wenn ich hier weg gehe
Â Erinnere mich daran Uhrzeit prüfen wenn ich wieder hier ankomme
Erinnerungen werden in der Standardliste für Erinnerungen hinzugefügt. 
Festlegen einer Standardliste für neue Erinnerungen:  Tippen Sie auf „Einstellungen“ > „Mail, 
Kontakte, Kalender“ > „Standardliste“.
Anlegen einer Liste ohne Angabe von Uhrzeit oder Ort für die Erinnerung:
Â Denke dran Milch kaufen
Â Füge Eier zur Einkaufsliste hinzu
Wenn Siri Sie fragt, wann Sie erinnert werden wollen, können Sie „nie“ sagen.
Wenn in den Erinnerungen eine Liste angezeigt wird, können Sie Objekte hinzufügen, indem Sie 
sagen: „Hinzufügen“:
Â Eier hinzufügen
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Sie können Aktionen bestätigen, abbrechen oder Siri wissen lassen, dass Sie etwas ändern 
möchten:
Â Ändere Uhrzeit in 7
Â Gib stattdessen Dienstag an
Â Ändere es zu: Auto waschen und polieren
Â Beweg es in meine Arbeitsliste
Â Beweg es in meine persönliche Liste
Nachdem Sie die Erinnerung bestätigt haben, können Sie darauf tippen, um die App 
„Erinnerungen“ zu öffnen und die Erinnerung sowie deren Details anzuzeigen.
Karten
Verwenden Sie Siri, um einen Ort zu finden, Wegbeschreibungen abzurufen und die Verkehrslage 
anzuzeigen. Beispiel:
Â Wie komme ich nach Hause?
Â Zeige 1 Infinite Loop Cupertino California
Â Wegbeschreibung zu Papas Büro
Â Verkehrslage für den Heimweg
Â Finde das nächste Café
Â Finde das nächste Restaurant
Â Finde die nächste Tankstelle
Â Zeige gute mexikanische Restaurants
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App „Karten“. Ist dies nicht der Fall, können Sie die App durch Tippen auf die Karte öffnen.
Möglicherweise zeigt Siri eine Auswahlliste an. Wenn Sie beispielsweise nach einem Restaurant 
fragen, sucht Siri nach Restaurants in der Nähe und sortiert die Liste nach Lage der Restaurants. 
Haben Sie nach dem besten Restaurant gefragt, sortiert Siri nach Rang. Zum Ändern der 
Sortierfolge fragen Sie einfach „welches ist das beste?“ oder „welches ist am nächsten?“. 
Mail
Mit Siri können Sie E-Mails senden, danach suchen und auf empfangene E-Mails antworten.
Für eine E-Mail sind mindestens ein Empfänger, eine Betreffzeile (sagen Sie „Betreff“) und der Text 
der Nachricht erforderlich. Sie müssen nicht alle Angaben sofort parat haben, denn Siri fragt die 
Informationen ab, die zum Vervollständigen der E-Mail benötigt werden. 
Zum Senden einer E-Mail können Sie sagen:
Â Emaile Georg wegen Reise
Â Neue E-Mail an Diana Pelzl
Â Schicke eine E-Mail an Vater wegen der Überweisung
Â Sende eine E-Mail an Herrn Wilde mit dem Inhalt danke ich habe die Formulare erhalten
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Zum Abrufen der E-Mail können Sie sagen:
Â Rufe E-Mails ab
Â Gibt es heute neue E-Mails von Christian?
Â Zeige neue E-Mails zum Mietvertrag
Â Zeige die E-Mail von Georg von gestern
Zum Antworten auf E-Mails können Sie sagen:
Â Antworte liebe Diana bitte entschuldige die späte Zahlung
Â Rufe ihn im Geschäft an
Bevor die E-Mail gesendet wird, zeigt sie Siri an oder liest sie Ihnen vor, um sicherzustellen, dass 
sie korrekt ist. Wenn Siri Sie fragt, ob die E-Mail gesendet werden soll, können Sie Folgendes 
sagen:
Â Ändern zu: verspätete Zahlung
Â Füge John hinzu (um einen weiteren Empfänger hinzuzufügen)
Â Ändere es zu: Dieses Wochenende
Bearbeiten von E-Mails
Wenn Sie eine E-Mail mit Siri erstellt haben, diese jedoch nicht genau das trifft, was Sie sagen 
wollten, können Sie Siri zum Ändern auffordern. Ist die E-Mail fast richtig, können Sie sie auch 
bearbeiten. Tippen Sie auf die Nachricht, um die App „Mail“ zu öffnen. Ändern Sie dann die E-Mail, 
indem Sie die Änderungen eingeben oder diktieren. Weitere Informationen unter „Diktieren“ auf 
Seite 60.
Wetter
Mithilfe von Siri können Sie Wetterinformationen abrufen. Wenn Sie keinen Ort angeben, geht Siri 
davon aus, dass Sie den aktuellen Standort meinen. Wenn Sie keine Uhrzeit angeben, zeigt Siri 
die Wettervorhersage für heute an. Sie können jedoch auch Vorhersagen für jeden Tag der Woche 
abrufen.
Â Wie wird das Wetter heute?
Â Wie wird das Wetter morgen?
Â Wird es in Detmold diese Woche regnen?
Â Wie ist die Vorhersage für den Abend?
Â Wie ist im Moment das Wetter in Frankfurt?
Â Wie heiß wird es an diesem Wochenende in München?
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Â Wie ist die Außentemperatur?
Â Ist es windig heute?
Â Wann geht in Paris die Sonne auf?
Aktien
Mit Siri können Sie schnell die Kurse für Ihre bevorzugten Aktien abrufen. Informieren Sie sich 
über den Börsenwert oder das Kurs-Gewinn-Verhältnis. Fragen Sie nach bestimmten Indices und 
der allgemeinen Situation. Beispiel:
Â Was kostet die Apple-Aktie?
Â Wie ist das Kurs-Gewinn-Verhältnis von Apple?
Â Wie ist der Schlusskurs von Yahoo heute?
Â Wie steht der Dow Jones heute?
Â Wie sehen die Börsen aus?
Â Wie steht der DAX?
Uhr
Mit Siri können Sie die Weckzeit am Morgen einstellen, den Timer für den Kuchen im Ofen stellen 
oder die Uhrzeit an Ihrem Zielort in Übersee herausfinden.
Zum Einstellen oder Ändern des Weckers können Sie sagen:
Â Wecke mich um 7 Uhr
Â Stelle einen Wecker für 6:30 Uhr morgens
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Â Ändere meinen Wecker von 6:30 Uhr auf 6:45 Uhr
Â Schalte meinen Wecker für 6:30 Uhr aus
Â Lösche meinen Wecker für 7:30
Wenn Sie den Wecker einstellen, zeigt Siri die Uhrzeit an, sodass Sie prüfen können, ob sie korrekt 
gestellt wurde. Sie können den Wecker durch Tippen auf den Schalter ein- oder ausschalten. 
Tippen Sie auf den Wecker, um die App „Uhr“ zu öffnen.
Zum Abrufen von Datum und Uhrzeit können Sie sagen:
Â Wie spät ist es?
Â Wie viel Uhr ist es in Berlin?
Â Welches Datum ist heute?
Â Welches Datum ist diesen Samstag?
Siri zeigt eine Uhr für Sie an. Tippen Sie darauf, um die App „Uhr“ zu öffnen.
Zum Verwenden des Timers können Sie sagen:
Â Stelle den Timer auf 10 Minuten
Â Zeige den Timer
Â Halte den Timer an
Â Stelle den Timer wieder an
Â Setze den Timer zurück
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Siri zeigt einen Timer an. Tippen Sie darauf, um die App „Uhr“ zu öffnen.
Kontakte
Siri verwendet Ihre Einträge in den Kontakten, um Adressen zu finden, Telefonnummern oder 
andere Informationen zu suchen oder Sie über den Geburtstag einer Person zu informieren. 
Siri weiß sogar, wer Ihre Verwandten sind, indem Sie auf Ihrer Karte mit persönlichen Kontakten 
nachsieht. Weitere Informationen unter „Mitteilen persönlicher Informationen“ auf Seite 45.
Zum Abfragen von Informationen über Kontakte können Sie Folgendes sagen:
Â Was ist Christians Adresse?“
Â Wie ist die Telefonnummer von Diana Pelzl?
Â Wann ist der Geburtstag meiner Frau?
Â Zeige die private E-Mail-Adresse von Susanne
Â Wie ist die Geschäftsadresse von meinem Bruder?
Zum Suchen nach Kontakten können Sie sagen:
Â Zeige Tobias Appel
Â Suche Personen mit dem Namen Pelzl
Â Wo ist Christian Wilde?
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lassen Sie Siri die Kontaktinformationen für diese Person anzeigen. Zum Starten eines Anrufs 
tippen Sie auf eine Nummer. Andere Objekte sind ebenfalls aktiv – tippen Sie auf eine E-MailAdresse, um eine neue E-Mail zu erstellen, oder tippen Sie auf die FaceTime-Taste, um einen 
FaceTime-Anruf zu starten. Mit der Anweisung „Zeige Tobias“ können Sie die Liste der möglichen 
Empfänger eventuell einschränken, wenn Sie wissen, das der Vorname Tobias lautet, sich aber 
nicht an den Nachnamen erinnern können.
Notizen
Verwenden Sie Siri, um gesprochene Notizen anzulegen oder nach bereits vorhandenen Notizen 
zu suchen. Sagen Sie etwa:
Â Notiere 12 Euro für Pizza
Â Notiz hör dir das neue Album von Alicia Keys an
Â Suche meine Restaurantnotiz
Â Erstelle eine Notiz Kinderbücher
Â Füge Max und Moritz zu meiner Notiz Kinderbücher hinzu
Siri zeigt die Notiz an, damit Sie sie prüfen können. Zum Bearbeiten der Notiz tippen Sie 
darauf. Siri öffnet die App „Notizen“ für Sie und Sie können die Notiz bearbeiten, indem Sie die 
Änderungen eingeben oder diktieren. Weitere Informationen unter „Diktieren“ auf Seite 60.
Safari
Mit Siri können Sie auch im Internet suchen. Geben Sie hierzu einfach die Suchmaschine an, die 
Sie verwenden wollen, oder suchen Sie auf einer Site wie Wikipedia. Beispiel:
Â Suche im Internet nach Sylt
Â Suche vegetarische Nudelrezepte
Â Suche im Internet nach Flugpreisen
Â Google nach dreißigjähriger Krieg
Â Suche auf Wikipedia nach Konrad Adenauer
Â Suche im Web nach Weltmeisterschaft
Â Bing-Suche nach Alicia Keys
Siri öffnet Safari und startet die gewünschte Suche. Wenn Sie keine Suchmaschine angeben, 
verwendet Siri die in den Safari-Einstellungen festgelegte. Wählen Sie „Einstellungen“ > „Safari“.
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Fordern Sie Siri auf, bestimmte Informationen anzuzeigen oder Berechnungen auszuführen, und 
Siri wird auf WolframAlpha (www.wolframalpha.com) zugreifen. Die Antworten enthalten häufig 
weitere Informationen. (Nur auf Englisch verfügbar.)
Hier einige Bespiele für Fragen und Anforderungen:
Â How many calories in a bagel?
Â What is an 18% tip on $86.74 for four people?
Â Who’s buried in Grant’s tomb?
Â How long do dogs live?
Â What is the Gossamer Condor?
Â What’s the square root of 28?
Â How many dollars is 45 euros?
Â What’s the square root of 1983?
Â How many days until Christmas?
Â How far away is the sun?
Â When is the next solar eclipse?
Â Show me the Orion constellation
Â What’s the population of Jamaica?
Â How high is Mt. Everest?
Â How deep is the Atlantic Ocean?
Â What’s the price of gasoline in Chicago?
Diktieren
Wenn Siri aktiviert ist, können Sie auch Text diktieren. Weitere Informationen unter „Diktieren“ auf 
Seite 29.
Obwohl Sie E-Mails, Textmitteilungen und andere Texte im Dialog mit Siri erstellen lassen können, 
können Sie diese Texte auch diktieren. Mit der Diktierfunktion können Sie Nachrichten bearbeiten, 
statt den kompletten Text zu ersetzen. Durch Verwenden der Diktierfunktion haben Sie zudem 
beim Verfassen des Texts mehr Zeit. 
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Zeit zum Antworten. Hierdurch können Sie eine natürliche Unterhaltung mit Siri führen, es kann 
allerdings vorkommen, dass Siri Sie unterbricht, bevor Sie wirklich fertig sind, da Sie zu lange 
nachgedacht haben. Mit der Diktierfunktion können sie so oft unterbrechen, wie Sie möchten, 
und jederzeit mit der Spracheingabe fortfahren.
Sie können Text auch zunächst mithilfe von Siri erfassen und dann mit der Diktierfunktion 
fortfahren. Sie können beispielsweise eine E-Mail mit Siri erstellen und dann auf den Entwurf 
tippen, um die Nachricht in Mail zu öffnen. Anschließend können Sie in Mail die Nachricht 
vervollständigen oder bearbeiten und weitere Änderungen daran vornehmen, etwa Empfänger 
hinzufügen oder entfernen, den Betreff korrigieren oder den Account ändern, von dem Sie die 
E-Mail versenden.
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Telefongespräche
Anrufen
Zum Telefonieren mit dem iPhone müssen Sie lediglich auf einen Namen und eine Nummer 
in Ihrer Kontakt- oder Favoritenliste oder auf einen Anrufer in der Anrufliste tippen. Alternativ 
können Sie Siri verwenden und zum Beispiel sagen: „Rufe Diana an“ (iPhone 4S). Mit den Tasten 
unten auf dem Telefonbildschirm können Sie schnell auf Ihre Favoriten, die Anrufliste, Ihre 
Kontakte und eine numerische Tastatur zugreifen, über die Sie eine Nummer eingeben können.
ACHTUNG:  Wichtige Hinweise zum sicheren Fahren finden Sie im Handbuch Wichtige 
Produktinformationen unter www.apple.com/de/support/manuals/iphone.
Anzahl 
verpasster Anrufe
Anrufen eines Favoriten mit nur einmal Tippen
Anzeigen der neuesten eingehenden und 
ausgehenden Anrufe, um zurückzurufen oder 
weitere Details anzuzeigen
Anruf, E-Mail oder Textmitteilung 
an einen Kontakt
Eingeben einer Nummer
Liste der 
VoicemailMitteilungen
Anzahl ungelesener 
Nachrichten
Zurückrufen eines Kontakts in der 
Anrufliste
Führen Sie einen der folgenden Schritte aus:
Â Telefon:  Tippen Sie auf „Anrufliste“ und danach auf einen Namen oder 
eine Nummer.
Â Gesperrter Bildschirm:  Wischen Sie das Symbol, das in der Mitteilung 
angezeigt wird, nach rechts.
Â In der Mitteilungszentrale:  Tippen Sie auf den verpassten Anruf.
Manuelles Wählen
Sie können den Ziffernblock verwenden, um eine Telefonnummer einzugeben.
Wählen einer Nummer:  Tippen Sie auf den Ziffernblock, geben Sie eine Nummer ein und tippen 
Sie auf „Anrufen“.
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Ziffernblock
Tippen Sie über der Tastatur auf den Bildschirm und tippen Sie dann auf 
„Einsetzen“.
Hinzufügen einer weichen (2 
Sekunden langen) Pause
Berühren Sie die Taste „*“, bis ein Komma angezeigt wird.
Hinzufügen einer harten Pause 
(zum Anhalten des Wählvorgangs, 
bis auf die Taste „Wählen“ gedrückt 
wird)
Berühren Sie die Taste „#“, bis ein Semikolon angezeigt wird.
Wählen der zuletzt gewählten 
Nummer
Öffnen Sie den Ziffernblock, tippen Sie auf „Anruf“ und dann nochmals auf 
„Anruf“.
Sprachwahl
Mit Siri (iPhone 4S) bzw. der Sprachsteuerung können Sie einen Teilnehmer anrufen, indem Sie 
seinen in den Kontakten hinterlegten Namen oder seine Rufnummer in das Mikrofon sprechen. 
Weitere Informationen unter Kapitel 4,„Siri,“ auf Seite 43 und „Sprachsteuerung“ auf Seite 32.
Tätigen eines Anrufs mit Siri bzw. per Sprachsteuerung:  Aktivieren Sie Siri bzw. die 
Sprachsteuerung, sagen Sie „Anrufen“ oder „Wählen“ und nennen Sie dann den Namen oder die 
Nummer.
Siri:  Wenn der Bildschirm nicht eingeschaltet ist, drücken Sie die Ein-/Aus- bzw. die Home-Taste 
und halten Sie dann das iPhone an Ihr Ohr.
Sprachsteuerung bzw. Siri:  Drücken und halten Sie die Home-Taste  , bis Sie den Signalton hören. 
Alternativ können Sie auf den iPhone-Kopfhörern die Mitteltaste drücken.
Beispiel:
Â Hans Mustermann anrufen
Â Hans Mustermann Zuhause anrufen
Â Hans Mustermann mobil anrufen
Die besten Ergebnisse erzielen Sie, wenn Sie den vollständigen Namen des gewünschten 
Teilnehmers sagen. Bei der Sprachwahl müssen Sie jede Ziffer für sich sprechen, zum Beispiel: „vier 
eins, fünf fünf, fünf eins, eins zwei“.
Hinweis:  Für den Vorwahlbereich „800“ in den USA können Sie „achthundert“ sagen.
Annehmen von Anrufen
Wenn Sie einen Anruf erhalten, tippen Sie auf „Annehmen“. Ist das iPhone gesperrt, bewegen Sie 
den Schieberegler. Alternativ können Sie auf den iPhone-Kopfhörern die Mitteltaste drücken.
Stummschalten eines Anrufs Drücken Sie die Ein-/Aus-Taste oder eine der Lautstärketasten. Sie können 
den Anruf auch nach dem Stummschalten noch entgegennehmen, bevor 
er an Ihre Voicemail weitergeleitet wird.
Ablehnen eines Anrufs und 
Weiterleiten an Voicemail
Führen Sie einen der folgenden Schritte aus:
Â Drücken Sie die Ein-/Aus-Taste zweimal schnell hintereinander.
Â Halten Sie die Mitteltaste auf den iPhone-Kopfhörern zwei Sekunden 
lang gedrückt. Zwei Pieptöne geben an, dass der Anruf abgelehnt wurde.
Â Tippen Sie auf „Ablehnen“ (wenn das iPhone aktiviert ist, wenn der Anruf 
eingeht).
Unterdrücken von Anrufen und 
Beibehalten des WLAN-Zugriffs auf 
das Internet
Aktivieren Sie den Flugmodus im Bereich „Einstellungen“, tippen Sie auf 
„WLAN“ und aktivieren Sie diese Option.
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an Voicemail weitergeleitet.
Während eines Anrufs
Wenn Sie ein Gespräch führen, werden im Bildschirm verschiedene Anrufoptionen angezeigt.
Stummschalten  
iPhone 4 oder neuer: Berühren und 
Halten, um einen Anruf zu halten
Wählen oder 
Eingeben einer 
Nummer
Verwenden des 
Lautsprechers 
oder eines 
Bluetooth-Geräts.
Abrufen der 
Kontaktinfos
iPhone 4 oder neuer:
FaceTime-Anruf  
iPhone 3GS (Taste „Halten“)
Halten eines Anrufs
Neuer Anruf
Je nachdem, welches iPhone Sie verwenden, variieren die Anrufoptionen.
Verwenden anderer Apps während 
eines Anrufs
Drücken Sie die Home-Taste  und tippen Sie dann auf ein App-Symbol. 
Tippen Sie auf die grüne Leiste am oberen Bildschirmrand, um den Anruf 
fortzusetzen.
Beenden eines Anrufs Tippen Sie auf „Anruf beenden“. Drücken Sie alternativ auf den iPhoneKopfhörern die Mitteltaste.
Gleichzeitige Anrufe
Sie können während eines Gesprächs einen weiteren Anruf tätigen oder annehmen. 
Wenn während eines Anrufs ein weiterer Anruf eingeht, piept das iPhone und zeigt die 
Anruferinformationen sowie eine Liste mit verschiedenen Optionen an.
Hinweis:  In einigen Regionen ist das Tätigen und Annehmen eines zweiten Anrufs eventuell nur 
im Rahmen eines optionalen Dienstes möglich. Weitere Informationen erhalten Sie bei Ihrem 
Netzanbieter.
Reagieren auf einen zweiten ankommenden Anruf:
Â Einen Anruf ignorieren und an Voicemail weiterleiten: Tippen Sie auf „Ignorieren“.
Â Halten des ersten Anrufs und Annehmen des zweiten: Tippen Sie auf „Halten+Annehmen“.
Â Beenden des ersten Anrufs und Annehmen des zweiten: Tippen Sie auf „Halten+Annehmen“, 
wenn Sie ein GSM-Netz nutzen. Tippen Sie im CDMA-Netz auf „Anruf beenden“ und beim 
Klingelzeichen des zweiten Anrufs auf „Annehmen“ oder bewegen Sie den Regler, wenn das 
Telefon gesperrt ist.
Wenn Sie einen FaceTime-Videoanruf führen, können Sie den Videoanruf beenden, um den 
ankommenden Anruf anzunehmen, oder den ankommenden Anruf ablehnen.
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Wechseln zwischen Gesprächen Tippen Sie auf „Tauschen“. Das aktuelle Gespräch wird gehalten.
Im CDMA-Netz können Sie nicht zwischen Anrufen wechseln, wenn es sich 
beim zweiten Anruf um einen ausgehenden Anruf handelte. Sie haben 
jedoch die Möglichkeit, die Gespräche zusammenzulegen. Wenn Sie den 
zweiten oder den zusammengelegten Anruf beenden, werden beide Anrufe 
beendet.
Zusammenlegen von Gesprächen Tippen Sie auf „Konferenz“.
Im CDMA-Netz können Anrufe nicht zusammengelegt werden, wenn es 
sich beim zweiten Anruf um einen eingehenden Anruf handelt.
Telefonkonferenzen
Im GSM-Netz können Sie eine Telefonkonferenz abhalten, um (abhängig von Ihrem 
Telefonanbieter) mit bis zu fünf Teilnehmern gleichzeitig zu sprechen.
Hinweis:  In einigen Regionen sind Telefonkonferenzen möglicherweise nur als optionaler Dienst 
verfügbar. Weitere Informationen erhalten Sie bei Ihrem Netzanbieter.
Starten einer Telefonkonferenz
1 Rufen Sie jemanden an.
2 Tippen Sie auf „Anruf hinzufügen“, um eine weitere Person anzurufen. Das erste Gespräch wird 
gehalten.
3 Tippen Sie auf „Konferenz“. Beide Gespräche werden zu einem zusammengelegt und alle 
Beteiligten können einander hören.
4 Wiederholen Sie die Schritte zwei und drei, um weitere Teilnehmer hinzuzufügen.
Beenden eines Anrufs Tippen Sie auf „Konferenz“ und dann neben einem Anruf auf  . Tippen Sie 
danach auf „Anruf beenden“.
Sprechen mit nur einem Teilnehmer Tippen Sie auf „Konferenz“ und dann neben einem Anruf auf „Privat“. Tippen 
Sie auf „Konferenz“, um die Konferenz fortzusetzen.
Hinzufügen eines eingehenden 
Anrufs
Tippen Sie auf „Halten+Annehmen“ und anschließend auf „Konferenz“.
Umfasst Ihr Dienst auch Telefonkonferenzen, steht dem iPhone neben der Telefonkonferenz eine 
zweite Leitung zur Verfügung.
Hinweis:  Solange Sie eine Telefonkonferenz führen, können Sie keinen FaceTime-Videoanruf 
tätigen.
Verwenden eines Bluetooth-Geräts für Anrufe
Sie können ein mit dem iPhone gekoppeltes Bluetooth-Gerät verwenden, um Anrufe zu tätigen 
und anzunehmen. Weitere Informationen unter „Koppeln eines Bluetooth-Geräts mit dem 
iPhone“ auf Seite 37. 
Weitere Informationen zur Verwendung von Bluetooth-Geräten finden Sie in der Dokumentation 
des betreffenden Geräts.
Umgehen Ihres Bluetooth-Geräts:
Â Nehmen Sie den Anruf an, indem Sie auf den iPhone-Bildschirm tippen.
Â Tippen Sie während eines Anrufs auf „Audio“ und wählen Sie „iPhone“ oder „Freisprechen“ aus.
Â Deaktivieren Sie Bluetooth in „Einstellungen“ > „Allgemein“ > „Bluetooth“.
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Bluetooth-Gerät mit dem iPhone verbunden wird, muss es sich in Reichweite des iPhone (bis zu 
ca. 10 m) befinden.
Notrufe
Auch wenn das iPhone mit einem Code gesperrt ist, können Sie damit Notrufe tätigen.
Tätigen eines Notrufs, wenn das iPhone gesperrt ist:  Tippen Sie im Bildschirm „Code eingeben“ 
auf „Notruf“, geben Sie die Nummer über die numerische Tastatur ein und tippen Sie auf die grüne 
Taste.
In den USA werden Informationen zu Ihrem Standort (sofern verfügbar) an Notfalldienste 
weitergeleitet, wenn Sie 911 wählen.
Wenn im CDMA-Netz ein Notruf beendet wird, wird das iPhone in den Notrufmodus versetzt, was 
einen Rückruf durch die Rettungsdienste ermöglicht. In diesem Modus sind Datenübertragung 
und Textnachrichten blockiert.
Beenden des Notrufmodus (CDMA): Führen Sie einen der folgenden Schritte aus:
Â Tippen Sie auf die Taste „Zurück“.
Â Drücken Sie die Ein-/Aus- oder die Home-Taste  .
Â Verwenden Sie den Ziffernblock, um eine andere Rufnummer zu wählen.
Der Notrufmodus wird nach einigen Minuten, wie von Ihrem Anbieter festgelegt, automatisch 
beendet.
Wichtig:  Verlassen Sie sich bei wichtigen Anrufen, z. B. bei medizinischen Notfällen, nicht auf 
Mobilfunkgeräte. Das Tätigen eines Notrufs mit dem iPhone funktioniert möglicherweise nicht 
in allen Regionen oder in jedem Betriebszustand. Die Telefonnummern von Rettungsdiensten 
können in verschiedenen Regionen variieren; in manchen Fällen ist es aufgrund mangelnder 
Netzverfügbarkeit oder von Interferenzen nicht möglich, den Rettungsdienst zu verständigen. 
Einige Mobilfunknetze akzeptieren möglicherweise keine mit dem iPhone getätigten Notrufe, 
wenn die SIM-Karte nicht in das iPhone eingesetzt oder gesperrt ist, wenn Sie Ihr iPhone nicht 
aktiviert haben oder wenn das iPhone nicht kompatibel ist bzw. nur in einem bestimmten 
Mobilfunknetz funktioniert. Wenn Sie einen FaceTime-Videoanruf tätigen, müssen Sie diesen 
beenden, damit Sie eine Notrufnummer anrufen können.
FaceTime
Mit FaceTime (iPhone 4 oder neuer) können Sie den Teilnehmer, mit dem Sie sprechen, zugleich 
auch sehen. Videotelefonate können Sie mit Teilnehmern führen, die einen Mac oder ein iOS-Gerät 
mit FaceTime-Unterstützung besitzen. Es ist keine Konfiguration erforderlich, Sie müssen nur eine 
WLAN-Verbindung zum Internet besitzen. Standardmäßig wird bei FaceTime die Frontkamera 
verwendet, damit Ihr Gesprächspartner Ihr Gesicht sehen kann. Wechseln Sie zur rückseitigen 
Kamera, um Ihre Umgebung zu zeigen.
Hinweis:  FaceTime ist möglicherweise nicht in allen Regionen verfügbar.
Tätigen eines FaceTime-Anrufs:  Wählen Sie einen Namen in den Kontakten aus. Tippen Sie auf 
„FaceTime“ und die E-Mail-Adresse oder Telefonnummer, die die Person für FaceTime verwendet.
Wenn Sie eine Person anrufen, die ein iPhone 4 (oder neuer) besitzt, können Sie zunächst einen 
normalen Anruf tätigen und dann auf „FaceTime“ tippen.
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zeigt, was der Gesprächspartner sieht. Drehen Sie das iPhone, um FaceTime im Querformat zu 
verwenden.
Wechseln Sie zwischen 
den Kameras.
Ziehen Sie Ihr Bild an 
eine beliebige Stelle.
Schalten Sie den Anruf stumm (Sie können den 
Anrufer hören und sehen, der Anrufer kann Sie 
sehen aber nicht hören).
Wenn kein WLAN-Netzwerk verfügbar ist (wenn Sie sich zum Beispiel außerhalb der Reichweite 
befinden), haben Sie die Möglichkeit, die Nummer erneut anzurufen.
Hinweis:  Beim Telefonieren mit FaceTime wird Ihre Telefonnummer auch dann angezeigt, wenn 
die Anruferkennung unterdrückt oder ausgeschaltet ist.
Tätigen eines FaceTime-Anrufs mit 
Siri bzw. der Sprachsteuerung
Drücken und halten Sie die Home-Taste , bis Sie den Signalton hören. 
Bei Siri (iPhone 4S) können Sie das iPhone einfach bei eingeschaltetem 
Bildschirm an Ihr Ohr halten. Sagen Sie „FaceTime“ und nennen Sie den 
Namen des Teilnehmers.
Unterdrücken von FaceTimeAnrufen
Öffnen Sie „Einstellungen“ > „FaceTime“ und deaktivieren Sie die 
Option „FaceTime“. Sie können FaceTime außerdem auch über den 
Bereich „Einschränkungen“ deaktivieren. Weitere Informationen unter 
„Einschränkungen“ auf Seite 189.
Verwenden Ihrer Apple-ID oder 
einer E-Mail-Adresse für FaceTime
Öffnen Sie „Einstellungen“ > „FaceTime“ und tippen Sie auf „Ihre Apple-ID für 
FaceTime“ oder „E-Mail-Adresse hinzufügen“. Weitere Informationen unter 
„FaceTime“ auf Seite 66.
Visual Voicemail
Einrichten von Voicemail
Auf dem iPhone können Sie dank Visual Voicemail eine Liste Ihrer Nachrichten anzeigen. In dieser 
Liste können Sie dann gezielt auswählen, welche Nachrichten Sie anhören oder löschen möchten, 
ohne Anweisungen oder die vorherigen Nachrichten anhören zu müssen.
Hinweis:  Visual Voicemail ist möglicherweise nicht in allen Regionen verfügbar oder wird 
möglicherweise nur als optionaler Dienst angeboten. Weitere Informationen erhalten Sie bei 
Ihrem Netzanbieter. Ist die Funktion für Visual Voicemail nicht verfügbar, tippen Sie auf „Voicemail“ 
und folgen Sie den Sprachanweisungen, um Ihre Nachrichten abzurufen.
Anzahl verpasster Anrufe und 
ungehörter Voicemail-Mitteilungen
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Voicemail festzulegen und eine Ansage aufzuzeichnen.
Ändern Ihrer Ansage:  Tippen Sie auf „Voicemail“ und auf „Begrüßung“. Tippen Sie dann 
auf „Eigene“. Tippen Sie auf „Aufnehmen“ und nehmen Sie Ihre Begrüßung auf. Tippen Sie 
abschließend auf „Stopp“.
Tippen Sie auf „Abspielen“, um die Ansage anzuhören. Um eine neue Aufnahme anzufertigen, 
tippen Sie erneut auf „Aufnehmen“. Wenn Sie zufrieden sind, tippen Sie auf „Sichern“.
Verwenden der Standardansage 
Ihres Mobilfunkanbieters
Tippen Sie auf „Voicemail“ und auf „Begrüßung“. Tippen Sie dann auf 
„Standard“.
Festlegen eines Hinweistons für 
neue Voicemail-Ereignisse
Tippen Sie auf „Einstellungen“ > „Töne“ und aktivieren Sie die Option „Neue 
Voicemail“. Der Warnton wird für jede neue Nachricht einmal ausgegeben.
Ist der Schalter „Klingeln/Aus“ auf „Lautlos“ gestellt, gibt das iPhone keine 
Hinweistöne für Nachrichten aus.
Ändern des Voicemail-Kennwortes Wählen Sie „Einstellungen“ > „Telefon“ > „Kennwort für Voicemail ändern“.
Abrufen von Voicemail-Nachrichten
Wenn Sie auf „Telefon“ tippen, zeigt das iPhone die Anzahl der versäumten Anrufe und nicht 
abgehörten Voicemail-Nachrichten an.
Tippen Sie auf „Voicemail“, um eine Liste Ihrer Voicemail-Nachrichten anzuzeigen.
Bewegen der 
Abspielposition, um zu 
einem bestimmten Teil der 
Mitteilung zu gelangen.
Nicht gehörte 
Mitteilungen Wiedergabe/Pause
Kontaktinfo
Navigationsleiste
Lautsprecher (Audio bei 
angeschlossenem 
Bluetooth-Gerät. Tippen, 
um die Audioausgabe zu 
wählen)
Zurückrufen
Anhören einer Voicemail-Nachricht:  Tippen Sie auf „Voicemail“ und wählen Sie eine Nachricht 
aus.
Wenn Sie die Nachricht bereits abgehört haben, tippen Sie nochmals darauf, um sie ein zweites 
Mal abzuspielen. Drücken Sie  oder  , um die Wiedergabe zu unterbrechen bzw. fortzusetzen.
Nachdem Sie eine Nachricht abgehört haben, bleibt diese noch so lange verfügbar, bis Ihr 
Mobilfunkanbieter sie löscht.
Abrufen von Voicemail-Nachrichten 
von einem anderen Telefon
Wählen Sie Ihre eigene Nummer oder die Nummer für die Fernabfrage 
Ihres Mobilfunkanbieters.
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Löschen einer Nachricht: Legen Sie Ihren Finger auf die Nachricht und tippen Sie dann auf 
„Löschen“.
Hinweis:  In bestimmten Regionen erfolgt das unwiderrufliche Löschen gelöschter VoicemailNachrichten möglicherweise durch den Mobilfunkanbieter.
Anhören einer gelöschten 
Nachricht
Tippen Sie auf „Gelöschte Sprachnachrichten“ (unter der Liste) und tippen 
Sie dann auf die gewünschte Nachricht.
Widerrufen des Löschvorgangs Tippen Sie auf „Gelöschte Sprachnachrichten“ (unter der Liste), tippen 
Sie auf die gewünschte Nachricht und tippen Sie anschließend auf 
„Widerrufen“.
Unwiderrufliches Löschen von 
Nachrichten
Tippen Sie auf „Gelöschte Sprachnachrichten“ (unter der Liste) und tippen 
Sie danach auf „Alles löschen“.
Kontakte
Im Info-Bildschirm eines Kontakts können Sie mit einem Fingertippen einen Telefonanruf tätigen, 
eine neue E-Mail erstellen, die Anschrift auf einer Karte anzeigen und vieles mehr. Weitere 
Informationen unter „Suchen nach Kontakten“ auf Seite 140.
Favoriten
Über „Favoriten“ können Sie schnell auf häufig gewählte Telefonnummern zugreifen.
Hinzufügen der Telefonnummer eines Kontakts zu Ihrer Favoritenliste:  Tippen Sie auf „Kontakte“ 
und wählen Sie einen Kontakt aus. Tippen Sie auf „Zu Favoriten hinzufügen“. Wählen Sie eine 
Telefonnummer oder E-Mail-Adresse (für FaceTime-Anrufe) aus. Wählen Sie auf dem iPhone 4 
(oder neuer) aus, ob der Favorit als normaler Anruf oder als FaceTime-Anruf gesichert werden soll.
Wählen Sie im Bereich „Favoriten“ einen Kontakt aus, um diesen anzurufen. Wird neben einem 
Namen  angezeigt, startet das iPhone einen FaceTime-Anruf.
Hinzufügen eines Kontakts aus der 
Anrufliste zur Favoritenliste
Tippen Sie auf „Anrufliste“ und dann auf  neben einem Kontakt. Wählen 
Sie dann „Zu Favoriten hinzufügen“
Löschen eines Kontakts aus Ihrer 
Favoritenliste
Tippen Sie auf „Favoriten“ und dann auf „Bearbeiten“. Tippen Sie dann 
neben einem Kontakt oder einer Nummer auf  und anschließend auf 
„Löschen“.
Neuanordnen Ihrer Favoritenliste Tippen Sie auf „Favoriten“ und dann auf „Bearbeiten“. Legen Sie Ihren Finger 
auf  neben einem Kontakt, um eine neue Position in der Liste dafür 
festzulegen.
Rufweiterleitung, Anklopfen und Anruferkennung
Rufweiterleitung
Sie können mit dem iPhone festlegen, dass alle eingehenden Anrufe an eine andere Nummer 
weitergeleitet werden.
Hinweis:  FaceTime-Anrufe werden nicht weitergeleitet.
Aktivieren der Rufweiterleitung (GSM):  Wählen Sie „Einstellungen“ > „Telefon“ > 
„Rufweiterleitung“ und aktivieren Sie diese Funktion. Geben Sie im Bildschirm „Weiterleiten an“ die 
Nummer ein, an die Ihre Anrufe weitergeleitet werden sollen.
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Nummer ein, an die Sie die Anrufe weiterleiten möchten. Tippen Sie dann auf „Anruf“.
Um die Rufweiterleitung zu deaktivieren, geben Sie *73 ein und tippen Sie dann auf „Anruf“.
Wenn die Rufweiterleitung aktiviert ist, wird das Symbol für die Rufweiterleitung  in der 
Statusleiste angezeigt (GSM). Sie müssen sich in Reichweite des Funknetzes befinden, wenn 
Sie die Rufweiterleitung auf dem iPhone aktivieren. Andernfalls werden die Anrufe nicht 
weitergeleitet.
Anklopfen/Makeln
Die Anklopffunktion ermöglicht es Ihnen, einen zweiten Anruf anzunehmen, wenn Sie bereits 
einen Anruf tätigen. Sie können:
Â Den eingehenden Anruf ignorieren
Â Den aktuellen Anruf halten und den eingehenden annehmen
Â Den aktuellen Anruf beenden und den eingehenden annehmen
Wenn Sie bereits sprechen und das Anklopfen deaktiviert haben, werden eingehende Anrufe 
direkt an Voicemail weitergeleitet. Weitere Informationen unter „Gleichzeitige Anrufe“ auf Seite 64. 
Aktivieren der Anklopffunktion (GSM): Wählen Sie „Einstellungen“ > „Telefon“ > „Anklopfen/
Makeln“.
Bei CDMA ist „Anklopfen/Makeln“ standardmäßig aktiviert. Sie können die Funktion jedoch für 
einzelne Anrufe deaktivieren.
Deaktivieren der Anklopffunktion beim Telefonieren (CDMA):  Geben Sie *70 ein und wählen Sie 
die Rufnummer.
Anruferkennung
Bei der Anruferkennung wird bei einem Anruf Ihr Name bzw. Ihre Telefonnummer angezeigt, 
wenn die angerufene Person über die dafür erforderliche Ausstattung verfügt und Sie die 
Anruferkennung nicht unterdrückt oder ausgeschaltet haben.
Hinweis:  Beim Telefonieren mit FaceTime wird Ihre Telefonnummer auch dann angezeigt, wenn 
die Anruferkennung unterdrückt oder ausgeschaltet ist.
Aktivieren oder Deaktivieren der Anruferkennung (GSM): Wählen Sie „Einstellungen“ > „Telefon“ 
> „Meine Rufnummer senden“.
Bei CDMA ist die Anruferkennung standardmäßig aktiviert. Sie können die Funktion jedoch für 
einzelne Anrufe deaktivieren.
Unterdrücken der Anruferkennung für einen Anruf (CDMA): Geben Sie *67 ein und wählen Sie 
die Rufnummer.
Klingeltöne, Ein-/Ausschalter und Vibrieren
Auf dem iPhone befinden sich verschiedene Klingeltöne, die Sie für eingehende Anrufe, für 
den Wecker sowie für den Timer verwenden können. Außerdem haben Sie die Möglichkeit, 
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Hinweistöne ein oder aus und verwenden Sie die Einstellung „Töne“, um die Vibrationsoptionen 
festzulegen. Standardmäßig vibriert das iPhone unabhängig davon, ob der Klingelton aktiviert ist 
oder nicht.
Festlegen des Standardklingeltons:  Wählen Sie „Einstellungen“ > „Töne“ > „Klingelton“.
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Weitere Informationen unter „Schalter „Klingeln/Aus““ auf Seite 12.
Wichtig:  Wecksignale werden auch dann ausgegeben, wenn der Schalter „Klingeln/Aus“ auf „Aus“ 
gestellt ist.
Festlegen des Vibrationsmodus für das iPhone:  Wählen Sie „Einstellungen“ > „Töne“. Dank der 
separaten Einstellungen können Sie verschiedene Vibrationsmodi für die Verwendung mit sowie 
ohne Klingelton festlegen.
Zuweisen eines Klingeltons zu 
einem Kontakt
Wählen Sie „Kontakte“, tippen Sie auf einen Kontakt, dann auf „Bearbeiten“ 
> „Klingelton“ und wählen Sie einen Klingelton aus.
Erwerben von Klingeltönen im 
iTunes Store
Weitere Informationen unter „Kaufen von Musik, Hörbüchern und 
Tönen“ auf Seite 130.
Weitere Informationen unter „Töne und der Schalter „Klingeln/Aus““ auf Seite 184.
Internationale Anrufe
Führen von internationalen Anrufen von Ihrem Heimatort aus
Informationen zu Gesprächen ins Ausland von Ihrem Heimatort aus, einschließlich zu Gebühren 
und sonstigen möglicherweise anfallenden Kosten, erhalten Sie bei Ihrem Mobilfunkanbieter oder 
auf dessen Website.
Verwenden des iPhone im Ausland
Wenn Sie sich im Ausland befinden, können Sie je nach verfügbarem Netzwerk möglicherweise 
trotzdem mit Ihrem iPhone Anrufe tätigen, Textmitteilungen verfassen und empfangen und Apps 
verwenden, für die eine Internetverbindung erforderlich ist.
Aktivieren des Dienstes für internationales Roaming:  Setzen Sie sich mit Ihrem 
Mobilfunkanbieter in Verbindung, wenn Sie Angaben zu Verfügbarkeit und Gebühren benötigen.
Wichtig:  Für das Telefon- und Daten-Roaming sowie das Versenden von Textmitteilungen können 
Gebühren anfallen. Schalten Sie das Sprach- und Daten-Roaming aus, wenn Sie sich in einem 
fremden Netz befinden, damit keine Gebühren für Anrufe und empfangene Daten über das 
Mobilfunknetz anfallen (einschließlich Visual Voicemail).
Wenn Sie ein iPhone 4S haben, das für die Verwendung in einem CDMA-Netzwerk aktiviert 
wurde, können Sie im GSM-Netz roamen, wenn eine SIM-Karte in das iPhone eingesetzt ist. 
Weitere Informationen unter „Einsetzen einer SIM-Karte“ auf Seite 15. Beim Roamen in einem GSMNetzwerk, können Sie mit dem iPhone auf verschiedene GSM-Netzwerkfunktionen zugreifen. Es 
können Gebühren anfallen. Weitere Informationen erhalten Sie bei Ihrem Netzanbieter.
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in einem CDMA-Netzwerk
Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“.
Wenn Sie das Sprach-Roaming deaktivieren, können Sie keine Telefonanrufe 
empfangen oder tätigen, wenn Sie sich in einem fremden Netz befinden. 
Deaktivieren von Daten-Roaming Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“.
Deaktivieren Sie das Daten-Roaming, um die Datenübertragung über 
das Mobilfunknetz zu deaktivieren. Apps, für die eine Internetverbindung 
erforderlich ist, werden erst dann aktiviert, wenn das iPhone über eine 
WLAN-Internetverbindung verfügt. Beim Roamen wird Visual Voicemail 
deaktiviert, es sei denn, Ihr Anbieter bietet diesen Dienst kostenlos an.
Festlegen, dass das iPhone beim 
Anrufen aus einem anderen Land 
die korrekte Landesvorwahl 
hinzufügt
Wählen Sie „Einstellungen“ > „Telefon“ und aktivieren Sie die Option 
„International Assist“ (nicht in allen Regionen verfügbar). Mit dieser 
Funktion können Sie in den Vereinigten Staaten telefonieren und die 
Nummern in Ihrer Kontakt- und Favoritenliste verwenden, ohne die 
Landesvorwahl hinzuzufügen.
Festlegen des gewünschten 
Anbieters
Wählen Sie „Einstellungen“ > „Netzbetreiber“. Diese Option steht nur zur 
Verfügung, wenn Sie sich außerhalb Ihres eigenen Netzwerks befinden 
und einen Netzbetreiber nutzen, der eine Roaming-Vereinbarung mit 
Ihrem Betreiber unterhält. Weitere Informationen unter „Netzbetreiber“ auf 
Seite 184.
Verwenden von GSM-Netzen im 
Ausland mit einem für CDMA 
aktivierten iPhone
Wählen Sie „Einstellungen“ > „Netzwerk“ > „Roaming“ und deaktivieren Sie 
die Option „Internationales CDMA“.
Abrufen von Voicemail-Nachrichten, 
wenn Visual Voicemail nicht 
verfügbar ist
Wählen Sie Ihre eigene Rufnummer (wählen Sie im CDMA-Netz Ihre 
Rufnummer gefolgt von #) oder legen Sie den Finger auf die „1“ der 
numerischen Tastatur.
Deaktivieren von Mobilfunkdaten Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“.
Deaktivieren von 
Mobilfunkdiensten
Aktivieren Sie den Flugmodus im Bereich „Einstellungen“, tippen Sie dann 
auf „WLAN“ und aktivieren Sie es.
Ankommende Anrufe werden direkt an den Voicemail-Dienst umgeleitet. 
Schalten Sie den Flugmodus aus, wenn Sie wieder Anrufe tätigen und 
annehmen wollen und die für Sie hinterlassenen Voicemail-Nachrichten 
abhören wollen.
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Öffnen Sie in den Einstellungen „Telefon“. Dort haben Sie folgende Möglichkeiten:
Â Anzeigen der Telefonnummer Ihres iPhone
Â Aktivieren bzw. Deaktivieren der Anrufweiterleitung, der Anklopffunktion sowie der 
Anruferkennung (GSM)
Â Aktivieren oder Deaktivieren von TTY
Â Ändern Ihres Voicemail-Kennwortes (GSM)
Â Aktivieren oder Deaktivieren von International Assist: Wenn Sie sich im Ausland befinden, 
können Sie mit International Assist in den Vereinigten Staaten telefonieren und die Nummern 
in Ihrer Kontakt- und Favoritenliste verwenden, ohne die Landesvorwahl hinzuzufügen (GSM).
Â Festlegen, dass eine PIN eingegeben werden muss, wenn Sie das iPhone einschalten (bei 
manchen Anbietern erforderlich)
Öffnen Sie in den Einstellungen „FaceTime“. Dort haben Sie folgende Möglichkeiten:
Â Aktivieren oder deaktivieren der Option „FaceTime“
Â Verwenden Ihrer Apple-ID für FaceTime
Â Hinzufügen einer E-Mail-Adresse für die Verwendung mit FaceTime
Öffnen Sie „Einstellungen“ > „Töne“, um Klingeltöne, Vibrationsoptionen und den Hinweiston für 
neue Voicemail-Nachrichten festzulegen. Weitere Informationen unter „Töne und der Schalter 
„Klingeln/Aus““ auf Seite 184.
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Mit der App „Mail“ können iCloud, Microsoft Exchange und viele gängige E-Mail-Systeme 
verwendet werden. Hierzu gehören: Yahoo!, Google, Hotmail und AOL sowie die meisten POP3- 
und IMAP-Standard-E-Mail-Systeme. Sie können E-Mails mit Fotos, Videos und Grafiken senden 
und empfangen und PDFs und andere angehängte Daten anzeigen. E-Mail-Nachrichten und 
Anhänge, die in der Übersicht angezeigt werden können, können gedruckt werden.
Abrufen und Lesen von E-Mails
In Mail gewährt Ihnen der Postfachbildschirm schnellen Zugriff auf Ihre Posteingänge und andere 
Postfächer. 
Wenn Sie ein Postfach öffnen, ruft Mail die neuesten Mitteilungen ab und zeigt diese an. Legen 
Sie in den Mail-Einstellungen fest, wie viele Mitteilungen abgerufen werden sollen. Weitere 
Informationen unter „Mail-Accounts und -einstellungen“ auf Seite 78.
Ungelesene 
Nachrichten
Anzahl der 
Nachrichten in 
einem Thread
Sortieren der Nachrichten nach 
E-Mail-Verlauf
Wählen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“ und aktivieren oder 
deaktivieren Sie die Option „Nach E-Mail-Verlauf“.
Wenn Sie Nachrichten nach Verlauf sortieren, werden zugehörige 
Nachrichten als ein Eintrag im Postfach angezeigt. Weitere Informationen 
unter „Mail-Accounts und -einstellungen“ auf Seite 78.
Abrufen neuer Nachrichten Wählen Sie ein Postfach oder tippen Sie jederzeit auf  .
Laden weiterer Nachrichten Blättern Sie in der E-Mail-Liste nach unten und tippen Sie auf „Weitere 
E-Mails laden“.
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Doppeltippen wird der Ausschnitt wieder verkleinert. Ziehen Sie den 
Ausschnitt auf oder zu, um das Bild zu vergrößern bzw. zu verkleinern.
Bildschirmfüllendes Vergrößern 
einer Textspalte
Tippen Sie zweimal auf den Text.
Anzeigen aller Empfänger einer 
E-Mail
Tippen Sie auf „Details“. Tippen Sie auf den Namen oder die E-Mail-Adresse, 
um die Kontaktinformationen des Empfängers anzuzeigen. Tippen Sie 
dann auf die Telefonnummer oder E-Mail-Adresse, um diese Person zu 
kontaktieren.
Hinzufügen eines E-MailEmpfängers zu Ihrer Kontaktliste
Tippen Sie auf die E-Mail und tippen Sie falls erforderlich auf „Details“, um 
die Empfänger anzuzeigen. Tippen Sie dann auf einen Namen oder eine 
E-Mail-Adresse und anschließend auf „Neuen Kontakt erstellen“ oder „Zu 
Kontakt hinzufügen“.
Kennzeichnen einer E-Mail als 
ungelesen
Öffnen Sie die Nachricht und tippen Sie falls erforderlich auf „Details“. 
Tippen Sie anschließend auf „Markieren“.
Um mehrere Nachrichten als ungelesen zu markieren, lesen Sie „Verwalten 
von E-Mails“ auf Seite 77.
Öffnen einer Einladung zu einer 
Besprechung
Tippen Sie auf die Einladung. Weitere Informationen unter „Antworten auf 
Einladungen“ auf Seite 97.
Verwenden mehrerer Accounts
Wenn Sie mehrere Accounts eingerichtet haben, können Sie über den Bereich „Accounts“ des 
Postfachbildschirms auf Ihre Accounts zugreifen. Sie können auch unter „Posteingänge“ auf „Alle“ 
tippen, um alle eingehenden Nachrichten in einer Liste anzuzeigen. Weitere Informationen zum 
Einrichten zusätzlicher E-Mail-Accounts erhalten Sie unter „Mail-Accounts und -einstellungen“ auf 
Seite 78. 
Wenn Sie eine neue Nachricht verfassen, tippen Sie auf das Feld „Von“, um den Account zu 
wählen, von dem die Nachricht gesendet werden soll.
Senden von E-Mails
Senden Sie eine E-Mail an eine beliebige Person mit einer E-Mail-Adresse.
Verfassen einer E-Mail:  Tippen Sie auf 
 Fügen Sie einen Empfänger aus 
Ihren Kontakten hinzu.
Geben Sie einen Namen oder eine E-Mail-Adresse in das Feld „An:“ ein oder 
tippen Sie auf  .
Neuanordnen von Empfängern Um einen Empfänger von einem Feld in ein anderes zu verschieben (z. B. 
von „An:“ zu „Kopie/Blindkopie:“), bewegen Sie einfach den Namen in das 
neue Feld.
Formatieren von Text (fett, kursiv, 
unterstreichen)
Tippen Sie auf die Einfügemarke, um die Auswahltasten anzuzeigen, und 
tippen Sie dann auf „Auswählen“. Bewegen Sie die Aktivpunkte, um den 
zu formatierenden Text auszuwählen. Tippen Sie auf  und dann auf „B“/
„I“/„U“. Tippen Sie auf „Fett“, „Kursiv“ oder „Unterstrichen“, um das Format 
anzuwenden.
Senden eines Fotos oder Videos per 
E-Mail
Wählen Sie in „Fotos“ ein Foto oder Video, tippen Sie auf  und dann auf 
„Per E-Mail senden“. Fotos und Videos können auch kopiert und an anderer 
Stelle eingesetzt werden.
Wenn Sie mehrere Fotos oder Videos senden möchten, tippen Sie in der 
Miniaturübersicht eines Albums auf  . Wählen Sie durch Tippen die Fotos 
und Videos aus, tippen Sie auf „Senden“ und wählen Sie dann „Per E-Mail 
senden“.
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die spätere Bearbeitung
Tippen Sie auf „Abbrechen“ und dann auf „Sichern“. Die E-Mail wird im 
Postfach „Entwürfe“ abgelegt. Legen Sie Ihren Finger auf  , um die E-Mail 
schnell zu öffnen.
Antworten auf eine E-Mail Tippen Sie auf  und anschließend auf „Antworten“. Die an die 
Originalnachricht angehängten Dateien oder Bilder werden nicht 
zurückgesendet. Wenn Sie einen Anhang hinzufügen möchten, leiten Sie 
die Nachricht weiter, anstatt darauf zu antworten.
Zitieren eines Teils der Nachricht, 
auf die Sie antworten bzw. die Sie 
weiterleiten
Legen Sie Ihren Finger auf den Text, um ihn auszuwählen. Bewegen Sie die 
Aktivpunkte, um den gewünschten Textteil auszuwählen, und tippen Sie 
dann auf  .
Um die Einzugsebene des zitierten Textes zu ändern, legen Sie den Finger 
darauf und tippen Sie auf  . Tippen Sie auf „Zitatebene“ und dann auf 
„Erhöhen“ bzw. „Verringern“.
Weiterleiten einer E-Mail Öffnen Sie eine Nachricht und tippen Sie auf  . Tippen Sie dann auf 
„Weiterleiten“.
Senden von Kontaktinformationen Wählen Sie in „Kontakte“ einen Kontakt, tippen Sie auf „Kontakt senden“ 
unten links im Infobildschirm.
Verwenden von Links und erkannten Daten
Das iPhone erkennt Weblinks, Telefonnummern, E-Mail-Adressen und andere Arten von 
Informationen, die Sie verwenden können, um eine Webseite zu öffnen, eine voradressierte E-Mail 
zu erstellen, Informationen zu einem Kontakt zu erstellen oder hinzuzufügen oder um weitere 
nützliche Aktionen auszuführen. Erkannte Daten werden als blau unterstrichener Text angezeigt. 
Tippen Sie auf diese Daten, um ihre Standardaktion zu verwenden, oder legen Sie den Finger 
darauf, um weitere Aktionen anzuzeigen. Bei einer Adresse können Sie zum Beispiel den Standort 
in der App „Karten“ anzeigen oder die Adresse zu „Kontakte“ hinzufügen.
Anzeigen von Anhängen
Das iPhone kann Bildanhänge in vielen gängigen Formaten (JPEG, GIF und TIFF) innerhalb des 
E-Mail-Textes anzeigen. Sie können mit dem iPhone auch viele verschiedene Audioanhänge 
wiedergeben (u. a. MP3, AAC, WAV und AIFF). Sie können Dateien (wie PDF-, Webseiten-, Text-, 
Pages-, Keynote-, Numbers- und Microsoft Word-, Excel- und PowerPoint-Dokumente), die an eine 
E-Mail angehängt wurden, anzeigen und empfangen.
Öffnen eines Anhangs:  Tippen Sie auf den Anhang, um ihn in der Übersicht zu öffnen. 
(Möglicherweise müssen Sie warten, bis der Ladevorgang abgeschlossen ist.)
Öffnen eines Anhangs Tippen Sie auf den Anhang, halten Sie den Finger darauf und wählen 
Sie dann eine App zum Öffnen. Wenn keine Ihrer Apps das Dateiformat 
unterstützt und der Anhang auch nicht in der Übersicht geöffnet werden 
kann, sehen Sie zwar den Namen der Datei, Sie können sie jedoch nicht 
öffnen.
Sichern eines angehängten Fotos 
oder Videos
Legen Sie den Finger auf das Foto oder Video und tippen Sie danach auf 
„Bild sichern“ bzw. „Video sichern“. Das Objekt wird im Album „Aufnahmen“ 
in der App „Fotos“ gesichert.
In der Übersicht werden folgende Dokumententypen unterstützt:
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.htm, .html Webseite
.key Keynote
.numbers Numbers
.pages Pages
.pdf Vorschau, Adobe Acrobat
.ppt, .pptx Microsoft PowerPoint
.rtf Rich Text Format
.txt Text
.vcf Kontaktinformationen
.xls, .xlsx Microsoft Excel
Drucken von Nachrichten und Anhängen
Sie können E-Mail-Nachrichten und Anhänge, die in der Übersicht angezeigt werden können, 
drucken. 
Drucken einer E-Mail:  Tippen Sie auf  und anschließend auf „Drucken“.
Drucken eines eingebundenen 
Bildes
Legen Sie den Finger auf das Bild und tippen Sie danach auf „Bild sichern“. 
Öffnen Sie dann die App „Fotos“ und drucken Sie das Foto aus dem Album 
„Aufnahmen“.
Drucken eines Anhangs Tippen Sie auf den Anhang, um ihn in der Übersicht anzuzeigen, und 
tippen Sie dann auf  und auf „Drucken“.
Weitere Informationen zum Drucken sowie zu den Druckeroptionen erhalten Sie unter 
„Drucken“ auf Seite 30.
Verwalten von E-Mails
Sie können E-Mails in einem beliebigen Postfach, Ordner oder Fenster mit Suchergebnissen 
verwalten. Sie können Nachrichten löschen oder als gelesen markieren. Ferner haben Sie die 
Möglichkeit, E-Mails von einem Postfach oder Ordner innerhalb desselben Accounts oder 
zwischen verschiedenen Accounts zu bewegen. Postfächer und Ordner können hinzugefügt, 
gelöscht und umbenannt werden.
Löschen einer Nachricht:  Öffnen Sie die Nachricht und tippen Sie auf  .
Sie können eine E-Mail auch direkt aus der E-Mail-Liste des Postfachs löschen, indem Sie mit dem 
Finger nach links oder rechts über den Titel der E-Mail streichen und dann auf „Löschen“ tippen.
Bei einigen E-Mail-Accounts werden Nachrichten archiviert anstatt gelöscht. Wenn Sie eine 
Nachricht archivieren, wird diese vom Postfach in den Ordner „Alle Nachrichten“ verschoben. 
Aktivieren bzw. deaktivieren Sie das Archivieren von Nachrichten unter „Einstellungen“ > „Mail, 
Kontakte, Kalender“.
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Öffnen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“, um festzulegen, wie 
lange eine Nachricht im Papierkorb bleibt, bevor sie endgültig gelöscht 
wird. Tippen Sie anschließend auf „Erweitert“. 
Löschen bzw. Bewegen mehrerer 
Nachrichten
Wenn Sie eine Liste mit E-Mails anzeigen, tippen Sie auf „Bearbeiten“, 
wählen Sie die E-Mails aus, die Sie löschen möchten, und tippen Sie dann 
auf „Löschen“ bzw. „Bewegen“.
Bewegen einer E-Mail in ein 
anderes Postfach oder einen 
anderen Ordner
Tippen Sie bei geöffneter E-Mail auf  und wählen Sie ein Postfach oder 
einen Ordner aus.
Postfach hinzufügen Öffnen Sie die Liste mit den Postfächern, tippen Sie auf „Bearbeiten“ und 
dann auf „Neues Postfach“.
Löschen bzw. Umbenennen eines 
Postfachs
Öffnen Sie die Liste mit den Postfächern, tippen Sie auf „Bearbeiten“ und 
wählen Sie dann ein Postfach. Geben Sie einen neuen Namen oder einen 
neuen Speicherort für das Postfach ein. Tippen Sie auf „Postfach löschen“, 
um das Postfach und die Inhalte zu löschen.
Markieren mehrerer Nachrichten 
als markiert bzw. als gelesen
Wenn Sie eine Liste mit E-Mails anzeigen, tippen Sie auf „Bearbeiten“, 
wählen Sie die E-Mails aus und tippen Sie dann auf „Markieren“. Wählen Sie 
„Markiert“ oder „Gelesen“.
Durchsuchen von E-Mails
Sie können den Empfänger, Absender, Betreff und den Text von E-Mail-Nachrichten nach einem 
bestimmten Text durchsuchen. Die App „Mail“ durchsucht die geladenen E-Mails, die sich im 
aktuell geöffneten Postfach befinden. Bei iCloud, Microsoft Exchange und einigen IMAP-Accounts 
können auch die Nachrichten auf dem Server durchsucht werden.
Durchsuchen von E-Mail-Nachrichten:  Öffnen Sie ein Postfach, blättern Sie nach oben an den 
Anfang und geben Sie einen Text in das Feld „Eingang durchsuchen“ ein. Tippen Sie auf „Von“, 
„An“ oder „Betreff“ oder alternativ auf „Alle“, um anzugeben, welche Felder durchsucht werden 
sollen. Sie können auch Nachrichten auf dem Server durchsuchen, wenn Ihr Mail-Account dies 
unterstützt.
Bei der Suche vom Home-Bildschirm aus können auch E-Mails gesucht werden. Weitere 
Informationen unter „Suchen“ auf Seite 31.
Mail-Accounts und -einstellungen
Accounts
Öffnen Sie für die App „Mail“ und andere E-Mail-Accounts „Einstellungen“ > „Mail, Kontakte, 
Kalender“. Sie haben folgende Möglichkeiten:
Â Microsoft Exchange
Â iCloud
Â MobileMe
Â Google Mail 
Â Yahoo! 
Â AOL 
Â Microsoft Hotmail
Â Andere POP- und IMAP-E-Mail-Systeme
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Systemadministrator kann Ihnen die Informationen bereitstellen, die Sie eingeben müssen.
Ändern der Einstellungen eines Accounts:  Öffnen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“, 
wählen Sie einen Account und nehmen Sie dann die gewünschten Änderungen vor.
Änderungen, die Sie an einem Account auf dem iPhone vornehmen, werden nicht mit dem 
Computer synchronisiert. So können Sie Accounts für die Verwendung mit dem iPhone 
konfigurieren, ohne dass sich dies auf die Accounteinstellungen auf dem Computer auswirkt.
Deaktivieren eines Accounts Wählen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“, wählen Sie danach 
den gewünschten Account aus und deaktivieren Sie den nicht mehr 
benötigten Dienst (Mail, Kalender, Notizen usw.).
Ist ein Accountdienst deaktiviert, wird dieser nicht mehr auf dem iPhone 
angezeigt oder synchronisiert. Dazu muss er erst wieder aktiviert werden. 
So können Sie beispielsweise Ihren Arbeitsaccount deaktivieren, während 
Sie im Urlaub sind.
Sichern von Entwürfen, gesendeten 
und gelöschten Nachrichten auf 
dem iPhone
Bei IMAP-Accounts können Sie den Speicherort für die Postfächer 
„Entwürfe“, „Gesendet“ und „Gelöscht“ ändern. Tippen Sie auf 
„Einstellungen“ > „Mail, Kontakte, Kalender“ und dann auf „Erweitert“.
Festlegen, wie lange Nachrichten 
aufbewahrt werden, bevor sie 
endgültig gelöscht werden
Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ und dann auf 
„Erweitert“. Tippen Sie auf „Entfernen“ und wählen Sie eine Dauer aus: Nie 
oder nach einem Tag, einer Woche oder einem Monat.
Anpassen der MailserverEinstellungen
Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ und wählen 
Sie dann einen Account aus. Bitten Sie Ihren Netzwerkadministrator oder 
Internetdienstanbieter um die korrekten Einstellungen.
Anpassen von SSL sowie der 
Kennworteinstellungen
Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ und 
dann auf „Erweitert“. Bitten Sie Ihren Netzwerkadministrator oder 
Internetdienstanbieter um die korrekten Einstellungen.
Aktivieren und Deaktivieren des 
Archivierens von Nachrichten
Öffnen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“, wählen Sie 
einen Account und aktivieren bzw. deaktivieren Sie die Option „E-Mails 
archivieren“. Weitere Informationen unter „Verwalten von E-Mails“ auf 
Seite 77.
Löschen eines Accounts Wählen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“ und wählen Sie 
einen Account aus. Blättern Sie dann nach unten und tippen Sie auf 
„Account löschen“.
Durch das Löschen werden alle E-Mails, Kontakte, Kalender und Lesezeichen 
vom iPhone entfernt, die mit dem Account synchronisiert wurden.
Senden signierter und 
verschlüsselter E-Mails
Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ und dann auf 
„Erweitert“. Aktivieren Sie „S/MIME“ und wählen Sie die Zertifikate aus, die 
für das Signieren und Verschlüsseln ausgehender Nachrichten verwendet 
werden sollen.
Um Zertifikate zu installieren, lassen Sie sich von Ihrem Systemadministrator 
ein Konfigurationsprofil zuweisen, laden Sie die Zertifikate mit Safari von 
der Website des Ausstellers oder lassen Sie sie sich als E-Mail-Anhang 
senden.
Festlegen der Push-Einstellungen Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ > 
„Datenabgleich“. Mit der Push-Funktion werden neue Daten abgeglichen, 
wenn das iPhone mit einem WLAN-Netzwerk verbunden ist. Deaktivieren 
Sie die Option „Push“, um keine E-Mails und andere Daten zu empfangen 
oder um die Batterie zu schonen. Wenn „Push“ deaktiviert ist, legen Sie 
unter „Datenabgleich“ fest, wie oft nach neuen Daten gesucht werden soll. 
Führen Sie die Suche nicht zu häufig aus, um Batteriestrom zu sparen.
Festlegen weiterer E-Mail-Optionen Einstellungen, die für alle Ihre E-Mail-Accounts gelten, finden Sie unter 
„Einstellungen“ > „Mail, Kontakte, Kalender“. 
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Zum Ändern der Einstellungen, die für alle Ihre E-Mail-Accounts gelten, wählen Sie „Einstellungen“ 
> „Mail, Kontakte, Kalender“.
Ändern der Töne, die beim Senden bzw. Empfangen von E-Mails wiedergegeben 
werden:  Wählen Sie „Einstellungen“ > „Töne“. 
Neue Daten laden
Mit dieser Einstellung können Sie die Funktion „Push“ für Ihre iCloud-, Microsoft Exchange-, 
Yahoo!- und anderen Push-Accounts auf dem iPhone aktivieren bzw. deaktivieren. Bei PushAccounts werden neue Informationen an das iPhone gesendet, sobald diese auf dem Server 
verfügbar sind (Verzögerungen sind möglich) und eine Internetverbindung besteht. Deaktivieren 
Sie die Option „Push“, um keine E-Mails und anderen Daten zu empfangen oder um die Batterie zu 
schonen.
Wenn die Push-Funktion deaktiviert ist und Accounts verwendet werden, die diese Funktion nicht 
unterstützen, können dennoch Daten abgerufen werden. Das iPhone kann auf dem Server prüfen, 
ob neue Informationen vorhanden sind. Verwenden Sie die Einstellung „Neue Daten laden“, um 
festzulegen, wie oft nach neuen Daten gesucht werden soll. Führen Sie die Suche nicht zu häufig 
aus, um Batteriestrom zu sparen. Wenn Sie für „Push“ die Einstellung „AUS“ (oder für „Laden“ im 
Bildschirm „Neue Daten laden“ die Einstellung „Manuell“) wählen, werden damit die Einstellungen 
einzelner Accounts überschrieben.
Festlegen der Push-Einstellungen:  Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ > 
„Datenabgleich“.
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Mit Safari können Sie im Internet surfen und Webseiten anzeigen. Sie können Lesezeichen auf 
dem iPhone erstellen und mit Ihrem Computer synchronisieren. Fügen Sie Weblinks zum HomeBildschirm hinzu, um schnell auf Ihre bevorzugten Websites zuzugreifen. Drucken Sie Webseiten, 
PDFs und andere Dokumente. Mit der Leseliste können Sie Websites für ein späteres Lesen 
speichern.
Anzeigen von Webseiten
Durchsuchen Sie das 
Internet und die aktuelle 
Seite.
Zeigen Sie die geöffneten 
Webseiten an oder öffnen 
Sie eine neue Seite.
Doppeltippen Sie auf ein 
Objekt oder ziehen Sie es 
mit Ihrem Daumen und 
Zeigefinger auf oder zu, 
um es zu vergrößern bzw. 
zu verkleinern.
Geben Sie eine Web-Adresse (URL) ein.
Hinzufügen eines Lesezeichens, Hinzufügen zur Leseliste, 
Hinzufügen eines Symbols zum Home-Bildschirm oder 
Freigeben bzw. Drucken der Seite
Auf die Statusleiste tippen, um nach oben zu blättern
Lesezeichen oder Leseliste anzeigen
Anzeigen einer Webseite:  Tippen Sie auf das Adressfeld (in der Titelleiste), um die Tastatur 
einzublenden. Geben Sie die Webadresse ein und tippen Sie auf „Öffnen“.
Wird das Adressfeld nicht angezeigt, tippen Sie auf die Statusleiste, um nach oben zu gelangen.
Webseiten lassen sich im Hoch- und Querformat anzeigen.
Löschen von Text im Adressfeld Tippen Sie auf  .
Scrollen einer Webseite Bewegen Sie Ihren Finger nach oben, unten oder zur Seite.
Blättern innerhalb eines 
Ausschnitts auf einer Webseite
Scrollen Sie mit zwei Fingern innerhalb des Rahmens.
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Seiten gleichzeitig geöffnet haben. Die Zahl innerhalb von  steht für die 
Anzahl der geöffneten Seiten.
Wechseln zu einer anderen Seite Tippen Sie auf  , streichen Sie nach rechts oder links und wählen Sie dann 
eine Seite.
Verhindern des Ladens einer 
Webseite
Tippen Sie auf  .
Erneutes Laden einer Webseite Tippen Sie im Adressfeld auf  .
Schließen einer Seite Tippen Sie auf  und anschließend auf  .
Schützen Ihrer privaten Daten und 
Blockieren einiger Websites, die Ihr 
Webverhalten verfolgen
Öffnen Sie „Einstellungen“ > „Safari“ und aktivieren Sie die Option „Privates 
Surfen“.
Festlegen der Optionen für Safari Wählen Sie „Einstellungen“ > „Safari“.
Links
Auswählen eines Links auf einer Webseite: Tippen Sie auf den Link.
Anzeigen der Zieladresse eines 
Links
Legen Sie den Finger auf den Link.
Gefundene Daten wie Telefonnummern und E-Mail-Adressen werden möglicherweise ebenfalls 
als Links in Webseiten angezeigt. Legen Sie Ihren Finger auf einen Link, um die verschiedenen 
Optionen anzuzeigen. Weitere Informationen unter „Verwenden von Links und erkannten 
Daten“ auf Seite 76.
Leseliste
In der Leseliste können Sie Links zu Webseiten für ein späteres Lesen sammeln.
Hinzufügen eines Links zur aktuellen Seite in der Leseliste:  Tippen Sie auf  und dann auf „Zur 
Leseliste hinzufügen“.
Hinzufügen eines Links zu Ihrer Leseliste: Legen Sie den Finger auf einen Link und wählen Sie 
dann „Zur Leseliste hinzufügen“.
Anzeigen der Leseliste Tippen Sie auf  und anschließend auf „Leseliste“.
Verwenden von iCloud, um die 
Leseliste auf Ihren iOS-Geräten 
und Computern auf dem neuesten 
Stand zu halten
Öffnen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie die Option 
„Lesezeichen“. Weitere Informationen unter „iCloud“ auf Seite 18.
Reader
Mit dem Reader werden Webartikel ganz übersichtlich und ohne Werbung angezeigt. So können 
Sie diese in Ruhe lesen. Sie können auf einer Webseite mit einem Artikel den Reader dazu 
verwenden, ausschließlich den Artikel zu öffnen.
Anzeigen eines Artikels im Reader:  Tippen Sie auf die Taste „Reader“, wenn diese im Adressfeld 
angezeigt wird.
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Speichern eines Artikels als 
Lesezeichen, Hinzufügen eines 
Artikels zur Leseliste bzw. zum 
Home-Bildschirm, Freigeben bzw. 
Drucken eines Artikels
Tippen Sie auf  .
Zurückkehren zur normalen Ansicht Tippen Sie auf „Fertig“.
Eingeben von Text und Ausfüllen von Formularen
Eingeben von Text: Wählen Sie ein Textfeld aus, um die Bildschirmtastatur einzublenden.
Wechseln in ein anderes Textfeld Tippen Sie auf ein anderes Textfeld oder tippen Sie auf „Weiter“ bzw. 
„Zurück“.
Absenden des Formulars Tippen Sie auf „Öffnen“ bzw. „Suchen“ bzw. auf den entsprechenden Link 
auf der Seite, um das Formular abzusenden.
Öffnen Sie „Einstellungen“ > „Safari“ und aktivieren Sie die Option „Autom. Ausfüllen“, um 
Formulare automatisch ausfüllen zu lassen.
Suchen
Über das Suchfeld oben rechts können Sie das Internet bzw. die aktuelle Seite oder PDF 
durchsuchen.
Durchsuchen des Internets sowie der aktuellen Seite oder PDF:  Geben Sie den gesuchten Text 
in das Feld „Suchen“ ein.
Â Suchen im Web:  Tippen Sie auf einen der angezeigten Vorschläge bzw. auf „Suchen“.
Â Suchen von Text auf der aktuellen Seite bzw. in der aktuellen PDF:  Scrollen Sie auf dem Bildschirm 
nach unten und tippen Sie auf den Eintrag unter „Auf dieser Seite“.
Das erste Vorkommen wird hervorgehoben. Tippen Sie auf  , um die nächsten Vorkommen des 
Begriffs zu finden.
Ändern der Suchmaschine Wählen Sie „Einstellungen“ > „Safari“ > „Suchmaschine“.
Lesezeichen und Verlauf
Setzen von Lesezeichen auf einer Webseite: Öffnen Sie die Seite, tippen Sie auf  und dann auf 
„Lesezeichen“.
Beim Sichern eines Lesezeichens können Sie dessen Titel bearbeiten. Standardmäßig wird das 
Lesezeichen auf der obersten Ebene im Lesezeichenordner gesichert. Tippen Sie auf „Lesezeichen“, 
um einen anderen Ordner auszuwählen.
Anzeigen zuvor besuchter Webseiten (Verlauf):  Tippen Sie auf  und anschließend auf 
„Verlauf“. Tippen Sie auf „Löschen“, um die Verlaufsliste zu löschen.
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versehenen Webseite
Tippen Sie auf  .
Bearbeiten eines Lesezeichens oder 
Lesezeichenordners
Tippen Sie auf  , wählen Sie den entsprechenden Ordner aus und tippen 
Sie auf „Bearbeiten“.
Verwenden von iCloud, um die 
Lesezeichen auf Ihren iOS-Geräten 
und Computern auf dem neuesten 
Stand zu halten
Öffnen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie die Option 
„Lesezeichen“. Weitere Informationen unter „iCloud“ auf Seite 18.
Synchronisieren von Lesezeichen 
mit dem Webbrowser auf Ihrem 
Computer
Weitere Informationen unter „Synchronisieren mit iTunes“ auf Seite 19.
Drucken von Webseiten, PDFs und anderen Dokumenten
Drucken von Webseiten, PDFs oder von in der Übersicht geöffneten Dokumenten: Tippen Sie 
auf  und anschließend auf „Drucken“.
Weitere Informationen unter „Drucken“ auf Seite 30.
Web-Clips
Sie können Web-Clips erstellen, die als Symbole auf Ihrem Home-Bildschirm angezeigt werden.
Hinzufügen eines Web-Clips: Öffnen Sie die Webseite und tippen Sie auf  . Tippen Sie dann auf 
„Zum Home-Bildschirm“.
Wenn Sie einen Web-Clip öffnen, vergrößert Safari automatisch den Bereich der Webseite, der 
beim Sichern des Web-Clips angezeigt wurde. Verfügt die Webseite über ein eigenes Symbol, wird 
dieses für das Web-Clip-Symbol auf dem Home-Bildschirm verwendet.
Web-Clips werden von iCloud und iTunes gespeichert, sie werden jedoch von iTunes oder 
MobileMe nicht synchronisiert. Sie werden von iCloud auch nicht an andere Geräte übertragen.
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Hinzufügen von Musik und Audiodateien
Übertragen von Musik und anderen Audioinhalten auf das iPhone:
Â Im iTunes Store auf dem iPhone können Sie Inhalte kaufen und laden. Weitere Informationen 
unter Kapitel 21,„iTunes Store,“ auf Seite 129. (Sie können auch über die App „Musik“ auf den 
iTunes Store zugreifen, indem Sie auf die Taste „Store“ tippen.)
Â Mit der Option „Automatische Downloads“ werden automatisch neu gekaufte Musiktitel auf 
Ihre anderen iOS-Geräte und Computer geladen. Weitere Informationen unter „iCloud“ auf 
Seite 18.
Â Synchronisieren Sie das Gerät mit Ihrem Computer. Sie können alle Medien synchronisieren 
oder nur bestimmte Musiktitel und andere Objekte. Weitere Informationen unter 
„Synchronisieren mit iTunes“ auf Seite 19.
Â Verwenden Sie iTunes Match zum Speichern Ihrer Musikmediathek in iCloud, damit sie auf allen 
iOS-Geräten und Computern verfügbar ist. Weitere Informationen unter „iTunes Match“ auf 
Seite 89.
Wiedergeben von Musik und anderen Audiodateien
ACHTUNG:  Wichtige Hinweise zur Vermeidung von Hörschäden und zur Sicherheit im 
Straßenverkehr finden Sie im Handbuch Wichtige Produktinformationen unter  
www.apple.com/de/support/manuals/iphone.
Mit den Tasten unten im Bildschirm können Sie Inhalte auf dem iPhone nach Wiedergabeliste, 
Interpret, Musiktitel und anderen Kategorien durchsuchen.
Wiedergeben eines Musiktitels oder eines anderen Objekts:  Tippen Sie auf ein Objekt.
Verwenden Sie die Tasten auf dem Bildschirm, um die Wiedergabe zu steuern. Alternativ können 
Sie auch die Tasten der Kopfhörer benutzen. Weitere Informationen unter „Apple Earphones mit 
Fernbedienung und Mikrofon“ auf Seite 36.
85Öffnen des Bildschirms „Sie hören“:  Tippen Sie auf „Sie hören“.
Nächster 
Titel/Vorspulen
Wiedergabe/
Pause
Titelliste
Zurück
Vorheriger Titel/ Lautstärke
Zurückspulen
AirPlay
Anpassen der Tasten zum Blättern Tippen Sie auf „Mehr“ und danach auf „Bearbeiten“ und bewegen Sie ein 
Symbol nach unten im Bildschirm über das Symbol, das ersetzt werden soll.
Laden weiterer Podcast-Folgen Tippen Sie auf „Podcasts“ (tippen Sie zuerst auf „Weitere“, wenn „Podcasts“ 
nicht angezeigt wird) und dann auf einen Podcast, um eine Liste mit den 
verfügbaren Folgen anzuzeigen.
Schütteln für die zufällige 
Wiedergabe
Schütteln Sie das iPhone, um die zufällige Wiedergabe zu aktivieren und 
einen anderen Titel abzuspielen. Schütteln Sie es erneut, um einen anderen 
Titel abzuspielen.
Sie können diese Funktion aktivieren oder deaktivieren, indem Sie 
„Einstellungen“ > „Musik“ wählen.
Wiedergeben von Musik über 
AirPlay-Lautsprecher oder Apple TV
Tippen Sie auf  . Weitere Informationen unter „AirPlay“ auf Seite 36.
Anzeigen des Liedtextes eines Titels Tippen Sie auf das Albumcover, wenn ein Musiktitel abgespielt wird. 
(Liedtexte werden angezeigt, wenn Sie sie über das Fenster „Infos“ des Titels 
in iTunes hinzugefügt haben und das iPhone mit iTunes synchronisiert 
haben.)
Festlegen der Musikoptionen Wählen Sie „Einstellungen“ > „Musik“. 
Wenn Sie eine andere App verwenden, zeigen Sie die Bedienelemente für die Audiowiedergabe 
an, indem Sie zweimal die Home-Taste  drücken und dann unten auf dem Bildschirm von links 
nach rechts streichen.
Mit den Steuerelementen wird die gerade geöffnete App gesteuert. Wurde die Musik angehalten, 
wird damit die als letztes verwendete App gesteuert. Das Symbol der App wird rechts 
angezeigt. Tippen Sie darauf, um die App zu öffnen. Streichen Sie erneut nach rechts, um den 
Lautstärkeregler und die Taste „AirPlay“ anzuzeigen (wenn sich das Gerät in der Reichweite eines 
Apple TV oder von AirPlay-Lautsprechern befindet).
Durch zweimaliges Drücken der Home-Taste  werden die Bedienelemente auch dann angezeigt, 
wenn der Bildschirm gesperrt ist.
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Tippen Sie im Bildschirm „Sie hören“ auf das Albumcover, um zusätzliche Bedienelemente 
anzuzeigen. Sie können die verstrichene Zeit, die verbleibende Zeit und die Titelnummer sehen. 
Haben Sie den Liedtext des Titels in iTunes hinzugefügt, wird dieser ebenfalls angezeigt.
Wiederholen
Ping-
„Gefällt mir“
Navigationsleiste
Zufällige 
Wiedergabe
Genius
Ping-Post
Abspielposition
Wiederholen von Musiktiteln Tippen Sie auf  . 
 = alle Titel des Albums bzw. der Liste wiederholen
 = aktuellen Titel wiederholen
 = keine Wiederholung
Zufällige Wiedergabe Tippen Sie auf  . 
 = Titel zufällig wiedergeben
 = Titel der Reihe nach wiedergeben
Springen zu einer beliebigen Stelle 
in einem Musiktitel
Bewegen Sie die Abspielposition auf der Navigationsleiste. Streichen Sie 
mit dem Finger langsam nach unten, um die Scrubbing-Geschwindigkeit 
anzupassen.
Erstellen einer GeniusWiedergabeliste
Tippen Sie auf  . Weitere Informationen unter „Genius“ auf Seite 90.
Verwenden von Ping Weitere Informationen unter „Mitverfolgen der Aktivitäten von Interpreten 
und Freunden“ auf Seite 131.
Bedienelemente für Podcasts und Hörbücher
Im Bildschirm „Sie hören“ werden Bedienelemente und Informationen angezeigt, wenn die 
Wiedergabe gestartet wird.
Navigationsleiste
Abspielposition
Wiedergabetempo
E-Mail  30 Sekunden-Wiedergabe
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Wiedergabegeschwindigkeit
Tippen Sie auf  . Tippen Sie ein weiteres Mal, um die Geschwindigkeit zu 
ändern.
 = mit doppelter Geschwindigkeit wiedergeben
 = mit halber Geschwindigkeit wiedergeben
 = mit normaler Geschwindigkeit wiedergeben
Springen zu einer beliebigen Stelle 
in der Timeline
Bewegen Sie die Abspielposition auf der Navigationsleiste. Streichen Sie 
mit dem Finger langsam nach unten, um die Scrubbing-Geschwindigkeit 
anzupassen.
Ein- oder Ausblenden der 
Bedienelemente
Tippen Sie auf die Mitte des Bildschirms.
Ausblenden von PodcastInformationen
Wählen Sie „Einstellungen“ > „Musik“.
Verwenden von Siri bzw. der Sprachsteuerung mit der App „Musik“
Sie können mit Siri (iPhone 4S) bzw. der Sprachsteuerung die Musikwiedergabe auf dem iPhone 
steuern. Weitere Informationen unter Kapitel 4,„Siri,“ auf Seite 43 und „Sprachsteuerung“ auf 
Seite 32.
Steuern der Musikwiedergabe Sagen Sie „Abspielen“ oder „Musik spielen“. Sagen Sie „Pause“ oder „Musik 
anhalten“, um die Wiedergabe zu unterbrechen. Weitere mögliche Befehle 
sind „Nächster Titel“ oder „Vorheriger Titel“.
Wiedergabe eines Albums, 
eines Künstlers oder einer 
Wiedergabeliste
Sagen Sie zunächst „Abspielen“, danach „Album“, „Interpret“ oder 
„Wiedergabeliste“ und schließlich den Namen.
Zufällige Wiedergabe der aktuellen 
Wiedergabeliste
Sagen Sie „Zufällig“.
Abrufen zusätzlicher Informationen 
über den aktuell gespielten Titel
Sagen Sie „Wie heißt der Song“, „Welcher Titel ist das“ oder „Wer singt dieses 
Lied“.
Wiedergabe ähnlicher Titel mittels 
Genius
Sagten Sie „Genius“, „Ähnliche Titel spielen“ oder „Ähnliche Lieder spielen“.
Abbrechen/Beenden der 
Sprachsteuerung
Sagen Sie „Abbrechen“ oder „Stopp“.
Durchblättern von Albumcovern mit Cover Flow
Wenn Sie Ihre Musik durchblättern, drehen Sie das iPhone, um Ihre iTunes-Inhalte mit Cover Flow 
anzusehen und Ihre Musik nach Albumcovern zu durchstöbern.
Durchblättern der Albumcover:  Streichen Sie mit dem Finger nach links oder rechts über den 
Bildschirm.
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oder unten, um die Musiktitel zu durchblättern, und tippen Sie auf einen 
Titel, um diesen wiederzugeben.
Zurückkehren zum Cover Tippen Sie auf die Titelleiste. Oder tippen Sie erneut auf  .
Anzeigen aller Titel eines Albums
Anzeigen aller Musiktitel des Albums, das den aktuellen Musiktitel enthält: Tippen Sie auf dem 
Bildschirm „Sie hören“ auf  . Tippen Sie auf einen Musiktitel, um ihn abzuspielen. Tippen Sie auf 
die Miniatur des Albums, um zum Bildschirm „Sie hören“ zurückzukehren.
Bewertungsleiste
Zurück zum 
Bildschirm „Sie hören“
Albumtitel
In der Darstellung „Titelliste“ können Sie Musiktitel bewerten. Verwenden Sie bei der Erstellung 
von intelligenten Wiedergabelisten in iTunes Bewertungen.
Suchen nach Audioinhalten
Sie können nach Titeln, Interpreten, Alben, Komponisten, Podcasts sowie anderen Audioinhalten 
suchen, die Sie mit dem iPhone synchronisiert haben.
Suchen nach Musik: Geben Sie den gesuchten Text in das Feld „Suchen“ ein, das über der 
Titelliste, der Wiedergabeliste, der Liste der Interpreten oder einer anderen Ansicht mit 
Musikinhalten angezeigt wird.
Sie können auch vom Home-Bildschirm aus Musik suchen. Weitere Informationen unter 
„Suchen“ auf Seite 31.
iTunes Match
iTunes Match speichert Ihre Musikmediathek in iCloud, einschließlich den von CDs importierten 
Titeln. So können Sie Ihre Sammlung immer und überall auf dem iPhone und anderen iOSGeräten und Computern genießen. Bei iTunes Match handelt es sich um ein kostenpflichtiges 
Abonnement.
Hinweis:  iTunes Match ist nicht in allen Regionen verfügbar. Es können Roaming-Gebühren 
anfallen, wenn unter „Einstellungen“ > „Musik“ > „Mobile Daten verwenden“ aktiviert ist.
Abonnieren von iTunes Match:  Wählen Sie in iTunes auf Ihrem Computer „Store“ > „iTunes Match 
aktivieren“ und klicken Sie auf die Taste „Abonnieren“.
Nach dem Abonnieren fügt iTunes Ihre Musik, Wiedergabelisten und Genius-Mixe zu iCloud 
hinzu. Titel, die bereits im iTunes Store vorhanden sind, sind in iCloud automatisch verfügbar. Alle 
anderen Titel werden hochgeladen. Sie können Titel, die mit iTunes Match verarbeitet wurden, in 
iTunes Plus-Qualität anhören (256 kBit/s AAC ohne Kopierschutz), auch wenn die ursprüngliche 
Datei eine geringere Qualität hatte. Weitere Informationen erhalten Sie unter www.apple.com/de/
icloud/features.
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Durch das Aktivieren von iTunes Match werden synchronisierte Musiktitel 
vom iPhone entfernt und Genius-Mixe und Genius-Wiedergabelisten 
deaktiviert.
Genius
Bei einer Genius-Wiedergabeliste handelt es sich um eine Sammlung von Musiktiteln aus Ihrer 
Mediathek, die gut zusammenpassen. Erstellen Sie in iTunes Genius-Wiedergabelisten und 
synchronisieren Sie diese mit Ihrem iPhone. Sie können Genius-Wiedergabelisten auch direkt auf 
dem iPhone erstellen und sichern.
Ein Genius-Mix ist eine Auswahl von Musiktiteln aus dem gleichen Genre, die jedes Mal neu aus 
Ihrer Mediathek zusammengestellt wird, wenn Sie den Mix wiedergeben.
Um die Genius-Funktion auf dem iPhone zu nutzen, aktivieren Sie sie zunächst in iTunes und 
synchronisieren Sie dann das iPhone mit iTunes. Genius-Mixe werden automatisch synchronisiert, 
es sei denn, Sie verwalten Ihre Musik manuell und wählen aus, welche Mixe in iTunes 
synchronisiert werden sollen. Genius ist ein kostenloser Dienst, zu dessen Nutzung eine Apple-ID 
erforderlich ist.
Wenn Sie einen Genius-Mix synchronisieren, wählt und synchronisiert iTunes möglicherweise 
Musiktitel in Ihrer Mediathek, die Sie bisher noch nicht für die Synchronisierung ausgewählt 
hatten.
Blättern durch Genius-Mixe: Tippen Sie auf „Genius“ (tippen Sie zuerst auf „Weitere“, wenn 
„Genius“ nicht angezeigt wird). Streichen Sie nach links oder rechts, um auf Ihre anderen Mixe 
zuzugreifen. Tippen Sie auf  , um einen Mix wiederzugeben.
Erstellen einer Genius-Liste:  Zeigen Sie Ihre Wiedergabelisten an, tippen Sie auf „Genius“ und 
wählen Sie einen Titel aus.
Um auf dem Bildschirm „Sie hören“ eine Genius-Liste zu erstellen, tippen Sie auf den Bildschirm, 
um die Bedienelemente anzuzeigen, und tippen Sie dann auf  .
Sichern einer Genius-Liste Tippen Sie in der Wiedergabeliste auf „Sichern“. Die Wiedergabeliste wird 
mit dem Namen des gewählten Titels unter „Listen“ gesichert.
Aktualisieren einer Genius-Liste Tippen Sie in der Wiedergabeliste auf „Aktualisieren“.
Erstellen einer Genius-Liste 
basierend auf einem anderen Titel
Tippen Sie in der Wiedergabeliste auf „Neu“ und wählen Sie einen Musiktitel 
aus.
Löschen einer gesicherten GeniusListe
Tippen Sie in der Wiedergabeliste auf „Löschen“.
Auf dem iPhone erstellte Genius-Wiedergabelisten werden auf Ihren Computer kopiert, wenn Sie 
das Gerät mit iTunes synchronisieren.
Hinweis:  Nachdem eine Genius-Liste mit iTunes synchronisiert wurde, können Sie sie nicht mehr 
direkt auf dem iPhone löschen. Verwenden Sie iTunes, um den Namen der Wiedergabeliste zu 
bearbeiten, die Synchronisierung zu beenden oder die Wiedergabeliste zu löschen.
Wiedergabelisten
Erstellen und bearbeiten Sie Ihre eigenen Wiedergabelisten auf dem iPhone oder bearbeiten Sie 
mit iTunes synchronisierte Wiedergabelisten auf Ihrem Computer.
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Liste“ oben. Geben Sie einen Titel ein, tippen Sie auf  , um Musiktitel und Videos auszuwählen, 
und wählen Sie dann „Fertig“.
Wenn Sie eine Wiedergabeliste erstellen und das iPhone mit Ihrem Computer synchronisieren, 
wird die Wiedergabeliste mit Ihrer iTunes-Mediathek synchronisiert.
Bearbeiten einer Wiedergabeliste  Zeigen Sie Ihre Wiedergabelisten an und wählen Sie die zu 
bearbeitende Liste aus. Tippen Sie auf „Bearbeiten“ und führen Sie eine der folgenden Aktionen 
aus
Â Hinzufügen weiterer Titel:  Tippen Sie auf  .
Â Löschen eines Musiktitels:  Tippen Sie auf  . Wenn Sie einen Titel aus einer Liste löschen, wird er 
nicht vom iPhone gelöscht.
Â Bewegen eines Titels an eine andere Stelle in der Liste:  Legen Sie Ihren Finger auf  und bewegen 
Sie den Titel.
Das nächste Mal, wenn Sie das iPhone mit Ihrem Computer synchronisieren, werden Ihre 
Änderungen automatisch mit Ihrer iTunes-Mediathek oder drahtlos via iCloud synchronisiert, 
wenn Sie iTunes Match abonniert haben.
Löschen einer Wiedergabeliste Tippen Sie unter „Wiedergabelisten“ auf die Liste, die Sie entfernen 
möchten, und tippen Sie dann auf „Löschen“.
Leeren einer Wiedergabeliste Tippen Sie unter „Wiedergabelisten“ auf die Liste, die Sie leeren möchten, 
und tippen Sie dann auf „Löschen“.
Löschen eines Titels vom iPhone Legen Sie in „Titel“ Ihren Finger auf den entsprechenden Titel und tippen 
Sie auf „Löschen“.
Der Titel wird vom iPhone gelöscht, jedoch nicht aus der iTunes-Mediathek 
auf Ihrem Mac oder PC.
Privatfreigabe
Mit der Funktion „Privatfreigabe“ können Sie Musik, Filme und Fernsehsendungen aus der iTunesMediathek auf Ihrem Computer oder PC auf dem iPhone wiedergeben. Dafür müssen sich das 
iPhone und der Computer im gleichen WLAN-Netzwerk befinden. Auf Ihrem Computer muss 
iTunes mit aktivierter Privatfreigabe geöffnet sein und dieselbe Apple-ID wie die Privatfreigabe auf 
dem iPhone verwendet werden.
Hinweis:  Für die Privatfreigabe ist iTunes 10.2 oder neuer erforderlich, verfügbar unter www.
itunes.com/de/download. Bonusmaterial wie digitale CD-Booklets und iTunes Extras können nicht 
freigegeben werden.
Wiedergeben von Musik von Ihrer iTunes-Mediathek auf Ihrem iPhone:
1 Wählen Sie in iTunes auf Ihrem Computer „Erweitert“ > „Privatfreigabe aktivieren“.
2 Melden Sie sich an und klicken Sie auf „Privatfreigabe anlegen“. 
3 Öffnen Sie auf dem iPhone „Einstellungen“ > „Musik“ und melden Sie sich mit der gleichen AppleID und dem gleichen Kennwort bei der Privatfreigabe an.
4 Tippen Sie in „Musik“ auf „Weitere“, „Freigegeben“ und wählen Sie dann Ihre Mediathek aus.
Zurückkehren zu den Inhalten auf 
dem iPhone
Tippen Sie auf „Freigegeben“ und wählen Sie „Mein iPhone“.
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Senden und Empfangen von Nachrichten
ACHTUNG:  Wichtige Hinweise zum sicheren Fahren finden Sie im Handbuch Wichtige 
Produktinformationen unter www.apple.com/de/support/manuals/iphone.
Die App „Nachrichten“ unterstützt den Austausch von Textmitteilungen mit anderen SMS- und 
MMS-Diensten sowie mit anderen iOS-Geräten über iMessage. Bei MMS und iMessage können Sie 
auch Fotos, Videos und andere Daten hinzufügen.
Senden Sie mit iMessage über WLAN oder das mobile Datennetzwerk Nachrichten an andere iOS 
5-Benutzer. Ihnen wird angezeigt, wenn die andere Person Text eingibt. Außerdem werden Sie 
benachrichtigt, wenn Ihre Nachricht gelesen wurde. iMessages werden auf all Ihren iOS 5-Geräten 
angezeigt, die den gleichen Account verwenden. So können Sie ein Gespräch auf einem Gerät 
beginnen und es auf einem anderen fortsetzen. iMessages sind verschlüsselt.
Hinweis:  Für SMS und MMS ist eine mobile Datenverbindung erforderlich. Diese ist 
möglicherweise nicht überall verfügbar. Zusätzliche Gebühren sind möglich.
Senden einer Textmitteilung:  Tippen Sie auf  , tippen Sie dann auf  und wählen Sie einen 
Kontakt aus, suchen Sie einen Kontakt, indem Sie einen Namen eingeben, oder geben Sie eine 
Telefonnummer oder E-Mail-Adresse ein. Geben Sie den Text ein und tippen Sie auf „Senden“.
Hinweis:  Wenn eine Nachricht nicht gesendet werden kann, wird eine Warnung  angezeigt. 
Tippen Sie auf die Warnung in einer Unterhaltung, um die Nachricht erneut zu senden.
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Ein blauer Punkt  kennzeichnet eine ungelesene Nachricht. Tippen Sie auf eine Unterhaltung, 
um sie anzuzeigen oder fortzusetzen. Bei einer iMessage-Unterhaltung werden ausgehende 
Nachrichten blau dargestellt.
Tippen Sie hier, um 
ein Foto oder Video 
anzuhängen.
Tippen Sie hier, um 
Text einzugeben.
Verwenden von Emoji-Zeichen Wählen Sie „Einstellungen“ > „Allgemein“ > „Landeseinstellungen“ > 
„Tastaturen“ > „Tastatur hinzufügen“ und tippen Sie auf „Emoji“, um diese 
Tastatur zu verwenden. Um beim Eingeben einer Nachricht Emoji-Zeichen 
zu verwenden, tippen Sie zum Öffnen der Emoji-Tastatur auf  . Weitere 
Informationen unter „Wechseln der Tastatur“ auf Seite 193.
Fortsetzen einer vorherigen 
Unterhaltung
Tippen Sie auf die Unterhaltung in der Nachrichtenliste, geben Sie Ihre 
Nachricht ein und tippen Sie dann auf „Senden“.
Anzeigen früherer Nachrichten in 
einer Unterhaltung
Scrollen Sie nach oben (tippen Sie auf die Statusleiste) und wählen Sie 
„Vorherige Nachrichten laden“.
Abrufen von iMessages mit einer 
anderen E-Mail-Adresse
Wählen Sie „Einstellungen“ > „Nachrichten“ > „Empfangen:“ > „Weitere 
E-Adresse hinzufügen“.
Angeben der Telefonnummer 
oder E-Mail-Adresse der AppleID, die beim Starten einer neuen 
Unterhaltung im Feld „Von“ 
angezeigt wird
Wählen Sie „Einstellungen“ > „Nachrichten“ > „Empfangen:“ > „Anrufer-ID“.
Bestehende Unterhaltungen sind durch das Ändern dieser Einstellung nicht 
betroffen.
Auswählen eines Links in einer 
Nachricht
Tippen Sie auf den Link. Dadurch kann zum Beispiel in Safari eine Website 
geöffnet oder eine Telefonnummer gewählt werden.
Weiterleiten einer Unterhaltung Wählen Sie eine Unterhaltung aus und tippen Sie auf „Bearbeiten“. Wählen 
Sie die Teile aus, die eingeschlossen werden sollen, und tippen Sie dann auf 
„Weiterleiten“.
Hinzufügen eines Kontakts zu Ihrer 
Kontaktliste
Tippen Sie auf eine Telefonnummer in der Nachrichtenliste und wählen Sie 
„Zu Kontakten hinzufügen“.
Benachrichtigen, wenn Sie 
Nachrichten gelesen haben
Öffnen Sie „Einstellungen“ > „Nachrichten“ und aktivieren Sie 
„Lesebestätigungen senden“.
Festlegen weiterer Optionen für 
Nachrichten
Wählen Sie „Einstellungen“ > „Nachrichten“.
Verwalten der Benachrichtigungen 
für Nachrichten
Weitere Informationen unter „Benachrichtigungen“ auf Seite 181.
Festlegen des Hinweistons für 
eingehende Textmitteilungen
Weitere Informationen unter „Töne und der Schalter „Klingeln/Aus““ auf 
Seite 184.
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Mit Gruppen-Messaging können Sie eine Nachricht an mehrere Empfänger senden. GruppenMessaging funktioniert mit iMessage und MMS (nicht in allen Regionen verfügbar).
Senden von Mitteilungen an eine Gruppe:  Tippen Sie auf  und geben Sie mehrere Empfänger 
ein.
Hinweis:  Beim Senden von MMS muss in „Einstellungen“ > „Nachrichten“ die Option „GruppenMessaging“ aktiviert werden. Antworten werden nur an Sie und nicht an die anderen 
Gruppenmitglieder gesendet.
Senden von Fotos, Videos und anderen Inhalten
Sie können mit iMessage oder MMS Fotos, Videos, Standorte, Kontaktinformationen und 
Sprachmemos senden.
Senden eines Fotos oder Videos:  Tippen Sie auf  .
Die zulässige Größe für Anhänge ist von Ihrem Serviceprovider abhängig. Bei Bedarf komprimiert 
das iPhone Fotos und Videos.
Senden eines Orts Tippen Sie in „Karten“ auf  , um einen Standort abzurufen, tippen Sie 
dann auf „Ort senden“ (unten) und auf „Nachricht“.
Senden von Kontaktinfos Wählen Sie in „Kontakte“ einen Kontakt, tippen Sie auf „Kontakt senden“ 
(unten) und dann auf „Nachricht“.
Senden eines Sprachmemos Tippen Sie in „Sprachmemos“ auf  , dann auf das Memo, auf „Senden“ und 
dann auf „Nachricht“.
Sichern eines Foto- oder 
Videoanhangs in Ihrem Album 
„Aufnahmen“
Tippen Sie auf das Foto oder Video und dann auf  .
Kopieren eines Fotos oder Videos Legen Sie den Finger auf den Anhang und tippen Sie danach auf 
„Kopieren“.
Sichern empfangener 
Kontaktinformationen
Tippen Sie auf die Sprechblase des Kontakts, tippen Sie danach auf „Neuen 
Kontakt erstellen“ oder auf „Zu Kontakt hinzufügen“.
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Wenn Sie nur einen Teil der Unterhaltung behalten möchten, können Sie die nicht gewünschten 
Teile löschen. Sie können auch in der Nachrichtenliste vollständige Unterhaltungen löschen.
Bearbeiten einer Unterhaltung:  Tippen Sie auf „Bearbeiten“, wählen Sie die zu löschenden Teile 
aus und tippen Sie auf „Löschen“.
Löschen aller Texte und Dateien, 
ohne die Unterhaltung zu löschen
Tippen Sie auf „Bearbeiten“ und danach auf „Löschen“.
Löschen einer Unterhaltung Legen Sie Ihren Finger auf die Unterhaltung und tippen Sie dann auf 
„Löschen“.
Durchsuchen von Nachrichten
In der Nachrichtenliste können Sie nach dem Inhalt von Nachrichten suchen.
Durchsuchen einer Unterhaltung:  Tippen Sie oben auf den Bildschirm, um das Suchfeld 
anzuzeigen. Geben Sie dann den gesuchten Text ein.
Sie können auch vom Home-Bildschirm aus Unterhaltungen suchen. Weitere Informationen unter 
„Suchen“ auf Seite 31.
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Kalender
Der Kalender macht es leicht, den Überblick über Termine zu behalten. Sie können Kalender 
einzeln oder mehrere Kalender gleichzeitig anzeigen. Sie können die Ereignisse nach Tagen, nach 
Monaten oder in einer Liste anzeigen. Sie können unter Verwendung von Titeln, eingeladenen 
Personen oder Veranstaltungsort nach bestimmten Veranstaltungen oder Terminen suchen. Wenn 
Sie Geburtstage für Kontakte eintragen, können Sie diese Geburtstage im Kalender anzeigen.
Sie können auf dem iPhone Ereignisse erstellen, bearbeiten oder absagen und diese dann wieder 
mit Ihrem Computer synchronisieren. Abonnieren Sie Kalender von Google, Yahoo! oder iCal. 
Wenn Sie über einen Microsoft Exchange- oder iCloud-Account verfügen, können Sie Einladungen 
erhalten und darauf reagieren.
Anzeigen Ihrer Kalender
Sie können einzelne oder mehrere Kalender zusammen anzeigen. Dies erleichtert das 
gleichzeitige Verwalten von beruflichen und privaten Kalendern.
Hinzufügen eines 
Ereignisses
Tage mit Punkten 
kennzeichnen Termine
Heutiger Tag Wechseln der 
Darstellung
Beantworten einer 
Einladung
Termine für den 
ausgewählten Tag
Wechseln der Darstellungen: Tippen Sie auf „Liste“, „Tag“ oder „Monat“. Drehen Sie das iPhone, 
um die gesamte Woche anzuzeigen.
Streichen Sie in der Tagesansicht nach links oder rechts, um zwischen Daten zu wechseln.
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Ihrer Kontakte gemeinsam mit Ihren Ereignissen anzuzeigen.
Anzeigen der Informationen eines 
Termins oder Ereignisses
Tippen Sie auf den Termin. Wenn Sie auf „Informationen“ tippen, werden 
weitere Einzelheiten angezeigt. Ist eine Adresse oder ein Ort angegeben, 
tippen Sie darauf, um „Karten“ zu öffnen.
Bearbeiten oder Löschen eines 
Kalenders
Tippen Sie auf „Kalender“ und dann auf „Bearbeiten“.
Auswählen der Kalender für die 
Anzeige
Tippen Sie auf „Kalender“ und wählen Sie dann die Kalender durch Tippen 
aus, die angezeigt werden sollen. Die Ereignisse aller ausgewählten 
Kalender werden in einem einzigen Kalender auf dem iPhone angezeigt.
Hinzufügen von Ereignissen
Sie können Kalenderereignisse direkt auf dem iPhone erstellen und aktualisieren.
Hinzufügen eines Ereignisses:  Tippen Sie auf  und geben Sie Informationen zum Ereignis ein. 
Tippen Sie dann auf „Fertig“.
Sie können Ihren Finger auch auf eine freie Stelle im Kalender legen, um ein neues Ereignis zu 
erstellen. Passen Sie mithilfe der Aktivpunkte die Dauer des Ereignisses an.
Setzen einer Erinnerung Setzen Sie eine Erinnerung von fünf Minuten bis zu zwei Tagen vor dem 
Ereignis.
Setzen einer Standarderinnerung 
für Ereignisse
Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ > 
„Standarderinnerungen“.
Aktualisieren eines Ereignisses Tippen Sie auf „Bearbeiten“ und ändern Sie die Informationen für das 
Ereignis. 
Um die Uhrzeit oder Dauer eines Ereignisses schnell anzupassen, legen 
Sie Ihren Finger auf das Ereignis, um es auszuwählen, und bewegen Sie es 
auf eine neue Uhrzeit oder bewegen Sie die Aktivpunkte, um die Dauer zu 
ändern.
Löschen eines Ereignisses Tippen Sie auf das Ereignis und auf „Bearbeiten“. Blättern Sie dann nach 
unten und tippen Sie auf „Ereignis löschen“.
Einladen weiterer Teilnehmer zu 
einem Ereignis
Tippen Sie auf „Teilnehmer“, um Personen aus Ihren Kontakten 
auszuwählen. Dafür benötigen Sie einen iCloud-, einen Microsoft Exchange- 
oder einen CalDAV-Account.
Antworten auf Einladungen
Wenn Sie einen iCloud-, Microsoft Exchange- oder CalDAV-Account besitzen, können Sie 
Einladungen zu Besprechungen von Mitarbeitern in Ihrem Unternehmen empfangen und 
beantworten. Wenn Sie eine Einladung erhalten, wird die jeweilige Besprechung in Ihrem 
Kalender mit einer gepunkteten Linie umrandet.  wird unten rechts im Bildschirm angezeigt.
Antworten auf eine Einladung:  Tippen Sie auf eine Einladung im Kalender. Oder tippen Sie auf 
, um den Ereignisbildschirm anzuzeigen, und tippen Sie dann auf eine Einladung.
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Organisator
Tippen Sie auf „Einladung von“.
Anzeigen weiterer Teilnehmer Tippen Sie auf „Teilnehmer“. Tippen Sie auf einen Namen, um die 
Kontaktinformationen dieser Person einzublenden.
Hinzufügen von Kommentaren zu 
einer Antwort
Tippen Sie auf „Kommentar hinzufügen“. Nur der Organisator kann 
den Kommentar ansehen. Je nach verwendetem Kalenderdienst ist die 
Kommentarfunktion möglicherweise nicht verfügbar.
Festlegen der eigenen 
Verfügbarkeit
Tippen Sie auf „Verfügbarkeit“ und wählen Sie „Beschäftigt“ oder „Frei“.
Durchsuchen von Kalendern
Sie können in der Listendarstellung nach Titeln, Namen eingeladener Personen, 
Veranstaltungsorten und Notizen für Termine in Ihren Kalendern suchen. Bei der Suche werden 
nur Ereignisse in den gerade angezeigten Kalendern durchsucht.
Suchen nach Veranstaltungen und Terminen:  Geben Sie in der Listenansicht den gesuchten Text 
in das Suchfeld ein.
Bei der Suche vom Home-Bildschirm aus kann auch nach Kalenderereignissen gesucht werden. 
Weitere Informationen unter „Suchen“ auf Seite 31.
Abonnieren von Kalendern
Sie können Kalender abonnieren, die das Format iCalendar (.ics) verwenden. Zahlreiche 
kalenderbasierte Dienste wie iCloud, Yahoo!, Google und das Programm „iCal“ von OS X 
unterstützen das Abonnieren von Kalendern.
Auf abonnierte Kalender haben Sie nur Lesezugriff. Sie können auf dem iPhone Ereignisse aus 
abonnierten Kalendern anzeigen, jedoch können diese nicht bearbeitet oder neue erstellt werden.
Abonnieren eines Kalenders: Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ und 
dann auf „Account hinzufügen“. Wählen Sie „Andere“ und dann „Kalenderabo hinzufügen“ aus.
Sie können auch einen iCal-Kalender (oder einen anderen .ics-Kalender) abonnieren, der im 
Internet veröffentlicht wurde, indem Sie auf einen Link im Kalender tippen.
Importieren von Kalenderereignissen aus Mail
Sie können Ereignisse zu einem Kalender hinzufügen, indem Sie eine Kalenderdatei aus einer 
E-Mail-Nachricht importieren. Importieren Sie eine beliebige Standard-.ics-Datei.
Importieren von Ereignissen aus einer Kalenderdatei:  Öffnen Sie in Mail die Nachricht und 
tippen Sie auf die Kalenderdatei.
Kalender-Accounts und -einstellungen
Es gibt unter „Einstellungen“ > „Mail, Kontakte, Kalender“ mehrere Einstellungen, die sich auf Ihre 
Kalender sowie Ihre Kalender-Accounts auswirken.
Kalender-Accounts werden auch verwendet, um Aufgaben für Erinnerungen zu synchronisieren.
Hinzufügen eines CalDAV-Accounts:  Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“, 
dann auf „Account hinzufügen“ und auf „Andere“. Tippen Sie unter „Kalender“ auf „CalDAV-Account 
hinzufügen“.
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Festlegen der Kalenderhinweise Wählen Sie „Einstellungen“ > „Töne“ > „Kalenderhinweise“. 
Synchronisieren vergangener 
Ereignisse
Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ und dann auf 
„Sync“. Künftige Ereignisse werden immer synchronisiert.
Festlegen, dass beim Eingang 
von Einladungen zu Meetings ein 
akustisches Signal ausgegeben 
wird
Wählen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“ und tippen Sie auf 
„Einladungsmeldungen“.
Festlegen des Zeitzonen-Supports Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ > „ZeitzonenSupport“.
Festlegen eines Standardkalenders Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ > 
„Standardkalender“.
Verwenden von iCloud, um den 
Kalender auf Ihren iOS-Geräten 
und Computern auf dem neuesten 
Stand zu halten
Öffnen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie die Option 
„Kalender“. Weitere Informationen unter „iCloud“ auf Seite 18.
Wichtig:  Wenn der Zeitzonen-Support aktiviert ist, zeigt die App „Kalender“ Datum und 
Uhrzeit der Termine in der Zeitzone der ausgewählten Stadt an. Wenn der Zeitzonen-Support 
deaktiviert ist, zeigt die App „Kalender“ Termine in der Zeitzone Ihres aktuellen Aufenthaltsorts 
an. Maßgeblich ist hierbei die Netzwerkzeit. Nicht alle Mobilfunkanbieter unterstützen überall das 
Abrufen von Netzwerkzeiten. Wenn Sie auf Reisen sind, gibt das iPhone visuelle und akustische 
Hinweise auf Ereignisse möglicherweise nicht zur korrekten lokalen Uhrzeit aus. Wenn Sie die 
Uhrzeit manuell korrigieren wollen, lesen Sie die Informationen unter „Datum & Uhrzeit“ auf 
Seite 190.
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Anzeigen von Fotos und Videos
Mit der App „Fotos“ können Sie Ihre Fotos und Videos auf dem iPhone anschauen. Sie haben dazu 
folgende Möglichkeiten:
Â Album „Aufnahmen“: Hier werden die Fotos und Videos gesichert, die Sie mit den integrierten 
Kameras gemacht bzw. über E-Mail oder Textmitteilung erhalten oder von einer Webseite 
gespeichert haben.
Â Album „Fotostream“: Fotos, die aus iCloud gestreamt werden (vgl. „Fotostream“ auf Seite 106)
Â Fotomediathek und andere Alben, die vom Computer synchronisiert werden (vgl. 
„Synchronisieren mit iTunes“ auf Seite 19)
Foto bearbeiten
Foto löschen
Auf den Bildschirm 
tippen, um die Steuerelemente anzuzeigen
Freigeben oder Zuweisen eines Fotos, Verwenden eines 
Fotos als Hintergrundbild oder Drucken eines Fotos
Wiedergeben einer Diashow
Streamen von Videos mithilfe von AirPlay
Anzeigen von Fotos und Videos:  Tippen Sie auf ein Album und dann auf eine Miniatur, um das 
jeweilige Foto oder Video im Vollbildmodus anzuzeigen.
Alben, die Sie mit iPhoto 8.0 (iLife ’09) oder neuer oder Aperture 3.0.2 oder neuer synchronisieren, 
können nach Ereignissen oder Gesichtern angezeigt werden. Wurde eine Kamera benutzt, die 
Geotagging unterstützt, können Sie Fotos auch nach Standort ansehen.
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Bedienelemente
Tippen Sie auf das Foto oder Video im Vollbildmodus.
Anzeigen des nächsten oder 
vorherigen Fotos oder Videos
Streichen Sie mit dem Finger nach links oder rechts über den Bildschirm.
Verkleinern oder Vergrößern Tippen Sie zweimal oder ziehen Sie das Foto auf bzw. zu.
Schwenken über ein Foto Bewegen Sie den Finger auf dem Foto.
Abspielen eines Videos Tippen Sie auf  in der Mitte des Bildschirms.
Anzeigen eines Videos in 
bildschirmfüllendem oder an die 
Bildschirmgröße angepasstem 
Modus
Tippen Sie zweimal auf das Video.
Streamen eines Videos auf einem 
HD-Fernsehgerät
Weitere Informationen unter „AirPlay“ auf Seite 36.
Bearbeiten von Fotos bzw.Trimmen 
von Videos
Weitere Informationen unter „Bearbeiten von Fotos“ oder „Trimmen von 
Videos“ auf Seite 106.
Anzeigen von Diashows
Anzeigen einer Diashow:  Tippen Sie auf ein Album, um es zu öffnen, tippen Sie dann auf ein 
Foto und anschließend auf  . Öffnen Sie die Diashow-Optionen und tippen Sie auf „Präsentation 
starten“.
Streamen einer Diashow auf einem 
HD-Fernsehgerät
Weitere Informationen unter „AirPlay“ auf Seite 36.
Stoppen einer Diashow Tippen Sie auf den Bildschirm.
Festlegen weiterer Optionen Wählen Sie „Einstellungen“ > „Fotos“.
Verwalten von Fotos und Videos
Sie können Alben auf Ihrem iPhone erstellen, umbenennen und löschen und behalten so den 
Überblick über Ihre Fotos und Videos.
Erstellen eines Albums: Tippen Sie beim Anzeigen der Alben auf „Bearbeiten“ und dann auf 
„Hinzufügen“. Wählen Sie die Fotos aus, die zum neuen Album hinzugefügt werden sollen, und 
tippen Sie auf „Fertig“.
Hinweis:  Alben, die auf dem iPhone erstellt werden, werden nicht auf dem Computer 
synchronisiert.
Umbenennen eines Albums Tippen Sie auf „Bearbeiten“ und wählen Sie ein Album.
Neuanordnen von Alben Tippen Sie auf „Bearbeiten“ und bewegen Sie  nach oben oder unten.
Löschen eines Albums Tippen Sie auf „Bearbeiten“ und auf  .
Senden von Fotos und Videos
Senden eines Fotos oder Videos in einer E-Mail, einer Textmitteilung (iMessage oder MMS) 
oder als Tweet:  Tippen Sie auf das entsprechende Foto oder Video und dann auf  . Wird 
nicht angezeigt, tippen Sie auf den Bildschirm, um die Bedienelemente anzuzeigen.
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veröffentlichen. Wählen Sie „Einstellungen“ > „Twitter“.
Die zulässige Größe für Anhänge ist von Ihrem Serviceprovider abhängig. Bei Bedarf komprimiert 
das iPhone Fotos und Videos.
Senden mehrerer Fotos oder Videos Tippen Sie in der Miniaturübersicht auf  , wählen Sie die gewünschten 
Fotos oder Videos aus und tippen Sie auf „Senden“.
Kopieren eines Fotos oder Videos Legen Sie den Finger auf das Foto oder Video und tippen Sie danach auf 
„Kopieren“.
Kopieren mehrerer Fotos oder 
Videos
Tippen Sie auf  oben rechts im Bildschirm. Wählen Sie die Fotos oder 
Videos aus und tippen Sie danach auf „Kopieren“.
Einfügen eines Fotos oder Videos 
in eine E-Mail, oder Textmitteilung 
(iMessage oder MMS)
Legen Sie Ihren Finger auf die Stelle, an der das Foto oder Video platziert 
werden soll, und wählen Sie dann „Einsetzen“.
Sichern eines Fotos oder Videos aus 
einer E-Mail
Tippen Sie auf das Foto oder legen Sie Ihren Finger auf das Video und 
wählen Sie dann „Sichern“.
Sichern eines Fotos oder Videos aus 
einer Textmitteilung
Tippen Sie auf Bild in der Unterhaltung, tippen Sie dann auf  und 
anschließend auf „Sichern“.
Sichern eines Fotos aus einer 
Webseite
Legen Sie den Finger auf das Bild und tippen Sie danach auf „Bild sichern“.
Senden eines Videos an YouTube Tippen Sie beim Anzeigen eines Videos auf  und anschließend auf „An 
YouTube senden“.
Wenn Sie Fotos und Videos erhalten oder von einer Webseite speichern, werden diese 
automatisch im Album „Aufnahmen“ gesichert.
Drucken von Fotos
Foto drucken: Tippen Sie auf  und anschließend auf „Drucken“.
Mehrere Fotos drucken: Tippen Sie beim Anzeigen eines Fotoalbums auf  . Wählen Sie die 
Fotos aus, die gedruckt werden sollen, und tippen Sie auf „Drucken“. 
Weitere Informationen unter „Drucken“ auf Seite 30.
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Kamera
Mit den eingebauten Kameras können Sie Fotos und Videos aufnehmen. Das iPhone 4 und das 
iPhone 4S verfügen über eine Frontkamera für FaceTime-Anrufe und Selbstporträts (zuzüglich zur 
Kamera auf der Rückseite) sowie einen LED-Blitz. 
Zum 
Einstellen des 
Fokus und der 
Belichtung auf 
eine Person 
oder ein 
Objekt tippen.
Wechseln 
zwischen 
den Kameras
Auslöser
Foto-/Videoschalter
Zuletzt aufgenommene Fotos und Videos
Einstellen des LED-Blitzmodus
Einschalten des Rasters/HDR-Modus
Wenn die Ortungsdienste aktiviert wurden, werden Fotos und Videos mit Angaben zum 
Aufnahmeort versehen, die von einigen Apps und Websites für die Fotobereitstellung verwendet 
werden. Weitere Informationen unter „Ortungsdienste“ auf Seite 182.
Hinweis:  Wenn die Ortungsdienste deaktiviert sind, wenn Sie die App „Kamera“ öffnen, werden 
Sie zum Aktivieren der Dienste aufgefordert. Sie können die Kamera auch ohne Ortungsdienste 
verwenden.
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Zum schnellen Öffnen der App „Kamera“ bei gesperrtem iPhone drücken Sie die Home-Taste 
oder die Ein-/Aus-Taste und bewegen Sie  nach oben.
Aufnehmen eines Fotos: Überprüfen Sie, dass die Kamera-/Video-Taste auf  steht, richten Sie 
dann das iPhone aus und tippen Sie auf  . Sie können auch ein Foto machen, indem Sie die 
Lauter-Taste drücken.
Aufnehmen eines Videos: Schieben Sie die Kamera-/Video-Taste auf  und tippen Sie dann auf 
, um die Aufnahme zu starten oder zu stoppen. Verwenden Sie alternativ die Lauter-Taste.
Wenn Sie ein Foto oder ein Video aufnehmen, macht das iPhone ein Auslösergeräusch. Sie können 
die Lautstärke mit der Leiser-/Lauter-Taste bzw. dem Schalter „Klingeln/Aus“ steuern. 
Hinweis:  In manchen Regionen kann das Auslösergeräusch nicht mit dem Schalter „Klingeln/Aus“ 
stummgeschaltet werden.
Über dem Bildausschnitt, den die Kamera scharf stellt und für den die Belichtung festgelegt wird, 
wird kurz ein Rechteck eingeblendet. Wenn Sie Personen fotografieren, fokussiert das iPhone 4S 
mithilfe der Gesichtererkennung automatisch und passt die Belichtung für bis zu zehn Gesichter 
an. Jedes erkannte Gesicht wird von einem Rechteck umrahmt.
Verkleinern oder Vergrößern Ziehen Sie eine Stelle auf dem Bildschirm mit Ihrem Daumen und 
Zeigefinger auf (Hauptkamera, nur im Kameramodus).
Aktivieren des Rasters Tippen Sie auf „Optionen“.
Einstellen des Fokus und der 
Belichtung
Tippen Sie auf die Person bzw. das Objekt auf dem Bildschirm. (Die 
Gesichtererkennung ist vorübergehend deaktiviert.)
Festlegen des Fokus und der 
Belichtung
Berühren Sie den Bildschirm, bis das Rechteck angezeigt wird. Auf dem 
Bildschirm wird die AE-/AF-Sperre angezeigt und der Fokus sowie die 
Belichtung bleiben gesperrt, bis Sie erneut auf den Bildschirm tippen.
Aufnehmen eines Bildschirmfotos Drücken Sie kurz die Ein-/Aus-Taste und die Home-Taste  gleichzeitig. Das 
Bildschirmfoto wird zum Album „Aufnahmen“ hinzugefügt.
HDR-Fotos
Mit HDR (iPhone 4 oder neuer) werden drei unterschiedlich belichtete Aufnahmen zu einem 
einzigen Hochkontrastbild zusammengefügt. Für optimale Aufnahmen dürfen das iPhone und das 
Motiv sich nicht bewegen.
Aktivieren von HDR: Tippen Sie auf „Optionen“ und dann auf „HDR“. Der Blitz ist deaktiviert, wenn 
HDR aktiv ist.
Um sowohl die normalen als auch die HDR-Versionen zu behalten, öffnen Sie „Einstellungen“ > 
„Fotos“. Werden beide Versionen beibehalten, wird oben links auf dem HDR-Foto  angezeigt 
(wenn Sie sich im Album „Aufnahmen“ befinden und die Bedienelemente sichtbar sind).
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Die aufgenommen Fotos und Videos werden im Album „Aufnahmen“ gesichert.
Anzeigen des Albums „Aufnahmen“: Streichen Sie von links nach rechts oder tippen Sie links 
unten auf dem Bildschirm auf die Miniatur Ihrer letzten Aufnahme. Sie können das Album 
„Aufnahmen“ auch in der App „Fotos“ öffnen.
Um weitere Fotos oder Videos anzuzeigen, tippen Sie auf  .
Wenn Sie den iCloud-Fotostream aktiviert haben (unter „Einstellungen“ > „iCloud“), werden 
neue Fotos auch zum Album „Fotostream“ hinzugefügt und an alle iOS-Geräte und Computer 
übertragen. Weitere Informationen unter „iCloud“ auf Seite 18.
Weitere Informationen über das Ansehen und Senden von Fotos und Videos finden Sie unter 
„Senden von Fotos und Videos“ auf Seite 101 und „Laden von Fotos und Videos auf Ihren 
Computer“ auf Seite 106.
Ein- bzw. Ausblenden der 
Bedienelemente beim Anzeigen 
eines Fotos oder Videos im 
Vollbildmodus
Tippen Sie auf den Bildschirm.
Senden eines Fotos oder Videos per 
E-Mail oder SMS
Tippen Sie auf  .
Veröffentlichen eines Fotos auf 
Twitter
Zeigen Sie das Foto im Vollbildmodus an, tippen Sie auf  und dann auf 
„Tweet“. Sie müssen dafür bei einem Twitter-Account angemeldet sein. 
Wählen Sie „Einstellungen“ > „Twitter“.
Um Ihren Standort hinzuzufügen, wählen Sie „Ort hinzufügen“.
Drucken eines Fotos Tippen Sie auf  . Weitere Informationen unter „Drucken“ auf Seite 30.
Löschen eines Fotos oder Videos Tippen Sie auf  .
Bearbeiten von Fotos
Sie können Fotos drehen, verbessern, zuschneiden und rote Augen entfernen. Durch das 
Verbessern eines Fotos werden die Dunkelheit bzw. Helligkeit insgesamt sowie die Farbsättigung 
und andere Eigenschaften optimiert.
Drehen
Verbessern
Rote Augen
Beschneiden
Bearbeiten eines Fotos: Tippen Sie beim Anzeigen eines Fotos auf „Bearbeiten“ und wählen Sie 
ein Werkzeug aus.
Tippen Sie beim Verwenden des „Rote Augen“-Werkzeugs auf jedes Auge, um es zu korrigieren. 
Um ein Foto zuzuschneiden, bewegen Sie die Eckpunkte des Rasters, ziehen Sie das Foto, um es 
neu zu positionieren, und tippen Sie auf „Beschneiden“. Wenn Sie beim Zuschneiden auf „Formate“ 
tippen, können Sie ein bestimmtes Verhältnis festlegen.
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Sie können die Bilder (Frames) am Anfang und am Ende eines gerade von Ihnen aufgenommenen 
Videos oder jedes andere Video im Album „Aufnahmen“ trimmen. Sie können das Originalvideo 
ersetzen oder die getrimmte Version als neuen Clip sichern.
Trimmen eines Videos:  Tippen Sie auf den Bildschirm, während das Video gezeigt wird, um die 
Bedienelemente einzublenden. Bewegen Sie die Ränder der Bildansicht wunschgemäß nach links 
oder rechts und tippen Sie auf „Trimmen“.
Wichtig:  Wenn Sie „Original trimmen“ gewählt haben, werden die Bilder aus dem Originalvideo 
gelöscht. Nach Auswahl von „Als neuen Clip sichern“ wird ein neuer (getrimmter) Videoclip im 
Album „Aufnahmen“ gesichert. Das Originalvideo bleibt unverändert.
Laden von Fotos und Videos auf Ihren Computer
Sie können Fotos und Videos, die Sie mit der App „Kamera“ aufgenommen haben, in ein 
Fotoprogramm auf Ihrem Computer laden (zum Beispiel in iPhoto auf einem Mac).
Laden von Fotos und Videos auf Ihren Computer: Verbinden Sie das iPhone über das 
mitgelieferte Dock Connector-auf-USB-Kabel mit dem Computer.
Â Mac:  Wählen Sie auf Ihrem Computer in iPhoto oder einem anderen unterstützten 
Fotoprogramm die gewünschten Fotos und Videos aus und klicken Sie auf „Importieren“ oder 
auf „Laden“.
Â PC:  Folgen Sie den Anleitungen, die mit Ihrer Kamera oder dem Fotoprogramm geliefert 
wurden.
Wenn Sie die Fotos und Videos, die Sie auf Ihren Computer laden, vom iPhone löschen, werden sie 
aus dem Album „Aufnahmen“ entfernt. In iTunes können Sie im Bereich „Fotos“ der Einstellungen 
festlegen, dass Fotos und Videos mit der App „Fotos“ auf dem iPhone synchronisiert werden 
(Videos können nur mit Mac-Computern synchronisiert werden). Weitere Informationen unter 
„Synchronisieren mit iTunes“ auf Seite 19.
Fotostream
Mit Fotostream – einer Funktion von iCloud – werden Fotos, die Sie mit dem iPhone aufnehmen, 
automatisch auf iCloud geladen und auf alle Geräte übertragen, auf denen Fotostream aktiviert 
ist. Fotos, die von Ihren anderen Geräten oder Computern auf iCloud geladen wurden, werden 
an Ihr Album „Fotostream“ auf dem iPhone übertragen. Weitere Informationen unter „iCloud“ auf 
Seite 18.
Aktivieren von Fotostream:  Öffnen Sie „Einstellungen“ > „iCloud“ > „Fotostream“.
Neu aufgenommene Fotos werden an Ihren Fotostream übertragen, wenn Sie die App „Kamera“ 
beenden und das iPhone mit dem Internet via WLAN verbunden ist Alle anderen Fotos, 
einschließlich aller Fotos, die aus E-Mails oder Textmitteilungen oder von Webseiten geladen 
wurden, sowie Bildschirmfotos, die zum Album „Aufnahmen“ hinzugefügt wurden, werden 
ebenfalls in den Fotostream geladen und an Ihre anderen Geräte übertragen. Mit „Fotostream“ 
können Sie von Ihren iOS-Geräten auf bis zu 1000 Ihrer aktuellsten Fotos zugreifen. Auf Ihren 
Computern können alle Fotostream-Fotos dauerhaft gespeichert werden.
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dem iPhone
Tippen Sie in Ihrem Album „Fotostream“ auf  , wählen Sie die zu 
sichernden Fotos aus und tippen Sie auf „Sichern“.
Löschen eines Fotos von iCloud Wählen Sie das Foto in Ihrem Album „Fotostream“ aus und tippen Sie auf  .
Löschen mehrerer Fotos von iCloud Tippen Sie in Ihrem Album „Fotostream“ auf  , wählen Sie die zu 
löschenden Fotos aus und tippen Sie auf „Löschen“.
Hinweis:  Zum Löschen von Fotos aus dem Fotostream benötigen Sie iOS 5.1 (oder neuer) auf dem 
iPhone und allen anderen iOS-Geräten. Vgl. support.apple.com/kb/HT4486?viewlocale=de_DE.
Die gelöschten Fotos werden nur aus dem Fotostream auf Ihren Geräten entfernt, das Original 
verbleibt im Album „Aufnahmen“ auf dem Gerät, auf dem sich das Foto ursprünglich befand.
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YouTube
Auf YouTube finden Sie kurze Videos, die von Benutzern weltweit veröffentlicht wurden. Für einige 
der YouTube-Funktionen ist ein YouTube-Account erforderlich. Um einen Account einzurichten, 
gehen Sie zu www.youtube.com.
Hinweis:  YouTube wird möglicherweise nicht in allen Sprachen oder Regionen angeboten.
Suchen von Videos
Suchen von Videos:  Tippen Sie auf eine Taste unten auf dem Bildschirm oder auf „Weitere“, um 
weitere Tasten zum Blättern anzuzeigen. Wenn Sie ein Video anschauen, tippen Sie auf „Fertig“, um 
die Tasten zum Blättern anzuzeigen.
Verwandte Videos 
ansehen oder dieses 
Video speichern oder 
freigeben
Weitere Suchtasten 
anzeigen oder die Tasten 
neu anordnen
Auf ein Video tippen, um es wiederzugeben
Auf eine Suchtaste tippen, um eine 
Liste mit Videos anzuzeigen
Ändern der Tasten zum Blättern Tippen Sie auf „Weitere“ und dann auf „Bearbeiten“. Bewegen Sie eine Taste 
nach unten über die Taste, die ersetzt werden soll. Ziehen Sie eine Taste 
nach links oder rechts, um sie zu bewegen. Wenn Sie fertig sind, tippen Sie 
auf „Fertig“.
Suchen nach ähnlichen Videos Tippen Sie neben einem Video in der Liste auf  .
Suchen nach einem Video Tippen Sie unten im Bildschirm auf „Suchen“ und dann auf das Suchfeld.
108Anzeigen weiterer Videos des 
gleichen Accounts
Tippen Sie auf dem Informationsbildschirm neben dem aktuellen Video auf 
 und dann auf „Weitere Videos“.
Anzeigen von Videos
Anschauen eines Videos:  Tippen Sie auf ein beliebiges Video. Die Wiedergabe beginnt, wenn 
ein ausreichend großer Teil des Videos auf das iPhone geladen wurde. Der farbige Teil der 
Navigationsleiste zeigt den Ladevorgang des Videos an.
Auf das Video 
tippen, um die 
Steuerelemente 
ein- oder 
auszublenden
Anzeigen auf 
einem 
Fernseher 
mit Apple TV
Bewegen, um 
zurück oder nach 
vorne zu springen Ladefortschritt
Video zu den 
YouTube-Favoriten 
hinzufügen
Bewegen, um 
die Lautstärke 
anzupassen
Unterbrechen oder Fortsetzen der 
Wiedergabe
Tippen Sie auf  oder  . Alternativ können Sie auf den iPhone-Kopfhörern 
die Mitteltaste drücken.
Erneute Wiedergabe Tippen Sie während der Wiedergabe auf  . Haben Sie das aktuelle Video 
weniger als fünf Sekunden lang angeschaut, wird stattdessen das vorherige 
Video in der Liste wiedergegeben.
Schneller Vor- bzw. Rücklauf Tippen und halten Sie  oder  .
Springen zu einem beliebigen 
Punkt
Bewegen Sie die Abspielposition auf der Navigationsleiste.
Springen zum nächsten oder 
vorherigen Video in der Liste
Tippen Sie auf  , um zum nächsten Video zu wechseln. Tippen Sie 
zweimal auf  , um zum vorherigen Video zu wechseln. Haben Sie das 
aktuelle Video weniger als fünf Sekunden lang angeschaut, tippen Sie 
einmal.
Umschalten zwischen 
bildschirmfüllendem und an die 
Bildschirmgröße angepasstem 
Modus
Tippen Sie zweimal auf das Video. Tippen Sie  , um mit dem Video 
den gesamten Bildschirm auszufüllen, oder tippen Sie  , um es der 
Bildschirmgröße anzupassen.
Ansehen von YouTube auf einem 
Fernsehgerät
Verbinden Sie das iPhone mithilfe von AirPlay oder einem Kabel mit Ihrem 
Fernsehgerät oder AV-Receiver. Weitere Informationen unter „Ansehen eines 
Videos auf einem Fernsehgerät“ auf Seite 145.
Abbrechen der Videowiedergabe Tippen Sie auf „Fertig“.
Verwalten Ihrer bevorzugten Videos
Hinzufügen eines Videos zu den Favoriten oder zu einer Wiedergabeliste:  Tippen Sie neben 
einem Video auf  , um die Taste zum Hinzufügen des Videos zu einer Liste anzuzeigen.
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Favoriten
Tippen Sie auf „Zu Favoriten hinzufügen“. Wenn Sie das Video anschauen, 
tippen Sie auf  .
Hinzufügen eines Videos zu einer 
Wiedergabeliste
Tippen Sie auf dem Informationsbildschirm des Videos auf „Zur Liste“ und 
wählen Sie eine Wiedergabeliste oder tippen Sie auf  , um eine neue 
Wiedergabeliste zu erstellen.
Löschen eines Favoriten Tippen Sie auf „Favoriten“, dann auf „Bearbeiten“ und auf  neben dem 
Video.
Löschen eines Videos aus einer 
Wiedergabeliste
Tippen Sie auf „Wiedergabelisten“, wählen Sie eine Liste aus, tippen Sie auf 
„Bearbeiten“ und auf  .
Löschen einer Wiedergabeliste Tippen Sie auf „Wiedergabelisten“, „Bearbeiten“ und auf  .
Abonnieren eines Accounts Tippen Sie neben dem aktuellen Video auf  (über der Liste mit ähnlichen 
Videos). Tippen Sie dann auf „Weitere Videos“, blättern Sie an das Ende der 
Liste und tippen Sie auf „Account abonnieren“.
Beenden eines Abonnements für 
einen YouTube-Account
Tippen Sie auf „Abonnements“ (bzw. auf „Weitere“, wenn Sie diese Option 
nicht sehen), wählen Sie einen Account aus der Liste und tippen Sie auf 
„Abo beenden“.
Freigeben von Videos, Kommentaren und Bewertungen
Anzeigen der Steuerelemente für Freigaben, Kommentare und Bewertungen:  Tippen Sie auf 
neben dem Video.
Versenden eines Links zu einem 
Video
Tippen Sie neben einem Video auf  und wählen Sie „Video senden“. 
Wenn Sie das Video anschauen, tippen Sie einfach auf  .
Bewerten oder Kommentieren 
eines Videos
Tippen Sie im Bildschirm „Weitere Infos“ auf „Bewerten/Kommentare/
Melden“ und wählen Sie „Bewerten/Kommentare“ aus.
Senden eines Videos an YouTube Öffnen Sie die App „Fotos“, wählen Sie ein Video und tippen Sie auf  .
Anzeigen von Informationen über ein Video
Anzeigen der Beschreibung oder Kommentare:  Tippen Sie neben dem Video in der Liste auf  . 
Tippen Sie dann erneut auf  , wenn es oben auf dem Bildschirm angezeigt wird.
Senden von Videos an YouTube
Wenn Sie über einen YouTube-Account verfügen, können Sie Videos direkt an YouTube senden. 
Weitere Informationen unter „Senden von Fotos und Videos“ auf Seite 101.
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Anzeigen von Aktienkursen
Mit der App „Aktien“ können Sie Kurse der von Ihnen ausgewählten Aktien, Fonds und 
Branchenindizes verfolgen. 
Abhängig vom eingesetzten Meldedienst kann die Aktualisierung der Kurse mit einer 
Verzögerung von bis zu 20 Minuten erfolgen. 
Hinzufügen einer Aktie, eines Fonds oder eines Index zu Ihrem Aktienbarometer  Tippen Sie auf 
 und anschließend auf  . Geben Sie ein Symbol, einen Firmennamen, einen Fondsnamen oder 
einen Index ein und tippen Sie auf „Suchen“.
Anzeigen der Entwicklung einer Aktie, eines Fonds oder eines Index im Zeitverlauf: Tippen Sie 
auf eine Aktie, einen Fonds oder einen Index in der Liste. Tippen Sie danach auf die Option für die 
gewünschte Zeitspanne (1 Tag, 1 Woche, 1 Monat, 3 Monate, 6 Monate, 1 Jahr oder 2 Jahre).
Bei der Anzeige eines Diagramms im Querformat können Sie auf das Diagramm tippen, um den 
Wert für einen bestimmten Zeitpunkt einzublenden.
Verwenden Sie zwei Finger, um die Veränderung eines Werts innerhalb einer bestimmten 
Zeitspanne anzuzeigen.
Sie können Ihren Aktien-Ticker auch in der Mitteilungszentrale ansehen. Weitere Informationen 
unter „Benachrichtigungen“ auf Seite 33.
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„Löschen“.
Ändern der Reihenfolge innerhalb 
der Liste
Tippen Sie auf  . Bewegen Sie  neben einer Aktie oder einem Index, um 
eine neue Position in der Liste dafür festzulegen.
Umschalten der Ansicht zwischen 
prozentualer Veränderung, 
Preisveränderung und 
Marktkapitalisierung
Tippen Sie auf einen der Werte an der rechten Seite des Bildschirms. Tippen 
Sie erneut, um zu einer anderen Ansicht umzuschalten.
Verwenden von iCloud, um die 
Aktienliste auf Ihren iOS-Geräten 
auf dem neuesten Stand zu halten
Öffnen Sie „Einstellungen“ > „iCloud“ > „Dokumente & Daten“ und aktivieren 
Sie die Option „Dokumente & Daten“ (standardmäßig aktiviert). Weitere 
Informationen unter „iCloud“ auf Seite 18.
Anzeigen weiterer Informationen
Anzeigen der Zusammenfassung, des Diagramms oder der neuesten Informationen für eine 
Aktie, einen Fonds oder einen Index: Wählen Sie die Aktie, den Fonds oder den Index in der Liste 
aus und blättern Sie in den Seiten unterhalb des Aktienbarometers, um die Zusammenfassung, 
das Diagramm und die Seite mit den neuesten Informationen anzuzeigen.
Auf der Seite mit den neuesten Informationen können Sie nach oben und unten blättern, um die 
Schlagzeilen zu lesen. Wenn Sie auf eine Schlagzeile tippen, können Sie den zugehörigen Artikel 
in Safari lesen.
Anzeigen weitere Aktieninformationen auf Yahoo.com: Wählen Sie die Aktie, den Fonds oder 
den Index in der Liste aus und tippen Sie auf  .
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Finden von Orten
ACHTUNG:  Wichtige Hinweise zum sicheren Fahren und Navigieren finden Sie im Handbuch 
Wichtige Produktinformationen unter www.apple.com/de/support/manuals/iphone.
Zeigen Sie den Standort eines 
Unternehmens oder einer 
Person aus Ihren Kontakten an.
Wählen Sie verschiedene 
Optionen wie das Anzeigen 
des Verkehrs oder die 
Satellitenansicht.
Weitere Informationen
Tippen Sie zweifach zum 
Einzoomen, tippen Sie mit 
zwei Fingern zum 
Auszoomen. Oder ziehen 
Sie den Ausschnitt auf oder 
zu, um das Bild zu 
vergrößern bzw. zu 
verkleinern.
Dies ist Ihre aktuelle 
Position.
Geben Sie 
hier einen 
Suchbegriff ein.
Zeigen Sie 
Ihre aktuelle 
Position.
Suchen Sie nach 
Routen mit dem 
Auto, öffentl. 
Verkehrsmitteln 
sowie zu Fuß.
Suchen eines Orts:  Tippen Sie auf das Suchfeld, um die Tastatur einzublenden. Geben Sie eine 
Adresse oder andere Informationen ein und tippen Sie dann auf „Suchen“.
Sie können nach Informationen suchen wie den folgenden:
Â Kreuzung („8th and market“)
Â Gegend („greenwich village“)
Â Sehenswürdigkeit („guggenheim“)
Â Postleitzahl
Â Unternehmen („kino“, „restaurants in san francisco“, „apple inc new york“)
Sie können auch auf  tippen, um den Standort eines Kontakts zu suchen.
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Beschreibung eines Orts
Tippen Sie auf die Stecknadel.
Anzeigen einer Liste mit 
gefundenen Unternehmen
Tippen Sie auf  und anschließend auf „Liste“.
Tippen Sie auf ein Unternehmen, um dessen Standort auf der Karte 
anzuzeigen.
Ermitteln der eigenen Position Tippen Sie auf  .
Ihr aktueller Standort wird mit einer blauen Stecknadel gekennzeichnet. 
Wenn sich der Standort nicht genau bestimmen lässt, erscheint ein 
zusätzlicher blauer Kreis um die Stecknadel. Je kleiner der Radius, desto 
genauer ist die gefundene Position.
Bestimmen der Himmelsrichtung, 
der Sie zugewandt sind
Tippen Sie erneut auf  .
Das Symbol ändert sich zu  . Die Karte dreht sich, um die 
Himmelsrichtung anzuzeigen, der Sie zugewandt sind.
Markieren eines Orts Berühren Sie den Bildschirm, bis die Stecknadel angezeigt wird.
Wichtig:  Karten, Richtungen und ortungsbasierte Apps hängen von den Datendiensten ab. 
Diese Datendienste unterliegen Änderungen und stehen möglicherweise in bestimmten 
Ländern oder Gebieten nicht zur Verfügung. Dies kann dazu führen, dass bestimmte Karten, 
Wegbeschreibungen oder ortungsbasierte Informationen nicht verfügbar, nicht präzise oder 
unvollständig sind. Vergleichen Sie die auf dem iPhone angezeigten Informationen mit dem, was 
Sie tatsächlich sehen. Beachten Sie außerdem mögliche Verkehrs- und Straßenschilder etc. 
Wenn die Ortungsdienste deaktiviert sind, wenn Sie die App „Karten“ zum ersten Mal 
öffnen, werden Sie zum Aktivieren der Dienste aufgefordert. Sie können „Karten“ auch ohne 
Ortungsdienste verwenden. Weitere Informationen unter „Ortungsdienste“ auf Seite 182.
Abrufen von Wegbeschreibungen
Abrufen von Informationen zur Route
1 Tippen Sie auf „Route“.
2 Geben Sie den Start- und Endpunkt an. 
Tippen Sie in einem der Felder auf  , um einen Ort, der in den Lesezeichen gespeichert 
wurde (einschließlich Ihres aktuellen Standorts bzw. der gesetzten Stecknadel), einen zuletzt 
verwendeten Ort oder einen Kontakt auszuwählen. Wird  nicht angezeigt, tippen Sie auf  , 
um das Feld zu leeren. 
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Verkehrsmitteln ( ) oder einem Fußweg ( ) gesucht werden soll.
4 Führen Sie einen der folgenden Schritte aus:
Â Um die Route abschnittsweise anzuzeigen, tippen Sie auf „Start“ und anschließend auf  . So 
zeigen Sie den nächsten Routenabschnitt an. 
Â Um alle Routen aufzulisten, tippen Sie auf  und dann auf „Liste“. 
Tippen Sie auf einen beliebigen Eintrag in der Liste, um eine Karte mit diesem 
Streckenabschnitt anzuzeigen. Tippen Sie auf „Routenübersicht“, um zum Übersichtsbildschirm 
zurückzukehren.
5 Tippen Sie, wenn mehrere Routen angezeigt werden, auf die Route, die verwendet werden soll.
Wenn Sie öffentliche Verkehrsmittel nutzen, tippen Sie auf  , um Ihre Abfahrts- bzw. Ankunftszeit 
festzulegen und einen Fahrplan zu wählen. Tippen Sie auf das Symbol an einer Haltestelle, um 
die dortige Abfahrtszeit des Busses oder Zuges zu erfahren oder einen Link zur Website oder den 
Kontaktinformationen des jeweiligen Beförderungsunternehmens zu erhalten.
Abrufen von Routen von einem 
Standort auf der Karte
Tippen Sie auf die Stecknadel, dann auf  und anschließend auf 
„Wegbeschreibung hierhin“ oder „Wegbeschreibung von hier“.
Anlegen eines Lesezeichens für 
einen Standort
Tippen Sie auf „Zu Lesezeichen hinzufügen“.
Abrufen und Freigeben von Informationen zu einem Standort
Abrufen von 
Wegbeschreibungen
Öffnen 
der 
Website
Auf „      “ tippen, um 
Kontaktinfos anzuzeigen
Anrufen
Abrufen und Freigeben von Informationen zu einem Standort: Tippen Sie auf die Stecknadel 
und dann auf  .
Hinzufügen eines Unternehmens zu 
Ihren Kontakten
Tippen Sie auf „Zu Kontakten hinzufügen“.
Teilen Ihres Standorts per Tweet, 
Textmitteilung oder E-Mail
Tippen Sie auf „Ort senden“. 
Hinweis:  Sie müssen bei einem Twitter-Account angemeldet sein, um einen 
Tweet zu veröffentlichen. Wählen Sie „Einstellungen“ > „Twitter“.
Anzeigen der Verkehrslage
Wenn verfügbar, können Sie Informationen zur Verkehrslage auf Haupt- und Schnellstraßen auf 
der Karte anzeigen. 
Ein- oder Ausblenden von Informationen zur Verkehrssituation: Tippen Sie auf  und danach 
auf „Verkehr einblenden“ oder „Verkehr ausblenden“.
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Â Grau: keine Daten verfügbar
Â Grün: Richtgeschwindigkeit
Â Gelb: Langsamer als die Richtgeschwindigkeit
Â Rot: Stockender Verkehr
Hinweis:  Verkehrsbedingungen sind nicht in allen Regionen verfügbar.
Kartendarstellungen
Anzeigen einer Satellitenansicht oder einer Hybrid-Darstellung: Tippen Sie auf  und wählen 
Sie die gewünschte Ansicht.
Anzeigen von Google Street View-Aufnahmen eines Orts: Tippen Sie auf  . Streichen Sie in der 
360°-Panoramadarstellung nach links oder rechts (der Ausschnitt zeigt Ihre aktuelle Sicht). Tippen 
Sie auf einen Pfeil, um die Straße entlang zu gehen. Tippen Sie auf den Kartenausschnitt unten 
rechts, um zur Kartenansicht zurückzukehren.
Tippen, um zur Karte zurückzukehren
Hinweis:  Die Street View-Funktion ist möglicherweise nicht in allen Regionen verfügbar.
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Abrufen von Wetterinformationen
Tippen Sie auf dem Home-Bildschirm auf „Wetter“, um für einen oder mehrere Orte auf der Welt 
die dortigen aktuellen Temperaturen und die Aussicht für die nächsten sechs Tage abzurufen.
Aktuelle Bedingungen
Städte hinzufügen oder 
löschen
Aktuelle Temperatur
Vorhersage für 
sechs Tage
Stündliche Vorhersage anzeigen
Anzahl der gespeicherten Städte
Wenn der Hintergrund der Wetteranzeige hellblau ist, ist in der betreffenden Stadt Tag. Ist der 
Hintergrund lila, ist es Nacht.
Hinzufügen einer Stadt:  Tippen Sie auf  und anschließend auf  . Geben Sie den Namen einer 
Stadt oder eine Postleitzahl ein und tippen Sie dann auf „Suchen“.
Wechseln zu einer anderen Stadt Streichen Sie mit dem Finger nach links oder rechts über den Bildschirm.
Neuanordnen von Städten Tippen Sie auf  und bewegen Sie  nach oben oder unten.
Löschen einer Stadt Tippen Sie auf  und auf  . Tippen Sie dann auf „Löschen“.
Anzeigen der Temperatur in 
Fahrenheit oder Celsius
Tippen Sie auf  und dann auf „°F“ oder „°C“.
Verwenden von iCloud, um die 
Städteliste auf andere iOS-Geräte 
zu übertragen
Öffnen Sie „Einstellungen“ > „iCloud“ > „Dokumente & Daten“ und aktivieren 
Sie die Option „Dokumente & Daten“ (standardmäßig aktiviert). Weitere 
Informationen unter „iCloud“ auf Seite 18.
Anzeigen von Informationen zu 
einer Stadt auf Yahoo.com
Tippen Sie auf  .
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Notizen
Erstellen Sie auf dem iPhone Notizen. Diese stehen dann über iCloud auf Ihren anderen iOSGeräten und Mac-Computern zur Verfügung. Sie können auch in anderen Accounts wie Google 
Mail oder Yahoo Notizen erstellen und lesen.
Tippen, um die 
Notiz zu bearbeiten
Löschen der Notiz
Senden oder Drucken 
der Notiz
Hinzufügen einer 
neuen Notiz
Anzeigen aller Notizen
Anzeigen der vorherigen oder nächsten Notiz
Verfassen von Notizen
Hinzufügen einer Notiz:  Tippen Sie auf  , geben Sie Ihre Notiz ein und tippen Sie dann auf 
„Fertig“.
Verwenden von iCloud, um die 
Notizen auf Ihren iOS-Geräten und 
Mac-Computern auf dem neuesten 
Stand zu halten
Wenn Sie für iCloud eine me.com- oder mac.com-E-Mail-Adresse 
verwenden, wählen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie die 
Option „Notizen“. 
Verwenden Sie für iCloud einen Google Mail- oder IMAP-Account, wählen 
Sie „Einstellungen“ > „Mail, Kontakte, Kalender“ und aktivieren Sie die 
Option „Notizen“ für den Account.
Weitere Informationen unter „iCloud“ auf Seite 18.
Anzeigen von Notizen für einen 
bestimmten Account
Tippen Sie auf „Accounts“ und wählen Sie einen Account aus. Tippen Sie 
dann auf  , um die Notiz zu erstellen.
Festlegen des Standardaccounts für 
neue Notizen
Wenn Sie in der Notizenübersicht auf  tippen, wird mit dem StandardAccount, den Sie über „Einstellungen“ > „Notizen“ festlegen, eine neue Notiz 
erstellt.
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Die Notizen werden nach dem letzten Änderungsdatum aufgelistet, wobei die zuletzt geänderte 
Notiz oben angezeigt wird. Wenn Sie mit Ihrem iCloud-Account mehr als ein iOS-Gerät 
verwenden, werden Notizen von allen Geräten aufgelistet. Nutzen Sie Notizen gemeinsam mit 
einem Programm auf Ihrem Computer oder mit anderen Online-Accounts wie Yahoo oder Google 
Mail, werden diese nach Account aufgelistet.
Lesen einer Notiz:  Tippen Sie auf die Notiz in der Liste. Tippen Sie auf  oder  , um die 
vorherige oder nächste Notiz anzuzeigen.
Ändern der Schrift Wählen Sie „Einstellungen“ > „Notizen“.
Anzeigen von Notizen für einen 
bestimmten Account
Tippen Sie auf „Accounts“ und wählen Sie einen Account aus.
Anzeigen von Notizen für alle 
Accounts
Tippen Sie auf „Accounts“ und wählen Sie „Alle Notizen“ aus.
Bearbeiten einer Notiz Tippen Sie auf die Notiz, um die Tastatur einzublenden.
Löschen einer Notiz Streichen Sie in der Notizenliste nach links oder rechts. Tippen Sie in einer 
Notiz auf  .
Durchsuchen von Notizen
Sie können alle Notizen durchsuchen.
Durchsuchen von Notizen:  Streichen Sie beim Anzeigen der Notizenliste nach unten, um nach 
oben zu gelangen und das Suchfeld anzuzeigen. Tippen Sie dann in das Suchfeld und geben Sie 
den gewünschten Text ein.
Sie können auch vom Home-Bildschirm aus Notizen suchen. Weitere Informationen unter 
„Suchen“ auf Seite 31.
Drucken oder Versenden von Notizen
Um eine Notiz per E-Mail zu versenden, muss auf dem iPhone ein E-Mail-Account eingerichtet 
sein. Weitere Informationen unter „Konfigurieren von Mail und anderen Accounts“ auf Seite 17.
Drucken oder Versenden einer Notiz per E-Mail:  Tippen Sie in der Notiz auf  .
Kapitel 17    Notizen 119Uhr
18
Die App „Uhr“
Mit der App „Uhr“ können Sie sich die Uhrzeit überall auf der Welt anzeigen lassen, den Wecker 
stellen, ein Ereignis planen oder einen Timer setzen.
Hinzufügen einer Uhr
Anzeigen von Uhren, 
Stellen eines Weckers, 
Planen eines Ereignisses 
oder Stellen eines Timers
Löschen von Uhren bzw. Ändern der Anordnung
Verwenden von Weltuhren
Sie können Uhren hinzufügen, um die Uhrzeit in anderen Großstädten und Zeitzonen weltweit 
anzuzeigen.
Hinzufügen einer Uhr:  Tippen Sie auf  und geben Sie den Namen einer Stadt ein. Wenn Sie 
die gesuchte Stadt nicht sehen, suchen Sie nach einer Großstadt, die sich in derselben Zeitzone 
befindet.
Neuanordnen von Uhren Tippen Sie auf „Bearbeiten“, legen Sie den Finger auf  und bewegen Sie 
die Uhr an die gewünschte Position.
Löschen einer Uhr Tippen Sie auf „Bearbeiten“ und auf  .
Stellen eines Weckers
Sie können mehrere Einstellungen für die Weck- und Erinnerungsfunktionen festlegen. Legen 
Sie fest, ob an angegebenen Tagen jedes Mal ein Hinweiston ausgegeben werden oder ob der 
Hinweiston nur einmal ertönen soll.
Stellen eines Weckers:  Tippen Sie auf „Wecker“ und dann auf  .
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Wecker
Tippen Sie auf „Bearbeiten“ und auf  .
Löschen eines Weckers Tippen Sie auf „Bearbeiten“ und auf  .
Ist ein Wecker gestellt und aktiviert, wird oben in der Statusleiste des iPhone angezeigt. Wenn 
der Wecker nur einmal klingeln soll, wird er nach dem Auslösen automatisch ausgeschaltet. Sie 
können den Wecker wieder einschalten, damit er erneut aktiviert wird.
Wichtig:  Nicht alle Mobilfunkanbieter unterstützen überall das Abrufen von Netzwerkzeiten. 
Wenn Sie auf Reisen sind, gibt das iPhone visuelle und akustische Hinweise auf Ereignisse 
möglicherweise nicht zur korrekten lokalen Uhrzeit aus. Weitere Informationen unter „Datum & 
Uhrzeit“ auf Seite 190.
Verwenden der Stoppuhr
Hinzufügen eines Ereignisses:  Tippen Sie auf „Stoppuhr“ und dann auf „Start“.
Wenn Sie zu einer anderen App wechseln, läuft die Stoppuhr weiter.
Festlegen eines Timers
Setzen Sie einen Timer, der weiterläuft, wenn Sie eine andere App verwenden.
Festlegen eines Timers:  Tippen Sie auf „Timer“, legen Sie die Dauer fest und tippen Sie auf „Start“.
Auswählen des Hinweistons Tippen Sie auf „Timer-Ende“.
Festlegen eines Timers für den 
Ruhezustand des iPhone
Stellen Sie den Timer ein, tippen Sie dann auf „Timer-Ende“ und wählen Sie 
„Wiedergabe stoppen“ aus. Das iPhone beendet die Wiedergabe von Musik 
oder Videos, wenn der Timer abgelaufen ist.
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Erinnerungen
Erstellen Sie mit der App „Erinnerungen“ eine Erinnerung, die ein Fälligkeitsdatum und einen 
Standort umfasst. So können Sie sich an ein Ereignis an einem bestimmten Tag erinnern lassen 
oder sich zum Beispiel daran erinnern lassen, dass Sie etwas erledigen müssen, wenn Sie 
sich einem bestimmten Ort nähern bzw. diesen verlassen, wie Ihr Büro oder Ihr Zuhause. Die 
App „Erinnerungen“ funktioniert mit Ihren Kalenderaccounts, d. h. dass Änderungen, die Sie 
vornehmen, automatisch auf Ihren anderen iOS-Geräten und Computern übernommen werden.
Darstellung wechseln
Als beendet markieren
Erinnerung hinzufügen
Listen anzeigen und bearbeiten
Wechseln zwischen der Listen- und der Datumsansicht:  Tippen Sie oben im Bildschirm auf 
„Liste“ bzw. „Datum“.
Festlegen einer Erinnerung
Sie können eine Erinnerung für ein bestimmtes Datum und eine bestimmte Uhrzeit und/oder für 
einen bestimmten Ort festlegen.
Hinzufügen einer Erinnerung:  Tippen Sie in „Erinnerungen“ auf  , geben Sie eine Beschreibung 
ein und tippen Sie auf „Fertig“.
Nach dem Hinzufügen einer Erinnerung können Sie die Einstellungen bearbeiten.
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Erinnerung
Tippen Sie auf die Erinnerung und dann auf „Erinnerung“. Aktivieren Sie die 
Option „An einem Ort“ und wählen Sie „Beim Verlassen“ und/oder „Bei der 
Ankunft“.
Um den Ort zu ändern, tippen Sie auf „Aktuelle Position“, tippen Sie 
dann auf „Adresse auswählen“ und wählen Sie aus Ihren Kontakten einen 
Standort aus.
Weitere Informationen unter „Standortbasierte Erinnerungen“ auf Seite 124.
Festlegen eines Datums für eine 
Erinnerung
Tippen Sie auf die Erinnerung und dann auf „Erinnerung“. Aktivieren Sie 
die Option „An einem Tag“ und legen Sie das gewünschte Datum und die 
Uhrzeit fest. Fällige Erinnerungen, die nicht als abgeschlossen markiert 
wurden, werden in der Mitteilungszentrale angezeigt.
Hinzufügen von Notizen zu einer 
Erinnerung
Tippen Sie auf die Erinnerung und dann auf „Mehr anzeigen“. Tippen Sie auf 
„Notizen“.
Bewegen einer Erinnerung in eine 
andere Liste
Tippen Sie auf die Erinnerung und dann auf „Mehr anzeigen“. Tippen Sie auf 
„Liste“ und wählen Sie eine neue Liste.
Informationen zum Erstellen oder Bearbeiten von Listen erhalten Sie unter 
„Verwalten von Erinnerungen in der Listenansicht“ auf Seite 123.
Löschen einer Erinnerung Tippen Sie auf die Erinnerung, dann auf „Mehr anzeigen“ und anschließend 
auf „Löschen“.
Bearbeiten einer Erinnerung Tippen Sie auf die Erinnerung und dann auf ihre Bezeichnung.
Markieren einer Erinnerung als 
abgeschlossen
Tippen Sie auf das Feld neben dem entsprechenden Element, um ein 
Markierungsfeld anzuzeigen.
Abgeschlossene Elemente werden in der Liste „Erledigt“ angezeigt. Weitere 
Informationen unter „Verwalten abgeschlossener Erinnerungen“ auf 
Seite 124.
Festlegen des Hinweistons für 
Erinnerungen
Wählen Sie „Einstellungen“ > „Töne“.
Verwenden von iCloud, um 
Erinnerungen auf Ihren iOSGeräten und Computern auf dem 
neuesten Stand zu halten
Öffnen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie die Option 
„Erinnerungen“. Weitere Informationen unter „iCloud“ auf Seite 18.
Verwalten von Erinnerungen in der Listenansicht
Durch das Organisieren von Erinnerungen in Listen ist es ganz einfach, Ihr Privatleben, Ihre Arbeit 
und andere Aufgaben voneinander getrennt zu halten. Die App „Erinnerungen“ beinhaltet eine 
Liste für aktive sowie eine Liste für abgeschlossene Erinnerungen. Sie können weitere Listen 
hinzufügen.
Erstellen einer Liste:  Tippen Sie oben im Bildschirm auf „Liste“ und dann auf  . Tippen Sie auf 
„Bearbeiten“.
Wechseln zwischen Listen Streichen Sie auf dem Bildschirm von links nach rechts.
Sie können auch direkt zu einer bestimmten Liste gehen. Tippen Sie auf 
und anschließend auf einen Listennamen.
Anzeigen abgeschlossener 
Elemente
Streichen Sie auf dem Bildschirm so lange nach links, bis Sie zur Liste mit 
den abgeschlossenen Elementen gelangen.
Ändern der Listenreihenfolge Tippen Sie in der Listenübersicht auf  und anschließend auf „Bearbeiten“. 
Legen Sie Ihren Finger neben einer Liste auf  , um sie an eine andere 
Position zu bewegen.
Listen können nicht in andere Accounts bewegt und die Reihenfolge der 
Erinnerungen in einer Liste kann nicht geändert werden.
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Tippen Sie für jede Liste, die gelöscht werden soll, auf  .
Wenn Sie eine Liste löschen, werden auch die darin enthaltenen Elemente 
gelöscht.
Ändern des Namens einer Liste Tippen Sie in der Listenübersicht auf  und anschließend auf „Bearbeiten“. 
Tippen Sie auf den zu bearbeitenden Namen und geben Sie einen neuen 
ein. Tippen Sie auf „Fertig“.
Festlegen einer Standardliste für 
neue Erinnerungen
Öffnen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“ und tippen Sie unter 
„Erinnerungen“ auf „Standardliste“.
Sie können auch per Sprachbefehl eine Erinnerung erstellen. Weitere Informationen unter 
Kapitel 4,„Siri,“ auf Seite 43.
Verwalten von Erinnerungen in der Datumsansicht
In der Datumsansicht können Sie Erinnerungen verwalten, die ein Fälligkeitsdatum haben.
Anzeigen der Erinnerungen für ein bestimmtes Datum:  Tippen Sie oben auf dem Bildschirm auf 
„Datum“, um die Erinnerungen des aktuellen Tags anzuzeigen. Außerdem sehen Sie so die nicht 
abgeschlossenen Elemente der vorherigen Tage.
Anzeigen eines bestimmten 
Datums
Bewegen Sie den Schieberegler für die Uhrzeit unter der Liste auf einen 
neuen Tag.
Anzeigen eines bestimmten Tags Tippen Sie auf  und wählen Sie ein Datum aus.
Standortbasierte Erinnerungen
Standortbasierte Erinnerungen sind nur auf dem iPhone 4 und iPhone 4S verfügbar. 
Möglicherweise stehen diese nicht in allen Regionen zur Verfügung. Bei Microsoft Exchange- und 
Outlook-Accounts können keine Standorte für Erinnerungen festgelegt werden.
Bei einer standortbasierten Erinnerung können Sie sich an ein Ereignis erinnern lassen, wenn 
Sie den Standort erreichen bzw. sich davon entfernen. Geben Sie für das bestmögliche Ergebnis 
einen möglichst genauen Standort an, wie eine Adresse anstatt einer Stadt. Beachten Sie, dass die 
Genauigkeit variieren kann. Je nach verwendetem iPhone-Modell und je nachdem, ob es gesperrt 
ist, wird der Standort möglicherweise weniger häufig überprüft, d. h. es kann beim Auslösen der 
Erinnerung zu einer Verzögerung kommen.
Wenn Sie eine Erinnerung erstellen, können Sie Ihren aktuellen Standort oder einen Standort aus 
Ihrer Kontaktliste wählen. Fügen Sie für die Verwendung von „Erinnerungen“ Standorte wie den 
Supermarkt oder die Schule zu Ihren Kontakten hinzu. Sie können in „Kontakte“ auch persönliche 
Standorte wie Ihre Privat- oder Ihre Büroadresse zur Kontaktkarte hinzufügen. Mit „Erinnerungen“ 
können Sie dann die Standorte aus Ihrer Kontaktkarte anzeigen. Weitere Informationen zum 
Erstellen Ihrer Kontaktkarte in der App „Kontakte“ erhalten Sie unter „Kontakte-Accounts und 
-einstellungen“ auf Seite 141.
Verwalten abgeschlossener Erinnerungen
Mit der App „Erinnerungen“ behalten Sie die Übersicht über Ihre als abgeschlossen markierten 
Elemente. Sie können diese in der Listen- oder in der Datumsansicht anzeigen oder auch die Liste 
„Erledigt“ verwenden.
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Sie dann von links nach rechts, bis die Liste „Erledigt“ angezeigt wird.
Anzeigen der Anzahl 
abgeschlossener Elemente
Scrollen Sie in der Listen- oder Datumsansicht auf dem Bildschirm mit den 
Erinnerungen nach oben und blättern Sie der Liste nach unten, bis die Liste 
„Erledigt“ angezeigt wird. Tippen Sie auf „Erledigt“, um alle abgeschlossenen 
Elemente anzuzeigen.
Markieren abgeschlossener 
Elemente als nicht abgeschlossen
Tippen Sie auf das entsprechende Element, um das Markierungsfeld zu 
entfernen. Dann wird dieses automatisch in seine ursprüngliche Liste 
bewegt.
Synchronisieren vergangener 
Erinnerungen
Öffnen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“ und tippen Sie 
unter „Erinnerungen“ auf „Synchr.“. Diese Einstellung gilt für Ihre gesamten 
Accounts. Um eine optimale Leistung zu erzielen, sollten Sie nur die 
benötigten vergangenen Erinnerungen synchronisieren.
Suchen von Erinnerungen
Sie können ausstehende oder abgeschlossene Erinnerungen ganz einfach finden. Die 
Erinnerungen werden nach Namen gesucht.
Suchen von Erinnerungen in der Datumsansicht:  Tippen Sie auf  und dann auf „Erinnerungen 
suchen“. Geben Sie anschließend einen Suchbegriff ein.
Suchen von Erinnerungen in der Listenansicht:  Tippen Sie auf  und dann auf „Erinnerungen 
suchen“. Geben Sie anschließend einen Suchbegriff ein.
Sie können auch vom Home-Bildschirm aus Erinnerungen suchen. Weitere Informationen unter 
„Spotlight-Suche“ auf Seite 188. Außerdem können Sie Siri bitten, Erinnerungen nach Namen zu 
finden. Weitere Informationen unter Kapitel 4,„Siri,“ auf Seite 43.
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Game Center
Entdecken Sie neue Spiele und tauschen Sie Ihre Spielerfahrungen mit Freunden aus aller Welt 
im Game Center aus. Laden Sie Ihre Freunde zum Spielen ein oder verwenden Sie die Funktion 
„Auto-Match“, um weitere interessante Gegner zu finden. Sammeln Sie Bonuspunkte, indem Sie 
bestimmte Ziele in einem Spiel erreichen, finden Sie heraus, was Ihre Freunde erreicht haben, und 
schauen Sie sich die Bestenliste an, um herauszufinden, wer die besten Spieler sind. 
Hinweis:  Das Game Center ist möglicherweise nicht in allen Regionen verfügbar und die 
verfügbaren Spiele können variieren.
Sie benötigen für das Game Center eine Internetverbindung und eine Apple-ID. Besitzen Sie noch 
keine Apple-ID, können Sie im Game Center eine erstellen, wie unten beschrieben.
Anzeigen der Bestenliste
Antworten auf eine 
Kontaktanfrage
Anzeigen einer Liste mit 
den Zielen des Spiels
Spielen des Spiels
Finden eines Gegners
Wählen eines Spiels
Einladen von Freunden zu einem Spiel
Festlegen Ihres Status, Ändern 
Ihres Fotos bzw. Abmelden
Anmelden beim Game Center
Anmelden:  Öffnen Sie das Game Center. Wenn Ihr Kurzname und Foto oben auf der Seite 
angezeigt werden, sind Sie bereits angemeldet. Geben Sie andernfalls Ihre Apple-ID und Ihr 
Kennwort ein und tippen Sie auf „Anmelden“. Oder tippen Sie auf „Neuen Account erstellen“, um 
eine neue Apple-ID zu erstellen.
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Angeben Ihres Status Tippen Sie auf „Ich“ und anschließend auf die Statusleiste und geben Sie 
Ihren Status ein.
Anzeigen Ihrer 
Accounteinstellungen
Tippen Sie auf „Ich“, auf das Accountbanner und dann auf „Account 
anzeigen“.
Abmelden Tippen Sie auf „Ich“, tippen Sie dann auf das Accountbanner und 
anschließend auf „Abmelden“. Sie müssen sich nicht jedes Mal beim 
Verlassen des Game Centers abmelden.
Kaufen und Laden von Spielen
Spiele für das Game Center sind im App Store erhältlich.
Kaufen und Laden eines Spiels:  Tippen Sie auf „Spiele“ und dann auf ein empfohlenes Spiel oder 
auf „Game Center-Spiele suchen“.
Kaufen von Spielen, die Ihre 
Freunde besitzen
Tippen Sie auf „Freunde“ und einen Namen in der Liste. Wählen Sie ein Spiel 
aus der Spieleliste Ihres Freundes aus und tippen Sie auf den Preis unter 
dem Namen (oben auf dem Bildschirm).
Spielen von Spielen
Spielen eines Spiels:  Tippen Sie auf „Spiele“ und wählen Sie ein Spiel aus. Tippen Sie dann auf 
„Spielen“.
Anzeigen einer Liste mit der 
Höchstpunktzahl
Tippen Sie auf „Spiele“ und wählen Sie das Spiel aus. Tippen Sie dann auf 
„Bestenliste“.
Anzeigen, welche Spielerfolge 
erzielt werden können
Tippen Sie auf „Spiele“ und wählen Sie ein Spiel aus. Tippen Sie dann auf 
„Erfolge“.
Zurückkehren zum Game Center 
nach dem Spiel
Drücken Sie die Home-Taste und tippen Sie auf „Game Center“ im HomeBildschirm.
Spielen mit Freunden
Das Game Center vermittelt Kontakte zu Spielern auf der ganzen Welt. Sie fügen Freunde zum 
Game Center hinzu, indem Sie eine Anfrage senden oder die Anfrage eines anderen Spielers 
akzeptieren.
Einladen von Freunden zu einem Mehrspieler-Spiel:  Tippen Sie auf „Freunde“, wählen Sie den 
Namen des Freundes und ein Spiel und tippen Sie dann auf „Spielen“. Sind bei dem Spiel mehrere 
Spieler erlaubt oder erforderlich, können Sie weitere Spieler auswählen und einladen. Tippen Sie 
anschließend auf „Weiter“. Geben Sie Ihre Einladung ein und versenden Sie sie. Warten Sie dann, 
bis die anderen die Einladung annehmen. Wenn jeder bereit ist, können Sie loslegen.
Ist ein Freund nicht verfügbar oder antwortet nicht auf die Einladung, können Sie auf „AutoMatch“ tippen, damit Game Center für Sie nach einem Mitspieler sucht. Oder tippen Sie auf 
„Einladen“, um einen anderen Freund einzuladen.
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Sie dann die E-Mail-Adresse eines Freundes oder dessen Game CenterKurznamen ein. Tippen Sie auf  , um Ihre Kontakte zu durchsuchen. Um 
eine Anfrage an mehrere Freunde zu senden, tippen Sie nach jeder Adresse 
auf „Zurück“.
Antworten auf eine Kontaktanfrage Tippen Sie auf „Anfragen“, wählen Sie die Anfrage und tippen Sie dann auf 
„Annehmen“ oder „Ignorieren“. Um ein Problem mit der Anfrage zu melden, 
streichen Sie nach oben und tippen Sie auf „Problem melden“.
Anzeigen der Spiele, die Freunde 
spielen, sowie deren Punktzahl
Tippen Sie auf „Freunde“, den Namen eines Freundes und dann auf „Spiele“ 
oder „Punkte“.
Suchen nach einem Kontakt in Ihrer 
Freundesliste
Tippen Sie auf die Statusleiste, um im Bildschirm nach oben zu blättern. 
Tippen Sie dann auf das Suchfeld und geben Sie den Suchbegriff ein.
Blockieren von Spieleeinladungen Deaktivieren Sie in Ihren Game Center-Einstellungen die Option 
„Spieleeinladungen“. Weitere Informationen unter „Game CenterEinstellungen“ auf Seite 128.
Verbergen Ihrer privaten E-MailAdresse
Deaktivieren Sie in Ihren Game Center-Einstellungen die Option „Meine 
E-Mail-Adresse finden“. Weitere Informationen unter „Game CenterEinstellungen“ auf Seite 128.
Deaktivieren von MehrspielerAktivitäten
Öffnen Sie „Einstellungen“ > „Allgemein“ > „Einschränkungen“ > „Game 
Center“ und deaktivieren Sie die Option „Mehrspieler“.
Deaktivieren von Kontaktanfragen Öffnen Sie „Einstellungen“ > „Allgemein“ > „Einschränkungen“ > „Game 
Center“ und deaktivieren Sie die Option „Freunde hinzufügen“.
Anzeigen der Freundesliste eines 
Kontakts
Tippen Sie auf „Freunde“, den Namen des Freundes und dann auf „Freunde“ 
unter dem Foto des Kontakts.
Entfernen eines Freundes Tippen Sie auf „Freunde“, den Namen des Freundes und dann auf 
„Entfreunden“.
Melden beleidigenden bzw. 
unangemessenen Verhaltens
Tippen Sie auf „Freunde“, den Namen des Freundes und dann auf „Problem 
melden“.
Game Center-Einstellungen
Einige Game Center-Einstellungen sind mit der Apple-ID verknüpft, mit der Sie sich anmelden. 
Andere befinden sich auf Ihrem iPhone unter „Einstellungen“.
Ändern der Game Center-Einstellungen für Ihre Apple-ID  Melden Sie sich mit Ihrer Apple-ID an, 
tippen Sie auf „Ich“ und auf das Accountbanner und wählen Sie „Account anzeigen“.
Festlegen der Art der Benachrichtigungen für das Game Center: Wählen Sie „Einstellungen“ > 
„Benachrichtigungen“ > „Game Center“. Wird das Game Center nicht angezeigt, aktivieren Sie die 
Benachrichtigungen.
Ändern der Game Center-Einschränkungen:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Einschränkungen“ > „Game Center“.
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iTunes Store
Übertragen Sie mithilfe des iTunes Store Inhalte auf Ihr iPhone. Sie können im Store nach Musik, 
Fernsehsendungen, Hörbüchern, Hinweistönen und Klingeltönen suchen und diese kaufen. Sie 
können außerdem Filme kaufen oder ausleihen oder Podcasts oder iTunes U-Sammlungen laden 
und wiedergeben. Um Inhalte zu erwerben, benötigen Sie eine Apple-ID. Weitere Informationen 
unter „Store-Einstellungen“ auf Seite 138.
Hinweis:  Der iTunes Store ist möglicherweise nicht in allen Regionen verfügbar und die iTunes 
Store-Inhalte können sich von Region zu Region unterscheiden. Funktionen können sich jederzeit 
ändern.
Um mit Ihrem iPhone auf iTunes zuzugreifen, benötigen Sie eine Internetverbindung. Weitere 
Informationen unter „Netzwerk“ auf Seite 186.
Suchen nach Musiktiteln, Videos und anderen Inhalten
Wählen einer Kategorie
Erneutes Laden 
von Käufen
Durchsuchen von Inhalten:  Tippen Sie auf eine der Inhaltskategorien unten im Bildschirm (z. B. 
„Musik“ oder „Videos“). Tippen Sie auf „Weitere“, um nach anderen Inhalten zu suchen.
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angezeigt wird), tippen Sie auf das Suchfeld und geben Sie einen oder 
mehrere Suchbegriffe ein. Tippen Sie anschließend auf „Suchen“.
Kaufen und Bewerten von Objekten 
und Freunde darüber informieren
Tippen Sie auf ein Objekt in der Liste, um weitere Detailinformationen im 
zugehörigen Info-Bildschirm anzuzeigen.
Suchen nach Empfehlungen von 
Interpreten und Freunden
Tippen Sie auf „Ping“ (tippen Sie zuerst auf „Weitere“, falls „Ping“ 
nicht angezeigt wird), um herauszufinden, was es Neues über Ihre 
Lieblingsinterpreten gibt oder welche Musik Ihren Freunden gerade 
besonders gut gefällt. Weitere Informationen unter „Mitverfolgen der 
Aktivitäten von Interpreten und Freunden“ auf Seite 131.
Kaufen von Musik, Hörbüchern und Tönen
Wenn Ihnen ein Musiktitel, ein Album, ein Hinweis- oder Klingelton oder ein Hörbuch im iTunes 
Store gefällt, können Sie den entsprechenden Artikel kaufen und laden. Sie können eine Hörprobe 
bzw. Vorschau des Objekts wiedergeben, um sicherzugehen, dass das der gewünschte Artikel ist.
Hörprobe eines Musiktitels, Klingeltons oder Hörbuchs:  Tippen Sie auf das Objekt und befolgen 
Sie die angezeigten Anleitungen.
Einlösen einer Geschenkkarte bzw. 
eines Geschenkcodes
Tippen Sie auf „Musik“ (tippen Sie zuerst auf „Weitere“, falls „Musik“ nicht 
angezeigt wird) und dann unten im Bildschirm auf „Einlösen“ und folgen 
Sie den angezeigten Anleitungen. Wenn Sie angemeldet sind, wird unten 
in den meisten iTunes Store-Bildschirmen zusammen mit Ihren Apple-IDInformationen Ihr aktuelles Guthaben angezeigt.
Vervollständigen eines Albums Tippen Sie beim Ansehen eines Albums auf den Rabattpreis für die 
verbleibenden Titel unter „Alben vervollständigen“ (nicht in allen Regionen 
verfügbar). Zum Anzeigen von Angeboten zu anderen Alben, die 
vervollständigt werden sollen, tippen Sie auf „Musik“ und dann auf „Alben 
vervollständigen“.
Laden einer zuvor gekauften App Tippen Sie auf „Käufe“.
Sie können beim Stöbern auch Objekte laden. Tippen Sie dort, wo 
normalerweise der Preis angezeigt wird, auf „Laden“.
Automatisches Laden von Käufen 
auf anderen Geräten oder 
Computern
Öffnen Sie „Einstellungen“ > „Store“ und legen Sie fest, welche Käufe 
automatisch geladen werden sollen.
Kaufen und Leihen von Videos
Sie können im iTunes Store Filme, Fernsehsendungen und Musikvideos kaufen und laden 
(möglicherweise nicht in allen Regionen verfügbar). Einige Filme können auch für eine begrenzte 
Zeit ausgeliehen werden. Videoinhalte können im SD-Format (Standard-Definition oder 480p), im 
HD-Format (High-Definition oder 720p) oder in beiden Formaten verfügbar sein.
Kaufen oder Leihen eines Videos  Tippen Sie auf „Kaufen“ bzw. auf „Leihen“.
Nachdem Sie den Kauf eines Objekts abgeschlossen haben, wird es geladen. Danach 
erscheint es im Bildschirm „Downloads“. Weitere Informationen unter „Prüfen des Status von 
Ladevorgängen“ auf Seite 132.
Vorschau eines Videos Tippen Sie auf „Vorschau“.
Anzeigen der Vorschau eines 
Videos auf einem Fernsehgerät mit 
AirPlay und Apple TV
Tippen Sie auf  , wenn die Vorschau beginnt, und wählen Sie „Apple TV“. 
Weitere Informationen unter „AirPlay“ auf Seite 36.
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Mitverfolgen der Aktivitäten von Interpreten und Freunden
Verwenden Sie Ping, um Kontakte zu den leidenschaftlichsten Musikfans der Welt zu knüpfen. 
Wenn Sie die Aktivitäten Ihrer Lieblingsinterpreten mitverfolgen, können Sie sich über 
Neuerscheinungen und bevorstehende Konzerte und Tourneen informieren, Sie erhalten über die 
geposteten Fotos und Videos echte Insider-Einblicke und erfahren mehr über ihre musikalischen 
Einflüsse. Lesen Sie die Kommentare von Freunden zu Musik, die diese gerade hören, und finden 
Sie heraus, was Ihre Freunde kaufen und welches Konzert sie besuchen möchten. Drücken Sie Ihre 
musikalischen Vorlieben aus und posten Sie Kommentare für Ihre Mitleser.
Wenn Sie musikalischen Verbindungen knüpfen und pflegen möchten, müssen Sie zuerst ein 
Profil erstellen.
Erstellen eines Ping-Profils:  Öffnen Sie das Programm „iTunes“ auf Ihrem Mac oder PC, klicken Sie 
auf „Ping“ und befolgen Sie die angezeigten Anleitungen.
Tippen Sie auf „Ping“ (tippen Sie zuerst auf „Weitere“, falls „Ping“ nicht angezeigt wird) und gehen 
Sie auf Erkundungstour. Sie haben folgende Möglichkeiten:
Folgen der Aktivitäten eines 
Interpreten
Tippen Sie auf den Profilseite des Interpreten auf „Folgen“.
Folgen der Aktivitäten eines 
Freundes
Wenn Sie jemandem folgen, folgt diese Person nicht automatisch auch 
Ihnen. Sie können in Ihrem Profil Anfragen anderer Personen bestätigen 
oder ablehnen (ignorieren) oder alle neuen Personen ohne Prüfung 
akzeptieren.
Gedankenaustausch mit anderen Wenn Sie in Alben oder Musiktiteln stöbern, können Sie auf „Posten“ tippen, 
um ein Musikstück zu kommentieren, oder durch Tippen auf „Gefällt mir“ 
Personen, die Ihnen folgen, mitteilen, dass Ihnen die Musik gefällt. Ihre 
Freunde sehen Ihre Kommentare und Empfehlungen in ihrem Feed „Ping 
Aktivitäten“.
Informieren über geplante 
Konzertbesuche
Tippen Sie auf Ihrer Profilseite auf „Konzerte“, um bevorstehende Konzerte 
der Interpreten, bei denen Sie mitlesen, zu finden. Gleichzeitig können Sie 
sehen, wer von Ihren Freunden zu einem bestimmten Konzert geht. Tippen 
Sie auf „Tickets“, um eine Eintrittskarte zu kaufen, oder tippen Sie auf „Ich 
gehe hin“, damit die anderen wissen, dass Sie auch dort sein werden. (Nicht 
in allen Regionen verfügbar.)
Streaming und Laden von Podcasts
Sie können Audio- oder Video-Podcasts abspielen, die per Streaming aus dem iTunes Store über 
das Internet übertragen werden. Sie können Audio- und Video-Podcasts auch laden.
Übertragen eines Podcasts per Streaming:  Tippen Sie auf „Podcasts“ (tippen Sie zuerst auf 
„Weitere“, falls „Podcasts“ nicht angezeigt wird), um die Podcasts im iTunes Store zu durchsuchen.
Video-Podcasts sind mit einem Videosymbol  gekennzeichnet.
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„Laden“. Geladene Podcasts werden in der Wiedergabeliste „Podcasts“ 
angezeigt.
Anhören bzw. Ansehen eines 
geladenen Podcasts
Tippen Sie unter „Musik“ auf „Podcasts“ (tippen Sie zuerst auf „Weitere“, falls 
„Podcasts“ nicht angezeigt wird) und tippen Sie auf den Podcast. VideoPodcasts werden auch in Ihrer Videoliste angezeigt.
Laden weiterer Folgen des 
geladenen Podcasts
Tippen Sie in der Liste „Podcasts“ unter „Musik“ auf den Podcast und danach 
auf „Weitere Folgen laden“.
Löschen eines Podcasts Streichen Sie in der Liste „Podcasts“ unter „Musik“ nach links oder rechts 
über den Podcast und tippen Sie auf „Löschen“.
Prüfen des Status von Ladevorgängen
Im Bildschirm „Downloads“ können Sie den Status aktueller oder geplanter Ladevorgänge sowie 
den Status von Einkäufen überprüfen, für die Sie eine Vorbestellung abgegeben haben.
Anzeigen des Status von Ladevorgängen:  Tippen Sie auf „Downloads“ (tippen Sie zuerst auf 
„Weitere“, falls „Downloads“ nicht angezeigt wird).
Vorbestellte Objekte werden an ihrem Erscheinungsdatum nicht automatisch auf Ihr Gerät 
geladen. Sie müssen den Ladevorgang manuell im Bildschirm „Downloads“ starten.
Laden eines vorbestellten Objekts Tippen Sie auf das Objekt und dann auf  .
Wenn der Ladevorgang unterbrochen wird, wird er fortgesetzt, sobald wieder eine 
Internetverbindung besteht. Wenn Sie alternativ iTunes auf Ihrem Computer öffnen, führt iTunes 
den Ladevorgang zu Ende und übernimmt das betreffende Objekt in die iTunes-Mediathek (sofern 
Ihr Computer mit dem Internet verbunden ist und Sie mit derselben Apple-ID angemeldet sind).
Ändern der Tasten zum Blättern
Sie können die Suchtasten „Musik“, „Podcasts“, „Videos“ und „Suchen“ unten im Bildschirm durch 
Tasten austauschen, die Sie häufiger verwenden. Wenn Sie beispielsweise häufig Hörbücher 
laden, jedoch kaum Videos ansehen, können Sie die Taste „Videos“ durch die Taste „Hörbücher“ 
austauschen.
Ändern der Tasten zum Blättern:  Tippen Sie auf „Mehr“ und danach auf „Bearbeiten“ und 
bewegen Sie eine Taste nach unten im Bildschirm über die Taste, die ersetzt werden soll.
Sie können die Tasten unten im Bildschirm auch nach links oder rechts bewegen, um sie 
wunschgemäß anzuordnen. Tippen Sie abschließend auf „Fertig“.
Tippen Sie beim Suchen auf „Weitere“, damit die derzeit nicht sichtbaren Suchtasten eingeblendet 
werden.
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Wenn Sie iTunes Store-Informationen für Ihre Apple-ID auf dem iPhone anzeigen möchten, 
tippen Sie auf Ihre Apple-ID (unten in den meisten iTunes Store-Bildschirmen). Oder wählen Sie 
„Einstellungen“ > „Store“ und tippen auf „Apple ID anzeigen“. Sie müssen angemeldet sein, um 
Ihre Accountinformationen anzuzeigen. Weitere Informationen unter „Store-Einstellungen“ auf 
Seite 138.
Prüfen der geladenen Dateien
Mithilfe von iTunes können Sie auf Ihrem Computer überprüfen, ob sich alle Musiktitel, Videos, 
Programme und anderen Objekte, die Sie im iTunes Store oder App Store gekauft haben, in 
Ihrer iTunes-Mediathek befinden. Dies ist möglicherweise sinnvoll, wenn ein Ladevorgang 
unterbrochen wurde.
Prüfen Ihrer Einkäufe  Öffnen Sie iTunes und wählen Sie „Store“ > „Nach verfügbaren Downloads 
suchen“.
Wenn Sie alle Einkäufe anzeigen möchten, können Sie sich mit Ihrer Apple-ID anmelden, „Store“ > 
„Meinen Account anzeigen“ auswählen und auf „Einkaufsstatistik“ klicken.
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Zeitungskiosk
Im Zeitungskiosk befinden sich Ihre Zeitschriften- und Zeitungsabonnements in einem Regal, 
über das Sie ganz einfach darauf zugreifen können. Zeitungskiosk-Apps sind direkt im Regal 
verfügbar. Wenn es eine neue Ausgabe gibt, wird dies mit einem Banner im Regal angezeigt. Sie 
werden automatisch auf das iPhone übertragen.
Legen Sie Ihren Finger 
auf ein Magazin/eine 
Zeitung, um das Objekt 
neu anzuordnen.
Suchen von Zeitungskiosk-Apps:  Tippen Sie auf „Zeitungskiosk“, um das Regal anzuzeigen, und 
wählen Sie dann „Store“.
Wenn Sie eine neue Zeitungskiosk-App kaufen, wird diese zu Ihrem Regal hinzugefügt und Sie 
können dort schnell darauf zugreifen. Nachdem die App geladen wurde, öffnen Sie sie, um die 
verschiedenen Ausgaben und Abonnementoptionen anzuzeigen.
Bei Abonnements handelt es sich um App-interne Käufe, die über Ihren Store-Account 
abgerechnet werden. Weitere Informationen unter „Store-Einstellungen“ auf Seite 138. 
Die Preise variieren und Zeitungskiosk-Apps stehen möglicherweise nicht in allen Regionen zur 
Verfügung.
134Lesen der neuesten Ausgabe
Wenn es eine neue Ausgabe einer Zeitschrift oder Zeitung gibt, wird diese automatisch im 
Zeitungskiosk geladen, wenn Ihr Gerät mit einem WLAN-Netzwerk verbunden ist. Außerdem 
informiert eine Kennzeichnung auf der App Sie über die neue Ausgabe. Öffnen Sie die App 
„Zeitungskiosk“, um mit dem Lesen zu beginnen, und suchen Sie nach den Apps, die mit einer 
Kennzeichnung „Neu“ versehen sind.
Wie Sie über neue Ausgaben informiert werden, variiert je nach App. Informationen zum Löschen, 
Suchen und Lesen einzelner Ausgaben erhalten Sie in der Hilfe der entsprechenden App bzw. 
im Informationstext zur App im App Store. Es ist nicht möglich, die App „Zeitungskiosk“ aus dem 
Regal zu entfernen oder andere Arten von Apps in das Regal zu stellen.
Deaktivieren automatischer Downloads:  Öffnen Sie „Einstellungen“ > „Store“ und deaktivieren 
Sie für das gewünschte Objekt automatische Downloads.
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App Store
Mit dem iPhone können Sie Apps im App Store suchen, als Demo anzeigen, bewerten, kaufen und 
laden. 
Ihr iPhone muss mit dem Internet verbunden sein, damit Sie den App Store öffnen können. 
Weitere Informationen unter „Netzwerk“ auf Seite 186. Zum Laden von Apps benötigen 
Sie außerdem eine Apple-ID (möglicherweise nicht in allen Regionen verfügbar). Weitere 
Informationen unter „Store-Einstellungen“ auf Seite 138.
Hinweis:  Der iTunes Store ist möglicherweise nicht in allen Regionen verfügbar und die iTunes 
Store-Inhalte können sich von Region zu Region unterscheiden. Funktionen können sich jederzeit 
ändern.
Genius-Empfehlungen 
anzeigen
Nach App-Updates suchen
Suchen und Laden von Apps
Blättern Sie durch die verschiedenen Listen, um neue, interessante oder empfohlenen Apps 
anzuzeigen. In den Top 25 finden Sie die beliebtesten Apps. Verwenden Sie die Suche, wenn Sie 
nach einer bestimmten App suchen.
Durchsuchen des App Store:  Tippen Sie auf „Highlights“, „Kategorien“ oder „Top 25“.
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„Genius“
Tippen Sie auf „Genius“, um eine Liste mit Empfehlungen anzuzeigen, die 
auf dem Inhalt Ihrer App-Sammlung basieren. Folgen Sie den angezeigten 
Anleitungen, um die Funktion „Genius“ zu aktivieren. Genius ist ein 
kostenloser Dienst, zu dessen Nutzung eine Apple-ID erforderlich ist. 
Suchen nach Apps Tippen Sie auf die Taste „Suchen“ und auf das Suchfeld. Geben Sie danach 
ein oder mehrere Wörter ein und tippen Sie auf „Suchen“.
Anzeigen von Wertungen und 
Rezensionen
Tippen Sie auf „Bewertungen“ unten im Info-Bildschirm der App. Sie können 
geladene Apps bewerten und eine Rezension verfassen.
Senden eines Links zur Info-Seite 
der App in iTunes
Tippen Sie auf „Empfehlen“ unten im Info-Bildschirm einer App.
Versenden einer App als Geschenk Tippen Sie unten im Info-Bildschirm auf die Option zum Schenken und 
folgen Sie dann den angezeigten Anleitungen.
Melden eines Problems Tippen Sie auf „Problem melden“ unten im Info-Bildschirm einer App. 
Wählen Sie ein Problem aus der Liste aus oder geben Sie optionale 
Kommentare ein. Tippen Sie dann auf „Melden“.
Kaufen und Laden einer App Tippen Sie auf den Preis (oder tippen Sie auf „Gratis“) und anschließend auf 
„Kaufen“. 
Wenn Sie die App bereits gekauft haben, wird auf dem Infobildschirm 
anstatt des Preises „Installieren“ angezeigt. Sie müssen nicht bezahlen, um 
die App erneut zu laden.
Einlösen einer Geschenkkarte bzw. 
eines Geschenkcodes
Tippen Sie unten im Bildschirm „Highlights“ auf „Einlösen“ und folgen Sie 
dann den angezeigten Anleitungen. 
Anzeigen des Ladestatus von Apps Wenn eine App geladen wird, wird deren Symbol mit einem Statusbalken 
auf dem Home-Bildschirm angezeigt.
Laden einer zuvor gekauften App Tippen Sie auf „Käufe“.
Sie können einen Artikel auch erneut laden, während Sie den Store 
durchstöbern: Tippen Sie einfach auf „Laden“ (wo üblicherweise der Preis 
angezeigt wird).
Automatisches Laden von Käufen 
auf anderen Geräten
Öffnen Sie „Einstellungen“ > „Store“ und legen Sie fest, welche Käufe 
automatisch geladen werden sollen.
Aktualisieren einer App Tippen Sie unten im Info-Bildschirm der App auf „Updates“ und folgen Sie 
dann den angezeigten Anleitungen.
Löschen von Apps
Sie können Apps, die Sie über den App Store installiert haben, löschen. Wenn Sie eine App 
löschen, werden auch alle verknüpften Daten gelöscht.
Löschen einer App Store-App  Legen Sie den Finger auf ein beliebiges Symbol im HomeBildschirm, bis die Symbole anfangen, sich leicht zu bewegen, und tippen Sie dann auf  . Wenn 
Sie mit dem Löschen der Apps fertig sind, drücken Sie die Home-Taste  .
Informationen zum Löschen aller Apps sowie Ihrer Daten und Einstellungen erhalten Sie im 
Kapitel „Inhalte & Einstellungen löschen“ unter Seite 191.
Sie können jede App, die Sie im App Store gekauft und gelöscht haben, kostenfrei erneut laden.
Laden einer gelöschten App Tippen Sie im App Store auf „Updates“ und dann auf „Gekaufte Artikel“. 
Tippen Sie auf die App und dann auf „Installieren“.
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In den Store-Einstellungen können Sie sich bei einem Apple-ID-Account anmelden, einen neuen 
Apple-ID-Account erstellen oder einen vorhandenen bearbeiten. Wenn Sie mehrere Apple-IDs 
haben, können Sie sich in den Store-Einstellungen bei einem Account abmelden und bei einem 
anderen anmelden. Standardmäßig wird in den Store-Einstellungen der Apple-ID-Account 
angezeigt, bei dem Sie sich für die Synchronisierung des iPhone mit Ihrem Computer angemeldet 
haben. 
Unter www.apple.com/de/legal/itunes/ww/ finden Sie die Bedingungen des iTunes Store. 
Anmelden bei einem Apple-ID-Account:  Wählen Sie „Store“ > „Anmelden“. Tippen Sie dann auf 
„Bestehende Apple-ID verwenden“ und geben Sie Ihre Apple-ID und das Kennwort ein.
Anzeigen und Bearbeiten Ihrer 
Accountinformationen
Wählen Sie „Einstellungen“ > „Store“, tippen Sie auf Ihre Apple-ID und 
tippen Sie auf „Apple-ID anzeigen“. Tippen Sie auf ein Element, um es zu 
bearbeiten. Zum Ändern Ihres Accountkennwortes tippen Sie auf das Feld 
„Apple-ID“.
Anmelden mit einer anderen 
Apple-ID
Wählen Sie „Einstellungen“ > „Store“, tippen Sie auf Ihren Accountnamen 
und auf „Abmelden“.
Erstellen einer neuen Apple-ID Wählen Sie „Einstellungen“ > „Store“ aus und tippen Sie auf „Anmelden“. 
Tippen Sie auf „Neue Apple-ID erstellen“ und befolgen Sie die angezeigten 
Anleitungen.
Automatisches Laden von Käufen Öffnen Sie „Einstellungen“ > „Store“ und legen Sie fest, welche Käufe (z. B. 
„Musik“ oder „Bücher“) automatisch auf das iPhone geladen werden sollen. 
Sie können die automatische Aktualisierung der Zeitungskiosk-Apps auch 
deaktivieren.
Laden von Käufen über das mobile 
Datennetzwerk
Wählen Sie „Einstellungen“ > „Store“ und aktivieren bzw. deaktivieren Sie 
die Option „Mobile Daten“. Für das Laden von Einkäufen über das mobile 
Datennetzwerk fallen möglicherweise Gebühren von Ihrem Telefonanbieter 
an. Zeitungskiosk-Apps werden nur aktualisiert, wenn das iPhone mit 
einem WLAN-Netzwerk verbunden ist. Weitere Informationen unter 
Kapitel 22,„Zeitungskiosk,“ auf Seite 134.
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Kontakte
Mit „Kontakte“ können Sie einfach auf Ihre Kontaktlisten von privaten, geschäftlichen und 
organisatorischen Accounts zugreifen und diese verwalten. Sie können in allen Gruppen suchen, 
wobei automatisch auf die Informationen in Ihren Kontakten zugegriffen wird, um E-MailAdressierung schnell und einfach zu machen.
Anrufen
Senden einer 
E-Mail
Senden einer 
Textmitteilung
Tätigen eines 
FaceTime-Anrufs
Anzeigen einer 
Karte und 
Abrufen von 
Wegbeschreibungen
Synchronisieren von Kontakten
Sie können Kontakte wie nachfolgend beschrieben hinzufügen:
Â In iTunes können Sie Kontakte mit Google, Yahoo! oder den Programmen synchronisieren, 
die auf Ihrem Computer installiert sind. Weitere Informationen unter „Synchronisieren mit 
iTunes“ auf Seite 19.
Â Verwenden Sie Ihre iCloud-Kontakte. Weitere Informationen unter „iCloud“ auf Seite 18.
Â Richten Sie einen Microsoft Exchange-Account auf dem iPhone ein und achten Sie dabei darauf, 
dass die App „Kontakte“ aktiviert wird. Weitere Informationen unter „Kontakte-Accounts und 
-einstellungen“ auf Seite 141.
Â Richten Sie einen LDAP- oder CardDAV-Account ein, um auf Geschäfts- oder Schulverzeichnisse 
zugreifen zu können. Weitere Informationen unter „Kontakte-Accounts und -einstellungen“ auf 
Seite 141.
Â Geben Sie Kontakte direkt in das iPhone ein. Weitere Informationen unter „Hinzufügen und 
Bearbeiten von Kontakten“ auf Seite 140.
139Â Importieren Sie Kontakte von einer SIM-Karte (GSM-Modelle). Weitere Informationen unter 
„Kontakte-Accounts und -einstellungen“ auf Seite 141.
Suchen nach Kontakten
Sie können in Ihren Kontakten auf dem iPhone nach Titel, Vor-, Nach- oder Firmenname suchen. 
Wenn Sie einen Microsoft Exchange-, einen LDAP- oder einen CardDAV-Account eingerichtet 
haben, können Sie auch diese Kontakte durchsuchen.
Suchen von Kontakten:  Tippen Sie oben in „Kontakte“ auf das Suchfeld und geben Sie einen 
Suchbegriff ein. 
Suchen einer GAL-Liste Tippen Sie auf „Gruppen“ und auf „Verzeichnisse“ unten in der Liste und 
geben Sie einen Suchbegriff ein.
Suchen auf einem LDAP-Server Tippen Sie auf „Gruppen“ und danach auf den Namen des LDAP-Servers. 
Geben Sie anschließend den Suchbegriff ein.
Suchen auf einem CardDAV-Server Tippen Sie auf „Gruppen“ und auf die durchsuchbare CardDAV-Gruppe 
unten in der Liste und geben Sie einen Suchbegriff ein.
Speichern von 
Kontaktinformationen von einem 
GAL-, LDAP- oder CardDAV-Server
Suchen Sie nach dem Kontakt, den Sie hinzufügen möchten, und tippen Sie 
auf „Kontakt hinzufügen“.
Bei der Suche vom Home-Bildschirm können auch Kontakte gesucht werden. Weitere 
Informationen unter „Suchen“ auf Seite 31.
Hinzufügen und Bearbeiten von Kontakten
Hinzufügen eines Kontakts auf dem iPhone: Tippen Sie auf „Kontakte“ und dann auf  . Wenn 
 nicht angezeigt wird, stellen Sie sicher, dass Sie sich nicht in einer LDAP-, CalDAV- oder GALKontaktliste befinden.
Löschen eines Kontakts Wählen Sie in der Kontaktliste einen Kontakt aus und tippen Sie dann auf 
„Bearbeiten“. Blättern Sie nach unten und tippen auf „Kontakt löschen“.
Hinzufügen eines Kontakts über die 
numerische Tastatur
Tippen Sie auf die Tastatur, geben Sie eine Nummer ein und tippen Sie auf 
. Tippen Sie anschließend auf „Neuen Kontakt erstellen“ oder auf „Zu 
Kontakt hinzufügen“ und wählen Sie einen Kontakt aus.
Hinzufügen einer weichen (2 
Sekunden langen) Pause zu einer 
Telefonnummer
Tippen Sie auf  und anschließend auf „Pause“. Ein Telefonsystem 
benötigt u. U. eine oder mehrere Pausen, um zu einer Nebenstelle 
durchzustellen. Eine solche Pause wird als Komma angezeigt, wenn die 
Telefonnummer gesichert wird.
Hinzufügen einer harten Pause zu 
einer Telefonnummer
Tippen Sie auf  und anschließend auf „Warten“. Eine solche Pause wird 
als Semikolon angezeigt, wenn die Telefonnummer gesichert wird. Beim 
Wählen stoppt das iPhone, wenn das Semikolon erreicht wird, und wartet, 
bis Sie auf die Taste „Wählen“ tippen, um fortzufahren.
Hinzufügen der Telefonnummer 
eines Anrufers in der Anrufliste zu 
Ihren Kontakten
Tippen Sie auf „Letzte Suche“ und  neben der Telefonnummer. Tippen 
Sie anschließend auf „Neuen Kontakt erstellen“ oder auf „Zu Kontakt 
hinzufügen“ und wählen Sie einen Kontakt aus.
Bearbeiten von Kontaktinformationen: Wählen Sie einen Kontakt aus und tippen Sie dann auf 
„Bearbeiten“.
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Hinzufügen des Twitter-Namens 
eines Kontakts
Tippen Sie auf  „Hinzufügen“ und dann auf „Twitter“.
Ändern eines Feldetiketts Tippen Sie auf das Etikett und wählen Sie ein anderes. Blättern Sie an das 
Ende der Liste und tippen Sie auf „Eigenes Etikett hinzufügen“, um ein 
neues hinzuzufügen.
Ändern des Klingeltons oder SMSTons für einen Kontakt
Tippen Sie auf das Feld „Klingelton“ oder „SMS-Ton“ und wählen Sie einen 
neuen Ton. Der Standardton wird in „Einstellungen“ > „Töne“ festgelegt.
Löschen eines Objekts Tippen Sie auf  und anschließend auf „Löschen“.
Zuordnen eines Fotos zu einem 
Kontakt
Tippen Sie auf „Foto hinzufügen“ oder auf das vorhandene Foto. Sie können 
mit der Kamera ein Foto machen oder ein vorhandenes verwenden.
Um Fotos von den Twitter-Profilen Ihrer Kontakte zu importieren, öffnen Sie 
„Einstellungen“ > „Twitter“. Melden Sie sich bei Ihrem Twitter-Account an. 
Tippen Sie danach auf „Kontakte aktualisieren“.
Vereinheitlichte Kontakte
Wenn Sie Kontakte mit mehreren Accounts synchronisieren, kann es vorkommen, dass Einträge 
für dieselbe Person in mehreren Accounts vorhanden sind. Damit Mehrfacheinträge nicht in 
der Liste „Alle Kontakte“ erscheinen, können Sie Kontakte mit demselben Namen miteinander 
verknüpfen als einzelnen vereinheitlichten Kontakt anzeigen. Wenn Sie einen solchen Kontakt 
anzeigen, erscheint oben auf dem Bildschirm der Titel „Gemeinsam“. 
Verknüpfen eines Kontakts: Tippen Sie auf „Bearbeiten“ und danach auf  und wählen Sie einen 
Kontakt aus.
Wenn Sie Kontakte mit unterschiedlichen Vor- oder Nachnamen verknüpfen, ändern sich die 
Namen der einzelnen Kontakte nicht. Es wird jedoch nur ein Name auf der vereinheitlichten 
Karte angezeigt. Wenn Sie auswählen möchten, welcher Name auf einer vereinheitlichten Karte 
angezeigt wird, müssen Sie auf die die verknüpfte Karte mit dem gewünschten Namen und dann 
auf „Namen für gem. Karte benutzen“ tippen.
Anzeigen von 
Kontaktinformationen von einem 
Quellen-Account
Tippen Sie auf einen Account.
Verknüpfung für einen Kontakt 
aufheben
Tippen Sie auf „Bearbeiten“, dann auf  und auf „Verknüpfung aufheben“.
Verknüpfte Kontakte werden nicht zusammengeführt. Haben Sie die Informationen in einem 
vereinheitlichten Kontakt geändert oder Informationen hinzugefügt, werden diese Änderungen in 
jeden Quellen-Account kopiert, in dem diese bereits vorhanden sind. 
Kontakte-Accounts und -einstellungen
Sie können Kontakte-Accounts hinzufügen und festlegen, wie diese sortiert und angezeigt 
werden.
Hinzufügen eines Kontakte-Accounts:  Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, Kalender“ 
und dann auf „Account hinzufügen“.
Um die Einstellungen zu ändern, öffnen Sie „Einstellungen“ > „Mail, Kontakte, Kalender“, um auf die 
folgenden Optionen zuzugreifen:
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Kontakten
Tippen Sie auf „Sortierfolge“ und legen Sie fest, ob die Kontakte nach Vor- 
oder Nachnamen sortiert werden.
Festlegen der Anzeigefolge von 
Kontakten
Tippen Sie auf „Anzeigefolge“ und legen Sie fest, ob die Kontakte nach Vor- 
oder Nachnamen sortiert werden.
Importieren von Kontakten von 
einer SIM-Karte
Tippen Sie auf „SIM-Kontakte importieren“.
Einrichten der Karte mit Ihren 
persönlichen Infos
Tippen Sie auf „Meine Infos“ und wählen Sie die Kontaktkarte mit Ihrem 
Namen und Ihren Informationen aus der Liste aus.
Die Karte „Meine Infos“ wird von Siri und anderen Apps verwendet. Legen 
Sie mithilfe der Felder „Zugehörige Personen“ Ihre Beziehung zu anderen 
Personen, die Siri kennen soll, damit Sie z. B. sagen können: „Rufe meine 
Schwester an“.
Festlegen eines standardmäßigen 
Kontakte-Accounts:
Wählen Sie „Standardaccount“ und wählen Sie dann einen Account aus. 
Neue Kontakte werden automatisch hier gespeichert, wenn Sie keinen 
anderen Account festlegen.
Verwenden von iCloud, um die 
Kontakte auf Ihren iOS-Geräten 
und Computern auf dem neuesten 
Stand zu halten
Öffnen Sie „Einstellungen“ > „iCloud“ und aktivieren Sie die Option 
„Kontakte“. Weitere Informationen unter „iCloud“ auf Seite 18.
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Videos
Auf dem iPhone können Sie nach Videoinhalten wie Filme, Musikvideos, Video-Podcasts und 
Fernsehsendungen (wenn für Ihre Region verfügbar) in iTunes suchen.
Anzeigen von Videos
Abspielen eines Videos:  Tippen Sie auf das Video.
Auf das Video 
tippen, um die 
Steuerelemente 
ein- oder 
auszublenden.
Anzeigen des 
Videos auf 
einem 
Fernsehgerät 
mit Apple TV.
Bewegen, um zurück oder nach vorne zu springen.
Auswählen 
eines Kapitels
Bewegen, um die 
Lautstärke anzupassen.
Das Erscheinungsdatum von Cars 2 variiert je nach Land. Weitere Informationen 
erhalten Sie in iTunes für Ihre Region. Cars 2 © Disney/Pixar.
Ein- oder Ausblenden der 
Bedienelemente
Tippen Sie während der Videowiedergabe auf den Bildschirm.
Anpassen der Lautstärke Bewegen Sie den Lautstärkeregler oder verwenden Sie die Lautstärketasten 
an der Seite des iPhone bzw. die Lautstärketasten der iPhone-Kopfhörer.
Auswählen zwischen einer 
bildschirmfüllenden oder einer 
auf die Bildschirmgröße skalierten 
Videodarstellung
Tippen Sie auf  oder  . Alternativ können Sie zweimal auf das Video 
tippen.
Unterbrechen oder Fortsetzen der 
Wiedergabe
Tippen Sie auf  oder  oder drücken Sie auf den iPhone-Kopfhörern die 
Mitteltaste.
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Abspielposition auf der Navigationsleiste ganz nach links. Gibt es keine 
Kapitel, tippen Sie auf  . Haben Sie das Video weniger als fünf Sekunden 
lang angeschaut, wird stattdessen das vorherige Video aus Ihrer Mediathek 
wiedergegeben.
Springen zu einem bestimmten 
Kapitel (falls verfügbar)
Tippen Sie auf  und wählen Sie ein Kapitel aus.
Springen zum nächsten Kapitel 
(falls verfügbar)
Tippen Sie auf  oder drücken Sie auf den iPhone-Kopfhörern die 
Mitteltaste zweimal.
Springen zum vorherigen Kapitel 
(falls verfügbar)
Tippen Sie auf  oder drücken Sie auf den iPhone-Kopfhörern die 
Mitteltaste dreimal. Haben Sie das Video weniger als fünf Sekunden lang 
angeschaut, wird stattdessen das vorherige Video aus Ihrer Mediathek 
wiedergegeben.
Zurück- bzw. Vorspulen Tippen und halten Sie  oder  .
Abbrechen der Videowiedergabe Tippen Sie auf „Fertig“.
Wählen einer anderen 
Audiosprache (falls verfügbar)
Tippen Sie auf  und wählen Sie eine Sprache aus der Liste.
Ein- bzw. Ausblenden von 
Untertiteln (falls verfügbar)
Tippen Sie auf  und wählen Sie eine Sprache bzw. die Option „Aus“ aus 
der Liste.
Ein- bzw. Ausblenden von 
erweiterten Untertiteln (falls 
verfügbar)
Wählen Sie „Einstellungen“ > „Video“.
Suchen nach Videos
Sie können unter dem jeweiligen Titel nach Filmen, Fernsehsendungen und Video-Podcasts auf 
dem iPhone suchen.
Suchen nach Ihren Videos:  Tippen Sie oben im Bildschirm auf die Statusleiste, um das Suchfeld 
zu öffnen, und geben Sie den Suchtext ein.
Sie können auch vom Home-Bildschirm aus Videos suchen. Weitere Informationen unter 
„Suchen“ auf Seite 31.
Anschauen geliehener Filme
Sie können im iTunes Store Filme ausleihen und diese auf dem iPhone anschauen. Sie können 
ausgeliehene Filme und Fernsehsendungen direkt auf das iPhone laden oder Filme in iTunes 
von Ihrem Computer auf Ihr iPhone übertragen. (Die Funktion ist möglicherweise nicht in allen 
Regionen verfügbar.)
Ausgeliehene Filme verfügen über eine Leihfrist. Sobald Sie mit der Wiedergabe beginnen, haben 
Sie einen begrenzten Zeitraum, um den Film zu beenden. Die verbleibende Zeitdauer wird neben 
dem Titel angezeigt. Nach Ablauf der Leihfrist werden die Medien gelöscht. Prüfen Sie im iTunes 
Store die Leihfrist, bevor Sie einen Film leihen. Weitere Informationen unter „Kaufen und Leihen 
von Videos“ auf Seite 130.
Ansehen eines Leihfilms: Tippen Sie auf das Video, das Sie ansehen möchten. Wenn das Video 
nicht in Ihrer Liste angezeigt wird, wurde es möglicherweise noch nicht vollständig geladen.
Übertragen geliehener Filme auf das iPhone: Verbinden Sie das iPhone mit dem Computer. 
Wählen Sie dann in der iTunes-Seitenleiste das iPhone aus, klicken Sie auf „Filme“ und wählen Sie 
die zu übertragenden Filme aus. Ihr Computer muss mit dem Internet verbunden sein. Mit dem 
iPhone geliehene Filme können nicht auf den Computer übertragen werden.
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und umgekehrt. Mit dem iPhone 4 können geliehene Filme nur zwischen iPhone und dem 
Computer übertragen werden, wenn sie über iTunes auf dem Computer ausgeliehen wurden.
Ansehen eines Videos auf einem Fernsehgerät
Sie können mit AirPlay und Apple TV Videos über WLAN auf Ihren Fernsehgerät streamen oder 
das iPhone mit einem der folgenden Kabel an das Fernsehgerät anschließen:
Â Apple Digital AV-Adapter und ein HDMI-Kabel (iPhone 4 oder neuer)
Â Apple Component AV-Kabel
Â Apple Composite AV-Kabel
Â Apple VGA-Adapter und ein VGA-Kabel
Apple-Kabel, -Adapter und -Docks sind in vielen Regionen separat erhältlich. Öffnen Sie 
www.apple.com/de/store oder besuchen Sie Ihren örtlichen Apple-Händler.
Streamen von Videos mithilfe von AirPlay:  Beginnen Sie mit der Videowiedergabe, tippen Sie 
auf  und wählen Sie aus der Liste der AirPlay-Geräte Ihr Apple TV aus. Wenn  nicht angezeigt 
oder Apple TV nicht in der Liste der AirPlay-Geräte aufgeführt wird, überprüfen Sie, ob es sich 
im gleichen WLAN-Netzwerk wie das iPhone befindet. Weitere Informationen unter „AirPlay“ auf 
Seite 36.
Sie können den Bereich „Video“ verlassen und andere Apps verwenden, während das Video 
abgespielt wird. Um die Wiedergabe auf dem iPhone fortzusetzen, tippen Sie auf  und wählen 
Sie iPhone.
Streamen von Videos mithilfe eines Kabels:  Schließen Sie das iPhone mit dem Kabel an Ihr 
Fernsehgerät bzw. AV-Receiver an und wählen Sie die entsprechende Audioausgabe.
Anschließen mithilfe eines AVKabels
Verwenden Sie das Apple Component AV-Kabel, das Apple Composite 
AV-Kabel oder ein anderes mit dem iPhone kompatibles Kabel. Sie können 
diese Kabel auch verwenden, um das Apple Universal Dock (separat 
erhältlich) mit dem iPhone und Ihrem Fernsehgerät zu verbinden. Steuern 
Sie die Wiedergabe mit der Fernbedienung des Docks. 
Anschließen mithilfe eines Apple 
Digital AV-Adapters (iPhone 4 oder 
neuer)
Verbinden Sie den Apple Digital AV-Adapter mit dem iPhoneDockanschluss. Verwenden Sie ein HDMI-Kabel, um den HDMI-Anschluss 
des Adapters mit Ihrem Fernsehgerät oder Receiver zu verbinden. Damit 
das iPhone auch während der Videowiedergabe aufgeladen wird, müssen 
Sie mit einem Apple Dock Connector-auf-USB-Kabel den 30-poligen 
Anschluss des Adapters mit Ihrem Computer verbinden oder ein mit dem 
Stromnetz verbundenes USB-Netzteil verwenden.
Anschließen mithilfe eines VGAAdapters
Verbinden Sie den AV-Adapter mit dem iPhone-Dockanschluss. Schließen 
Sie den VGA-Adapter mit einem VGA-Kabel an ein kompatibles Gerät 
(Fernsehgerät, Projektor oder VGA-Bildschirm) an.
Der Digital AV-Adapter unterstützt HD-Videos (High-Definition) mit bis zu 720p mit Audio.
Wenn Sie das iPhone 4S über einen Apple Digital AV- oder VGA-Adapter an ein Fernsehgerät 
oder Projektor anschließen, wird der iPhone-Bildschirm automatisch mit dem externen Display 
synchronisiert (bei einer Auflösung von bis zu 1080p). Videos werden mit einer Auflösung von 
maximal 720p wiedergegeben.
Sie können den iPhone 4S-Bildschirm auch mithilfe der AirPlay-Synchronisierung und Apple TV 
mit dem Fernsehgerät synchronisieren. Weitere Informationen unter „AirPlay“ auf Seite 36.
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Sie können von Ihrem iPhone Videos löschen, um Speicherplatz zu sparen. Wenn Sie ein Video 
(ausgenommen geliehene Filme) vom iPhone löschen, wird das Video nicht aus Ihrer iTunesMediathek gelöscht. Möglicherweise wird es wieder auf dem iPhone angezeigt, wenn für Videos in 
iTunes weiterhin die Synchronisierung aktiviert ist.
Wichtig:  Wenn Sie einen geliehenen Film vom iPhone löschen, wird er dauerhaft gelöscht und 
kann nicht mehr zurück auf Ihren Computer übertragen werden.
Löschen eines Videos:  Streichen Sie in der Liste „Videos“ nach links oder rechts über das Video 
und tippen Sie auf „Löschen“.
Verwenden der Privatfreigabe
Mit der Funktion „Privatfreigabe“ können Sie Musik, Filme und Fernsehsendungen aus der iTunesMediathek auf Ihrem Computer oder PC auf dem iPhone wiedergeben. Weitere Informationen 
unter „Privatfreigabe“ auf Seite 91.
Festlegen eines Timers für den Ruhezustand
Sie können das iPhone so konfigurieren, dass die Wiedergabe von Musik oder Videos nach einer 
bestimmten Zeit gestoppt wird.
Festlegen eines Timers für den Ruhezustand: Tippen Sie in der App „Uhr“ auf „Timer“ und legen 
Sie durch Streichen mit dem Finger die gewünschten Stunden und Minuten fest. Tippen Sie auf 
„Timer-Ende“ und wählen Sie „iPhone-Ruhezustand“ aus. Tippen Sie dann auf „Einstellen“ und 
„Starten“, um den Timer zu starten.
Wenn der Timer abgelaufen ist, stoppt das iPhone die Musik- oder Videowiedergabe, schließt alle 
geöffneten Apps und aktiviert die Sperre.
Umwandeln von Videos für die Verwendung mit dem iPhone
Sie können auch Videos, die Sie nicht im iTunes Store gekauft haben, zum iPhone hinzufügen, 
wie Videos, die Sie mit iMovie auf einem Mac erstellt oder aus dem Internet geladen und dann 
zu iTunes hinzugefügt haben. Wenn Sie beim Hinzufügen eines Videos von iTunes auf das iPhone 
eine Meldung angezeigt bekommen, dass das Video nicht auf dem iPhone wiedergegeben 
werden kann, können Sie es konvertieren
Umwandeln eines Videos zur Wiedergabe auf dem iPhone:  Wählen Sie das Video in Ihrer 
iTunes-Mediathek aus und wählen Sie „Erweitert“ > „Version für iPod oder iPhone erstellen“. 
Übertragen Sie dann das umgewandelte Video auf das iPhone.
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Verwenden des Rechners
Addieren, subtrahieren, multiplizieren und dividieren Sie wie mit einem Standardtaschenrechner. 
Wenn Sie auf die Taste zum Addieren, Subtrahieren, Multiplizieren oder Dividieren tippen, wird 
ein weißer Ring um die Taste eingeblendet, um darauf hinzuweisen, dass die Rechenoperation 
ausgeführt wird.
Hinzufügen einer Zahl 
zum Speicher
Leeren des Speichers
Leeren der Anzeige
Subtrahieren einer Zahl 
aus dem Speicher
Einfügen einer Zahl aus 
dem Speicher (die weiße 
Umrandung zeigt an, 
dass eine Zahl 
gespeichert wurde)
Wissenschaftlicher Rechner
Drehen Sie das iPhone, um im Querformat den wissenschaftlichen Rechner anzuzeigen.
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Kompass
Der integrierte Kompass zeigt die Himmelsrichtung, der Sie zugewandt sind, und die 
geografischen Koordinaten Ihres aktuellen Standorts an. Sie können den magnetischen oder den 
geografischen Nordpol verwenden.
Wichtig:  Die Genauigkeit der digitalen Kompassmessungen kann durch magnetische 
Gegenstände und andere Umwelteinflüsse beeinträchtigt werden. Dazu zählen auch Interferenzen 
bei einem zu geringen Abstand zu den Magneten in den iPhone-Ohrhörern. Der digitale Kompass 
ist als Hilfsmittel für grundlegende Ortungs- und Navigationszwecke konzipiert und sollte nicht 
als alleinige Informationsquelle verwendet werden, wenn es darum geht, einen Standort, eine 
räumliche Nähe, eine Entfernung oder eine Richtung präzise zu bestimmen.
Wenn die Ortungsdienste deaktiviert sind, wenn Sie die App „Kompass“ öffnen, werden Sie 
zum Aktivieren der Dienste aufgefordert. Sie können den Kompass auch ohne aktivierte 
Ortungsdienste verwenden. Weitere Informationen unter „Ortungsdienste“ auf Seite 182.
Wählen des 
magnetischen oder 
geografischen Nordens
Aktuelle Position
Die Richtung, in die
das iPhone zeigt
Zeigen des aktuellen Standorts in „Karten“
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Sie müssen den Kompass vor der ersten Verwendung und möglicherweise auch später 
gelegentlich neu kalibrieren. Das iPhone benachrichtigt Sie, wenn eine erneute Kalibrierung 
erforderlich ist.
Kalibrieren des eingebauten Kompasses:  Bewegen Sie das iPhone in Form einer „8“.
Finden der Richtung
Finden der Richtung, in die das iPhone zeigt:  Halten Sie das iPhone waagerecht, d. h. parallel zur 
Erdoberfläche. Die Position wird oben im Bildschirm angezeigt, der Standort unten.
Umschalten zwischen 
geografischem und magnetischem 
Nordpol
Tippen Sie auf  .
Verwenden des Kompasses mit der App „Karten“
Mit der App „Kompass“ können Sie die App „Karten“ öffnen, um darin Ihren aktuellen Standort 
anzuzeigen. Weitere Informationen unter „Finden von Orten“ auf Seite 113.
Bestimmen des aktuellen Standorts in der App „Karten“:  Tippen Sie unten im KompassBildschirm auf  . „Karten“ wird geöffnet und zeigt Ihren aktuellen Standort blau markiert an.
Bestimmen der Himmelsrichtung, 
der Sie zugewandt sind
Tippen Sie in „Karten“ zweifach auf  . Das Symbol wird durch  ersetzt. 
Der Winkel veranschaulicht die Genauigkeit der Kompassmessung – je 
kleiner der Winkel ist, desto größer ist die Genauigkeit.
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Sprachmemos
Die App „Sprachmemos“ macht Ihr iPhone zu einem mobilen Sprachaufnahme- und Diktiergerät. 
Für die Aufnahme können Sie das eingebaute Mikrofon, das Mikrofon des iPhone- oder 
Bluetooth-Headsets oder ein unterstütztes externes Mikrofon verwenden. Aufnahmen mit dem 
eingebauten Mikrofon erfolgen in Mono. Mit einem externen Stereomikrofon können Sie auch 
Stereoaufnahmen machen.
Hinweis:  Externe Mikrofone müssen so ausgelegt sein, dass sie über den Kopfhörer- oder den 
Dockanschluss an das iPhone angeschlossen werden können. Diese Anforderung erfüllen zum 
Beispiel Originalohrhörer von Apple und Zubehörprodukte autorisierter Fremdfirmen, die das 
Logo „Made for iPhone“ oder „Works with iPhone“ tragen.
Aufnahme wiedergeben, anhalten oder stoppen
Aufnahmepegel 
Liste der 
Aufnahmen anzeigen
Aufnahme
Starten einer Aufnahme:  Tippen Sie auf  oder drücken Sie auf den iPhone-Kopfhörern die 
Mitteltaste. Tippen Sie auf  , um die Aufnahme unterbrechen, auf  , um sie zu stoppen, oder 
drücken Sie auf den iPhone-Kopfhörern die Mitteltaste.
150Anpassen des Aufnahmepegels Den Aufnahmepegel können Sie variieren, indem Sie den Abstand des 
Mikrofons zur Geräuschquelle verändern. Für eine Aufnahme in guter 
Qualität sollte der lauteste Pegel im Bereich zwischen -3 dB und 0 dB.
Wiedergeben bzw. Stummschalten 
des Start-/Stopp-Tons
Verwenden Sie den Schalter „Klingeln/Aus“ des iPhone. (In bestimmten 
Regionen wird der Soundeffekt für ein Sprachmemo auch wiedergegeben, 
wenn der Schalter „Klingeln/Aus“ auf „Aus“ eingestellt ist.)
Verwenden anderer Apps während 
einer Aufnahme
Drücken Sie die Home-Taste  und öffnen Sie eine App. Tippen Sie 
auf die rote Leiste am oberen Bildschirmrand, um zu „Sprachmemos“ 
zurückzukehren.
Anhören einer Aufnahme
Wiedergeben einer Aufnahme:  Tippen Sie auf  , tippen Sie auf ein Memo und tippen Sie dann 
auf  . Tippen Sie auf  , um das Memo anzuhalten.
Die Aufnahme 
zuschneiden oder 
umbenennen.
Anhören von Aufnahmen
Die Aufnahme an eine 
E-Mail oder SMS 
anhängen.
Bewegen, um zu einem 
beliebigen Punkt zu 
springen.
Wechseln zwischen Lautsprecher und Hörer
Springen zu einer beliebigen Stelle 
in einer Aufnahme
Bewegen Sie die Abspielposition auf der Navigationsleiste.
Verwenden des eingebauten 
iPhone-Lautsprechers anstatt des 
Empfängers
Tippen Sie auf „Lautsprecher“.
Trimmen einer Aufnahme Tippen Sie auf  neben der Aufnahme und dann auf „Memo kürzen“. 
Bewegen Sie die Ränder des Audiobereichs und tippen Sie auf  , um eine 
Hörprobe zu erhalten. Nehmen Sie bei Bedarf Änderungen vor und tippen 
Sie dann auf „Memo kürzen“, um die Aufnahme zu sichern. Die getrimmten 
Teile werden endgültig gelöscht.
Anzeigen und Freigeben von Aufnahmen
Aufnahmen verwenden als Titel die Uhrzeit, zu der sie erstellt wurden.
Benennen einer Aufnahme:  Tippen Sie neben der Aufnahme auf  , tippen Sie auf dem 
Infobildschirm auf  und legen Sie eine Bezeichnung fest bzw. wählen Sie eine aus.
Löschen einer Aufnahme Tippen Sie auf eine Aufnahme und danach auf „Löschen“.
Anzeigen der Aufnahmedetails Tippen Sie auf  neben der Aufnahme.
Versenden einer Aufnahme per 
E-Mail oder Textmitteilung
Tippen Sie auf eine Aufnahme und danach auf „Senden“.
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iTunes kann Sprachmemos mit Ihrer iTunes-Mediathek synchronisieren, wenn Sie das iPhone mit 
Ihrem Computer verbinden.
Die Sprachmemos verbleiben auch nach der Synchronisierung mit iTunes in der App 
„Sprachmemos“, bis Sie sie explizit löschen. Wenn Sie ein Sprachmemo vom iPhone löschen, wird 
es nicht automatisch auch aus der Wiedergabeliste für Sprachmemos in iTunes gelöscht. Wenn Sie 
ein Sprachmemo aus iTunes löschen, wird  es vom iPhone gelöscht, wenn Sie es das nächste Mal 
synchronisieren.
Synchronisieren von Sprachmemos mit iTunes:  Schließen Sie das iPhone an den Computer 
an und wählen Sie in der iTunes-Geräteliste iPhone. Wählen Sie oben im Bildschirm „Musik“ aus 
(zwischen „Apps“ und „Filme“), wählen Sie „Musik synchronisieren“, klicken Sie „Sprachmemos 
einbeziehen“ und anschließend „Anwenden“.
Die Sprachmemos von Ihrem iPhone werden in iTunes in der Wiedergabeliste „Sprachmemos“ 
angezeigt.
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Nike + iPod
In Verbindung mit dem (separat erhältlichen) „Nike + iPod“-Sensor gibt Ihnen die App „Nike + 
iPod“ während einer Trainingseinheit akustische Rückmeldungen über Ihre Geschwindigkeit, die 
zurückgelegte Wegstrecke, die dafür benötigte Zeit und die Anzahl der verbrauchten Kalorien. Sie 
können Ihre Trainingsdaten an nikeplus.com senden, um Ihren persönlichen Fortschritt verfolgen, 
Zielvorgaben festlegen und an Wettbewerben teilnehmen zu können.
Zeigen Sie Ihren 
Trainingsverlauf.
Kalibrieren Sie das Gerät 
entsprechend Ihres letzten 
Trainings.
Wählen Sie die Art 
des Trainings.
Wählen Sie ein 
Standardtraining.
Wählen Sie ein 
Training oder 
erstellen Sie eines.
Aktivieren der App „Nike + iPod“
Die App „Nike + iPod“ wird erst auf dem Home-Bildschirm angezeigt, wenn Sie sie aktivieren.
Hilfe beim Einrichten von „Nike + iPod“ finden Sie in der Dokumentation.
Aktivieren von „Nike + iPod“:  Wählen Sie „Einstellungen“ > „Nike + iPod“.
153Verbinden eines Sensors
„Nike + iPod“ erhält die Trainingsdaten über ein Signal, das von einem Sensor gesendet wird 
(separat erhältlich). Diesen können Sie an Ihrem Schuh befestigen. Wenn Sie zum ersten Mal ein 
Training starten, werden Sie aufgefordert, Ihren Sensor zu aktivieren. Bei diesem Vorgang wird 
der Sensor automatisch mit dem iPhone gekoppelt. Sie können einen Sensor auch über die 
Einstellung „Nike + iPod“ mit dem iPhone verbinden.
„Nike + iPod“ kann jeweils nur einen Sensor verbinden. Wenn Sie einen anderen Sensor benutzen 
möchten, verwenden Sie die Einstellungen „Nike + iPod“, um den neuen Sensor zu verbinden.
Verbinden Ihres Sensors mit dem iPhone:  Befestigen Sie den Sensor an Ihrem Schuh und öffnen 
Sie „Einstellungen“ > „Nike + iPod“ > „Sensor“.
Verbinden eines anderen Sensors 
mit dem iPhone
Öffnen Sie „Einstellungen“ > „Nike + iPod“ > „Sensor“ und tippen Sie auf 
„Neu verbinden“.
Training mit der App „Nike + iPod“
Nachdem Sie „Nike + iPod“ aktiviert und den „Nike + iPod“-Sensor in Ihren „Nike+“-bereiten Schuh 
gesteckt haben, können Sie Ihre Trainingsdaten erfassen.
Wichtig:  Bevor Sie mit dem Training starten, sollten Sie einen Arzt zu Rate ziehe und sich 
untersuchen lassen. Wärmen Sie sich auf und dehnen Sie sich, bevor Sie mit dem Training 
beginnen. Seien Sie während des Trainings aufmerksam und vorsichtig. Verlangsamen Sie bei 
Bedarf Ihr Tempo, bevor Sie beim Laufen Ihr Gerät anpassen. Sollten Sie Schmerzen verspüren 
oder sich schwindelig, erschöpft oder kurzatmig fühlen, beenden Sie Ihr Training umgehend. Sie 
tragen selbst das Risiko, das mit dem Training einhergeht, und sind verantwortlich für mögliche 
Verletzungen, die sich aus solchen Aktivitäten ergeben können.
Trainieren mit „Nike + iPod“:  Öffnen Sie „Nike + iPod“, tippen Sie auf „Trainings“ und wählen Sie 
ein Training aus. Auch wenn Ihr iPhone im Ruhezustand ist, werden die Daten erfasst.
Unterbrechen oder Fortsetzen des 
Trainings
Wenn Sie Ihr Training unterbrechen, tippen Sie im Sperrbildschirm des 
iPhone auf  . Tippen Sie auf  , wenn Sie loslegen möchten.
Beenden des Trainings Tippen Sie auf Ihrem iPhone auf  und dann auf „Training beenden“.
Ändern der Trainingseinstellungen Wählen Sie „Einstellungen“ > „Nike + iPod“.
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Um möglichst genaue Trainingsdaten zu erhalten, können Sie „Nike + iPod“ entsprechend der 
Länge der Strecke oder Ihres Geh- bzw. Laufschritts kalibrieren.
Kalibrieren von „Nike + iPod“:  Zeichnen Sie ein Training (Gehen oder Laufen) über eine bekannte 
Strecke von mindestens 400 Metern auf. Tippen Sie dann auf „Training beenden“, wählen Sie auf 
dem Bildschirm mit der Trainingszusammenfassung „Kalibrieren“ und geben Sie die zurückgelegte 
Strecke ein.
Zurücksetzen von „Nike + iPod“ auf 
die Standardkalibrierung
Wählen Sie „Einstellungen“ > „Nike + iPod“.
Senden von Trainingsdaten an nikeplus.com
Auf nikeplus.com können Sie Ihren Fortschritt über einen bestimmten Zeitraum erfassen, Ihre 
Trainings in der Vergangenheit anzeigen, Ihre Trainingsziele festlegen und im Auge behalten 
sowie Ihre Ergebnisse mit Anderen vergleichen. Sie können sogar gegen andere Nike + iPodBenutzer in Online-Wettkämpfen antreten.
Senden von Trainingsdaten an nikeplus.com über WLAN:  Öffnen Sie bei aktiver 
Internetverbindung „Nike + iPod“ auf dem iPhone, tippen Sie auf „Übersicht“ und dann auf „An 
Nike+ senden“.
Schauen Sie sich Ihren 
Trainingsverlauf auf nikeplus.com 
an.
Öffnen Sie in Safari nikeplus.com, melden Sie sich bei Ihrem Account an 
und befolgen Sie die angezeigten Anleitungen.
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iBooks
Die App „iBooks“ ist eine großartige Lösung, um Bücher zu lesen und zu kaufen. Laden Sie die 
kostenlose App aus dem App Store und kaufen oder laden Sie anschließend Bücher aller Art, von 
klassischer Literatur bis hin zu Bestsellern, im integrierten iBookstore. Sobald Sie ein Buch geladen 
haben, wird es auf Ihrem Bücherregal dargestellt. 
Sie benötigen eine Internetverbindung und eine Apple-ID, damit Sie die App „iBooks“ laden und 
den iBookstore verwenden können. Wenn Sie keine Apple-ID haben oder für einen Kauf eine 
andere Apple-ID verwenden wollen, können Sie „Einstellungen“ > „Store“ auswählen und die 
gewünschten Änderungen vornehmen. Weitere Informationen unter „Store-Einstellungen“ auf 
Seite 138.
Hinweis:  Die App „iBooks“ und der iBookstore stehen möglicherweise nicht in allen Sprachen und 
Regionen zur Verfügung.
Verwenden des iBookstore
Tippen Sie in der App „iBooks“ auf „Store“, um den iBookstore zu öffnen. Hier können Sie durch 
empfohlene und meistverkaufte Bücher blättern und Bücher nach Autor oder Thema suchen. 
Wenn Sie das gewünschte Buch gefunden haben, können Sie es kaufen und laden.
Hinweis:  Einige Funktionen des iBookstore sind nicht überall verfügbar.
Kaufen eines Buchs:  Finden Sie das gewünschte Buch, tippen Sie auf den Preis und dann auf 
„Buch kaufen“ oder auf „Buch laden“, wenn es kostenlos erhältlich ist.
Abrufen von Informationen über 
ein Buch
Sie können eine Zusammenfassung des Buchs lesen, eine Rezension lesen 
und eine Leseprobe des Buchs laden, bevor Sie das Buch kaufen. Nach dem 
Kauf eines Buchs können Sie selbst eine Rezension schreiben.
Laden einer zuvor gekauften App Tippen Sie auf „Käufe“.
Sie können einen Artikel auch erneut laden, während Sie den Store 
durchstöbern: Tippen Sie einfach auf „Laden“ (wo üblicherweise der Preis 
angezeigt wird).
Automatisches Laden von Käufen 
auf anderen Geräten oder 
Computern
Öffnen Sie „Einstellungen“ > „Store“ und legen Sie fest, welche Käufe 
automatisch geladen werden sollen.
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Verwenden Sie iTunes zum Synchronisieren Ihrer Bücher und PDFs zwischen iPhone und Ihrem 
Computer und zum Kaufen von Büchern im iTunes Store. Wenn das iPhone mit Ihrem Computer 
verbunden ist, können Sie im Bereich „Bücher“ die Objekte zum Synchronisieren auswählen. Ferner 
können Sie Bücher, die ohne Kopierschutz im ePub-Format erstellt wurden, und PDF-Dokumente 
zu Ihrer iTunes-Mediathek hinzufügen. Im Internet sind Bücher im PDF- und ePub-Format 
verfügbar.
Synchronisieren eines ePub-Buchs oder einer PDF auf dem iPhone:  Wählen Sie in iTunes 
„Ablage“ > „Zur Mediathek hinzufügen“ und anschließend die Datei. Wählen Sie das Buch oder die 
PDF im Bereich „Bücher“ in iTunes aus und starten Sie die Synchronisierung.
Um ein Buch oder eine PDF zu iBooks hinzuzufügen, ohne das Gerät synchronisieren zu müssen, 
schicken Sie sich die Datei per E-Mail von Ihrem Computer. Öffnen Sie auf dem iPhone die E-Mail, 
legen Sie den Finger auf den Anhang und wählen Sie „In „iBooks“ öffnen“ aus dem angezeigten 
Menü. 
Lesen von Büchern
Es ist einfach, ein Buch zu lesen. Zeigen Sie Ihr Bücherregal an und tippen Sie auf das Buch, das 
Sie lesen möchten. Wird das gewünschte Buch nicht angezeigt, tippen Sie oben im Bildschirm auf 
den Namen der aktuellen Sammlung, um weitere Sammlungen anzuzeigen.
Tippen für die 
Wiedergabe
Blättern zu einer 
anderen Seite
Hinzufügen eines 
Lesezeichens
Im Liegen lesen:  Damit Sie ein Buch auch im Liegen lesen können, verwenden Sie die 
Ausrichtungssperre für das Hochformat, um das iPhone daran zu hindern, die Anzeige zu 
drehen, wenn Sie das iPhone drehen. Weitere Informationen unter „Anzeigen im Hoch- oder 
Querformat“ auf Seite 23.
Jedes Buch verfügt über bestimmte Funktionen, die auf seinem Inhalt und Format basieren. Einige 
der unten beschriebenen Funktionen sind möglicherweise nicht in dem Buch vorhanden, das Sie 
gerade lesen. Die Druckfunktion ist zum Beispiel nur für PDFs verfügbar und wenn ein Buch keine 
gesprochene Erzählung enthält, wird das Symbol zum Vorlesen nicht angezeigt.
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Umblättern der Seite Tippen Sie auf den rechten oder linken Rand des Bildschirms oder streichen 
Sie mit dem Finger von links nach rechts über die Seite. Zum Ändern der 
Blätterrichtung beim Tippen auf den linken Rand wählen Sie „Einstellungen“ 
> „iBooks“ > „Auf linken Rand tippen“. 
Anzeigen des Inhaltsverzeichnisses Tippen Sie auf  . Bei einigen Büchern können Sie das Inhaltsverzeichnis 
auch durch Aufziehen anzeigen.
Einfügen oder Entfernen von 
Lesezeichen
Tippen Sie auf  . Sie können mehrere Lesezeichen verwenden. 
Zum Entfernen des Lesezeichens tippen Sie darauf.
Es ist nicht erforderlich, ein Lesezeichen zu setzen, wenn Sie ein Buch 
schließen, da sich iBooks die Seite merkt.
Einfügen oder Entfernen von 
Markierungen
Wählen Sie ein Wort durch Doppeltippen aus, passen Sie die Auswahl 
mithilfe der Aktivpunkte an und tippen Sie auf „Markieren“. Wählen Sie 
anschließend eine Farbe aus. 
Zum Entfernen einer Markierung tippen Sie auf den hervorgehobene Text 
und dann auf  . 
Zum Unterstreichen von Wörtern tippen Sie auf  . 
Zum Ändern der Farbe tippen Sie auf den hervorgehobenen Text und die 
aktuelle Farbe. Wählen Sie dann eine neue Farbe aus dem Menü aus.
Hinzufügen, Entfernen oder 
Bearbeiten von Notizen
Wählen Sie ein Wort durch Doppeltippen aus, tippen Sie auf „Markieren“ 
und wählen Sie  aus dem angezeigten Menü aus.
Zum Anzeigen der Notiz tippen Sie auf die Markierung, die am Rand des 
hervorgehobenen Textes angezeigt wird.
Zum Entfernen einer Notiz löschen Sie deren Text. Zum Entfernen einer Notiz 
und deren Markierung tippen Sie auf den hervorgehobenen Text und dann 
auf  . 
Zum Ändern der Farbe tippen Sie auf den hervorgehobenen Text und 
wählen dann eine Farbe aus dem Menü aus.
Zum Hinzufügen einer Notiz zu einer Markierung tippen Sie auf den 
hervorgehobenen Text und dann auf  .
Anzeigen aller Lesezeichen Tippen Sie auf  und anschließend auf „Lesezeichen“.
Anzeigen aller Notizen Tippen Sie auf  und anschließend auf „Notizen“.
Vergrößern eines Bildes Vergrößern Sie das Bild durch Doppeltippen.
Blättern zu einer bestimmten Seite Verwenden Sie die Bedienelemente für die Seitennavigation unten im 
Bildschirm. Oder tippen Sie auf  und geben Sie eine Seitenzahl ein. 
Tippen Sie dann auf die Seitenzahl in den Suchergebnissen.
Suchen im Buch Tippen Sie auf  . 
Für die Internetrecherche tippen Sie auf „Im Internet suchen“ oder auf „Mit 
Wikipedia suchen“. Safari wird geöffnet und zeigt die Ergebnisse an.
Suchen nach weitere Vorkommen 
eines Wortes oder Satzes
Wählen Sie ein Wort durch Doppeltippen aus, passen Sie die Auswahl 
mithilfe der Aktivpunkte an und tippen Sie im angezeigten Menü auf 
„Suchen“.
Nachschlagen eines Wortes Wählen Sie ein Wort durch Doppeltippen aus, passen Sie die Auswahl 
mithilfe der Aktivpunkte an und tippen Sie im angezeigten Menü auf 
„Nachschlagen“.
Definitionen stehen möglicherweise nicht in allen Sprachen zur Verfügung.
Anhören eines Buchs Tippen Sie auf  . 
Diese Funktion ist nicht bei allen Büchern verfügbar.
Wenn Ihr Sehvermögen eingeschränkt ist, können Sie VoiceOver nutzen 
und sich fast alle Bücher vorlesen lassen. Weitere Informationen unter 
„VoiceOver“ auf Seite 162.
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aktuellen Seiteninformationen, sodass Sie Ihre Bücher auf allen iOS-Geräten lesen können. iBooks 
sichert die Informationen für alle Bücher, wenn Sie die App öffnen bzw. schließen. Informationen 
einzelner Bücher werden ebenfalls gesichert, wenn Sie das Buch öffnen oder schließen.
Aktivieren oder Deaktivieren der Synchronisierung:  Wählen Sie „Einstellungen“ > „iBooks“.
Einige Bücher greifen auf Video- oder Audioinhalte zu, die im Internet gespeichert sind.
Aktivieren oder Deaktivieren des Online-Video- und Audiozugriffs:  Wählen Sie „Einstellungen“ > 
„iBooks“ > „Online Audio & Video“.
Hinweis:  Das iPhone verwendet ein Datennetzwerk. Für das Abspielen dieser Dateien können 
Gebühren des Anbieters anfallen.
Ändern des Erscheinungsbildes eines Buchs
Bei einigen Büchern können Sie Schriftgröße, Schriftart und Seitenfarbe ändern.
Ändern der Helligkeit:  Tippen Sie in die Mitte der aktuellen Seite, um die Bedienelemente 
anzuzeigen, und tippen Sie dann auf  . Wird  nicht angezeigt, tippen Sie erst auf  .
Ändern der Schriftart oder der 
Schriftgröße
Tippen Sie in die Mitte der aktuellen Seite, um die Bedienelemente 
anzuzeigen, und tippen Sie dann auf  . Tippen Sie auf „Schrift“, um eine 
Schriftart auszuwählen. Nicht alle Bücher unterstützen das Ändern der 
Schriftart.
Bei einigen Büchern kann die Schriftart nur geändert werden, wenn sich 
das iPhone im Hochformat befindet.
Ändern der Farbe von Seite und 
Text
Tippen Sie in die Mitte der aktuellen Seite, um die Bedienelemente 
anzuzeigen, und tippen Sie auf  . Tippen Sie dann auf „Thema“. Diese 
Einstellung ist für Bücher gültig, die dies unterstützen.
Aktivieren oder Deaktivieren der 
Ausrichtung und Worttrennung
Wählen Sie „Einstellungen“ > „iBooks“. Einige Bücher und PDFs unterstützen 
die Ausrichtung und Worttrennung nicht.
Drucken oder Versenden einer PDF per E-Mail
Mit iBooks können Sie die Kopie eines PDF-Dokuments per E-Mail versenden und das Dokument 
komplett oder in Auszügen auf einem unterstützten Drucker ausdrucken.
Sie können nur PDFs drucken oder per e-Mail versenden, nicht jedoch Bücher.
Versenden von PDFs per E-Mail:  Öffnen Sie die PDF, tippen Sie auf  und wählen Sie „Per 
E-Mail senden“. Daraufhin wird eine neue E-Mail mit der PDF als Anhang geöffnet. Tippen Sie auf 
„Senden“, wenn Sie die Adresse und Ihre Mitteilung eingegeben haben.
Drucken von PDFs Öffnen Sie die PDF, tippen Sie auf  und wählen Sie „Drucken“. Wählen 
Sie einen Drucker, einen Seitenbereich und die Anzahl der Kopien aus 
und tippen Sie auf „Drucken“. Weitere Informationen unter „Drucken“ auf 
Seite 30.
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Mithilfe des Bücherregals können Sie Ihre Bücher und PDFs durchsuchen. Ferner können Sie 
Objekte in Sammlungen verwalten.
Legen Sie Ihren Finger 
auf ein Buch, um es neu 
anzuordnen.
Zeigen Sie hier Ihre 
Sammlungen an.
Buch oder PDF in eine Sammlung bewegen:  Zeigen Sie das Bücherregal an und tippen Sie auf 
„Bearbeiten“. Tippen Sie auf die Objekte, die bewegt werden sollen, und dann auf „Bewegen“ und 
wählen Sie eine Sammlung aus.
Wenn Sie ein Buch oder eine PDF zu Ihrem Bücherregal hinzufügen, wird es der Sammlung 
„Bücher“ oder „PDFs“ hinzugefügt. Sie können das Objekt dann von hier aus in eine andere 
Sammlung bewegen. Sie können beispielsweise Sammlungen für Arbeit und Schule oder zu 
Referenzzwecken oder als Freizeitlektüre anlegen.
Anzeigen einer Sammlung Tippen Sie oben im Bildschirm auf den Namen der aktuellen Sammlung 
und wählen dann eine neue Sammlung aus der angezeigten Liste aus.
Verwalten von Sammlungen Tippen Sie auf den Namen der derzeit angezeigten Sammlung (z. B. 
„Bücher“ oder „PDFs“), um eine Liste der Sammlungen anzuzeigen.
Die integrierten Sammlungen „Bücher“ und „PDFs“ können nicht gelöscht 
werden. 
Sortieren des Bücherregals Zeigen Sie das Bücherregal an und tippen Sie auf die Statusleiste, um 
zum Anfang des Bildschirms zu blättern. Tippen Sie dann auf  , um 
eine Sortiermethode aus den unten im Bildschirm angezeigten Optionen 
auszuwählen.
Löschen eines Objekts aus dem 
Bücherregal
Tippen Sie auf „Bearbeiten“ und dann auf das Objekt (Buch oder PDF), das 
gelöscht werden soll, sodass ein Häkchen angezeigt wird. Tippen Sie auf 
„Löschen“. Tippen Sie abschließend auf „Fertig“. 
Wenn Sie ein gekauftes Buch löschen, können Sie es über den Bereich 
„Gekaufte Artikel“ erneut aus dem iBookstore laden.
Suchen nach einem Buch Zeigen Sie das Bücherregal an. Tippen Sie auf die Statusleiste, um im 
Bildschirm nach oben zu blättern. Tippen Sie dann auf  . Bei der Suche 
wird nach dem Buchtitel und dem Namen des Autors gesucht. 
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Funktionen der Bedienungshilfen
Das iPhone stellt zahlreiche Funktionen zur Bedienungshilfe bereit. Hierzu gehören:
Â VoiceOver
Â Audio-Routing für Anrufe
Â Siri
Â Zoomen
Â Großer Text
Â Weiß auf schwarz
Â Auswahl vorlesen
Â Auto-Text vorlesen
Â Mono-Audio und Balance
Â Hörgerätbetrieb (iPhone 4 GSM)
Â Eigene Vibrationen
Â LED-Blitz bei Hinweisen
Â AssistiveTouch
Â Unterstützung für Braillezeilen
Â Wiedergabe von Inhalten mit erweiterten Untertiteln
Mit Ausnahme von VoiceOver können diese Bedienungshilfen für die meisten Apps auf dem 
iPhone genutzt werden, auch für Apps von Drittanbietern, die Sie aus dem App Store geladen 
haben. VoiceOver funktioniert bei allen Apps, die auf dem iPhone vorinstalliert sind, sowie bei 
vielen anderen Apps von Drittanbietern.
Weitere Informationen zu Bedienungshilfen für das iPhone finden Sie unter www.apple.com/de/
accessibility.
Sie können einzelne Funktionen in den Einstellungen für die Bedienungshilfen auf dem iPhone 
aktivieren oder deaktivieren. Sie können einige Funktionen auch in iTunes aktivieren oder 
deaktivieren, wenn Ihr iPhone an den Computer angeschlossen ist. 
Aktivieren der Bedienungshilfen auf dem iPhone:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“.
Aktivieren der Bedienungshilfen mit iTunes:  Schließen Sie das iPhone an den Computer an 
und wählen Sie in der iTunes-Geräteliste „iPhone“. Klicken Sie auf „Übersicht“ und dann unten im 
Bildschirm auf „Bedienungshilfen konfigurieren“.
Die Option „Großer Text“ kann nur über die iPhone-Einstellungen aktiviert bzw. deaktiviert werden. 
Weitere Informationen unter „Großer Text“ auf Seite 175.
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VoiceOver liest vor, was auf dem Bildschirm angezeigt wird. So können Sie das iPhone benutzen, 
ohne es zu sehen.
VoiceOver liest Ihnen die verfügbaren Informationen für jedes Element vor, das auf dem 
Bildschirm ausgewählt wird. Wenn ein Element ausgewählt wird, wird es auf dem Bildschirm durch 
einen schwarzen Rahmen hervorgehoben, dem VoiceOver-Cursor. Gleichzeitig liest VoiceOver den 
Namen oder eine Kurzbeschreibung des Elements vor.
Berühren Sie den Bildschirm oder bewegen Sie Ihre Finger über den Bildschirm, um Informationen 
über verschiedene Elemente auf dem Bildschirm zu hören. Wenn Sie Text auswählen, liest 
VoiceOver den Text vor. Wenn die Option „Eingabe vorlesen“ aktiviert ist, liest VoiceOver entweder 
den Namen des Objekts vor oder aber Anleitungen für das weitere Vorgehen – z. B. „Doppeltippen, 
um Objekt zu öffnen“. Verwenden Sie die unter „Lernen von VoiceOver-Gesten“ auf Seite 165
beschriebenen Gesten, um mit den Bildschirmelementen, wie Schaltflächen und Links, zu 
interagieren.
VoiceOver informiert Sie mit einem akustischen Signal über jeden Bildschirmwechsel. Bei einem 
Wechsel wählt VoiceOver das erste Element im neuen Bildschirm aus und liest dessen Namen 
oder Kurzbeschreibung vor. (Normalerweise handelt es sich dabei um das Element in der linken 
oberen Ecke eines Bildschirms.) VoiceOver informiert Sie außerdem darüber, wenn die Anzeige 
vom Hoch- ins Querformat (oder umgekehrt) geändert wird und wenn ein Bildschirm gesperrt 
und wieder entsperrt wird.
Hinweis:  Für das Vorlesen verwendet VoiceOver die in den Landeseinstellungen festgelegte 
Sprache, wobei die für „Region“ festgelegte Einstellung („Einstellungen“ > „Allgemein“ > 
„Landeseinstellungen“ > „Region“) berücksichtigt wird. VoiceOver ist in vielen, jedoch nicht in allen 
Sprachen verfügbar.
Einrichten von VoiceOver
Wichtig:  VoiceOver ändert die Gesten, mit denen Sie das iPhone steuern. Nachdem Sie VoiceOver 
aktiviert haben, müssen Sie die speziellen VoiceOver-Gesten verwenden, um Ihr iPhone zu 
steuern. Dies gilt auch für die Geste, mit der Sie die VoiceOver-Funktion deaktivieren, um das 
Gerät wieder auf normale Weise bedienen zu können.
Hinweis:  Sie können die Funktionen „VoiceOver“ und „Zoomen“ nicht gleichzeitig verwenden.
Aktivieren oder Deaktivieren von VoiceOver:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“ > „VoiceOver“. Sie können auch festlegen, dass VoiceOver über die Funktion 
„Home-Dreifachklick“ aktiviert oder deaktiviert werden kann. Weitere Informationen unter „HomeDreifachklick“ auf Seite 174.
162 Kapitel 31    BedienungshilfenAktivieren und Deaktivieren 
gesprochener Hinweise
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“. Wenn die Option „Vorschläge vorlesen“ aktiviert ist, liest 
VoiceOver entweder die Aktion vor, die mit dem Element ausgeführt 
werden kann, oder aber Anleitungen für das weitere Vorgehen – z. B. 
„Doppeltippen, um Objekt zu öffnen“. Sie können die Option „Vorschläge“ 
auch zum Rotor hinzufügen und nach oben oder unten streichen, um 
Anpassungen vorzunehmen. Weitere Informationen unter „Verwenden der 
VoiceOver-Rotorsteuerung“ auf Seite 167.
Festlegen der Lesegeschwindigkeit 
für VoiceOver
Öffnen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > „VoiceOver“ 
aus und passen Sie den Regler „Lesegeschwindigkeit“ wie gewünscht an. 
Sie können die Option „Sprechtempo“ auch zum Rotor hinzufügen und 
nach oben oder unten streichen, um Anpassungen vorzunehmen. Weitere 
Informationen unter „Verwenden der VoiceOver-Rotorsteuerung“ auf 
Seite 167.
Festlegen der Art der Rückmeldung Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Eingabe vorlesen“.
Verwenden des 
Buchstabieralphabets beim 
Vorlesen der Eingabe
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Buchstabieralphabet“. Der Text wird Buchstabe für 
Buchstabe vorgelesen. VoiceOver spricht zunächst den ersten Buchstaben 
und dann das phonetische Äquivalent, zum Beispiel „B“ und dann „Berta“.
Tonhöhenänderung Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Tonhöhenänderung“. VoiceOver verwendet einen höheren 
Ton bei der Eingabe eines Buchstabens und einen tieferen Ton beim 
Löschen eines Buchstabens. VoiceOver verwendet einen höheren Ton auch, 
wenn es das erste Objekt einer Gruppe (etwa einer Liste oder Tabelle) 
vorliest, und einen tieferen Ton beim Vorlesen des letzten Objekts einer 
Gruppe.
Festlegen der Rotoroptionen Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Rotor“. Tippen Sie, um Optionen auszuwählen bzw. deren 
Auswahl aufzuheben, oder legen Sie Ihren Finger auf  , um ein Element 
an eine andere Position zu bewegen.
Ändern der VoiceOver-Aussprache Wählen Sie für den Rotor den Sprachmodus aus und streichen Sie dann 
nach oben oder unten. Der Sprachenrotor ist immer dann verfügbar, wenn 
Sie mehr als eine Aussprache ausgewählt haben.
Auswählen einer der im 
Sprachenrotor verfügbaren 
Aussprachen
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Sprachenrotor“. Um die Position einer Sprache in der Liste zu 
ändern, ziehen Sie  nach oben oder unten.
Ändern der Sprache für das iPhone Wählen Sie „Einstellungen“ > „Allgemein“ > „Landeseinstellungen“ > 
„Sprache“. Einige Sprachen werden zusätzlich durch die Einstellung unter 
„Region“ („Einstellungen“ > „Allgemein“ > „Landeseinstellungen“ > „Region“) 
beeinflusst.
Überspringen von Bildern beim 
Navigieren
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Bilder navigieren“. Sie können entweder alle Bilder 
überspringen oder nur diejenigen, für die keine Beschreibung vorhanden 
ist.
Vorlesen von Mitteilungen bei 
entsperrtem iPhone
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Mitteilungen vorlesen“. Ist diese Option deaktiviert, spricht 
das iPhone nur, wenn Sie es entsperren.
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Auswählen von Elementen im Bildschirm:  Bewegen Sie Ihren Finger über den Bildschirm. 
VoiceOver liest Ihnen dabei den Namen oder die Beschreibung jedes Elements vor, das Sie 
berühren. Sie können systematisch von einem Element zum jeweils nächsten bzw. vorherigen 
navigieren, indem Sie mit einem Finger nach rechts oder links streichen. Die Auswahl der 
Elemente erfolgt von links nach rechts und von oben nach unten. Durch das Streichen nach 
rechts gelangen Sie zum jeweils nächsten Element, durch das Streichen nach links zum jeweils 
vorherigen Element.
Aktivieren der vertikalen 
Navigation
Sie können die Option „Vertikale Navigation“ auch zum Rotor hinzufügen, 
diese dort auswählen und nach oben oder unten streichen, um die Position 
zu ändern. Weitere Informationen unter „Verwenden der VoiceOverRotorsteuerung“ auf Seite 167.
Auswählen des ersten oder letzten 
Objekts auf dem Bildschirm
Streichen Sie mit vier Fingern nach oben oder unten.
Entsperren des iPhone Wählen Sie den Schalter „Entsperren“ aus und heben Sie die Sperre durch 
Doppeltippen auf den Bildschirm auf.
Auswählen eines Objekts nach 
Namen
Tippen Sie mit zwei Fingern dreifach auf eine beliebige Stelle des 
Bildschirms, um die Objektauswahl zu öffnen. Geben Sie dann den Namen 
in das Suchfeld ein oder streichen Sie nach links oder rechts, um die 
Liste alphabetisch durchzugehen. Alternativ können Sie auch auf den 
Tabellenindex rechts tippen und nach oben oder unten gehen.
Ändern des Bildschirmnamens für 
ein schnelleres Finden
Tippen Sie mit zwei Fingern auf eine beliebige Stelle des Bildschirms und 
lassen Sie sie darauf liegen.
Sprechen des Textes des ausgewählten Objekts:  Streichen Sie mit einem Finger nach oben oder 
unten, um das nächste oder vorherige Wort oder Zeichen vorzulesen. (Drehen Sie den Rotor, um 
Zeichen oder Wörter auszuwählen.) Es kann auch das Buchstabieralphabet verwendet werden. 
Weitere Informationen unter „Einrichten von VoiceOver“ auf Seite 162.
Stoppen der Vorlesefunktion für ein 
Element
Tippen Sie einmal mit zwei Fingern. Tippen Sie erneut mit zwei Fingern, um 
die Vorlesefunktion wieder zu aktivieren. Bei der Auswahl eines anderen 
Elements wird die Vorlesefunktion automatisch wieder aufgenommen.
Ändern der Sprechlautstärke Verwenden Sie die Lautstärketasten des iPhone oder fügen Sie die Option 
„Lautstärke“ zum Rotor hinzu und streichen Sie nach oben oder unten, um 
Anpassungen vorzunehmen. Weitere Informationen unter „Verwenden der 
VoiceOver-Rotorsteuerung“ auf Seite 167.
Stummschalten von VoiceOver Tippen Sie zweimal mit drei Fingern. Tippen Sie erneut zweimal mit 
drei Fingern, um das Vorlesen wieder zu aktivieren. Bringen Sie den 
Schalter „Klingeln/Aus“ in die Position „Aus“, wenn Sie die VoiceOver-Töne 
ausschalten wollen. Wenn eine externe Tastatur angeschlossen ist, können 
Sie auch die Taste „ctrl“ auf der Tastatur drücken, um die Stummschaltung 
von VoiceOver zu aktivieren bzw. zu deaktivieren.
Ändern der Lesestimme Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Kompakte Stimme verwenden“.
Vorlesen des gesamten Bildschirms 
von oben
Streichen Sie mit zwei Fingern nach oben über den Bildschirm.
Vorlesen ab dem aktuellen Element 
bis zum Ende des Bildschirms
Streichen Sie mit zwei Finger nach unten über den Bildschirm.
Sprechen der iPhoneStatusinformationen
Tippen Sie oben auf den Bildschirm, um sich Informationen zu Uhrzeit, 
Batteriestatus, WLAN-Signalstärke etc. ansagen zu lassen.
Tippen auf ein ausgewähltes Element bei aktivierter VoiceOver-Funktion:  Tippen Sie zweimal 
an einer beliebigen Stelle auf den Bildschirm.
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ausgewähltes Element bei 
aktivierter VoiceOver-Funktion:
Tippen Sie dreimal an einer beliebigen Stelle auf den Bildschirm.
Anpassen eines Schiebereglers Streichen Sie mit einem Finger nach oben über den Bildschirm, um die 
Einstellung zu erhöhen, und nach unten, um die Einstellung zu verringern. 
VoiceOver liest Ihnen die jeweils ausgewählte Einstellung vor.
Blättern in einer Liste oder einem 
Bereich des Bildschirms
Streichen Sie mit drei Fingern nach oben oder unten über den Bildschirm. 
Streichen Sie nach unten, um seitenweise nach unten durch die Liste oder 
den Bildschirm zu blättern, oder nach oben, um seitenweise nach oben zu 
blättern. Beim Blättern in einer Liste liest VoiceOver den aktuell angezeigten 
Abschnitt von Elementen vor (Beispiel: „es werden die Reihen 5 bis 10 
angezeigt“). Sie können auch fortlaufend durch eine Liste blättern, anstatt 
sie seitenweise anzuzeigen. Tippen Sie zweimal und halten Sie die Finger 
auf dem Bildschirm, bis Sie eine Tonfolge hören. Bewegen Sie den Finger 
dann nach oben oder unten, um in der Liste zu blättern. Wenn Sie den 
Finger anheben, wird der fortlaufende Blättervorgang beendet.
Verwenden eines Listenindex Einige Listen verfügen über einen alphabetisch sortierten Index, der an 
der rechten Seite angezeigt wird. Der Index kann nicht durch Streichen 
ausgewählt werden, sondern nur durch direktes Antippen. Nachdem der 
Index ausgewählt wurde, können Sie durch Streichen nach oben oder 
unten durch den Index blättern. Sie können auch zweimal tippen und dann 
den Finger nach oben oder unten streichen.
Neuanordnen einer Liste Einige Listen wie die Liste „Favoriten“ in der App „Telefon“ und die Listen 
„Rotor“ und „Sprachenrotor“ in den Einstellungen für die Bedienungshilfen 
können neu angeordnet werden. Wählen Sie  rechts neben einem 
Objekt, doppeltippen und halten Sie, bis Sie einen Ton hören, und ziehen 
Sie das Objekt dann nach oben oder unten. Abhängig von der Richtung, in 
die Sie das Objekt bewegt haben, liest VoiceOver vor, ob es nach oben oder 
unten bewegt wurde.
Neuanordnen des HomeBildschirms
Wählen Sie im Home-Bildschirm das Symbol aus, das Sie bewegen 
möchten. Tippen Sie zweimal auf das Symbol, halten Sie den Finger darauf 
und bewegen Sie es anschließend. VoiceOver liest beim Bewegen des 
Symbols die Zeilen und Spalten der aktuellen Position vor. Lassen Sie das 
Symbol los, wenn es sich an der gewünschten Position befindet. Sie können 
weitere Symbole bewegen. Bewegen Sie ein Objekt an den linken oder 
rechten Rand des Bildschirms, um es auf eine andere Seite des HomeBildschirms zu bewegen. Drücken Sie die Home-Taste  , wenn Sie fertig 
sind.
Aktivieren oder Deaktivieren des 
Bildschirmvorhangs
Tippen Sie dreimal mit drei Fingern. Wenn der Bildschirmvorhang aktiviert 
ist, ist der Bildschirminhalt aktiv, obwohl der Bildschirm ausgeschaltet ist.
Entsperren des iPhone Wählen Sie den Schalter „Entsperren“ aus und heben Sie die Sperre durch 
Doppeltippen auf den Bildschirm auf.
Lernen von VoiceOver-Gesten
Wenn VoiceOver aktiviert ist, führen die für den Touchscreen definierten standardmäßigen Gesten 
zu anderen Ergebnissen, da VoiceOver für die Navigation im Bildschirm und für die Steuerung 
ausgewählter Elemente neben den Standardgesten zusätzliche Gesten unterstützt. Zu den 
VoiceOver-Gesten gehören das Tippen und das Streichen mit zwei oder mit drei Fingern. Optimale 
Ergebnisse bei der Verwendung von Gesten mit zwei und drei Fingern erreichen Sie, indem Sie die 
Finger entspannt und mit etwas Abstand auf dem Bildschirm bewegen.
Sie können auch Standardgesten verwenden, wenn VoiceOver aktiviert ist, indem Sie zweimal 
tippen und den Finger auf dem Bildschirm halten. Durch eine Abfolge von Tönen wird 
angegeben, dass nun die Standardgesten aktiviert sind. Diese bleiben so lange aktiviert, bis Sie 
den Finger anheben. Danach sind wieder die VoiceOver-Gesten aktiviert.
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Tippen mit zwei Fingern zwei Finger derselben Hand oder alternativ je einen Finger der rechten 
und der linken Hand verwenden. Auch die Daumen können Sie dafür verwenden. Viele Benutzer 
finden die Geste „geteiltes Tippen“ besonders nützlich: Statt ein Objekt durch Doppeltippen 
auszuwählen, können Sie mit einem Finger auf ein Element und mit einem zweiten Finger auf 
den Bildschirm tippen. Testen Sie die verschiedenen Möglichkeiten, um zu sehen, welche für Ihre 
Zwecke am besten geeignet ist.
Funktionieren Ihre Gesten nicht, bewegen Sie die Finger schneller, speziell bei Gesten mit 
Doppeltipp- und Streichbewegungen. Streichen Sie mit einem oder mehreren Fingern schnell 
über den Bildschirm. Wenn VoiceOver aktiviert ist, wird die Taste „VoiceOver-Übungen“ angezeigt. 
Hiermit können Sie die VoiceOver-Gesten zunächst üben, bevor Sie sie verwenden.
Üben von Gesten: Öffnen Sie den Bereich „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“. Tippen Sie dann auf „VoiceOver-Übungen“. Tippen Sie abschließend auf „Fertig“.
Wird die Taste „VoiceOver-Übungen“ nicht angezeigt, stellen Sie sicher, dass VoiceOver aktiviert ist.
Nachfolgend finden Sie einen Überblick über wichtige VoiceOver-Gesten:
Navigieren und Lesen
Â Tippen: Ausgewähltes Element vorlesen
Â Nach links oder rechts streichen: Auswählen des nächsten oder vorherigen Elements
Â Nach oben oder unten streichen: Abhängig von den Einstellungen der Rotorsteuerung Weitere 
Informationen unter „Verwenden der VoiceOver-Rotorsteuerung“ auf Seite 167.
Â Mit zwei Fingern tippen: Stoppen der Vorlesens eines Elements
Â Nach oben streichen mit zwei Fingern: Vorlesen des gesamten Bildschirm von oben
Â Nach unten streichen mit zwei Fingern: Vorlesen von der aktuellen Auswahl an
Â Zickzack-Geste mit zwei Fingern: Dreimaliges schnelles Hin- und Herbewegen (wie ein Z) von 
zwei Fingern, um eine Warnung zu ignorieren oder zum vorherigen Bildschirm zurückzukehren
Â Mit zwei Fingern dreifach tippen: Öffnet die Objektauswahl
Â Nach oben oder unten streichen mit drei Fingern: Blättern einer Seite
Â Nach rechts oder links streichen mit drei Fingern: Zur nächsten bzw. vorherigen Seite wechseln 
(zum Beispiel zum Home-Bildschirm, zum Bildschirm „Aktien“ oder zum Bildschirm „Safari“)
Â Mit drei Fingern tippen: Ansagen weiterer Informationen, wie die Position in einer Liste oder die 
Auswahl von Text
Â Mit vier Fingern oben auf den Bildschirm tippen: Auswählen des ersten Objekts auf der Seite
Â Mit vier Fingern unten auf den Bildschirm tippen: Auswählen des letzten Objekts auf der Seite
Aktivieren
Â Doppeltippen: Aktivieren des gewählten Objekts
Â Dreifachtippen: Öffnen eines Objekts (vergleichbar mit Doppeltippen)
Â Geteiltes Tippen: Alternative zum Auswählen eines Objekts durch Doppeltippen. Hierbei wird 
ein Objekt aktiviert, indem mit einem Finger auf ein Element und mit einem zweiten Finger auf 
den Bildschirm getippt wird.
Â Tippen mit einem Finger auf ein Element und mit einem zweiten Finger auf den Bildschirm („geteiltes 
Tippen“): Aktivieren des Objekts
Â Doppeltippen und halten (1 Sekunde) + Standardgeste: Verwenden einer Standardgeste
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Standardgeste verwendet werden soll. Sie können zum Beispiel die Stellung eines Schalters 
ändern, indem Sie doppeltippen und nach kurzem Halten und ohne Abheben des Fingers Ihren 
Finger bewegen.
Â Mit zwei Fingern doppeltippen: Beantworten oder Beenden eines Anrufs Unterbrechen der 
Wiedergabe und Wiedergabe von Musiktiteln in den Apps „Musik“, „Videos“, „YouTube“, 
„Sprachmemos“ oder „Fotos“. Foto aufnehmen (Kamera), Aufnahme starten oder stoppen 
(Kamera oder Sprachmemos) Stoppuhr starten oder stoppen
Â Mit zwei Fingern doppeltippen und halten: Beschriften eines Elements
Â Mit zwei Fingern dreifach tippen: Öffnet die Objektauswahl
Â Mit drei Fingern doppeltippen: Aktivieren bzw. Deaktivieren der VoiceOver-Stummschaltung
Â Mit drei Fingern dreifachtippen: Aktivieren oder Deaktivieren des Bildschirmvorhangs
Verwenden der VoiceOver-Rotorsteuerung
Bei der Rotorsteuerung handelt es sich um eine virtuelle „Wählscheibe“, mit der Sie das Ergebnis 
beeinflussen können, das Sie durch Streichen nach oben oder nach unten erzielen. Diese Funktion 
steht nur zur Verfügung, wenn VoiceOver aktiviert ist.
Bedienen des Rotors: Legen Sie zwei Finger auf den Bildschirm des iPhone und drehen Sie die 
Hand.
Ändern der im Rotor angezeigten Optionen:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“ > „VoiceOver“ > „Rotor“ und wählen Sie die Optionen, die im Rotor verfügbar 
sein sollen.
Die Funktionsweise des Rotors hängt von der Aktion ab, die Sie ausführen. Wenn Sie sich den Text 
einer empfangenen E-Mail-Nachricht vorlesen lassen, können Sie mit dem Rotor festlegen, dass 
beim Streichen nach oben oder unten der Wechsel vom wortweisen zum zeichenweisen Vorlesen 
(und umgekehrt) erfolgen soll. Wenn Sie eine Webseite durchblättern, können Sie mit dem Rotor 
festlegen, dass Sie den kompletten Text (Wort für Wort oder Zeichen für Zeichen) hören wollen 
oder von einem Element eines bestimmten Typs (z. B. Überschriften oder Links) zum jeweils 
nächsten Element desselben Typs springen wollen.
Lesen von Text
Auswählen und Vorlesen von Text:
Â Zeichen, Wort oder Zeile
Sprechen
Anpassen der VoiceOver Sprachausgabe:
Â Lautstärke oder Geschwindigkeit
Â Verwenden der Wiedergabe der Texteingabe, der Tonhöhenänderung oder des 
Buchstabieralphabets (mit dem Apple Wireless Keyboard)
Weitere Informationen unter „Steuern von VoiceOver mit einem Apple Wireless Keyboard“ auf 
Seite 171.
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Auswählen und Vorlesen von Objekten:
Â Zeichen, Wort oder Zeile
Â Überschrift
Â Link, besuchter Link, nicht besuchter Link oder In-Page-Link
Â Bedienelemente für Formulare
Â Tabelle oder Zeile (beim Navigieren in einer Tabelle)
Â Liste
Â Sehenswürdigkeit
Â Bild
Â Statischer Text
Â Elemente des gleichen Typs
Â Tasten
Â Textfelder
Â Suchfelder
Â Container (Bildschirmbereiche wie das Dock)
Verkleinern oder Vergrößern
Eingeben von Text
Bewegen der Einfügemarke und Vorlesen von Text:
Â Zeichen, Wort oder Zeile
Auswählen der Bearbeitungsfunktion
Auswählen einer Sprache
Verwenden eines Steuerelements 
Auswählen und Vorlesen von Text:
Â Zeichen, Wort oder Zeile
Anpassen des Werts des Steuerungsobjekts
Eingeben und Bearbeiten von Text mit VoiceOver
Wenn Sie mit VoiceOver ein Textfeld auswählen, können Sie die virtuelle oder eine externe 
Tastatur verwenden, die an das iPhone angeschlossen wird, um Text einzugeben.
Es gibt zwei Möglichkeiten, Text in VoiceOver einzugeben – normales Tippen und Tippen durch 
Berühren. Beim normalen standardmäßigen Tippen wählen Sie eine Taste aus und geben das 
Zeichen durch Doppeltippen auf den Bildschirm ein. Beim Tippen durch Berühren wird die Taste 
durch Berühren ausgewählt und beim Anheben des Fingers automatisch eingegeben. Diese 
Methode kann zwar schneller sein, erfordert jedoch mehr Übung als das herkömmliche Tippen.
Mit VoiceOver können Sie außerdem die Bearbeitungsfunktionen des iPhone verwenden, um 
Inhalt im Textfeld auszuschneiden, zu kopieren oder einzusetzen.
Eingeben von Text:  Wählen Sie ein bearbeitbares Textfeld aus. Tippen Sie dann zweimal, um die 
Einfügemarke anzuzeigen und die Bildschirmtastatur einzublenden, und geben Sie dann Zeichen 
ein.
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um eine Taste auf der Tastatur auszuwählen, und wählen Sie die gewünschte Taste durch 
Doppeltippen aus, um das entsprechende Zeichen einzugeben. Sie können alternativ auch 
einen Finger über die Tastatur bewegen, den Finger auf der gewünschten Taste halten und mit 
einem zweiten Finger auf den Bildschirm tippen. VoiceOver liest das Zeichen ein erstes Mal vor, 
wenn Sie es auswählen, und ein weiteres Mal, nachdem das Zeichen eingegeben wurde.
Â Zehnfingersystem:  Berühren Sie eine Taste auf der Tastatur, um sie auszuwählen. Heben Sie dann 
Ihren Finger an, um das Zeichen einzugeben. Haben Sie die falsche Taste berührt, bewegen 
Sie Ihren Finger auf der Tastatur, bis die gewünschte Taste ausgewählt ist. VoiceOver liest das 
Zeichen für jede Taste vor, die Sie berühren. Das Zeichen wird aber erst eingegeben, wenn Sie 
Ihren Finger anheben.
Hinweis:  Diese Art der Texteingabe funktioniert nur bei Tasten, mit denen Text eingegeben 
wird. Verwenden Sie die Standardmethode für andere Tasten wie die Umschalttaste, 
Rückschritttaste und Zeilenschalter.
Bewegen der Einfügemarke:  Streichen Sie nach oben oder unten über den Bildschirm, um die 
Einfügemarke innerhalb des Textes nach vorne oder nach hinten zu versetzen. Verwenden Sie 
den Rotor, um auszuwählen, ob Sie die Einfügemarke zeichen-, wort- oder zeilenweise bewegen 
möchten. VoiceOver informiert Sie mit einem akustischen Signal, wenn die Einfügemarke bewegt 
wird, und liest das entsprechende Zeichen, das Wort oder die Zeile vor. 
Bei der Vorwärtsbewegung wird die Einfügemarke am Ende des Wortes platziert, über 
das sie bewegt wird, und vor dem Leerzeichen oder Satzzeichen, das darauf folgt. Bei der 
Rückwärtsbewegung wird die Einfügemarke am Ende des Wortes platziert, über das sie bewegt 
wird, und vor dem Leerzeichen oder Satzzeichen, das darauf folgt. Wenn Sie die Einfügemarke 
hinter das Satzzeichen am Wort- oder Satzende bewegen wollen, wechseln Sie mithilfe des 
Rotors in den Modus für die zeichenweise Bewegung. Wird die Einfügemarke zeilenweise bewegt, 
liest VoiceOver jede Zeile vor, über die sie bewegt wurde. Bei der Vorwärtsbewegung wird 
die Einfügemarke am Anfang der nächsten Zeile platziert (es sei denn, es handelt sich um die 
letzte Zeile des Absatzes, die Einfügemarke wird dann zum Ende der Zeile bewegt, die gerade 
vorgelesen wurde). Bei der Rückwärtsbewegung wird die Einfügemarke an den Anfang der Zeile 
gestellt, die vorgelesen wird.
Wählen der Standardmethode oder 
Tippen durch Berühren
Wenn VoiceOver aktiviert und eine Taste auf der Tastatur ausgewählt ist, 
können Sie mit dem Rotor den Schreibmodus auswählen und dann mit 
dem Finger nach oben oder unten streichen.
Löschen eines Zeichens Wählen Sie den Schalter  aus und heben Sie die Sperre durch Doppel- 
oder geteiltes Tippen auf den Bildschirm auf. Dies ist auch beim Tippen 
durch Berühren erforderlich. Zum Löschen mehrerer Zeichen berühren 
und halten Sie die Taste „Löschen“ und tippen mit einem anderen Finger 
auf den Bildschirm (einmal auf jedes Zeichen, das gelöscht werden soll). 
VoiceOver liest das Zeichen vor, das gelöscht wird. Wenn die Funktion 
„Tonhöhenänderung“ aktiviert ist, liest VoiceOver die gelöschten Zeichen in 
einem tieferen Ton.
Text auswählen Wählen Sie für den Rotor den Bearbeitungsmodus aus, streichen Sie 
mit dem Finger nach oben oder unten, um die Funktionen „Auswählen“ 
oder „Alle auswählen“ zu verwenden, und tippen Sie dann zweimal. Bei 
Verwendung von „Auswählen“ wird beim Doppeltippen das Wort direkt 
neben der Einfügemarke ausgewählt. Bei Verwendung von „Alle auswählen“ 
wird der gesamte Text ausgewählt. Ziehen Sie zwei Finger auf oder zu, um 
die Auswahl zu erweitern oder zu verringern.
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Einsetzen
Vergewissern Sie sich, dass mit dem Rotor der Bearbeitungsmodus 
ausgewählt wurde. Streichen Sie, wenn Text ausgewählt ist, nach oben oder 
unten, um „Ausschneiden“, „Kopieren“ oder „Einsetzen“ auszuwählen. Tippen 
Sie dann zweimal.
Widerrufen Schütteln Sie das iPhone bzw. streichen Sie nach links oder rechts, um eine 
Aktion rückgängig zu machen, und tippen Sie zweimal.
Eingeben eines diakritischen 
Zeichens
Wählen Sie im Standardeingabemodus die Taste mit dem entsprechenden 
Grundzeichen aus. Tippen Sie zweimal auf die Taste und lassen Sie den 
Finger auf der Taste, bis Sie durch ein akustisches Signal informiert werden, 
dass die Leiste mit den alternativen diakritischen Zeichen zu sehen ist. 
Bewegen Sie danach den Finger nach links oder rechts, um die alternativen 
Zeichen auszuwählen und vorlesen zu lassen. Heben Sie Ihren Finger ab, 
um das aktuell ausgewählte Zeichen einzugeben.
Ändern der Sprache für die Eingabe Wählen Sie für den Rotor den Sprachmodus aus und streichen Sie dann 
nach oben oder unten. Wählen Sie die Standardsprache, um die in den 
Landeseinstellungen festgelegte Sprache zu verwenden. Die Sprachenliste 
wird nur angezeigt, wenn Sie mehrere Sprachen in der VoiceOverEinstellung für die Sprachenliste gewählt haben. Weitere Informationen 
unter „Einrichten von VoiceOver“ auf Seite 162.
Anrufen mit VoiceOver
Tippen Sie mit zwei Fingern zweimal auf den Bildschirm, um einen Anruf anzunehmen oder zu 
beenden. Wenn Sie mit VoiceOver anrufen, wird statt den Anrufoptionen standardmäßig die 
numerische Tastatur eingeblendet. Hierdurch können Sie einfacher die verschiedenen Optionen 
mit der Tastatur auswählen, wenn Sie mit einem automatischem System verbunden sind.
Anzeigen der Anrufoptionen: Wählen Sie die Taste „Zurück“ unten rechts aus und tippen Sie 
zweifach darauf.
Erneutes Anzeigen der numerischen Tastatur: Wählen Sie die Taste „Tastatur“ in der Mitte des 
Bildschirms aus und tippen Sie zweifach darauf.
Verwenden von VoiceOver mit Safari
Wenn Sie Safari zum Suchen im Internet mit aktiviertem VoiceOver verwenden, können Sie mit 
dem Rotor für die Suchergebnisse eine Liste der vorgeschlagenen Suchbegriffe anhören.
Suchen im Web  Wählen Sie das Suchfeld, geben Sie einen Suchbegriff ein und wählen Sie 
mithilfe des Rotors „Suchergebnisse“. Streichen Sie mit dem Finger nach rechts oder links, um in 
der Liste nach oben oder unten zu blättern, und doppeltippen Sie dann auf den Bildschirm, um im 
Internet nach dem aktuellen Suchbegriff zu suchen.
Verwenden von VoiceOver mit der App „Karten“
Mithilfe von VoiceOver können Sie Karten durch Zoomen vergrößern oder verkleinern, 
Stecknadeln auswählen und Informationen zu Orten abrufen.
Verkleinern oder Vergrößern: Wählen Sie mit dem Rotor den Zoom-Modus aus und streichen Sie 
dann nach oben oder unten, um ein- oder auszuzoomen.
Auswählen einer Stecknadel: Tippen Sie auf eine Stecknadel oder streichen Sie nach links oder 
rechts, um von einer Stecknadel zu nächsten zu wechseln. 
Abrufen von Informationen über einen Ort: Tippen Sie zweimal auf eine ausgewählte 
Stecknadel, um die zugehörigen Informationen einzublenden. Streichen Sie nach links oder rechts, 
um die Taste „Weitere Infos“ auszuwählen, und tippen Sie dann zweimal, um die Informationsseite 
zu öffnen.
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Mithilfe von VoiceOver-Gesten können Sie Kameravideos und Sprachmemos kürzen.
Kürzen eines Sprachmemos: Wählen Sie im Bildschirm „Sprachmemos“ die Taste rechts neben 
dem Sprachmemo aus, das Sie kürzen möchten, und tippen Sie zweimal. Wählen Sie dann „Memo 
kürzen“ und tippen Sie erneut zweimal. Wählen Sie den Anfang oder das Ende des Werkzeugs 
zum Kürzen aus. Streichen Sie nach oben für eine Bewegung nach rechts oder nach unten für eine 
Bewegung nach links. VoiceOver gibt an, um wie viel die Aufnahme mit der aktuellen Position des 
Werkzeugs gekürzt wird. Möchten Sie die Kürzung vornehmen, wählen Sie „Sprachmemo kürzen“ 
und tippen Sie zweimal.
Trimmen eines Videos: Wenn Sie in „Fotos“ ein Video anschauen, tippen Sie zweimal auf den 
Bildschirm, um die Bedienelemente anzuzeigen, und wählen Sie dann den Anfang bzw. das 
Ende des Werkzeugs zum Kürzen. Streichen Sie nach oben für eine Bewegung nach rechts oder 
nach unten für eine Bewegung nach links. VoiceOver gibt an, um wie viel die Aufnahme mit der 
aktuellen Position des Werkzeugs gekürzt wird. Möchten Sie die Kürzung vornehmen, wählen Sie 
„Trimmen“ und tippen Sie zweimal.
Steuern von VoiceOver mit einem Apple Wireless Keyboard
Sie können zur Eingabe von Text auf dem iPhone auch ein Apple Wireless Keyboard verwenden. 
Weitere Informationen unter „Verwenden eines Apple Wireless Keyboard“ auf Seite 29.
Mit den VoiceOver-Tastaturbefehlen können Sie auf dem Bildschirm navigieren, Elemente 
auswählen, Bildschirminhalte lesen, den Rotor anpassen und andere VoiceOver-Aktionen 
ausführen. Alle Tastaturbefehle (außer einem) umfassen die Tastenkombination „ctrl-Wahl“, die in 
der folgenden Tabelle als „VO“ abgekürzt ist. 
Die VoiceOver-Hilfe liest die Tasten oder Tastaturbefehle vor, während Sie sie eingeben. Sie können 
die VoiceOver-Hilfe verwenden, um sich mit der Tastaturbelegung und den Aktionen, die den 
Tastenkombinationen zugeordnet sind, vertraut zu machen. 
VoiceOver-Tastaturbefehle
VO = ctrl-Wahl
Vorlesen von der aktuellen Auswahl 
an
VO–A
Vorlesen des gesamten Bildschirms 
von oben
VO–B
Bewegen zur Statusleiste VO–M
Drücken der Home-Taste VO–H
Auswählen des nächsten oder 
vorherigen Objekts
VO–Rechtspfeil oder VO–Linkspfeil
Tippen auf ein Objekt VO–Leertaste
Doppeltippen mit zwei Fingern VO–”-”
Auswählen des nächsten oder 
vorherigen Rotorobjekts
VO–Aufwärtspfeil oder VO–Abwärtspfeil
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vorherigen Objekts in der Liste mit 
den Spracheinstellungen
VO–Befehl-Linkspfeil oder VO–Befehl-Rechtspfeil
Anpassen der Liste mit den 
Spracheinstellungen
VO–Befehl-Aufwärtspfeil oder VO–Befehl-Abwärtspfeil
Aktivieren bzw. Deaktivieren der 
VoiceOver-Stummschaltung
VO–S
Aktivieren oder Deaktivieren des 
Bildschirmvorhangs
VO–Umschalt-S
Aktivieren der VoiceOver-Hilfe VO–K
Zurückkehren zum vorherigen 
Bildschirm oder Deaktivieren der 
VoiceOver-Hilfe
Esc
Schnelle Navigation
Aktivieren Sie die schnelle Navigation, um VoiceOver mit den Pfeiltasten zu steuern. Die Option 
„Schnelle Navigation“ ist standardmäßig deaktiviert.
Aktivieren oder Deaktivieren der 
schnellen Navigation
Linkspfeil–Rechtspfeil
Auswählen des nächsten oder 
vorherigen Objekts
Rechtspfeil–Linkspfeil
Auswählen des nächsten oder 
vorherigen Objekts, das in der 
Rotoreinstellung festgelegt ist
Aufwärtspfeil oder Abwärtspfeil
Auswählen des ersten oder letzten 
Objekts
ctrl–Aufwärtspfeil oder ctrl–Abwärtspfeil
Tippen auf ein Objekt Aufwärtspfeil–Abwärtspfeil
Blättern nach oben, unten, links 
oder rechts
Wahl–Aufwärtspfeil, Wahl–Abwärtspfeil, Wahl–Linkspfeil oder Wahl–
Rechtspfeil
Ändern des Rotors Aufwärtspfeil–Linkspfeil oder Aufwärtspfeil–Rechtspfeil
Sie können auch die Tasten auf der numerischen Tastatur des Apple Wireless Keyboard zum 
Wählen einer Telefonnummer in der App „Telefon“ oder zur Eingabe von Zahlen in der App 
„Rechner“ verwenden.
Schnelle Navigation im Internet mit einem Buchstaben
Wenn Sie bei aktivierter schneller Navigation eine Webseite anzeigen, können Sie mit den 
folgenden Tasten schnell durch die Seite navigieren. Wenn Sie die entsprechende Taste eingeben, 
gelangen Sie zum nächsten Element des aufgezeigten Typs. Halten Sie beim Eingeben des 
Buchstabens die Umschalttaste gedrückt, um zum vorherigen Element zurückzukehren.
H Überschrift
L Link
R Textfeld
B Taste
C Bedienelemente für Formulare
I Bild
T Tabelle
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W ARIA-Landmark
X Liste
M Element des gleichen Typs
1 Überschrift der ersten Ebene
2 Überschrift der zweiten Ebene
3 Überschrift der dritten Ebene
4 Überschrift der vierten Ebene
5 Überschrift der fünften Ebene
6 Überschrift der sechsten Ebene
Verwenden von Braillezeilen mit VoiceOver
Sie können eine aktualisierbare Bluetooth-Braillezeile verwenden, um die VoiceOver-Ausgabe 
in Blindenschrift darzustellen. Ferner können Braillezeilen mit Eingabetasten und anderen 
Bedienelementen zur Steuerung des iPhone verwendet werden, wenn VoiceOver aktiviert ist. Das 
iPhone funktioniert mit vielen drahtlosen Braillezeilen. Eine vollständige Liste der unterstützten 
Bildschirme finden Sie auf der folgenden Website: www.apple.com/de/accessibility/iphone/
braille-display.html.
Einrichten einer Braillezeile  Schalten Sie den Bildschirm ein, öffnen Sie „Einstellungen“ > 
„Allgemein“ > „Bluetooth“ und aktivieren Sie „Bluetooth“. Wählen Sie dann „Einstellungen“ > 
„Allgemein“ > „Bedienungshilfen“ > „VoiceOver“ > „Blindenschrift“, um die Braillezeile auszuwählen.
Aktivieren bzw. Deaktivieren der 
verkürzten Blindenschrift:
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Blindenschrift“.
Aktivieren bzw. Deaktivieren der 
8-Punkt-Blindenschrift
Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„VoiceOver“ > „Blindenschrift“.
Informationen zu allgemeinen Braille-Befehlen für die VoiceOver-Navigation und spezielle 
Informationen zu bestimmten Braillezeilen finden Sie unter support.apple.com/kb/
HT4400?viewlocale=de_DE.
Die Braillezeile verwendet die für die Sprachsteuerung festgelegte Sprache. Standardmäßig 
handelt es sich hierbei um die Sprache, die unter „Einstellungen“ > „Landeseinstellungen“ > 
„Sprache“ für das iPhone festgelegt wird. Sie können die Einstellung für die VoiceOver-Sprache 
verwenden, um eine andere Sprache für VoiceOver und Braillezeilen auszuwählen.
Festlegen der Sprache für VoiceOver: Tippen Sie auf „Einstellungen“, wählen Sie „Allgemein“ > 
„Landeseinstellungen“ > „Sprachstrg.“ aus und tippen Sie auf die gewünschte Sprache.
Wenn Sie die Sprache für das iPhone ändern, müssen Sie möglicherweise die Sprache für 
VoiceOver und Ihre Braillezeile zurücksetzen.
Sie können die Zelle ganz links bzw. ganz rechts auf Ihrer Braillezeile so definieren, dass sie den 
Systemstatus und andere Informationen wiedergibt:
Â Meldungsverlauf enthält eine ungelesene Nachricht
Â Die aktuelle Nachricht im Meldungsverlauf wurde noch nicht gelesen
Â VoiceOver ist stummgeschaltet
Â Die Batterie des iPhone ist fast leer (weniger als 20 % Ladung)
Â iPhone befindet sich im Querformat
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Â Auf der linken Seite der aktuellen Zeile befindet sich weiterer Text
Â Auf der rechten Seite der aktuellen Zeile befindet sich weiterer Text
Festlegen der Zelle ganz links bzw. rechts zur Wiedergabe von Statusinformationen: Öffnen Sie 
den Bereich „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > „VoiceOver“ > „Blindenschrift“ > 
„Statuszelle“ und tippen Sie dann auf „Links“ oder „Rechts“. 
Anzeigen einer erweiterten Beschreibung der Statuszelle: Drücken Sie auf Ihrer Braillezeile die 
Routing-Taste der Statuszelle.
Audio-Routing für eingehende Anrufe
Sie können die Tonausgabe eingehender Anrufe automatisch auf ein Headset oder eine 
Freisprecheinrichtung weiterleiten, anstatt auf den iPhone-Empfänger.
Einrichten des Audio-Routings für Anrufe:  Öffnen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“ > „Eingehende Anrufe“ und wählen Sie, wo Sie Ihre Anrufe hören möchten.
Siri
Mit Siri können Sie Ihr iPhone bitten, bestimmte Aufgaben zu erledigen, und VoiceOver liest Ihnen 
die Antworten vor, die Siri gibt. Weitere Informationen unter Kapitel 4,„Siri,“ auf Seite 43.
Home-Dreifachklick
Die Funktion „Home-Dreifachklick“ bietet eine einfache Möglichkeit, einige der Bedienungshilfen 
ganz einfach zu aktivieren oder zu deaktivieren, indem Sie die Home-Taste  dreimal schnell 
hintereinander drücken. Sie können die Funktion zum Home-Dreifachklick zu Folgendem 
verwenden:
Â Aktivieren oder Deaktivieren von VoiceOver
Â Aktivieren oder Deaktivieren der Funktion „Weiß auf schwarz“
Â Aktivieren oder Deaktivieren der Zoomfunktion
Â Aktivieren oder Deaktivieren der Funktion „AssistiveTouch“
Sie können die Funktion „Home-Dreifachklick“ auch so einstellen, dass die Option zum Aktivieren 
bzw. Deaktivieren von VoiceOver, der Funktion „Weiß auf schwarz“oder der Zoomfunktion 
angezeigt wird. Die Funktion „Home-Dreifachklick“ ist standardmäßig deaktiviert.
Einstellen der Funktion „Home-Dreifachklick“: Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“ > „Home-Dreifachklick“.
Zoomen
Bei vielen iPhone-Apps können Sie bestimmte Elemente ein- oder auszoomen. So können Sie zum 
Beispiel in Safari die Spalte einer Webseite vergrößert darstellen, indem Sie zweimal tippen oder 
die Spalte mit zwei Fingern „aufziehen“. 
Das Zoomen ist eine spezielle Bedienungshilfefunktion, mit der Sie den gesamten Bildschirm einer 
App vergrößern können, um die einzelnen Komponenten besser sehen zu können.
Beim Verwenden der Zoomfunktion mit einem Apple Wireless Keyboard (siehe „Verwenden eines 
Apple Wireless Keyboard“ auf Seite 29) folgt die Bildschirmanzeige der Einfügemarke und wird in 
der Mitte des Bildschirms angezeigt.
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„Bedienungshilfen“ > „Zoom“. Oder verwenden Sie die Funktion „Home-Dreifachklick“. Weitere 
Informationen unter „Home-Dreifachklick“ auf Seite 174.
Hinweis:  Sie können die Funktionen „VoiceOver“ und „Zoomen“ nicht gleichzeitig verwenden.
Verkleinern oder Vergrößern Tippen Sie mit drei Fingern zweimal auf den Bildschirm. Standardmäßig 
wird der Bildschirm mit dem Vergrößerungsfaktor 200 % angezeigt. Wenn 
Sie den Zoomfaktor manuell ändern (mit der unten beschriebenen Geste 
„Tippen und Bewegen“), verwendet das iPhone automatisch diesen 
Zoomfaktor, wenn Sie das nächste Mal zweimal mit drei Fingern auf den 
Bildschirm tippen.
Ändern des Vergrößerungsfaktors Tippen Sie mit drei Fingern auf den Bildschirm und bewegen Sie Ihre Finger 
zum oberen Rand des Bildschirms (um den Zoomfaktor zu erhöhen) oder 
zum unteren Rand (um den Zoomfaktor) zu reduzieren. Diese Geste „Tippen 
und Bewegen“ ähnelt dem zweimaligen Tippen. Allerdings heben Sie Ihre 
Finger für das zweite Tippen nicht an, sondern bewegen sie über den 
Bildschirm. Nachdem Sie den Bewegungsvorgang gestartet haben, können 
Sie ihn mit nur einem Finger zu Ende führen.
Navigieren im Bildschirm Streichen Sie in der vergrößerten Darstellung mit drei Fingern über 
den Bildschirm, um im Bildschirm zu navigieren. Nachdem Sie den 
Bewegungsvorgang gestartet haben, können Sie ihn mit nur einem Finger 
zu Ende führen, sodass Sie einen größeren Ausschnitt des Bildschirms 
sehen können. Tippen Sie mit einem Finger auf eine Stelle nahe am 
Rand der Anzeige und halten Sie den Finger an dieser Stelle, um in 
der Bildschirmanzeige in die entsprechende Richtung zu blättern. Je 
näher Sie Ihren Finger am Rand platzieren, umso schneller erfolgt dieser 
Blättervorgang. Beim Öffnen eines neuen Bildschirms wird die obere Hälfte 
des Bildschirms vergrößert angezeigt.
Großer Text
Mit dieser Funktion können Sie den Text in Warnungen, Kalender, Kontakten, Mail, Nachrichten 
und Notizen vergrößern.
Festlegen der Textgröße: Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„Großer Text“.
Weiß auf schwarz
Mit der Funktion „Weiß auf schwarz“ können Sie die Farben auf der Anzeige des iPhone umkehren, 
was das Lesen der Informationen auf dem Bildschirm in bestimmten Situationen vereinfacht. Ist 
die Funktion „Weiß auf schwarz“ aktiviert, sieht der Bildschirm wie ein Fotonegativ aus.
Umkehren der Farben auf dem Bildschirm: Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“ > „Weiß auf schwarz“.
Auswahl vorlesen
Auch mit deaktiviertem VoiceOver kann das iPhone ausgewählten Text vorlesen.
Aktivieren der Sprachauswahl und Anpassen der Geschwindigkeit:  Wählen Sie „Einstellungen“ > 
„Allgemein“ > „Bedienungshilfen“ > „Auswahl vorlesen“.
Vorlesen lassen von Text Wählen Sie den Text aus und tippen Sie auf „Vorlesen“.
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Mit dieser Funktion werden die Textkorrekturen und -vorschläge, die das iPhone macht, während 
der Texteingabe vorgelesen.
Aktivieren und Deaktivieren der Option „Auto-Text vorlesen“: Wählen Sie „Einstellungen“ > 
„Allgemein“ > „Bedienungshilfen“ > „Auto-Text vorlesen“.
Die Option „Auto-Text vorlesen“ kann auch zusammen mit VoiceOver und der Zoomfunktion 
verwendet werden.
Mono-Audio
Die Funktion „Mono-Audio“ fasst den linken und den rechten Kanal zu einem einzelnen 
Monosignal zusammen, das in gleicher Weise über beide Kanäle ausgegeben wird. Passen Sie die 
Balance des Monosignals an, um rechts oder links eine höhere Lautstärke zu verwenden.
Aktivieren oder Deaktivieren der Funktion „Mono-Audio“: Wählen Sie „Einstellungen“ > 
„Allgemein“ > „Bedienungshilfen“ > „Mono-Audio“.
Kompatibilität von Hörgeräten
Die FCC hat Regelungen zur Kompatibilität von Hörgeräten für digitale, drahtlose Telefone 
herausgegeben. Diese Regelungen erfordern, dass bestimmte Telefone auf der Basis der 
vom American National Standard Institute (ANSI) festgelegten C63.19-2007-Standards für die 
Kompatibilität von Hörgeräten getestet und bewertet werden. Der ANSI-Standard für die 
Kompatibilität von Hörgeräten beinhaltet zwei Arten der Bewertung: die Bewertung „M“ für 
reduzierte Interferenzen durch Funkfrequenzen, um eine akustische Kopplung mit Hörgeräten 
zu ermöglichen, die nicht im Telecoil-Modus arbeiten; und die Bewertung „T“ für die induktive 
Kopplung von Hörgeräten im Telecoil-Modus. Bei diesen Bewertungen wird eine Skala von eins 
bis vier verwendet, wobei vier für die höchste Kompatibilitätsstufe steht. Ein Telefon gilt gemäß 
der FCC-Regelungen als kompatibel mit Hörgeräten, wenn es mit M3 oder M4 für die akustische 
Kopplung und mit T3 oder T4 für induktive Kopplung bewertet wurde.
Aktuelle Bewertungen der Kompatibilität von Hörgeräten für das iPhone finden Sie auf der 
folgenden Website: http://support.apple.com/kb/HT4526?viewlocale=de_DE
Bewertungen der Kompatibilität von Hörgeräten sind keine Garantie dafür, dass ein bestimmtes 
Hörgerät mit einem bestimmten Telefon funktioniert. Einige Hörgeräte funktionieren 
möglicherweise auch einwandfrei mit Telefonen, die diese Bewertungen nicht aufweisen. Damit 
die Kompatibilität zwischen Hörgerät und Telefon sichergestellt ist, sollten Sie die Geräte vor dem 
Kauf zusammen verwenden.
Hörgerätbetrieb
Das iPhone 4 GSM bietet einen Hörgerätbetrieb, bei dem bei manchen Hörgeräten Störgeräusche 
reduziert werden. Beim Hörgerätbetrieb wird die Sendeleistung des Mobilfunks im GSM-Netz auf 
1900 MHz reduziert. Dies kann die 2G-Abdeckung beeinträchtigen.
Aktivieren des Hörgerätbetriebs (iPhone 4 GSM): Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“.
Eigene Vibrationen
Sie können bestimmten Kontakten ein besonderes Vibrationsmuster für Telefon- oder FaceTimeAnrufe zuweisen. Wählen Sie ein bestehendes aus oder erstellen Sie ein neues.
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„Bedienungshilfen“ > „Eigene Vibrationen“.
Auswählen des Vibrationsmusters 
für einen Kontakt
Wählen Sie in der Kontaktliste einen Kontakt aus und tippen Sie dann auf 
„Vibration“. Wenn in den Kontaktdaten „Vibration“ nicht angezeigt wird, 
tippen Sie auf „Bearbeiten“ und füge Sie die Option hinzu.
Erstellen eines neuen 
Vibrationsmusters
Wenn Sie bereits einen Kontakt bearbeiten, tippen Sie auf „Vibration“ 
und anschließend auf „Neue Vibration erstellen“. Öffnen Sie alternativ 
„Einstellungen“ > „Töne“ > „Vibration“ > „Neue Vibration erstellen“.
Festlegen eines eigenen 
Vibrationsmusters als Standard
Öffnen Sie „Einstellungen“ > „Töne“ > „Vibration“ und wählen Sie ein Muster.
LED-Blitz bei Hinweisen
Wenn Sie nicht in der Lage sind, die Hinweistöne und andere akustische Signale zu hören, die 
das iPhone von sich gibt, können Sie festlegen, dass das iPhone mit dem LED-Blitz (neben der 
Kameralinse auf der Rückseite) ein Signal ausgibt. Dies funktioniert nur, wenn das iPhone gesperrt 
ist oder sich im Ruhezustand befindet. Verfügbar für iPhone 4 oder neuer.
Aktivieren des LED-Blitzes bei Hinweisen:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bedienungshilfen“ > „LED-Blitz bei Hinweisen“.
AssistiveTouch
AssistiveTouch hilft Ihnen beim Verwenden des iPhone, wenn Sie Schwierigkeiten mit dem 
Touchscreen bzw. den Tasten haben. Sie können mit AssistiveTouch kompatibles adaptives 
Zubehör (wie einen Joystick) verwenden, um das iPhone zu steuern. AssistiveTouch kann auch 
ohne Zubehör verwendet werden, wenn Sie Gesten verwenden möchten, die schwierig für Sie 
sind.
Aktivieren von AssistiveTouch:  Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„AssistiveTouch“. Legen Sie fest, dass durch dreimaliges Drücken der Home-Taste AssistiveTouch 
aktiviert bzw. deaktiviert wird. Öffnen Sie dazu „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ 
> „Home-Dreifachklick“.
Anpassen der Zeigerbewegung Wählen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„AssistiveTouch“ > „Zeigerbewegung“.
Ein- oder Ausblenden des 
AssistiveTouch-Menüs
Klicken Sie auf dem Zubehör auf die sekundäre Taste.
Ausblenden der Menütaste Öffnen Sie „Einstellungen“ > „Allgemein“ > „Bedienungshilfen“ > 
„AssistiveTouch“ > „Menü immer einblenden“.
Verwenden von 2, 3, 4 oder 5 
Fingern für eine Streich- oder 
Ziehbewegung
Tippen Sie auf die Menütaste, wählen Sie „Gesten“ und geben Sie die 
Anzahl der Finger ein, die für eine Geste erforderlich sind. Wenn die 
entsprechenden Kreise angezeigt werden, ziehen oder streichen Sie in die 
für die Geste erforderliche Richtung. Wenn Sie fertig sind, tippen Sie auf die 
Menütaste.
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Wenn die Kreise angezeigt werden, berühren Sie den Bildschirm, um diese 
zu bewegen, und machen Sie eine Ziehbewegung an eine beliebige Stelle 
auf dem Bildschirm. Wenn Sie fertig sind, tippen Sie auf die Menütaste.
Erstellen eigener Gesten Tippen Sie auf die Menütaste, auf „Favoriten“ und dann auf einen freien 
Platzhalter für eine Geste. Öffnen Sie alternativ „Einstellungen“ > „Allgemein“ 
> „Bedienungshilfen“ > „AssistiveTouch“ > „Neue Geste erstellen“.
Sperren oder Drehen des 
Bildschirms, Anpassen der 
Lautstärke, Wechseln zwischen 
„Klingeln/Aus“ und Simulieren 
einer Schüttelbewegung
Tippen Sie auf die Menütaste und dann auf „Gerät“.
Simulieren des Drückens der 
Home-Taste
Tippen Sie auf die Menütaste und dann auf „Home“.
Bewegen der Menütaste Bewegen Sie sie auf eine beliebige Stelle auf dem Bildschirm.
Schließen eines Menüs ohne das 
Verwenden einer Geste
Tippen Sie außerhalb des Menüs auf den Bildschirm.
Bedienungshilfen in OS X
Nutzen Sie die Funktionen der Bedienungshilfen von OS X, wenn Sie Informationen und Inhalte 
Ihrer iTunes-Mediathek mithilfe von iTunes auf das iPhone übertragen. Wählen Sie im Finder „Hilfe“ 
> „Hilfe-Zentrum” und suchen Sie nach „Bedienungshilfe“.
Weitere Informationen zu Bedienungshilfen für das iPhone und von OS X finden Sie unter
www.apple.com/de/accessibility.
TTY-Unterstützung
Verbinden Sie mithilfe eines TTY-Adapter-Kabels (in vielen Regionen separat erhältlich) Ihr iPhone 
mit einem TTY-Gerät. Besuchen Sie die Website www.apple.com/de/store (nicht in allen Ländern 
und Regionen verfügbar) oder wenden Sie sich an Ihren Apple-Händler vor Ort.
Verbinden des iPhone mit einem TTY-Gerät:  Wählen Sie „Einstellungen“ > „Telefon” und 
aktivieren Sie „TTY“. Verbinden Sie dann Ihr iPhone mithilfe des TTY-Adapters mit dem TTY-Gerät.
Wenn TTY auf dem iPhone aktiviert ist, wird in der Statusleiste oben auf dem Bildschirm das TTYSymbol  angezeigt. Weitere Informationen zur Verwendung von TTY-Geräten finden Sie in der 
Dokumentation des betreffenden Geräts.
Minimale Schriftgröße für E-Mails
Stellen Sie die minimale Schriftgröße für Text in E-Mails auf „Groß“, „Sehr groß“ oder „Supergroß“ 
ein, um die Lesbarkeit zu erhöhen.
Festlegen der Mindestschriftgröße für E-Mails:  Tippen Sie auf „Einstellungen“ > „Mail, Kontakte, 
Kalender“ > „Mindestschriftgröße“.
Die Einstellung „Großer Text“ überschreibt die hier festgelegte Mindestschriftgröße.
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Sie können Personen in Ihrer Kontaktliste verschiedene Klingeltöne zuweisen, um die akustische 
Anruferkennung zu nutzen. Im iTunes Store auf dem iPhone können Sie Klingeltöne kaufen. 
Weitere Informationen unter „Kaufen von Musik, Hörbüchern und Tönen“ auf Seite 130.
Visual Voicemail
Mit „Wiedergabe“ und „Pause“ können Sie die Wiedergabe Ihrer Nachrichten in der Voicemail 
steuern. Bewegen Sie die Abspielposition der Navigationsleiste, um einen Teil einer Nachricht zu 
wiederholen, der schwer zu verstehen ist. Weitere Informationen unter „Abrufen von VoicemailNachrichten“ auf Seite 68.
Tastaturen im Querformat
Bei vielen Apps, einschließlich Mail, Safari, Nachrichten, Notizen und Kontakte, können Sie bei der 
Texteingabe das iPhone drehen und eine größere Tastatur verwenden.
Große Telefontastatur
Sie können sich das Wählen erleichtern, indem Sie in Ihrer Kontakt- oder Favoritenliste auf 
Einträge tippen. Wenn Sie eine Nummer wählen müssen, ist das mit der großen numerischen 
Tastatur des iPhone ganz einfach. Weitere Informationen unter „Telefongespräche“ auf Seite 62.
Sprachsteuerung
Die Sprachsteuerung bietet die Möglichkeit, mittels gesprochener Befehle Telefonanrufe zu 
tätigen und die Musikwiedergabe zu steuern. Weitere Informationen unter „Sprachwahl“ auf 
Seite 63 und „Verwenden von Siri bzw. der Sprachsteuerung mit der App „Musik““ auf Seite 88.
Erweiterte Untertitel
Aktivieren der erweiterten Untertitel für Videos:  Wählen Sie „Einstellungen“ > „Video“ > 
„Erweiterte Untertitel“.
Nicht alle Videoinhalte sind für erweiterte Untertitel ausgelegt.
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Im Bereich „Einstellungen“ können Sie Ihr iPhone konfigurieren, App-Optionen festlegen, Accounts 
hinzufügen und andere Einstellungen eingeben.
Flugmodus
Im Flugmodus werden die WLAN-Funktionen deaktiviert, um mögliche Störungen des 
Flugbetriebs bzw. elektronischer Ausrüstung zu reduzieren.
Aktivieren des Flugmodus:  Öffnen Sie „Einstellungen“ und aktivieren Sie den Flugmodus.
Wenn der Flugmodus auf dem iPhone aktiviert ist, wird in der Statusleiste oben auf dem 
Bildschirm  angezeigt. Das iPhone gibt keine Telefon-, WLAN- oder Bluetooth-Signale aus und 
GPS wird deaktiviert. Apps oder Funktionen, die diese Signale benötigen, können nicht verwendet 
werden. Dazu zählen unter anderem Apps, bei denen eine Internetverbindung benötigt wird, 
Textmitteilungen gesendet oder empfangen, Anrufe getätigt oder empfangen und Visual 
Voicemail-Nachrichten abgerufen werden. 
Sofern von der Fluggesellschaft und durch entsprechende Gesetze und Bestimmungen gestattet, 
können Sie im Flugmodus Musik hören, Videos anschauen, E-Mails, Kalender und andere Daten, 
die Sie zuvor empfangen haben, ansehen. Apps, die keine Internetverbindung erfordern, können 
verwendet werden.
Sofern WLAN verfügbar und von der Fluggesellschaft und durch geltende Gesetze und 
Regelungen genehmigt ist, können Sie es unter „Einstellungen“ wieder aktivieren. Aktivieren Sie 
Bluetooth in „Einstellungen“ > „Allgemein“ > „Bluetooth“.
WLAN
Herstellen einer WLAN-Netzwerkverbindung
In den WLAN-Einstellungen wird festgelegt, ob das iPhone lokale WLAN-Netzwerke für die 
Verbindung zum Internet nutzt. Wenn das iPhone mit einem WLAN-Netzwerk verbunden ist, 
zeigt das WLAN-Symbol  in der Statusleiste oben im Bildschirm die aktuelle Signalstärke an. Je 
mehr Balken angezeigt werden, desto stabiler ist die Verbindung. Wenn keine WLAN-Netzwerke 
verfügbar sind oder Sie die WLAN-Funktionalität deaktiviert haben, stellt das iPhone die 
Verbindung zum Internet über Ihr Mobilfunknetz her, sofern dieses verfügbar ist.
Wenn Sie die Verbindung zu einem WLAN-Netzwerk manuell hergestellt haben, aktiviert das 
iPhone diese Verbindung automatisch, wenn Sie sich innerhalb der Reichweite dieses Netzwerks 
befinden. Werden mehrere zuvor verwendete Netzwerke innerhalb der Reichweite gefunden, 
stellt das iPhone die Verbindung zum zuletzt verwendeten Netzwerk her.
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daheim bzw. im Büro WLAN-Dienste nutzen können. Weitere Informationen unter „Konfigurieren 
einer AirPort-Basisstation“ auf Seite 181.
Aktivieren oder Deaktivieren von WLAN:  Wählen Sie „Einstellungen“ > „WLAN“.
Festlegen, dass das iPhone fragt, 
ob eine Verbindung zu einem 
Netzwerk hergestellt werden soll
Wählen Sie „Einstellungen“ > „WLAN“ und aktivieren oder deaktivieren Sie 
die Option „Auf Netze hinweisen“.
Ist die Option „Verbinden bestätigen“ deaktiviert, müssen Sie für den 
Internetzugriff manuell eine Verbindung zu einem Netzwerk herstellen, 
wenn kein zuvor verwendetes Netzwerk oder Mobilfunknetz verfügbar ist.
Ignorieren eines Netzwerks, damit 
das iPhone nicht automatisch eine 
Verbindung damit herstellt
Wählen Sie „Einstellungen“ > „WLAN“ und tippen Sie dann neben einem 
zuvor verwendeten Netzwerk auf  . Tippen Sie dann auf „Dieses Netzwerk 
ignorieren“.
Herstellen einer WLAN-Verbindung 
zu einem geschlossenen WLANNetzwerk
Wählen Sie „Einstellungen“ > „WLAN“ > „Anderes“ und geben Sie den 
Netzwerknamen ein, wenn Sie auf ein WLAN-Netzwerk zugreifen wollen, 
das in der Liste der gefundenen Netzwerke nicht angezeigt wird.
Damit Sie auf ein geschlossenes Netzwerk zugreifen können, müssen Sie 
Netzwerkname, Kennwort und Sicherheitsstandard kennen.
Anpassen von Einstellungen für 
die Verbindung zu einem WLANNetzwerk
Wählen Sie „Einstellungen“ > „WLAN“ und tippen Sie dann neben einem 
Netzwerk auf  . Sie können ein HTTP-Proxy einrichten, Einstellungen für 
ein statisches Netzwerk definieren, BootP aktivieren oder die von einem 
DHCP-Server bereitgestellten Einstellungen erneuern.
Konfigurieren einer AirPort-Basisstation
Eine AirPort-Basisstation bietet eine WLAN-Verbindung für Zuhause, in der Schule oder im Büro. 
Mit dem iPhone können Sie eine neue AirPort Express-, AirPort Extreme- oder Time CapsuleBasisstation konfigurieren. 
Verwenden des AirPort-Assistenten:  Wählen Sie „Einstellungen“ > „WLAN“. Wählen Sie unter „Eine 
AirPort-Basisstation konfigurieren“ den Namen der Basisstation, die Sie konfigurieren möchten. 
Befolgen Sie die angezeigten Anleitungen.
Einige ältere AirPort-Basisstationen können nicht über iOS-Geräte konfiguriert werden. Ziehen Sie 
die entsprechende Dokumentation zu Rate, die im Lieferumfang der Basisstation enthalten war.
Ist die gewünschte Basisstation nicht aufgeführt, überprüfen Sie, ob die Stromversorgung 
ausreichend ist, ob Sie sich in Reichweite befinden und ob diese zuvor bereits konfiguriert wurde. 
Nur neue oder zurückgesetzte Basisstationen können konfiguriert werden.
Wurde Ihre AirPort-Basisstation bereits konfiguriert, können Sie über die App „AirPortDienstprogramm“ im App Store die Einstellungen ändern und den Status auf dem iPhone 
überwachen.
Benachrichtigungen
Push-Benachrichtigungen werden in der Mitteilungszentrale angezeigt und informieren 
Sie auch dann über neue Informationen, wenn die jeweilige App nicht ausgeführt wird. 
Benachrichtigungen variieren abhängig von der jeweiligen App. Sie können Textelemente 
und akustische Warnhinweise umfassen oder das Symbol der jeweiligen App auf dem HomeBildschirm mit einer kleinen Nummer versehen.
Sie können Mitteilungen deaktivieren, zu denen Sie keine Informationen wünschen, und die 
Reihenfolge ändern, in der die Mitteilungen angezeigt werden sollen.
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Tippen Sie in der Liste auf ein Element und aktivieren bzw. deaktivieren Sie dann die 
Benachrichtigungen für das entsprechende Element.
Apps, bei denen Mitteilungen deaktiviert wurden, werden in der Liste „Nicht in der 
Mitteilungszentrale“ angezeigt.
Ändern der Anzahl der 
Mitteilungen
Wählen Sie „Einstellungen“ > „Mitteilungen“ und dann ein Objekt aus der 
Liste „In der Mitteilungszentrale“. Tippen Sie auf „Anzeigen“, um festzulegen, 
wie viele Mitteilungen dieser Art in der Mitteilungszentrale angezeigt 
werden.
Ändern des Hinweisstils Wählen Sie „Einstellungen“ > „Mitteilungen“ und dann ein Objekt aus der 
Liste „In der Mitteilungszentrale“. Wählen Sie einen Hinweisstil oder „Keine“ 
aus, um Hinweise oder Kennzeichnungen zu deaktivieren. Mitteilungen 
werden weiterhin in der Mitteilungszentrale angezeigt.
Ändern der Reihenfolge der 
Mitteilungen
Öffnen Sie „Einstellungen“ > „Mitteilungen“ und tippen Sie auf „Bearbeiten“. 
Ziehen Sie die Mitteilungen in den gewünschten Ordner. Um eine 
Mitteilung zu deaktivieren, ziehen Sie sie in die Liste „Nicht in der 
Mitteilungszentrale“.
Anzeigen von nummerierten 
Bannern für Apps, bei denen 
Mitteilungen vorliegen
Wählen Sie „Mitteilungen“ und dann ein Objekt aus der Liste 
„In der Mitteilungszentrale“. Deaktivieren Sie dann die Option 
„Kennzeichensymbol“.
Ausblenden von Hinweisen, wenn 
das iPhone gesperrt ist
Wählen Sie „Einstellungen“ > „Mitteilungen“ und dann eine App aus 
der Liste „In der Mitteilungszentrale“. Deaktivieren Sie die Option „Im 
Sperrbildschirm“, um Hinweise von Apps auszublenden, wenn das iPhone 
gesperrt ist.
Manche Apps verfügen über weitere Optionen. So können Sie in „Nachrichten“ festlegen, wie oft 
der Hinweiston ertönt und ob eine Vorschau der Nachricht in der Benachrichtigung angezeigt 
werden soll.
Ortungsdienste
Die Ortungsdienste ermöglichen es Apps wie „Karten“, „Kamera“ und „Erinnerungen“ sowie 
ortungsbezogenen Apps anderer Anbieter, Daten bezüglich Ihres Standorts zu sammeln und 
zu verwenden. Die von Apple gesammelten Standortangaben werden in einer Weise erfasst, 
die keine Rückschlüsse auf Ihre persönliche Identität zulässt. Ortungsdienste verwenden 
Informationen, die über lokale WLAN-Netzwerke (sofern WLAN eingeschaltet wurde) und GPS 
bereitgestellt werden. (GPS ist möglicherweise nicht überall verfügbar.) Sie können die Batterie 
schonen, indem Sie die Ortungsdienste deaktivieren, solange Sie sie nicht verwenden.
Wenn eine App Ortungsdienste nutzt, wird in der Menüleiste  angezeigt.
Apps und Systemdienste, die Ortungsdienste verwenden, werden im Bildschirm mit den 
Einstellungen der Ortungsdienste angezeigt. Dort sehen Sie, ob für die entsprechende App bzw. 
den entsprechenden Dienst Ortungsdienste aktiviert oder deaktiviert sind. Sie können für einzelne 
oder alle Apps und Dienste Ortungsdienste deaktivieren, wenn Sie diese Funktion nicht nutzen 
möchten. Wenn Sie die Ortungsdienste deaktivieren, werden Sie aufgefordert, sie wieder zu 
aktivieren, wenn eine App das nächste Mal versucht, diese Funktion zu verwenden.
Wenn Sie auf dem iPhone eine App eines anderen Anbieters verwenden, die die Ortungsdienste 
nutzt, sollten Sie die allgemeinen Nutzungsbedingungen und datenschutzrechtlichen 
Bestimmungen dieses Anbieters lesen, damit Sie informiert sind, wie die betreffende App Ihre 
Standortdaten verwertet.
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„Ortungsdienste“.
VPN
In Unternehmen verwendete virtuelle private Netzwerke (VPN) ermöglichen das sichere 
Übertragen von Daten über ein öffentliches Netzwerk. Möglicherweise müssen Sie für bestimmte 
Dienste VPN konfigurieren (z. B. zum Abrufen Ihrer Arbeits-E-Mails). Diese Einstellung wird 
angezeigt, wenn Sie VPN auf dem iPhone konfiguriert haben. Hierdurch haben Sie die Möglichkeit, 
VPN zu aktivieren bzw. zu deaktivieren. Weitere Informationen unter „Netzwerk“ auf Seite 186.
Persönlicher Hotspot
Mit der Option „Persönlicher Hotspot“ (iPhone 4 oder neuer) können Sie eine Internetverbindung 
für Ihren Computer oder andere Geräte wie dem iPod touch, iPad oder einem anderen iPhone 
bereitstellen, wenn diese über WLAN mit Ihrem iPhone verbunden sind. Sie können auch eine 
Internetverbindung für einen Computer bereitstellen, der über Bluetooth oder USB mit Ihrem 
iPhone verbunden ist. Der persönliche Hotspot funktioniert nur, wenn das iPhone über das 
Mobilfunknetz mit dem Internet verbunden ist.
Hinweis:  Die Funktion ist möglicherweise nicht in allen Regionen verfügbar. Hierfür können 
zusätzliche Gebühren anfallen. Weitere Informationen erhalten Sie bei Ihrem Netzanbieter.
Freigeben einer Internetverbindung:  Öffnen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“ und 
tippen Sie auf „Persönlichen Hotspot konfigurieren“, wenn diese Option angezeigt wird, um den 
Dienst mit Ihrem Anbieter einzurichten.
Nach dem Aktivieren des persönlichen Hotspots können andere Geräte über eine der folgenden 
Optionen verbunden werden:
Â Über WLAN:  Wählen Sie in der Liste mit verfügbaren WLAN-Netzwerken Ihr iPhone aus.
Â Über USB:  Verbinden Sie das iPhone über das mitgelieferte Dock Connector-auf-USB-Kabel mit 
dem Computer. Wählen Sie in den Netzwerkeinstellungen auf Ihrem Computer das iPhone und 
konfigurieren Sie die Netzwerkeinstellungen.
Â Über Bluetooth:  Öffnen Sie auf dem iPhone „Einstellungen“ > „Allgemein“ > „Bluetooth“ 
und aktivieren Sie „Bluetooth“. Um das iPhone mit Ihrem Gerät zu koppeln, ziehen Sie die 
Dokumentation zu Rate, die im Lieferumfang Ihres Computers enthalten war.
Wenn die Verbindung steht, erscheint oben auf dem iPhone-Bildschirm ein blaues Band. Bei der 
Verbindung über USB bleibt der persönliche Hotspot aktiv, auch wenn Sie die Internetverbindung 
nicht aktiv nutzen.
Hinweis:  Das Symbol „Persönlicher Hotspot“  wird in der Statusleiste von iOS-Geräten angezeigt, 
wenn diese den persönlichen Hotspot verwenden.
Ändern des WLAN-Kennwortes für 
das iPhone
Wählen Sie „Einstellungen“ > „Persönlicher Hotspot“ > „WLAN-Kennwort“ 
und geben Sie ein Kennwort mit mindestens 8 Zeichen ein. 
Überwachen der Benutzung des 
Mobilfunknetzes
Wählen Sie „Einstellungen“ > „Allgemein“ > „Benutzung“ > „Benutzung“.
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Diese Einstellung wird in GSM-Netzen angezeigt, wenn Sie sich nicht in Netzreichweite Ihres 
Mobilfunkanbieters befinden und Telefon, Visual Voicemail und drahtlose Internetverbindung 
über die Datennetze anderer lokaler Anbieter verfügbar sind. Sie können nur Telefonate über 
Anbieter führen, mit denen eine Roaming-Vereinbarung mit Ihrem Mobilfunkanbieter besteht. 
Hierfür können zusätzliche Gebühren anfallen. Roaming-Gebühren werden Ihnen möglicherweise 
vom anderen Netzanbieter über Ihren Anbieter in Rechnung gestellt.
Auswählen eines Mobilfunkanbieters:  Tippen Sie auf „Einstellungen“ > „Netzbetreiber“ und 
wählen Sie das Netz aus, das Sie verwenden möchten.
Nachdem Sie ein Netz ausgewählt haben, verwendet das iPhone ausschließlich dieses Netz. Ist 
das gewählte Netz nicht verfügbar, wird die Meldung „Kein Dienst“ auf dem iPhone-Bildschirm 
angezeigt.
Töne und der Schalter „Klingeln/Aus“
Legen Sie fest, dass das iPhone einen Ton ausgibt, wenn Sie eine neue Nachricht, eine E-Mail, 
einen Anruf, einen Tweet, eine Voicemail oder eine Erinnerung erhalten. Es können auch Töne 
für Termine, das Senden von E-Mails, das Verwenden der Tastatur sowie das Sperren des iPhone 
ausgegeben werden.
Wenn das iPhone stummgeschaltet ist, werden keine Klingel-, Hinweis- oder andere Effekttöne 
ausgegeben. Wecktöne und andere Töne werden trotzdem abgespielt.
Wechseln zwischen den Modi mit und ohne Klingelton:  Bewegen Sie den Schalter an der Seite 
des iPhone.
Hinweis:  In bestimmten Regionen wird der Soundeffekt für die Kamera und Sprachmemos auch 
wiedergegeben, wenn der Schalter „Klingeln/Aus“ auf „Aus“ gestellt ist.
Festlegen des Vibrationsalarms, 
wenn ein Anruf auf dem iPhone 
eingeht
Wählen Sie „Einstellungen“ > „Töne“.
Anpassen der Lautstärke von 
Klingel- und Hinweistönen
Öffnen Sie „Einstellungen“ > „Töne“ und passen Sie den Schieberegler 
an. Ist die Option „Mit Tasten ändern“ aktiviert, können Sie auch die 
Lautstärketasten an der Seite des iPhone verwenden. 
Ändern der Lautstärke anderer 
Töne
Verwenden Sie die Lautstärketasten an der Seite des iPhone.
Einstellen des Klingeltons Wählen Sie „Einstellungen“ > „Töne“ > „Klingelton“.
Anpassen von Klingel- und 
Hinweistönen
Öffnen Sie „Einstellungen“ > „Töne“ und wählen Sie die Töne für die 
Elemente in der Liste aus.
Helligkeit
Die Bildschirmhelligkeit hat Einfluss darauf, wie lange die Batterieladung reicht. Verringern Sie 
die Helligkeit, damit Sie die Batterie des iPhone seltener laden müssen, oder verwenden Sie die 
Option „Auto-Helligkeit“.
Anpassen der Helligkeit des Bildschirms: Öffnen Sie „Einstellungen“ > „Helligkeit“ und passen Sie 
den Schieberegler an.
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Bildschirmhelligkeit automatisch 
anpassen soll
Wählen Sie „Einstellungen“ > „Helligkeit“ und aktivieren oder deaktivieren 
Sie die Option „Auto-Helligkeit“. Wenn die Option „Auto-Helligkeit“ aktiviert 
ist, verwendet das iPhone den integrierten Sensor für das Umgebungslicht, 
um die Bildschirmhelligkeit der jeweiligen Umgebung entsprechend 
anzupassen.
Hintergrundbild
Mit der Einstellung „Hintergrundbild“ können Sie ein Bild oder ein Foto als Hintergrundbild für die 
Anzeigesperre oder den Home-Bildschirm auswählen. Weitere Informationen unter „Hinzufügen 
eines Hintergrundbilds“ auf Seite 25.
Allgemein
Im Bereich „Allgemein“ sind die Netzwerk-, Freigabe- und Sicherheitseinstellungen und andere 
iOS-Einstellungen zusammengefasst. Dort können Sie verschiedene Informationen zu Ihrem 
iPhone anzeigen sowie verschiedene iPhone-Optionen zurücksetzen.
Info
Öffnen Sie den Bereich „Einstellungen“ > „Allgemein“ > „Info“, um Informationen zum 
iPhone anzuzeigen. Dazu gehören: der verfügbare Speicherplatz, die Seriennummer, die 
Netzwerkadressen, die IMEI- (International Mobile Equipment Identity) und ICCID-Nummern 
(Integrated Circuit Card Identifier oder Smart Card) (GSM), die MEID-Nummer (Mobile Equipment 
Identifier) (CDMA) sowie rechtliche und regulatorische Informationen.
Ändern des Gerätenamens:  Öffnen Sie den Bereich „Einstellungen“ > „Allgemein“ > „Info“. Tippen 
Sie dann auf „Name“.
Der Gerätename wird in der Seitenleiste in iTunes angezeigt (wenn iTunes geöffnet ist) und von 
iCloud verwendet.
Softwareaktualisierung
Über die Softwareaktualisierung können Sie iOS-Updates von Apple laden und installieren. 
Aktualisieren auf die neueste iOS-Version:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Softwareaktualisierung“.
Wenn eine neuere iOS-Version verfügbar ist, befolgen Sie die angezeigten Anweisungen, um das 
Update zu laden und zu installieren.
Hinweis:  Stellen Sie sicher, dass das iPhone an eine Stromquelle angeschlossen ist, damit die 
Installation erfolgreich abgeschlossen werden kann. Dieser Vorgang kann mehrere Minuten 
dauern.
Benutzung
Im Bereich „Benutzung“ sehen Sie Informationen zur Benutzung, zum Batteriestatus sowie zum 
verfügbaren Speicherplatz. Hier können Sie auch den iCloud-Speicher verwalten.
Anzeigen von Informationen zu Nutzung, Batteriestatus und verfügbarem Speicher:  Wählen 
Sie „Einstellungen“ > „Allgemein“ > „Benutzung“.
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Benutzungsinformationen
Wählen Sie „Einstellungen“ > „Allgemein“ > „Benutzung“ > „Benutzung“.
Verwalten des iCloud-Speichers Wählen Sie „Einstellungen“ > „Allgemein“ > „Benutzung“ > „Speicher 
verwalten“. Sie können Backups anzeigen und löschen und die Sicherung 
Ihres Albums „Aufnahmen“ deaktivieren. Sie können auch zusätzlichen 
iCloud-Speicher erwerben.
Weitere Informationen unter „iCloud“ auf Seite 18.
Anzeigen des App-Speichers Wählen Sie „Einstellungen“ > „Allgemein“ > „Benutzung“. Für jede installierte 
App wird der insgesamt beanspruchte Speicherplatz angezeigt. Weitere 
Details erhalten Sie, indem Sie auf den Namen der App tippen.
Zurücksetzen Ihrer 
Benutzungsstatistiken
Tippen Sie auf „Einstellungen“ > „Allgemein“ > „Benutzung“ und danach auf 
„Statistiken zurücksetzen“, um die Daten und gesammelten Zeitstatistiken 
zu löschen. 
Anzeigen der Batterieladung Wählen Sie in den Einstellungen „Allgemein“ > „Benutzung“ und aktivieren 
Sie die Option unter „Batterieverbrauch“.
Siri
Aktivieren von Siri:  Wählen Sie „Einstellungen“ > „Allgemein“ > „Siri“. 
Weitere Informationen zum Verwenden von Siri und Ändern der Siri-Einstellungen finden Sie 
unter „Festlegen der Optionen für Siri“ auf Seite 46.
Netzwerk
Verwenden Sie die Netzwerkeinstellungen, um eine VPN-Verbindung (Virtual Private Network) zu 
konfigurieren, auf WLAN-Einstellungen zuzugreifen oder das Daten-Roaming zu aktivieren bzw. zu 
deaktivieren.
Wenn für eine App eine Internetverbindung erforderlich ist, erfolgt die Verbindungsherstellung 
auf dem iPhone in folgender Reihenfolge:
Â Es wird eine Verbindung mit dem zuletzt verwendeten WLAN-Netzwerk  hergestellt.
Â Eine Liste mit verfügbaren WLAN-Netzwerken wird angezeigt und eine Verbindung mit dem 
Netzwerk hergestellt, das Sie auswählen.
Â Wenn verfügbar, wird eine Verbindung über das Mobilfunknetz hergestellt.
Ist das iPhone über das Mobilfunknetz mit dem Internet verbunden, wird in der Statusleiste das 
Symbol  ,  ,  oder  angezeigt.
Die 4G- und 3G GSM-Datennetze unterstützen die gleichzeitige Sprach- und 
Datenkommunikation. Bei allen anderen Netzwerkverbindungen können Sie Internetdienste 
beim Telefonieren nicht nutzen. Dies ist nur dann möglich, wenn das iPhone auch über eine 
WLAN-Verbindung zum Internet verfügt. Abhängig von Ihrer Netzwerkverbindung können 
Sie möglicherweise keine Anrufe empfangen, während das iPhone Daten über das Funknetz 
überträgt, etwa beim Laden einer Webseite.
GSM:  Bei einer EDGE- oder GPRS-Verbindung werden eingehende Anrufe möglicherweise direkt 
während der Datenübertragung an Voicemail geleitet. Nehmen Sie einen eingehenden Anruf an, 
wird die Datenübertragung angehalten.
CDMA:  Bei EV-DO-Verbindungen wird die Datenübertragung angehalten, wenn Sie eingehende 
Anrufe annehmen. Bei 1xRTT-Verbindungen werden eingehende Anrufe möglicherweise direkt 
während der Datenübertragung an Voicemail geleitet. Nehmen Sie einen eingehenden Anruf an, 
wird die Datenübertragung angehalten.
Die Datenübertragung wird fortgesetzt, wenn Sie den Anruf beenden.
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„Netzwerk“ und aktivieren oder deaktivieren Sie die Option „Mobile Daten“. 
Wenn mobile Daten deaktiviert sind, wird für das Empfangen und Senden von E-Mails, für das 
Surfen im Internet, für Push-Benachrichtigungen und andere Dienste WLAN verwendet. Wenn 
mobile Daten aktiviert sind, können Gebühren anfallen. Beispiel: Bestimmte Funktionen und 
Dienste wie „Siri “und „Nachrichten“ übertragen Daten, d. h. dass Ihre Nutzung dieser Dienste zu 
zusätzlichen Kosten führen kann.
Aktivieren und Deaktivieren des 
Sprach-Roamings (CDMA)
Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“. Deaktivieren Sie 
das Sprach-Roaming, um Kosten zu vermeiden, wenn Sie das Netz eines 
anderen Anbieters nutzen. Ist das Netz Ihres Anbieters nicht verfügbar, kann 
das iPhone keine Mobilfunkdienste (Daten- oder Sprachdienste) nutzen.
Aktivieren oder Deaktivieren von 
Daten-Roaming
Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“.
Wenn Sie sich in einer Region ohne Netzabdeckung durch Ihren Anbieter 
befinden, wird durch Daten-Roaming der Zugriff auf das Internet über 
ein anderes Funknetz aktiviert. Auf Reisen sollten Sie die Option „DatenRoaming“ deaktivieren, um Roaming-Gebühren zu vermeiden. Weitere 
Informationen unter „Netzbetreiber“ auf Seite 184.
Aktivieren oder Deaktivieren von 
3G
Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“. Diese Option ist 
nicht in allen Regionen verfügbar.
In einigen Fällen werden Internetdaten durch die Verwendung von 3G 
zwar schneller geladen, kann sich jedoch negativ auf die Batterieleistung 
auswirken. Wenn Sie häufig telefonieren, empfiehlt es sich, 3G zu 
deaktivieren, um die Batterielebensdauer zu verlängern.
Aktivieren oder Deaktivieren des 
persönlichen Hotspots
Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“ > „Persönlicher 
Hotspot“. Weitere Informationen unter „Persönlicher Hotspot“ auf Seite 183.
Hinzufügen einer neuen VPNKonfiguration
Wählen Sie „Einstellungen“ > „Allgemein“ > „Netzwerk“ > „VPN“ > „VPN 
hinzufügen“.
Erkundigen Sie sich bei Ihrem Netzwerkadministrator, welche Einstellungen 
verwendet werden müssen. In den meisten Fällen können Sie die gleichen 
VPN-Einstellungen für Ihr iPhone verwenden, die Sie auch auf dem 
Computer nutzen. 
Weitere Informationen unter „VPN“ auf Seite 183.
Bluetooth
Das iPhone kann sich drahtlos mit Bluetooth-Geräten wie Headsets, Kopfhörern und Auto-Kits 
verbinden, um Musik zu hören bzw. die Freisprecheinrichtung zu verwenden. Über Bluetooth 
können Sie auch das Apple Wireless Keyboard anschließen. Weitere Informationen unter 
„Verwenden eines Apple Wireless Keyboard“ auf Seite 29.
Aktivieren oder Deaktivieren von Bluetooth:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Bluetooth“ und aktivieren Sie Bluetooth.
Herstellen einer Verbindung zu 
einem Bluetooth-Gerät
Tippen Sie in der Geräteliste auf das Gerät und befolgen Sie die 
angezeigten Anleitungen zum Herstellen der Verbindung. Beachten Sie die 
Anleitungen zum Koppeln unter Bluetooth in der Dokumentation zu Ihrem 
Gerät.
iTunes WLAN Sync
Sie können das iPhone mit iTunes auf einem Computer synchronisieren, wenn sich beide Geräte 
im gleichen WLAN-Netzwerk befinden.
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konfigurieren, schließen Sie das iPhone an den gewünschten Computer an. Weitere Informationen 
unter „Synchronisieren mit iTunes“ auf Seite 19.
Nachdem Sie iTunes WLAN Sync konfiguriert haben, wird das iPhone einmal pro Tag 
synchronisiert, wenn es an eine Stromquelle angeschlossen ist und folgende Bedingungen erfüllt 
sind:
Â Das iPhone und der Computer müssen sich im gleichen WLAN-Netzwerk befinden.
Â iTunes muss auf dem Computer geöffnet sein.
Anzeigen des Datums und 
der Uhrzeit der letzten 
Synchronisierung
Wählen Sie „Einstellungen“ > „Allgemein“ > „iTunes WLAN Sync“.
Sofortiges Synchronisieren mit 
iTunes
Öffnen Sie „Einstellungen“ > „Allgemein“ > „iTunes WLAN Sync“ und wählen 
Sie „Jetzt synchronisieren“.
Spotlight-Suche
Mithilfe der Spotlight-Suchfunktion können Sie die Inhaltskategorien auswählen, die bei einer 
Suche berücksichtigt werden sollen, und festlegen, in welcher Reihenfolge diese Kategorien 
durchsucht werden sollen.
Festlegen der zu durchsuchenden Inhaltskategorien  Öffnen Sie „Einstellungen“ > „Allgemein“ > 
„Spotlight-Suche“ und wählen Sie die zu suchenden Objekte aus.
Festlegen der Reihenfolge der 
Kategorien in den Suchergebnissen
Wählen Sie „Einstellungen“ > „Allgemein“ > „Spotlight-Suche“. Legen Sie 
Ihren Finger neben einem Objekt auf  und ziehen Sie es dann nach oben 
oder unten. 
Automatische Sperre
Wenn das iPhone gesperrt ist, wird der Bildschirm ausgeschaltet, um Batteriestrom zu sparen und 
um zu vermeiden, dass das iPhone unbeabsichtigt bedient wird. Sie können trotzdem Anrufe und 
SMS-Nachrichten empfangen. Außerdem können Sie beim Musikhören oder beim Telefonieren die 
Lautstärke anpassen und die Mikrofontaste der iPhone-Ohrhörer verwenden. 
Festlegen, nach welcher Zeit das iPhone gesperrt wird: Öffnen Sie „Einstellungen“ > „Allgemein“ 
> „Automatische Sperre“ und wählen Sie eine Dauer.
Code-Sperre
Standardmäßig ist das iPhone so konfiguriert, dass kein Code eingegeben werden muss, um die 
Sperre aufzuheben.
Festlegen eines Codes: Tippen Sie auf „Einstellungen“, wählen Sie „Allgemein“ > „Code-Sperre“ 
und geben Sie einen vierstelligen Code ein. 
Falls Sie Ihren Code vergessen haben, müssen Sie die Software des iPhone wiederherstellen. 
Weitere Informationen unter „Aktualisieren und Wiederherstellen der iPhone-Software“ auf 
Seite 200.
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Ändern des Codes
Wählen Sie „Einstellungen“ > „Allgemein“ > „Code-Sperre“.
Festlegen, wann der Code 
eingegeben werden muss
Tippen Sie auf „Einstellungen“, wählen Sie „Allgemein“ > „Code-Sperre“ und 
geben Sie einen vierstelligen Code ein. Tippen Sie auf „Code anfordern“ und 
legen Sie fest, wie lange die Sperre des iPhone dauern soll, bevor es die 
Eingabe des Codes anfordert, um die Sperre wieder aufzuheben.
Aktivieren oder Deaktivieren des 
einfachen Codes
Wählen Sie „Einstellungen“ > „Allgemein“ > „Code-Sperre“. 
Der einfache Code umfasst nur vier Ziffern. Sie können die Sicherheit 
erhöhen, indem Sie statt eines einfachen Codes einen längeren Code 
verwenden, der aus einer Kombination von Zahlen, Buchstaben, Satz- und 
Sonderzeichen besteht.
Verhindern des Zugriffs auf Siri bei 
gesperrtem iPhone
Wählen Sie „Einstellungen“ > „Allgemein“ > „Code-Sperre“ > „Siri“. Weitere 
Informationen unter „Festlegen der Optionen für Siri“ auf Seite 46.
Aktivieren und Deaktivieren der 
Sprachwahl
Wählen Sie „Einstellungen“ > „Allgemein“ > „Code-Sperre“.
Wenn Sie die Sprachwahl deaktivieren, verhindern Sie, dass Anrufe mit 
Ihrem iPhone erfolgen, wenn es gesperrt ist. Diese Einstellung ist nur 
verfügbar, wenn Siri deaktiviert ist. Weitere Informationen zu, Wählen mit 
Siri finden Sie unter „Telefon“ auf Seite 48.
Löschen der Daten nach zehn 
fehlgeschlagenen CodeEingabeversuchen
Tippen Sie auf „Einstellungen“, wählen Sie „Allgemein“ > „Code-Sperre“ und 
tippen Sie auf „Daten löschen“. 
Nach zehn fehlgeschlagenen Code-Eingabeversuchen werden alle 
Einstellungen zurückgesetzt und alle Informationen und Medien werden 
durch Entfernen des für die Datenverschlüsselung verwendeten Codes 
(256-Bit-AES-Verschlüsselung) gelöscht.
Einschränkungen
Sie können für einige Apps und gekaufte Inhalte Einschränkungen festlegen. So können Eltern 
beispielsweise festlegen, dass Musik, die als „Explicit“ (Anstößig) gekennzeichnet ist, nicht in 
Wiedergabelisten angezeigt wird, oder sie können den Zugriff auf YouTube sperren.
Aktivieren von Einschränkungen:  Öffnen Sie den Bereich „Einstellungen“ > „Allgemein“ > 
„Einschränkungen“. Tippen Sie dann auf „Einschränkungen aktivieren“.
Wichtig:  Falls Sie Ihren Code vergessen haben, müssen Sie die Software des iPhone 
wiederherstellen. Weitere Informationen unter „Aktualisieren und Wiederherstellen der iPhoneSoftware“ auf Seite 200.
Sie haben folgende Möglichkeiten, Inhalte einzuschränken:
Safari Safari wird deaktiviert und das App-Symbol wird vom Home-Bildschirm entfernt. Das Surfen 
im Internet und die Wiedergabe von Clips im Internet ist mit Safari nicht möglich.
YouTube YouTube wird deaktiviert und das App-Symbol wird vom Home-Bildschirm entfernt.
Kamera Die Kamera wird deaktiviert und das App-Symbol wird vom Home-Bildschirm entfernt. Es 
können keine Fotos aufgenommen werden.
FaceTime Das Tätigen oder Annehmen von FaceTime-Videoanrufen ist nicht möglich.
iTunes Der iTunes Store wird deaktiviert und das App-Symbol wird vom Home-Bildschirm entfernt. 
Es ist nicht möglich, Inhalte anzusehen, zu kaufen oder zu laden.
Ping Sie können nicht auf Ping oder die Ping-Funktionen zugreifen.
Installieren von 
Apps
Der App Store wird deaktiviert und das App-Symbol wird vom Home-Bildschirm entfernt. Es 
können keine Apps auf dem iPhone installiert werden.
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angezeigt, wenn Sie den Home-Bildschirm anpassen.
Siri Siri kann nicht verwendet werden. Sprachbefehle und das Diktieren sind deaktiviert.
Anstößige Sprache Siri versucht, anstößige Ausdrücke durch Sterne zu ersetzen und einen Piepton zu 
verwenden.
Ort Deaktivieren Sie für bestimmte Apps Ortungsdienste. Sie können die Ortungsdienste auch 
sperren, damit keine Änderungen an den Einstellungen vorgenommen werden können 
einschließlich der Nutzung von Ortungsdiensten durch andere Apps.
Accounts Die aktuellen Einstellungen für „Mail“, „Kontakte“ und „Kalender“ sind gesperrt. Accounts 
können nicht erstellt, geändert oder gelöscht werden. Auch die iCloud-Einstellungen können 
nicht geändert werden.
In-App-Käufe Deaktivieren Sie die Option „In-App-Käufe“. Wenn Sie die Option aktivieren, können Sie in 
Apps, die Sie aus dem App Store geladen haben, zusätzliche Inhalte oder Funktionen kaufen.
Kennwort 
erforderlich
Diese Option erfordert die Eingabe Ihrer Apple-ID für In-App-Käufe nach einer von Ihnen 
festgelegten Zeitspanne.
Festlegen von 
Einschränkungen 
für Inhalte
Tippen Sie auf „Altersfreigaben für“ und wählen Sie aus der Liste ein Land aus. Sie können 
Einschränkungen basierend auf dem Freigabeschema des jeweiligen Landes für die 
folgenden Musik, Podcasts, Filme, Fernsehsendungen und Apps festlegen. Inhalte, die nicht 
den von Ihnen festgelegten Kriterien entsprechen, werden nicht auf dem iPhone angezeigt.
Multiplayer Spiele Ist die Option „Multiplayer-Spiele“ deaktiviert, ist es nicht möglich, einen anderen Spieler 
herauszufordern, Einladungen zu Spielen zu senden und zu empfangen oder Freunde im 
Game Center hinzuzufügen.
Freunde 
hinzufügen
Wenn diese Option deaktiviert ist, können Sie im Game Center keine Aufforderungen an 
Freunde senden oder von diesen empfangen. Sind die Multiplayer-Spiele aktiviert, können 
Sie mit vorhandenen Freunden weiterhin spielen.
Datum & Uhrzeit
Diese Einstellungen wirken sich auf die Zeit aus, die oben im Bildschirm in der Statusleiste sowie 
in Weltuhren und Kalendern angezeigt wird.
Festlegen des Formats für die Uhr des iPhone (24-Stunden- oder 12-Stunden-Format): Wählen 
Sie „Einstellungen“ > „Allgemein“ > „Datum & Uhrzeit“ und aktivieren oder deaktivieren Sie die 
24-Stunden-Uhr. (Das 24-Stunden-Format ist möglicherweise nicht in allen Regionen verfügbar.) 
Festlegen, ob das iPhone 
Datum und Uhrzeit automatisch 
aktualisieren soll
Wählen Sie „Einstellungen“ > „Allgemein“ > „Datum & Uhrzeit“ und 
aktivieren oder deaktivieren Sie die Option „Automatisch einstellen“.
Wenn das iPhone so eingestellt ist, dass die Zeitangabe automatisch 
aktualisiert wird, ruft es die korrekte Zeit vom Funknetz ab und aktualisiert 
diese entsprechend der Zeitzone, in der Sie sich befinden.
Nicht alle Mobilfunkanbieter unterstützen überall das Abrufen von 
Netzwerkzeiten. Wenn Sie unterwegs sind, kann das iPhone deshalb die 
lokale Zeit möglicherweise nicht automatisch einstellen.
Manuelles Festlegen von Datum 
und Uhrzeit
Wählen Sie „Einstellungen“ > „Allgemein“ > „Datum & Uhrzeit“ und 
deaktivieren Sie die Option „Automatisch einstellen“. Tippen Sie auf 
„Zeitzone“, um Ihre Zeitzone festzulegen. Tippen Sie auf „Datum & Uhrzeit“ 
> „Datum & Uhrzeit einstellen“ und geben Sie Datum und Uhrzeit ein.
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Sie können mehrere Tastaturen aktivieren, um in verschiedenen Sprachen zu schreiben. 
Außerdem können Sie Texteingabefunktionen wie die Rechtschreibprüfung aktivieren bzw. 
deaktivieren. Weitere Informationen zu Tastaturen finden Sie unter „Eingeben von Text, Zahlen und 
Symbolen“ auf Seite 26.
Weitere Informationen zu internationalen Tastaturen finden Sie unter Anhang A,„Internationale 
Tastaturen,“ auf Seite 193.
Landeseinstellungen
Mit den Landeseinstellungen legen Sie die Sprache für das iPhone fest, aktivieren und 
deaktivieren Sie die Tastaturbelegungen für verschiedene Sprachen und stellen Sie die Formate 
für Datum, Uhrzeit und Telefonnummern für Ihr Land ein.
Festlegen der Sprache für das iPhone: Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Landeseinstellungen“ > „Sprache“.
Festlegen des Kalenderformats Wählen Sie „Allgemein“ > „Landeseinstellungen“ > „Kalender“. Wählen Sie 
danach ein Format aus.
Festlegen der Sprache für Siri bzw. 
die Sprachsteuerung
Tippen Sie auf „Einstellungen“, wählen Sie „Allgemein“ > 
„Landeseinstellungen“ > „Sprachstrg.“ aus und tippen Sie auf die 
gewünschte Sprache.
Festlegen der Formate für Datum, 
Uhrzeit und Telefonnummern
Wählen Sie „Einstellungen“ > „Allgemein“ > „Landeseinstellungen“ > 
„Region“. Wählen Sie Ihre Region aus.
Die gewählte Region legt auch fest, welche Sprache für Tage und Monate in 
Apps verwendet wird.
Bedienungshilfen
Wählen Sie „Bedienungshilfen“, wenn Sie die Bedienungshilfen aktivieren wollen, und wählen Sie 
die gewünschten Funktionen aus. Weitere Informationen unter Kapitel 31,„Bedienungshilfen,“ auf 
Seite 161.
Profile
Diese Einstellung wird angezeigt, wenn Sie ein oder mehrere Profile auf dem iPhone installieren. 
Tippen Sie auf „Profile“, um Informationen über die installierten Profile zu sehen.
Zurücksetzen
Sie können das Wörterbuch, die Netzwerkeinstellungen, das Layout des Home-Bildschirms sowie 
Ortungswarnungen zurücksetzen. Außerdem können Sie Ihre gesamten Inhalte und Einstellungen 
löschen.
Löschen aller Inhalte und Einstellungen:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Zurücksetzen“ und tippen Sie auf „Inhalte & Einstellungen löschen“.
Nachdem Sie das Zurücksetzen des iPhone bestätigt haben, werden alle Inhalte, Informationen 
und Einstellungen gelöscht. Das iPhone muss erst konfiguriert werden, damit Sie es erneut 
benutzen können.
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auf „Alle Einstellungen“.
Alle Einstellungen werden zurückgesetzt.
Zurücksetzen der 
Netzwerkeinstellungen
Wählen Sie „Einstellungen“ > „Allgemein“ > „Zurücksetzen“ und tippen Sie 
auf „Netzwerkeinstellungen“.
Beim Zurücksetzen der Netzwerkeinstellungen wird die Liste mit allen 
bisher benutzten Netzwerken und VPN-Einstellungen entfernt, die 
nicht mithilfe eines Konfigurationsprofils installiert wurden. WLAN wird 
deaktiviert und dann wieder aktiviert. Dabei werden alle eventuell 
vorhandenen Verbindungen zu Netzwerken getrennt. Die Einstellungen für 
WLAN und die Option „Auf Netze hinweisen” bleiben aktiviert.
Wenn Sie VPN-Einstellungen entfernen wollen, die mithilfe eines 
Konfigurationsprofils installiert wurden, müssen Sie „Einstellungen“ > 
„Allgemein“ > „Profil“ und danach das zu löschende Profil auswählen 
und auf „Entfernen“ tippen. Dadurch werden außerdem alle anderen 
Einstellungen und Accounts im Zusammenhang mit diesem Profil gelöscht.
Zurücksetzen des 
Tastaturwörterbuchs
Wählen Sie „Einstellungen“ > „Allgemein“ > „Zurücksetzen“ und tippen Sie 
auf „Tastaturwörterbuch“.
Sie fügen Wörter zum Tastaturwörterbuch hinzu, indem Sie 
Korrekturvorschläge des iPhone ablehnen. Tippen Sie auf ein Wort, 
um den Korrekturvorschlag abzulehnen, und fügen Sie das Wort zum 
Tastaturwörterbuch hinzu. Durch Zurücksetzen des Tastaturwörterbuchs 
werden alle von Ihnen hinzugefügten Wörter gelöscht.
Zurücksetzen der Anordnung des 
Home-Bildschirms
Wählen Sie „Einstellungen“ > „Allgemein“ > „Zurücksetzen“ und tippen Sie 
auf „Home-Bildschirm“.
Zurücksetzen der 
Ortungswarnungen
Wählen Sie „Einstellungen“ > „Allgemein“ > „Zurücksetzen“ und tippen Sie 
auf „Ortungswarnungen zurücksetzen“.
Eine Ortungswarnung wird von einer App angezeigt, wenn sie versucht, 
die Ortungsdienste zu nutzen. Das iPhone zeigt für jede App eine 
Ortungswarnung an, wenn diese erstmals versucht, auf die Ortungsdienste 
zuzugreifen. Wenn Sie den Hinweis durch Tippen auf „Abbrechen“ 
beantworten, wird er künftig nicht mehr angezeigt. Tippen Sie auf 
„Ortungswarnungen zurücksetzen“, damit Sie erneut eine Anfrage für jede 
App erhalten.
App-Einstellungen
Ziehen Sie die anderen Kapitel zu Rate, um Informationen zu den verschiedenen AppEinstellungen zu erhalten. Wenn Sie zum Beispiel Näheres zu den Safari-Einstellungen wissen 
möchten, konsultieren Sie Kapitel 7,„Safari,“ auf Seite 81.
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A Anhang
Internationale Tastaturen ermöglichen die Eingabe von Textzeichen in unterschiedlichen 
Landessprachen, u. a. auch von asiatischen Sprachen und Sprachen mit der Schreibrichtung von 
rechts nach links.
Hinzufügen und Entfernen von Tastaturen
Zur Texteingabe in anderen Sprachen auf dem iPhone verwenden Sie unterschiedliche Tastaturen. 
Standardmäßig ist nur die Tastatur in der von Ihnen festgelegten Sprache verfügbar. Öffnen Sie 
die Tastatureinstellungen, um Tastaturen für andere Sprachen hinzuzufügen. Eine vollständige 
Liste der unterstützten iPhone-Tastaturen finden Sie auf der folgenden Website: www.apple.com/
de/iphone/specs.html
Hinzufügen einer Tastatur  Öffnen Sie in den Einstellungen „Allgemein“ > „Landeseinstellungen“, 
tippen Sie auf „Tastaturen“ und wählen Sie eine Tastatur aus der Liste aus. Wiederholen Sie diese 
Schritte, um weitere Tastaturen hinzuzufügen.
Entfernen einer Tastatur:  Öffnen Sie den Bereich „Einstellungen“ > „Allgemein“ > 
„Landeseinstellungen“ > „Tastaturen“. Tippen Sie dann auf „Bearbeiten“. Tippen Sie neben der 
Tastatur, die Sie entfernen möchten, auf  und tippen Sie dann auf „Löschen“.
Bearbeiten der Tastaturliste:  Wählen Sie „Einstellungen“ > „Allgemein“ > „Landeseinstellungen“ > 
„Tastaturen“. Tippen Sie auf „Bearbeiten“ und ziehen Sie  neben der gewünschten Tastatur, um 
diese an eine neue Position in der Liste zu bewegen.
Wechseln der Tastatur
Wechseln Sie die Tastatur, wenn Sie Text in einer anderen Sprache eingeben möchten.
Wechseln der Tastatur bei der Eingabe:  Legen Sie Ihren Finger auf die Globustaste  , um alle 
aktivierten Tastaturen anzuzeigen. Zur Auswahl einer Tastatur bewegen Sie Ihren Finger auf 
den Namen der Tastatur und heben ihn dann an. Die Globustaste  wird angezeigt, wenn Sie 
mindestens zwei Tastaturen aktiviert haben.
Sie können außerdem auf  tippen. Der Name der nun aktivierten Tastatur wird kurz 
eingeblendet, wenn Sie auf  tippen. Tippen Sie weiter, um weitere aktivierte Tastaturen 
aufzurufen.
Bei zahlreichen Tastaturen sind Buchstaben, Nummern und Symbole verfügbar, die nicht auf der 
Tastatur sichtbar sind.
Eingeben von Buchstaben mit Akzenten bzw. anderen Buchstabenalternativen:  Legen Sie den 
Finger auf die jeweilige Buchstaben-, Ziffern- oder Symboltaste und bewegen Sie ihn, um eine 
Variante auszuwählen. Bei der Tastatur für Thai können Sie zum Beispiel das sprachspezifische 
Ziffernzeichen auswählen, indem Sie auf die Taste mit der entsprechenden arabischen Ziffer 
tippen und den Finger darauf halten.
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Für die Eingabe von chinesischen Zeichen einschließlich Pinyin, Cangjie, Wubihua und Zhuyin 
stehen Ihnen verschiedene Tastaturen zur Verfügung. Sie können auch mit Ihrem Finger 
chinesische Zeichen auf den Bildschirm schreiben.
Texteingabe mit Pinyin
Verwenden Sie die QWERTY-Tastaturbelegung, um vereinfachtes oder traditionelles Pinyin 
einzugeben. Beim Schreiben werden die vorgeschlagenen Zeichen eingeblendet. Tippen Sie 
auf einen Vorschlag, um ihn auszuwählen, oder geben Sie weiter Text ein, um weitere Optionen 
anzuzeigen.
Wenn Sie weiterhin Pinyin ohne Leerzeichen eingeben, werden Satzvorschläge eingeblendet.
Texteingabe mit Cangjie
Geben Sie mithilfe der Cangjie-Tasten chinesische Zeichen ein. Beim Schreiben werden die 
vorgeschlagenen Zeichen eingeblendet. Tippen Sie auf ein Zeichen, um es auszuwählen, oder 
geben Sie bis zu fünf weitere Zeichenkomponenten ein, um weitere Zeichenoptionen anzuzeigen.
Texteingabe mit Wubihua
Verwenden Sie die Tastatur, um mit bis zu fünf Strichen chinesische Zeichen zu schreiben: 
horizontal, vertikal, nach links unten, nach rechts unten und Haken (beachten Sie die richtige 
Reihenfolge). So sollte das chinesische Zeichen ? (Kreis) mit einem vertikalen Strich ? beginnen.
Bei der Eingabe werden Zeichen vorgeschlagen (die am häufigsten verwendeten Zeichen werden 
zuerst angezeigt). Tippen Sie auf ein Zeichen, um es auszuwählen.
Wenn Sie das korrekte Zeichen nicht kennen, tippen Sie auf den Stern (*). Zum Anzeigen von 
weiteren Zeichenoptionen geben Sie ein anderes Zeichen ein oder blättern in der Liste mit den 
Zeichen.
Tippen Sie auf die Taste ??, um nur die Zeichen anzuzeigen, die exakt Ihrer Eingabe 
entsprechen. 
Texteingabe mit Zhuyin
Zhuyin-Zeichen können Sie mithilfe der Tastatur eingeben. Beim Schreiben werden die 
vorgeschlagenen chinesischen Zeichen eingeblendet. Tippen Sie auf einen Vorschlag, um ihn 
auszuwählen, oder geben Sie weiter Zhuyin-Buchstaben ein, um weitere Optionen anzuzeigen. 
Nach der Eingabe eines Anfangszeichens werden auf der Tastatur zusätzliche Zeichen angeboten.
Wenn Sie weiterhin Zhuyin ohne Leerzeichen eingeben, werden Satzvorschläge eingeblendet. 
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Wenn die Tastaturbelegungen für vereinfachtes oder traditionelles Chinesisch aktiviert sind, 
können Sie chinesische Zeichen mit dem Finger auf dem Bildschirm zeichnen bzw. schreiben. 
Beim Schreiben der Zeichen erkennt das iPhone diese und zeigt übereinstimmende Zeichen 
in einer Liste an. Die beste Übereinstimmung wird oben in der Liste angezeigt. Wenn Sie ein 
Zeichen auswählen, werden die wahrscheinlich folgenden Zeichen in der Liste als zusätzliche 
Auswahlmöglichkeiten angezeigt.
Touchpad
Komplexe Zeichen wie ? (Teil des Namens des internationalen Flughafens in Hongkong), ??
(Fahrstuhl), und ? (im Kantonesischen verwendeter Partikel) können eingegeben werden, indem 
mindestens zwei Zeichenkomponenten hintereinander eingegeben werden. Tippen Sie auf das 
Zeichen, um die eingegebenen Zeichen zu ersetzen. 
Auch römische Zeichen werden erkannt.
Konvertieren von vereinfachtem und traditionellem Chinesisch
Wählen Sie das Zeichen oder die Zeichen aus, das/die konvertiert werden soll(en), und tippen Sie 
dann auf „Ersetzen“. Weitere Informationen unter „Bearbeiten von Text“ auf Seite 28. Sie können 
vor dem Konvertieren einen vollständigen Satz eingeben.
Japanisch
Für die Eingabe von japanischen Zeichen stehen die Kana- oder Romaji-Tastaturen zur Verfügung. 
Sie können auch Smileys eingeben.
Eingeben von Zeichen in Japanisch Kana
Verwenden Sie die Kana-Tastaturbelegung, um Silben auszuwählen. Weitere Optionen für Silben 
können Sie anzeigen, indem Sie auf die Pfeiltaste tippen und eine andere Silbe oder ein anderes 
Wort im angezeigten Fenster auswählen.
Eingeben von Zeichen in Japanisch Romaji
Verwenden Sie die Romaji-Tastatur zur Eingabe von Silben. Oben auf der Tastatur werden 
alternative Auswahlmöglichkeiten angezeigt. Tippen Sie auf eine Alternative, um diese 
einzugeben. Weitere Optionen für Silben können Sie anzeigen, indem Sie auf die Pfeiltaste tippen 
und eine andere Silbe oder ein anderes Wort im angezeigten Fenster auswählen. 
Eingeben von Smileys
Auf einer japanischen Kana-Tastatur tippen Sie auf die Taste „^_^“.
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Nummerntaste  und dann auf die Taste „^_^“. 
Auf einer chinesischen Pinyin-Tastatur (vereinfacht oder traditionell) oder Zhuyin-Tastatur 
(traditionell) tippen Sie auf die Nummerntaste  und dann auf die Taste „^_^“.
Eingeben von Emoji-Zeichen
Verwenden Sie die Emoji-Tastatur, um Bildzeichen einzugeben. Sie können auch mit einer 
japanischen Tastatur Emoji-Zeichen eingeben. Beispiel: Geben Sie „???“ ein, um ? zu 
erhalten.
Durchsuchen der Kandidatenliste
Wenn Sie eine chinesische, japanische oder arabische Tastatur verwenden, werden die 
vorgeschlagenen Zeichen oder Kandidaten über der Tastatur angezeigt. Tippen Sie auf einen 
Kandidaten, um ihn auszuwählen, oder streichen Sie mit dem Finger nach links, um weitere 
Optionen anzuzeigen.
Durchsuchen der erweiterten Kandidatenliste:  Tippen Sie auf den Aufwärtspfeil rechts, um 
eine Liste mit allen Kandidaten anzuzeigen. Bewegen Sie den Finger nach oben oder unten, 
um die Liste zu durchblättern. Tippen Sie auf den Abwärtspfeil, um die zusammengefasste Liste 
anzuzeigen.
Verwenden von Kurzbefehlen 
Beim Verwenden von bestimmten chinesischen und japanischen Tastaturen können Sie einen 
Kurzbefehl für ein Wörterbuch mit Wort- und Eingabepaaren anlegen. Dieser wird zu Ihrem 
persönlichen Wörterbuch hinzugefügt. Wenn Sie ein Wort aus dem Wörterbuch eingeben und 
eine unterstützte Tastatur verwenden, wird das Wort bzw. Eingabepaar durch die zugehörige 
Eingabe ersetzt. Für die folgenden Tastaturen sind Kurzbefehle verfügbar:
Â Chinesisch – Vereinfacht (Pinyin)
Â Chinesisch – Traditionell (Pinyin)
Â Chinesisch – Traditionell (Zhuyin)
Â Japanisch (Romaji)
Â Japanisch (Kana)
Aktivieren oder Deaktivieren von Kurzbefehlen:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Tastatur“ > „Kurzbefehle“.
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Legen Sie den Finger auf ein Zeichen, um die verfügbaren diakritischen Zeichen anzuzeigen. 
Bewegen Sie dann den Finger auf das gewünschte Zeichen.
Sie können auch die folgende Tastenkombination eingeben, um Buchstaben mit diakritischen 
Zeichen einzugeben:
Â aa—â (a Zirkumflex)
Â aw—a (a Hatschek)
Â as—á (a Akut)
Â af—à (a Gravis)
Â ar—? (a Haken)
Â ax—ã (a Tilde)
Â aj—? (a Punkt darunter)
Â dd—d (d Bindestrich)
Â ee—ê (e Zirkumflex)
Â oo—ô (o Zirkumflex)
Â ow—o (o Horn)
Â w—u (u Horn)
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iPhone-Support-Website
Umfassende Support-Informationen finden Sie auf der Website www.apple.com/de/support/
iphone. Sie können auch die Option „Express Lane“ für individuellen Support verwenden (nicht in 
allen Ländern verfügbar). Zur Website expresslane.apple.com.
Neustarten oder Zurücksetzen des iPhone
Treten funktionelle Probleme auf, versuchen Sie, das iPhone neu zu starten, beenden Sie die 
verwendete App sofort oder setzen Sie das iPhone zurück.
Neustarten des iPhone: Drücken und halten Sie die Ein-/Aus-Taste, bis der rote Schieberegler 
angezeigt wird. Bewegen Sie den Schieberegler mit dem Finger, um das iPhone auszuschalten. 
Drücken und halten Sie die Ein-/Aus-Taste, bis das Apple-Logo angezeigt wird, um das iPhone 
erneut einzuschalten.
Sofortiges Beenden einer App: Drücken Sie die Ein-/Aus-Taste einige Sekunden lang, bis ein roter 
Regler eingeblendet wird. Drücken Sie danach die Home-Taste  und halten Sie sie gedrückt, bis 
die verwendete App beendet wird.
Sie können eine App auch aus der Liste der zuletzt verwendeten Apps löschen, um die App sofort 
zu beenden. Weitere Informationen unter „Öffnen und Wechseln von Apps“ auf Seite 21.
Wenn Sie das iPhone nicht ausschalten können oder das Problem weiterhin besteht, müssen Sie 
das iPhone möglicherweise zurücksetzen. Das Zurücksetzen sollte aber nur erfolgen, wenn ein 
Fehler durch das Aus- und erneute Einschalten des iPhone nicht behoben werden konnte.
Zurücksetzen des iPhone: Drücken Sie die Ein-/Aus-Taste und die Home-Taste  mindestens 
zehn Sekunden lang, bis das Apple-Logo angezeigt wird.
Erstellen eines iPhone-Backups
Sie können mit iCloud oder iTunes automatisch ein Backup Ihres iPhone erstellen. Wenn Sie 
festlegen, dass Backups automatisch mit iCloud erstellt werden sollen, können mit iTunes keine 
automatischen Backups auf Ihrem Computer erstellt werden. Sie können jedoch manuell Backups 
mit iTunes auf Ihrem Computer erstellen. 
Datensicherung mit iCloud 
iCloud erstellt täglich automatisch ein Backup des iPhone über WLAN, wenn das iPhone an eine 
Stromquelle angeschlossen und gesperrt ist. Datum und Uhrzeit des letzten Backups werden 
unten im Bildschirm „Speicher & Backup“ angezeigt. Für folgende Objekte können Sie mit iCloud 
ein Backup erstellen:
Â Gekaufte Musik, Fernsehsendungen, Apps und Bücher
Â Fotos und Videos im Album „Aufnahmen“
Â iPhone-Einstellungen
Â App-Daten
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Â Nachrichten (iMessage, SMS und MMS)
Â Klingeltöne
Hinweis:  Für gekaufte Musik kann nicht in allen Regionen ein Backup erstellt werden. 
Fernsehsendungen sind nicht in allen Regionen verfügbar.
Wenn Sie beim ersten Einrichten des iPhone die Option „iCloud-Backup“ nicht aktiviert haben, 
können Sie dies in den iCloud-Einstellungen nachholen. 
Aktivieren von iCloud-Backups Öffnen Sie „Einstellungen“ > „iCloud“ und melden Sie sich wenn erforderlich 
mit Ihrer Apple-ID und Ihrem Kennwort an. Öffnen Sie „Speicher & Backup“ 
und aktivieren Sie die Option „iCloud-Backup“.
Sofort Backup erstellen Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“ und tippen Sie 
auf „Backup jetzt erstellen“.
Verwalten Ihrer Backups Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“ und tippen Sie 
auf „Speicherplatz verwalten“. Tippen Sie auf den Namen Ihres iPhone.
Aktivieren oder Deaktivieren 
des Backups für das Album 
„Aufnahmen“
Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“ und tippen Sie 
auf „Speicherplatz verwalten“. Tippen Sie auf den Namen des iPhone und 
aktivieren bzw. deaktivieren Sie die Erstellung eines Backups für das Album 
„Aufnahmen“.
Anzeigen der Geräte, für die ein 
Backup erstellt wird
Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“ > „Speicherplatz 
verwalten“.
Stoppen von automatischen 
iCloud-Backups
Öffnen Sie „Einstellungen“ > „iCloud“ > „Speicher & Backup“ und 
deaktivieren Sie die Option „iCloud-Backup“. 
Musik, die nicht in iTunes gekauft wird, wird nicht in iCloud gesichert. Diese Inhalte müssen mit 
iTunes gesichert und wiederhergestellt werden. Weitere Informationen unter „Synchronisieren mit 
iTunes“ auf Seite 19.
Wichtig:  Nicht in allen Regionen können Backups von Musik oder Fernsehsendungen erstellt 
werden. Vorherige Einkäufe können möglicherweise nicht mehr verfügbar sein, sobald diese nicht 
mehr im iTunes Store, App Store oder iBookstore sind. 
Gekaufte sowie Fotostream-Inhalte beanspruchen keinen Teil Ihres kostenlosen 5 GBSpeicherplatzes in iCloud.
Datensicherung mit iTunes
 iTunes erstellt ein Backup der Fotos im Album „Aufnahmen“ bzw. „Gesicherte Fotos“, sowie 
von Textmitteilungen, Notizen, Anruflisten, Kontakten, Audioeinstellungen und vielem mehr. 
Mediendateien wie Musiktitel und einige Fotos werden nicht in das Backup eingeschlossen. Diese 
können jedoch wiederhergestellt werden, indem Sie das Gerät mit iTunes synchronisieren. 
Wenn Sie das iPhone an den Computer anschließen, mit dem Sie es normalerweise 
synchronisieren, erstellt iTunes in folgenden Fällen ein Backup:
Â Synchronisieren mit iTunes:  iTunes synchronisiert das iPhone immer dann, wenn Sie das 
iPhone an den Computer anschließen. Wurde ein iPhone nicht für die Synchronisierung mit 
iTunes konfiguriert, erstellt iTunes kein automatisches Backup. Weitere Informationen unter 
„Synchronisieren mit iTunes“ auf Seite 19. 
Â Aktualisieren bzw. Wiederherstellen des iPhone:  Bevor das iPhone aktualisiert und 
wiederhergestellt wird, erstellt iTunes automatisch ein Backup.
Das iPhone-Backup kann in iTunes auch verschlüsselt werden, um Ihre Daten zu schützen.
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Wiederherstellen der Dateien und Einstellungen auf dem iPhone:  Verbinden Sie das iPhone mit 
dem Computer, den Sie üblicherweise für die Synchronisierung verwenden, wählen Sie in iTunes 
iPhone aus und klicken Sie im Bildschirm „Übersicht“ auf „Wiederherstellen“.
Weitere Informationen zu Backups, einschließlich der Einstellungen und Informationen, die in 
einem Backup gespeichert sind, finden Sie unter: support.apple.com/kb/
HT1766?viewlocale=de_DE.
Entfernen eines iTunes-Backups
Sie können in iTunes ein iPhone-Backup aus der Backupliste entfernen. Dies ist zum Beispiel 
sinnvoll, wenn ein Backup auf einem fremden Computer erstellt wurde.
Entfernen eines Backups
1 Öffnen Sie in iTunes den Bereich „Einstellungen“.
Â Mac:  Wählen Sie „iTunes“ > „Einstellungen“.
Â Windows:  Wählen Sie „Bearbeiten“ > „Einstellungen“.
2 Klicken Sie auf „Geräte“ (das iPhone muss dafür nicht angeschlossen sein).
3 Wählen Sie die Sicherungskopie aus, die Sie entfernen möchten, und klicken Sie auf „Backup 
löschen“.
4 Bestätigen Sie, dass Sie das gewählte Backup entfernen möchten, indem Sie auf „Löschen“ klicken. 
Klicken Sie anschließend auf „OK“.
Aktualisieren und Wiederherstellen der iPhone-Software
Die iPhone-Software kann über „Einstellungen“ oder in iTunes aktualisiert werden. Sie können 
das iPhone auch löschen oder wiederherstellen. Verwenden Sie iCloud oder iTunes zum 
Wiederherstellen der Daten aus einem Backup.
Sie können über die iPhone-Oberfläche nicht mehr auf gelöschte Daten zugreifen. Die Daten 
werden jedoch nicht endgültig vom iPhone entfernt. Weitere Informationen zum endgültigen 
Löschen aller Inhalte und Einstellungen erhalten Sie unter „Zurücksetzen“ auf Seite 191.
Aktualisieren des iPhone
Die iPhone-Software kann über „Einstellungen“ oder in iTunes aktualisiert werden. 
Aktualisierung über WLAN auf dem iPhone:  Wählen Sie „Einstellungen“ > „Allgemein“ > 
„Softwareaktualisierung“, um nach verfügbaren Updates für das iPhone zu suchen.
Softwareaktualisierung in iTunes:  iTunes überprüft jedes Mal, wenn Sie das iPhone mit iTunes 
synchronisieren, ob eine Softwareaktualisierung verfügbar ist. Weitere Informationen unter 
„Synchronisieren mit iTunes“ auf Seite 19.
Weitere Informationen zum Aktualisieren und Wiederherstellen der iPhone-Software erhalten Sie 
unter support.apple.com/kb/HT4623?viewlocale=de_DE.
Wiederherstellen des iPhone
Stellen Sie das iPhone mit iCloud oder iTunes aus einem Backup wieder her. 
Von iCloud-Backup:  Setzen Sie das iPhone zurück, um alle Einstellungen und Daten zu löschen. 
Melden Sie sich bei iCloud an und wählen Sie bei der Einrichtung „Aus Backup wiederherstellen“ 
aus. Weitere Informationen unter „Zurücksetzen“ auf Seite 191.
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die Synchronisierung verwenden, wählen Sie in iTunes iPhone aus und klicken Sie im Bildschirm 
„Übersicht“ auf „Wiederherstellen“.
Wird die iPhone-Software wiederhergestellt, können Sie das iPhone entweder als neues 
Gerät konfigurieren oder Ihre Musik, Videos, Apps und andere Inhalte aus einem Backup 
wiederherstellen.
Weitere Informationen zum Aktualisieren und Wiederherstellen der iPhone-Software erhalten Sie 
unter support.apple.com/kb/HT1414?viewlocale=de_DE.
Dateifreigabe
Über die Dateifreigabe können Sie mit iTunes Dateien vom iPhone auf den Computer übertragen 
und umgekehrt. Verbinden Sie dazu das iPhone mithilfe eines USB-Kabels mit dem Computer. Die 
Dateifreigabe setzt voraus, dass die Dokumente mit einer kompatiblen App erstellt und in einem 
unterstützten Format gesichert werden.
Apps, die die Dateifreigabe unterstützen, werden in iTunes in der Liste für freigegebene Apps 
angezeigt. Für jede App werden in der Liste „Dateien“ die Dokumente angezeigt, die sich auf dem 
iPhone befinden. Informationen darüber, ob und ggf. in welcher Weise eine App die Dateifreigabe 
unterstützt, finden Sie in der jeweiligen Dokumentation. Beachten Sie, dass die Dateifreigabe nicht 
von allen Apps unterstützt wird.
Übertragen von Dateien vom iPhone auf den Computer:  Öffnen Sie in iTunes den Bereich 
„Apps“. Wählen Sie im Bereich „Dateifreigabe“ in der Liste links eine App aus. Klicken Sie danach 
in der Liste rechts auf die zugehörige Datei, die übertragen werden soll. Klicken Sie danach auf 
„Sichern unter“.
Übertragen von Dateien vom Computer auf das iPhone:  Öffnen Sie in iTunes den Bereich 
„Apps“. Wählen Sie im Bereich „Dateifreigabe“ in der Liste links eine App aus und klicken Sie 
auf „Hinzufügen“. Die Dateien werden sofort auf das Gerät übertragen, damit Sie sie mit der 
ausgewählten App verwenden können.
Löschen von Dateien vom iPhone:  Öffnen Sie in iTunes den Bereich „Apps“. Wählen Sie im 
Bereich „Dateifreigabe“ die entsprechenden Dateien aus und drücken Sie die Entf.-Taste.
Informationen zu Sicherheit, Software und Service
In dieser Tabelle ist aufgelistet, wo Sie weitere Informationen zur Sicherheit, Software und Service 
für das iPhone erhalten.
Näheres über Finden Sie hier
Sicherer Umgang mit dem iPhone Aktuelle Hinweise zur Sicherheit und andere 
Bestimmungen finden Sie im Handbuch Wichtige 
Produktinformationen unter www.apple.com/de/
support/manuals/iphone.
iPhone-Service & Support, Tipps, Benutzerforen und 
Apple-Software Downloads
Öffnen Sie www.apple.com/de/support/iphone/.
Service & Support durch Ihren Mobilfunkanbieter Wenden Sie sich an den Anbieter oder besuchen Sie 
dessen Website.
Die neuesten Informationen über das iPhone Öffnen Sie www.apple.com/de/iphone.
Erstellen einer Apple-ID Öffnen Sie appleid.apple.com.
Verwenden von iCloud Öffnen Sie www.apple.com/de/support/icloud.
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Verwenden von iTunes Öffnen Sie iTunes und wählen Sie „Hilfe“ > „iTunes-Hilfe“. 
Eine Online-Einführung zu iTunes (möglicherweise nicht 
in allen Ländern und Regionen verfügbar) finden Sie 
unter www.apple.com/de/support/itunes.
Verwenden von iPhoto in OS X Öffnen Sie iPhoto und wählen Sie „Hilfe“ > „iPhoto-Hilfe“.
Verwenden des Adressbuchs unter OS X Öffnen Sie das Adressbuch und wählen Sie „Hilfe“ > 
„Adressbuch-Hilfe“.
Verwenden von iCal in OS X Öffnen Sie iCal und wählen Sie „Hilfe“ > „iCal-Hilfe“.
Microsoft Outlook, Windows-Adressbuch oder Adobe 
Photoshop Elements
Beachten Sie die Informationen in der Dokumentation 
zu diesen Apps.
Ermitteln der Seriennummer, IMEI, ICCID oder MEID 
des iPhone
Sie finden die Seriennummer, IMEI-Nummer 
(International Mobile Equipment Identity), ICCDNummer oder MEID-Nummer (Mobile Equipment 
Identifier) des iPhone auf der iPhone-Verpackung. 
Alternativ können Sie auf dem iPhone auch 
„Einstellungen“ > „Allgemein“ > „Über“ wählen. Weitere 
Informationen erhalten Sie unter support.apple.com/kb/
ht1267?viewlocale=de_DE.
Garantieleistungen Folgen Sie zuerst den Tipps zur Fehlerbeseitigung 
in diesem Handbuch und in den Online-Ressourcen. 
Öffnen Sie www.apple.com/de/support oder ziehen 
Sie das Handbuch Wichtige Produktinformationen unter 
www.apple.com/de/support/manuals/iphone zu Rate.
Austauschprogramm der iPhone-Batterie Weitere Informationen erhalten Sie auf www.apple.com/
de/support/iphone/service/battery.
Verwenden des iPhone in einer Unternehmensumgebung
Besuchen Sie die Website www.apple.com/de/iphone/business um Näheres über die 
Unternehmensfunktionen des iPhone zu erfahren, einschließlich Microsoft Exchange, IMAP, 
CalDAV, CardDAV, VPN und vielem mehr. 
Verwenden des iPhone mit einem anderen Anbieter
Bei einigen Anbietern kann das iPhone entsperrt und somit in deren Mobilfunknetz verwendet 
werden. Wenn Sie wissen möchten, ob Ihr Mobilfunkanbieter diese Option anbietet, besuchen Sie 
Webseite: support.apple.com/kb/HT1937?viewlocale=de_DE. 
Wenden Sie sich an Ihren Mobilfunkanbieter, um Informationen zum Anmelden und zur 
Konfiguration zu erhalten. Verbinden Sie das iPhone mit iTunes, um den Vorgang abzuschließen. 
Hierfür können zusätzliche Gebühren anfallen.
Weitere Informationen zur Fehlerbehebung erhalten Sie unter support.apple.com/kb/
TS3198?viewlocale=de_DE.
Informationen zur Entsorgung und zum Recycling
Apple Recycling Program (verfügbar in einigen Regionen): Näheres zum kostenlosen Recycling 
Ihres ausgedienten Mobiltelefons sowie ein bereits freigemachtes Versandetikett und Anleitungen 
finden Sie unter: www.apple.com/de/recycling
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und Regelungen ordnungsgemäß entsorgen. Da das iPhone Elektronikkomponenten und eine 
Batterie enthält, darf das iPhone nicht mit dem normalen Hausmüll entsorgt werden. Wenn Sie 
Ihr gebrauchtes iPhone entsorgen wollen, können Sie sich von Ihrer örtlichen Verwaltung über 
Möglichkeiten zur Entsorgung und zum Recycling beraten lassen, das Gerät im nächstgelegenen 
Apple Store abgeben oder an Apple einsenden. Das Batterie wird ausgebaut und einem 
umweltverträglichen Recycling zugeführt. Weitere Informationen finden Sie unter: 
www.apple.com/de/recycling
Europäische Union – Informationen zur Entsorgung von elektronischen Geräten und Batterien:
Dieses Symbol bedeutet, dass Ihr Produkt und seine Batterie den geltenden Gesetzen und 
Regelungen entsprechend separat vom Hausmüll recycelt und entsorgt werden muss. Geben Sie 
dieses Produkt am Ende seines Lebenszyklus zur Entsorgung bei einer offiziellen Sammelstelle für 
Elektroschrott ab. Das ordnungswidrige Entsorgen von elektronischen Geräten durch Verbraucher 
kann strafbar sein. Durch getrenntes Sammeln und Recycling werden die Rohstoff-Reserven 
geschont und es ist sichergestellt, dass beim Recycling des Produkts alle Bestimmungen zum 
Schutz von Gesundheit und Umwelt eingehalten werden.
Näheres zum Recycling Ihres iPhone finden Sie unter: www.apple.com/de/recycling/
nationalservices/europe.html
Austauschprogramm der iPhone-Batterie: Die wiederaufladbare Batterie im iPhone darf nur 
von einem autorisierten Service-Partner ausgetauscht werden. Weitere Informationen zum 
Austauschen der Batterie finden Sie auf der folgenden Website: www.apple.com/de/batteries/
replacements.html
Deutschland: Dieses Gerät enthält Batterien. Es darf nicht mit dem normalen Hausmüll entsorgt 
werden. Entsorgen Sie dieses Gerät am Ende seines Lebenszyklus entsprechend den jeweiligen 
Vorschriften und Gesetzen.
Nederlands: Gebruikte batterijen kunnen worden ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) worden gedeponeerd.
Türkiye: EEE yönetmelig?ine (Elektrikli ve Elektronik Es¸yalarda Bazi Zararli Maddelerin 
Kullaniminin Sinirlandirilmasina Dair Yönetmelik) uygundur.
 Brasil: Informac¸o~es sobre descarte e reciclagem
O símbolo acima indica que este produto e/ou sua bateria não devem ser descartadas no lixo 
doméstico. Quando decidir descartar este produto e/ou sua bateria, fac¸a-o de acordo com as leis 
e diretrizes ambientais locais. Para informac¸ões sobre o programa de reciclagem da Apple, pontos 
de coleta e telefone de informac¸ões, visite www.apple.com/br/environment.
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Apple Inc. ist ständig darum bemüht, die Umweltbelastungen, die sich aus der Verwendung 
von Apple-Systemen und -Produkten ergeben können, möglichst gering zu halten. Weitere 
Informationen finden Sie unter: www.apple.com/de/environment
iPhone-Betriebstemperatur
Überschreitet die Temperatur im Inneren des iPhone die normale Betriebstemperatur, geschieht 
möglicherweise Folgendes, um die Temperatur zu verringern:
Â Der Ladevorgang wird unterbrochen.
Â Der Bildschirm wird abgedunkelt.
Â Das Mobilfunksignal wird schwächer.
Â Eine Temperaturwarnung wird angezeigt.
Wichtig:  Sie können das iPhone nicht verwenden, während die Temperaturwarnung auf dem 
Bildschirm angezeigt wird. Einzige Ausnahme ist das Absetzen eines Notrufs. Wenn das iPhone die 
interne Temperatur nicht regulieren kann, wird der Ruhezustand aktiviert, bis das Gerät abgekühlt 
ist. In diesem Modus sind mit dem iPhone auch keine Notrufe möglich. Legen Sie das iPhone an 
einen kühleren Ort und warten Sie einige Minuten, bevor Sie versuchen, das iPhone erneut zu 
verwenden.
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Perspectiva del iPhone
Salida de 
auriculares
Receptor
Interruptor 
de tono/silencio
Micrófono 
superior
Botones de 
volumen
Pantalla 
Retina de 
Apple
Altavoz
Botón de inicio
Cámara frontal
Cámara 
trasera
Flash LED
Bandeja de 
la tarjeta SIM
Conector Dock
Botón de 
encendido/
apagado
Micrófono 
inferior
Iconos de apps
Barra de 
estado
iPhone
Las funciones del iPhone y la pantalla de inicio pueden ser distintas, dependiendo de su modelo 
de iPhone y de si ha personalizado la pantalla de inicio.
Accesorios
Los accesorios siguientes están incluidos en el iPhone:
Cable de conector Dock a USB
Auriculares Apple con 
mando y micrófono
Herramienta de expulsión 
de tarjetas SIM
Adaptador de 
corriente USB
9Ítem Función
Auriculares Apple Earphones con 
mando a distancia y micrófono
Escuche música y vídeos y realice llamadas telefónicas. Consulte “Auriculares 
Apple Earphones con micrófono” en la página 34.
Cable de conector Dock a USB Use este cable para conectar el iPhone a su ordenador para sincronizarlo 
y cargarlo. Este cable puede utilizarse con la base de conexión opcional o 
conectarse directamente al iPhone.
Adaptador de corriente USB Conecte el adaptador de corriente al iPhone mediante el cable que se incluye y, a continuación, conéctelo a una toma de corriente estándar para 
recargar el iPhone.
Herramienta de expulsión de la 
tarjeta SIM (no incluida en todas 
las áreas).
Expulsar la bandeja de la tarjeta SIM.
Botones
Botón de encendido/apagado
Cuando no utilice el iPhone, puede bloquearlo para apagar la pantalla y ahorrar batería. 
Bloquear el iPhone:  Pulse el botón de encendido/apagado.
Cuando el iPhone está bloqueado, no ocurre nada si toca la pantalla. El iPhone puede seguir recibiendo llamadas, mensajes de texto y otras actualizaciones. También puede:
Â Escuchar música
Â Ajustar el volumen con los botones del lateral del iPhone (o de los auriculares del iPhone) 
mientras habla por teléfono o escucha música
Â Usar el botón central de los auriculares del iPhone para responder o finalizar una llamada, o 
para controlar la reproducción de audio (consulte “Cómo reproducir música y otros contenidos 
de audio” en la página 82)
Botón de 
encendido/apagado
Desbloquear el iPhone Pulse el botón de inicio  o el botón de encendido/apagado y, a continuación, arrastre el regulador.
Abrir la app Cámara cuando el 
iPhone está bloqueado
Pulse el botón de inicio  o el botón de encendido/apagado y, a continuación, arrastre  hacia arriba.
Acceder a los controles de audio 
cuando el iPhone está bloqueado
Haga doble clic en el botón de inicio  .
Desactivación del iPhone Mantenga pulsado el botón de encendido/apagado durante unos segundos hasta que aparezca el regulador rojo y arrástrelo.
Activación del iPhone Mantenga pulsado el botón de encendido/apagado hasta que aparezca el 
logotipo de Apple.
El iPhone está configurado por omisión para bloquearse automáticamente si no toca la pantalla 
durante un minuto. Para desactivar el bloqueo automático, o para cambiar el tiempo que el iPhone tarda en bloquearse, consulte “Bloqueo automático” en la página 181. Para que se solicite un 
código para desbloquear el iPhone, consulte “Bloqueo con código” en la página 181.
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El botón de inicio  le permite regresar a la pantalla de inicio en cualquier momento. Ofrece también otras funciones rápidas que resultan muy prácticas.
Ir a la pantalla de inicio:  Pulse el botón de inicio  .
En la pantalla de inicio, una sola pulsación abre una app. Consulte “Apertura y cambio de apps” en 
la página 20.
Mostrar la barra multitarea para ver 
las apps utilizadas recientemente
Con el iPhone desbloqueado, haga doble clic en el botón de inicio  . 
Mostrar los controles de reproducción de audio
Cuando el iPhone esté bloqueado:  Haga doble clic en el botón de inicio 
. Consulte “Cómo reproducir música y otros contenidos de audio” en la 
página 82.
Cuando esté utilizando otra app:  Haga doble clic en el botón de inicio  y, a 
continuación, deslice el selector de aplicación de izquierda a derecha.
Iniciar Siri (iPhone 4S) o “Control 
por voz”
Mantenga pulsado el botón de inicio  . Consulte Capítulo 4,“Siri,” en la 
página 41 y “Control por voz” en la página 31.
Botones de volumen
Cuando está hablando por teléfono o escuchando música, películas u otros archivos multimedia, 
los botones laterales del iPhone le permiten ajustar el volumen del sonido. En el resto de los casos, estos botones controlan el volumen del timbre, las alertas y otros efectos de sonido.
ADVERTENCIA: Para obtener información importante sobre cómo prevenir daños auditivos, 
consulte la Guía de información importante del producto en support.apple.com/es_ES/manuals/
iphone/ (España y Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ (México). 
Subir 
volumen
Bajar 
volumen
Para ajustar un límite de volumen para la música y los vídeos, vaya a Ajustes > Música.
También puede utilizar el botón de subir volumen para hacer una foto o grabar un vídeo. 
Consulte “Cómo hacer fotos y grabar vídeos” en la página 100.
Interruptor de tono/silencio
Desplace el interruptor de tono/silencio para poner el iPhone en modo de tono de llamada  o 
en modo de silencio  .
Tono
Silencio
Capítulo 1    Visión general 11En el modo de tono de llamada, el iPhone reproduce todos los sonidos. En el modo de silencio, el 
iPhone no suena y no emite ni alertas ni otros efectos de sonido.
Importante: Las alarmas del reloj, las apps de audio como Música y muchos juegos siguen emitiendo sonidos a través del altavoz integrado cuando el iPhone está en modo de silencio.
Para obtener información sobre la forma de cambiar los ajustes de sonido y vibración, consulte 
“Sonidos y el botón de tono/silencio” en la página 177.
Iconos de estado
Los iconos de la barra de estado en la parte superior de la pantalla proporcionan información sobre el iPhone:
Icono de estado Significado
Señal de telefonía móvil* Muestra si se encuentra en el radio de alcance de una red 
de telefonía móvil y si puede realizar y recibir llamadas. 
Cuantas más barras haya, más potente será la señal. Si 
no hay señal, en vez de las barras aparecerá la frase “Sin 
servicio”.
Modo Avión Muestra que el modo Avión está activado, lo que significa 
que no puede usar el teléfono, acceder a Internet ni usar 
dispositivos Bluetooth®. Las funciones no inalámbricas 
están disponibles. Consulte “Modo Avión” en la página 173.
UMTS Muestra que la red 4G UMTS (GSM) de su operador está 
disponible y que el iPhone puede conectarse a Internet 
a través de ella. (Solo en el iPhone 4S. No disponible en 
todas las áreas.) Consulte “Red” en la página 178.
UMTS/EV-DO Muestra que la red 3G UMTS (GSM) o EV-DO (CDMA) de 
su operador está disponible y que el iPhone puede conectarse a Internet a través de dicha red. Consulte “Red” en la 
página 178.
EDGE Muestra que la red EDGE (GSM) de su operador está disponible y que el iPhone puede conectarse a Internet a 
través de ella. Consulte “Red” en la página 178.
GPRS/1xRTT Muestra que la red GPRS (GSM) o 1xRTT (CDMA) de su 
operador está disponible y que el iPhone puede conectarse a Internet a través de dicha red. Consulte “Red” en la 
página 178.
Wi-Fi* Muestra que el iPhone está conectado a Internet mediante una red Wi-Fi. Cuantas más barras hay, más potente es 
la conexión. Consulte “Wi-Fi” en la página 173.
Compartir Internet Muestra que el iPhone está conectado a otro iPhone que 
ofrece la función Compartir Internet. Consulte “Compartir 
Internet” en la página 176.
Sincronización Muestra que el iPhone se está sincronizando con iTunes.
Actividad de red Muestra la actividad de red. Algunas apps de terceros 
también pueden usar el icono para mostrar un proceso 
activo.
Desvío de llamadas Muestra que el desvío de llamadas está activado en el 
iPhone. Consulte “Desvío de llamadas” en la página 67.
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VPN Muestra que está conectado a una red mediante VPN. 
Consulte “Red” en la página 178.
Bloqueo Muestra que el iPhone está bloqueado. Consulte “Botón 
de encendido/apagado” en la página 10.
TTY Muestra que el iPhone está ajustado para trabajar con 
un dispositivo TTY. Consulte “Compatibilidad TTY” en la 
página 171.
Reproducir Muestra que se está reproduciendo una canción, audiolibro o podcast. Consulte “Cómo reproducir música y otros 
contenidos de audio” en la página 82.
Bloqueo de la orientación vertical Muestra que la pantalla del iPhone está bloqueada en 
orientación vertical. Consulte “Ver en vertical u horizontal” en la página 22.
Alarma Muestra que hay una alarma activada. Consulte “Cómo 
ajustar alarmas” en la página 115.
Localización Indica que un ítem está utilizando los servicios de localización. Consulte “Localización” en la página 175.
Bluetooth* Icono azul o blanco: Bluetooth está activado y enlazado 
con un dispositivo. 
Icono gris: Bluetooth está activado y enlazado con un dispositivo, pero el dispositivo está fuera del radio de alcance 
o apagado. 
Sin icono: Bluetooth está apagado o no está enlazado con 
ningún dispositivo. 
Consulte “Dispositivos Bluetooth” en la página 35.
Batería Bluetooth Muestra el nivel de batería de un dispositivo Bluetooth 
enlazado compatible.
Batería Muestra el nivel de batería o el estado de la carga. 
Consulte “Batería” en la página 37.
* El uso de ciertos accesorios con el iPhone puede afectar al funcionamiento de las redes 
inalámbricas.
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ADVERTENCIA: Para evitar daños, lea todas las instrucciones de funcionamiento de este manual 
y la información sobre seguridad de la Guía de información importante del producto del iPhone
en support.apple.com/es_ES/manuals/iphone/ (España y Latinoamérica) o support.apple.com/
es_MX/manuals/iphone/ (México). antes de utilizar el iPhone.
·
Visualización del manual del usuario en el iPhone
El Manual del usuario puede visualizarse en el iPhone en Safari y en la app gratuita iBooks.
Visualizar el manual del usuario en Safari: Pulse  y, a continuación, pulse el favorito “Manual 
del usuario”.
Para añadir un icono del manual a la pantalla de inicio, pulse  y, a continuación, pulse “Añadir a 
pantalla de inicio”. Para verlo en un idioma distinto, pulse “Cambiar idioma” en la página principal 
de contenidos.
Visualizar el manual del usuario en iBooks:  Si no tiene instalado iBooks, abra App Store y, a continuación, busque e instale “iBooks”. Abra iBooks y pulse Tienda. Busque “Usuario del iPhone” y, a 
continuación, seleccione y descargue el manual.
Para obtener más información sobre iBooks, consulte Capítulo 30,“iBooks,” en la página 150.
Requisitos necesarios
Para utilizar el iPhone, necesita lo siguiente:
Â un contrato de servicio inalámbrico con el operador que ofrezca servicio para el iPhone en su 
zona;
Â un ID de Apple (para algunas características), que puede crearse durante la configuración;
Â un Mac o un PC con un puerto USB 2.0 y uno de estos sistemas operativos:
Â Mac OS X 10.5.8 o posterior
Â Windows 7, Windows Vista o Windows XP Home o Professional (SP3)
Â una conexión a Internet para su ordenador (se recomienda banda ancha);
Â iTunes 10.5 o posterior (para algunas características), disponible en www.itunes.com/es/
download.
Instalación de la tarjeta SIM
Si no le han facilitado ninguna tarjeta SIM para instalar, instálela antes de configurar el iPhone.
14Importante: La tarjeta SIM es necesaria para utilizar servicios de telefonía móvil al conectarse a 
redes GSM y a algunas redes CDMA. Es posible que un iPhone 4S que se haya activado en una red 
inalámbrica CDMA también utilice una tarjeta SIM para conectarse a una red GSM, principalmente 
para la itinerancia internacional. Su iPhone está sujeto a las políticas de su proveedor de servicios 
inalámbricos, que pueden incluir restricciones sobre el cambio de proveedor de servicios y sobre 
la itinerancia, incluso tras la terminación de cualquier contrato de servicio mínimo requerido. 
Póngase en contacto con su proveedor de servicios inalámbricos para obtener más detalles al respecto. La disponibilidad de las funciones de telefonía móvil dependerá de la red inalámbrica.
Instalación de la tarjeta SIM en el iPhone 4S
Tarjeta
micro-SIM
Bandeja de 
la tarjeta 
micro-SIM
Clip o herramienta 
de expulsión 
de tarjetas SIM
Instalar la tarjeta SIM:  Introduzca el extremo de un clip pequeño o la herramienta de expulsión 
de la SIM en el orificio de la bandeja de la tarjeta SIM. Extraiga la bandeja de la tarjeta SIM y coloque la SIM en la bandeja tal como indica la ilustración. Con la bandeja alineada y la tarjeta SIM en 
ella, coloque de nuevo la bandeja en su lugar con cuidado.
Configuración y activación
Para configurar y activar el iPhone, encienda el iPhone y siga las instrucciones del Asistente de 
Configuración. El Asistente de Configuración le guiará a lo largo del proceso de configuración, 
incluida la conexión a una red Wi-Fi, el inicio de sesión con un ID de Apple o la creación de un ID 
de Apple gratuito, la configuración de iCloud, la activación de las funciones recomendadas, como 
Localización y “Buscar mi iPhone”, y la activación del iPhone con su operador. También puede realizar una restauración a partir de una copia de seguridad iCloud o iTunes durante el proceso de 
configuración.
La activación puede realizarse a través de una red Wi-Fi o, con el iPhone 4S, a través de la red de 
telefonía móvil de su operador (no disponible en todas las áreas). Si ninguna de estas dos opciones se encuentra disponible, deberá conectar el iPhone a su ordenador para poder realizar la 
activación.
Conexión al ordenador
Si no dispone de acceso Wi-Fi o de telefonía móvil, es posible necesite conectar el iPhone al ordenador para completar la activación. Conectar el iPhone al ordenador también le permite sincronizar información, música y otros contenidos con iTunes. Consulte “Sincronización con iTunes” en la 
página 18.
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iPhone.
Conexión a Internet
El iPhone se conectará a Internet siempre que sea necesario, ya sea mediante una conexión Wi-Fi 
(si está disponible) o mediante la red de telefonía móvil de su operador. Para obtener información 
sobre cómo conectarse a una red Wi-Fi, consulte “Wi-Fi” en la página 173. 
Nota: Si no hay disponible ninguna conexión Wi-Fi a Internet, es posible que determinadas funciones y servicios del iPhone transfieran datos a través de la red de telefonía móvil de su operador, 
lo que podría suponer la aplicación de tarifas adicionales. Póngase en contacto con su operador 
para solicitar información sobre las tarifas de sus planes de datos de telefonía móvil. Para gestionar el uso de los datos de telefonía móvil, consulte “Red” en la página 178.
Configuración del correo y otras cuentas
El iPhone puede utilizarse con iCloud, Microsoft Exchange y muchos de los proveedores habituales de servicios de correo, contactos y calendarios a través de Internet. 
Si aún no dispone de una cuenta de correo electrónico, puede configurar una cuenta iCloud 
gratuita la primera vez que configure el iPhone, o posteriormente en Ajustes > iCloud. Consulte 
“iCloud” en la página 17.
Configurar una cuenta de iCloud: Vaya a Ajustes > iCloud.
Configurar cualquier otra cuenta: Vaya a Ajustes > “Correo, contactos, calendarios”.
Si su empresa u organización lo permite, puede añadir contactos mediante una cuenta LDAP o 
CardDAV. Consulte “Cómo sincronizar contactos” en la página 133.
Puede añadir una cuenta de calendario CalDAV y puede suscribirse a calendarios de iCal (.ics) o 
importarlos desde Mail. Consulte “Suscripción a calendarios” en la página 94.
Gestión del contenido en dispositivos iOS
Puede transferir información y archivos entre sus dispositivos iOS y ordenadores mediante iCloud 
o iTunes.
Â iCloud almacena contenidos, como música, fotos y otros tipos de archivos, y los transfiere de 
forma inalámbrica a sus otros dispositivos iOS y ordenadores mediante la tecnología push, de 
modo que todo se mantenga actualizado. Consulte “iCloud” más adelante.
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Los cambios que realice en un dispositivo se copiarán en el otro cuando realice una sincronización. También puede usar iTunes para copiar un archivo en el iPhone a fin de utilizarlo con 
una app, o para copiar en el ordenador un documento que haya creado en el iPhone. Consulte 
“Sincronización con iTunes” en la página 18.
Puede utilizar iCloud, iTunes, o ambos, según sus necesidades. Por ejemplo, puede utilizar Fotos en 
streaming de iCloud para obtener automáticamente fotos que haya realizado en el iPhone en sus 
otros dispositivos, y puede utilizar iTunes para sincronizar álbumes de fotos del ordenador en el 
iPhone.
Nota: No debe sincronizar ítems en el panel Información de iTunes (como contactos, calendarios 
y notas) y utilizar también iCloud para mantener esa información actualizada en sus dispositivos. 
Si hace ambas cosas, podrían duplicarse los datos.
iCloud
iCloud almacena sus contenidos, como música, fotos, contactos, calendarios y documentos compatibles. Los contenidos almacenados en iCloud se transfieren de forma inalámbrica a sus dispositivos iOS y ordenadores configurados con la misma cuenta de iCloud. 
iCloud está disponible en dispositivos iOS 5, en equipos Mac con OS X Lion 10.7.2 o posterior y en 
equipos PC con el Panel de control de iCloud para Windows (se requiere Windows Vista Service 
Pack 2 o Windows 7). 
Entre las funciones de iCloud se incluyen las siguientes:
Â iTunes en la nube: descargue compras anteriores de música y programas de televisión de iTunes 
en el iPhone de forma gratuita y en cualquier momento.
Â Apps y libros: descargue compras anteriores realizadas en las tiendas App Store y iBookstore en 
el iPhone de forma gratuita y en cualquier momento.
Â Fotos en streaming: las fotos que realice en un dispositivo aparecerán de forma automática en 
todos sus dispositivos. Consulte “Fotos en streaming” en la página 102.
Â Documentos en la nube: para apps con iCloud activado, mantenga actualizados los documentos 
y datos de las apps en todos sus dispositivos.
Â Correo, contactos, calendarios: mantenga actualizados sus contactos de correo, calendarios, notas 
y recordatorios en todos sus dispositivos.
Â Copia de seguridad: realice copias de seguridad del iPhone en iCloud automáticamente al conectarse a una fuente de alimentación y a una red Wi-Fi. Consulte “Realización de copias de 
seguridad del iPhone” en la página 189.
Â Buscar mi iPhone: localice su iPhone en un mapa, muestre un mensaje, reproduzca un sonido, bloquee la pantalla o borre los datos de forma remota. Consulte “Buscar mi iPhone” en la 
página 39.
Â Buscar a mis amigos: comparta su ubicación con personas importantes para usted. Descargue 
esta app gratuita en la tienda App Store.
Â iTunes Match: con una suscripción a iTunes Match, toda su música, incluida la música importada 
desde discos CD o adquirida en lugares distintos de iTunes, aparecerá en todos sus dispositivos 
y podrá descargarse y reproducirse bajo demanda. Consulte “iTunes Match” en la página 86.
Capítulo 2    Introducción 17Con iCloud, obtendrá una cuenta de correo electrónico gratuita y 5 GB de almacenamiento para 
su correo, sus documentos y sus copias de seguridad. La música, las apps, los programas de televisión y los libros que compre, así como el espacio que ocupe en Fotos en streaming, no se descontarán del total de su espacio libre.
Si dispone de una suscripción a MobileMe, podrá pasarse a iCloud desde un Mac o PC en la dirección www.me.com/move hasta el 30 de junio de 2012.
Nota: Es posible que iCloud no esté disponible en todas las áreas, y sus funciones pueden variar 
según el área.
Iniciar sesión o crear una cuenta iCloud:  En Ajustes, pulse iCloud. 
Activar o desactivar servicios de 
iCloud
Vaya a Ajustes > iCloud.
Activar copia de seguridad de 
iCloud
Vaya a Ajustes > iCloud > “Almacenamiento y copias”.
Buscar mi iPhone Visite www.icloud.com, inicie sesión con su ID de Apple y, a continuación, 
seleccione “Buscar mi iPhone”. 
Importante:  En el iPhone, debe activar el ajuste “Buscar mi iPhone” en 
Ajustes > iCloud para poder localizar el iPhone.
Adquirir más almacenamiento para 
iCloud
Vaya a Ajustes > iCloud > “Almacenamiento y copias” y, a continuación, 
pulse “Gestionar almacenamiento”. Para obtener información sobre la forma 
de comprar espacio de almacenamiento para iCloud, consulte la help.apple.
com/icloud.
Ver y descargar compras anteriores 
realizadas en la tienda iTunes Store
Vaya a iTunes y, a continuación, pulse Comprado.
Ver y descargar compras anteriores 
realizadas en la tienda App Store
Vaya a la tienda App Store, pulse Actualizar y, a continuación, pulse 
Comprado.
Ver y descargar compras anteriores 
realizadas en la tienda iBookstore
Vaya a iBooks, pulse Store y, a continuación, pulse Comprado.
Activar “Descargas automáticas” 
para música, apps o libros
Vaya a Ajustes > Store.
Para obtener más información sobre iCloud, visite www.apple.com/es/icloud. Para obtener información de soporte, visite www.apple.com/es/support/icloud/ (España), www.apple.com/mx/
support/icloud/ (México) y www.apple.com/la/support/icloud/ (Latinoamérica).
Sincronización con iTunes
La sincronización con iTunes copia información de su ordenador al iPhone, y viceversa. Puede realizar una sincronización conectando el iPhone al ordenador mediante el cable de conector Dock 
a USB, o puede configurar iTunes para que realice una sincronización inalámbrica vía Wi-Fi. Puede 
configurar iTunes para sincronizar música, fotos, vídeo, podcasts, apps y otros tipos de archivos. 
Para obtener información sobre la forma de sincronizar el iPhone con un ordenador, abra iTunes y 
seleccione “Ayuda iTunes” en el menú Ayuda.
Configurar la sincronización inalámbrica con iTunes:  Conecte el iPhone al ordenador utilizando el cable de conector Dock a USB. En iTunes, active “Sincronizar a través de Wi-Fi” en el panel 
Resumen del dispositivo. 
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los días. El iPhone debe estar conectado a una fuente de alimentación, tanto el iPhone como su 
ordenador deben estar conectados a la misma red inalámbrica y iTunes debe estar abierto en 
el ordenador. Para obtener más información, consulte “Sincronización con iTunes vía Wi-Fi” en la 
página 180. 
Consejos para realizar la sincronización con iTunes
Â Si utiliza iCloud para almacenar sus contactos, calendarios, favoritos y notas, no los sincronice 
también con su dispositivo utilizando iTunes.
Â Las compras realizadas en las tiendas iTunes Store o App Store en el iPhone se sincronizan con 
la biblioteca de iTunes. También puede adquirir o descargar contenidos y apps de iTunes Store 
en su ordenador, y después sincronizarlos con el iPhone.
Â En el panel Resumen del dispositivo, puede ajustar iTunes para que sincronice automáticamente su dispositivo cuando se conecte a su ordenador. Para invalidar temporalmente este ajuste, 
mantenga pulsadas las teclas Comando y Opción (Mac) o Mayúsculas y Control (PC) hasta vea 
que el iPhone aparece en la barra lateral.
Â En el panel Resumen del dispositivo, seleccione “Encriptar copia de seguridad del iPhone” si desea encriptar la información almacenada en su ordenador cuando iTunes realice una copia de 
seguridad. Las copias de seguridad encriptadas se indican con el icono de un candado  , y se 
requiere una contraseña para restablecer la copia de seguridad. Si no selecciona esta opción, las 
contraseñas (como las de las cuentas de correo) no se incluirán en la copia de seguridad y tendrán que volver a introducirse si utiliza la copia de seguridad para restaurar el dispositivo.
Â En el panel Información del dispositivo, cuando sincronice cuentas de correo, solo se transferirán los ajustes de su ordenador al iPhone. Los cambios que realice en una cuenta de correo 
electrónico del iPhone no afectan a la cuenta del ordenador.
Â En el panel Información del dispositivo, haga clic en Avanzado para seleccionar opciones que 
le permitan reemplazar la información del iPhone por la información de su ordenador en la siguiente sincronización.
Â Si escucha parte de un podcast o audiolibro, el lugar en que se haya quedado se incluirá si sincroniza este contenido con iTunes. Si empezó a escucharlo en el iPhone, podrá seguir donde lo 
dejó utilizando iTunes en el ordenador o viceversa. 
Â En el panel Foto del dispositivo, puede sincronizar fotos y vídeos de una carpeta de su 
ordenador.
Capítulo 2    Introducción 19Nociones básicas
3
Uso de las apps
Gracias a la pantalla táctil Multi-Touch de alta resolución y a sencillos gestos con los dedos, es 
muy fácil utilizar las apps del iPhone.
Apertura y cambio de apps
Pulse el botón de inicio  para ir a la pantalla de inicio y ver sus apps.
Abrir una app:  Púlsela.
Para volver a la pantalla de inicio, vuelva a pulsar el botón de inicio  . Desplace el dedo hacia la 
izquierda o hacia la derecha para ver otra pantalla de inicio.
Desplace el dedo hacia la izquierda o 
hacia la derecha para pasar a otra 
pantalla de inicio.
Haga doble clic en el botón de inicio  para mostrar la barra multitarea, donde aparecen las apps 
utilizadas más recientemente. Pulse una app para volver a abrirla o desplácese para ver más apps.
Apps utilizadas 
recientemente
20Eliminar una app de la barra 
multitarea
Mantenga pulsado el icono de la app hasta que comience a moverse y, a 
continuación, pulse  . Eliminar una app de la barra multitarea también 
fuerza su salida.
Desplazamiento
Arrastre hacia arriba o hacia abajo para desplazarse. En algunas pantallas, como las páginas web, 
también puede desplazarse lateralmente.
Si arrastra el dedo para desplazarse por la pantalla, no seleccionará ni activará nada.
Pulse ligeramente para desplazarse rápidamente.
Puede esperar a que el desplazamiento se detenga o bien tocar la pantalla para detenerlo inmediatamente. Tocar la pantalla para detener el desplazamiento no selecciona ni activa nada.
Para desplazarse rápidamente a la parte superior de una página, pulse la barra de estado situada 
en la parte superior de la pantalla.
Arrastre el dedo por el 
índice para desplazarse 
rápidamente. Pulse una 
letra para ir directamente 
a una sección. 
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diferentes; por ejemplo, puede abrir una nueva lista, reproducir una canción, abrir un mensaje de 
correo electrónico o mostrar la información de uno de sus contactos para que pueda llamarlo.
Zoom en las imágenes
Al visualizar fotos, páginas web, correo electrónico o mapas, puede acercar o alejar la imagen. Para 
ello, realice el movimiento de un pellizco con sus dedos o hacia dentro o hacia fuera. Con fotos y 
páginas web, puede pulsar dos veces (rápidamente) para acercar la imagen y volver a pulsar dos 
veces para alejarla. Con mapas, pulse dos veces para acercar la imagen y una vez con dos dedos 
para alejarla.
El zoom también es una prestación de accesibilidad que le permite ampliar la pantalla con cualquier app que esté usando para ayudarle a ver lo que hay en la pantalla. Consulte “Zoom” en la 
página 167.
Ver en vertical u horizontal
Muchas apps del iPhone le permiten ver la pantalla en orientación vertical u horizontal. Gire 
el iPhone y la pantalla girará también, ajustándose automáticamente para encajar en la nueva 
orientación.
Por ejemplo, puede preferir la orientación horizontal para ver páginas web en Safari, o al introducir texto. Las páginas web se escalan a la mayor anchura de pantalla en orientación horizontal, por 
lo que el texto y las imágenes se ven más grandes. El teclado en pantalla es también mayor.
Las películas vistas en Vídeos y en YouTube solo se muestran con orientación horizontal. La visualización de calles en Mapas también aparece solo en orientación horizontal.
Bloquear la pantalla en orientación vertical: Haga doble clic en el botón de inicio  , desplace la 
parte inferior de la pantalla de izquierda a derecha y pulse  .
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Personalización de la pantalla de inicio
Reorganización de las apps
Puede personalizar la disposición de los iconos de las apps en la pantalla de inicio (incluidas las 
apps del Dock de la parte inferior de la pantalla). Si lo desea, ordénelos mediante varias pantallas 
de inicio. También puede organizar las apps colocándolas en carpetas.
Reordenar los iconos:
1 Mantenga pulsada cualquier app en la pantalla de inicio hasta que empiece a moverse 
lateralmente.
2 Arrastre las apps para ordenarlas.
3 Pulse el botón de inicio  para guardar su disposición.
Mover un icono a otra pantalla Mientras ordena las apps, arrastre una hasta el borde de la pantalla.
Crear pantallas de inicio adicionales Mientras ordena las apps, desplácese hasta la pantalla de inicio situada más 
a la derecha y, a continuación, arrastre una app al borde derecho de la pantalla. Puede crear hasta 11 pantallas de inicio.
Restablecer la disposición por omisión de la pantalla de inicio
Vaya a Ajustes > General > Restablecer y, a continuación, pulse “Restablecer 
pantalla de inicio”.
Al restablecer la pantalla de inicio, se eliminan todas las carpetas que haya 
creado y se le aplica el fondo de pantalla por omisión.
Puede añadir iconos en la pantalla de inicio para abrir sus páginas web favoritas. Consulte “Clips 
web” en la página 81.
Cuando el iPhone esté conectado físicamente al ordenador (con el cable de conector Dock a USB), 
podrá personalizar sus pantallas de inicio utilizando iTunes. En iTunes, seleccione el iPhone en la 
lista Dispositivos y, a continuación, haga clic en Apps en la parte superior de la pantalla.
Organización mediante carpetas
Las carpetas le permiten organizar las apps de la pantalla de inicio. Puede colocar hasta 12 apps 
en una carpeta. El iPhone asigna automáticamente un nombre a las carpetas en el momento de 
crearlas, según la categoría de las apps que coloque al crearlas. Puede modificar este nombre 
siempre que lo desee. Al igual que las apps, las carpetas pueden reorganizarse arrastrándolas en 
las pantallas de inicio o en el Dock.
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El iPhone crea una nueva carpeta que incluye las dos apps y muestra el nombre de la carpeta. 
Puede pulsar el campo del nombre e introducir otro nombre.
Pulse una carpeta para abrirla. A continuación, puede pulsar una app situada en su interior para 
abrirla. Para cerrar una carpeta, pulse fuera de la carpeta o bien pulse el botón de inicio  .
Mientras ordena las apps:
Añadir una app a una carpeta Arrastre la app sobre la carpeta.
Eliminar una app de una carpeta Pulse la carpeta para abrirla y arrastre la app fuera de la carpeta.
Borrar una carpeta Mueva todas las apps fuera de la carpeta. La carpeta se elimina 
automáticamente.
Renombrar una carpeta Pulse la carpeta para abrirla y, a continuación, pulse el nombre de la parte 
superior y utilice el teclado para introducir un nuevo nombre.
Cuando haya terminado de organizar la pantalla de inicio, pulse el botón de inicio  para guardar 
los cambios.
Añadir un fondo de pantalla
Puede especificar una imagen o una foto como fondo de la pantalla bloqueada. También puede 
establecer el fondo de la pantalla de inicio. Puede elegir una imagen incluida con el iPhone, una 
foto del Carrete u otro álbum del iPhone.
Establecer el fondo de pantalla:
1 En Ajustes, seleccione “Fondo de pantalla”, pulse la imagen de la pantalla bloqueada y de la pantalla de inicio y, a continuación, pulse “Fondo de pantalla” o un álbum.
2 Pulse para elegir una imagen o una foto. Si selecciona una foto, arrástrela para colocarla donde 
desee y junte o separe los dedos sobre ella para acercar o alejar la imagen hasta que tenga el aspecto que quiera.
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pantalla de inicio o ambas.
Escritura
El teclado en pantalla aparece siempre que necesita introducir texto.
Introducción de texto
Utilice el teclado para introducir texto. El teclado corrige faltas de ortografía, predice lo que está 
escribiendo y aprende a medida que lo utiliza. Dependiendo de la app que esté utilizando, el teclado inteligente puede sugerir correcciones mientras escribe para ayudarle a evitar palabras mal 
escritas.
Escribir texto:  Pulse un campo de texto para que aparezca el teclado y, a continuación, pulse en 
el teclado.
Mientras escribe, cada letra aparecerá encima del dedo. Si pulsa la tecla equivocada, puede desplazar el dedo hasta la tecla correcta. La letra no aparecerá hasta que retire el dedo de la tecla.
Eliminar el carácter anterior Pulse  .
Escritura en mayúsculas Pulse la tecla Mayúsculas  antes de pulsar una letra. También puede mantener pulsada la tecla Mayúsculas y, a continuación, deslizar el dedo hasta 
una letra.
Escritura rápida de un punto y un 
espacio
Pulse dos veces en la barra espaciadora. Para activar y desactivar esta función, vaya a Ajustes > General > Teclado.
Utilizar la función de autocorrección para introducir “’ll”
Escriba “lll.” Por ejemplo, escriba “youlll” para obtener “you’ll.”
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mayúsculas
Pulse dos veces la tecla Mayúsculas  . Pulse la tecla Mayúsculas otra vez 
para desactivar el bloqueo de mayúsculas. Puede activar y desactivar esta 
función en Ajustes > General > Teclado.
Introducir números, signos de puntuación o símbolos
Pulse la tecla Número  . Pulse la tecla Símbolo  para ver más signos de 
puntuación y símbolos.
Ajustar opciones para escribir Vaya a Ajustes > General > Teclado.
Para escribir un carácter 
alternativo, mantenga pulsada 
una tecla y, a continuación, 
deslice el dedo para seleccionar 
una de las opciones.
Autocorrección y ortografía
Para muchos de los idiomas, el iPhone realiza correcciones automáticas de palabras mal escritas o 
muestra sugerencias a medida que se escribe. Cuando el iPhone sugiere una palabra, no es necesario dejar de escribir para aceptar la sugerencia.
Nota: Para ver una lista de los idiomas incluidos, consulte www.apple.com/es/iphone/specs.html
(España), www.apple.com/mx/iphone/specs.html (México) y www.apple.com/la/iphone/specs.
html (Latinoamérica).
Palabra 
sugerida
Aceptar la sugerencia: Escriba un espacio, un signo de puntuación o un retorno de carro.
Rechazar una sugerencia: Pulse la “x”.
Cada vez que rechace una sugerencia para la misma palabra, es más probable que el iPhone acepte la palabra.
El iPhone también puede subrayar las palabras que ya se han introducido y que podrían estar mal 
escritas.
Sustituir una palabra mal escrita Pulse la palabra y, después, pulse una de las grafías alternativas.
Si la palabra que desea no aparece, escríbala de nuevo.
Activar o desactivar la autocorrección y el corrector ortográfico
Vaya a Ajustes > General > Teclado.
Funciones rápidas y su diccionario personal
Las funciones rápidas le permiten escribir unos pocos caracteres en lugar de tener que escribir 
una palabra o frase más larga. Cada vez que escribe la función rápida, aparece el texto expandido. 
Por ejemplo, la función rápida “qhh” se expande a “¿Qué hacemos hoy?”. 
26 Capítulo 3    Nociones básicasCrear una función rápida:  Vaya a Ajustes > General > Teclado y, a continuación, pulse “Crear función rápida”.
Añada una palabra o frase a su diccionario personal de modo que el iPhone no intente corregirla ni sustituirla:  Cree la función rápida, pero deje en blanco el campo “Función rápida”.
Editar una función rápida Vaya a Ajustes > Teclado y, a continuación, pulse la función rápida.
Edición de texto
La pantalla táctil simplifica la modificación del texto introducido. Una lupa en pantalla le ayuda a 
situar el punto de inserción en el lugar exacto donde lo necesita. Los puntos de selección le permiten ampliar o reducir la selección de texto. También puede cortar, copiar y pegar texto y fotos 
en una misma app o entre distintas apps.
Situar el punto de inserción: Mantenga el dedo pulsado para mostrar la lupa y, a continuación, 
arrastre para colocar el punto de inserción.
Seleccionar texto: Pulse el punto de inserción para mostrar los botones de selección. 
También puede pulsar dos veces en una palabra para seleccionarla. En los documentos de solo 
lectura, como las páginas web o los mensajes de correo electrónico recibidos, mantenga el dedo 
sobre una palabra para seleccionarla. Arrastre los puntos de captura para seleccionar más o menos texto.
Cortar o copiar texto Seleccione texto y, a continuación, pulse Cortar o Copiar.
Pegar texto Pulse el punto de inserción y, a continuación, pulse Pegar. Se insertará el 
último texto cortado o copiado. También puede seleccionar texto y pulsar 
Pegar para reemplazarlo.
Deshacer la última edición Agite el iPhone y pulse Deshacer.
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o subrayarlo
Cuando esté disponible, pulse  y, a continuación, pulse Negrita/Cursiva/
Subrayar.
Obtener la definición de una 
palabra
Cuando esté disponible, pulse  y, a continuación, pulse Definir.
Obtener palabras alternativas Cuando esté disponible, pulse Sugerir y, a continuación, pulse una de las 
palabras.
Disposiciones de teclado
Puede utilizar Ajustes para especificar las disposiciones de teclado de los teclados de software y 
hardware. Las disposiciones que están disponibles dependen del idioma del teclado.
Seleccione una disposición de teclado: Vaya a Ajustes > General > Teclado > “Teclados internacionales” y seleccione un teclado.
En cada idioma, puede seleccionar opciones distintas tanto para el software en pantalla como 
para cualquier teclado externo de hardware. La disposición del teclado de software determina la 
disposición del teclado de la pantalla del iPhone. La disposición del teclado de hardware determina la disposición de un teclado inalámbrico de Apple conectado al iPhone.
Teclado inalámbrico Apple Wireless Keyboard
Puede utilizar un teclado inalámbrico de Apple (disponible por separado) para escribir en el 
iPhone. El teclado inalámbrico Apple Wireless Keyboard se conecta mediante Bluetooth. Consulte 
“Enlazar un dispositivo Bluetooth con el iPhone” en la página 36.
Cuando el teclado esté enlazado al iPhone, se conectará siempre que el teclado se encuentre 
dentro del radio de acción (hasta 10 metros). Sabrá que el teclado está conectado si no aparece el 
teclado en pantalla al pulsar en un campo de texto. Para ahorrar batería, desactive o desenlace el 
teclado cuando no lo vaya a utilizar.
Dictado
Gracias a la función de dictado, puede crear y editar textos dictándolos en lugar de escribiéndolos. 
Por ejemplo, puede dictar mensajes de correo electrónico, mensajes de texto y notas. La función 
de dictado funciona incluso con apps de otros fabricantes, por lo que puede hacer cosas como actualizar su estado de Facebook, publicar mensajes en Twitter o escribir y enviar fotos de Instagram. 
Puede dictar en cualquier momento en que el teclado en pantalla aparezca con la tecla  .
Nota: Active Siri en Ajustes > General > Siri. La función de dictado solo está disponible en el iPhone 4S y requiere acceso a Internet a través de una conexión de telefonía móvil o de una conexión 
Wi-Fi. Es posible que la función de dictado no esté disponible en todos los idiomas ni en todas 
las áreas, y puede que las funciones varíen de un área a otra. Pueden aplicarse tarifas de datos de 
telefonía móvil.
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Pulse para iniciar el 
Aparecen mientras Siri 
redacta el texto de su 
dictado.
Para añadir texto, vuelva a pulsar  y siga dictando. 
Puede utilizar la función de dictado para insertar una palabra o reemplazar un fragmento de texto 
seleccionado. Coloque el punto de inserción en el lugar donde desee añadir más texto, o seleccione el texto que desee reemplazar y, a continuación, pulse  y comience a dictar. Si desea cambiar 
una palabra, púlsela dos veces para seleccionarla, pulse  y, a continuación, diga en alto la palabra 
que desee.
Puede llevarse el iPhone al oído para empezar a dictar en lugar de pulsar  en el teclado. Para finalizar, baje el iPhone y vuelva a colocarlo delante de usted.
Añadir un signo de puntuación:  Diga el signo de puntuación. 
Por ejemplo, “Dear Mary comma the check is in the mail exclamation mark” daría lugar a “Dear 
Mary, the check is in the mail!”
Impresión
AirPrint
AirPrint le permite imprimir de forma inalámbrica en impresoras compatibles con AirPrint. Puede 
imprimir desde:
Â Mail: mensajes de correo electrónico y archivos adjuntos que puedan visualizarse en Vista 
Rápida
Â Fotos y Cámara: fotos
Â Safari: páginas web, archivos PDF y otros tipos de archivos adjuntos que puedan visualizarse en 
Vista Rápida
Â iBooks: archivos PDF
Â Mapas: visualización de un mapa que se muestra en la pantalla
Â Notas: nota que se muestra en estos momentos
Es posible que otras apps disponibles en la tienda App Store también sean compatibles con 
AirPrint.
Las impresoras compatibles con AirPrint no requieren configuración; solo es necesario conectarlas 
a la misma red Wi-Fi que el iPhone. Para obtener más información, vaya a support.apple.com/kb/
HT4356?viewlocale=es_ES.
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AirPrint usa su red Wi-Fi para enviar tareas de impresión de forma inalámbrica a su impresora. El 
iPhone y la impresora deben estar conectados a la misma red Wi-Fi.
Imprimir un documento:  Pulse  ,  o  (en función de la app que esté usando) y, a continuación, pulse Imprimir. Seleccione una impresora y las opciones de impresión y, a continuación, 
pulse Imprimir.
Consultar el estado de una tarea de 
impresión
Haga doble clic en el botón de inicio  y, a continuación, pulse Impresión.
La app Impresión aparece como la app más reciente cuando se está imprimiendo un documento. 
En la app aparecerá un globo con un número para indicar cuántos documentos se encuentran en 
la cola de impresión.
Si está imprimiendo más de un documento, seleccione una tarea de impresión para ver el resumen de su estado.
Cancelar una tarea de impresión Haga doble clic en el botón de inicio  , pulse Impresión, seleccione la tarea 
de impresión (si está imprimiendo más de un documento) y, a continuación, pulse “Cancelar impresión”.
Cómo buscar
Puede realizar búsquedas en muchas apps del iPhone, como Contactos, Mail, Calendario, Música, 
Mensajes, Notas y Recordatorios. Puede buscar en una app concreta o en todas a la vez.
Buscar en el iPhone:  Vaya a la pantalla Buscar. (En la primera página de inicio, desplace un dedo 
hacia la derecha o pulse el botón de inicio  .) Introduzca texto en el campo Buscar.
Los resultados de la búsqueda van apareciendo a medida que escribe. Pulse un ítem de la lista 
para abrirlo. Pulse Buscar para ocultar el teclado y ver más resultados.
Los iconos situados junto a los resultados de búsqueda muestran la app de la que proceden los 
resultados.
El iPhone puede mostrar el mejor resultado basándose en sus búsquedas anteriores. Los resultados de búsqueda de Safari incluyen opciones para buscar en Internet o en Wikipedia.
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Contactos Nombres, apellidos y nombres de empresa
Mail Campos De, Para y Asunto y los mensajes de todas las cuentas
Calendario Títulos de eventos, invitados, ubicaciones y notas
Música Música (nombres de canciones, artistas y álbumes) y títulos de podcasts, 
vídeos y audiolibros
Mensajes Nombres y texto de los mensajes
Notas El texto de las notas
Recordatorios Títulos
La función Buscar también incluye los nombres de las apps nativas e instaladas en el iPhone, de 
modo que puede emplear Buscar para localizar y abrir apps, en caso de que disponga de muchas.
Abrir apps desde Buscar Introduzca el nombre de la app y, a continuación, pulse para abrirla directamente desde los resultados de la búsqueda.
Utilice el ajuste “Búsqueda en Spotlight” para indicar los contenidos en los que se realizará la 
búsqueda y el orden de presentación de los resultados. Consulte “Búsqueda en Spotlight” en la 
página 180.
Control por voz
La función “Control por voz” le permite realizar llamadas de teléfono y controlar la reproducción 
de música mediante comandos de voz. En el iPhone 4S, también puede utilizar Siri para controlar 
el iPhone por voz. Consulte Capítulo 4,“Siri,” en la página 41.
Nota: Es posible que la función “Control por voz” no esté disponible en todos los idiomas. “Control 
por voz” no estará disponible en iPhone 4S cuando Siri esté activado.
Utilizar “Control por voz”: Mantenga pulsado el botón de inicio  hasta que aparezca la pantalla 
de “Control por voz” y escuche un sonido. También puede mantener pulsado el botón central de 
los auriculares del iPhone.
Para obtener el mejor resultado:
Â Hable al micrófono del iPhone como si estuviera realizando una llamada telefónica. También 
puede usar el micrófono del auricular manos libres Bluetooth o de un kit de coche Bluetooth 
compatible.
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Â Diga solo comandos y nombres del iPhone, y también números. Realice una breve pausa entre 
los comandos.
Â Utilice nombres completos.
Para obtener más información sobre el uso de “Control por voz”, incluida información sobre su uso 
en distintos idiomas, visite support.apple.com/kb/HT3597?viewlocale=es_ES.
Normalmente, “Control por voz” espera que usted pronuncie los comandos de voz en el idioma 
especificado para el iPhone (vaya a Ajustes > General > Internacional > Idioma). Los ajustes de 
“Control por voz” le permiten cambiar el idioma de los comandos de voz. Algunos idiomas están 
disponibles en distintos dialectos o acentos.
Cambiar el idioma o el país: Vaya a Ajustes > General > Internacional > “Control por voz” y, a continuación, pulse el idioma o país.
“Control por voz” para la app Música siempre está activado, pero para mayor seguridad puede impedir la marcación por voz cuando el iPhone esté bloqueado.
Desactivar la marcación por voz cuando el iPhone esté bloqueado: Vaya a Ajustes > General > 
“Bloqueo con código” y desactive “Marcación por voz”. Desbloquee el iPhone para utilizar la marcación por voz.
Consulte “Marcación por voz” en la página 61 y “Cómo utilizar Siri o “Control por voz” con 
Música” en la página 85.
Notificaciones
El centro de notificaciones muestra todas sus alertas en un único lugar, incluidas las alertas sobre:
Â Llamadas perdidas y mensajes de voz
Â Nuevos mensajes de correo electrónico
Â Nuevos mensajes de texto
Â Recordatorios
Â Eventos de calendario
Â Solicitudes de amistad (Game Center)
Â Tiempo
Â Bolsa
Mostrar el centro de notificaciones: Arrastre el dedo hacia abajo desde la parte superior de la 
pantalla. Desplácese por la lista para ver más alertas.
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la pantalla cuando se utiliza el iPhone. Puede ver todas sus alertas actuales en el centro de 
notificaciones.
Muchas apps, como Teléfono, Mensajes, Mail y App Store, pueden mostrar en su icono de la pantalla de inicio un globo de alerta con un número (que indica los ítems entrantes) o un signo de admiración (que indica un problema). Si estas apps están en una carpeta, el globo aparece sobre la 
carpeta. Un globo con un número muestra el número total de ítems que aún no se han revisado, 
como las llamadas de teléfono, los mensajes de correo electrónico y de texto que se han recibido, 
y las apps actualizadas pendientes de descarga. Un globo con un signo de admiración indica que 
existe algún problema con una app. 
Responder a una alerta en el centro 
de notificaciones
Pulse la alerta.
Responder a una alerta en la pantalla de bloqueo
Deslice el icono que se muestra en la alerta hacia la derecha.
Eliminar alertas del centro de 
notificaciones
Pulse  y, a continuación, pulse Borrar.
Ajustar opciones para 
notificaciones
Vaya a Ajustes > Notificaciones.
Twitter
Inicie sesión en su cuenta Twitter (o cree una cuenta nueva) en Ajustes para activar los mensajes 
de Twitter con archivos adjuntos procedentes de las siguientes apps:
Â Cámara o Fotos: con una foto
Â Safari: con una página web
Â Mapas: con una ubicación 
Â YouTube: con un vídeo
Iniciar sesión en una cuenta Twitter o crear una cuenta nueva:  Vaya a Ajustes > Twitter. 
Introduzca el nombre de usuario y la contraseña de una cuenta existente o pulse “Crear nueva 
cuenta”.
En Cámara o Fotos, 
pulse el botón Acción 
para publicar una foto 
en Twitter.
Publicar una foto 
en Twitter.
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o una página web
Visualice el ítem, pulse  y, a continuación, pulse Twitter. Si no se muestra 
, pulse la pantalla.
Para incluir su ubicación, pulse “Añadir ubicación”. Los servicios de localización deben estar activados en Ajustes > Localización.
Mostrar una ubicación en Mapas Pulse la ubicación, pulse  , pulse “Compartir ubicación” y, a continuación, 
pulse Twitter. 
Añadir su ubicación actual a Twitter Pulse  . Los servicios de localización deben estar activados en Ajustes > 
Localización.
Añadir nombres de usuario y fotos 
de Twitter a sus contactos
Vaya a Ajustes > Twitter y, a continuación, pulse “Actualizar contactos”.
Activar o desactivar Twitter para 
Fotos o Safari
Vaya a Ajustes > Twitter.
Al escribir un mensaje de Twitter, el número que aparece en la esquina inferior derecha en la pantalla de Twitter indica el número de caracteres que aún puede introducir. Los archivos adjuntos 
utilizan parte de los 140 caracteres permitidos en Twitter.
También puede instalar y utilizar la app Twitter para publicar un mensaje en Twitter, ver su cronología, buscar temas de actualidad y muchas más cosas.
Instalar la app Twitter:  Vaya a Ajustes > Twitter y, a continuación, pulse Instalar.
Para aprender a utilizar la app Twitter, abra la app, pulse el botón Más (…), pulse “Cuentas y ajustes”, pulse Ajustes y, a continuación, pulse Manual.
Auriculares Apple Earphones con micrófono
Los auriculares Apple Earphones con mando a distancia y micrófono incluidos con el iPhone llevan un micrófono, botones de volumen y un botón integrado que le permite contestar y finalizar 
llamadas fácilmente, así como controlar la reproducción de audio y vídeo.
Botón central
Conecte los auriculares para escuchar música o realizar una llamada telefónica. Pulse el botón central para controlar la reproducción de música y contestar o terminar llamadas, aunque el iPhone 
esté bloqueado.
Poner en pausa una canción o 
vídeo
Pulse el botón central. Púlselo de nuevo para reanudar la reproducción.
Pasar a la canción siguiente Pulse dos veces rápidamente el botón central.
Volver a la canción anterior Pulse tres veces rápidamente el botón central.
Avanzar rápidamente Pulse dos veces rápidamente el botón central y manténgalo pulsado.
Retroceder Pulse tres veces rápidamente el botón central y manténgalo pulsado.
Ajustar el volumen Pulse el botón “+” o “–”.
Contestar a una llamada entrante Pulse el botón central.
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Rechazar una llamada entrante Mantenga pulsado el botón central durante unos dos segundos y, a continuación, suéltelo. Dos sonidos graves confirman que ha rechazado la 
llamada.
Cambiar a una llamada entrante o 
en espera y poner en espera la llamada actual
Pulse el botón central. Vuelva a pulsarlo para volver a la primera llamada.
Cambiar a una llamada entrante o 
en espera tras terminar la llamada 
actual
Mantenga pulsado el botón central durante unos dos segundos y, a continuación, suéltelo. Dos sonidos graves confirman que ha concluido la primera llamada.
Utilizar Siri o “Control por voz” Mantenga pulsado el botón central. Consulte Capítulo 4,“Siri,” en la página 41 o “Control por voz” en la página 31.
Si recibe una llamada mientras los auriculares están conectados, escuchará el tono tanto por el 
altavoz del iPhone como por los auriculares.
AirPlay
Puede transmitir música, fotos y vídeos de forma inalámbrica a su HDTV mediante AirPlay y un 
Apple TV. También puede utilizar AirPlay para transmitir audio a una estación base Airport Express. 
Existen otros receptores con AirPlay activado de otros fabricantes. Visite la tienda Apple Store en 
Internet para obtener detalles al respecto.
Transmitir contenido a un dispositivo con AirPlay activado:  Comience a reproducir el vídeo, el 
pase de diapositivas o la música y, a continuación, pulse  y seleccione el dispositivo AirPlay. Una 
vez que se inicie la transmisión, puede salir de la app que está reproduciendo el contenido.
El iPhone y el dispositivo con AirPlay activado deben estar conectados a la misma red Wi-Fi.
Obtener acceso rápido al control 
de AirPlay
Si la pantalla está encendida, haga doble clic en el botón de inicio  y desplácese a la izquierda del todo de la barra multitarea.
Volver a cambiar la salida de 
AirPlay al iPhone
Pulse  y seleccione el iPhone.
Con el iPhone 4S, puede duplicar la pantalla del iPhone en un televisor con Apple TV. Todo lo que 
aparezca en la pantalla del iPhone se mostrará en el televisor.
Duplicar la pantalla del iPhone en un televisor:  Pulse  en el extremo izquierdo de la barra 
multitarea, seleccione un Apple TV y, a continuación, pulse el botón Duplicación que aparece.
Aparece una barra de color azul en la parte superior de la pantalla del iPhone 4S cuando está 
activada la duplicación de AirPlay. También puede duplicar la pantalla del iPhone en un televisor 
utilizando un cable. Consulte “Ver vídeos en un televisor” en la página 138.
Dispositivos Bluetooth
Puede utilizar el iPhone con el teclado inalámbrico Apple Wireless Keyboard u otros dispositivos 
Bluetooth, como dispositivos manos libres, kits de coche y auriculares estéreo Bluetooth. Los auriculares Bluetooth de terceros pueden ser compatibles con los controles de volumen y reproducción. Consulte la documentación de su dispositivo Bluetooth. Para obtener más información, vaya 
a support.apple.com/kb/HT3647?viewlocale=es_ES.
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ADVERTENCIA: Para obtener información importante sobre cómo evitar pérdidas auditivas y 
conducir de manera segura, consulte la Guía de información importante del producto en support.
apple.com/es_ES/manuals/iphone/ (España y Latinoamérica) o support.apple.com/es_MX/
manuals/iphone/ (México).
Para poder utilizar un dispositivo Bluetooth con el iPhone, primero debe enlazarlos.
Enlazar un auricular manos libres, un kit de coche u otro dispositivo Bluetooth con el iPhone:
1 Siga las instrucciones que acompañan al dispositivo para hacerlo visible o ajustarlo de modo que 
busque otros dispositivos Bluetooth.
2 Vaya a Ajustes > General > Bluetooth y active Bluetooth.
3 Seleccione el dispositivo en el iPhone e introduzca su clave o número PIN. Consulte las instrucciones relativas a la clave o PIN que vienen con el dispositivo.
Tras enlazar un dispositivo Bluetooth para que funcione con el iPhone, debe realizar una conexión para que el iPhone utilice el dispositivo en sus llamadas. Consulte la documentación del 
dispositivo.
Cuando el iPhone está conectado a un auricular manos libres o kit de coche Bluetooth, las llamadas salientes se realizan a través del dispositivo. Las llamadas entrantes también se efectúan a 
través del dispositivo si responde utilizando el dispositivo, pero se realizan con iPhone si responde 
utilizando el iPhone.
Enlazar un teclado inalámbrico de Apple con el iPhone:
1 Vaya a Ajustes > General > Bluetooth y active Bluetooth.
2 Pulse el botón de encendido del teclado inalámbrico Apple Wireless Keyboard para encenderlo.
3 En el iPhone, seleccione el teclado en la lista Dispositivos.
4 Escriba la clave en el teclado, tal y como se indica, y pulse Retorno.
Nota: Solo puede enlazar un teclado inalámbrico Apple Wireless Keyboard a la vez con el iPhone. 
Para enlazar otro teclado, primero debe eliminar el enlace con el actual.
Para obtener más información, consulte “Teclado inalámbrico Apple Wireless Keyboard” en la 
página 28.
Estado Bluetooth
El icono Bluetooth puede verse en la barra de estado del iPhone, en la parte superior de la 
pantalla:
Â o  :  Bluetooth está activado y enlazado con un dispositivo. (El color depende del color que 
tenga la barra de estado.)
Â :  Bluetooth está activado y enlazado con un dispositivo, pero el dispositivo está fuera del radio 
de alcance o apagado.
Â Sin icono Bluetooth:  Bluetooth está apagado o no está enlazado con ningún dispositivo.
Desenlazar un dispositivo Bluetooth del iPhone
Puede desenlazar un dispositivo Bluetooth si no va a utilizarlo más con el iPhone.
Desenlazar un dispositivo Bluetooth:
1 Vaya a Ajustes > General > Bluetooth y active Bluetooth.
2 Pulse  junto al nombre del dispositivo y, a continuación, pulse “Omitir dispositivo”.
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El iPhone tiene en su interior una batería recargable.
Recarga de la batería
ADVERTENCIA: Para obtener información de seguridad importante sobre cómo cargar el iPhone, 
consulte la Guía de información importante del producto en support.apple.com/es_ES/manuals/
iphone/ (España y Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ (México). 
El icono de batería de la esquina superior derecha de la pantalla muestra el nivel de la batería o 
su estado de carga. También puede mostrar el porcentaje de carga de la batería. Vaya a Ajustes > 
General > Uso y active el ajuste situado bajo “Uso de la batería”.
Cargando Cargado
Recargar la batería: Conecte el iPhone a una toma de corriente utilizando el cable de conector 
Dock a USB incluido y el adaptador de corriente USB.
Nota: Conectar el iPhone a una toma de corriente puede iniciar una copia de seguridad de iCloud 
o una sincronización inalámbrica con iTunes. Consulte “Realización de copias de seguridad del 
iPhone” en la página 189 y “Sincronización con iTunes” en la página 18.
Recargar la batería y sincronizar el iPhone: Conecte el iPhone al ordenador utilizando el cable 
de conector Dock a USB incluido. O bien conecte el iPhone al ordenador utilizando el cable incluido y la base de conexión, disponible por separado.
A menos que su teclado tenga un puerto USB 2.0 de alta potencia, debe conectar el iPhone a un 
puerto USB 2.0 del ordenador.
Importante: La batería del iPhone puede descargarse en vez de cargarse si el iPhone está conectado a un ordenador que está apagado o en estado de reposo.
Si recarga la batería mientras sincroniza o utiliza el iPhone, el proceso de recarga puede precisar 
más tiempo. 
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imágenes, lo que indica que el iPhone necesita cargarse durante diez minutos aproximadamente 
antes de poder utilizarlo. Si el nivel de carga del iPhone es muy bajo, la pantalla puede apagarse 
hasta dos minutos antes de que aparezca una de las imágenes de batería baja.
o bien
Cómo maximizar la autonomía de la batería
El iPhone utiliza baterías de litio. Para obtener más información sobre cómo maximizar la autonomía de la batería del iPhone, visite www.apple.com/es/batteries (España), www.apple.com/mx/
batteries (México) y www.apple.com/la/batteries (Latinoamérica).
Sustitución de la batería
Las baterías recargables pueden recargarse un número limitado de veces, por lo que es posible 
que llegue un momento en el que deba sustituirlas. El usuario no puede reemplazar la batería del 
iPhone; solo debe hacerlo un proveedor de servicios autorizado. Para obtener más información, 
vaya a www.apple.com/es/batteries/replacements.html (España), www.apple.com/mx/batteries/
replacements.html (México) y www.apple.com/la/batteries/replacements.html (Latinoamérica)..
Funciones de seguridad
Las funciones de seguridad le permiten evitar que otros accedan a la información en el iPhone.
Códigos y protección de datos
Puede definir un código que deberá introducirse cada vez que encienda o active el iPhone.
Establecer un código: Vaya a Ajustes > General > “Bloqueo con código”, introduzca un código de 
4 dígitos y, a continuación, vuelva a introducirlo para verificarlo. El iPhone le solicitará entonces 
que introduzca el código para desbloquearse o para mostrar los ajustes del bloqueo con código.
Al especificar un código, se activa la protección de datos. La protección de datos utiliza el código 
como clave para encriptar los mensajes de correo y los documentos adjuntos almacenados en el 
iPhone. (La protección de datos también pueden utilizarla algunas apps disponibles en la tienda 
App Store.) Un aviso en la parte inferior de la pantalla “Bloqueo con código”, en Ajustes, muestra si 
la protección de datos está activada.
Para aumentar la seguridad del iPhone, desactive el código simple y use un código más largo 
con una combinación de números, letras, signos de puntuación y caracteres especiales. Consulte 
“Bloqueo con código” en la página 181.
Importante: En un iPhone 3GS que no incluyera de fábrica el iOS 4 o posterior, también debe 
restaurar el software iOS para activar la protección de datos. Consulte “Actualización y restauración 
del software del iPhone” en la página 191.
Desactivar la marcación por voz cuando el iPhone esté bloqueado: Vaya a Ajustes > General > 
“Bloqueo con código” y desactive “Marcación por voz”. Desbloquee el iPhone para utilizar la marcación por voz.
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La función “Buscar mi iPhone” le ayuda a localizar y proteger su iPhone mediante la app gratuita 
“Buscar mi iPhone” desde otro iPhone, iPad o iPod touch, o utilizando un navegador web para Mac 
o PC con una sesión iniciada en www.icloud.com o www.me.com.
Buscar mi iPhone” incluye:
Â Localizar en un mapa: Vea la ubicación aproximada de su iPhone en un mapa a pantalla 
completa.
Â Enviar un mensaje o reproducir un sonido: Le permite escribir un mensaje que aparecerá en 
la pantalla del iPhone, o reproducir un sonido a volumen máximo durante dos minutos, incluso 
si el interruptor de tono/silencio está en la posición de silencio.
Â Bloqueo con código remoto: Le permite bloquear su iPhone a distancia y crear un código de 
cuatro dígitos, si no lo había definido anteriormente.
Â Borrado a distancia: Le permite proteger su privacidad borrando todo el contenido y los datos 
del iPhone y restaurando los ajustes de fábrica.
Importante: Para poder usar sus características, la función “Buscar mi iPhone” debe estar activada 
en los ajustes de iCloud o MobileMe en su iPhone. La función “Buscar mi iPhone” solo puede estar 
activada en una cuenta.
Activar “Buscar mi iPhone” mediante iCloud
Vaya a Ajustes > iCloud y active “Buscar mi iPhone”. 
Activar “Buscar mi iPhone” mediante MobileMe
Vaya a Ajustes > “Correo, contactos, calendarios”, pulse su cuenta MobileMe 
y, a continuación, active “Buscar mi iPhone”. 
Consulte “iCloud” en la página 17 o “Configuración del correo y otras cuentas” en la página 16.
Limpieza del iPhone
Limpie el iPhone inmediatamente si entra en contacto con cualquier sustancia que pueda mancharlo, como tinta, colorantes, productos de maquillaje, barro, comida, aceite o lociones. Para 
limpiar el iPhone, desconecte todos los cables y apague el iPhone (mantenga pulsado el botón 
de encendido/apagado y, a continuación, arrastre el regulador rojo que aparece en pantalla). A 
continuación, utilice un paño suave, ligeramente húmedo y que no desprenda pelusa. Evite que 
entre humedad en las aberturas. No utilice limpiacristales, limpiadores domésticos, aire comprimido, aerosoles, disolventes, alcohol, amoniaco o productos abrasivos para limpiar el iPhone. La 
cubierta delantera del iPhone 3GS y las cubiertas delantera y posterior del iPhone 4S y iPhone 4 
están hechas de vidrio y poseen un revestimiento oleófobo. Para limpiar dichas superficies, utilice 
un paño suave que no desprenda pelusa. Con el uso habitual, la capacidad de este revestimiento 
para repeler las sustancias grasientas disminuye a lo largo del tiempo. Asimismo, si frota la pantalla con un material abrasivo, el efecto del revestimiento se verá disminuido y el vidrio podría llegar 
a rayarse.
Para obtener más información sobre cómo utilizar el iPhone, consulte la Guía de información 
importante del producto del iPhone en support.apple.com/es_ES/manuals/iphone/ (España y 
Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ (México).
Reinicio o restauración
Si hay algo que no funciona correctamente, pruebe a reiniciar el iPhone, forzar la salida de una 
app o restablecer el iPhone.
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regulador rojo. Deslice el dedo por el regulador para apagar el iPhone. Para volver a encender el 
iPhone, mantenga pulsado el botón de encendido/apagado hasta que aparezca el logotipo de 
Apple.
Si no puede apagar el iPhone o si el problema persiste, puede ser necesario restablecer el iPhone. 
Solo hay que recurrir a esta opción si al apagar y encender el iPhone no se resuelve el problema.
Forzar el cierre de una app: Mantenga pulsado el botón de encendido/apagado durante unos 
segundos hasta que aparezca un regulador rojo y, a continuación, mantenga pulsado el botón de 
inicio  hasta que la app se cierre.
También puede forzar la salida de una app eliminándola de la barra multitarea. Consulte “Apertura 
y cambio de apps” en la página 20.
Restablecer el iPhone: Mantenga pulsado el botón de encendido/apagado y el botón de inicio 
durante al menos diez segundos, hasta que aparezca el logotipo de Apple.
Para obtener más sugerencias sobre la solución de problemas, consulte Apéndice B,“Información 
de soporte e información adicional,” en la página 189.
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¿Qué es Siri?
Siri es un asistente personal inteligente que le ayuda a realizar operaciones simplemente hablando. Siri entiende el habla natural, de modo que no es necesario que se aprenda comandos especí-
ficos ni que recuerde palabras clave. Puede pedir las cosas de distintas formas. Por ejemplo, puede 
decir “Set the alarm for 6:30 a.m.” o “Wake me at 6:30 in the morning”. En cualquiera de los dos 
casos, Siri hará lo que le pide.
Siri le permite escribir y enviar mensajes, programar reuniones, realizar llamadas telefónicas, obtener direcciones, ajustar un recordatorio, realizar búsquedas en Internet y muchas más cosas simplemente hablando de forma natural. Siri entiende lo que usted dice y sabe a qué se refiere. Siri 
le repite lo que ha dicho para que sepa lo que ha entendido, y hace preguntas si necesita alguna 
aclaración o más información. Es muy parecido a tener una conversación con una persona.
Por ejemplo, si pregunta “Any good burger joints around here?” es probable que Siri le responda “I 
found a number of burger restaurants near you”. Si dice “Hmm. How about tacos”, Siri recuerda que 
acaba de preguntar por restaurantes y busca restaurantes mexicanos por el barrio.
Además de la capacidad de procesamiento interno del iPhone, Siri utiliza los centros de datos de 
Apple para entender lo que dice y contestar rápidamente. Siri también utiliza la información de 
sus contactos, biblioteca musical, calendarios, recordatorios, etc., para saber de qué está hablando.
Siri funciona con la mayoría de las apps integradas en el iPhone 4S y es lo suficientemente inteligente como para darse cuenta de qué app utilizar para una determinada petición. Siri también 
utiliza los servicios de búsqueda y localización para ayudarle con sus peticiones.
Hay infinidad de cosas que puede decirle a Siri. A continuación se muestra otra serie de ejemplos 
para principiantes:
Â Call Joe
Â Set the timer for 30 minutes
Â How far to the nearest Apple store?
Â Is it going to rain tomorrow?
Nota: Siri solo está disponible en el iPhone 4S y requiere acceso a Internet a través de una conexión de telefonía móvil o de una conexión Wi-Fi. Es posible que Siri no esté disponible en todos 
los idiomas ni en todas las áreas, y puede que las funciones varíen de un área a otra. Pueden aplicarse tarifas de datos de telefonía móvil.
Cómo utilizar Siri
Cómo iniciar Siri
Siri se activa pulsando un botón.
Iniciar Siri:  Pulse el botón de inicio  hasta que aparezca Siri.
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Simplemente comience a hablar. El icono de micrófono se iluminará para indicarle que Siri le está 
escuchando. Una vez que haya empezado a dialogar con Siri, pulse el icono de micrófono para 
volver a hablar.
Siri esperará a que termine de hablar, pero también puede pulsar el icono de micrófono para indicar a Siri que ya ha terminado. Esto resultará de gran utilidad cuando haya mucho ruido de fondo. 
También permite acelerar su conversación con Siri, puesto que Siri no tendrá que esperar ninguna 
pausa en su discurso.
Cuando termine de hablar, Siri le mostrará lo que ha entendido y le ofrecerá una respuesta. Siri 
suele incluir información adicional relacionada que puede resultar útil. Si la información está relacionada con una app (por ejemplo, un mensaje de texto que ha redactado o una ubicación por la 
que ha preguntado) simplemente pulse la pantalla para abrir la app a fin de obtener más detalles 
y nuevas acciones.
Lo que ha entendido Siri
Pulse para hablar a Siri.
Respuesta de Siri
Información relacionada; 
pulse para abrir la app.
Es posible que Siri le pida más información si la necesita para completar alguna petición. Por 
ejemplo, si le dice a Siri “Remind me to call mom”, Siri puede preguntarle: “What time would you 
like me to remind you?” No se preocupe de decirle a Siri todo a la vez. Siri le preguntará los detalles que sean necesarios.
Puede empezar a hablar a Siri simplemente llevándose el iPhone al oído, como para realizar una 
llamada telefónica. Si la pantalla no está encendida, pulse primero el botón de encendido/apagado o el botón de inicio. Escuchará dos pitidos rápidos que le indican que Siri está escuchando. A 
continuación, puede comenzar a hablar.
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Cancelar una petición Diga “cancel”, pulse  o pulse el botón de inicio  .
Detener una llamada telefónica que 
haya iniciado con Siri
Antes de que se abra Teléfono, pulse el botón de inicio  . Si Teléfono ya 
está abierto, pulse Finalizar.
Cómo darle información a Siri sobre usted
Cuanto más sepa Siri sobre usted, más podrá usar su información para ayudarle. Siri obtiene su 
información de su tarjeta de información personal (“Mis datos”) en Contactos.
Dígale a Siri quién es usted:  Vaya a Ajustes > Siri > “Mis datos” y, a continuación, pulse su nombre.
Introduzca las direcciones de su hogar y de su trabajo en su tarjeta para poder decir cosas de tipo 
“How do I get home?” y “Remind me to call Bob when I get to work”. 
Siri también querrá saber información sobre las personas más importantes para usted, por lo que 
es importante que especifique estas relaciones en su tarjeta de información personal. Siri puede 
hacer esto por usted. Por ejemplo, la primera vez que pida a Siri que llame a su hermana, Siri le 
preguntará quién es su hermana (si aún no tiene registrada esa información en su tarjeta). Siri 
añadirá dicha relación a su tarjeta de información personal de modo que no tenga que preguntarle la próxima vez. 
Cree tarjetas en Contactos para todas sus relaciones importantes e incluya información como nú-
meros de teléfono, direcciones de correo electrónico, direcciones del hogar y del trabajo, y sobrenombres que desee utilizar.
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Siri le ofrece ejemplos de frases que puede decir, directamente en la pantalla. Pregunte a Siri 
“what can you do” o pulse  la primera vez que aparezca Siri.
Siri manos libres
Puede utilizar Siri con los auriculares Apple Earphones con mando a distancia y micrófono incluidos con el iPhone, o con unos auriculares o auriculares con micrófono Bluetooth compatibles.
Hablar a Siri utilizando los auriculares:  Mantenga pulsado el botón central.
Hablar a Siri utilizando unos auriculares con micrófono Bluetooth:  Mantenga pulsado el botón 
de llamada.
Para continuar una conversación con Siri, mantenga pulsado el botón cada vez que desee hablar. 
Cuando utilice auriculares o unos auriculares con micrófono, Siri le comunicará sus respuestas. Siri 
repite los mensajes de texto y mensajes de correo electrónico dictados antes de enviarlos. De esta 
forma, tiene la oportunidad de cambiar un mensaje de texto si lo desea. Siri también repite los 
asuntos de los recordatorios antes de crearlos.
Contexto
Siri presta atención a dónde se encuentra y a lo que está haciendo para entender el contexto. Si 
acaba de recibir un mensaje de texto de Pedro, simplemente diga “Reply” y Siri sabrá que tiene 
que enviarle un mensaje a Pedro. Diga “Call him” y Siri sabrá que tiene que llamar a Pedro en lugar 
de enviarle un mensaje. Siri siempre le permite saber la acción que va a realizar. 
Cómo ajustar las opciones de Siri
Activar o desactivar Siri:  Vaya a Ajustes > General > Siri.
Nota: Si desactiva Siri, la aplicación se restablecerá y olvidará todo lo que ha aprendido sobre su 
voz.
Ajustar opciones para Siri:  Vaya a Ajustes > General > Siri.
Idioma:  Seleccione el idioma que desee utilizar con Siri.
Mensajes de voz:  Por omisión, Siri solo dice en alto sus respuestas si mantiene el iPhone cerca del 
oído o si utiliza Siri con auriculares o con unos auriculares con micrófono. Si desea que Siri siempre diga en alto sus respuestas, ajuste esta opción en Siempre.
Mis datos:  Indique a Siri qué tarjeta de Contactos contiene su información personal. Consulte 
“Cómo darle información a Siri sobre usted” en la página 43.
Elevar para hablar:  Háblele a Siri elevando el iPhone al oído cuando la pantalla esté encendida.
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a Ajustes > General > “Bloqueo con código”.
También puede desactivar Siri activando restricciones. Consulte “Restricciones” en la página 181. 
Localización
Puesto que Siri conoce ubicaciones como “current”, “home” y “work”, puede recordarle que haga 
una determinada tarea cuando abandone una ubicación o cuando llegue a otra ubicación. Dígale 
a Siri “Remind me to call my wife when I leave the office”, y Siri lo hará.
No se realiza un seguimiento de la información de localización y dicha información tampoco se 
almacena fuera del teléfono. Podrá seguir utilizando Siri con los servicios de localización desactivados, pero Siri no hará nada que requiera información de localización.
Desactivar la función Localización para Siri:  Vaya a Ajustes > Localización.
Accesibilidad
Siri es accesible a usuarios ciegos y con problemas de visión a través de VoiceOver, el lector de 
pantalla integrado en el iOS. VoiceOver describe en voz alta lo que hay en la pantalla (incluido el 
texto de las respuestas de Siri) de modo que pueda utilizar el iPhone sin verlo.
Activar VoiceOver:  Vaya a Ajustes > Accesibilidad.
La activación de VoiceOver hace que incluso sus notificaciones se lean en voz alta. Para obtener 
más información, consulte “VoiceOver” en la página 156.
Cómo corregir a Siri
Si Siri tiene problemas
Es posible que a veces Siri tenga problemas para entenderle. Por ejemplo, en un entorno ruidoso 
Siri puede tener dificultades para escuchar lo que está diciendo. Si habla con acento, Siri puede 
tardar un tiempo en acostumbrarse a su voz. Si Siri no le escucha con precisión, puede hacer 
correcciones.
Siri le mostrará lo que le ha entendido decir, junto con su respuesta. 
Corregir lo que Siri piensa que usted está diciendo:  Pulse el globo donde se muestra lo que Siri 
piensa que usted ha dicho. Edite su petición escribiendo o pulse  en el teclado para dictar.
Para obtener información sobre la forma de utilizar la función de dictado, consulte “Dictado” en la 
página 58.
Si parte del texto aparece subrayada en azul, púlsela para que Siri le sugiera alternativas. Pulse una 
de las sugerencias o reemplace el texto escribiendo o dictando texto nuevo.
Corregir a Siri hablando:  Pulse  y, a continuación, vuelva a plantear o aclare su petición. Por 
ejemplo, “I meant Boston”.
Cuando corrija a Siri, no le diga lo que no quiere, dígale únicamente lo que quiere.
Corregir un mensaje de correo o un mensaje de texto:  Si Siri le pregunta si desea enviar el mensaje, diga algo como:
“Change it to: Call me tomorrow.”
“Add: See you there question mark.”
“No, send it to Bob.”
“No.” (Para no enviar el mensaje)
“Cancel.”
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diga algo como “Yes, send it”.
Consulte “Mail” en la página 52 y “Mensajes” en la página 48.
Modo de aprendizaje de Siri
Siri funciona desde el principio sin configuración y va mejorando con el tiempo. Siri va aprendiendo las peculiaridades de su acento y otras características de su voz, y clasifica su voz en uno de los 
dialectos o acentos que entiende. A medida que haya más gente que utilice Siri y que vaya exponiéndose a más variaciones idiomáticas, la función de reconocimiento mejorará y Siri funcionará 
incluso mejor.
Entornos ruidosos
En un entorno ruidoso, mantenga el iPhone cerca de la boca, pero no hable directamente sobre el 
borde inferior. Siga hablando de forma clara y natural. Cuando termine de hablar, pulse  .
También puede intentar llevarse el iPhone al oído para hablarle a Siri.
Conexión de red
Es posible que Siri le indique que está teniendo problemas para conectarse a la red. Puesto que 
Siri depende de los servidores de Apple para el reconocimiento de voz y otros servicios, deberá 
disponer de una buena conexión de telefonía móvil 3G o 4G o de una buena conexión Wi-Fi a 
Internet. 
Siri y las apps
Siri funciona con la mayoría de las apps integradas en el iPhone 4S y utiliza las apps que necesita 
para ayudarle con sus peticiones. Siri sabe cuándo está usando una app, por lo que puede hacer 
referencia a los elementos de la pantalla. Por ejemplo, si está leyendo un mensaje en Mail, puede 
decir “Reply, I like it”. 
Teléfono
Utilice Siri para realizar una llamada de teléfono o iniciar una llamada FaceTime. Puede referirse a 
sus familiares, amigos y asociados de Contactos, o decir qué número de teléfono debe utilizarse. 
Por ejemplo:
Â Call Jennifer Wright mobile
Â Call Susan on her work phone
Â Call 408 555 1212
Â Call home
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Si dice tanto el nombre como el apellido, quedará claro a quién desea llamar, pero puede decir 
solo el nombre o solo el apellido y dejar que Siri deduzca a quién se refiere. Siri busca primero en 
sus favoritos y, si encuentra alguna coincidencia, llama a dicho número. A continuación, Siri busca 
en todos sus contactos. Si hay más de una persona con el mismo nombre, Siri le preguntará a cuál 
de ellas desea llamar. Siri también le preguntará qué número de teléfono debe utilizar si aparece 
más de uno en la lista.
También puede pedir a Siri que llame a un negocio de sus contactos.
Para que Siri sepa a quién se refiere cuando le pida que realice una llamada, asegúrese de presentarse a Siri. Consulte “Cómo darle información a Siri sobre usted” en la página 43. 
Detener una llamada telefónica que 
haya iniciado con Siri
Antes de que se abra Teléfono, pulse el botón de inicio  . Si la llamada 
telefónica está en curso, pulse Finalizar.
Música
Pida a Siri que reproduzca una canción, un álbum o una lista de reproducción. Ponga en pausa 
la reproducción y, a continuación, reanúdela. Ajuste el estilo pidiendo un determinado tipo de 
música.
O simplemente diga “Play” y deje que Siri elija por usted. Si no reconoce la canción, pregunte a Siri 
“What’s playing?”.
A continuación, se indican algunas formas de reproducir música con Siri:
Â Play The Light of the Sun
Â Play Trouble
Â Play Taking Back Sunday shuffled
Â Play Alicia Keys
Â Play some blues
Â Play my party mix
Â Shuffle my roadtrip playlist
Â Play
Â Pause
Â Resume
Â Skip
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reproducción Genius temporal, pero no la guardará.)
Mensajes
Puede enviar mensajes de texto, hacer que Siri le lea los mensajes nuevos y responder a los mensajes recibidos.
Incluya el nombre de la persona a la que desee escribir o espere a que Siri le pregunte a quién 
desea enviar el mensaje. Puede enviar mensajes a un número de teléfono y puede escribir a más 
de una persona a la vez.
Para enviar un mensaje, diga cosas de este tipo:
Â Tell Susan I’ll be right there
Â Send a message to Jason Russell
Â Send a message to Lisa saying how about tomorrow?
Â Send a message to Susan on her mobile saying I’ll be late
Â Send a message to 408 555 1212
Â Text Jason and Lisa where are you?
Para ver o escuchar los mensajes recibidos, puede decir:
Â Read me my messages
Â Show my new texts
Â Read it again
Si acaba de recibir un mensaje de texto o si está leyendo un mensaje recibido con anterioridad, 
puede decir simplemente:
Â Reply that’s great news
Â Tell him I’ll be there in 10 minutes
Â Call her
Siri entiende el contexto y sabe a quién dirigir la respuesta.
Antes de enviar un mensaje que haya redactado, Siri se lo mostrará o se lo leerá para asegurarse 
de que sea correcto. Cuando Siri le pregunte si desea enviar un mensaje, puede decir:
Â Change it to: Call me tomorrow
Â Add: See you there question mark
Â No, send it to Bob
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Â Cancel
Want to tag your message with a smiley face? Say “smiley face,” of course. :-)
Edición de mensajes
Si está creando un mensaje de texto con Siri pero se da cuenta de que no dice exactamente lo 
que quería, puede pedir a Siri que lo modifique. Si se parece mucho a lo que quería, es posible 
que desee modificarlo usted mismo. Cuando Siri le muestre el mensaje para que lo revise, pulse 
el globo del mensaje para abrirlo en la app Mensajes. A continuación, puede modificar el mensaje 
escribiendo o dictando nuevo texto. Consulte “Dictado” en la página 58.
Calendario
Añada nuevos eventos a su calendario, modifique los eventos existentes o sepa qué tiene programado. Al crear un evento, puede especificar una hora, un lugar, un título y las personas a las que 
desea invitar.
Para crear un evento:
Â Set up a meeting at 9
Â Set up a meeting with Michael at 9
Â Meet with Lisa at noon
Â Set up a meeting about hiring tomorrow at 9 a.m.
Â New appointment with Susan Park Friday at 3
Â Schedule a planning meeting at 8:30 today in the boardroom
Para cambiar o cancelar un evento:
Â Move my 3 p.m. meeting to 4:30
Â Reschedule my appointment with Dr. Manning to next Monday at 9 a.m.
Â Add Lisa to my meeting with Jason
Â Cancel the budget review meeting
Para preguntar a Siri por los eventos:
Â What does the rest of my day look like?
Â What’s on my calendar for Friday?
Â When is my next appointment?
Â When am I meeting with Michael?
Â Where is my next event?
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obtener más información, pulse el evento. 
Recordatorios
Siri es un buen medio para configurar un recordatorio rápido. 
Para crear un recordatorio, diga cosas de este tipo:
Â Remind me to call mom
Â Remember to take an umbrella
Â Remind me take my medicine at 6 a.m. tomorrow
Â Remind me when I leave to call Jason
Â Remind me to finish the report by 6
Siri le pedirá la información que necesita para crear el recordatorio, como la fecha, hora y 
ubicación.
Incluir información de localización permite que Siri le recuerde el ítem al acercarse o salir de una 
determinada ubicación. Una ubicación puede ser su ubicación actual (“here”) o una dirección de 
Contactos. Para permitir que Siri conozca la ubicación de su casa y de su trabajo, consulte “Cómo 
darle información a Siri sobre usted” en la página 43.
Â Remind me to call my mom when I get home
Â Remind me when I get to the office to call my wife
Â Remind me to pick up flowers when I leave here
Â Remind me to check the time when I get back here
Los recordatorios se añaden a la lista de recordatorios por omisión. 
Ajustar la lista por omisión para Recordatorios:  Vaya a Ajustes > Correo, contactos, calendarios > 
“Lista por omisión”.
Para guardar una lista sin ajustar ninguna hora ni ubicación específica que recordar:
Â Remember to buy milk
Â Add eggs to my groceries list
Si Siri le pregunta cuándo desea que se lo recuerde, puede decir “never”.
Si tiene una lista visible en Recordatorios, puede añadir elementos a la misma simplemente diciendo “Add”:
Â Add eggs
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Puede confirmar, cancelar o indicar a Siri que desea modificar algo:
Â Change the time to 7
Â Make it Tuesday instead
Â Change that to: Get the car washed and waxed
Â Move it to my Work list
Â Move it to my Personal list
Una vez que confirme el recordatorio, puede pulsarlo para abrir la app Recordatorios y ver el recordatorio y los detalles del mismo.
Mapas
Utilice Siri para buscar una ubicación, obtener direcciones y ver la situación del tráfico. Por 
ejemplo:
Â How do I get home?
Â Show 1 Infinite Loop Cupertino California
Â Directions to my dad’s work
Â What’s the traffic like getting home?
Â Find coffee near me
Â Find some burger joints in Baltimore
Â Find a gas station within walking distance
Â Good Mexican restaurants around here
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Mapas, pero puede pulsar el mapa para abrir la app Mapas si Siri no la abre.
Es posible que Siri responda con una lista de posibilidades. Por ejemplo, si pregunta por hamburgueserías buenas, Siri buscará restaurantes que sirvan hamburguesas en el vecindario y ordenará 
la lista por proximidad. Si pregunta por la mejor hamburguesería del lugar, Siri las ordenará por 
categoría. Para ordenar la lista de cualquier otra forma, simplemente pregunte “which is the best?” 
o “which is the closest?”. 
Mail
Con Siri, puede enviar mensajes de correo electrónico, comprobar si tiene mensajes nuevos y responder a los mensajes que haya recibido.
Un mensaje de correo electrónico exige al menos un destinatario, una línea de asunto (diga 
“about”) y el texto del mensaje. Pero no se preocupe de dar toda esta información de una vez; Siri 
le preguntará todo lo que necesite para completar el mensaje de correo electrónico. 
Para enviar un mensaje de correo electrónico a otra persona:
Â Email Lisa about the trip
Â New email to Susan Park
Â Mail Dad about the rent check
Â Email Dr. Manning and say I got the forms, thanks
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Para comprobar si tiene nuevos mensajes de correo electrónico:
Â Check email
Â Any new email from Michael today?
Â Show new mail about the lease
Â Show the email from Lisa yesterday
Para responder a un mensaje de correo electrónico:
Â Reply Dear Susan sorry about the late payment
Â Call him at work
Antes de enviar un mensaje de correo electrónico, Siri se lo mostrará o se lo leerá para que pueda 
asegurarse de que es correcto. Cuando Siri le pregunte si desea enviar un mensaje, puede decir:
Â Change it to say: Check’s in the mail
Â Add John (para incluir otro destinatario)
Â Change subject to: This weekend
Edición de mensajes de correo electrónico
Si crea un mensaje de correo electrónico con Siri pero se da cuenta de que no dice exactamente 
lo que quería, pídale a Siri que lo modifique. Si se parece mucho a lo que quería, puede modificarlo usted mismo. Pulse el mensaje para abrirlo en la app Mail y, a continuación, edítelo escribiendo 
o dictando nuevo texto. Consulte “Dictado” en la página 58.
Tiempo
Utilice Siri para obtener información meteorológica. Si no indica ninguna ubicación, Siri dará por 
hecho que se refiere a su ubicación actual. Si no indica ninguna fecha, Siri le mostrará la previsión 
del día, pero puede preguntar por el tiempo previsto para cualquier día de la semana venidera.
Â What’s the weather for today?
Â What’s the weather for tomorrow?
Â Will it rain in Cupertino this week?
Â What’s the forecast for this evening?
Â How’s the weather in Tampa right now?
Â How hot will it be in Palm Springs this weekend?
Â What’s the high for Anchorage on Thursday?
Â What’s the temperature outside?
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Â When is sunrise in Paris?
Bolsa
Utilice Siri para obtener rápidamente las cotizaciones de sus valores favoritos. Obtenga la capitalización de mercado o los coeficientes precio/ganancias. Pregunte sobre índices específicos y por la 
situación en general. Por ejemplo:
Â What’s Apple’s stock price?
Â What’s Apple’s P/E ratio?
Â What did Yahoo close at today?
Â How’s the Nikkei doing?
Â How are the markets doing?
Â What’s the Dow at?
Reloj
Utilice Siri para ajustar rápidamente una alarma despertador o un temporizador para el bizcocho 
del horno, o para ver qué hora es en su destino en el extranjero.
Para ajustar o cambiar alarmas:
Â Wake me up tomorrow at 7 a.m.
Â Set an alarm for 6:30 a.m.
Â Wake me up in 8 hours
Â Change my 6:30 alarm to 6:45
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Â Delete my 7:30 alarm
Cuando ajuste una alarma, Siri le mostrará la alarma para que pueda ver si es correcta. Puede pulsar el interruptor para activar o desactivar la alarma. Pulse la alarma para abrirla en la app Reloj.
Para preguntar la fecha y hora:
Â What time is it?
Â What time is it in Berlin?
Â What is today’s date?
Â What’s the date this Saturday?
Siri le mostrará un reloj. Púlselo para abrir la app Reloj.
Para utilizar el temporizador:
Â Set the timer for ten minutes
Â Show the timer
Â Pause the timer
Â Resume
Â Reset the timer
Â Stop it
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Contactos
Siri utiliza sus entradas de Contactos para buscar direcciones, números de teléfono y otros datos, o 
para avisarle del cumpleaños de alguna persona. Siri sabe incluso quiénes son sus familiares consultando su tarjeta de contacto personal. Consulte “Cómo darle información a Siri sobre usted” en 
la página 43.
Para hacer alguna pregunta sobre sus contactos, puede decir:
Â What’s Michael’s address?
Â What is Susan Park’s phone number?
Â When is my wife’s birthday?
Â Show Jennifer’s home email address
Â What’s my brother’s work address?
Para buscar contactos:
Â Show Jason Russell
Â Find people named Park
Â Who is Michael Manning?
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hay otros ítems activos; pulse una dirección de correo electrónico para iniciar un nuevo mensaje 
de correo electrónico o pulse el botón de FaceTime para hablar cara a cara. “Find John” puede ayudarle a restringir la lista de posibilidades, si sabe que el nombre es John pero no se acuerda del 
apellido.
Notas
Utilice Siri para apuntar notas verbalmente, o busque notas que ya haya creado. Diga cosas de 
tipo:
Â Note that I spent $12 on lunch
Â Note: check out that new Alicia Keys album
Â Find my restaurant note
Â Create a reading list note
Â Add Tom Sawyer to my reading list note
Siri le mostrará la nota para que la revise. Para editar la nota, púlsela. Siri abrirá la app Notas 
por usted y podrá editar la nota escribiendo o dictando nuevo texto. Consulte “Dictado” en la 
página 58.
Safari
Puede realizar una búsqueda en Internet con Siri: especifique qué motor de búsqueda desea utilizar o busque en un sitio como Wikipedia. Por ejemplo:
Â Search the web for Bora Bora
Â Search for vegetarian pasta recipes
Â Search the web for best cable plans
Â Google the war of 1812
Â Search Wikipedia for Abraham Lincoln
Â Search for news about the World Cup
Â Bing Alicia Keys
Siri abrirá Safari y realizará la búsqueda solicitada. Si no especifica ningún motor de búsqueda, Siri 
utilizará el motor especificado en los ajustes de Safari. Vaya a Ajustes > Safari.
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Pídale a Siri que le proporcione información o que realice un cálculo, y es posible que Siri consulte 
WolframAlpha (www.wolframalpha.com). Las respuestas suelen incluir información relacionada.
A continuación se muestran algunas preguntas y peticiones de ejemplo:
Â How many calories in a bagel?
Â What is an 18% tip on $86.74 for four people?
Â Who’s buried in Grant’s tomb?
Â How long do dogs live?
Â What is the Gossamer Condor?
Â What’s the square root of 28?
Â How many dollars is 45 euros?
Â What was the Best Picture of 1983?
Â How many days until Christmas?
Â How far away is the sun?
Â When is the next solar eclipse?
Â Show me the Orion constellation
Â What’s the population of Jamaica?
Â How high is Mt. Everest?
Â How deep is the Atlantic Ocean?
Â What’s the price of gasoline in Chicago?
Dictado
Si Siri está activado, también puede dictar texto. Consulte “Dictado” en la página 28.
Aunque puede redactar mensajes de correo electrónico, mensajes de texto y otros tipos de texto 
hablando directamente con Siri, es posible que prefiera dictarlos. La función de dictado le permite 
editar un mensaje en lugar de reemplazar todo el texto. La función de dictado también le da más 
tiempo para pensar mientras redacta. 
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la ocasión para responder. Aunque esto le permite entablar una conversación natural con Siri, Siri 
podría interrumpirle antes de que hubiese acabado realmente, puesto que ha podido dejar de 
hablar para pararse un momento a pensar. Con la función de dictado, puede detenerse todas las 
veces que quiera y seguir hablando cuando esté preparado.
También puede empezar a redactar un texto utilizando Siri y seguir utilizando la función de dictado. Por ejemplo, puede crear un mensaje de correo electrónico con Siri y, a continuación, pulsar 
el borrador para abrir el mensaje en Mail. En Mail, puede completar o editar el mensaje y realizar 
otros cambios, como añadir o eliminar destinatarios, revisar el asunto o cambiar la cuenta desde la 
que está enviando los mensajes de correo electrónico.
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5
Llamadas telefónicas
Cómo hacer una llamada
Realizar una llamada en el iPhone es tan sencillo como pulsar un nombre o un número de sus 
contactos, utilizar Siri para decir “llama a Pedro” (iPhone 4S), pulsar uno de sus favoritos o pulsar un número reciente para devolver la llamada. Los botones de la parte inferior de la pantalla 
Teléfono ofrecen acceso rápido a los favoritos, números recientes y contactos, así como a un teclado para marcar manualmente.
ADVERTENCIA: Para obtener información importante acerca de una conducción segura, consulte 
la Guía de información importante del producto en support.apple.com/es_ES/manuals/iphone/ 
(España y Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ (México).
Número de llamadas 
perdidas
Llamar a un favorito con una sola pulsación.
Ver sus llamadas entrantes y salientes recientes 
para devolver una llamada u obtener más 
información.
Llamar, enviar un mensaje de correo 
electrónico o enviar un mensaje de texto a 
una persona de su lista de contactos.
Marcar manualmente.
Ver una lista de 
sus mensajes de 
voz.
Número de mensajes
no escuchados
Devolver una llamada perdida Realice una de las siguientes operaciones:
Â Teléfono:  Pulse Recientes y, a continuación, pulse el nombre o el número.
Â Pantalla bloqueada:  Deslice el icono que se muestra en la alerta hacia la 
derecha.
Â Centro de notificaciones:  Pulse la llamada perdida.
Marcación manual
Puede usar el teclado numérico para marcar un número de teléfono de forma manual.
Marcar un número:  Pulse Teclado, introduzca el número y pulse Llamar.
60Pegar un número en el teclado 
numérico
Pulse la pantalla situada sobre el teclado y, a continuación, pulse Pegar.
Introducir una pausa breve (de 2 
segundos)
Toque la tecla “*” hasta que aparezca una coma.
Introducir una pausa larga (para detener la marcación hasta que pulse 
el botón Marcar)
Toque la tecla “#” hasta que aparezca un punto y coma.
Volver a marcar el último número Pulse Teclado, pulse Llamar y, después, vuelva a pulsar Llamar.
Marcación por voz
Puede usar Siri (iPhone 4S) o “Control por voz” para llamar a uno de sus contactos o para marcar 
un número concreto. Consulte Capítulo 4,“Siri,” en la página 41 y “Control por voz” en la página 31.
Realizar una llamada telefónica por voz:  Active Siri o “Control por voz”, diga “llamar” o “marcar” y, 
a continuación, diga el nombre o el número.
Siri:  Si la pantalla no está encendida, pulse el botón de encendido/apagado o el botón de inicio 
y, a continuación, sujete el iPhone junto al oído.
“Control por voz” o Siri:  Mantenga pulsado el botón de inicio  hasta que oiga el tono. También 
puede mantener pulsado el botón central de los auriculares del iPhone.
Por ejemplo:
Â llamar Juan López
Â llamar Juan López en casa
Â llamar Juan López, móvil
Para obtener el mejor resultado posible, diga el nombre completo de la persona a la que desea 
llamar. Al marcar por voz un número, pronuncie cada uno de los dígitos por separado. Por ejemplo, diga “cuatro uno cinco, cinco cinco cinco, uno dos uno dos”.
Nota: En EE UU, en el caso del código de área “800”, puede decir “ochocientos”.
Recepción de llamadas
Cuando reciba una llamada, pulse Contestar. Si el iPhone está bloqueado, arrastre el regulador. 
También puede pulsar el botón central de los auriculares del iPhone.
Silenciar una llamada Pulse el botón de encendido/apagado o bien el botón de volumen. Si lo 
desea, puede contestar a la llamada después de silenciarla antes de que se 
desvíe al buzón de voz.
Rechazar una llamada y enviarla 
directamente al buzón de voz
Realice una de las siguientes operaciones:
Â Pulse el botón de encendido/apagado dos veces seguidas rápidamente.
Â Mantenga pulsado el botón central de los auriculares del iPhone durante 
dos segundos aproximadamente. La emisión de dos sonidos graves 
confirmará que se ha rechazado la llamada.
Â Pulse Declinar (si el iPhone está activado cuando se recibe la llamada).
Bloquear llamadas y mantener el 
acceso Wi-Fi a Internet
Vaya a Ajustes, active el modo Avión y, después, pulse Wi-Fi para activarlo.
Si el iPhone está desactivado o en el modo Avión, las llamadas entrantes irán directamente al buzón de voz.
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Durante una llamada, la pantalla muestra las opciones de llamada.
Silenciar su línea.  
iPhone 4 o posterior: Mantenga pulsado 
para poner su llamada en espera.
Marcar un número 
o introducir 
números.
Use el altavoz o 
un dispositivo 
Bluetooth.
Obtener 
información de 
contacto.
iPhone 4 o posterior: 
Realizar una llamada FaceTime.  
iPhone 3GS (botón para poner una 
llamada en espera): Poner una llamada 
en espera.
Realizar otra 
llamada.
Las opciones de llamada pueden variar en función del iPhone que esté usando.
Utilizar otra app durante una 
llamada
Pulse el botón de inicio  y, a continuación, pulse el icono de una app. Para 
recuperar la llamada, pulse la barra de color verde situada en la parte superior de la pantalla.
Finalizar una llamada Pulse Finalizar. También puede pulsar el botón central de los auriculares del 
iPhone.
Segundas llamadas
Durante una llamada, puede realizar o recibir otra llamada. Si recibe una segunda llamada, el iPhone emite un sonido y muestra la información de la persona que le está llamando y una lista de 
opciones.
Nota: La realización y la recepción de una segunda llamada puede estar disponible como servicio 
opcional en algunas áreas. Póngase en contacto con su operador de telefonía para obtener más 
información al respecto.
Contestar a una segunda llamada entrante:
Â Para ignorar la llamada y enviarla al buzón de voz: Pulse Ignorar.
Â Para mantener en espera la primera llamada y contestar a la segunda: Pulse “Retener + Contestar”.
Â Para finalizar la primera llamada y contestar a la segunda: Si utiliza una red GSM, pulse “Finalizar 
+ Contestar”. Con una red CDMA, pulse Finalizar y, cuando la segunda llamada vuelva a sonar, 
pulse Contestar o arrastre el regulador si el teléfono está bloqueado.
Durante una llamada de vídeo FaceTime, puede finalizar la llamada de vídeo y contestar a la llamada entrante, o bien puede rechazar la llamada entrante.
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Pasar de una llamada a otra Pulse Intercambiar. La llamada activa se pone en espera.
Con CDMA, no se puede pasar de una llamada a otra si la segunda llamada 
era saliente, pero se pueden fusionar las llamadas. Si finaliza la segunda 
llamada o la llamada fusionada, ambas llamadas finalizarán.
Fusionar llamadas Pulse Fusionar.
Con CDMA, no se pueden fusionar llamadas si la segunda llamada era 
entrante.
Multiconferencias
Con GSM, puede realizar multiconferencias con hasta cinco personas a la vez en función del operador de telefonía utilizado.
Nota: La realización de multiconferencias puede estar disponible como servicio opcional en 
algunas áreas. Póngase en contacto con su operador de telefonía para obtener información al 
respecto.
Realizar una multiconferencia:
1 Haga una llamada.
2 Pulse “Añadir llamada” y realice otra llamada. La primera llamada se pone en espera.
3 Pulse Fusionar. Las llamadas se fusionarán en una sola línea, de modo que todos los invitados podrán hablar entre sí.
4 Repita los pasos dos y tres para añadir otras llamadas.
Eliminar una llamada Pulse Conferencia y, a continuación, pulse  junto a una llamada. 
Entonces, pulse Finalizar.
Hablar en privado con uno de los 
invitados
Pulse Conferencia y, a continuación, pulse Privado junto a una llamada. 
Pulse Fusionar para reanudar la multiconferencia.
Añadir una llamada entrante Pulse “Retener + Contestar” y, a continuación, pulse Fusionar.
Si su servicio incluye la realización de multiconferencias, el iPhone siempre tendrá una segunda 
línea disponible, además de la utilizada para la multiconferencia.
Nota: No es posible realizar una llamada de vídeo FaceTime durante una multiconferencia.
Cómo utilizar un dispositivo Bluetooth para las llamadas
Puede realizar y recibir llamadas utilizando un dispositivo Bluetooth enlazado con el iPhone. 
Consulte “Enlazar un dispositivo Bluetooth con el iPhone” en la página 36. 
Para obtener información sobre cómo usar un dispositivo Bluetooth, consulte la documentación 
del dispositivo.
Ignorar su dispositivo Bluetooth:
Â Conteste a una llamada pulsando la pantalla del iPhone.
Â Durante una llamada, pulse Audio y seleccione iPhone o “Altavoz teléfono”.
Â Desactive Bluetooth en Ajustes > General > Bluetooth.
Â Apague el dispositivo Bluetooth o salga del radio de alcance. Debe encontrarse a menos de 10 
metros de un dispositivo Bluetooth para poder conectarlo al iPhone.
Llamadas de emergencia
Aunque el iPhone esté bloqueado mediante un código, permite realizar llamadas de emergencia.
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“Introduzca el código”, pulse “Llamada SOS” y, a continuación, introduzca el número de emergencia 
y pulse el botón verde.
En EE UU, se facilita información sobre la ubicación (si está disponible) a los servicios de emergencia al marcar el 911.
Con CDMA, cuando finaliza una llamada de emergencia, el iPhone entra en el modo de llamada 
SOS para permitir la devolución de una llamada de los servicios de emergencia. Mientras se encuentre en este modo, se bloquearán las transmisiones de datos y los mensajes de texto.
Salir del modo de llamada SOS (CDMA): Realice una de las siguientes operaciones:
Â Pulse el botón Atrás.
Â Pulse el botón de encendido/apagado o el botón de inicio  .
Â Use el teclado numérico para marcar un número que no sea de emergencia.
El modo de llamada SOS finalizará automáticamente tras unos minutos, dependiendo de su operador de telefonía.
Importante: No es aconsejable depender únicamente de dispositivos inalámbricos para realizar 
comunicaciones vitales (por ejemplo, en caso de urgencias médicas). Es posible que el iPhone no 
pueda utilizarse para realizar llamadas a servicios de emergencia en todas las áreas o en todas las 
condiciones de funcionamiento. Los números y servicios de emergencia pueden variar de un área 
a otra y, en ocasiones, es probable que no pueda realizarse una llamada de emergencia debido 
a problemas con la red o a interferencias ambientales. Asimismo, puede que algunas redes de 
telefonía móvil no acepten una llamada de emergencia del iPhone si el iPhone no está activado, 
si el iPhone no es compatible o no está configurado para funcionar en una determinada red de 
telefonía móvil, o (cuando corresponda) si el iPhone no dispone de una tarjeta SIM o si la SIM está 
bloqueada por PIN. Durante una llamada de vídeo FaceTime, deberá finalizar dicha llamada para 
poder llamar a un número de emergencia.
FaceTime
Las llamadas de vídeo FaceTime (iPhone 4 o posterior) le permiten ver y escuchar a la persona 
con la que está hablando. Puede realizar videollamadas con todos los usuarios que dispongan de 
un Mac o de un dispositivo iOS compatible con FaceTime. No es necesario que realice ninguna 
configuración, pero debe disponer de una conexión Wi-Fi a Internet. Por omisión, FaceTime usa la 
cámara frontal para que el destinatario de la llamada pueda verle; cambie a la cámara trasera para 
compartir lo que usted ve.
Nota: Es posible que FaceTime no esté disponible en todas las áreas.
Realizar una llamada FaceTime:  En Contactos, seleccione un nombre, pulse FaceTime y, a continuación, pulse el número de teléfono o la dirección de correo electrónico que esa persona utilice 
para FaceTime.
Para llamar a una persona que tenga un iPhone 4 o posterior, puede comenzar realizando una llamada de voz y, a continuación, pulsar FaceTime.
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Un círculo indica lo que ve la otra persona. Gire el iPhone para utilizar FaceTime en orientación 
horizontal.
Cambiar de cámara.
Arrastre su imagen a 
cualquier esquina.
Silenciar (puede ver y oír; la persona que realiza la 
llamada puede ver pero no oír).
Si la red Wi-Fi no está disponible (por ejemplo, si está fuera de su radio de alcance), se mostrará 
una opción para que pueda volver a marcar el número y realizar una llamada de voz.
Nota: Cuando realice una llamada de vídeo FaceTime, su número de teléfono se mostrará aunque 
la identificación de llamadas esté bloqueada o desactivada.
Realizar una llamada FaceTime utilizando Siri o “Control por voz”
Mantenga pulsado el botón de inicio hasta que oiga el tono. Con Siri (iPhone 4S), también puede sujetar el iPhone junto al oído mientras la pantalla 
está encendida. Diga “FaceTime” seguido del nombre de la persona a la que 
desee llamar.
Bloquear llamadas FaceTime Vaya a Ajustes > FaceTime y desactive FaceTime. También puede desactivar 
FaceTime en Restricciones. Consulte “Restricciones” en la página 181.
Utilizar su ID de Apple o una dirección de correo electrónico para 
FaceTime
Vaya a Ajustes > FaceTime y, a continuación, pulse “Use su ID de Apple 
para FaceTime” o “Añadir dirección de correo”. Consulte “FaceTime” en la 
página 64.
Buzón de voz visual
Configuración del buzón de voz
En el iPhone, el buzón de voz visual permite ver una lista de mensajes y elegir los que desea escuchar o eliminar sin tener que escuchar las instrucciones o los mensajes anteriores.
Nota: Es posible que el buzón de voz visual no esté disponible en todas las áreas, o que sea un 
servicio opcional. Póngase en contacto con su operador de telefonía para obtener más información al respecto. Si el buzón de voz visual no está disponible, pulse “Buzón voz” y siga las instrucciones que escuchará para recibir sus mensajes.
Número de de llamadas perdidas y de 
mensajes del buzón de voz no escuchados.
La primera vez que pulse “Buzón de voz”, el iPhone le solicitará que cree una contraseña para el 
buzón y grabe su mensaje de saludo personal.
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mensaje personal. Cuando acabe, pulse Detener.
Para escuchar el mensaje, pulse Reproducir. Para volver a grabar, vuelva a pulsar Grabar. Pulse 
Guardar cuando esté satisfecho.
Utilizar el mensaje de saludo predeterminado de su operador de 
telefonía
Pulse “Buzón voz”, Saludo y “Por omisión”.
Definir un sonido de alerta para los 
nuevos mensajes de voz
Vaya a Ajustes > Sonidos y, a continuación, active “Mensaje de voz”. La alerta 
sonará una vez por cada nuevo mensaje de voz.
Si el interruptor de tono/silencio está apagado, el iPhone no emitirá alertas.
Cambiar la contraseña del buzón 
de voz
Vaya a Ajustes > Teléfono > “Contraseña del buzón de voz”.
Cómo consultar el buzón de voz
Al pulsar Teléfono, el iPhone muestra el número de llamadas perdidas y mensajes de voz no 
escuchados.
Pulse “Buzón voz” para ver una lista de los mensajes.
Arrastre el cursor de 
reproducción para saltar 
a cualquier punto del 
mensaje.
Mensajes no 
escuchados Reproducción/Pausa
Información del contacto
Barra de desplazamiento
Altavoz (Audio, cuando 
hay un dispositivo 
Bluetooth conectado. 
Pulse aquí para 
seleccionar la salida de 
audio.)
Devolver la llamada.
Escuchar un mensaje de voz:  Pulse “Buzón de voz” y, a continuación, pulse un mensaje.
Si ya ha escuchado el mensaje, púlselo de nuevo para repetirlo. Utilice  y  para realizar una pausa y reanudar la reproducción.
Una vez escuchado, el mensaje se guarda hasta que su operador de telefonía lo borra.
Consultar el buzón de voz desde 
otro teléfono
Marque su propio número o el número de acceso remoto de su operador 
de telefonía.
Cómo eliminar mensajes
Eliminar un mensaje: Pase el dedo por el mensaje o púlselo y, a continuación, pulse Eliminar.
Nota: En algunas áreas, es posible que el operador de telefonía borre permanentemente los mensajes de voz visuales eliminados.
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mensaje.
Deshacer la eliminación de un 
mensaje
Pulse “Mensajes eliminados” (al final de la lista) y, a continuación, pulse el 
mensaje y “Recuperar”.
Eliminar los mensajes 
permanentemente
Pulse “Mensajes eliminados” (al final de la lista) y, a continuación, pulse 
“Borrar todo”.
Contactos
En la pantalla de información de un contacto, una sola pulsación permite realizar una llamada telefónica, crear un mensaje de correo electrónico y buscar su ubicación, entre otras cosas. Consulte 
“Cómo buscar contactos” en la página 134.
Favoritos
Los favoritos ofrecen un acceso rápido a los números de teléfono utilizados con más frecuencia.
Añadir el número de teléfono de un contacto a la lista de favoritos:  Pulse Contactos y seleccione un contacto. Pulse Favoritos. Seleccione un número de teléfono o una dirección de correo 
electrónico (para llamadas FaceTime). En el iPhone 4 o posterior, seleccione si desea guardar el 
favorito como una llamada de voz o como una llamada FaceTime.
Para llamar a un favorito, pulse Favoritos y seleccione un contacto. Si  se muestra junto a un 
nombre, el iPhone realiza una llamada FaceTime.
Añadir un contacto a Favoritos desde la lista Recientes
Pulse Recientes, pulse  junto al nombre del contacto y, a continuación, 
pulse “Añadir a Favoritos”.
Eliminar un contacto de los 
favoritos
Pulse Favoritos y luego Editar. A continuación, pulse  junto a un contacto 
o número y, finalmente, pulse Eliminar.
Reordenar la lista de favoritos Pulse Favoritos y luego Editar. A continuación, arrastre  junto a un contacto hasta una nueva posición en la lista.
Desvío de llamadas, llamada en espera e identificación de llamadas
Desvío de llamadas
Puede configurar el iPhone para que desvíe las llamadas de teléfono entrantes a otro número.
Nota: Las llamadas FaceTime no se desvían.
Activar el desvío de llamadas (GSM):  Vaya a Ajustes > Teléfono > “Desvío de llamadas” y, a continuación, active esta función. En la pantalla “Desviar a”, introduzca el número al que esté desviando 
las llamadas.
Activar el desvío de llamadas (CDMA):  Introduzca *72, seguido del número al que esté desviando las llamadas y, a continuación, pulse Llamar.
Para desactivar el desvío de llamadas (CDMA), introduzca *73 y, a continuación, pulse Llamar.
Con GSM, el icono de desvío de llamadas ( ) aparece en la barra de estado cuando está activado el desvío de llamadas. Debe encontrarse en el radio de alcance de la red de telefonía móvil 
cuando ajuste el iPhone para que desvíe las llamadas, pues de lo contrario las llamadas no se 
desviarán.
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La llamada en espera le ofrece la posibilidad de responder a otra llamada entrante mientras está 
hablando por teléfono. Puede:
Â Ignorar la llamada entrante.
Â Poner la llamada actual en espera y responder a la llamada entrante.
Â Finalizar la llamada actual y responder a la llamada entrante.
Si la función de llamada en espera está desactivada mientras está hablando por teléfono, las 
llamadas entrantes irán directamente al buzón de voz. Consulte “Segundas llamadas” en la 
página 62. 
Activar la llamada en espera (GSM): Vaya a Ajustes > Teléfono > “Llamada en espera”.
Con CDMA, la función de llamada en espera está activada por omisión, pero puede desactivarla 
para una llamada.
Desactivar la llamada en espera para una llamada (CDMA):  Introduzca *70 y marque el número.
Identificación de llamadas
La función de identificación de llamadas muestra su nombre o número de teléfono a la persona a 
la que llama, si el dispositivo del destinatario incluye esa función y no ha desactivado ni bloqueado esta función.
Nota: En el caso de las llamadas FaceTime, su número de teléfono se mostrará aunque la identificación de llamadas esté desactivada o bloqueada.
Activar o desactivar la identificación de llamadas (GSM): Vaya a Ajustes > Teléfono > “Mostrar ID 
de llamada”.
Con CDMA, la función de identificación de llamadas está activada por omisión, pero puede desactivarla para una llamada.
Bloquear la identificación de llamadas para una llamada (CDMA): Introduzca *67 y marque el 
número.
Tonos de llamada, interruptor de tono/silencio y vibración
El iPhone incorpora tonos de llamada que se reproducen para las llamadas entrantes, las alarmas 
del reloj y el temporizador. También puede adquirir tonos de llamada de canciones en iTunes. 
Utilice el interruptor de tono/silencio para activar o desactivar el tono de llamada, y los ajustes de 
Sonido para ajustar las opciones de vibración. Por omisión, el iPhone vibra siempre, tanto en el 
modo de tono como en el modo de silencio.
Ajustar el tono por omisión:  Vaya a Ajustes > Sonidos > “Tono de llamada”.
Activar o desactivar el tono de llamada:  Deslice el interruptor situado en el lateral del iPhone. 
Consulte “Interruptor de tono/silencio” en la página 11.
Importante: Las alarmas del reloj continuarán sonando aunque este interruptor esté en la posición Silencio.
Ajustar el iPhone para que vibre:  Vaya a Ajustes > Sonidos. Los controles permiten ajustar la vibración de manera independiente para el modo de tono y para el modo de silencio.
Asignar un tono diferente a un 
contacto:
En Contactos, seleccione un contacto, pulse Editar y, a continuación, pulse 
Tono y seleccione un tono de llamada.
Comprar un tono en la tienda iTunes Store
Consulte “Cómo comprar música, audiolibros y tonos” en la página 125.
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Llamadas internacionales
Cómo realizar llamadas internacionales desde su país
Para obtener información sobre la realización de llamadas internacionales desde su país, incluidas 
las tarifas y otros cargos aplicables, póngase en contacto con su operador de telefonía o visite la 
página web del operador.
Cómo usar el iPhone en el extranjero
Cuando viaje al extranjero, es posible que pueda utilizar el iPhone para realizar llamadas, enviar y 
recibir mensajes de texto y utilizar apps que necesitan acceso a Internet, en función de las redes 
disponibles.
Activar la itinerancia internacional:  Póngase en contacto con su operador para obtener información sobre la disponibilidad del servicio y las tarifas.
Importante: Pueden aplicarse tarifas de itinerancia para voz, mensajes de texto y datos. Para evitar 
la aplicación de tarifas por llamadas de teléfono y datos entregados a través la red de datos de 
telefonía móvil (incluido el buzón de voz visual) cuando se encuentre en itinerancia fuera de la 
red de su operador, desactive “Itinerancia de voz” e “Itinerancia de datos”.
Si dispone de un iPhone 4S que se haya activado para funcionar en una red CDMA, es posible que 
pueda utilizar el servicio de itinerancia en redes GSM si el teléfono tiene instalada una tarjeta SIM. 
Consulte “Instalación de la tarjeta SIM” en la página 14. Si se encuentra en itinerancia en una red 
GSM, el iPhone tendrá acceso a las funciones de la red GSM. Pueden aplicarse tarifas. Póngase en 
contacto con su operador de telefonía para obtener más información al respecto.
Desactivar “Itinerancia de voz” en 
una red CDMA
Vaya a Ajustes > General > Red.
Desactivar “Itinerancia de voz” desactiva las llamadas de teléfono cuando se 
encuentra fuera de la red de su operador. 
Desactivar “Itinerancia de datos” Vaya a Ajustes > General > Red.
Desactivar “Itinerancia de datos” desactiva la transmisión de datos a través 
de la red de telefonía móvil. Las apps que dependen del acceso a Internet 
se desactivarán a menos que el iPhone tenga acceso a Internet a través 
de una conexión Wi-Fi. La función de buzón de voz visual se suspenderá 
en itinerancia, a menos que su operador no le aplique ninguna tarifa por 
utilizarlo.
Ajustar el iPhone para que añada 
el prefijo correcto cuando marque 
desde otro país
Vaya a Ajustes > Teléfono y, a continuación, active la función de asistencia 
internacional (no disponible en todas las áreas). Esto le permitirá utilizar 
contactos y favoritos para realizar llamadas a EE UU sin tener que añadir un 
prefijo o el código de su país.
Definir el operador que se utilizará Vaya a Ajustes > Operador. Esta opción solo está disponible cuando se 
encuentra fuera del alcance de la red de su operador, y con los operadores 
que tienen acuerdos de itinerancia con su proveedor de servicios. Para obtener más información, consulte “Operador” en la página 176.
Usar redes GSM en el extranjero 
con un iPhone con CDMA activado
Vaya a Ajustes > Red > Itinerancia y, a continuación, desactive “CDMA 
internacional”.
Consultar el buzón de voz cuando 
el buzón de voz visual no está 
disponible
Marque su propio número (con CDMA, marque su número seguido de #) o 
mantenga pulsado “1” en el teclado numérico.
Desactivar los datos de telefonía 
móvil
Vaya a Ajustes > General > Red.
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Wi-Fi y active esta función.
Las llamadas entrantes se envían al buzón de voz. Para volver a realizar y 
recibir llamadas y obtener los mensajes de su buzón de voz, desactive el 
modo Avión.
Cómo ajustar opciones de Teléfono
En Ajustes, vaya a Teléfono para:
Â Ver el número de teléfono de su iPhone
Â Activar o desactivar el desvío de llamadas, la llamada en espera y la identificación de llamadas 
(GSM)
Â Activar o desactivar TTY
Â Cambiar la contraseña del buzón de voz (GSM)
Â Activar o desactivar la función de asistencia internacional; cuando llama desde el extranjero, la 
función de asistencia internacional le permite llamar a contactos y favoritos situados en EE UU 
sin tener que añadir un prefijo o el código de su país (GSM)
Â Bloquear su SIM para solicitar un PIN cuando active el iPhone (obligatorio con algunos 
operadores)
En Ajustes, vaya a FaceTime para:
Â Activar o desactivar FaceTime
Â Utilizar su ID de Apple para FaceTime
Â Añadir una dirección de correo electrónico para FaceTime
Para ajustar tonos de llamada, opciones de vibración y el sonido para los nuevos mensajes de voz, 
vaya a Ajustes > Sonidos. Consulte también “Sonidos y el botón de tono/silencio” en la página 177.
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Mail puede utilizarse con iCloud, Microsoft Exchange y muchos de los sistemas de correo más populares (incluidos Yahoo!, Google, Hotmail y AOL), así como con otros sistemas estándar de correo 
POP3 e IMAP. Puede enviar y recibir fotos, vídeos y gráficos, y visualizar archivos PDF y otros archivos adjuntos. También puede imprimir mensajes y archivos adjuntos que se abran en Vista Rápida.
Comprobar y leer el correo electrónico
En Mail, la pantalla Buzones ofrece acceso rápido a todos los buzones de entrada y a otros 
buzones. 
Al abrir un buzón, Mail recupera y muestra los mensajes más recientes. Puede especificar el nú-
mero de mensajes recuperados en los ajustes de Mail. Consulte “Cuentas de correo y ajustes de 
Mail” en la página 75.
Mensajes no leídos
Número de mensajes 
de la cadena
Organizar los mensajes por cadena Vaya a Ajustes > “Correo, contactos, calendarios” y, a continuación, active o 
desactive “Organizar cadenas”.
Si organiza los mensajes por cadenas, los mensajes relacionados se mostrarán como una sola entrada en el buzón. Consulte “Cuentas de correo y 
ajustes de Mail” en la página 75.
Comprobar si hay mensajes nuevos Seleccione un buzón o pulse  en cualquier momento.
Cargar mensajes adicionales Desplácese hasta el final de la lista de mensajes y pulse “Cargar más 
mensajes”.
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mensaje
Pulse dos veces el área cuya imagen desee acercar. Vuelva a pulsar dos 
veces para alejar la imagen. También puede pellizcar con dos dedos hacia 
dentro o hacia fuera para acercar o alejar la imagen.
Redimensionar cualquier columna 
de texto para ajustarla a la ventana
Pulse dos veces en el texto.
Ver todos los destinatarios de un 
mensaje
Pulse Detalles. Pulse un nombre o dirección de correo electrónico para 
ver la información de contacto del destinatario y, a continuación, pulse un 
número de teléfono o una dirección de correo electrónico para ponerse en 
contacto con dicha persona.
Añadir un destinatario de correo a 
su lista de contactos
Pulse el mensaje y, si es necesario, pulse Detalles para ver los destinatarios. 
A continuación, pulse un nombre o dirección de correo electrónico y pulse 
“Nuevo contacto” o “Contacto existente”.
Marcar un mensaje como no leído Abra el mensaje y, si es necesario, pulse Detalles. A continuación, pulse 
Marcar.
Para marcar varios mensajes como no leídos, consulte “Organización del 
correo” en la página 74.
Abrir una invitación a una reunión Pulse la invitación. Consulte “Cómo responder a invitaciones” en la 
página 93.
Cómo trabajar con varias cuentas
Si configura más de una cuenta, en la sección Cuentas de la pantalla Buzones tendrá acceso a 
todas sus cuentas. También puede pulsar Todos para ver todos sus mensajes entrantes en una única lista. Para obtener información sobre la forma de configurar otras cuentas de correo, consulte 
“Cuentas de correo y ajustes de Mail” en la página 75. 
Cuando escriba un mensaje nuevo, pulse el campo De para seleccionar la cuenta desde la que 
enviar el mensaje.
Cómo enviar correo
Puede enviar un mensaje de correo electrónico a cualquier persona que tenga una dirección de 
correo electrónico.
Redactar un mensaje:  Pulse 
 Añadir un destinatario de 
Contactos
Escriba un nombre o una dirección de correo electrónico en el campo Para 
o pulse  .
Reorganizar los destinatarios Para mover un destinatario de un campo a otro, como de Para a Cc, arrastre 
el nombre del destinatario a la nueva ubicación.
Poner el texto en negrita o cursiva, 
o subrayarlo
Pulse el punto de inserción para mostrar los botones de selección y, a continuación, pulse Seleccionar. Arrastre los puntos para seleccionar el texto al 
que desee aplicar estilo. Pulse  y, a continuación, pulse Negrita/Cursiva/
Subrayar. Pulse Negrita, Cursiva o Subrayar para aplicar el estilo.
Enviar una foto o un vídeo en un 
mensaje de correo electrónico
En Fotos, seleccione una foto o un vídeo, pulse  y, a continuación, pulse 
“Correo electrónico”. También puede copiar y pegar fotos y vídeos.
Para enviar varias fotos o vídeos, pulse  mientras visualiza las miniaturas de un álbum. Pulse las fotos y los vídeos que desee seleccionar, pulse 
Compartir y, después, pulse “Enviar por correo”.
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Pulse Cancelar y, a continuación, pulse Guardar. El mensaje se guarda en el 
buzón de correo Borradores. Mantenga pulsado  para acceder rápidamente al mismo.
Responder a un mensaje Pulse  y, a continuación, pulse Responder. Los archivos o imágenes adjuntos al mensaje inicial no se reenvían. Para incluir los archivos adjuntos, 
reenvíe el mensaje en lugar de responder al mismo.
Citar parte del mensaje al que 
está respondiendo o que está 
reenviando
Mantenga el dedo sobre el texto para seleccionarlo. Arrastre los puntos de 
selección para seleccionar el texto que desee incluir en su respuesta y, a 
continuación, pulse  .
Para cambiar la sangría del texto citado, mantenga el dedo sobre el texto 
para seleccionarlo y, a continuación, pulse  . Pulse “Nivel de cita” y, a continuación, pulse Aumentar o Reducir.
Reenviar un mensaje Abra un mensaje, pulse  y, después, pulse Reenviar.
Compartir información de contacto En Contactos, seleccione un contacto, pulse “Compartir contacto” en la parte inferior de la pantalla de información.
Uso de enlaces y datos detectados
El iPhone detecta enlaces web, números de teléfono, direcciones de correo electrónico, fechas y 
otros tipos de datos que puede utilizar para abrir una página web, crear un mensaje de correo 
electrónico con la dirección ya incluida, crear o añadir información a un contacto o llevar a cabo 
alguna otra acción que puede serle de utilidad. Los datos detectados se muestran como texto subrayado en azul. 
Pulse los datos para usar su acción por omisión o mantenga la pulsación para ver otras acciones. 
Por ejemplo, para una dirección, puede mostrar su ubicación en Mapas o añadirla a Contactos.
Cómo visualizar los archivos adjuntos
El iPhone muestra las imágenes adjuntas en muchos de los formatos más utilizados (JPEG, GIF y 
TIFF) dentro del texto de los mensajes de correo electrónico. El iPhone puede reproducir muchos 
tipos de archivos de audio adjuntos, como MP3, AAC, WAV y AIFF. Puede descargar y visualizar archivos (como PDF, páginas web y documentos de texto, Pages, Keynote, Numbers, Microsoft Word, 
Excel y PowerPoint) que estén adjuntos a los mensajes que recibe.
Ver un archivo adjunto:  Pulse el archivo adjunto para abrirlo en Vista Rápida. (Puede que tenga 
que esperar un poco a que el archivo se descargue para poder visualizarlo.)
Abrir un archivo adjunto Mantenga pulsado el archivo adjunto y, a continuación, seleccione una app 
para abrirla. Si ninguna de sus apps es compatible con el archivo, y tampoco es compatible con Vista Rápida, podrá visualizar el nombre del archivo 
pero no abrirlo.
Guardar una foto o un vídeo 
adjunto
Mantenga pulsada la foto o el vídeo y, a continuación, pulse “Guardar imagen” o “Guardar vídeo”. El ítem se guardará en el álbum Carrete de la app 
Fotos.
Vista Rápida acepta los siguientes tipos de documento:
.doc, .docx Microsoft Word
.htm, .html página web
.key Keynote
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.pages Pages
.pdf Vista Previa, Adobe Acrobat
.ppt, .pptx Microsoft PowerPoint
.rtf texto con formato
.txt texto
.vcf información de contactos
.xls, .xlsx Microsoft Excel
Impresión de mensajes y archivos adjuntos
Puede imprimir mensajes de correo electrónico y archivos adjuntos que puedan visualizarse en 
Vista Rápida. 
Imprimir un mensaje de correo electrónico:  Pulse  y, a continuación, pulse Imprimir.
Imprimir una imagen integrada Mantenga pulsada la imagen y, a continuación, pulse “Guardar imagen”. A 
continuación, abra Fotos e imprima la imagen desde el álbum Carrete.
Imprimir un archivo adjunto Pulse el archivo adjunto para verlo en Vista Rápida y, a continuación, pulse 
 y pulse Imprimir.
Para obtener más información sobre la forma de imprimir y las opciones de la impresora, consulte 
“Impresión” en la página 29.
Organización del correo
Puede organizar los mensajes de cualquier buzón, carpeta o ventana de resultados de búsqueda. 
Puede eliminar mensajes o marcar mensajes como leídos. También puede mover mensajes de un 
buzón o carpeta a otro buzón o carpeta de la misma cuenta o de cuentas distintas. Puede añadir, 
eliminar o renombrar buzones y carpetas.
Eliminar un mensaje:  Abra el mensaje y pulse  .
También puede borrar un mensaje directamente en la lista de mensajes del buzón deslizando el 
dedo sobre el título del mensaje hacia la izquierda o la derecha y pulsando Eliminar.
Algunas cuentas de correo permiten comprimir los mensajes en lugar de eliminarlos. Al comprimir 
un mensaje, se traslada del buzón de entrada a la carpeta Todos. Active o desactive la compresión 
de mensajes en Ajustes > “Correo, contactos, calendarios”.
Recuperar un mensaje Los mensajes eliminados se trasladan al buzón Papelera 
Para cambiar el tiempo que debe permanecer un mensaje en la Papelera 
antes de eliminarse permanentemente, vaya a Ajustes > “Correo, contactos, 
calendarios”. A continuación, pulse Avanzado. 
Eliminar o mover varios mensajes Mientras visualiza una lista de mensajes, pulse Editar, seleccione los mensajes que desee borrar y, a continuación, pulse Trasladar o Eliminar.
Trasladar un mensaje a otro buzón 
o carpeta
Mientras visualiza un mensaje, pulse  y, a continuación, seleccione un 
buzón o carpeta.
Añadir un buzón Vaya a la lista de buzones, pulse Editar y, a continuación, pulse “Nuevo 
buzón”.
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Introduzca un nuevo nombre o ubicación para el buzón. Pulse “Eliminar 
buzón” para eliminarlo, así como todo su contenido.
Marcar varios mensajes como 
leídos
Mientras visualiza una lista de mensajes, pulse Editar, seleccione los mensajes que desee y pulse Marcar. Seleccione “Marcar con indicador” o “Marcar 
como leído”.
Cómo buscar en el correo
Puede realizar búsquedas en los campos Para, De y Asunto y en el texto del cuerpo de los mensajes de correo electrónico. Mail buscará en los mensajes descargados del buzón actual. En las cuentas iCloud, Exchange y algunas cuentas de correo IMAP, también puede realizar búsquedas en los 
mensajes alojados en el servidor.
Buscar en mensajes de correo electrónico:  Abra un buzón de correo, desplácese hasta la parte 
superior e introduzca texto en el campo de búsqueda. Pulse De, Para, Asunto o Todo para seleccionar los campos en los que desee buscar. Si su cuenta de correo lo permite, también se buscará en 
los mensajes del servidor.
Los mensajes de Mail también pueden incluirse en las búsquedas que se realizan en la pantalla de 
inicio. Consulte “Cómo buscar” en la página 30.
Cuentas de correo y ajustes de Mail
Cuentas
Para Mail y cuentas de correo, vaya a Ajustes > “Correo, contactos, calendarios”. Puede configurar:
Â Microsoft Exchange
Â iCloud
Â MobileMe
Â Google 
Â Yahoo! 
Â AOL 
Â Microsoft Hotmail
Â Otros sistemas de correo POP e IMAP
Los ajustes pueden variar, según el tipo de cuenta que configure. Su proveedor de servicios o el 
administrador del sistema puede facilitarle la información que debe introducir.
Cambiar los ajustes de una cuenta:  Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione 
una cuenta y, a continuación, realice los cambios que desee.
Los cambios que realice en los ajustes de una cuenta en el iPhone no se sincronizarán con el ordenador, lo que le permite configurar sus cuentas de modo que funcionen con el iPhone sin afectar a los ajustes de cuenta de su ordenador.
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continuación, desactive un servicio de la cuenta (como Mail, Calendarios o 
Notas).
Si un servicio de una cuenta está desactivado, el iPhone no mostrará ni 
sincronizará información con dicho servicio de la cuenta hasta que vuelva 
a activarlo. Es una buena forma de dejar de recibir mensajes de trabajo en 
vacaciones, por ejemplo.
Almacenar borradores, mensajes 
enviados y mensajes eliminados en 
el iPhone
En el caso de las cuentas IMAP, puede cambiar la ubicación de los buzones 
Borradores, Enviado y Papelera. Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione una cuenta y, a continuación, pulse Avanzado.
Ajustar el tiempo que debe transcurrir para que los mensajes se eliminen permanentemente de Mail
Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione una cuenta y, 
a continuación, pulse Avanzado. Pulse Eliminar y seleccione un periodo de 
tiempo: nunca, o tras un día, una semana o un mes.
Definir los ajustes del servidor de 
correo
Vaya a Ajustes > “Correo, contactos, calendarios” y, a continuación, seleccione una cuenta. Consulte a su administrador de red o proveedor de acceso a 
Internet para obtener los ajustes adecuados.
Definir los ajustes de SSL y de 
contraseña
Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione una cuenta y, 
a continuación, pulse Avanzado. Consulte a su administrador de red o proveedor de acceso a Internet para obtener los ajustes adecuados.
Activar o desactivar “Archivar 
mensajes”
Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione su cuenta y, a 
continuación, active o desactive “Archivar mensajes”. Consulte “Organización 
del correo” en la página 74.
Eliminar una cuenta Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione una cuenta y, a 
continuación, desplácese hacia abajo y pulse “Eliminar cuenta”.
Toda la información del correo electrónico, los contactos, los calendarios y 
los favoritos que esté sincronizada con la cuenta, se eliminará del iPhone.
Enviar mensajes firmados y 
encriptados
Vaya a Ajustes > “Correo, contactos, calendarios”, seleccione una cuenta y, a 
continuación, pulse Avanzado. Active “S/MIME” y, a continuación, seleccione 
certificados para firmar y encriptar los mensajes salientes.
Para instalar certificados, obtenga un perfil de configuración de su administrador del sistema, descargue los certificados del sitio web del emisor 
utilizando Safari o recíbalos en archivos adjuntos de Mail.
Definir ajustes de Push Vaya a Ajustes > Correo, contactos, calendarios > “Obtener datos”. La función 
“push” transmite nueva información cuando el iPhone está conectado a 
una red Wi-Fi. Puede desactivar “push” para suspender el envío de correo 
electrónico u otra información, o para prolongar la autonomía de la batería.
Cuando “push” está desactivado, el uso del ajuste “Obtener datos” determina 
con qué regularidad se solicita esta información. Para ahorrar batería, es 
recomendable no obtener información demasiado a menudo.
Ajustar otras opciones de Mail Para ajustes que se apliquen a todas sus cuentas, vaya a Ajustes > “Correo, 
contactos, calendarios”. 
Ajustes de Mail
Para cambiar ajustes que se apliquen a todas sus cuentas, vaya a Ajustes > “Correo, contactos, 
calendarios”.
Cambiar los tonos que se reproducen cuando se envía o se recibe correo:  Vaya a Ajustes > 
Sonidos. 
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Este ajuste le permite activar o desactivar la función “push” de las cuentas iCloud, Microsoft 
Exchange, Yahoo! y cualquier otra cuenta de tipo “push” configurada en el iPhone. Las cuentas 
Push envían al iPhone nueva información siempre que esté disponible en el servidor (pueden 
producirse algunos retardos) y siempre que haya una conexión a Internet. Puede desactivar “push” 
para suspender el envío de correo electrónico u otra información, o para prolongar la autonomía 
de la batería.
Cuando “push” está desactivado y se emplean cuentas no compatibles con esta función, puede 
obtener la información solicitándola, es decir, el iPhone puede comprobar si hay nueva información disponible en el servidor. El uso del ajuste “Obtener datos” determina con qué regularidad se 
solicita esta información. Para ahorrar batería, es recomendable no obtener información demasiado a menudo. Desactivar la función “push” (o ajustar la obtención de datos a Manualmente en la 
pantalla “Obtener datos”) hace que no se utilicen los ajustes específicos de la cuenta.
Definir ajustes de Push:  Vaya a Ajustes > Correo, contactos, calendarios > “Obtener datos”.
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Safari le permite navegar por Internet y ver páginas web. Cree favoritos en el iPhone y sincronícelos con el ordenador. Añada clips web a la pantalla de inicio para acceder rápidamente a sus páginas web favoritas. Imprima páginas web, documentos PDF y otros tipos de documentos. Utilice la 
lista de lectura para recopilar sitios que desee leer más tarde.
Visualización de páginas web
Buscar en Internet y 
en la página actual.
Desplazarse sobre 
páginas web abiertas o 
abrir una página nueva.
Pulse un ítem dos veces 
o separe o junte los 
dedos para acercar o 
alejar la imagen.
Introducir una dirección web (URL).
Añadir un favorito, añadir a la lista de lectura, añadir un icono 
a la pantalla de inicio o compartir o imprimir la página.
Pulse la barra de estado para desplazarse 
rápidamente a la parte superior.
Ver sus favoritos o lista de lectura.
Ver una página web:  Pulse el campo de dirección (en la barra de título) para mostrar el teclado. 
Escriba la dirección web y pulse Ir.
Si no aparece el campo de dirección, pulse la barra de estado para ir rápidamente a la parte 
superior.
Puede visualizar páginas web en orientación vertical u horizontal.
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dirección
Pulse  .
Desplazarse por una página web Arrastre hacia arriba, hacia abajo o lateralmente.
Desplazarse dentro de un marco en 
una página web
Desplácese con dos dedos en el interior del marco.
Abrir una página nueva Pulse  y, a continuación, pulse “Nueva página”. Puede tener hasta ocho 
páginas abiertas a la vez. El número situado dentro de  indica cuántas 
páginas hay abiertas.
Ir a otra página Pulse  , desplace el dedo hacia la izquierda o hacia la derecha y, a continuación, pulse la página.
Detener la carga de una página 
web
Pulse  .
Volver a cargar una página web Pulse  en el campo de dirección.
Cerrar una página Pulse  y, a continuación, pulse  junto a la página.
Proteger información privada y 
bloquear el seguimiento de su 
comportamiento por parte de algunos sitios web
Vaya a Ajustes > Safari y active “Navegación privada”.
Ajustar opciones para Safari Vaya a Ajustes > Safari.
Enlaces
Seguir un enlace de una página web: Pulse el enlace.
Ver la dirección de destino de un 
enlace
Mantenga pulsado el enlace.
Los datos detectados —como números de teléfono y direcciones de correo electrónico— también pueden aparecer como enlaces en páginas web. Mantenga pulsado un enlace para ver las 
opciones disponibles. Consulte “Uso de enlaces y datos detectados” en la página 73.
Lista de lectura
La lista de lectura le permite recopilar enlaces a páginas web para leerlos posteriormente.
Añadir un enlace a la página actual a su lista de lectura:  Pulse  y, a continuación, pulse “Añadir 
a la lista de lectura”.
Añadir un enlace a su lista de lectura: Mantenga pulsado el enlace y, a continuación, seleccione 
“Añadir a la lista de lectura”.
Ver su lista de lectura Pulse  y, a continuación, pulse “Lista de lectura”.
Use iCloud para mantener su lista 
de lectura actualizada en sus dispositivos iOS y ordenadores.
Vaya a Ajustes > iCloud y, a continuación, active Favoritos. Consulte “iCloud” en la página 17.
Lector
El Lector muestra artículos web sin anuncios ni desorden, de modo que pueda leer sin distracciones. En una página web con un artículo, puede utilizar el Lector para ver solamente el artículo.
Ver un artículo en el Lector:  Pulse el botón Lector si aparece en el campo de dirección.
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Añadir a Favoritos, añadir a la lista 
de lectura o a la pantalla de inicio, 
compartir o imprimir el artículo
Pulse  .
Volver al modo de visualización 
normal
Pulse OK.
Cómo introducir texto y rellenar formularios
Introducir texto: Pulse un campo de texto para mostrar el teclado.
Desplazarse a otro campo de texto Pulse el campo de texto, o pulse Siguiente o Anterior.
Enviar un formulario Pulse Ir o Buscar, o el enlace de la página para enviar el formulario, si está 
disponible.
Para activar Autorrelleno para ayudarle a rellenar formularios, vaya a Ajustes > Safari > 
Autorrelleno.
Cómo buscar
El campo de búsqueda de la esquina superior derecha le permite efectuar búsquedas en Internet 
y en la página web o PDF actual.
Realizar búsquedas en Internet y en la página web actual o PDF con capacidad de búsqueda:  Introduzca texto en el campo Buscar.
Â Para buscar en Internet:  Pulse una de las sugerencias que aparecen o pulse Buscar.
Â Para buscar el texto objeto de la búsqueda en la página o PDF actual:  Desplácese a la parte inferior de la pantalla y, a continuación, pulse la entrada situada bajo “En esta página”.
La primera aparición se mostrará resaltada. Para buscar apariciones posteriores, pulse  .
Cambiar el motor de búsqueda Vaya a Ajustes > Safari > Buscador.
Favoritos e historial
Añadir una página web a los favoritos: Abra la página, pulse  y, a continuación, pulse “Añadir 
favorito”.
Al guardar un favorito, podrá editar su título. Por omisión, los favoritos se guardan en el nivel superior de Favoritos. Pulse Favoritos para seleccionar otra carpeta.
Ver páginas web anteriores (historial):  Pulse  y, a continuación, pulse Historial. Para borrar el 
historial, pulse Borrar.
Abrir una página web marcada 
como favorito
Pulse  .
Editar un favorito o una carpeta de 
favoritos
Pulse  , seleccione la carpeta que contiene el favorito o la carpeta que 
desea editar y pulse Editar.
Use iCloud para mantener actualizados los favoritos en sus dispositivos iOS y ordenadores.
Vaya a Ajustes > iCloud y, a continuación, active Favoritos. Consulte “iCloud” en la página 17.
Sincronizar favoritos con el navegador web de su ordenador
Consulte “Sincronización con iTunes” en la página 18.
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Imprimir una página web, un archivo PDF o un documento de Vista Rápida: Pulse  y, a continuación, pulse Imprimir.
Para obtener más información, consulte “Impresión” en la página 29.
Clips web
Puede crear clips web, que se representan mediante iconos en la pantalla de inicio.
Añadir un clip web: Abra la página web y pulse  . A continuación, pulse “Añadir a pantalla de 
inicio”.
Cuando abre un clip web, Safari acerca la imagen de forma automática hacia la zona de la página 
web que se mostraba en el momento de guardar el clip web. La imagen también se utiliza para el 
icono del clip web en la pantalla de inicio, salvo que la página web disponga de su propio icono 
personalizado.
iCloud y iTunes realizan una copia de seguridad de los clips web, pero estos no se sincronizan con 
iTunes o MobileMe. iCloud tampoco los transfiere a otros dispositivos.
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Cómo añadir música y audio
Para obtener música y otros contenidos de audio en el iPhone:
Â Compre y descargue contenido de la tienda iTunes Store en el iPhone. Consulte Capítulo 21,“La 
tienda iTunes Store,” en la página 124. (También puede ir a la tienda iTunes Store desde Música 
pulsando el botón Store si se encuentra explorando contenidos.)
Â Use “Descargas automáticas” para descargar automáticamente nueva música adquirida en otros 
dispositivos iOS y ordenadores. Consulte “iCloud” en la página 17.
Â Realice una sincronización con iTunes en su ordenador. Puede sincronizar todos sus contenidos, 
o bien seleccionar canciones concretas y otros archivos. Consulte “Sincronización con iTunes” en 
la página 18.
Â Utilice iTunes Match para almacenar su biblioteca musical de iCloud y acceder a ella desde todos sus dispositivos iOS y ordenadores. Consulte “iTunes Match” en la página 86.
Cómo reproducir música y otros contenidos de audio
ADVERTENCIA: Para obtener información importante sobre cómo prevenir daños auditivos, 
consulte la Guía de información importante del producto en support.apple.com/es_ES/manuals/
iphone/ (España y Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ (México).
Los botones situados a lo largo de la parte inferior de la pantalla le permiten buscar contenido en 
el iPhone por listas de reproducción, artistas, canciones y otras categorías.
Reproducir una canción u otro tipo de archivo:  Pulse el ítem.
Use los controles en pantalla para controlar la reproducción. También puede pulsar los botones de 
los auriculares. Consulte “Auriculares Apple Earphones con micrófono” en la página 34.
82Ver la pantalla “Ahora suena”:  Pulse “Ahora suena”.
Siguiente/Avance 
rápido
Reproducción/Pausa
Lista de pistas
Atrás
Anterior/Ret Volumen
roceso
AirPlay
Personalizar los botones de 
exploración
Pulse Más, pulse Editar y, a continuación, arrastre un icono sobre el botón 
que desee reemplazar.
Obtener más episodios de podcast Pulse Podcasts (o pulse Más primero, si Podcasts no es visible) y, a continuación, pulse un podcast para ver los episodios disponibles.
Agitar para aleatorio Agite el iPhone para activar la función de reproducción aleatoria y cambiar 
de canción. Agite de nuevo para cambiar a otra canción.
Para activar o desactivar la opción “Agitar para aleatorio”, vaya a Ajustes > 
Música.
Reproducir música en altavoces 
AirPlay o en un Apple TV
Pulse  . Consulte “AirPlay” en la página 35.
Mostrar la letra de una canción Pulse la ilustración del álbum mientras se reproduce una canción. (Las letras 
aparecen si las ha añadido a la canción utilizando la ventana de información de la canción en iTunes y si ha sincronizado el iPhone con iTunes.)
Ajustar opciones para Música Vaya a Ajustes > Música. 
Cuando utilice otra app, puede mostrar los controles de reproducción de audio haciendo doble 
clic en el botón de inicio  y, a continuación, desplazándose de izquierda a derecha a lo largo de 
la parte inferior de la pantalla.
Estos controles funcionan en la app actualmente activa o, si la música está en pausa, en la app 
activa más reciente. El icono de la app se muestra a la derecha. Púlselo para abrir la app. Vuelva a 
desplazarse hacia la derecha para mostrar un control de volumen y el botón de AirPlay (cuando se 
encuentre en el radio de alcance de un Apple TV o de unos altavoces AirPlay).
Haciendo doble clic en el botón de inicio  también se muestran los controles de reproducción 
de audio cuando la pantalla está bloqueada.
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Para mostrar controles adicionales, pulse la ilustración del álbum en la pantalla “Ahora suena”. 
Puede ver el tiempo transcurrido, el tiempo restante y el número de la canción. También aparece 
la letra de la canción si la ha añadido a la canción en iTunes.
Repetir Me gusta 
(Ping)
Barra de 
desplazamiento
Aleatorio
Genius
Publicar (Ping)
Cursor de 
reproducción
Repetir canciones Pulse  . 
 = repetir todas las canciones del álbum o de la lista
 = repetir solamente la canción actual
 = no repetir
Reproducir canciones 
aleatoriamente
Pulse  . 
 = reproducir canciones aleatoriamente
 = reproducir canciones en orden
Ir a cualquier punto de una canción Arrastre el cursor de reproducción a lo largo de la barra de desplazamiento. 
Deslice el dedo hacia abajo para ralentizar la velocidad de desplazamiento.
Crear una lista de reproducción 
Genius
Pulse  . Consulte “Genius” en la página 86.
Usar Ping Consulte “Cómo seguir a artistas y amigos” en la página 126.
Controles de podcasts y audiolibros
Al iniciar la reproducción, en la pantalla “Ahora suena” aparecen controles de podcasts y audiolibros, así como información.
Barra de 
desplazamiento
Cursor de reproducción
Velocidad de 
reproducción
Repetición de 30 segundos
Correo 
electrónico 
Ajustar la velocidad de 
reproducción
Pulse  . Vuelva a pulsar para cambiar la velocidad.
 = Reproducir al doble de velocidad.
 = Reproducir a la mitad de velocidad.
 = Reproducir a velocidad normal.
Saltar a cualquier punto del control 
temporal
Arrastre el cursor de reproducción a lo largo de la barra de desplazamiento. 
Deslice el dedo hacia abajo para ralentizar la velocidad de desplazamiento.
Mostrar u ocultar los controles Pulse el centro de la pantalla.
Ocultar la información del podcast Vaya a Ajustes > Música.
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Puede usar Siri (iPhone 4S) o “Control por voz” para controlar la reproducción de música en el 
iPhone. Consulte Capítulo 4,“Siri,” en la página 41 y “Control por voz” en la página 31.
Controlar la reproducción de 
música
Diga “reproducir” o “reproducir música”. Para poner en pausa la reproducción, diga “pausa” o “música en pausa”. También puede decir “canción anterior” o “canción anterior”.
Reproducir un álbum, artista o lista 
de reproducción
Diga “reproducir” y, a continuación, “álbum” “artista” o “lista” y el nombre.
Reorganizar aleatoriamente la lista 
de reproducción actual
Diga “aleatorio”.
Obtener más información sobre la 
canción que se está reproduciendo 
en estos momentos
Diga “qué suena”, “qué canción es esta”, “quién canta esta canción” o “de 
quién es esta canción”.
Usar Genius para reproducir canciones similares
Diga “Genius”, “reproducir más canciones así” o “reproducir más canciones 
como esta”.
Cancelar “Control por voz” Diga “cancelar” o “detener”.
Cómo explorar ilustraciones de álbumes en Cover Flow
Cuando busque música, gire el iPhone para ver el contenido de iTunes en Cover Flow y explorar la 
música por la ilustración de los álbumes.
Buscar ilustraciones de álbumes:  Arrastre el dedo hacia la izquierda o hacia la derecha.
Ver las pistas de un álbum Pulse la ilustración del álbum o  . Arrastre hacia arriba o hacia abajo para 
desplazarse; pulse una pista para reproducirla.
Volver a la ilustración Pulse la barra de título. O vuelva a pulsar  .
Cómo visualizar las pistas de un álbum
Consultar todas las pistas del álbum que contiene la canción actual: En la pantalla “Ahora suena”, pulse  . Pulse una pista para reproducirla. Pulse la imagen en miniatura para volver a la pantalla “Ahora suena”.
Barra de puntuación
Volver a la pantalla 
“En reproducción”.
Pistas del álbum
Capítulo 8    Música 85En la vista a modo de lista de pistas, puede asignar puntuaciones a las canciones. Puede utilizar las 
puntuaciones para crear listas de reproducción inteligentes en iTunes.
Cómo buscar contenido de audio
Puede realizar búsquedas en los títulos, artistas, álbumes y autores de canciones, podcasts y otros 
contenidos de audio del iPhone.
Buscar música: Introduzca texto en el campo Buscar, en la parte superior de una lista de canciones, lista de reproducción, lista de artistas o cualquier otra visualización del contenido de Música.
También puede buscar contenido de audio desde la pantalla de inicio. Consulte “Cómo buscar” en 
la página 30.
iTunes Match
iTunes Match almacena su biblioteca musical en iCloud (incluidas las canciones importadas de 
discos CD) y le permite disfrutar de su colección en cualquier lugar y en cualquier momento, en 
el iPhone y en otros dispositivos iOS y ordenadores. iTunes Match estará disponible mediante el 
pago de una suscripción.
Nota: iTunes Match no está disponible en todas las áreas. Pueden aplicarse tarifas de datos de 
telefonía móvil si está activada la opción Ajustes > Música > “Usar datos móviles”.
Suscribirse a iTunes Match:  En iTunes en su ordenador, seleccione Store > “Activar iTunes Match” 
y, a continuación, haga clic en el botón Suscribirse.
Una vez suscrito, iTunes añadirá su música, listas de reproducción y mezclas Genius a iCloud. Las 
canciones que coincidan con la música que ya se encuentre en la tienda iTunes Store pasarán a 
estar automáticamente disponibles en iCloud. Las canciones que falten se cargarán. Puede descargar y reproducir las canciones coincidentes con calidad iTunes Plus (AAC a 256 kbps sin DRM), 
aunque la calidad del original fuese inferior. Para obtener más información al respecto, consulte 
www.apple.com/es/icloud/features.
Activar iTunes Match Vaya a Ajustes > Música.
La activación de iTunes Match elimina la música sincronizada del iPhone y 
desactiva las mezclas Genius y las listas de reproducción Genius.
Genius
Una lista de reproducción Genius es una colección de canciones de su biblioteca que combinan 
bien. Puede crear listas de reproducción Genius en iTunes y sincronizarlas con el iPhone. También 
puede crear y guardar listas de reproducción Genius directamente en el iPhone.
Una mezcla Genius es una selección de canciones del mismo estilo musical, que vuelve a crearse a 
partir de su biblioteca cada vez que la escucha.
Para utilizar Genius en el iPhone, primero debe activar Genius en iTunes y, después, debe sincronizar el iPhone con iTunes. Las mezclas Genius se sincronizan automáticamente, a menos que gestione manualmente su música y seleccione qué mezclas desea sincronizar en iTunes. Genius es un 
servicio gratuito, pero requiere disponer de un ID de Apple.
Al sincronizar una mezcla Genius, iTunes puede seleccionar y sincronizar canciones de su biblioteca que usted no haya seleccionado específicamente para sincronizar.
86 Capítulo 8    MúsicaBuscar mezclas Genius: Pulse Genius (o pulse Más primero, si Genius no es visible). Desplácese 
hacia la izquierda o hacia la derecha para acceder a las demás mezclas. Para reproducir una mezcla, pulse  .
Crear una lista de reproducción Genius:  Pulse Listas, pulse “Lista Genius” y seleccione una canción de la lista.
Para crear una lista de reproducción Genius desde la pantalla “Ahora suena”, pulse para para mostrar los controles y, a continuación, pulse  .
Guardar una lista de reproducción 
Genius
En la lista, pulse Guardar. La lista se guarda en Listas con el título de la canción elegida.
Actualizar una lista de reproducción Genius
En la lista, pulse Actualizar.
Crear una lista de reproducción 
Genius utilizando una canción 
diferente
Pulse “Lista Genius” y, a continuación, pulse Nueva y elija una canción.
Borrar una lista de reproducción 
Genius guardada
Pulse la lista de reproducción Genius y, a continuación, pulse Eliminar.
Las listas de reproducción Genius creadas en el iPhone se copiarán en su ordenador al sincronizarlo con iTunes.
Nota: Cuando una lista de reproducción Genius se sincronice con iTunes, no podrá borrarla directamente del iPhone. Utilice iTunes para editar el nombre de la lista de reproducción, detener su 
sincronización o eliminarla.
Listas de reproducción
Puede crear y editar sus propias listas de reproducción en el iPhone o editar listas de reproducción sincronizadas desde iTunes en su ordenador.
Crear una lista de reproducción:  Pulse Listas y, a continuación, pulse “Añadir lista”, junto a la parte 
superior de la lista. Escriba un título, pulse  para seleccionar las canciones y los vídeos que desee incluir y, a continuación, pulse OK.
Cuando crea una lista de reproducción y luego sincroniza el iPhone con el ordenador, la lista se 
sincroniza con la biblioteca de iTunes.
Editar una lista de reproducción:  Pulse Listas y, a continuación, seleccione la lista de reproducción que desee editar. Pulse Editar y realice una de las siguientes operaciones:
Â Para añadir más canciones:  Pulse  .
Â Para borrar una canción:  Pulse  . Borrar una canción de la lista de reproducción no la elimina 
del iPhone.
Â Para subir o bajar una canción en la lista:  Arrastre  .
Sus ediciones se copiarán en la lista de reproducción de su biblioteca de iTunes, o bien la próxima 
vez que sincronice el iPhone con su ordenador, o bien de forma inalámbrica a través de iCloud si 
está suscrito a iTunes Match.
Capítulo 8    Música 87Eliminar una lista de reproducción En Listas, pulse la lista de reproducción que desee eliminar y, a continuación, pulse Eliminar.
Borrar una lista de reproducción En Listas, pulse la lista de reproducción que desee borrar y, a continuación, 
pulse Borrar.
Eliminar una canción del iPhone En Canciones, deslice el dedo sobre la canción y, a continuación, pulse 
Eliminar.
La canción se eliminará del iPhone, pero no de su biblioteca de iTunes de 
su Mac o PC.
Compartir en casa
La función “Compartir en casa” le permite reproducir música, películas y programas de televisión 
en el iPhone desde la biblioteca de iTunes de su Mac o PC. El iPhone y el ordenador deben estar 
conectados a la misma red Wi-Fi. En el ordenador, debe tener la aplicación iTunes abierta, con 
la función “Compartir en casa” activada y con una sesión iniciada con el mismo ID de Apple que 
“Compartir en casa” en el iPhone.
Nota: Esta función requiere iTunes 10.2 o posterior, disponible en www.itunes.com/es/download. 
No es posible compartir contenidos extra, como folletos digitales y iTunes Extras.
Reproducir música desde la biblioteca de iTunes en el iPhone:
1 En iTunes, en su ordenador, seleccione Avanzado > Activar Compartir en casa.
2 Inicie sesión y, a continuación, haga clic en “Crear Compartir en casa”. 
3 En el iPhone, vaya a Ajustes > Música y, a continuación, inicie sesión en “Compartir en casa” con el 
mismo ID de Apple y la misma contraseña.
4 En Música, pulse Más y, a continuación, pulse Compartido y seleccione la biblioteca de su 
ordenador.
Regresar al contenido del iPhone Pulse Compartido y seleccione “Mi iPhone”.
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Cómo enviar y recibir mensajes
ADVERTENCIA: Para obtener información importante acerca de una conducción segura, consulte 
la Guía de información importante del producto en support.apple.com/es_ES/manuals/iphone/ 
(España y Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ (México).
Mensajes acepta mensajes de texto de otros dispositivos SMS y MMS, y de otros dispositivos iOS 
que utilizan iMessage. Con MMS y iMessage, también puede incluir fotos, vídeos y otros tipos de 
archivos.
Utilice iMessage para enviar mensajes a través de conexiones Wi-Fi o conexiones de datos de telefonía móvil a otros usuarios de iOS 5. Puede ver cuándo está escribiendo la otra persona, y dejar 
que a otras personas se les notifique que ha leído sus mensajes. Como los mensajes de iMessage 
se muestran en todos sus dispositivos iOS 5 con una sesión iniciada en la misma cuenta, puede 
iniciar una conversación en uno de sus dispositivos y continuarla en otro. Los mensajes de iMessage también se encriptan.
Nota: SMS y MMS requieren una conexión de telefonía móvil, y es posible que no estén disponibles en todas las áreas. Pueden aplicarse tarifas de datos de telefonía móvil o tarifas adicionales.
Enviar un mensaje de texto:  Pulse  y, a continuación, pulse  y seleccione un contacto, busque en sus contactos introduciendo un nombre, o introduzca un número de teléfono o una dirección de correo electrónico manualmente. Escriba el mensaje y pulse Enviar.
Nota: Si no es posible enviar un mensaje, aparecerá un globo de alerta  . Pulse la alerta de una 
conversación para intentar enviar el mensaje de nuevo.
89Las conversaciones se guardan en la lista Mensajes. Un punto azul  indica los mensajes sin leer. 
Pulse una conversación para verla o continuar con ella. En una conversación de iMessage, sus 
mensajes salientes se muestran de color azul.
Pulse el botón de 
adjuntar contenido 
multimedia para incluir 
una foto o un vídeo.
Pulse para 
introducir texto.
Utilizar caracteres emoji Vaya a Ajustes > General > Teclado > Teclados internacionales > Añadir 
nuevo teclado y, a continuación, pulse Emoji para hacer que esté disponible 
ese teclado. Para introducir caracteres Emoji al escribir un mensaje, pulse 
a fin de mostrar el teclado Emoji. Consulte “Cómo cambiar de teclado” en la 
página 185.
Reanudar una conversación previa Pulse la conversación en la lista Mensajes y, a continuación, escriba un mensaje y pulse Enviar.
Mostrar mensajes anteriores de la 
conversación
Desplácese a la parte superior (pulse la barra de estado) y pulse “Cargar 
mensajes anteriores”.
Recibir mensajes de iMessage utilizando otra dirección de correo 
electrónico
Vaya a Ajustes > Mensajes > Recibir en > “Añadir otro correo electrónico”.
Especificar el número de teléfono 
o la dirección de correo electrónico 
correspondiente al ID de Apple que 
aparece en el campo “de” al iniciar 
una nueva conversación
Vaya a Ajustes > Mensajes > Recibir en > “ID de llamada”.
Las conversaciones existentes no se verán afectadas cuando cambie este 
ajuste.
Seguir un enlace en un mensaje Pulse el enlace. Un enlace puede abrir una página web en Safari o marcar 
un número de teléfono, por ejemplo.
Reenviar una conversación Seleccione una conversación y, a continuación, pulse Editar. Seleccione las 
partes de la conversación que desee incluir y pulse Reenviar.
Añadir una persona a su lista de 
contactos
Pulse un número de teléfono en la lista Mensajes y, a continuación, pulse 
“Añadir contacto”.
Notificar a otras personas que ha 
leído sus mensajes
Vaya a Ajustes > Mensajes y active “Notificar lectura”.
Ajustar otras opciones de Mensajes Vaya a Ajustes > Mensajes.
Gestionar notificaciones para 
mensajes
Consulte “Notificaciones” en la página 174.
Ajustar el sonido de alerta para 
mensajes de texto entrantes
Consulte “Sonidos y el botón de tono/silencio” en la página 177.
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La opción “Mensajería en grupo” le permite enviar un mensaje a varios destinatarios. La mensajería 
en grupo funciona con iMessage y MMS (no disponible en todas las áreas).
Enviar mensajes a un grupo:  Pulse  y, a continuación, introduzca varios destinatarios.
Nota: Con MMS, también debe estar activada la mensajería en grupo en Ajustes > Mensajes, y las 
respuestas solo se le enviarán a usted, no se copiarán al resto de las personas del grupo.
Cómo enviar fotos, vídeos y otros contenidos
Con iMessage o MMS, puede enviar fotos, vídeos, ubicaciones, datos de contacto y notas de voz.
Enviar una foto o vídeo:  Pulse  .
El límite de tamaño de los archivos adjuntos viene determinado por su proveedor de servicios. El 
iPhone puede comprimir los archivos de foto o vídeo adjuntos en caso necesario.
Enviar una ubicación En Mapas, pulse  para una ubicación, pulse “Compartir ubicación” (en la 
parte inferior de la pantalla) y, por último, pulse Mensaje.
Enviar información de contacto En Contactos, seleccione un contacto, pulse “Compartir contacto” (en la 
parte inferior de la pantalla) y, a continuación, pulse Mensaje.
Enviar una nota de voz En Notas de Voz, pulse  , pulse la nota de voz, pulse Compartir y, a continuación, pulse Mensaje.
Guardar una foto o un vídeo recibido en el álbum Carrete
Pulse la foto o el vídeo y, a continuación, pulse  .
Copiar una foto o vídeo Mantenga pulsado el archivo adjunto y, a continuación, pulse Copiar.
Guardar información de contacto 
recibida
Pulse la burbuja de contacto y, a continuación, pulse “Nuevo contacto” o 
“Contacto existente”.
Cómo editar conversaciones
Si desea guardar solamente una parte de una conversación, puede eliminar las partes que no desee. También puede eliminar conversaciones enteras desde la lista Mensajes.
Editar una conversación:  Pulse Editar, seleccione las partes que desee eliminar y, a continuación, 
pulse Eliminar.
Borrar todos los mensajes y archivos adjuntos sin eliminar la 
conversación
Pulse Editar y, a continuación, pulse “Borrar todo”.
Eliminar una conversación Pase el dedo por la conversación y, a continuación, pulse Eliminar.
Cómo buscar mensajes
Puede buscar en el contenido de las conversaciones de la lista Mensajes.
Buscar una conversación:  Pulse la parte superior de la pantalla para mostrar el campo de búsqueda y, a continuación, introduzca el texto que desee buscar.
También puede buscar conversaciones desde la pantalla de inicio. Consulte “Cómo buscar” en la 
página 30.
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Acerca de Calendario
Calendario le permite ceñirse a sus horarios programados con facilidad. Puede ver calendarios 
determinados uno por uno o bien varios calendarios a la vez. Asimismo, puede visualizar los 
eventos por días, por meses o en forma de lista. Puede realizar búsquedas en los títulos, invitados, 
ubicaciones y notas de los eventos. Si introduce datos de cumpleaños para sus contactos, puede 
mostrarlos en Calendario.
También puede crear, editar o cancelar eventos en el iPhone y sincronizarlos con su ordenador. 
Puede suscribirse a calendarios de Google, Yahoo! o iCal. Si tiene una cuenta Microsoft Exchange o 
iCloud, puede recibir y responder a invitaciones de reunión.
Visualización de los calendarios
Puede ver los calendarios de uno en uno, o en forma de calendario combinado. Esto facilita la gestión simultánea de los calendarios de trabajo y familiares.
Añadir un evento.
Los días con puntos 
contienen eventos 
programados.
Ir a hoy. Cambiar de 
visualización.
Responder a una 
invitación del calendario.
Eventos para el día 
seleccionado
Cambiar de visualización: Pulse Lista, Día o Mes. Para ver el calendario por semana, gire el iPhone 
lateralmente.
En la visualización Día, desplácese hacia la izquierda o hacia la derecha para moverse por las 
fechas.
92Ver el calendario de cumpleaños Pulse Calendarios y, a continuación, pulse Cumpleaños para incluir cumpleaños de sus Contactos con sus eventos.
Consultar los detalles de un evento Pulse el evento. Puede pulsar la información del evento para obtener más 
detalles. Si se especifica, por ejemplo, una dirección para la ubicación, púlsela para abrir Mapas.
Editar o eliminar un calendario Pulse Calendarios y, a continuación, pulse Editar.
Seleccionar los calendarios que se 
mostrarán
Pulse Calendarios y, a continuación, pulse para seleccionar los calendarios 
que desea ver. Los eventos de todos los calendarios seleccionados aparecen 
en un solo calendario en el iPhone.
Cómo añadir eventos
También puede crear y actualizar eventos de calendario directamente en el iPhone.
Añadir un evento:  Pulse  , introduzca la información del evento y, a continuación, pulse OK.
También puede mantener pulsado un punto vacío de un calendario para crear un nuevo evento. 
Arrastre los puntos de selección para ajustar la duración del evento.
Ajustar una alerta Pulse Alerta y, a continuación, ajuste una alerta de 5 minutos a dos días 
antes del evento.
Ajustar una alerta por omisión para 
los eventos
Vaya a Ajustes > Correo, contactos, calendarios > Alertas por omisión.
Actualizar un evento Pulse Editar y modifique la información del evento. 
Para ajustar rápidamente la hora o duración de un evento, mantenga pulsado el evento para seleccionarlo y, a continuación, arrástrelo a una nueva 
hora o use los puntos de selección para cambiar su duración.
Eliminar un evento Pulse el evento, pulse Editar y después desplácese hacia abajo y pulse 
“Eliminar evento”.
Invitar a otras personas a un evento Pulse Invitados para seleccionar personas de Contactos. Para ello, es necesario disponer de una cuenta de iCloud, Microsoft Exchange o CalDAV.
Cómo responder a invitaciones
Si posee una cuenta iCloud, Microsoft Exchange o una cuenta CalDAV compatible, podrá recibir 
invitaciones de reunión de otras personas de su empresa y responderlas. Cuando se recibe una 
invitación, la reunión aparece en su calendario rodeada por una línea de puntos.  aparece en la 
esquina inferior derecha de la pantalla.
Responder a una invitación:  Pulse una invitación del calendario. O pulse  para que se muestre 
la pantalla de eventos y, a continuación, pulse una invitación.
Ver información sobre el 
organizador
Pulse “Invitación de”.
Ver otros invitados Pulse Invitados. Pulse un nombre para ver los datos de contacto de dicha 
persona.
Añadir comentarios como 
respuesta
Pulse “Añadir comentarios”. Sus comentarios son visibles para el organizador, 
pero no para los demás invitados. Es posible que los comentarios no estén 
disponibles, según el servicio de calendario que utilice.
Ajustar su disponibilidad Pulse Disponibilidad y seleccione “Ocupado” o “Libre”.
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En la visualización como lista, puede realizar búsquedas en los campos Título, Invitados, 
Ubicaciones y Notas de los calendarios. Calendario solo busca en los eventos de los calendarios 
que se están visualizando.
Buscar eventos:  Pulse Lista y, a continuación, introduzca texto en el campo de búsqueda.
Los eventos de Calendario también pueden incluirse en las búsquedas realizadas en la pantalla de 
inicio. Consulte “Cómo buscar” en la página 30.
Suscripción a calendarios
Puede suscribirse a calendarios que utilicen el formato iCalendar (.ics). Muchos servicios basados 
en calendarios aceptan la suscripción a calendarios, como iCloud, Yahoo!, Google y la aplicación 
iCal de OS X.
Los calendarios de suscripción son de solo lectura. Puede leer los eventos de los calendarios a los 
que se ha suscrito en el iPhone, pero no puede editarlos ni crear nuevos eventos.
Suscribirse a un calendario: Vaya a Ajustes > “Correo, contactos, calendarios” y pulse “Añadir 
cuenta”. Pulse Otras y, a continuación, pulse “Añadir calendario suscrito”.
También puede suscribirse a un calendario de iCal (u otro calendario en formato .ics) publicado en 
Internet pulsando un enlace a dicho calendario.
Importación de eventos de calendario desde Mail
Puede añadir eventos a un calendario importando un archivo de calendario desde un mensaje de 
correo electrónico. Puede importar cualquier archivo de calendario .ics estándar.
Importar eventos desde un archivo de calendario:  En Mail, abra el mensaje y pulse el archivo de 
calendario.
Cuentas de calendario y ajustes de Calendario
Hay varios ajustes en Ajustes > “Correo, contactos, calendarios” que afectan a Calendario y a sus 
cuentas de calendario.
Las cuentas de calendario también se utilizan para sincronizar tareas para Recordatorios.
Añadir una cuenta CalDAV:  Vaya a Ajustes > “Correo, contactos, calendarios”, pulse “Añadir cuenta” 
y, a continuación, pulse Otras. En Calendarios, pulse “Añadir cuenta CalDAV”.
Estas opciones se aplican a todos sus calendarios:
Ajustar tonos de alerta para 
calendarios
Vaya a Ajustes > Sonidos > Alertas calendario. 
Sincronizar eventos pasados Vaya a Ajustes > Correo, contactos, calendarios > Sincronizar y, a continuación, seleccione un periodo de tiempo. Los eventos futuros siempre están 
sincronizados.
Establecer que suene una alerta 
cuando reciba una invitación a una 
reunión
Vaya a Ajustes > “Correo, contactos, calendarios” y active “Alerta de 
invitación”.
Activar el soporte para zona horaria 
del calendario
Vaya a Ajustes > Correo, contactos, calendarios > “Soporte zona horaria”.
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Use iCloud para mantener actualizado Calendario en sus dispositivos 
iOS y ordenadores.
Vaya a Ajustes > iCloud y, a continuación, active Calendario. Consulte “iCloud” en la página 17.
Importante: Cuando “Soporte zona horaria” está activado, el calendario muestra la fecha y la hora 
de los eventos según la zona horaria de la ciudad seleccionada. Cuando está desactivado, el calendario muestra los eventos en la zona horaria de su ubicación actual, determinada por el horario 
de red. Algunos operadores no ofrecen el servicio horario de red en todas las áreas. Cuando esté 
de viaje, es posible que el iPhone no muestre los eventos o alertas sonoras a la hora local correcta. 
Para ajustar de forma manual la hora correcta, consulte “Fecha y hora” en la página 182.
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Cómo visualizar fotos y vídeos
Fotos le permite ver las fotos y vídeos del iPhone en su:
Â Álbum Carrete: fotos y vídeos realizados con cualquier de las cámaras integradas, o fotos y ví-
deos guardados procedentes de un mensaje de correo electrónico, un mensaje de texto o una 
página web
Â Álbum “Fotos en streaming”: fotos transferidas desde iCloud (consulte “Fotos en streaming” en la 
página 102)
Â Fototeca y otros álbumes sincronizados desde su ordenador (consulte “Sincronización con iTunes” en la página 18)
Editar la foto.
Eliminar la foto.
Pulse la pantalla para 
mostrar los controles.
Compartir la foto, asignársela a un contacto,
utilizarla como fondo de pantalla o imprimirla.
Reproducir un pase de diapositivas.
Transmitir fotos utilizando AirPlay.
Visualizar fotos y vídeos:  Pulse un álbum y, a continuación, pulse la imagen en miniatura de una 
foto o de un vídeo para verlo a pantalla completa.
Los álbumes que sincronice con iPhoto 8.0 (iLife ’09) o posterior, o con Aperture v3.0.2 o posterior, 
podrán visualizarse por eventos o por caras. También podrá visualizar las fotos por lugar si se han 
realizado con una cámara compatible con la función de etiquetado geográfico.
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Visualizar la foto o el vídeo siguiente o anterior
Desplácese hacia la izquierda o hacia la derecha.
Acercar o alejar la imagen Pulse dos veces o pellizque.
Desplazar una foto Arrastre la foto.
Reproducir un vídeo Pulse  en el centro de la pantalla.
Visualizar un vídeo a pantalla completa o ajustar a pantalla
Pulse dos veces en el vídeo.
Transmitir un vídeo a un HDTV Consulte “AirPlay” en la página 35.
Editar fotos o recortar vídeos Consulte “Cómo editar fotos” o “Cómo cortar vídeos” en la página 101.
Cómo visualizar pases de diapositivas
Ver un pase de diapositivas:  Pulse un álbum para abrirlo, pulse una foto y, a continuación, pulse 
. Seleccione las opciones del pase de diapositivas y, a continuación, pulse “Iniciar pase”.
Transmitir un pase de diapositivas 
a un HDTV
Consulte “AirPlay” en la página 35.
Detener un pase de diapositivas Pulse la pantalla.
Ajustar opciones adicionales Vaya a Ajustes > Fotos.
Cómo organizar fotos y vídeos
Puede crear, renombrar y eliminar álbumes en el iPhone para organizar sus fotos y vídeos.
Crear un álbum: Mientras visualiza los álbumes, pulse Editar y, a continuación, pulse Añadir. 
Seleccione fotos para añadirlas al nuevo álbum y, a continuación, pulse OK.
Nota: Los álbumes creados en el iPhone no se sincronizarán con el ordenador.
Renombrar un álbum Pulse Editar y, a continuación, seleccione un álbum.
Reorganizar álbumes Pulse Editar y, a continuación, arrastre  hacia arriba o hacia abajo.
Eliminar un álbum Pulse Editar y, a continuación, pulse  .
Cómo compartir fotos y vídeos
Enviar una foto o un vídeo en un mensaje de correo electrónico, en un mensaje de texto (iMessage o MMS) o a través de Twitter:  Seleccione una foto o un vídeo y, a continuación, pulse  . Si 
no ve  , pulse la pantalla para mostrar los controles.
Nota: Para publicar un mensaje en Twitter, debe tener iniciada una sesión en su cuenta de Twitter. 
Vaya a Ajustes > Twitter.
El límite de tamaño de los archivos adjuntos viene determinado por su proveedor de servicios. El 
iPhone puede comprimir los archivos de foto o vídeo adjuntos en caso necesario.
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o los vídeos y, a continuación, pulse Compartir.
Copiar una foto o vídeo Mantenga pulsada la foto o el vídeo y, a continuación, pulse Copiar.
Copiar varias fotos o vídeos Pulse  en la esquina superior derecha de la pantalla. Seleccione las fotos 
y los vídeos y, a continuación, pulse Copiar.
Pegar una foto o un vídeo en un 
mensaje de correo electrónico o 
en un mensaje de texto (iMessage 
o MMS)
Mantenga pulsado el lugar donde desee colocar la foto o el vídeo y, a continuación, pulse Pegar.
Guardar una foto o un vídeo procedente de un mensaje de correo 
electrónico
Pulse para descargar el ítem si es necesario, pulse la foto o mantenga pulsado el vídeo y, a continuación, pulse Guardar.
Guardar una foto o un vídeo procedente de un mensaje de texto
Pulse la imagen en la conversación, pulse  , y, a continuación, pulse 
Guardar.
Guardar una foto de una página 
web
Mantenga pulsada la foto y, a continuación, pulse “Guardar imagen”.
Compartir un vídeo en YouTube Mientras visualiza un vídeo, pulse  y, a continuación, pulse “Enviar a 
YouTube”.
Las fotos y vídeos que reciba, o que guarde de una página web, se guardarán en el álbum Carrete.
Impresión de fotos
Imprimir una foto: Pulse  y, a continuación, pulse Imprimir.
Imprimir varias fotos: Mientras visualiza un álbum de fotos, pulse  . Seleccione las fotos que desee imprimir y, a continuación, pulse Imprimir. 
Para obtener más información, consulte “Impresión” en la página 29.
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Acerca de Cámara
Las cámaras integradas le permiten realizar fotografías y grabar vídeos. El iPhone 4 y el iPhone 4S 
incluyen una cámara frontal para FaceTime y autorretratos (además de la cámara de la parte trasera) y un flash LED. 
Pulse una 
persona u 
objecto para 
enfocar y 
ajustar la 
exposición.
Cambiar de 
cámara.
Hacer una foto.
Interruptor Cámara/Vídeo
Ver las fotos y los vídeos realizados.
Ajustar el modo de flash LED.
Activar la cuadrícula o HDR.
Si los servicios de localización están activados, las fotos y los vídeos se etiquetarán con datos de 
localización que podrán utilizarse en algunas apps y sitios web que permiten compartir fotos. 
Consulte “Localización” en la página 175.
Nota: Si cuando abra la app Cámara los servicios de localización están desactivados, se le solicitará que los active. No obstante, puede utilizar Cámara sin los servicios de localización.
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Para abrir rápidamente la app Cámara cuando el iPhone esté bloqueado, pulse el botón de inicio 
 o el botón de encendido/apagado y, a continuación, arrastre  hacia arriba.
Hacer una foto: Asegúrese de que el interruptor Cámara/Vídeo esté situado en la posición  y, a 
continuación, dirija el iPhone hacia lo que desee fotografiar y pulse  . También puede hacer una 
foto pulsando el botón de subir volumen.
Grabar un vídeo: Desplace el interruptor Cámara/Vídeo a la posición  y, a continuación, pulse 
 para iniciar o detener la grabación, o pulse el botón de subir volumen.
Cuando hace una foto o empieza la grabación de un vídeo, el iPhone emite un sonido de obturador. Puede controlar el volumen con los botones de volumen o con el interruptor de tono/silencio. 
Nota: En algunas áreas, sonido del obturador no se silencia con el interruptor de tono/silencio.
Aparece brevemente un rectángulo en el área de la imagen que la cámara tiene enfocada y en la 
que ajusta la exposición. Cuando se fotografía a personas, el iPhone 4S utiliza la función de detección de caras para enfocar automáticamente y ajustar la exposición para un máximo de 10 caras. 
Aparece un rectángulo para cada cara detectada.
Acercar o alejar la imagen Pulse la pantalla (cámara trasera, solo en modo Cámara).
Activar la cuadrícula Pulse Opciones.
Ajustar el enfoque y la exposición Pulse la persona o el objeto que aparece en la pantalla. (La función de detección de caras se desactiva temporalmente.)
Bloquear el enfoque y la exposición Mantenga pulsada la pantalla hasta que el rectángulo oscile. “Bloqueo de 
AE/AF” aparece en la pantalla, y el enfoque y la exposición permanecen 
bloqueados hasta que se vuelve a pulsar la pantalla.
Hacer una captura de pantalla Pulse y suelte simultáneamente el botón de encendido/apagado y el botón 
de inicio  . La captura de pantalla se añade al álbum Carrete.
Fotos HDR
HDR (iPhone 4 o posterior) une las mejores partes de tres exposiciones diferentes en una única 
foto de “alto rango dinámico”. Para obtener el mejor resultado posible, tanto el iPhone como el objeto de la foto deberían estar fijos.
Activar HDR: Pulse Opción y, a continuación, ajuste HDR. Cuando la función HDR está activada, el 
flash se desactiva.
Para guardar las versiones normales además de las versiones HDR de las fotos, vaya a Ajustes > 
Fotos. Si guarda ambas versiones, en la esquina superior izquierda de las fotos HDR se mostrará 
 (al visualizarlas en el álbum Carrete con los controles visibles).
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Las fotos y los vídeos que se capturan con Cámara se guardan en el álbum Carrete.
Ver el álbum Carrete: Desplácese de izquierda a derecha o pulse la miniatura en la esquina inferior izquierda de la pantalla. También puede ver el álbum Carrete en la app Fotos.
Para hacer más fotos o grabar más vídeos, pulse  .
Si ha activado Fotos en streaming de iCloud en Ajustes > iCloud, las fotos nuevas también aparecerán en el álbum de Fotos en streaming y se transferirán a sus otros dispositivos iOS y ordenadores. Consulte “iCloud” en la página 17.
Para obtener más información sobre el modo de visualizar y compartir fotos y vídeos, consulte 
“Cómo compartir fotos y vídeos” en la página 97 y “Cargar fotos y vídeos en su ordenador” en la 
página 102.
Mostrar u ocultar los controles 
mientras visualiza una foto o un 
vídeo a pantalla completa
Pulse la pantalla.
Enviar una foto o un vídeo por correo electrónico o en un mensaje 
de texto
Pulse  .
Publicar una foto en Twitter Visualice la foto a pantalla completa, pulse  y, a continuación, pulse 
“Publicar en Twitter”. Debe tener iniciada una sesión en su cuenta de Twitter. 
Vaya a Ajustes > Twitter.
Para incluir su ubicación, pulse “Añadir ubicación”.
Imprimir una foto Pulse  . Consulte “Impresión” en la página 29.
Eliminar una foto o un vídeo Pulse  .
Cómo editar fotos
Puede girar las fotos, retocarlas, corregir ojos rojos que aparezcan en ellas y recortarlas. Los retoques mejoran la claridad u oscuridad, saturación de color y otras cualidades en general de una 
foto.
Girar
Mejora automática
Corregir ojos rojos
Recortar
Editar una foto: Mientras visualiza una foto a pantalla completa, pulse Editar y, a continuación, 
pulse una herramienta.
Con la herramienta “Ojos rojos”, pulse cada uno de los ojos que dese corregir. Para recortar una 
foto, arrastre las esquinas de la cuadrícula, arrastre la foto para recolocarla y, por último, pulse 
Recortar. También puede pulsar Proporción al recortar la foto, para ajustar unas proporciones 
concretas.
Cómo cortar vídeos
Puede recortar fotogramas del principio y el final de un vídeo que haya grabado o de cualquier 
otro vídeo del álbum Carrete. Puede sustituir el vídeo original, o guardar la versión recortada 
como un nuevo clip de vídeo.
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uno de los dos extremos del visualizador de fotogramas en la parte superior del vídeo y, a continuación, pulse Cortar.
Importante: Si selecciona “Cortar original”, los fotogramas recortados se eliminarán permanentemente del vídeo original. Si selecciona “Guardar como vídeo nuevo”, se guardará un nuevo clip de 
vídeo recortado en el álbum Carrete y no se modificará el vídeo original.
Cargar fotos y vídeos en su ordenador
Puede cargar las fotos y vídeos capturados con Cámara en aplicaciones fotográficas de su ordenador, como iPhoto en un Mac.
Cargar fotos y vídeos en su ordenador: Conecte el iPhone al ordenador utilizando el cable de 
conector Dock a USB.
Â Mac:  Seleccione las fotos y vídeos que desea y, a continuación, haga clic en el botón Importar o 
Descargar de iPhoto o de cualquier aplicación fotográfica compatible instalada en el ordenador.
Â PC:  Siga las instrucciones incluidas con su aplicación fotográfica.
Si elimina las fotos y vídeos del iPhone al cargarlas en el ordenador, se eliminarán del álbum 
Carrete. Puede usar el panel de ajustes Fotos de iTunes para sincronizar fotos y vídeos con la app 
Fotos del iPhone (en el caso de vídeos, solo en un Mac). Consulte “Sincronización con iTunes” en la 
página 18.
Fotos en streaming
Con Fotos en streaming (una prestación de iCloud) las fotos que realice en el iPhone se cargarán 
automáticamente en iCloud y se trasferirán a todos sus otros dispositivos que tengan activado 
Fotos en streaming. Las fotos cargadas en iCloud desde sus otros dispositivos y ordenadores se 
trasferirán al álbum de Fotos en streaming del iPhone. Consulte “iCloud” en la página 17.
Activar Fotos en streaming:  Vaya a Ajustes > iCloud > Fotos en streaming.
Las nuevas fotos que realice se cargarán en Fotos en streaming cuando salga de la app Cámara y 
el iPhone se conecte a Internet vía Wi-Fi. Cualquier otra foto que añada al Carrete también se cargará en Fotos en streaming y se trasferirá a sus otros dispositivos, como las fotos descargadas desde mensajes de correo electrónico y mensajes de texto, las imágenes guardadas desde páginas 
web y las capturas de pantalla. Fotos en streaming puede compartir hasta 1.000 de sus fotos más 
recientes entre sus dispositivos iOS. Sus ordenadores pueden mantener permanentemente todas 
sus fotos de Fotos en streaming.
Guardar fotos en el iPhone desde 
Fotos en streaming
En su álbum de Fotos en streaming, pulse  , seleccione las fotos que desee guardar y, a continuación, pulse Guardar.
Eliminar una foto de iCloud En su álbum de Fotos en streaming, seleccione la foto y, a continuación, 
pulse  .
Eliminar varias fotos de iCloud En su álbum de Fotos en streaming, pulse  , seleccione las fotos que desee eliminar y, a continuación, pulse Eliminar.
Nota: Para eliminar fotos de Fotos en streaming, debe tener instalado iOS 5.1 o posterior en el iPhone y en todos sus otros dispositivos iOS. Consulte support.apple.com/kb/
HT4486?viewlocale=es_ES.
Aunque las fotos eliminadas se borren de Fotos en streaming en sus dispositivos, las fotos originales permanecerán en el álbum Carrete del dispositivo donde se originó la foto.
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Acerca de YouTube
YouTube le permite ver vídeos cortos enviados por personas de todo el mundo. Algunas funciones de YouTube requieren una cuenta de YouTube. Para configurar una cuenta, vaya a www.
youtube.com.
Nota: YouTube puede no estar disponible en todos los idiomas o áreas.
Cómo explorar y buscar vídeos
Explorar los vídeos:  Pulse cualquier botón de exploración de la parte inferior de la pantalla o pulse Más para ver otros controles de exploración adicionales. Si está viendo un vídeo, pulse OK para 
ver los botones de exploración.
Ver vídeos relacionados
o guardar o compartir
este vídeo.
Ver otros botones de 
exploración o reorganizar 
los botones.
Pulse un vídeo para reproducirlo.
Pulse un botón de exploración 
para ver una lista de vídeos.
Cambiar los botones de exploración Pulse Más y, a continuación, pulse Editar. Arrastre un botón a la parte inferior de la pantalla, sobre el botón que quiere reemplazar. Arrastre un botón 
hacia la izquierda o hacia la derecha para moverlo. Cuando acabe, pulse OK.
Explorar vídeos relacionados Pulse  junto a cualquier vídeo de una lista.
Buscar un vídeo Pulse Buscar en la parte inferior de la pantalla y, a continuación, pulse el 
campo de búsqueda.
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la misma cuenta
Pulse  junto al vídeo actual en la pantalla de información del vídeo y, a 
continuación, pulse “Más vídeos”.
Cómo reproducir vídeos
Visualizar un vídeo:  Pulse cualquier vídeo mientras explora. La reproducción comenzará cuando 
se haya descargado suficiente vídeo al iPhone. La parte oscurecida de la barra de desplazamiento 
indica el progreso de la descarga.
Pulse el 
vídeo para 
mostrar u 
ocultar los 
controles.
Ver en un 
televisor con 
Apple TV.
Arrastre para avanzar 
o retroceder. Progreso de la descarga
Añadir el vídeo a sus 
Favoritos de YouTube.
Arrastre para 
ajustar el volumen.
Poner en pausa o reanudar la 
reproducción
Pulse  o  . También puede pulsar el botón central de los auriculares del 
iPhone.
Volver a empezar desde el principio Pulse  mientras se reproduce el vídeo. Si ha visto menos de cinco segundos de vídeo, en lugar de ello pasará al primer vídeo de la lista.
Retroceder o avanzar Mantenga pulsado  o  .
Ir a cualquier punto Arrastre el cursor de reproducción a lo largo de la barra de desplazamiento.
Pasar al vídeo siguiente o al anterior en una lista
Pulse  para pasar al vídeo siguiente. Pulse  dos veces para pasar al 
vídeo anterior. Si ha visto menos de cinco segundos de vídeo, pulse una 
sola vez.
Alternar entre vídeo a pantalla 
completa o ajustado a la pantalla
Pulse dos veces en el vídeo. También puede pulsar  para que el vídeo 
ocupe toda la pantalla, o pulsar  para ajustarlo a la pantalla.
Ver YouTube en un televisor Conecte el iPhone a su televisor o receptor AV mediante AirPlay o mediante 
un cable. Consulte “Ver vídeos en un televisor” en la página 138.
Dejar de ver un vídeo Pulse OK.
Registrar los vídeos que le gustan
Añadir un vídeo a su lista de favoritos o a una lista de reproducción:  Pulse  junto al vídeo 
para ver los botones para añadir el vídeo a una lista.
Añadir un vídeo a Favoritos Pulse Favoritos. Si está viendo el vídeo, pulse  .
Añadir un vídeo a una lista de 
reproducción
Pulse “Añadir a la lista” en la pantalla de información del vídeo y, a continuación, pulse una lista existente o pulse  para crear una nueva.
Eliminar un favorito Pulse Favoritos, pulse Editar y, a continuación, pulse  junto al vídeo.
Eliminar un vídeo de una lista de 
reproducción
Pulse Listas, pulse la lista de reproducción, pulse Editar y, a continuación, 
pulse  .
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Suscribirse a una cuenta Pulse  junto al vídeo actual (sobre la lista “Vídeos relacionados”). A continuación, pulse “Más vídeos”, desplácese a la parte inferior de la lista y pulse 
“Suscribirse a cuenta”.
Anular la suscripción a una cuenta Pulse Suscripciones (pulse Más si no ve esta opción), pulse una cuenta de la 
lista y, a continuación, pulse “Anular suscripción”.
Cómo compartir vídeos, comentarios y puntuaciones
Mostrar los controles para compartir, comentar y puntuar:  Pulse  junto al vídeo.
Enviar un enlace a un vídeo por 
correo electrónico
Pulse  junto al vídeo y, a continuación, pulse “Compartir vídeo”. O bien, si 
está viendo el vídeo, simplemente pulse  .
Puntuar o comentar un vídeo En la pantalla “Más información”, pulse “Puntuar, comentar o marcar” y, a 
continuación, seleccione “Puntuar o comentar”.
Enviar un vídeo a YouTube Abra la app Fotos, seleccione el vídeo y, a continuación, pulse  .
Cómo obtener información sobre un vídeo
Ver una descripción y comentarios de los usuarios:  Pulse  junto al vídeo en una lista y, a continuación, vuelva a pulsar  cuando aparezca en la parte superior de la ventana.
Cómo enviar vídeos a YouTube
Si dispone de una cuenta de YouTube, puede enviar vídeos directamente a YouTube. Consulte 
“Cómo compartir fotos y vídeos” en la página 97.
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Cómo visualizar la cotización de las acciones
Bolsa le permite consultar las últimas cotizaciones disponibles de sus valores, fondos e índices 
seleccionados. 
Las cotizaciones pueden llevar un retraso de hasta 20 minutos o más, dependiendo del servicio de 
información. 
Añadir un valor, fondo o índice al lector de bolsa:  Pulse  y, a continuación, pulse  . Introduzca 
un símbolo, nombre de empresa, nombre de fondo o índice y, a continuación, pulse Buscar.
Mostrar la variación de un valor, fondo o índice a lo largo del tiempo: Pulse el valor, fondo o índice en su lista y, a continuación, pulse 1d, 1s, 1m, 3m, 6m, 1a o 2a.
Al visualizar una gráfica en orientación horizontal, puede tocar la gráfica para mostrar el valor de 
un punto específico en el tiempo.
Utilice dos dedos para ver el cambio en el valor a lo largo de un periodo de tiempo concreto.
También puede ver su teletipo bursátil en el centro de notificaciones. Consulte “Notificaciones” en 
la página 32.
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Cambiar el orden de la lista Pulse  . A continuación, arrastre  junto a una acción o índice hasta una 
nueva posición en la lista.
Configurar la pantalla para ver 
el cambio porcentual, el cambio 
de precio o la capitalización de 
mercado
Pulse cualquiera de los valores a lo largo del lado derecho de la pantalla. 
Pulse de nuevo para cambiar a otra visualización.
Use iCloud para mantener su lista 
de valores actualizada en sus dispositivos iOS.
Vaya a Ajustes > iCloud > “Documentos y datos” y, a continuación, active 
“Documentos y datos” (está activado por omisión). Consulte “iCloud” en la 
página 17.
Cómo obtener más información
Consultar el resumen, las gráficas y la página de noticias de un valor, fondo o índice:
Seleccione el valor, fondo o índice en su lista y, a continuación, desplace con el dedo las páginas 
bajo el lector de bolsa para ver el resumen, la gráfica o la página de noticias.
En la página de noticias puede desplazarse hacia arriba o hacia abajo para leer titulares, o puede 
pulsar un titular para ver el artículo en Safari.
Ver más información sobre valores en Yahoo.com: Seleccione el valor, fondo o índice en su lista 
y, a continuación, pulse  .
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Cómo buscar ubicaciones
ADVERTENCIA: Para obtener información importante sobre cómo conducir y orientarse con 
seguridad, consulte la Guía de información importante del producto en support.apple.com/es_ES/
manuals/iphone/ (España y Latinoamérica) o support.apple.com/es_MX/manuals/iphone/ 
(México).
Mostrar la ubicación de un negocio 
o de una persona de su lista de 
contactos.
Ajustar opciones, como 
mostrar el tráfico o la 
visualización de satélite.
Más información
Pulse dos veces para 
acercar la imagen; pulse 
con dos dedos para alejar 
la imagen. O bien, separe 
o junte los dedos para 
acercar o alejar la 
imagen.
Ubicación actual
Introducir una 
búsqueda.
Mostrar su 
ubicación 
actual.
Obtener indicaciones 
para ir en coche, en 
transporte público o 
a pie.
Buscar una ubicación:  Pulse el campo de búsqueda para mostrar el teclado. Escriba una dirección 
o cualquier otro dato y, a continuación, pulse Buscar.
Puede buscar datos de tipo:
Â Intersección (“octava y mercado”)
Â Área (“greenwich village”)
Â Punto de referencia (“guggenheim”)
Â Código postal
Â Negocio (“cines”, “restaurantes madrid”, “apple españa”)
También puede pulsar  para buscar la ubicación de un contacto.
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de una ubicación
Pulse el marcador.
Ver una lista de los negocios encontrados en una búsqueda
Pulse  y, a continuación, pulse Lista.
Pulse un negocio para ver su ubicación.
Buscar su ubicación actual Pulse  .
Su ubicación actual se muestra con un marcador de color azul. Si no es 
posible determinar su ubicación con precisión, aparecerá un círculo azul 
alrededor del marcador. Cuanto más pequeño sea el círculo, mayor será la 
precisión.
Mostrar su orientación Pulse de nuevo  .
El icono cambia a  y el mapa gira para mostrar su dirección.
Marcar una ubicación Mantenga pulsado el mapa hasta que aparezca el marcador.
Importante: La app Mapas, las indicaciones y las apps basadas en información de localización 
geográfica dependen de servicios de datos. Estos servicios de datos están sujetos a cambios y 
pueden no estar disponibles en todas las zonas, lo que puede dar como resultado mapas, indicaciones o datos de localización no disponibles, imprecisos o incompletos. Compare la información 
proporcionada por el iPhone con sus alrededores, y emplee las señales a la vista para resolver 
cualquier discrepancia. 
Si cuando abra la app Mapas los servicios de localización están desactivados, se le solicitará que los active. No obstante, puede utilizar Mapas sin los servicios de localización. Consulte 
“Localización” en la página 175.
Cómo obtener indicaciones
Obtener indicaciones:
1 Pulse “Cómo llegar”.
2 Introduzca las ubicaciones inicial y final. 
Pulse  en uno de los dos campos para seleccionar una ubicación de Favoritos (incluida su ubicación actual o el marcador insertado), una ubicación reciente o un contacto. Si  no se muestra, pulse  para eliminar el contenido del campo. 
3 Pulse Ruta y, a continuación, seleccione indicaciones para ir en coche ( ), en transporte público (
) o a pie ( ).
4 Realice una de las siguientes operaciones:
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Â Para ver todas las indicaciones en forma de lista, pulse  y, después, pulse Lista. 
Pulse cualquier ítem de la lista para ver un mapa que muestre ese tramo de la ruta. Pulse Ruta 
para volver a la pantalla de visión general.
5 Si aparecen varias rutas, seleccione la que desee utilizar.
Si utiliza el transporte público, pulse  para ajustar la hora de salida o de llegada y elegir un horario para el viaje. Pulse el icono de una parada para ver la hora de salida de dicho autobús o tren y 
para ver un enlace al sitio web del proveedor de transporte o información de contacto.
Obtener indicaciones de una ubicación del mapa
Pulse el marcador, pulse  y, a continuación, pulse “Obtener indicaciones 
hasta aquí” o bien “Obtener indicaciones desde aquí”.
Añadir una ubicación a los favoritos Pulse Favoritos.
Cómo obtener y compartir información sobre una ubicación
Obtener 
indicaciones.
Visitar el 
sitio web.
Pulse        para 
mostrar la 
información de 
contacto.
Realizar 
una llamada.
Obtener o compartir información sobre una ubicación: Pulse el marcador y, a continuación, pulse  .
Añadir un negocio a sus contactos: Pulse “Añadir contacto”.
Enviar su ubicación a través de 
Twitter, en un mensaje de texto o 
por correo electrónico
Pulse “Compartir ubicación”. 
Nota:  Para publicar un mensaje en Twitter, debe tener iniciada una sesión 
en su cuenta de Twitter. Vaya a Ajustes > Twitter.
Cómo mostrar la situación del tráfico
Puede mostrar en el mapa el estado del tráfico de las calles y carreteras principales. 
Mostrar u ocultar la situación del tráfico: Pulse  y, a continuación, pulse “Mostrar tráfico” u 
“Ocultar tráfico”.
Las calles y carreteras presentan un color que indica el estado del tráfico:
Â Gris: no hay datos disponibles
Â Verde: límite de velocidad señalizado
Â Amarillo: menor velocidad que el límite señalizado
Â Rojo: parar y continuar
Nota: El estado del tráfico no está disponible en todas las zonas.
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Ver una visualización de satélite o una visualización híbrida: Pulse  y, a continuación, seleccione la visualización que desee.
Mostrar la visualización de calles de Google de una ubicación: Pulse  . Desplácese hacia la 
izquierda o hacia la derecha para moverse por la vista panorámica de 360° (el círculo muestra la 
visualización actual). Pulse una flecha para desplazarse por la calle. Para volver a la visualización de 
mapa, pulse el círculo del mapa de la esquina inferior derecha.
Pulse para volver a la visualización en mapa
Nota: Es posible que la visualización de calles no esté disponible en todas las zonas.
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Cómo obtener información meteorológica
Pulse Tiempo en el menú de inicio para obtener la temperatura actual y una previsión a seis días 
de una o más ciudades de todo el mundo.
Condiciones actuales
Añadir o eliminar 
ciudades.
Temperatura actual
Previsión a 6 días
Ver la previsión por horas.
Número de ciudades guardadas
Si el panel del tiempo es azul claro, es de día en esa ciudad. Si el panel es violeta oscuro, es de 
noche.
Añadir una ciudad:  Pulse  y, a continuación, pulse  . Introduzca una ciudad o código postal y 
pulse Buscar.
Cambiar a otra ciudad Desplácese hacia la izquierda o hacia la derecha.
Reordenar las ciudades Pulse  y, a continuación, arrastre  hacia arriba o hacia abajo.
Borrar una ciudad Pulse  , pulse  y, a continuación, pulse Eliminar.
Mostrar la temperatura en grados 
Fahrenheit o centígrados
Pulse  y, a continuación, pulse °F o °C.
Usar iCloud para transferir su lista 
de ciudades a otros dispositivos iOS 
mediante la tecnología push
Vaya a Ajustes > iCloud > “Documentos y datos” y, a continuación, active 
“Documentos y datos” (está activado por omisión). Consulte “iCloud” en la 
página 17.
Consultar información sobre una 
ciudad en Yahoo.com
Pulse  .
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Acerca de Notas
Escriba notas en el iPhone y iCloud hará que estén disponibles en sus otros dispositivos iOS y ordenadores Mac. También puede leer y crear notas en otras cuentas, como Gmail o Yahoo.
Pulse la nota para 
editarla.
Eliminar la nota.
Enviar la nota por correo 
electrónico o imprimirla.
Añadir una nota nueva.
Ver la lista de notas.
Ver la nota anterior o siguiente.
Cómo escribir notas
Añadir una nota:  Pulse  y, a continuación, escriba la nota y pulse OK.
Usar iCloud para mantener sus notas actualizadas en sus dispositivos 
iOS y ordenadores Mac
Si utiliza una dirección de correo electrónico me.com o mac.com para iCloud, vaya a Ajustes > iCloud y active Notas. 
Si utiliza una cuenta Gmail u otra cuenta IMAP para iCloud, vaya a Ajustes > 
“Correo, contactos, calendarios” y active Notas para la cuenta.
Consulte “iCloud” en la página 17.
Crear una nota en una cuenta 
específica
Pulse Cuentas y seleccione la cuenta antes de pulsar  para crear la nota.
Establecer la cuenta por omisión de 
las nuevas notas
Si pulsa  mientras visualiza “Todas las notas”, la nota se creará en la cuenta 
por omisión que seleccione en Ajustes > Notas.
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Las notas más recientes se muestran en la parte superior de la lista. Si utiliza más de un dispositivo iOS u ordenador con su cuenta de iCloud, se mostrarán las notas de todos los dispositivos. Si 
comparte notas con una aplicación de su ordenador o con otras cuentas en línea, como Yahoo o 
Gmail, las notas se organizarán por cuentas.
Leer una nota:  Pulse una nota de la lista. Para ver la nota siguiente o anterior, pulse  o  .
Cambiar el tipo de letra Vaya a Ajustes > Notas.
Ver las notas de una determinada 
cuenta
Pulse Cuentas y seleccione la cuenta.
Ver las notas de todas las cuentas Pulse Cuentas y seleccione “Todas las notas”.
Editar una nota Pulse cualquier lugar de la nota para mostrar el teclado.
Eliminar una nota Mientas visualiza la lista de notas, desplácese hacia la izquierda o hacia la 
derecha sobre la nota. Mientras lee una nota, pulse  .
Cómo buscar en las notas
Puede realizar búsquedas en el texto de todas sus notas.
Buscar notas:  Mientras visualiza una lista de notas, desplácese hacia abajo para dirigirse a la parte 
superior de la lista y mostrar el campo de búsqueda y, a continuación, pulse en el campo y escriba 
lo que esté buscando.
También puede buscar notas desde la pantalla de inicio del iPhone. Consulte “Cómo buscar” en la 
página 30.
Cómo imprimir notas o enviar notas por correo electrónico
Para enviar una nota por correo electrónico, el iPhone debe estar configurado para utilizar correo 
electrónico. Consulte “Configuración del correo y otras cuentas” en la página 16.
Imprimir o enviar una nota por correo electrónico:  Mientras lee la nota, pulse  .
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Acerca de Reloj
Puede utilizar Reloj para comprobar la hora en cualquier lugar del mundo, ajustar una alarma, cronometrar un evento o ajustar un temporizador.
Añadir un reloj.
Ver relojes, ajustar una 
alarma, cronometrar un 
evento o ajustar un 
temporizador.
Eliminar relojes o cambiar su orden.
Cómo ajustar relojes mundiales
Puede añadir relojes en los que aparezca la hora de otras ciudades importantes y zonas horarias 
de todo el mundo.
Añadir un reloj:  Pulse  y, a continuación, escriba el nombre de una ciudad. Si no encuentra la 
ciudad que busca, pruebe con una ciudad mayor que esté en la misma zona horaria.
Reordenar relojes Pulse Editar y, a continuación, arrastre  .
Eliminar un reloj Pulse Editar y, a continuación, pulse  .
Cómo ajustar alarmas
Puede ajustar más de una alarma. Ajuste cada alarma para que se repita los días que especifique, 
o para que solo suene una vez.
Ajustar una alarma:  Pulse Alarma y, a continuación, pulse  .
115Cambiar los ajustes de una alarma Pulse Editar y, a continuación, pulse  .
Eliminar una alarma Pulse Editar y, a continuación, pulse  .
Si hay como mínimo una alarma definida y activada, aparecerá  en la barra de estado de la 
parte superior de la pantalla del iPhone. Si una alarma está configurada para sonar una sola vez, 
se desactivará automáticamente cuando haya sonado. Puede volver a activarla para utilizarla de 
nuevo.
Importante: Algunos operadores no ofrecen el servicio horario de red en todos los países. Si está 
de viaje, es posible que el iPhone no le avise a la hora local correcta. Consulte “Fecha y hora” en la 
página 182.
Cómo usar el cronómetro
Cronometrar un evento:  Pulse Cronómetro y, a continuación, pulse Iniciar.
El cronómetro continuará funcionando si pasa a otra app.
Cómo ajustar un temporizador
Puede ajustar un temporizador que siga funcionando aunque use otras apps.
Ajustar un temporizador:  Pulse Temporizador, desplace el dedo para ajustar la duración y, a continuación, pulse Iniciar.
Seleccionar un sonido de alerta Pulse “Al finalizar”.
Ajustar un temporizador de reposo 
para el iPhone
Ajuste la duración, pulse “Al finalizar” y seleccione “Detener reproducción”. El 
iPhone dejará de reproducir música o vídeo cuando se acabe el tiempo.
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Acerca de Recordatorios
Recordatorios le permite organizar su vida con listas, que se completan con fechas límite y ubicaciones. Se le puede recordar un ítem en un día o en una fecha en concreto, o cuando esté acercándose o saliendo de una ubicación, como su casa u oficina. Los recordatorios funcionan con sus 
cuentas de calendario, por lo que los cambios que realice se actualizarán automáticamente en sus 
otros dispositivos iOS y ordenadores.
Cambiar de visualización.
Marcar como completado.
Añadir un recordatorio.
Ver y editar listas.
Alternar entre el modo de visualización de lista y de fecha:  En la parte superior de la pantalla, 
pulse Lista o Fecha.
Cómo ajustar un recordatorio
Puede ajustar un recordatorio para una fecha y hora, para una ubicación o para ambas cosas.
Añadir un recordatorio:  En Recordatorios, pulse  y, a continuación, introduzca una descripción y 
pulse OK.
Después de añadir un recordatorio, puede definir sus ajustes con más precisión.
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recordatorio
Pulse el recordatorio y, a continuación, pulse Avisar. Active “En una ubicación” y seleccione “Cuando salga”, “Cuando llegue” o ambas opciones.
Para cambiar la ubicación por otro lugar distinto al que se encuentre, pulse 
“Ubicación actual” y, a continuación, pulse “Seleccionar dirección” y escoja 
una ubicación de Contactos.
Consulte “Acerca de los recordatorios de ubicación” en la página 119.
Ajustar una fecha límite para un 
recordatorio
Pulse el recordatorio y, a continuación, pulse Avisar. Active “En una fecha” 
y, a continuación, ajuste la fecha y hora que desee que se le recuerde. Los 
recordatorios programados y no completados se mostrarán en el centro de 
notificaciones.
Añadir notas a un recordatorio Pulse el recordatorio y, a continuación, pulse “Mostrar más”. Pulse Notas.
Mover un recordatorio a otra lista Pulse el recordatorio y, a continuación, pulse “Mostrar más”. Pulse Lista y 
seleccione una nueva lista.
Para crear o editar listas, consulte “Cómo gestionar los recordatorios en el 
modo de visualización de lista” en la página 118.
Eliminar un recordatorio Pulse un recordatorio, pulse “Mostrar más” y, a continuación, pulse Eliminar.
Editar un recordatorio Pulse el recordatorio y, a continuación, pulse su nombre.
Marcar un recordatorio como 
completado
Pulse el cuadro situado junto al ítem, de modo que aparezca una marca de 
verificación.
Los ítems completados se mostrarán en la lista Completado. Consulte 
“Cómo gestionar los recordatorios completados” en la página 119.
Ajustar el tono que debe reproducirse para los recordatorios
Vaya a Ajustes > Sonido.
Use iCloud para mantener actualizado Recordatorios en sus dispositivos iOS y ordenadores.
Vaya a Ajustes > iCloud y, a continuación, active Recordatorios. Consulte 
“iCloud” en la página 17.
Cómo gestionar los recordatorios en el modo de visualización de lista
Organizar los recordatorios en listas permite separar con facilidad las tareas de trabajo, de las personales y de otros tipos de tareas. Recordatorios incluye una lista para los recordatorios activos, 
más una lista integrada de ítems completados. Puede añadir sus propias listas.
Crear una lista:  En la parte superior de la pantalla, pulse Lista y, a continuación, pulse  . Pulse 
Editar.
Cambiar rápidamente de una lista 
a otra
Deslice el dedo hacia la izquierda o hacia la derecha sobre la pantalla.
También puede ir directamente a una lista específica. Pulse  y, a continuación, pulse el nombre de una lista.
Ver los ítems completados Deslice el dedo hacia la izquierda sobre la pantalla hasta que llegue a la 
lista Completado.
Para cambiar el orden de las listas En el modo de visualización de lista, pulse  y, a continuación, pulse 
Editar. Arrastre  junto a una lista para cambiar el orden.
No es posible mover una lista a una cuenta distinta, y tampoco es posible 
cambiar el orden de los recordatorios de una lista.
Eliminar una lista En el modo de visualización de lista, pulse  y, a continuación, pulse 
Editar. Pulse  para cada lista que desee eliminar.
Al eliminar una lista, también se eliminan todos los ítems de la lista.
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Editar. Pulse el nombre que desee cambiar y, a continuación, escriba un 
nuevo nombre. Pulse OK.
Establecer una lista por omisión 
para los nuevos recordatorios
Vaya a Ajustes > “Correo, contactos, calendarios” y, a continuación, bajo el 
título Recordatorios, pulse “Lista por omisión”.
También puede crear un recordatorio hablando. Consulte Capítulo 4,“Siri,” en la página 41.
Cómo gestionar los recordatorios en el modo de visualización de fecha
El modo de visualización de fecha se utiliza para gestionar los recordatorios que tienen una fecha 
límite.
Ver los recordatorios para una fecha:  En la parte superior de la pantalla, pulse Fecha para ver los 
recordatorios de hoy, así como los ítems no completados de los días anteriores.
Ver una fecha reciente Arrastre el regulador de hora, situado bajo la lista, a un nuevo día.
Ver un día en concreto Pulse  y seleccione una fecha para verla.
Acerca de los recordatorios de ubicación
Los recordatorios de ubicación solo están disponibles en el iPhone 4 and iPhone 4S, y es posible 
que no estén disponibles en todas las áreas. No podrá ajustar ubicaciones para los recordatorios 
de cuentas Microsoft Exchange y Outlook.
Puede ajustar un recordatorio de ubicación para que Recordatorios le avise cuando se acerque a 
la ubicación y, de nuevo, cuando deje de estar cerca de esa área. Para obtener los mejores resultados posibles, especifique una ubicación que esté bien definida, como una dirección en lugar de 
una cuidad, y recuerde que la precisión puede variar. El iPhone puede comprobar su ubicación 
con menor frecuencia, en función del modelo de iPhone que tenga y de si se encuentra bloqueado, por lo que puede producirse un retardo antes de que se emita el recordatorio.
Cuando cree un recordatorio, puede usar su ubicación actual o una ubicación de su lista de contactos. Añada a Contactos ubicaciones que vaya a usar con Recordatorios, como el supermercado 
o la escuela. También es recomendable que añada ubicaciones personales, como sus direcciones 
de casa y del trabajo, a su tarjeta de contactos de la app Contactos. Recordatorios muestra las ubicaciones de su tarjeta de contactos. Para obtener información sobre la forma de ajustar su tarjeta 
de contactos en Contactos, consulte “Cuentas y ajustes de Contactos” en la página 135.
Cómo gestionar los recordatorios completados
Recordatorios registra los ítems marcados como completados. Puede verlos en el modo de visualización de lista o de fecha, o puede utilizar la lista Completado.
Ver los ítems completados:  Pulse el botón Lista, situado en la parte superior de la pantalla y, 
a continuación, deslice el dedo hacia la izquierda o hacia la derecha hasta que aparezca la lista 
Completado.
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completados
En el modo de visualización de lista o de fecha, desplácese a la parte superior de la lista de recordatorios y, a continuación, desplácese hacia abajo en 
la lista hasta que aparezca Completado. Pulse Completado para ver todos 
los ítems completados.
Marcar un ítem completado como 
no completado
Pulse para eliminar la marca de verificación. El ítem regresará automáticamente a su lista original.
Sincronizar recordatorios anteriores Vaya a Ajustes > “Correo, contactos, calendarios” y, a continuación, bajo 
Recordatorios, pulse Sincronizar. Este ajuste se aplica a todas sus cuentas de 
recordatorio. Para obtener un mayor rendimiento, no sincronice más ítems 
anteriores de los necesarios.
Cómo buscar recordatorios
Puede encontrar rápidamente recordatorios pendientes o completados. Los recordatorios se buscan por nombre.
Buscar recordatorios en el modo de visualización de fecha  Pulse  y, a continuación, pulse 
“Buscar recordatorios” e introduzca una frase de búsqueda.
Buscar recordatorios en el modo de visualización de lista  Pulse  y, a continuación, pulse 
“Buscar recordatorios” e introduzca una frase de búsqueda.
También puede buscar recordatorios desde la pantalla de inicio. Consulte “Búsqueda en 
Spotlight” en la página 180. Y puede pedir a Siri que busque recordatorios por título. Consulte 
Capítulo 4,“Siri,” en la página 41.
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Acerca de Game Center
Descubra nuevos juegos y comparta sus experiencias de juego con amigos de todo el mundo en 
Game Center. Invite a sus amigos a jugar o utilice la función de selección automática para encontrar dignos oponentes. Obtenga puntos de bonificación acumulando logros específicos en un juego, vea lo que han conseguido sus amigos y consulte las tablas de clasificación para ver quiénes 
son los mejores jugadores. 
Nota: Es posible que Game Center no esté disponible en todas las áreas, y la disponibilidad de los 
juegos puede variar.
Para usar Game Center necesita una conexión a Internet y un ID de Apple. Si aún no dispone de 
un ID de Apple, puede crear uno en Game Center, tal y como se describe más adelante.
Ver quién es el mejor.
Responder a solicitudes 
de amistad.
Ver una lista de objetivos 
del juego.
Jugar una partida.
Buscar un oponente.
Seleccionar un juego.
Invitar a amigos a jugar.
Declarar su estado, cambiar su foto o cerrar 
sesión.
Cómo iniciar sesión en Game Center
Iniciar sesión:  Abra Game Center. Si ve su sobrenombre y su foto en la parte superior de la pantalla, significa que ya ha iniciado sesión. Si no lo ve, introduzca su ID de Apple y su contraseña y, 
a continuación, pulse Conectarse. O bien, pulse “Crear nueva cuenta” para crear un nuevo ID de 
Apple.
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Declarar su estado Pulse Yo, pulse la barra de estado y, a continuación, introduzca su estado.
Ver los ajustes de su cuenta Pulse Yo, pulse el banner de su cuenta y, a continuación, seleccione “Ver 
cuenta”.
Cerrar sesión Pulse Yo, pulse el banner de su cuenta y, a continuación, pulse 
Desconectarse. No es necesario que cierre sesión cada vez que salga de 
Game Center.
Cómo comprar y descargar juegos
En la tienda App Store hay juegos disponibles para Game Center.
Comprar y descargar un juego:  Pulse Juegos y, a continuación, pulse un juego recomendado o 
pulse “Buscar juegos de Game Center”.
Comprar un juego que tiene un 
amigo
Pulse Amigos y, a continuación, pulse el nombre de su amigo. Pulse un 
juego de la lista de juegos de su amigo y, a continuación, pulse el precio del 
juego bajo su nombre, en la parte superior de la pantalla.
Cómo jugar
Jugar:  Pulse Juegos, seleccione un juego y, a continuación, pulse Jugar.
Ver una lista de los jugadores mejor 
clasificados
Pulse Juegos, seleccione un juego y, a continuación, pulse “Tabla de 
clasificación”.
Consultar los logros que pueden 
conseguirse en un juego
Pulse Juegos, seleccione un juego y, a continuación, pulse Logros.
Volver a Game Center después de 
jugar
Pulse el botón de inicio y, a continuación, pulse Game Center en la pantalla 
de inicio.
Cómo jugar con amigos
Game Center le permite ponerse en contacto con jugadores de todo el mundo. Puede añadir amigos a Game Center realizando una solicitud o aceptando una solicitud de otro jugador.
Invitar a amigos a un juego multijugador:  Pulse Amigos, seleccione un amigo, seleccione un juego y, por último, pulse Jugar. Si el juego permite o requiere jugadores adicionales, seleccione otros 
jugadores a los que invitar. A continuación, pulse Siguiente. Envíe su invitación y, después, espere 
a que los otros jugadores la acepten. Cuando todo el mundo esté listo, comience la partida.
Si un amigo no está disponible o no responde a su invitación, puede pulsar “Selección automática” 
para que Game Center busque jugadores por usted, o bien pulsar “Invitar amigo” para intentar invitar a algún otro amigo.
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Pulse  para explorar sus contactos. Para añadir varios amigos en una 
misma solicitud, pulse Retorno después de cada dirección.
Responder a una solicitud de 
amistad
Pulse Solicitudes, pulse la solicitud y, a continuación, pulse Aceptar o 
Ignorar. Para informar de algún problema con la solicitud, desplácese hacia 
arriba y pulse “Informar del problema”.
Consultar los juegos a los que juega un amigo y ver las puntuaciones 
de su amigo
Pulse Amigos, pulse el nombre de su amigo y, a continuación, pulse Juegos 
o Puntos.
Buscar a alguien en su lista de 
amigos
Pulse la barra de estado para desplazarse a la parte superior de la pantalla. 
A continuación, pulse el campo de búsqueda y empiece a escribir.
Impedir la recepción de invitaciones de otros jugadores
Desactive “Invitaciones a juegos” en los ajustes de su cuenta de Game 
Center. Consulte “Game Center” en la página 123.
Mantener la privacidad de su dirección de correo electrónico
Desactive “Buscarme por dirección” en los ajustes de su cuenta de Game 
Center. Consulte “Game Center” en la página 123.
Desactivar toda la actividad 
multijugador
Vaya a Ajustes > General > Restricciones > “Game Center” y desactive 
“Juegos multijugador”.
No permitir solicitudes de amistad Vaya a Ajustes > General > Restricciones > “Game Center” y desactive 
“Añadir amigos”.
Ver una lista de los amigos de un 
amigo
Pulse Amigos, pulse el nombre de un amigo y, a continuación, pulse 
Amigos, justo debajo de su imagen.
Eliminar un amigo Pulse Amigos, pulse un nombre y, a continuación, pulse “Eliminar amigo”.
Informar de comportamientos 
ofensivos o inapropiados
Pulse Amigos, pulse el nombre de la persona en cuestión y, a continuación, 
pulse “Informar del problema”.
Game Center
Algunos ajustes de Game Center están asociados al ID de Apple que utiliza para iniciar sesión. 
Otros se encuentran en la app Ajustes del iPhone.
Cambiar los ajustes de Game Center para utilizar su ID de Apple:  Inicie sesión con su ID de 
Apple, pulse Yo, pulse el banner de su cuenta y, a continuación, seleccione “Ver cuenta”.
Indicar qué notificaciones desea recibir de Game Center: Vaya a Ajustes > Notificaciones > 
Game Center. Si Game Center no aparece, active Notificaciones.
Cambiar restricciones que afectan a Game Center:  Vaya a Ajustes > General > Restricciones > 
Game Center.
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Acerca de iTunes Store
Use la tienda iTunes Store para añadir contenido a su iPhone. Puede buscar y comprar música, 
programas de televisión, audiolibros, tonos de alerta y tonos de llamada. También puede comprar 
o alquilar películas, o descargar y reproducir podcasts o colecciones de iTunes U. Para comprar 
contenido necesita un ID de Apple. Consulte “Ajustes de Store” en la página 132.
Nota: La tienda iTunes Store puede no estar disponible en todas las áreas, y su contenido puede 
variar según el área. Estas prestaciones pueden modificarse sin previo aviso.
Para acceder a la tienda iTunes Store, el iPhone debe estar conectado a Internet. Consulte “Red” en 
la página 178.
Buscar música, vídeos y otros contenidos
Seleccionar una 
categoría.
Volver a descargar 
compras.
Explorar contenido:  Pulse uno de los tipos de contenido, como Música o Vídeos. O pulse Más 
para explorar otros contenidos.
124Buscar contenido Pulse Buscar (o pulse Más primero, si Buscar no es visible) y, a continuación, 
pulse el campo de búsqueda, introduzca una o más palabras y pulse Buscar.
Comprar un ítem, escribir reseñas 
sobre un ítem o recomendar un 
ítem a un amigo
Pulse un ítem en una lista para ver más detalles en su pantalla de 
información.
Buscar artistas y recomendaciones 
de amigos
Pulse Ping (o pulse Más primero, si Ping no es visible) para conocer las 
novedades sobre sus artistas favoritos o ver la música que recomiendan 
sus amigos. Para obtener información, consulte “Cómo seguir a artistas y 
amigos” en la página 126.
Cómo comprar música, audiolibros y tonos
Cuando encuentre una canción, álbum, tono de alerta, tono de llamada o audiolibro que le guste 
en la tienda iTunes Store, puede adquirirlo y descargarlo. Puede previsualizar un ítem antes de adquirirlo para asegurarse de que es lo que desea.
Previsualizar una canción, tono de llamada o audiolibro:  Pulse el ítem y siga las instrucciones en 
pantalla.
Canjear una tarjeta o código de 
regalo
Pulse Música (o pulse Más primero, si Música no es visible) y, a continuación, 
pulse Canjear, cerca de la parte inferior de la pantalla, y siga las instrucciones que aparecen en pantalla. Cuando haya iniciado sesión, el saldo restante de sus vales de compra se mostrará junto con su información de ID de 
Apple en la parte inferior de la mayoría de las pantallas de la tienda iTunes 
Store.
Completar un álbum Mientras visualiza cualquier álbum, pulse el precio con descuento de las 
canciones restantes, bajo “Completar álbum” (no disponible en todas las 
áreas). Para ver ofertas para completar otros álbumes, pulse Música y, a continuación, pulse “Ofertas para completar álbum”.
Descargar una compra anterior Pulse Comprado.
También puede descargar un ítem mientras explora contenidos. Basta con 
que pulse Descargar donde normalmente se ve el precio.
Descargar automáticamente compras realizadas en otros dispositivos iOS y ordenadores
Vaya a Ajustes > Store y, a continuación, active los tipos de compras que 
desee que se descarguen automáticamente.
Cómo comprar o alquilar vídeos
La tienda iTunes Store (puede que no esté disponible en todas las áreas) le permite comprar y 
descargar películas, programas de televisión y vídeos musicales. Algunas películas también pueden alquilarse durante un período de tiempo limitado. El contenido de vídeo puede estar disponible en formato de definición estándar (SD o 480p), en alta definición (HD o 720p) o en ambos 
formatos.
Comprar o alquilar un vídeo:  Pulse Comprar o Alquilar.
Una vez que se compra un ítem, este empieza a descargarse y aparece en la pantalla Descargas. 
Consulte “Cómo comprobar el estado de descarga” en la página 126.
Previsualizar un vídeo Pulse Prever.
Ver la previsualización en un televisor con AirPlay y un Apple TV
Cuando se inicie la previsualización, pulse  y seleccione Apple TV. 
Consulte “AirPlay” en la página 35.
Nota: Si adquiere vídeo HD en el iPhone 3GS, el vídeo se descargará en formato SD.
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Use Ping para establecer conexiones con los aficionados a la música más apasionados del mundo. 
Siga a sus artistas favoritos para estar al tanto de sus nuevos lanzamientos y sus próximos conciertos y giras, y conózcalos como nadie a través de sus fotos, vídeos e influencias musicales. Lea los 
comentarios de sus amigos sobre la música que están escuchando y sepa qué están comprando y 
a qué conciertos tienen pensado asistir. Exprese sus gustos musicales y publique también comentarios para sus propios seguidores.
Para crear y explorar conexiones musicales, primero debe crear un perfil.
Crear su perfil Ping:  Abra la aplicación iTunes en su Mac o PC, haga clic en Ping y siga las instrucciones que aparecen en la pantalla.
Pulse Ping (o pulse Más primero, si Ping no es visible) y, a continuación, explore Ping. Puede hacer 
lo siguiente:
Seguir a un artista Pulse Seguir en su página de perfil.
Seguir a un amigo Ser seguidor de una persona no implica que dicha persona le siga automáticamente a usted. En su perfil puede elegir entre aprobar o declinar 
las solicitudes de seguimiento según le lleguen, o simplemente aceptar a 
todos los nuevos seguidores sin examinarlos primero.
Compartir sus ideas Mientras explora álbumes y canciones, pulse Publicar para comentar una 
pieza musical, o pulse “Me gusta” simplemente para indicar que le gusta. 
Sus amigos verán sus comentarios en su propio canal de actividad Ping.
Compartir sus planes de conciertos Pulse Conciertos en su página de perfil para consultar los próximos conciertos de los artistas a los que sigue y para comprobar cuáles de sus amigos 
asistirán a un concierto. Pulse Entradas para comprar su entrada, o pulse 
Asistiré para que los demás sepan que piensa asistir. (No disponible en todas las áreas.)
Cómo descargar o reproducir podcasts en tiempo real
Puede escuchar podcasts de audio o ver podcasts de vídeo transmitidos en tiempo real a través 
de Internet desde la tienda iTunes Store. También puede descargar podcasts de audio y vídeo.
Reproducir un podcast en tiempo real:  Pulse Podcasts (o pulse Más primero, si Podcasts no es 
visible) para buscar podcasts en iTunes Store.
Los podcasts de vídeo están marcados con un icono de vídeo  .
Descargar un podcast Pulse el botón Gratis y, a continuación, pulse Descargar. Los podcasts descargados aparecen en la lista de reproducción de podcasts.
Escuchar o ver un podcast 
descargado
En Música, pulse Podcasts (o pulse Más y, después, Podcasts) y, a continuación, pulse el podcast. Los podcasts de vídeo también aparecen en la lista 
de vídeos.
Obtener más episodios del podcast 
descargado
En la lista de podcasts de Música, pulse el podcast y, a continuación, pulse 
“Obtener más episodios”.
Eliminar un podcast En la lista de podcasts de Música, deslice el dedo hacia la izquierda o hacia 
la derecha sobre el podcast y pulse Eliminar.
Cómo comprobar el estado de descarga
Puede consultar la pantalla Descargas para ver el estado de las descargas en curso o programadas, 
incluidos los pedidos anticipados.
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Descargas no es visible).
Los pedidos anticipados no se descargan automáticamente tras su publicación. Vuelva a la pantalla Descargas para comenzar la descarga.
Descargar un pedido anticipado Pulse el ítem y, a continuación, pulse  .
Si se interrumpe una descarga, se reanudará cuando haya una conexión a Internet. O bien, si abre 
iTunes en el ordenador, iTunes finalizará la descarga en la biblioteca de iTunes (si el ordenador 
está conectado a Internet y se ha iniciado sesión utilizando el mismo ID de Apple).
Cómo cambiar los botones de exploración
Puede reemplazar los botones Música, Podcasts, Vídeos y Buscar de la parte inferior de la pantalla 
por otros que utilice más frecuentemente. Por ejemplo, si descarga audiolibros a menudo y no ve 
muchos vídeos, puede reemplazar Vídeos por Audiolibros.
Cambiar los botones de exploración:  Pulse Más, pulse Editar y arrastre un botón a la parte inferior de la pantalla, sobre el botón que quiere reemplazar.
Puede arrastrar los botones de la parte inferior de la pantalla hacia la izquierda y hacia la derecha 
para ordenarlos. Cuando acabe, pulse Salir.
Cuando esté navegando, pulse Más para acceder a los botones de exploración que no sean 
visibles.
Visualización de la información de la cuenta
Para visualizar la información de iTunes Store relacionada con su ID de Apple en el iPhone, pulse 
su ID de Apple (en la parte inferior de la mayoría de las pantallas de la tienda iTunes Store). O bien 
vaya a Ajustes > Store y pulse “Ver ID de Apple”. Debe tener iniciada una sesión para poder visualizar la información de su cuenta. Consulte “Ajustes de Store” en la página 132.
Verificación de las descargas
Puede utilizar iTunes en su ordenador para verificar que toda la música, vídeos, apps y otros ítems 
adquiridos en la tienda iTunes Store o App Store estén en su biblioteca de iTunes. Puede hacerlo 
en el caso de que una descarga se interrumpa.
Verificar las compras:  En iTunes en su ordenador, seleccione Store > “Comprobar si hay descargas 
disponibles”.
Para ver todas sus compras, inicie una sesión con su ID de Apple, seleccione Store > “Ver mi cuenta” y haga clic en “Historial de compras”.
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Acerca de Quiosco
Quiosco organiza sus suscripciones a apps de periódicos y revistas con una estantería que le 
permite acceder a sus publicaciones con rapidez y facilidad. Las apps de Quiosco aparecen en la 
estantería y, a medida que hay nuevos números disponibles, un globo le permite saber que están 
listos para leerse. Se transfieren al iPhone automáticamente.
Mantenga pulsada una 
publicación para 
reorganizarla.
Buscar apps de Quiosco:  Pulse Quiosco para mostrar la estantería y, a continuación, pulse Store.
Cuando adquiera una app de quiosco, se añadirá a su estantería para que pueda accederse a ella 
con facilidad. Una vez descargada la app, ábrala para ver sus números y opciones de suscripción.
Las suscripciones son compras integradas, que se facturan a su cuenta de tienda. Consulte “Ajustes 
de Store” en la página 132. 
Los precios son variables, y es posible que las apps de Quiosco no estén disponibles en todas las 
áreas.
Cómo leer los números más recientes
Cuando un periódico o una revista saque un número nuevo, Quiosco lo descargará al conectarse 
a una Wi-Fi y se lo notificará mostrando un globo en el icono de la app. Para empezar a leer, abra 
Quiosco y busque apps con el banner “Nuevo”.
128Cada app tiene su propio método de gestión de números. Para obtener información sobre la 
forma de eliminar, buscar o trabajar con números individuales, consulte la información de ayuda 
de la app o el listado de App Store. No se puede eliminar una app de Quiosco de la estantería, ni 
poner otros tipos de apps en la estantería.
Desactivar las descargas automáticas:  Vaya a Ajustes > Store y desactive las descargas automáticas de la publicación.
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Acerca de App Store
Puede buscar, explorar, previsualizar, comprar y descargar apps desde la tienda App Store directamente al iPhone. 
Para explorar la tienda App Store, el iPhone debe estar conectado a Internet. Consulte “Red” en la 
página 178. Para comprar apps, también necesita un ID de Apple (que puede no estar disponible 
en todas las áreas). Consulte “Ajustes de Store” en la página 132.
Nota: Es posible que la tienda App Store no esté disponible en todas las áreas, y su contenido 
puede variar de un área a otra. Estas prestaciones pueden modificarse sin previo aviso.
Ver recomendaciones 
Genius.
Buscar actualizaciones 
de apps.
Cómo buscar y descargar apps
Explore las selecciones destacadas para descubrir apps nuevas, notables o recomendadas, o explore las listas de los 25 más vendidos para ver cuáles son las apps más populares. Para buscar 
una app determinada, utilice la función de búsqueda.
Explorar la tienda App Store:  Pulse Destacados, Categorías o “Top 25”.
130Explorar utilizando Genius Pulse Genius para ver una lista de apps recomendadas basadas en el contenido de su colección actual de apps. Para activar Genius, siga las instrucciones que aparecen en pantalla. Genius es un servicio gratuito, pero requiere 
disponer de un ID de Apple. 
Buscar apps Pulse Buscar y, a continuación, pulse el campo de búsqueda, introduzca una 
o más palabras y pulse Buscar.
Obtener puntuaciones y leer 
reseñas
Pulse Valoraciones, cerca de la parte inferior de la pantalla de información de la app. Puede puntuar y escribir reseñas de las apps que se haya 
descargado.
Enviar un enlace a la página de 
información de la app en iTunes
Pulse “Pasa la voz”, cerca de la parte inferior de la pantalla de información de 
la app.
Enviar la app a una persona como 
regalo
Pulse “App de regalo”, cerca de la parte inferior de la pantalla de información de la app, y a continuación siga las instrucciones que aparecen en la 
pantalla.
Informar de un problema Pulse “Informar de un problema”, cerca de la parte inferior de la pantalla de 
información. Seleccione un problema de la lista o escriba comentarios opcionales y pulse Informar.
Comprar y descargar una app Pulse el precio (o pulse Gratis) y, a continuación, pulse Comprar. 
Si ya ha adquirido la app, en lugar del precio se indicará “Instalar” en la pantalla Información. No se le cobrará nada si vuelve a descargarla.
Canjear una tarjeta o código de 
regalo
Pulse Canjear, cerca de la parte inferior de la pantalla Destacados y, a continuación, siga las instrucciones que aparecen en pantalla. 
Consultar el estado de las 
descargas
Durante la descarga de una app, su icono aparece en la pantalla de inicio y 
muestra un indicador de estado.
Descargar una compra anterior Pulse Comprado.
También puede descargar un ítem mientras explora contenidos; basta con 
que pulse Descargar donde normalmente se ve el precio.
Descargar automáticamente 
compras realizadas en otros 
dispositivos
Vaya a Ajustes > Store y, a continuación, active los tipos de compras que 
desee que se descarguen automáticamente.
Actualizar una app En la parte inferior de la pantalla de información de la app, pulse Actualizar 
y siga las instrucciones que aparecen en pantalla.
Eliminación de apps
Puede eliminar apps instaladas desde App Store. Si elimina una app, los datos asociados a la misma también se eliminarán.
Eliminar una app de App Store:  Mantenga pulsado el icono de la app en la pantalla de inicio 
hasta que los iconos empiecen a moverse lateralmente y, a continuación, pulse  . Pulse el botón 
de inicio  cuando termine de eliminar las apps.
Para obtener información sobre la manera de borrar todas las apps y todos sus datos ajustes, consulte “Borrar contenidos y ajustes” en página 183.
Puede descargar gratuitamente cualquier app eliminada que haya adquirido en la tienda App 
Store.
Descargara una app eliminada En la App Store, pulse Actualizar y, a continuación, pulse Comprado. Pulse la 
app y, después, pulse Instalar.
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Utilice los ajustes de Store para iniciar una sesión con un ID de Apple, crear un nuevo ID de Apple 
o editar un ID existente. Si dispone de más de un ID de Apple, puede usar los ajustes de Store para 
cerrar la sesión con uno de ellos e iniciar una sesión con otro. Por omisión, en los ajustes de Store 
aparece el ID Apple con el que se conecta cuando sincroniza el iPhone con el ordenador. 
Para consultar los términos y condiciones de iTunes Store, vaya a www.apple.com/legal/itunes/
ww/. 
Iniciar sesión con un ID de Apple:  Vaya a Ajustes > Store, pulse Conectarse y, a continuación, pulse “Usar ID de Apple existente” e introduzca su ID de Apple y su contraseña.
Ver y editar la información de su 
cuenta
Vaya a Ajustes > Store, pulse su ID de Apple y, a continuación, pulse “Ver 
ID de Apple”. Pulse un ítem para editarlo. Para cambiar la contraseña de su 
cuenta, pulse el campo “ID de Apple”.
Iniciar sesión con otro ID de Apple Vaya a Ajustes > Store, pulse su nombre de cuenta y, a continuación, pulse 
Desconectarse.
Crear un nuevo ID de Apple Vaya a Ajustes > Store, pulse Conectarse y, a continuación, pulse “Crear nuevo ID de Apple” y siga las instrucciones que aparecen en pantalla.
Descargar compras 
automáticamente
Vaya a Ajustes > Store y, a continuación, active los tipos de compras que 
desee que se descarguen automáticamente en el iPhone, como Música o 
Libros. También puede desactivar la actualización automática de apps de 
quiosco.
Descargar compras utilizando la 
red de telefonía móvil
Vaya a Ajustes > Store y, a continuación, active o desactive “Usar datos 
móviles”. Descargar compras a través de la red de telefonía móvil puede 
suponer la aplicación de tarifas por parte de su operador. Las apps de 
quiosco solo se actualizan cuando el iPhone está conectado a una red Wi-Fi. 
Consulte Capítulo 22,“Quiosco,” en la página 128.
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Acerca de Contactos
Contactos le permite acceder y editar con facilidad sus listas de contactos de cuentas personales, 
de empresa y de organización. Puede realizar búsquedas en todos sus grupos, y el acceso a la 
información de Contactos es automático para que la introducción de direcciones en mensajes de 
correo electrónico resulte rápida y sencilla.
Llamar
Enviar un mensaje 
de correo 
electrónico.
Enviar un 
mensaje de 
texto.
Realizar una 
videollamada 
FaceTime.
Ver un mapa
y obtener 
indicaciones.
Cómo sincronizar contactos
Puede añadir contactos de las siguientes maneras:
Â En iTunes, sincronice contactos de Google o Yahoo!, o sincronice aplicaciones en el ordenador. 
Consulte “Sincronización con iTunes” en la página 18.
Â Utilice sus contactos de iCloud. Consulte “iCloud” en la página 17.
Â Configure una cuenta Microsoft Exchange en el iPhone con la función Contactos activada. 
Consulte “Cuentas y ajustes de Contactos” en la página 135.
Â Configure una cuenta LDAP o CardDAV para acceder a directorios empresariales o escolares. 
Consulte “Cuentas y ajustes de Contactos” en la página 135.
Â Introduzca contactos directamente en el iPhone. Consulte “Cómo añadir y editar contactos” en 
la página 134.
Â Importe contactos de una tarjeta SIM (GSM). Consulte “Cuentas y ajustes de Contactos” en la 
página 135.
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Puede buscar por cargo, nombre, apellido o nombre de la empresa en los contactos del iPhone. Si 
tiene configurada una cuenta Microsoft Exchange, una cuenta LDAP o una cuenta CardDAV, también puede buscar dichos contactos.
Buscar contactos:  En Contactos, pulse el campo de búsqueda de la parte superior de cualquier 
lista de contactos e introduzca su búsqueda. 
Buscar en una Lista Global de 
Direcciones
Pulse Grupos y, después, Directorios, en la parte inferior de la lista, e introduzca su búsqueda.
Buscar en un servidor LDAP Pulse Grupos y, después, el nombre del servidor LDAP, e introduzca su 
búsqueda.
Buscar en un servidor CardDAV Pulse Grupos y, después, pulse el grupo CardDAV disponible para realizar 
búsquedas, en la parte inferior de la lista, e introduzca su búsqueda.
Guardar la información de contacto de un servidor GAL, LDAP o 
CardDAV
Busque el contacto que desee añadir y, a continuación, pulse “Añadir 
contacto”.
También pueden encontrarse contactos a través de las búsquedas que se realizan en la pantalla 
de inicio. Consulte “Cómo buscar” en la página 30.
Cómo añadir y editar contactos
Añadir un contacto al iPhone: Pulse Contactos y pulse  . Si  no está visible, asegúrese de que 
no esté visualizando una lista de contactos LDAP, CalDAV o GAL.
Eliminar un contacto En Contactos, seleccione un contacto y pulse Editar. Desplácese hacia abajo 
y pulse “Eliminar contacto”.
Añadir un contacto desde el teclado numérico
Pulse Teclado, introduzca un número y pulse  . Pulse “Nuevo contacto”, o 
bien pulse “Contacto existente” y seleccione un contacto.
Introducir una pausa breve (de dos 
segundos) en un número
Pulse  y, a continuación, pulse Pausa. El sistema telefónico puede necesitar una o varias pausas antes de marcar una extensión, por ejemplo. Cada 
pausa se muestra como una coma cuando se guarda el número.
Introducir una pausa larga en un 
número
Pulse  y, a continuación, pulse Esperar. Una pausa larga se muestra 
como un punto y coma cuando se guarda el número. Al marcar, el iPhone 
se realizará una pausa cuando llegue al punto y coma y esperará a que pulse Marcar para continuar.
Añadir a los contactos el número 
de teléfono de una persona que ha 
llamado recientemente
Pulse Recientes y, a continuación, pulse  junto al número. Después 
pulse “Nuevo contacto”, o bien pulse “Contacto existente” y seleccione un 
contacto.
Editar información de contacto: Seleccione un contacto y pulse Editar.
Añadir un nuevo campo Pulse  “Añadir campo”.
Añadir el nombre de usuario de 
Twitter de un contacto
Pulse  “Añadir campo” y, a continuación, pulse Twitter.
Cambiar la etiqueta de un campo Pulse la etiqueta y seleccione una distinta. Para añadir una nueva etiqueta, 
desplácese al final de la lista y pulse “Etiqueta personalizada”.
Cambiar el tono de llamada o el 
tono de SMS del contacto
Pulse el campo de tono de llamada o tono de SMS y seleccione un nuevo 
sonido. El tono por omisión se especifica en Ajustes > Sonidos.
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Asignar una foto a un contacto Pulse “Añadir foto” o pulse la foto existente. Puede hacer una foto con la 
cámara o usar una foto existente.
Para importar fotos de los perfiles de Twitter de sus contactos, vaya a 
Ajustes > Twitter. Inicie sesión en su cuenta Twitter y, a continuación, pulse 
“Actualizar contactos”.
Contactos unificados
Al sincronizar contactos con varias cuentas, es posible que tenga diversas entradas para la misma 
persona en más de una cuenta. Para evitar que aparezcan contactos repetidos en la lista “Todos 
los contactos”, los contactos de distintas cuentas que tienen el mismo nombre se combinan y se 
visualizan como un solo contacto unificado. Al visualizar un contacto unificado, en la parte superior de la pantalla aparece el título “Info unificada”. 
Vincular un contacto: Pulse Editar y, a continuación, pulse  y seleccione un contacto.
Si vincula contactos con distintos nombres o apellidos, los nombres de los contactos individuales 
no cambiarán, pero solo se mostrará un nombre en la tarjeta unificada. Para seleccionar el nombre 
que debe aparecer cuando visualice la tarjeta unificada, pulse la tarjeta vinculada con el nombre 
que prefiera y, a continuación, pulse “Usar este nombre para la tarjeta unif.”.
Ver la información de contactos de 
una cuenta de origen
Pulse una de las cuentas de origen.
Desenlazar un contacto Pulse Editar, luego pulse  y, a continuación, pulse Desenlazar.
Los contactos vinculados no se fusionan. Si modifica o añade información en un contacto unificado, los cambios se copian a cada cuenta de origen en la que dicha información ya exista. 
Cuentas y ajustes de Contactos
Puede añadir cuentas de Contactos, y ajustar el modo en que se muestran y se ordenan los nombres de los contactos.
Añadir una cuenta de Contactos:  Vaya a Ajustes > “Correo, contactos, calendarios” y pulse “Añadir 
cuenta”.
Para cambiar los ajustes de Contactos, vaya a Ajustes > “Correo, contactos, calendarios” y ajuste 
estas opciones:
Ajustar el criterio de ordenación de 
los contactos
Pulse “Ordenar como” para ordenarlos por nombre o por apellido.
Ajustar cómo se muestran los 
contactos
Pulse “Mostrar como” y seleccione la visualización por nombre o por 
apellido.
Importar contactos de una tarjeta 
SIM
Pulse “Importar contactos de la SIM”.
Ajustar su tarjeta “Mis datos” Pulse “Mis datos” y seleccione en la lista la tarjeta de contacto con su nombre y sus datos.
Siri y otras apps utilizan la tarjeta “Mis datos”. Utilice los campos de personas 
relacionadas para definir relaciones que desee que Siri conozca, de modo 
que pueda decir cosas como “call my sister”.
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por omisión
Pulse “Cuenta por omisión” y, a continuación, seleccione una cuenta. Los 
nuevos contactos que cree sin especificar otra cuenta se almacenarán en 
dicha cuenta.
Use iCloud para mantener actualizado Contactos en sus dispositivos 
iOS y ordenadores.
Vaya a Ajustes > iCloud y, a continuación, active Contactos. Consulte “iCloud” en la página 17.
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Acerca de Vídeos
Con el iPhone, puede ver contenido de vídeo, como películas, vídeos musicales y podcasts de ví-
deo desde iTunes y, si están disponibles en su área, programas de televisión.
Cómo reproducir vídeos
Reproducir un vídeo:  Pulse encima del vídeo.
Pulse el 
vídeo para 
mostrar u 
ocultar los 
controles.
Ver el vídeo 
en un 
televisor con 
Apple TV.
Arrastre para avanzar o retroceder.
Seleccionar un 
capítulo.
Arrastre para 
ajustar el volumen.
Cars 2 está disponible en iTunes. Cars 2 © Disney/Pixar.
Mostrar u ocultar los controles de 
reproducción
Mientras se reproduce un vídeo, pulse la pantalla.
Ajustar el volumen Arrastre el regulador de volumen o utilice los botones de volumen del lateral del iPhone o los botones de volumen de los auriculares del iPhone.
Escalar un vídeo a pantalla completa o ajustarlo a la pantalla
Pulse  o  . O bien, pulse dos veces en el vídeo.
Poner en pausa o reanudar la 
reproducción
Pulse  o  , o pulse el botón central de los auriculares del iPhone.
Volver a empezar desde el principio Si el vídeo contiene capítulos, arrastre el cursor de reproducción hacia la 
izquierda del todo en la barra de reproducción. Si no contiene capítulos, 
pulse  . Si había visto menos de 5 segundos del vídeo, se abrirá el vídeo 
anterior de la biblioteca.
Ir a un capítulo específico (si está 
disponible)
Pulse  y seleccione un capítulo.
Ir al capítulo siguiente (si está 
disponible)
Pulse  , o pulse dos veces rápidamente el botón central de los auriculares 
del iPhone.
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disponible)
Pulse  , o pulse tres veces rápidamente el botón central de los auriculares 
del iPhone. Si había visto menos de 5 segundos del vídeo, se abrirá el vídeo 
anterior de la biblioteca.
Retroceder o avanzar Mantenga pulsado  o  .
Dejar de ver un vídeo Pulse OK.
Seleccionar otro idioma para el 
audio (si está disponible)
Pulse  y después seleccione un idioma en la lista Audio.
Mostrar u ocultar los subtítulos (si 
están disponibles)
Pulse  y después seleccione un idioma, o pulse No en la lista Subtítulos.
Mostrar u ocultar los subtítulos 
para sordos (si están disponibles)
Vaya a Ajustes > Vídeo.
Búsqueda de vídeos
Puede realizar búsquedas en los títulos de películas, programas de TV y podcast de vídeo del 
iPhone.
Buscar sus vídeos:  Pulse la barra de estado en la parte superior de la pantalla para que se muestre el campo de búsqueda, pulse el campo e introduzca texto.
También puede buscar vídeos desde la pantalla de inicio. Consulte “Cómo buscar” en la página 30.
Cómo ver películas alquiladas
Puede alquilar películas en la tienda iTunes Store y verlas en el iPhone. Puede descargar películas 
alquiladas directamente en el iPhone, o bien transferir películas desde iTunes en su ordenador al 
iPhone. (Es posible que las películas alquiladas no estén disponibles en todas las áreas).
Las películas alquiladas caducan y, una vez que inicia su reproducción, dispone de un tiempo limitado para terminar de verlas. El tiempo restante se indica junto al título. Los archivos alquilados se 
borran cuando caducan. Antes de alquilar una película, compruebe en iTunes Store el periodo de 
alquiler. Para obtener información, consulte “Cómo comprar o alquilar vídeos” en la página 125.
Ver una película alquilada: Pulse el vídeo que desee ver. Si no ve el vídeo en su lista, es posible 
que aún esté cargándose.
Transferir películas alquiladas al iPhone: Conecte el iPhone al ordenador. A continuación, seleccione iPhone en la barra lateral de iTunes, haga clic en Películas y seleccione las películas alquiladas que desee transferir. El ordenador debe estar conectado a Internet. Las películas alquiladas en 
el iPhone no pueden transferirse a un ordenador.
En el iPhone 3GS, pueden transferirse películas alquiladas entre el iPhone y el ordenador. En el 
iPhone 4 solo pueden transferirse películas alquiladas entre el iPhone y el ordenador si se alquilaron mediante iTunes en el ordenador.
Ver vídeos en un televisor
Puede transmitir vídeos de forma inalámbrica a su televisor utilizando AirPlay y un Apple TV, o conectar el iPhone a su televisor utilizando cualquiera de los siguientes cables:
Â un adaptador digital VGA de Apple y un cable HDMI (iPhone 4 o posterior);
Â un cable AV de componentes de Apple;
Â un cable AV compuesto de Apple;
Â un adaptador VGA de Apple y un cable VGA.
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tienda Apple habitual.
Transmisión de vídeos mediante AirPlay:  Inicie la reproducción de un vídeo, pulse  y seleccione su Apple TV en la lista de dispositivos AirPlay. Si  no aparece o si no ve Apple TV en la lista 
de dispositivos AirPlay, asegúrese de que se encuentra en la misma red inalámbrica que el iPhone. 
Para obtener más información, consulte “AirPlay” en la página 35.
Mientras se reproduce el vídeo, puede salir de Vídeos y utilizar otras apps. Para regresar al iPhone, 
pulse  y seleccione el iPhone.
Transmitir vídeos utilizando un cable:  Use el cable para conectar el iPhone a su televisor o receptor AV y seleccione la entada correspondiente.
Conexión mediante un cable AV Utilice el cable AV de componentes de Apple o el cable AV compuesto de 
Apple u otro cable autorizado compatible con el iPhone. También puede 
utilizar estos cables con la base de conexión universal de Apple para conectar el iPhone al televisor. Puede utilizar el mando a distancia de la base de 
conexión para controlar la reproducción. 
Conexión mediante un adaptador 
digital VGA de Apple (iPhone 4 o 
posterior)
Conecte el adaptador AV digital de Apple al conector Dock del iPhone. Use 
un cable HDMI para conectar el puerto HDMI del adaptador a su televisor 
o receptor. Para mantener el iPhone cargado durante la visualización de 
vídeos, use un cable de conector Dock a USB de Apple a fin de conectar el 
puerto de 30 clavijas del adaptador al ordenador o a un adaptador de corriente USB conectado a una toma de corriente.
Conexión mediante un adaptador 
VGA
Conecte el adaptador VGA al conector Dock del iPhone. Conecte el adaptador VGA con un cable VGA a un televisor, proyector o pantalla VGA 
compatible.
El adaptador digital AV acepta vídeo de alta definición de hasta 720p con audio.
Cuando conecte el iPhone 4S a un televisor o proyector mediante un adaptador AV digital de 
Apple o un adaptador VGA de Apple, la pantalla del iPhone se duplicará automáticamente en la 
pantalla externa con una resolución de hasta 1080p, y los vídeos se reproducirán con una resolución de hasta 720p.
Con el iPhone 4S, también puede duplicar la pantalla en un televisor de forma inalámbrica mediante la duplicación de AirPlay y un Apple TV. Consulte “AirPlay” en la página 35.
Cómo eliminar vídeos del iPhone
Puede eliminar vídeos del iPhone para ahorrar espacio. Al eliminar un vídeo del iPhone (que no 
sea una película alquilada), dicho vídeo no se elimina de la biblioteca de iTunes. Puede reaparecer 
en el iPhone si el vídeo en iTunes sigue estando ajustado para que se sincronice.
Importante: Si elimina una película alquilada del iPhone, se borrará permanentemente y no será 
posible transferirla de vuelta al ordenador.
Eliminar un vídeo:  En la lista de vídeos, deslice el dedo a izquierda o derecha sobre el vídeo y 
pulse Eliminar.
Cómo utilizar “Compartir en casa”
La función “Compartir en casa” le permite reproducir música, películas y programas de televisión 
en el iPhone desde la biblioteca de iTunes de su Mac o PC. Consulte “Compartir en casa” en la 
página 88.
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Puede ajustar el iPhone para que deje de reproducir música o vídeos al cabo de un periodo de 
tiempo.
Ajustar un temporizador de reposo: En la app Reloj, pulse Temporizador y, a continuación, deslice el dedo para ajustar el número de horas y minutos. Pulse “Al finalizar” y seleccione “Poner iPod 
en reposo”, pulse Guardar y después pulse Iniciar para poner en marcha el temporizador.
Cuando el temporizador acaba, el iPhone deja de reproducir música o vídeo, cierra cualquier otra 
app abierta y se bloquea.
Conversión de vídeos para el iPhone
Puede añadir al iPhone otros vídeos aparte de los adquiridos en iTunes Store, como vídeos 
creados en iMovie en un Mac o vídeos descargados de Internet y después añadidos a iTunes. Si 
intenta añadir un vídeo desde iTunes al iPhone y aparece un mensaje que indica que el vídeo no 
puede reproducirse en el iPhone, puede convertir el vídeo.
Convertir un vídeo para hacerlo compatible con el iPhone:  Seleccione el vídeo en la biblioteca 
de iTunes y elija Avanzado > “Crear versión del iPod o el iPhone”. A continuación, añada el vídeo 
convertido al iPhone.
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Cómo usar la calculadora
Pulse números y funciones en Calculadora como lo haría con una calculadora cualquiera. Cuando 
pulse los botones de sumar, restar, multiplicar y dividir, aparecerá un círculo blanco alrededor del 
botón para indicarle qué operación está llevando a cabo.
Añadir un número a la 
memoria.
Borrar memoria.
Borrar la pantalla.
Restar un número 
almacenado en la 
memoria.
Obtener un número de la 
memoria (un anillo de 
color blanco indica que 
un número está 
almacenado en la 
memoria).
Calculadora científica
Gire el iPhone hasta colocarlo horizontalmente para mostrar la calculadora científica.
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Acerca de Brújula
La brújula integrada le muestra la orientación del iPhone y las coordenadas geográficas de su ubicación actual. Puede hacer que la brújula señale el norte magnético o el norte verdadero.
Importante: La precisión de la brújula puede verse afectada negativamente por interferencias 
magnéticas o ambientales; incluso los imantes de los auriculares de botón del iPhone pueden provocar una desviación. Utilice la brújula digital para tener unas pautas de navegación básicas y no 
la emplee como fuente de referencia principal para determinar ubicaciones precisas, proximidad, 
distancias o direcciones.
Si cuando abra la app Brújula los servicios de localización están desactivados, se le solicitará que 
los active. No obstante, puede utilizar Brújula sin tenerlos activados. Consulte “Localización” en la 
página 175.
Seleccionar lecturas 
magnéticas o verdaderas.
Ubicación actual
La orientación del iPhone
Mostrar su ubicación actual en Mapas.
Cómo calibrar la brújula
La primera vez que utilice la brújula deberá calibrarla, y es posible que deba volver a hacerlo de 
vez en cuando. El iPhone le avisará si es necesario realizar una calibración.
Calibrar la brújula interna:  Mueva el iPhone formando un ocho.
142Cómo determinar la dirección
Determinar la dirección del iPhone:  Sostenga el iPhone en la mano en posición horizontal, paralelo al suelo. Su dirección actual aparece en la parte superior de la pantalla y las coordenadas de 
su ubicación actual se muestran en la parte inferior de la pantalla.
Alternar entre norte verdadero y 
norte magnético
Pulse  .
Uso de Brújula con Mapas
La app Brújula también puede mostrar su ubicación y dirección actual en Mapas. Para obtener información, consulte “Cómo buscar ubicaciones” en la página 108.
Visualizar su ubicación actual en Mapas:  Pulse  en la parte inferior de la pantalla de Brújula. 
Mapas se abre y muestra su ubicación actual con un marcador azul.
Mostrar la dirección: En Mapas, pulse  dos veces. El icono cambia a  . El ángulo muestra la 
precisión de la lectura de la brújula: cuanto menor sea el ángulo, mayor la 
precisión.
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Acerca de Notas de voz
La app Notas de Voz le permite utilizar el iPhone como dispositivo de grabación portátil combinado con el micrófono integrado, el micrófono de un auricular manos libres del iPhone o Bluetooth, 
o un micrófono externo compatible. Las grabaciones realizadas con el micrófono integrado son 
mono, aunque puede realizar grabaciones estéreo utilizando un micrófono externo estéreo.
Nota: Los micrófonos externos deben estar diseñados para funcionar con la salida de auriculares 
o el conector Dock del iPhone. Pueden utilizarse, por ejemplo, los auriculares de botón de marca 
Apple y los accesorios de otros fabricantes autorizados que lleven el logotipo “Made for iPhone” o 
“Works with iPhone” de Apple.
Iniciar, poner en pausa o detener una grabación.
Nivel de grabación 
Ver su lista de 
grabaciones.
Cómo grabar
Realizar una grabación:  Pulse  o pulse el botón central de los auriculares del iPhone. Pulse 
para poner en pausa la grabación o  para detenerla, o pulse el botón central de los auriculares 
del iPhone.
144Ajustar el nivel de grabación Acerque o aleje el micrófono de la fuente de sonido que esté grabando. 
Para obtener una grabación de mayor calidad, el registro más alto del medidor de nivel debe estar comprendido entre –3 dB y 0 dB.
Activar o desactivar el tono de 
incio/fin
Utilice el interruptor de tono/silencio del iPhone. (En algunas áreas, los 
efectos de sonido de Notas de Voz suenan aunque el interruptor de tono/
silencio esté en la posición Silencio.)
Utilizar otra app durante la 
grabación
Pulse el botón de inicio  y abra una app. Para regresar a Notas de voz, 
pulse la barra de color rojo situada en la parte superior de la pantalla.
Cómo escuchar una grabación
Reproducir una grabación:  Pulse  , pulse una nota y, a continuación, pulse  . Pulse  para poner 
en pausa la reproducción.
Acortar o reetiquetar la 
grabación.
Escuchar la grabación.
Adjuntar la grabación a 
un mensaje de correo 
electrónico o de texto.
Arrastre el dedo para ir 
directamente a cualquier 
punto.
Pasar del altavoz al receptor y viceversa.
Saltar a cualquier punto de una 
grabación
Arrastre el cursor de reproducción a lo largo de la barra de desplazamiento.
Escuchar a través del altavoz integrado del iPhone en lugar de a 
través del receptor
Pulse Altavoz.
Acortar una grabación Pulse  junto a la grabación que desee acortar y, a continuación, pulse 
“Acortar nota”. Arrastre los bordes del pasaje de audio y, a continuación, pulse  para previsualizarla. Ajústela si es necesario y, por último, pulse “Acortar 
nota de voz” para guardarla. Las partes que acorte no podrán recuperarse.
Cómo gestionar y compartir grabaciones
Una grabación se etiqueta con la hora a la que se grabó.
Etiquetar una grabación:  Pulse  junto a la grabación que desee reetiquetar, pulse  en la pantalla de información y, a continuación, seleccione una etiqueta o seleccione Personalizado.
Eliminar una grabación Pulse una grabación de la lista y, a continuación, pulse Eliminar.
Ver los detalles de una grabación Pulse  junto a la grabación cuyos detalles desee consultar.
Enviar una grabación por correo 
electrónico o en un mensaje
Pulse una grabación de la lista y, a continuación, pulse Compartir.
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iTunes puede sincronizar las notas de voz con su biblioteca de iTunes al conectar el iPhone al 
ordenador.
Aunque sincronice sus notas de voz con iTunes, estas permanecen en la app Notas de Voz hasta 
que las elimina. Si elimina una nota de voz en el iPhone, no se eliminará de la lista de reproducción “Notas de voz” de iTunes. Sin embargo, si elimina una nota de voz de iTunes, sí se eliminará 
del iPhone la próxima vez que lo sincronice con iTunes.
Sincronizar notas de voz con iTunes:  Conecte el iPhone al ordenador y seleccione el iPhone 
en la lista de dispositivos de iTunes. Seleccione Música en la parte superior de la pantalla (entre 
Aplicaciones y Películas), seleccione “Sincronizar la música”, seleccione “Incluir notas de voz” y haga 
clic en Aplicar.
Las notas de voz del iPhone aparecerán en la lista de reproducción “Notas de voz” de iTunes.
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Acerca de Nike + iPod
Con un sensor Nike + iPod (a la venta por separado), la app Nike + iPod proporciona información 
audible sobre la velocidad, la distancia, el tiempo transcurrido y las calorías quemadas corriendo 
o caminando. Puede enviar su información de entrenamiento a nikeplus.com, donde podrá seguir 
sus progresos, marcarse objetivos y participar en retos deportivos.
Revisar su historial de 
entrenamientos.
Calibrar en función del 
último entrenamiento.
Seleccionar un tipo de 
entrenamiento.
Seleccionar un 
entrenamiento 
estándar.
Seleccionar o crear 
un entrenamiento 
personalizado.
Cómo activar Nike + iPod
La app Nike + iPod no aparece en la pantalla de inicio hasta que se activa.
Para obtener ayuda a la hora de configurar Nike + iPod, consulte la documentación de Nike + 
iPod.
Activar Nike + iPod:  Vaya a Ajustes > Nike + iPod.
Cómo enlazar un sensor
Nike + iPod basa los datos de entrenamiento en una señal de un sensor (a la venta por separado) 
que se coloca su zapatilla. La primera vez que inicie un entrenamiento se le pedirá que active el 
sensor, lo que enlazará automáticamente el sensor con el iPhone. También puede usar los ajustes 
de Nike + iPod para enlazar un sensor con el iPhone.
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Enlazar su sensor con el iPhone:  Coloque el sensor en su zapatilla y, a continuación, vaya a 
Ajustes > Nike + iPod > Sensor.
Enlazar otro sensor con el iPhone Vaya a Ajustes > Nike + iPod > Sensor y pulse “Enlazar nuevo”.
Cómo entrenarse con Nike + iPod
Después de activar Nike + iPod e insertar el sensor Nike + iPod en una zapatilla compatible con 
Nike+, estará listo para recopilar datos de entrenamiento.
Importante: Antes de iniciar cualquier programa de ejercicios, es recomendable someterse a un 
examen médico completo. Realice ejercicios de calentamiento y estiramiento antes de comenzar la sesión de entrenamiento y permanezca atento y cauto durante el desarrollo de la misma. 
Disminuya la velocidad, si es necesario, antes de ajustar el dispositivo durante el entrenamiento. 
Deténgase inmediatamente si nota dolor o se siente débil, mareado, exhausto o sofocado. Al 
practicar deporte, usted asume los riesgos inherentes al ejercicio físico, incluido cualquier tipo de 
lesión derivada de dicha actividad.
Entrenarse con Nike + iPod:  Abra Nike + iPod, pulse Entrenamientos y seleccione un entrenamiento. La recopilación de datos continuará mientras el iPhone está en reposo.
Poner en pausa o reanudar su 
entrenamiento
Si se interrumpe su entrenamiento, active el iPhone y pulse  en la pantalla 
de bloqueo. Pulse  cuando esté listo para continuar.
Finalizar su entrenamiento Active el iPhone, pulse  y, a continuación, pulse Finalizar.
Cambiar los ajustes de 
entrenamiento
Vaya a Ajustes > Nike + iPod.
Cómo calibrar Nike + iPod
Para garantizar la precisión de los datos de entrenamiento, puede calibrar Nike + iPod con la longitud de su zancada al caminar o correr.
Calibrar Nike + iPod:  Grabe un entrenamiento que consista en correr o andar una distancia conocida de al menos 400 metros. A continuación, después de pulsar Finalizar, pulse Calibrar en la 
pantalla de resumen de entrenamientos e introduzca la distancia real recorrida.
Restaurar a la calibración por 
omisión
Vaya a Ajustes > Nike + iPod.
Cómo enviar datos de entrenamiento a nikeplus.com
Desde nikeplus.com podrá realizar un seguimiento de su evolución en el tiempo, consultar un 
registro de todos sus entrenamientos, fijarse objetivos y comprobar si los alcanza, y comparar sus 
resultados con los de otros corredores. Puede incluso competir con otros usuarios de Nike + iPod 
en concursos de entrenamiento en línea.
Enviar los datos de entrenamiento de forma inalámbrica a nikeplus.com desde el iPhone:  Con 
el iPhone conectado a Internet, abra Nike + iPod, pulse Historial y, a continuación, pulse “Enviar a 
Nike+”.
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En Safari, vaya a nikeplus.com, inicie sesión en su cuenta y siga las instrucciones que aparecen en pantalla.
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Acerca de iBooks
iBooks es una forma extraordinaria de leer y comprar libros. Descargue la app gratuita iBooks 
de la tienda App Store y acceda a todo tipo de libros, desde los grandes clásicos hasta las obras 
más vendidas, en la tienda iBookstore integrada. Los libros que descargue se mostrarán en la 
estantería. 
Para descargar la app iBooks y utilizar la iBookstore, necesita una conexión a Internet y un ID de 
Apple. Si no dispone de un ID de Apple o si desea realizar compras utilizando otro ID de Apple, 
seleccione Ajustes > Store. Consulte “Ajustes de Store” en la página 132.
Nota: La app iBooks y la tienda iBookstore pueden no estar disponibles en todos los idiomas o en 
todas las áreas.
Uso de la iBookstore
En la app iBooks, pulse Store para abrir la iBookstore. Desde aquí, puede explorar los libros recomendados o los superventas, así como buscar libros por autor o tema. Cuando encuentre un libro 
que le guste, podrá comprarlo y descargarlo.
Nota: Algunas características de la iBookstore pueden no estar disponibles en todas las áreas.
Comprar un libro:  Busque un libro que le interese, pulse el precio y, a continuación, pulse 
“Comprar libro” u “Obtener libro” si es gratuito.
Obtener información sobre un libro Puede leer un resumen del libro, consultar reseñas y descargar una muestra 
del libro antes de comprarlo. Después de comprar un libro, puede escribir 
su propia reseña.
Descargar una compra anterior Pulse Comprado.
También puede descargar un ítem mientras explora contenidos; basta con 
que pulse Descargar donde normalmente se ve el precio.
Descargar automáticamente compras realizadas en otros dispositivos iOS y ordenadores
En Ajustes, seleccione Store y, a continuación, active los tipos de compras 
que desee que se descarguen automáticamente.
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Utilice iTunes para sincronizar sus libros y documentos PDF entre el iPhone y el ordenador, y para 
comprar libros en la tienda iTunes Store. Cuando el iPhone está conectado al ordenador, el panel 
Libros le permite seleccionar los ítems que desea sincronizar. También puede añadir libros ePub 
sin DRM y documentos PDF a la biblioteca de iTunes. En Internet encontrará libros en formato 
ePub y PDF.
Sincronizar un libro ePub o un archivo PDF con el iPhone:  En iTunes en su ordenador, seleccione Archivo > “Añadir a la biblioteca” y seleccione el archivo. Seleccione el libro o PDF en el panel 
Libros de iTunes y, a continuación, realice una sincronización.
Para añadir un libro o PDF a iBooks sin tener que realizar una sincronización, envíese a sí mismo 
el archivo por correo electrónico desde su ordenador. Abra el mensaje de correo electrónico en el 
iPhone y, a continuación, mantenga pulsado el archivo adjunto y seleccione “Abrir en iBooks” en el 
menú que aparece. 
Lectura de libros
Leer un libro es fácil. Vaya a la estantería y pulse el libro que desee leer. Si no encuentra el libro 
que busca, pulse el nombre de la colección actual en la parte superior de la pantalla para ir a otras 
colecciones.
Pulsar para reproducir.
Ir a otra página.
Añadir un marcador.
Leer un libro mientras está recostado:  Utilice el bloqueo de la orientación vertical para impedir 
que el iPhone cambie la orientación de la pantalla cuando gire el iPhone. Consulte “Ver en vertical 
u horizontal” en la página 22.
Cada libro presenta una serie de características específicas, basadas en su contenido y formato. Es 
posible que algunas de las funciones que se describen a continuación no estén disponibles en el 
libro que esté leyendo. Por ejemplo, la impresión solo está disponible para documentos PDF, y si 
un libro no incluye una narración grabada, no verá el icono de lectura en voz alta.
Mostrar los controles Pulse cerca del centro de la página.
Pasar de página Pulse cerca del margen derecho o izquierdo de la página o desplácese 
hacia la izquierda o hacia la derecha. Para cambiar la dirección en la que 
pasan las páginas al pulsar en el margen izquierdo, vaya a Ajustes > iBooks 
> Pulsar margen izquierdo. 
Ver el índice Pulse  . Con algunos libros, también puede realizar un movimiento de 
pellizco para ver el índice.
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Para eliminar un marcador, púlselo.
No es necesario que añada un marcador de página al cerrar un libro, ya que 
iBooks recuerda dónde dejó la lectura.
Añadir o eliminar un fragmento 
resaltado
Pulse dos veces una palabra, utilice los puntos de selección para ajustar el 
fragmento seleccionado, pulse Resaltar y seleccione un color. 
Para eliminar el resaltado de un texto, pulse el texto resaltado y, a continuación, pulse  . 
Para subrayar palabras, pulse  . 
Para cambiar el color, pulse el texto resaltado, pulse el color actual y, a continuación, seleccione un nuevo color en el menú.
Añadir, eliminar o editar una nota Pulse dos veces una palabra, pulse Resaltar y, a continuación, seleccione 
en el menú que aparece.
Para ver una nota, pulse el indicador de nota que aparece en el margen 
cerca del texto resaltado.
Para eliminar una nota, borre su texto. Para eliminar una nota y su resaltado, 
pulse el texto resaltado y, a continuación, pulse  . 
Para cambiar el color, pulse el texto resaltado y, a continuación, seleccione 
un color en el menú.
Para añadir una nota a un resaltado, pulse el texto resaltado y, a continuación, pulse  .
Ver todos los marcadores Pulse  y, a continuación, pulse Marcadores.
Ver todas las notas Pulse  y, a continuación, pulse Notas.
Ampliar una imagen Pulse dos veces la imagen para acercarla.
Ir a una página determinada Utilice los controles de navegación de páginas de la parte inferior de la 
pantalla. O bien pulse  , introduzca un número de página y, a continuación, pulse el número de página en los resultados de la búsqueda.
Buscar en el contenido de un libro Pulse  . 
Para buscar en Internet, pulse “Buscar en Internet” o “Buscar en Wikipedia”. 
Safari se abrirá y mostrará los resultados.
Buscar otras apariciones de una 
palabra o frase.
Pulse dos veces una palabra, utilice los puntos de selección para ajustar el 
fragmento seleccionado y, a continuación, pulse Buscar en el menú que 
aparece.
Buscar una palabra Pulse dos veces una palabra, utilice los puntos de selección para ajustar el 
fragmento seleccionado y, a continuación, pulse Definir en el menú que 
aparece.
No hay definiciones disponibles para todos los idiomas.
Escuchar un libro Pulse  . 
Esta función no está disponible para todos los libros.
Si tiene problemas de visión, también puede usar VoiceOver para que 
lea el texto de casi cualquier libro en voz alta. Consulte “VoiceOver” en la 
página 156.
iBooks guarda las colecciones, los marcadores, las notas y la información sobre la página actual 
utilizando su ID de Apple para que pueda leer libros sin interrupción en todos sus dispositivos iOS. 
iBooks guarda información de todos sus libros al abrir y al cerrar la app. También se guarda información de los libros individuales al abrir o cerrar los libros.
Activar o desactivar la sincronización  Vaya a Ajustes > iBooks.
Algunos libros también pueden ofrecer acceso a archivos de audio o vídeo almacenados en 
Internet.
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vídeo en línea”.
Nota: Si el iPhone dispone de una conexión de datos de telefonía móvil, el operador puede aplicar tarifas por la reproducción de estos archivos.
Modificación del aspecto de un libro
Algunos libros le permiten cambiar el tamaño de la letra, el tipo y el color de página.
Cambiar el brillo:  Pulse cerca del centro de una página para mostrar los controles y, a continuación, pulse  . Si no ve  , pulse  primero.
Cambiar el tipo o el tamaño de la 
letra:
Pulse cerca del centro de una página para mostrar los controles y, a continuación, pulse  . Pulse “Tipos de letra” para seleccionar un tipo. No todos 
los libros admiten un cambio de tipo de letra.
Algunos libros solo le permiten cambiar el tamaño de la letra cuando el 
iPhone está en orientación vertical.
Cambiar el color de la página y del 
texto
Pulse cerca del centro de una página para mostrar los controles, pulse 
y, a continuación, pulse Tema. Este ajuste se aplica a todos los libros que lo 
admiten.
Activar o desactivar justificación y 
división de palabras
Vaya a Ajustes > iBooks. Algunos libros y documentos PDF no se pueden 
justificar ni dividir silábicamente.
Impresión o envío de un PDF por correo electrónico
Puede usar iBooks para enviar una copia de un PDF por correo electrónico, o para imprimir total o 
parcialmente el PDF en una impresora compatible.
Solo se pueden enviar por correo electrónico o imprimir documentos PDF, no libros.
Enviar un PDF por correo electrónico:  Abra el PDF, pulse  y seleccione “Enviar documento”. 
Aparecerá un nuevo mensaje con el PDF adjunto. Cuando termine de introducir las direcciones de 
los destinatarios y de escribir su mensaje, pulse Enviar.
Imprimir un PDF Abra el PDF, pulse  y seleccione Imprimir. Seleccione una impresora, el 
intervalo de páginas y el número de copias que desee y, a continuación, 
pulse Imprimir. Para obtener más información, consulte “Impresión” en la 
página 29.
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Utilice la estantería para explorar sus libros y documentos PDF. También es posible organizar los 
ítems en colecciones.
Mantenga pulsado un 
libro para reorganizarlo.
Ver colecciones.
Mover un libro o PDF a una colección:  Vaya a la estantería y pulse Editar. Seleccione los ítems 
que desee mover y, a continuación, pulse Trasladar y seleccione una colección.
Cuando añada un libro o PDF a la estantería, aparecerá en su colección Libros o PDF. Desde aquí, 
podrá moverlo a una colección distinta. Es posible que desee crear colecciones para el trabajo y la 
escuela, por ejemplo, o lecturas de consulta o de ocio.
Ver una colección Pulse el nombre de la colección actual en la parte superior de la pantalla y, 
a continuación, elija uno nuevo en la lista que aparece.
Gestionar colecciones Pulse el nombre de la colección actual que esté visualizando, como Libros o 
PDF, para que se muestre la lista de colecciones.
No es posible editar ni eliminar las colecciones integradas Libros y PDF. 
Ordenar la estantería Pulse en la barra de estado o desplácese hasta la parte superior de la pantalla; a continuación, pulse  y seleccione un método de ordenación entre 
las opciones que encontrará en la parte inferior de la pantalla.
Eliminar un ítem de la estantería Pulse Editar y, a continuación, pulse los libros o documentos PDF que desee eliminar para que aparezca una marca de verificación. Pulse Eliminar. 
Cuando acabe, pulse Salir. 
Si borra un libro que ha comprado, puede descargarlo de nuevo en 
Compras en la tienda iBookstore.
Buscar un libro Vaya a la estantería. Pulse la barra de estado para desplazarse a la parte 
superior de la pantalla y, a continuación, pulse  . La búsqueda se realiza 
por el título y el nombre del autor. 
154 Capítulo 30    iBooksAccesibilidad
31
Funciones de Acceso Universal
El iPhone incorpora numerosas funciones de accesibilidad, entre las que se incluyen:
Â VoiceOver
Â Direccionamiento del audio de las llamadas
Â Siri
Â Zoom
Â Texto grande
Â Blanco sobre negro
Â Leer selección
Â Leer texto automático
Â Audio mono y balance
Â Modo de ayuda auditiva (iPhone 4 GSM)
Â Vibraciones personalizadas
Â Parpadeo para las alertas
Â AssistiveTouch
Â Soporte para pantallas Braille
Â Reproducción de contenido con subtítulos
Con la excepción de VoiceOver, estas características de accesibilidad funcionan con la mayoría de 
las apps del iPhone, incluidas las apps de otros fabricantes que pueden descargarse en la tienda 
App Store. VoiceOver funciona con todas las apps preinstaladas en el iPhone, y con muchas apps 
de terceros.
Para obtener más información sobre las características de accesibilidad del iPhone, vaya a www.
apple.com/es/accessibility (España), www.apple.com/mx/accessibility (México) y www.apple.com/
la/accessibility (Latinoamérica).
Es posible activar o desactivar individualmente cada una de las características de accesibilidad en 
los ajustes de Accesibilidad del iPhone. Algunas características también se pueden activar y desactivar desde iTunes cuando el iPhone está conectado al ordenador. 
Activar funciones de accesibilidad con el iPhone:  Vaya a Ajustes > General > Accesibilidad.
Activar funciones de accesibilidad con iTunes:  Conecte el iPhone al ordenador y seleccione 
iPhone en la lista de dispositivos de iTunes. Haga clic en Resumen y, a continuación, haga clic en 
“Configurar Acceso Universal” en la parte inferior de la pantalla Resumen.
La opción “Texto grande” solo puede activarse o desactivarse en los ajustes del iPhone. Consulte 
“Texto grande” en la página 168.
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VoiceOver describe en voz alta los elementos que aparecen en la pantalla, para que pueda utilizar 
el iPhone sin verlo.
VoiceOver informa de cada elemento que se selecciona en la pantalla. Cuando se selecciona un 
elemento, se resalta con un rectángulo de color negro (el cursor de VoiceOver) y VoiceOver pronuncia el nombre del ítem o lo describe.
Toque la pantalla o arrastre los dedos para escuchar distintos ítems de la pantalla. Cuando se selecciona texto, VoiceOver lo lee. Si activa “Leer indicaciones”, VoiceOver puede decirle el nombre 
del ítem y facilitarle instrucciones como, por ejemplo, “pulse dos veces para abrir”. Para interactuar 
con ítems de la pantalla, como botones y enlaces, use los gestos que se describen en “Aprendizaje 
de gestos de VoiceOver” en la página 159.
Al pasar a una nueva pantalla, VoiceOver emite un sonido y selecciona automáticamente el primer 
elemento de la pantalla (normalmente, el ítem situado en la esquina superior izquierda) y lo lee 
en alto. VoiceOver también le informa cuando la pantalla cambia entre las orientaciones vertical y 
horizontal y cuando la pantalla se bloquea y desbloquea.
Nota: VoiceOver habla en el idioma especificado en los ajustes Internacional, un aspecto que puede verse afectado por el ajuste “Formato regional” (Ajustes > General > Internacional > Formato 
regional). VoiceOver está disponible en numerosos idiomas, aunque no en todos.
Configuración de VoiceOver
Importante: VoiceOver cambia los gestos que usted utiliza para controlar el iPhone. Una vez activado, deberá usar los gestos de VoiceOver para controlar el iPhone, incluso para desactivar la 
propia función y reanudar la operación normal.
Nota: No es posible utilizar VoiceOver y Zoom al mismo tiempo.
Activar o desactivar VoiceOver:  Vaya a Ajustes > General > Accesibilidad > VoiceOver. También 
puede ajustar la función “Clic triple en Inicio” para activar o desactivar VoiceOver. Consulte “Clic 
triple en Inicio” en la página 167.
Activar o desactivar las indicaciones 
habladas
Vaya a Ajustes > General > Accesibilidad > VoiceOver. Cuando “Leer indicaciones” está activado, VoiceOver puede decirle la acción del ítem o facilitarle 
instrucciones como, por ejemplo, “pulse dos veces para abrir”. También puede añadir Indicaciones al rotor y, a continuación, desplazarse hacia arriba 
o hacia abajo para realizar ajustes. Consulte “Uso del control de rotor de 
VoiceOver” en la página 160.
Ajustar la velocidad de habla de 
VoiceOver
Vaya a Ajustes > General > Accesibilidad > VoiceOver y arrastre el regulador 
“Velocidad de habla”. También puede añadir “Velocidad de habla” al rotor y, 
a continuación, desplazarse hacia arriba o hacia abajo para realizar ajustes. 
Consulte “Uso del control de rotor de VoiceOver” en la página 160.
Cambiar la función de pronunciar 
al escribir
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Pronunciar al 
escribir.
Alfabeto por palabras en pronunciar al escribir
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Alfabeto por palabras. El texto se leerá carácter por carácter. VoiceOver pronuncia primero 
el carácter y, a continuación, su equivalente fonético; por ejemplo, “f” y después “foxtrot”.
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VoiceOver usa un tono alto al introducir una letra y un tono bajo al eliminar 
una letra. Asimismo, VoiceOver utiliza un tono alto al pronunciar el primer 
ítem de un grupo (como una lista o tabla) y un tono bajo al pronunciar el 
último ítem de un grupo.
Ajustar las opciones del rotor Vaya a Ajustes > General > Accesibilidad > VoiceOver > Rotor. Pulse para 
seleccionar las opciones o anular su selección, o arrastre  hacia arriba 
para cambiar la posición de un ítem.
Cambiar la pronunciación de 
VoiceOver
Ajuste el rotor a Idioma y desplácese hacia arriba o hacia abajo. La posición del rotor de idiomas estará disponible si selecciona más de una 
pronunciación.
Seleccionar las pronunciaciones 
disponibles en el rotor de idiomas
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Rotor de idiomas. 
Para cambiar la posición de un idioma en la lista, arrastre  hacia arriba o 
hacia abajo.
Cambiar el idioma del iPhone Vaya a Ajustes > General > Internacional > Idioma. Algunos idiomas pueden verse afectados por el ajuste “Formato regional” (Ajustes > General > 
Internacional > Formato regional).
Omitir imágenes al navegar Vaya a Ajustes > General > Accesibilidad > VoiceOver > Explorar imágenes. 
Puede seleccionar que se omitan todas las imágenes o solo las que no incluyan descripciones.
Leer notificaciones al desbloquear 
el iPhone
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Leer notificaciones. Si esta opción está desactivada, el iPhone solo leerá la hora cuando lo 
desbloquee.
Uso de VoiceOver
Seleccionar ítems en la pantalla  Arrastre el dedo sobre la pantalla. VoiceOver identificará cada 
elemento que toque. Puede pasar sistemáticamente de un elemento al siguiente desplazando un 
solo dedo hacia la izquierda o hacia la derecha. Los elementos se seleccionan de izquierda a derecha y de arriba abajo. Desplace un dedo hacia la derecha para pasar al siguiente elemento, o hacia 
la izquierda para pasar al anterior.
Activar la navegación vertical Añada “Navegación vertical” al rotor, use el rotor para seleccionarla y, a continuación, desplácese hacia arriba o hacia abajo para trasladarse al ítem situado encima o debajo. Consulte “Uso del control de rotor de VoiceOver” en 
la página 160.
Seleccionar el primer o el último 
elemento de la pantalla
Deslice cuatro dedos hacia arriba o hacia abajo.
Desbloquear el iPhone Seleccione el botón Desbloquear y pulse dos veces en la pantalla.
Seleccionar un ítem por nombre Pulse tres veces con dos dedos en cualquier lugar de la pantalla para abrir 
el “Selector de ítem”. A continuación, escriba un nombre en el campo de 
búsqueda, o desplácese hacia la derecha o hacia la izquierda para moverse 
por la lista alfabética, o pulse el índice alfabético situado a la derecha de la 
lista y desplácese hacia arriba o hacia abajo para moverse rápidamente por 
la lista de ítems.
Cambiar el nombre de un ítem de 
la pantalla para que sea más fácil 
de encontrar
Mantenga pulsados dos dedos en cualquier lugar de la pantalla.
Leer el texto del elemento seleccionado:  Desplácese hacia arriba o hacia abajo con un dedo para 
leer la palabra o el carácter anterior o siguiente (gire el control de rotor para seleccionar caracteres o palabras). Puede incluir la transcripción fonética. Consulte “Configuración de VoiceOver” en la 
página 156.
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la pronunciación. La lectura se reanuda automáticamente al seleccionar 
otro ítem.
Cambiar el volumen de lectura Utilice los botones de volumen del iPhone o añada volumen al rotor y desplácese hacia arriba y hacia abajo para ajustarlo. Consulte “Uso del control 
de rotor de VoiceOver” en la página 160.
Silenciar VoiceOver Pulse dos veces con tres dedos. Vuelva a pulsar dos veces con tres dedos 
para activar el habla de nuevo. Para desactivar únicamente los sonidos de 
VoiceOver, ajuste el interruptor de tono/silencio en Silencio. Si hay un teclado externo conectado, también puede pulsar la tecla Control para activar o 
desactivar el sonido de VoiceOver.
Cambiar la voz de lectura Vaya a Ajustes > General > Accesibilidad > VoiceOver > Usar voz compacta.
Leer todos los elementos de la pantalla desde la parte superior
Desplace dos dedos hacia arriba.
Leer desde el ítem actual hasta el 
final de la pantalla
Desplace dos dedos hacia abajo.
Leer la información de estado del 
iPhone
Pulse la parte superior de la pantalla para escuchar este tipo de información, como la hora, la duración de la batería, la intensidad de la señal Wi-Fi y 
muchos más datos.
“Pulsar” el ítem seleccionado cuando VoiceOver está activado:  Pulse dos veces en cualquier parte de la pantalla.
“Pulsar dos veces” el ítem seleccionado cuando VoiceOver está 
activado
Pulse tres veces en cualquier parte de la pantalla.
Ajustar un regulador Deslice un solo dedo hacia arriba para aumentar el valor, o hacia abajo para 
reducirlo. VoiceOver anunciará el valor a medida que lo ajuste.
Desplazarse por una lista o área de 
la pantalla
Deslice tres dedos hacia arriba o hacia abajo. Deslice el dedo hacia abajo 
para avanzar una página en la lista o pantalla o hacia arriba para retroceder 
una página. Si se está desplazando por las páginas de una lista, VoiceOver 
leerá el intervalo de ítems mostrados (por ejemplo, “mostrando filas 5 a 
10”). También puede desplazarse de modo continuo por una lista, en lugar 
de desplazarse por sus páginas. Pulse dos veces y mantenga la pulsación. 
Cuando oiga una serie de tonos, podrá mover el dedo hacia arriba o hacia 
abajo para desplazarse por la lista. El desplazamiento continuo se detendrá 
cuando suelte el dedo.
Usar un índice de lista Algunas listas incluyen un índice alfabético en la parte derecha de la pantalla. No es posible seleccionar el índice desplazándose entre los elementos; 
es necesario tocar el índice directamente para seleccionarlo. Con el índice 
seleccionado, desplácese hacia arriba o hacia abajo para moverse por el 
índice. También puede pulsar dos veces y deslizar el dedo hacia arriba o 
hacia abajo.
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los ajustes de Accesibilidad, pueden reordenarse. Seleccione  situado a la 
derecha de un ítem, púlselo dos veces y mantenga la última pulsación hasta que oiga un sonido; a continuación, arrástrelo hacia arriba o hacia abajo. 
VoiceOver pronuncia el ítem que ha movido hacia arriba o hacia abajo, 
según la dirección en la que arrastre.
Reorganizar la pantalla de inicio En la pantalla de inicio, seleccione el icono que desee mover. Pulse dos veces el icono y mantenga la pulsación; a continuación, arrástrelo. VoiceOver 
leerá en alto la posición de fila y columna mientras arrastra el icono. Suelte 
el icono cuando esté en la ubicación que desee. Puede arrastrar otros iconos. Arrastre un ítem hacia el lado izquierdo o derecho de la pantalla para 
moverlo a una página distinta de la pantalla de inicio. Cuando termine, pulse el botón de inicio  .
Activar o desactivar la cortina de 
pantalla
Pulse tres veces con tres dedos. Si la cortina de pantalla está activada, el 
contenido de la pantalla estará activo aunque la pantalla esté desactivada.
Desbloquear el iPhone Seleccione el interruptor Desbloquear y pulse dos veces en la pantalla.
Aprendizaje de gestos de VoiceOver
Cuando VoiceOver está activado, los gestos estándar de la pantalla táctil dan lugar a distintos 
efectos. Estos y otros gestos le permiten desplazarse por la pantalla y controlar los elementos individuales seleccionados. Los gestos de VoiceOver incluyen el uso de dos y tres dedos para pulsar 
o desplazar. Para lograr el mejor resultado posible con los gestos de dos y tres dedos, relaje los 
dedos y toque la pantalla dejando algo de espacio entre ellos.
Es posible utilizar gestos estándar cuando VoiceOver está activado; para ello, hay que pulsar dos 
veces y mantener la pulsación sin levantar el dedo de la pantalla. Una serie de tonos indican que 
están activos los gestos normales. Se mantendrán activos hasta que suelte el dedo. A continuación, se reanudarán los gestos de VoiceOver.
Puede utilizar distintas técnicas para introducir gestos de VoiceOver. Por ejemplo, puede introducir una pulsación de dos dedos utilizando dos dedos de una mano o un dedo de cada mano. 
También puede utilizar los pulgares. Muchos usuarios encuentran muy eficaz el gesto de la “pulsación dividida”: en vez de seleccionar un ítem y pulsarlo dos veces, puede pulsar un ítem con un 
dedo, mantenerlo pulsado y, entonces, pulsar la pantalla con otro dedo. Pruebe con distintas técnicas para averiguar cuál es la que mejor le va.
Si sus gestos no funcionan, pruebe realizando movimientos más rápidos, especialmente en el caso 
de los gestos de doble pulsación y desplazamiento. Para desplazarse, pruebe a barrer la pantalla 
rápidamente con el dedo o los dedos. Cuando VoiceOver está activado, aparece el botón “Práctica 
de VoiceOver”, que le da la oportunidad de practicar los gestos de VoiceOver antes de continuar.
Practicar gestos: Vaya a Ajustes > General > Accesibilidad > VoiceOver y, a continuación, pulse 
“Práctica de VoiceOver”. Cuando termine de practicar, pulse Salir.
Si no ve el botón “Práctica de VoiceOver”, asegúrese de que VoiceOver esté activado.
A continuación se muestra un resumen de los gestos más importantes de VoiceOver:
Navegar y leer
Â Pulsación: Pronunciar ítem.
Â Desplazamiento a derecha o izquierda: Seleccionar el siguiente ítem o el ítem anterior.
Â Desplazamiento hacia arriba o hacia abajo: Depende del ajuste del control de rotor. Consulte 
“Uso del control de rotor de VoiceOver” en la página 160.
Â Pulsación con dos dedos: Detener la pronunciación del ítem actual.
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Â Desplazamiento hacia abajo con dos dedos: Leer todo desde la posición actual.
Â Barrido con dos dedos: Mover dos dedos de un lado a otro tres veces rápidamente (dibujando 
una “z”) para descartar una alerta o ir a la pantalla anterior.
Â Triple pulsación con dos dedos: Abrir el “Selector de ítem”.
Â Desplazamiento hacia arriba o hacia abajo con tres dedos: Pasar una página cada vez.
Â Desplazamiento a la derecha o a la izquierda con tres dedos: Ir a la siguiente página o a la página 
anterior (como la pantalla de inicio, Bolsa o Safari).
Â Pulsación con tres dedos: Leer información adicional, como la posición dentro de una lista o si 
hay texto seleccionado.
Â Pulsación con cuatro dedos en la parte superior de la pantalla: Seleccionar el primer ítem de la 
página.
Â Pulsación con cuatro dedos en la parte inferior de la pantalla: Seleccionar el último ítem de la 
página.
Activar
Â Doble pulsación: Activar el ítem seleccionado.
Â Tripe pulsación: Pulsar dos veces un ítem.
Â Pulsación dividida: En lugar de seleccionar un ítem y pulsarlo dos veces, puede pulsar un ítem 
con un dedo y pulsar la pantalla con otro dedo para activar el ítem.
Â Tocar un ítem con un dedo y pulsar la pantalla con otro dedo (“pulsación dividida”): Activar el ítem.
Â Pulsar dos veces y mantener la pulsación (1 segundo) + gesto estándar: Usar un gesto estándar.
El gesto de doble pulsación y mantenimiento indica al iPhone que debe interpretar el siguiente 
gesto como un gesto estándar. Por ejemplo, puede pulsar dos veces y mantener la pulsación y, 
a continuación, sin soltar el dedo, arrastrarlo para regular un interruptor.
Â Doble pulsación con dos dedos: Responder o finalizar una llamada. Reproducir o poner en pausa 
Música, Vídeos, YouTube, Notas de Voz o Fotos. Hacer una fotografía (Cámara). Iniciar o detener 
la grabación de la cámara o las notas de voz. Iniciar o detener el cronómetro.
Â Pulsar dos veces con dos dedos y mantener la pulsación: Abrir el etiquetador de elementos.
Â Triple pulsación con dos dedos: Abrir el “Selector de ítem”.
Â Doble pulsación con tres dedos: Activar o desactivar sonido de VoiceOver.
Â Triple pulsación con tres dedos: Activar o desactivar la cortina de pantalla.
Uso del control de rotor de VoiceOver
El control de rotor es un dial virtual que puede utilizarse para modificar los resultados de los gestos de desplazamiento hacia arriba y hacia abajo cuando VoiceOver está activado.
Funcionamiento de un rotor: Gire dos dedos sobre la pantalla del iPhone alrededor de un punto 
situado entre ambos.
Cambiar las opciones incluidas en el rotor:  Vaya a Ajustes > General > Accesibilidad > VoiceOver 
> Rotor y seleccione las opciones que desee que estén disponibles mediante el uso del rotor.
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mensaje de correo electrónico recibido, puede utilizar el rotor para pasar de escuchar la pronunciación del texto palabra por palabra a carácter por carácter, o viceversa, desplazándose hacia 
arriba o hacia abajo. Si está navegando por una página web, puede utilizar el ajuste de rotor para 
escuchar todo el texto (palabra por palabra o carácter por carácter) o para saltar de un elemento a 
otro de un tipo determinado, como títulos o enlaces.
Lectura de texto
Seleccionar y escuchar texto por:
Â Carácter, palabra o línea
Voz
Ajustar voz de VoiceOver por:
Â Volumen o velocidad
Â Uso de repetición de escritura, cambio de tono o alfabeto por palabras (utilizando un teclado 
inalámbrico Apple Wireless Keyboard)
Consulte “Cómo controlar VoiceOver con un teclado inalámbrico Apple Wireless Keyboard” en la 
página 164.
Navegación
Seleccionar y escuchar ítems por:
Â Carácter, palabra o línea
Â Título
Â Enlace, enlace visitado, enlace no visitado o enlace interno
Â Control de formulario
Â Tabla o fila (cuando se navega por una tabla)
Â Lista
Â Punto de referencia
Â Imagen
Â Texto estático
Â Ítems del mismo tipo
Â Botones
Â Campos de texto
Â Campos de búsqueda
Â Contenedores (regiones de la pantalla, como el Dock)
Acercar o alejar la imagen
Introducción de texto
Mover el punto de inserción y escuchar texto por:
Â Carácter, palabra o línea
Selección de la función de edición
Selección del idioma
Uso de un control 
Seleccionar y escuchar valores por:
Â Carácter, palabra o línea
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Introducción y edición de texto con VoiceOver
Al seleccionar un campo de texto con VoiceOver, puede utilizar el teclado en pantalla o un teclado 
externo conectado al iPhone para introducir texto.
Existen dos maneras de introducir texto en VoiceOver: la escritura normal y la escritura “al tacto”. 
Con la escritura normal, se selecciona una tecla y se pulsa dos veces en la pantalla para introducir 
el carácter correspondiente. Con la escritura al tacto, se toca una tecla para seleccionarla y el carácter se introduce de modo automático al levantar el dedo. La escritura al tacto puede ser más 
rápida, pero requiere más práctica que la escritura normal.
VoiceOver también le permite utilizar las funciones de edición del iPhone para cortar, copiar o pegar en un campo de texto.
Introducir texto:  Seleccione un campo de texto editable, pulse dos veces para mostrar el punto 
de inserción y el teclado en pantalla, y escriba caracteres.
Â Escritura normal: Seleccione una tecla del teclado deslizando un dedo hacia la izquierda o hacia la derecha y pulse dos veces para introducir el carácter. Otra opción consiste en desplazar 
el dedo por el teclado para seleccionar una tecla y, mientras mantiene pulsada la tecla con un 
dedo, pulsar la pantalla con otro dedo. VoiceOver pronuncia la tecla al seleccionarla y vuelve a 
pronunciarla al introducir el carácter.
Â Escritura al tacto: Toque una tecla del teclado para seleccionarla y levante el dedo para introducir el carácter. Si toca una tecla equivocada, desplace el dedo por el teclado hasta que seleccione la tecla deseada. VoiceOver pronuncia el carácter de cada tecla que toca, pero no introducirá 
ningún carácter hasta que levante el dedo.
Nota: La escritura al tacto solo funciona con las teclas que introducen texto. Utilice la escritura 
normal para las demás teclas, como Mayúsculas, Suprimir y Retorno.
Mover el punto de inserción:  Realice un desplazamiento hacia arriba o hacia abajo para mover el 
punto de inserción hacia delante o hacia atrás en el texto. Use el rotor para indicar si desea mover 
el punto de inserción carácter por carácter, palabra por palabra o línea a línea. VoiceOver emite un 
sonido cuando el punto de inserción se mueve, y pronuncia el carácter, la palabra o la línea a donde se ha desplazado el punto de inserción. 
Al avanzar por palabras, el punto de inserción se coloca al final de cada palabra, antes del espacio 
o signo de puntuación posterior a la palabra. Al retroceder, el punto de inserción se coloca al final 
de la palabra precedente, antes del espacio o signo de puntuación posterior a aquella. Para colocar el punto de inserción detrás del signo de puntuación del final de una palabra o frase, utilice 
el rotor para volver al modo de caracteres. Al mover el punto de inserción línea a línea, VoiceOver 
pronuncia cada una de las líneas mientras se desplaza. Al avanzar, el punto de inserción se coloca 
al principio de la siguiente línea (excepto cuando se alcanza la última línea de un párrafo: en ese 
caso, el punto de inserción se coloca al final de la línea que acaba de pronunciarse). Al retroceder, 
el punto de inserción se coloca al principio de la línea pronunciada.
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tacto
Si VoiceOver está activado y hay una tecla seleccionada en el teclado, utilice 
el rotor para seleccionar el tipo de escritura y, a continuación, deslice el 
dedo hacia arriba o hacia abajo.
Eliminar un carácter Seleccione  y pulse dos veces o realice una pulsación dividida. Debe 
hacerlo así incluso en el modo de escritura al tacto. Para eliminar varios 
caracteres, mantenga pulsada la tecla Suprimir y pulse la pantalla con otro 
dedo una vez por cada carácter que desee borrar. VoiceOver pronunciará 
el carácter mientras lo elimina. Si la opción “Cambio de tono” está activada, 
VoiceOver pronuncia los caracteres eliminados en un tono más bajo.
Seleccionar texto Ajuste el rotor a Edición, desplácese hacia arriba o hacia abajo para elegir 
entre Seleccionar o “Seleccionar todo” y, a continuación, pulse dos veces. 
Si elige Seleccionar, se seleccionará la palabra situada más cerca del punto 
de inserción al pulsar dos veces. Si elige “Seleccionar todo”, se seleccionará 
todo el texto. Pellizque hacia fuera o hacia dentro para ampliar o reducir la 
selección.
Cortar, copiar o pegar Asegúrese de que el rotor esté ajustado en el modo de edición. Con texto 
seleccionado, desplácese hacia arriba o hacia abajo para seleccionar Cortar, 
Copiar o Pegar y, a continuación, pulse dos veces.
Deshacer Agite el iPhone, desplácese hacia la izquierda o hacia la derecha para seleccionar la acción que desee deshacer y, a continuación, pulse dos veces.
Introducir un carácter acentuado En el modo de escritura normal, seleccione el carácter sin acento y, a continuación, pulse dos veces y mantenga la pulsación hasta que oiga un sonido 
que indique la aparición de caracteres acentuados. Arrastre hacia la izquierda o hacia la derecha para seleccionar y escuchar las opciones. Suelte el 
dedo para introducir la selección actual.
Cambiar el idioma en el que está 
escribiendo
Ajuste el rotor a Idioma y desplácese hacia arriba o hacia abajo. Seleccione 
“Idioma por omisión” para utilizar el idioma especificado en los ajustes 
Internacional. El rotor de idiomas solo aparece si selecciona más de un idioma en el ajuste “Rotor de idiomas” de VoiceOver. Consulte “Configuración de 
VoiceOver” en la página 156.
Realizar llamadas telefónicas con VoiceOver
Pulse dos veces en la pantalla con dos dedos para responder a una llamada o finalizarla. Al establecer una llamada con VoiceOver activado, la pantalla muestra por omisión el teclado numé-
rico en lugar de las opciones de llamada. De este modo, resulta más fácil utilizar el teclado para 
responder a un menú de opciones cuando establezca comunicación con un sistema telefónico 
automatizado.
Mostrar las opciones de llamada: Seleccione el botón Ocultar en la esquina inferior derecha y 
pulse dos veces.
Volver a mostrar el teclado numérico: Seleccione el botón Teclado situado cerca del centro de la 
pantalla y pulse dos veces.
Uso de VoiceOver con Safari
Cuando realice búsquedas en Internet con Safari y la opción VoiceOver activada, los ítems del rotor “Resultados de la búsqueda” le permitirán escuchar la lista de las frases de búsqueda sugeridas.
Buscar en Internet:  Seleccione el campo de búsqueda, introduzca lo que desee buscar y, a continuación, seleccione “Resultados de la búsqueda” utilizando el rotor. Desplácese hacia la derecha o 
hacia la izquierda para moverse hacia abajo o hacia arriba en la lista y, a continuación, pulse dos 
veces la pantalla para buscar en Internet la frase de búsqueda actual.
Uso de VoiceOver con Mapas
Puede utilizar VoiceOver para acercar o alejar la imagen, seleccionar marcadores y obtener información sobre ubicaciones.
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a continuación, desplácese hacia arriba o hacia abajo para acercar o alejar la imagen.
Seleccionar un marcador: Toque un marcador o desplácese hacia arriba o hacia abajo para moverse de un ítem a otro. 
Obtener información sobre una ubicación: Con un marcador seleccionado, pulse dos veces para 
mostrar el indicador de información. Desplácese hacia la izquierda o hacia la derecha para seleccionar el botón “Más información” y, a continuación, pulse dos veces para mostrar la página de 
información.
Edición de vídeos y notas de voz con VoiceOver
Puede utilizar gestos de VoiceOver para acortar los vídeos de la cámara y las grabaciones de notas 
de voz.
Acortar una nota de voz: En la pantalla “Notas de voz”, seleccione el botón situado a la derecha 
de la nota que desee acortar y, a continuación, pulse dos veces. Después, seleccione “Acortar nota” 
y pulse dos veces. Seleccione el comienzo o el final de la herramienta Acortar. Desplácese hacia 
arriba para arrastrar a la derecha, o hacia abajo para arrastrar a la izquierda. VoiceOver indicará la 
cantidad de tiempo que la posición actual acortará de la grabación. Para efectuar el acortamiento, 
seleccione “Acortar nota de voz” y pulse dos veces.
Cortar un vídeo: Mientras visualiza un vídeo en Fotos, pulse dos veces la pantalla para mostrar los 
controles de vídeo y, a continuación, seleccione el comienzo o el final de la herramienta Acortar. 
A continuación, desplácese hacia arriba para arrastrar a la derecha, o hacia abajo para arrastrar a 
la izquierda. VoiceOver indicará la cantidad de tiempo que la posición actual acortará de la grabación. Para realizar el acortamiento, seleccione Cortar y pulse dos veces.
Cómo controlar VoiceOver con un teclado inalámbrico Apple Wireless Keyboard
Puede controlar VoiceOver en el iPhone utilizando un teclado inalámbrico Apple Wireless 
Keyboard. Consulte “Teclado inalámbrico Apple Wireless Keyboard” en la página 28.
Puede utilizar los comandos de teclado de VoiceOver para desplazarse por la pantalla, seleccionar 
ítems, leer el contenido de la pantalla, ajustar el rotor y realizar otras acciones de VoiceOver. Todos 
los comandos de teclado (excepto uno) incluyen Control + Opción, que aparece abreviado como 
“CO” en la siguiente tabla. 
La Ayuda VoiceOver lee en alto las teclas o los comandos de teclado mientras los escribe. Puede 
usar la Ayuda VoiceOver para obtener información acerca de la disposición del teclado y de las 
acciones asociadas a las distintas combinaciones de teclas. 
Comandos de teclado de VoiceOver
CO = Control + Opción
Leer todo, comenzando por la posición actual
CO + A
Leer desde la parte superior CO + B
Desplazarse a la barra de estado CO + M
Pulsar el botón de inicio CO + H
Seleccionar el siguiente ítem o el 
ítem anterior
CO + flecha derecha o CO + flecha izquierda
Pulsar un ítem CO + barra espaciadora
Pulsar dos veces con dos dedos CO + “-”
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rotor o el ítem del rotor anterior
CO + flecha arriba o CO + flecha abajo
Seleccionar el siguiente ítem del 
rotor de habla o el ítem del rotor 
de habla anterior
CO + Comando + flecha izquierda o CO + Comando + flecha derecha
Ajustar ítem del rotor de habla CO + Comando + flecha arriba o CO + Comando + flecha abajo
Activar o desactivar sonido de 
VoiceOver
CO + S
Activar o desactivar la cortina de 
pantalla
CO + Mayúsculas + S
Activar la Ayuda VoiceOver CO + K
Volver a la pantalla anterior o desactivar la Ayuda VoiceOver
Esc
Navegación rápida
Active la función de navegación rápida para controlar VoiceOver con las flechas de dirección. La 
función de navegación rápida está desactivada por omisión.
Activar o desactivar la función de 
navegación rápida
Flecha izquierda + flecha derecha
Seleccionar el siguiente ítem o el 
ítem anterior
Flecha derecha o flecha izquierda
Seleccionar el siguiente ítem o el 
ítem anterior especificado por el 
ajuste de rotor
Flecha arriba o flecha abajo
Seleccionar el primer ítem o el último ítem
Control + flecha arriba o Control + flecha abajo
“Pulsar” un ítem Flecha arriba + flecha abajo
Desplazarse hacia arriba, hacia 
abajo, hacia la izquierda o hacia la 
derecha
Opción + flecha arriba, Opción + flecha abajo, Opción + flecha izquierda u 
Opción + flecha derecha
Cambiar el rotor Flecha arriba + flecha izquierda o flecha arriba o + flecha derecha
También puede utilizar las teclas de números de un teclado inalámbrico de Apple para marcar un 
número de teléfono en Teléfono o introducir números en Calculadora.
Navegación rápida de una sola letra para Internet
Cuando visualice una página web con la función de navegación rápida activada, puede utilizar las 
siguientes teclas del teclado para desplazarse rápidamente por la página. Al pulsar la tecla se trasladará al siguiente ítem del tipo indicado. Mantenga pulsada la tecla Mayúsculas mientras escribe 
la letra para trasladarse al ítem anterior.
H Título
L Enlace
R Campo de texto
B Botón
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I Imagen
T Tabla
S Texto estático
W Punto de referencia ARIA
X Lista
M Elemento del mismo tipo
1 Cabecera de nivel 1
2 Cabecera de nivel 2
3 Cabecera de nivel 3
4 Cabecera de nivel 4
5 Cabecera de nivel 5
6 Cabecera de nivel 6
Uso de una pantalla Braille con VoiceOver
Puede utilizar una pantalla Braille Bluetooth para leer en Braille la salida de texto de VoiceOver, y 
puede utilizar una pantalla Braille con teclas de entrada y otros controles para controlar el iPhone cuando VoiceOver está activado. El iPhone es compatible con muchos modelos de pantallas 
Braille inalámbricas. Puede consultar una lista de las pantallas compatibles en www.apple.com/es/
accessibility/iphone/braille-display.html.
Configurar una pantalla Braille:  Encienda la pantalla y, a continuación, vaya a Ajustes > General 
> Bluetooth y active Bluetooth. Después, vaya a Ajustes > General > Accesibilidad > VoiceOver > 
Braille y seleccione la pantalla.
Active o desactive el Braille 
abreviado
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Braille.
Activar o desactivar el Braille de 
ocho puntos
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Braille.
Para obtener información sobre comandos comunes de Braille para la navegación en VoiceOver, 
así como para obtener información específica de determinadas pantallas, vaya a http://support.
apple.com/kb/HT4400?viewlocale=es_ES.
La pantalla Braille utiliza el idioma especificado para “Control por voz”. Normalmente se trata del 
idioma ajustado para el iPhone en Ajustes > Internacional > Idioma. Puede usar el ajuste de idioma de VoiceOver para ajustar otro idioma para VoiceOver y para las pantallas Braille.
Ajustar el idioma para VoiceOver: Vaya a Ajustes > General > Internacional > “Control por voz” y, 
a continuación, seleccione el idioma.
Si cambia el idioma del iPhone, es posible que deba volver a ajustar el idioma para VoiceOver y la 
pantalla Braille.
Puede usar la celda del extremo izquierdo o derecho de la pantalla Braille para ver el estado del 
sistema y demás información:
Â El historial de avisos contiene un mensaje no leído
Â El mensaje actual del historial de avisos no se ha leído
Â El habla de VoiceOver está silenciada
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Â El iPhone está en orientación horizontal
Â La pantalla está apagada
Â La línea actual contiene texto adicional a la izquierda
Â La línea actual contiene texto adicional a la derecha
Ajustar la celda del extremo izquierdo o derecho para que muestre información de estado:
Vaya a Ajustes > General > Accesibilidad > VoiceOver > Braille > “Celda de estado” y pulse 
Izquierda o Derecha. 
Ver una descripción ampliada de la celda de estado: En la pantalla Braille, pulse el botón posicionador de la celda de estado.
Cómo dirigir el audio de las llamadas entrantes
Puede hacer que el audio de las llamadas entrantes se envíe a unos auriculares con micrófono o 
altavoz en lugar de enviarse al receptor del iPhone.
Redirigir el audio de las llamadas:  Vaya a Ajustes > General > Accesibilidad > “Llamadas entrantes” y seleccione dónde desea escuchar sus llamadas.
Siri
Con Siri, puede realizar operaciones con su iPhone simplemente pidiéndoselo, y VoiceOver puede 
leerle las respuestas de Siri. Para obtener información, consulte Capítulo 4,“Siri,” en la página 41.
Clic triple en Inicio
La función “Clic triple en Inicio” proporciona un modo sencillo de activar o desactivar algunas de 
las funciones de accesibilidad cuando se pulsa el botón de inicio  tres veces rápidamente. Puede 
ajustar la función “Clic triple en Inicio” para:
Â Activar o desactivar VoiceOver
Â Activar o desactivar “Blanco sobre negro”
Â Activar o desactivar el zoom
Â Activar o desactivar AssistiveTouch
También puede ajustar la función “Clic triple en Inicio” para presentar la opción de activar o desactivar VoiceOver, “Blanco sobre negro” o el zoom. La función “Clic triple en Inicio” está desactivada 
por omisión.
Ajustar la función “Clic triple en Inicio”: Vaya a Ajustes > General > Accesibilidad > Clic triple en 
Inicio.
Zoom
Muchas apps del iPhone le permiten acercar o alejar elementos concretos. Por ejemplo, en Safari 
puede pulsar dos veces o usar el gesto de pellizcar para ampliar las columnas de una página web. 
El zoom también es una prestación de accesibilidad especial que le permite ampliar la pantalla 
completa de cualquier app que esté usando para ayudarle a ver lo que hay en la pantalla.
Cuando se usa el zoom con un teclado inalámbrico Apple Wireless Keyboard (consulte “Teclado 
inalámbrico Apple Wireless Keyboard” en la página 28), la imagen de la pantalla sigue al punto de 
inserción, manteniéndolo centrado en la pantalla.
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“Clic triple en Inicio”. Consulte “Clic triple en Inicio” en la página 167.
Nota: No es posible utilizar VoiceOver y Zoom al mismo tiempo.
Acercar o alejar la imagen Pulse dos veces la pantalla con tres dedos. Por omisión, la pantalla se amplía un 200%. Si varía manualmente la magnificación (mediante el gesto de 
pulsar y arrastrar descrito más adelante), el iPhone vuelve automáticamente 
a dicha magnificación al acercar la imagen pulsando dos veces con tres 
dedos.
Aumentar magnificación Con tres dedos, pulse y arrastre hacia la parte superior de la pantalla (para 
aumentar la magnificación) o hacia la parte inferior (para reducirla). El gesto de pulsar y arrastrar es similar al de pulsar dos veces, salvo que tras la 
segunda pulsación no se levantan los dedos, sino que se arrastran sobre la 
pantalla. Una vez empiece a arrastrar, puede hacerlo con un solo dedo.
Desplazarse por la pantalla Cuando la pantalla está ampliada, arrastre o desplace tres dedos por la 
misma. Una vez que empiece a arrastrar, puede hacerlo con un solo dedo 
para así ver una mayor superficie de la pantalla. Mantenga un único dedo 
cerca del borde de la pantalla para desplazarse hacia ese lado de la imagen. 
Acerque el dedo al borde para desplazarse a mayor velocidad. Al abrir una 
nueva pantalla, el zoom siempre se dirige a la mitad superior de la pantalla.
Texto grande
La opción “Texto grande” le permite aumentar el tamaño del texto en las alertas y en Calendario, 
Contactos, Mail, Mensajes y Notas.
Ajustar el tamaño del texto: Vaya a Ajustes > General > Accesibilidad > Texto grande.
Blanco sobre negro
Use “Blanco sobre negro” para invertir los colores de la pantalla del iPhone, lo que puede facilitar 
la lectura de la pantalla. Cuando esta opción está activada, la pantalla parece el negativo de una 
fotografía.
Invertir los colores de la pantalla: Vaya a Ajustes > General > Accesibilidad > Blanco sobre negro.
Leer selección
Incluso con VoiceOver desactivado, puede hacer que el iPhone lea en voz alta cualquier texto que 
seleccione.
Active la opción “Leer selección” y ajuste la velocidad de habla :  Vaya a Ajustes > General > 
Accesibilidad > Leer selección.
Hacer que el texto se lea para usted Seleccione el texto y pulse Voz.
Leer texto automático
“Leer texto automático” lee las correcciones de texto y las sugerencias que el iPhone realiza mientras escribe.
Activar o desactivar “Leer texto automático”: Vaya a Ajustes > General > Accesibilidad > Leer 
texto automático.
“Leer texto automático” también funciona con VoiceOver o Zoom.
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“Audio mono” combina los canales izquierdo y derecho en una señal mono que se repite a través 
de ambos canales. Puede ajustar el balance de la señal mono para aumentar el volumen de salida 
a la derecha o a la izquierda.
Activar o desactivar “Audio mono”: Vaya a Ajustes > General > Accesibilidad > Audio mono.
Compatibilidad con audífonos
La Comisión Federal de Comunicaciones (FCC, por sus siglas en inglés) ha adoptado la normativa 
de compatibilidad con audífonos (HAC) para los teléfonos inalámbricos digitales. Esta normativa 
exige que determinados teléfonos se sometan a pruebas y se evalúen conforme a los estándares de compatibilidad con audífonos C63.19-2007 del Instituto Nacional Estadounidense de 
Normalización (ANSI, por sus siglas en inglés). El estándar ANSI para la compatibilidad con audífonos incluye dos clasificaciones posibles: “M” para que la interferencia de radiofrecuencia reducida 
permita el acoplamiento acústico con los audífonos que no funcionan en modo telecoil, y “T” para 
el acoplamiento inductivo con audífonos que funcionan en modo telecoil. Estas clasificaciones 
están basadas en una escala del uno al cuatro, donde cuatro indica la máxima compatibilidad. Se 
considera que un teléfono es compatible con audífonos según la normativa de la FCC si tiene un 
valor de M3 o M4 para el acoplamiento acústico y de T3 o T4 para el acoplamiento inductivo.
Para consultar los valores actuales de compatibilidad con audífonos del iPhone, vaya a www.
apple.com/support/hac.
Los valores de compatibilidad con audífonos no garantizan la compatibilidad de un audífono en 
concreto con un teléfono determinado. Es posible que algunos audífonos funcionen bien con 
teléfonos que no cumplan determinados valores. Para garantizar la interoperabilidad entre un audífono y un teléfono, utilícelos conjuntamente antes de realizar ninguna compra.
Modo de ayuda auditiva
El iPhone 4 GSM incluye un modo de ayuda auditiva que, cuando se activa, puede reducir la interferencia con algunos modelos de audífonos. El modo de ayuda auditiva reduce la potencia de 
transmisión de las radiocomunicaciones móviles en la banda de 1900 MHz de GSM, y puede dar 
lugar a una reducción de la cobertura móvil 2G.
Activar “Modo de ayuda auditiva” (iPhone 4 GSM): Vaya a Ajustes > General > Accesibilidad.
Vibraciones personalizadas
Puede asignar secuencias de vibración especiales a llamadas de teléfono o llamadas FaceTime de 
contactos importantes. Seleccione entre las secuencias existentes o cree secuencias nuevas.
Activar vibraciones personalizadas:  Vaya a Ajustes > General > Accesibilidad > Vibraciones 
personalizadas.
Seleccionar la secuencia de vibración de un contacto
En Contactos, seleccione un contacto y, a continuación, pulse “Vibración”. 
Si no ve ninguna vibración en la información del contacto, pulse Editar y 
añádala.
Crear una nueva secuencia de 
vibración
Si ya está editando un contacto, pulse “Vibración” y, a continuación, pulse 
“Crear nueva vibración”. También puede ir a Ajustes > Sonidos > Vibración > 
Crear nueva vibración
Ajustar una secuencia personalizada por omisión
Vaya a Ajustes > Sonidos > Vibración y seleccione una vibración.
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Si no puede oír los sonidos que anuncian las llamadas entrantes y otras alertas, puede hacer 
que el indicador luminoso del iPhone parpadee (el indicador se encuentra junto a la lente de la 
cámara, en la parte posterior del iPhone). Solo funciona con el iPhone bloqueado o en reposo. 
Disponible para el iPhone 4 o posterior.
Activar “Parpadeo para las alertas”:  Vaya a Ajustes > General > Accesibilidad > Parpadeo para las 
alertas.
AssistiveTouch
AssistiveTouch le ayuda a usar el iPhone si tiene dificultades para tocar la pantalla o pulsar 
los botones. Puede usar un accesorio de adaptación compatible (como un joystick) junto con 
AssistiveTouch para controlar el iPhone. También puede utilizar AssistiveTouch sin ningún accesorio para realizar gestos que le resulten complicados.
Activar AssistiveTouch:  Vaya a Ajustes > General > Accesibilidad > AssistiveTouch. También puede ajustar la función “Clic triple en Inicio” para activar o desactivar AssistiveTouch; vaya a Ajustes > 
General > Accesibilidad > Clic triple en Inicio.
Ajustar la velocidad del cursor Vaya a Ajustes > General > Accesibilidad > AssistiveTouch > Velocidad del 
cursor.
Mostrar u ocultar el menú 
AssistiveTouch
Haga clic en el botón secundario de su accesorio.
Ocular el botón de menú Vaya a Ajustes > General > Accesibilidad > AssistiveTouch > Mostrar menú 
siempre.
Realice un movimiento de desplazamiento o arrastre con 2, 3, 4 o 5 
dedos
Pulse el botón de menú, pulse Gestos y, a continuación, pulse el número 
de dígitos necesarios para realizar el gesto. Cuando aparezcan los círculos 
correspondientes en la pantalla, realice un movimiento de desplazamiento 
o arrastre en la dirección requerida por el gesto. Cuando acabe, pulse el 
botón de menú.
Realizar un gesto de pellizco Pulse el botón de menú, pulse Favoritos y, a continuación, pulse Pellizcar. 
Cuando aparezcan los círculos de pellizco, pulse en cualquier parte de la 
pantalla para mover los círculos de pellizco y, a continuación, arrastre los 
círculos de pellizco hacia dentro o hacia fuera para realizar un gesto de 
pellizco. Cuando acabe, pulse el botón de menú.
Crear su propio gesto Pulse el botón de menú, pulse Favoritos y, a continuación, pulse un marcador de gesto vacío. También puede ir a Ajustes > General > Accesibilidad > 
AssistiveTouch > “Crear gesto personalizado”.
Bloquear o girar la pantalla, ajustar 
el volumen, alternar tono/silencio o 
simular agitación del iPhone
Pulse el botón de menú y, a continuación, pulse Dispositivo.
Simular pulsación del botón de 
inicio
Pulse el botón de menú y, a continuación, pulse Inicio.
Mover el botón de menú Arrástrelo a cualquier ubicación de la pantalla.
Salir de un menú sin realizar ningún gesto
Pulse en cualquier lugar situado fuera del menú.
Acceso Universal en OS X
Aproveche la función Acceso Universal de OS X cuando utilice iTunes para sincronizar información 
y contenido de su biblioteca de iTunes con el iPhone. En el Finder, seleccione Ayuda > “Centro de 
ayuda” y busque “acceso universal”.
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www.apple.com/es/accessibility, www.apple.com/mx/accessibility (México) y www.apple.com/la/
accessibility (Latinoamérica).
Compatibilidad TTY
Puede utilizar el cable adaptador TTY para el iPhone (a la venta por separado en muchas áreas) 
para conectar el iPhone a un teletipo (TTY). Vaya a www.apple.com/es/store o http://store.apple.
com/mx/ (puede que no esté disponible en todas las áreas) o compruébelo en su tienda Apple 
habitual.
Conectar el iPhone a un teletipo:  Vaya a Ajustes > Teléfono y active la opción TTY. Después, conecte el iPhone al equipo TTY mediante el adaptador TTY para el iPhone.
Cuando TTY está activado en el iPhone, aparece  en la barra de estado de la parte superior de 
la pantalla. Para obtener información sobre cómo usar un determinado equipo TTY, consulte la 
documentación del dispositivo.
Tamaño de letra mínimo para los mensajes de Mail
Para aumentar la legibilidad, puede ajustar el tamaño de letra mínimo para el texto de los mensajes de Mail a Grande, Enorme o Gigante.
Ajustar el tamaño de letra mínimo para los mensajes de Mail:  Vaya a Ajustes > Correo, contactos, calendarios > Tamaño letra mínimo.
El ajuste “Texto grande” invalida este tamaño de letra mínimo.
Tonos asignables
Puede asignar tonos de llamada distintivos a las diferentes personas de su lista de contactos para 
utilizarlos como identificadores de llamada sonoros. Puede adquirir tonos en la tienda iTunes 
Store desde el iPhone. Consulte “Cómo comprar música, audiolibros y tonos” en la página 125.
Buzón de voz visual
Los controles de reproducción y pausa en el buzón de voz visual le permiten controlar la reproducción de mensajes. Arrastre el cursor de reproducción en la barra de reproducción para repetir 
una parte del mensaje que le cueste entender. Consulte “Cómo consultar el buzón de voz” en la 
página 66.
Teclados panorámicos
Varias apps, como Mail, Safari, Mensajes, Notas y Contactos, le permiten girar el iPhone al escribir, 
de modo que pueda utilizar un teclado mayor.
Teclado de teléfono grande
Realice llamadas pulsando las entradas en sus listas de contactos y favoritos. Si desea marcar un 
número, el gran teclado numérico del iPhone se lo pone fácil. Consulte “Llamadas telefónicas” en 
la página 60.
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La función “Control por voz” le permite realizar llamadas de teléfono y controlar la reproducción 
de música mediante comandos de voz. Consulte “Marcación por voz” en la página 61 y “Cómo utilizar Siri o “Control por voz” con Música” en la página 85.
Con subtítulos
Activar subtítulos para vídeos:  Vaya a Ajustes > Vídeo > Con subtítulos.
No todos los contenidos de vídeo incluyen subtítulos.
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El menú Ajustes le permite configurar el iPhone, ajustar opciones de apps, añadir cuentas e introducir otras preferencias.
Modo Avión
El modo Avión desactiva las funciones inalámbricas para reducir la posible producción de interferencias que obstaculicen el funcionamiento del avión y otros equipos eléctricos.
Activar el modo Avión:  Vaya a Ajustes y active el modo Avión.
Cuando el modo Avión está activado, aparece  en la barra de estado de la parte superior de la 
pantalla. Se dejan de emitir señales de teléfono, Wi-Fi o Bluetooth desde el iPhone y se desactiva 
la recepción GPS. No podrá utilizar las apps o las funciones que dependan de estas señales, como 
conectarse a Internet, realizar y recibir llamadas telefónicas y mensajes, consultar el buzón de voz 
visual, etc. 
Si el operador del avión y la legislación y regulaciones aplicables lo permiten, podrá seguir utilizando el iPhone para escuchar música, ver vídeos, consultar su correo electrónico, calendario y 
otros datos previamente recibidos, y utilizar apps que no requieran conexión a Internet.
Si hay una conexión Wi-Fi disponible y el operador del avión y la legislación o normativa aplicable 
lo permite, vaya a Ajustes > Wi-Fi para activarla. Puede activar Bluetooth en Ajustes > General > 
Bluetooth.
Wi-Fi
Conexión a redes Wi-Fi
Los ajustes Wi-Fi determinan cuándo el iPhone utiliza redes Wi-Fi locales para conectarse a 
Internet. Cuando el iPhone está conectado a una red Wi-Fi, el icono Wi-Fi  situado en la barra 
de estado de la parte superior de la pantalla muestra la intensidad de la señal. Cuantas más barras 
haya, más intensa será la señal. Si no hay redes Wi-Fi disponibles o si ha desactivado la conexión 
Wi-Fi, el iPhone se conectará a Internet a través de la red de datos de telefonía móvil cuando dicha red esté disponible.
Una vez que se conecte a una red Wi-Fi, el iPhone se conectará automáticamente a ella siempre 
que esté en su radio de alcance. Si hay más de una red anteriormente utilizada dentro del radio 
de alcance, el iPhone se conectará a la última empleada.
También puede utilizar el iPhone para configurar una nueva estación base AirPort que proporcione servicios Wi-Fi a su hogar u oficina. Consulte “Configuración de una estación base AirPort” en la 
página 174.
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Ajustar el iPhone para que pregunte si desea acceder a una red nueva
Vaya a Ajustes > Wi-Fi y active o desactive la opción “Preguntar al conectar”.
Si la opción “Preguntar al conectar” está desactivada, deberá acceder manualmente a una red para conectarse a Internet cuando no esté disponible 
ninguna red utilizada previamente.
Omitir una red para que el iPhone 
no se conecte
Vaya a Ajustes > Wi-Fi y pulse  junto a una red a la que se haya conectado anteriormente. A continuación, pulse “Omitir esta red”.
Conectarse a una red Wi-Fi cerrada Para conectarse a una red Wi-Fi que no aparezca en la lista de redes detectadas, vaya a Ajustes > Wi-Fi > Otra y, a continuación, introduzca el nombre 
de la red.
Debe conocer de antemano el nombre, contraseña y tipo de seguridad de 
la red para conectarse a una red cerrada.
Especificar los ajustes para conectarse a una red Wi-Fi
Vaya a Ajustes > Wi-Fi y pulse  junto a una red. Puede ajustar un proxy 
HTTP, definir ajustes de red estática, activar BootP o renovar los ajustes proporcionados por un servidor DHCP.
Configuración de una estación base AirPort
Una estación base AirPort proporciona una conexión Wi-Fi a la red de su hogar, escuela o peque-
ña empresa. Puede utilizar el iPhone para configurar una nueva estación base AirPort Express, 
AirPort Extreme o Time Capsule. 
Utilizar el Asistente Configuración Airport:  Vaya a Ajustes > Wi-Fi. Bajo “Configurar una estación 
base AirPort”, pulse el nombre de la estación base que desee configurar. A continuación, siga las 
instrucciones que aparecen en pantalla.
Algunos modelos antiguos de estaciones base AirPort no pueden configurarse utilizando un dispositivo iOS. Para ver las instrucciones de configuración, consulte la documentación que acompa-
ñaba a la estación base.
Si la estación base que desea configurar no aparece en la lista, asegúrese de que esté recibiendo 
alimentación, de que se encuentre dentro del radio de alcance y de que aún no se haya configurado. Solo podrá configurar estaciones base que sean nuevas o que se hayan restaurado.
Si su estación base AirPort ya está configurada, la app Utilidad AirPort de la tienda App Store le 
permitirá cambiar sus ajustes y controlar su estado en el iPhone.
Notificaciones
Las notificaciones “push” aparecen en el centro de notificaciones y le alertan de novedades, aunque una app no se esté ejecutando. Estas notificaciones varían con cada app, aunque pueden 
incluir alertas de texto o sonido, así como un globo con un número en el icono de la app en la 
pantalla de inicio.
Puede desactivar las notificaciones si no desea ser informado, y puede cambiar el orden en que 
aparecen las notificaciones.
Activar o desactivar las notificaciones:  Vaya a Ajustes > Notificaciones. Pulse un ítem de la lista y 
active o desactive las notificaciones para dicho ítem.
Las apps que tienen desactivadas las notificaciones se muestran en la lista “Fuera del centro de 
notificaciones”.
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notificaciones
Vaya a Ajustes > Notificaciones y seleccione un ítem en la lista “En el centro 
de notificaciones”. Pulse Mostrar para ajustar cuántas notificaciones de este 
tipo deben aparecer en el centro de notificaciones.
Cambiar los estilos de alerta Vaya a Ajustes > Notificaciones y seleccione un ítem en la lista “En el centro 
de notificaciones”. Seleccione un estilo de alerta o seleccione Ninguna para 
desactivar las alertas y las tiras. Las notificaciones seguirán apareciendo en 
el centro de notificaciones.
Cambiar el orden de las 
notificaciones
Vaya a Ajustes > Notificaciones y, a continuación, pulse Editar. Arrastre las 
notificaciones en el orden que desee. Para desactivar una notificación, arrástrela a la lista “Fuera del centro de notificaciones”.
Mostrar globos numerados en apps 
con notificaciones
Vaya a Ajustes > Notificaciones, seleccione un ítem en la lista “En el centro 
de notificaciones” y active “Globos en los iconos”.
Ocultar alertas cuando el iPhone 
esté bloqueado
Vaya a Ajustes > Notificaciones y seleccione una app en la lista “En el centro 
de notificaciones”. Desactive “Ver en la pantalla bloqueada” para ocultar 
alertas de la app cuando el iPhone esté bloqueado.
Algunas apps incluyen opciones adicionales. Por ejemplo, Mensajes le permite especificar cuántas 
veces debe repetirse el sonido de alerta y si deben mostrarse previsualizaciones del mensaje en la 
notificación.
Localización
Los servicios de localización permiten que apps como Recordatorios, Mapas, Cámara y apps de 
otros fabricantes basadas en información de localización obtengan y empleen información relativa a su ubicación geográfica. Los datos de ubicación recopilados por Apple se obtienen de un 
modo que no permite identificarle de forma personal. Su posición aproximada se determina empleando la información disponible en las redes de datos de telefonía móvil, las redes Wi-Fi locales 
(si Wi-Fi está activado) y el sistema GPS (puede que no esté disponible en todas las áreas). Para 
conservar batería, desactive los servicios de localización cuando no los utilice.
Si una app está usando los servicios de localización,  aparecerá en la barra de menús.
Todas las apps y servicios del sistema que utilicen los servicios de localización aparecerán en la 
pantalla de ajustes de Localización, mostrando si los servicios de localización están activados o 
desactivados para cada app o servicio. Si no desea utilizar los servicios de localización, puede 
desactivarlos para algunas de las apps y algunos de los servicios, o para todos. Si desactiva los servicios de localización, el sistema le pedirá que vuelva a activarlos la próxima vez que una app o un 
servicio intente utilizarlos.
Si utiliza apps de otros fabricantes en el iPhone que utilizan servicios de localización, revise las 
condiciones y la política de privacidad de dicho fabricante para entender el modo en que cada 
app utiliza sus datos de ubicación.
Activar o desactivar los servicios de localización:  Vaya a Ajustes > Localización.
VPN
Las VPN se utilizan en empresas para poder comunicar información privada de forma segura a 
través de una red no privada. Por ejemplo, puede necesitar configurar una VPN para acceder al 
correo electrónico de su trabajo. Este ajuste aparece cuando se ha configurado una red privada 
virtual o VPN en el iPhone y le permite activarla o desactivarla. Consulte “Red” en la página 178.
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Puede usar Compartir Internet (iPhone 4 o posterior) para compartir una conexión a Internet con 
un ordenador u otro dispositivo Wi-Fi, como un iPod touch, un iPad u otro iPhone, conectado a su 
iPhone a través de Wi-Fi. También puede usar Compartir Internet para compartir una conexión a 
Internet con un ordenador conectado al iPhone a través de Bluetooth o USB. Compartir Internet 
solo funcionará si el iPhone está conectado a Internet a través de una red de datos de telefonía 
móvil.
Nota: Puede que esta función no esté disponible en todas las áreas. Pueden aplicarse tarifas 
adicionales. Póngase en contacto con su operador de telefonía para obtener más información al 
respecto.
Compartir una conexión a Internet:  Vaya a Ajustes > General > Red y, a continuación, pulse 
“Configurar Compartir Internet” (si aparece) para configurar el servicio con su operador.
Después de activar Compartir Internet, otros dispositivos podrán conectarse de las siguientes 
formas:
Â Wi-Fi:  En el dispositivo, seleccione su iPhone en la lista de redes Wi-Fi disponibles.
Â USB:  Conecte el ordenador al iPhone utilizando el cable de conector Dock a USB. En el panel de 
preferencias Red de su ordenador, seleccione iPhone y configure los ajustes de red.
Â Bluetooth:  En el iPhone, vaya a Ajustes > General > Bluetooth y active Bluetooth. Para enlazar y 
conectar el iPhone a su dispositivo, consulte la documentación que acompañaba al ordenador.
Cuando haya un dispositivo conectado, en la parte superior de la pantalla del iPhone aparecerá 
una banda de color azul. Compartir Internet permanecerá activado cuando se conecte mediante 
USB, aunque no esté utilizando de forma activa la conexión a Internet.
Nota: El icono de Compartir Internet  se muestra en la barra de estado de los dispositivos iOS 
que usan la función Compartir Internet.
Cambiar la contraseña Wi-Fi del 
iPhone
Vaya a Ajustes > Compartir Internet > “Contraseña Wi-Fi” e introduzca una 
contraseña de al menos 8 caracteres. 
Supervisar el uso de la red de datos 
de telefonía móvil
Vaya a Ajustes > General > Uso > “Uso de la red móvil”.
Operador
En las redes GSM, este ajuste aparece cuando se encuentra fuera de la red de su operador habitual y hay otras redes de datos de operadores locales que puede utilizar para sus llamadas de 
teléfono, el buzón de voz visual y las conexiones a Internet a través de redes de telefonía móvil. 
Solo podrá realizar llamadas con los operadores que tengan activo un contrato de itinerancia con 
su operador. Pueden aplicarse tarifas adicionales. El otro operador puede aplicarle tarifas de itinerancia a través de su operador.
Seleccionar un operador:  Vaya a Ajustes > Operador y, a continuación, seleccione la red que desee utilizar.
Una vez seleccionada la red, el iPhone solo usará dicha red. Si la red no se encuentra disponible, se 
mostrará la frase “Sin servicio” en el iPhone.
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Puede ajustar el iPhone para que reproduzca un sonido siempre que reciba un mensaje de texto, 
un mensaje de correo electrónico, una llamada, un mensaje de Twitter, un mensaje en el buzón 
de voz o un recordatorio. También pueden reproducirse sonidos para citas, envío de mensajes de 
correo electrónico, clics del teclado y cuando bloquee el iPhone.
Cuando está en modo de silencio, el iPhone no emite ningún tono, alerta, ni efecto de sonido. No 
obstante, sí que se emiten las alarmas de Reloj y otros sonidos.
Cambiar entre los modos de tono y silencio:  Deslice el interruptor de tono/silencio situado en el 
lateral del iPhone.
Nota: En algunas áreas, los efectos de sonido de Cámara y Notas de Voz se reproducen aunque el 
interruptor de tono/silencio esté en la posición Silencio.
Especificar si el iPhone vibrará al 
recibir una llamada
Vaya a Ajustes > Sonidos.
Modificar el volumen de los tonos 
y alertas
Vaya a Ajustes > Sonidos y arrastre el regulador. O bien, si está activada la 
opción “Ajustar con botones”, use los botones de volumen del lateral del 
iPhone. 
Cambiar el volumen de otros 
sonidos
Utilice los botones de volumen de lateral del iPhone.
Ajustar el tono de llamada Vaya a Ajustes > Sonidos > “Tono de llamada”.
Ajustar los sonidos de los tonos y 
alertas
Vaya a Ajustes > Sonidos y seleccione tonos para los ítems en la lista.
Brillo
El brillo de la pantalla afecta a la duración de la batería. Oscurezca la pantalla para aumentar 
el tiempo que transcurrirá antes de que necesite recargar el iPhone o utilice la función “Brillo 
automático”.
Ajustar el brillo de la pantalla: Vaya a Ajustes > Brillo y arrastre el regulador.
Indicar si el iPhone ajustará el brillo 
de la pantalla automáticamente
Vaya a Ajustes > Brillo y active o desactive “Brillo automático”. Si “Brillo automático” está activado, el iPhone ajusta el brillo de la pantalla según las 
condiciones de iluminación de cada momento utilizando el sensor de luz 
ambiental integrado.
Fondo de pantalla
Los ajustes de “Fondo de pantalla” le permiten establecer una imagen o foto como fondo de pantalla de la pantalla de bloqueo o de la pantalla de inicio. Consulte “Añadir un fondo de pantalla” en 
la página 24.
General
Los ajustes generales incluyen la configuración de red, el uso compartido, la seguridad y otros 
ajustes de iOS. En este panel de ajustes también puede encontrar información sobre su iPhone y 
restablecer varios de los ajustes del iPhone.
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Vaya a Ajustes > General > Información para obtener información sobre el iPhone, como el espacio de almacenamiento disponible, números de serie, direcciones de red, IMEI (identidad internacional de equipo móvil) e ICCID (identificador de tarjeta con circuito integrado, o tarjeta inteligente) (GSM), MEID (identificador de equipos móviles) (CDMA) e información legal y regulatoria.
Cambiar el nombre del dispositivo:  Vaya a Ajustes > General > Información y, a continuación, 
pulse Nombre.
El nombre del dispositivo aparecerá en la barra lateral cuando se conecte a iTunes y lo utilice 
iCloud.
Actualización de Software
Actualización de Software le permite descargar e instalar actualizaciones de iOS desde Apple. 
Actualizar a la última versión de iOS:  Vaya a Ajustes > General > Actualización de Software.
Si hay una nueva versión disponible de iOS, siga las instrucciones que aparecen en pantalla para 
descargar e instalar la actualización.
Nota: Asegúrese de que el iPhone esté conectado a una fuente de alimentación para que la instalación, que puede durar varios minutos, se complete correctamente.
Uso
Uso le permite ver el uso de la red móvil, el estado de la batería y el espacio de almacenamiento 
disponible. También puede ver y gestionar el almacenamiento de iCloud.
Ver el uso de la red móvil, el estado de la batería y el espacio de almacenamiento disponible:  Vaya a Ajustes > General > Uso.
Ver su uso de la red móvil Vaya a Ajustes > General > Uso > “Uso de la red móvil”.
Gestionar el almacenamiento de 
iCloud
Vaya a Ajustes > General > Uso > “Gestionar almacenamiento”. Puede ver y 
eliminar copias de seguridad, así como desactivar la copia de seguridad de 
su Carrete. También comprar más espacio de almacenamiento para iCloud.
Para obtener información, consulte “iCloud” en la página 17.
Ver el espacio de almacenamiento 
de las apps
Vaya a Ajustes > General > Uso. Se muestra el espacio de almacenamiento 
total de todas las apps instaladas. Para obtener más detalles, pulse el nombre de la app.
Reinicializar las estadísticas de uso Vaya a Ajustes > General > Uso > “Uso de la red móvil” y, a continuación, 
pulse “Restablecer estadísticas” para borrar los datos y las estadísticas de 
tiempo acumuladas. 
Mostrar el porcentaje de carga de 
la batería
Vaya a Ajustes > General > Uso y active “Carga de la batería”.
Siri
Activar Siri:  Vaya a Ajustes > General > Siri. 
Para obtener información sobre cómo utilizar Siri y cómo cambiar los ajustes de Siri, consulte 
“Cómo ajustar las opciones de Siri” en la página 44.
Red
Use los ajustes de Red para configurar una conexión VPN (red privada virtual), acceder a los ajustes Wi-Fi o activar y desactivar la itinerancia de datos de telefonía móvil.
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orden, hasta que establece conexión:
Â Se conecta a través de la última red Wi-Fi  utilizada que se encuentre disponible.
Â Muestra una lista de las redes Wi-Fi situadas en el radio de alcance y se conecta utilizando la 
que usted elige.
Â Se conecta a través de la red de datos de telefonía móvil, si está disponible.
Si el iPhone se conecta a Internet a través de la red de datos de telefonía móvil, en la barra de estado aparecerá el icono  ,  ,  o  .
Las redes de datos de telefonía móvil 4G y 3G GSM aceptan comunicaciones simultáneas de voz 
y datos. Con todas las demás conexiones de telefonía móvil, no podrá usar servicios de Internet 
mientras habla por teléfono a menos que el iPhone también disponga de una conexión Wi-Fi 
a Internet. En función de la conexión de red de que disponga, es posible que no pueda recibir 
llamadas mientras el iPhone transfiere datos a través de la red de datos de telefonía móvil (por 
ejemplo, mientras descarga una página web).
Redes GSM:  Con una conexión EDGE o GPRS, es posible que las llamadas entrantes vayan directamente al buzón de voz durante las operaciones de transferencia de datos. Cuando responda a las 
llamadas entrantes, se pausarán las operaciones de transferencia de datos.
CDMA:  Con conexiones EV-DO, las operaciones de transferencia de datos se detendrán momentáneamente cuando responda a las llamadas entrantes. Con conexiones 1xRTT, es posible que las 
llamadas entrantes vayan directamente al buzón de voz durante las operaciones de transferencia 
de datos. Cuando responda a las llamadas entrantes, se pausarán las operaciones de transferencia 
de datos.
La transferencia de datos se reanudará cuando finalice la llamada.
Activar o desactivar los datos de telefonía móvil:  Vaya a Ajustes > General > Red y, a continuación, active o desactive “Datos móviles”. 
Si los datos de telefonía móvil están desactivados, todos los servicios de datos utilizarán únicamente la conexión Wi-Fi, incluidos los servicios de correo electrónico, navegación web, notificaciones “push” y otros. Si los datos de telefonía móvil están activados, el operador puede aplicar tarifas. 
Por ejemplo, determinadas funciones y servicios transfieren datos (como Siri y Mensajes), y el uso 
de estas funciones y servicios podría influir en las tarifas de su plan de datos.
Activar o desactivar “Itinerancia de 
voz” (CDMA)
Vaya a Ajustes > General > Red. Desactive “Itinerancia de voz” para evitar 
gastos derivados del uso de las redes de otros operadores. Cuando la red 
de su operador no esté disponible, el iPhone no dispondrá de servicio de 
telefonía móvil (datos o voz).
Activar o desactivar la itinerancia 
de datos
Vaya a Ajustes > General > Red.
La itinerancia de datos permite el acceso a Internet a través de una red de 
datos de telefonía móvil cuando se encuentra en una zona situada fuera de 
la red de su operador. Cuando esté de viaje, puede desactivar la itinerancia 
de datos para impedir la facturación de tarifas de itinerancia. Consulte 
“Operador” en la página 176.
Activar o desactivar 3G Vaya a Ajustes > General > Red. Esta opción no está disponible en todas las 
áreas.
El uso de 3G permite cargar datos de Internet con más rapidez en algunos 
casos, pero puede reducir el rendimiento de la batería. Si realiza muchas 
llamadas de teléfono, es probable que prefiera desactivar 3G para que la 
batería dure más.
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Internet”
Vaya a Ajustes > General > Red > “Compartir Internet”. Consulte “Compartir 
Internet” en la página 176.
Añadir una nueva configuración 
VPN
Vaya a Ajustes > General > Red > VPN > “Añadir configuración VPN”.
Consulte al administrador de red qué ajustes utilizar. En la mayoría de los 
casos, si configura una VPN en su ordenador, podrá utilizar los mismos ajustes VPN para el iPhone. 
Consulte “VPN” en la página 175.
Bluetooth
El iPhone puede conectarse de forma inalámbrica a dispositivos Bluetooth, como dispositivos 
manos libres, auriculares y kits de coche, para poder escuchar música y hablar sin necesidad de 
emplear las manos. También puede conectar el teclado inalámbrico Apple Wireless Keyboard con 
Bluetooth. Consulte “Teclado inalámbrico Apple Wireless Keyboard” en la página 28.
Activar o desactivar Bluetooth:  Vaya a Ajustes > General > Bluetooth y active o desactive 
Bluetooth.
Conectarse a un dispositivo 
Bluetooth
Pulse el dispositivo en la lista Dispositivos y siga las instrucciones que aparecen en la pantalla para conectarse al mismo. Consulte la documentación 
del dispositivo para obtener instrucciones sobre el enlace Bluetooth.
Sincronización con iTunes vía Wi-Fi
Puede sincronizar el iPhone con iTunes en un ordenador que esté conectado a la misma red Wi-Fi.
Activar “Sincr. con iTunes vía Wi-Fi”:  Para configurar la sincronización Wi-Fi por primera vez, conecte el iPhone al ordenador con el que desee realizar la sincronización. Para obtener instrucciones al respecto, consulte “Sincronización con iTunes” en la página 18.
Después de configurar la sincronización Wi-Fi, el iPhone se sincronizará automáticamente con iTunes, una vez al día, cuando se conecte a una fuente de alimentación y:
Â El iPhone y el ordenador estén conectados a la misma red Wi-Fi.
Â iTunes se esté ejecutando en su ordenador.
Consultar la fecha y hora de la última sincronización
Vaya a Ajustes > General > “Sincr. con iTunes vía Wi-Fi”.
Sincronizar inmediatamente con 
iTunes
Vaya a Ajustes > General > “Sincr. con iTunes vía Wi-Fi” y, a continuación, 
pulse “Sincronizar ahora”.
Búsqueda en Spotlight
El ajuste “Búsqueda en Spotlight” le permite especificar las áreas de contenido en las que deben 
realizarse las búsquedas con Buscar, así como reordenar los resultados.
Establecer las áreas de contenido en las que se realizarán las búsquedas con Buscar:  Vaya a 
Ajustes > General > “Búsqueda en Spotlight” y, a continuación, seleccione los ítems que desee 
buscar.
Ajustar el orden de las categorías 
de resultados
Vaya a Ajustes > General > “Búsqueda en Spotlight”. Pulse  situado junto 
a un ítem y arrástrelo hacia arriba o hacia abajo. 
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Bloquear el iPhone apaga la pantalla para ahorrar batería y evitar un uso no deseado del iPhone. 
Puede seguir recibiendo llamadas y mensajes de texto, así como ajustar el volumen y usar el botón del micrófono de los auriculares del iPhone mientras está escuchando música o durante una 
llamada. 
Ajustar el tiempo que transcurre antes de que el iPhone se bloquea: Vaya a Ajustes > General > 
“Bloqueo automático” y, a continuación, seleccione un periodo de tiempo.
Bloqueo con código
Por omisión, el iPhone no requiere que se introduzca un código para desbloquearlo.
Establecer un código: Vaya a Ajustes > General > “Bloqueo con código” y establezca un código 
de 4 dígitos. 
Si olvida el código, deberá restablecer el software del iPhone. Consulte “Actualización y restauración del software del iPhone” en la página 191.
Desactivar el bloqueo con código o 
cambiar el código
Vaya a Ajustes > General > “Bloqueo con código”.
Ajustar el tiempo que transcurrirá 
antes de solicitar el código
Vaya a Ajustes > General > “Bloqueo con código” e introduzca su código. Pulse Solicitar y seleccione cuánto tiempo debe esperar el iPhone 
después de bloquearse para solicitarle el código que le permita volver a 
desbloquearse.
Activar o desactivar el código 
simple
Vaya a Ajustes > General > “Bloqueo con código”. 
Un código simple es un número de cuatro dígitos. Para aumentar la seguridad, desactive el código simple y use un código más largo con una combinación de números, letras, signos de puntuación y caracteres especiales.
Impedir el acceso a Siri cuando el 
iPhone esté bloqueado
Vaya a Ajustes > General > Bloqueo con código > Siri. Consulte “Cómo ajustar las opciones de Siri” en la página 44.
Activar o desactivar la marcación 
por voz
Vaya a Ajustes > General > “Bloqueo con código”.
Desactivar “Marcación por voz” impide que se realicen llamadas cuando el 
iPhone está bloqueado. Este ajuste solo se encuentra disponible cuando Siri 
está desactivado. Para obtener información sobre cómo marcar utilizando 
Siri, consulte “Teléfono” en la página 46.
Borrar datos después de introducir 
un código equivocado diez veces
Vaya a Ajustes > General > “Bloqueo con código” y pulse “Borrar datos”. 
Después de introducir un código equivocado diez veces, se restablecerán 
todos los ajustes y se borrarán todos los datos y contenidos eliminando la 
clave de encriptación de los datos (que están encriptados mediante el sistema de encriptación AES de 256 bits).
Restricciones
Puede fijar restricciones para determinadas apps y contenido comprado. Por ejemplo, los padres 
pueden evitar que la música con letras para adultos aparezca en las listas de reproducción, así 
como desactivar completamente el acceso a YouTube.
Activar las restricciones:  Vaya a Ajustes > General > Restricciones y pulse “Activar restricciones”.
Importante: Si olvida el código, deberá restablecer el software del iPhone. Consulte “Actualización 
y restauración del software del iPhone” en la página 191.
Puede establecer las siguientes restricciones:
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Safari para navegar por la red o acceder a clips web.
YouTube YouTube está desactivado y su icono no aparece en la pantalla de inicio.
Cámara Cámara está desactivado y su icono no aparece en la pantalla de inicio. No podrá hacer fotos.
FaceTime No podrá realizar ni recibir videollamadas FaceTime.
iTunes La tienda iTunes Store está desactivada y su icono no aparece en la pantalla de inicio. No puede 
previsualizar, adquirir o descargar contenido.
Ping No podrá acceder a Ping ni a ninguna de sus funciones.
Instalación de 
apps
La App Store está desactivada y su icono no aparece en la pantalla de inicio. No es posible instalar apps en el iPhone.
Eliminación de 
apps
No es posible eliminar apps del iPhone.  no aparece en los iconos de las apps al personalizar 
la pantalla de inicio.
Siri No podrá utilizar Siri. Los comandos de voz y la función de dictado están desactivados.
Lenguaje 
explícito
Siri intentará sustituir las palabras explícitas que diga por asteriscos o pitidos.
Lugar Desactive la función Localización para cada app concreta. También puede bloquear la función 
Localización para que no puedan realizarse cambios en los ajustes, como autorizar el uso de los 
servicios por parte de otras apps.
Cuentas Los ajustes actuales de “Correo, contactos, calendarios” están bloqueados. No es posible añadir, 
modificar ni eliminar cuentas. Tampoco es posible modificar los ajustes de iCloud.
Compras 
integradas
Desactive “Compras integradas”. Cuando esta función esté activada, le permitirá adquirir contenido o funciones adicionales a través de las apps que descargue desde la tienda App Store.
Solicitar 
contraseñas
Le solicita que introduzca su ID de Apple para las compras integradas una vez transcurrido el 
periodo de tiempo que especifique.
Establecer restricciones de 
contenido
Pulse “Puntuaciones para” y, a continuación, seleccione un país de la lista. Puede establecer restricciones utilizando el sistema de puntuación de dicho país para música, podcasts, películas, 
programas de televisión y apps. El contenido que no se ajuste a la puntuación seleccionada no 
se mostrará en el iPhone.
Juegos 
multijugador
Si la opción “Juegos multijugador” está desactivada, no podrá solicitar partidas, enviar o recibir 
invitaciones para jugar ni añadir amigos a Game Center.
Añadir amigos Si la opción “Añadir amigos” está desactivada, no podrá enviar ni recibir solicitudes de amistad 
en Game Center. Si está activada la opción “Juegos multijugador”, podrá seguir jugando con sus 
amigos existentes.
Fecha y hora
Estos ajustes afectan a la hora indicada en la barra de estado de la parte superior de la pantalla, a 
los relojes internacionales y a los calendarios.
Indicar si el iPhone mostrará la hora en formato de 24 o 12 horas: Vaya a Ajustes > General > 
“Fecha y hora” y, a continuación, active o desactive “Reloj de 24 horas”. (Es posible que la opción 
“Reloj de 24 horas” no esté disponible en todas las áreas.) 
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fecha y la hora automáticamente
Vaya a Ajustes > General > “Fecha y hora” y, a continuación, active o desactive “Ajuste automático”.
Si el iPhone se ajusta para que actualice la hora de forma automática, obtendrá la hora correcta a través de la red de datos de telefonía móvil y la 
actualizará para la zona horaria en la que se encuentre.
Algunos operadores no ofrecen el servicio horario de red en todas las áreas. 
Si está de viaje, es posible que el iPhone no pueda ajustar automáticamente 
la hora local.
Ajustar la fecha y la hora de forma 
manual
Vaya a Ajustes > General > “Fecha y hora” y, a continuación, desactive 
“Ajuste automático”. Pulse “Zona horaria” para ajustar su zona horaria. Pulse 
el botón “Fecha y hora”, pulse “Ajustar fecha y hora” e introduzca dichos 
datos.
Teclado
Puede activar teclados para escribir en distintos idiomas, y puede activar y desactivar distintas 
funciones de escritura, como la comprobación ortográfica. Para obtener información sobre el teclado, consulte “Escritura” en la página 25.
Para obtener información sobre los teclados internacionales, consulte Apéndice A,“Teclados internacionales,” en la página 185.
Internacional
Utilice los ajustes Internacional para configurar el idioma del iPhone, activar teclados para distintos idiomas y especificar el formato local para fechas, horas y números de teléfono.
Ajustar el idioma del iPhone: Vaya a Ajustes > General > Internacional > Idioma.
Ajustar el formato del calendario Vaya a General > Internacional > Calendario y, a continuación, seleccione el 
formato.
Ajustar el idioma para Siri y 
“Control por voz”
Vaya a Ajustes > General > Internacional > “Control por voz” y, a continuación, seleccione un idioma.
Ajustar los formatos de fecha, hora 
y número de teléfono
Vaya a Ajustes > General > Internacional > Región y, a continuación, seleccione su país.
El formato regional también determina el idioma que debe utilizarse para 
los días y meses que aparecen en las apps.
Accesibilidad
Para activar las funciones de accesibilidad, seleccione Accesibilidad y, a continuación, seleccione 
las funciones que desee activar. Consulte Capítulo 31,“Accesibilidad,” en la página 155.
Perfiles
Este ajuste aparecerá si instala uno o varios perfiles en el iPhone. Pulse Perfiles para ver la información sobre los perfiles instalados.
Restablecer
Puede restablecer el diccionario de teclado, los ajustes de red, la disposición de la pantalla de inicio y los avisos de localización. También puede borrar todo su contenido y ajustes.
Borrar todo el contenido y los ajustes:  Vaya a Ajustes > General > Restablecer y, a continuación, 
pulse “Borrar contenidos y ajustes”.
Después de confirmar que desea restablecer el iPhone, se eliminará todo el contenido, los datos y 
los ajustes. El iPhone no podrá utilizarse hasta que vuelva a configurarse.
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Todas sus preferencias y ajustes se restablecerán.
Restablecer los ajustes de red Vaya a Ajustes > General > Restablecer y pulse “Restablecer ajustes de red”.
Cuando restablezca los ajustes de red, se eliminarán la lista de redes utilizadas previamente y los ajustes VPN no instalados por un perfil de configuración. El sistema Wi-Fi se desactivará y se volverá a activar, con lo que se 
desconectará de cualquier red a la que esté conectado. Los ajustes “Wi-Fi” y 
“Preguntar al conectar” permanecen activados.
Para eliminar ajustes VPN instalados por un perfil de configuración, vaya 
a Ajustes > General > Perfil y, a continuación, seleccione el perfil y pulse 
Eliminar. Esta operación también elimina otros ajustes o cuentas proporcionados por el perfil.
Restablecer el diccionario del 
teclado
Vaya a Ajustes > General > Restablecer y pulse “Restablecer diccionario del 
teclado”.
Puede añadir palabras al diccionario rechazando las palabras que el iPhone 
sugiere al escribir. Pulse una palabra para rechazar la corrección y añadir 
la palabra al diccionario del teclado. Restablecer el diccionario del teclado 
borra todas las palabras que ha añadido.
Restablecer la disposición de la 
pantalla de inicio
Vaya a Ajustes > General > Restablecer y, a continuación, pulse “Restablecer 
pantalla de inicio”.
Restablecer los avisos de 
localización
Vaya a Ajustes > General > Restablecer y pulse “Restablecer avisos 
localización”.
Los avisos de localización son solicitudes efectuadas por las apps para utilizar los servicios de localización. El iPhone presenta un aviso de localización 
para una app la primera vez que la app realiza una solicitud para usar el 
servicio de localización. Si pulsa Cancelar como respuesta, la solicitud no 
volverá a aparecer. Para restablecer los avisos de localización de modo que 
vea una solicitud para cada app, pulse “Restablecer avisos localización”.
Ajustes de apps
Consulte otros capítulos para obtener información sobre ajustes de apps. Por ejemplo, para los 
ajustes de Safari, consulte Capítulo 7,“Safari,” en la página 78.
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A Apéndice
“Teclados internacionales” le permite escribir texto en muchos idiomas distintos, incluidos idiomas 
asiáticos y aquellos que se leen de derecha a izquierda.
Cómo añadir y eliminar teclados
Para escribir en distintos idiomas en el iPhone, se utilizan distintos teclados. Por omisión, solo 
estará disponible el teclado correspondiente al idioma que haya establecido. Para que haya otros 
teclados disponibles para otros idiomas, utilice los ajustes de Teclado. Para consultar una lista 
de todos los teclados compatibles con el iPhone, vaya a www.apple.com/es/iphone/specs.html
(España), www.apple.com/mx/iphone/specs.html (México) y www.apple.com/la/iphone/specs.
html (Latinoamérica). 
Añadir un teclado:  Vaya a Ajustes > General > Internacional, pulse Teclados y, a continuación, seleccione un teclado de la lista. Repita la operación para añadir más teclados.
Eliminar un teclado:  Vaya a Ajustes > General > Internacional > Teclados y, a continuación, pulse 
Editar. Pulse  junto al teclado que desee eliminar y, a continuación, pulse Eliminar.
Editar su lista de teclados:  Vaya a Ajustes > General > Internacional > Teclados. Pulse Editar y, a 
continuación, arrastre  junto a un teclado para moverlo a una nueva posición en la lista.
Cómo cambiar de teclado
Para introducir texto en otro idioma, cambie de teclado.
Cambiar de teclado mientras escribe:  Mantenga pulsada la tecla de globo terráqueo  para 
mostrar todos los teclados activados. Para seleccionar un teclado, desplace el dedo hasta el nombre del teclado y, a continuación, suelte el dedo. La tecla de globo terráqueo  se muestra al activar más de un teclado.
También puede pulsar  . Cuando pulse  , aparecerá brevemente el nombre del teclado recién 
activado. Mantenga la pulsación para acceder a otros teclados activados.
Muchos teclados incluyen letras, números y símbolos que no son visibles en el teclado.
Introducir letras acentuadas u otros caracteres alternativos:  Mantenga pulsada la letra, el número o el símbolo relacionado y, a continuación, deslice el dedo para seleccionar una variante. En un 
teclado tailandés, por ejemplo, puede seleccionar sus números nativos manteniendo pulsados los 
números arábigos correspondientes.
Chino
Puede utilizar teclados para escribir en chino de varias formas distintas, como pinyin, cangjie, wubihua y zhuyin. También puede usar el dedo para escribir caracteres chinos en la pantalla.
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Utilice el teclado QWERTY para escribir pinyin simplificado o tradicional. A medida que escriba, 
aparecerán sugerencias de caracteres. Pulse una sugerencia para seleccionarla o continúe escribiendo para ver más opciones.
Si sigue escribiendo pinyin sin espacios, aparecerán sugerencias de frases.
Cómo escribir utilizando cangjie
Construya caracteres chinos a partir de las teclas cangjie componentes. A medida que escriba, 
aparecerán sugerencias de caracteres. Pulse un carácter para seleccionarlo o continúe escribiendo 
hasta cinco componentes para ver más opciones de caracteres.
Cómo escribir utilizando trazos (wubihua)
Utilice el teclado para construir caracteres chinos a partir de un máximo de cinco trazos en la secuencia correcta de escritura: horizontal, vertical, cola, escoba y gancho. Por ejemplo, el carácter 
chino ? (círculo) debe comenzar con el trazo vertical ?.
A medida que escribe, aparecen sugerencias de caracteres, con los caracteres más utilizados en 
primer lugar. Pulse un carácter para seleccionarlo.
Si no está seguro del trazo correcto, escriba un asterisco (*). Para ver más opciones de caracteres, 
realice otro trazo o desplácese por la lista de caracteres.
Pulse la tecla de coincidencia (??) para mostrar solamente caracteres que coincidan exactamente con lo que ha escrito. 
Cómo escribir utilizando zhuyin
Utilice el teclado para introducir letras zhuyin. A medida que escribe, aparecerán caracteres chinos 
sugeridos. Pulse una sugerencia para seleccionarla o continúe escribiendo letras zhuyin para ver 
más opciones. Después de escribir la letra inicial, el teclado cambia para mostrar más letras.
Si sigue escribiendo zhuyin sin espacios, aparecerán sugerencias de frases. 
Cómo dibujar caracteres chinos
Cuando los formatos simplificado o tradicional de la escritura china están activados, puede dibujar 
o escribir caracteres chinos en la pantalla con el dedo. A medida que realice trazos, el iPhone los 
reconocerá y mostrará una lista de caracteres concordantes ordenados de mayor a menor concordancia. Cuando selecciona un carácter, los caracteres que le siguen con más probabilidad aparecen en la lista como opciones adicionales.
Pantalla táctil
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Kong), ?? (ascensor) y ? (partícula que se utiliza en cantonés), pueden escribirse introduciendo 
dos o más de los caracteres que los componen en secuencia. Pulse el carácter para sustituir los 
caracteres escritos. 
También se reconocen los caracteres romanos.
Cómo convertir chino simplificado en chino tradicional y viceversa
Seleccione el carácter o los caracteres que desee convertir y pulse Sustituir. Consulte “Edición de 
texto” en la página 27. Puede escribir una frase entera antes de convertirla.
Japonés
Puede escribir en japonés utilizando los teclados romaji o kana. También puede introducir emoticonos japoneses.
Cómo escribir japonés kana
Utilice el teclado kana para seleccionar sílabas. Para ver más opciones de sílabas, pulse la tecla de 
flecha y seleccione otra sílaba o palabra de la ventana.
Cómo escribir japonés romaji
Use el teclado romaji para escribir sílabas: En la parte superior del teclado aparecen opciones 
alternativas; pulse una para escribirla. Para ver más opciones de sílabas, pulse la tecla de flecha y 
seleccione otra sílaba o palabra de la ventana. 
Cómo introducir emoticonos japoneses
Si utiliza el teclado japonés kana, pulse la tecla ^_^.
En el teclado japonés romaji (disposición QWERTY japonesa), pulse la tecla Número  y, a continuación, pulse la tecla ^_^. 
En los teclados chinos pinyin (simplificado o tradicional) o zhuyin (tradicional), pulse la tecla 
Símbolos  y, a continuación, pulse la tecla ^_^.
Cómo escribir caracteres emoji
Utilice el teclado emoji para añadir caracteres de imagen. También puede escribir caracteres emoji 
utilizando el teclado japonés. Por ejemplo, escriba ??? para obtener ?.
Cómo usar la lista de candidatos
A medida que escribe en los teclados chino, japonés o árabe, aparecen sugerencias de caracteres 
o candidatos en la parte superior del teclado. Pulse un candidato para introducirlo o desplácese a 
la izquierda para ver más candidatos.
Utilizar la lista de candidatos ampliada:  Pulse la flecha arriba situada a la derecha para ver la lista 
completa de candidatos. Deslice el dedo hacia arriba o hacia abajo para desplazarse por la lista. 
Pulse la flecha abajo para regresar a la lista corta.
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Cuando se usan determinados teclados chinos o japoneses, es posible crear una función rápida para parejas de palabras y entradas. La función rápida se añade a su diccionario personal. Al 
escribir una función rápida utilizando un teclado compatible, la pareja de palabra o entrada asociada sustituirá dicha función rápida. Las funciones rápidas están disponibles para los siguientes 
teclados:
Â Chino simplificado (Pinyin)
Â Chino tradicional (Pinyin)
Â Chino tradicional (Zhuyin)
Â Japonés (Romaji)
Â Japonés (Kana)
Activar o desactivar las funciones rápidas:  Vaya a Ajustes > General > Teclado > Funciones 
rápidas.
Vietnamita
Mantenga pulsado un carácter para ver los signos diacríticos disponibles y, después, desplácese 
para seleccionar el signo deseado.
También puede pulsar las siguientes secuencias de teclas para introducir caracteres con signos 
diacríticos:
Â aa—â (a con acento circunflejo)
Â aw—a (a con acento carón)
Â as—á (a con acento agudo)
Â af—à (a con acento grave)
Â ar—? (a con interrogante)
Â ax—ã (a con tilde)
Â aj—? (a con punto por debajo)
Â dd—d (d con guión)
Â ee—ê (e con acento circunflejo)
Â oo—ô (o con acento circunflejo)
Â ow—o (o con garfio)
Â w—u (u con garfio)
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Sitio web de soporte del iPhone
Dispone de un completo portal con información de soporte en Internet, en la dirección support.
apple.com/es_ES/manuals/iphone/ (España y Latinoamérica) o support.apple.com/es_MX/
manuals/iphone/ (México). También puede usar Express Lane para obtener soporte personalizado 
(no disponible en todas las áreas). Vaya a expresslane.apple.com.
Reinicio o restauración del iPhone
Si hay algo que no funciona correctamente, pruebe a reiniciar el iPhone, forzar la salida de una 
app o restablecer el iPhone.
Reiniciar el iPhone: Mantenga pulsado el botón de encendido/apagado hasta que aparezca el 
regulador rojo. Deslice el dedo por el regulador para apagar el iPhone. Para volver a encender el 
iPhone, mantenga pulsado el botón de encendido/apagado hasta que aparezca el logotipo de 
Apple.
Forzar el cierre de una app: Mantenga pulsado el botón de encendido/apagado durante unos 
segundos hasta que aparezca un regulador rojo y, a continuación, mantenga pulsado el botón de 
inicio  hasta que la app se cierre.
También puede eliminar una app de la lista de apps recientes para forzar su cierre. Consulte 
“Apertura y cambio de apps” en la página 20.
Si no puede apagar el iPhone o si el problema persiste, puede ser necesario restablecer el iPhone. 
Solo hay que recurrir a esta opción si al apagar y encender el iPhone no se resuelve el problema.
Restablecer el iPhone: Mantenga pulsado al mismo tiempo el botón de encendido/apagado y el 
botón de inicio  durante al menos diez segundos, hasta que aparezca el logotipo de Apple.
Realización de copias de seguridad del iPhone
Puede utilizar iCloud o iTunes para realizar copias de seguridad automáticas del iPhone. Si selecciona que se realicen copias de seguridad automáticas con iCloud, no podrá utilizar también iTunes para realizar copias de seguridad automáticas de su ordenador, aunque puede utilizar iTunes 
para realizar copias de seguridad manuales de su ordenador. 
Cómo realizar copias de seguridad con iCloud 
iCloud realiza copias de seguridad automáticas del iPhone a diario, a través de la conexión Wi-Fi, 
cuando se conecta a una fuente de alimentación y está bloqueado. La fecha y hora de la última 
copia de seguridad se muestra en la parte inferior de la pantalla “Almacenamiento y copias”. iCloud 
realiza copias de seguridad de:
Â La música, los programas de televisión, las apps y los libros que compra.
Â Las fotos y los vídeos del Carrete.
Â Los ajustes del iPhone.
Â Los datos de las apps.
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Â Los mensajes (iMessage, SMS y MMS).
Â Los tonos de llamada.
Nota: Es posible que no se realicen copias de seguridad de la música comprada en todas las 
áreas, y que los programas de televisión no estén disponibles en todas las áreas.
Si no activó las copias de seguridad de iCloud la primera vez que configuró el iPhone, puede activarlas en los ajustes de iCloud. 
Activar las copias de seguridad de 
iCloud
Vaya a Ajustes > iCloud y, a continuación, inicie sesión con su ID de Apple y 
su contraseña, si es preciso. Vaya a “Almacenamiento y copias” y, a continuación, active “Copia de seguridad de iCloud”.
Realizar una copia de seguridad de 
forma inmediata
Vaya a Ajustes > iCloud > “Almacenamiento y copias” y, a continuación, pulse “Realizar copia de seguridad ahora”.
Gestionar sus copias de seguridad Vaya a Ajustes > iCloud > “Almacenamiento y copias” y, a continuación, pulse “Gestionar almacenamiento”. Pulse el nombre de su iPhone.
Activar o desactivar copia de seguridad del Carrete
Vaya a Ajustes > iCloud > “Almacenamiento y copias” y, a continuación, pulse “Gestionar almacenamiento”. Pulse el nombre de su iPhone y, a continuación, active o desactive la copia de seguridad del Carrete.
Ver los dispositivos de los que 
se están realizando copias de 
seguridad
Vaya a Ajustes > iCloud > Almacenamiento y copias > “Gestionar 
almacenamiento”.
Detener las copias de seguridad 
automáticas de iCloud
Vaya a Ajustes > iCloud > Almacenamiento y copias > “Copia de seguridad” 
y, a continuación, desactive “Copia de seguridad de iCloud”. 
No se realizarán copias de seguridad en iCloud de la música que no se haya adquirido en iTunes. 
Deberá utilizar iTunes para realizar copias de seguridad de dicho contenido y restaurarlo. Consulte 
“Sincronización con iTunes” en la página 18.
Importante: Es posible que las copias de seguridad de compras de música o programas de televisión no estén disponibles en todas las áreas. Puede que sus compras anteriores no estén disponibles si ya no está en las tiendas iTunes Store, App Store o iBookstore. 
Los contenidos que compre, así como los contenidos de Fotos en Streaming, no se descontarán 
del sus 5 GB de almacenamiento gratuito en iCloud.
Cómo realizar copias de seguridad con iTunes
 iTunes crea una copia de seguridad de las fotos del álbum Carrete o del álbum “Fotos guardadas”, 
así como de los mensajes de texto, notas, historial de llamadas, favoritos de contactos, ajustes de 
sonido, etc. No se realizan copias de seguridad de los archivos multimedia, como canciones y algunas fotos, pero pueden restaurarse mediante una sincronización con iTunes. 
Cuando conecte el iPhone al ordenador con el que normalmente realice la sincronización, iTunes 
creará una copia de seguridad cada vez que:
Â Realice una sincronización con iTunes:  iTunes sincroniza el iPhone cada vez que conecta el iPhone a su ordenador. iTunes no realizará ninguna copia de seguridad automática de un iPhone 
que no esté configurado para sincronizarse con dicho ordenador. Consulte “Sincronización con 
iTunes” en la página 18. 
Â Actualice o restaure el iPhone:  iTunes realiza una copia de seguridad del iPhone automáticamente antes de la actualización y de la restauración.
iTunes también puede encriptar las copias de seguridad del iPhone para proteger sus datos.
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Restaure los archivos y los ajustes del iPhone:  Conecte el iPhone al ordenador con el que normalmente realice la sincronización, seleccione el iPhone en la ventana de iTunes y haga clic en 
Restaurar en el panel Resumen.
Para obtener más información sobre las copias de seguridad como, por ejemplo, los ajustes y datos que contienen, vaya a support.apple.com/kb/HT1766?viewlocale=es_ES.
Cómo eliminar una copia de seguridad de iTunes
Puede eliminar una copia de seguridad del iPhone desde la lista de copias con iTunes. Puede interesarle, por ejemplo, si se ha creado una copia de seguridad en un ordenador ajeno.
Eliminar una copia de seguridad:
1 En iTunes, abra las preferencias de iTunes.
Â Mac:  Seleccione iTunes > Preferencias.
Â Windows:  Seleccione Edición > Preferencias.
2 Haga clic en Dispositivos (el iPhone no tiene por qué estar conectado).
3 Seleccione la copia de seguridad que desea eliminar y, a continuación, haga clic en “Eliminar copia 
de seguridad”.
4 Haga clic en Eliminar para confirmar que desea eliminar la copia seleccionada y, a continuación, 
haga clic en OK.
Actualización y restauración del software del iPhone
Puede actualizar el software del iPhone en Ajustes o utilizando iTunes. También puede borrar o 
restaurar el iPhone y, a continuación, utilizar iCloud o iTunes para realizar una restauración a partir 
de una copia de seguridad.
Ya no podrá acceder a los datos eliminados a través la interfaz de usuario del iPhone, pero no se 
borrarán del iPhone. Para obtener información sobre la eliminación de todos los contenidos y 
ajustes, consulte “Restablecer” en la página 183.
Actualización del iPhone
Puede actualizar el software del iPhone en Ajustes o utilizando iTunes. 
Realizar una actualización inalámbrica en el iPhone:  Vaya a Ajustes > General > Actualización de 
Software. El iPhone comprobará si hay actualizaciones de software disponibles.
Realizar una actualización de software en iTunes:  iTunes comprueba si hay actualizaciones de 
software disponibles cada vez que sincroniza el iPhone con iTunes. Consulte “Sincronización con 
iTunes” en la página 18.
Para obtener más información sobre la actualización y restauración del software del iPhone, vaya a 
support.apple.com/kb/HT4623?viewlocale=es_ES.
Restauración del iPhone
Puede utilizar iCloud o iTunes para restaurar el iPhone a partir de una copia de seguridad. 
Realizar una restauración a partir de una copia de seguridad de iCloud:  Restablezca el iPhone 
para borrar todos los ajustes y todos los datos. Inicie sesión en iCloud y seleccione “Restaurar a 
partir de una copia de seguridad” en el Asistente de Configuración. Consulte “Restablecer” en la 
página 183.
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iTunes y haga clic en Restaurar en el panel Resumen.
Cuando se haya restaurado el software del iPhone, podrá configurarlo como un nuevo iPhone o 
bien restaurar su música, vídeos, datos de las apps y otros contenidos a partir de una copia de 
seguridad.
Para obtener más información sobre la actualización y restauración del software del iPhone, vaya a 
support.apple.com/kb/HT1414?viewlocale=es_ES.
Compartir Archivos
Compartir Archivos le permite transferir archivos con un cable USB entre el iPhone y el ordenador, 
utilizando iTunes. Puede compartir archivos creados con una app compatible y guardados en un 
formato compatible.
Las apps que permiten compartir archivos se muestran en la lista de apps con archivos compartidos de iTunes. Para cada app, la lista de archivos muestra los documentos que hay en el iPhone. 
Consulte la documentación de la app para obtener información sobre el modo en que comparte 
archivos; no todas las apps admiten esta función.
Transferir un archivo del iPhone al ordenador:  En iTunes, vaya al panel Aplicaciones de su dispositivo. En la sección Compartir Archivos, seleccione una app en la lista. A la derecha, seleccione el 
archivo que desee transferir y, a continuación, haga clic en “Guardar en”.
Transferir un archivo del ordenador al iPhone:  En iTunes, vaya al panel Aplicaciones de su dispositivo. En la sección Compartir Archivos, seleccione una app y haga clic en Añadir. El archivo se 
transferirá inmediatamente a su dispositivo y podrá utilizarlo con la app que haya seleccionado.
Borrar un archivo del iPhone:  En iTunes, vaya al panel Aplicaciones de su dispositivo. En la sección Compartir Archivos, seleccione el archivo y, a continuación, pulse la tecla Suprimir.
Información sobre seguridad, software y servicio
Esta tabla describe dónde obtener más información sobre seguridad, software y servicio relacionada con el iPhone.
Para obtener información acerca de Haga lo siguiente
Cómo usar el iPhone de forma segura Consulte la Guía de información importante del producto
en support.apple.com/es_ES/manuals/iphone/ (España 
y Latinoamérica) o support.apple.com/es_MX/manuals/
iphone/ (México) para obtener la información más reciente sobre seguridad y normativas.
Servicio y soporte iPhone, consejos, foros y descargas 
de software de Apple
Visite support.apple.com/es_ES/manuals/iphone/
(España y Latinoamérica) o support.apple.com/es_MX/
manuals/iphone/ (México).
Servicio y soporte de su operador Póngase en contacto con su operador o vaya al sitio 
web de su operador.
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Las últimas novedades del iPhone Visite www.apple.com/iphone/countries/.
Creación de un ID de Apple Vaya a https://appleid.apple.com/es_ES (España), 
https://appleid.apple.com/es_LA (Latinoamérica) y 
https://appleid.apple.com/es_MX (México).
Cómo usar iCloud Visite www.apple.com/es/support/icloud/ (España), 
www.apple.com/mx/support/icloud/ (México) y www.
apple.com/la/support/icloud/ (Latinoamérica).
Cómo usar iTunes Abra iTunes y seleccione Ayuda > Ayuda iTunes. Para 
acceder a las lecciones de iTunes disponibles en Internet 
(pueden no estar disponibles en todas las áreas), visite 
www.apple.com/es/support/itunes.
Cómo usar iPhoto en OS X Abra iPhoto y seleccione Ayuda > Ayuda iPhoto.
Cómo usar la Agenda en OS X Abra la Agenda y seleccione Ayuda > Ayuda Agenda.
Cómo usar iCal en OS X Abra iCal y seleccione Ayuda > Ayuda iCal.
Microsoft Outlook, Libreta de direcciones de Windows 
o Adobe Photoshop Elements
Consulte la documentación de dichas apps.
Localización del número de serie, IMEI, ICCID o MEID 
del iPhone
Puede encontrar el número de serie, el número IMEI 
(identidad internacional de equipo móvil), el número 
ICCID o el número MEID (identificador de equipos 
móviles) del iPhone en la caja del iPhone. O bien en el 
iPhone, en Ajustes > General > Información. Para obtener más información, vaya a support.apple.com/kb/
ht1267?viewlocale=es_ES.
Obtención de servicios técnicos en garantía En primer lugar, siga los consejos de este manual y de 
los recursos disponibles en Internet. A continuación, 
vaya a www.apple.com/support/country/ o consulte la Guía de información importante del producto en 
support.apple.com/es_ES/manuals/iphone/ (España y 
Latinoamérica) o support.apple.com/es_MX/manuals/
iphone/ (México).
Servicio de sustitución de la batería Vaya a www.apple.com/es/batteries/replacements.html
(España), www.apple.com/mx/batteries/replacements.
html (México) y www.apple.com/la/batteries/
replacements.html.
Uso del iPhone en un entorno empresarial
Vaya a www.apple.com/es/business (España), www.apple.com/mx/business (México) y www.apple.
com/la/business (Latinoamérica) para obtener más información sobre las prestaciones empresariales del iPhone, entre las que se incluyen Microsoft Exchange, IMAP, CalDAV, CardDAV y VPN. 
Cómo usar el iPhone con otros operadores de telefonía móvil
Algunos operadores le permiten desbloquear el iPhone para usarlo en su red. Para ver si su operador ofrece esta opción, vaya a support.apple.com/kb/HT1937?viewlocale=es_ES. 
Póngase en contacto con su operador para obtener la información de autorización y configuración necesaria. Debe conectar el iPhone a iTunes para completar el proceso. Pueden aplicarse 
tarifas adicionales.
Para obtener información sobre solución de problemas, vaya a support.apple.com/kb/
TS3198?viewlocale=es_ES.
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Programa de reciclaje de Apple (disponible en algunos países): Para reciclar gratuitamente su teléfono móvil antiguo, obtener una etiqueta de envío prepagada y consultar otras instrucciones al 
respecto, vaya a: www.apple.com/es/recycling (España), www.apple.com/mx/recycling (México) y 
www.apple.com/la/recycling (Latinoamérica).
Deshacerse del iPhone y reciclarlo: El iPhone debe desecharse de acuerdo con la normativa local 
aplicable. Como el iPhone contiene componentes electrónicos y una batería, es necesario desechar el iPhone separadamente del resto de los residuos domésticos. Cuando el iPhone alcance el 
fin de su vida útil, póngase en contacto con las autoridades locales para informarse respecto a las 
opciones de reciclaje o, simplemente, deposítelo en su tienda Apple local o devuélvalo a Apple. 
La batería será extraída y reciclada de un modo respetuoso con el medio ambiente. Para obtener 
más información, consulte: www.apple.com/es/recycling (España), www.apple.com/mx/recycling
(México) y www.apple.com/la/recycling (Latinoamérica).
Unión Europea. Información sobre eliminación de dispositivos electrónicos y baterías:
Este símbolo indica que, de acuerdo con la normativa local, este producto y su batería no deben 
desecharse junto con los residuos domésticos. Cuando llegue al final de su vida útil, llévelo a los 
puntos de recogida estipulados por la administración local para el reciclaje de equipos electró-
nicos. El tratamiento inadecuado de los residuos de equipos electrónicos por parte de los consumidores puede ser sancionado. La recogida selectiva y el reciclaje del producto y de su batería en 
el momento de desecharlo contribuirán a preservar los recursos naturales y a proteger la salud 
humana y el medio ambiente.
Para consultar los servicios de recogida y reciclaje del iPhone, vaya a: www.apple.com/recycling/
nationalservices/europe.html
Sustitución de la batería del iPhone: La batería recargable del iPhone solo puede cambiarla Apple 
o un proveedor de servicios autorizado Apple. Para obtener más información sobre los servicios 
de sustitución de la batería, vaya a: www.apple.com/es/batteries/replacements.html (España), 
www.apple.com/mx/batteries/replacements.html (México) y www.apple.com/la/batteries/
replacements.html
Deutschland: Dieses Gerät enthält Batterien. Bitte nicht in den Hausmüll werfen. Entsorgen 
Sie dieses Gerätes am Ende seines Lebenszyklus entsprechend der maßgeblichen gesetzlichen 
Regelungen.
Nederlands: Gebruikte batterijen kunnen worden ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) worden gedeponeerd.
Türkiye: EEE yönetmelig?ine (Elektrikli ve Elektronik Es¸yalarda Bazi Zararli Maddelerin 
Kullaniminin Sinirlandirilmasina Dair Yönetmelik) uygundur.
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O símbolo acima indica que este produto e/ou sua bateria não devem ser descartadas no lixo 
doméstico. Quando decidir descartar este produto e/ou sua bateria, faça-o de acordo com as leis 
e diretrizes ambientais locais. Para informações sobre o programa de reciclagem da Apple, pontos 
de coleta e telefone de informações, visite www.apple.com/br/environment.
Apple y el medio ambiente
En Apple somos conscientes de nuestra responsabilidad en la minimización del impacto ambiental de nuestras operaciones y nuestros productos. Para obtener más información, vaya a: www.
apple.com/es/environment (España), www.apple.com/mx/environment (México) y www.apple.
com/la/environment (Latinoamérica).
Temperatura de funcionamiento del iPhone
Si la temperatura interior del iPhone excede el límite normal de funcionamiento, puede experimentar los siguientes síntomas al tratar de regularse la temperatura:
Â El iPhone deja de recargarse.
Â La pantalla se oscurece.
Â La señal de telefonía es débil.
Â Aparece en pantalla una advertencia sobre la temperatura.
Importante: No podrá utilizar el iPhone mientras se muestre en pantalla la advertencia sobre la 
temperatura, salvo para realizar una llamada de emergencia. Si el iPhone no puede regular su 
temperatura interna, entra en un modo de reposo profundo hasta que se enfría. Mientras el iPhone esté en este modo, no podrá realizar llamadas de emergencia. Lleve el iPhone a una ubicación 
más fría y espere unos minutos antes de intentar utilizar de nuevo el iPhone.
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iPhone at a Glance
iPhone 5 overview
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Note:  iPhone apps and features may vary based on your location, language, carrier, and model of 
iPhone. Apps that send or receive data over a cellular network may incur additional fees. Contact 
your carrier for information about your iPhone service plan and fees.
Accessories
The following accessories are included with iPhone:
Apple headset: Use the Apple EarPods with Remote and Mic (iPhone 5, shown above) or the 
Apple Earphones with Remote and Mic (iPhone 4S or earlier) to listen to music and videos, and 
make phone calls. See Apple headset on page 31.
Connecting cable: Use the Lightning to USB Cable (iPhone 5, shown above) or the Dock 
Connector to USB Cable (iPhone 4S or earlier) to connect iPhone to your computer to sync and 
charge. The cable can also be used with the iPhone Dock (sold separately).Chapter  1    iPhone at a Glance 8
Apple USB power adapter: Use with the Lightning to USB Cable or Dock Connector to USB 
Cable to charge the iPhone battery.
SIM eject tool: Use to eject the SIM card tray. (Not included in all areas.)
Buttons
Sleep/Wake button
When you’re not using iPhone, you can lock it to turn off the display and save the battery.
Lock iPhone: Press the Sleep/Wake button.
When iPhone is locked, nothing happens if you touch the screen. iPhone can still receive calls, 
text messages, and other updates. You can also:
• Listen to music
• Adjust the volume
• Use the center button on your headset to take calls or listen to music
Sleep/Wake 
button
Sleep/Wake 
button
Unlock iPhone: Press the Sleep/Wake button or the Home button  , then drag the slider.
Turn iPhone off: Press and hold the Sleep/Wake button for a few seconds until the red slider 
appears, then drag the slider.
Turn iPhone on: Press and hold the Sleep/Wake button until the Apple logo appears.
Open Camera when iPhone is locked: Press the Sleep/Wake button or the Home button  , then 
drag  up.
Access the audio controls when iPhone is locked: Double-click the Home button  .
iPhone locks if you don’t touch the screen for a minute or so. You can adjust the auto-lock time 
(or turn it off), and require a passcode to unlock iPhone.
Adjust the auto-lock timing or turn it off: See Auto-Lock on page 136.
Require a passcode to unlock iPhone: See Passcode Lock on page 136.Chapter  1    iPhone at a Glance 9
Home button
The Home button  takes you to the Home screen, no matter what you’re doing. It also provides 
other convenient shortcuts.
Go to the Home screen: Press the Home button  .
On the Home screen, tap an app to open it. See Opening and switching between apps on 
page 17.
Display recently used apps: With iPhone unlocked, double-click the Home button  . The 
multitasking bar appears at the bottom of the screen, showing the most recently used apps. 
Swipe the bar to the left to see more apps.
Display audio playback controls:
• When iPhone is locked:  Double-click the Home button  . See Playing music on page 58.
• When you’re using another app:  Double-click the Home button  , then swipe the multitasking 
bar from left to right.
Use Siri (iPhone 4S or later) or Voice Control: Press and hold the Home button  . See 
Chapter 4, Siri, on page 36 and Voice Control on page 26.
Volume controls
While you’re on the phone or listening to songs, movies, or other media, the buttons on the side 
of iPhone adjust the audio volume. Otherwise, the buttons control the volume for the ringer, 
alerts, and other sound effects.
WARNING:  For important information about avoiding hearing loss, see Important safety 
information on page 146. 
Volume
up
Volume
up
Volume
down
Volume
down
Lock the ringer and alerts volume: Go to Settings > Sounds and turn off “Change with Buttons.”
Limit the volume for music and videos: Go to Settings > Music > Volume Limit.
Note:  In some countries, iPhone may indicate when you’re setting the volume above the 
European Union hearing safety guidelines. To increase the volume beyond this level, you may 
need to briefly release the volume control.
You can also use either volume button to take a picture or record a video. See 
Chapter 12, Camera, on page 74.Chapter  1    iPhone at a Glance 10
Ring/Silent switch
Flip the Ring/Silent switch to put iPhone in ring mode  or silent mode  .
Ring Ring
Silent Silent
In ring mode, iPhone plays all sounds. In silent mode, iPhone doesn’t ring or play alerts and other 
sound effects.
Important:  Clock alarms, audio apps such as Music, and many games still play sounds through 
the built-in speaker when iPhone is in silent mode. In some areas, the sound effects for Camera 
and Voice Memos are played even if the Ring/Silent switch is set to silent.
For information about changing sound and vibrate settings, see Sounds on page 139.
You can also use the Do Not Disturb setting to silence calls, alerts, and notifications.
Set iPhone to Do Not Disturb ( ): Go to Settings and turn on Do Not Disturb. Do Not Disturb 
keeps calls, alerts, and notifications from making any sounds or lighting up the screen when the 
screen is locked. Alarms still sound, however, and if the screen is unlocked, Do Not Disturb has 
no effect.
To schedule quiet hours, allow certain people to call, or enable repeated calls to ring through, go 
to Settings > Notifications > Do Not Disturb. See Do Not Disturb and Notifications on page 132.
Status icons
The icons in the status bar at the top of the screen give information about iPhone:
Status icon What it means
Cell signal* Shows whether you’re in range of the cellular network and can make 
and receive calls. The more bars, the stronger the signal. If there’s no 
signal, the bars are replaced with “No service.”
Airplane mode Shows that airplane mode is on—you cannot use the phone, access 
the Internet, or use Bluetooth® devices. Non-wireless features are 
available. See Airplane mode on page 130.
LTE Shows that your carrier’s LTE network is available, and iPhone can 
connect to the Internet over that network. (iPhone 5. Not available in 
all areas.) See Cellular on page 135.
UMTS Shows that your carrier’s 4G UMTS (GSM) network is available, and 
iPhone can connect to the Internet over that network. (iPhone 4S or 
later. Not available in all areas.) See Cellular on page 135.
UMTS/EV-DO Shows that your carrier’s 3G UMTS (GSM) or EV-DO (CDMA) network 
is available, and iPhone can connect to the Internet over that 
network. See Cellular on page 135.
EDGE Shows that your carrier’s EDGE (GSM) network is available, and 
iPhone can connect to the Internet over that network. See 
Cellular on page 135.Chapter  1    iPhone at a Glance 11
Status icon What it means
GPRS/1xRTT Shows that your carrier’s GPRS (GSM) or 1xRTT (CDMA) network is 
available, and iPhone can connect to the Internet over that network. 
See Cellular on page 135.
Wi-Fi* Shows that iPhone is connected to the Internet over a Wi-Fi network. 
The more bars, the stronger the connection. See Wi-Fi on page 130.
Do Not Disturb Shows that “Do Not Disturb” is turned on. See Sounds on page 139.
Personal Hotspot Shows that iPhone is connected to another iPhone providing a 
Personal Hotspot. See Personal Hotspot on page 132.
Syncing Shows that iPhone is syncing with iTunes.
Network activity Shows network activity. Some third-party apps may also use the icon 
to show an active process.
Call Forwarding Shows that Call Forwarding is set up on iPhone. See Call forwarding, 
call waiting, and caller ID on page 49.
VPN Shows that you’re connected to a network using VPN. See 
Cellular on page 135.
Lock Shows that iPhone is locked. See Sleep/Wake button on page 8.
TTY Shows that iPhone is set to work with a TTY machine. See TTY 
support on page 129.
Play Shows that a song, audiobook, or podcast is playing. See Playing 
music on page 58.
Portrait 
orientation lock
Shows that the iPhone screen is locked in portrait orientation. See 
Portrait and landscape orientation on page 19.
Alarm Shows that an alarm is set. See Chapter 19, Clock, on page 90.
Location Services Shows that an item is using Location Services. See Privacy on 
page 140.
Bluetooth* Blue or white icon: Bluetooth is on and paired with a device. 
Gray icon: Bluetooth is on and paired with a device, but the device is 
out of range or turned off. 
No icon: Bluetooth is not paired with a device. 
See Bluetooth devices on page 32.
Bluetooth battery Shows the battery level of a supported paired Bluetooth device.
Battery Shows battery level or charging status. See Battery on page 34.
* Accessories and wireless performance: The use of certain accessories with iPhone may affect 
wireless performance. Not all iPod accessories are fully compatible with iPhone. Turning on 
airplane mode on iPhone may eliminate audio interference between iPhone and an accessory. 
While airplane mode is on, you cannot make or receive calls or use features that require wireless 
communication. Reorienting or relocating iPhone and the connected accessory may improve 
wireless performance.2
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Getting Started
· WARNING:  To avoid injury, read Important safety information on page 146 before using iPhone.
What you need
To use iPhone, you need:
• A wireless service plan with a carrier that provides iPhone service in your area
• An Internet connection for your computer (broadband is recommended)
• An Apple ID for some features, including iCloud, the App Store and iTunes Store, and online 
purchases. An Apple ID can be created during setup.
To use iPhone with your computer, you need:
• A Mac with a USB 2.0 or 3.0 port, or a PC with a USB 2.0 port, and one of the following 
operating systems:
• Mac OS X version 10.6.8 or later
• Windows 7, Windows Vista, or Windows XP Home or Professional with Service Pack 3 or later
• iTunes 10.7 or later (for some features), available at www.itunes.com/download
Installing the SIM card
If you were given a SIM card to install, install it before setting up iPhone.
Important:  A SIM card is required in order to use cellular services when connecting to GSM 
networks and some CDMA networks. An iPhone 4S or later that’s been activated on a CDMA 
wireless network may also use a SIM card for connecting to a GSM network, primarily for 
international roaming. Your iPhone is subject to your wireless service provider’s policies, which 
may include restrictions on switching service providers and roaming, even after conclusion of 
any required minimum service contract. Contact your wireless service provider for more details. 
Availability of cellular capabilities depends on the wireless network.
Installing the SIM Card in iPhone 5
Nano SIM
card
Nano SIM
card
Nano SIM
card tray
Nano SIM
card tray
Paper clip
or SIM
eject tool
Paper clip
or SIM
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Install the SIM card: Insert the end of a small paper clip or SIM eject tool into the hole on the 
SIM card tray. Pull out the SIM card tray and place the SIM card in the tray as shown. With the tray 
aligned and the SIM card on top, carefully replace the tray.
Setting up and activating iPhone
To set up and activate iPhone, turn on iPhone and follow the Setup Assistant. The Setup Assistant 
steps you through the setup process, including connecting to a Wi-Fi network, signing in with or 
creating a free Apple ID, setting up iCloud, turning on recommended features such as Location 
Services and Find My iPhone, and activating iPhone with your carrier. You can also restore from 
an iCloud or iTunes backup during setup.
Activation can be done over a Wi-Fi network or, with iPhone 4S or later, over your carrier’s cellular 
network (not available in all areas). If neither option is available, you need to connect iPhone to 
your computer running iTunes for activation.
Connecting iPhone to your computer
You may need to connect iPhone to your computer in order to complete activation. Connecting 
iPhone to your computer also lets you sync information, music, and other content with iTunes. 
See Syncing with iTunes on page 16.
Connect iPhone to your computer: Use the Lightning to USB Cable (iPhone 5) or Dock 
Connector to USB Cable (earlier iPhone models) provided with iPhone.
Connecting to the Internet
iPhone connects to the Internet whenever necessary, using a Wi-Fi connection (if available) or 
your carrier’s cellular network. For information about connecting to a Wi-Fi network, see Wi-Fi on 
page 130. 
Note:  If a Wi-Fi connection to the Internet isn’t available, some iPhone apps and services may 
transfer data over your carrier’s cellular network, which may result in additional fees. Contact your 
carrier for information about your cellular data plan rates. To manage cellular data usage, see 
Cellular on page 135.Chapter  2    Getting Started 14
Setting up mail and other accounts
iPhone works with iCloud, Microsoft Exchange, and many of the most popular Internet-based 
mail, contacts, and calendar service providers. 
If you don’t already have a mail account, you can set up a free iCloud account when you first set 
up iPhone, or later in Settings > iCloud. See iCloud on page 15.
Set up an iCloud account: Go to Settings > iCloud.
Set up some other account: Go to Settings > Mail, Contacts, Calendars.
You can add contacts using an LDAP or CardDAV account, if your company or organization 
supports it. See Adding contacts on page 101.
You can add calendars using a CalDAV calendar account, and you can subscribe to iCalendar (.ics) 
calendars or import them from Mail. See Working with multiple calendars on page 68.
Apple ID
An Apple ID is the user name for a free account that lets you access Apple services, such as the 
iTunes Store, the App Store, and iCloud. You need only one Apple ID for everything you do with 
Apple. There may be charges for services and products that you use, purchase, or rent. 
If you have an Apple ID, use it when you first set up iPhone, and whenever you need to sign in to 
use an Apple service. If you don’t already have an Apple ID, you can create one whenever you’re 
asked to sign in. 
For more information, see support.apple.com/kb/he37.
Managing content on your iOS devices
You can transfer information and files between your iOS devices and computers using either 
iCloud or iTunes.
• iCloud stores content such as music, photos, calendars, contacts, documents, and more, and 
wirelessly pushes it to your other iOS devices and computers, keeping everything up to date. 
See iCloud below.
• iTunes syncs music, video, photos, and more, between your computer and iPhone. Changes 
you make on one device are copied to the other when you sync. You can also use iTunes to 
copy a file to iPhone for use with an app, or to copy a document you’ve created on iPhone to 
your computer. See Syncing with iTunes on page 16.
You can use iCloud or iTunes, or both, depending on your needs. For example, you can use 
iCloud Photo Stream to automatically get photos you take on iPhone to your other devices, and 
use iTunes to sync photo albums from your computer to iPhone.
Important:  Don’t sync items in the Info pane of iTunes (such as contacts, calendars, and notes) 
and also use iCloud to keep that information up to date on your devices. Otherwise, duplicated 
data may result.Chapter  2    Getting Started 15
iCloud
iCloud stores your content, including music, photos, contacts, calendars, and supported 
documents. Content stored in iCloud is pushed wirelessly to your other iOS devices and 
computers set up with the same iCloud account. 
iCloud is available on devices with iOS 5 or later, on Mac computers with OS X Lion v10.7.2 or 
later, and on PCs with the iCloud Control Panel for Windows (Windows Vista Service Pack 2 or 
Windows 7 required). 
iCloud features include:
• iTunes in the Cloud—Download previous iTunes music and TV show purchases to iPhone for 
free, anytime.
• Apps and Books—Download previous App Store and iBookstore purchases to iPhone for 
free, anytime.
• Photo Stream—Photos you take appear on all your devices. You can also create photo streams 
to share with others. See Photo Stream on page 71.
• Documents in the Cloud—For iCloud-enabled apps, keep documents and app data up to date 
across all your devices.
• Mail, Contacts, Calendars—Keep your mail contacts, calendars, notes, and reminders up to date 
across all your devices.
• Backup—Back up iPhone to iCloud automatically when connected to power and Wi-Fi. See 
Backing up iPhone on page 150.
• Find My iPhone—Locate your iPhone on a map, display a message, play a sound, lock the 
screen, or remotely wipe the data. See Find My iPhone on page 34.
• Find My Friends—Share your location with people who are important to you. Download the 
free app from the App Store.
• iTunes Match—With an iTunes Match subscription, all your music—including music you’ve 
imported from CDs or purchased somewhere other than iTunes—appears on all of your 
devices and can be downloaded and played on demand. See iTunes Match on page 62.
• iCloud Tabs—See the webpages you have open on your other iOS devices and OS X 
computers. See Chapter 7, Safari, on page 55.
With iCloud, you get a free email account and 5 GB of storage for your mail, documents, and 
backups. Your purchased music, apps, TV shows, and books, as well as your photo streams, don’t 
count against your free space.
Sign in or create an iCloud account, and set iCloud options: Go to Settings > iCloud.
Purchase additional iCloud storage: Go to Settings > iCloud > Storage & Backup, then tap 
Manage Storage. For information about purchasing iCloud storage, go to help.apple.com/icloud.
View and download previous purchases:
• iTunes Store purchases:  Go to iTunes, tap More, then tap Purchased.
• App Store purchases:  Go to App Store, tap Updates, then tap Purchased.
• iBookstore purchases:  Go to iBooks, tap Store, then tap Purchased.
Turn on Automatic Downloads for music, apps, or books: Go to Settings > iTunes & App Stores.
For more information about iCloud, go to www.apple.com/icloud. For support information, go to 
www.apple.com/support/icloud.Chapter  2    Getting Started 16
Syncing with iTunes
Syncing with iTunes copies information from your computer to iPhone, and vice versa. You can 
sync by connecting iPhone to your computer, or you can set up iTunes to sync wirelessly with 
Wi-Fi. You can set iTunes to sync music, photos, videos, podcasts, apps, and more. For information 
about syncing iPhone with your computer, open iTunes, then choose iTunes Help from the 
Help menu.
Set up wireless iTunes syncing: Connect iPhone to your computer. In iTunes on the computer, 
select your iPhone (under Devices), click Summary, then turn on “Sync over Wi-Fi connection.” 
When Wi-Fi syncing is turned on, iPhone syncs every day. iPhone must be connected to a power 
source, iPhone and your computer must both be on the same wireless network, and iTunes must 
be open on your computer. For more information, see iTunes Wi-Fi Sync on page 136. 
Tips for syncing with iTunes
• If you use iCloud to store your contacts, calendars, bookmarks, and notes, don’t also sync them 
to your device using iTunes.
• Purchases you make from the iTunes Store or the App Store on iPhone are synced back to your 
iTunes library. You can also purchase or download content and apps from the iTunes Store on 
your computer, and then sync them to iPhone.
• In the device’s Summary pane, you can set iTunes to automatically sync when your device is 
attached to your computer. To temporarily override this setting, hold down Command and 
Option (Mac) or Shift and Control (PC) until you see iPhone appear in the sidebar.
• In the device’s Summary pane, select “Encrypt iPhone backup” if you want to encrypt the 
information stored on your computer when iTunes makes a backup. Encrypted backups are 
indicated by a lock icon  , and a separate password is required to restore the backup. If you 
don’t select this option, other passwords (such as those for mail accounts) aren’t included in 
the backup and will have to be reentered if you use the backup to restore the device.
• In the device’s Info pane, when you sync mail accounts, only the settings are transferred from 
your computer to iPhone. Changes you make to an email account on iPhone don’t affect the 
account on your computer.
• In the device’s Info pane, click Advanced to select options to let you replace the information on 
iPhone with the information from your computer during the next sync.
• If you listen to part of a podcast or audiobook, the place you left off is included if you sync 
the content with iTunes. If you started listening on iPhone, you can pick up where you left off 
using iTunes on your computer—or vice versa. 
• In the device’s Photo pane, you can sync photos and videos from a folder on your computer.
Viewing this user guide on iPhone
You can view the iPhone User Guide on iPhone in Safari, and in the free iBooks app.
View the user guide in Safari: Tap  , then tap the iPhone User Guide bookmark.
• Add an icon for the guide to the Home screen: Tap  , then tap “Add to Home Screen.”
• View the guide in a different language: Tap “Change Language” on the main contents page.
View the user guide in iBooks: If you haven’t installed iBooks, open App Store, then search 
for and install “iBooks.” Open iBooks and tap Store. Search for “iPhone User,” then select and 
download the guide.
For more information about iBooks, see Chapter 30, iBooks, on page 109.3
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Basics
Using apps
You interact with iPhone using your fingers to tap, double-tap, swipe, and pinch objects on 
the touchscreen.
Opening and switching between apps
To go to the Home screen, press the Home button  .
Open an app:  Tap it.
To return to the Home screen, press the Home button  again.
See another Home screen: Swipe left or right.
Swipe left or right to switch 
to another Home screen.
Swipe left or right to switch 
to another Home screen.
Go to the first Home screen: Press the Home button  .
View recently used apps: Double-click the Home button  to reveal the multitasking bar. Chapter  3    Basics 18
Tap an app to use it again. Swipe left to see more apps.
Recently used apps Recently used apps
If you have a lot of apps, you might want to use Spotlight to locate and open them. See 
Searching on page 27.
Scrolling
Drag up or down to scroll. On some screens, such as webpages, you can also scroll side to side. 
Dragging your finger to scroll won’t choose or activate anything on the screen.
Flick to scroll quickly.
You can wait for the scrolling to come to a stop, or touch the screen to stop it immediately.
To quickly scroll to the top of a page, tap the status bar at the top of the screen.
Lists
Depending on the list, choosing an item can do different things—for example, it may open 
another list, play a song, open an email, or show someone’s contact information.
Choose an item in a list: Tap it.Chapter  3    Basics 19
Some lists have an index along the side to help you navigate quickly.
Drag your finger along
the index to scroll 
quickly. Tap a letter to 
jump to a section. 
Drag your finger along
the index to scroll 
quickly. Tap a letter to 
jump to a section. 
Return to a previous list: Tap the back button in the upper-left corner.
Zooming in or out
Depending on the app, you may be able to zoom in to enlarge, or zoom out to reduce the image 
on the screen. When viewing photos, webpages, mail, or maps, for example, pinch two fingers 
together to zoom out or spread them apart to zoom in. For photos and webpages, you can also 
double-tap (tap twice quickly) to zoom in, then double-tap again to zoom out. For maps, doubletap to zoom in and tap once with two fingers to zoom out.
Zoom is also an accessibility feature that lets you magnify the screen with any app you’re using, 
to help you see what’s on the display. See Zoom on page 125.
Portrait and landscape orientation
You can view many iPhone apps in either portrait or landscape orientation. Rotate iPhone and 
the display rotates too, adjusting to fit the new orientation.
Lock the screen in portrait orientation: Double-click the Home button  , swipe the 
multitasking bar from left to right, then tap  .
The orientation lock icon  appears in the status bar when the screen orientation is locked.Chapter  3    Basics 20
Adjusting brightness
You can manually adjust the brightness of the screen, or turn on Auto-Brightness to have iPhone 
use the built-in ambient light sensor to automatically adjust the brightness.
Adjust the screen brightness: Go to Settings > Brightness & Wallpaper, then drag the slider.
Turn Auto-Brightness on or off: Go to Settings > Brightness & Wallpaper.
See Brightness & Wallpaper on page 139.
Customizing iPhone
You can customize the layout of your apps on the Home screen, organize them in folders, and 
change the wallpaper.
Rearranging apps
Customize your Home screen by rearranging apps, moving apps to the Dock along the bottom 
of the screen, and creating additional Home screens. 
Rearrange apps: Touch and hold any app on the Home screen until it jiggles, then move apps 
around by dragging them. Press the Home button  to save your arrangement.
Create a new Home screen: While arranging apps, drag an app to the right edge of the 
rightmost screen, until a new screen appears.
You can create up to 11 Home screens. The dots above the Dock show the number of screens 
you have, and which screen you’re viewing.
Swipe left or right to switch between screens. To go to the first Home screen, press the 
Home button  .
Move an app to another screen: While it’s jiggling, drag an app to the side of the screen.
Customize the Home screen using iTunes: Connect iPhone to your computer. In iTunes on 
your computer, select iPhone, then click the Apps button to see the image of the iPhone 
Home screen.
Reset the Home screen to its original layout: In Settings, go to General > Reset, then tap Reset 
Home Screen Layout. Resetting the Home screen removes any folders you’ve created and applies 
the default wallpaper to your Home screen.Chapter  3    Basics 21
Organizing with folders
You can use folders to organize the apps on your Home screens. Rearrange folders—just as you 
do apps—by dragging them around your Home screens or to the Dock.
Create a folder: Touch an app until the Home screen icons begin to jiggle, then drag the app 
onto another.
iPhone creates a new folder that includes the two apps, and names the folder based on the type 
of apps. To enter a different name, tap the name field.
Open a folder: Tap the folder. To close a folder, tap outside the folder, or press the Home button  .
Organize with folders: While arranging apps (the icons are jiggling):
• Add an app to a folder:  Drag the app onto the folder.
• Remove an app from a folder:  Open the folder if necessary, then drag the app out.
• Delete a folder:  Move all apps out of the folder. The folder is automatically deleted.
• Rename a folder:  Tap to open the folder, then tap the name and enter a new one.
When you finish, press the Home button  .
Changing the wallpaper
You can customize both the Lock screen and the Home screen by choosing an image or photo 
to use as wallpaper. Choose one of the supplied images, or a photo from your Camera Roll or 
another album on iPhone.
Change the wallpaper: Go to Settings > Brightness & Wallpaper.Chapter  3    Basics 22
Typing
The onscreen keyboard lets you type when you need to enter text.
Entering text
Use the onscreen keyboard to enter text, such as contact information, mail, and web addresses. 
Depending on the app and the language you’re using, the keyboard may correct misspellings, 
predict what you’re typing, and even learn as you use it.
You can also use an Apple Wireless Keyboard to type. See Apple Wireless Keyboard on page 24. 
To use dictation instead of typing, see Dictation on page 25.
Enter text: Tap a text field to bring up the keyboard, then tap keys on the keyboard.
As you type, each letter appears above your thumb or finger. If you touch the wrong key, you 
can slide your finger to the correct key. The letter isn’t entered until you release your finger from 
the key.
• Type uppercase:  Tap the Shift key  before tapping a letter. Or touch and hold the Shift key, 
then slide to a letter.
• Quickly type a period and space:  Double-tap the space bar. 
• Turn on caps lock:  Double-tap the Shift key  . To turn caps lock off, tap the Shift key.
• Enter numbers, punctuation, or symbols:  Tap the Number key  . To see additional punctuation 
and symbols, tap the Symbol key  .
• Enter accented letters or other alternate characters:  Touch and hold a key, then slide to choose 
one of the options.
To type an alternate character, 
touch and hold a key, then slide 
to choose one of the options.
To type an alternate character, 
touch and hold a key, then slide 
to choose one of the options.
Set options for typing: Go to Settings > General > Keyboard.Chapter  3    Basics 23
Editing text
If you need to edit text, an onscreen magnifying glass lets you position the insertion point where 
you need it. You can select text, and cut, copy, and paste text. In some apps, you can also cut, 
copy, and paste photos and videos.
Position the insertion point: Touch and hold to bring up the magnifying glass, then drag to 
position the insertion point.
Select text: Tap the insertion point to display the selection buttons. Tap Select to select the 
adjacent word, or tap Select All to select all text.
You can also double-tap a word to select it. Drag the grab points to select more or less text. In 
read-only documents, such as webpages, touch and hold to select a word.
Cut or copy text: Select text, then tap Cut or Copy.
Paste text: Tap the insertion point, then tap Paste to insert the last text that you cut or copied. 
To replace text, select it before tapping Paste.
Undo the last edit: Shake iPhone, then tap Undo.
Make text bold, italic, or underlined: Select text, tap  , then tap B/I/U (not always available).
Get the definition of a word: Select the word, then tap Define (not always available).
Get alternative words: Select a word, then tap Suggest (not always available).
Auto-correction and spell checking
For many languages, iPhone uses the active dictionary to correct misspellings or 
make suggestions as you type. When iPhone suggests a word, you can accept the 
suggestion without interrupting your typing. For a list of supported languages, see 
www.apple.com/iphone/specs.html.
Suggested word Suggested word
Accept the suggestion: Type a space, punctuation mark, or return character.
Reject a suggestion: Tap the “x” next to the suggestion.Chapter  3    Basics 24
Each time you reject a suggestion for the same word, iPhone becomes more likely to accept 
the word.
iPhone may also underline words you’ve already typed that might be misspelled.
Replace a misspelled word: Tap the underlined word, then tap the correct spelling. If the word 
you want doesn’t appear, just retype it.
Turn auto-correction or spell checking on or off: Go to Settings > General > Keyboard.
Shortcuts and your personal dictionary
Shortcuts lets you type just a few characters instead of a longer word or phrase. The expanded 
text appears whenever you type the shortcut. For example, the shortcut “omw” expands to “On 
my way!” 
Create a shortcut: Go to Settings > General > Keyboard, then tap Add New Shortcut.
Prevent iPhone from trying to correct a word or phrase: Create a shortcut, but leave the 
Shortcut field blank.
Edit a shortcut: Go to Settings > General > Keyboard, then tap the shortcut.
Use iCloud to keep your personal dictionary up to date on your other iOS devices: Go to 
Settings > iCloud and turn on “Documents & Data.”
Keyboard layouts
You can use Settings to set the layouts for the onscreen keyboard or for an Apple Wireless 
Keyboard that you use with iPhone. The available layouts depend on the keyboard language. See 
Apple Wireless Keyboard below and Appendix B, International Keyboards, on page 143.
Select keyboard layouts: Go to Settings > General > International > Keyboards, select a 
language, then choose the layouts.
Apple Wireless Keyboard
You can use an Apple Wireless Keyboard (available separately) for typing on iPhone. The Apple 
Wireless Keyboard connects via Bluetooth, so you must first pair it with iPhone. See Pairing 
Bluetooth devices on page 32.
Once the keyboard is paired, it connects whenever the keyboard is within range of iPhone—up to 
about 33 feet (10 meters). When a wireless keyboard is connected, the onscreen keyboard doesn’t 
appear when you tap a text field. To save the battery, turn off the keyboard when not in use.
Switch the language when using a wireless keyboard: Press Command–Space bar to display a 
list of available languages. Press the Space bar again while holding down the Command key to 
choose a different language.
Turn off a wireless keyboard: Hold down the power button on the keyboard until the green 
light goes off. 
iPhone disconnects the keyboard when the keyboard is turned off or out of range.
Unpair a wireless keyboard: Go to Settings > Bluetooth, tap  next to the keyboard name, 
then tap “Forget this Device.”Chapter  3    Basics 25
Dictation
On iPhone 4S or later, you can dictate text instead of typing. To use dictation, Siri must be 
turned on and iPhone must be connected to the Internet. You can include punctuation and give 
commands to format your text.
Note:  Cellular data charges may apply.
Turn on dictation: Go to Settings > General > Siri, then turn on Siri.
Dictate text: From the onscreen keyboard, tap  , then speak. When you finish, tap Done.
Tap to begin dictation. Tap to begin dictation.
These appear while Siri 
composes the text from 
your dictation.
These appear while Siri 
composes the text from 
your dictation.
To add text, tap  again and continuing dictating. To insert text, tap to place the insertion point 
first. You can also replace selected text by dictating.
You can bring iPhone to your ear to start dictation, instead of tapping  on the keyboard. To 
finish, move iPhone back down in front of you.
Add punctuation or format text: Say the punctuation or formatting command. 
For example, “Dear Mary comma the check is in the mail exclamation mark” results in “Dear Mary, 
the check is in the mail!”
Punctuation and formatting commands include:
• quote … end quote
• new paragraph
• cap—to capitalize the next word
• caps on … caps off—to capitalize the first character of each word
• all caps—to make the next word all uppercase
• all caps on … all caps off—to make the enclosed words all uppercase
• no caps on … no caps off—to make the enclosed words all lowercase
• no space on … no space off—to run a series of words together
• smiley—to insert :-)
• frowny—to insert :-(
• winky—to insert ;-)Chapter  3    Basics 26
Voice Control
Voice Control lets you make phone calls and control music playback using voice commands. On 
iPhone 4S or later, you can also use Siri to control iPhone by voice. See Chapter 4, Siri, on page 36.
Note:  Voice Control and Voice Control settings are not available when Siri is turned on.
Use Voice Control: Press and hold the Home button  until the Voice Control screen appears 
and you hear a beep. You can also press and hold the center button on your headset. See Apple 
headset on page 31.
For best results:
• Speak clearly and naturally.
• Say only iPhone commands, names, and numbers. Pause slightly between commands.
• Use full names.
Voice Control normally expects you to speak voice commands in the language that’s set for 
iPhone (in Settings > General > International > Language). Voice Control settings let you change 
the language for speaking voice commands. Some languages are available in different dialects 
or accents.
Change the language or country: Go to Settings > General > International > Voice Control, then 
tap the language or country.
Voice Control for the Music app is always on, but you can prevent voice dialing when iPhone 
is locked.
Prevent voice dialing when iPhone is locked: Go to Settings > General > Passcode Lock, then 
turn off Voice Dial (available only when Siri is turned off in Settings > General > Siri). To use voice 
dialing, you must first unlock iPhone.
For specific commands, see Making calls on page 43 and Siri and Voice Control on page 62.
For more about using Voice Control, including information about using Voice Control in different 
languages, go to support.apple.com/kb/HT3597.Chapter  3    Basics 27
Searching
You can search many of the apps on iPhone, as well as Wikipedia and the web. Search an 
individual app, or search all the apps at once using Spotlight. Spotlight also searches the names 
of apps on iPhone—if you have a lot of apps, you might want to use Spotlight to locate and 
open them.
Search an individual app: Enter text in the search field. 
Search iPhone using Spotlight: Swipe right from your first Home screen, or press the Home 
button  from any Home screen. Enter text in the search field.
Search results appear as you type. To dismiss the keyboard and see more results, tap Search. Tap 
an item in the list to open it. The icons let you know which apps the results are from. 
iPhone may display a top hit for you, based on previous searches.
Spotlight searches the following:
• Contacts—All content
• Apps—Titles
• Music—Names of songs, artists, and albums, and the titles of podcasts and videos
• Podcasts—Titles
• Videos—Titles
• Audiobooks—Titles
• Notes—Text of notes
• Calendar (Events)—Event titles, invitees, locations, and notes 
• Mail—To, From, and Subject fields of all accounts (the text of messages isn’t searched)
• Reminders—Titles
• Messages—Names and text of messages
Search the web or Wikipedia from Spotlight: Scroll to the bottom of the search results, then tap 
Search Web or Search Wikipedia.
Open an app from Search: Enter all or part of the app name, then tap the app.
Choose which items are searched, and the order they’re searched: Go to Settings > General > 
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Notifications
To help make sure you don’t miss important events, many iPhone apps can provide alerts. 
An alert can appear briefly as a banner at the top of the screen, which goes away if you don’t 
respond to it, or as a notice in the center of the screen that remains until you acknowledge it. 
Some apps can also display badges on their icons on the Home screen, to let you know how 
many new items await—for example, how many new email messages you have. If there’s a 
problem—such as a message that couldn’t be sent—an exclamation mark  appears on the 
badge. A numbered badge on a folder shows the total number of alerts for all the apps in 
the folder.
Alerts can also appear on the Lock screen. 
Respond to an alert when iPhone is locked: Swipe the alert from left to right.
Notification Center displays all your alerts in one place. So if you weren’t able to respond when 
you first received an alert, you can respond to them in Notification Center when you’re ready. 
Alerts can include:
• Missed phone calls and voice messages
• New email
• New text messages
• Reminders
• Calendar events
• Friend requests (Game Center)
You can also get the local weather, and display your personal stock ticker. If you’ve signed 
in to your Twitter and Facebook accounts, you can tweet and post to those accounts from 
Notification Center.
View Notification Center: Swipe down from the top of the screen. Scroll the list to see 
additional alerts.
• Respond to an alert:  Tap it.
• Remove an alert:  Tap  , then tap Clear.Chapter  3    Basics 29
Manage alerts for your apps: Go to Settings > Notifications. See Do Not Disturb and 
Notifications on page 132.
Choose alert sounds, adjust the alert volume, or turn vibrate on or off: Go to Settings > Sounds.
Sharing
iPhone gives you lots of way to share with other people.
Sharing within apps
In many apps, tapping  displays options for sharing, as well as other actions such as printing or 
copying. The options vary depending on the app you’re using.
Facebook
Sign in to your Facebook account (or create a new account) in Settings to enable posting directly 
from many of the apps on iPhone.
Sign in to or create a Facebook account: Go to Settings > Facebook.
Post from Notification Center: Tap “Tap to Post.” 
Post using Siri: Say “Post to Facebook ….”
Post an item from an app: In most apps, tap  . In Maps, tap  , tap Share Location, then 
tap Facebook.
Set options for Facebook: Go to Settings > Facebook to:
• Update Contacts on iPhone with Facebook names and photos
• Allow App Store, Calendar, Contacts, or iTunes to use your account
Install the Facebook app: Go to Settings > Facebook, then tap Install. 
Twitter
Sign in to your Twitter account (or create a new account) in Settings to enable Tweets with 
attachments from many of the apps on iPhone.
Sign in to or create a Twitter account: Go to Settings > Twitter. 
Tweet from Notification Center: Tap “Tap to Tweet.” 
Tweet using Siri: Say “Tweet ….”
Tweet an item from an app: View the item, tap  , then tap Twitter. If  isn’t showing, tap the 
screen. To include your location, tap Add Location.
Tweet a location in Maps: Tap the location pin, tap  , tap Share Location, then tap Twitter. Chapter  3    Basics 30
When you’re composing a Tweet, the number in the lower-right corner of the Tweet screen 
shows the number of characters remaining that you can enter. Attachments use some of a 
Tweet’s 140 characters.
Add Twitter user names and photos to your contacts: Go to Settings > Twitter, then tap 
Update Contacts.
Install the Twitter app: Go to Settings > Twitter, then tap Install. 
To learn how to use the Twitter app, open the app, tap Me, then tap Help.
Connecting iPhone to a TV or other device
You can use AirPlay with Apple TV to stream content to an HDTV, or connect iPhone to your TV 
using cables.
AirPlay
With AirPlay, you can stream music, photos, and video wirelessly to Apple TV and other 
AirPlay-enabled devices. The AirPlay controls appear when an AirPlay-enabled device is available 
on the same Wi-Fi network that iPhone is connected to. You can also mirror the contents of 
your iPhone screen on a TV.
Stream content to an AirPlay-enabled device: Tap  , then choose the device.
Access the AirPlay and volume controls while using any app: When the screen is on, 
double-click the Home button  and scroll to the left end of the multitasking bar.
Switch playback back to iPhone: Tap  , then choose iPhone
Mirror the iPhone screen on a TV: Tap  at the left end of the multitasking bar, choose an 
Apple TV, then tap Mirroring. A blue bar appears at the top of the iPhone screen when AirPlay 
mirroring is turned on. Everything on the iPhone screen appears on the TV. 
Connecting iPhone to a TV using a cable
Apple cables and adapters (available separately) may be used to connect iPhone to a TV, 
projector, or other external display. For more information, go to support.apple.com/kb/HT4108.
Printing with AirPrint
AirPrint lets you print wirelessly to AirPrint-enabled printers from the following iOS apps:
• Mail—email messages and attachments that can be viewed in Quick Look
• Photos and Camera—photos
• Safari—webpages, PDFs, and other attachments that can be viewed in Quick Look
• iBooks—PDFs
• Maps—the portion of the map showing on the screen
• Notes—the currently displayed note
Other apps available from the App Store may also support AirPrint.
iPhone and the printer must be on the same Wi-Fi network. For more information about AirPrint, 
go to support.apple.com/kb/HT4356.Chapter  3    Basics 31
Print a document: Tap  or  (depending on the app you’re using), then tap Print.
See the status of a print job: Double-click the Home button  , then tap Print Center in the 
multitasking bar. The badge on the icon shows how many documents are ready to print, 
including the current one.
Cancel a print job: In Print Center, select the print job, if necessary, then tap Cancel Printing.
Apple headset
The Apple EarPods with Remote and Mic (iPhone 5) and the Apple Earphones with Remote and 
Mic (iPhone 4S or earlier) feature a microphone, volume buttons, and an integrated button that 
allows you to answer and end calls, and control audio and video playback.
Center button Center button
Plug in the headset to listen to music or make a phone call. Press the center button to control 
music playback and answer or end calls, even when iPhone is locked.
Adjust the volume: Press the  or  button.
Use the center button to control music playback:
• Pause a song or video:  Press the center button. Press again to resume playback.
• Skip to the next song:  Press the center button twice quickly.
• Return to the previous song:  Press the center button three times quickly.
• Fast-forward:  Press the center button twice quickly and hold.
• Rewind:  Press the center button three times quickly and hold.
Use the center button to answer or make phone calls:
• Answer an incoming call:  Press the center button.
• End the current call:  Press the center button.
• Decline an incoming call:  Press and hold the center button for about two seconds, then let go. 
Two low beeps confirm you declined the call.
• Switch to an incoming or on-hold call, and put the current call on hold:  Press the center button. 
Press again to switch back to the first call.
• Switch to an incoming or on-hold call, and end the current call:  Press and hold the center button 
for about two seconds, then let go. Two low beeps confirm you ended the first call.
Use Siri or Voice Control: Press and hold the center button. 
See Chapter 4, Siri, on page 36 or Voice Control on page 26.
If you get a call while the headset is plugged in, you can hear the ringtone through both the 
iPhone speaker and the headset.Chapter  3    Basics 32
Bluetooth devices
You can use iPhone with the Apple Wireless Keyboard and other Bluetooth devices, such as 
Bluetooth headsets, car kits, and stereo headphones. For supported Bluetooth profiles, go to 
support.apple.com/kb/HT3647.
Pairing Bluetooth devices
WARNING:  For important information about avoiding hearing loss and avoiding distraction 
while driving, see Important safety information on page 146.
Before you can use a Bluetooth device with iPhone, you must first pair them.
Pair a Bluetooth device with iPhone:
1 Make the device discoverable.
See the documentation that came with the device. For an Apple Wireless Keyboard, press the 
power button.
2 Go to Settings > Bluetooth and turn Bluetooth on.
3 Select the device and, if prompted, enter the passkey or PIN. See the instructions about the 
passkey or PIN that came with the device.
For information about using an Apple Wireless Keyboard, see Apple Wireless Keyboard on 
page 24.
To use a Bluetooth headset with iPhone, see the documentation that came with the device. 
Return audio output to iPhone when a Bluetooth headset is connected: Turn off or unpair the 
device, or turn off Bluetooth in Settings > Bluetooth. Audio output returns to iPhone whenever 
the device is out of range. You can also use AirPlay  to switch audio output to iPhone. See 
AirPlay on page 30.
Bluetooth status
After you pair a device with iPhone, the Bluetooth icon appears in the status bar at the top of 
the screen:
• or  : Bluetooth is on and paired with a device. (The color depends on the current color of 
the status bar.)
• : Bluetooth is on and paired with a device, but the device is out of range or turned off.
• No Bluetooth icon: Bluetooth is not paired with a device.
Unpairing a Bluetooth device from iPhone
You can unpair a Bluetooth device if you don’t want to use it with iPhone any more.
Unpair a Bluetooth device: Go to Settings > Bluetooth and turn on Bluetooth. Tap  next to 
the device name, then tap “Forget this Device.”Chapter  3    Basics 33
File sharing
You can use iTunes to transfer files between iPhone and your computer. You can also view files 
received as email attachments on iPhone. See Reading mail on page 51. If you have the same 
apps that work with iCloud on more than one device, you can use iCloud to automatically keep 
your documents up to date across all your devices. See iCloud on page 15.
Transfer files using iTunes: Connect iPhone to your computer using the included cable. In 
iTunes on your computer, select iPhone, then click the Apps button. Use the File Sharing section 
to transfer documents between iPhone and your computer. Apps that support file sharing 
appear in the File Sharing Apps list in iTunes. To delete a file, select the file in the Files list, then 
press the Delete key.
Security features
Security features help protect the information on iPhone from being accessed by others.
Passcodes and data protection
For security, you can set a passcode that you must enter each time you turn on or wake up 
iPhone, or when you access the passcode lock settings.
Setting a passcode turns on data protection, which uses your passcode as the key for encrypting 
mail messages and attachments stored on iPhone. (Some apps available from the App Store may 
also use data protection.) A notice at the bottom of the Passcode Lock screen in Settings shows 
that data protection is enabled.
Important:  On an iPhone 3GS that didn’t ship with iOS 4 or later, you must also restore iOS 
software to enable data protection. See Updating and restoring iPhone software on page 152.
Set a passcode: Go to Settings > General > Passcode Lock, then tap Turn Passcode On and enter 
a 4-digit passcode. 
Use a more secure passcode: To increase security, turn off Simple Passcode and use a longer 
passcode with a combination of numbers, letters, punctuation, and special characters. 
To unlock iPhone when it’s protected by a combination passcode, you enter the passcode using 
the keyboard. If you prefer to unlock iPhone using the numeric keypad, you can set up a longer 
passcode using numbers only.
Prevent access to Siri when iPhone is locked: Go to Settings > General > Passcode Lock, then 
turn Siri off.
Prevent voice dialing when iPhone is locked: Go to Settings > General > Passcode Lock, then 
turn Voice Dial off. (Available only when Siri is turned off in Settings > General > Siri.)
See Passcode Lock on page 136.Chapter  3    Basics 34
Find My iPhone
Find My iPhone can help you locate and secure your iPhone using the free Find My iPhone 
app on another iPhone, iPad, or iPod touch, or using a Mac or PC web browser signed in to 
www.icloud.com.
Find My iPhone includes:
• Play Sound: Play a sound for two minutes.
• Lost mode: You can immediately lock your missing iPhone with a passcode and send it a 
message displaying a contact number. iPhone also tracks and reports its location, so you can 
see where it’s been when you check the Find My iPhone app.
• Erase iPhone: Protects your privacy by erasing all the information and media on your iPhone 
and restoring iPhone to its original factory settings.
Important:  To use these features, Find My iPhone must have been turned on in iCloud settings 
on your iPhone before it was lost, and iPhone must be connected to the Internet.
Turn on Find My iPhone: Go to Settings > iCloud, then turn on Find My iPhone.
Battery
iPhone has an internal, lithium-ion rechargeable battery. For more information about the 
battery—including tips for maximizing battery life—go to www.apple.com/batteries. 
WARNING:  For important safety information about the battery and charging iPhone, see 
Important safety information on page 146. 
Charge the battery: Connect iPhone to a power outlet using the included cable and USB 
power adapter.
Note:  Connecting iPhone to a power outlet can start an iCloud backup or wireless iTunes 
syncing. See Backing up iPhone on page 150 and Syncing with iTunes on page 16.
Charge the battery and sync iPhone using a computer: Connect iPhone to your computer 
using the included cable. Or connect iPhone to your computer using the included cable and the 
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Unless your keyboard has a high-power USB 2.0 or 3.0 port, you must connect iPhone to a 
USB 2.0 or 3.0 port on your computer.
Important:  The iPhone battery may drain instead of charge if iPhone is connected to a computer 
that’s turned off or is in sleep or standby mode.
The battery icon in the upper-right corner shows the battery level or charging status.
Charging Charging Charged Charged
Display the percentage of battery charge: Go to Settings > General > Usage and turn on the 
setting under Battery Usage.
If you charge the battery while syncing or using iPhone, it may take longer to charge. 
Important:  If iPhone is very low on power, it may display one of the following images, indicating 
that iPhone needs to charge for up to ten minutes before you can use it. If iPhone is extremely 
low on power, the display may be blank for up to two minutes before one of the low-battery 
images appears.
or or
Rechargeable batteries have a limited number of charge cycles and may eventually need to 
be replaced. 
Replace the battery: The iPhone battery isn’t user replaceable; it can be replaced only by an 
authorized service provider. See www.apple.com/batteries/replacements.html.4
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Siri
What is Siri?
Siri is the intelligent personal assistant that helps you get things done just by talking. Siri 
understands natural speech, so you don’t have to learn specific commands or remember 
keywords. You can ask things in different ways. For example, you can say “Set the alarm for 
6:30 a.m.” or “Wake me at 6:30 in the morning.” Either way, Siri gets it.
WARNING:  For important information about avoiding distraction while driving, see Important 
safety information on page 146.
Note:  Siri is available on iPhone 4S or later, and requires Internet access. Cellular data charges 
may apply.
Siri lets you write and send a message, schedule a meeting, place a phone call, get directions, 
set a reminder, search the web, and much more—simply by talking naturally. Siri asks a question 
if it needs clarification or more information. Siri also uses information from your contacts, music 
library, calendars, reminders, and so forth to understand what you’re talking about.
Siri works seamlessly with most of the built-in apps on iPhone, and uses Search and Location 
Services when needed. You can also ask Siri to open an app for you.
There’s so much you can say to Siri—here are some more examples, for starters:
• Call Joe
• Set the timer for 30 minutes
• Directions to the nearest Apple store
• Is it going to rain tomorrow?
• Open Passbook
• Post to Facebook
• TweetChapter  4    Siri 37
Using Siri
Starting Siri
Siri comes to life with the press of a button.
Start Siri: Press the Home button  until Siri appears. If you didn’t turn Siri on when you set up 
iPhone, go to Settings > General > Siri.
You’ll hear two quick beeps and see “What can I help you with?” on the screen. 
Just start speaking. The microphone icon lights up to let you know that Siri hears you talking. 
Once you’ve started a dialogue with Siri, tap the microphone icon to talk to it again.
Siri waits for you to stop speaking, but you can also tap the microphone icon to tell Siri 
you’re done. This is useful when there’s a lot of background noise. It can also speed up your 
conversation with Siri, since Siri won’t have to wait for your pause.
When you stop speaking, Siri displays what it heard and provides a response. Siri often includes 
related info that might be useful. If the info is related to an app—for example, a text message 
you’ve composed, or a location you asked for—just tap the display to open the app for details 
and further action.
What Siri heard 
you say
What Siri heard 
you say
Tap to speak to Siri. Tap to speak to Siri.
Siri’s response Siri’s response
Related info—tap to
open the app.
Related info—tap to
open the app.
Siri may ask you for clarification in order to complete a request. For example, tell Siri to “Remind 
me to call mom,” and Siri may ask “What time would you like me to remind you?” 
Cancel a request: Say “cancel,” tap  , or press the Home button  .
Stop a phone call you started with Siri: Before the Phone app opens, press the Home button  . 
If Phone is already open, tap End.Chapter  4    Siri 38
Telling Siri about yourself
The more Siri knows about you, the more it can use your information to help you. Siri gets your 
information from your personal info card (“My Info”) in Contacts.
Tell Siri who you are: Go to Settings > General > Siri > My Info, then tap your name.
Put your home and work addresses on your card, so you can say things like “How do I get home?” 
and “Remind me to call Bob when I get to work.” 
Siri also wants to know about the important people in your life, so put those relationships on 
your personal info card—Siri can help you. For example, the first time you tell Siri to call your 
sister, Siri asks you who your sister is (if you don’t already have that info on your card). Siri adds 
that relationship to your personal info card so it doesn’t have to ask next time. 
Create cards in Contacts for all your important relationships, and include information such as 
phone numbers, email addresses, home and work addresses, and nicknames you like to use.
Onscreen guide
Siri prompts you with examples of things you can say, right on screen. Ask Siri “what can you 
do” or tap  when Siri first appears. Siri displays a list of the apps it supports, with an example 
request. Tap an item in the list to more examples.Chapter  4    Siri 39
Raise to Speak
You can start talking to Siri just by bringing iPhone to your ear, like making a phone call. If 
the screen isn’t on, first press the Sleep/Wake or Home button. You’ll hear two quick beeps to 
indicate Siri is listening. Then start talking.
Turn on Raise to Speak: Go to Settings > General > Siri.
If Siri doesn’t respond when you bring iPhone to your ear, start with the screen facing you, so 
your hand rotates on the way up.
Handsfree Siri
You can use Siri with the headset that came with iPhone, and with other compatible wired or 
Bluetooth headsets.
Talk to Siri using a headset: Press and hold the center button (or the call button on a 
Bluetooth headset).
To continue a conversation with Siri, press and hold the button each time you want to talk. 
When you use a headset, Siri speaks its responses to you. Siri reads back text messages and email 
messages that you’ve dictated before sending them. This gives you a chance to change the 
message if you want. Siri also reads back the subjects of reminders before creating them.
Location Services
Because Siri knows locations (iPhone 4S or later) like “current,” “home,” and “work,” it can remind 
you to do a certain task when you leave a location or arrive at a location. Tell Siri “Remind me to 
call my daughter when I leave the office,” and Siri does just that.
Location information isn’t tracked or stored outside iPhone. You can still use Siri if you turn 
Location Services off, but Siri won’t do anything that requires location information.
Turn off Location Services for Siri: Go to Settings > Privacy > Location Services.
Accessibility
Siri is accessible to blind and visually impaired users through VoiceOver, the screen reader built 
into iOS. VoiceOver describes aloud what’s onscreen—including any text in Siri’s responses—so 
you can use iPhone without seeing it.
Turn on VoiceOver: Go to Settings > General > Accessibility.
Turning on VoiceOver causes even your notifications to be read aloud for you. For more 
information, see VoiceOver on page 115.Chapter  4    Siri 40
Setting options for Siri
Turn Siri on or off: Go to Settings > General > Siri.
Note:  Turning Siri off resets Siri, and Siri forgets what it’s learned about your voice.
Set options for Siri: Go to Settings > General > Siri.
• Language: Select the language you want to use with Siri.
• Voice Feedback: By default, Siri speaks its responses only when you hold iPhone to your ear or 
use Siri with a headset. If you want Siri to always speak its responses, set this option to Always.
• My Info: Let Siri know which card in Contacts contains your personal info. See Telling Siri about 
yourself on page 38.
• Raise to Speak: Talk to Siri by bringing iPhone to your ear when the screen is on. To turn this 
feature on or off, go to Settings > General > Siri.
Allow or prevent access to Siri when iPhone is locked with a passcode: Go to Settings > 
General > Passcode Lock.
You can also disable Siri by turning on restrictions. See Restrictions on page 137. 
Restaurants
Siri works with Yelp, OpenTable, and others to provide information about restaurants and help 
you make reservations. Ask to find restaurants by cuisine, price, location, outdoor seating, or a 
combination of options. Siri can show you available photos, Yelp stars, price range, and reviews. 
Get more information by using the Yelp and OpenTable apps—iPhone prompts you to download 
them if you don’t already have them installed.
See detailed info about a restaurant: Tap a restaurant that Siri suggests.
Find the location in 
Maps.
Find the location in 
Maps.
See Yelp reviews. See Yelp reviews.
Call the restaurant. Call the restaurant.
Visit the website. Visit the website.
Make a reservation 
through OpenTable.
Make a reservation 
through OpenTable.Chapter  4    Siri 41
Movies
Ask Siri about what movies are playing, or where you can see a specific movie. Find out when a 
film premiered, who directed it and what awards it won. Siri gives theater locations, show times, 
and Rotten Tomato reviews.
See detailed info about a movie: Tap a movie that Siri suggests.
Get theaters and 
showtimes.
Get theaters and 
showtimes.
Watch the trailer. Watch the trailer.
Read Rotten Tomato 
reviews.
Read Rotten Tomato 
reviews.
Sports
Siri knows a lot about sports—including baseball, basketball, football, soccer, and hockey. Ask Siri 
for game schedules, scores from the current season’s games, or up-to-the minute scores from live 
games. Tell Siri to show you player stats and compare them against other players’ stats. Siri tracks 
team records, too. Here are some things you might ask:
• What was the score of the last Giants game?
• What are the National League standings?
• When is the Chicago Cubs first game of the season?
Dictation
When Siri is turned on, you can also dictate text. See Dictation on page 25.
Although you can compose email, text messages, and other text by talking directly with Siri, 
you might prefer dictation. Dictation lets you edit a message instead of replacing the entire text. 
Dictation also gives you more time to think while composing. 
Siri understands a pause to mean you finished talking for the moment, and takes that 
opportunity to respond. While this lets you have a natural conversation with Siri, Siri might 
interrupt you before you’re really done if you pause too long. With dictation, you can pause as 
much as you like, and resume talking when you’re ready.
You can also start composing text using Siri, then continue using dictation. For example, you 
can create an email with Siri, then tap the draft to open the message in Mail. In Mail, you can 
complete or edit the message and make other changes, such as adding or removing recipients, 
revising the subject, or changing the account you’re sending the email from.Chapter  4    Siri 42
Correcting Siri
If Siri is having trouble
Siri may sometimes have trouble understanding you—in a noisy environment, for example. If you 
speak with an accent, it can take Siri some time to get used to your voice. If Siri doesn’t hear you 
exactly right, you can make corrections.
Siri shows what it heard you say, along with its response. 
Correct what Siri hears you say: Tap the bubble showing what Siri heard you say. Edit your 
request by typing, or tap  on the keyboard to dictate.
For information about using dictation, see Dictation on page 41.
If some of the text is underlined in blue, tap it and Siri suggests some alternatives. Tap one of the 
suggestions, or replace the text by typing or dictating.
Correct Siri by voice: Tap  , then restate or clarify your request. For example, “I meant Boston.”
When correcting Siri, don’t say what you don’t want—just tell Siri what you do want.
Correct a mail or text message: If Siri asks if you want to send the message, say something like:
• Change it to: Call me tomorrow.
• Add: See you there question mark.
• No, send it to Bob.
• No. (to keep the message without sending it)
• Cancel.
To have Siri read the message to you, say “Read it back to me” or “Read me the message.” If it’s 
correct, say something like “Yes, send it.”
Noisy environments
In a noisy environment, hold iPhone close to your mouth, but don’t talk directly into the bottom 
edge. Continue to speak clearly and naturally. Tap  when you finish speaking.
You can also try holding iPhone to your ear to speak to Siri.
Network connection
Siri might tell you it’s having trouble connecting to the network. Because Siri relies on Apple 
servers for voice recognition and other services, you need to have a good 3G, 4G, or LTE cellular 
connection or a Wi-Fi connection to the Internet. 5
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Phone
Phone calls
Making calls
Making a call on iPhone is as simple as tapping a name or number in your contacts, using Siri 
to say “call Bob” (iPhone 4S or later), tapping one of your favorites, or tapping a recent call to 
return it. 
Call a favorite with a single tap. Call a favorite with a single tap.
View your recent incoming and outgoing calls to 
return a call or get more info. The red badge 
indicates the number of missed calls.
View your recent incoming and outgoing calls to 
return a call or get more info. The red badge 
indicates the number of missed calls.
Call, email, or text someone
in your contacts list.
Call, email, or text someone
in your contacts list.
Dial manually. Dial manually.
View a list of
your voicemail 
messages.
View a list of
your voicemail 
messages.
WARNING:  For important information about avoiding distraction, see Important safety 
information on page 146. 
Buttons at the bottom of the Phone screen give you quick access to your favorites, recent calls, 
your contacts, and a numeric keypad for dialing manually.Chapter  5    Phone 44
Manually dial a number: Tap Keypad, enter the number, then tap Call.
• Paste a number to the keypad:  Tap the screen above the keyboard, then tap Paste.
• Enter a soft (2-second) pause:  Touch the “*” key until a comma appears.
• Enter a hard pause (to pause dialing until you tap the Dial button):  Touch the “#” key until a 
semicolon appears.
• Redial the last number:  Tap Keypad, tap Call to display the number, then tap Call again.
Add a contact to Favorites: In Contacts, tap “Add to Favorites” at the bottom of a contact card. To 
delete or rearrange your favorites list, tap Edit.
Use Siri or Voice Control: Press and hold the Home button  , say call or dial, then say the name 
or number. You can add at home, work, or mobile. See Chapter 4, Siri, on page 36 and Voice 
Control on page 26.
For best results, speak the full name of the person you’re calling. When voice dialing a number, 
speak each digit separately—for example, four one five, five five five, one two one two. For the 800 
area code in the U.S., you can say eight hundred.
Receiving calls
Answer a call: Tap Answer. If iPhone is locked, drag the slider. You can also press the center 
button on your headset.
Silence a call: Press the Sleep/Wake button or either volume button. You can still answer the call 
after silencing it, until it goes to voicemail.
Reply to an incoming call with a text message: Swipe  up, tap “Reply with Message,” then 
choose a reply or tap Custom. To create your own default replies, go to Settings > Phone > “Reply 
with Message” and replace any of the default messages.
Remind yourself to return an incoming call: Swipe  up, tap Remind Me Later, then choose 
when you want to be reminded.
Decline a call and send it directly to voicemail: Do one of the following:
• Press the Sleep/Wake button twice quickly.
• Press and hold the center button on your headset for about two seconds. Two low beeps 
confirm that the call was declined.
• Tap Decline (if iPhone is awake when the call comes in).
Block calls and maintain Wi-Fi access to the Internet: Go to Settings and turn on Airplane 
Mode, then tap Wi-Fi to turn it on.
Set iPhone to Do Not Disturb ( ): Go to Settings and turn on Do No Disturb. See Do Not 
Disturb and Notifications on page 132.
When iPhone is turned off, in airplane mode, or set to Do Not Disturb, incoming calls go directly 
to voicemail.Chapter  5    Phone 45
While on a call
When you’re on a call, the screen shows call options. 
Mute your line.  
iPhone 4 or later: Touch and
hold to put your call on hold.
Mute your line.  
iPhone 4 or later: Touch and
hold to put your call on hold.
Dial a number 
or enter 
numbers.
Dial a number 
or enter 
numbers.
Use the
speakerphone
or a Bluetooth
device.
Use the
speakerphone
or a Bluetooth
device.
Get contact 
info.
Get contact 
info.
Make another Make a FaceTime call. Make a FaceTime call.
call.
Make another
call.
Use another app during a call: Press the Home button  , then open the app. To return to the 
call, tap the green bar at the top of the screen.
End a call: Tap End. Or press the center button on your headset.
Respond to a second incoming call:
• Ignore the call and send it to voicemail: Tap Ignore.
• Put the first call on hold and answer the new one: Tap Hold Call + Answer.
• End the first call and answer the new one: When using a GSM network, tap End Call + Answer. 
With a CDMA network, tap End Call and when the second call rings back, tap Answer, or drag 
the slider if the phone is locked.
If you’re on a FaceTime video call, you can either end the video call and answer the incoming call, 
or decline the incoming call.
Switch between calls: Tap Swap. The active call is put on hold. With CDMA, you can’t switch 
between calls if the second call was outgoing, but you can merge the calls. If you end the second 
call or the merged call, both calls are terminated.
Merge calls: Tap Merge Calls. With CDMA, you can’t merge calls if the second call was incoming.
Conference calls
With GSM, you can set up a conference call with up to five people at a time, depending on 
your carrier.
Create a conference call: While on a call, tap Add Call, make another call, then tap Merge Calls. 
Repeat to add more people to the conference.
• Drop one person:  Tap Conference, tap  next to a person, then tap End Call.
• Talk privately with one person:  Tap Conference, then tap Private next to the person. Tap Merge 
Calls to resume the conference.
• Add an incoming caller:  Tap Hold Call + Answer, then tap Merge Calls.
Note:  You can’t make a FaceTime video call when you’re on a conference call.Chapter  5    Phone 46
Using a Bluetooth device
For information about using a Bluetooth device, see the documentation that came with the 
device. See Pairing Bluetooth devices on page 32.
Bypass your Bluetooth device:
• Answer a call by tapping the iPhone screen.
• During a call, tap Audio and choose iPhone or Speaker Phone.
• Turn off Bluetooth in Settings > Bluetooth.
• Turn off the Bluetooth device, or move out of range. You must be within about 30 feet 
(10 meters) of a Bluetooth device for it to be connected to iPhone.
Emergency calls
Make an emergency call when iPhone is locked: On the Enter Passcode screen, tap 
Emergency Call.
Important:   iPhone can be used to make an emergency call in many locations, provided 
that cellular service is available, but it should not be relied on for emergencies. Some cellular 
networks may not accept an emergency call from iPhone if iPhone is not activated, if iPhone 
is not compatible with or configured to operate on a particular cellular network, or (when 
applicable) if iPhone does not have a SIM card or if the SIM card is PIN-locked.
In the U.S., location information (if available) is provided to emergency service providers when 
you dial 911.
With CDMA, when an emergency call ends, iPhone enters emergency call mode for a few minutes 
to allow a call back from emergency services. During this time, data transmission and text 
messages are blocked.
Exit emergency call mode (CDMA): Do one of the following:
• Tap the back button.
• Press the Sleep/Wake button or the Home button  .
• Use the keypad to dial a non-emergency number.Chapter  5    Phone 47
FaceTime
With iPhone 4 or later, you can make a video call to someone with a Mac or other iOS device that 
supports FaceTime. The FaceTime camera lets you talk face-to-face; switch to the iSight camera 
on the back to share what you see around you.
Note:  On iPhone 3GS or iPhone 4, you need a Wi-Fi connection to the Internet. On iPhone 4S or 
later, you can also make FaceTime calls over a cellular data connection. Cellular data charges may 
apply. To turn off FaceTime using cellular data, go to Settings > General > Cellular.
Make a FaceTime call: In Contacts, choose a name, tap FaceTime, then tap the phone number or 
email address that the person uses for FaceTime.
To call someone who has an iPhone 4 or later, you can start by making a voice call, then 
tap FaceTime.
Switch cameras. Switch cameras.
Drag your image
to any corner.
Drag your image
to any corner.
Mute (you can hear 
and see; the caller 
can see but
not hear).
Mute (you can hear 
and see; the caller 
can see but
not hear).
Note:  With FaceTime, your phone number is displayed even if caller ID is blocked or turned off.
Use Siri or Voice Control: Press and hold the Home button  , then say “FaceTime,” followed by 
the name of the person to call.
Set FaceTime options: Go to Settings > FaceTime to:
• Turn FaceTime on or off
• Specify your Apple ID or an email address for receiving FaceTime calls
Visual voicemail
Visual voicemail lets you see a list of your messages and choose which ones to listen to or delete, 
without having to listen to instructions or prior messages. The badge on the Voicemail icon tells 
you how many unheard messages you have.
Set up visual voicemail: The first time you tap Voicemail, you’re prompted to create a voicemail 
password and record your voicemail greeting.
Listen to a voicemail message: Tap Voicemail, then tap a message. To listen again, select the 
message and tap  . If visual voicemail isn’t available with your service, tap Voicemail and follow 
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Check voicemail from another phone: Dial your own number or your carrier’s remote 
access number.
Drag the playhead 
to skip to any point 
in a message.
Drag the playhead 
to skip to any point 
in a message.
Unheard messages Unheard messages
Play/pause Play/pause
Contact info Contact info
Speakerphone
(Audio, when a 
Bluetooth device is 
connected. Tap to 
choose audio output.)
Speakerphone
(Audio, when a 
Bluetooth device is 
connected. Tap to 
choose audio output.)
Return the call. Return the call.
Messages are saved until you delete them or your carrier erases them.
Delete a message: Swipe or tap the message, then tap Delete.
Note:  In some areas, deleted messages may be permanently erased by your carrier.
Manage deleted messages: Tap Deleted Messages (at the end of the messages list), then:
• Listen to a deleted message:  Tap the message.
• Undelete a message:  Tap the message and tap Undelete.
• Delete messages permanently:  Tap Clear All.
Change your greeting: Tap Voicemail, tap Greeting, tap Custom, then tap Record and say your 
greeting. Or, to use your carrier’s generic greeting, tap Default.
Set an alert sound for new voicemail: Go to Settings > Sounds, then tap New Voicemail. 
Note:  If the Ring/Silent switch is off, iPhone won’t sound alerts.
Change the voicemail password: Go to Settings > Phone > Change Voicemail Password.
Contacts
From a contact’s Info screen, a quick tap lets you make a phone call, create an email message, 
find the contact’s location, and more. See Chapter 25, Contacts, on page 100.Chapter  5    Phone 49
Call forwarding, call waiting, and caller ID
The following information applies only to GSM networks. For CDMA networks, 
contact your carrier for information about enabling and using these features. See 
support.apple.com/kb/HT4515.
Turn call forwarding on or off: Go to Settings > Phone > Call Forwarding. The Call Forwarding 
icon ( ) appears in the status bar when call forwarding is on. You must be in range of the cellular 
network when you set iPhone to forward calls, or calls won’t be forwarded. FaceTime calls are 
not forwarded.
Turn call waiting on or off: Go to Settings > Phone > Call Waiting. If you’re on a call and call 
waiting is turned off, incoming calls go directly to voicemail. 
Turn caller ID on or off: Go to Settings > Phone > Show My Caller ID.
Note:  For FaceTime calls, your phone number is displayed even if caller ID is turned off.
Ringtones, Ring/Silent switch, and vibrate
iPhone comes with ringtones that sound for incoming calls, Clock alarms, and the Clock timer. 
You can also purchase ringtones from songs in iTunes. See Chapter 22, iTunes Store, on page 94.
Set the default ringtone: Go to Settings > Sounds > Ringtone.
Turn the ringer on or off: Flip the switch on the side of iPhone. 
Important:  Clock alarms still sound even if you set the Ring/Silent switch to silent.
Turn vibrate on or off: Go to Settings > Sounds.
Assign a different ringtone for a contact: In Contacts, choose a contact, tap edit, then tap 
Ringtone and choose a ringtone.
For more information, see Sounds on page 139.
International calls
For information about making international calls from your home area, including rates and other 
charges that may apply, contact your carrier or go to your carrier’s website.
When traveling abroad, you may be able to use iPhone to make calls, send and receive text 
messages, and use apps that access the Internet, depending on available networks.
Enable international roaming: Contact your carrier for information about availability and fees.
Important:  Voice, text message, and data roaming charges may apply. To avoid charges when 
roaming, turn off Voice Roaming and Data Roaming.
If you have an iPhone 4S or later that’s been activated to work on a CDMA network, you may be 
able to roam on GSM networks if the phone has a SIM card installed. When roaming on a GSM 
network, iPhone has access to GSM network features. Charges may apply. Contact your carrier for 
more information.
Set network options: Go to Settings > General > Cellular to:
• Turn data roaming on or off. 
• Turn cellular data on or off.
• Turn voice roaming on or off (CDMA).
• Use GSM networks abroad (CDMA).Chapter  5    Phone 50
Turn off cellular services: Go to Settings, turn on Airplane Mode, then tap Wi-Fi and turn Wi-Fi 
on. Incoming phone calls are sent to voicemail. To resume cellular service, turn Airplane Mode off.
Automatically add the prefix or country code for calls to the U.S.: (GSM) Go to Settings > Phone, 
then turn on Dial Assist. This lets you use contacts and favorites to make calls while abroad.
Choose a carrier: Go to Settings > Carrier. This option is available only when you’re traveling 
outside your service provider’s network, and for carriers that have roaming agreements with your 
provider. See Carrier on page 133.
Get voicemail when visual voicemail isn’t available: Dial your own number (with CDMA, add # 
after your number), or touch and hold “1” on the numeric keypad.
Setting options for Phone
Go to Settings > Phone to:
• See the phone number for your iPhone
• Change the default text message replies for incoming calls
• Turn call forwarding, call waiting, and caller ID on or off (GSM)
• Turn TTY on or off
• Change your voicemail password (GSM)
• Require a PIN to unlock your SIM when you turn iPhone on (required by some carriers)
Go to Settings > FaceTime to:
• Turn FaceTime on or off
• Use your Apple ID for FaceTime
• Add an email address for FaceTime
• Turn cellular data on or off
Go to Settings > Sounds to:
• Set ringtones and volume
• Set vibration options
• Set the sound for new voicemail6
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Mail
Reading mail
Change mailboxes or accounts. Change mailboxes or accounts.
Search this mailbox. Search this mailbox.
VIP VIP
Compose a 
message.
Compose a 
message.
Change the preview 
length in Settings > 
Mail, Contacts, 
Calendars.
Change the preview 
length in Settings > 
Mail, Contacts, 
Calendars.
Delete, move, or 
mark multiple 
messages.
Delete, move, or 
mark multiple 
messages.
Flag a message or mark it as unread: Tap  . To mark multiple messages at once, tap Edit while 
viewing the message list.
Identify messages addressed specifically to you: Go to Settings > Mail, Contacts, Calendars, 
then turn Show To/Cc Label on or off. Messages with your address in the To or Cc field are 
indicated with an icon in the message list.
See all the recipients of a message: Tap the word Details in the From field. Tap a recipient’s 
name or email address to view the recipient’s contact information or add them to Contacts or 
your VIP list.
Prevent downloading remote images: Go to Settings > Mail, Contacts, Calendars, then turn 
Load Remote Images on or off.
Open a link: Tap the link to use its default action, or touch and hold to see other actions. For 
example, for an address, you can show its location in Maps or add it to Contacts. For a web link, 
you can add it to Reading List.
Open a meeting invitation or attachment: Tap the item. If the attachment can be used by 
multiple apps, touch and hold to choose an app that works with the file.
Save an attached photo or video: Touch and hold the photo or video, then tap Save Image or 
Video. It’s saved to your Camera Roll in the Photos app.Chapter  6    Mail 52
Load new messages: Pull the message list or mailbox list down to refresh the list.
• Set the number of older messages retrieved: Go to Settings > Mail, Contacts, Calendars > Show.
Turn off new message notifications for an account: Go to Settings > Notifications > Mail > 
account name, then turn Notification Center off.
Change the tones played by Mail: Go to Settings > Sound.
• Change the tone played for new mail in each account: Go to Settings > Notifications > Mail > 
account name > New Mail Sound.
• Change the tone played for new mail from VIPs: Go to Settings > Notifications > Mail > VIP > 
New Mail Sound. 
Sending mail
Tap to change From, 
Cc, or Bcc. 
Tap to change From, 
Cc, or Bcc. 
Change your signature 
in Settings > Mail, 
Contacts, Calendars. 
Change your signature 
in Settings > Mail, 
Contacts, Calendars. 
Tap to attach a photo 
or video. 
Tap to attach a photo 
or video. 
Compose a message: Tap  , then type a name or email address. After you enter recipients, you 
can drag to move them between fields, such as from To to Cc. If you have multiple mail accounts, 
tap From to change the account you’re sending from.
Automatically Bcc yourself on outgoing messages: Go to Settings > Mail, Contacts, Calendars > 
Always Bcc Myself.
Save a draft of a message: Tap Cancel, then tap Save. The message is saved in the account’s 
Drafts mailbox. Touch and hold  to see your saved drafts.
Reply to a message: Tap  , then tap Reply. Files or images attached to the initial message aren’t 
sent back. To include the attachments, forward the message instead of replying.
Forward a message: Open a message and tap  , then tap Forward. This also forwards the 
message’s attachments.
Quote a portion of the message you’re replying to or forwarding: Touch and hold to select 
text. Drag the grab points to select the text you want to include in your reply, then tap  .
• Change the indentation level: Select the text to indent, tap  at least twice, then tap 
Quote Level.
• Automatically increase the quote level: Go to Settings > Mail, Contacts, Calendars, then turn on 
Increase Quote Level.
Send a photo or video in a message: Tap the insertion point to display the selection buttons. 
Tap  , tap Insert Photo or Video, then choose a photo or video from an album. You can also email 
multiple photos using Photos—see Sharing photos and videos on page 72.
Change your email signature: Go to Settings > Mail, Contacts, Calendars > Signature. If you have 
more than one mail account, tap Per Account to specify a different signature for each account.Chapter  6    Mail 53
Organizing mail
See messages from VIPs: Go to the mailbox list (tap Mailboxes to get there), then tap VIP.
• Add a person to the VIP list: Tap the person’s name or address in a From, To, or CC/Bcc field, then 
tap Add to VIP.
Group related messages together: Go to Settings > Mail, Contacts, Calendars, then turn 
Organize by Thread on or off.
Search messages: Open a mailbox, scroll to the top, then enter text in the Search field. You can 
search the From, To, or the Subject field in the mailbox that’s currently open. For mail accounts 
that support searching messages on the server, tap All to search From, To, Subject, and the 
message body.
Delete a message: If the message is open, Tap  .
• Delete a message without opening it: Swipe over the message title, then tap Delete.
• Delete multiple messages: While viewing the message list, tap Edit.
• Turn off deletion confirmation: Go to Settings > Mail, Contacts, Calendars > Ask Before Deleting.
Recover a message: Go to the account’s Trash mailbox, open the message, tap  , then move the 
message to the account’s Inbox or other folder.
• Set how long your messages stay in Trash before being permanently deleted: Go to Settings > 
Mail, Contacts, Calendars > account name > Account > Advanced.
Turn archiving on or off: Go to Settings > Mail, Contacts, Calendars > account name > Account > 
Advanced. When you archive a message, it moves to the All Mail mailbox. Not all mail accounts 
support archiving.
Move a message to a different mailbox: While viewing the message, tap  , then choose 
a destination.
Add, rename, or delete a mailbox: In the mailbox list, tap Edit. Some mailboxes can’t be 
renamed or deleted.
Printing messages and attachments
Print a message: Tap  , then tap Print.
Print an inline image: Touch and hold the image, then tap Save Image. Go to Photos and print 
the image from your Camera Roll album.
Print an attachment: Tap the attachment to open it in Quick Look, tap  , then tap Print.
For more information about printing, see Printing with AirPrint on page 30.Chapter  6    Mail 54
Mail accounts and settings
Change Mail and mail account settings: Go to Settings > Mail, Contacts, Calendars. You can set up:
• iCloud
• Microsoft Exchange and Outlook
• Google
• Yahoo!
• AOL
• Microsoft Hotmail
• Other POP and IMAP accounts
Settings vary based on the type of account you’re setting up. Your Internet service provider or 
system administrator can provide the information you need to enter.
Temporarily stop using an account: Go to Settings > Mail, Contacts, Calendars, choose an 
account, then turn off mail service for the account. When the service is turned off, iPhone doesn’t 
display or sync that information until you turn it back on. This is a good way to stop receiving 
work email while on vacation, for example.
Delete an account: Go to Settings > Mail, Contacts, Calendars, choose an account, then scroll 
down and tap Delete Account. All information synced with that account, such as bookmarks, 
mail, and notes, is removed.
Set Push settings: Go to Settings > Mail, Contacts, Calendars > Fetch New Data. Push delivers 
new information whenever it appears on the server and there’s an Internet connection (some 
delays may occur). When Push is turned off, use the Fetch New Data setting to determine how 
often data is requested. The setting you choose here overrides individual account settings. For 
optimal battery life, don’t fetch too often. Not all accounts support push.
Send signed and encrypted messages: Go to Settings > Mail, Contacts, Calendars > account 
name > Account > Advanced. Turn on S/MIME, then select certificates for signing and encrypting 
outgoing messages. To install certificates, you may get a configuration profile from your system 
administrator, download the certificates from the issuer’s website using Safari, or receive them as 
mail attachments.
Set advanced options: Go to Settings > Mail, Contacts, Calendars > account name > Account > 
Advanced. Options vary depending on the account, and may include:
• Store drafts, sent messages, and deleted messages on iPhone
• Set how long deleted messages are kept before being permanently removed
• Adjust mail server settings
• Adjust SSL and password settings
Ask your Internet service provider or system administrator if you’re not sure what the appropriate 
settings are for your account.7
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Safari
Safari features include:
• Reader—view articles without ads or clutter
• Reading list—collect articles to read later
• Full-screen mode—when viewing webpages in landscape orientation
Use iCloud to see pages you have open on other devices, and to keep your bookmarks and 
reading list up to date on your other devices.
Search the web and 
the current page.
Search the web and 
the current page.
Swipe through open 
webpages or open a 
new page.
Swipe through open 
webpages or open a 
new page.
Double-tap an item 
or pinch to zoom in 
or out.
Double-tap an item 
or pinch to zoom in 
or out.
Enter a web address (URL). Enter a web address (URL).
Add a bookmark, Reading List item, 
or icon to the Home Page, or share 
or print the page.
Add a bookmark, Reading List item, 
or icon to the Home Page, or share 
or print the page.
Tap the status bar to quickly scroll to the top. Tap the status bar to quickly scroll to the top.
View your reading list, history,
and bookmarks.
View your reading list, history,
and bookmarks.
View a webpage: Tap the address field (in the title bar), enter the URL, then tap Go.
• Scroll a webpage:  Drag up, down, or sideways.
• Scroll within a frame:  Drag two fingers inside the frame.
• View in full-screen landscape:  Rotate iPhone, then tap  .
• Reload a webpage:  Tap  in the address field.
Close a webpage: Tap  , then tap  by the page.Chapter  7    Safari 56
See webpages you have open on your other devices: Tap  , then tap iCloud Tabs. To share 
webpages you have open on iPhone with your other devices using iCloud Tabs, go to Settings > 
iCloud and turn on Safari.
Follow a link on a webpage: Tap the link. 
• See a link’s destination:  Touch and hold the link.
• Open a link in a new tab:  Touch and hold the link, then tap “Open in New Page.”
Detected data—such as phone numbers and email addresses—may also appear as links in 
webpages. Touch and hold a link to see the available options.
View an article in Reader: Tap the Reader button, if it appears in the address field.
• Adjust the font size:  Tap  .
• Share the article: Tap  .
Note:  When you email an article from Reader, the full text of the article is sent, in addition to 
the link.
• Return to normal view:  Tap Done.
Use Reading List to collect webpages and read them later:
• Add the current webpage:  Tap  , then tap “Add to Reading List.” With iPhone 4 or later, the 
webpage is saved as well as the link, so you can read it even when you can’t connect to 
the Internet.
• Add the destination of a link:  Touch and hold the link, then tap “Add to Reading List.”
• View your reading list:  Tap  , then tap Reading List.
• Delete an item from your reading list: Swipe the item, then tap Delete.
Fill out a form: Tap a text field to bring up the keyboard.
• Move to a different text field:  Tap the text field, or tap Next or Previous.
• Submit a form:  Tap Go, Search, or the link on the webpage to submit the form.
• Enable AutoFill:  Go to Settings > Safari > AutoFill.
Search the web, the current webpage, or a searchable PDF: Enter text in the search field.
• Search the web:  Tap one of the suggestions that appear, or tap Search.
• Find the search text on the current webpage or PDF:  Scroll to the bottom of the screen, then tap 
the entry below On This Page.
The first instance is highlighted. To find later instances, tap  .
Bookmark the current webpage: Tap  , then tap Bookmark.
When you save a bookmark, you can edit its title. By default, bookmarks are saved at the top level 
of Bookmarks. To choose a different folder, tap Bookmarks on the Add Bookmarks screen.
Create an icon on the Home screen: Tap  , then tap “Add to Home Screen.” Safari adds an 
icon for the current webpage to your Home Screen. Unless the webpage has a custom icon, that 
image is also used for the web clip icon on the Home screen. Web clips are backed up by iCloud 
and iTunes, but they aren’t pushed to other devices by iCloud or synced by iTunes.
Share or copy a link for the current webpage: Tap  , then tap Mail, Message, Twitter, Facebook, 
or Copy.
Print the current webpage: Tap  , then tap Print. See Printing with AirPrint on page 30.Chapter  7    Safari 57
Use iCloud to keep your bookmarks and reading list up to date on your other devices: Go to 
Settings > iCloud and turn on Safari. See iCloud on page 15.
Set options for Safari: Go to Settings > Safari. Options include:
• Search engine
• AutoFill for filling out forms
• Opening links in a new page or in the background
• Private browsing to help protect private information and block some websites from tracking 
your behavior
• Clearing history, cookies, and data
• Cellular data for Reading List
• Fraud warning8
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Music
Getting music
Get music and other audio content onto iPhone:
• Purchase and download from the iTunes Store:  In Music, tap Store. See Chapter 22, iTunes 
Store, on page 94. 
• Automatically download music purchased on your other iOS devices and computers:  See 
iCloud on page 15.
• Sync content with iTunes on your computer:  See Syncing with iTunes on page 16.
• Use iTunes Match to store your music library in iCloud:  See iTunes Match on page 62.
Playing music
WARNING:  For important information about avoiding hearing loss, see Important safety 
information on page 146.
You can listen to audio from the built-in speaker, headphones attached to the headset jack, or 
wireless Bluetooth stereo headphones paired with iPhone. When headphones are attached or 
paired, no sound comes from the speaker.
Open iTunes Store. Open iTunes Store.
Choose how to browse. Choose how to browse.
See additional 
browse buttons.
See additional 
browse buttons.
Tap to listen. Tap to listen.Chapter  8    Music 59
Play a track: Browse by playlist, artist, song, or other category, then tap the track.
• See additional browse buttons:  Tap More.
• Change which browse buttons appear at the bottom:  Tap More, tap Edit, then drag an icon over 
the button you want to replace.
The Now Playing screen shows you what’s playing, and provides playback controls.
Next/Fast-forward Next/Fast-forward
Play/Pause Play/Pause
Track list Track list
Back Back
Previous/ Volume Volume
Rewind
Previous/
Rewind
AirPlay AirPlay
Lyrics appear on the Now Playing screen if you’ve added them to the song using the song’s Info 
window in iTunes and you’ve synced iPhone with iTunes.
Display additional controls (iPhone 4S or earlier): Tap the album artwork on the Now Playing 
screen to display the scrubber bar and playhead, and the Repeat, Genius, and Shuffle buttons.
Skip to any point in a song: Drag the playhead along the scrubber bar. Slide your finger down 
to slow down the scrub rate.
Shake to shuffle: Shake iPhone to turn on shuffle, and to change songs. To turn Shake to Shuffle 
on or off, go to Settings > Music.
See all tracks on the album containing the current song: Tap  . To play a track, tap it.
Tap a star to rate this song for
creating smart playlists in iTunes.
Tap a star to rate this song for
creating smart playlists in iTunes.
Return to the Now 
Playing screen.
Return to the Now 
Playing screen.
Album tracks Album tracks
Search music (titles, artists, albums, and composers): While browsing, tap the status bar to 
reveal the search field at the top of the screen, then enter your search text. You can also search 
audio content from the Home screen. See Searching on page 27.Chapter  8    Music 60
Display audio controls while in another app: Double-click the Home button  , then swipe 
the multitasking bar to the right. Swipe right again to display a volume control and the AirPlay 
button  (when in range of an Apple TV or AirPlay speakers).
Current audio 
app—tap to open it.
Current audio 
app—tap to open it.
Currently playing song. Currently playing song.
Display audio controls while the screen is locked: Double-click the Home button  .
Play music on AirPlay speakers or Apple TV: Tap  . See AirPlay on page 30.
Cover Flow
When you rotate iPhone, your music content appears in Cover Flow.
Browse albums in Cover Flow: Drag left or right.
• See the tracks on an album:  Tap the album artwork or  . Drag up or down to scroll; tap a track 
to play it.
• Return to the artwork:  Tap the title bar, or tap  again.
Podcasts and audiobooks
On iPhone 5, podcast and audiobook controls and info appear on the Now Playing screen when 
you begin playback. 
Note:  The Podcasts app is available for free in the App Store. See Chapter 31, Podcasts, on 
page 113. If you install the Podcasts app, podcast content and controls are removed from Music.
Show or hide the controls and info (iPhone 4S or earlier): Tap the center of the screen.
Playhead Playhead Scrubber bar Scrubber bar
Playback speed Playback speed
Skip 15 seconds. Skip 15 seconds.
Email  Email  Repeat last 15 seconds. Repeat last 15 seconds.
Get more podcast episodes: Tap Podcasts (tap More first, if Podcasts isn’t visible), then tap a 
podcast to see available episodes. To download more episodes, tap Get More Episodes.
Hide lyrics and podcast info: Go to Settings > Music, then turn off Lyrics & Podcasts Info.Chapter  8    Music 61
Playlists
Create a playlist: View Playlists, tap Add Playlist near the top of the list, then enter a title. Tap 
to add songs and videos, then tap Done.
Edit a playlist: Select the playlist to edit, then tap Edit.
• Add more songs:  Tap  .
• Delete a song:  Tap  . Deleting a song from a playlist doesn’t delete it from iPhone.
• Change the song order:  Drag  .
New and changed playlists are copied to your iTunes library the next time you sync iPhone with 
your computer, or via iCloud if you’ve subscribed to iTunes Match.
Clear or delete a playlist: Select the playlist, then tap Clear or Delete.
Delete a song from iPhone: In Songs, swipe the song, then tap Delete. 
The song is deleted from iPhone, but not from your iTunes library on your Mac or PC, or 
from iCloud.
When iTunes Match is turned on, you can’t delete music. If space is needed, iTunes Match 
removes music for you, starting with the oldest and least played songs.
Genius
A Genius playlist is a collection of songs from your library that go together. Genius is a free 
service, but it requires an Apple ID.
A Genius Mix is a selection of songs of the same kind of music, recreated from your library each 
time you listen to the mix.
Use Genius on iPhone: Turn on Genius in iTunes on your computer, then sync iPhone with 
iTunes. Genius Mixes are synced automatically, unless you manually manage your music. You can 
also sync Genius playlists.
Browse and play Genius Mixes: Tap Genius (tap More first, if Genius isn’t visible). Swipe left or 
right to access other mixes. To play a mix, tap  .
Make a Genius playlist: View Playlists, then tap Genius Playlist and choose a song. Or, from the 
Now Playing screen, tap the screen to display the controls, then tap  .
• Replace the playlist using a different song:  Tap New and pick a song.
• Refresh the playlist:  Tap Refresh.
• Save the playlist:  Tap Save. The playlist is saved with the title of the song you picked and 
marked by  .
Edit a saved Genius playlist: Tap the playlist, then tap Edit.
• Delete a song:  Tap  .
• Change the song order:  Drag  .
Delete a saved Genius playlist: Tap the Genius playlist, then tap Delete.
Genius playlists created on iPhone are copied to your computer when you sync with iTunes.
Note:  Once a Genius playlist is synced to iTunes, you can’t delete it directly from iPhone. Use 
iTunes to edit the playlist name, stop syncing, or delete the playlist.Chapter  8    Music 62
Siri and Voice Control
You can use Siri (iPhone 4S or later) or Voice Control to control music playback. See 
Chapter 4, Siri, on page 36 and Voice Control on page 26.
Use Siri or Voice Control: Press and hold the Home button  .
• Play or pause music:  Say “play” or “play music.” To pause, say “pause,” “pause music,” or “stop.” 
You can also say “next song” or “previous song.”
• Play an album, artist, or playlist:  Say “play,” then say “album,” “artist,” or “playlist” and the name.
• Shuffle the current playlist:  Say “shuffle.”
• Find out more about the current song:  Say “what’s playing,” “who sings this song,” or “who is this 
song by.”
• Use Genius to play similar songs:  Say “Genius” or “play more songs like this.”
iTunes Match
iTunes Match stores your music library in iCloud—including songs imported from CDs—and lets 
you play your collection on iPhone and your other iOS devices and computers. iTunes Match is 
available as a paid subscription.
Subscribe to iTunes Match: In iTunes on your computer, choose Store > Turn On iTunes Match, 
then click the Subscribe button.
Once you subscribe, iTunes adds your music, playlists, and Genius Mixes to iCloud. Your songs 
that match music already in the iTunes Store are automatically available in iCloud. Other 
songs are uploaded. You can download and play matched songs at up to iTunes Plus quality 
(256 kbps DRM-free AAC), even if your original was of lower quality. For more information, see 
www.apple.com/icloud/features.
Turn on iTunes Match: Go to Settings > Music. 
Turning on iTunes Match removes synced music from iPhone, and disables Genius Mixes and 
Genius Playlists. 
Note:  If Use Cellular Data is turned on, cellular data charges may apply.
Songs are downloaded to iPhone when you play them. You can also download songs manually.
Download an album to iPhone: While browsing, tap Albums, tap an album, then tap  .
Show only music that’s been downloaded from iCloud: Go to Settings > Music, then turn off 
Show All Music (available only when iTunes Match is turned on).
Manage your devices using iTunes Match or Automatic Downloads: In iTunes on your 
computer, go to Store > View My Account. Sign in, then click Manage Devices in the “iTunes in 
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Home Sharing
Home Sharing lets you play music, movies, and TV shows from the iTunes library on your Mac or 
PC. iPhone and your computer must be on the same Wi-Fi network.
Note:  Home Sharing requires iTunes 10.2 or later, available at www.itunes.com/download. Bonus 
content, such as digital booklets and iTunes Extras, can’t be shared.
Play music from your iTunes library on iPhone:
1 In iTunes on your computer, choose Advanced > Turn On Home Sharing. Log in, then click Create 
Home Share.
2 On iPhone, go to Settings > Music, then log in to Home Sharing using the same Apple ID 
and password.
3 In Music, tap More, then tap Shared and choose your computer’s library.
Return to content on iPhone: Tap Shared and choose My iPhone.
Music settings
Go to Settings > Music to set options for Music, including:
• Shake to Shuffle
• Sound Check (to normalize the volume level of your audio content)
• Equalization (EQ)
Note:  EQ affects all sound output, including the headset jack and AirPlay. EQ settings generally 
apply only to music played from the Music app.
The Late Night setting applies to all audio output—video as well as music. Late Night 
compresses the dynamic range of the audio output, reducing the volume of loud passages 
and increasing the volume of quiet passages. You might want to use this setting when 
listening to music on an airplane or in some other noisy environment, for example.
• Lyrics and podcast info
• Grouping by album artist
• iTunes Match
• Home Sharing
Set the volume limit: Go to Settings > Music > Volume Limit, then adjust the volume slider.
Note:  In European Union countries, you can limit the maximum headset volume to the 
European Union recommended level. Go to Settings > Music > Volume Limit, then turn on 
EU Volume Limit.
Restrict changes to the volume limit: Go to Settings > General > Restrictions > Volume Limit, 
then tap Don’t Allow Changes.9
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Messages
Sending and receiving messages
WARNING:  For important information about avoiding distraction while driving, see Important 
safety information on page 146.
Messages lets you exchange text messages with other SMS and MMS devices via your cellular 
connection, and with other iOS devices using iMessage. 
iMessage is an Apple service that lets you send unlimited messages over Wi-Fi (as well as cellular 
connections) to other iOS and OS X Mountain Lion users. With iMessage, you can see when other 
people are typing, and let them know when you’ve read their messages. iMessages are displayed 
on all of your iOS devices logged in to the same account, so you can start a conversation on one 
of your devices, and continue it on another device. iMessages are encrypted for security.
Tap the attach media button to 
include a photo or video.
Tap the attach media button to 
include a photo or video.
Tap to enter text. Tap to enter text.
Blue indicates an 
iMessage
conversation.
Blue indicates an 
iMessage
conversation.
Start a text conversation: Tap  , then tap  and choose a contact, search your contacts by 
entering a name, or enter a phone number or email address manually. Enter a message, then 
tap Send.
An alert badge  appears if a message can’t be sent. Tap the alert in a conversation to try 
sending the message again. Double-tap to send the message as an SMS text message.
Resume a conversation: Tap the conversation in the Messages list.Chapter  9    Messages 65
Use picture characters: Go to Settings > General > Keyboard > Keyboards > Add New Keyboard, 
then tap Emoji to make that keyboard available. Then while typing a message, tap  to bring up 
the Emoji keyboard. See Special input methods on page 144.
See a person’s contact info: Scroll to the top (tap the status bar) to see actions you can perform, 
such as making a FaceTime call.
See earlier messages in the conversation: Scroll to the top (tap the status bar). Tap Load Earlier 
Messages if needed.
Send messages to a group (iMessage and MMS): Tap  , then enter multiple recipients. With 
MMS, group messaging must also be turned on in Settings > Messages, and replies are sent only 
to you—they aren’t copied to the other people in the group.
Managing conversations
Conversations are saved in the Messages list. A blue dot  indicates unread messages. Tap a 
conversation to view or continue it.
Forward a conversation: Tap Edit, select parts to include, then tap Forward.
Edit a conversation: Tap Edit, select the parts to delete, then tap Delete. To clear all text and 
attachments without deleting the conversation, tap Clear All.
Delete a conversation: In the Message list, swipe the conversation, then tap Delete.
Search a conversation: Tap the top of the screen to display the search field, then enter the 
text you’re looking for. You can also search conversations from the Home screen. See 
Searching on page 27.
Add someone to your contacts list: Tap a phone number in the Messages list, then tap 
“Add to Contacts.”
Sharing photos, videos, and other info
With iMessage or MMS, you can send and receive photos and videos, and send locations, contact 
info, and voice memos. The size limit of attachments is determined by your service provider—
iPhone may compress photo and video attachments when needed.
Send a photo or video: Tap  .
Send a location: In Maps, tap  for a location, tap Share Location, then tap Message.
Send contact info: In Contacts, choose a contact, tap Share Contact, then tap Message.
Send a voice memo: In Voice Memos, tap  , tap the voice memo, tap Share, then tap Message.
Save a photo or video you receive to your Camera Roll album: Tap the photo or video, 
then tap  .
Copy a photo or video: Touch and hold the attachment, then tap Copy.
Add someone to your contacts from the Messages list: Tap the phone number or email 
address, tap the status bar to scroll to the top, then tap “Add Contact.”
Save contact info you receive: Tap the contact bubble, then tap Create New Contact or 
“Add to Existing Contact.”Chapter  9    Messages 66
Messages settings
Go to Settings > Messages to set options for Messages, including:
• Turning iMessage on or off
• Notifying others when you’ve read their messages
• Specifying an Apple ID or email address to use with Messages
• SMS and MMS options
• Showing the Subject field
• Showing the character count
Manage notifications for messages: See Do Not Disturb and Notifications on page 132.
Set the alert sound for incoming text messages: See Sounds on page 139.10
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Calendar
At a glance
iPhone makes it easy to stay on schedule. You can view calendars individually, or view several 
calendars at once.
A day with a dot has 
events.
A day with a dot has 
events.
Change calendars or 
accounts.
Change calendars or 
accounts.
View invitations. View invitations.
View or edit an event: Tap the event. You can:
• Set a primary and secondary alert
• Change the event’s date, time, or duration
• Move an event to a different calendar
• Invite others to attend events on iCloud, Microsoft Exchange, and CalDAV calendars
• Delete the event
You can also move an event by holding it down and dragging it to a new time, or by adjusting 
the grab points.
Add an event: Tap  and enter event information, then tap Done.
• Set the default calendar for new events: Go to Settings > Mail, Contacts, Calendars > 
Default Calendar.
• Set default alert times for birthdays and events: Go to Settings > Mail, Contacts, Calendars > 
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Search for events: Tap List, then enter text in the search field. The titles, invitees, locations, and 
notes for the calendars you’re viewing are searched. You can also search Calendar events from 
the Home screen. See Searching on page 27.
Set the calendar alert tone: Go to Settings > Sounds > Calendar Alerts.
View by week: Rotate iPhone sideways.
Import events from a calendar file: If you receive an .ics calendar file in Mail, open the message 
and tap the calendar file to import all of the events it contains. You can also import an .ics file 
published on the web by tapping a link to the file. Some .ics files subscribe you to a calendar 
instead of adding events to your calendar. See Working with multiple calendars on page 68.
If you have an iCloud account, a Microsoft Exchange account, or a supported CalDAV account, 
you can receive and respond to meeting invitations from people in your organization.
Invite others to an event: Tap an event, tap Edit, then tap Invitees to select people 
from Contacts.
Respond to an invitation: Tap an invitation in the calendar. Or tap  to display the Event 
screen, then tap an invitation. You can view information about the organizer and other invitees. 
If you add comments, which may not be available for all types of calendars, your comments are 
visible to the organizer but not other attendees.
Accept an event without marking the time as reserved: Tap the event, then tap Availability and 
select “free.” The event stays on your calendar, but doesn’t appear as busy to others who send 
you invitations.
Working with multiple calendars
You can view individual calendars, or several calendars at once. You can subscribe to iCloud, 
Google, Yahoo!, or iCalendar calendars, as well as your Facebook events and birthdays. 
Turn on iCloud, Google, Exchange, or Yahoo! calendars: Go to Settings > Mail, Contacts, 
Calendars, tap an account, then turn on Calendar.
Add a CalDAV account: Go to Settings > Mail, Contacts, Calendars, tap Add an Account, then tap 
Other. Under Calendars, tap Add CalDAV Account.
View Facebook events: Go to Settings > Facebook, then sign in to your Facebook account and 
turn on access to Calendar.
Select calendars to view: Tap Calendars, then tap to select the calendars you want to view. The 
events for all selected calendars appear in one view.
View the Birthdays calendar: Tap Calendars, then tap Birthdays to include birthdays from 
your Contacts with your events. If you’ve set up a Facebook account, you can also include your 
Facebook friends’ birthdays.
You can subscribe to calendars that use the iCalendar (.ics) format. Many calendar-based services 
support calendar subscriptions, including iCloud, Yahoo!, Google, and the Calendar application 
in OS X. Subscribed calendars are read-only. You can read events from subscribed calendars on 
iPhone, but you can’t edit events or create new ones.
Subscribe to a calendar: Go to Settings > Mail, Contacts, Calendars, then tap Add Account. 
Tap Other, then tap Add Subscribed Calendar. Enter the server and filename of the .ics file to 
subscribe to. You can also subscribe to an iCalendar (.ics) calendar published on the web, by 
tapping a link to the calendar.Chapter  10    Calendar 69
Sharing iCloud calendars
You can share an iCloud calendar with other iCloud users. When you share a calendar, others can 
view it, and you can let them add or change events, too. You can also share a read-only version 
that anyone can view.
Create an iCloud calendar: Tap Calendars, tap Edit, then tap Add Calendar.
Share an iCloud calendar: Tap Calendars, tap Edit, then tap the iCloud calendar you want 
to share. Tap Add Person, then choose someone from Contacts. The person will receive an 
email invitation to join the calendar, but needs an Apple ID and iCloud account to accept 
your invitation.
Turn off notifications for shared calendars: Go to Settings > Mail, Contacts, Calendars and turn 
off Shared Calendar Alerts.
Change a person’s access to a shared calendar: Tap Calendars, tap Edit, then tap a person you’re 
sharing with. You can turn off their ability to edit the calendar, resend the invitation to join the 
calendar, or stop sharing with them.
Share a read-only calendar with anyone: Tap Calendars, tap Edit, then tap the iCloud calendar 
you want to share. Turn on Public Calendar, then tap Share Link to copy or send the URL for the 
calendar. Anyone can use the URL to subscribe to your calendar using a compatible app, such as 
Calendar for iOS or OS X. 
Calendar settings
There are several settings in Settings > Mail, Contacts, Calendars that affect Calendar and your 
calendar accounts. These include:
• Syncing of past events (future events are always synced)
• Alert tone played for new meeting invitations
• Calendar time zone support, to show dates and times using a different time zone11
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Photos
Viewing photos and videos
Photos lets you view photos and videos on iPhone, in your:
• Camera Roll album—photos and videos you took on iPhone, or saved from an email, text 
message, webpage, or screenshot
• Photo Stream albums—photos in My Photo Stream and your shared photo streams (see Photo 
Stream on page 71)
• Photo Library and other albums synced from your computer (see Syncing with iTunes on 
page 16)
Edit the photo. Edit the photo.
Delete the photo. Delete the photo.
Tap the screen to
display the 
controls.
Tap the screen to
display the 
controls.
Share the photo, assign it to a contact,
use it as wallpaper, or print it.
Share the photo, assign it to a contact,
use it as wallpaper, or print it.
Play a slideshow. Play a slideshow.
Stream photos using AirPlay. Stream photos using AirPlay.
View photos and videos: Tap an album, then tap a thumbnail.
• See the next or previous photo or video:  Swipe left or right.
• Zoom in or out:  Double-tap or pinch.
• Pan a photo:  Drag it.
• Play a video:  Tap  in the center of the screen. To change between full-screen and fit-to-screen 
viewing, double-tap the screen.Chapter  11    Photos 71
Albums you sync with iPhoto 8.0 (iLife ’09) or later, or Aperture v3.0.2 or later, can be viewed by 
events or by faces. You can also view photos by location, if they were taken with a camera that 
supports geotagging.
View a slideshow: Tap a thumbnail, then tap  . Select options, then tap Start Slideshow. To stop 
the slideshow, tap the screen. To set other options, go to Settings > Photos & Camera.
Stream a slideshow or video to a TV: See AirPlay on page 30.
Organizing photos and videos
Create an album: Tap Albums, tap  , enter a name, then tap Save. Select items to add to the 
album, then tap Done.
Note:  Albums created on iPhone aren’t synced back to your computer.
Add items to an album: When viewing thumbnails, tap Edit, select items, then tap Add To.
Manage albums: Tap Edit:
• Rename an album:  Select the album, then enter a new name.
• Rearrange albums:  Drag  .
• Delete an album:  Tap  .
Only albums created on iPhone can be renamed or deleted.
Photo Stream
With Photo Stream, a feature of iCloud (see iCloud on page 15), photos you take on iPhone 
automatically appear on your other devices set up with Photo Stream, including your Mac or PC. 
Photo Stream also lets you share select photos with friends and family, directly to their devices or 
on the web.
About Photo Stream
When Photo Stream is turned on, photos you take on iPhone (as well as any other photos added 
to your Camera Roll) appear in your photo stream after you leave the Camera app and iPhone 
is connected to the Internet via Wi-Fi. These photos appear in the My Photo Stream album on 
iPhone and on your other devices set up with Photo Stream.
Turn on Photo Stream: Go to Settings > iCloud > Photo Stream.
Photos added to your photo stream from your other iCloud devices also appear in My Photo 
Stream. iPhone and other iOS devices can keep up to 1000 of your most recent photos in My 
Photo Stream. Your computers can keep all your Photo Stream photos permanently.
Note:  Photo Stream photos don’t count against your iCloud storage.
Manage photo stream contents: In a photo stream album, tap Edit.
• Save photos to iPhone: Select the photos, then tap Save.
• Share, print, copy, or save photos to your Camera Roll album: Select the photos, then tap Share.
• Delete photos:  Select the photos, then tap Delete. Chapter  11    Photos 72
Note:  Although deleted photos are removed from photo streams on your devices, the 
original photos remain in the Camera Roll album on the device they originated from. Photos 
saved to a device or computer from a photo stream are also not deleted. To delete photos 
from Photo Stream, you need iOS 5.1 or later on iPhone and your other iOS devices. See 
support.apple.com/kb/HT4486.
Shared photo streams
Shared photo streams let you share selected photos with just the people you choose. iOS 6 and 
OS X Mountain Lion users can subscribe to your shared photo streams, view the latest photos 
you’ve added, “like” individual photos, and leave comments—right from their devices. You can 
also create a public website for a shared photo stream, to share your photos with others over 
the web.
Note:  Shared photo streams work over both Wi-Fi and cellular networks. Cellular data charges 
may apply.
Turn on Shared Photo Streams: Go to Settings > iCloud > Photo Stream.
Create a shared photo stream: Tap Photo Stream, then tap  . To invite other iOS 6 or 
OS X Mountain Lion users to subscribe to your shared photo stream, enter their email addresses. 
To post the photo stream on icloud.com, turn on Public Website. Name the album, then 
tap Create.
Add photos to a shared photo stream: Select a photo, tap  , tap Photo Stream, then select 
the shared photo stream. To add several photos from an album, tap Edit, select the photos, then 
tap Share.
Delete photos from a shared photo stream: Tap the shared photo stream, tap Edit, select the 
photos, then tap Delete.
Edit a shared photo stream: Tap Photo Stream, then tap  . You can:
• Rename the photo stream
• Add or remove subscribers, and resend an invitation
• Create a public website, and share the link
• Delete the photo stream
Sharing photos and videos
You can share photos in email, text messages (MMS or iMessage), photo streams, Twitter posts, 
and Facebook. Videos can be shared in email and text messages (MMS or iMessage), and 
on YouTube.
Share or copy a photo or video: Choose a photo or video, then tap  . If you don’t see  , tap 
the screen to show the controls.
The size limit of attachments is determined by your service provider. iPhone may compress 
photo and video attachments, if necessary.
You can also copy photos and videos, and then paste them into an email or text message (MMS 
or iMessage).
Share or copy multiple photos and videos: While viewing thumbnails, tap Edit, select the 
photos or videos, then tap Share. Chapter  11    Photos 73
Save a photo or video from:
• Email:  Tap to download it if necessary, tap the photo or touch and hold the video, then 
tap Save.
• Text message:  Tap the item in the conversation, tap  , than tap Save to Camera Roll.
• Webpage (photo only):  Touch and hold the photo, then tap Save Image.
Photos and videos that you receive, or that you save from a webpage, are saved to your 
Camera Roll album.
Printing photos
Print to AirPrint-enabled printers:
• Print a single photo:  Tap  , then tap Print.
• Print multiple photos:  While viewing a photo album, tap Edit, select the photos, tap Share, 
then tap Print.
See Printing with AirPrint on page 30.12
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Camera
At a glance
To quickly open Camera when iPhone is locked, swipe  up.
With iPhone, you can take both still photos and videos. In addition to the iSight camera on the 
back, there’s a FaceTime camera on the front for FaceTime calls and self-portraits. An LED flash on 
the back gives you extra light when you need it.
Tap a person or 
object to focus 
and set 
exposure.
Tap a person or 
object to focus 
and set 
exposure.
Switch 
between 
cameras.
Switch 
between 
cameras.
Take a
photo.
Take a
photo.
Camera/
Video 
switch
Camera/
Video 
switch
View the 
photos and 
videos you’ve 
taken.
View the 
photos and 
videos you’ve 
taken.
Set LED
flash mode.
Set LED
flash mode.
Turn on the grid 
or HDR, or take 
a Panorama 
photo.
Turn on the grid 
or HDR, or take 
a Panorama 
photo.
A rectangle briefly appears where the camera is focused and setting the exposure. When you 
photograph people with iPhone 4S or later, iPhone uses face detection to automatically focus on 
and balance the exposure across up to 10 faces. A rectangle appears for each face detected.
Take a photo: Tap  or press either volume button.
• Zoom in or out:  Pinch the screen (iSight camera only).Chapter  12    Camera 75
Take a panorama photo (iPhone 4S or later): Tap Options, then tap Panorama. Point iPhone 
where you want to start, then tap  . Pan slowly in the direction of the arrow, holding iPhone 
steady. Try to keep the arrow directly on top of the horizontal line. When you finish, tap Done.
• Reverse the panning direction:  Tap the arrow.
Record a video: Switch to  , then tap  or press either volume button to start or 
stop recording.
• Capture a still photo while recording:  Tap  .
When you take a photo or start a video recording, iPhone makes a shutter sound. You can control 
the volume with the volume buttons, or mute the sound using the Ring/Silent switch. 
Note:  In some countries, muting iPhone does not prevent the shutter sound.
If Location Services is turned on, photos and videos are tagged with location data that can be 
used by other apps and photo-sharing websites. See Privacy on page 140.
Set the focus and exposure:
• Set the focus and exposure for the next shot:  Tap the object on the screen. Face detection is 
temporarily turned off.
• Lock the focus and exposure:  Touch and hold the screen until the rectangle pulses. AE/AF Lock 
is displayed at the bottom of the screen, and the focus and exposure remain locked until you 
tap the screen again.
Take a screenshot: Press and release the Sleep/Wake button and the Home button  at the 
same time. The screenshot is added to your Camera Roll album.
HDR photos
HDR (iPhone 4 or later) combines three separate exposures into a single “high dynamic range” 
photo. For best results, iPhone and the subject should be stationary.
Turn on HDR: Tap Option, then set HDR. When HDR is on, the flash is turned off.
Keep the normal photo in addition to the HDR version: Go to Settings > Photos & Camera. 
When you keep both versions,  appears in the upper-left corner of the HDR photo when 
viewed in your Camera Roll album with the controls visible.
Viewing, sharing, and printing
The photos and videos you take with Camera are saved in your Camera Roll album. If you have 
Photo Stream turned on, new photos also appear in your Photo Stream album and are streamed 
to your other iOS devices and computers. See Photo Stream on page 71.
View your Camera Roll album: Swipe to the right, or tap the thumbnail image. You can also 
view your Camera Roll album in the Photos app.
• Show or hide the controls while viewing a photo or video:  Tap the screen.
• Share a photo or video:  Tap  . To send multiple photos or videos, tap  while viewing 
thumbnails, select the items, then tap Share.
• Print a photo:  Tap  . See Printing with AirPrint on page 30.
• Delete a photo or video:  Tap  .
Return to the camera: Tap  .Chapter  12    Camera 76
Upload photos and videos to your computer: Connect iPhone to your computer.
• Mac: Select the photos and videos you want, then click the Import or Download button in 
iPhoto or other supported photo application on your computer.
• PC: Follow the instructions that came with your photo application.
If you delete photos or videos from iPhone when you upload them to your computer, they’re 
removed from your Camera Roll album. You can use the Photos settings pane in iTunes to sync 
photos and videos to the Photos app on iPhone (videos can be synced only with a Mac). See 
Syncing with iTunes on page 16.
Editing photos and trimming videos
Rotate Rotate
Auto-enhance Auto-enhance
Remove red-eye Remove red-eye
Crop Crop
Edit a photo: While viewing a photo in full screen, tap Edit, then tap a tool.
• Auto-enhance:  Enhancing improves a photo’s overall darkness or lightness, color saturation, 
and other qualities. If you decide against the enhancement, tap the tool again (even if you 
saved the changes).
• Remove red-eye:  Tap each eye that needs correcting.
• Crop:  Drag the corners of the grid, drag the photo to reposition it, then tap Crop. To set a 
specific ratio, tap Constrain.
Trim a video: While viewing a video, tap the screen to display the controls. Drag either end of 
the frame viewer at the top, then tap Trim.
Important:  If you choose Trim Original, the trimmed frames are permanently deleted from 
the original video. If you choose “Save as New Clip,” a new trimmed video clip is saved in your 
Camera Roll album and the original video is unaffected.13
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Videos
Use the Videos app to watch movies, TV shows, and music videos. To watch video podcasts, 
install the free Podcasts app from the App Store. See Chapter 31, Podcasts, on page 113. To watch 
videos you record using Camera on iPhone, open the Photos app.
Swipe down to 
search.
Swipe down to 
search.
See additional 
episodes of a 
series.
See additional 
episodes of a 
series.
Tap a video to play it. Tap a video to play it.
WARNING:  For important information about avoiding hearing loss, see Important safety 
information on page 146.
Get videos:
• Buy or rent videos from the iTunes store (not available in all areas): Open the iTunes app on 
iPhone and tap Videos. See Chapter 22, iTunes Store, on page 94.
• Transfer videos from your computer: Connect iPhone, then sync videos in iTunes on your 
computer. See Syncing with iTunes on page 16.
• Stream videos from your computer: Turn on Home Sharing in iTunes on your computer. Then, 
on iPhone, go to Settings > Videos and enter the Apple ID and password you used to set up 
Home Sharing on your computer. Then, open Videos on iPhone and tap Shared at the top of 
the list of videos.Chapter  13    Videos 78
Convert a video to work with iPhone: If you try to add a video from iTunes to iPhone and a 
message says the video can’t play on iPhone, you can convert the video. Select the video in your 
iTunes library and choose Advanced > “Create iPod or iPhone Version.” Then add the converted 
video to iPhone.
Tap the video to show 
or hide controls.
Tap the video to show 
or hide controls.
Watch the video on
a TV with Apple TV.
Watch the video on
a TV with Apple TV.
Drag to skip
forward or back.
Drag to skip
forward or back.
Choose a
chapter.
Choose a
chapter.
Drag to adjust
the volume.
Drag to adjust
the volume.
Watch a video: Tap the video in the list of videos.
• Scale the video to fill the screen or fit to the screen: Tap  or  . Or, double-tap the video to 
scale without showing the controls.
• Start over from the beginning: If the video contains chapters, drag the playhead along the 
scrubber bar all the way to the left. If there are no chapters, tap  .
• Skip to the next or previous chapter (if available): Tap  or  . You can also press the center 
button or equivalent on a compatible headset two times (skip to next) or three times (skip 
to previous).
• Rewind or fast-forward: Touch and hold  or  .
• Select a different audio language (if available): Tap  , then choose a language from the 
Audio list.
• Show or hide subtitles (if available): Tap  , then choose a language, or Off, from the 
Subtitles list.
• Show or hide closed captioning (if available): Go to Settings > Videos.
• Watch the video on a TV: See Connecting iPhone to a TV or other device on page 30.
Set a sleep timer: Open the Clock app and tap Timer, then swipe to set the number of hours 
and minutes. Tap When Timer Ends and choose Stop Playing, tap Set, then tap Start to start the 
timer. When the timer ends, iPhone stops playing music or video, closes any other open app, and 
then locks itself.
Delete a video: Swipe left or right over the video in the list. Deleting a video (other than a 
rented movie) from iPhone doesn’t delete it from your iTunes library.
Important:  If you delete a rented movie from iPhone, it’s deleted permanently and cannot be 
transferred back to your computer.
When you delete a video (other than a rented movie) from iPhone, it isn’t deleted from your 
iTunes library on your computer, and you can sync the video back to iPhone later. If you don’t 
want to sync the video back to iPhone, set iTunes to not sync the video. See Syncing with 
iTunes on page 16.14
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Maps
Finding locations
WARNING:  For important information about navigating safely and avoiding distraction while 
driving, see Important safety information on page 146.
Print, show traffic, 
list results, or 
choose the view.
Print, show traffic, 
list results, or 
choose the view.
Tap a pin to display 
the info banner.
Tap a pin to display 
the info banner.
Quick driving 
directions
Quick driving 
directions
Get more info. Get more info.
Double-tap to zoom 
in; tap with two 
fingers to zoom out. 
Or, pinch.
Double-tap to zoom 
in; tap with two 
fingers to zoom out. 
Or, pinch.
Current location Current location
Enter a search. Enter a search.
Show your
current
location.
Show your
current
location.
Flyover (3D
in standard 
view)
Flyover (3D
in standard 
view)
Get directions. Get directions.
Important:  Maps, directions, 3D, Flyover, and location-based apps depend on data services. 
These data services are subject to change and may not be available in all areas, resulting in 
maps, directions, 3D, Flyover, or location-based information that may be unavailable, inaccurate, 
or incomplete. Compare the information provided on iPhone to your surroundings, and defer 
to posted signs to resolve any discrepancies. Some Maps features require Location Services. See 
Privacy on page 140.Chapter  14    Maps 80
Find a location: Tap the search field, then type an address or other information, such as:
• Intersection (“8th and market”)
• Area (“greenwich village”)
• Landmark (“guggenheim”)
• Zip code
• Business (“movies,” “restaurants san francisco ca,” “apple inc new york”)
Or, tap one of the suggestions in the list below the search field.
Navigate maps:
• Move up or down, left or right: Drag the screen.
• Rotate the map: Rotate two fingers on the screen. A compass appears in the upper-right 
corner to show the map’s orientation.
• Return to the north-facing orientation: Tap  .
Find the location of a contact, or of a bookmarked or recent search: Tap  .
Get and share info about a location: Tap the pin to display the info banner, then tap  . When 
available, you can get reviews and photos from Yelp. You can also get directions, contact the 
business, visit the home page, add the business to your contacts, share the location, or bookmark 
the location.
• Read reviews: Tap Reviews. To use other Yelp features, tap the buttons beneath the reviews.
• See photos: Tap Photos.
• Email, text, tweet, or post a location to Facebook: Tap Share Location. To tweet or post to 
Facebook, you must be signed in to your accounts. See Sharing on page 29.
Use the drop pin to mark a location: Touch and hold the map until the drop pin appears.
Choose standard, hybrid, or satellite view: Tap the lower-right corner.
Report a problem: Tap the lower-right corner.
Getting directions
Get driving directions: Tap  , tap  , enter the starting and ending locations, then tap Route. Or, 
choose a location or a route from the list, when available. If multiple routes appear, tap the one 
you want to take. Tap Start to begin.
• Hear turn-by-turn directions (iPhone 4S or later): Tap Start.
Maps follows your progress and speaks turn-by-turn directions to your destination. To show or 
hide the controls, tap the screen.
If iPhone auto-locks, Maps stays onscreen and continues to announce instructions. You can 
also open another app and continue to get turn-by-turn directions. To return to Maps, tap the 
banner across the top of the screen.
• View turn-by-turn directions (iPhone 4 or earlier): Tap Start, then swipe left to see the 
next instruction.
• Return to the route overview: Tap Overview.
• View the directions as a list: Tap  on the Overview screen.
• Stop turn-by-turn directions: Tap End.
Get quick driving directions from your current location: Tap  on the banner of your 
destination, then tap Directions To Here.Chapter  14    Maps 81
Get walking directions: Tap  , tap  , enter the starting and ending locations, then tap Route. 
Or, choose a location or a route from the list, when available. Tap Start, then swipe left to see the 
next instruction. 
Get public transit directions: Tap  , tap  , enter the starting and ending locations, then tap 
Route. Or, choose a location or a route from the list, when available. Download and open the 
routing apps for the transit services you want to use.
Show traffic conditions: Tap the bottom-right corner of the screen, then tap Show Traffic. 
Orange dots show slowdowns, and red dots show stop-and-go traffic. To see an incident report, 
tap a marker.
3D and Flyover
On iPhone 4S or later, use 3D (standard view) or Flyover (satellite or hybrid view) for threedimensional views of many cities around the world. You can navigate in the usual ways, and 
zoom in to see buildings. You can also adjust the camera angle.
The Transamerica Pyramid Building is a registered 
service mark of Transamerica Corporation.
The Transamerica Pyramid Building is a registered 
service mark of Transamerica Corporation.
Use 3D or Flyover: Zoom in until  or  becomes active, then tap the button. Or, drag two 
fingers up. You can switch between 3D and Flyover by tapping the lower-right corner and 
changing views.
Adjust the camera angle: Drag two fingers up or down.
Maps settings
Set options for Maps: Go to Settings > Maps. Settings include:
• Navigation voice volume (iPhone 4S or later)
• Miles or kilometers for distance
• Language and size of labels15
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Weather
Get the current temperature and six-day forecast for one or more cities around the world, with 
hourly forecasts for the next 12 hours. Weather also uses Location Services to get the forecast for 
your current location.
Current conditions Current conditions
Add or delete cities. Add or delete cities.
Current temperature Current temperature
Current hourly 
forecast
Current hourly 
forecast
Number of cities stored Number of cities stored
If the weather board is light blue, it’s daytime in that city. Dark purple indicates nighttime.
Manage your list of cities: Tap  , then add a city or make other changes. Tap Done when 
you finish.
• Add a city:  Tap  . Enter a city or zip code, then tap Search.
• Rearrange the order of cities:  Drag  up or down.
• Delete a city:  Tap  , then tap Delete.
• Choose Fahrenheit or Celsius:  Tap °F or °C.
See weather for another city: Swipe left or right. 
The leftmost screen shows your local weather.
View the current hourly forecast:
• iPhone 5: Swipe the hourly display left or right.
• iPhone 4S or earlier: Tap Hourly.Chapter  15    Weather 83
Turn local weather on or off: Go to Settings > Privacy > Location Services. See Privacy on 
page 140.
See information about a city at yahoo.com: Tap  .
Use iCloud to push your list of cities to your other iOS devices: Go to Settings > iCloud > 
Documents & Data, then turn on Documents & Data (it’s on by default). See iCloud on page 15.16
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Passbook
Passbook lets you organize all of your passes, such as boarding passes or movie tickets, in 
one place. 
Tap a pass to view it. Tap a pass to view it.
Store your gift cards, coupons, tickets, and other passes in Passbook. When you need to see or 
use a pass, view it in Passbook or on the Lock screen. 
Add a pass to Passbook: Tap Add to Passbook on a merchant’s website or in a confirmation 
email. You can also add a pass from a Passbook-enabled app.
You must be signed in to your iCloud account to add passes to Passbook.
Use a pass: Select the pass, then point the barcode at the reader or scanner. Chapter  16    Passbook 85
If Location Services is turned on and the merchant supports it, a pass appears on your Lock 
screen when you need it. For example, when you arrive at the airport, your hotel, or the 
movie theater.
Tap to view details. Tap to view details.
View more information: Tap  .
Delete a pass: Tap  , then tap  .
Prevent passes from appearing on your Lock screen: Go to Settings > General > Passcode Lock, 
tap Turn Passcode On, then go to Allow Access When Locked, and turn Passbook off.
Push a pass to your other iPhone or iPod touch: Go to Settings > iCloud and turn on Passbook. 17
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Notes
Type notes on iPhone, and iCloud makes them available on your other iOS devices and Mac 
computers. You can also read and create notes in other accounts, such as Gmail or Yahoo!.
Tap the note to edit it. Tap the note to edit it.
Delete the note. Delete the note.
Email or print 
the note.
Email or print 
the note.
Add a new note. Add a new note.
View the list of notes. View the list of notes.
View the previous or next note. View the previous or next note.
Use iCloud to keep your notes up to date on your iOS devices and Mac computers:
• If you use a me.com or mac.com email address for iCloud: Go to Settings > iCloud and turn 
on Notes.
• If you use a Gmail or other IMAP account for iCloud: Go to Settings > Mail, Contacts, Calendars 
and turn on Notes for the account.
Choose the default account for new notes: Go to Settings > Notes.
Create a note in a specific account: Tap Accounts and select the account, then tap  to create 
the note. If you don’t see the Accounts button, tap the Notes button first.
See only notes in a specific account: Tap Accounts and choose the account. If you don’t see the 
Accounts button, tap Notes first.
Delete a note while viewing the list of notes: Swipe left or right across the note in the list.Chapter  17    Notes 87
Search for notes: While viewing the list of notes, scroll to the top of the list to reveal the search 
field. Tap in the field and type what you’re looking for. You can also search for notes from the 
Home screen. See Searching on page 27.
Print or email a note: While reading the note, tap  . To email the note, iPhone must be set up 
for email. See Setting up mail and other accounts on page 14.
Change the font: Go to Settings > Notes.18
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Reminders
Reminders lets you keep track of all the things you need to do.
Completed item Completed item
Add an item. Add an item.
View lists View lists
See reminder details: Tap a reminder. You can:
• Change or delete it
• Set a due date
• Set a priority
• Add notes
• Move it to a different list
Reminders can alert you when you arrive at or leave a location.
Add a location alert: While entering a reminder, tap  , then turn on “Remind Me At a Location.”
To use a different location, tap your current location. Locations in the list include addresses from 
your personal info card in Contacts, such as the home and work addresses you’ve added. To use a 
different address, tap Enter an Address.
Note:  Location reminders are not available on iPhone 3GS. You cannot set locations for 
reminders in Microsoft Exchange and Outlook accounts.
Search your reminders: Tap  to see the search field, or search from the Home screen. 
Reminders are searched by name. You can also use Siri to find or add reminders.Chapter  18    Reminders 89
Turn off reminder notifications: Go to Settings > Notifications. For information, see Do Not 
Disturb and Notifications on page 132.
Set the tone played for notifications: Go to Settings > Sounds.
Keep your reminders up to date on other devices: Go to Settings > iCloud, then turn on 
Reminders. To keep up to date with Reminders on OS X Mountain Lion, turn on iCloud on 
your Mac, too. Some other types of accounts, such as Exchange, also support Reminders. Go to 
Settings > Mail, Contacts, Calendars and turn on Reminders for the accounts you want to use.
Set a default list for new reminders: Go to Settings > Mail, Contacts, Calendars, then under 
Reminders, tap Default List.19
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Clock
Add a clock. Add a clock.
View clocks, set 
an alarm, time 
an event, or set 
a timer.
View clocks, set 
an alarm, time 
an event, or set 
a timer.
Delete clocks or change their order. Delete clocks or change their order.
Add a clock: Tap  , then type the name of a city or choose a city from the list. If you don’t see 
the city you’re looking for, try a major city in the same time zone.
Organize clocks: Tap Edit, then drag  to move or tap  to delete.
Set an alarm: Tap Alarm, then tap  .
Change an alarm: Tap Edit, then tap  to change settings or tap  to delete.
Set a sleep timer for iPhone: Set a timer, tap When Timer Ends, and choose Stop Playing.20
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Stocks
Keep track of your stocks, see the change in value over time, and get news about 
your investments.
Tap to see percent 
change. Tap again 
to see market 
capitalization.
Tap to see percent 
change. Tap again 
to see market 
capitalization.
Customize your 
stock list.
Customize your 
stock list.
Go to yahoo.com for more info. Go to yahoo.com for more info.
Swipe left or right to 
see stats or news 
articles.
Swipe left or right to 
see stats or news 
articles.
Manage your stock list: Tap  , then add stocks or make other changes. When you finish, 
tap Done.
• Add an item:  Tap  . Enter a symbol, company name, fund name, or index, then tap Search.
• Delete an item:  Tap  .
• Rearrange the order of items:  Drag  up or down.
View stock info:
• Switch the display to percentage change, price change, or market capitalization:  Tap any of the 
values along the right side of the screen.
• See the summary, chart, or news:  Swipe the info beneath the stock list. Tap a news headline to 
view the article in Safari. To change the chart’s time period, tap 1d, 1w, 1m, 3m, 6m, 1y, or 2y.
• Add a news article to your reading list:  Touch and hold the news headline, then tap Add to 
Reading List.
• See more stock information at yahoo.com: Tap  .
Quotes may be delayed 20 minutes or more, depending upon the reporting service. To display 
your stocks as a ticker in Notification Center, see Notifications on page 28.Chapter  20    Stocks 92
View a full-screen chart: Rotate iPhone to landscape orientation.
• See the value at a specific date or time:  Touch the chart with one finger.
• See the difference in value over time:  Touch the chart with two fingers.
Use iCloud to keep your stock list up to date on your iOS devices: Go to Settings > iCloud > 
Documents & Data, then turn on Documents & Data (it’s on by default). See iCloud on page 15.21
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Newsstand
Newsstand organizes your magazine and newspaper apps and lets you know when new issues 
are ready for reading. 
Touch and hold 
a publication to 
rearrange.
Touch and hold 
a publication to 
rearrange.
Find Newsstand 
apps.
Find Newsstand 
apps.
Newsstand organizes magazine and newspaper apps with a shelf for easy access.
Find Newsstand apps: Tap Newsstand to reveal the shelf, then tap Store. When you purchase a 
newsstand app, it’s added to your shelf. After the app is downloaded, open it to view its issues 
and subscription options. Subscriptions are In-App purchases, billed to your store account.
Turn off automatically downloading new issues: Go to Settings > Newsstand. If an app 
supports it, Newsstand downloads new issues when connected to Wi-Fi.22
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iTunes Store
At a glance
Use the iTunes Store to add music and TV shows, music, and podcasts to iPhone.
Browse Browse
See purchases, 
downloads, and 
more.
See purchases, 
downloads, and 
more.
Use iTunes Store to:
• Find music, TV shows, movies, tones, and more, by browsing or searching
• See your personal Genius recommendations
• Download previous purchases
Note:  You need an Internet connection and an Apple ID to use the iTunes Store.
Browse content: Tap one of the categories. Tap Genres to refine the listings. To see more 
information about an item, tap it.
Search for content: Tap Search, then tap the search field and enter one or more words, then 
tap Search.
Preview an item: Tap a song or video to play a sample.
Purchase an item: Tap the item’s price (or tap Free), then tap again to buy it. If you already 
purchased the item, “Download” appears instead of the price and you won’t be charged again. 
When items are being downloaded, tap More, then tap Downloads to see their progress.
Rent a movie: In some areas, certain movies are available to rent. You have 30 days to begin 
viewing a rented movie. Once you’ve started playing it, you can watch it as many times as you 
want in 24 hours. After these time limits, the movie is deleted.Chapter  22    iTunes Store 95
Download a previous purchase: Tap More, then tap Purchased. To automatically download 
purchases made on other devices, go to Settings > iTunes & App Stores.
Redeem a gift card or code: Tap any category (such as music), scroll to the bottom, then 
tap Redeem.
View or edit your account: Go to Settings > iTunes & App Stores, tap your Apple ID, then tap 
View Apple ID. Tap an item to edit it. To change your password, tap the Apple ID field.
Turn iTunes Match on or off: Go to Settings > iTunes & App Stores. iTunes Match is a 
subscription service that stores all of your music in iCloud so you can access it from wherever 
you are.
Sign in using a different Apple ID: Go to Settings > iTunes & App Stores, tap your account name, 
then tap Sign Out. The next time you download an app, you can enter a different Apple ID.
Download purchases using the cellular network: Go to Settings > iTunes & App Stores > Use 
Cellular Data. Downloading purchases and using iTunes Match over the cellular network may 
incur charges from your carrier.
Changing the browse buttons
You can replace and rearrange the buttons at the bottom of the screen. For example, if you often 
download tones but don’t watch many TV shows, you could replace those buttons.
Change the browse buttons: Tap More, tap Edit, then drag a button to the bottom of the screen, 
over the button you want to replace. When you finish, tap Done.23
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App Store
At a glance
Use the App Store to browse, purchase, and download apps to iPhone.
View a category. View a category.
View updates and 
previous purchases.
View updates and 
previous purchases.
Browse buttons Browse buttons
Use the App Store to:
• Find new free or purchased apps by browsing or searching
• Download previous purchases and updates
• Redeem a gift card or download code
• Recommend an app to a friend
• Manage your App Store account
Note:  You need an Internet connection and an Apple ID to use the App Store.
Purchase an app: Tap the app’s price (or tap Free), then tap Buy Now. If you already purchased 
the app, “install” appears instead of the price. You won’t be charged to download it again. While 
an app is being downloaded, its icon appears on the Home screen with a progress indicator.
Download a previous purchase: Tap Updates, then tap Purchased. To automatically download 
new purchases made on other devices, go to Settings > iTunes & App Stores.
Download updated apps: Tap Updates. Tap an app to read about the new version, then tap 
Update to download it. Or tap Update All to download all the apps in the list.Chapter  23    App Store 97
Redeem a gift card or download code: Tap Featured, scroll to the bottom, then tap Redeem.
Tell a friend about an app: Find the app, then tap  and select how you want to share it. 
View and edit your account: Go to Settings > iTunes & App Stores, tap your Apple ID, then tap 
View Apple ID. You can turn subscribe to iTunes newsletters, and view Apple’s privacy policy. To 
change your password, tap the Apple ID field.
Sign in using a different Apple ID: Go to Settings > iTunes & App Stores, tap your account name, 
then tap Sign Out. The next time you download an app, you can enter a different Apple ID.
Create a new Apple ID: Go to Settings > iTunes & App Stores, then tap Create New Apple ID and 
follow the onscreen instructions.
Download purchases using the cellular network: Go to Settings > iTunes & App Stores > 
Use Cellular Data. Downloading purchases over the cellular network may incur charges from 
your carrier. Newsstand apps update only over Wi-Fi.
Deleting apps
Delete an App Store app: Touch and hold its icon on the Home screen until the icon starts to 
jiggle, then tap  . You can’t delete built-in apps. When you finish, press the Home button  .
Deleting an app also deletes all of its data. You can re-download any app you’ve purchased from 
the App Store, free of charge.
For information about erasing all of your apps, data, and settings, see Reset on page 138.24
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Game Center
At a glance
Game Center lets you play your favorite games with friends who have an iPhone, iPad, 
iPod touch, or a Mac with OS X Mountain Lion.
WARNING:   For important information about avoiding repetitive motion injuries, see Important 
safety information on page 146.
See who’s the best. See who’s the best.
Respond to 
friend requests.
Respond to 
friend requests.
See a list of game 
goals.
See a list of game 
goals.
Play the game. Play the game.
Find someone 
to play against.
Find someone 
to play against.
Choose a 
game to play.
Choose a 
game to play.
Check for challenges 
from friends.
Check for challenges 
from friends.
Invite friends to play. Invite friends to play.
Declare your status, change
your photo, or sign out.
Declare your status, change
your photo, or sign out.
Sign in: Open Game Center. If you see your nickname and photo at the top of the screen, you’re 
already signed in. If not, enter your Apple ID and password, then tap Sign In. You can use the 
same Apple ID you use for iCloud or Store purchases, or tap Create New Account if you want a 
separate Apple ID for gaming.
Purchase a game: Tap Games, then tap a recommended game or tap Find Game Center Games.
Play a game: Tap Games, choose a game, then tap Play.
Return to Game Center after playing: Press the Home button  , then tap Game Center on the 
Home screen.
Sign out: Tap Me, tap the Account banner, then tap Sign Out. You don’t need to sign out each 
time you quit Game Center.Chapter  24    Game Center 99
Playing with friends
Invite friends to a multiplayer game: Tap Friends, choose a friend, choose a game, then tap Play. 
If the game allows or requires more players, choose additional players, then tap Next. Send your 
invitation, then wait for the others to accept. When everyone is ready, start the game. If a friend 
isn’t available or doesn’t respond to your invitation, you can tap Auto-Match to have 
Game Center find another player for you, or tap Invite Friend to invite someone else.
Send a friend request: Tap Friends or Requests, tap  , then enter your friend’s email address or 
Game Center nickname. To browse your contacts, tap  . To add several friends in one request, 
type Return after each address.
Challenge someone to outdo you: Tap one of your scores or achievements, then tap 
Challenge Friends.
See the games a friend plays and check your friend’s scores: Tap Friends, tap your friend’s 
name, then tap Games or Points.
Purchase a game your friend has: Tap Friends, then tap the name of your friend. Tap the game 
in your friend’s list of games, then tap the price at the top of the screen.
See a list of a friend’s friends: Tap Friends, tap the friend’s name, then tap Friends just below 
their picture.
Remove a friend: Tap Friends, tap a name, then tap Unfriend.
Keep your email address private: Turn off Public Profile in your Game Center account settings. 
See “Game Center settings” below.
Disable multiplayer activity or friend requests: Go to Settings > General > Restrictions and turn 
off Multiplayer Games or Adding Friends. If the switches are disabled, tap Enable Restrictions (at 
the top) first.
Report offensive or inappropriate behavior: Tap Friends, tap the person’s name, then tap 
“Report a Problem.”
Game Center settings
Some Game Center settings are associated with the Apple ID you use to sign in. Others are in the 
Settings app on iPhone.
Change Game Center settings for your Apple ID: Sign in with your Apple ID, tap Me, tap the 
Account banner, then choose View Account.
Specify which notifications you want for Game Center: Go to Settings > Notifications > 
Game Center. If Game Center doesn’t appear, turn on Notifications.
Change restrictions for Game Center: Go to Settings > General > Restrictions.25
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Contacts
At a glance
iPhone lets you easily access and edit your contact lists from personal, business, and 
organizational accounts.
Open in Mail. Open in Mail.
Send a Tweet. Send a Tweet.
Dial a number. Dial a number.
Set your My Info card: Go to Settings > Mail, Contacts, Calendars, then tap My Info and select 
the contact card with your name and information. The My Info card is used by Siri and other 
apps. Use the related persons fields to define relationships you want Siri to know about, so you 
can say things like “call my sister.”
Search contacts: Tap the search field at the top of the contact list and enter your search. You can 
also search your contacts from the Home screen. See Searching on page 27.
Share a contact: Tap a contact, then tap Share Contact. You can send the contact info by email 
or message.
Add a contact: Tap  . You can’t add contacts to a directory you’re only viewing, such as a 
Microsoft Exchange Global Address List.
Add a contact to your Favorites list: Choose a contact, then scroll down and tap the Add 
to Favorites button. The Favorites list is used by Do Not Disturb. See Do Not Disturb and 
Notifications on page 132.
Add a phone number to Contacts when dialing: In Phone, tap Keypad, enter a number, then 
tap  . Tap Create New Contact or tap “Add to Existing Contact” and choose a contact.Chapter  25    Contacts 101
Add a recent caller to Contacts: In Phone, tap Recents and tap  next to the number. Then tap 
Create New Contact, or tap “Add to Existing Contact” and choose a contact.
Delete a contact: Choose a contact, than tap Edit. Scroll down and tap Delete Contact.
Edit a contact: Choose a contact, then tap Edit. You can:
• Add a new field: Tap  , then choose or enter a label for the field.
• Change a field label: Tap the label and choose a different one. To add a new field, tap Add 
Custom Label.
• Change the ringtone or text tone for the contact: Tap the ringtone or text tone field, then choose 
a new sound. To change the default tone for contacts, go to Settings > Sounds.
• Change how iPhone vibrates for call or messages from the contact: Tap the ringtone or text tone 
vibration field, then select a vibration pattern. If you don’t see the vibration field, tap Edit and 
add it. For information about creating custom vibration patterns, see Sounds on page 139. 
• Assign a photo to the contact: Tap Add Photo. You can take a photo with the camera or use an 
existing photo.
• Update contact info using Twitter: Go to Settings > Twitter > Update Contacts. Contacts are 
matched using email addresses. For friends that you’re following, their contact card is updated 
with their Twitter user name and photo.
• Update contact info using Facebook: Go to Settings > Facebook > Update Contacts. Contacts 
are matched using email addresses. For each match in your friend list, their contact card is 
updated with their Facebook user name and photo.
• Enter a pause in a telephone number: Tap  , then tap Pause or Wait. Each pause lasts two 
seconds. Each wait stops dialing until you tap Dial again. Use these to automate dialing of an 
extension or passcode, for example. 
Adding contacts
In addition to adding contacts on iPhone, you can:
• Use your iCloud contacts: Go to Settings > iCloud, then turn on Contacts.
• Import your Facebook Friends: Go to Settings > Facebook, then turn on Contacts in the “Allow 
These Apps to Use Your Accounts” list. This creates a Facebook group in Contacts. 
• Access a Microsoft Exchange Global Address List: Go to Settings > Mail, Contacts, Calendars, then 
tap your Exchange account and turn on Contacts.
• Set up an LDAP or CardDAV account to access business or school directories: Go to Settings > Mail, 
Contacts, Calendars > Add Account > Other. Then tap “Add LDAP Account” or “Add CardDAV 
Account” and enter the account information.
• Sync contacts from your computer, Yahoo!, or Google: In iTunes on your computer, turn on 
contact syncing in the device info pane. For information, see iTunes Help.
• Import contacts from a SIM card (GSM): Go to Settings > Mail, Contacts, Calendars > Import 
SIM Contacts.
• Import contacts from a vCard: Tap a .vcf attachment in an email or message, or on a webpage.
Search a GAL, CardDAV, or LDAP server: Tap Groups, tap the directory you want to search, then 
enter your search.
Save contact information from a GAL, LDAP, or CardDAV server: Search for the contact you 
want to add, then tap Add Contact.Chapter  25    Contacts 102
Show or hide a group: Tap Groups then select the groups you want to see. This button only 
appears if you have more than one source of contacts.
When you have contacts from multiple sources, you might have multiple entries for the same 
person. To keep redundant contacts from appearing in the All Contacts list, contacts from 
different sources that have the same name are linked and displayed as a single unified contact. 
When you view a unified contact, the title Unified Info appears at the top of the screen. 
Link a contact: Edit a contact, tap Edit, then tap  and choose the contact entry to link to. 
Linked contacts aren’t merged. If you change or add information in a unified contact, the 
changes are copied to each source account where that information already exists. 
If you link contacts with different first or last names, the names on the individual cards won’t 
change, but only one name appears on the unified card. To choose which name appears when 
you view the unified card, tap the linked card with the name you prefer, then tap Use This Name 
For Unified Card.
View contact information from a source account: Tap one of the source accounts.
Unlink a contact: Tap Edit, tap  , then tap Unlink.
Contacts settings
To change Contacts settings, go to Settings > Mail, Contacts, Calendars. Available options let you:
• Change how contacts are sorted
• Display contacts by first or last name
• Set a default account for new contacts
• Set your My Info card26
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Calculator
Tap numbers and functions in Calculator just as you would with a standard calculator.
Add a number
to memory.
Add a number
to memory.
Clear memory. Clear memory.
Clear the display. Clear the display.
Subtract a number
from memory.
Subtract a number
from memory.
Get a number from 
memory (a white 
ring indicates a 
number is stored in 
memory).
Get a number from 
memory (a white 
ring indicates a 
number is stored in 
memory).
Use the scientific calculator: Rotate iPhone to landscape orientation.27
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Compass
Choose magnetic
or true north.
Choose magnetic
or true north.
Current location Current location
The direction iPhone
is pointing
The direction iPhone
is pointing
Show your current location in Maps. Show your current location in Maps.
Find the direction your iPhone is pointing: Hold iPhone flat in your hand, level with the ground.
If Location Services is turned off when you open Compass, you may be asked to turn it on. You 
can use Compass without turning on Location Services. See Privacy on page 140.
Important:  The accuracy of the compass can be affected by magnetic or environmental 
interference; even the magnets in the iPhone earbuds can cause a deviation. Use the digital 
compass only for basic navigation assistance and don’t rely on it to determine precise location, 
proximity, distance, or direction.28
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Voice Memos
At a glance
Voice Memos lets you use iPhone as a portable recording device using the built-in microphone, 
iPhone or Bluetooth headset mic, or supported external microphone.
Start, pause, or stop recording. Start, pause, or stop recording.
Recording level  Recording level 
See your list of 
recordings.
See your list of 
recordings.
Make a recording: Tap  or press the center button on your headset. Tap  to pause or  to 
stop recording, or press the center button on your headset.
Recordings using the built-in microphone are mono, but you can record stereo using an external 
stereo microphone that works with the iPhone headset jack, or with the Lightning connector 
(iPhone 5) or Dock connector (earlier iPhone models). Look for accessories marked with the 
Apple “Made for iPhone” or “Works with iPhone” logo.
Adjust the recording level: Move the microphone closer to or further away from what you’re 
recording. For better recording quality, the loudest level on the level meter should be between 
–3 dB and 0 dB.
Play or mute the start/stop tone: Use the iPhone volume buttons to turn the volume all the 
way down.
Use another app while recording: Press the Home button  and open an app. To return to 
Voice Memos, tap the red bar at the top of the screen.Chapter  28    Voice Memos 106
Play a recording: Tap  , tap a recording, then tap  . Tap  to pause.
Trim or relabel the 
recording.
Trim or relabel the 
recording.
Listen to the 
recording.
Listen to the 
recording.
Attach the recording 
to an email or text 
message.
Attach the recording 
to an email or text 
message.
Drag to skip 
to any point.
Drag to skip 
to any point.
Switch between the speaker and the receiver. Switch between the speaker and the receiver.
Trim a recording: Tap  next to the recording, then tap Trim Memo. Drag the edges of the 
audio region, then tap  to preview. Adjust if necessary, then tap Trim Voice Memo to save. The 
portions you trim can’t be recovered.
Sharing voice memos with your computer
iTunes can sync voice memos with your iTunes library when you connect iPhone to 
your computer.
When you sync voice memos to iTunes, they remain in the Voice Memos app until you delete 
them. If you delete a voice memo on iPhone, it isn’t deleted from the Voice Memos playlist in 
iTunes. However, if you delete a voice memo from iTunes, it is deleted from iPhone the next time 
you sync with iTunes.
Sync voice memos with iTunes: Connect iPhone to your computer and select iPhone in the 
iTunes device list. Select Music at the top of the screen (between Apps and Movies), select Sync 
Music, select “Include voice memos,” and click Apply.
The voice memos from iPhone appear in the Voice Memos playlist in iTunes.29
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Nike + iPod
With a Nike + iPod Sensor (sold separately), the Nike + iPod app provides audible feedback on 
your speed, distance, time elapsed, and calories burned during a run or walk.
Review your
workout history.
Review your
workout history.
Calibrate based on
your last workout.
Calibrate based on
your last workout.
Choose a standard workout. Choose a standard workout.
Choose or create a
custom workout.
Choose or create a
custom workout.
Choose a 
workout type.
Choose a 
workout type.
The Nike + iPod app doesn’t appear on the Home screen until you turn it on.
Turn on Nike + iPod: Go to Settings > Nike + iPod.
Nike + iPod collects workout data from a wireless sensor (sold separately) that you attach to your 
shoe. Before you use it the first time, you need to link your sensor to iPhone.
Link your sensor to iPhone: Attach the sensor to your shoe, then go to Settings > Nike + iPod > 
Sensor.
Start a workout: Tap Workouts, and choose a workout.
• Pause a workout: Wake iPhone and tap  on the lock screen. Tap  when you’re ready 
to continue.
• End a workout: Wake iPhone, tap  , then tap End Workout.
Change workout settings: Go to Settings > Nike + iPod.
Calibrate Nike + iPod: Record a workout over a known distance of at least a quarter mile 
(400 meters). Then, after you tap End Workout, tap Calibrate on the workout summary screen and 
enter the actual distance you covered.Chapter  29    Nike + iPod 108
Reset to the default calibration: Go to Settings > Nike + iPod.
Send workout data to nikeplus.com: With iPhone connected to the Internet, open Nike + iPod, 
tap History, then tap “Send to Nike+.”
See your workouts on nikeplus.com: In Safari, go to nikeplus.com, log in to your account, and 
follow the onscreen instructions.30
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iBooks
At a glance
iBooks is a great way to read and buy books. Download the free iBooks app from the App Store, 
and then enjoy everything from classics to bestsellers.
Go to a 
different page.
Go to a 
different page.
Bookmark Bookmark
Contents, bookmarks, and notes Contents, bookmarks, and notes
iBooks is a great way to enjoy books and PDFs. Download the free iBooks app from the 
App Store, and then get everything from classics to bestsellers from the built-in iBookstore. 
To download the iBooks app and use the iBookstore, you need an Internet connection and 
an Apple ID.
Visit the iBookstore: In iBooks, tap Store to:
• Find books by browsing or searching
• Get a sample of a book to see if you like it
• Read and write reviews, and see current bestsellers
• Tell a friend about a book via email
Purchase a book: Find one you want, tap the price, then tap again to get it.
Get information about a book: You can read a summary of the book, read reviews, and try a 
sample of the book before buying it. After buying a book, you can write a review of your own.Chapter  30    iBooks 110
Download a previous purchase: Tap Purchased. To download while browsing, tap Download 
where you usually see the price. You won’t be charged again. To automatically download items 
purchased on other devices, go to Settings > iTunes & App Stores.
Reading books
Reading a book is easy. Go to the bookshelf and tap the book you want to read. Each book has 
a particular set of features, based on its contents and format. Some of the features described 
below might not be available in the book you’re reading.
Open a book: Tap the book you want to read. If you don’t see it on the shelf, swipe left or right 
to see other collections.
• Show the controls: Tap near the center of the page.
• Enlarge an image: Double-tap the image. In some books, touch and hold to display a 
magnifying glass you can use to view an image.
• Go to a specific page: Use the page navigation controls at the bottom of the screen. Or, tap 
and enter a page number, then tap the page number in the search results.
• Look up a word: Double-tap a word, use the grab points to adjust the selection, then tap 
Define in the menu that appears. Definitions are not available for all languages.
• View the table of contents: Tap  . With some books, you can also pinch to see the the table 
of contents.
• Add or remove a bookmark: Tap  . Tap again to remove the bookmark. You don’t need to add 
a bookmark when you close the book, because iBooks remembers where you left off. You can 
have multiple bookmarks—to see them all, tap  , then tap Bookmarks.
Annotate a book: You can add notes and highlights to a book.
• Add a highlight: Double-tap a word, use the grab points to adjust the selection, then tap 
Highlight and choose a color or underline. 
• Remove a highlight: Tap the highlighted text, then tap  .
• Add a note: Double-tap a word, tap Highlight, then choose  from the menu that appears.
• Remove a note: Delete its text. To remove the note and its highlight, tap the highlighted text, 
then tap  . 
• See all your notes: Tap  , then tap Notes. Tap  to print or email your notes.
Change a book’s appearance: Some books let you change the type size, font, and page color.
• Change the font or type size: Tap near the center of a page to display the controls, then tap 
. Tap Fonts to select a typeface. Some books allow you to change the type size only when 
iPhone is in portrait orientation. 
• Change the color of the page and text: Tap near the center of the page to display the controls, 
tap  , then tap Theme. This setting applies to all books that support it.
• Change the brightness: Tap near the center of a page to display the controls, then tap  . If you 
don’t see  , tap  first.
• Turn justification and hyphenation on or off: Go to Settings > iBooks. PDFs and some books 
can’t be justified or hyphenated.Chapter  30    iBooks 111
Organizing the bookshelf
Use the bookshelf to browse your books and PDFs. You can also organize items into collections.
Touch and hold a
book to rearrange.
Touch and hold a
book to rearrange.
View collections. View collections.
Move a book or PDF to a collection: Tap Edit. Select the items you want to move, then tap Move 
and select a collection.
View and manage collections: Tap the name of the current collection at the top of the screen, 
such as Books or PDFs, to display the collections list. You can’t edit or remove the built-in Books 
and PDFs collections.
Sort the bookshelf: Tap the status bar to scroll to the top of the screen, then tap  and select a 
sort method at the bottom of the screen.
Delete an item from the bookshelf: Tap Edit, then tap each item that you want to delete, so 
that a checkmark appears. Tap Delete. When you finish, tap Done. If you delete an item you 
purchased, you can download it again from Purchases in the iBookstore.
Search for a book: Go to the bookshelf. Tap the status bar to scroll to the top of the screen, then 
tap  . Searching looks for the title and the author’s name. 
Syncing books and PDFs
Use iTunes to sync your books and PDFs between iPhone and your computer, and to buy books 
from the iTunes Store. When iPhone is connected to your computer, the Books pane lets you 
select which items to sync. You can also find DRM-free ePub books and PDFs on the web and 
add them to your iTunes library.
Sync a book or PDF to iPhone: In iTunes on your computer, choose File > Add to Library and 
select the file. Then sync.
Add a book or PDF to iBooks without syncing: If the book or PDF isn’t too large, email it to 
yourself from your computer. Open the email message on iPhone, then touch and hold the 
attachment and choose “Open in iBooks” from the menu that appears.Chapter  30    iBooks 112
Printing or emailing a PDF
You can use iBooks to email a copy of a PDF, or to print all or a portion of the PDF to an 
AirPrint printer.
Email a PDF: Open the PDF, tap  then choose Email Document.
Print a PDF: Open the PDF, tap  then choose Print. For more information, see Printing with 
AirPrint on page 30.
iBooks settings
iBooks stores your collections, bookmarks, notes, and current page information using your Apple 
ID, so you can read books seamlessly across all your iOS devices. iBooks saves information for 
all of your books when you open or quit the app. Information for individual books is also saved 
when you open or close the book.
Turn syncing on or off: Go to Settings > iBooks. You can sync collections and bookmarks, too.
Some books might access video or audio that’s stored on the web. If iPhone has a cellular data 
connection, playing these files may incur carrier charges.
Turn online video and audio access on or off: to Settings > iBooks > Online Audio & Video.
Change the direction the page turns when you tap the left margin: Go to Settings > iBooks > 
Tap Left Margin.31
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Podcasts
Download the free Podcasts app from the App Store, then browse, subscribe to, and play your 
favorite audio and video podcasts.
View the podcasts
in your library.
View the podcasts
in your library.
Browse all available podcasts.  Browse all available podcasts. 
Tap a podcast to 
view available 
episodes.
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